
Preface

Note The terms “Unidirectional Path Switched Ring” and “UPSR” may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as “Path Protected Mesh Network” and “PPMN”, refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This section explains the objectives, intended audience, and organization of this publication and 
describes the conventions that convey instructions and other information. 

This section provides the following information:

• Revision History

• Document Objectives

• Audience

• Document Organization

• Related Documentation

• Document Conventions

• Obtaining Optical Networking Information

• Obtaining Documentation and Submitting a Service Request
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Revision History

Date Notes

July 2012 Updated the table “Gigabit Ethernet RMON Variables” in the chapter 
“Provision Transponder and Muxponder Cards”.

August 2012 • Updated the table “Platform and Software Release Compatibility for 
Control Cards” in the chapter “Install the Control Cards”.

• Added a section “Important Notes Regarding Patchcord Installation” in the 
chapter “Provision Optical Amplifier Cards”.

• Updated the section “TCC2P Card” in the chapter “Install the Control 
cards” and “Supported Node Configurations for OPT-RAMP-C and 
OPT-RAMP-CE Cards” in the chapter “Node Reference”.

September 2012 • Added the “NTP-G333 Add an ADM-10G Card to an Existing Topology” 
in the chapter “Provision Transponder and Muxponder Cards”.

• Updated the procedures “NTP-G60 Create and Delete Overhead Circuits” 
and “DLP-G76 Provision DCC/GCC Terminations” in the chapter “Create 
Optical Channel Circuits and Provisionable Patchcords”.

• Updated the procedure “NTP-G38 Provision OSC Terminations” in the 
chapter “Turn Up a Node”.

October 2012 • Updated the “Circuit Provisioning” section of ADM-10G card in the 
chapter “Provision Transponder and Muxponder Cards”.

• Updated the section, “Network Data Pane” in the chapter, “Node 
Reference”.

• Added a note to “DLP -G264 Enable Node Security Mode” in the chapter, 
“Turn Up a Node”.

• Added a caution to the section, “IP Addressing with Secure Mode 
Enabled” in the chapter, “Management Network Connectivity”.

December 2012 Updated “NTP-G244 Perform the Four Degree ROADM Node with 
40-SMR-2-C Cards Acceptance Test” in the chapter, “Perform Node 
Acceptance Tests”.

January 2013 Updated the procedure “DLP-G351 Delete a Card in CTC” in the chapter, 
“Turn Up a Node”.

February 2013 • In the chapter “Provision Transponder and Muxponder Cards,” added a 
note after “Table 11-22 Supported SDH Circuit Sizes of ADM-10G card 
on ONS 15454 SDH”.

• In the chapter “Create Optical Channel Circuits and Provisionable 
Patchcords,” updated the procedures “NTP-G245 Create an Automatically 
Routed VCAT Circuit” and “NTP-G246 Create a Manually Routed VCAT 
Circuit”.

March 2013 Revised the part number and included Release 9.6.0.3 features. For the list of 
9.6.0.3 features, see the “New and Changed Information” section.
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April 2013 • Updated the section “External Firewalls” in the chapter “Manage Network 
Connectivity”.

• Updated step 4 in the procedure, "DLP-G713 Provision Administrative 
VLAN for Ports in a REP Segment Using CTC" in the chapter, “Provision 
Transponder and Muxponder Cards”.

• Updated the section, “FEC” in the chapter, “Card Features”.

• Added a note to “NTP-G33 Create a Y-Cable Protection Group” in the 
chapter, “Provision Transponder and Muxponder Cards”.

May 2013 • Updated the "NTP-G38 Provision OSC Terminations" procedure in the 
chapter, "Turn Up a Node" and the "DLP-G605 Provision PPM and Port 
for the TNC and TNCE Cards" procedure in the chapter, "Install the 
Control Cards".

• Modified a note in the procedure, "NTP-G104 Restore the Database" in the 
chapter, "Maintain the Node".

• Updated the section, “ REP Limitations and Restrictions” in the chapter, 
“ Provision Transponder and Muxponder Cards”.

• Added the procedure, “NTP-G341 Set Up Secure Access to the ONS 
15454 TL1” in the chapter, “Turn Up a Node”.

June 2013 Added a footnote to the table, "MXP_MR_10DME_C or 
MXP_MR_10DME_L Ethernet Variables" in the chapter, "Provision 
Transponder and Muxponder Cards".

July 2013 Added a step to the procedure “DLP-G347 Delete Optical Channel Client 
Connections” in the chapter “Create Optical Channel Circuits and 
Provisionable Patchcords”.

September 2013 Updated "DLP-G604 Install the TNC, TNCE, TSC, or TSCE Card" in the 
chapter, "Install the Control Cards".

October 2013 Created a new table "Revision Number Compatibility for Transponder and 
Muxponder Cards " in the chapter, “Provision Transponder and Muxponder 
Cards”.

November 2013 • Updated the section “Trunk Interface” of OTU2_XP card in the chapter 
“Provision Transponder and Muxponder Cards”.

• Updated the description of rx8b10bWords and tx8b10bWords counters in 
the chapter “Provision Transponder and Muxponder Cards”.

• Updated the “Multiple Operating Modes” section in the chapter, 
“Provision Transponder and Muxponder Cards”.

October 2014 Added “DLP-G771 Changing the WXC Line Thresholds for the 80-WXC-C 
Card.” in the chapter, “Change DWDM Card Settings”.

December 2014 Updated the key features of the OTU2_XP card in the chapter “Provision 
Transponder and Muxponder Cards”.

Date Notes
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Document Objectives
The Cisco ONS 15454 DWDM Configuration Guide includes content previously found in two separate 
guides—Cisco ONS 15454 DWDM Reference Manual and Cisco ONS 15454 DWDM Procedure Guide. 

The new Cisco ONS 15454 DWDM Configuration Guide, Release 9.3 and later releases will now include 
background and reference material, installation, turn up, provisioning, and maintenance procedures for 
the Cisco ONS 15454, Cisco ONS M2, and Cisco ONS M6 dense wavelength division (DWDM) 
systems. Use this document in conjunction with the appropriate publications listed in the Related 
Documentation section.

Audience
To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware 
and cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and 
preferably have experience as a telecommunications technician

Document Organization
Table 1 Cisco ONS 15454 Configuration Guide Chapters

Title Summary

"Cisco ONS Documentation Roadmap for 
Release 9.6.x"

Provides a link to quickly access publications of Cisco ONS Release 9.6.x.

"New and Changed Information" Provides new and changed information for Cisco ONS Release 9.6.x.

Chapter 1, “Install the Cisco ONS 15454, 
ONS 15454 M2, and ONS 15454 M6 Shelf”

Explains how to install the Cisco ONS 15454 ETSI, Cisco ONS 15454 ANSI, 
Cisco ONS 15454 M2, and Cisco ONS 15454 M6 shelf assemblies.

Chapter 2, “Connecting the PC and Logging 
into the GUI”

Explains how to connect Windows PCs and Solaris workstations to the 
Cisco ONS 15454 and how to log into Cisco Transport Controller (CTC) 
software.

Chapter 3, “Install the Control Cards” Explains how to install the control cards needed for the Cisco ONS 15454, 
Cisco ONS 15454 M2, and Cisco ONS 15454 M6 shelf assemblies.

Chapter 4, “Setup Optical Service Channel 
Cards”

Includes descriptions of OSCM and OSC-CSM cards. Also provides 
references to related procedures.

Chapter 5, “Provision Optical Amplifier 
Cards”

Includes descriptions of the optical amplifier cards. Also provides references 
to related procedures.

Chapter 6, “Provision Multiplexer and 
Demultiplexer Cards”

Includes descriptions of the 32-MUX-O, 32DMX-O, and 4MD-xx.x cards. 
Also provides references to related procedures.

Chapter 7, “Setup Tunable Dispersion 
Compensating Units”

Explains the Tunable Dispersion Compensating Units (T-DCU) used in Cisco 
ONS 15454 dense wavelength division multiplexing (DWDM) networks. 
Also provides references to related procedures.

Chapter 8, “Provision Protection Switching 
Module”

Includes descriptions of the Protection Switching Module (PSM) card used in 
Cisco ONS 15454 DWDM networks. Also provides references to related 
procedures.
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Chapter 9, “Provision Optical Add/Drop 
Cards”

Includes descriptions of the AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, 
AD-1B-xx.x, and AD-4B-xx.x cards. Also provides references to related 
procedures.

Chapter 10, “Provision Reconfigurable 
Optical Add/Drop Cards”

Includes descriptions of the ROADM cards. Also provides references to 
related procedures.

Chapter 11, “Provision Transponder and 
Muxponder Cards”

Includes descriptions of transponder (TXP), muxponder (MXP), Xponder 
(GE_XP, 10GE_XP, GE_XPE and 10GE_XPE), and ADM-10G cards. Also 
provides references to related procedures.

Chapter 12, “Node Reference” Explains the DWDM node types available for the ONS 15454. The DWDM 
node type is determined by the type of amplifier and filter cards that are 
installed in an ONS 15454. Also explains the DWDM automatic power 
control (APC), reconfigurable optical add/drop multiplexing (ROADM) 
power equalization, span loss verification, and automatic node setup (ANS) 
functions.

Chapter 13, “Network Reference” Explains the DWDM network applications and topologies. Also provides 
network-level optical performance references.

Chapter 14, “Manage the Shelf” Explains how to provision a single Cisco ONS 15454 DWDM node and turn 
it up for service.

Chapter 15, “Perform Node Acceptance 
Tests”

Provides test procedures to verify that installed cards are operating correctly 
in a Cisco ONS 15454 DWDM node.

Chapter 16, “Turn Up a Network” Explains how to turn up and test a Cisco ONS 15454 DWDM network.

Chapter 17, “Create Optical Channel Circuits 
and Provisionable Patchcords”

Explains how to create Cisco ONS 15454 DWDM optical channel client 
connections (OCHCCs), optical channel network connections (OCHNCs), 
and optical trail circuits.

Chapter 18, “Monitor Performance” Explains how to enable and view performance monitoring (PM) statistics for 
the Cisco ONS 15454.

Chapter 19, “Manage the Node” Explains how to modify node provisioning for the Cisco ONS 15454 and 
perform common management tasks such as monitoring the DWDM 
automatic power control (APC) and span loss values.

Chapter 20, “Alarm and TCA Monitoring and 
Management”

Contains the procedures for viewing and managing the alarms and conditions 
on a Cisco ONS 15454.

Chapter 21, “Change DWDM Card Settings” Explains how to change line, performance monitoring (PM), and threshold 
settings on Cisco ONS 15454 DWDM cards.

Chapter 22, “Manage Network Connectivity” Provides an overview of ONS 15454 data communications network (DCN) 
connectivity. Cisco Optical Networking System (ONS) network 
communication is based on IP, including communication between Cisco 
Transport Controller (CTC) computers and ONS 15454 nodes, and 
communication among networked ONS 15454 nodes. The chapter shows 
common Cisco ONS 15454 IP network configurations and includes detailed 
data communications network (DCN) case studies.

Chapter 23, “Upgrade, Add, and Remove 
Cards and Nodes”

Provides procedures for adding and removing DWDM cards and nodes

Table 1 Cisco ONS 15454 Configuration Guide Chapters (continued)

Title Summary
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Related Documentation
Use the Cisco ONS 15454 DWDM Configuration Guide in conjunction with the following referenced 
Release 9.6.x publications:

• Release Notes for Cisco ONS 15454, ONS 15454 M2, and ONS 15454 M6 DWDM, Release 9.6.x

• Cisco ONS 15454 Hardware Installation Guide

• Cisco ONS 15454 DWDM Troubleshooting Guide

• Cisco ONS SONET TL1 Command Guide

• Cisco ONS SONET TL1 Reference Guide

• Cisco ONS SONET TL1 Command Quick Reference Guide

• Cisco ONS SONET TL1 for Beginners

• Cisco ONS SDH TL1 Command Guide

• Cisco ONS SDH TL1 Reference Guide

• Cisco ONS SDH TL1Command Quick Reference Guide

Chapter 24, “Maintain the Node” Provides procedures for maintaining the Cisco ONS 15454, including 
database backup and restoration, removing and replacing cards, viewing the 
ONS 15454 audit trail, and hardware maintenance procedures.

Chapter 25, “Security Reference” Provides information about Cisco ONS 15454 users and security.

Chapter 26, “Timing Reference” Provides information about Cisco ONS 15454 users and node timing.

Chapter 27, “SNMP” Explains Simple Network Management Protocol (SNMP) as implemented by 
the Cisco ONS 15454.

Appendix A, “CTC Enhancements, 
Operations, and Shortcuts”

Describes the Cisco Transport Controller (CTC) views, menus options, tool 
options, shortcuts, and table display options. 

Appendix B, “Hardware Specifications” Contains hardware specifications for the ONS 15454 ANSI and ETSI shelf 
assemblies and cards.

Appendix C, “Administrative and Service 
States”

Describes the administrative and service states for Cisco ONS 15454 DWDM 
cards, optical payload ports, out-of-band optical service channel (OSC) ports, 
optical channel network connections (OCHNCs), and 
transponder/muxponder cards and ports.

Appendix D, “Configure GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Cards Using 
PCLI”

Describes how to provision GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards using Pseudo Command Line Interface (PCLI). 

Appendix E, “Pseudo Command Line 
Interface Reference”

Describes Pseudo-IOS command line interface (PCLI) for GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Appendix F, “Fiber and Connector Losses in 
Raman Link Configuration”

Describes guidelines to be followed when configuring a Raman link.

Appendix G, “Card Features” Describes the card features.

Appendix H, “Network Element Defaults” Describes the defaults for the network element settings for Cisco ONS 15454, 
Cisco ONS 15454 M2, and Cisco ONS 15454 M6 platforms.

Table 1 Cisco ONS 15454 Configuration Guide Chapters (continued)

Title Summary
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• Cisco ONS SDH TL1 for Beginners

• Cisco Transport Planner – DWDM Operations Guide

• Regulatory Compliance and Safety Information for Cisco CPT and Cisco ONS Platforms

• Electrostatic Discharge and Grounding Guide for Cisco CPT and Cisco ONS Platforms

For an update on End-of-Life and End-of-Sale notices, refer to 

http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_eol_notices_list.html.

Document Conventions
This publication uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ ] Keywords or arguments that appear within square brackets are optional.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.
li
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Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. Use the statement number provided at the end of 
each warning to locate its translation in the translated safety warnings that accompanied this 
device. Statement 1071

SAVE THESE INSTRUCTIONS

Waarschuwing BELANGRIJKE VEILIGHEIDSINSTRUCTIES

Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die lichamelijk letsel kan 
veroorzaken. Voordat u aan enige apparatuur gaat werken, dient u zich bewust te zijn van de bij 
elektrische schakelingen betrokken risico's en dient u op de hoogte te zijn van de standaard 
praktijken om ongelukken te voorkomen. Gebruik het nummer van de verklaring onderaan de 
waarschuwing als u een vertaling van de waarschuwing die bij het apparaat wordt geleverd, wilt 
raadplegen.

BEWAAR DEZE INSTRUCTIES

Varoitus TÄRKEITÄ TURVALLISUUSOHJEITA

Tämä varoitusmerkki merkitsee vaaraa. Tilanne voi aiheuttaa ruumiillisia vammoja. Ennen kuin 
käsittelet laitteistoa, huomioi sähköpiirien käsittelemiseen liittyvät riskit ja tutustu 
onnettomuuksien yleisiin ehkäisytapoihin. Turvallisuusvaroitusten käännökset löytyvät laitteen 
mukana toimitettujen käännettyjen turvallisuusvaroitusten joukosta varoitusten lopussa näkyvien 
lausuntonumeroiden avulla.

SÄILYTÄ NÄMÄ OHJEET

Attention IMPORTANTES INFORMATIONS DE SÉCURITÉ 

Ce symbole d'avertissement indique un danger. Vous vous trouvez dans une situation pouvant 
entraîner des blessures ou des dommages corporels. Avant de travailler sur un équipement, soyez 
conscient des dangers liés aux circuits électriques et familiarisez-vous avec les procédures 
couramment utilisées pour éviter les accidents. Pour prendre connaissance des traductions des 
avertissements figurant dans les consignes de sécurité traduites qui accompagnent cet appareil, 
référez-vous au numéro de l'instruction situé à la fin de chaque avertissement.

CONSERVEZ CES INFORMATIONS

Warnung WICHTIGE SICHERHEITSHINWEISE

Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation, die zu Verletzungen führen 
kann. Machen Sie sich vor der Arbeit mit Geräten mit den Gefahren elektrischer Schaltungen und 
den üblichen Verfahren zur Vorbeugung vor Unfällen vertraut. Suchen Sie mit der am Ende jeder 
Warnung angegebenen Anweisungsnummer nach der jeweiligen Übersetzung in den übersetzten 
Sicherheitshinweisen, die zusammen mit diesem Gerät ausgeliefert wurden.

BEWAHREN SIE DIESE HINWEISE GUT AUF.
lii
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Preface
Avvertenza IMPORTANTI ISTRUZIONI SULLA SICUREZZA 

Questo simbolo di avvertenza indica un pericolo. La situazione potrebbe causare infortuni alle 
persone. Prima di intervenire su qualsiasi apparecchiatura, occorre essere al corrente dei pericoli 
relativi ai circuiti elettrici e conoscere le procedure standard per la prevenzione di incidenti. 
Utilizzare il numero di istruzione presente alla fine di ciascuna avvertenza per individuare le 
traduzioni delle avvertenze riportate in questo documento. 

CONSERVARE QUESTE ISTRUZIONI

Advarsel VIKTIGE SIKKERHETSINSTRUKSJONER

Dette advarselssymbolet betyr fare. Du er i en situasjon som kan føre til skade på person. Før du 
begynner å arbeide med noe av utstyret, må du være oppmerksom på farene forbundet med 
elektriske kretser, og kjenne til standardprosedyrer for å forhindre ulykker. Bruk nummeret i slutten 
av hver advarsel for å finne oversettelsen i de oversatte sikkerhetsadvarslene som fulgte med denne 
enheten.

TA VARE PÅ DISSE INSTRUKSJONENE

Aviso INSTRUÇÕES IMPORTANTES DE SEGURANÇA 

Este símbolo de aviso significa perigo. Você está em uma situação que poderá ser causadora de 
lesões corporais. Antes de iniciar a utilização de qualquer equipamento, tenha conhecimento dos 
perigos envolvidos no manuseio de circuitos elétricos e familiarize-se com as práticas habituais de 
prevenção de acidentes. Utilize o número da instrução fornecido ao final de cada aviso para 
localizar sua tradução nos avisos de segurança traduzidos que acompanham este dispositivo.

GUARDE ESTAS INSTRUÇÕES 

¡Advertencia! INSTRUCCIONES IMPORTANTES DE SEGURIDAD

Este símbolo de aviso indica peligro. Existe riesgo para su integridad física. Antes de manipular 
cualquier equipo, considere los riesgos de la corriente eléctrica y familiarícese con los 
procedimientos estándar de prevención de accidentes. Al final de cada advertencia encontrará el 
número que le ayudará a encontrar el texto traducido en el apartado de traducciones que acompaña 
a este dispositivo. 

GUARDE ESTAS INSTRUCCIONES

Varning! VIKTIGA SÄKERHETSANVISNINGAR

Denna varningssignal signalerar fara. Du befinner dig i en situation som kan leda till personskada. 
Innan du utför arbete på någon utrustning måste du vara medveten om farorna med elkretsar och 
känna till vanliga förfaranden för att förebygga olyckor. Använd det nummer som finns i slutet av 
varje varning för att hitta dess översättning i de översatta säkerhetsvarningar som medföljer denna 
anordning.

SPARA DESSA ANVISNINGAR
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Aviso INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Este símbolo de aviso significa perigo. Você se encontra em uma situação em que há risco de lesões 
corporais. Antes de trabalhar com qualquer equipamento, esteja ciente dos riscos que envolvem os 
circuitos elétricos e familiarize-se com as práticas padrão de prevenção de acidentes. Use o 
número da declaração fornecido ao final de cada aviso para localizar sua tradução nos avisos de 
segurança traduzidos que acompanham o dispositivo.

GUARDE ESTAS INSTRUÇÕES

Advarsel VIGTIGE SIKKERHEDSANVISNINGER

Dette advarselssymbol betyder fare. Du befinder dig i en situation med risiko for 
legemesbeskadigelse. Før du begynder arbejde på udstyr, skal du være opmærksom på de 
involverede risici, der er ved elektriske kredsløb, og du skal sætte dig ind i standardprocedurer til 
undgåelse af ulykker. Brug erklæringsnummeret efter hver advarsel for at finde oversættelsen i de 
oversatte advarsler, der fulgte med denne enhed.

GEM DISSE ANVISNINGER
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Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that 
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Regulatory Compliance and Safety Information for 
Cisco CPT and Cisco ONS Platforms document that accompanied the product. This publication 
describes the international agency compliance and safety information for the Cisco ONS 15454 system. 
It also includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as an RSS feed and set content to be 
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco currently 
supports RSS Version 2.0.
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Cisco ONS Documentation Roadmap for 
Release 9.6.x

To quickly access publications of Cisco ONS Release 9.6.x, see the 
Cisco ONS Documentation Roadmap for Release 9.6.x.
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New and Changed Information

This table summarizes the new and changed information for the Cisco ONS 15454 DWDM Configuration 
Guide, and tells you where the features are documented.

Table 1 New and Changed Features

Feature Description
Introduced/Changed 
in Release Where Documented

100G-LC-C, 
10x10G-LC, and 
CFP-LC Card 
Enhancements

This feature was 
enhanced.

Changed in 9.6.0.3 Provision Transponder and Muxponder Cards chapter

• 11.21 100G-LC-C,10x10G-LC, and CFP-LC Cards

• NTP-G33 Create a Y-Cable Protection Group

• NTP-G235 Provision an Operating Mode on the 
100G-LC-C, 10x10G-LC, or CFP-LC Card

• DLP-G714 Change the 100G-LC-C, 10x10G-LC, or 
CFP-LC Card Line Settings

• DLP-G722 Change the 100G-LC-C Card OTN 
Settings

Create Optical Channel Circuits and Provisionable 
Patchcords chapter

• DLP-G76 Provision DCC/GCC Terminations

Manage Network Connectivity chapter

• 22.15 Proactive Protection Regen

Card Features appendix

• G.34 Card Protection

AR_XPE Card This card was 
introduced.

Introduced in 9.6.0.3 Provision Transponder and Muxponder Cards chapter

• 11.20 AR_MXP, AR_XP, and AR_XPE Cards

• NTP-G321 Provision Multiple Operating Modes on 
AR_MXP, AR_XP, or AR_XPE Cards

• NTP-G322 Modify the AR_MXP, AR_XP, or 
AR_XPE Card Line Settings and PM Parameter 
Thresholds

• NTP-G33 Create a Y-Cable Protection Group
lix
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GMPLS Restoration 
and UNI

This feature was 
introduced.

Introduced in 9.6.0.3 Node Reference chapter

• 12.10.1.4 GMPLS Optical Restoration

• 12.10.1.9 GMPLS UNI

Create Optical Channel Circuits and Provisionable 
Patchcords chapter

• NTP-G334 Configure GMPLS Optical Restoration

Lamp Test Per Card This feature was 
introduced.

Introduced in 9.6.0.3 Card Features appendix

• G.15 Lamp Test

• NTP-G335 Perform Lamp Test

Persistence of 
Perspective View

This feature was 
introduced.

Introduced in 9.6.0.3 Connecting the PC and Logging into the GUI chapter

• NTP-G336 Persist Perspective View

Enhancements in 
40E-MXP-C and 
40ME-MXP-C Cards

This feature was 
introduced.

Introduced in 9.6.0.3 Provision Transponder and Muxponder Cards chapter

• 11.13 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C Cards

• DLP-G735 Provision the 40G Muxponder Ethernet 
Settings

• DLP-G666 Change the 40G Muxponder Line 
Settings

Automatic Power 
Calculations

This feature was 
introduced.

Introduced in 9.6.0.3 Turn Up a Node chapter

• NTP-G30 Install the DWDM Cards

Cisco ONS 15454 Hardware Installation Guide

• DC Power Module

• Power Calculation (link to be provided)

Splitter Wavelengths This feature was 
introduced.

Introduced in 9.6.0.3 Provision Transponder and Muxponder Cards chapter

• 11.16 OTU2_XP Card

• 11.20 AR_MXP, AR_XP, and AR_XPE Cards

CIR and PIR 
Granularity

This feature was 
introduced.

Introduced in 9.6.0.3 Provision Transponder and Muxponder Cards chapter

• DLP-G612 Modify the Parameters of the Channel 
Group Using CTC

• DLP-G380 Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Ethernet Settings

• DLP-G471 Create a SVLAN or CVLAN Profile

Table 1 New and Changed Features

Feature Description
Introduced/Changed 
in Release Where Documented
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Install the Cisco ONS 15454, ONS 15454 M2, and 
ONS 15454 M6 Shelf

For information on installing the Cisco ONS 15454, ONS 15454 M2, and ONS 15454 M6 shelf, refer:

Cisco ONS 15454 Hardware Installation Guide.
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C H A P T E R 2

Connecting the PC and Logging into the GUI

The information in this chapter is in a new location. See Connect the PC and Log into the GUI document 
for information on how to connect Windows PCs and Solaris workstations to the Cisco ONS 15454 and 
how to log into Cisco Transport Controller (CTC) software, the ONS 15454 Operation, Administration, 
Maintenance and Provisioning (OAM&P) user interface.
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Install the Control Cards

Note The terms “Unidirectional Path Switched Ring” and “UPSR” may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as “Path Protected Mesh Network” and “PPMN”, refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter describes the common-control cards needed for the Cisco ONS 15454, 
Cisco ONS 15454 M2, and Cisco ONS 15454 M6 platforms and provides installation and card turn up 
procedures. 

For card safety and compliance information, refer to the Regulatory Compliance and Safety Information 
for Cisco CPT and Cisco ONS Platforms document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco 
ONS 15454 M2 platforms, unless noted otherwise. 

Chapter topics include:

• 3.1 Card Overview, page 3-2

• 3.3 TCC2 Card, page 3-4

• “3.3.3 Related Procedures for TCC2 Card” section on page 3-6

• 3.4 TCC2P Card, page 3-6

• “3.4.3 Related Procedures for TCC2P Card” section on page 3-9

• 3.5 TCC3 Card, page 3-9

• 3.5.3 Related Procedures for TCC3 Card, page 3-12

• 3.6 TNC and TNCE Card, page 3-12

• 3.6.3 Related Procedures for TNC and TNCE Cards, page 3-16

• 3.7 TSC and TSCE Cards, page 3-16

• 3.7.3 Related Procedures for TSC and TSCE Cards, page 3-19
3-1
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3.1   Card Overview
• 3.8 Digital Image Signing, page 3-20

• 3.8.2 Related Procedures for DIS, page 3-20

• 3.9 AIC-I Card, page 3-20

• 3.9.8 Related Procedures for AIC-I Card, page 3-26

• 3.10 MS-ISC-100T Card, page 3-26

• 3.10.3 Related Procedures for MS-ISC-100T Card, page 3-28

• 3.11 Front Mount Electrical Connections, page 3-29

• 3.12 Procedures for Control Cards, page 3-34

3.1 Card Overview
The card overview section lists the cards described in this chapter.

Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. For a list of slots and symbols, see 
the “Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation Guide.

3.1.1 Common Control Cards
The following common control cards are needed to support the functions of the DWDM, transponder, 
and muxponder cards on ONS 15454 shelf:

• TCC2 or TCC2P or TCC3

• AIC-I (optional)

• MS-ISC-100T (multishelf configurations only)

The TNC, TNCE, TSC, and TSCE cards are used to support the functions of DWDM, transponder, and 
muxponder cards on the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 shelves.

3.1.2 Card Compatibility
Table 3-1 lists the platform and software release compatibility for the control cards.

Table 3-1 Platform and Software Release Compatibility for Control Cards

TCC2 TCC2P AIC-I MS-ISC-100T TCC31 TNC TSC TNCE TSCE

R4.5 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R4.6 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R4.7 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R5.0 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R6.0 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R7.0 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R7.2 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R8.0 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No
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3.1.3   Front Mount Electrical Connections (ETSI only)
3.1.3 Front Mount Electrical Connections (ETSI only)
The following Front Mount Electrical Connections (FMECs) are needed to support the functions of the 
DWDM, transponder, and muxponder cards:

• MIC-A/P

• MIC-C/T/P

R8.5 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R9.0 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R9.1 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM No No No No No

R9.2

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM 15454-
DWDM

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

No No

R9.2.1 
and 
R9.2.2

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM 15454-
DWDM

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

No No

R9.2.3

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM 15454-
DWDM

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

15454
-M2 
and 
15454
-M6

R9.3

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM 15454-
DWDM

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

15454
-M2 
and 
15454
-M6

R9.4

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM 15454-
DWDM

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M6

15454
-M2 
and 
15454
-M6

R9.6.x

15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM 15454-
DWDM

15454-
M2 and 
15454-
M62

15454-
M2 and 
15454-
M6

15454-
M2 and 
15454-
M62

15454
-M2 
and 
15454
-M6

1. The TCC3 card is backward compatible with software Release 9.1 and earlier releases. In the Release 9.1 and earlier releases, the TCC3 card boots up as 
the TCC2P card in the Cisco ONS 15454 DWDM systems. 

2. From releases 9.2.3 and later, the TNC and TNCE cards can be interchanged on an ONS 15454 M6 shelf without any alarms. However, if you combine 
both the cards in a single chassis and configure the OC3 OSC, it raises an EOC alarm.

Table 3-1 Platform and Software Release Compatibility for Control Cards (continued)

TCC2 TCC2P AIC-I MS-ISC-100T TCC31 TNC TSC TNCE TSCE
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3.2   Safety Labels
3.2 Safety Labels
For information about safety labels, see the “G.1 Safety Labels” section on page G-1.

3.3 TCC2 Card
(Cisco ONS 15454 only)

Note For TCC2 card specifications, see the “TCC2 Card Specifications” section in the Hardware 
Specifications document.

The Advanced Timing, Communications, and Control (TCC2) card performs system initialization, 
provisioning, alarm reporting, maintenance, diagnostics, IP address detection/resolution, SONET 
section overhead (SOH) data communications channel/generic communications channel (DCC/GCC) 
termination, optical service channel (OSC) DWDM data communications network (DCN) termination, 
and system fault detection for the ONS 15454. The TCC2 also ensures that the system maintains 
Stratum 3 (Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system. 

Note The LAN interface of the TCC2 card meets the standard Ethernet specifications by supporting a cable 
length of 328 ft. (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees Celsius).

Install TCC2 cards in Slots 7 and 11 for redundancy. If the active TCC2 fails, traffic switches to the 
protect TCC2.

3.3.1 Faceplate and Block Diagram
Figure 3-1 shows the faceplate and block diagram for the TCC2 card. 
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3.3.2   TCC2 Card Functions
Figure 3-1 TCC2 Faceplate and Block Diagram

3.3.2 TCC2 Card Functions
The functions of the TCC2 card are:

• G.22 Communication and Control for Controller Cards, page G-24

• G.10 Timing Synchronization, page G-19
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3.3.3   Related Procedures for TCC2 Card
• G.23 Interface Ports, page G-25

• G.27 Redundant Controller Card Installation, page G-27

• Card level indicators—Table G-1 on page G-8

• Network level indicators—Table G-14 on page G-15

3.3.3 Related Procedures for TCC2 Card
The following is the list of procedures and tasks related to the configuration of the TCC2 card:

• NTP-G15 Install the Common Control Cards, page 3-35

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454

• NTP-G17 Set Up Computer for CTC

• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G144 Provision a Multishelf Node, page 14-8

• NTP-G25 Set Battery Power Monitor Thresholds, page 14-16

• NTP-G26 Set Up CTC Network Access, page 14-17

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-48

• NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G81 Change CTC Network Access

• NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node

• NTP-G147 Delete a Passive Unit, Shelf, or Rack from a Multishelf Node

• NTP-G103 Back Up the Database, page 24-2

• NTP-G104 Restore the Database, page 24-3

• NTP-G106 Reset Cards Using CTC, page 24-13

• NTP-G105 Restore the Node to Factory Configuration, page 24-4

3.4 TCC2P Card
(Cisco ONS 15454 only)

Note For TCC2P card specifications, see the”TCC2P Card Specifications” section in the Hardware 
Specifications document.

The Advanced Timing, Communications, and Control Plus (TCC2P) card is an enhanced version of the 
TCC2 card. The primary enhancements are Ethernet security features and 64K composite clock BITS 
timing.

The TCC2P card performs system initialization, provisioning, alarm reporting, maintenance, 
diagnostics, IP address detection/resolution, SONET SOH DCC/GCC termination, and system fault 
detection for the ONS 15454. The TCC2P also ensures that the system maintains Stratum 3 
(Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system. 
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3.4.1   Faceplate and Block Diagram
The TCC2P card supports multi-shelf management. The TCC2P card acts as a shelf controller and node 
controller for the ONS 15454. The TCC2P card supports up to four subtended shelves through the 
MS-ISC card or external switch. In a multi-shelf configuration, the TCC2P card allows the ONS 15454 
node to be a node controller and does not support subtending of ONS 15454 M6 shelves.

The TCC2P card is compliant to the following standards:

• The LAN interface of the TCC2P card meets the standard Ethernet specifications by supporting a 
cable length of 328 ft. (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees 
Celsius). The interfaces can operate with a cable length of 32.8 ft. (10 m) maximum at temperatures 
from –40 to 32 degrees Fahrenheit (–40 to 0 degrees Celsius). 

• The TCC2P card is Restriction of Use of Hazardous Substances (RoHS) complaint. The RoHS 
regulations limit or ban the specific substances such as lead, cadmium, polybrominated biphenyl 
(PBB), mercury, hexavalent chromium, and polybrominated diphenyl ether (PBDE) flame retardants 
in a new electronic and electric equipment.

Install TCC2P cards in Slots 7 and 11 for redundancy. If the active TCC2P card fails, traffic switches to 
the protect TCC2P card. All TCC2P card protection switches conform to protection switching standards 
when the bit error rate (BER) counts are not in excess of 1 * 10 exp – 3 and completion time is less than 
50 ms.

3.4.1 Faceplate and Block Diagram
Figure 3-2 shows the faceplate and block diagram for the TCC2P card. 
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3.4.2   TCC2P Card Functions
Figure 3-2 TCC2P Faceplate and Block Diagram

3.4.2 TCC2P Card Functions
The functions of the TCC2P card are:

• G.22 Communication and Control for Controller Cards, page G-24
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3.4.3   Related Procedures for TCC2P Card
• G.10 Timing Synchronization, page G-19

• G.23 Interface Ports, page G-25

• G.26 Database Storage, page G-27

• G.27 Redundant Controller Card Installation, page G-27

• Card level indicators—Table G-1 on page G-8 l

• Network level indicators—Table G-14 on page G-15

• Power level indicators—Table G-11 on page G-13

3.4.3 Related Procedures for TCC2P Card
The following is the list of procedures and tasks related to the configuration of the TCC2P card:

• NTP-G15 Install the Common Control Cards, page 3-35

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454

• NTP-G17 Set Up Computer for CTC

• DLP-G43 Disable or Bypass Proxy Service Using Internet Explorer (Windows)

• DLP-G44 Disable or Bypass Proxy Service Using Mozilla (Solaris)

• DLP-G48 Create Login Node Groups

• DLP-G49 Add a Node to the Current Session or Login Group

• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G144 Provision a Multishelf Node, page 14-8

• NTP-G25 Set Battery Power Monitor Thresholds, page 14-16

• NTP-G26 Set Up CTC Network Access, page 14-17

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-48

• NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G81 Change CTC Network Access

• NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node

• NTP-G147 Delete a Passive Unit, Shelf, or Rack from a Multishelf Node

• NTP-G103 Back Up the Database, page 24-2

• NTP-G104 Restore the Database, page 24-3

• NTP-G106 Reset Cards Using CTC, page 24-13

• NTP-G105 Restore the Node to Factory Configuration, page 24-4

3.5 TCC3 Card
(Cisco ONS 15454 only)
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3.5.1   Faceplate and Block Diagram
Note For TCC3 card specifications, see the “TCC3 Card Specifications” section in the Hardware 
Specifications document.

The Timing Communications Control Three (TCC3) card is an enhanced version of the TCC2P card. The 
primary enhancements include the increase in memory size and compact flash space. The TCC3 card 
boots up as TCC2P card in older releases and as TCC3 card from Release 9.2 onwards.

The TCC3 card performs system initialization, provisioning, alarm reporting, maintenance, diagnostics, 
IP address detection/resolution, SONET SOH DCC/GCC termination, and system fault detection for the 
ONS 15454. The TCC3 also ensures that the system maintains Stratum 3 (Telcordia GR-253-CORE) 
timing requirements. It monitors the supply voltage of the system. 

The TCC3 card supports multi-shelf management. The TCC3 card acts as a shelf controller and node 
controller for the ONS 15454. The TCC3 card supports up to 50 subtended shelves through the 
MSM-ISC card or external switch. In a multi-shelf configuration, the TCC3 card allows the ONS 15454 
node to be a node controller if an M6 shelf is subtended to it. We recommend the use of TCC3 card as a 
node controller when the number of subtended shelves exceeds three.

The TCC3 card is compliant with the following standards:

• The LAN interface of the TCC3 card meets the standard Ethernet specifications by supporting a 
cable length of 328 ft (100 m) at temperatures ranging from 32 to 149 degrees Fahrenheit (0 to 65 
degrees Celsius). The interfaces can operate with a cable length of 32.8 ft (10 m) maximum at 
temperatures from –40 to 32 degrees Fahrenheit (–40 to 0 degrees Celsius). 

• The TCC3 card is Restriction of Use of Hazardous Substances (RoHS) compliant. The RoHS 
regulations limit or ban the specific substances such as lead, cadmium, polybrominated biphenyl 
(PBB), mercury, hexavalent chromium, and polybrominated diphenyl ether (PBDE) flame retardants 
in a new electronic and electric equipment.

3.5.1 Faceplate and Block Diagram
Figure 3-3 shows the faceplate and block diagram for the TCC3 card. 
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Chapter 3      Install the Control Cards
3.5.2   TCC3 Card Functions
Figure 3-3 TCC3 Faceplate and Block Diagram

3.5.2 TCC3 Card Functions
The functions of the TCC3 card are:

• G.22 Communication and Control for Controller Cards, page G-24

• G.10 Timing Synchronization, page G-19

• G.23 Interface Ports, page G-25

• G.26 Database Storage, page G-27

• G.27 Redundant Controller Card Installation, page G-27

• Card level indicators—Table G-1 on page G-8
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Chapter 3      Install the Control Cards
3.5.3   Related Procedures for TCC3 Card
• Network level indicators—Table G-14 on page G-15

• Power level indicators—Table G-13 on page G-14

3.5.3 Related Procedures for TCC3 Card
The following is the list of procedures and tasks related to the configuration of the TCC3 card:

• NTP-G15 Install the Common Control Cards, page 3-35

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454

• NTP-G17 Set Up Computer for CTC

• DLP-G43 Disable or Bypass Proxy Service Using Internet Explorer (Windows)

• DLP-G44 Disable or Bypass Proxy Service Using Mozilla (Solaris)

• DLP-G48 Create Login Node Groups

• DLP-G49 Add a Node to the Current Session or Login Group

• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G144 Provision a Multishelf Node, page 14-8

• NTP-G25 Set Battery Power Monitor Thresholds, page 14-16

• NTP-G26 Set Up CTC Network Access, page 14-17

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-48

• NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G81 Change CTC Network Access

• NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node

• NTP-G147 Delete a Passive Unit, Shelf, or Rack from a Multishelf Node

• NTP-G103 Back Up the Database, page 24-2

• NTP-G104 Restore the Database, page 24-3

• NTP-G106 Reset Cards Using CTC, page 24-13

• NTP-G105 Restore the Node to Factory Configuration, page 24-4

3.6 TNC and TNCE Card
(Cisco ONS 15454 M2 and ONS 15454 M6 only)

The TNC and TNCE cards combine the functions of multiple cards such as TCC2P, OSCM, ISC, and 
AIC-I cards. The card has a similar look and feel to TCC2/TCC2P/TCC3 cards.

Note For TNC and TNCE card specifications, see the “TNC and TNCE Card Specifications (Cisco ONS 
15454 M2 and Cisco ONS 15454 M6)” section in the Hardware Specifications document.
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Chapter 3      Install the Control Cards
3.6.1   Faceplate and Block Diagram
The TNC and TNCE cards are provisioned as master and slave in the 15454-M6 shelf, and as a 
stand-alone card in the 15454-M2 shelf. The TNC and TNCE cards serve as the processor card for the 
node.

On the 15454-M6 shelf, install redundant TNC and TNCE cards in slots 1 and 8. If the active TNC or 
TNCE card fails, system traffic switches to the redundant TNC or TNCE card. The card supports line 
cards from slots 2 to 7. 

On the 15454-M2 shelf, install the stand-alone TNC and TNCE cards in slot 1. The TNC and TNCE 
cards support line cards in slots 2 and 3.

The TNC and TNCE cards monitor both the supply voltage inputs on the 15454-M6 shelf. The TNC and 
TNCE cards raise an alarm if one of the supply voltage inputs has a voltage out of the specified range. 
The 15454-M2 shelf has dual power supply.

You can insert and remove the TNC and TNCE cards even when the system is online, without impacting 
the system traffic.

You can upgrade the TSC or TSCE card to a TNC or TNCE card. During the upgrade, the TNC and 
TNCE cards do not support OSC functions such as UDC, VoIP, DCC, and timing function. However, you 
can still provision the SFP ports on the TNC and TNCE cards during the upgrade. The TNC/TNCE and 
TSC/TSCE cards cannot be inserted in the same shelf.

The TNC and TNCE cards support all the alarms supported by the TCC2P and AIC-I cards. The card 
adjusts the fan speed according to the temperature and reports a fan failure alarm.

Note The LAN interface of the TNC and TNCE cards meet the standard Ethernet specifications by supporting 
a cable length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees 
Celsius). The interfaces can operate with a cable length of 32.8 ft (10 m) maximum at temperatures from 
-40 to 32 degrees Fahrenheit (-40 to 0 degrees Celsius). 

3.6.1 Faceplate and Block Diagram 
The faceplate design of the TNC and TNCE cards allow sufficient space to insert or remove cables while 
accessing the Ethernet and SFP ports.

The TNC and TNCE cards can be installed only in slots 1 or 8 of the ONS 15454 M6 shelf and in slot 1 
of the ONS 15454 M2 shelf. The TNC and TNCE cards have an identifier on the faceplate that matches 
with an identifier in the shelf. A key is also provided on the backplane interface connectors as identifier 
in the shelf.

The TNC and TNCE cards support field-programmable gate array (FPGA) for the backplane interface. 
The TNC cards have two FPGA: TCCA, SYNTIDE and FRAMPOS

The TNCE cards have one FPGA: VEGA and FRAMPOS

Figure 3-4 illustrates the faceplate and block diagram for the TNC card.
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Chapter 3      Install the Control Cards
3.6.1   Faceplate and Block Diagram
Figure 3-4 TNC Faceplate and Block Diagram

Figure 3-5 illustrates the faceplate and block diagram for the TNCE card.
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Chapter 3      Install the Control Cards
3.6.2   TNC and TNCE Card Functions
Figure 3-5 TNCE Faceplate and Block Diagram

3.6.2 TNC and TNCE Card Functions
The functions of the TNC and TNCE cards are:

• G.22 Communication and Control for Controller Cards, page G-24

• G.28 Optical Service Channel, page G-28

• G.10 Timing Synchronization, page G-19

• G.29 MultiShelf Management, page G-28

• G.26 Database Storage, page G-27

• G.23 Interface Ports, page G-25

• G.24 External Alarms and Controls, page G-26

• G.15 Lamp Test, page G-22

• G.27 Redundant Controller Card Installation, page G-27

• Card level indicators—Table G-1 on page G-8

• Network level indicators—Table G-14 on page G-15

• Power level indicators—Table G-13 on page G-14

• Port level indicators—Table G-15 on page G-15

• TNC and TNCE SFP indicators—Table G-16 on page G-15
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Chapter 3      Install the Control Cards
3.6.3   Related Procedures for TNC and TNCE Cards
• G.30 Protection Schemes, page G-29

• G.31 Cards Supported by TNC/TNCE/TSC/TSCE, page G-29

3.6.3 Related Procedures for TNC and TNCE Cards
The following is the list of procedures and tasks related to the configuration of the TNC and TNCE cards:

• NTP-G313 Install and Configure the TNC, TNCE, TSC, or TSCE Card, page 3-42

• NTP-G17 Set Up Computer for CTC

• DLP-G43 Disable or Bypass Proxy Service Using Internet Explorer (Windows)

• DLP-G44 Disable or Bypass Proxy Service Using Mozilla (Solaris)

• DLP-G48 Create Login Node Groups

• DLP-G49 Add a Node to the Current Session or Login Group

• DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host 
Detection

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454

• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G250 Verify Digital Image Signing (DIS) Information, page 14-6

• NTP-G279 Monitor TNC and TNCE Card Performance 

• NTP-G144 Provision a Multishelf Node, page 14-8

• NTP-G25 Set Battery Power Monitor Thresholds, page 14-16

• NTP-G26 Set Up CTC Network Access, page 14-17

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-48

• NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G81 Change CTC Network Access

• NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node

• NTP-G147 Delete a Passive Unit, Shelf, or Rack from a Multishelf Node

• NTP-G103 Back Up the Database, page 24-2

• NTP-G104 Restore the Database, page 24-3

• NTP-G106 Reset Cards Using CTC, page 24-13

• NTP-G277 Provision Alarms and Controls on the TNC, TNCE, TSC, or TSCE Card

• NTP-G105 Restore the Node to Factory Configuration, page 24-4

3.7 TSC and TSCE Cards
(Cisco ONS 15454 M2 and ONS 15454 M6 only)

The TSC and TSCE cards combine the functions of multiple cards such as TCC2P, ISC, and AIC-I cards. 
The card has a similar look and feel to TCC2/TCC2P/TCC3 cards.
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Chapter 3      Install the Control Cards
3.7.1   Faceplate and Block Diagram
Note For TSC and TSCE cards specification, see the “TSC and TSCE Card Specifications (ONS 15454 M2 
and ONS 15454 M6)” section in the Hardware Specifications document.

The TSC and TSCE cards are provisioned as master and slave in the ONS 15454 M6 shelf, and as a 
stand-alone card in the ONS 15454 M2 shelf. The TSC and TSCE cards serve as the processor card for 
the node.

On the ONS 15454 M6 shelf, install redundant TSC and TSCE cards in slots 1 and 8. If the active TSC 
or TSCE card fails, system traffic switches to the redundant TSC or TSCE card. The TSC and TSCE 
cards support line cards from slots 2 to 7. 

On the ONS 15454 M2 shelf, install the stand-alone TSC and TSCE cards in slot 1. The TSC and TSCE 
cards support line cards in slots 2 and 3.

The TSC and TSCE cards monitor both the supply voltage inputs on the 15454-M6 shelf. The TSC and 
TSCE cards raise an alarm if one of the supply voltage inputs has a voltage out of the specified range. 
The 15454-M2 shelf has dual power supply.

You can insert and remove the TSC and TSCE cards even when the system is online, without impacting 
the system traffic.

The TSC and TSCE cards do not support optical service channel (OSC) and SFP ports.

You can upgrade the TSC or TSCE card to a TNC or TNCE card. During the upgrade, the TNC and 
TNCE cards do not support OSC functions such as UDC, VoIP, DCC, and timing function. However, you 
can still provision SFP ports on the TNC and TNCE cards during the upgrade. The TNC, TNCE, TSC, 
and TSCE cards cannot be inserted in the same shelf.

The TSC and TSCE cards support all the alarms supported by the TCC2P and AIC-I cards. The card 
adjusts the fan speed according to the temperature and reports a fan failure alarm.

Note The LAN interface of the TSC and TSCE cards meet the standard Ethernet specifications by supporting 
a cable length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees 
Celsius). The interfaces can operate with a cable length of 32.8 ft (10 m) maximum at temperatures from 
-40 to 32 degrees Fahrenheit (-40 to 0 degrees Celsius). 

3.7.1 Faceplate and Block Diagram
The faceplate design of the TSC and TSCE cards allow sufficient space to insert or remove cables while 
accessing the Ethernet ports.

The TSC and TSCE cards can be installed only in slots 1 or 8 of the 15454-M6 shelf and in slot 1 of the 
15454-M2 shelf. The TSC and TSCE cards have an identifier on the faceplate that matches with an 
identifier in the shelf. A key is also provided on the backplane interface connectors as identifier in the 
shelf.

The TSC and TSCE cards support field-programmable gate array (FPGA) for the backplane interface. 
The TSC cards have two FPGA: TCCA and SYNTIDE

The TSCE cards have one FPGA: VEGA

Figure 3-6 illustrates the faceplate and block diagram for the TSC card.
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Chapter 3      Install the Control Cards
3.7.2   TSC and TSCE Card Functions
Figure 3-6 TSC Faceplate and Block Diagram

Figure 3-7 illustrates the faceplate for the TSCE card.

Figure 3-7 TSCE Faceplate

3.7.2 TSC and TSCE Card Functions
The functions of the TSC and TSCE cards are:

• G.22 Communication and Control for Controller Cards, page G-24

• G.10 Timing Synchronization, page G-19

• G.29 MultiShelf Management, page G-28

• G.26 Database Storage, page G-27

• G.23 Interface Ports, page G-25

• G.24 External Alarms and Controls, page G-26

• G.15 Lamp Test, page G-22

• G.27 Redundant Controller Card Installation, page G-27

• Card level indicators—Table G-1 on page G-8
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Chapter 3      Install the Control Cards
3.7.3   Related Procedures for TSC and TSCE Cards
• Network level indicators—Table G-14 on page G-15

• Power level indicators—Table G-13 on page G-14

• Port level indicators—Table G-15 on page G-15

• G.30 Protection Schemes, page G-29

• G.31 Cards Supported by TNC/TNCE/TSC/TSCE, page G-29

3.7.3 Related Procedures for TSC and TSCE Cards
The following is the list of procedures and tasks related to the configuration of the TSC and TSCE cards:

• NTP-G313 Install and Configure the TNC, TNCE, TSC, or TSCE Card, page 3-42

• NTP-G17 Set Up Computer for CTC

• DLP-G43 Disable or Bypass Proxy Service Using Internet Explorer (Windows)

• DLP-G44 Disable or Bypass Proxy Service Using Mozilla (Solaris)

• DLP-G48 Create Login Node Groups

• DLP-G49 Add a Node to the Current Session or Login Group

• DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host 
Detection

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454

• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G250 Verify Digital Image Signing (DIS) Information, page 14-6

• NTP-G144 Provision a Multishelf Node, page 14-8

• NTP-G25 Set Battery Power Monitor Thresholds, page 14-16

• NTP-G26 Set Up CTC Network Access, page 14-17

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-48

• NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G81 Change CTC Network Access

• NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node

• NTP-G147 Delete a Passive Unit, Shelf, or Rack from a Multishelf Node

• NTP-G103 Back Up the Database, page 24-2

• NTP-G104 Restore the Database, page 24-3

• NTP-G106 Reset Cards Using CTC, page 24-13

• NTP-G103 Back Up the Database, page 24-2

• NTP-G104 Restore the Database, page 24-3

• NTP-G106 Reset Cards Using CTC, page 24-13

• NTP-G277 Provision Alarms and Controls on the TNC, TNCE, TSC, or TSCE Card

• NTP-G280 Modify Threshold Settings for the TNC and TNCE Cards, page 21-123

• NTP-G105 Restore the Node to Factory Configuration, page 24-4
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3.8   Digital Image Signing
• NTP-G278 Upgrade the TSC Card to the TNC Card, page 3-48

3.8 Digital Image Signing
(Cisco ONS 15454 M2 and ONS 15454 M6 only)

The DIS feature complies with the new U.S. Government Federal Information Processing Standard 
(FIPS) 140-3 to provide security for all software provided on the Cisco ONS 15454 M6 and ONS 15454 
M2 platforms. This standard requires software to be digitally signed and verified for authenticity and 
integrity prior to load and execution. 

DIS feature automatically provides increased protection. DIS focuses on software security and provides 
increased protection from attacks and threats to Cisco ONS 15454 M2 and ONS 15454 M6 products. 
DIS verifies software integrity and provides assurance that the software has not been tampered with or 
modified. Digitally signed Cisco software provides counterfeit protection.

New controller cards, such as TNC/TNCE/TSC/TSCE, provide services that authenticate the origin of 
the software running on the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms. The signage and 
verification process is transparent until verification fails.

3.8.1 DIS Identification
Digitally signed software can be identified by the last three characters appended to the working version 
and protected version field in CTC. The DIS conventions can be viewed under the working version 
displayed in the Maintenance > Software tab in CTC. For example, 9.2.0 (09.20-X10C-29.09-SDA) 
and 9.2.0 (09.20-010C-18.18-SPA).

The significance of the three characters appended to the software version is explained in Table:

3.8.2 Related Procedures for DIS
To verify DIS, see NTP-G250 Verify Digital Image Signing (DIS) Information, page 14-6.

3.9 AIC-I Card
(Cisco ONS 15454 only)

Character Meaning

S (first character) Indicates that the package is signed.

P or D (second character) Production (P) or Development (D) image. Production image—Software 
approved for general release. Development image—development software 
provided under special conditions for limited use.

A (third character) This third character indicates the version of the key used for signature 
generation. The version changes when a key is revoked and a new key is 
used. The values of the version key varies from A to Z.
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3.9.1   Faceplate and Block Diagram
Note For hardware specifications, see the “AIC-I Card Specifications” section in the Hardware Specifications 
document.

The optional Alarm Interface Controller–International (AIC-I) card provides customer-defined 
(environmental) alarms and controls and supports local and express orderwire. It provides 
12 customer-defined input and 4 customer-defined input/output contacts. The physical connections are 
via the backplane wire-wrap pin terminals. If you use the additional alarm expansion panel (AEP), the 
AIC-I card can support up to 32 inputs and 16 outputs, which are connected on the AEP connectors. The 
AEP is compatible with ANSI shelves only. A power monitoring function monitors the supply voltage 
(–48 VDC). 

3.9.1 Faceplate and Block Diagram
Figure 3-8 shows the AIC-I faceplate and a block diagram of the card. 
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3.9.2   AIC-I Card-Level Indicators
Figure 3-8 AIC-I Faceplate and Block Diagram

3.9.2 AIC-I Card-Level Indicators
Table G-2 lists the card-level LEDs on the card.
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3.9.3   External Alarms and Controls
3.9.3 External Alarms and Controls
The AIC-I card provides input/output alarm contact closures. You can define up to 12 external alarm 
inputs and 4 external alarm inputs/outputs (user configurable). The physical connections are made using 
the backplane wire-wrap pins or FMEC connections. For information about increasing the number of 
input/output contacts, see the “ONS 15454 ANSI Alarm Expansion Panel” section in the Cisco ONS 
15454 Hardware Installation Guide.

LEDs on the front panel of the AIC-I indicate the status of the alarm lines, one LED representing all of 
the inputs and one LED representing all of the outputs. External alarms (input contacts) are typically 
used for external sensors such as open doors, temperature sensors, flood sensors, and other 
environmental conditions. External controls (output contacts) are typically used to drive visual or 
audible devices such as bells and lights, but they can control other devices such as generators, heaters, 
and fans.

You can program each of the twelve input alarm contacts separately. You can program each of the sixteen 
input alarm contacts separately. Choices include:

• Alarm on Closure or Alarm on Open

• Alarm severity of any level (Critical, Major, Minor, Not Alarmed, Not Reported)

• Service Affecting or Non-Service Affecting alarm-service level

• 63-character alarm description for CTC display in the alarm log

You cannot assign the fan-tray abbreviation for the alarm; the abbreviation reflects the generic name of 
the input contacts. The alarm condition remains raised until the external input stops driving the contact 
or you provision the alarm input.

The output contacts can be provisioned to close on a trigger or to close manually. The trigger can be a 
local alarm severity threshold, a remote alarm severity, or a virtual wire:

• Local NE alarm severity: A hierarchy of Not Reported, Not Alarmed, Minor, Major, or Critical 
alarm severities that you set to cause output closure. For example, if the trigger is set to Minor, a 
Minor alarm or above is the trigger.

• Remote NE alarm severity: Same as the local NE alarm severity but applies to remote alarms only.

• Virtual wire entities: You can provision any environmental alarm input to raise a signal on any 
virtual wire on external outputs 1 through 4 when the alarm input is an event. You can provision a 
signal on any virtual wire as a trigger for an external control output.

You can also program the output alarm contacts (external controls) separately. In addition to 
provisionable triggers, you can manually force each external output contact to open or close. Manual 
operation takes precedence over any provisioned triggers that might be present.

Note For ANSI shelves, the number of inputs and outputs can be increased using the AEP. The AEP is 
connected to the shelf backplane and requires an external wire-wrap panel. 

3.9.4 Orderwire
Orderwire allows a crafts person to plug a phone set into an ONS 15454 and communicate with crafts 
people working at other ONS 15454s or other facility equipment. The orderwire is a pulse code 
modulation (PCM) encoded voice channel that uses E1 or E2 bytes in section/line overhead.
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3.9.4   Orderwire
The AIC-I allows simultaneous use of both local (section overhead signal) and express (line overhead 
channel) orderwire channels on a SONET/SDH ring or particular optics facility. Express orderwire also 
allows communication via regeneration sites when the regenerator is not a Cisco device.

You can provision orderwire functions with CTC similar to the current provisioning model for 
DCC/GCC channels. In CTC, you provision the orderwire communications network during ring turn-up 
so that all NEs on the ring can reach one another. Orderwire terminations (that is, the optics facilities 
that receive and process the orderwire channels) are provisionable. Both express and local orderwire can 
be configured as on or off on a particular SONET/SDH facility. The ONS 15454 supports up to four 
orderwire channel terminations per shelf. This allows linear, single ring, dual ring, and small 
hub-and-spoke configurations. Orderwire is not protected in ring topologies such as bidirectional line 
switched ring (BLSR), multiplex section-shared protection ring (MS-SPRing), path protection, or 
subnetwork connection protection (SNCP) ring.

Caution Do not configure orderwire loops. Orderwire loops cause feedback that disables the orderwire channel.

The ONS 15454 implementation of both local and express orderwire is broadcast in nature. The line acts 
as a party line. Anyone who picks up the orderwire channel can communicate with all other participants 
on the connected orderwire subnetwork. The local orderwire party line is separate from the express 
orderwire party line. Up to four OC-N/STM-N facilities for each local and express orderwire are 
provisionable as orderwire paths.

The AIC-I supports selective dual tone multi-frequency (DTMF) dialing for telephony connectivity, 
which causes one AIC-I card or all ONS 15454 AIC-I cards on the orderwire subnetwork to “ring.” The 
ringer/buzzer resides on the AIC-I. There is also a “ring” LED that mimics the AIC-I ringer. It flashes 
when a call is received on the orderwire subnetwork. A party line call is initiated by pressing *0000 on 
the DTMF pad. Individual dialing is initiated by pressing * and the individual four-digit number on the 
DTMF pad. 

Table 3-2 shows the pins on the orderwire connector that correspond to the tip and ring orderwire 
assignments. 

When provisioning the orderwire subnetwork, make sure that an orderwire loop does not exist. Loops 
cause oscillation and an unusable orderwire channel. 

Figure 3-9 shows the standard RJ-11 connectors used for orderwire ports.

Table 3-2 Orderwire Pin Assignments

RJ-11 Pin Number Description

1 Four-wire receive ring

2 Four-wire transmit tip

3 Two-wire ring

4 Two-wire tip

5 Four-wire transmit ring

6 Four-wire receive tip
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3.9.5   Power Monitoring
Figure 3-9 RJ-11 Connector

3.9.5 Power Monitoring
The AIC-I card provides a power monitoring circuit that monitors the supply voltage of –48 VDC for 
presence, under voltage, and over voltage. 

3.9.6 User Data Channel 
The user data channel (UDC) features a dedicated data channel of 64 kbps (F1 byte) between two nodes 
in an ONS 15454 network. Each AIC-I card provides two user data channels, UDC-A and UDC-B, 
through separate RJ-11 connectors on the front of the AIC-I card. Each UDC can be routed to an 
individual optical interface in the ONS 15454.

The UDC ports are standard RJ-11 receptacles. Table 3-3 lists the UDC pin assignments.

3.9.7 Data Communications Channel
The DCC features a dedicated data channel of 576 kbps (D4 to D12 bytes) between two nodes in an 
ONS 15454 network. Each AIC-I card provides two data communications channels, DCC-A and 
DCC-B, through separate RJ-45 connectors on the front of the AIC-I card. Each DCC can be routed to 
an individual optical interface in the ONS 15454.

The DCC ports are synchronous serial interfaces. The DCC ports are standard RJ-45 receptacles. 
Table 3-4 lists the DCC pin assignments. 

61
07

7

Pin 1 Pin 6

RJ-11

Table 3-3 UDC Pin Assignments

RJ-11 Pin Number Description

1 For future use

2 TXN

3 RXN

4 RXP

5 TXP

6 For future use
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3.9.8   Related Procedures for AIC-I Card
3.9.8 Related Procedures for AIC-I Card
The following is the list of procedures and tasks related to the configuration of the AIC-I card:

• NTP-G15 Install the Common Control Cards, page 3-35

• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G60 Create and Delete Overhead Circuits, page 17-87

• NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International 
Card

• NTP-G101 Modify Alarm Interface Controller–International Settings, page 21-119

3.10 MS-ISC-100T Card
(Cisco ONS 15454 only)

Note For hardware specifications, see the “MS-ISC-100T Card Specifications” section in the Hardware 
Specifications document.

The Multishelf Internal Switch Card (MS-ISC-100T) is an Ethernet switch used to implement the 
multishelf LAN. It connects the node controller shelf to the network and to subtending shelves. The 
MS-ISC-100T must always be equipped on the node controller shelf; it cannot be provisioned on a 
subtending controller shelf. 

The recommended configuration is to implement LAN redundancy using two MS-ISC-100T cards: one 
switch is connected to the Ethernet front panel port of the TCC2/TCC2P card in Slot 7, and the other 
switch is connected to the Ethernet front panel port of the TCC2/TCC2P card in Slot 11. The Ethernet 
configuration of the MS-ISC-100T card is part of the software package and is automatically loaded. The 
MS-ISC-100T card operates in Slots 1 to 6 and 12  to 17 on the node controller shelf; the recommended 
slots are Slot 6 and Slot 12.

Table 3-5 lists the MS-ISC-100T port assignments. 

Table 3-4 DCC Pin Assignments

RJ-45 Pin Number Description

1 TCLKP

2 TCLKN

3 TXP

4 TXN

5 RCLKP

6 RCLKN

7 RXP

8 RXN
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3.10.1   Faceplate Diagram
Caution Shielded twisted-pair cabling should be used for inter-building applications. 

3.10.1 Faceplate Diagram
Figure 3-10 shows the card faceplate.

Table 3-5 MS-ISC-100T Card Port Assignments

Port Description

DCN 1and DCN 2 Connection to the network

SSC1 to SSC7 Connection to subtending shelves

NC Connection to TCC2/TCC2P using a cross-over cable

PRT Connection to the PRT port of the redundant MS-ISC-100T
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3.10.2   MS-ISC-100T Card-Level Indicators
Figure 3-10 MS-ISC-100T Faceplate

3.10.2 MS-ISC-100T Card-Level Indicators
Table G-3 lists the card-level LEDs on the card.

3.10.3 Related Procedures for MS-ISC-100T Card
The following is the list of procedures and tasks related to the configuration of the MS-ISC-100T card:

• NTP-G15 Install the Common Control Cards, page 3-35
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3.11   Front Mount Electrical Connections
• NTP-G22 Verify Common Card Installation, page 14-5

• NTP-G144 Provision a Multishelf Node, page 14-8

• NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129

• NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node

• NTP-G147 Delete a Passive Unit, Shelf, or Rack from a Multishelf Node

3.11 Front Mount Electrical Connections
This section describes the MIC-A/P and MIC-C/T/P FMECs, which provide power, external alarm, and 
timing connections for the ONS 15454 ETSI shelf.

3.11.1 MIC-A/P FMEC

Note For hardware specifications, see the “MIC-A/P FMEC Specifications (ETSI only)” section in the 
Hardware Specifications document.

The MIC-A/P FMEC provides connection for the BATTERY B input, one of the two possible redundant 
power supply inputs. It also provides connection for eight alarm outputs (coming from the TCC2/TCC2P 
card), sixteen alarm inputs, and four configurable alarm inputs/outputs. Its position is in Slot 23 in the 
center of the subrack Electrical Facility Connection Assembly (EFCA) area. 

The MIC-A/P FMEC has the following features:

• Connection for one of the two possible redundant power supply inputs

• Connection for eight alarm outputs (coming from the TCC2/TCC2P card)

• Connection for four configurable alarm inputs/outputs 

• Connection for sixteen alarm inputs 

• Storage of manufacturing and inventory data

For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the 
ONS 15454 ETSI shelf. 

3.11.2 Faceplate and Block Diagram
Figure 3-11 shows the MIC-A/P faceplate.

Figure 3-11 MIC-A/P Faceplate 

Figure 3-12 shows a block diagram of the MIC-A/P.
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3.11.2   Faceplate and Block Diagram
Figure 3-12 MIC-A/P Block Diagram

Table 3-6 shows the alarm interface pinouts on the MIC-A/P DB-62 connector. 
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Table 3-6 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector

Pin No. Signal Name Signal Description

1 ALMCUTOFF N Alarm cutoff, normally open ACO pair

2 ALMCUTOFF P Alarm cutoff, normally open ACO pair

3 ALMINP0 N Alarm input pair 1, reports closure on connected wires

4 ALMINP0 P Alarm input pair 1, reports closure on connected wires

5 ALMINP1 N Alarm input pair 2, reports closure on connected wires

6 ALMINP1 P Alarm input pair 2, reports closure on connected wires

7 ALMINP2 N Alarm input pair 3, reports closure on connected wires

8 ALMINP2 P Alarm input pair 3, reports closure on connected wires

9 ALMINP3 N Alarm input pair 4, reports closure on connected wires

10 ALMINP3 P Alarm input pair 4, reports closure on connected wires

11 EXALM0 N External customer alarm 1

12 EXALM0 P External customer alarm 1

13 GND Ground

14 EXALM1 N External customer alarm 2

15 EXALM1 P External customer alarm 2

16 EXALM2 N External customer alarm 3

17 EXALM2 P External customer alarm 3

18 EXALM3 N External customer alarm 4

19 EXALM3 P External customer alarm 4

20 EXALM4 N External customer alarm 5

21 EXALM4 P External customer alarm 5

22 EXALM5 N External customer alarm 6

23 EXALM5 P External customer alarm 6

24 EXALM6 N External customer alarm 7

25 EXALM6 P External customer alarm 7
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3.11.2   Faceplate and Block Diagram
26 GND Ground

27 EXALM7 N External customer alarm 8

28 EXALM7 P External customer alarm 8

29 EXALM8 N External customer alarm 9

30 EXALM8 P External customer alarm 9

31 EXALM9 N External customer alarm 10

32 EXALM9 P External customer alarm 10

33 EXALM10 N External customer alarm 11

34 EXALM10 P External customer alarm 11

35 EXALM11 N External customer alarm 12

36 EXALM11 P External customer alarm 12

37 ALMOUP0 N Normally open output pair 1

38 ALMOUP0 P Normally open output pair 1

39 GND Ground

40 ALMOUP1 N Normally open output pair 2

41 ALMOUP1 P Normally open output pair 2

42 ALMOUP2 N Normally open output pair 3

43 ALMOUP2 P Normally open output pair 3

44 ALMOUP3 N Normally open output pair 4

45 ALMOUP3 P Normally open output pair 4

46 AUDALM0 N Normally open Minor audible alarm

47 AUDALM0 P Normally open Minor audible alarm

48 AUDALM1 N Normally open Major audible alarm

49 AUDALM1 P Normally open Major audible alarm

50 AUDALM2 N Normally open Critical audible alarm

51 AUDALM2 P Normally open Critical audible alarm

52 GND Ground

53 AUDALM3 N Normally open Remote audible alarm

54 AUDALM3 P Normally open Remote audible alarm

55 VISALM0 N Normally open Minor visual alarm

56 VISALM0 P Normally open Minor visual alarm

57 VISALM1 N Normally open Major visual alarm

58 VISALM1 P Normally open Major visual alarm

59 VISALM2 N Normally open Critical visual alarm

60 VISALM2 P Normally open Critical visual alarm

Table 3-6 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

Pin No. Signal Name Signal Description
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3.11.3   MIC-C/T/P FMEC
3.11.3 MIC-C/T/P FMEC 

Note For hardware specifications, see the “MIC-C/T/P FMEC Specifications (ETSI only)” section in the 
Hardware Specifications document.

The MIC-C/T/P FMEC provides connection for the BATTERY A input, one of the two possible 
redundant power supply inputs. It also provides connection for system management serial port, system 
management LAN port, modem port (for future use), and system timing inputs and outputs. Install the 
MIC-C/T/P in Slot 24. 

The MIC-C/T/P FMEC has the following features:

• Connection for one of the two possible redundant power supply inputs

• Connection for two serial ports for local craft/modem (for future use)

• Connection for one LAN port

• Connection for two system timing inputs

• Connection for two system timing outputs

• Storage of manufacturing and inventory data

For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the shelf.

3.11.4 Faceplate and Block Diagram
Figure 3-13 shows the MIC-C/T/P FMEC faceplate. 

Figure 3-13 MIC-C/T/P Faceplate 

Figure 3-14 shows a block diagram of the MIC-C/T/P.

61 VISALM3 N Normally open Remote visual alarm

62 VISALM3 P Normally open Remote visual alarm

Table 3-6 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

Pin No. Signal Name Signal Description

M
IC

-C
/T

/P

CLEI CODE BARCODE

POWER RATING

G
N

D

B
A

T
T

E
R

Y
 A

T
IM
IN

G
 A

IN
   

   
 T
IM
IN

G
 B

   
O

U
T

C
A

U
T
IO

N
TI

G
H

TE
N

 T
H

E 
FA

C
EP

LA
TE

TI
G

H
TE

N
 T

H
E 

FA
C

EP
LA

TE

SC
R

EW
S 

W
IT

H
 1

.0
 N

M
 T

O
R

Q
U

E
SC

R
EW

S 
W
IT

H
 1

.0
 N

M
 T

O
R

Q
U

E

27
13

06

LA
N

A
U

X

T
E

R
M A

C
T

LI
N

K

3-32
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html#reference_921B7DA9D0B34CDBA3A938EA3F1CC726


 

Chapter 3      Install the Control Cards
  Control Card Reset
Figure 3-14 MIC-C/T/P Block Diagram

The MIC-C/T/P FMEC has one pair of LEDs located on the RJ45 LAN connector. The green LED is on 
when a link is present, and the amber LED is on when data is being transferred. 

Control Card Reset
You can soft reset the control card by using CTC or by physically resetting the card (a hard reset). A soft 
reset reboots the control card and reloads the operating system and the application software. 
Additionally, a hard reset temporarily removes power from the control card and clears all the buffer 
memory. 

You can apply a soft reset from CTC to either an active or standby control card without affecting traffic. 
If you need to perform a hard reset on an active control card, put the control card into standby mode first 
by performing a soft reset.

Note Hard reset can also be performed on the TNC/TNCE/TSC/TSCE card through CTC and TL1 interface. 
Before performing the hard reset, bring the TNC/TNCE/TSC/TSCE card to maintenance mode.

When you reset the standby control card, the system traffic is not affected. When you reset the active 
control card, traffic switches to the standby card if the standby card is present and in the ready standby 
state. If the standby card is not in the ready standby state, traffic does not switch, and results in loss of 
system traffic and management connectivity until the card reboots completely.

Caution When you reset the TNC/TNCE/TSC/TSCE card on the ONS 15454 or 15454-M6 shelves in simplex 
control mode, loss of management connectivity happens until the card reboots. The system traffic loss 
may occur depending on the line card and traffic type. 

Note (Cisco ONS 15454 shelf) When a CTC reset is performed on an active TCC2/TCC2P/TCC3 card, the 
AIC-I card goes through an initialization process and also resets because it is controlled by the active 
TCC2/TCC2P/TCC3 card. 

Inventory Data
(EEPROM)
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Control Card Database
When dual control cards are installed in the ONS 15454, 15454-M2, or 15454-M6 shelves, each control 
card hosts a separate database; therefore, the protect card database is available if the database on the 
working control card fails. You can also store a backup version of the database on the workstation 
running CTC. This operation should be part of a regular ONS 15454, 15454-M2, or 15454-M6 
maintenance program at approximately weekly intervals, and should also be completed when preparing 
ONS 15454, 15454-M2, or 15454-M6 for a pending natural disaster, such as a flood or fire.

The TNC and TNCE cards provide 4 GB of nonvolatile database storage for communication, 
provisioning, and system control. This allows full database recovery during power failure.

The configuration details are stored in the database of the control card. The database restore from a TNC 
and TNCE cards to a TSC and TSCE cards or vice versa is not supported.

Note The following parameters are not backed up and restored: node name, IP address, mask and gateway, and 
Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up 
database with a different node name, the circuits map to the new node name. We recommend keeping a 
record of the old and new node names.

3.12 Procedures for Control Cards
The procedures described below explain how to install the control cards needed for the 
Cisco ONS 15454, Cisco ONS 15454 M2, and Cisco ONS 15454 M6 platforms.

3.12.1 Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

• NTP-G15 Install the Common Control Cards, page 3-35—Complete this procedure to install the 
control cards needed for the ONS 15454 platform.

• NTP-G313 Install and Configure the TNC, TNCE, TSC, or TSCE Card, page 3-42—Complete this 
procedure to install the control cards needed for the ONS 15454 M2 and ONS 15454 M6 platforms.
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3.12.1   Before You Begin
NTP-G15 Install the Common Control Cards

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. For detailed 
instructions on how to wear the ESD wristband, refer to the Electrostatic Discharge and Grounding 
Guide for Cisco CPT and Cisco ONS Platforms.

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 (ONS 15454 only) Complete the “DLP-G33 Install the TCC2, TCC2P, or TCC3 Card” task on page 3-36.

Note If you install the wrong card in a slot, see the NTP-G107 Remove Permanently or Remove and 
Replace DWDM Cards.

Step 2 (ONS 15454 only) Complete the “DLP-G34 Install the AIC-I Card” task on page 3-39, if necessary.

Step 3 (ONS 15454 only) Complete the “DLP-G309 Install the MS-ISC-100T Card” task on page 3-40, if 
necessary.

Stop. You have completed this procedure.

Purpose This procedure describes how to install the control cards needed for the 
ONS 15454 platform.

Tools/Equipment Redundant TCC2/TCC2P/TCC3 cards on ONS 15454 shelf (required)

AIC-I card (optional)

MS-ISC-100T (optional; for multishelf node configurations)

Prerequisite Procedures Following procedures in the 
Cisco ONS 15454 Hardware Installation Guide:

• “NTP-G7 Install the Power and Ground”

• “NTP-G14 Install DWDM Equipment”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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DLP-  G33 Install the TCC2, TCC2P, or TCC3 Card
DLP-G33 Install the TCC2, TCC2P, or TCC3 Card 

Caution Do not remove a TCC2/TCC2P/TCC3 card during the software transfer process, which is indicated by 
alternate flashing FAIL and ACT/STBY LEDs. Removing a TCC2/TCC2P/TCC3 during the software 
transfer process will corrupt the system memory. 

Note Allow each card to boot completely before installing the next card.

Step 1 Open the latches/ejectors of the first TCC2/TCC2P/TCC3 card that you will install. 

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 7 or 11). 

Note In Step 4, you will be instructed to watch the LED activity (sequence) on the front of the 
TCC2/TCC2P/TCC3 card. This activity begins immediately after you close the latches in Step 3.

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the back 
panel of the shelf. Ensure that you cannot insert the card any farther. 

If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Step 4 As needed, go to Step a to verify the LED activity on the TCC2 card. For the TCC2P go to Step b. For 
the TCC3 card go to Step c.

a. For the TCC2 card:

• All LEDs turn on briefly. The red FAIL LED and the yellow ACT/STBY LED turn on for about 
15 seconds. (For TCC3 card it takes around 20 to 25 seconds)

• The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds. 

• The red FAIL LED blinks for about 15 seconds.

• The red FAIL LED turns on for about 15 seconds. All LEDs turn on for about 3 seconds before 
turning off for about 3 seconds.

• Both green PWR LEDs turn on for 10 seconds. The PWR LEDs then turn red for 2 to 3 minutes 
before going to steady green.

Purpose This task installs redundant TCC2/TCC2P/TCC3 cards. The first card you 
install in the ONS 15454  must be a TCC2/TCC2P/TCC3 card, and it must 
initialize before you install any cross-connect or traffic cards. 
Cross-connect cards are only required in hybrid nodes.

Tools/Equipment Two TCC2/TCC2P/TCC3 cards

Prerequisite Procedures None

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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• While the PWR LEDs are red for two to three minutes, the ACT/STBY turn on.

• The boot-up process is complete when the PWR LEDs turn green and the ACT/STBY remains 
on. (The ACT/STBY LED will be green if this is the first TCC2 card installed, and amber if this 
is the second TCC2 card installed.)

Note It might take up to four minutes for the A and B power alarms to clear.

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Note If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while 
the TCC2 card initializes. The alarm should clear after the card completely boots.

Note If the FAIL LED is on continuously, see the tip in Step 8 about the TCC2 card automatic upload.

b. For the TCC2P card:

• All LEDs turn on briefly. The red FAIL LED, the yellow ACT/STBY LED, the green SYNC 
LED, and the green ACO LED turn on for about 15 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on for about 30 seconds. 

• The red FAIL LED blinks for about 3 seconds.

• The red FAIL LED turns on for about 15 seconds.

• The red FAIL LED blinks for about 10 seconds and then becomes solid.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn 
off for about 5 seconds.

• Both green PWR LEDs turn on for 10 seconds. The PWR LEDs then turn red for 2 to 3 minutes 
before going to steady green. During this time, the ACT/STBY, MJ, and MN LEDs might turn 
on, followed by the SNYC LED briefly.

• The boot-up process is complete when the PWR LEDs turn green and the yellow ACT/STBY 
remains on. (The ACT/STBY LED will be green if this is the first TCC2P card installed, and 
yellow if this is the second TCC2P card installed.)

Note It might take up to three minutes for the A and B power alarms to clear.

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Note If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while 
the TCC2P card initializes. The alarm should clear after the card completely boots.
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Note If the FAIL LED is on continuously, see the tip in Step 8 about the TCC2P card automatic 
upload.

c. For the TCC3 card:

• All LEDs turn on briefly. The red FAIL LED, the yellow ACT/STBY LED, the green SYNC 
LED, and the green ACO LED turn on for about 25 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on for about 15 seconds. 

• The red FAIL LED blinks for about 3 seconds.

• The red FAIL LED turns on for about 60 seconds.

• The red FAIL LED blinks for about 15 seconds and then becomes solid (the LED is turned on 
for about 20 seconds).

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn 
off for about 5 seconds.

• Both green PWR LEDs turn on for 10 seconds. The PWR LEDs then turn red for 2 to 3 minutes 
before going to steady green. During this time, the ACT/STBY, MJ, and MN LEDs might turn 
on, followed by the SNYC LED briefly.

• The boot-up process is complete when the PWR LEDs turn green and the yellow ACT/STBY 
remains on. (The ACT/STBY LED will be green if this is the first TCC3 card installed, and 
yellow if this is the second TCC3 card installed.)

Note It might take up to three minutes for the A and B power alarms to clear.

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Note If you are logged into CTC, the SFTWDOWN alarm might appear as many as two times while 
the TCC3 card initializes. The alarm should clear after the card completely boots.

Note If the FAIL LED is on continuously, see the tip in Step 8 about the TCC3 card automatic upload.

Step 5 Verify that the ACT/STBY LED is green if this is the first powered-up TCC2/TCC2P/TCC3 card 
installed, or yellow for standby if this is the second powered-up TCC2/TCC2P/TCC3. The IP address, 
temperature of the node, and time of day appear on the LCD. The default time and date is 12:00 AM, 
January 1, 1970. 

Step 6 The LCD cycles through the IP address (the default is 192.1.0.2), node name, and software version. 
Verify that the correct software version is shown on the LCD. The software text string indicates the node 
type (SDH or SONET) and software release. (For example: SDH 09.20-05L-20.10 indicates it is an SDH 
software load, Release 9.2. The numbers following the release number do not have any significance.) 

Step 7 If the LCD shows the correct software version, continue with Step 8. If the LCD does not show the 
correct software version, refer to your next level of technical support, upgrade the software, or remove 
the TCC2/TCC2P/TCC3 card and install a replacement card. 
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Refer to the release-specific software upgrade document to replace the software. To replace the 
TCC2/TCC2P/TCC3 card, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

Step 8 Repeat Steps 1 through 7 for the redundant TCC2/TCC2P/TCC3 card. If both TCC2/TCC2P/TCC3 cards 
are already installed, proceed to Step 9. 

Tip If you install a standby TCC2/TCC2P/TCC3 card that has a different software version than the 
active TCC2/TCC2P/TCC3 card, the newly installed standby TCC2/TCC2P/TCC3 card 
automatically copies the software version from the active TCC2/TCC2P/TCC3 card. You do not 
need to do anything in this situation. However, the loading TCC2/TCC2P/TCC3 card does not 
boot up in the normal manner. When the standby card is first inserted, the LEDs follow most of 
the normal boot-up sequence. However, after the red FAIL LED turns on for about 5 seconds, 
the FAIL LED and the ACT/STBY LED begin to flash alternately for up to 30 minutes while the 
new software loads onto the active TCC2/TCC2P/TCC3 card. After loading the new software, 
the upgraded TCC2/TCC2P/TCC3 card’s LEDs repeat the appropriate bootup sequence, and the 
amber ACT/STBY LED turns on.

Note If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view the 
Alarms tab.

Step 9 Return to your originating procedure (NTP).

DLP-G34 Install the AIC-I Card

Note When installing cards, allow each card to boot completely before installing the next card.

Step 1 Open the latches/ejectors on the card.

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails in Slot 9 until the card plugs into 
the receptacle at the back of the slot. 

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Purpose This task installs the AIC-I card. The AIC-I card provides connections for 
external alarms and controls (environmental alarms). 

Tools/Equipment AIC-I card

Prerequisite Procedures DLP-G33 Install the TCC2, TCC2P, or TCC3 Card, page 3-36

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 4 Verify the following:

• The red FAIL LED blinks for up to 10 seconds.

Note If the red FAIL LED does not turn on, check the power. 

• The PWR A and PWR B LEDs become red, the two INPUT/OUTPUT LEDs become amber, and the 
ACT LED turns green for approximately 5 seconds.

• The PWR A and PWR B LEDs turn green, the INPUT/OUTPUT LEDs turn off, and the green ACT 
LED remains on.

Note It might take up to 3 minutes for the PWR A and PWR B LEDs to update.

Note If you insert a card into a slot provisioned for a different card, no LEDs turn on. 

Note If the red FAIL LED is on continuously or the LEDs act erratically, the card is not installed 
properly. Remove the card and repeat Steps 1 to 4. 

Step 5 Return to your originating procedure (NTP).

DLP-G309 Install the MS-ISC-100T Card 

Note When installing cards, allow each card to boot completely before installing the next card.

Purpose This task installs redundant MS-ISC-100T cards. The MS-ISC-100T card 
is required for a multishelf node configuration. It provides LAN 
redundancy on the node controller shelf. An alternative to using the 
MS-ISC-100T card is the Cisco Catalyst 2950, although Cisco recommends 
using the MS-ISC-100T. For more information on the Catalyst 2950 
installation, refer to the Catalyst 2950 product documentation.

Tools/Equipment MS-ISC-100T card (2)

Prerequisite Procedures DLP-G33 Install the TCC2, TCC2P, or TCC3 Card, page 3-36

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note The MS-ISC-100T is not supported in a subtended shelf. 

Step 1 Open the latches/ejectors on the card.

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails into the appropriate slot in the node 
controller shelf until the card plugs into the receptacle at the back of the slot. The card can be installed 
in any slot from Slot 1 to 6 or 12 to 17. Cisco recommends that you install the MS-ISC-100T cards in 
Slot 6 and Slot 12.

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 4 Verify the LED activity:

• The red FAIL LED blinks for 35 to 45 seconds.

• The red FAIL LED turns on for 15 to 20 seconds. 

• The red FAIL LED blinks for approximately 3 minutes.

• The red FAIL LED turns on for approximately 6 minutes.

• The green ACT or ACT/STBY LED turns on. The SF LED can persist until all card ports connect 
to their far end counterparts and a signal is present.

Note If the red FAIL LED does not turn on, check the power. 

Note If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Step 5 Repeat Steps 1 through 4 for the redundant MS-ISC-100T card.

Step 6 Return to your originating procedure (NTP).
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NTP-G313 Install and Configure the TNC, TNCE, TSC, or TSCE 
Card

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Caution Always use the supplied ESD wristband when working with a powered ONS 15454 M2 and ONS 15454 
M6 shelf assemblies. For detailed instructions on how to wear the ESD wristband, refer to the 
Electrostatic Discharge and Grounding Guide for Cisco CPT and Cisco ONS Platforms.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Complete the “DLP-G604 Install the TNC, TNCE, TSC, or TSCE Card” task on page 3-43.

Note If you install the wrong card in a slot, see the NTP-G107 Remove Permanently or Remove and 
Replace DWDM Cards.

Step 2 Complete the “DLP-G605 Provision PPM and Port for the TNC and TNCE Cards” task on page 3-46.

Step 3 Complete the “DLP-G606 Configure UDC and VoIP for the TNC and TNCE Cards” task on page 3-46.

Step 4 Complete the “DLP-G774 Change the Frame Type on the OSC” task on page 3-47

Stop. You have completed this procedure.

Purpose This procedure describes how to install and configure the TNC, TNCE, 
TSC, or TSCE card. TNC, TNCE, TSC, and TSCE cards are the control 
cards needed for the ONS 15454 M2 and ONS 15454 M6 platforms.

Tools/Equipment Redundant TNC/TNCE/TSC/TSCE cards on ONS 15454 M6 shelf 
(required)

Stand-alone TNC/TNCE/TSC/TSCE card on ONS 15454 M2 shelf 
(required)

Prerequisite Procedures Following procedures in the 
Cisco ONS 15454 Hardware Installation Guide:

• “NTP-G271 Install the Power and Ground to the ONS 15454 M2 
Shelf”

• “NTP-G14 Install DWDM Equipment”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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DLP-G604 Install the TNC, TNCE, TSC, or TSCE Card

Note The ONS 15454 M2 shelf supports stand-alone control cards such as TNC, TSC, TNCE, or TSCE. 
During replacement or removal of the control card, ensure that the optical fibers are not disturbed. The 
fibers must be correctly routed in the retention feature mounted on the front side of the shelf.

Caution Do not remove the TNC/TNCE/TSC/TSCE cards during the software installation process, which is 
indicated by alternate flashing FAIL and ACT/STBY LEDs. Removing the TNC/TNCE/TSC/TSCE 
cards during the software installation process will corrupt the system memory. 

Note Allow each TNC/TNCE/TSC/TSCE card to boot completely before installing the redundant 
TNC/TNCE/TSC/TSCE card.

Note On the ONS 15454 M6 shelf, install the TNC/TNCE/TSC/TSCE cards in slots 1 and 8 for redundancy. 
On the ONS 15454 M2 shelf, install the stand-alone TNC/TNCE/TSC/TSCE card in slot 1. For more 
information, see the “Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation 
Guide.

Note You cannot insert the TNC/TNCE/TSC/TSCE cards in other slots due to mechanical constraints. To 
identify the card slot, match the symbol placed on the lower side of the card front panel with the symbol 
in the shelf.

Caution To achieve redundancy, two TNC and TNCE cards or two TSC and TSCE cards must be installed in the 
ONS 15454 M6 shelf. Do not install one TNC or TNCE card and a redundant TSC or TSCE card in the 
same shelf.

Purpose (ONS 15454 M2 and ONS 15454 M6 only) This task installs redundant 
TNC/TNCE/TSC/TSCE cards on the ONS 15454 M6 shelf and a 
stand-alone TNC/TNCE/TSC/TSCE card on the ONS 15454 M2 shelf. 
Install and initialize the TNC/TNCE/TSC/TSCE card before installing any 
other line cards into the shelf assemblies. On the ONS 15454 M6 shelf, 
install the TNC/TNCE/TSC/TSCE cards in slots 1 and 8 for redundancy. 
On the ONS 15454 M2 shelf, install the stand-alone 
TNC/TNCE/TSC/TSCE card in slot 1.

Tools/Equipment Two TNC/TNCE/TSC/TSCE cards for the ONS 15454 M6 shelf and one 
TNC/TNCE/TSC/TSCE card for the ONS 15454 M2 shelf

Prerequisite Procedures None

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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DLP-  G604 Install the TNC, TNCE, TSC, or TSCE Card
Step 1 Open the latches/ejectors of the first TNC/TNCE/TSC/TSCE card that you will install. 

Step 2 Use the latches/ejectors to firmly slide the card horizontally along the guide rails until the card plugs 
into the receptacle at the back of the slot (slot 1 or 8 in the ONS 15454 M6 shelf and slot 1 in the ONS 
15454 M2 shelf).

Step 3 Verify that the card is inserted correctly, and close the latches/ejectors on the card.

If you insert a card into a slot assigned for a different card, all LEDs turn off. 

Step 4 As needed, verify the LED activity on the TNC/TNCE/TSC/TSCE card.

• The red FAIL LED, PWR LED turn on briefly.

• The red FAIL LED turns on for about 10 seconds.

• The red FAIL LED and the amber ACT/STBY LED turn on for about 30 seconds.

• The red FAIL LED blinks for about 10 seconds.

• The red FAIL LED turns on for about 15 seconds.

• All the LEDs including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs blink once and 
turn off for about 10 seconds.

• ACT/STBY LED blinks for about 1 second.

• All the LEDs including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs turn off for about 
10 seconds.

• The ACT/STBY, ACO, and PWR LEDs turn on.

• The boot-up process is complete when the PWR LEDs turn green and the amber ACT/STBY 
remains on. The ACT/STBY LED turns green if this is the first TNC/TNCE/TSC/TSCE card 
installed, and amber if this is the second TNC/TNCE/TSC/TSCE card installed.

Note It might take up to four minutes for the power alarms to clear.

Note Alarm LEDs might be on. After completing the TNC/TNCE/TSC/TSCE card installation, log in 
to CTC and click the Alarms tab to display the alarms raised on the card. For procedure to clear 
the alarm, see the Cisco ONS DWDM Troubleshooting Guide.

Note During the TNC/TNCE/TSC/TSCE card initialization, the SFTWDOWN alarm appears twice. 
The alarm clears after the TNC/TNCE/TSC/TSCE card boots completely.

Note If the FAIL LED is on continuously, see the tip in Step 8 about the TNC/TNCE/TSC/TSCE card 
automatic upload.

Figure 3-15 illustrates the installation of TNC and TNCE cards on ONS 15454 M6 shelf.
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DLP-  G604 Install the TNC, TNCE, TSC, or TSCE Card
Figure 3-15 Installing TNC and TNCE Cards on ONS 15454 M6 Shelf

Step 5 Verify that the ACT/STBY LED is green if this is the first powered-up TNC/TNCE/TSC/TSCE card 
installed or amber if this is the second powered-up TNC/TNCE/TSC/TSCE. The IP address, temperature 
of the node, and time of day appear on the LCD. The default time and date is 12:00 AM, January 1, 1970.

Step 6 The LCD cycles through the IP address (the default is 192.1.0.2), node name, and software version. 
Verify that the correct software version is shown on the LCD. The software text string indicates the node 
type (SDH or SONET) and software release. (For example: SDH 09.20-05L-20.10 indicates it is an SDH 
software load, Release 9.2. The numbers following the release number do not have any significance.) 

Step 7 If the LCD shows the correct software version, continue with Step 8. If the LCD does not show the 
correct software version, refer to your next level of technical support, upgrade the software, or remove 
the TNC/TNCE/TSC/TSCE card and install a replacement card. Refer to the release-specific software 
upgrade document to replace the software.

Step 8 (ONS 15454 M6 shelf only) Repeat Steps 1 through 7 for the redundant TNC/TNCE/TSC/TSCE card. 

Tip If you install a standby TNC/TNCE/TSC/TSCE card that has a different software version than 
the active TNC/TNCE/TSC/TSCE card, the standby TNC/TNCE/TSC/TSCE card copies the 
software version from the active TNC/TNCE/TSC/TSCE card. When the standby card is first 
inserted, the LEDs follow the normal boot-up sequence. However, after the red FAIL LED turns 
on for about 5 seconds, the FAIL LED and the ACT/STBY LED begin to flash alternately for up 
to 30 minutes. After loading the new software, the upgraded TNC/TNCE/TSC/TSCE cards 
LEDs repeat the appropriate bootup sequence, and the amber ACT/STBY LED turns on.

Step 9 Return to your originating procedure (NTP).

27
91

19

1 2

TNC card

Guide rail
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DLP-  G605 Provision PPM and Port for the TNC and TNCE Cards
DLP-G605 Provision PPM and Port for the TNC and TNCE Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TNC and TNCE cards 
where you want to provision PPM and port settings. 

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.

Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose 1 or 2 from the PPM drop-down list.

• PPM Type—Displays the PPM associated with the chosen PPM in the above step.

Step 5 Click OK. The newly created PPM appears in the Pluggable Port Modules area. The row in the Pluggable 
Port Modules area becomes white when the PPM is inserted and the Actual Equipment Type column lists 
the name of PPM.

Step 6 In the Pluggable Ports area, click Create. The Create Port dialog box appears.

Step 7 In the Create Ports dialog box, complete the following:

• Port—Choose the port you want to configure from the Port drop-down list.

• Port Type—Choose the port type, such as OC-3, FE, or ONE-GE from the Port Type drop-down list.

Note OC-3 can be configured only on PPM port 1. FE and ONE-GE can be configured on both the ports. If 
the port type is FE, then disable ALS before provisioning OSC on that port.

Step 8 Click OK. The newly created port appears in the Pluggable Ports area. The port type you provisioned is 
listed in the Rate column.

Step 9 Repeat Steps 3 through 8 to provision another PPM and port on the TNC and TNCE cards.

Step 10 Return to your originating procedure (NTP).

DLP-G606 Configure UDC and VoIP for the TNC and TNCE Cards

Purpose (ONS 15454 M2 and ONS 15454 M6 only) This task provisions a PPM and 
port on TNC and TNCE cards. PPMs are created to support the OSC 
function.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None

Purpose (ONS 15454 M2 and ONS 15454 M6 only) This task configures UDC and 
VoIP traffic for the TNC and TNCE cards.

Tools/Equipment None
3-46
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 3      Install the Control Cards
DLP-  G774 Change the Frame Type on the OSC
Note Each TNC and TNCE cards support UDC/VoIP configuration. You can configure UDC or VoIP on the 
two SFP ports present on the TNC and TNCE cards. The TNC and TNCE cards support the UDC/VoIP 
configuration only when OSC is provisioned on the SFP ports.

Note If two nodes are connected through the fiber and if the TNC and TNCE cards in one node has UDC 
configuration, the TNC and TNCE cards in the other node must also have UDC configuration. The same 
rule applies to VoIP configuration.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TNC and TNCE cards 
where you want to configure UDC and VoIP. 

Step 2 Click the Provisioning > UDC / VOIP tabs. 

Step 3 From the Service Type drop-drop list, choose UDC or VOIP.

Note You can configure UDC or VoIP on only one SFP port at a time per TNC or TNCE card. If you want to 
configure UDC or VoIP on the second SFP port, choose NONE from the Service Type drop-down list for 
the first port and then choose UDC or VoIP for the second port.

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-G774 Change the Frame Type on the OSC

Step 1 Delete the OC-3, STM1, FE, or ONE_GE OSC communication channel. See DLP-G186 Delete an OSC 
Termination.

Step 2 Click the Provisioning > WDM-ANS > Internal Patchcords tabs. 

Step 3 Choose the internal patchcord that is associated with OSC and click Delete.

Prerequisite Procedures DLP-G46 Log into CTC

NTP-G38 Provision OSC Terminations, page 14-124

DLP-G605 Provision PPM and Port for the TNC and TNCE Cards, 
page 3-46

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None

Purpose This task changes the frame type on the OSC.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None
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Step 4 Delete the OSC payload on the TNC/TNCE card.

a. In node view (single-shelf mode) or shelf view (multishelf view), double-click the TNC/TNCE card 
where you want to delete the OSC payload.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. In the Pluggable Ports area, choose the OSC payload that you want to delete and click Delete.

Step 5 Provision the OSC payload on the TNC/TNCE card. See “DLP-G605 Provision PPM and Port for the 
TNC and TNCE Cards” procedure on page 3-46.

Note OC-3/STM1 can be configured only on port 1. FE and ONE-GE can be configured on both the 
ports.

Step 6 Provision the internal patchcord from the OSC on the TNC card to the corresponding line card. See 
Virtual Patchcords.

Step 7 Provision the OSC communication channel. See NTP-G38 Provision OSC Terminations.

Step 8 Repeat the above steps for the other node.

Step 9 Return to your originating procedure (NTP).

NTP-G278 Upgrade the TSC Card to the TNC Card

Note Downgrade procedures from TNC or TNCE cards to TSC or TSCE cards are not supported. Log into the 
Technical Support Website at http://www.cisco.com/cisco/web/support/index.html for more information 
or call Cisco TAC (1 800 553-2447).

Step 1 Verify that the node you are upgrading has 9.6.x installed. The software version is displayed in the upper 
left corner of the window.

Step 2 Back up the database before beginning the upgrade.

Step 3 Physically replace the standby TSC card with a TNC card.

a. Check the LED on the faceplate. The ACT/STBY LED on the faceplate of the TNC/TSC card 
indicates whether the card is in active or standby mode. A green ACT/STBY LED indicates an active 
card and an amber light indicates a standby card.

b. Open the ejectors on the standby TSC card.

Purpose This procedure upgrades the TSC card to the TNC card on the Cisco ONS 
15454 M6 shelf. This procedure also applies to TSC to TNCE, TSCE to 
TNCE, TNC to TNCE, and TSC to TSCE upgrades.

Tools/Equipment Two TNC cards

Prerequisite Procedures DLP-G46 Log into CTC 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Maintenance or higher
3-48
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/c/en/us/td/docs/optical/15000r9_6/dwdm/configuration/guide/454d96_configuration/454d96_optcircuit.html#pgfId-396621
http://www.cisco.com/c/en/us/td/docs/optical/15000r9_6/dwdm/configuration/guide/454d96_configuration/454d96_turnupnode.html#wp557090
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/cisco/web/support/index.html


 

Chapter 3      Install the Control Cards
  NTP-G278 Upgrade the TSC Card to the TNC Card
c. Slide the card out of the slot. This raises the IMPROPRMVL alarm, which clears when the upgrade 
is complete.

d. Right-click the slot from which the TSC card was ejected out.

e. Click Delete Card to delete TSC from CTC.

Note If the TSC card is not deleted from the CTC shelf view before inserting the TNC card, the MEA 
(card mismatch) alarm appears on that slot.

f. Open the ejectors on the TNC card to be installed.

g. Slide the TNC card into the slot along the guide rails.

h. Close the ejectors.

i. In CTC node view, Ldg (loading) appears on the newly installed TNC card.

Note It takes approximately 10 minutes for the active TSC card to copy the system software and 
database to the newly installed TNC card. During this operation, the LEDs on the TNC card flash 
Fail and then the active/standby LED flashes. When the transfer completes, the TNC card 
reboots and goes into standby mode after approximately three minutes. Do not remove the card 
from the shelf during a database transfer.

Caution If your active TSC card resets during the upgrade before the new TNC card is in full standby mode, 
remove the new TNC card immediately.

Step 4 When the newly installed TNC card is in standby, right-click active TSC card in CTC.

Step 5 From the pull-down menu, click Reset Card.

Wait for the TSC card to reboot. The standby TNC card is switched to active mode. The TSC card 
verifies that it has the same database as the TNC card and then switches to standby.

Step 6 Verify that the remaining TSC card is now in standby mode (the ACT/STBY LED changes to amber).

Step 7 Physically replace the remaining TSC card with the second TNC card.

a. Open the ejectors on the TSC card.

b. Slide the card out of the slot. This raises the IMPROPRMVL alarm, which clears when the upgrade 
is complete.

c. Right-click the slot from which the TSC card was ejected out.

d. Click Delete Card to delete TSC from CTC.

If the TSC card is not deleted from the CTC shelf view before inserting the TNC card, the MEA 
(card mismatch) alarm appears on that slot.

e. Open the ejectors on the TNC card.

f. Slide the TNC card into the slot along the guide rails.

g. Close the ejectors.

The second TNC card boots up. The second TNC card must also copy the database. Do not remove 
the card from the shelf during a database transfer.
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  NTP-G278 Upgrade the TSC Card to the TNC Card
Step 8 If power-related alarms occur after the second TNC card is installed, check the voltage on the RJ-45 
LAN port. Refer to the troubleshooting guide for information on clearing the alarms.

Stop. You have completed this procedure.
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Setup Optical Service Channel Cards

This chapter describes the optical service channel (OSC) cards for Cisco ONS 15454 dense wavelength 
division multiplexing (DWDM) networks. For card safety and compliance information, refer to the 
Regulatory Compliance and Safety Information for Cisco CPT and Cisco ONS Platforms document.

Note Unless noted otherwise, the cards described in this chapter are supported on the Cisco ONS 15454, Cisco 
ONS 15454 M6, Cisco ONS 15454 M2 platforms. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 4.1 Card Overview, page 4-1

• 4.2 Class 1 Laser Safety Labels, page 4-3

• 4.3 OSCM Card, page 4-3

• 4.3.3 Related Procedures for the OSCM Card, page 4-5

• 4.4 OSC-CSM Card, page 4-6

• 4.4.3 Related Procedures for the OSC-CSM Card, page 4-11

4.1 Card Overview
This section provides card summary and compatibility information. 

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. For a list of slots and symbols, see 
the “Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation Guide. 

An optical service channel (OSC) is a bidirectional channel connecting two adjacent nodes in a DWDM 
ring. For every DWDM node (except terminal nodes), two different OSC terminations are present, one 
for the west side and another for the east side. The channel transports OSC overhead that is used to 
manage ONS 15454 DWDM networks. An OSC signal uses the 1510-nm wavelength and does not affect 
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4.1.1   Card Summary
client traffic. The primary purpose of this channel is to carry clock synchronization and orderwire 
channel communications for the DWDM network. It also provides transparent links between each node 
in the network. The OSC is an OC-3/STM-1 formatted signal. 

There are two versions of the OSC modules: the OSCM, and the OSC-CSM, which contains the OSC 
wavelength combiner and separator component in addition to the OSC module.

The Mesh/Multiring Upgrade (MMU) card is used to optically bypass a given wavelength from one 
section of the network or ring to another one without requiring 3R regeneration.

Note On 15454-M2 and 15454-M6 shelves, the TNC and TNCE cards include the functions of the OSCM 
card. OSC can be created on the OC3 port (SFP-0) of the TNC and TNCE cards.

The TNC and TNCE cards support two optical service channels (OSC): primary OSC and secondary 
OSC.

The primary optical service channel (SFP-0) supports the following interfaces: 

• OC-3/STM-1

• Fast Ethernet (FE) 

• Gigabit Ethernet (GE). 

The secondary optical service channel (SFP-1) supports the following interfaces:

• Fast Ethernet (FE) 

• Gigabit Ethernet (GE).

4.1.1 Card Summary
Table 4-1 lists and summarizes the functions of each card.

4.1.2 Card Compatibility
Table 4-2 lists the CTC software compatibility for the OSC and OSCM cards.

Table 4-1 OSCM, and OSC-CSM Card Summary

Card Port Description For Additional Information

OSCM The OSCM has one set of optical ports and one 
Ethernet port located on the faceplate. It 
operates in Slots 8 and 10.

See the “4.3 OSCM Card” 
section on page 4-3.

OSC-CSM The OSC-CSM has three sets of optical ports 
and one Ethernet port located on the faceplate. 
It operates in Slots 1 to 6 and 12 to 17.

See the “4.4 OSC-CSM Card” 
section on page 4-6.

Table 4-2 Software Release Compatibility for Optical Service Channel Cards

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1 R9.3 R9.4 R9.6.x

OSCM Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

OSC-CSM Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
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4.2   Class 1 Laser Safety Labels
4.2 Class 1 Laser Safety Labels
For information about safety labels, see the “G.1 Safety Labels” section on page G-1.

4.3 OSCM Card
(Cisco ONS 15454 only)

Note For OSCM card specifications, see the OSCM Card Specifications document.

Note On 15454-M2 and 15454-M6 shelves, the TNC and TNCE cards include the functions of the OSCM 
card.

The OSCM card is used in amplified nodes that include the OPT-BST, OPT-BST-E, or OPT-BST-L 
booster amplifier. The OPT-BST, OPT-BST-E, and OPT-BST-L cards include the required OSC 
wavelength combiner and separator component. The OSCM cannot be used in nodes where you use 
OC-N/STM-N cards, electrical cards, or cross-connect cards. The OSCM uses Slots 8 and 10, which are 
also cross-connect card slots. 

The OSCM supports the following features:

• OC-3/STM-1 formatted OSC

• Supervisory data channel (SDC) forwarded to the TCC2/TCC2P/TCC3 cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT far-end (FE) User Channel (UC)

• Monitoring functions such as orderwire support and optical safety

The OC-3/STM-1 section data communications channel (SDCC or RS-DCC) overhead bytes are used 
for network communications. An optical transceiver terminates the OC-3/STM-1, then it is regenerated 
and converted into an electrical signal. The SDCC or RS-DCC bytes are forwarded to the active and 
standby TCC2/TCC2P/TCC3 cards for processing through the system communication link (SCL) bus on 
the backplane. Orderwire bytes (E1, E2, F1) are also forwarded via the SCL bus to the 
TCC2/TCC2P/TCC3 for forwarding to the AIC-I card.

The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UC. The frame is sent to a 
packet-over-SONET/SDH (POS) processing block that extracts the Ethernet packets and makes them 
available at the RJ-45 connector.

The OSCM distributes the reference clock information by removing it from the incoming OC-3/STM-1 
signal and then sending it to the DWDM cards. The DWDM cards then forward the clock information to 
the active and standby TCC2/TCC2P/TCC3 cards.
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4.3.1   Faceplate and Block Diagram
4.3.1 Faceplate and Block Diagram
Figure 4-1 shows the OSCM card faceplate and block diagram.

Figure 4-1 OSCM Card Faceplate 

For information on safety labels for the card, see the “4.2 Class 1 Laser Safety Labels” section on 
page 4-3.

Figure 4-2 shows the block diagram of the variable optical attenuator (VOA) within the OSCM.

The OSCM has one OC-3/STM-1 optical port located on the faceplate. One long-reach OSC transmits 
and receives the OSC to and from another DWDM node. Both DCN data and FE payload are carried on 
this link.
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4.3.2   OSCM Card Functions
Figure 4-2 OSCM VOA Optical Module Functional Block Diagram

4.3.2 OSCM Card Functions
The functions of the OSCM card are:

• 4.3.2.1 OSCM Card Power Monitoring

• Card level indicators—Table G-5 on page G-10

• G.4 Port-Level Indicators, page G-10

4.3.2.1 OSCM Card Power Monitoring

Physical photodiode P1 monitors the power for the OSCM card. The returned power level value is 
calibrated to the OSC TX port (Table 4-3).

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

4.3.3 Related Procedures for the OSCM Card
The following is the list of procedures and tasks related to the configuration of the OSCM card:

• NTP-G39 Verify OSCM Transmit Power, page 14-126

• NTP-G45 Perform the C-Band and L-Band Line Amplifier Node with OSCM Cards Acceptance 
Test, page 15-75

• NTP-G47 Perform the C-Band Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance 
Test, page 15-87

P1

P1

OSC TX

Physical photodiode

OSC Variable optical attenuator

Control
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OSC RX

Control
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12
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68

Table 4-3 OSCM VOA Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Output OSC OSC TX
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4.4   OSC-CSM Card
• NTP-G157 Perform the L-Band Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance 
Test, page 15-91

• NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards, 
page 15-95

• DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards, page 15-105

• DLP-G139 View PM Parameters for OSCM and OSC-CSM cards

• NTP-G90 Modify OSCM and OSC-CSM Card Line Settings and PM Thresholds, page 21-2

4.4 OSC-CSM Card

Note For OSC-CSM card specifications, see the OSC-CSM Card Specifications document.

The OSC-CSM card is used in unamplified nodes. This means that the booster amplifier with the OSC 
wavelength combiner and separator is not required for OSC-CSM operation. The OSC-CSM can be 
installed in Slots 1 to 6 and 12 to 17. To operate in hybrid mode, the OSC-CSM cards must be 
accompanied by cross-connect cards. The cross-connect cards enable functionality on the OC-N/STM-N 
cards and electrical cards.

The OSC-CSM supports the following features:

• Optical combiner and separator module for multiplexing and demultiplexing the optical service 
channel to or from the wavelength division multiplexing (WDM) signal

• OC-3/STM-1 formatted OSC

• SDC forwarded to the TCC2/TCC2P/TCC3 cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT FE UC

• Monitoring functions such as orderwire support

• Optical safety: Signal loss detection and alarming, fast transmitted power shut down by means of an 
optical 1x1 switch

• Optical safety remote interlock (OSRI), a feature capable of shutting down the optical output power

• Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut. For details on 
ALS provisioning for the card, see the DLP-G203 Change the OSCM and OSC-CSM ALS 
Maintenance Settings, page 21-12. For information on using the card to implement ALS in a 
network, see the “13.11 Network Optical Safety” section on page 13-30.

The WDM signal coming from the line is passed through the OSC combiner and separator, where the 
OSC signal is extracted from the WDM signal. The WDM signal is sent along with the remaining 
channels to the COM port (label on the front panel) for routing to the OADM or amplifier units, while 
the OSC signal is sent to an optical transceiver.

The OSC is an OC-3/STM-1 formatted signal. The OC-3/STM-1 SDCC or RS-DCC overhead bytes are 
used for network communications. An optical transceiver terminates the OC-3/STM-1, and then it is 
regenerated and converted into an electrical signal. The SDCC or RS-DCC bytes are forwarded to the 
active and standby TCC2/TCC2P/TCC3 cards for processing via the SCL bus on the backplane. 
Orderwire bytes (E1, E2, F1) are also forwarded via the SCL bus to the TCC2/TCC2P/TCC3 for 
forwarding to the AIC-I card.
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4.4   OSC-CSM Card
The payload portion of the OC-3/STM-1 is used to carry the fast Ethernet UC. The frame is sent to a 
POS processing block that extracts the Ethernet packets and makes them available at the RJ-45 front 
panel connector.

The OSC-CSM distributes the reference clock information by removing it from the incoming 
OC-3/STM-1 signal and then sending it to the active and standby TCC2/TCC2P/TCC3 cards. The clock 
distribution is different from the OSCM card because the OSC-CSM does not use Slot 8 or 10 
(cross-connect card slots). 

Note S1 and S2 (Figure 4-5 on page 4-10) are optical splitters with a splitter ratio of 2:98. The result is that 
the power at the MON TX port is about 17 dB lower than the relevant power at the COM RX port, and 
the power at the MON RX port is about 20 dB lower than the power at the COM TX port. The difference 
is due to the presence of a tap coupler for the P1 photodiode.
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4.4.1   Faceplate and Block Diagram
4.4.1 Faceplate and Block Diagram
Figure 4-3 shows the OSC-CSM faceplate.

Figure 4-3 OSC-CSM Faceplate 

For information on safety labels for the card, see the “4.2 Class 1 Laser Safety Labels” section on 
page 4-3. 

The OSC-CSM has a OC3 port and three other sets of ports located on the faceplate.

Figure 4-4 shows a block diagram of the OSC-CSM card.
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4.4.1   Faceplate and Block Diagram
Figure 4-4 OSC-CSM Block Diagram
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4.4.2   OSC-CSM Card Functions
Figure 4-5 shows the OSC-CSM optical module functional block diagram.

Figure 4-5 OSC-CSM Optical Module Functional Block Diagram

4.4.2 OSC-CSM Card Functions
The functions of the OSC-CSM card are: 

• 4.4.2.1 OSC-CSM Card Power Monitoring

• G.33 Alarms and Thresholds, page G-29

• Card level indicators—Table G-5 on page G-10

• G.4 Port-Level Indicators, page G-10

4.4.2.1 OSC-CSM Card Power Monitoring

Physical photodiodes P1, P2, P3, and P5 monitor the power for the OSC-CSM card. Their function is as 
follows:
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4.4.3   Related Procedures for the OSC-CSM Card
• P1: The returned power value is calibrated to the LINE RX port, including the insertion loss of the 
previous filter (the reading of this power dynamic range has been brought backward towards the 
LINE RX output). 

• P2: The returned value is calibrated to the LINE RX port.

• P3: The returned value is calibrated to the COM RX port.

• P5: The returned value is calibrated to the OSC TX port, including the insertion loss of the 
subsequent filter.

The returned power level values are calibrated to the ports as shown in Table 4-4.

The OSC power on the LINE TX is the same as the power reported from P5.

The PM parameters for the power values are listed in the Optics and 8b10b PM Parameter Definitions 
document.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

4.4.3 Related Procedures for the OSC-CSM Card
The following is the list of procedures and tasks related to the configuration of the OSC-CSM card:

• NTP-G46 Perform the C-Band Line Amplifier Node with OSC-CSM Cards Acceptance Test, 
page 15-79

• NTP-G156 Perform the L-Band Line Amplifier Node with OSC-CSM Cards Acceptance Test, 
page 15-83

• NTP-G47 Perform the C-Band Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance 
Test, page 15-87

• NTP-G157 Perform the L-Band Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance 
Test, page 15-91

• NTP-G49 Perform the Active OADM Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards, page 15-107

• NTP-G50 Perform the Passive OADM Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards, page 15-113

• DLP-G139 View PM Parameters for OSCM and OSC-CSM cards

• NTP-G90 Modify OSCM and OSC-CSM Card Line Settings and PM Thresholds, page 21-2

Table 4-4 OSC-CSM Port Calibration

Photodiode CTC Type Name Calibrated to Port Power PM Parameters

P1 Input Line LINE RX Channel Power Supported

OSC Power

P2 Input Line LINE RX OSC Power Supported

P3 Input Com COM RX Channel Power Supported

P5 Output OSC OSC TX OSC Power Supported
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C H A P T E R 5

Provision Optical Amplifier Cards

This chapter describes the optical amplifier cards used in Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) networks and related procedures. 

For card safety and compliance information, refer to the Regulatory Compliance and Safety Information 
for Cisco CPT and Cisco ONS Platforms document.

Note The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, 
Cisco ONS 15454 M2 platforms, unless noted otherwise.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to 
the 15454-M-RAMAN-COP card.

Chapter topics include the nine types of ONS 15454 DWDM amplifiers:

• 5.1 Card Overview, page 5-2

• 5.2 Class 1M Laser Safety Labels, page 5-6

• 5.3 OPT-PRE Amplifier Card, page 5-7

• 5.3.3 Related Procedures for OPT-PRE Card, page 5-10

• 5.4 OPT-BST and OPT-BST-E Amplifier Card, page 5-10

• 5.4.3 Related Procedures for OPT-BST and OPT-BST-E Cards, page 5-14

• 5.5 OPT-BST-L Amplifier Card, page 5-14

• 5.5.3 Related Procedures for OPT-BST-L Card, page 5-18

• 5.6 OPT-AMP-L Card, page 5-19

• 5.6.3 Related Procedures for OPT-AMP-L Card, page 5-23

• 5.7 OPT-AMP-17-C Card, page 5-24

• 5.7.3 Related Procedures for OPT-AMP-17-C Card, page 5-28

• 5.8 OPT-AMP-C Card, page 5-29

• 5.8.3 Related Procedures for OPT-AMP-C Card, page 5-33
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5.1   Card Overview
• 5.9 OPT-RAMP-C and OPT-RAMP-CE Cards, page 5-33

• 5.9.3 Related Procedures for OPT-RAMP-C and OPT-RAMP-CE Cards, page 5-38

• 5.10 RAMAN-CTP and RAMAN-COP Cards, page 5-38

• 5.10.4 Related Procedures for RAMAN-CTP and RAMAN-COP Cards, page 5-43

• 5.11 OPT-EDFA-17 and OPT-EDFA-24 Cards, page 5-44

• 5.11.4 Related Procedures for OPT-EDFA-17 and OPT-EDFA-24 Cards, page 5-48

5.1 Card Overview
This section provides summary and compatibility information for the optical amplifier cards. 

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
Cards should be installed in slots that have the same symbols. See the Cisco ONS 15454 Hardware 
Installation Guide for a list of slots and symbols. 

Optical amplifier card architecture includes an optical plug-in module with a controller that manages 
optical power, laser current, and temperature control loops. An amplifier also manages communication 
with the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card and operation, administration, maintenance, 
and provisioning (OAM&P) functions such as provisioning, controls, and alarms. 

5.1.1 Applications
The following amplifiers can be configured as booster or preamplifiers:

• OPT-AMP-C

• OPT-AMP-17C

• OPT-AMP-L

• OPT-BST-E

• OPT-BST

• OPT-EDFA-17

• OPT-EDFA-24

The amplifier functions as a booster amplifier by default. The amplifier role is automatically configured 
when the CTP NE update configuration file is loaded in CTC. The amplifier role can also be manually 
modified.

Note The OPT-BST and OPT-BST-E amplifiers are supported as preamplifiers in sites that are equipped with 
the OPT-RAMP-C card. In any other configuration, the OPT-BST and OPT-BST-E cards must be 
configured as a booster amplifier.

For more information about the supported configurations and network topologies, see Chapter 12, “Node 
Reference” and Chapter 13, “Network Reference.”
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5.1.2   Card Summary
5.1.2 Card Summary
Table 5-1 lists and summarizes the functions of each optical amplifier card.

Table 5-1 Optical Amplifier Cards for the ONS 15454

Card Port Description For Additional Information

OPT-PRE The OPT-PRE amplifier has five optical ports (three sets) 
located on the faceplate. It operates in Slots 1 to 6 and 12  
to 17.

See the “5.3 OPT-PRE Amplifier 
Card” section on page 5-7.

OPT-BST The OPT-BST amplifier has four sets of optical ports located 
on the faceplate. It operates in Slots 1 to 6 and 12  to 17.

See the “5.4 OPT-BST and 
OPT-BST-E Amplifier Card” section on 
page 5-10.

OPT-BST-E The OPT-BST-E amplifier has four sets of optical ports 
located on the faceplate. It operates in Slots 1 to 6 and 12  
to 17.

See the “5.4 OPT-BST and 
OPT-BST-E Amplifier Card” section on 
page 5-10.

OPT-BST-L The OPT-BST-L L-band amplifier has four sets of optical 
ports located on the faceplate. It operates in Slots 1 to 6 and 
12  to 17.

See the “5.5 OPT-BST-L Amplifier 
Card” section on page 5-14.

OPT-AMP-L The OPT-AMP-L L-band preamplifier has five sets of optical 
ports located on the faceplate. It is a two-slot card that 
operates in Slots 1 to 6 and 12  to 17.

See the “5.6 OPT-AMP-L Card” 
section on page 5-19.

OPT-AMP-17-C The OPT-AMP-17-C C-band low-gain preamplifier/booster 
amplifier has four sets of optical ports located on the 
faceplate. It operates in Slots 1 to 6 and 12  to 17.

See the “5.7 OPT-AMP-17-C Card” 
section on page 5-24.

OPT-AMP-C The OPT-AMP-C C-band high-gain, high-power 
preamplifier/booster amplifier has five sets of optical ports 
located on the faceplate. It operates as a preamplifier when 
equipped and provisioned in Slots 2 to 6 and 11  to 16 or as a 
booster amplifier when equipped and provisioned in Slot 1 
and 17.

See the “5.8 OPT-AMP-C Card” 
section on page 5-29.

OPT-RAMP-C The OPT-RAMP-C C-band amplifier has five sets of optical 
ports located on the faceplate and operates in Slots 1 to 5 and 
12 to 16. 

See the “5.9 OPT-RAMP-C and 
OPT-RAMP-CE Cards” section on 
page 5-33.

OPT-RAMP-CE The OPT-RAMP-CE C-band amplifier has five sets of optical 
ports located on the faceplate and operates in Slots 1 to 5 and 
12 to 16. 

See the “5.9 OPT-RAMP-C and 
OPT-RAMP-CE Cards” section on 
page 5-33.

RAMAN-CTP The RAMAN-CTP amplifier is a single-slot card and has six 
optical ports located on the faceplate. The RAMAN-CTP and 
RAMAN-COP units must be installed in adjacent slots (Slots 
2 and 3, 4 and 5, or 6 and 7) in the ONS 15454 M6 chassis 
and Slots 2 and 3 in the ONS 15454 M2 chassis.

See the “5.10 RAMAN-CTP and 
RAMAN-COP Cards” section on 
page 5-38.

RAMAN-COP The RAMAN-COP amplifier has one optical port located on 
the faceplate. It is a single-slot card and works in conjunction 
with the RAMAN-CTP amplifier.

See the “5.10 RAMAN-CTP and 
RAMAN-COP Cards” section on 
page 5-38.
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5.1.3 Card Compatibility
Table 5-2 lists the Cisco Transport Controller (CTC) software compatibility for each optical amplifier 
card.

OPT-EDFA-17 The OPT-EDFA-17 amplifier has four sets of optical ports 
located on the faceplate. It operates in Slots 1 to 6 and 12  
to 17.

See the “5.11 OPT-EDFA-17 and 
OPT-EDFA-24 Cards” section on 
page 5-44

OPT-EDFA-24 The OPT-EDFA-24 amplifier has four sets of optical ports 
located on the faceplate. It operates in Slots 1 to 6 and 12  
to 17.

See the “5.11 OPT-EDFA-17 and 
OPT-EDFA-24 Cards” section on 
page 5-44

Table 5-1 Optical Amplifier Cards for the ONS 15454 (continued)

Card Port Description For Additional Information

Table 5-2 Software Release Compatibility for Optical Amplifier Cards up to Release 5.0

Card Type R4.5 R4.6 R4.7 R5.0

OPT-PRE 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM

OPT-BST 15454-DWDM 15454-DWDM 15454-DWDM 15454-DWDM

OPT-BST-E No No 15454-DWDM 15454-DWDM

OPT-BST-L No No No No

OPT-AMP-L No No No No

OPT-AMP-17-C No No No No

OPT-AMP-C No No No No

OPT-RAMP-C No No No No

OPT-RAMP-CE No No No No

RAMAN-CTP No No No No

RAMAN-COP No No No No

OPT-EDFA-17 No No No No

OPT-EDFA-24 No No No No
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Table 5-3 Software Release Compatibility for Optical Amplifier Cards Release 6.0 and Later
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Card Type R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R 9.2 R 9.2.1 R 9.3

OPT-PRE 15454-
DWDM
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DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

ONS 15454, 
15454-M2, 
15454-M6

ONS 15454, 
15454-M2, 
15454-M6
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OPT-BST 15454-
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15454-
DWDM
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ONS 15454, 
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OPT-RAMP
-CE

No No No No No No 15454-
DWDM

ONS 15454, 
15454-M6
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5.1.4 Optical Power Alarms and Thresholds
Table 5-4 lists the alarms and related thresholds for the OPT-BST, OPT-BST-E, OPT-BST-L, OPT
OPT-AMP-C cards.

5.2 Class 1M Laser Safety Labels
For information about safety labels, see the “G.1 Safety Labels” section on page G-1.

OPT-EDFA-
17

No No No No No No No No No ONS 15
15454-M
15454-M

OPT-EDFA-
24

No No No No No No No No No ONS 15
15454-M
15454-M

Table 5-4 Alarms and Thresholds

Port Alarms Thresholds

LINE RX LOS None

LOS-P LOS-P Fai

LOS-O LOS-O Fai

LINE TX OPWR-FAIL OPWR Fai

OSC TX None None

OSC RX None None

COM TX None None

COM RX LOS-P LOS-P Fai
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5.3 OPT-PRE Amplifier Card

Note For OPT-PRE card specifications, see the OPT-PRE Amplifier Card Specifications section in the 
Hardware Specifications document. 

Note For OPT-PRE card safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

The OPT-PRE is a C-band, DWDM, two-stage erbium-doped fiber amplifier (EDFA) with midamplifier 
loss (MAL) that can be connected to a dispersion compensating unit (DCU). The OPT-PRE is equipped 
with a built-in variable optical attenuator (VOA) that controls the gain tilt and can also be used to pad 
the DCU to a reference value. You can install the OPT-PRE in Slots 1 to 6 and 12 to 17. The card is 
designed to support up to 80 channels at 50-GHz channel spacing. The OPT-PRE features include:

• Fixed gain mode with programmable tilt

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• MAL for fiber-based DCU

• Amplified spontaneous emissions (ASE) compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Four signal photodiodes to monitor the input and output optical power of the two amplifier stages 
through CTC

• An optical output port for external monitoring

Note The optical splitter has a ratio of 1:99, resulting in about 20 dB-lower power at the MON port than at the 
COM TX port.

5.3.1 OPT-PRE Faceplate Ports and Block Diagram
The OPT-PRE amplifier has five optical ports located on the faceplate:

• MON is the output monitor port

• COM RX (receive) is the input signal port

• COM TX (transmit) is the output signal port

• DC RX is the MAL input signal port

• DC TX is the MAL output signal port
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Chapter 5      Provision Optical Amplifier Cards
5.3.1   OPT-PRE Faceplate Ports and Block Diagram
Figure 5-1 shows the OPT-PRE amplifier card faceplate.

Figure 5-1 OPT-PRE Faceplate 

Figure 5-2 shows a simplified block diagram of the OPT-PRE card’s features.
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Chapter 5      Provision Optical Amplifier Cards
5.3.2   OPT-PRE Card Functions
Figure 5-2 OPT-PRE Block Diagram

Figure 5-3 shows the a block diagram of how the OPT-PRE optical module functions.

Figure 5-3 OPT-PRE Optical Module Functional Block Diagram

5.3.2 OPT-PRE Card Functions
The functions of the OPT-PRE card are: 

• 5.3.2.1 OPT-PRE card Power Monitoring

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10
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Chapter 5      Provision Optical Amplifier Cards
5.3.3   Related Procedures for OPT-PRE Card
5.3.2.1 OPT-PRE card Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-PRE card. Table 5-5 shows the 
returned power level values calibrated to each port.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

5.3.3 Related Procedures for OPT-PRE Card
The following is the list of procedures and tasks related to the configuration of the OPT-PRE card:

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• NTP-G77 Manage Automatic Power Control

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.4 OPT-BST and OPT-BST-E Amplifier Card

Note For OPT-BST and OPT-BST-E hardware specifications, see the OPT-BST Amplifier Card Specifications 
and OPT-BST-E Amplifier Card Specifications sections in the Hardware Specifications document. 

Note For OPT-BST and OPT-BST-E cards safety labels, see the “G.1.2 Class 1M Laser Product Cards” 
section on page G-4.

Table 5-5 OPT-PRE Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 Input Com COM RX

P2 Output DC DC TX

P3 Input DC DC RX

P4 Output COM (Total Output) COM TX

Output COM (Signal Output)
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Chapter 5      Provision Optical Amplifier Cards
5.4.1   OPT-BST and OPT-BST-E Faceplate Ports and Block diagram
The OPT-BST is designed to ultimately support up to 80 channels at 50-GHz channel spacing. The 
OPT-BST-E amplifier card is a gain-enhanced version of the OPT-BST card. It is designed to support up 
to 80 channels at 50-GHz channel spacing. Both the cards are C-band, DWDM EDFA with optical 
service channel (OSC) add-and-drop capability. When an OPT-BST or an OPT-BST-E is installed in the 
an ONS 15454, an OSCM card is also needed to process the OSC. You can install the OPT-BST and 
OPT-BST-E cards in Slots 1 to 6 and 12 to 17. The card’s features include:

• Fixed gain mode (with programmable tilt)

• Gain range of 5 to 20 dB in constant gain mode and output power mode for an OPT-BST card

• Gain range of 8 to 23 dBm with the tilt managed at 0 dBm in constant gain mode and output power 
mode for an OPT-BST-E card

• Enhanced gain range of 23 to 26 dBm with unmanaged tilt with OPT-BST-E card

• True variable gain

• Built-in VOA to control gain tilt

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Optical Safety Remote Interlock (OSRI), a CTC software feature capable of shutting down optical 
output power or reducing the power to a safe level (automatic power reduction) 

• Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut. For 
information about using the card to implement ALS in a network, see the “13.11 Network Optical 
Safety” section on page 13-30.

Note The optical splitters each have a ratio of 1:99. The result is that MON TX and MON RX port power is 
about 20 dB lower than COM TX and COM RX port power.

5.4.1 OPT-BST and OPT-BST-E Faceplate Ports and Block diagram
The OPT-BST and OPT-BST-E amplifier has eight optical ports located on the faceplate:

• MON RX is the output monitor port (receive section). 

• MON TX is the output monitor port. 

• COM RX is the input signal port. 

• LINE TX is the output signal port. 

• LINE RX is the input signal port (receive section). 

• COM TX is the output signal port (receive section). 

• OSC RX is the OSC add input port. 

• OSC TX is the OSC drop output port.
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Chapter 5      Provision Optical Amplifier Cards
5.4.1   OPT-BST and OPT-BST-E Faceplate Ports and Block diagram
Figure 5-4 shows the OPT-BST amplifier card faceplate.

Figure 5-4 OPT-BST Faceplate 

The OPT-BST-E card faceplate is the same as that of the OPT-BST card.

Figure 5-5 shows a simplified block diagram of the OPT-BST and OPT-BST-E card’s features.
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Chapter 5      Provision Optical Amplifier Cards
5.4.2   OPT-BST and OPT-BST-E Card Functions
Figure 5-5 OPT-BST and OPT-BST-E Block Diagram

Figure 5-6 shows a block diagram of how the OPT-BST and OPT-BST-E optical module functions.

Figure 5-6 OPT-BST and OPT-BST-E Optical Module Functional Block Diagram

5.4.2 OPT-BST and OPT-BST-E Card Functions
The functions of the OPT-BST and OPT-BST-E cards are: 

• 5.4.2.1 OPT-BST and OPT-BST-E cards Power Monitoring

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10

5.4.2.1 OPT-BST and OPT-BST-E cards Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-BST and OPT-BST-E cards. 
Table 5-6 shows the returned power level values calibrated to each port.
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Chapter 5      Provision Optical Amplifier Cards
5.4.3   Related Procedures for OPT-BST and OPT-BST-E Cards
The power on the OSC-TX and COM-TX ports are calculated by adding the insertion loss (IL) to the 
power reported from P3 and P4.

The PM parameters for the power values are listed in the Optics and 8b10b PM Parameter Definitions 
document.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

5.4.3 Related Procedures for OPT-BST and OPT-BST-E Cards
The following is the list of procedures and tasks related to the configuration of the OPT-BST and 
OPT-BST-E cards:

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.5 OPT-BST-L Amplifier Card
(Cisco ONS 15454 only)

Table 5-6 Port Calibration

Photodiode CTC Type Name Calibrated to Port Power PM Parameter

P1 Input Com COM RX Channel 
Power

Supported

P2 Output Line (Total 
Output)

LINE TX Channel 
Power

Supported

Output Line (Signal 
Output)

P3 Input Line LINE RX Channel 
Power

Supported

P4 Input Line LINE RX OSC Power Supported
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Chapter 5      Provision Optical Amplifier Cards
5.5.1   OPT-BST-L Faceplate Ports and Block Diagram
Note For OPT-BST-L card specifications, see the OPT-BST-L Amplifier Card Specifications section in the 
Hardware Specifications document. 

Note For OPT-BST-L safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

The OPT-BST-L is an L-band, DWDM EDFA with OSC add-and-drop capability. The card is well suited 
for use in networks that employ dispersion shifted (DS) fiber or SMF-28 single-mode fiber. The 
OPT-BST-L is designed to ultimately support 64 channels at 50-GHz channel spacing, but in 
Software R9.0 and earlier it is limited to 32 channels at 100-GHz spacing.When an ONS 15454 has an 
OPT-BST-L installed, an OSCM card is needed to process the OSC. You can install the OPT-BST-L in 
Slots 1 to 6 and 12 to 17. The card’s features include:

• Fixed gain mode (with programmable tilt)

• Standard gain range of 8 to 20 dB in the programmable gain tilt mode

• True variable gain

• 20 to 27 dB gain range in the uncontrolled gain tilt mode

• Built-in VOA to control gain tilt

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• OSRI

• ALS

Note The optical splitters each have a ratio of 1:99. The result is that MON TX and MON RX port power is 
about 20 dB lower than COM TX and COM RX port power.

5.5.1 OPT-BST-L Faceplate Ports and Block Diagram
The OPT-BST-L amplifier has eight optical ports located on the faceplate: 

• MON RX is the output monitor port (receive section).

• MON TX is the output monitor port. 

• COM RX is the input signal port. 

• LINE TX is the output signal port. 

• LINE RX is the input signal port (receive section). 

• COM TX is the output signal port (receive section). 

• OSC RX is the OSC add input port. 
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Chapter 5      Provision Optical Amplifier Cards
5.5.1   OPT-BST-L Faceplate Ports and Block Diagram
• OSC TX is the OSC drop output port.

Figure 5-7 shows the OPT-BST-L card faceplate.

Figure 5-7 OPT-BST-L Faceplate 

Figure 5-8 shows a simplified block diagram of the OPT-BST-L card’s features.
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Chapter 5      Provision Optical Amplifier Cards
5.5.2   OPT-BST-L Card Functions
Figure 5-8 OPT-BST-L Block Diagram

Figure 5-9 shows a block diagram of how the OPT-BST-L optical module functions.

Figure 5-9 OPT-BST-L Optical Module Functional Block Diagram

5.5.2 OPT-BST-L Card Functions
The functions of the OPT-BST-L card are: 

• 5.5.2.1 OPT-BST-L Card Power Monitoring

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10
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Chapter 5      Provision Optical Amplifier Cards
5.5.3   Related Procedures for OPT-BST-L Card
5.5.2.1 OPT-BST-L Card Power Monitoring

Physical photodiodes P1, P2, P3, P4, and P5 monitor the power for the OPT-BST-L card. Table 5-7 
shows the returned power level values calibrated to each port.

The power values on the OSC-TX and COM-TX ports are calculated by adding the insertion loss (IL) to 
the power values reported from P4 and P5.

The OSC power on the LINE TX is calculated by adding the IL to the power reported from P3.

The PM parameters for the power values are listed in the Optics and 8b10b PM Parameter Definitions 
document.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

5.5.3 Related Procedures for OPT-BST-L Card
The following is the list of procedures and tasks related to the configuration of the OPT-BST-L card:

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

Table 5-7 OPT-BST-L Port Calibration

Photodiode CTC Type Name Calibrated to Port Power PM Parameter

P1 Input COM COM RX Channel Power Supported

P2 Output Line (Total 
Output)

LINE TX Channel Power Supported

Output Line (Signal 
Output)

P3 Input OSC OSC RX OSC Power Supported

P4 Input Line LINE RX Channel Power Supported

P5 Input Line LINE RX OSC Power Supported
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5.6   OPT-AMP-L Card
5.6 OPT-AMP-L Card
(Cisco ONS 15454 only)

Note For OPT-AMP-L card specifications, see the OPT-AMP-L Preamplifier Card Specifications section in 
the Hardware Specifications document. 

Note For OPT-AMP-L card safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

The OPT-AMP-L is an L-band, DWDM optical amplifier card consisting of a two-stage EDFA with 
midstage access loss (MSL) for an external DCU and OSC add-and-drop capability. Using CTC, the card 
is provisionable as a preamplifier (OPT-PRE) or booster amplifier (OPT-BST), and is well suited for use 
in networks that employ DS or SMF-28 fiber. The amplifier can operate up to 64 optical transmission 
channels at 50-GHz channel spacing in the 1570 nm to 1605 nm wavelength range.

When an OPT-AMP-L installed, an OSCM card is needed to process the OSC. You can install the 
two-slot OPT-AMP-L in Slots 1 to 6 and 12 to 17. 

The card has the following features:

• Maximum power output of 20 dBm

• True variable gain amplifier with settable range from 12 to 24 dBm in the standard gain range and 
24 dBm to 35 dbM with uncontrolled gain tilt

• Built-in VOA to control gain tilt

• Up to 12 dBm MSL for an external DCU

• Fast transient suppression; able to adjust power levels in hundreds of microseconds to avoid bit 
errors in failure or capacity growth situations

• Nondistorting low frequency transfer function

• Midstage access loss for dispersion compensation unit

• Constant pump current mode (test mode)

• Constant output power mode (used during optical node setup)

• Constant gain mode

• Internal ASE compensation in constant gain mode and in constant output power mode

• Full monitoring and alarm handling capability

• Optical safety support through signal loss detection and alarm at any input port, fast power down 
control (less than one second), and reduced maximum output power in safe power mode. For 
information on using the card to implement ALS in a network, see the “13.11 Network Optical 
Safety” section on page 13-30.

Note Before disconnecting any OPT AMP-L fiber for troubleshooting, first make sure the OPT AMP-L card 
is unplugged.
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Chapter 5      Provision Optical Amplifier Cards
5.6.1   OPT-AMP-L Faceplate Ports and Block Diagrams
5.6.1 OPT-AMP-L Faceplate Ports and Block Diagrams
The OPT-AMP-L amplifier card has ten optical ports located on the faceplate:

• MON RX is the output monitor port (receive section).

• MON TX is the output monitor port. 

• COM RX is the input signal port. 

• LINE TX is the output signal port. 

• LINE RX is the input signal port (receive section). 

• COM TX is the output signal port (receive section). 

• OSC RX is the OSC add input port. 

• OSC TX is the OSC drop output port. 

• DC TX is the output signal to the DCU. 

• DC RX is the input signal from the DCU.
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Chapter 5      Provision Optical Amplifier Cards
5.6.1   OPT-AMP-L Faceplate Ports and Block Diagrams
Figure 5-10 shows the OPT-AMP-L card faceplate.

Figure 5-10 OPT-AMP-L Faceplate 

Figure 5-11 shows a simplified block diagram of the OPT-AMP-L card’s features.
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Chapter 5      Provision Optical Amplifier Cards
5.6.1   OPT-AMP-L Faceplate Ports and Block Diagrams
Figure 5-11 OPT-AMP-L Block Diagram

Figure 5-12 shows a block diagram of how the OPT-AMP-L optical module functions.

Figure 5-12 OPT-AMP-L Optical Module Functional Block Diagram
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Chapter 5      Provision Optical Amplifier Cards
5.6.2   OPT-AMP-L Card Functions
5.6.2 OPT-AMP-L Card Functions
The functions of the OPT-AMP-L card are: 

• 5.6.2.1 OPT-AMP-L and OPT-AMP-C cards Power Monitoring

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10

5.6.2.1 OPT-AMP-L and OPT-AMP-C cards Power Monitoring

Physical photodiodes P1 through P7 monitor the power for the OPT-AMP-L and OPT-AMP-C cards. 
Table 5-8 shows the returned power level values calibrated to each port.

The power values on the OSC-TX and COM-TX ports are calculated by adding the insertion loss (IL) to 
the power values reported from P5 and P6.

The power values on the LINE TX port is calculated by adding the IL to the power value reported from 
P7.

The PM parameters for the power values are listed in the Optics and 8b10b PM Parameter Definitions 
document.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

5.6.3 Related Procedures for OPT-AMP-L Card
The following is the list of procedures and tasks related to the configuration of the OPT-AMP-L card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-47

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

Table 5-8 Port Calibration

Photodiode CTC Type Name Calibrated to Port Power PM Parameter

P1 Input COM COM RX Channel Power Supported

P2 Output DC (total power) DC TX Channel Power Supported

Output DC (signal power)

P3 Input DC (input power) DC RX Channel Power Supported

P4 Output Line (total power) LINE TX Channel Power Supported

Output Line (signal power)

P5 Input Line LINE RX Channel Power Supported

P6 Input Line LINE RX OSC Power Supported

P7 Input OSC OSC RX OSC Power Supported
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• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.7 OPT-AMP-17-C Card

Note For OPT-AMP-17-C card specifications, see the OPT-AMP-17-C Amplifier Card Specifications section 
in the Hardware Specifications document. 

Note For OPT-AMP-17-C safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

The OPT-AMP-17-C is a 17-dB gain, C-band, DWDM EDFA amplifier/preamplifier with OSC 
add-and-drop capability. It supports 80 channels at 50-GHz channel spacing in the C-band (that is, the 
1529 nm to 1562.5 nm wavelength range). When an ONS 15454 has an OPT-AMP-17-C installed, an 
OSCM card is needed to process the OSC. You can install the OPT-AMP-17-C in Slots 1 to 6 and 
12 to 17. 

The card’s features include:

• Fixed gain mode (no programmable tilt)

• Standard gain range of 14 to 20 dB at startup when configured as a preamplifier

• Standard gain range of 20 to 23 dB in the transient mode when configured as a preamplifier

• Gain range of 14 to 23 dB (with no transient gain range) when configured as a booster amplifier

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• OSRI

• ALS
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5.7.1 OPT-AMP-17-C Faceplate Ports and Block Diagrams
The OPT-AMP-17-C amplifier card has eight optical ports located on the faceplate:

• MON RX is the output monitor port (receive section).

• MON TX is the output monitor port. 

• COM RX is the input signal port. 

• LINE TX is the output signal port. 

• LINE RX is the input signal port (receive section).

• COM TX is the output signal port (receive section). 

• OSC RX is the OSC add input port. 

• OSC TX is the OSC drop output port.
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5.7.1   OPT-AMP-17-C Faceplate Ports and Block Diagrams
Figure 5-13 shows the OPT-AMP-17-C amplifier card faceplate. 

Figure 5-13 OPT-AMP-17-C Faceplate 

Figure 5-14 shows a simplified block diagram of the OPT-AMP-17C card’s features.
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Figure 5-14 OPT-AMP17-C Block Diagram

Figure 5-15 shows how the OPT-AMP-17-C optical module functions.

Figure 5-15 OPT-AMP-17-C Optical Module Functional Block Diagram

5.7.2 OPT-AMP-17-C Card Functions
The functions of the OPT-AMP-17-C card are: 

• G.32 Automatic Power Control, page G-29

• 5.7.2.1 OPT-AMP-17-C card Power Monitoring

• Card level indicators—Table G-4 on page G-9
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• G.4 Port-Level Indicators, page G-10

5.7.2.1 OPT-AMP-17-C card Power Monitoring

Physical photodiodes P1, P2, P3, P4, and P5 monitor power for the OPT-AMP-17-C card. Table 5-9 
shows the returned power level values calibrated to each port.

The power on the OSC-TX and COM-TX ports are calculated by adding the insertion loss (IL) to the 
power reported from P3 and P4.

The OSC power on the LINE TX is calculated by adding the IL to the power reported from P5.

The PM parameters for the power values are listed in the Optics and 8b10b PM Parameter Definitions 
document.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

5.7.3 Related Procedures for OPT-AMP-17-C Card
The following is the list of procedures and tasks related to the configuration of the OPT-AMP-17-C card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-47

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

Table 5-9 OPT-AMP-17-C Port Calibration

Photodiode CTC Type Name Calibrated to Port Power PM Parameter

P1 Input COM COM RX Channel Power Supported

P2 Output Line (Total 
Output)

LINE TX Channel Power Supported

Output Line (Signal 
Output)

P3 Input Line LINE RX Channel Power Supported

P4 Input Line LINE RX OSC Power Supported

P5 Input OSC OSC RX OSC Power Supported
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• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.8 OPT-AMP-C Card

Note For OPT-AMP-C card specifications, see the OPT-AMP-C Amplifier Card Specifications section in the 
Hardware Specifications document.

Note For OPT-AMP-C card safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

The OPT-AMP-C card is a 20-dB output power, C-band, DWDM EDFA amplifier/preamplifier. It 
contains mid-stage access loss for a Dispersion Compensation Unit (DCU). To control gain tilt, a VOA 
is used. The VOA can also be used to attenuate the signal to the DCU to a reference value. The amplifier 
module also includes the OSC add (TX direction) and drop (RX direction) optical filters.

The OPT-AMP-C card supports 80 channels at 50-GHz channel spacing in the C-band (that is, the 1529 
nm to 1562.5 nm wavelength range). When an ONS 15454 has an OPT-AMP-C card installed, an OSCM 
card is needed to process the OSC. You can install the OPT-AMP-C card in Slots 1 to 6 and 12 to 17. 
Slots 2 to 6 and Slots 12 to 16 are the default slots for provisioning the OPT-AMP-C card as a 
preamplifier, and slots 1 and 17 are the default slots for provisioning the OPT-AMP-C card as a booster 
amplifier.

The card’s features include:

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Mid-stage access for DCU

• Constant pump current mode (test mode)

• Fixed output power mode (mode used during provisioning)

• Constant gain mode

• ASE compensation in Constant Gain and Constant Output Power modes

• Programmable tilt

• Full monitoring and alarm handling capability

• Gain range with gain tilt control of 12 to 24 dB

• Extended gain range (with uncontrolled tilt) of 24 to 35 dB

• Full monitoring and alarm handling with settable thresholds

• OSRI

• ALS
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5.8.1 OPT-AMP-C Card Faceplate Ports and Block Diagrams
The OPT-AMP-C amplifier card has 10 optical ports located on the faceplate:

• MON RX is the output monitor port (receive section).

• MON TX is the output monitor port. 

• COM RX is the input signal port. 

• COM TX is the output signal port (receive section). 

• DC RX is the input DCU port.

• DC TX is the output DCU port.

• OSC RX is the OSC add input port. 

• OSC TX is the OSC drop output port.

• LINE RX is the input signal port (receive section).

• LINE TX is the output signal port. 
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5.8.1   OPT-AMP-C Card Faceplate Ports and Block Diagrams
Figure 5-16 shows the OPT-AMP-C amplifier card faceplate. 

Figure 5-16 OPT-AMP-C Card Faceplate 

Figure 5-17 shows a simplified block diagram of the OPT-AMP-C card features.
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5.8.1   OPT-AMP-C Card Faceplate Ports and Block Diagrams
Figure 5-17 OPT-AMP-C Block Diagram

Figure 5-18 shows how the OPT-AMP-C optical module functions.

Figure 5-18 OPT-AMP-C Optical Module Functional Block Diagram
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5.8.2 OPT-AMP-C Card Functions
The functions of the OPT-AMP-C card are:

• 5.6.2.1 OPT-AMP-L and OPT-AMP-C cards Power Monitoring

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10

5.8.3 Related Procedures for OPT-AMP-C Card
The following is the list of procedures and tasks related to the configuration of the OPT-AMP-C card:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-47

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.9 OPT-RAMP-C and OPT-RAMP-CE Cards
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For OPT-RAMP-C and OPT-RAMP-CE specifications, see the OPT-RAMP-C Amplifier Card 
Specifications and OPT-RAMP-CE Amplifier Card Specifications sections in the Hardware 
Specifications document.

Note For OPT-RAMP-C or OPT-RAMP-CE card safety labels, see the “G.1.2 Class 1M Laser Product Cards” 
section on page G-4.

The OPT-RAMP-C card is a double-slot card that improves unregenerated sections in long spans using 
the span fiber to amplify the optical signal. Different wavelengths in C-band receive different gain 
values. To achieve Raman amplification, two Raman signals (that do not carry any payload or overhead) 
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are required to be transmitted on the optical fiber because the gain generated by one signal is not flat. 
The energy of these Raman signals transfer to the higher region of the spectrum thereby amplifying the 
signals transmitted at higher wavelengths. The Raman effect reduces span loss but does not compensate 
it completely.

When the Raman optical powers are set correctly, a gain profile with limited ripple is achieved. The 
wavelengths of the Raman signals are not in the C-band of the spectrum (used by MSTP for payload 
signals). The two Raman wavelengths are fixed and always the same. Due to a limited Raman gain, an 
EDFA amplifier is embedded into the card to generate a higher total gain. An embedded EDFA gain 
block provides a first amplification stage, while the mid stage access (MSA) is used for DCU loss 
compensation.

The OPT-RAMP-CE card is a 20 dBm output power, gain-enhanced version of the OPT-RAMP-C card 
and is optimized for short spans. The OPT-RAMP-C and OPT-RAMP-CE cards can support up to 80 
optical transmission channels at 50-GHz channel spacing over the C-band of the optical spectrum 
(wavelengths from 1529 nm to 1562.5 nm). To provide a counter-propagating Raman pump into the 
transmission fiber, the Raman amplifier provides up to 500 mW at the LINE-RX connector. The 
OPT-RAMP-C or OPT-RAMP-CE card can be installed in Slots 1 to 5 and 12 to 16, and supports all 
network configurations. However, the OPT-RAMP-C or OPT-RAMP-CE card must be equipped on both 
endpoints of a span.

The Raman total power and Raman ratio can be configured using CTC. The Raman configuration can be 
viewed on the Maintenance > Installation tab.

The features of the OPT-RAMP-C and OPT-RAMP-CE card include:

• Raman pump with embedded EDFA gain block

• Raman section: 500 mW total pump power for two pump wavelengths

• EDFA section:

– OPT-RAMP-C: 16 dB gain and 17 dB output power

– OPT-RAMP-CE: 11 dB gain and 20 dB output power

• Gain Flattening Filter (GFF) for Raman plus EDFA ripple compensation

• MSA for DC units

• VOA for DC input power control

• Full monitoring of pump, OSC, and signal power

• Fast gain control for transient suppression

• Low-FIT (hardware-managed) optical laser safety

• Hardware output signals for LOS monitoring at input photodiodes

• Optical service channel add and drop filters

• Raman pump back-reflection detector

5.9.1 Card Faceplate Ports and Block Diagrams
The OPT-RAMP-C and OPT-RAMP-CE cards have ten optical ports located on the faceplate:

• MON RX is the output monitor port (receive section).

• MON TX is the output monitor port.

• COM RX is the input signal port (receive section).

• COM TX is the output signal port.
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• DC RX is the input DCU port.

• DC TX is the output DCU port.

• OSC RX is the OSC add input port.

• OSC TX is the OSC drop output port.

• LINE RX is the input signal port (receive section).

• LINE TX is the output signal port.

Figure 5-19 shows the OPT-RAMP-C card faceplate.

Figure 5-19 OPT-RAMP-C Faceplate

The OPT-RAMP-CE card faceplate is the same as that of the OPT-RAMP-C card.

Figure 5-20 shows a simplified block diagram of the OPT-RAMP-C and OPT-RAMP-CE card features.
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Figure 5-20 OPT-RAMP-C and OPT-RAMP-CE Block Diagram

Figure 5-21 shows a block diagram of how the OPT-RAMP-C and OPT-RAMP-CE card functions.

Figure 5-21 OPT-RAMP-C and OPT-RAMP-CE Card Functional Block Diagram
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Two Raman pump lasers are combined internally and launched in-fiber at the LINE-RX port, thereby 
counter-propagating with the DWDM signal. An EDFA gain block provides further amplification of the 
DWDM signal, which allows regulated output power entry in the mid stage access and acts upon the 
VOA attenuation. While the optical filters are present for the OSC add and drop functions, the OSC 
signal counter-propagates with the DWDM signal. Two monitor ports, MON-RX and MON-TX, are 
provided at the EDFA input and output stages and are used to evaluate the total gain ripple. A total of 12 
photodiodes (PDs) are provided, allowing full monitoring of RP power, DWDM power, and OSC power 
in each section of the device. In particular, PD12 allows the detection of the remnant Raman pump power 
at the end of the counter-pumped span, while PD11 detects the amount of Raman pump power back 
scattered by the LINE-RX connector and transmission fiber. 

The EDFA section calculates the signal power, considering the expected ASE power contribution to the 
total output power. The signal output power or the signal gain can be used as feedback signals for the 
EDFA pump power control loop. The ASE power is derived according to the working EDFA gain. PD2, 
PD3, and PD4 provide the total power measured by the photodiode and the signal power is derived by 
calculating the total power value. The insertion loss of the main optical path and the relative optical 
attenuation of the two monitor ports are stored into the card’s not-volatile memory.

5.9.2 OPT-RAMP-C and OPT-RAMP-CE Card Functions
The functions of the OPT-RAMP-C and OPT-RAMP-CE card are:

• 5.9.2.1 OPT-RAMP-C and OPT-RAMP-CE Cards Power Monitoring, page 5-37

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10

5.9.2.1 OPT-RAMP-C and OPT-RAMP-CE Cards Power Monitoring

Physical photodiodes PD1 through PD12 monitor the power for the OPT-RAMP-C and OPT-RAMP-CE 
cards (see Table 5-10).

Table 5-10 OPT-RAMP-C and OPT-RAMP-CE Port Calibration

Photodiode CTC Type Name Calibrated to Port

PD1 EDFA DWDM Input Power LINE-RX

PD2 EDFA Output Power (pre-VOA 
attenuation)

DC-TX (port with 0 dB VOA attenuation)

PD3 DCU Input Power DC-TX

PD4 DCU Output Power DC-RX

PD5 DWDM Input Power COM-RX

PD6 OSC ADD Input Power OSC-RX

PD7 OSC DROP Output Power OSC-TX

PD8 Pump 1 in-fiber Output Power LINE-RX

PD9 Pump 2 in-fiber Output Power LINE-RX

PD10 Total Pump in-fiber Output Power LINE-RX
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5.9.3   Related Procedures for OPT-RAMP-C and OPT-RAMP-CE Cards
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

5.9.3 Related Procedures for OPT-RAMP-C and OPT-RAMP-CE Cards
The following is the list of procedures and tasks related to the configuration of the OPT-RAMP-C and 
OPT-RAMP-CE cards:

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G201 Configure the Raman Pump on an MSTP Link, page 16-4

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.10 RAMAN-CTP and RAMAN-COP Cards
(Cisco ONS 15454 M2 and ONS 15454 M6 only)

Note The RAMAN-CTP and RAMAN-COP cards are supported in R9.3.02 and later.

Note For hardware specifications, see the RAMAN-CTP and RAMAN-COP Card Specifications section in the 
Hardware Specifications document.

PD11 Back-Reflected Pump Power LINE-RX

PD12 Remnant Pump Power LINE-TX

Table 5-10 OPT-RAMP-C and OPT-RAMP-CE Port Calibration (continued)

Photodiode CTC Type Name Calibrated to Port
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5.10   RAMAN-CTP and RAMAN-COP Cards
Note For RAMAN-CTP and RAMAN-COP cards safety labels, see the “G.1.2 Class 1M Laser Product 
Cards” section on page G-4.

The single-slot RAMAN-CTP and RAMAN-COP cards support counter and co-propagating Raman 
amplification on very long unregenerated spans. 

The cards manage up to 96 ITU-T 50-GHz spaced channels over the C-band of the optical spectrum 
(wavelengths from 1528.77 nm to 1566.72 nm). The counter-propagating RAMAN-CTP card is the 
master unit. The co-propagating RAMAN-COP card is the slave unit and can be used only when the 
counter-propagating unit is present. The RAMAN-CTP card and the RAMAN-COP card must be 
installed in adjacent slots (Slots 2 and 3, 4 and 5, or 6 and 7) in the Cisco ONS 15454 M6 chassis and 
Slots 2 and 3 in the Cisco ONS 15454 M2 chassis. However, these adjacent slots must not be used to 
install two RAMAN-CTP or two RAMAN-COP cards. 

The features of the RAMAN-CTP and RAMAN-COP cards include:

• Raman section: 1000 mW total pump power for four pumps and two wavelengths

• Embedded distributed feedback (DFB) laser at 1568.77 nm to be used for optical safety and link 
continuity (in RAMAN-CTP card only)

• Photodiodes to enable monitoring of Raman pump power

• Photodiodes to enable monitoring of the DFB laser and signal power (in RAMAN-CTP card only)

• Hardware managed automatic laser shutdown (ALS) for optical laser safety

• Hardware output signals for loss of signal (LOS) monitoring at input photodiodes 

• Raman pump back reflection detector to check for excessive back reflection

5.10.0.0.1 Important Notes Regarding Patchcord Installation

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Warning Avoid eye or skin exposure to direct or scattered radiation. Statement 1013

• Two E-2000 PS PC to F-3000s SM PC patchcords are shipped with the RAMAN-CTP card.

• One E-2000 PS PC to E-2000 PS PC patchcord is shipped with the RAMAN-COP card.

• Connect the F-3000s SM PC connector to the RAMAN-CTP card before connecting the E2000 PS 
PC high optical power connector to the card.

• The F-3000s SM PC connector is mechanically and optically compatible with the LC PC connectors 
and the LC PC mating adapters. If the connectors are clean, the standard connectors and the F-3000s 
SM PC connectors can be used for optical power of 250 mW and higher.

• The patchcords used to connect the RAMAN-CTP cards to the span must use only PC connectors 
and not angled connectors.
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5.10.1   Card Faceplate Ports and Block Diagrams
5.10.1 Card Faceplate Ports and Block Diagrams
The RAMAN-CTP card has six optical ports located on the faceplate:

– MON TX is the output monitor port

– COM RX is the input signal port (receive section)

– COM TX is the output signal port

– RAMAN-COP RX is the Raman co-propagating input port

– LINE RX is the input signal port (receive section)

– LINE TX is the output signal port

Figure 5-22 shows the RAMAN-CTP card faceplate.

Figure 5-22 RAMAN-CTP Faceplate

The RAMAN-COP card has only one optical port located on the faceplate. RAMAN-TX is the Raman 
co-propagating output port.

Figure 5-23 shows the RAMAN-COP card faceplate.

Figure 5-23 RAMAN-COP Faceplate

Figure 5-24 shows a block diagram of how the RAMAN-CTP card functions.
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5.10.1   Card Faceplate Ports and Block Diagrams
Figure 5-24 RAMAN-CTP Functional Block Diagram

Four Raman pump lasers (two for each wavelength) are combined internally and launched in-fiber at the 
LINE-RX port, thereby counter-propagating with the DWDM signal. The two pump lasers at the same 
nominal central wavelength, power, and polarization are made orthogonally polarized by the polarization 
beam combiner (that rotates one of the laser beams) and then coupled, resulting in a depolarized beam. 
A DFB laser at 1568.77 nm is used for optical safety. Optical filters for DFB add and drop are present. 
The DFB signal generated by the DFB laser is transmitted in-fiber, co-propagating with the DWDM 
signal. A MON-TX port monitors the DWDM signal at the COM-TX port. A total of ten photodiodes are 
provided, allowing monitoring of Raman pump (RP) power, DWDM signal power, and DFB signal 
power in each section of the card. In particular, P8 measures the co-propagating Raman pump power 
in-fiber (when the RAMAN-COP unit is present), while P6 detects the amount of Raman pump power 
back scattered by the LINE-RX connector and transmission fiber. P1 measures the DFB signal power 
transmitted in-fiber while P9 and P10 measure the DFB signal and ASE power respectively, which is 
received from the other line site. The insertion loss of the main optical path and the relative optical 
attenuation of the monitor port is stored in non-volatile memory of the card.

Figure 5-25 shows a block diagram of how the RAMAN-COP card functions.
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5.10.2   RAMAN-CTP and RAMAN-COP Cards Power Monitoring
Figure 5-25 15454-M-RAMAN-COP Functional Block Diagram

Four Raman pump lasers (two for each wavelength) are combined internally and launched in-fiber at the 
LINE-TX port of the counter-propagating unit, thereby co-propagating with the DWDM signal. The two 
pump lasers at the same nominal central wavelength, power, and polarization are made orthogonally 
polarized by the polarization beam combiner (that rotates one of the laser beams) and then coupled, 
resulting in a depolarized beam. A total of four photodiodes are provided, allowing the monitoring of RP 
power. In particular, P6 detects the amount of Raman pump power back scattered by the LINE-RX 
connector and transmission fiber. 

5.10.2 RAMAN-CTP and RAMAN-COP Cards Power Monitoring
Physical photodiodes P1 through P10 monitor the power for the RAMAN-CTP card (see Table 5-11).
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Table 5-11 RAMAN-CTP Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 DFB in-fiber Output Power LINE-TX

P2 DWDM RX Input Power LINE-RX

P3 Pump 1 in-fiber Output Power LINE-RX

P4 Pump 2 in-fiber Output Power LINE-RX

P5 Total Pump in-fiber Output Power LINE-RX
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5.10.3   RAMAN-CTP and RAMAN-COP Card Functions
Physical photodiodes P3 through P6 monitor the power for the RAMAN-COP card (see Table 5-12).

The PM parameters for the power values are listed in the Optics and 8b10b PM Parameter Definitions 
document.

For information on the associated TL1 AIDs for the optical power monitoring points, see the “CTC Port 
Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.6.x.

5.10.3 RAMAN-CTP and RAMAN-COP Card Functions
The functions of the RAMAN-CTP and RAMAN-COP cards are:

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10

• G.15 Lamp Test, page G-22

5.10.4 Related Procedures for RAMAN-CTP and RAMAN-COP Cards

Caution During a software upgrade, do not unplug the RAMAN-CTP or RAMAN-COP card fibers or connectors. 
The ends of unterminated fibers or connectors emit invisible laser radiation.

The following is the list of procedures and tasks related to the configuration of the RAMAN-CTP and 
RAMAN-COP cards:

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

P6 Back-Reflected Pump Power LINE-RX

P7 DWDM TX Input Power COM-RX

P8 Total Co-Pump in-fiber Output 
Power

LINE-TX

P9 DFB Input Power LINE-RX

P10 ASE Input Power LINE-RX

Table 5-11 RAMAN-CTP Port Calibration (continued)

Photodiode CTC Type Name Calibrated to Port

Table 5-12 RAMAN-CTP Port Calibration

Photodiode CTC Type Name Calibrated to Port

P3 Pump 1 in-fiber Output Power RAMAN-TX

P4 Pump 2 in-fiber Output Power RAMAN-TX

P5 Total Pump in-fiber Output Power RAMAN-TX

P6 Back-Reflected Pump Power RAMAN-TX
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5.11   OPT-EDFA-17 and OPT-EDFA-24 Cards
• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G201 Configure the Raman Pump on an MSTP Link, page 16-4

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27

• NTP-G184 Create a Provisionable Patchcord, page 17-77

• DLP-G690 Configure the Raman Pump Using Manual Day-0 Installation

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

5.11 OPT-EDFA-17 and OPT-EDFA-24 Cards

Note For OPT-EDFA-17 and OPT-EDFA-24 card specifications, see the OPT-EDFA-17 Amplifier Card 
Specifications and OPT-EDFA-24 Amplifier Card Specifications sections in the Hardware 
Specifications document.

Note For OPT-EDFA-17 and OPT-EDFA-24 card safety labels, see the “G.1.2 Class 1M Laser Product Cards” 
section on page G-4.

The OPT-EDFA-17 and OPT-EDFA-24 cards are C-band, DWDM EDFA amplifiers/preamplifiers with 
20-dBm output powers. These cards do not contain mid-stage access loss for a Dispersion Compensation 
Unit (DCU). The OPT-EDFA-17 and OPT-EDFA-24 cards provide a noise-figure optimized version of 
the EDFA amplifiers to cope with new modulation formats like PM-DQPSK, which do not need 
dispersion compensation. To control gain tilt, a VOA is used. The amplifier module also includes the 
OSC add (TX direction) and drop (RX direction) optical filters.

The OPT-EDFA-17 and OPT-EDFA-24 cards share the same hardware platform and firmware 
architecture but differ in their operative optical gain range, which is 17 dB and 24 dB respectively.

The OPT-EDFA-17 and OPT-EDFA-24 cards are true variable gain amplifiers, offering an optimal 
equalization of the transmitted optical channels over a wide gain range. They support 96 channels at 
50-GHz channel spacing in the C-band (that is, 1528.77 nm to 1566.72 nm wavelength range). When an 
ONS 15454 has an OPT-EDFA-17 or OPT-EDFA-24 card installed, an OSCM card is needed to process 
the OSC. You can install the OPT-EDFA-17 or OPT-EDFA-24 card in Slots 1 to 6 and 12 to 17. Slots 
2 to 6 and Slots 12 to 16 are the default slots for provisioning the OPT-EDFA-17 and OPT-EDFA-24 
cards as a preamplifier. Slots 1 and 17 are the default slots for provisioning the OPT-EDFA-17 and 
OPT-EDFA-24 cards as a booster amplifier. You can install the OPT-EDFA-17 or OPT-EDFA-24 card in 
Slots 2 and 3 in an ONS 15454 M2 chassis, and Slots 2 to 7 in an ONS 15454 M6 chassis.

The main functionalities of the OPT-EDFA-17 and OPT-EDFA-24 cards are:
5-44
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_F1E51EA0611E4D6E808D5ADFE153435D
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_00571E134BC6419DB84C48B88127E0C8
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_6F7DB9E72ABD455C969AA54F2040DAC5
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_49020A0465444625AF7652CC995032A8
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_cardnodes.html#task_2283A2FC0F6F42268507D128E59FCDBF
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html#reference_E10548A9457C41E6AB3901805F1F7F1D
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html#reference_E10548A9457C41E6AB3901805F1F7F1D
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html#reference_12EA573820354271AD9C29BA8E8B1355


 

Chapter 5      Provision Optical Amplifier Cards
5.11.1   Card Faceplate Ports and Block Diagrams
• Amplification of the input signal at COM-RX port towards LINE-TX port through a true-variable 
gain EDFA block

• Multiplexing the OSC to the LINE-TX port

• Demultiplexing the OSC from LINE-RX port

• Monitoring of the LINE input or output signal with 1% TAP splitters

The features of the OPT-EDFA-17 and OPT-EDFA-24 cards are:

• Embedded Gain Flattening Filter

• Constant pump current mode (test mode)

• Constant output power mode

• Constant gain mode

• Nondistorting low-frequency transfer function

• ASE compensation in Constant Gain and Constant Output Power modes

• Fast transient suppression

• Programmable tilt

• Full monitoring and alarm handling capability

• Gain range with gain tilt control of 5 to 17 dB (for OPT-EDFA-17 card) and 12 to 24 dB (for 
OPT-EDFA-24 card)

• Extended gain range (with uncontrolled tilt) of 17 to 20 dB (for OPT-EDFA-17 card) and 24 to 27 
dB (for OPT-EDFA-24 card)

• Optical Safety Remote Interlock (OSRI)

• Automatic Alarm Shutdown (ALS)

5.11.1 Card Faceplate Ports and Block Diagrams
The OPT-EDFA-17 and OPT-EDFA-24 cards have eight optical ports located on the faceplate:

• MON RX is the input monitor port (receive section). 

• MON TX is the output monitor port. 

• COM RX is the input signal port. 

• COM TX is the output signal port (receive section). 

• LINE RX is the input signal port (receive section).

• LINE TX is the output signal port. 

• OSC RX is the OSC add input port. 

• OSC TX is the OSC drop output port.
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5.11.1   Card Faceplate Ports and Block Diagrams
Figure 5-26 shows the OPT-EDFA-17 card faceplate.

Figure 5-26 OPT-EDFA-17 Card Faceplate 

The OPT-EDFA-24 card faceplate is similar to that of the OPT-EDFA-17 card.

Figure 5-27 shows a simplified block diagram of the OPT-EDFA-17 and OPT-EDFA-24 card features.
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5.11.1   Card Faceplate Ports and Block Diagrams
Figure 5-27 OPT-EDFA-17 and OPT-EDFA-24 Block Diagram

Figure 5-28 shows a block diagram of how the OPT-EDFA-17 and OPT-EDFA-24 optical modules 
function.

Figure 5-28 OPT-EDFA-17 and OPT-EDFA-24 Optical Modules Function
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5.11.2   OPT-EDFA-17 and OPT-EDFA-24 Cards Power Monitoring
5.11.2 OPT-EDFA-17 and OPT-EDFA-24 Cards Power Monitoring
Physical photodiodes PD1 through PD6 monitor the power for the OPT-EDFA-17 and OPT-EDFA-24 
cards (see Table 5-13).

5.11.3 OPT-EDFA-17 and OPT-EDFA-24 Card Functions
The functions of the OPT-EDFA-17 and OPT-EDFA-24 cards are:

• Card level indicators—Table G-4 on page G-9

• G.4 Port-Level Indicators, page G-10

5.11.4 Related Procedures for OPT-EDFA-17 and OPT-EDFA-24 Cards
The list of procedures and tasks related to the configuration of the OPT-EDFA-17 and OPT-EDFA-24 
cards are:

• NTP-G143 Import the Cisco Transport Planner NE Update Configuration File, page 14-47

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-67

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G38 Provision OSC Terminations, page 14-123

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G76 Verify Optical Span Loss Using CTC

• NTP-G74 Monitor DWDM Card Performance

• DLP-G140 View Power Statistics for Optical Amplifier, 40-SMR1-C, and 40-SMR2-C Cards

• NTP-G77 Manage Automatic Power Control

• NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

Table 5-13 OPT-EDFA-17 and OPT-EDFA-24 Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 EDFA Input Power COM-RX

P2 EDFA Output Power LINE-TX

P3 EDFA Output Power LINE-TX

P4 OSC ADD Input Power OSC-RX

P5 OSC DROP Output Power LINE-RX

P6 COM-TX Output Power LINE-RX
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Provision Multiplexer and Demultiplexer Cards

This chapter describes legacy multiplexer and demultiplexer cards used in Cisco ONS 15454 dense 
wavelength division multiplexing (DWDM) networks and related procedures. 

For card safety and compliance information, see the Regulatory Compliance and Safety Information for 
Cisco CPT and Cisco ONS Platforms document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 6.1 Card Overview, page 6-1

• 6.2 Safety Labels, page 6-9

• 6.3 32MUX-O Card, page 6-9

• 6.3.5 Related Procedures for the 32MUX-O Card, page 6-13

• 6.4 32DMX-O Card, page 6-14

• 6.4.4 Related Procedures for the 32DMX-O Card, page 6-18

• 6.5 4MD-xx.x Card, page 6-19

• 6.5.5 Related Procedures for the 4MD-xx.x Card, page 6-23

Note For a description of the 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 40-MUX-C, 40-WSS-C, 
40-WSS-CE, and 40-WXC-C cards, see the “Provision Reconfigurable Optical Add/Drop Cards” 
chapter.

6.1 Card Overview
The card overview section contains card summary, compatibility, interface class, and channel allocation 
plan information for legacy multiplexer and demultiplexer cards.

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. For a list of slots and symbols, see 
the “Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation Guide. 
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6.1.1 Card Summary
Table 6-1 lists and summarizes the functions of the 32MUX-O, 32DMX-O, and 4MD-xx.x cards.

6.1.2 Card Compatibility
Table 6-2 lists the CTC software compatibility for the legacy cards.

Table 6-1 Multiplexer and Demultiplexer Cards

Card Port Description For Additional Information

32MUX-O The 32MUX-O has five sets of ports located on the 
faceplate. It operates in Slots 1 to 5 and 12 to 16.

See the “6.3 32MUX-O Card” 
section on page 6-9.

32DMX-O The 32DMX-O has five sets of ports located on the 
faceplate. It operates in Slots 1 to 5 and 12 to 16.

“6.4 32DMX-O Card” section on 
page 6-14

4MD-xx.x The 4MD-xx.x card has five sets of ports located on 
the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “6.5 4MD-xx.x Card” 
section on page 6-19.

Table 6-2 Software Compatibility for Legacy Multiplexer and Demultiplexer Cards

Release

Cards

32MUX-O 32DMX-O 4MD-xx.x

R4.5 Yes Yes Yes

R4.6 Yes Yes Yes

R4.7 Yes Yes Yes

R5.0 Yes Yes Yes

R6.0 Yes Yes Yes

R7.0 Yes Yes Yes

R7.2 Yes Yes Yes

R8.0 Yes Yes Yes

R8.5 Yes Yes Yes

R9.0 Yes Yes Yes

R9.1 Yes Yes Yes

R9.2 Yes Yes Yes

R9.2.1 Yes Yes Yes

R9.3 Yes Yes Yes

R9.4 Yes Yes Yes
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6.1.3 Interface Classes
The 32MUX-O, 32DMX-O, and 4MD-xx.x cards have different input and output optical channel signals 
depending on the interface card where the input signal originates. The input interface cards have been 
grouped in classes listed in Table 6-3. The subsequent tables list the optical performance and output 
power of each interface class. 

Table 6-5 lists the optical performance parameters for 40-Gbps cards that provide signal input to 
multiplexer and demultiplexer cards.

Table 6-3 ONS 15454 Card Interfaces Assigned to Input Power Classes

Input Power Class Card

A 10-Gbps multirate transponder cards (TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, and TXP_MR_10E_L) with forward error correction (FEC) 
enabled, 10-Gbps muxponder cards (MXP_2.5G_10G, MXP_2.5G_10E, 
MXP_MR_10DME_C, MXP_MR_10DME_L, MXP_2.5G_10E_C, and 
MXP_2.5G_10E_L) with FEC enabled, 40-Gbps transponder cards (40E-TXP-C, 
and 40ME-TXP-C), and 40-Gbps muxponder cards (40G-MXP-C, 40E-MXP-C, 
and 40ME-MXP-C)

B 10-Gbps multirate transponder card (TXP_MR_10G) without FEC, 10-Gbps 
muxponder cards (MXP_2.5G_10G, MXP_MR_10DME_C, 
MXP_MR_10DME_L), 40-Gbps transponder cards (40E-TXP-C, and 
40ME-TXP-C), 40-Gbps muxponder cards (40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C), and ADM-10G cards with FEC disabled

C OC-192 LR ITU cards (TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L) 
without FEC

D 2.5-Gbps multirate transponder card (TXP_MR_2.5G), both protected and 
unprotected, with FEC enabled

E OC-48 100-GHz DWDM muxponder card (MXP_MR_2.5G) and 2.5-Gbps 
multirate transponder card (TXP_MR_2.5G), protected or unprotected, with FEC 
disabled and retime, reshape, and regenerate (3R) mode enabled

F 2.5-Gbps multirate transponder card (TXP_MR_2.5G), protected or unprotected, 
in regenerate and reshape (2R) mode

G OC-48 ELR 100 GHz card

H 2/4 port GbE transponder (GBIC WDM 100GHz)

I TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L, 40E-TXP-C, and 
40ME-TXP-C cards with enhanced FEC (E-FEC) and the MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_MR_10DME_C, 
MXP_MR_10DME_L, 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards with 
E-FEC enabled
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Table 6-5 lists the optical performance parameters that provide signal input for the 40-Gbps multiplexer 
and demultiplexer cards.

Table 6-4 40-Gbps Interface Optical Performance

Parameter Class A Class B Class I

Type
Power 
Limited

OSNR1 
Limited

1. OSNR = optical signal-to-noise ratio

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum bit rate 40 Gbps 40 Gbps 40 Gbps

Regeneration 3R 3R 3R

FEC Yes No Yes (E-FEC)

Threshold Optimum Average Optimum

Maximum BER2

2. BER = bit error rate

10–15 10–12 10–15

OSNR1 sensitivity 23 dB 9 dB 23 dB 19 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –21 dBm –20 dBm –26 dBm –18 dBm

Power overload –8 dBm –8 dBm –8 dBm

Transmitted Power Range3

3. These values, decreased by patchcord and connector losses, are also the input power values for the OADM 
cards.

40-Gbps multirate 
transponder/40-Gbps 
EC transponder 
(40E-TXP-C and 
40ME-TXP-C)

+2.5 to 3.5 dBm +2.5 to 3.5 dBm —

OC-192 LR ITU — — —

Dispersion 
compensation 
tolerance

+/–800 ps/nm +/–1,000 ps/nm +/–800 ps/nm

Table 6-5 10-Gbps Interface Optical Performance Parameters

Parameter Class A Class B Class C Class I

Type
Power 
Limited

OSNR1 
Limited

Power 
Limited

OSNR 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum bit rate 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneration 3R 3R 3R 3R

FEC Yes No No Yes (E-FEC)

Threshold Optimum Average Average Optimum

Maximum BER2 10–15 10–12 10–12 10–15

OSNR1 sensitivity 23 dB 9 dB 23 dB 19 dB 19 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –21 dBm –20 dBm –22 dBm –26 dBm –18 dBm
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Table 6-6 lists the optical interface performance parameters for 2.5-Gbps cards that provide signal input 
to multiplexer and demultiplexer cards. 

Power overload –8 dBm –8 dBm –9 dBm –8 dBm

Transmitted Power Range3

10-Gbps multirate 
transponder/10-Gbps 
FEC transponder 
(TXP_MR_10G)

+2.5 to 3.5 dBm +2.5 to 3.5 dBm — —

OC-192 LR ITU — — +3.0 to 6.0 
dBm

—

10-Gbps multirate 
transponder/10-Gbps 
FEC transponder 
(TXP_MR_10E)

+3.0 to 6.0 dBm +3.0 to 6.0 dBm — +3.0 to 6.0 dBm

Dispersion 
compensation 
tolerance

+/–800 ps/nm +/–1,000 ps/nm +/–1,000 
ps/nm

+/–800 ps/nm

1. OSNR = optical signal-to-noise ratio

2. BER = bit error rate

3. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

Table 6-5 10-Gbps Interface Optical Performance Parameters (continued)

Parameter Class A Class B Class C Class I

Type
Power 
Limited

OSNR1 
Limited

Power 
Limited

OSNR 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Table 6-6 2.5-Gbps Interface Optical Performance

Parameter Class D Class E Class F Class G Class H Class J

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

Maximum bit rate 2.5 Gbps 2.5 Gbps 2.5 Gbps 2.5 Gbps 1.25 Gbps 2.5 Gbps

Regeneration 3R 3R 2R 3R 3R 3R

FEC Yes No No No No No

Threshold Average Average Average Average Average Average

Maximum BER 10–15 10–12 10–12 10–12 10–12 10–12

OSNR sensitivity 14 dB 6 dB 14 dB 10 dB 15 dB 14 dB 11 dB 13 dB 8 dB 12 dB

Power sensitivity –31 
dBm

–25 
dBm

–30 
dBm

–23 
dBm

–24 dBm –27 
dBm

–33 
dBm

–28 dBm –18 dBm –26 dBm

Power overload –9 dBm –9 dBm –9 dBm –9 dBm –7 dBm –17dBm
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6.1.4 Channel Allocation Plan
ONS 15454 DWDM multiplexer and demultiplexer cards are designed for use with specific channels in 
the C band and L band. In most cases, the channels for these cards are either numbered (for example, 
1 to 32 or 1 to 40) or delimited (odd or even). Client interfaces must comply with these channel 
assignments to be compatible with the ONS 15454 system.

Table 6-7 lists the channel IDs and wavelengths assigned to the C-band DWDM channels. 

Note In some cases, a card uses only one of the bands (C band or L band) and some or all of the channels listed 
in a band. Also, some cards use channels on the 100-GHz ITU grid while others use channels on the 
50-GHz ITU grid. See the specific card description or the “Hardware Specifications” document for more 
details.

Transmitted Power Range1

TXP_MR_2.5G –1.0 to 1.0 dBm –1.0 to 1.0 dBm –1.0 to 
1.0 dBm

–2.0 to 0 dBm

TXPP_MR_2.5G –4.5 to –2.5 dBm –4.5 to –2.5 dBm –4.5 to 
–2.5 dBm

MXP_MR_2.5G — +2.0 to +4.0 dBm —

MXPP_MR_2.5G — –1.5 to +0.5 dBm —

2/4 port GbE 
Transponder (GBIC 
WDM 100GHz)

+2.5 to 3.5 dBm —

Dispersion 
compensation 
tolerance

 –1200 to 
+5400 ps/nm

 –1200 to 
+5400 ps/nm

 –1200 to 
+3300 
ps/nm

 –1200 to 
+3300 ps/nm

–1000 to +3600 
ps/nm

–1000 to 
+3200 
ps/nm

1. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

Table 6-6 2.5-Gbps Interface Optical Performance (continued)

Parameter Class D Class E Class F Class G Class H Class J

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

Table 6-7 DWDM Channel Allocation Plan (C Band)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115
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Table 6-8 lists the channel IDs and wavelengths assigned to the L-band channels.

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 6-7 DWDM Channel Allocation Plan (C Band) (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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Table 6-8 DWDM Channel Allocation Plan (L Band)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 190.85 1570.83 41 188.85 1587.46

2 190.8 1571.24 42 188.8 1587.88

3 190.75 1571.65 43 188.75 1588.30

4 190.7 1572.06 44 188.7 1588.73

5 190.65 1572.48 45 188.65 1589.15

6 190.6 1572.89 46 188.6 1589.57

7 190.55 1573.30 47 188.55 1589.99

8 190.5 1573.71 48 188.5 1590.41

9 190.45 1574.13 49 188.45 1590.83

10 190.4 1574.54 50 188.4 1591.26

11 190.35 1574.95 51 188.35 1591.68

12 190.3 1575.37 52 188.3 1592.10

13 190.25 1575.78 53 188.25 1592.52

14 190.2 1576.20 54 188.2 1592.95

15 190.15 1576.61 55 188.15 1593.37

16 190.1 1577.03 56 188.1 1593.79

17 190.05 1577.44 57 188.05 1594.22

18 190 1577.86 58 188 1594.64

19 189.95 1578.27 59 187.95 1595.06

20 189.9 1578.69 60 187.9 1595.49

21 189.85 1579.10 61 187.85 1595.91

22 189.8 1579.52 62 187.8 1596.34

23 189.75 1579.93 63 187.75 1596.76

24 189.7 1580.35 64 187.7 1597.19

25 189.65 1580.77 65 187.65 1597.62

26 189.6 1581.18 66 187.6 1598.04

27 189.55 1581.60 67 187.55 1598.47

28 189.5 1582.02 68 187.5 1598.89

29 189.45 1582.44 69 187.45 1599.32

30 189.4 1582.85 70 187.4 1599.75

31 189.35 1583.27 71 187.35 1600.17

32 189.3 1583.69 72 187.3 1600.60

33 189.25 1584.11 73 187.25 1601.03

34 189.2 1584.53 74 187.2 1601.46

35 189.15 1584.95 75 187.15 1601.88
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6.2 Safety Labels
For information about safety labels, see the “G.1 Safety Labels” section on page G-1”.

6.3 32MUX-O Card

Note For 32MUX-O card specifications, see the “32MUX-O Card Specifications” section in the Hardware 
Specifications document.

The 32-Channel Multiplexer (32MUX-O) card multiplexes 32 100-GHz-spaced channels identified in 
the channel plan. The 32MUX-O card takes up two slots in an ONS 15454 and can be installed in 
Slots 1 to 5 and 12 to 16. 

6.3.1 32MUX-O Card Functions
The 32MUX-O functions include:

• Arrayed waveguide grating (AWG) device that enables full multiplexing functions for the channels.

• Each single-channel port is equipped with VOAs for automatic optical power regulation prior to 
multiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for 
safety purposes. A manual VOA setting is also available.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.

• Card level indicators—Table G-4 on page G-9

An additional optical monitoring port with 1:99 splitting ratio is available.

6.3.2 32MUX-O Card Faceplate and Block Diagram
Figure 6-1 shows the 32MUX-O faceplate.

36 189.1 1585.36 76 187.1 1602.31

37 189.05 1585.78 77 187.05 1602.74

38 189 1586.20 78 187 1603.17

39 188.95 1586.62 79 186.95 1603.60

40 188.9 1587.04 80 186.9 1604.03

Table 6-8 DWDM Channel Allocation Plan (L Band) (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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Figure 6-1 32MUX-O Faceplate 

For information on safety labels for the card, see the “G.1 Safety Labels” section on page G-1”.

Figure 6-2 shows a block diagram of the 32MUX-O card. 
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Figure 6-2 32MUX-O Block Diagram

The 32MUX-O card has four receive connectors that accept multifiber push-on (MPO) cables on its front 
panel for the client input interfaces. MPO cables break out into eight separate cables. The 32MUX-O 
card also has two LC-PC-II optical connectors, one for the main output and the other for the monitor port.

Figure 6-3 shows the 32MUX-O optical module functional block diagram.

Figure 6-3 32MUX-O Optical Module Functional Block Diagram

6.3.2.1 Port-Level Indicators for the 32MUX-O Cards

The 32MUX-O card has five sets of ports located on the faceplate. COM TX is the line output. COM 
MON is the optical monitoring port. The xx.x to yy.y RX ports represent the four groups of eight 
channels ranging from wavelength xx.x to wavelength yy.y, according to the channel plan.
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6.3.3 Channel Plan
The 32MUX-O is typically used in hub nodes and provides the multiplexing of 32 channels, spaced at 
100 GHz, into one fiber before their amplification and transmission along the line. The channel plan is 
shown in Table 6-9.

Table 6-9 32MUX-O Channel Plan

Channel Number1 Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98
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6.3.4   Power Monitoring
6.3.4 Power Monitoring
Physical photodiodes P1 through P32 monitor the power for the 32MUX-O card. The returned power 
level values are calibrated to the ports as shown in Table 6-10.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

6.3.5 Related Procedures for the 32MUX-O Card
The following is the list of procedures and tasks related to the configuration of the 32MUX-O card:

• “DLP-G353 Preprovision a Slot” task on page 14-53

• “NTP-G30 Install the DWDM Cards” task on page 14-63

• “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” task on page 14-47

• “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” task on page 14-74

• “NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes” task on 
page 14-79

• “DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Standard Patch Panel Tray” task on page 14-82

• “DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Deep Patch Panel Tray” task on page 14-87

• “NTP-G184 Create a Provisionable Patchcord” task on page 17-77

• “NTP-G152 Create and Verify Internal Patchcords” task on page 14-110

• “NTP-G242 Create an Internal Patchcord Manually” task on page 14-111

• “NTP-G86 Convert a Pass-Through Connection to Add/Drop Connections”

• “NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance 
Test” task on page 15-3

• “NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test” task on page 15-72

• “NTP-G74 Monitor DWDM Card Performance”

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61

1. The Channel Number column is only for reference purposes. The channel ID is consistent with 
the ONS 15454 and is used in card identification.

Table 6-9 32MUX-O Channel Plan

Channel Number1 Channel ID Frequency (GHz) Wavelength (nm)

Table 6-10 32MUX-O Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 ADD COM TX
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6.4   32DMX-O Card
• “DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards”

• “NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds” task on page 21-54

• “DLP-G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-55

• “DLP-G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-57

• “DLP-G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-59

• “DLP-G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-62

• “DLP-G78 Verify the 32MUX-O or 40-MUX-C Card Power” task on page 15-7

• “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7

• “DLP-G355 Delete an Internal Patchcord” task on page 14-120

• “NTP-G106 Reset Cards Using CTC” task on page 24-14

• “DLP-G251 Reset DWDM Cards Using CTC” task on page 24-15

• “NTP-G107 Remove Permanently or Remove and Replace DWDM Card”

• “DLP-G351 Delete a Card in CTC” task on page 14-51

• “NTP-G119 Power Down the Node” task on page 24-23

6.4 32DMX-O Card

Note For 32DMX-O card specifications, see the “32DMX-O Card Specifications” section in the Hardware 
Specifications document.

The 32-Channel Demultiplexer (32DMX-O) card demultiplexes 32 100-GHz-spaced channels identified 
in the channel plan. The 32DMX-O takes up two slots in an ONS 15454 and can be installed in 
Slots 1 to 5 and 12 to 16.

6.4.1 32DMX-O Card Functions
The 32DMX-O functions include:

• AWG that enables channel demultiplexing functions.

• Each single-channel port is equipped with VOAs for automatic optical power regulation after 
demultiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation 
for safety purposes. A manual VOA setting is also available. 

• The 32DXM-O has four physical receive connectors that accept MPO cables on its front panel for 
the client input interfaces. MPO cables break out into eight separate cables.
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6.4.2   32DMX-O Card Faceplate and Block Diagram
Note In contrast, the single-slot 32DMX card does not have VOAs on each drop port for optical power 
regulation. The 32DMX optical demultiplexer module is used in conjunction with the 32WSS 
card in ONS 15454 Multiservice Transport Platform (MSTP) nodes.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.

• Card level indicators—Table G-4 on page G-9

6.4.2 32DMX-O Card Faceplate and Block Diagram
Figure 6-4 shows the 32DMX-O card faceplate.
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Chapter 6      Provision Multiplexer and Demultiplexer Cards
6.4.2   32DMX-O Card Faceplate and Block Diagram
Figure 6-4 32DMX-O Faceplate 

For information on safety labels for the card, see the “G.1 Safety Labels” section on page G-1”.

Figure 6-5 shows a block diagram of the 32DMX-O card.
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6.4.3   Power Monitoring
Figure 6-5 32DMX-O Block Diagram

Figure 6-6 shows the 32DMX-O optical module functional block diagram.

Figure 6-6 32DMX-O Optical Module Functional Block Diagram

6.4.2.1 Port-Level Indicators for the 32DMX-O Cards

The 32DMX-O card has five sets of ports located on the faceplate. MON is the output monitor port. COM 
RX is the line input. The xx.x to yy.y TX ports represent the four groups of eight channels ranging from 
wavelength xx.x to wavelength yy.y according to the channel plan.

6.4.3 Power Monitoring
Physical photodiodes P1 through P33 monitor the power for the 32DMX-O card. The returned power 
level values are calibrated to the ports as shown in Table 6-11.
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6.4.4   Related Procedures for the 32DMX-O Card
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

6.4.4 Related Procedures for the 32DMX-O Card
The following is the list of procedures and tasks related to the configuration of the 32DMX-O card:

• “DLP-G353 Preprovision a Slot” task on page 14-53

• “NTP-G30 Install the DWDM Cards” task on page 14-63

• “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” task on page 14-47

• “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” task on page 14-74

• “NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes” task on 
page 14-79

• “DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Standard Patch Panel Tray” task on page 14-82

• “DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Deep Patch Panel Tray” task on page 14-87

• “NTP-G184 Create a Provisionable Patchcord” task on page 17-77

• “NTP-G152 Create and Verify Internal Patchcords” task on page 14-110

• “NTP-G242 Create an Internal Patchcord Manually” task on page 14-111

• “NTP-G86 Convert a Pass-Through Connection to Add/Drop Connections”

• “NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test” task on page 15-72

• “NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance 
Test” task on page 15-3

• “NTP-G74 Monitor DWDM Card Performance”

• “DLP-G78 Verify the 32MUX-O or 40-MUX-C Card Power” task on page 15-7

• “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7

• “DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards”

• “NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds” task on page 21-54

• “DLP-G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-55

• “DLP-G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-57

Table 6-11 32DMX-O Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 DROP DROP TX

P33 INPUT COM COM RX
6-18
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_7D32F0D9CEB24E6B97D25B5A93FF376B
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_00571E134BC6419DB84C48B88127E0C8
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_858A0BD3FDC54E19B891BB5568BB4988
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_858A0BD3FDC54E19B891BB5568BB4988
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_858A0BD3FDC54E19B891BB5568BB4988


 

Chapter 6      Provision Multiplexer and Demultiplexer Cards
6.5   4MD-xx.x Card
• “DLP-G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-59

• “DLP-G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-62

• “DLP-G355 Delete an Internal Patchcord” task on page 14-120

• “NTP-G106 Reset Cards Using CTC” task on page 24-14

• “DLP-G251 Reset DWDM Cards Using CTC” task on page 24-15

• “NTP-G107 Remove Permanently or Remove and Replace DWDM Card”

• “DLP-G351 Delete a Card in CTC” task on page 14-51

• “NTP-G119 Power Down the Node” task on page 24-23

6.5 4MD-xx.x Card

Note For 4MD-xx.x card specifications, see the section “4MD-xx.x Card Specifications” section in the 
Hardware Specifications document.

The 4-Channel Multiplexer/Demultiplexer (4MD-xx.x) card multiplexes and demultiplexes four 
100-GHz-spaced channels identified in the channel plan. The 4MD-xx.x card is designed to be used with 
band OADMs (both AD-1B-xx.x and AD-4B-xx.x). 

The card is bidirectional. The demultiplexer and multiplexer functions are implemented in two different 
sections of the same card. In this way, the same card can manage signals flowing in opposite directions.

There are eight versions of this card that correspond with the eight sub-bands specified in Table 6-12 on 
page 6-22. The 4MD-xx.x can be installed in Slots 1 to 6 and 12 to 17.

6.5.1 4MD-xx.x Card Functions
The 4MD-xx.x has the following functions implemented inside a plug-in optical module:

• Passive cascade of interferential filters perform the channel multiplex/demultiplex function.

• Software-controlled VOAs at every port of the multiplex section regulate the optical power of each 
multiplexed channel.

• Software-monitored photodiodes at the input and output multiplexer and demultiplexer ports for 
power control and safety purposes.

• Software-monitored virtual photodiodes at the common DWDM output and input ports. A virtual 
photodiode is a firmware calculation of the optical power at that port. This calculation is based on 
the single channel photodiode reading and insertion losses of the appropriated paths.

• Card level indicators—Table G-4 on page G-9

6.5.2 4MD-xx.x Card Faceplate and Block Diagram
Figure 6-7 shows the 4MD-xx.x faceplate.
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6.5.2   4MD-xx.x Card Faceplate and Block Diagram
Figure 6-7 4MD-xx.x Faceplate 

For information on safety labels for the card, see the “G.1 Safety Labels” section on page G-1”.

Figure 6-8 shows a block diagram of the 4MD-xx.x card.
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6.5.2   4MD-xx.x Card Faceplate and Block Diagram
Figure 6-8 4MD-xx.x Block Diagram

Figure 6-9 shows the 4MD-xx.x optical module functional block diagram.

Figure 6-9 4MD-xx.x Optical Module Functional Block Diagram

The optical module shown in Figure 6-9 is optically passive and consists of a cascade of interferential 
filters that perform the channel multiplexing and demultiplexing functions.

VOAs are present in every input path of the multiplex section in order to regulate the optical power of 
each multiplexed channel. Some optical input and output ports are monitored by means of photodiodes 
implemented both for power control and for safety purposes. An internal control manages VOA settings 
and functionality as well as photodiode detection and alarm thresholds. The power at the main output 
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6.5.3   Wavelength Pairs
and input ports is monitored through the use of virtual photodiodes. A virtual photodiode is implemented 
in the firmware of the plug-in module. This firmware calculates the power on a port, summing the 
measured values from all single channel ports (and applying the proper path insertion loss) and then 
providing the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card with the obtained value. 

6.5.2.1 Port-Level Indicators for the 4MD-xx.x Cards

The 4MD-xx.x card has five sets of ports located on the faceplate. COM RX is the line input. COM TX 
is the line output. The 15xx.x TX ports represent demultiplexed channel outputs 1 to 4. The 15xx.x RX 
ports represent multiplexed channel inputs 1 to 4.

6.5.3 Wavelength Pairs
Table 6-12 shows the band IDs and the add/drop channel IDs for the 4MD-xx.x card.

6.5.4 Power Monitoring
Physical photodiodes P1 through P8 and virtual photodiodes V1 and V2 monitor the power for the 
4MD-xx.x card. The returned power level values are calibrated to the ports as shown in Table 6-13.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Table 6-12 4MD-xx.x Channel Sets

Band ID Add/Drop Channel IDs

Band 30.3 (A) 30.3, 31.2, 31.9, 32.6

Band 34.2 (B) 34.2, 35.0, 35.8, 36.6

Band 38.1 (C) 38.1, 38.9, 39.7, 40.5

Band 42.1 (D) 42.1, 42.9, 43.7, 44.5

Band 46.1 (E) 46.1, 46.9, 47.7, 48.5

Band 50.1 (F) 50.1, 50.9, 51.7, 52.5

Band 54.1 (G) 54.1, 54.9, 55.7, 56.5

Band 58.1 (H) 58.1, 58.9, 59.7, 60.6

Table 6-13 4MD-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

V1 OUT COM COM TX

V2 IN COM COM RX
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6.5.5   Related Procedures for the 4MD-xx.x Card
6.5.5 Related Procedures for the 4MD-xx.x Card
The following is the list of procedures and tasks related to the configuration of the 4MD-xx.x card:

• “DLP-G353 Preprovision a Slot” task on page 14-53

• “NTP-G30 Install the DWDM Cards” task on page 14-63

• “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” task on page 14-47

• “NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards” 
task on page 15-95

• “DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 15-100

• “DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power” task on page 15-101

• “DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards” task on 
page 15-105

• “NTP-G49 Perform the Active OADM Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards” task on page 15-107

• “DLP-G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards” task on 
page 15-111

• “NTP-G59 Create, Delete, and Manage Optical Channel Network Connections” task on page 17-40

• “DLP-G105 Provision Optical Channel Network Connections” task on page 17-44

• “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” task on page 14-74

• “NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes” task on 
page 14-79

• “DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Standard Patch Panel Tray” task on page 14-82

• “DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards 
to the Deep Patch Panel Tray” task on page 14-87

• “NTP-G184 Create a Provisionable Patchcord” task on page 17-77

• “NTP-G152 Create and Verify Internal Patchcords” task on page 14-110

• “NTP-G242 Create an Internal Patchcord Manually” task on page 14-111

• “NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance 
Test” task on page 15-3

• “NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test” task on page 15-72

• “NTP-G86 Convert a Pass-Through Connection to Add/Drop Connections”

• “NTP-G74 Monitor DWDM Card Performance”

• “DLP-G78 Verify the 32MUX-O or 40-MUX-C Card Power” task on page 15-7

• “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7

• “DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards”

• “NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds” task on page 21-54
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Chapter 6      Provision Multiplexer and Demultiplexer Cards
6.5.5   Related Procedures for the 4MD-xx.x Card
• “DLP-G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-55

• “DLP-G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-57

• “DLP-G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-59

• “DLP-G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards” task on page 21-62

• “DLP-G355 Delete an Internal Patchcord” task on page 14-120

• “NTP-G106 Reset Cards Using CTC” task on page 24-14

• “DLP-G251 Reset DWDM Cards Using CTC” task on page 24-15

• “NTP-G107 Remove Permanently or Remove and Replace DWDM Card”

• “DLP-G351 Delete a Card in CTC” task on page 14-51

• “NTP-G119 Power Down the Node” task on page 24-23
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Setup Tunable Dispersion Compensating Units

This chapter explains the Tunable Dispersion Compensating Units (T-DCU) used in Cisco ONS 15454 
dense wavelength division multiplexing (DWDM) networks. For card safety and compliance 
information, refer to the Regulatory Compliance and Safety Information for Cisco CPT and Cisco ONS 
Platforms document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

The T-DCU unit compensates for chromatic dispersion (CD) of the transmission fiber. The T-DCU 
provides two line cards with varied set of tunable wavelengths to compensate for CD.

This chapter includes:

• 7.1 Card Overview, page 7-1

• 7.2 Safety Labels, page 7-2 

• 7.3 TDC-CC and TDC-FC Cards, page 7-2

• 7.4 Monitoring Optical Performance, page 7-5

• 7.4.1 Related Procedures for TDC-CC and TDC-FC Cards, page 7-6

7.1 Card Overview
The T-DCU card provides a selectable set of discrete negative chromatic dispersion values to compensate 
for chromatic dispersion of the transmission line. The card operates over the entire C-band (in the range 
of 1529.0 nm to 1562.5 nm) and monitors the optical power at the input and the output ports. The two 
types of T-DCU line cards are:

• TDC-CC (Coarse T-DCU)

• TDC-FC (Fine T-DCU)

Note Each T-DCU card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf 
assembly. Cards should be installed in slots that have the same symbols. See the “Card Slot 
Requirements” section in the Cisco ONS 15454 Hardware Installation Guide.
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Chapter 7      Setup Tunable Dispersion Compensating Units
7.1.1   Card Summary
7.1.1 Card Summary
Table 7-1 lists and summarizes the information about the TDC-CC and TDC-FC cards.

7.2 Safety Labels
For information about safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

7.3 TDC-CC and TDC-FC Cards
The TDC-CC card provides 16 values of CD ranging from 0 to -1650 ps/nm with a granularity of 
110 ps/nm in the C-band spectrum. 

The TDC-FC card provides 16 values of CD ranging from 0 to -675 ps/nm with a granularity of 45 ps/nm 
in the C-band spectrum.

You can configure the TDC-CC and TDC-FC cards for the CD value listed in Table 7-2.

Table 7-1 T-DCU Cards

Card Port Description For Additional Information

TDC-CC The TDC-CC has one set of optical ports 
located on the faceplate. It operates in slots 1 
to 6 and slots 12 to 17.

See the 7.3 TDC-CC and TDC-FC 
Cards section.

TDC-FC The TDC-FC has one set of optical ports 
located on the faceplate. It operates in slots 1 
to 6 and slots 12 to 17. 

Table 7-2 TDC-CC and TDC-FC Tunable CD Value

Unit Configuration TDC-CC [ps/nm] TDC-FC [ps/nm]

0 0 1 02

1 -110 -45

2 -220 -90

3 -330 -135

4 -440 -180

5 -550 -225

6 -660 -270

7 -770 -315

8 -880 -360

9 -990 -405

10 -1100 -450

11 -1210 -495

12 -1320 -540
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Chapter 7      Setup Tunable Dispersion Compensating Units
7.3.1   Key Features
7.3.1 Key Features
The TDC-CC and TDC-FC cards provide the following features:

• Single slot card with three LEDs on the front panel.

• Two LC-PC-II optical connectors on the front panel.

• Operates in slots from slot 1 to 6 and 12 to 17.

• Operates over the C-band (wavelengths from 1529 nm to 1562.5 nm) of the optical spectrum.

• Allows upto 16 provisionable CD values for chromatic dispersion compensation.

• Connects to OPT-PRE, OPT-AMP-C, OPT-RAMP-C, and OPT-RAMP-CE amplifiers and 
40-SMR-1 and 40-SMR-2 cards.

• Supports performance monitoring and alarm handling for selectable thresholds.

• Allows monitoring and provisioning using CTC, SNMP, or TL1.

7.3.2 TDC-CC and TDC-FC Faceplate Diagram
Figure 7-1 shows the TDC-CC and TDC-FC faceplate diagram. The TDC-CC and TDC-FC cards can be 
installed or pulled out of operation from any user interface slot, without impacting other service cards 
operating within that shelf.

13 -1430 -585

14 -1540 -630

15 -1650 -675

1. The default value of the TDC-CC CD value for Coarse Unit is 0.

2. The default value of the TDC-FC value for Fine Unit is 0.

Table 7-2 TDC-CC and TDC-FC Tunable CD Value

Unit Configuration TDC-CC [ps/nm] TDC-FC [ps/nm]
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Chapter 7      Setup Tunable Dispersion Compensating Units
7.3.3   Functioning of Optical Ports
Figure 7-1 TDC-CC and TDC-FC Faceplates

Note The coarse T-DCU is identified with the card label as TDC-CC and the fine T-DCU with TDC-FC in the 
faceplate of the T-DCU card.

7.3.3 Functioning of Optical Ports
The T-DCU unit contains the DC-RX (input) and DC-TX (output) ports. The optical signal enters the 
DC-RX port, compensates the chromatic dispersion and then exits from the DC-TX port.
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Chapter 7      Setup Tunable Dispersion Compensating Units
7.3.4   TDC-CC and TDC-FC Block Diagram
7.3.4 TDC-CC and TDC-FC Block Diagram
The TDC-CC and TDC-FC cards embed an optical module with four spools (D1, D2, D3, and D4) of 
dispersion compensating fiber that connects through the 2x2 bypass switches (Figure 7-2). Each bypass 
switch allows the corresponding dispersion compensation fiber spools to connect to the optical path from 
the DC-RX (input port) to the DC-TX (output port). The switch configuration selects the requested CD 
value and combines the four spools based on the 16 chromatic dispersion compensation values fetched. 
The photo diodes PD1 and PD2 are used to monitor the input and output ports respectively.

Figure 7-2 Block Diagram of TDC-CC and TDC-FC

7.3.5 TDC-CC and TDC-FC Cards Functions
The functions of the TDC-CC and TDC-FC cards are:

• G.15 Lamp Test, page G-22

• Card level indicators—Table G-1 on page G-8

7.4 Monitoring Optical Performance
The TDC-CC and TDC-FC cards monitor the optical input power and optical output power of the fiber. 
It monitors the insertion loss from the input (DC-RX) to the output (DC-TX) port, with the help of the 
two photodiodes PD1 and PD2. The TDC-CC and TDC-FC cards report the minimum, average, and 
maximum power statistics of each of the monitored ports or channels in the specific card. To view the 
optical power statistics of the TDC-CC and TDC-FC cards, refer to the Monitor Performance document. 
The performance data is recorded at 15 minutes and 24 hours intervals. 

Note You can view the performance monitoring (PM) data of the card using CTC, SNMP, and TL1 interfaces. 

Note The PM data is stored on a wrap-around basis at 32 x 15 min. and 2 x 24 hour intervals.
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7.4.1   Related Procedures for TDC-CC and TDC-FC Cards
7.4.1 Related Procedures for TDC-CC and TDC-FC Cards
The following section lists procedures and tasks related to the configuration of the TDC-CC and 
TDC-FC cards:

• NTP-G30 Install the DWDM Cards, page 14-63

• DLP-G525 View Optical Power Statistics for TDC-CC and TDC-FC cards

• NTP-G240 Modify TDC-CC and TDC-FC Line Settings and PM Thresholds, page 21-76

• NTP-G242 Modify the CD setting of TDC-CC and TDC-FC Cards 

• NTP-G119 Power Down the Node, page 24-23
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Provision Protection Switching Module 

This chapter describes the Protection Switching Module (PSM) card used in Cisco ONS 15454 dense 
wavelength division multiplexing (DWDM) networks. For card safety and compliance information, refer 
to the Regulatory Compliance and Safety Information for Cisco CPT and Cisco ONS Platforms 
document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 8.1 PSM Card Overview

• 8.1.6 Related Procedures for PSM Card, page 8-5

8.1 PSM Card Overview
The PSM card performs splitter protection functions. In the transmit (TX) section of the PSM card (see 
Figure 8-1), the signal received on the common receive port is duplicated by a hardware splitter to both 
the working and protect transmit ports. In the receive (RX) section of the PSM card (Figure 8-1), a 
switch is provided to select one of the two input signals (on working and protect receive ports) to be 
transmitted through the common transmit port.

The PSM card supports multiple protection configurations:

• Channel protection—The PSM COM ports are connected to the TXP/MXP trunk ports.

• Line (or path) protection—The PSM working (W) and protect (P) ports are connected directly to the 
external line.

• Multiplex section protection—The PSM is equipped between the MUX/DMX stage and the 
amplification stage.

• Standalone—The PSM can be equipped in any slot and supports all node configurations.

The PSM card is a single-slot card that can be installed in any node from Slot 1 to 6 and 12 to 17. The 
PSM card includes six LC-PC-II optical connectors on the front panel. In channel protection 
configuration, the PSM card can be installed in a different shelf from its peer TXP/MXP card.
8-1
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Chapter 8      Provision Protection Switching Module
8.1.1   Key Features
Note It is strongly recommended that you use the default layouts designed by Cisco Transport Planner, 
which place the PSM card and its peer TXP/MXP card as close as possible to simplify cable 
management. 

For more information on the node configurations supported for the PSM card, see the 12.3 Supported 
Node Configurations for PSM Card, page 12-45.

For more information on the network topologies supported for the PSM card, see the 13.6 Network 
Topologies for the PSM Card, page 13-19.

8.1.1 Key Features
The PSM card provides the following features:

• Operates over the C-band (wavelengths from 1529 nm to 1562.5 nm) and L-band (wavelengths from 
1570.5 nm to 1604 nm) of the optical spectrum. 

• Implements bidirectional non-revertive protection scheme. For more details on bidirectional 
switching, see the “8.1.5 PSM Bidirectional Switching” section on page 8-4.

• Supports automatic creation of splitter protection group when the PSM card is provisioned.

• Supports switching priorities based on ITU-T G.873.1.

• Supports performance monitoring and alarm handling with settable thresholds.

• Supports automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut. ALS 
is applicable only in line protection configuration. For information about using the card to 
implement ALS in a network, see the 13.11 Network Optical Safety, page 13-30.

8.1.2 PSM Block Diagram
Figure 8-1 shows a simplified block diagram of the PSM card.
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Chapter 8      Provision Protection Switching Module
8.1.3   PSM Faceplate Ports
Figure 8-1 PSM Block Diagram

8.1.3 PSM Faceplate Ports
The PSM card has six optical ports located on the faceplate:

• COM-RX (receive) is the input signal port.

• COM-TX (transmit) is the output signal port.

• W-RX is the working input signal port (receive section).

• W-TX is the working output signal port (transmit section).

• P-RX is the protect input signal port (receive section).

• P-TX is the protect output signal port (transmit section).

All ports are equipped with photodiodes to monitor optical power and other related thresholds. The 
COM-RX port is equipped with a virtual photodiode (firmware calculations of port optical power) to 
monitor optical power. The W-RX, P-RX, W-TX, and P-TX ports have optical power regulation, which 
are provided by variable optical attenuators (VOA). All VOAs equipped within the PSM card work in 
control attenuation mode. 

Figure 8-2 shows the PSM card faceplate.
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Chapter 8      Provision Protection Switching Module
8.1.4   PSM Card-Level Indicators
Figure 8-2 PSM Card Faceplate

8.1.4 PSM Card-Level Indicators
Table G-1 describes the card-level indicators on the card.

8.1.5 PSM Bidirectional Switching
A VOA is equipped after the hardware splitter within the PSM card. The VOA implements bidirectional 
switching when there is a single fiber cut in a protection configuration involving two peer PSM cards. 
Figure 8-3 shows a sample configuration that explains the bidirectional switching capability of the PSM 
card. 
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8.1.6   Related Procedures for PSM Card
Figure 8-3 PSM Bidirectional Switching

In this example, there is a fiber cut in the working path from Station A to Station B as shown in 
Figure 8-3. As a result of the fiber cut, an LOS alarm is raised on the W-RX port of Station B and it 
immediately switches traffic on to its P-RX port. Station B simultaneously also stops transmission (for 
approximately 25 milliseconds) on its W-TX port, which raises an LOS alarm on the W-RX port of 
Station A. This causes Station A to also switch traffic to its P-RX port. In this way, PSM implements 
bidirectional switching without any data exchange between the two stations. 

Since the two stations do not communicate using signaling protocols (overhead bytes), a Manual or 
Force protection switch on the PSM card is implemented by creating a traffic hit. For example, consider 
that you perform a Manual or Force protection switch on Station A. The TX VOA on the active path is 
set to automatic VOA shutdown (AVS) state for 25 milliseconds. This causes Station B to switch traffic 
to the other path because it cannot differentiate between a maintenance operation and a real fail. After 
25 milliseconds, the VOA in Station A is automatically reset. However, Station B will not revert back by 
itself because of nonrevertive switching protection scheme used in the PSM card.

To effectively implement switching, the Lockout and Force commands must be performed on both the 
stations. If these commands are not performed on both the stations, the far-end and near-end PSMs can 
be misaligned. In case of misalignment, when a path recovers, traffic might not recover automatically. 
You might have to perform a Force protection switch to recover traffic.

Note The order in which you repair the paths is important in the event of a double failure (both the working 
and protect paths are down due to a fiber cut) on the PSM card in line protection configuration when the 
active path is the working path. If you repair the working path first, traffic is automatically restored. 
However, if you repair the protect path first, traffic is not automatically restored. You must perform a 
Force protection switch to restore traffic on the protect path.

8.1.6 Related Procedures for PSM Card
The following is the list of procedures and tasks related to the configuration of the PSM card:

• NTP-G30 Install the DWDM Cards, page 14-63

• NTP-G202 Modify PSM Card Line Settings and PM Thresholds, page 21-47

• NTP-G242 Create an Internal Patchcord Manually, page 14-111
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Chapter 8      Provision Protection Switching Module
8.1.6   Related Procedures for PSM Card
• DLP-G493 Provision Protected Optical Channel Network Connections, page 17-48

• DLP-G479 View Optical Power Statistics for the PSM Card

• DLP-G176 Modify a Splitter Protection Group

• DLP-G459 Delete a Splitter Protection Group
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Provision Optical Add/Drop Cards

This chapter describes optical add/drop cards used in Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) networks. For card safety and compliance information, refer to the Regulatory 
Compliance and Safety Information for Cisco CPT and Cisco ONS Platforms document.

Note The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco 
ONS 15454 M2 platforms, unless noted otherwise. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 9.1 Card Overview, page 9-1

• 9.2 Safety Labels, page 9-9

• 9.3 AD-1C-xx.x Card, page 9-9

• 9.3.4 Related Procedures for AD-1C-xx.x Card

• 9.4 AD-2C-xx.x Card, page 9-12

• 9.4.5 Related Procedures for AD-2C-xx.x Card

• 9.5 AD-4C-xx.x Card, page 9-16

• 9.5.5 Related Procedures for AD-4C-xx.x Card

• 9.6 AD-1B-xx.x Card, page 9-20

• 9.6.4 Related Procedures for AD-1B-xx.x Card

• 9.7 AD-4B-xx.x Card, page 9-23

• 9.7.4 Related Procedures for AD-4B-xx.x Card

9.1 Card Overview
The card overview section contains card overview, software compatibility, interface class, and channel 
allocation information for optical add/drop cards. 
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Chapter 9      Provision Optical Add/Drop Cards
9.1.1   Card Summary
Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. For a list of slots and symbols, see 
the “Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation Guide. 

Optical add/drop cards are divided into two groups: band optical add/drop multiplexer (OADM) cards 
and channel OADM cards. Band OADM cards add and drop one or four bands of adjacent channels. The 
cards in this chapter, including the 4-Band OADM (AD-4B-xx.x) and the 1-Band OADM (AD-1B-xx.x) 
are utilized only in the C band. Channel OADM cards add and drop one, two, or four adjacent channels; 
they include the 4-Channel OADM (AD-4C-xx.x), the 2-Channel OADM (AD-2C-xx.x), and the 
1-Channel OADM (AD-1C-xx.x). 

Note For information about L band add and drop capability, see Chapter 10, “Provision Reconfigurable 
Optical Add/Drop Cards.”

9.1.1 Card Summary
Table 9-1 lists and summarizes the functions of the optical add/drop cards.

9.1.2 Card Compatibility
Table 9-2 lists the CTC software compatibility for each optical add/drop card.

Table 9-1 Optical Add/Drop Cards

Card Port Description For Additional Information

AD-1C-xx.x The AD-1C-xx.x card has three sets of ports 
located on the faceplate. It operates in Slots 
1 to 6 and 12 to 17.

See the “9.3 AD-1C-xx.x Card” 
section on page 9-9.

AD-2C-xx.x The AD-2C-xx.x card has four sets of ports 
located on the faceplate. It operates in Slots 
1 to 6 and 12 to 17.

See the “9.4 AD-2C-xx.x Card” 
section on page 9-12.

AD-4C-xx.x The AD-4C-xx.x card has six sets of ports 
located on the faceplate. It operates in Slots 
1 to 6 and 12 to 17.

See the “9.5 AD-4C-xx.x Card” 
section on page 9-16.

AD-1B-xx.x The AD-1B-xx.x card has three sets of ports 
located on the faceplate. It operates in Slots 
1 to 6 and 12 to 17.

See the “9.6 AD-1B-xx.x Card” 
section on page 9-20.

AD-4B-xx.x The AD-4B-xx.x card has six sets of ports 
located on the faceplate. It operates in Slots 
1 to 6 and 12 to 17.

See the “9.7 AD-4B-xx.x Card” 
section on page 9-23.
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ut and output optical channel 
rds have been grouped in 
ach interface class. 

Table 9-2 Software Release Compatibility for Optical Add/Drop Cards

R9.6.x

4-M2, 
4-M6,
4-DWDM

15454-M2, 
15454-M6,
15454-DWDM

4-M2, 
4-M6,
4-DWDM

15454-M2, 
15454-M6,
15454-DWDM

4-M2, 
4-M6,
4-DWDM

15454-M2, 
15454-M6,
15454-DWDM

4-DWDM 15454-DWDM

4-DWDM 15454-DWDM
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

9.1.3 Interface Classes
The AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, and AD-4B-xx.x cards have different inp
signals depending on the interface card where the input signal originates from. The input interface ca
classes listed in Table 9-3. The subsequent tables list the optical performances and output power of e

Card 
Name R4.5 - R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1 R9.3 R9.4

AD-1C
-xx.x

15454-DWDM 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-M2, 
15454-M6,
15454-DWDM

15454-M2, 
15454-M6,
15454-DWDM

15454-M2, 
15454-M6,
15454-DWDM

1545
1545
1545
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9.1.3   Interface Classes
Table 9-4 lists the optical performance parameters for 40-Gbps cards that provide signal input to the 
optical add/drop cards.

Table 9-3 ONS 15454 Card Interfaces Assigned to Input Power Classes

Input Power Class Card

A 10-Gbps multirate transponder cards (TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, and TXP_MR_10E_L) with forward error correction (FEC) 
enabled, 10-Gbps muxponder cards (MXP_2.5G_10G, MXP_2.5G_10E, 
MXP_MR_10DME_C, MXP_MR_10DME_L, MXP_2.5G_10E_C, and 
MXP_2.5G_10E_L) with FEC enabled, 40-Gbps transponder cards (40E-TXP-C, 
and 40ME-TXP-C), and 40-Gbps muxponder cards (40G-MXP-C, 40E-MXP-C, 
and 40ME-MXP-C)

B 10-Gbps multirate transponder card (TXP_MR_10G) without FEC and the 
10-Gbps muxponder card (MXP_2.5G_10G, MXP_MR_10DME_C, 
MXP_MR_10DME_L), 40-Gbps transponder cards (40E-TXP-C, and 
40ME-TXP-C), and 40-Gbps muxponder cards (40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C), and ADM-10G cards with FEC disabled

C OC-192 LR ITU cards (TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L) 
without FEC

D 2.5-Gbps multirate transponder card (TXP_MR_2.5G), both protected and 
unprotected, with FEC enabled

E OC-48 100-GHz DWDM muxponder card (MXP_MR_2.5G) and 2.5-Gbps 
multirate transponder card (TXP_MR_2.5G), both protected and unprotected, 
with FEC disabled and retime, reshape, and regenerate (3R) mode enabled

F 2.5-Gbps multirate transponder card (TXP_MR_2.5G), both protected and 
unprotected, in regenerate and reshape (2R) mode

G OC-48 ELR 100 GHz card

H 2/4 port GbE transponder (GBIC WDM 100GHz)

I TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L, 40E-TXP-C, and 
40ME-TXP-C cards with enhanced FEC (E-FEC) and the MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_MR_10DME_C, 
MXP_MR_10DME_L, 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards with 
E-FEC enabled

Table 9-4 40-Gbps Interface Optical Performance

Parameter Class A Class B Class I

Type
Power 
Limited

OSNR1 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

Maximum bit rate 40 Gbps 40 Gbps 40 Gbps

Regeneration 3R 3R 3R

FEC Yes No Yes (E-FEC)

Threshold Optimum Average Optimum

Maximum BER2 10–15 10–12 10–15
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9.1.3   Interface Classes
Table 9-5 lists the optical performance parameters for 40-Gbps cards that provide signal input to the 
optical add/drop cards.

OSNR1 sensitivity 23 dB 9 dB 23 dB 19 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –21 dBm –20 dBm –26 dBm –18 dBm

Power overload –8 dBm –8 dBm –8 dBm

Transmitted Power Range3

40-Gbps multirate 
transponder/40-Gbps 
FEC transponder 
(40E-TXP-C, and 
40ME-TXP-C)

+2.5 to 3.5 dBm +2.5 to 3.5 dBm —

OC-192 LR ITU — — —

Dispersion 
compensation 
tolerance

+/–800 ps/nm +/–1,000 ps/nm +/–800 ps/nm

1. OSNR = optical signal-to-noise ratio

2. BER = bit error rate

3. These values, decreased by patchcord and connector losses, are also the input power values for the OADM 
cards.

Table 9-4 40-Gbps Interface Optical Performance (continued)

Parameter Class A Class B Class I

Type
Power 
Limited

OSNR1 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

Table 9-5 10-Gbps Interface Optical Performance

Parameter Class A Class B Class C Class I

Type
Power 
Limited

OSNR1 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

OSNR 
Limited

Power 
Limited

OSNR 
Limited
(if appl.)

Maximum bit rate 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneration 3R 3R 3R 3R

FEC Yes No No Yes (E-FEC)

Threshold Optimum Average Average Optimum

Maximum BER2 10–15 10–12 10–12 10–15

OSNR1 sensitivity 23 dB 9 dB 23 dB 19 dB 19 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –21 dBm –20 dBm –22 dBm –26 dBm –18 dBm

Power overload –8 dBm –8 dBm –9 dBm –8 dBm
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9.1.3   Interface Classes
2.5-Gbps cards that provide signal input to the optical add/drop cards have the interface performance 
parameters listed in Table 9-6.

Transmitted Power Range3

10-Gbps multirate 
transponder/10-Gbps 
FEC transponder 
(TXP_MR_10G)

+2.5 to 3.5 dBm +2.5 to 3.5 dBm — —

OC-192 LR ITU — — +3.0 to 6.0 
dBm

—

10-Gbps multirate 
transponder/10-Gbps 
FEC transponder 
(TXP_MR_10E)

+3.0 to 6.0 dBm +3.0 to 6.0 dBm — +3.0 to 6.0 dBm

Dispersion 
compensation 
tolerance

+/–800 ps/nm +/–1,000 ps/nm +/–1,000 
ps/nm

+/–800 ps/nm

1. OSNR = optical signal-to-noise ratio

2. BER = bit error rate

3. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

Table 9-5 10-Gbps Interface Optical Performance (continued)

Parameter Class A Class B Class C Class I

Type
Power 
Limited

OSNR1 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

OSNR 
Limited

Power 
Limited

OSNR 
Limited
(if appl.)

Table 9-6 2.5-Gbps Interface Optical Performance

Parameter Class D Class E Class F Class G Class H Class J

Type
Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if 
appl.)

OSNR 
Limited

Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

Maximum bit rate 2.5 Gbps 2.5 Gbps 2.5 Gbps 2.5 Gbps 1.25 Gbps 2.5 Gbps

Regeneration 3R 3R 2R 3R 3R 3R

FEC Yes No No No No No

Threshold Average Average Average Average Average Average

Maximum BER 10–15 10–12 10–12 10–12 10–12 10–12

OSNR sensitivity 14 dB 6 dB 14 dB 10 dB 15 dB 14 dB 11 dB 13 dB 8 dB 12 dB

Power sensitivity –31 
dBm

–25 
dBm

–30 
dBm

–23 
dBm

–24 dBm –27 
dBm

–33 
dBm

–28 dBm –18 dBm –26 dBm

Power overload –9 dBm –9 dBm –9 dBm –9 dBm –7 dBm –17dBm
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9.1.4   DWDM Card Channel Allocation Plan
9.1.4 DWDM Card Channel Allocation Plan
ONS 15454 DWDM channel OADM and band OADM cards are designed for use with specific channels 
in the C band. In most cases, the channels for these cards are either numbered (for example, 1 to 32) or 
delimited (odd or even). Client interfaces must comply with these channel assignments to be compatible 
with the ONS 15454 system.

Table 9-7 lists the channel IDs and wavelengths assigned to the C-band DWDM channels. 

Note In some cases, a card uses only some or all of the channels listed in a band. Also, some cards use channels 
on the 100-GHz ITU-T grid while others use channels on the 50-GHz ITU-T grid. See specific card 
descriptions in Appendix B, “Hardware Specifications,” for more details.

Transmitted Power Range1

TXP_MR_2.5G –1.0 to 1.0 dBm –1.0 to 1.0 dBm –1.0 to 
1.0 dBm

–2.0 to 0 dBm — —

TXPP_MR_2.5G –4.5 to –2.5 dBm –4.5 to –2.5 dBm –4.5 to 
–2.5 dBm

MXP_MR_2.5G — +2.0 to +4.0 dBm —

MXPP_MR_2.5G — –1.5 to +0.5 dBm —

2/4 port GbE 
Transponder (GBIC 
WDM 100GHz)

— — — — +2.5 to 3.5 dBm —

Dispersion 
compensation 
tolerance

 –1200 to 
+5400 ps/nm

 –1200 to 
+5400 ps/nm

 –1200 to 
+3300 
ps/nm

 –1200 to 
+3300 ps/nm

–1000 to +3600 
ps/nm

–1000 to 
+3200 
ps/nm

1. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

Table 9-6 2.5-Gbps Interface Optical Performance (continued)

Parameter Class D Class E Class F Class G Class H Class J

Type
Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if 
appl.)

OSNR 
Limited

Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

OSNR 
Limited
(if appl.)

Power 
Limited

Table 9-7 DWDM Channel Allocation Plan (C Band)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715
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9.1.4   DWDM Card Channel Allocation Plan
7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 9-7 DWDM Channel Allocation Plan (C Band) (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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9.2   Safety Labels
9.2 Safety Labels
For information about safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

9.3 AD-1C-xx.x Card

Note For AD-1C-xx.x card specifications, see the “AD-1C-xx.x Card Specifications” section in the Hardware 
Specifications document. 

The 1-Channel OADM (AD-1C-xx.fx) card passively adds or drops one of the 32 channels utilized 
within the 100-GHz-spacing of the DWDM card system. Thirty-two versions of this card—each 
designed only for use with one wavelength—are used in the ONS 15454 DWDM system. Each 
wavelength version of the card has a different part number. The AD-1C-xx.x can be installed in Slots 1 
to 6 and 12 to 17.

The AD-1C-xx.x has the following internal features:

• Two cascaded passive optical interferential filters perform the channel add and drop functions.

• One software-controlled variable optical attenuator (VOA) regulates the optical power of the 
inserted channel.

• Software-controlled VOA regulates the insertion loss of the express optical path.

• VOA settings and functions, photodiode detection, and alarm thresholds, are internally controlled.

• Virtual photodiodes (firmware calculations of port optical power) at the common DWDM output and 
input ports are monitored within the software.

9.3.1 Faceplate and Block Diagrams
Figure 9-1 shows the AD-1C-xx.x faceplate.
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9.3.1   Faceplate and Block Diagrams
Figure 9-1 AD-1C-xx.x Faceplate 

For information on safety labels for the card, see the “9.2 Safety Labels” section on page 9-9.

Figure 9-2 shows a block diagram of the AD-1C-xx.x card.
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9.3.2   Power Monitoring
Figure 9-2 AD-1C-xx.x Block Diagram

Figure 9-3 shows the AD-1C-xx.x optical module functional block diagram.

Figure 9-3 AD-1C-xx.x Optical Module Functional Block Diagram

9.3.2 Power Monitoring
Physical photodiodes P1 through P4 and virtual photodiodes V1 and V2 monitor the power for the 
AD-1C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 9-8.
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Table 9-8 AD-1C-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 ADD DROP RX

P2 DROP DROP TX
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9.3.3   AD-1C-xx.x Card Functions
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

9.3.3 AD-1C-xx.x Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

9.3.4 Related Procedures for AD-1C-xx.x Card
The following section lists procedures and tasks related to the configuration of the AD-1C-xx.x card:

• “NTP-G30 Install the DWDM Cards” procedure on page 14-63

• “NTP-G37 Run Automatic Node Setup” procedure on page 14-124

• “NTP-G59 Create, Delete, and Manage Optical Channel Network Connections” procedure on 
page 17-40

• “NTP-G51 Verify DWDM Node Turn Up” procedure on page 16-2

• NTP-G74 Monitor DWDM Card Performance

• “NTP-G106 Reset Cards Using CTC” procedure on page 24-14

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• “NTP-G119 Power Down the Node” procedure on page 24-23

9.4 AD-2C-xx.x Card

Note For AD-2C-xx.x card specifications, see the “AD-2C-xx.x Card Specifications” section in the Hardware 
Specifications document. 

The 2-Channel OADM (AD-2C-xx.x) card passively adds or drops two adjacent 100-GHz channels 
within the same band. Sixteen versions of this card—each designed for use with one pair of 
wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in 
two different sections on the same card to manage signal flow in both directions. Each version of the 
card has a different part number.

The AD-2C-xx.x has the following features:

• Passive cascade of interferential filters perform the channel add and drop functions.

P3 IN EXP EXP RX

P4 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 9-8 AD-1C-xx.x Port Calibration (continued)

Photodiode CTC Type Name Calibrated to Port
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9.4.1   Faceplate and Block Diagrams
• Two software-controlled VOAs in the add section, one for each add port, regulate the optical power 
of inserted channels. 

• Software-controlled VOAs regulate insertion loss on express channels.

• VOA settings and functions, photodiode detection, and alarm thresholds are internally controlled.

• Virtual photodiodes (firmware calculation of port optical power) at the common DWDM output and 
input ports are monitored within the software. 

9.4.1 Faceplate and Block Diagrams
Figure 9-4 shows the AD-2C-xx.x faceplate.

Figure 9-4 AD-2C-xx.x Faceplate 
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9.4.2   Wavelength Pairs
For information on safety labels for the card, see the “9.2 Safety Labels” section on page 9-9.

Figure 9-5 shows a block diagram of the AD-2C-xx.x card. 

Figure 9-5 AD-2C-xx.x Block Diagram

Figure 9-6 shows the AD-2C-xx.x optical module functional block diagram.

Figure 9-6 AD-2C-xx.x Optical Module Functional Block Diagram

9.4.2 Wavelength Pairs
The AD-2C-xx.x cards are provisioned for the wavelength pairs listed in Table 9-9. In this table, channel 
IDs are given rather than wavelengths. To compare channel IDs with the actual wavelengths they 
represent, see wavelengths in Table 9-7 on page 9-7.
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9.4.3   Power Monitoring
9.4.3 Power Monitoring
Physical photodiodes P1 through P10 and virtual photodiodes V1 and V2 monitor the power for the 
AD-2C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 9-10.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

9.4.4 AD-2C-xx.x Card Functions
• Card level indicators—Table G-4 on page G-9

Table 9-9 AD-2C-xx.x Channel Pairs

Band ID Add/Drop Channel ID

Band 30.3 (A) 30.3, 31.2

31.9, 32.6

Band 34.2 (B) 34.2, 35.0

35.8, 36.6

Band 38.1 (C) 38.1, 38.9

39.7, 40.5

Band 42.1 (D) 42.1, 42.9

43.7, 44.5

Band 46.1 (E) 46.1, 46.9

47.7, 48.5

Band 50.1 (F) 50.1, 50.9

51.7, 52.5

Band 54.1 (G) 54.1, 54.9

55.7, 56.5

Band 58.1 (H) 58.1, 58.9

59.7, 60.6

Table 9-10 AD-2C-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P2 ADD COM TX

P3–P4 DROP DROP TX

P5 IN EXP EXP RX

P6 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX
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9.4.5   Related Procedures for AD-2C-xx.x Card
• “G.4 Port-Level Indicators” section on page G-10

9.4.5 Related Procedures for AD-2C-xx.x Card
The following section lists procedures and tasks related to the configuration of the AD-2C-xx.x card:

• “NTP-G30 Install the DWDM Cards” procedure on page 14-63

• “NTP-G37 Run Automatic Node Setup” procedure on page 14-124

• “NTP-G59 Create, Delete, and Manage Optical Channel Network Connections” procedure on 
page 17-40

• “NTP-G51 Verify DWDM Node Turn Up” procedure on page 16-2

• NTP-G74 Monitor DWDM Card Performance

• “NTP-G106 Reset Cards Using CTC” procedure on page 24-14

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• “NTP-G119 Power Down the Node” procedure on page 24-23

9.5 AD-4C-xx.x Card

Note For AD-4C-xx.x card specifications, see the “AD-4C-xx.x Card Specifications” section in the Hardware 
Specifications document. 

The 4-Channel OADM (AD-4C-xx.x) card passively adds or drops all four 100-GHz-spaced channels 
within the same band. Eight versions of this card—each designed for use with one band of 
wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in 
two different sections on the same card to manage signal flow in both directions. There are eight versions 
of this card with eight part numbers. 

The AD-4C-xx.x has the following features:

• Passive cascade of interferential filters perform the channel add and drop functions.

• Four software-controlled VOAs in the add section, one for each add port, regulate the optical power 
of inserted channels. 

• Two software-controlled VOAs regulate insertion loss on express and drop path, respectively.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common 
DWDM output and input ports.

9.5.1 Faceplate and Block Diagrams
Figure 9-7 shows the AD-4C-xx.x faceplate.
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9.5.1   Faceplate and Block Diagrams
Figure 9-7 AD-4C-xx.x Faceplate 

For information on safety labels for the card, see the “9.2 Safety Labels” section on page 9-9.

Figure 9-8 shows a block diagram of the AD-4C-xx.x card.
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9.5.2   Wavelength Sets
Figure 9-8 AD-4C-xx.x Block Diagram

Figure 9-9 shows the AD-4C-xx.x optical module functional block diagram.

Figure 9-9 AD-4C-xx.x Optical Module Functional Block Diagram

9.5.2 Wavelength Sets
The AD-4C-xx.x cards are provisioned for the sets of four 100-GHz-spaced wavelengths shown 
Table 9-11 on page 9-19.
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9.5.3   Power Monitoring
9.5.3 Power Monitoring
Physical photodiodes P1 through P10 and virtual photodiodes V1 and V2 monitor the power for the 
AD-4C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 9-12.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

9.5.4 AD-4C-xx.x Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

9.5.5 Related Procedures for AD-4C-xx.x Card
The following section lists procedures and tasks related to the configuration of the AD-4C-xx.x card:

• “NTP-G30 Install the DWDM Cards” procedure on page 14-63

• “NTP-G37 Run Automatic Node Setup” procedure on page 14-124

Table 9-11 AD-4C-xx.x Channel Sets

Band ID Add/Drop Wavelengths

Band 30.3 (A) 1530.3, 1531.2, 1531.9, 1532.6

Band 34.2 (B) 1534.2, 1535.0, 1535.8, 1536.6

Band 38.1 (C) 1538.1, 1538.9, 1539.7, 1540.5

Band 42.1 (D) 1542.1, 1542.9, 1543.7, 1544.5

Band 46.1 (E) 1546.1, 1546.9, 1547.7, 1548.5

Band 50.1 (F) 1550.1, 1550.9, 1551.7, 1552.5

Band 54.1 (G) 1554.1, 1554.9, 1555.7, 1556.5

Band 58.1 (H) 1558.1, 1558.9, 1559.7, 1560.6

Table 9-12 AD-4C-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX
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9.6   AD-1B-xx.x Card
• “NTP-G59 Create, Delete, and Manage Optical Channel Network Connections” procedure on 
page 17-40

• “NTP-G51 Verify DWDM Node Turn Up” procedure on page 16-2

• NTP-G74 Monitor DWDM Card Performance

• “NTP-G106 Reset Cards Using CTC” procedure on page 24-14

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• “NTP-G119 Power Down the Node” procedure on page 24-23

9.6 AD-1B-xx.x Card
(Cisco ONS 15454 only)

Note For AD-1B-xx.x card specifications, see the “AD-1B-xx.x Card Specifications” section in the Hardware 
Specifications document. 

The 1-Band OADM (AD-1B-xx.x) card passively adds or drops a single band of four adjacent 
100-GHz-spaced channels. Eight versions of this card with eight different part numbers—each version 
designed for use with one band of wavelengths—are used in the ONS 15454 DWDM system. The card 
bidirectionally adds and drops in two different sections on the same card to manage signal flow in both 
directions. This card can be used when there is asymmetric adding and dropping on each side (east or 
west) of the node; a band can be added or dropped on one side but not on the other.

The AD-1B xx.x can be installed in Slots 1 to 6 and 12 to17 and has the following features:

• Passive cascaded interferential filters perform the channel add and drop functions.

• Two software-controlled VOAs regulate the optical power flowing in the express and drop OADM 
paths (drop section). 

• Output power of the dropped band is set by changing the attenuation of the VOA drop.

• The VOA express is used to regulate the insertion loss of the express path.

• VOA settings and functions, photodiode detection, and alarm thresholds are internally controlled.

• Virtual photodiode (firmware calculation of port optical power) at the common DWDM output are 
monitored within the software.

9.6.1 Faceplate and Block Diagrams
Figure 9-10 shows the AD-1B-xx.x faceplate.
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9.6.1   Faceplate and Block Diagrams
Figure 9-10 AD-1B-xx.x Faceplate 

For information on safety labels for the card, see the “9.2 Safety Labels” section on page 9-9.

Figure 9-11 shows a block diagram of the AD-1B-xx.x card. 
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9.6.2   Power Monitoring
Figure 9-11 AD-1B-xx.x Block Diagram

Figure 9-12 shows the AD-1B-xx.x optical module functional block diagram.

Figure 9-12 AD-1B-xx.x Optical Module Functional Block Diagram

9.6.2 Power Monitoring
Physical photodiodes P1 through P4 and virtual photodiodes V1 and V2 monitor the power for the 
AD-1B-xx.x card. The returned power level values are calibrated to the ports as shown in Table 9-13.
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Table 9-13 AD-1B-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 ADD BAND RX

P2 DROP BAND TX
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9.6.3   AD-1B-xx.x Card Functions
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

9.6.3 AD-1B-xx.x Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

9.6.4 Related Procedures for AD-1B-xx.x Card
The following section lists procedures and tasks related to the configuration of the AD-1B-xx.x card:

• “NTP-G30 Install the DWDM Cards” procedure on page 14-63

• “NTP-G37 Run Automatic Node Setup” procedure on page 14-124

• “NTP-G59 Create, Delete, and Manage Optical Channel Network Connections” procedure on 
page 17-40

• “NTP-G51 Verify DWDM Node Turn Up” procedure on page 16-2

• NTP-G74 Monitor DWDM Card Performance

• “NTP-G106 Reset Cards Using CTC” procedure on page 24-14

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• “NTP-G119 Power Down the Node” procedure on page 24-23

9.7 AD-4B-xx.x Card
(Cisco ONS 15454 only)

The 4-Band OADM (AD-4B-xx.x) card passively adds or drops four bands of four adjacent 
100-GHz-spaced channels. Two versions of this card with different part numbers—each version 
designed for use with one set of bands—are used in the ONS 15454 DWDM system. The card 
bidirectionally adds and drops in two different sections on the same card to manage signal flow in both 
directions. This card can be used when there is asymmetric adding and dropping on each side (east or 
west) of the node; a band can be added or dropped on one side but not on the other. 

The AD1B-xx.x can be installed in Slots 1 to 6 and 12 to 17 and has the following features:

• Five software-controlled VOAs regulate the optical power flowing in the OADM paths. 

• Output power of each dropped band is set by changing the attenuation of each VOA drop.

P3 IN EXP EXP RX

P4 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 9-13 AD-1B-xx.x Port Calibration (continued)

Photodiode CTC Type Name Calibrated to Port
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9.7.1   Faceplate and Block Diagrams
• The VOA express is used to regulate the insertion loss of the express path.

• VOA settings and functions, photodiode detection, and alarm thresholds are internally controlled.

• Virtual photodiode (firmware calculation of port optical power) at the common DWDM output port 
are monitored within the software.

9.7.1 Faceplate and Block Diagrams
Figure 9-13 shows the AD-4B-xx.x faceplate.

Figure 9-13 AD-4B-xx.x Faceplate 

For information on safety labels for the card, see the “9.2 Safety Labels” section on page 9-9.

Figure 9-14 shows a block diagram of the AD-4B-xx.x card.
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9.7.2   Power Monitoring
Figure 9-14 AD-4B-xx.x Block Diagram

Figure 9-15 shows the AD-4B-xx.x optical module functional block diagram.

Figure 9-15 AD-4B-xx.x Optical Module Functional Block Diagram

9.7.2 Power Monitoring
Physical photodiodes P1 through P11 and virtual photodiode V1 monitor the power for the AD-4B-xx.x 
card. The returned power level values are calibrated to the ports as shown in Table 9-14.
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9.7.3   AD-4B-xx.x Card Functions
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

9.7.3 AD-4B-xx.x Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

9.7.4 Related Procedures for AD-4B-xx.x Card
The following section lists procedures and tasks related to the configuration of the AD-4B-xx.x card:

• “NTP-G30 Install the DWDM Cards” procedure on page 14-63

• “NTP-G37 Run Automatic Node Setup” procedure on page 14-124

• “NTP-G59 Create, Delete, and Manage Optical Channel Network Connections” procedure on 
page 17-40

• “NTP-G51 Verify DWDM Node Turn Up” procedure on page 16-2

• NTP-G74 Monitor DWDM Card Performance

• “NTP-G106 Reset Cards Using CTC” procedure on page 24-14

• NTP-G107 Remove Permanently or Remove and Replace DWDM Cards

• “NTP-G119 Power Down the Node” procedure on page 24-23

Table 9-14 AD-4B-xx.x Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P4 ADD COM TX

P5–P8 DROP DROP TX

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

P11 IN COM COM RX

V1 OUT COM COM TX
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C H A P T E R 10

Provision Reconfigurable Optical Add/Drop 
Cards

This chapter describes the Cisco ONS 15454 cards deployed in reconfigurable optical add/drop 
(ROADM) networks. For card safety and compliance information, refer to the Regulatory Compliance 
and Safety Information for Cisco CPT and Cisco ONS Platforms document.

Note The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco 
ONS 15454 M2 platforms, unless noted otherwise.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 10.1 Card Overview, page 10-2

• 10.2 Safety Labels, page 10-15

• 10.3 32WSS Card, page 10-15

• 10.3.6 Related Procedures for 32WSS Card, page 10-22

• 10.4 32WSS-L Card, page 10-22

• 10.4.6 Related Procedures for 32WSS-L Card, page 10-29

• 10.5 32DMX Card, page 10-29

• 10.5.6 Related Procedures for 32DMX Card, page 10-33

• 10.6 32DMX-L Card, page 10-34

• 10.6.6 Related Procedures for 32DMX-L Card, page 10-38

• 10.7 40-DMX-C Card, page 10-39

• 10.7.6 Related Procedures for 40-DMX-C Card, page 10-43

• 10.8 40-DMX-CE Card, page 10-44

• 10.8.6 Related Procedures for 40-DMX-CE Card, page 10-48

• 10.9 40-MUX-C Card, page 10-49

• 10.9.5 Related Procedures for 40-MUX-C Card, page 10-53

• 10.10 40-WSS-C Card, page 10-54
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10.1   Card Overview
• 10.10.6 Related Procedures for 40-WSS-C Card, page 10-60

• 10.11 40-WSS-CE Card, page 10-60

• 10.11.6 Related Procedures for 40-WSS-CE Card, page 10-67

• 10.12 40-WXC-C Card, page 10-67

• 10.12.5 Related Procedures for 40-WXC-C Card, page 10-73

• 10.13 80-WXC-C Card, page 10-73

• 10.13.5 Related Procedures for 80-WXC-C Card, page 10-80

• 10.14 Single Module ROADM (SMR-C) Cards, page 10-80

• 10.14.5 Related Procedures for 40-SMR1-C and 40-SMR2-C Card, page 10-90

• 10.15 MMU Card, page 10-90

• 10.15.4 Related Procedures for MMU Card, page 10-93

Note This chapter contains information about cards that perform mesh topology functions. Multiplexer and 
demultiplexer cards that do not perform these functions are described in Chapter 6, “Provision 
Multiplexer and Demultiplexer Cards.”

10.1 Card Overview
The ROADM cards include six add drop cards utilized in the C-band (32WSS, 32DMX, 32DMX-C, 
40-MUX-C, 40-WXC-C, 80-WXC-C, and MMU), two add drop cards utilized for the L-band (32WSS-L, 
and 32DMX-L), and two single module ROADM (SMR) cards utilized in the C-band (40-SMR1-C and 
40-SMR2-C).

This section provides card summary, compatibility, channel allocation, and safety information. 

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots that have the same symbols. For a list of slots and symbols, see the 
“Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation Guide. 

10.1.1 Card Summary
Table 10-1 lists and summarizes information about each ROADM card.

Table 10-1 ROADM Card Summary

Card Port Description For Additional Information

32WSS The 32WSS card has seven sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.3 32WSS Card” 
section on page 10-15

32WSS-L The 32WSS-L card has seven sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.4 32WSS-L Card” 
section on page 10-22
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10.1.2   Card Compatibility
10.1.2 Card Compatibility
Table 10-2 lists the Cisco Transport Controller (CTC) software compatibility for the ROADM cards.

32DMX The 32DMX has five sets of ports located on 
the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “10.5 32DMX Card” 
section on page 10-29

32DMX-L The 32DMX-L has five sets of ports located 
on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “10.6 32DMX-L Card” 
section on page 10-34

40-DMX-C The 40-DMX-C has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “10.7 40-DMX-C Card” 
section on page 10-39

40-DMX-CE The 40-DMX-CE has six sets of ports 
located on the faceplate. It operates in 
Slots 1 to 6 and 12 to 17.

See the “10.8 40-DMX-CE 
Card” section on page 10-44

40-MUX-C The 40-MUX-C has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “10.9 40-MUX-C Card” 
section on page 10-49.

40-WSS-C The 40-WSS-C card has eight sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.10 40-WSS-C 
Card” section on page 10-54

40-WSS-CE The 40-WSS-CE card has eight sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.11 40-WSS-CE 
Card” section on page 10-60

40-WXC-C The 40-WXC-C card has five sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.12 40-WXC-C 
Card” section on page 10-67

80-WXC-C The 80-WXC-C card has 14 ports located on 
the faceplate. It operates in Slots 1 to 5 and 
12 to 16.

See the “10.13 80-WXC-C 
Card” section on page 10-73.

40-SMR1-C The 40-SMR1-C card has six sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.14 Single Module 
ROADM (SMR-C) Cards” 
section on page 10-80

40-SMR2-C The 40-SMR2-C card has six sets of ports 
located on the faceplate. It operates in 
Slots 1 to 5 and 12 to 16.

See the “10.14 Single Module 
ROADM (SMR-C) Cards” 
section on page 10-80

MMU The MMU card has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “10.15 MMU Card” 
section on page 10-90

Table 10-1 ROADM Card Summary (continued)

Card Port Description For Additional Information
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Table 10-2 Software Release Compatibility for ROADM Cards

R9.3 R9.4 R9.6.x

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6, 
15454-
DWDM 
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DWDM 
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M6, 
15454-
DWDM 
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DWDM 

15454-
M6, 
15454-
DWDM 

15454-
M6, 
15454-
DWDM 

15454-
DWDM 

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM
Cisco O
N
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D
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Card Name R4.5 R4.6 R4.7 - R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1

32WSS No No 15454-DWDM 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

32WSS-L No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

40-WSS-C No No No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6, 
15454-
DWDM 

15454-
M6, 
15454-
DWDM 

40-WSS-CE No No No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6, 
15454-
DWDM 

15454-
M6, 
15454-
DWDM 

32DMX No No 15454-DWDM 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

32DMX-L No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

40-DMX-C No No No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

40-DMX-C
E

No No No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

40-MUX-C No No No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

40-WXC-C No No No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM

80-WXC-C No No No No No No No No No 15454-
M6,
15454-
DWDM

15454-
M6,
15454-
DWDM
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15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

Table 10-2 Software Release Compatibility for ROADM Cards

Card Name R4.5 R4.6 R4.7 - R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1 R9.3 R9.4 R9.6.x

P-C, 
P-C, 

th 
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

78-20702-02

10.1.3 Interface Classes
The input interface cards have been grouped in classes listed in Table 10-3. The subsequent tables
output power of each interface class. 

40-SMR1-C No No No No No No No No 15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

40-SMR2-C No No No No No No No No 15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

15454-
M2, 
15454-
M6,
15454-
DWDM

MMU No No No 15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

Table 10-3 Cisco ONS 15454 Card Interfaces Assigned to Input Power Classes

Input Power Class Card

A 10-Gbps multirate transponder cards (TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, and TXP_MR_10E_L), 10-Gbps muxponder cards 
(MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_10DME_C, 
MXP_MR_10DME_L, MXP_2.5G_10E_C, and MXP_2.5G_10E_L) with 
forward error correction (FEC) enabled, 40-Gbps transponder cards (40E-TX
and 40ME-TXP-C), and 40-Gbps muxponder cards (40G-MXP-C, 40G-MX
40E-MXP-C, and 40ME-MXP-C)

B 10-Gbps multirate transponder card (TXP_MR_10G) and muxponder card 
(MXP_2.5G_10G) without FEC

C OC-192 LR ITU cards without FEC, 10-Gbps multirate transponder 
(TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L) and muxponder 
(MXP_2.5G_10E, MXP_2.5G_10E_L, and MXP_MR_10DME_L) cards wi
FEC disabled



 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.1.3   Interface Classes
D 2.5-Gbps multirate transponder card (TXP_MR_2.5G), both protected and 
unprotected, with FEC enabled

E OC-48 100-GHz dense wavelength division multiplexing (DWDM) muxponder 
card (MXP_MR_2.5G) and 2.5-Gbps multirate transponder card 
(TXP_MR_2.5G), protected or unprotected; FEC disabled; and retime, reshape, 
and regenerate (3R) mode enabled

F 2.5-Gbps multirate transponder card (TXP_MR_2.5G), protected or unprotected, 
in regenerate and reshape (2R) mode

G OC-48 ELR 100 GHz card

H 2/4 port GbE transponder (GBIC WDM 100GHz)

I 10-Gbps multirate transponder cards (TXP_MR_10E, TXP_MR_10E_C, and 
TXP_MR_10E_L) and 10-Gbps muxponder cards (MXP_2.5G_10E, 
MXP_2.5G_10E_L, and MXP_MR_10DME_L) with enhanced FEC (E-FEC) 
enabled, 40-Gbps transponder cards (40E-TXP-C, and 40ME-TXP-C), and 
40-Gbps muxponder cards (40G-MXP-C, 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C)

K OC-192/STM-64 LR ITU cards without FEC, 100GHz 10Gbps Ethernet Xponder 
(GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), Sonet/SDH add/drop (ADM_10G), 
OTU2 Xponder (OTU2_XP), with FEC disabled

L 40Gbps Duobinary CRS-1 DWDM ITU-T line card

M 2.5 Gbps DWDM ITU-T SPF

N 10Gbps enhanced full tunable transponder (TXP_MR_10E_C) and muxponder 
(MXP_2.5G_10E_C, MXP_MR_10DME_C) with E-FEC enabled

O 10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), 10Gbps 
Sonet/SDH add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with FEC 
enabled

P 10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), 10Gbps 
Sonet/SDH add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with E-FEC 
enabled

T 40Gbps DPSK CRS-1 DWDM ITU-T line card

V OC-192/STM-64 LR ITU cards without FEC, full tunable 10Gbps Ethernet 
Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), Sonet/SDH add/drop 
(ADM_10G), OTU2 Xponder (OTU2_XP), with FEC disabled, full tunable

W 10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), 
Sonet/SDH add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with FEC 
enabled, full tunable

X 10Gbps Ethernet Xponder (GE_XP, GE_XPE, 10GE_XP, 10GE_XPE), 
Sonet/SDH add/drop (ADM_10G), OTU2 Xponder (OTU2_XP), with E-FEC 
enabled, full tunable

Table 10-3 Cisco ONS 15454 Card Interfaces Assigned to Input Power Classes (continued)

Input Power Class Card
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Table 10-4 lists the optical performance parameters for 40-Gbps cards.

Table 10-5, Table 10-6, and Table 10-7 lists the optical performance parameters for 10-Gbps cards.

Y 10Gbps enhanced full tunable transponder (TXP_MR_10EX_C) and muxponder 
(MXP_2.5G_10EX_C, MXP_MR_10DMEX_C), with FEC enabled and 
maximum likelihood sequence estimator (MLSE) correction

Z 10Gbps enhanced full tunable transponder (TXP_MR_10EX_C) and muxponder 
(MXP_2.5G_10EX_C, MXP_MR_10DMEX_C), with E-FEC enabled and MLSE 
correction

Table 10-3 Cisco ONS 15454 Card Interfaces Assigned to Input Power Classes (continued)

Input Power Class Card

Table 10-4 40-Gbps Interface Optical Performance

Parameter Class A Class I

Type
Power 
Limited

OSNR1 
Limited
(if appl.)

1. OSNR = optical signal-to-noise ratio

Power 
Limited

OSNR 
Limited
(if appl.)

Maximum bit rate 10 Gbps 10 Gbps

Regeneration 3R 3R

FEC Yes Yes (E-FEC)

Threshold Optimum Optimum

Maximum BER2

2. BER = bit error rate

10–15 10–15

OSNR1 sensitivity 23 dB 9 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –26 dBm –18 dBm

Power overload –8 dBm –8 dBm

Transmitted Power Range3

3. These values, decreased by patchcord and connector losses, are also the input 
power values for the OADM cards.

40-Gbps multirate 
transponder/40-Gbps 
FEC transponder 
(40E-TXP-C, and 
40ME-TXP-C)

+2.5 to 3.5 dBm —

OC-192 LR ITU — —

Dispersion 
compensation 
tolerance

+/–800 ps/nm +/–800 ps/nm
10-7
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Table 10-5 10-Gbps Interface Optical Performance (Class A, B, C, I, and K)

Parameter Class A Class B Class C Class I Class K

Type
Power 
Limited

OSNR1 
Limited

1. OSNR = optical signal-to-noise ratio

Power 
Limited

OSNR 
Limit
ed

Power 
Limited

OSNR 
Limite
d

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum 
bit rate

10 Gbps 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneratio
n

3R 3R 3R 3R 3R

FEC Yes No No Yes (E-FEC) No

Threshold Optimum Average Average Optimum Average

Maximum 
BER2

10–15 10–12 10–12 10–15 10–12

OSNR1 
sensitivity

23 dB 8.5 dB 23 dB 19 dB 19 dB 19 dB 20 dB

6 dB

23 dB3 16 dB3

23 dB4 17 dB4

23 dB5 17 dB5

Power 
sensitivity

–24 
dBm

–18 
dBm

–21 
dBm

–20 
dBm

–22 
dBm

–22 
dBm

–26 dBm –18 
dBm

–24 
dBm3

–17 
dBm3

–23 
dBm4

–18 
dBm4

–23 
dBm5

–17 
dBm5

Power 
overload

–8 dBm –8 dBm –9 dBm –8 dBm –7 dBm

Transmitted Power Range6

10-Gbps 
multirate 
transponder/
10-Gbps 
FEC 
transponder

+2.5 to 3.5 dBm 
(for 
TXP_MR_10G)

+3.0 to 6.0 dBm 
(for 
TXP_MR_10E)

+2.5 to 3.5 dBm +3.0 to 6.0 
dBm 

+3.0 to 6.0 dBm —

OC-192 LR 
ITU

— — +3.0 to 6.0 
dBm

— –1.0 to +3.0 dBm

10-Gbps 
Ethernet 
Xponder, 
Sonet/SDH 
Add/Drop, 
OTU2 
Xponder

— — — — –1.0 to +3.0 dBm

Dispersion 
compensatio
n tolerance

+/–800 ps/nm +/–1,000 ps/nm +/–1,000 ps/nm +/–800 ps/nm –400 to +800 ps/nm
10-8
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2. BER = bit error rate

3. This value is for Xen Pak XFP used with Catalyst card.

4. This value is for XFP used with Catalyst, Xponder, and ADM-10G cards.

5. This value is for X2 XFP used with Catalyst card.

6. These values, decreased by patchcord and connector losses, are also the input power values for the optical add drop multiplexer 
(OADM) cards.

Table 10-6 10-Gbps Interface Optical Performance (Class N, O, P, and V)

Parameter Class N Class O Class P Class V

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR1 
Limited

1. OSNR = optical signal-to-noise ratio

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum bit rate 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneration 3R 3R 3R 3R

FEC Yes (E-FEC) Yes Yes (E-FEC) No

Threshold Optimum Optimum Optimum Average

Maximum BER2

2. BER = bit error rate

10–15 10–15 10–15 10–12

OSNR1 sensitivity 19 dB 5 dB 11 dB 11 dB 23 dB 8 dB 23 dB 16 dB

Power sensitivity –27 
dBm

–20 
dBm

–18 dBm –18 
dBm

–27 dBm –18 
dBm

–24 dBm –18 
dBm

Power overload –8 dBm –7 dBm –7 dBm –7 dBm

Transmitted Power Range3

3. These values, decreased by patchcord and connector losses, are also the input power values for the optical add drop multiplexer (OADM) 
cards.

10-Gbps multirate 
transponder/10-Gbp
s FEC transponder

+3.0 to 6.0 dBm — — —

OC-192 LR ITU — — — 0 to +3.0 dBm

10-Gbps Ethernet 
Xponder, 
Sonet/SDH 
Add/Drop, OTU2 
Xponder

— –1.0 to +3.0 dBm –1.0 to +3.0 dBm 0 to +3.0 dBm

Dispersion 
compensation 
tolerance

+/–800 ps/nm –500 to +1100 ps/nm –500 to +1100 ps/nm –500 to +1600 ps/nm
10-9
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Table 10-8 and Table 10-9 lists the optical interface performance parameters for 2.5-Gbps cards.

Table 10-7 10-Gbps Interface Optical Performance (Class W, X, Y, and Z)

Parameter Class W Class X Class Y Class Z

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR1 
Limited

1. OSNR = optical signal-to-noise ratio

Power 
Limited

OSNR 
Limited

Maximum bit rate 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneration 3R 3R 3R 3R

FEC Yes Yes (E-FEC) Yes Yes (E-FEC)

Threshold Optimum Optimum Optimum Optimum

Maximum BER2

2. BER = bit error rate

10–15 10–15 10–15 10–15

OSNR1 sensitivity 8.5 dB 8.5 dB 19 dB 5 dB 23 dB 8 dB 19 dB 5.5 dB

Power sensitivity –18 
dBm

–18 
dBm

–27 dBm –20 
dBm

–24 dBm –20 
dBm

–27 dBm –20 
dBm

Power overload –7 dBm –7 dBm –8 dBm –8 dBm

Transmitted Power Range3

3. These values, decreased by patchcord and connector losses, are also the input power values for the optical add drop multiplexer (OADM) cards.

10-Gbps multirate 
transponder/10-Gbps FEC 
transponder

— — +3.0 to 6.0 dBm +3.0 to 6.0 dBm

OC-192 LR ITU — — — —

10-Gbps Ethernet Xponder, 
Sonet/SDH Add/Drop, OTU2 
Xponder

0 to +3.0 dBm 0 to +3.0 dBm — —

Dispersion compensation 
tolerance

–500 to +1100 
ps/nm

–500 to +1300 ps/nm –800 to +1600 ps/nm –2200 to +3700 ps/nm

Table 10-8 2.5-Gbps Interface Optical Performance (Class D, E, and F)

Parameter Class D Class E Class F

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum bit rate 2.5 Gbps 2.5 Gbps 2.5 Gbps

Regeneration 3R 3R 2R

FEC Yes No No

Threshold Average Average Average

Maximum BER 10–15 10–12 10–12

OSNR sensitivity 14 dB 5 dB 14 dB 10 dB 15 dB 15 dB

Power sensitivity –31 dBm –25 dBm –30 dBm –23 dBm –24 dBm –24 dBm

Power overload –9 dBm –9 dBm –9 dBm
10-10
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Transmitted Power Range1

TXP_MR_2.5G and 
TXPP_MR_2.5G

–1.0 to 1.0 dBm –1.0 to 1.0 dBm –1.0 to 1.0 dBm

MXP_MR_2.5G and 
MXPP_MR_2.5G

— +2.0 to +4.0 dBm —

OC-48 ELR 100 GHz — — —

2/4 port GbE Transponder 
(GBIC WDM 100GHz)

— — —

2.5 Gbps DWDM ITU-T 
SPF

— — —

Dispersion compensation 
tolerance

 –1200 to 
+5400 ps/nm

 –1200 to 
+5400 ps/nm

 –1200 to +3300 ps/nm

1. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

Table 10-9 2.5-Gbps Interface Optical Performance (Class G, H, and M)

Parameter Class G Class H Class M

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Maximum bit rate 2.5 Gbps 1.25 Gbps 2.5 Gbps

Regeneration 3R 3R 3R

FEC No No No

Threshold Average Average Average

Maximum BER 10–12 10–12 10–12

OSNR sensitivity 14 dB 11 dB 13 dB 8 dB 14 dB 9 dB

Power sensitivity –27 dBm –23 dBm –28 dBm –18 dBm –28 dBm –22 dBm

Power overload –9 dBm –7 dBm –9 dBm

Transmitted Power Range1

TXP_MR_2.5G — — —

TXPP_MR_2.5G —

MXP_MR_2.5G –2.0 to 0 dBm

MXPP_MR_2.5G —

OC-48 ELR 100 GHz — — —

2/4 port GbE 
Transponder (GBIC 
WDM 100GHz)

 –1200 to +3300 ps/nm 0 to +3 dBm —

Table 10-8 2.5-Gbps Interface Optical Performance (Class D, E, and F) (continued)

Parameter Class D Class E Class F

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited
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10.1.4 Channel Allocation Plans
ONS 15454 DWDM ROADM cards are designed for use with specific channels in the C band and 
L band. In most cases, the channels for these cards are either numbered (for example, 1 to 32 or 1 to 40) 
or delimited (odd or even). Client interfaces must comply with these channel assignments to be 
compatible with the ONS 15454 system.

. The following cards operate in the C-band:

• 32WSS

• 32DMX

• 32DMX-C

• 40-MUX-C

• 40-WXC-C

• 80-WXC-C

• 40-SMR1-C

• 40-SMR2-C

• MMU

Table 10-10 lists the C-band channel IDs and wavelengths at ITU-T 50-GHz intervals. This is a 
comprehensive C-band channel table that encompasses present and future card capabilities.

. 

2.5 Gbps DWDM 
ITU-T SPF

— 0 to +4 dBm

Dispersion 
compensation tolerance

–1000 to +3600 ps/nm –800 to +2400 ps/nm

1. These values, decreased by patchcord and connector losses, are also the input power values for the OADM cards.

Table 10-9 2.5-Gbps Interface Optical Performance (Class G, H, and M) (continued)

Parameter Class G Class H Class M

Type
Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Power 
Limited

OSNR 
Limited

Table 10-10 DWDM C-Band1 Channel Allocation Plan with 50-GHz Spacing

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz) Wavelength (nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515
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The following add drop cards utilize the L-band DWDM channels:

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

1. Channels on the C-band are 4-skip-1, starting at 1530.33 nm.

Table 10-10 DWDM C-Band1 Channel Allocation Plan with 50-GHz Spacing (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz) Wavelength (nm)
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10.1.4   Channel Allocation Plans
• 32WSS-L

• 32DMX-L

Table 10-11 lists the L-band channel IDs and wavelengths at ITU-T 50-GHz intervals. This is a 
comprehensive L-band channel table that encompasses present and future card capabilities.

Table 10-11 DWDM L-band1 Channel Allocation Plan at 50 GHz Spacing

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz) Wavelength (nm)

1 190.85 1570.83 41 188.85 1587.46

2 190.8 1571.24 42 188.8 1587.88

3 190.75 1571.65 43 188.75 1588.30

4 190.7 1572.06 44 188.7 1588.73

5 190.65 1572.48 45 188.65 1589.15

6 190.6 1572.89 46 188.6 1589.57

7 190.55 1573.30 47 188.55 1589.99

8 190.5 1573.71 48 188.5 1590.41

9 190.45 1574.13 49 188.45 1590.83

10 190.4 1574.54 50 188.4 1591.26

11 190.35 1574.95 51 188.35 1591.68

12 190.3 1575.37 52 188.3 1592.10

13 190.25 1575.78 53 188.25 1592.52

14 190.2 1576.20 54 188.2 1592.95

15 190.15 1576.61 55 188.15 1593.37

16 190.1 1577.03 56 188.1 1593.79

17 190.05 1577.44 57 188.05 1594.22

18 190 1577.86 58 188 1594.64

19 189.95 1578.27 59 187.95 1595.06

20 189.9 1578.69 60 187.9 1595.49

21 189.85 1579.10 61 187.85 1595.91

22 189.8 1579.52 62 187.8 1596.34

23 189.75 1579.93 63 187.75 1596.76

24 189.7 1580.35 64 187.7 1597.19

25 189.65 1580.77 65 187.65 1597.62

26 189.6 1581.18 66 187.6 1598.04

27 189.55 1581.60 67 187.55 1598.47

28 189.5 1582.02 68 187.5 1598.89

29 189.45 1582.44 69 187.45 1599.32

30 189.4 1582.85 70 187.4 1599.75

31 189.35 1583.27 71 187.35 1600.17
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10.2   Safety Labels
10.2 Safety Labels 
For information about safety labels, see the “G.1.2 Class 1M Laser Product Cards” section on page G-4.

10.3 32WSS Card
(Cisco ONS 15454 only)

Note For 32WSS card specifications, see the “32WSS Card Specifications” section in the Hardware 
Specifications document.

The two-slot 32-Channel Wavelength Selective Switch (32WSS) card performs channel add/drop 
processing within the ONS 15454 DWDM node. The 32WSS card can be installed in the following pairs 
of slots:

• Slots 1 and 2

• Slots 3 and 4

• Slots 5 and 6

• Slots 12 and 13

• Slots 14 and 15

• Slots 16 and 17 

32 189.3 1583.69 72 187.3 1600.60

33 189.25 1584.11 73 187.25 1601.03

34 189.2 1584.53 74 187.2 1601.46

35 189.15 1584.95 75 187.15 1601.88

36 189.1 1585.36 76 187.1 1602.31

37 189.05 1585.78 77 187.05 1602.74

38 189 1586.20 78 187 1603.17

39 188.95 1586.62 79 186.95 1603.60

40 188.9 1587.04 80 186.9 1604.03

1. Channels on the L-band are contiguous, starting at 1577.86 nm. The channels listed in this table begin with 1570.83 nm for 
backward compatibility with other ONS products.

Table 10-11 DWDM L-band1 Channel Allocation Plan at 50 GHz Spacing (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz) Wavelength (nm)
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10.3.1   Faceplate and Block Diagrams
10.3.1 Faceplate and Block Diagrams
The 32WSS has six types of ports: 

• ADD RX ports (1 to 32): These ports are used for adding channels (listed in Table 10-13 on 
page 10-21). Each add channel is associated with an individual switch element that selects whether 
that channel is added. Each add port has optical power regulation provided by a variable optical 
attenuator (VOA). The 32WSS has four physical receive connectors that accept multifiber push-on 
(MPO) cables on its front panel for the client input interfaces. Each MPO cable breaks out into eight 
separate cables. 

• EXP RX port: The EXP RX port receives an optical signal from another 32WSS card in the same 
network element (NE).

• EXP TX port: The EXP TX port sends an optical signal to the other 32WSS card within the NE.

• COM TX port: The COM TX (line input) port sends an aggregate optical signal to a booster 
amplifier card (for example, OPT-BST) for transmission outside of the NE.

• COM RX port: The COM RX port receives the optical signal from a preamplifier (such as the 
OPT-PRE) and sends it to the optical splitter.

• DROP TX port: The DROP TX port sends the split-off optical signal containing drop channels to 
the 32DMX card, where the channels are further processed and dropped. 

Figure 10-1 shows the 32WSS card front panel and identifies the traffic flow through the ports. 
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10.3.1   Faceplate and Block Diagrams
Figure 10-1 32WSS Faceplate and Ports

Figure 10-2 provides a high-level functional block diagram of the 32WSS card and Figure 10-3 shows 
how optical signals are processed on the EXP RX and COM RX ports.
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10.3.1   Faceplate and Block Diagrams
Figure 10-2 32WSS Block Diagram

Aggregate optical signals that enter the EXP RX and COM RX port are processed in two ways: Add 
channel/pass-through and optical splitter processing. The optical processing stages are shown in 
Figure 10-3, which provides a detailed optical functional diagram of the 32WSS card.
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10.3.1   Faceplate and Block Diagrams
Figure 10-3 32WSS Optical Block Diagram

The EXP RX PORT and COM RX PORT operate as follows:

• EXP RX Port Add Channel/Pass-through Processing

The incoming optical signal is received at the EXP RX port from the other 32WSS card within the 
NE. The incoming aggregate optical signal is demultiplexed into 32 individual wavelengths, or 
channels. Each channel is then individually processed by the optical switch, which performs 
add/pass-through processing. By using software controls, the switch either selects the optical 
channel coming in from the demultiplexer (that is, the pass-through channel) or it selects the 
external ADD channel. If the ADD port channel is selected this channel is transmitted and the 
optical signal coming from the demultiplexer is blocked.

After the optical switch stage, all of the channels are multiplexed into an aggregate optical signal, 
which is sent out on the COM TX port. The output is typically connected to an OPT-BST or 
OPT-BST-E card (in the event a booster amplifier is needed) or to an OSC-CSM card (if no 
amplification is needed).

• COM RX Port Optical Splitter Processing

The COM RX port receives the incoming optical signal and directs it to the 32WSS card’s optical 
splitter. The splitter optically diverts channels that are designated to be dropped to the DROP TX 
port. The DROP TX port is typically connected to the COM RX port of the 32DMX where the drop 
channels are being dropped. Channels that are not dropped pass-through the optical splitter and flow 
out of the 32WSS card EXP TX port. Typically, this optical signal is connected to the other 32WSS 
module within the NE.

• COM TX Port Monitoring
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10.3.2   32WSS ROADM Functionality
The COM TX value can be measured by either a physical or a virtual photodiode of the 
15454-32WSS card. If the vendor ID of the 15454-32WSS card is between 1024 (0x400) and 
2047 (0x800) the COM TX value is measured by physical photodiode. If the vendor ID of the 
15454-32WSS card is greater than 2048 (0x800), the COM TX value is measured by the virtual 
photodiode. For COM TX values measured by virtual photodiode, check the values at the RX port 
in the downstream of the COM TX port (COM-RX port on OPT-BST or OSC-CSM card).

10.3.2 32WSS ROADM Functionality
The 32WSS card works in combination with the 32DMX card to implement ROADM functionality. As 
a ROADM node, the ONS 15454 can be configured to add or drop individual optical channels using 
CTC, Cisco Transport Planner, and Cisco Transport Manager (CTM). ROADM functionality using the 
32WSS card requires two 32DMX single-slot cards and two 32WSS double-slot cards (totalling six slots 
needed in the ONS 15454 chassis). 

For other cards’ ROADM functionality, see that card’s description in this chapter. For a diagram of a 
typical ROADM configuration, see the “12.1.3 ROADM Node” section on page 12-11.

Note A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or 
west side of the shelf.

10.3.3 32WSS Power Monitoring
Physical photodiodes P1 through P69 monitor the power for the 32WSS card. Table 10-12 shows how 
the returned power level values are calibrated to each port.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide.

Table 10-12 32WSS Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 ADD (Power ADD) ADD RX

P33–P641

1. P33–P64 monitor either ADD or PASSTHROUGH power, depending on the state 
of the optical switch

PASS THROUGH COM TX

ADD (Power) COM TX

P65 OUT EXP EXP TX

P66 IN EXP EXP RX

P67 OUT COM COM TX

P68 IN COM COM RX

P69 DROP DROP TX
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10.3.4   32WSS Channel Allocation Plan
10.3.4 32WSS Channel Allocation Plan
The 32WSS Card’s channel labels, frequencies, and wavelengths are listed in Table 10-13.

Table 10-13 32WSS Channel Allocation Plan

Band ID Channel Label Frequency (THz) Wavelength (nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.1 195.1 1536.61

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.87

39.7 194.7 1539.77

40.5 194.6 1540.46

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61
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10.3.5   32WSS Card Functions
10.3.5 32WSS Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.3.6 Related Procedures for 32WSS Card
The following section lists procedures and tasks related to the configuration of the 32WSS card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G93 Modify the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Line Settings and PM 
Thresholds, page 21-65

10.4 32WSS-L Card
(Cisco ONS 15454 only)

Note For 32WSS-L card specifications, see the “32WSS-L Card Specifications” section in the Hardware 
Specifications document.

The two-slot 32-Channel Wavelength Selective Switch L-Band (32WSS-L) card performs channel 
add/drop processing within the ONS 15454 DWDM node. The 32WSS-L card is particularly well suited 
for use in networks that employ DS fiber or SMF-28 single-mode fiber.The 32WSS-L card can be 
installed in the following pairs of slots:

• Slots 1 and 2

• Slots 3 and 4

• Slots 5 and 6

• Slots 12 and 13

• Slots 14 and 15 

• Slots16 and 17 
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10.4.1   Faceplate and Block Diagrams
10.4.1 Faceplate and Block Diagrams
The 32WSS-L card faceplate has six types of ports: 

• ADD RX ports (1 to 32): These ports are used for adding channels (which are listed in Table 10-15 
on page 10-28). Each add channel is associated with an individual switch element that selects 
whether the channel is added. Each add port has optical power regulation provided by a VOA. 

• EXP RX port: The EXP RX port receives an optical signal from another 32WSS-L card in the same 
NE.

• EXP TX port: The EXP TX port sends an optical signal to the other 32WSS-L card within the NE.

• COM TX port: The COM TX port sends an aggregate optical signal to a booster amplifier card (for 
example, the OPT-BST card) for transmission outside of the NE.

• COM RX port: The COM RX port receives the optical signal from a preamplifier (such as the 
OPT-PRE) and sends it to the optical splitter.

• DROP TX port: The DROP TX port sends the split-off optical signal with drop channels to the 
32DMX-L card, where the channels are further processed and dropped. 

Figure 10-4 shows the 32WSS-L module front panel and identifies the traffic flow through the ports. 
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10.4.1   Faceplate and Block Diagrams
Figure 10-4 32WSS-L Faceplate and Ports

Figure 10-5 provides a high-level functional block diagram of the 32WSS-L card and Figure 10-6 on 
page 10-26 shows how optical signals are processed on the EXP RX and COM RX ports.
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10.4.1   Faceplate and Block Diagrams
Figure 10-5 32WSS-L Block Diagram

Aggregate optical signals that enter the EXP RX and COM RX ports are processed in two ways: add 
channel/pass-through and optical splitter processing. The optical processing stages are shown in 
Figure 10-6, which provides a detailed optical functional diagram of the 32WSS-L card.
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10.4.1   Faceplate and Block Diagrams
Figure 10-6 32WSS-L Optical Block Diagram

The EXP RX PORT and COM RX PORT operate as follows:

• EXP RX Port Add Channel/Pass-through Processing

The incoming optical signal is received at the EXP RX port from the other 32WSS-L card within 
the NE. The incoming aggregate optical signal is demultiplexed into 32 individual wavelengths, or 
channels. Each channel is then individually processed by the optical switch, which performs 
add/pass-through processing. By using software controls, the switch either selects the optical 
channel coming in from the demultiplexer (that is, the pass-through channel) or it selects the 
external ADD channel. If the ADD port channel is selected this channel is transmitted and the 
optical signal coming from the demultiplexer is blocked.

After the optical switch stage, all of the channels are multiplexed into an aggregate optical signal, 
which is sent out on the COM TX port. The output is typically connected to an OPT-AMP-L or 
OPT-BST-E card (in the event a booster amplifier is needed) or to an OSC-CSM card (if no 
amplification is needed).

• COM RX Port Optical Splitter Processing

The COM RX port receives the incoming optical signal and directs it to the 32WSS-L card’s optical 
splitter. The splitter optically diverts channels that are designated to be dropped to the DROP TX 
port. The DROP TX port is typically connected to the COM RX port of the 32DMX-L where the 
drop channels are being dropped. Channels that are not dropped pass-through the optical splitter and 
flow out of the 32WSS-L card EXP TX port. Typically, this optical signal is connected to the other 
32WS-L module within the NE.
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10.4.2   32WSS-L ROADM Functionality
10.4.2 32WSS-L ROADM Functionality
The 32WSS-L works in combination with the 32DMX-L to implement L-band (1570 to 1620 nm) 
functionality. As a ROADM node, the ONS 15454 can be configured to add or drop individual optical 
channels using CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 32WSS-L 
card requires two 32DMX-L single-slot cards and two 32WSS-L double-slot cards (totalling six slots 
needed in the ONS 15454 chassis). 

For other cards’ ROADM functionality, see that card’s description in this chapter. For a diagram of a 
typical ROADM configuration, see the “12.1.3 ROADM Node” section on page 12-11.

Note A terminal site can be configured using a 32WSS-L card and a 32DMX-L card plugged into the east or 
west side of the shelf.

10.4.3 32WSS-L Power Monitoring
Physical photodiodes P1 through P69 monitor the power for the 32WSS-L card. Table 10-14 shows the 
returned power level values calibrated to each port.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.4.4 32WSS-L Channel Plan
The 32WSS-L card uses 32 banded channels on the ITU-T 100-GHz grid, as shown in Table 10-15.

Table 10-14 32WSS-L Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 ADD (Power ADD) ADD RX

P33–P641

1. P33–P64 monitor either ADD or PASSTHROUGH power, depending on the state 
of the optical switch

PASS THROUGH COM TX

ADD (Power) COM TX

P65 OUT EXP EXP TX

P66 IN EXP EXP RX

P67 OUT COM COM TX

P68 IN COM COM RX

P69 DROP DROP TX
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10.4.4   32WSS-L Channel Plan
Table 10-15 32WSS-L Channel Plan

Band ID Channel Label
Frequency 
(THz)

Wavelength 
(nm)

B77.8 77.8 190 1577.86

78.6 189.9 1578.69

79.5 189.8 1579.52

80.3 189.7 1580.35

B81.1 81.1 189.6 1581.18

82.0 189.5 1582.02

82.8 189.4 1582.85

83.6 189.3 1583.69

B84.5 84.5 189.2 1584.53

85.3 189.1 1585.36

86.2 189 1586.20

87.0 188.9 1587.04

B87.8 87.8 188.8 1587.88

88.7 188.7 1588.73

89.5 188.6 1589.57

90.4 188.5 1590.41

B91.2 91.2 188.4 591.26

92.1 188.3 1592.10

92.9 188.2 1592.95

93.7 188.1 1593.79

B94.6 94.6 188 1594.64

95.4 187.9 1595.49

96.3 187.8 1596.34

97.1 187.7 1597.19

B98.0 98.0 187.6 1598.04

98.8 187.5 1598.89

99.7 187.4 1599.75

00.6 187.3 1600.60

B01.4 01.4 187.2 1601.46

02.3 187.1 1602.31

03.1 187 1603.17

04.0 186.9 1604.03
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.4.5   32WSS-L Card Functions
10.4.5 32WSS-L Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.4.6 Related Procedures for 32WSS-L Card
The following section lists procedures and tasks related to the configuration of the 32WSS-L card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G93 Modify the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Line Settings and PM 
Thresholds, page 21-65

10.5 32DMX Card
(Cisco ONS 15454 only)

Note For 32DMX card specifications, see the “32DMX Card Specifications” section in the Hardware 
Specifications document.

The single-slot 32-Channel Demultiplexer (32DMX) card is an optical demultiplexer. The card receives 
an aggregate optical signal on its COM RX port and demultiplexes it into to (32) ITU-T 100-GHz-spaced 
channels. The 32DMX card can be installed in Slots 1 to 6 and in Slots 12 to 17. 

10.5.1 Faceplate and Block Diagrams
The 32DMX card has two types of ports:

• COM RX port: COM RX is the input port for the aggregate optical signal being demultiplexed. This 
port is supported by a VOA for optical power regulation and a photodiode for optical power 
monitoring.

• DROP TX ports (1 to 32): On its output, the 32DMX provides 32 drop ports (listed in Table 10-17 
on page 10-32) that are typically used for dropping channels within the ROADM node. These ports 
are connected using four 8-fiber MPO ribbon connectors. The incoming optical signal to the 
demultiplexer comes into the COM RX port. This input port is connected using a single LC duplex 
optical connector.Each drop port has a photodiode for optical power monitoring. Unlike the two-slot 
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.5.1   Faceplate and Block Diagrams
32DMX-O demultiplexer, the drop ports on the 32DMX do not have a VOA per channel for optical 
power regulation. For a description of the 32DMX-O card, see the “6.4 32DMX-O Card” section 
on page 6-14.

Figure 10-7 shows the 32DMX card front panel and the basic traffic flow through the ports.

Figure 10-7 32DMX Faceplate and Ports

A block diagram of the 32DMX card is shown in Figure 10-8.
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.5.2   32DMX ROADM Functionality
Figure 10-8 32DMX Block Diagram

Figure 10-9 shows the 32DMX optical module functional block diagram.

Figure 10-9 32DMX Optical Module Functional Block Diagram

10.5.2 32DMX ROADM Functionality
The 32DMX card works in combination with the 32WSS card to implement ROADM functionality. As 
a ROADM node, the ONS 15454 can be configured to add or drop individual optical channels using 
CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 32DMX card requires two 
32DMX single-slot cards and two 32WSS double-slot cards (for six slots total in the ONS 15454 
chassis). 
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.5.3   32DMX Power Monitoring
For information about the ROADM functionality for other cards, see that card’s description in this 
chapter. For a diagram of a typical ROADM configuration, see the “12.1.3 ROADM Node” section on 
page 12-11.

Note A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or 
west side of the shelf.

10.5.3 32DMX Power Monitoring
Physical photodiodes P1 through P33 monitor the power for the 32DMX card. The returned power level 
values are calibrated to the ports as shown in Table 10-16.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.5.4 32DMX Channel Allocation Plan
The 32DMX card’s channel labels, frequencies, and wavelengths are listed in Table 10-17.

Table 10-16 32DMX Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 DROP DROP TX

P33 INPUT COM COM RX

Table 10-17 32DMX Channel Allocation Plan  

Band ID Channel Label Frequency (THz) Wavelength (nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.1 195.1 1536.61

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.87

39.7 194.7 1539.77

40.5 194.6 1540.46
10-32
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.5.5   32DMX Card Functions
10.5.5 32DMX Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.5.6 Related Procedures for 32DMX Card
The following section lists procedures and tasks related to the configuration of the 32DMX card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

Table 10-17 32DMX Channel Allocation Plan (continued) 

Band ID Channel Label Frequency (THz) Wavelength (nm)
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10.6   32DMX-L Card
• NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds, page 21-54

10.6 32DMX-L Card
(Cisco ONS 15454 only)

Note For 32DMX-L card specifications, see the “32DMX-L Card Specifications” section in the Hardware 
Specifications document.

The single-slot 32-Channel Demultiplexer L-Band card (32DMX-L) is an L-band optical demultiplexer. 
The card receives an aggregate optical signal on its COM RX port and demultiplexes it into to (32) 
100-GHz-spaced channels. The 32DMX-L card is particularly well suited for use in networks that 
employ DS fiber or SMF-28 single-mode fiber. The 32DMX-L card can be installed in Slots 1 to 6 and 
in Slots 12 to 17. 

10.6.1 Faceplate and Block Diagrams
The 32DMX-L card has two types of ports:

• COM RX port: COM RX is the input port for the aggregate optical signal being demultiplexed. This 
port is supported by both a VOA for optical power regulation and a photodiode for optical power 
monitoring.

• DROP TX ports (1 to 32): On its output, the 32DMX-L card provides 32 drop ports (listed in 
Table 10-21 on page 10-42) that are typically used for dropping channels within the ROADM node. 
These ports are connected using four 8-fiber MPO ribbon connectors. Each drop port has a 
photodiode for optical power monitoring. Unlike the two-slot 32DMX-O demultiplexer, the drop 
ports on the 32DMX-L do not have a VOA per channel for optical power regulation. For a 
description of the 32DMX-O card, see the “6.4 32DMX-O Card” section on page 6-14.

Figure 10-10 shows the 32DMX-L card front panel and the basic traffic flow through the ports.
10-34
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html#reference_1E393D31B54048C7AFB01A2F40ECEF5A


 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.6.1   Faceplate and Block Diagrams
Figure 10-10 32DMX-L Faceplate and Ports

Figure 10-11 shows a block diagram of the 32DMX-L card.
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.6.2   32DMX-L ROADM Functionality
Figure 10-11 32DMX-L Block Diagram

Figure 10-12 shows the 32DMX-L optical module functional block diagram.

Figure 10-12 32DMX-L Optical Module Functional Block Diagram

10.6.2 32DMX-L ROADM Functionality
The 32DMX-L card works in combination with the 32WSS-L card to implement ROADM functionality. 
AS a ROADM node, the ONS 15454 can be configured to add or drop individual optical channels using 
CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 32DMX-L card requires two 
32DMX-L single-slot cards and two 32WSS-L double-slot cards (for a total of six slots in the 
ONS 15454 chassis). 
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.6.3   32DMX-L Power Monitoring
For information about ROADM functionality for other cards, see that card’s description in this chapter. 
For a diagram of a typical ROADM configuration, see the “12.1.3 ROADM Node” section on 
page 12-11.

Note A terminal site can be configured using only a 32WSS-L card and a 32DMX-L card plugged into the east 
or west side of the shelf.

10.6.3 32DMX-L Power Monitoring
Physical photodiodes P1 through P33 monitor the power for the 32DMX-L card. The returned power 
level values are calibrated to the ports as shown in Table 10-18.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.6.4 32DMX-L Channel Plan
The 32DMX-L card uses 32 banded channels on the ITU-T 100-GHz grid, as shown in Table 10-19.

Table 10-18 32DMX-L Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P32 DROP DROP TX

P33 INPUT COM COM RX

Table 10-19 32DMX-L Channel Plan 

Band ID Channel Label Frequency (THz) Wavelength (nm)

B77.8 77.8 190 1577.86

78.6 189.9 1578.69

79.5 189.8 1579.52

80.3 189.7 1580.35

B81.1 81.1 189.6 1581.18

82.0 189.5 1582.02

82.8 189.4 1582.85

83.6 189.3 1583.69

B84.5 84.5 189.2 1584.53

85.3 189.1 1585.36

86.2 189 1586.20

87.0 188.9 1587.04
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10.6.5   32DMX-L Card Functions
10.6.5 32DMX-L Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.6.6 Related Procedures for 32DMX-L Card
The following section lists procedures and tasks related to the configuration of the 32DMX-L card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

B87.8 87.8 188.8 1587.88

88.7 188.7 1588.73

89.5 188.6 1589.57

90.4 188.5 1590.41

B91.2 91.2 188.4 1591.26

92.1 188.3 1592.10

92.9 188.2 1592.95

93.7 188.1 1593.79

B94.6 94.6 188 1594.64

95.4 187.9 1595.49

96.3 187.8 1596.34

97.1 187.7 1597.19

B98.0 98.0 187.6 1598.04

98.8 187.5 1598.89

99.7 187.4 1599.75

00.6 187.3 1600.60

B01.4 01.4 187.2 1601.46

02.3 187.1 1602.31

03.1 187 1603.17

04.0 186.9 1604.03

Table 10-19 32DMX-L Channel Plan  (continued)

Band ID Channel Label Frequency (THz) Wavelength (nm)
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10.7   40-DMX-C Card
• NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds, page 21-54

10.7 40-DMX-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For 40-DMX-C card specifications, see the “40-DMX-C Card Specifications” section in the Hardware 
Specifications document.

The single-slot 40-Channel Demultiplexer C-band (40-DMX-C) card demultiplexes 40 100-GHz-spaced 
channels identified in the channel plan (Table 10-21 on page 10-42), and sends them to dedicated output 
ports. The overall optical power can be adjusted using a single VOA that is common to all channels. The 
40-DMX-C card is unidirectional, optically passive, and can be installed in Slots 1 to 6 and 12 to 17.

10.7.1 Faceplate and Block Diagrams
The 40-DMX-C has two types of ports: 

• COM RX port: COM RX is the line input port for the aggregate optical signal being demultiplexed. 
This port is supported by a VOA for optical power regulation and a photodiode for per channel 
optical power monitoring.

Note By default, the VOA is set to its maximum attenuation for safety purposes (for example, 
electrical power failure). A manual VOA setting is also available.

• DROP TX ports (1 to 40): On its output, the 40-DMX-C card provides 40 drop ports that are 
typically used for dropping channels within the ROADM node. These ports are connected using five 
physical connectors on the front panel that accept MPO client input cables. (MPO cables break out 
into eight separate cables.) The 40-DMX-C card also has one LC-PC-II optical connector for the 
main input. 

Figure 10-13 shows the 40-DMX-C card faceplate.
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10.7.1   Faceplate and Block Diagrams
Figure 10-13 40-DMX-C Faceplate 

Figure 10-14 shows a block diagram of the 40-DMX-C card.
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10.7.2   40-DMX-C ROADM Functionality
Figure 10-14 40-DMX-C Block Diagram

Figure 10-15 shows the 40-DMX-C optical module functional block diagram.

Figure 10-15 40-DMX-C Optical Module Functional Block Diagram

10.7.2 40-DMX-C ROADM Functionality
The 40-DMX-C card works in combination with the 40-WSS-C card to implement ROADM 
functionality. As a ROADM node, the ONS 15454 can be configured at the optical channel level using 
CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 40-DMX-C card requires two 
single-slot 40-DMX-C cards and two 40-WSS-C double-slot cards (for a total of six slots in the 
ONS 15454 chassis). 
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Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.7.3   40-DMX-C Power Monitoring
For other cards’ ROADM functionality, see that card’s description in this chapter. For a diagram of a 
typical ROADM configuration, see the “12.1.3 ROADM Node” section on page 12-11.

10.7.3 40-DMX-C Power Monitoring
Physical photodiodes P1 through P40 monitor the power at the outputs of the 40-DMX-C card. P41 
monitors the total multiplexed power at the input, calibrated to the COM-RX port. Table 10-20 shows 
the returned power level values calibrated to each port.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.7.4 40-DMX-C Channel Plan
Table 10-21 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are 
demultiplexed by the 40-DMX-C card. 

Table 10-20 40-DMX-C Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P40 DROP DROP TX

P41 INPUT COM COM RX

Table 10-21 40-DMX-C Channel Plan 

Band ID Channel Label Frequency (GHz)
Wavelength 
(nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

33.4 195.5 1533.47

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.6 195.1 1536.61

37.4 195 1537.40

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.98

39.7 194.7 1539.77

40.5 194.6 1540.56

41.3 194.5 1541.35
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10.7.5   40-DMX-C Card Functions
10.7.5 40-DMX-C Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.7.6 Related Procedures for 40-DMX-C Card
The following section lists procedures and tasks related to the configuration of the 40-DMX-C card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

45.3 194 1545.32

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

49.3 193.5 1549.32

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

53.3 193 1553.33

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

57.3 192.5 1557.36

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

61.4 192 1561.42

Table 10-21 40-DMX-C Channel Plan  (continued)

Band ID Channel Label Frequency (GHz)
Wavelength 
(nm)
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10.8   40-DMX-CE Card
• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds, page 21-54

10.8 40-DMX-CE Card
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For 40-DMX-CE card specifications, see the “40-DMX-CE Card Specifications” section in the 
Hardware Specifications document.

The single-slot 40-Channel Demultiplexer C-band, even channels (40-DMX-CE) card demultiplexes 40 
100-GHz-spaced even-numbered channels identified in the channel plan (Table 10-23 on page 10-47), 
and sends them to dedicated output ports. The overall optical power can be adjusted using a single VOA 
that is common to all channels. The 40-DMX-CE card is unidirectional, optically passive, and can be 
installed in Slots 1 to 6 and 12 to 17.

10.8.1 Faceplate and Block Diagrams
The 40-DMX-CE card has two types of ports: 

• COM RX port: COM RX is the line input port for the aggregate optical signal being demultiplexed. 
This port is supported by a VOA for optical power regulation and a photodiode for per channel 
optical power monitoring.

Note By default, the VOA is set to its maximum attenuation for safety purposes (for example, 
electrical power failure). A manual VOA setting is also available.

• DROP TX ports (1 to 40): On its output, the 40-DMX-CE card provides 40 drop ports that are 
typically used for dropping channels within the ROADM node. These ports are connected using five 
physical connectors on the front panel that accept MPO client input cables. (MPO cables break out 
into eight separate cables.) The 40-DMX-CE card also has one LC-PC-II optical connector for the 
main input. 

Figure 10-16 shows the 40-DMX-CE card faceplate.
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10.8.1   Faceplate and Block Diagrams
Figure 10-16 40-DMX-CE Card Faceplate 

Figure 10-17 shows a block diagram of the 40-DMX-CE card.
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10.8.2   40-DMX-CE Card ROADM Functionality
Figure 10-17 40-DMX-CE Card Block Diagram

Figure 10-18 shows the 40-DMX-CE card optical module functional block diagram.

Figure 10-18 40-DMX-CE Card Optical Module Functional Block Diagram

10.8.2 40-DMX-CE Card ROADM Functionality
The 40-DMX-CE card works in combination with the 40-WSS-CE card to implement ROADM 
functionality. As a ROADM node, the ONS 15454 can be configured at the optical channel level using 
CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 40-DMX-CE card requires 
two single-slot 40-DMX-CE cards and two 40-WSS-CE double-slot cards (for a total of six slots in the 
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10.8.3   40-DMX-CE Card Power Monitoring
For the ROADM functionality of other cards, see the description of that card in this chapter. For a 
diagram of a typical ROADM configuration, see the “12.1.3 ROADM Node” section on page 12-11.

10.8.3 40-DMX-CE Card Power Monitoring
Physical photodiodes P1 through P40 monitor the power at the outputs of the 40-DMX-CE card. P41 
monitors the total multiplexed power at the input, calibrated to the COM-RX port. Table 10-22 shows 
the returned power level values calibrated to each port.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.8.4 40-DMX-CE Card Channel Plan
Table 10-23 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are 
demultiplexed by the 40-DMX-CE card. 

Table 10-22 40-DMX-CE Card Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P40 DROP DROP TX

P41 INPUT COM COM RX

Table 10-23 40-DMX-CE Card Channel Plan 

Band ID Channel Label Frequency (GHz) Wavelength (nm)

B30.7 30.7 195.85 1530.72

31.5 195.75 1531.51

32.3 195.65 1532.29

33.1 195.55 1533.07

33.9 195.45 1533.86

B34.6 34.6 195.35 1534.64

35.4 195.25 1535.43

36.2 195.15 1536.22

37.0 195.05 1537.00

37.8 194.95 1537.79

B38.6 38.6 194.85 1538.58

39.4 194.75 1539.37

40.1 194.65 1540.16

40.9 194.55 1540.95

41.8 194.45 1541.75
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10.8.5   40-DMX-CE Card Functions
10.8.5 40-DMX-CE Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.8.6 Related Procedures for 40-DMX-CE Card
The following section lists procedures and tasks related to the configuration of the 40-DMX-CE card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

B42.5 42.5 194.35 1542.54

43.3 194.25 1543.33

44.1 194.15 1544.13

44.9 194.05 1544.92

45.7 193.95 1545.72

B46.5 46.5 193.85 1546.52

47.3 193.75 1547.32

48.1 193.65 1548.11

48.9 193.55 1548.91

49.7 193.45 1549.72

B50.5 50.5 193.35 1550.52

51.3 193.25 1551.32

52.1 193.15 1552.12

52.9 193.05 1552.93

53.7 192.95 1553.73

B54.4 54.4 192.85 1554.54

55.3 192.75 1555.34

56.1 192.65 1556.15

56.9 192.55 1556.96

57.8 192.45 1557.77

B58.6 58.6 192.35 1558.58

59.4 192.25 1559.39

60.2 192.15 1560.20

61.0 192.05 1561.01

61.8 191.95 1561.83

Table 10-23 40-DMX-CE Card Channel Plan  (continued)

Band ID Channel Label Frequency (GHz) Wavelength (nm)
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10.9   40-MUX-C Card
• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds, page 21-54

10.9 40-MUX-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For 40-MUX-C card specifications, see the “40-MUX-C Card Specification” section in the Hardware 
Specifications document.

The single-slot 40-Channel Multiplexer C-band (40-MUX-C) card multiplexes forty ITU-T 
100-GHz-spaced channels identified in the channel plan in Table 10-21 on page 10-42. The 40-MUX-C 
card can be installed in Slots 1 to 6 and 12 to 17. The 40-MUX-C card is typically used in hub nodes. 

10.9.1 Faceplate and Block Diagrams
The 40-MUX-C card has two types of ports:

• COM TX port: COM TX is the line output port for the aggregate optical signal being multiplexed. 
This port is supported by both a VOA for optical power regulation and a photodiode for per channel 
optical power monitoring.

Note By default, the VOA is set to its maximum attenuation for safety purposes (for example, 
electrical power failure). A manual VOA setting is also available.

• DROP RX ports (1 to 40): The 40-MUX-C card provides 40 input optical channels. These ports are 
connected using five physical receive connectors on the card’s front panel that accept MPO cables 
for the client input interfaces. MPO cables break out into eight separate cables. The 40-DMX-C card 
also has one LC-PC-II optical connector for the main output. For the wavelength range, see 
Table 10-21 on page 10-42.

Figure 10-19 shows the 40-MUX-C card faceplate.
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10.9.1   Faceplate and Block Diagrams
Figure 10-19 40-MUX-C Card Faceplate 

Figure 10-20 shows a block diagram of the 40-MUX-C card. 
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10.9.2   40-MUX-C Card Power Monitoring
Figure 10-20 40-MUX-C Card Block Diagram

Figure 10-21 shows the 40-MUX-C optical module functional block diagram.

Figure 10-21 40-MUX-C Optical Module Functional Block Diagram

10.9.2 40-MUX-C Card Power Monitoring
Physical photodiodes P1 through P40 monitor the power of the individual input ports to the 40-MUX-C 
card. P41 monitors the total multiplexed output power, calibrated to the COM-TX port. Table 10-24 
shows the returned power level values calibrated to each port.
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10.9.3   40-MUX-C Card Channel Plan
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.9.3 40-MUX-C Card Channel Plan
Table 10-25 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are multiplexed 
by the 40-MUX-C card. 

Table 10-24 40-MUX-C Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1–P40 ADD ADD RX

P41 OUTPUT COM COM-TX

Table 10-25 40-MUX-C Channel Plan 

Band ID Channel Label Frequency (GHz)
Wavelength 
(nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

33.4 195.5 1533.47

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.6 195.1 1536.61

37.4 195 1537.40

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.98

39.7 194.7 1539.77

40.5 194.6 1540.56

41.3 194.5 1541.35

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

45.3 194 1545.32
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10.9.4   40-MUX-C Card Functions
10.9.4 40-MUX-C Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.9.5 Related Procedures for 40-MUX-C Card
The following section lists procedures and tasks related to the configuration of the 40-MUX-C card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

49.3 193.5 1549.32

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

53.3 193 1553.33

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

57.3 192.5 1557.36

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

61.4 192 1561.42

Table 10-25 40-MUX-C Channel Plan  (continued)

Band ID Channel Label Frequency (GHz)
Wavelength 
(nm)
10-53
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.10   40-WSS-C Card
• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds, page 21-54

10.10 40-WSS-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For 40-WSS-C card specifications, see the “40-WSS-C Card Specifications” section in the Hardware 
Specifications document.

The double-slot 40-channel Wavelength Selective Switch C-Band (40-WSS-C) card switches 40 ITU-T 
100-GHz-spaced channels identified in the channel plan (Table 10-21 on page 10-42) and sends them to 
dedicated output ports. The 40-WSS-C card is bidirectional and optically passive. The card can be 
installed in Slots 1 to 6 and 12 to 17

The 40-WSS-C features include:

• Receipt of an aggregate DWDM signal into 40 output optical channels from the Line receive port 
(EXP RX) in one direction and from the COM-RX port in the other direction.

• Per-channel optical power monitoring using photodiodes.

• Signal splitting in a 70%-to-30% ratio, sent to the 40-DMX-C for dropping signals, then to the other 
40-WSS-C card.

• Aggregate DWDM signal monitoring and control through a variable optical attenuator (VOA). In 
the case of electrical power failure, the VOA is set to its maximum attenuation for safety purposes. 
A manual VOA setting is also available.

Within the 40-WSS-C card, the first AWG opens the spectrum and each wavelength is directed to one of 
the ports of a 1x2 optical switch. The same wavelength can be passed through or stopped. If the 
pass-through wavelength is stopped, a new channel can be added at the ADD port. The card’s second 
AWG multiplexes all of the wavelengths, and the aggregate signal is output through the COM-TX port. 

10.10.1 Faceplate and Block Diagrams
The 40-WSS-C has eight types of ports: 

• ADD RX ports (1 to 40): These ports are used for adding channels. Each add channel is associated 
with an individual switch element that selects whether an individual channel is added. Each add port 
has optical power regulation provided by a VOA. The five connectors on the card faceplate accept 
MPO cables for the client input interfaces. MPO cables break out into eight separate cables. The 
40-WSS-C card also has one LC-PC-II optical connector for the main input.

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE) 
and sends it to the optical splitter. 

• COM TX: The COM TX port sends an aggregate optical signal to a booster amplifier card (for 
example, the OPT-BST card) for transmission outside of the NE.
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10.10.1   Faceplate and Block Diagrams
• EXP RX port: The EXP RX port receives an optical signal from another 40-WSS-C card in the same 
NE.

• EXP TX: The EXP TX port sends an optical signal to the other 40-WSS-C card within the NE.

• DROP TX port: The DROP TX port sends the split off optical signal that contains drop channels to 
the 40-DMX-C card, where the channels are further processed and dropped. 

Figure 10-22 shows the 40-WSS-C card faceplate.

Figure 10-22 40-WSS-C Faceplate 

Figure 10-23 shows a block diagram of the 40-WSS-C card.
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10.10.1   Faceplate and Block Diagrams
Figure 10-23 40-WSS-C Block Diagram

Figure 10-24 shows the 40-WSS-C optical module functional block diagram.
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10.10.2   40-WSS-C ROADM Functionality
Figure 10-24 40-WSS-C Optical Module Functional Block Diagram

10.10.2 40-WSS-C ROADM Functionality
The 40-WSS-C card works in combination with the 40-DMX-C card to implement ROADM 
functionality. As a ROADM node, the ONS 15454 can be configured at the optical channel level using 
CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 40-WSS-C card requires two 
40-WSS-C double-slot cards and two 40-DMX-C single-slot cards (for a total of six slots in the 
ONS 15454 chassis). 

For information about ROADM functionality for other cards, see that card’s description in this chapter. 
For a diagram of a typical ROADM configuration, see the “12.1.3 ROADM Node” section on 
page 12-11.

10.10.3 40-WSS-C Power Monitoring
The 40-WSS-C has physical diodes that monitor power at various locations on the card. Table 10-26 lists 
the physical diode descriptions. 
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Table 10-26 40-WSS-C Physical Photodiode Port Calibration

Physical Photodiode CTC Type Name Calibrated to Port(s)

P1 DROP DROP TX

P2 EXP EXP RX
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10.10.4   40-WSS-C Channel Plan
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Additionally, the 40-WSS-C has two virtual diodes. Virtual diodes are monitor points for each physical 
photodiode; they are identified with a physical diode relative to the way that the physical diode is 
identified with one of the two interlink (ILK) ports. Table 10-27 lists the virtual diodes. 

10.10.4 40-WSS-C Channel Plan
Table 10-28 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are switched by 
the 40-WSS-C card. 

PDi31 RX Add i RX ports (that is, channel input Add i RX 
power), up to 40 ports and therefore 40 PDs1

PDi41 TX COM TX port (that is, per channel output COM TX 
power) up to 40 channels and therefore 40 PDs

PD5 COM COM TX port (that is, total output COM TX power)

1. i indicates any channel from 01 through 40.

Table 10-26 40-WSS-C Physical Photodiode Port Calibration (continued)

Physical Photodiode CTC Type Name Calibrated to Port(s)

Table 10-27 40-WSS-C Virtual Photodiode Port Calibration

Virtual Photodiode CTC Type Name Calibrated to Port(s)

VPD1 COM COM RX port (total input COM RX power)

VPD2 EXP EXP TX port (total output EXP TX power)

Table 10-28 40-WSS-C Channel Plan

Band ID Channel Label Frequency (GHz) Wavelength (nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

33.4 195.5 1533.47

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.6 195.1 1536.61

37.4 195 1537.40
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10.10.5 40-WSS-C Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.98

39.7 194.7 1539.77

40.5 194.6 1540.56

41.3 194.5 1541.35

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

45.3 194 1545.32

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

49.3 193.5 1549.32

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

53.3 193 1553.33

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

57.3 192.5 1557.36

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

61.4 192 1561.42

Table 10-28 40-WSS-C Channel Plan (continued)

Band ID Channel Label Frequency (GHz) Wavelength (nm)
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10.10.6 Related Procedures for 40-WSS-C Card
The following section lists procedures and tasks related to the configuration of the 40-WSS-C card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G93 Modify the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Line Settings and PM 
Thresholds, page 21-65

10.11 40-WSS-CE Card
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For 40-WSS-CE card specifications, see the “40-WSS-CE Card Specifications” section in the Hardware 
Specifications document.

The double-slot 40-channel Wavelength Selective Switch Even-Channel C-Band (40-WSS-CE) card 
switches 40 ITU-T 100-GHz-spaced channels identified in the channel plan (Table 10-31 on page 10-65) 
and sends them to dedicated output ports. The 40-WSS-CE card is bidirectional and optically passive. 
The card can be installed in Slots 1 to 6 and 12 to 17.

The 40-WSS-CE features include:

• Receipt of an aggregate DWDM signal into 40 output optical channels from the Line receive port 
(EXP RX) in one direction and from the COM-RX port in the other direction.

• Per-channel optical power monitoring using photodiodes.

• Signal splitting in a 70-to-30 percent ratio, sent to the 40-DMX-CE card for dropping signals, then 
to the other 40-WSS-CE card.

• Aggregate DWDM signal monitoring and control through a VOA. In the case of electrical power 
failure, the VOA is set to its maximum attenuation for safety purposes. A manual VOA setting is 
also available.

Within the 40-WSS-CE card, the first AWG opens the spectrum and each wavelength is directed to one 
of the ports of a 1x2 optical switch. The same wavelength can be passed through or stopped. If the 
pass-through wavelength is stopped, a new channel can be added at the ADD port. The card’s second 
AWG multiplexes all of the wavelengths, and the aggregate signal is output through the COM-TX port. 

10.11.1 Faceplate and Block Diagrams
The 40-WSS-CE card has eight types of ports: 
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10.11.1   Faceplate and Block Diagrams
• ADD RX ports (1 to 40): These ports are used for adding channels. Each add channel is associated 
with an individual switch element that selects whether an individual channel is added. Each add port 
has optical power regulation provided by a VOA. The five connectors on the card faceplate accept 
MPO cables for the client input interfaces. MPO cables break out into eight separate cables. The 
40-WSS-CE card also has one LC-PC-II optical connector for the main input.

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE) 
and sends it to the optical splitter. 

• COM TX: The COM TX port sends an aggregate optical signal to a booster amplifier card (for 
example, the OPT-BST card) for transmission outside of the NE.

• EXP RX port: The EXP RX port receives an optical signal from another 40-WSS-CE card in the 
same NE.

• EXP TX: The EXP TX port sends an optical signal to the other 40-WSS-CE card within the NE.

• DROP TX port: The DROP TX port sends the split off optical signal that contains drop channels to 
the 40-DMX-C card, where the channels are further processed and dropped. 

Figure 10-25 shows the 40-WSS-CE card faceplate.
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Figure 10-25 40-WSS-CE Faceplate 

Figure 10-26 shows a block diagram of the 40-WSS-CE card.
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10.11.1   Faceplate and Block Diagrams
Figure 10-26 40-WSS-CE Block Diagram

Figure 10-27 shows the 40-WSS-CE optical module functional block diagram.
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10.11.2   40-WSS-CE Card ROADM Functionality
Figure 10-27 40-WSS-CE Card Optical Module Functional Block Diagram

10.11.2 40-WSS-CE Card ROADM Functionality
The 40-WSS-CE card works in combination with the 40-DMX-CE card to implement ROADM 
functionality. As a ROADM node, the ONS 15454 can be configured at the optical channel level using 
CTC, Cisco Transport Planner, and CTM. ROADM functionality using the 40-WSS-CE card requires 
two 40-WSS-CE double-slot cards and two 40-DMX-CE single-slot cards (for a total of six slots in the 
ONS 15454 chassis). 

For information about ROADM functionality for another cards, see the description of that card in this 
chapter. For a diagram of a typical ROADM configuration, see the “12.1.3 ROADM Node” section on 
page 12-11.

10.11.3 40-WSS-CE Card Power Monitoring
The 40-WSS-CE card has physical diodes that monitor power at various locations on the card. 
Table 10-29 lists the physical diode descriptions. 

Optical
module

 1
59

39
2

uP8260

COM RX

COM TX

FPGA
For SCL Bus
management

2xSCL Buses

DC/DC
Power supply
Input filters

BAT A&B

EXP RX

ADD RX

LC connector

MPO connector

EXP TX

DROP TX

Table 10-29 40-WSS-CE Physical Photodiode Port Calibration

Physical Photodiode CTC Type Name Calibrated to Port(s)

P1 DROP DROP TX

P2 EXP EXP RX
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10.11.4   40-WSS-CE Card Channel Plan
For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Additionally, the 40-WSS-CE card has two virtual diodes. Virtual diodes are monitor points for each 
physical photodiode; they are identified with a physical diode relative to the way that the physical diode 
is identified with one of the two interlink (ILK) ports. Table 10-30 lists the virtual diodes. 

10.11.4 40-WSS-CE Card Channel Plan
Table 10-31 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are switched by 
the 40-WSS-CE card. 

PDi31 RX Add i RX ports (that is, channel input Add i RX 
power), up to 40 ports and therefore 40 PDs1

PDi41 TX COM TX port (that is, per channel output COM TX 
power) up to 40 channels and therefore 40 PDs

PD5 COM COM TX port (that is, total output COM TX power)

1. i indicates any channel from 01 through 40.

Table 10-29 40-WSS-CE Physical Photodiode Port Calibration (continued)

Physical Photodiode CTC Type Name Calibrated to Port(s)

Table 10-30 40-WSS-CE Virtual Photodiode Port Calibration

Virtual Photodiode CTC Type Name Calibrated to Port(s)

VPD1 COM COM RX port (total input COM RX power)

VPD2 EXP EXP TX port (total output EXP TX power)

Table 10-31 40-WSS-CE Channel Plan 

Band ID Channel Label Frequency (GHz) Wavelength (nm)

B30.7 30.7 195.85 1530.72

31.5 195.75 1531.51

32.3 195.65 1532.29

33.1 195.55 1533.07

33.9 195.45 1533.86

B34.6 34.6 195.35 1534.64

35.4 195.25 1535.43

36.2 195.15 1536.22

37.0 195.05 1537.00

37.8 194.95 1537.79
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10.11.5 40-WSS-CE Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

B38.6 38.6 194.85 1538.58

39.4 194.75 1539.37

40.1 194.65 1540.16

40.9 194.55 1540.95

41.8 194.45 1541.75

B42.5 42.5 194.35 1542.54

43.3 194.25 1543.33

44.1 194.15 1544.13

44.9 194.05 1544.92

45.7 193.95 1545.72

B46.5 46.5 193.85 1546.52

47.3 193.75 1547.32

48.1 193.65 1548.11

48.9 193.55 1548.91

49.7 193.45 1549.72

B50.5 50.5 193.35 1550.52

51.3 193.25 1551.32

52.1 193.15 1552.12

52.9 193.05 1552.93

53.7 192.95 1553.73

B54.4 54.4 192.85 1554.54

55.3 192.75 1555.34

56.1 192.65 1556.15

56.9 192.55 1556.96

57.8 192.45 1557.77

B58.6 58.6 192.35 1558.58

59.4 192.25 1559.39

60.2 192.15 1560.20

61.0 192.05 1561.01

61.8 191.95 1561.83

Table 10-31 40-WSS-CE Channel Plan  (continued)

Band ID Channel Label Frequency (GHz) Wavelength (nm)
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10.11.6 Related Procedures for 40-WSS-CE Card
The following section lists procedures and tasks related to the configuration of the 40-WSS-CE card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G93 Modify the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Line Settings and PM 
Thresholds, page 21-65

10.12 40-WXC-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

Note For 40-WXC-C card specifications, see the “40-WXC-C Card Specifications” section in the Hardware 
Specifications document.

The double-slot 40-channel Wavelength Cross-Connect C-band (40-WXC-C) card selectively sends any 
wavelength combination coming from nine input ports to a common output port. The device can manage 
up to 41 channels spaced at 100GHz on each port according to the channel grid in Table 10-10 on 
page 10-12. Each channel can be selected from any input. The card is optically passive and provides 
bidirectional capability. It can be installed in Slots 1 to 6 and 12 to 17.

.The 40-WXC-C card provides the following features:

• Demultiplexing, selection, and multiplexing of DWDM aggregate signal from input ports to 
common output port.

• Aggregate DWDM signal monitoring and control through a VOA.

• VOAs are deployed in every channel path in order to regulate the channel’s optical power. In the case 
of an electrical power failure, VOAs are set to their maximum attenuation value, or to a fixed and 
configurable one. The VOA can also be set manually.

• Per-channel optical power monitoring using photodiodes.

The 40-WXC-C card acts as a selector element with the following characteristics:

• It is able to select a wavelength from one input port and pass the wavelength through to the common 
out port. Simultaneously, the card can block the same wavelength coming from the other eight input 
ports.

• It is able to stop wavelengths from all nine inputs.

• It is able to monitor optical power and control path attenuation using per channel VOA 
independently of the wavelength input-to-out port connection.
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10.12.1 Faceplate and Block Diagram
The 40-WXC-C card has six types of ports:

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE) 
and sends it to the optical splitter.

• COM TX: The COM TX port sends an aggregate optical signal to a booster amplifier card (for 
example, the OPT-BST card) for transmission outside of the NE.

• EXP TX: The EXP TX port sends an optical signal to the other 40-WXC-C card within the NE.

• MON TX: The optical service channel (OSC) monitor.

• ADD/DROP RX: The 40-WXC-C card provides 40 input optical channels. For the wavelength 
range, see Table 10-34 on page 10-72.

• ADD/DROP TX: The DROP TX port sends the split off optical signal that contains drop channels 
to the 40-WXC-C card, where the channels are further processed and dropped. 

Figure 10-28 shows the 40-WXC-C card faceplate.
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Figure 10-28 40-WXC-C Faceplate 

Figure 10-29 shows the 40-WXC-C optical module functional block diagram.
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Figure 10-29 40-WXC-C Optical Module Functional Block Diagram

10.12.2 40-WXC-C Power Monitoring
The 40-WXC-C has 83 physical diodes (P1 through P40) that monitor power at the outputs of the card. 
Table 10-32 describes the physical diodes. 

WXC optical module

COM
TX

ADD RX

Virtual

PDi3

P5

Table 10-32 40-WXC-C Physical Photodiode Port Calibration

Physical 
Photodiode CTC Type Name Calibrated to Port(s)

P1 DROP DROP TX

P2 EXP EXP RX

PDi31

1. i indicates any channel from 01 through 40.

RX Add i RX ports (that is, 
channel input Add i RX 
power), up to 40 ports and 
therefore 40 PDs1

PDi41 TX COM TX port (that is, per 
channel output COM TX 
power) up to 40 channels and 
therefore 40 PDs

PD5 COM COM TX port (that is, total 
output COM TX power)
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For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Additionally, the 40-WXC-C has two virtual diodes. Virtual diodes are monitor points for each physical 
photodiode; they are identified with a physical diode relative to the way that the physical diode is 
identified with one of the two interlink (ILK) ports. Table 10-33 lists the virtual diodes. 

The usage of WXC and mesh PP power readings to troubleshoot a LOS-P in WXC COM TX port in Side 
A is described in the following example. The example is explained assuming a single wavelength 
1558.17 in the setup that comes from Side H to Side A. If there is more than one wavelength, then there 
is a risk of dropping traffic when pulling common fibers. The example is explained below:

When the wavelength from side H is 1558.17, you can check the power reading at WXC EXP TX port 
of the WXC card and verify the consistency with side H pre output power and WXC COMRX-EXPTX 
port loss. You can also check with a power meter connected to the 8th fiber (since it is from side H) of 
an MPO-FC (or LC) cable connected to the TAP-TX port of the MESH-PP. This value should be 
consistent with the previous reading, less than the insertion loss of the installed PP-MESH. If it is 
consistent, the issue is with the MPO between side A WXC and PP-MESH. If it is not consistent, the 
issue is with the PP-MESH or the LC-LC from side H. With only the PP-MESH already tested during 
installation, the only issue can be with the patch cord b.

You can check if the 1558.17 wavelength from side H is unequalized (that is, if the channel is not aligned 
with the linear fit of the power values of the other channels) by keeping the DMX COM-RX port of side 
H in maintenance, and checking both the signal and ASE levels of CHAN-TX ports of the DMX card. If 
the channel is equalized (that is, if the channel is aligned with the linear fit of the power values of the 
other channels), then the issue is in the WXC side A that cannot properly regulate the VOA for such 
channel. If the channel is unequalized, then the issue is on a remote node. 

Note With an OSA or a spare 40 DMX, you can see the light coming from all the sides from TAP-TX of the 
PP-MESH. 

10.12.3 40-WXC-C Channel Plan
Table 10-34 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) that are cross 
connected by the 40-WXC-C card. 

Table 10-33 40-WXC-C Virtual Photodiode Port Calibration

Virtual 
Photodiode CTC Type Name Calibrated to Port(s)

VPD1 COM COM RX port (total input 
COM RX power)

VPD2 EXP EXP TX port (total output 
EXP TX power)
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Table 10-34 40-WXC-C Channel Plan

Band ID Channel Label Frequency (GHz)
Wavelength 
(nm)

Ch. 01 29.5 196 1529.55

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

33.4 195.5 1533.47

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.6 195.1 1536.61

37.4 195 1537.40

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.98

39.7 194.7 1539.77

40.5 194.6 1540.56

41.3 194.5 1541.35

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

45.3 194 1545.32

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

49.3 193.5 1549.32

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

53.3 193 1553.33
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10.12.4 40-WXC-C Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.12.5 Related Procedures for 40-WXC-C Card
The following section lists procedures and tasks related to the configuration of the 40-WXC-C card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G185 Install Fiber-Optic Cables between Mesh Nodes, page 14-98

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G174 Modify the 40-WXC-C or 80-WXC-C Line Settings and PM Thresholds, page 21-79

10.13 80-WXC-C Card
(Cisco ONS 15454 and ONS 15454 M6 only)

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

57.3 192.5 1557.36

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

61.4 192 1561.42

1. This channel is unused by the 40-WXC-C

Table 10-34 40-WXC-C Channel Plan (continued)

Band ID Channel Label Frequency (GHz)
Wavelength 
(nm)
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10.13.1   Faceplate and Block Diagram
Note For 80-WXC-C card specifications, see the “80-WXC-C Card Specifications” section in the Hardware 
Specifications document.

The double-slot 80-channel Wavelength Cross-Connect C-band (80-WXC-C) card manages up to 80 
ITU-T 100-GHz-spaced channels identified in the channel plan (Table 10-10 on page 10-12) and sends 
them to dedicated output ports. Each channel can be selected from any input port to any output port. The 
card is optically passive, and provides bidirectional capability. It can be installed in Slots 1 to 5 and 
12 to 16 the ONS 15454 chassis and Slots 2 to 6 in the ONS 15454 M6 chassis.

The 80-WXC-C card provides the following functionalities:

• When used in the multiplexer or bidirectional mode, the 80-WXC-C card allows selection of a single 
wavelength or any combination of wavelengths from any of the nine input ports to the common 
output port. 

• When used in the bidirectional mode, the output wavelength from the COM-RX port is split to 
manage the express and drop wavelengths.

• When used in the demultiplexer mode, the 80-WXC-C card, allows selection of a single wavelength 
or a combination of wavelengths from the common input port to any of the nine output ports.

• Automatic VOA shutdown (AVS) blocking state on each wavelength and port.

• Per-channel (closed loop) power regulation on the output port based on OCM block feedback.

• Per-channel (open loop) attenuation regulation on the output port which is not based on the OCM 
feedback.

The OCM unit provides per-channel optical power monitoring on the following ports: 

• COM port in output direction

• COM port in input direction

• DROP-TX port in output direction

• Eight Express/Add/Drop (EAD) ports and one Add/Drop (AD) port in both input and output 
directions

10.13.1 Faceplate and Block Diagram
The 80-WXC-C card has 14 types of ports:

• MON: The MON port monitors power on the COM T/R port.

• COM RX: The COM RX port receives the optical signal from a preamplifier (such as the OPT-PRE) 
and sends it to the optical splitter. 

• DROP TX: In the bidirectional mode, the DROP TX port sends the optical signal to the 
demultiplexer.

• EXP TX: The EXP TX port sends the split off optical signal that contains pass-through channels to the 
other side of the NE.

• COM T/R: The COM port is bidirectional. It functions as a COM TX port in the multiplexer mode 
and as a COM RX port in the demultiplexer mode.

• AD T/R: The AD port functions as ADD RX port in bidirectional and multiplexer modes and as a 
DROP port in the demultiplexer mode. 
10-74
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html#reference_780B1A64D9A44A2389417FC4999082F0


 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.13.1   Faceplate and Block Diagram
• EAD T/R i (where i = 1 to 8): The EAD ports function as EXP ports in the bidirectional mode, as 
ADD ports in the multiplexer mode, and as DROP ports in the demultiplexer mode.

Figure 10-30 shows the 80-WXC-C card faceplate and the optical module functional block diagram.

Figure 10-30 80-WXC-C Faceplate and the Optical Module Functional Block Diagram

The different units of the 80-WXC-C card are:

• 40/60 splitter with VOA on drop path—The preamplifier output signal from the preamplifier is split 
in a 40%-to-60% ratio; 40% is sent on the drop path (DROP-TX port) and 60% is sent on the 
pass-through path (EXP-TX port). The VOA equipped on the drop path is used to match the power 
range of the receiver photodiode without the need for bulk attenuation. If a channel is expected to 
be dropped in the 80-WXC-C card, the pass-through channel is stopped after the EXP-TX port either 
by a 40-WSS-C or a 40-WXC-C card. 
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10.13.2   80-WXC-C Power Monitoring
• 50 Ghz 10 port WXC—The WXC block is optically passive and has bidirectional capability. The 
WXC block can selectively send any wavelength combination coming from the eight input EAD 
ports and one AD port to a common (COM) output port, when used as a multiplexer, whereas it can 
selectively send any wavelength combination coming from its common (COM) input port to any of 
the eight output EAD ports and one AD port, when used as a demultiplexer. The WXC block can 
manage (on each port) up to 80 channels according to the channel grid reported in Table 10-37. Each 
channel can be selected from any input and routed to any output.

• 50 Ghz Optical Channel Monitor (OCM)—The OCM provides per channel power monitoring on the 
COM T/R, DROP-TX, AD, and EADi (i=1 to 8) ports. The power value for each wavelength is 
refreshed after a variable timer depending on the port and card activity.

10.13.2 80-WXC-C Power Monitoring
The 80-WXC-C has two physical photodiodes and an OCM unit that monitors power at the different 
ports of the card. Table 10-35 describes the physical photodiodes. 

For information on the associated TL1 AIDs for the optical power monitoring points, see the “CTC Port 
Numbers and TL1 Aids” section in the Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

Additionally, the 80-WXC-C has two virtual photodiodes. Table 10-36 lists the virtual photodiodes. 

Table 10-35 80-WXC-C Port Calibration

Physical 
Photodiode CTC Type Name Calibrated to Port(s)

PD1 COM Total Power COM

PD2 EXP-TX Total Power EXP-TX

OCM1 EAD 1 Per-Channel and Total Power EAD-1

OCM2 EAD 2 Per-Channel and Total Power EAD-2

OCM3 EAD 3 Per-Channel and Total Power EAD-3

OCM4 EAD 4 Per-Channel and Total Power EAD-4

OCM5 EAD 5 Per-Channel and Total Power EAD-5

OCM6 EAD 6 Per-Channel and Total Power EAD-6

OCM7 EAD 7 Per-Channel and Total Power EAD-7

OCM8 EAD 8 Per-Channel and Total Power EAD-8

OCM9 AD Per-Channel and Total Power AD

OCM10 Output Per-Channel and Total Power COM

OCM11 Input Per-Channel and Total Power COM

OCM12 Drop Per-Channel and Total Power DROP-TX
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10.13.3   80-WXC-C Channel Plan
10.13.3 80-WXC-C Channel Plan
Table 10-37 shows the 80 ITU-T 50-GHz-spaced, C-band channels (wavelengths) that are cross 
connected by the 80-WXC-C card. 

Table 10-36 80-WXC-C Virtual Photodiode Port Calibration

Virtual 
Photodiode CTC Type Name Calibrated to Port(s)

VPD3 DROP-TX Total Power DROP-TX

VPD4 COM-RX Total Power COM-RX

Table 10-37 80-WXC-C Channel Plan

Band ID Channel Label Frequency (THz)
Wavelength 
(nm)

Ch. 01 - 196 1529.55

30.3 30.3 195.9 1530.33

30.7 195.85 1530.72

31.1 195.8 1531.12

31.5 195.75 1531.51

31.9 195.7 1531.90

32.3 195.65 1532.29

32.7 195.6 1532.68

33.1 195.55 1533.07

33.5 195.5 1533.47

33.9 195.45 1533.86

34.3 34.3 195.4 1534.25

34.6 195.35 1534.64

35.0 195.3 1535.04

35.4 195.25 1535.43

35.8 195.2 1535.82

36.2 195.15 1536.22

36.6 195.1 1536.61

37.0 195.05 1537

37.4 195 1537.40

37.8 194.95 1537.79
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10.13.3   80-WXC-C Channel Plan
38.2 38.2 194.9 1538.19

38.6 194.85 1538.58

39.0 194.8 1538.98

39.4 194.75 1539.37

39.8 194.7 1539.77

40.2 194.65 1540.16

40.6 194.6 1540.56

41.0 194.55 1540.95

41.3 194.5 1541.35

41.7 194.45 1541.75

42.1 42.1 194.4 1542.14

42.5 194.35 1542.94

42.9 194.3 1542.94

43.3 194.25 1543.33

43.7 194.2 1543.73

44.1 194.15 1544.13

44.5 194.1 1544.53

44.9 194.05 1544.92

45.3 194 1545.32

45.7 193.95 1545.72

46.1 46.1 193.9 1546.12

46.5 193.85 1546.52

46.9 193.8 1546.92

47.3 193.75 1547.32

47.7 193.7 1547.72

48.1 193.65 1548.11

48.5 193.6 1548.51

48.9 193.55 1548.91

49.3 193.5 1549.32

49.7 193.45 1549.72

Table 10-37 80-WXC-C Channel Plan (continued)

Band ID Channel Label Frequency (THz)
Wavelength 
(nm)
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10.13.4   80-WXC-C Card Functions
10.13.4 80-WXC-C Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

50.1 50.1 193.4 1550.12

50.5 193.35 1550.52

50.9 193.3 1550.92

51.3 193.25 1551.32

51.7 193.2 1551.72

52.1 193.15 1552.12

52.5 193.1 1552.52

52.9 193.05 1552.93

53.3 193 1553.33

53.7 192.95 1553.73

54.1 54.1 192.9 1554.13

54.5 192.85 1554.54

54.9 192.8 1554.94

55.3 192.75 1555.34

55.7 192.7 1555.75

56.2 192.65 1556.15

56.6 192.6 1556.55

57.0 192.55 1556.96

57.4 192.5 1557.36

57.8 192.45 1557.77

58.2 58.2 192.4 1558.17

58.6 192.35 1558.58

59.0 192.3 1558.98

59.4 192.25 1559.39

59.8 192.2 1559.79

60.2 192.15 1560.20

60.6 192.1 1560.61

61.0 192.05 1561.01

61.4 192 1561.42

61.8 191.95 1561.83

1. This channel is unused by the 80-WXC-C

Table 10-37 80-WXC-C Channel Plan (continued)

Band ID Channel Label Frequency (THz)
Wavelength 
(nm)
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10.13.5   Related Procedures for 80-WXC-C Card
10.13.5 Related Procedures for 80-WXC-C Card
The following section lists procedures and tasks related to the configuration of the 80-WXC-C card:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G185 Install Fiber-Optic Cables between Mesh Nodes, page 14-98

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G174 Modify the 40-WXC-C or 80-WXC-C Line Settings and PM Thresholds, page 21-79

10.14 Single Module ROADM (SMR-C) Cards

Note For the 40-SMR1-C or 40-SMR2-C card specifications, see the “40-SMR1-C Card Specifications” or 
“40-SMR2-C Card Specifications” section in the Hardware Specifications document.

Note For 40-SMR1-C and 40-SMR2-C safety label information, see the “10.2 Safety Labels” section on 
page 10-15.

The single-slot 40-channel single module ROADM (SMR-C) cards integrate the following functional 
blocks onto a single line card:

• Optical preamplifier

• Optical booster amplifier

• Optical service channel (OSC) filter

• 2x1 wavelength cross-connect (WXC) or a 4x1 WXC

• Optical channel monitor (OCM)

The SMR-C cards are available in two versions:

• 10.14.2 40-SMR1-C Card

• 10.14.3 40-SMR2-C Card

The SMR-C cards can manage up to 40 channels spaced at 100GHz on each port according to the channel 
grid in Table 10-10. The cards can be installed in Slots 1 to 6 and 12 to 17.

10.14.1 SMR-C Card Key Features
The optical amplifier units in the SMR-C cards provide the following features:

• Embedded gain flattening filter
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10.14.2   40-SMR1-C Card
• Mid-stage access for dispersion compensation unit (only applicable for preamplifier erbium-doped 
fiber amplifier [EDFA])

• Fixed output power mode

• Fixed gain mode

• Nondistorting low-frequency transfer function

• Amplified spontaneous emissions (ASE) compensation in fixed gain and fixed output power mode

• Fast transient suppression

• Programmable tilt (only applicable for preamplifier EDFA)

• Full monitoring and alarm handling capability

• Optical safety support through signal loss detection and alarm at any input port, fast power down 
control, and reduced maximum output power in safe power mode.

• EDFA section calculates the signal power, by taking into account the expected ASE power 
contribution to the total output power. The signal output power or the signal gain can be used as 
feedback signals for the EDFA pump power control loop.

The 1x2 WXC unit (40-SMR1-C card) provides the following features:

• Selection of individual wavelength of the aggregated 100GHz signal from either the EXP-RX or 
ADD-RX ports

• Automatic VOA shutdown (AVS) blocking state on each wavelength and port

• Per-channel power regulation based on external OCM unit

• Open loop path attenuation control for each wavelength and port

The 1x4 WXC unit (40-SMR2-C card) provides the following features:

• Selection of individual wavelength of the aggregated 100GHz signal from either the EXPi-RX 
(where i = 1, 2, 3) or ADD-RX ports

• Automatic VOA shutdown (AVS) blocking state on each wavelength and port

• Per-channel power regulation based on external OCM unit

• Open loop path attenuation control for each wavelength and port

The OCM unit provides per channel optical power monitoring at EXP-RX, ADD-RX, DROP-TX, and 
LINE-TX ports.

10.14.2 40-SMR1-C Card
The 40-SMR1-C card includes a 100Ghz 1x2 WXC unit with integrated preamplifier unit (single EDFA).

10.14.2.1 Faceplate and Block Diagram

The 40-SMR1-C card has the following types of ports:

• MON RX: The MON RX port monitors power on the EXP-TX output port.

• MON TX: The MON TX port monitors power on the LINE-TX output port.

• DC RX: The DC RX port receives the optical signal from the dispersion compensating unit (DCU) 
and sends it to the second stage preamplifier input.

• DC TX: The DC TX port sends the optical signal from the first stage preamplifier output to the DCU.
10-81
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.14.2   40-SMR1-C Card
• OSC RX: The OSC RX port is the OSC add input port.

• OSC TX: The OSC TX port is the OSC drop output port.

• ADD/DROP RX: The ADD RX port receives the optical signal from the multiplexer section of the 
NE and sends it to the 1x2 WXC unit.

• ADD/DROP TX: The DROP TX port sends the split off optical signal to the demultiplexer section 
of the NE.

• LINE RX: The LINE RX port is the input signal port. 

• LINE TX: The LINE TX port is the output signal port.

• EXP RX: The EXP RX port receives the optical signal from the other side of the NE and sends it to 
the 1x2 WXC unit.

• EXP TX: The EXP TX port sends the split off optical signal that contains pass-through channels to 
the other side of the NE.

Figure 10-31 shows the 40-SMR1-C card faceplate.

Figure 10-31 40-SMR1-C Faceplate 

Figure 10-32 shows a block diagram of the 40-SMR1-C card.
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10.14.2   40-SMR1-C Card
Figure 10-32 40-SMR1-C Block Diagram

The different units of the 40-SMR1-C card are:

• OSC filter—The OSC filter allows to add an OSC channel to the C-band in the transmission path 
and to drop an OSC channel on the receiving path. The OSCM card that is connected to the OSC-TX 
and OSC-RX ports generates the OSC channel.

• Double-stage variable gain EDFA preamplifier—The double-stage preamplifier allows the insertion 
of a DCU between the DC-TX and DC-RX ports to compensate for chromatic dispersion. It is also 
equipped with built-in variable optical attenuator (VOA) and gain flattening filter (GFF) that 
provides tilt compensation and enables the use of this device over an extended range of span losses 
(5 dB to 35 dB).

• 70/30 splitter and VOA—The output signal from the preamplifier is split in a 70%-to-30% ratio, 
70% is sent on the pass-through path (EXP-TX port) and 30% is sent on the drop path (DROP-TX 
port). The VOA equipped on the drop path is used to match the power range of the receiver photo 
diode without the need for bulk attenuation. If a channel is expected to be dropped in the 
40-SMR1-C card, the pass-through channel is stopped after the EXP-TX port either by a 40-WSS-C, 
40-SMR1-C, or 40-SMR2-C card.

• 1x2 WXC—The 1x2 WXC aggregates on its output port a 100-GHz-spaced optical channel received 
from either its ADD-RX or EXP-RX port. In addition to the switching function, the 1x2 WXC 
allows to set a different per channel power for each of the managed wavelengths and also monitor 
the optical power.

• OCM—The OCM provides per channel power monitoring on the DROP-RX, EXP-RX, ADD-RX, 
and LINE-TX ports. The power value for each wavelength is refreshed after a variable timer 
depending on the port and card activity. 
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10.14.2   40-SMR1-C Card
10.14.2.2 40-SMR1-C Power Monitoring

The 40-SMR1-C card has seven physical diodes (PD1 through PD6 and PD8) and an OCM unit that 
monitors power at the input and output ports of the card (see Table 10-38).

10.14.2.3 40-SMR1-C Channel Plan

Table 10-39 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) supported by the 
40-SMR1-C card. 

Table 10-38 40-SMR1-C Port Calibration

Physical 
Photodiode CTC Type Name Calibrated to Port(s)

PD1 LINE LINE-RX

PD2 LINE LINE-RX

PD3 DC DC-TX

PD4 DC DC-RX

PD5 EXP EXP-TX

PD6 OSC OSC-RX

PD8 LINE LINE-TX

OCM1 LINE OCH LINE-TX

OCM2 DROP OCH DROP-TX

OCM3 ADD OCH ADD-RX

OCM4 EXP OCH EXP-RX

Table 10-39 40-SMR1-C Channel Plan

Band ID Channel Label Frequency (GHz) Wavelength (nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

33.4 195.5 1533.47

B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.6 195.1 1536.61

37.4 195 1537.40
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10.14.3 40-SMR2-C Card
The 40-SMR2-C card includes a 100Ghz 1x4 WXC unit with integrated preamplifier and booster 
amplifier units (double EDFA).

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.98

39.7 194.7 1539.77

40.5 194.6 1540.56

41.3 194.5 1541.35

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

45.3 194 1545.32

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

49.3 193.5 1549.32

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

53.3 193 1553.33

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

57.3 192.5 1557.36

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

61.4 192 1561.42

Table 10-39 40-SMR1-C Channel Plan (continued)

Band ID Channel Label Frequency (GHz) Wavelength (nm)
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10.14.3   40-SMR2-C Card
10.14.3.1 Faceplate and Block Diagram

The 40-SMR2-C card has the following types of ports:

• MON RX: The MON RX port monitors power on the EXP-TX output port.

• MON TX: The MON TX port monitors power on the LINE-TX output port.

• DC RX: The DC RX port receives the optical signal from the dispersion compensating unit (DCU) 
and sends it to the second stage preamplifier input.

• DC TX: The DC TX port sends the optical signal from the first stage preamplifier output to the DCU.

• OSC RX: The OSC RX port is the OSC add input port.

• OSC TX: The OSC TX port is the OSC drop output port.

• ADD/DROP RX: The ADD RX port receives the optical signal from the multiplexer section of the 
NE and sends it to the 1x4 WXC unit.

• ADD/DROP TX: The DROP TX port sends the split off optical signal to the demultiplexer section 
of the NE.

• LINE RX: The LINE RX port is the input signal port. 

• LINE TX: The LINE TX port is the output signal port.

• EXP TX: The EXP TX port sends the split off optical signal that contains pass-through channels to 
the other side of the NE.

• EXPi-RX (where i = 1, 2, 3): The EXPi-RX port receives the optical signal from the other side of 
the NE and sends it to the 1x4 WXC unit.

Figure 10-31 shows the 40-SMR2-C card faceplate.

Figure 10-33 40-SMR2-C Faceplate 

Figure 10-32 shows a block diagram of the 40-SMR2-C card.
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10.14.3   40-SMR2-C Card
Figure 10-34 40-SMR2-C Block Diagram

The different units of the 40-SMR2-C card are:

• OSC filter—The OSC filter allows to add an OSC channel to the C-band in the transmission path 
and to drop an OSC channel on the receiving path. The OSCM card that is connected to the OSC-TX 
and OSC-RX ports generates the OSC channel.

• Double-stage variable gain EDFA preamplifier—The double-stage preamplifier allows the insertion 
of a DCU between the DC-TX and DC-RX ports to compensate for chromatic dispersion. It is also 
equipped with built-in variable optical attenuator (VOA) and gain flattening filter (GFF) that 
provides tilt compensation and enables the use of this device over an extended range of span losses 
(5 dB to 35 dB).

• 70/30 splitter and VOA—The output signal from the preamplifier is split in a 70%-to-30% ratio, 
70% is sent on the pass-through path (EXP-TX port) and 30% is sent on the drop path (DROP-TX 
port). The VOA equipped on the drop path is used to match the power range of the receiver photo 
diode without the need for bulk attenuation. If a channel is expected to be dropped in the 
40-SMR2-C card, the pass-through channel is stopped after the EXP-TX port by a 40-WSS-C, 
40-SMR1-C, or 40-SMR2-C card.

• 1x4 WXC—The 1x4 WXC aggregates on its output port a 100-GHz-spaced optical channel received 
from either its ADD-RX or EXPi-RX (where i = 1, 2, 3) port. In addition to the switching function, 
the 1x4 WXC allows to set a different per channel power for each of the managed wavelengths and 
also monitor the optical power.
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10.14.3   40-SMR2-C Card
• Single-stage fixed gain EDFA booster amplifier—The booster amplifier amplifies the output signal 
from the 1x4 WXC unit before transmitting it into the fiber. Since it is a fixed gain (17 dB) amplifier, 
it does not allow gain tilt control.

• OCM—The OCM provides per channel power monitoring on the DROP-RX, EXPi-RX (where i = 
1, 2, 3), ADD-RX, and LINE-TX ports. The power value for each wavelength is refreshed after a 
variable timer depending on the port and card activity. 

10.14.3.2 40-SMR2-C Power Monitoring

The 40-SMR2-C card has eight physical diodes (PD1 through PD8) and an OCM unit that monitors 
power at the input and output ports of the card (see Table 10-40).

10.14.3.3 40-SMR2-C Channel Plan

Table 10-41 shows the 40 ITU-T 100-GHz-spaced, C-band channels (wavelengths) supported by the 
40-SMR2-C card. 

Table 10-40 40-SMR2-C Port Calibration

Physical 
Photodiode CTC Type Name Calibrated to Port(s)

PD1 LINE LINE-RX

PD2 LINE LINE-RX

PD3 DC DC-TX

PD4 DC DC-RX

PD5 EXP EXP-TX

PD6 OSC OSC-RX

PD7 Not reported on CTC Internal port

PD8 LINE LINE-TX

OCM1 LINE OCH LINE-TX

OCM2 DROP OCH DROP-TX

OCM3 ADD OCH ADD-RX

OCM4 EXP-1 OCH EXP1-RX

OCM5 EXP-2 OCH EXP2-RX

OCM6 EXP-3 OCH EXP3-RX

Table 10-41 40-SMR2-C Channel Plan

Band ID Channel Label Frequency (GHz) Wavelength (nm)

B30.3 30.3 195.9 1530.33

31.1 195.8 1531.12

31.9 195.7 1531.90

32.6 195.6 1532.68

33.4 195.5 1533.47
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10.14.3   40-SMR2-C Card
B34.2 34.2 195.4 1534.25

35.0 195.3 1535.04

35.8 195.2 1535.82

36.6 195.1 1536.61

37.4 195 1537.40

B38.1 38.1 194.9 1538.19

38.9 194.8 1538.98

39.7 194.7 1539.77

40.5 194.6 1540.56

41.3 194.5 1541.35

B42.1 42.1 194.4 1542.14

42.9 194.3 1542.94

43.7 194.2 1543.73

44.5 194.1 1544.53

45.3 194 1545.32

B46.1 46.1 193.9 1546.12

46.9 193.8 1546.92

47.7 193.7 1547.72

48.5 193.6 1548.51

49.3 193.5 1549.32

B50.1 50.1 193.4 1550.12

50.9 193.3 1550.92

51.7 193.2 1551.72

52.5 193.1 1552.52

53.3 193 1553.33

B54.1 54.1 192.9 1554.13

54.9 192.8 1554.94

55.7 192.7 1555.75

56.5 192.6 1556.55

57.3 192.5 1557.36

B58.1 58.1 192.4 1558.17

58.9 192.3 1558.98

59.7 192.2 1559.79

60.6 192.1 1560.61

61.4 192 1561.42

Table 10-41 40-SMR2-C Channel Plan (continued)

Band ID Channel Label Frequency (GHz) Wavelength (nm)
10-89
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 10      Provision Reconfigurable Optical Add/Drop Cards
10.14.4   40-SMR1-C and 40-SMR2-C Card Functions
10.14.4 40-SMR1-C and 40-SMR2-C Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.14.5 Related Procedures for 40-SMR1-C and 40-SMR2-C Card
The following section lists procedures and tasks related to the configuration of the 40-SMR-1C and 
40-SMR-2C cards:

• NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 14-79

• NTP-G185 Install Fiber-Optic Cables between Mesh Nodes, page 14-98

• NTP-G152 Create and Verify Internal Patchcords, page 14-110

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G243 Perform the Two-Degree ROADM Node with 40-SMR-1-C and OPT-AMP-17-C Cards 
Acceptance Test, page 15-148

• NTP-G244 Perform the Four Degree ROADM Node with 40-SMR-2-C Cards Acceptance Test, 
page 15-152

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• DLP- G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 32DMX, 
32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards

• NTP-G241 Modify the 40-SMR1-C and 40-SMR2-C Line Settings and PM Thresholds, page 21-94

10.15 MMU Card
(Cisco ONS 15454 only)

The single-slot Mesh Multi-Ring Upgrade Module (MMU) card supports multiring and mesh upgrades 
for ROADM nodes in both the C-band and the L-band. Mesh/multiring upgrade is the capability to 
optically bypass a given wavelength from one section of the network or ring to another one without 
requiring 3R regeneration. In each node, you need to install one east MMU and one west MMU. The 
card can be installed in Slots 1 through 6 and 12 through 17.

Note For MMU card specifications, see the “MMU Card Specifications” section in the Hardware 
Specifications document.

10.15.1 Faceplate and Block Diagram
The MMU has six types of ports:

• EXP RX port: The EXP RX port receives the optical signal from the ROADM section available on 
the NE.
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10.15.1   Faceplate and Block Diagram
• EXP TX port: The EXP TX port sends the optical signal to the ROADM section available on the NE.

• EXP-A RX port: The EXP-A RX port receives the optical signal from the ROADM section available 
on other NEs or rings.

• EXP-A TX port: The EXP-A TX port sends the optical signal to the ROADM section available on 
other NEs or rings.

• COM TX port: The COM TX port sends the optical signal to the fiber stage section.

• COM RX port: The COM RX port receives the optical signal from the fiber stage section.

Figure 10-35 shows the MMU card faceplate. 
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10.15.1   Faceplate and Block Diagram
Figure 10-35 MMU Faceplate and Ports

Figure 10-36 provides a high-level functional block diagram of the MMU card.
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10.15.2   MMU Power Monitoring
Figure 10-36 MMU Block Diagram

10.15.2 MMU Power Monitoring
Physical photodiodes P1 through P3 monitor the power for the MMU card. The returned power level 
values are calibrated to the ports as shown in Table 10-42. VP1 to VP3 are virtual photodiodes that have 
been created by adding (by software computation) the relevant path insertion losses of the optical 
splitters (stored in the module) to the real photodiode (P1 to P3) measurement.

For information on the associated TL1 AIDs for the optical power monitoring points, refer the “CTC 
Port Numbers and TL1 Aids” section in Cisco ONS SONET TL1 Command Guide, Release 9.2.1.

10.15.3 MMU Card Functions
• Card level indicators—Table G-4 on page G-9

• “G.4 Port-Level Indicators” section on page G-10

10.15.4 Related Procedures for MMU Card
The following section lists procedures and tasks related to the configuration of the MMU card:
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Table 10-42 MMU Port Calibration

Photodiode CTC Type Name Calibrated to Port

P1 1 (EXP-RX) EXP RX

P2 5 (EXP A-RX) EXP A RX 

P3 6 (EXP A-TX) EXP A TX

VP1 2 (EXP-TX) EXP TX

VP2 4 (COM-TX) COM TX

VP3 3 (COM-RX) COM RX
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10.15.4   Related Procedures for MMU Card
• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-74

• NTP-G37 Run Automatic Node Setup, page 14-124

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G149 Modify the MMU Line Settings and PM Thresholds, page 21-114
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Provision Transponder and Muxponder Cards

Note The terms “Unidirectional Path Switched Ring” and “UPSR” may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as “Path Protected Mesh Network” and “PPMN,” refer generally to Cisco’s 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter describes Cisco ONS 15454 transponder (TXP), muxponder (MXP), GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, 
and AR_XPE cards, as well as their associated plug-in modules (Small Form-factor Pluggables [SFP, 
SFP+, XFP, CXP, or CFP module]). For card safety and compliance information, see the Regulatory 
Compliance and Safety Information for Cisco CPT and Cisco ONS Platforms.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco 
ONS 15454 M2 platforms, unless noted otherwise. 

Note The procedures and tasks described in this chapter for the Cisco ONS 15454 platform is applicable to 
the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.

Note In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the 
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card. 

Chapter topics include:

• 11.1 Card Overview, page 11-3

• 11.2 Safety Labels, page 11-11

• 11.3 TXP_MR_10G Card, page 11-11

• 11.3.3 Related Procedures for TXP_MR_10G Card, page 11-14

• 11.4 TXP_MR_10E Card, page 11-14
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• 11.4.4 Related Procedures for TXP_MR_10E Card, page 11-16

• 11.5 TXP_MR_10E_C and TXP_MR_10E_L Cards, page 11-16

• 11.5.4 Related Procedures for TXP_MR_10E_C and TXP_MR_10E_L Cards, page 11-18

• 11.6 TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 11-18

• 11.6.3 Related Procedures for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 11-23

• 11.7 40E-TXP-C and 40ME-TXP-C Cards, page 11-23

• 11.7.3 Related Procedures for 40E-TXP-C and 40ME-TXP-C Cards, page 11-25

• 11.8 MXP_2.5G_10G Card, page 11-25

• 11.8.3 Related Procedures for MXP_2.5G_10G Card, page 11-28

• 11.9 MXP_2.5G_10E Card, page 11-28

• 11.9.4 Related Procedures for MXP_2.5G_10E Card, page 11-32

• 11.10 MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards, page 11-32

• 11.10.4 Related Procedures for MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards, page 11-38

• 11.11 MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 11-39

• 11.11.3 Related Procedures for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 11-44

• 11.12 MXP_MR_10DME_C and MXP_MR_10DME_L Cards, page 11-44

• 11.12.4 Related Procedures for MXP_MR_10DME_C and MXP_MR_10DME_L Cards, 
page 11-51

• 11.13 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards, page 11-52

• 11.13.4 Related Procedures for 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards, page 11-58

• 11.14 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards, page 11-58

• 11.14.17 Related Procedures for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards, page 11-82

• 11.15 ADM-10G Card, page 11-83

• 11.15.17 Related Procedures for ADM-10G Card, page 11-97

• 11.16 OTU2_XP Card, page 11-97

• 11.16.9 Related Procedures for OTU2_XP Card, page 11-106

• 11.17 TXP_MR_10EX_C Card, page 11-106

• 11.17.4 Related Procedures for TXP_MR_10EX_C Card, page 11-109

• 11.18 MXP_2.5G_10EX_C card, page 11-109

• 11.18.4 Related Procedures for MXP_2.5G_10EX_C Card, page 11-113

• 11.19 MXP_MR_10DMEX_C Card, page 11-113

• 11.19.4 Related Procedures for MXP_MR_10DMEX_C Card, page 11-119

• 11.20 AR_MXP, AR_XP, and AR_XPE Cards, page 11-119

• 11.21 100G-LC-C,10x10G-LC, and CFP-LC Cards, page 11-144

• 11.22 Related Procedures for 100G-LC-C, 10x10G-LC, and CFP-LC Cards, page 11-163

• 11.23 MLSE UT, page 11-163

• 11.24 SFP, SFP+, XFP, CXP, and CFP Modules, page 11-163
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11.1   Card Overview
Note Cisco ONS 15454 DWDM supports IBM's 5G DDR (Double Data Rate) InfiniBand1 interfaces.

11.1 Card Overview
The card overview section lists the cards described in this chapter and provides compatibility 
information.

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. For a list of slots and symbols, see 
the “Card Slot Requirements” section in the Cisco ONS 15454 Hardware Installation Guide.

The purpose of a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, 
AR_MXP, AR_XP, or AR_XPE card is to convert the “gray” optical client interface signals into trunk 
signals that operate in the “colored” dense wavelength division multiplexing (DWDM) wavelength 
range. Client-facing gray optical signals generally operate at shorter wavelengths, whereas DWDM 
colored optical signals are in the longer wavelength range (for example, 1490 nm = violet; 1510 nm = 
blue; 1530 nm = green; 1550 nm = yellow; 1570 nm = orange; 1590 nm = red; 1610 nm = brown). Some 
of the newer client-facing PPMs, however, operate in the colored region. Transponding or muxponding 
is the process of converting the signals between the client and trunk wavelengths.

An MXP generally handles several client signals. It aggregates, or multiplexes, lower rate client signals 
together and sends them out over a higher rate trunk port. Likewise, it demultiplexes optical signals 
coming in on a trunk and sends them out to individual client ports. A TXP converts a single client signal 
to a single trunk signal and converts a single incoming trunk signal to a single client signal. GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards can be provisioned as TXPs, as MXPs, or as Layer 2 
switches.

All of the TXP and MXP cards perform optical to electrical to optical (OEO) conversion. As a result, 
they are not optically transparent cards. The reason for this is that the cards must operate on the signals 
passing through them, so it is necessary to do an OEO conversion.

On the other hand, the termination mode for all of the TXPs and MXPs, which is done at the electrical 
level, can be configured to be transparent. In this case, neither the Line nor the Section overhead is 
terminated. The cards can also be configured so that either Line or Section overhead can be terminated, 
or both can be terminated.

Note The MXP_2.5G_10G card, by design, when configured in the transparent termination mode, actually 
does terminate some of the bytes. See Table G-19 on page G-36 for details.

11.1.1 Card Summary
Table 11-1 lists and summarizes the functions of each TXP, TXPP, MXP, MXPP, AR_MXP, AR_XP, 
AR_XPE, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, 
and OTU2_XP card.

1. 5G DDR InfiniBand is referred to as IB_5G.
11-3
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html


Chapter 11      Provision Transponder and Muxponder Cards
11.1.1   Card Summary
Table 11-1 Cisco ONS 15454 Transponder and Muxponder Cards

Card Port Description For Additional Information

TXP_MR_10G The TXP_MR_10G card has two sets of ports 
located on the faceplate.

See the “11.3 TXP_MR_10G Card” section on 
page 11-11.

TXP_MR_10E The TXP_MR_10E card has two sets of ports 
located on the faceplate.

See the “11.4 TXP_MR_10E Card” section on 
page 11-14.

TXP_MR_10E_C and 
TXP_MR_10E_L

The TXP_MR_10E_C and TXP_MR_10E_L 
cards have two sets of ports located on the 
faceplate.

See the “11.5 TXP_MR_10E_C and 
TXP_MR_10E_L Cards” section on page 11-16.

TXP_MR_2.5G The TXP_MR_2.5G card has two sets of ports 
located on the faceplate.

See the “11.6 TXP_MR_2.5G and 
TXPP_MR_2.5G Cards” section on page 11-18.

TXPP_MR_2.5G The TXPP_MR_2.5G card has three sets of ports 
located on the faceplate.

See the “11.6 TXP_MR_2.5G and 
TXPP_MR_2.5G Cards” section on page 11-18.

40E-TXP-C, and 
40ME-TXP-C

The 40E-TXP-C and 40ME-TXP-C cards have 
two ports located on the face plate.

See the “11.7 40E-TXP-C and 40ME-TXP-C 
Cards” section on page 11-23.

MXP_2.5G_10G The MXP_2.5G_10G card has nine sets of ports 
located on the faceplate.

See the “11.8 MXP_2.5G_10G Card” section on 
page 11-25.

MXP_2.5G_10E The MXP_2.5G_10E card has nine sets of ports 
located on the faceplate.

See the “11.9 MXP_2.5G_10E Card” section on 
page 11-28.

MXP_2.5G_10E_C and 
MXP_2.5G_10E_L

The MXP_2.5G_10E_C and MXP_2.5G_10E_L 
cards have nine sets of ports located on the 
faceplate.

See the “11.10 MXP_2.5G_10E_C and 
MXP_2.5G_10E_L Cards” section on page 11-32.

MXP_MR_2.5G The MXP_MR_2.5G card has nine sets of ports 
located on the faceplate.

See the “11.11 MXP_MR_2.5G and 
MXPP_MR_2.5G Cards” section on page 11-39.

MXPP_MR_2.5G The MXPP_MR_2.5G card has ten sets of ports 
located on the faceplate.

See the “11.11 MXP_MR_2.5G and 
MXPP_MR_2.5G Cards” section on page 11-39.

MXP_MR_10DME_C 
and 
MXP_MR_10DME_L

The MXP_MR_10DME_C and 
MXP_MR_10DME_L cards have eight sets of 
ports located on the faceplate.

See the “11.12 MXP_MR_10DME_C and 
MXP_MR_10DME_L Cards” section on 
page 11-44.

40G-MXP-C
40E-MXP-C
and
40ME-MXP-C

The 40G-MXP-C, 40E-MXP-C and 
40ME-MXP-C cards have five ports located on 
the faceplate.

See the “11.13 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C Cards” section on page 11-52.

AR_MXP, AR_XP, and
AR_XPE

The AR_MXP, AR_XP, and AR_XPE cards have 
ten ports located on the faceplate.

See the “11.20 AR_MXP, AR_XP, and AR_XPE 
Cards” section on page 11-119.

GE_XP and GE_XPE The GE_XP and GE_XPE cards have twenty 
Gigabit Ethernet client ports and two 10 Gigabit 
Ethernet trunk ports.

See the “11.14 GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Cards” section on page 11-58.

10GE_XP and 
10GE_XPE

The 10GE_XP and 10GE_XPE cards have two 10 
Gigabit Ethernet client ports and two 10 Gigabit 
Ethernet trunk ports.

See the “11.14 GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Cards” section on page 11-58.

100G-LC-C The 100G-LC-C card has one DWDM port and 
one CXP port.

See the “11.21.1 100G-LC-C Card” section on 
page 11-144.
11-4
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02
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XP, TXPP, MXP, MXPP, 

 

 

Table 11-1 Cisco ONS 15454 Transponder and Muxponder Cards (continued)

R9.3 R9.4 R9.6.x

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

11.1.2 Card Compatibility
Table 11-2 lists the platform and Cisco Transport Controller (CTC) software compatibility for each T
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP card.

10x10G-LC The 10x10G-LC card has 10-ports SFP+ based 
(gray, colored, coarse wavelength division 
multiplexing (CWDM), and DWDM optics 
available)) and one 100G CXP based port.

See the“11.21.2 10x10G-LC Card” section on 
page 11-148.

CFP-LC The CFP-LC card has two 100G CFP pluggable 
modules and a cross-bar embedded switch 
module. 

See the “11.21.3 CFP-LC Card” section on 
page 11-154.

ADM-10G The ADM-10G card has 19 sets of ports located 
on the faceplate.

See the “11.15 ADM-10G Card” section on 
page 11-83.

OTU2_XP The OTU2_XP card has four ports located on the 
faceplate.

See the “11.16 OTU2_XP Card” section on 
page 11-97.

TXP_MR_10EX_C The TXP_MR_10EX_C card has two sets of ports 
located on the faceplate.

See the “11.17 TXP_MR_10EX_C Card” section
on page 11-106.

MXP_2.5G_10EX_C The MXP_2.5G_10EX_C card has nine sets of 
ports located on the faceplate.

See the “11.18 MXP_2.5G_10EX_C card” section
on page 11-109.

MXP_MR_10DMEX_C The MXP_MR_10DMEX_C card has eight sets 
of ports located on the faceplate.

See the “11.19 MXP_MR_10DMEX_C Card” 
section on page 11-113.

Card Port Description For Additional Information

Table 11-2 Platform and Software Release Compatibility for Transponder and Muxponder Cards

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1

TXP_MR_10G 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

15454-
DWDM

TXP_MR_10E No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

15454-
DWDM
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54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
DM

15454-
DWDM

15454-
DWDM

15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
DM

15454-
DWDM

15454-
DWDM

15454-
DWDM

54-
DM

15454-
DWDM

15454-
DWDM

15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
DM

15454-
DWDM

15454-
DWDM

15454-
DWDM

Table 11-2 Platform and Software Release Compatibility for Transponder and Muxponder Cards

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1 R9.3 R9.4 R9.6.x
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

78-20702-02

TXP_MR_10E_
C

No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

TXP_MR_10E_
L

No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

154
DW

TXP_MR_2.5G 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

TXPP_MR_2.5G 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

MXP_2.5G_10G 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

154
DW

MXP_2.5G_10E No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

154
DW

MXP_2.5G_10E
_C

No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

MXP_2.5G_10E
_L

No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

154
DW
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15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

Table 11-2 Platform and Software Release Compatibility for Transponder and Muxponder Cards

R9.3 R9.4 R9.6.x
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

MXP_MR_2.5G No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

MXPP_MR_2.5
G

No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

MXP_MR_10D
ME_C

No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

MXP_MR_10D
ME_L

No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
DWDM

15454-
DWDM

GE_XP No No No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

10GE_XP No No No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1
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54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

54-
, 
54-
, 
54-
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

Table 11-2 Platform and Software Release Compatibility for Transponder and Muxponder Cards

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1 R9.3 R9.4 R9.6.x
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

78-20702-02

GE_XPE No No No No No No No No No 1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

10GE_XPE No No No No No No No No No 1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

ADM-10G No No No No No No No 1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

OTU2_XP No No No No No No No No No 1545
4-DW
DM

1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

TXP_MR_10EX
_C

No No No No No No No No No No 1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW

MXP_2.5G_10E
X_C

No No No No No No No No No No 1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

154
M2
154
M6
154
DW
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15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

Table 11-2 Platform and Software Release Compatibility for Transponder and Muxponder Cards

R9.3 R9.4 R9.6.x
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

MXP_MR_10D
MEX_C

No No No No No No No No No No 1545
4-DW
DM

15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

40E-TXP-C No No No No No No No No No No No No 15454-
M2, 
15454-
M6, 
15454-
DWDM

40ME-TXP-C No No No No No No No No No No No No 15454-
M2, 
15454-
M6, 
15454-
DWDM

40G-MXP-C No No No No No No No No No No No 15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

40E-MXP-C No No No No No No No No No No No No 15454-
M2, 
15454-
M6, 
15454-
DWDM

40ME-MXP-C No No No No No No No No No No No No 15454-
M2, 
15454-
M6, 
15454-
DWDM

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1
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C cards cannot be installed in the 
onnector.

 15454 M2 and ONS 15454 M6 

No 15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

No 15454-
M2, 
15454-
M6, 
15454-
DWDM

15454-
M2, 
15454-
M6, 
15454-
DWDM

No No 15454-
M2, 
15454-
M6, 
15454-
DWDM

No No 15454-
M2, 
15454-
M6

No No 15454-
M2, 
15454-
M6

No No 15454-
M6

Table 11-2 Platform and Software Release Compatibility for Transponder and Muxponder Cards

Card Name R4.5 R4.6 R4.7 R5.0 R6.0 R7.0 R7.2 R8.0 R8.5 R9.0 R9.1 R9.2 R9.2.1 R9.3 R9.4 R9.6.x
Cisco O
N

S 15454 D
W

D
M

 Configuration G
uide, Release 9.6.x

78-20702-02

Older versions of the TXP_MR_10E_C, TXP_MR_2.5G, TXPP_MR_2.5G, and MXP_2.5G_10E_
Cisco ONS 15454 M2 and Cisco ONS 15454 M6 shelves because of an incompatible backplane c

The following table describes the version numbers of the cards that are compatible with the ONS
shelves. The version numbers can be viewed from the HW Rev field in the Inventory tab.

AR_MXP No No No No No No No No No No No No No

AR_XP No No No No No No No No No No No No No

AR_XPE No No No No No No No No No No No No No

100G-LC-C No No No No No No No No No No No No No

10x10G-LC No No No No No No No No No No No No No

CFP-LC No No No No No No No No No No No No No
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11.2   Safety Labels
11.2 Safety Labels
For information about safety labels, see the “G.1 Safety Labels” section on page G-1.

11.3 TXP_MR_10G Card
(Cisco ONS 15454 only)

The TXP_MR_10G processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM 
signal (trunk side). It provides one 10-Gbps port per card that can be provisioned for an STM-64/OC-192 
short reach (1310-nm) signal, compliant with ITU-T G.707, ITU-T G.709, ITU-T G.691, and 
Telcordia GR-253-CORE, or a 10GBASE-LR signal compliant with IEEE 802.3. 

The TXP_MR_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz 
range. It is available in 16 different versions, each of which covers two wavelengths, for a total coverage 
of 32 different wavelengths in the 1550-nm range. 

Note ITU-T G.709 specifies a form of forward error correction (FEC) that uses a “wrapper” approach. The 
digital wrapper lets you transparently take in a signal on the client side, wrap a frame around it and 
restore it to its original form. FEC enables longer fiber links because errors caused by the optical signal 
degrading with distance are corrected. 

The trunk port operates at 9.95328 Gbps (or 10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC) 
and at 10.3125 Gbps (or 11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC) over unamplified 
distances up to 80 km (50 miles) with different types of fiber such as C-SMF or dispersion compensated 
fiber limited by loss and/or dispersion.

Caution Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_10G 
card does not display circuits under card view. 

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G card. Using direct 
fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

Table 11-3 Version Number Compatibility for Transponder and Muxponder Cards

Card Version Number

TXP_MR_2.5G Version 06 or later of the different unit part number

TXPP_MR_2.5G Version 06 or later of the different unit part number

MXP_2.5G_10E_C Version 04 or later of the 800-26774 part number

TXP_MR_10E_C Version 04 or later of the 800-26772 part number
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You can install TXP_MR_10G cards in Slots 1 to 6 and 12 to 17 and provision this card in a linear 
configuration. TXP_MR_10G cards cannot be provisioned as a bidirectional line switched ring 
(BLSR)/Multiplex Section - Shared Protection Ring (MS-SPRing), a path protection/single node control 
point (SNCP), or a regenerator. They can only be used in the middle of BLSR/MS-SPRing and 1+1 spans 
when the card is configured for transparent termination mode.

The TXP_MR_10G port features a 1550-nm laser for the trunk port and a 1310-nm laser for the for the 
client port and contains two transmit and receive connector pairs (labeled) on the card faceplate.

The MTU setting is used to display the OverSizePkts counters on the receiving trunk and client port 
interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client port 
to the trunk port and vice versa irrespective of the MTU setting.

The TXP_MR_10G card has the following available wavelengths and versions: 

• ITU grid blue band:

– 1538.19 to 1538.98 nm, 10T-L1-38.1

– 1539.77 to 1540.56 nm, 10T-L1-39.7

– 1530.33 to 1531.12 nm, 10T-L1-30.3

– 1531.90 to 1532.68 nm, 10T-L1-31.9

– 1534.25 to 1535.04 nm, 10T-L1-34.2

– 1535.82 to 1536.61 nm, 10T-L1-35.8

– 1542.14 to 1542.94 nm, 10T-L1-42.1

– 1543.73 to 1544.53 nm, 10T-L1-43.73

• ITU grid red band:

– 1554.13 to 1554.94 nm, 10T-L1-54.1

– 1555.75 to 1556.55 nm, 10T-L1-55.7 

– 1546.12 to 1546.92 nm, 10T-L1-46.1

– 1547.72 to 1548.51 nm, 10T-L1-47.7

– 1550.12 to 1550.92 nm, 10T-L1-50.1

– 1551.72 to 1552.52 nm, 10T-L1-51.7

– 1558.17 to 1558.98 nm, 10T-L1-58.1

– 1559.79 to 1560.61 nm, 10T-L1-59.7

11.3.1 Faceplate and Block Diagram
Figure 11-1 shows the TXP_MR_10G faceplate and block diagram.
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Figure 11-1 TXP_MR_10G Faceplate and Block Diagram

For information about safety labels for the card, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

11.3.2 TXP_MR_10G Functions
The functions of the TXP_MR_10G card are: 

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-7 on page G-11
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11.3.3 Related Procedures for TXP_MR_10G Card
The following is the list of procedures and tasks related to the configuration of the TXP_MR_10G card:

• NTP-G96 Provision the 10G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 11-211

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.4 TXP_MR_10E Card 
(Cisco ONS 15454 only)

The card is fully backward compatible with the TXP_MR_10G card. It processes one 10-Gbps signal 
(client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side) that is tunable over four wavelength 
channels (spaced at 100 GHz on the ITU grid) in the C band and tunable over eight wavelength channels 
(spaced at 50 GHz on the ITU grid) in the L band. There are eight versions of the C-band card, with each 
version covering four wavelengths, for a total coverage of 32 wavelengths. There are five versions of the 
L-band card, with each version covering eight wavelengths, for a total coverage of 40 wavelengths.

You can install TXP_MR_10E cards in Slots 1 to 6 and 12 to 17 and provision the cards in a linear 
configuration, BLSR/MS-SPRing, path protection/SNCP, or a regenerator. The card can be used in the 
middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent termination mode.

The TXP_MR_10E card features a 1550-nm tunable laser (C band) or a 1580-nm tunable laser (L band) 
for the trunk port and a separately orderable ONS-XC-10G-S1 1310-nm or ONS-XC-10G-L2 1550-nm 
laser XFP module for the client port. 

Note When the ONS-XC-10G-L2 XFP is installed, the TXP_MR_10E card must be installed in Slots 6, 7, 12 
or 13)

On its faceplate, the TXP_MR_10E card contains two transmit and receive connector pairs, one for the 
trunk port and one for the client port. Each connector pair is labeled.

11.4.1 Key Features 
The key features of the TXP_MR_10E card are:

• A tri-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately)

– OC-192 (SR1) 

– 10GE (10GBASE-LR)

– 10G-FC (1200-SM-LL-L)

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping

• The MTU setting is used to display the OverSizePkts counters on the receiving trunk and client port 
interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client 
port to the trunk port and vice versa irrespective of the MTU setting.
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11.4.2 Faceplate and Block Diagram
Figure 11-2 shows the TXP_MR_10E faceplate and block diagram.

Figure 11-2 TXP_MR_10E Faceplate and Block Diagram

For information about safety labels for the card, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10E card. Using direct 
fiber loopbacks causes irreparable damage to the TXP_MR_10E card.

11.4.3 TXP_MR_10E Functions
The functions of the TXP_MR_10E card are:

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11

• G.5 Client Interface, page G-16

• G.7 DWDM Trunk Interface, page G-17
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• G.8 FEC, page G-18

• G.9 Client-to-Trunk Mapping, page G-19

11.4.4 Related Procedures for TXP_MR_10E Card
The following is the list of procedures and tasks related to the configuration of the TXP_MR_10E card:

• NTP-G96 Provision the 10G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 11-211

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.5 TXP_MR_10E_C and TXP_MR_10E_L Cards
TXP_MR_10E_L: (Cisco ONS 15454 only)

The TXP_MR_10E_C and TXP_MR_10E_L cards are multirate transponders for the ONS 15454 
platform. The cards are fully backward compatible with the TXP_MR_10G and TXP_MR_10E cards. 
They processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side). 
The TXP_MR_10E_C is tunable over the entire set of C-band wavelength channels (82 channels spaced 
at 50 GHz on the ITU grid). The TXP_MR_10E_L is tunable over the entire set of L-band wavelength 
channels (80 channels spaced at 50 GHz on the ITU grid) and is particularly well suited for use in 
networks that employ DS fiber or SMF-28 single-mode fiber. 

The advantage of these cards over previous versions (TXP_MR_10G and TXP_MR_10E) is that there is 
only one version of each card (one C-band version and one L-band version) instead of several versions 
needed to cover each band.

You can install TXP_MR_10E_C and TXP_MR_10E_L cards in Slots 1 to 6 and 12 to 17 and provision 
the cards in a linear configuration, BLSR/MS-SPRing, path protection/SNCP, or a regenerator. The cards 
can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the cards are configured for 
transparent termination mode.

The TXP_MR_10E_C and TXP_MR_10E_L cards feature a universal transponder 2 (UT2) 1550-nm 
tunable laser (C band) or a UT2 1580-nm tunable laser (L band) for the trunk port and a separately 
orderable ONS-XC-10G-S1 1310-nm or ONS-XC-10G-L2 1550-nm laser XFP module for the client 
port. 

Note When the ONS-XC-10G-L2 XFP is installed, the TXP_MR_10E_C or TXP_MR_10E-L card is required 
to be installed in a high-speed slot (slot 6, 7, 12, or 13)

On its faceplate, the TXP_MR_10E_C and TXP_MR_10E_L cards contain two transmit and receive 
connector pairs, one for the trunk port and one for the client port. Each connector pair is labeled.

11.5.1 Key Features 
The key features of the TXP_MR_10E_C and TXP_MR_10E_L cards are:

• A tri-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately):

– OC-192 (SR1) 
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– 10GE (10GBASE-LR)

– 10G-FC (1200-SM-LL-L)

• A UT2 module tunable through the entire C band (TXP_MR_10E_C card) or L band 
(TXP_MR_10E_L card). The channels are spaced at 50 GHz on the ITU grid.

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping.

• The MTU setting is used to display the OverSizePkts counters on the receiving trunk and client port 
interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client 
port to the trunk port and vice versa irrespective of the MTU setting.

11.5.2 Faceplates and Block Diagram
Figure 11-3 shows the TXP_MR_10E_C and TXP_MR_10E_L faceplates and block diagram.

Figure 11-3 TXP_MR_10E_C and TXP_MR_10E_L Faceplates and Block Diagram

For information about safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.
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Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E_C or 
TXP_MR_10E_L card in a loopback on the trunk port. Do not use direct fiber loopbacks with the cards. 
Using direct fiber loopbacks causes irreparable damage to the cards.

11.5.3 TXP_MR_10E_C and TXP_MR_10E_L Functions
The functions of the TXP_MR_10E_C and TXP_MR_10E_L cards are:

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11.

• G.5 Client Interface, page G-16

• G.7 DWDM Trunk Interface, page G-17

• G.8 FEC, page G-18

• G.9 Client-to-Trunk Mapping, page G-19

11.5.4 Related Procedures for TXP_MR_10E_C and TXP_MR_10E_L Cards
The following is the list of procedures and tasks related to the configuration for both TXP_MR_10E_C 
and TXP_MR_10E_L:

• NTP-G96 Provision the 10G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 11-211

• DLP-G358 Provision TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance Testing, 
page 15-25

• NTP-G75 Monitor Transponder and Muxponder Performance

11.6 TXP_MR_2.5G and TXPP_MR_2.5G Cards
The TXP_MR_2.5G card processes one 8-Mbps to 2.488-Gbps signal (client side) into one 8-Mbps to 
2.5-Gbps, 100-GHz DWDM signal (trunk side). It provides one long-reach STM-16/OC-48 port per 
card, compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE. 

The TXPP_MR_2.5G card processes one 8-Mbps to 2.488-Gbps signal (client side) into two 8-Mbps to 
2.5-Gbps, 100-GHz DWDM signals (trunk side). It provides two long-reach STM-16/OC-48 ports per 
card, compliant with ITU-T G.707, ITU-T G.957, and Telcordia GR-253-CORE.

The TXP_MR_2.5G and TXPP_MR_2.5G cards are tunable over four wavelengths in the 1550-nm, 
ITU 100-GHz range. They are available in eight versions, each of which covers four wavelengths, for a 
total coverage of 32 different wavelengths in the 1550-nm range. 

Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it, and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 
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The trunk/line port operates at up to 2.488 Gbps (or up to 2.66 Gbps with ITU-T G.709 Digital 
Wrapper/FEC) over unamplified distances up to 360 km (223.7 miles) with different types of fiber such 
as C-SMF or higher if dispersion compensation is used. 

Caution Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_2.5G 
or TXPP_MR_2.5G card does not display circuits under card view. 

The TXP_MR_2.5G and TXPP_MR_2.5G cards support 2R (retime, regenerate) and 3R (retime, 
reshape, and regenerate) modes of operation where the client signal is mapped into a ITU-T G.709 frame. 
The mapping function is simply done by placing a digital wrapper around the client signal. Only 
OC-48/STM-16 client signals are fully ITU-T G.709 compliant, and the output bit rate depends on the 
input client signal. Table 11-51 shows the possible combinations of client interfaces, input bit rates, 2R 
and 3R modes, and ITU-T G.709 monitoring.

Note ITU-T G.709 and FEC support is disabled for all the 2R payload types in the TXP_MR_2.5G and 
TXPP_MR_2.5G cards.

The output bit rate is calculated for the trunk bit rate by using the 255/238 ratio as specified in 
ITU-T G.709 for OTU1. Table 11-5 lists the calculated trunk bit rates for the client interfaces with 
ITU-T G.709 enabled.

Table 11-4 2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

Client Interface Input Bit Rate 3R vs. 2R ITU-T G.709

OC-48/STM-16 2.488 Gbps 3R On or Off

DV-6000 2.38 Gbps 2R —

2 Gigabit Fibre Channel (2G-FC)/fiber 
connectivity (FICON)

2.125 Gbps 3R1

1. No monitoring

On or Off

High-Definition Television (HDTV) 1.48 Gbps 2R —

Gigabit Ethernet (GE) 1.25 Gbps 3R On or Off

1 Gigabit Fibre Channel (1G-FC)/FICON 1.06 Gbps 3R On or Off

OC-12/STM-4 622 Mbps 3R On or Off

OC-3/STM-1 155 Mbps 3R On or Off

Enterprise System Connection (ESCON) 200 Mbps 2R —

SDI/D1/DVB-ASI video 270 Mbps 2R —

ISC-1 Compat 1.06 Gbps 2R Off

ISC-3 1.06 or 
2.125 Gbps

2R —

ETR_CLO 16 Mbps 2R —
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For 2R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to pass data 
through transparently from client side interfaces to a trunk side interface, which resides on an ITU grid. 
The data might vary at any bit rate from 200-Mbps up to 2.38-Gbps, including ESCON, DVB-ASI, 
ISC-1, and video signals. In this pass-through mode, no performance monitoring (PM) or digital 
wrapping of the incoming signal is provided, except for the usual PM outputs from the SFPs. Similarly, 
this card has the ability to pass data through transparently from the trunk side interfaces to the client side 
interfaces with bit rates varying from 200-Mbps up to 2.38-Gbps. Again, no PM or digital wrapping of 
received signals is available in this pass-through mode.

For 3R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards apply a digital wrapper to the 
incoming client interface signals (OC-N/STM-N, 1G-FC, 2G-FC, GE). PM is available on all of these 
signals except for 2G-FC, and varies depending upon the type of signal. For client inputs other than 
OC-48/STM-16, a digital wrapper might be applied but the resulting signal is not ITU-T G.709 
compliant. The card applies a digital wrapper that is scaled to the frequency of the input signal.

The TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to take digitally wrapped signals in 
from the trunk interface, remove the digital wrapper, and send the unwrapped data through to the client 
interface. PM of the ITU-T G.709 OH and SONET/SDH OH is implemented.

11.6.1 Faceplates and Block Diagram 
Figure 11-4 shows the TXP_MR_2.5G and TXPP_MR_2.5G faceplates. 

Table 11-5 Trunk Bit Rates With ITU-T G.709 Enabled

Client Interface ITU-T G.709 Disabled ITU-T G.709 Enabled

OC-48/STM-16 2.488 Gbps 2.66 Gbps

2G-FC 2.125 Gbps 2.27 Gbps

GE 1.25 Gbps 1.34 Gbps

1G-FC 1.06 Gbps 1.14 Gbps

OC-12/STM-3 622 Mbps 666.43 Mbps

OC-3/STM-1 155 Mbps 166.07 Mbps
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Figure 11-4 TXP_MR_2.5G and TXPP_MR_2.5G Faceplates

For information about safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Figure 11-5 shows a block diagram of the TXP_MR_2.5G and TXPP_MR_2.5G cards.
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Figure 11-5 TXP_MR_2.5G and TXPP_MR_2.5G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G and 
TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the 
TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to 
the TXP_MR_2.5G and TXPP_MR_2.5G cards.

You can install TXP_MR_2.5G and TXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. You can 
provision this card in a linear configuration. TXP_MR_10G and TXPP_MR_2.5G cards cannot be 
provisioned as a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the 
middle of BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination 
mode.

The TXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm laser for the 
client port. It contains two transmit and receive connector pairs (labeled) on the card faceplate. The card 
uses dual LC connectors for optical cable termination. 

The TXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm 
laser (depending on the SFP) for the client port and contains three transmit and receive connector pairs 
(labeled) on the card faceplate. The card uses dual LC connectors for optical cable termination.

11.6.2 TXP_MR_2.5G and TXPP_MR_2.5G Functions
The functions of the TXP_MR_2.5G and TXPP_MR_2.5G cards are:

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11 (for TXP_MR_2.5G)

• Port level indicators—Table G-8 on page G-11 (for TXPP_MR_2.5G)
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11.6.3 Related Procedures for TXP_MR_2.5G and TXPP_MR_2.5G Cards
The following is the list of procedures and tasks related to the configuration for both TXP_MR_2.5G 
and TXPP_MR_2.5G:

• NTP-G98 Provision the 2.5G Multirate Transponder Card Line Settings and PM Parameter 
Thresholds, page 11-191

• NTP-G33 Create a Y-Cable Protection Group, page 11-182 (TXP_MR_2.5G only)

• NTP-G75 Monitor Transponder and Muxponder Performance

11.7 40E-TXP-C and 40ME-TXP-C Cards
The 40E-TXP-C and 40ME-TXP-C cards process a single 40-Gbps signal (client side) into a single 
40-Gbps, 50-GHz DWDM signal (trunk side). It provides one 40-Gbps port per card that can be 
provisioned for an OC-768/STM-256 very short reach (1550-nm) signal compliant with ITU-T G.707, 
ITU-T G.691, and Telcordia GR-253-CORE, 40G Ethernet LAN signal compliant with IEEE 802.3ba, 
or OTU3 signal compliant with ITU-T G.709.

The trunk port of the 40E-TXP-C and 40ME-TXP-C cards are tunable between 1529.55 nm through 
1561.83 nm, ITU 50-GHz range.

ITU-T G.709 specifies a form of forward error correction (FEC) that uses a “wrapper” approach. The 
digital wrapper lets you transparently take in a signal on the client side, wrap a frame around it and 
restore it to its original form. FEC enables longer fiber links because errors caused by the optical signal 
degrading with distance are corrected.

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the 40E-TXP-C, and 
40ME-TXP-C cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the 
40E-TXP-C, and 40ME-TXP-C cards. Using direct fiber loopbacks causes irreparable damage to the 
these cards.

You can install and provision the 40E-TXP-C, and 40ME-TXP-C cards in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in ONS 15454 DWDM chassis

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis

When a protection switch occurs on the 40E-TXP-C, and 40ME-TXP-C cards, the recovery from 
PSM protection switch takes about 3 to 4 minutes.

Note The maximum ambient operating temperature for 40E-TXP-C, and 40ME-TXP-C cards is 500 Celsius.

11.7.1 Faceplates and Block Diagram 
Figure 11-6 shows the 40E-TXP-C and 40ME-TXP-C faceplate and block diagram.
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Figure 11-6 40E-TXP-C and 40ME-TXP-C Faceplate and Block Diagram

For information about safety labels for the card, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

11.7.2 40E-TXP-C and 40ME-TXP-C Functions
The functions of the 40E-TXP-C and 40ME-TXP-C cards are:

• G.2 Automatic Laser Shutdown, page G-7 (supported on a client interface)

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11.
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11.7.3 Related Procedures for 40E-TXP-C and 40ME-TXP-C Cards
The following is the list of procedures and tasks related to the configuration of 40E-TXP-C and 
40ME-TXP-C:

• NTP-G292 Provision the 40G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 11-237

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.8 MXP_2.5G_10G Card
(Cisco ONS 15454 only)

The MXP_2.5G_10G card multiplexes/demultiplexes four 2.5-Gbps signals (client side) into one 
10-Gbps, 100-GHz DWDM signal (trunk side). It provides one extended long-range STM-64/OC-192 
port per card on the trunk side (compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia 
GR-253-CORE) and four intermediate- or short-range OC-48/STM-16 ports per card on the client side. 
The port operates at 9.95328 Gbps over unamplified distances up to 80 km (50 miles) with different types 
of fiber such as C-SMF or dispersion compensated fiber limited by loss and/or dispersion. 

Client ports on the MXP_2.5G_10G card are also interoperable with SONET OC-1 (STS-1) fiber optic 
signals defined in Telcordia GR-253-CORE. An OC-1 signal is the equivalent of one DS-3 channel 
transmitted across optical fiber. OC-1 is primarily used for trunk interfaces to phone switches in the 
United States. There is no SDH equivalent for SONET OC-1.

The MXP_2.5G_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz 
range. It is available in 16 different versions, each of which covers two wavelengths, for a total coverage 
of 32 different wavelengths in the 1550-nm range. 

Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The port can also operate at 10.70923 Gbps in ITU-T G.709 Digital Wrapper/FEC mode. 

Caution Because the transponder has no capability to look into the payload and detect circuits, an 
MXP_2.5G_10G card does not display circuits under card view. 

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10G card. Using 
direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10G card.

You can install MXP_2.5G_10G cards in Slots 1 to 6 and 12 to 17. 
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Caution Do not install an MXP_2.5G_10G card in Slot 3 if you have installed a DS3/EC1-48 card in Slots 1or 2. 
Likewise, do not install an MXP_2.5G_10G card in Slot 17 if you have installed a DS3/EC1-48 card in 
Slots 15 or 16. If you do, the cards will interact and cause DS-3 bit errors.

You can provision this card in a linear configuration. MXP_2.5G_10G cards cannot be provisioned as a 
BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. They can be used in the middle of 
BLSR/MS-SPRing or 1+1 spans only when the card is configured for transparent termination mode.

The MXP_2.5G_10G port features a 1550-nm laser on the trunk port and four 1310-nm lasers on the 
client ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The 
card uses a dual LC connector on the trunk side and SFP connectors on the client side for optical cable 
termination.

Note When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A 
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision 
a 4xOC-48 OCHCC circuit.

11.8.1 Faceplates and Block Diagram
Figure 11-7 shows the MXP_2.5G_10G faceplate.
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Figure 11-7 MXP_2.5G_10G Faceplate 

For information about safety labels for the card, see the “G.1.1 Class 1 Laser Product Cards” section on 
page G-2.

Figure 11-8 shows a block diagram of the MXP_2.5G_10G card.
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Figure 11-8 MXP_2.5G_10G Card Block Diagram

11.8.2 MXP_2.5G_10G Functions
The functions of the MXP_2.5G_10G card are:

• G.10 Timing Synchronization, page G-19

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8

• Port level indicators— Table G-7 on page G-11

11.8.3 Related Procedures for MXP_2.5G_10G Card
The following is the list of procedures and tasks related to the configuration of MXP_2.5G_10G:

• NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-282

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.9 MXP_2.5G_10E Card 
The faceplate designation of the card is “4x2.5G 10E MXP.” The MXP_2.5G_10E card is a DWDM 
muxponder for the ONS 15454 platform that supports full transparent termination the client side. The 
card multiplexes four 2.5 Gbps client signals (4 x OC48/STM-16 SFP) into a single 10-Gbps DWDM 
optical signal on the trunk side. The MXP_2.5G_10E provides wavelength transmission service for the 
four incoming 2.5 Gbps client interfaces. The MXP_2.5G_10E muxponder passes all SONET/SDH 
overhead bytes transparently. 
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The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up generic communications channels (GCCs) for data communications, enable FEC, or 
facilitate performance monitoring.

The MXP_2.5G_10E works with optical transport network (OTN) devices defined in ITU-T G.709. The 
card supports ODU1 to OTU2 multiplexing, an industry standard method for asynchronously mapping 
a SONET/SDH payload into a digitally wrapped envelope. See the “G.11 Multiplexing Function” 
section on page G-21.

The MXP_2.5G_10E card is not compatible with the MXP_2.5G_10G card, which does not support full 
transparent termination. You can install MXP_2.5G_10E cards in Slots 1 to 6 and 12 to 17. You can 
provision this card in a linear configuration, as a BLSR/MS-SPRing, a path protection/SNCP, or a 
regenerator. The card can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is 
configured for transparent termination mode.

The MXP_2.5G_10E features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client 
ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card uses 
a dual LC connector on the trunk side and uses SFP modules on the client side for optical cable 
termination. The SFP pluggable modules are short reach (SR) or intermediate reach (IR) and support an 
LC fiber connector.

Note When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A 
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision 
a 4xOC-48 OCHCC circuit.

11.9.1 Key Features
The MXP_2.5G_10E card has the following high level features:

• Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals 
are mapped into a ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard Reed-Solomon (RS, specified in 
ITU-T G.709) and E-FEC, which allows an improved gain on trunk interfaces with a resultant 
extension of the transmission range on these interfaces. The E-FEC functionality increases the 
correction capability of the transponder to improve performance, allowing operation at a lower 
OSNR compared to the standard RS (237,255) correction algorithm. A new block code (BCH) 
algorithm implemented in E-FEC allows recovery of an input BER up to 1E-3.

• Pluggable client interface optic modules: The MXP_2.5G_10E card has modular interfaces. Two 
types of optics modules can be plugged into the card. These include an OC-48/STM 16 SR-1 
interface with a 7-km (4.3-mile) nominal range (for short range and intra-office applications) and an 
IR-1 interface with a range up to 40 km (24.9 miles). SR-1 is defined in Telcordia GR-253-CORE 
and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in S-16-1 
(ITU-T G.957).

• High level provisioning support: The MXP_2.5G_10E card is initially provisioned using 
Cisco TransportPlanner software. Subsequently, the card can be monitored and provisioned using 
CTC software.

• Link monitoring and management: The MXP_2.5G_10E card uses standard OC-48 OH (overhead) 
bytes to monitor and manage incoming interfaces. The card passes the incoming SDH/SONET data 
stream and its overhead bytes transparently. 
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• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate 
regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It 
can help reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_2.5G_10E normally synchronizes from the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card. If for some reason, such as maintenance or 
upgrade activity, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE is not available, the 
MXP_2.5G_10E automatically synchronizes to one of the input client interface clocks.

• Configurable squelching policy: The card can be configured to squelch the client interface output if 
there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the 
card manages multiplex section alarm indication signal (MS-AIS) insertion.

11.9.2 Faceplates and Block Diagram
Figure 11-9 shows the MXP_2.5G_10E faceplate.

Figure 11-9 MXP_2.5G_10E Faceplate

For information about safety labels for the card, see the “G.1.1 Class 1 Laser Product Cards” section on 
page G-2.
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Figure 11-10 shows a block diagram of the MXP_2.5G_10E card.

Figure 11-10 MXP_2.5G_10E Block Diagram

11.9.3 MXP_2.5G_10E Functions
The functions of the MXP_2.5G_10E card are:

• G.5 Client Interface, page G-16

• G.6 DWDM Interface, page G-16

• G.11 Multiplexing Function, page G-21

• G.10 Timing Synchronization, page G-19

• G.8 FEC, page G-18

• G.12 SONET/SDH Overhead Byte Processing, page G-21

• G.12 SONET/SDH Overhead Byte Processing, page G-21

• G.13 Client Interface Monitoring, page G-21

• G.2 Automatic Laser Shutdown, page G-7

• G.14 Jitter, page G-22

• G.15 Lamp Test, page G-22

• G.16 Onboard Traffic Generation, page G-23

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11. 
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11.9.3.1 Wavelength Identification

The card uses trunk lasers that are wave-locked, which allows the trunk transmitter to operate on the ITU 
grid effectively. Table 11-6 describes the required trunk transmit laser wavelengths. The laser is tunable 
over eight wavelengths at 50-GHz spacing or four at 100-GHz spacing.

11.9.4 Related Procedures for MXP_2.5G_10E Card
The following is the list of procedures and tasks related to the configuration of MXP_2.5G_10E Card:

• NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-282

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.10 MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards 
MXP_2.5G_10E_L: (Cisco ONS 15454 only)

The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are DWDM muxponders for the ONS 15454 
platform that support transparent termination mode on the client side. The faceplate designation of the 
cards is “4x2.5G 10E MXP C” for the MXP_2.5G_10E_C card and “4x2.5G 10E MXP L” for the 
MXP_2.5G_10E_L card. The cards multiplex four 2.5-Gbps client signals (4 x OC48/STM-16 SFP) into 

Table 11-6 MXP_2.5G_10E Trunk Wavelengths

Band
Wavelength 
(nm) Band

Wavelength 
(nm)

30.3 1530.33 46.1 1546.12

30.3 1531.12 46.1 1546.92

30.3 1531.90 46.1 1547.72

30.3 1532.68 46.1 1548.51

34.2 1534.25 50.1 1550.12

34.2 1535.04 50.1 1550.92

34.2 1535.82 50.1 1551.72

34.2 1536.61 50.1 1552.52

38.1 1538.19 54.1 1554.13

38.1 1538.98 54.1 1554.94

38.1 1539.77 54.1 1555.75

38.1 1540.56 54.1 1556.55

42.1 1542.14 58.1 1558.17

42.1 1542.94 58.1 1558.98

42.1 1543.73 58.1 1559.79

42.1 1544.53 58.1 1560.61
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a single 10-Gbps DWDM optical signal on the trunk side. The MXP_2.5G_10E_C and 
MXP_2.5G_10E_L cards provide wavelength transmission service for the four incoming 2.5 Gbps client 
interfaces. The MXP_2.5G_10E_C and MXP_2.5G_10E_L muxponders pass all SONET/SDH overhead 
bytes transparently. 

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate PM.

The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards work with OTN devices defined in ITU-T G.709. 
The cards support ODU1 to OTU2 multiplexing, an industry standard method for asynchronously 
mapping a SONET/SDH payload into a digitally wrapped envelope. See the “G.11 Multiplexing 
Function” section on page G-21.

The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are not compatible with the MXP_2.5G_10G 
card, which does not support transparent termination mode. 

You can install MXP_2.5G_10E_C and MXP_2.5G_10E_L cards in Slots 1 to 6 and 12 to 17. You can 
provision a card in a linear configuration, as a BLSR/MS-SPRing, a path protection/SNCP, or a 
regenerator. The cards can be used in the middle of BLSR/MS-SPRing or 1+1 spans when the cards are 
configured for transparent termination mode.

The MXP_2.5G_10E_C card features a tunable 1550-nm C-band laser on the trunk port. The laser is 
tunable across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. The 
MXP_2.5G_10E_L features a tunable 1580-nm L-band laser on the trunk port. The laser is tunable 
across 80 wavelengths on the ITU grid, also with 50-GHz spacing. Each card features four 1310-nm 
lasers on the client ports and contains five transmit and receive connector pairs (labeled) on the card 
faceplate. The cards uses dual LC connectors on the trunk side and use SFP modules on the client side 
for optical cable termination. The SFP pluggable modules are SR or IR and support an LC fiber 
connector.

Note When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A 
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is necessary to provision 
a 4xOC-48 OCHCC circuit.

11.10.1 Key Features
The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards have the following high level features:

• Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals 
are mapped into a ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and 
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the 
transmission range on these interfaces. The E-FEC functionality increases the correction capability 
of the transponder to improve performance, allowing operation at a lower OSNR compared to the 
standard RS (237,255) correction algorithm. A new BCH algorithm implemented in E-FEC allows 
recovery of an input BER up to 1E-3.

• Pluggable client interface optic modules: The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards 
have modular interfaces. Two types of optics modules can be plugged into the card. These include 
an OC-48/STM 16 SR-1 interface with a 7-km (4.3-mile) nominal range (for short range and 
intra-office applications) and an IR-1 interface with a range up to 40 km (24.9 miles). SR-1 is 
defined in Telcordia GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia 
GR-253-CORE and in S-16-1 (ITU-T G.957).
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• High level provisioning support: The cards are initially provisioned using Cisco TransportPlanner 
software. Subsequently, the card can be monitored and provisioned using CTC software.

• Link monitoring and management: The cards use standard OC-48 OH (overhead) bytes to monitor 
and manage incoming interfaces. The cards pass the incoming SDH/SONET data stream and its 
overhead bytes transparently. 

• Control of layered SONET/SDH transport overhead: The cards are provisionable to terminate 
regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It 
can help reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_2.5G_10E_C and MXP_2.5G_10E_L cards 
normally synchronize from the TCC2/TCC2P/TCC3 card. If for some reason, such as maintenance 
or upgrade activity, the TCC2/TCC2P/TCC3 is not available, the cards automatically synchronize 
to one of the input client interface clocks.

• Configurable squelching policy: The cards can be configured to squelch the client interface output 
if there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the 
card manages MS-AIS insertion.

• The cards are tunable across the full C band (MXP_2.5G_10E_C) or full L band 
(MXP_2.5G_10E_L), thus eliminating the need to use different versions of each card to provide 
tunability across specific wavelengths in a band.

11.10.2 Faceplates and Block Diagram
Figure 11-11 shows the MXP_2.5G_10E_C and MXP_2.5G_10E_L faceplates and block diagram. 
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Figure 11-11 MXP_2.5G_10E _C and MXP_2.5G_10E_L Faceplates and Block Diagram

For information about safety labels for the cards, see the “G.1.1 Class 1 Laser Product Cards” section 
on page G-2.

11.10.3 MXP_2.5G_10E_C and MXP_2.5G_10E_L Functions
The functions of the MXP_2.5G_10E_C and MXP_2.5G_10E_L cards are:

• G.5 Client Interface, page G-16

• G.6 DWDM Interface, page G-16

• G.11 Multiplexing Function, page G-21

• G.10 Timing Synchronization, page G-19

• G.8 FEC, page G-18

• G.12 SONET/SDH Overhead Byte Processing, page G-21

• G.12 SONET/SDH Overhead Byte Processing, page G-21

• G.13 Client Interface Monitoring, page G-21

• G.2 Automatic Laser Shutdown, page G-7
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• G.14 Jitter, page G-22

• G.15 Lamp Test, page G-22

• G.16 Onboard Traffic Generation, page G-23

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11.

11.10.3.1 Wavelength Identification

The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU 
grid effectively. Both the MXP_2.5G_10E_C and MXP_2.5G_10E_L cards implement the UT2 module. 
The MXP_2.5G_10E_C card uses a C-band version of the UT2 and the MXP_2.5G_10E_L card uses an 
L-band version. 

Table 11-7 describes the required trunk transmit laser wavelengths for the MXP_2.5G_10E_C card. The 
laser is tunable over 82 wavelengths in the C band at 50-GHz spacing on the ITU grid.

Table 11-7 MXP_2.5G_10E_C Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537
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Table 11-8 describes the required trunk transmit laser wavelengths for the MXP_2.5G_10E_L card. The 
laser is fully tunable over 80 wavelengths in the L band at 50-GHz spacing on the ITU grid.

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 11-7 MXP_2.5G_10E_C Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Table 11-8 MXP_2.5G_10E_L Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 190.85 1570.83 41 188.85 1587.46

2 190.8 1571.24 42 188.8 1587.88

3 190.75 1571.65 43 188.75 1588.30

4 190.7 1572.06 44 188.7 1588.73

5 190.65 1572.48 45 188.65 1589.15

6 190.6 1572.89 46 188.6 1589.57

7 190.55 1573.30 47 188.55 1589.99

8 190.5 1573.71 48 188.5 1590.41

9 190.45 1574.13 49 188.45 1590.83

10 190.4 1574.54 50 188.4 1591.26

11 190.35 1574.95 51 188.35 1591.68
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11.10.4 Related Procedures for MXP_2.5G_10E_C and MXP_2.5G_10E_L Cards
The following is the list of procedures and tasks related to the configuration of MXP_2.5G_10E_C and 
MXP_2.5G_10E_L cards:

• NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-282

12 190.3 1575.37 52 188.3 1592.10

13 190.25 1575.78 53 188.25 1592.52

14 190.2 1576.20 54 188.2 1592.95

15 190.15 1576.61 55 188.15 1593.37

16 190.1 1577.03 56 188.1 1593.79

17 190.05 1577.44 57 188.05 1594.22

18 190 1577.86 58 188 1594.64

19 189.95 1578.27 59 187.95 1595.06

20 189.9 1578.69 60 187.9 1595.49

21 189.85 1579.10 61 187.85 1595.91

22 189.8 1579.52 62 187.8 1596.34

23 189.75 1579.93 63 187.75 1596.76

24 189.7 1580.35 64 187.7 1597.19

25 189.65 1580.77 65 187.65 1597.62

26 189.6 1581.18 66 187.6 1598.04

27 189.55 1581.60 67 187.55 1598.47

28 189.5 1582.02 68 187.5 1598.89

29 189.45 1582.44 69 187.45 1599.32

30 189.4 1582.85 70 187.4 1599.75

31 189.35 1583.27 71 187.35 1600.17

32 189.3 1583.69 72 187.3 1600.60

33 189.25 1584.11 73 187.25 1601.03

34 189.2 1584.53 74 187.2 1601.46

35 189.15 1584.95 75 187.15 1601.88

36 189.1 1585.36 76 187.1 1602.31

37 189.05 1585.78 77 187.05 1602.74

38 189 1586.20 78 187 1603.17

39 188.95 1586.62 79 186.95 1603.60

40 188.9 1587.04 80 186.9 1604.03

Table 11-8 MXP_2.5G_10E_L Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.11 MXP_MR_2.5G and MXPP_MR_2.5G Cards
The MXP_MR_2.5G card aggregates a mix and match of client Storage Area Network (SAN) service 
client inputs (GE, FICON, Fibre Channel, and ESCON) into one 2.5 Gbps STM-16/OC-48 DWDM 
signal on the trunk side. It provides one long-reach STM-16/OC-48 port per card and is compliant with 
Telcordia GR-253-CORE.

Note In Software Release 7.0 and later, two additional operating modes have been made available to the user: 
pure ESCON (all 8 ports running ESCON), and mixed mode (Port 1 running FC/GE/FICON, and Ports 
5 through 8 running ESCON). When the card is part of a system running Software Release 6.0 or below, 
only one operating mode, (FC/GE) is available for use.

The 2.5-Gbps Multirate Muxponder–Protected–100 GHz–Tunable 15xx.xx-15yy.yy (MXPP_MR_2.5G) 
card aggregates various client SAN service client inputs (GE, FICON, Fibre Channel, and ESCON) into 
one 2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides two long-reach 
STM-16/OC-48 ports per card and is compliant with ITU-T G.957 and Telcordia GR-253-CORE.

Because the cards are tunable to one of four adjacent grid channels on a 100-GHz spacing, each card is 
available in eight versions, with 15xx.xx representing the first wavelength and 15yy.yy representing the 
last wavelength of the four available on the card. In total, 32 DWDM wavelengths are covered in 
accordance with the ITU-T 100-GHz grid standard, G.692, and Telcordia GR-2918-CORE, Issue 2. The 
card versions along with their corresponding wavelengths are shown in Table 11-9.

The muxponders are intended to be used in applications with long DWDM metro or regional 
unregenerated spans. Long transmission distances are achieved through the use of flat gain optical 
amplifiers. 

The client interface supports the following payload types: 

• 2G FC

• 1G FC

• 2G FICON

Table 11-9 Card Versions

Card Version Frequency Channels at 100 GHz (0.8 nm) Spacing

1530.33–1532.68 1530.33 nm 1531.12 nm 1531.90 nm  1532.68 nm

1534.25–1536.61 1534.25 nm  1535.04 nm  1535.82 nm  1536.61 nm

1538.19–1540.56 1538.19 nm 1538.98 nm 1539.77 nm 1540.56 nm

1542.14–1544.53 1542.14 nm 1542.94 nm 1543.73 nm 1544.53 nm

1546.12–1548.51 1546.12 nm 1546.92 nm 1547.72 nm 1548.51 nm

1550.12–1552.52 1550.12 nm 1550.92 nm 1551.72 nm 1552.52 nm

1554.13–1556.55 1554.13 nm  1554.94 nm 1555.75 nm  1556.55 nm

1558.17–1560.61 1558.17 nm 1558.98 nm 1559.79 nm 1560.61 nm
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• 1G FICON

• GE

• ESCON

Note Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up to 
a maximum limit of 2.5 Gbps. 

Table 11-10 shows the input data rate for each client interface, and the encapsulation method. The 
current version of the ITU-T Transparent Generic Framing Procedure (GFP-T) G.7041 supports 
transparent mapping of 8B/10B block-coded protocols, including Gigabit Ethernet, Fibre Channel, and 
FICON.

In addition to the GFP mapping, 1-Gbps traffic on Port 1 or 2 of the high-speed serializer/deserializer 
(SERDES) is mapped to an STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 
of the SERDES, the Port 1 signal is mapped into the first STS-24c channel and the Port 2 signal into the 
second STS-24c channel. The two channels are then mapped into an OC-48 trunk channel.

Table 11-11 shows some of the mix and match possibilities on the various client ports. The table is 
intended to show the full client payload configurations for the card.

Table 11-10 MXP_MR_2.5G and MXPP_MR_2.5G Client Interface Data Rates and Encapsulation

Client Interface Input Data Rate ITU-T GFP-T G.7041 Encapsulation

2G FC 2.125 Gbps Yes

1G FC 1.06 Gbps Yes

2G FICON 2.125 Gbps Yes

1G FICON 1.06 Gbps Yes

GE 1.25 Gbps Yes

ESCON 0.2 Gbps Yes

Table 11-11 Client Data Rates and Ports 

Mode Port(s) Aggregate Data Rate

2G FC 1 2.125 Gbps

1G FC 1, 2 2.125 Gbps

2G FICON 1 2.125 Gbps

1G FICON 1, 2 2.125 Gbps

GE 1, 2 2.5 Gbps

1G FC
ESCON
(mixed mode)

1
5, 6, 7, 8

1.06 Gbps
0.8 Gbps

1.86 Gbps total

1G FICON
ESCON
(mixed mode)

1
5, 6, 7, 8

1.06 Gbps
0.8 Gbps

1.86 Gbps total
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11.11.1 Faceplates and Block Diagram
Figure 11-12 shows the MXP_MR_2.5G and MXPP_MR_2.5G faceplates.

GE
ESCON
(mixed mode)

1
5, 6, 7, 8

1.25 Gbps
0.8 Gbps

Total 2.05 Gbps

ESCON 1, 2, 3, 4, 5, 6, 7, 8 1.6 Gbps

Table 11-11 Client Data Rates and Ports  (continued)

Mode Port(s) Aggregate Data Rate
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Figure 11-12 MXP_MR_2.5G and MXPP_MR_2.5G Faceplates

For information about safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Figure 11-13 shows a block diagram of the MXP_MR_2.5G card. The card has eight SFP client 
interfaces. Ports 1 and 2 can be used for GE, FC, FICON, or ESCON. Ports 3 through 8 are used for 
ESCON client interfaces. There are two SERDES blocks dedicated to the high-speed interfaces (GE, FC, 
FICON, and ESCON) and two SERDES blocks for the ESCON interfaces. A FPGA is provided to 
support different configurations for different modes of operation. This FPGA has a Universal Test and 
Operations Physical Interface for ATM (UTOPIA) interface. A transceiver add/drop multiplexer 
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(TADM) chip supports framing. Finally, the output signal is serialized and connected to the trunk front 
end with a direct modulation laser. The trunk receive signal is converted into an electrical signal with an 
avalanche photodiode (APD), is deserialized, and is then sent to the TADM framer and FPGA. 

The MXPP_MR_2.5G is the same, except a 50/50 splitter divides the power at the trunk interface. In the 
receive direction, there are two APDs, two SERDES blocks, and two TADM framers. This is necessary 
to monitor both the working and protect paths. A switch selects one of the two paths to connect to the 
client interface.

Figure 11-13 MXP_MR_2.5G and MXPP_MR_2.5G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G and 
MXPP_MR_2.5G cards in a loopback configuration on the trunk port. Do not use direct fiber loopbacks 
with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable 
damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

11.11.2 MXP_MR_2.5G and MXPP_MR_2.5G Functions
The functions of the MXP_MR_2.5G and MXPP_MR_2.5G cards are:

• G.17 Performance Monitoring, page G-23

• G.18 Distance Extension, page G-23

• G.19 Slot Compatibility, page G-23

• G.20 Interoperability with Cisco MDS Switches, page G-23

• G.21 Client and Trunk Ports, page G-23

• G.2 Automatic Laser Shutdown, page G-7
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• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-10 on page G-12

11.11.3 Related Procedures for MXP_MR_2.5G and MXPP_MR_2.5G Cards
The following is the list of procedures and tasks related to the configuration of MXP_MR_2.5G and 
MXPP_MR_2.5G cards:

• NTP-G99 Modify the 2.5G Data Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-303

• NTP-G33 Create a Y-Cable Protection Group, page 11-182 (MXP_MR_2.5G only)

• NTP-G75 Monitor Transponder and Muxponder Performance

11.12 MXP_MR_10DME_C and MXP_MR_10DME_L Cards 
MXP_MR_10DME_L: (Cisco ONS 15454 only)

The MXP_MR_10DME_C and MXP_MR_10DME_L cards aggregate a mix of client SAN service client 
inputs (GE, FICON, and Fibre Channel) into one 10.0 Gbps STM-64/OC-192 DWDM signal on the trunk 
side. It provides one long-reach STM-64/OC-192 port per card and is compliant with Telcordia 
GR-253-CORE and ITU-T G.957.

The cards support aggregation of the following signal types:

• 1-Gigabit Fibre Channel

• 2-Gigabit Fibre Channel

• 4-Gigabit Fibre Channel

• 1-Gigabit Ethernet

• 1-Gigabit ISC-Compatible (ISC-1)

• 2-Gigabit ISC-Peer (ISC-3)

Note On the card faceplates, the MXP_MR_10DME_C and MXP_MR_10DME_L cards are displayed as 
10DME_C and 10DME_L, respectively.

Caution The card can be damaged by dropping it. Handle it safely.

The MXP_MR_10DME_C and MXP_MR_10DME_L muxponders pass all SONET/SDH overhead 
bytes transparently. 

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate PM. The MXP_MR_10DME_C 
and MXP_MR_10DME_L cards work with the OTN devices defined in ITU-T G.709. The cards support 
ODU1 to OTU2 multiplexing, an industry standard method for asynchronously mapping a SONET/SDH 
payload into a digitally wrapped envelope. See the “G.11 Multiplexing Function” section on page G-21.
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Note Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up to 
a maximum limit of 10 Gbps.

You can install MXP_MR_10DME_C and MXP_MR_10DME_L cards in Slots 1 to 6 and 12 to 17. 

Note The MXP_MR_10DME_C and MXP_MR_10DME_L cards are not compatible with the 
MXP_2.5G_10G card, which does not support transparent termination mode.

The MXP_MR_10DME_C card features a tunable 1550-nm C-band laser on the trunk port. The laser is 
tunable across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. The 
MXP_MR_10DME_L features a tunable 1580-nm L-band laser on the trunk port. The laser is tunable 
across 80 wavelengths on the ITU grid, also with 50-GHz spacing. Each card features four 1310-nm 
lasers on the client ports and contains five transmit and receive connector pairs (labeled) on the card 
faceplate. The cards uses dual LC connectors on the trunk side and use SFP modules on the client side 
for optical cable termination. The SFP pluggable modules are SR or IR and support an LC fiber 
connector.

Table 11-12 shows the input data rate for each client interface, and the encapsulation method. The 
current version of the GFP-T G.7041 supports transparent mapping of 8B/10B block-coded protocols, 
including Gigabit Ethernet, Fibre Channel, ISC, and FICON.

In addition to the GFP mapping, 1-Gbps traffic on Port 1 or 2 of the high-speed SERDES is mapped to 
an STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 of the high-speed 
SERDES, the Port 1 signal is mapped into the first STS-24c channel and the Port 2 signal into the second 
STS-24c channel. The two channels are then mapped into an OC-48 trunk channel.

There are two FPGAs on each MXP_MR_10DME_C and MXP_MR_10DME_L, and a group of four 
ports is mapped to each FPGA. Group 1 consists of Ports 1 through 4, and Group 2 consists of Ports 5 
through 8. Table 11-13 shows some of the mix and match possibilities on the various client data rates for 
Ports 1 through 4, and Ports 5 through 8. An X indicates that the data rate is supported in that port.

Table 11-12 MXP_MR_10DME_C and MXP_MR_10DME_L Client Interface Data Rates and 

Encapsulation

Client Interface Input Data Rate GFP-T G.7041 Encapsulation

2G FC 2.125 Gbps Yes

1G FC 1.06 Gbps Yes

2G FICON/2G ISC-Compatible (ISC-1)/ 
2G ISC-Peer (ISC-3)

2.125 Gbps Yes

1G FICON/1G ISC-Compatible (ISC-1)/ 
1G ISC-Peer (ISC-3)

1.06 Gbps Yes

Gigabit Ethernet 1.25 Gbps Yes

Table 11-13 Supported Client Data Rates for Ports 1 through 4 and Ports 5 through 8

Port (Group 1) Port (Group 2) Gigabit Ethernet 1G FC 2G FC 4G FC

1 5 X X X X

2 6 X X — —
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GFP-T PM is available through RMON and trunk PM is managed according to Telcordia GR-253-CORE 
and ITU G.783/826. Client PM is achieved through RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a port 
indicates the number of frames that can be sent to it (its buffer credit), before the sender is required to 
stop transmitting and wait for the receipt of a “ready” indication The MXP_MR_10DME_C and 
MXP_MR_10DME_L cards support FC credit-based flow control with a buffer-to-buffer credit 
extension of up to 1600 km (994.1 miles) for 1G FC, up to 800 km (497.1 miles) for 2G FC, or up to 
400 km (248.5 miles) for 4G FC. The feature can be enabled or disabled. 

The MXP_MR_10DME_C and MXP_MR_10DME_L cards feature a 1550-nm laser for the trunk/line 
port and a 1310-nm or 850-nm laser (depending on the SFP) for the client ports. The cards contains eight 
12.5 degree downward tilt SFP modules for the client interfaces. For optical termination, each SFP uses 
two LC connectors, which are labeled TX and RX on the faceplate. The trunk port is a dual-LC connector 
with a 45 degree downward angle.

The throughput of the MXP_MR_10DME_C and MXP_MR_10DME_L cards is affected by the 
following parameters:

• Distance extension—If distance extension is enabled on the card, it provides more throughput but 
more latency. If distance extension is disabled on the card, the buffer to buffer credits on the storage 
switch affects the throughput; higher the buffer to buffer credits higher is the throughput.

Note For each link to operate at the maximum throughput, it requires a minimum number of buffer 
credits to be available on the devices which the link connects to. The number of buffer 
credits required is a function of the distance between the storage switch extension ports and 
the link bandwidth, that is, 1G, 2G, or 4G. These buffer credits are provided by either the 
storage switch (if distance extension is disabled) or by both the storage switch and the card 
(if distance extension is enabled).

• Forward Error Correction (FEC)—If Enhanced FEC (E-FEC) is enabled on the trunk port of the 
card, the throughout is significantly reduced in comparison to standard FEC being set on the trunk 
port.

Note If distance extension is enabled on the card, the FEC status does not usually affect the 
throughput of the card.

• Payload size—The throughput of the card decreases with decrease in payload size.

The resultant throughput of the card is usually the combined effect of the above parameters.

11.12.1 Key Features
The MXP_MR_10DME_C and MXP_MR_10DME_L cards have the following high-level features:

3 7 X X X —

4 8 X X — —

Table 11-13 Supported Client Data Rates for Ports 1 through 4 and Ports 5 through 8 (continued)

Port (Group 1) Port (Group 2) Gigabit Ethernet 1G FC 2G FC 4G FC
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• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and 
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the 
transmission range on these interfaces. The E-FEC functionality increases the correction capability 
of the transponder to improve performance, allowing operation at a lower OSNR compared to the 
standard RS (237,255) correction algorithm. A new BCH algorithm implemented in E-FEC allows 
recovery of an input BER up to 1E-3.

• Pluggable client interface optic modules: The MXP_MR_10DME_C and MXP_MR_10DME_L 
cards have modular interfaces. Two types of optics modules can be plugged into the card. These 
include an OC-48/STM 16 SR-1 interface with a 7-km (4.3-mile) nominal range (for short range and 
intra-office applications) and an IR-1 interface with a range up to 40 km (24.9 miles). SR-1 is 
defined in Telcordia GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia 
GR-253-CORE and in S-16-1 (ITU-T G.957).

• Y-cable protection: Supports Y-cable protection between the same card type only, on ports with the 
same port number and signal rate. See the “G.34.1.1 Y-Cable Protection” section on page G-30 for 
more detailed information.

• High level provisioning support: The cards are initially provisioned using Cisco TransportPlanner 
software. Subsequently, the card can be monitored and provisioned using CTC software.

• ALS: A safety mechanism used in the event of a fiber cut. For details regarding ALS provisioning 
for the MXP_MR_10DME_C and MXP_MR_10DME_L cards, see the “NTP-G162 Change the 
ALS Maintenance Settings” section on page 11-471.

• Link monitoring and management: The cards use standard OC-48 OH bytes to monitor and manage 
incoming interfaces. The cards pass the incoming SDH/SONET data stream and its OH bytes 
transparently. 

• Control of layered SONET/SDH transport overhead: The cards are provisionable to terminate 
regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It 
can help reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_MR_10DME_C and MXP_MR_10DME_L 
cards normally synchronize from the TCC2/TCC2P/TCC3 card. If for some reason, such as 
maintenance or upgrade activity, the TCC2/TCC2P/TCC3 is not available, the cards automatically 
synchronize to one of the input client interface clocks.

Note MXP_MR_10DME_C and MXP_MR_10DME_L cards cannot be used for line timing.

• Configurable squelching policy: The cards can be configured to squelch the client interface output 
if there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the 
card manages MS-AIS insertion.

• The cards are tunable across the full C band (MXP_MR_10DME_C) or full L band 
(MXP_MR_10DME_L), thus eliminating the need to use different versions of each card to provide 
tunability across specific wavelengths in a band.

• You can provision a string (port name) for each fiber channel/FICON interface on the 
MXP_MR_10DME_C and MXP_MR_10DME_L cards, which allows the MDS Fabric Manager to 
create a link association between that SAN port and a SAN port on a Cisco MDS 9000 switch.

• From Software Release 9.0, the fast switch feature of MXP_MR_10DME_C and 
MXP_MR_10DME_L cards along with the buffer-to-buffer credit recovery feature of MDS 
switches, prevents reinitialization of ISL links during Y-cable switchovers.
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11.12.2 Faceplates and Block Diagram
Figure 11-14 shows the MXP_MR_10DME_C and MXP_MR_10DME_L faceplates and block diagram.

Figure 11-14 MXP_MR_10DME_C and MXP_MR_10DME_L Faceplates and Block Diagram

For information about safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the cards in a loopback on the 
trunk port. Do not use direct fiber loopbacks with the cards. Using direct fiber loopbacks causes 
irreparable damage to the MXP_MR_10DME_C and MXP_MR_10DME_L cards.
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11.12.3 MXP_MR_10DME_C and MXP_MR_10DME_L Functions
The functions of the MXP_MR_10DME_C and MXP_MR_10DME_L cards are:

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-9 on page G-12

11.12.3.1 Wavelength Identification

The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU 
grid effectively. Both the MXP_MR_10DME_C and MXP_MR_10DME_L cards implement the UT2 
module. The MXP_MR_10DME_C card uses a C-band version of the UT2 and the 
MXP_MR_10DME_L card uses an L-band version. 

Table 11-14 describes the required trunk transmit laser wavelengths for the MXP_MR_10DME_C card. 
The laser is tunable over 82 wavelengths in the C band at 50-GHz spacing on the ITU grid.

Table 11-14 MXP_MR_10DME_C Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537
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Table 11-15 describes the required trunk transmit laser wavelengths for the MXP_MR_10DME_L card. 
The laser is fully tunable over 80 wavelengths in the L band at 50-GHz spacing on the ITU grid.

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 11-14 MXP_MR_10DME_C Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Table 11-15 MXP_MR_10DME_L Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 190.85 1570.83 41 188.85 1587.46

2 190.8 1571.24 42 188.8 1587.88

3 190.75 1571.65 43 188.75 1588.30

4 190.7 1572.06 44 188.7 1588.73

5 190.65 1572.48 45 188.65 1589.15

6 190.6 1572.89 46 188.6 1589.57

7 190.55 1573.30 47 188.55 1589.99

8 190.5 1573.71 48 188.5 1590.41

9 190.45 1574.13 49 188.45 1590.83

10 190.4 1574.54 50 188.4 1591.26

11 190.35 1574.95 51 188.35 1591.68
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11.12.4 Related Procedures for MXP_MR_10DME_C and MXP_MR_10DME_L 
Cards

The following is the list of procedures and tasks related to the configuration of MXP_MR_10DME_C 
and MXP_MR_10DME_L cards:

12 190.3 1575.37 52 188.3 1592.10

13 190.25 1575.78 53 188.25 1592.52

14 190.2 1576.20 54 188.2 1592.95

15 190.15 1576.61 55 188.15 1593.37

16 190.1 1577.03 56 188.1 1593.79

17 190.05 1577.44 57 188.05 1594.22

18 190 1577.86 58 188 1594.64

19 189.95 1578.27 59 187.95 1595.06

20 189.9 1578.69 60 187.9 1595.49

21 189.85 1579.10 61 187.85 1595.91

22 189.8 1579.52 62 187.8 1596.34

23 189.75 1579.93 63 187.75 1596.76

24 189.7 1580.35 64 187.7 1597.19

25 189.65 1580.77 65 187.65 1597.62

26 189.6 1581.18 66 187.6 1598.04

27 189.55 1581.60 67 187.55 1598.47

28 189.5 1582.02 68 187.5 1598.89

29 189.45 1582.44 69 187.45 1599.32

30 189.4 1582.85 70 187.4 1599.75

31 189.35 1583.27 71 187.35 1600.17

32 189.3 1583.69 72 187.3 1600.60

33 189.25 1584.11 73 187.25 1601.03

34 189.2 1584.53 74 187.2 1601.46

35 189.15 1584.95 75 187.15 1601.88

36 189.1 1585.36 76 187.1 1602.31

37 189.05 1585.78 77 187.05 1602.74

38 189 1586.20 78 187 1603.17

39 188.95 1586.62 79 186.95 1603.60

40 188.9 1587.04 80 186.9 1604.03

Table 11-15 MXP_MR_10DME_L Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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• NTP-G148 Modify the 10G Data Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-321

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.13 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards
The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards aggregate a variety of client service inputs 
(Gigabit Ethernet, Fibre Channel, OTU2, OTU2e, and OC-192) into a single 40-Gbps OTU3/OTU3e 
signal on the trunk side. 

Note In CTC, the 40E-MXP-C and 40ME-MXP-C card is displayed with the same card name, 40E-MXP-C.

The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards support aggregation of the following signals:

• With overclock enabled on the trunk port:

– 10 Gigabit Fibre Channel

– OTU2e

– 10 Gigabit Ethernet LAN-Phy (CBR mapping)
(only on 40E-MXP-C and 40ME-MXP-C cards)

• With overclock disabled on the trunk port:

– 8 Gigabit Fibre Channel

– 10 GigabitEthernet LAN-Phy (GFP framing)

– 10 GigabitEthernet LAN-Phy (WIS framing)

– OC-192/STM-64

– OTU2

Caution Handle the card with care. Dropping or misuse of the card could result in permanent damage.

The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponders pass all SONET/SDH overhead bytes 
transparently, section, or line termination.

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate performance monitoring. The 
40G-MXP-C, 40E-MXP-C and 40ME-MXP-C cards work with the OTN devices defined in 
ITU-T G.709. The card supports ODTU23 multiplexing, an industry standard method for 
asynchronously mapping client payloads into a digitally wrapped envelope. See the “G.11 Multiplexing 
Function” section on page G-21.

You can install and provision the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards in a linear 
configuration in:

• Slots 1 to 5 and 12 to 16 in ONS 15454 DWDM chassis

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis
11-52
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_ABA5BDBA34684C40A1F2B60AFA862C21


Chapter 11      Provision Transponder and Muxponder Cards
11.13   40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards
The client ports of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards interoperates with all the 
existing TXP/MXP (OTU2 trunk) cards.

The auto negotiation is not supported on the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards in 8G 
FC client mode. Hence, during interoperation, the auto negotiation of the 8G-FC client port of the other 
device connected to 8G-FC client port on 40G-MXP-C, 40E-MXP-C, or 40ME-MXP-C card must be set 
to Fixed/Disabled.

The client port of 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards does not interoperate with 
OTU2_XP card when the signal rate is OTU1e (11.049 Gbps) and the “No Fixed Stuff” option is enabled 
on the trunk port of OTU2_XP card.

For OTU2 and OTU2e client protocols, Enhanced FEC (EFEC) is not supported on Port 1 of the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards. Table 11-16 lists the FEC configuration supported 
on OTU2/OTU2e protocol for 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

When setting up the card for the first time, or when the card comes up after clearing the LOS-P condition 
due to fiber cut, the trunk port of the 40G-MXP-C card takes about 6 minutes to lock a signal. The trunk 
port of the 40G-MXP-C card raises an OTUK-LOF alarm when the card is comes up. The alarm clears 
when the trunk port locks the signal.

When a protection switch occurs on the 40E-TXP-C and 40ME-TXP-C cards, the recovery from 
PSM protection switch takes about 3 to 4 minutes.

The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards is tunable over C-band on the trunk port. The 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards support pluggable XFPs on the client ports on the 
card faceplate. The card uses dual LC connectors on the trunk side, and XFP modules on the client side 
for optical cable termination. The XFP pluggable modules are SR, LR, MM, DWDM, or CWDM and 
support an LC fiber connector. The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards contains four 
XFP modules for the client interfaces. For optical termination, each XFP uses two LC connectors, which 
are labeled TX and RX on the faceplate. The trunk port is a dual LC connector facing downward at 
45 degrees.

Table 11-17 shows the input data rate for each client interface.

Table 11-16 Client Interface Data Rates for 40G-MXP-C, 40E-MXP-C and 40ME-MXP-C Cards

40G-MXP-C, 40E-MXP-C 
and 40ME-MXP-C Client 
Port

FEC Configuration Supported on 
OTU2/OTU2e Client Protocol

Port 1 Only Standard FEC

Port 2 Standard and Enhanced FEC

Port 3 Standard and Enhanced FEC

Port 4 Standard and Enhanced FEC

Table 11-17 Client Interface Input Data Rates for 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Client Interface Input Data Rate

8-Gigabit Fibre Channel 8.48 Gbps

10-Gigabit Fibre Channel 10.519 Gbps

10-GigabitEthernet LAN-Phy 10.312 Gbps

10-GigabitEthernet WAN-Phy 9.953 Gbps
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11.13.1 Key Features
The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards provides the following key features:

• The 40G-MXP-C card uses the RZ-DQPSK 40G modulation format.

• The 40E-MXP-C and 40ME-MXP-C cards uses the CP-DQPSK modulation format.

• Onboard E-FEC processor—The E-FEC functionality improves the correction capability of the 
transponder to improve performance, allowing operation at a lower OSNR compared to the standard 
RS (239,255) correction algorithm. A new BCH algorithm implemented (according to G.975.1 I.7) 
in E-FEC allows recovery of an input BER up to 1E-3. The 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C cards support both the standard RS (specified in ITU-T G.709) and E-FEC standard, 
which allows an improved gain on trunk interfaces with a resultant extension of the transmission 
range on these interfaces.

• Y-cable protection—Supports Y-cable protection only between the same card type on ports with the 
same port number and signal rate. For more information on Y-cable protection, seethe 
“G.34.1 Y-Cable and Splitter Protection” section on page G-30.

Note Y-cable cannot be created on a 10 GE port when WIS framing is enabled on the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

• Unidirectional regeneration—The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards supports 
unidirectional regeneration configuration. Each 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C card 
in the configuration regenerates the signal received from another 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C card in one direction.

Note When you configure the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards in the 
Unidirectional Regen mode, ensure that the payload is not configured on the pluggable port 
modules of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C card.

Figure 11-15 shows a typical unidirectional regeneration configuration.

OC-192/STM-64 9.953 Gbps

OTU2 10.709 Gbps

OTU2e 11.096 Gbps

Table 11-17 Client Interface Input Data Rates for 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Client Interface Input Data Rate
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11.13.2   Faceplate and Block Diagram
Figure 11-15 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards in Unidirectional Regeneration 

Configuration

• High level provisioning support—The cards are initially provisioned using Cisco Transport Planner 
software. Subsequently, the card can be monitored and provisioned using CTC software.

• Automatic Laser Shutdown (ALS)—A safety mechanism, Automatic Laser Shutdown (ALS), is 
used in the event of a fiber cut. The Auto Restart ALS option is supported only for OC-192/STM-64 
and OTU2 payloads. The Manual Restart ALS option is supported for all payloads. For more 
information on provisioning ALS for the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards, see 
the “NTP-G162 Change the ALS Maintenance Settings” section on page 11-471.

• Control of layered SONET/SDH transport overhead—The cards are provisionable to terminate 
regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It 
can help reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization—The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C 
cards synchronize to the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards. Because of a 
maintenance or upgrade activity, if the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards are not 
available, the cards automatically synchronize to one of the input client interface clocks.

• Squelching policy—The cards are set to squelch the client interface output if there is LOS at the 
DWDM receiver, or if there is a remote fault. In the event of a remote fault, the card manages 
MS-AIS insertion.

• The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards are tunable across the full C-band 
wavelength.

11.13.2 Faceplate and Block Diagram
Figure 11-16 shows the faceplate and block diagram of the 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C cards.
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Figure 11-16 Faceplate and Block Diagram of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

For information about safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the cards in a loopback on the 
trunk port. Do not use direct fiber loopbacks with the cards. Using direct fiber loopbacks causes 
irreparable damage to the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

11.13.3 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Functions
The functions of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards are:

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-9 on page G-12
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11.13.3.1 Wavelength Identification

The 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards use trunk lasers that are wavelocked, which 
allows the trunk transmitter to operate on the ITU grid effectively. These cards implement the UT2 
module; they use a C-band version of the UT2.

Table 11-18 lists the required trunk transmit laser wavelengths for the 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C cards. The laser is tunable over 82 wavelengths in the C-band at 50-GHz spacing on the 
ITU grid.

Table 11-18 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555
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11.13.4 Related Procedures for 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C 
Cards

The following is the list of procedures and tasks related to the configuration of 40G-MXP-C, 
40E-MXP-C, and 40ME-MXP-C cards:

• NTP-G293 Modify the 40G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-342

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G75 Monitor Transponder and Muxponder Performance

11.14 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards are Gigabit Ethernet Xponders for the ONS 15454 
ANSI and ETSI platforms.

Note GE_XPE card is the enhanced version of the GE_XP card and 10GE_XPE card is the enhanced version 
of the 10GE_XP card.

The cards aggregate Ethernet packets received on the client ports for transport on C-band trunk ports that 
operate on a 100-GHz grid. The trunk ports operate with ITU-T G.709 framing and either FEC or E-FEC. 
The GE_XP and 10GE_XP cards are designed for bulk point-to-point transport over 10GE LAN PHY 
wavelengths for Video-on-Demand (VOD), or broadcast video across protected 10GE LAN PHY 
wavelengths. The GE_XPE and 10GE_XPE cards are designed for bulk GE_XPE or 10GE_XPE 

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 11-18 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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point-to-point, point-to-multipoint, multipoint-to-multipoint transport over 10GE LAN PHY 
wavelengths for Video-on-Demand (VOD), or broadcast video across protected 10GE LAN PHY 
wavelengths.

You can install and provision the GE_XP, and GE_XPE cards in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in ONS 15454 DWDM chassis

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis

The 10GE_XP and 10GE_XPE cards can be installed in Slots 1 through 6 or 12 through 17. The GE_XP 
and GE_XPE are double-slot cards with twenty Gigabit Ethernet client ports and two 10 Gigabit Ethernet 
trunk ports. The 10GE_XP and 10GE_XPE are single-slot cards with two 10 Gigabit Ethernet client 
ports and two 10 Gigabit Ethernet trunk ports. The client ports support SX, LX, and ZX SFPs and SR 
and 10GBASE-LR XFPs. (LR2 XFPs are not supported.) The trunk ports support a DWDM XFP. 

The RAD pluggables (ONS-SC-E3-T3-PW= and ONS-SC-E1-T1-PW=) do not support:

• No loopbacks (Terminal or Facility)

• RAI (Remote Alarm Indication) alarm

• AIS and LOS alarm

Caution A fan-tray assembly (15454E-CC-FTA for the ETSI shelf, or 15454-CC-FTA for the ANSI shelf) must 
be installed in a shelf where a GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed.

GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards can be provisioned to perform different Gigabit 
Ethernet transport roles. All the cards can work as Layer 2 switches. However, the 10GE_XP and 
10GE_XPE cards can also perform as a 10 Gigabit Ethernet transponders (10GE TXP mode), and the 
GE_XP and GE_XPE can perform as a 10 Gigabit Ethernet or 20 Gigabit Ethernet muxponders (10GE 
MXP or 20GE MXP mode). Table 11-19 shows the card modes supported by each card.

Note Changing the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card mode requires the ports to be in a 
OOS-DSBL (ANSI) or Locked, disabled (ETSI) service state. In addition, no circuits can be provisioned 
on the cards when the mode is being changed.

Table 11-19 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Modes

Card Mode Cards Description

Layer 2 
Ethernet 
switch

GE_XP

10GE_XP

GE_XPE

10GE_XPE

Provides capability to switch between any two ports irrespective of 
client or trunk port. Supported Ethernet protocols and services include 
1+1 protection, QoS (Quality of Service), CoS (Class of Service), 
QinQ, MAC learning, MAC address retrieval, service provider 
VLANs (SVLANs), IGMP snooping and Multicast VLAN 
Registration (MVR), link integrity, and other Ethernet switch 
services.
11-59
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
11.14.1   Key Features
11.14.1 Key Features
The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have the following high-level features:

• Link Aggregation Control Protocol (LACP) that allows you to bundle several physical ports together 
to form a single logical channel.

• Ethernet Connectivity Fault Management (CFM) protocol that facilitates proactive connectivity 
monitoring, fault verification, and fault isolation.

• Ethernet Operations, Administration, and Maintenance (OAM) protocol that facilitates link 
monitoring, remote failure indication, and remote loopback.

• Resilient Ethernet Protocol (REP) that controls network loops, handles link failures, and improves 
convergence time.

• Configurable service VLANs (SVLANs) and customer VLANs (CVLANs). 

• Ingress rate limiting that can be applied on both SVLANs and CVLANs. You can create SVLAN 
and CVLAN profiles and can associate a SVLAN profile to both UNI and NNI ports; however, you 
can associate a CVLAN profile only to UNI ports.

• CVLAN rate limiting that is supported for QinQ service in selective add mode.

• Differentiated Services Code Point (DSCP) to class of service (CoS) mapping that you can configure 
for each port. You can configure the CoS of the outer VLAN based on the incoming DSCP bits. This 
feature is supported only on GE_XPE and 10GE_XPE cards.

• Ports, in Layer 2 switch mode, can be provisioned as network-to-network interfaces (NNIs) or 
user-network interfaces (UNIs) to facilitate service provider to customer traffic management.

• Broadcast drop-and-continue capability for VOD and broadcast video applications.

• Gigabit Ethernet MXP, TXP, and Layer 2 switch capability over the ONS 15454 DWDM platform.

• Compatible with the ONS 15454 ANSI high-density shelf assembly, the ONS 15454 ETSI shelf 
assembly, ONS 15454 ETSI high-density shelf assembly, ONS 15454 M2, and the ONS 15454 M6 
shelf assemblies. Compatible with TCC2, TCC2P, TCC3, TNC, TNCE, TSC, and TSCE cards.

• Far-End Laser Control (FELC) that is supported on copper SFPs from Release 8.52 and later 
releases. For more information on FELC, see the “G.35 Far-End Laser Control” section on 
page G-35.

• Layer 2 switch mode that provides VLAN translation, QinQ, ingress CoS, egress QoS, Fast Ethernet 
protection switching, and other Layer 2 Ethernet services.

10GE TXP 10GE_XP

10GE_XPE

Provides a point-to-point application in which each 10 Gigabit 
Ethernet client port is mapped to a 10 Gigabit Ethernet trunk port.

10GE MXP

20GE MXP

GE_XP

GE_XPE

Provides the ability to multiplex the twenty Gigabit Ethernet client 
ports on the card to one or both of its 10 Gigabit Ethernet trunk ports. 
The card can be provisioned as a single MXP with twenty Gigabit 
Ethernet client ports mapped to one trunk port (Port 21) or as two 
MXPs with ten Gigabit Ethernet client ports mapped to a trunk port 
(Ports 1 to 10 mapped to Port 21, and Ports 11-20 mapped to Port 22).

Table 11-19 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Modes

Card Mode Cards Description
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• Interoperable with TXP_MR_10E and TXP_MR_10E_C cards. Also interoperable with 
Cisco Catalyst 6500 and Cisco 7600 series Gigabit Ethernet, 10 GE interfaces and CRS-1 10GE 
interfaces.

• The GE_XP and GE_XPE cards have twenty Gigabit Ethernet client ports and two 10 Gigabit 
Ethernet trunk ports. The 10GE_XP and 10GE_XPE cards have two 10 Gigabit Ethernet client ports 
and two 10 Gigabit Ethernet trunk ports. The client Gigabit Ethernet signals are mapped into an 
ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing when configured in one of the 
MXP modes (10GE MXP or 20GE MXP).

• ITU-T G.709 framing with standard Reed-Soloman (RS) (255,237) FEC. Performance monitoring 
and ITU-T G.709 Optical Data Unit (ODU) synchronous and asynchronous mapping. E-FEC with 
ITU-T G.709 ODU and 2.7 Gbps with greater than 8 dB coding gain.

• IEEE 802.3 frame format that is supported for 10 Gigabit Ethernet interfaces. The minimum frame 
size is 64 bytes. The maximum frame size is user-provisionable. 

• MAC learning capability in Layer 2 switch mode.

• MAC address retrieval in cards provisioned in the L2-over-DWDM mode.

• When a port is in UNI mode, tagging can be configured as transparent or selective. In transparent 
mode, only SVLANs in the VLAN database of the node can be configured. In selective mode, a 
CVLAN- to-SVLAN relationship can be defined.

• Layer 2 VLAN port mapping that allows the cards to be configured as multiple Gigabit Ethernet 
TXPs and MXPs.

• Y-cable protection is configurable in TXP and MXP modes.

• Two protection schemes are available in Layer 2 mode. They are:

– 1+1 protection—Protection scheme to address card, port, or shelf failures for client ports.

– Fast Automatic Protection—Protection scheme to address card, port, or shelf failures for trunk 
ports.

• End-to-end Ethernet link integrity.

• Pluggable client interface optic modules (SFPs and XFPs)—Client ports support tri-rate SX, LX, 
and ZX SFPs, and 10-Gbps SR1 XFPs. 

• Pluggable trunk interface optic modules; trunk ports support the DWDM XFP.

• Internet Group Management Protocol (IGMP) snooping that restricts the flooding of multicast 
traffic by forwarding multicast traffic to those interfaces where a multicast device is present. 

• Multicast VLAN Registration (MVR) for applications using wide-scale deployment of multicast 
traffic across an Ethernet ring-based service provider network.

• Ingress CoS that assigns a CoS value to the port from 0 (highest) to 7 (lowest) and accepts CoS of 
incoming frames.

• Egress QoS that defines the QoS capabilities for the egress port.

• MAC address learning that facilitates switch processing.

• Storm Control that limits the number of packets passing through a port. You can define the 
maximum number of packets allowed per second for the following types of traffic: Broadcast, 
Multicast, and Unicast. The threshold for each type of traffic is independent and the maximum 
number of packets allowed per second for each type of traffic is 16777215.
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11.14.2 Protocol Compatibility list
Table 11-20 lists the protocol compatibility for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

11.14.3 Faceplate and Block Diagram
Figure 11-17 shows the GE_XP faceplate and block diagram. The GE_XPE faceplate and block diagram 
looks the same. 

Table 11-20 Protocol Compatibility List for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards

Protocol L1 1+1 FAPS IGMP REP LACP CFM EFM

L1 No Yes Yes No No Yes No

1+1 No Yes Yes No No Yes No

FAPS Yes Yes Yes No No Yes No

IGMP Yes Yes Yes Yes No Yes No

REP No No No Yes No Yes No

LACP No No No No No No No

CFM Yes Yes Yes Yes Yes No No

EFM No No No No No No No
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Figure 11-17 GE_XP and GE_XPE Faceplates and Block Diagram

The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have two trunk ports. The GE_XP and GE_XPE 
trunk ports are displayed as follows:

• Trunk 1 and Trunk 2 on the faceplate

• 21-1 and 22-1 on CTC

• 21 (Trunk) and 22 (Trunk) on the Optics Thresholds table

Figure 11-18 shows the 10GE_XP faceplate and block diagram. The 10 GE_XPE faceplate and block 
diagram looks the same. 
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Figure 11-18 10GE_XP and 10GE_XPE Faceplates and Block Diagram

The 10GE_XP and 10GE_XPE card trunk ports are displayed as follows:

• Trunk 1 and Trunk 2 on the faceplate

• 3-1 and 4-1 on CTC

• 3 (Trunk) and 4 (Trunk) on the Optics Thresholds table

For information about safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the cards in a loopback on the 
trunk port. Do not use direct fiber loopbacks with the cards. Using direct fiber loopbacks causes 
irreparable damage to the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.
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11.14.4 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Functions
The functions of the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards are:

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-9 on page G-12

11.14.4.1 Client Interface

The client interface is implemented with separately orderable SFP or XFP modules. The client interfaces 
support the following tri-rate SFPs and XFPs using dual LC connectors and multimode fiber: 

• SFP - GE/1G-FC/2G-FC - 850 nm - MM - LC (PID ONS-SE-G2F-SX)

• SFP - GE/1G-FC/2G-FC 1300 nm - SM - LC (PID ONS-SE-G2F-LX)

• SFP - GE/1G-FC/2G-FC 1300 nm - SM - LC (PID ONS-SE-G2F-ZX)

• SFP - 10/100/1000Base-T - Copper (PID ONS-SE-ZE-EL) Intra office up to 100;
Cable: RJ45 STP CAT5, CAT5E, and CAT6

• SFP - 1000Base BX D/Gigabit Ethernet 1550 nm - SM - LC (PID ONS-SE-GE-BXD)

• SFP - 1000Base BX U/Gigabit Ethernet 1550 nm - SM - LC (PID ONS-SE-GE-BXU)

• SFP - Fast Ethernet 1310 nm - SM - LC (PID ONS-SI-100-LX10)

• SFP - Fast Ethernet 1310 nm - MM - LC (PID ONS-SI-100-FX)

• SFP - Fast Ethernet over DS1/E1 - SM - LC (PID ONS-SC-EOP1) (GE_XPE only)

• SFP - Fast Ethernet over DS3/E3 - SM - LC (PID ONS-SC-EOP3) (GE_XPE only)

• SFP - E1/DS1 over Fast Ethernet - SM - LC (PID ONS-SC-E1-T1-PW) (GE_XPE only)

• SFP - E3/DS3 PDH over Fast Ethernet - SM - LC (PID ONS-SC-E3-T3-PW) (GE_XPE only)

Note The recommended topology for using ONS-SC-E1-T1-PW and ONS-SC-E3-T3-PW SFPs is shown in 
Figure 11-19.

Figure 11-19 Recommended Topology for Using ONS-SC-E1-T1-PW and ONS -SC-E3-T3-PW SFPs

The client interfaces support the following dual-rate XFP using dual LC connectors and single-mode 
fiber:
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• XFP - OC-192/STM-64/10GE/10-FC/OTU2 - 1310 SR - SM LC (PID: ONS-XC-10G-S1)

• XFP - 10GE - 1550 nm - SM - LC (PID ONS-XC-10G-L2)

• XFP - 10GE - 1550 nm - SM - LC (PID ONS-XC-10G-C)

Note If ONS-XC-10G-C XFP is used on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards on 
client port 1, the maximum temperature at which the system qualifies is +45 degree Celsius.

The client interfaces support the following multimode XFP using dual LC connectors and multi-mode 
fiber:

• XFP - OC-192/10GFC/10GE - 850 nm MM LC (PID ONS-XC-10G-SR-MM)

11.14.4.2 DWDM Trunk Interface

The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have two 10 Gigabit Ethernet trunk ports 
operating at 10 Gigabit Ethernet (10.3125 Gbps) or 10 Gigabit Ethernet into OTU2 (nonstandard 
11.0957 Gbps). The ports are compliant with ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE 
standards. The ports are capable of carrying C-band and L-band wavelengths through insertion of 
DWDM XFPs. Forty channels are available in the 1550-nm C band 100-GHz ITU grid, and forty 
channels are available in the L band.

11.14.4.3 Configuration Management

The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards support the following configuration 
management parameters:

• Port name—User-assigned text string.

• Admin State/Service State—Administrative and service states to manage and view port status.

• MTU—Provisionable maximum transfer unit (MTU) to set the maximum number of bytes per 
frames accepted on the port.

• Mode—Provisional port mode, either Autonegotiation or the port speed.

• Flow Control—Flow control according to IEEE 802.1x pause frame specification can be enabled or 
disabled for TX and RX ports.

• Bandwidth—Provisionable maximum bandwidth allowed for the port.

• Ingress CoS—Assigns a CoS value to the port from 0 (highest) to 7 (lowest) and accepts CoS of 
incoming frames.

• Egress QoS—Defines the QoS capabilities at the egress port.

• NIM—Defines the port network interface management type based on Metro Ethernet Forum 
specifications. Ports can be defined as UNI or NNI.

• MAC Learning—MAC address learning to facilitate switch processing.

• VLAN tagging provided according to the IEEE 802.1Q standard.

Note When the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards are provisioned in a MXP or TXP mode, 
only the following parameters are available: Port Name, State, MTU, Mode, Flow control, and 
Bandwidth.
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11.14.4.4 Security

GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card ports can be provisioned to block traffic from a 
user-defined set of MAC addresses. The remaining traffic is normally switched. You can manually 
specify the set of blocked MAC addresses for each port. Each port of the card can receive traffic from a 
limited predefined set of MAC addresses. The remaining traffic will be dropped. This capability is a 
subset of the Cisco IOS “Port Security” feature.

11.14.4.5 Card Protection

The following card protection schemes are available for the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards.

• Y-Cable Protection—See the “G.34.1.1 Y-Cable Protection” section on page G-30.

• 1+1 Protection—See the “G.34.2 1+1 Protection” section on page G-34.

• Layer 2 Over DWDM Protection—See the “G.34.3 Layer 2 Over DWDM Protection” section on 
page G-35.

11.14.4.5.1 Related Procedures for Card Protection

The following are the related procedures for creating card protection on GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE cards:

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G198 Create 1+1 Protection for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards, 
page 11-188

• DLP-G381 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Layer 2 Protection Settings, 
page 11-415

11.14.5 IGMP Snooping
As networks increase in size, multicast routing becomes critically important as a means to determine 
which segments require multicast traffic and which do not. IP multicasting allows IP traffic to be 
propagated from one source to a number of destinations, or from many sources to many destinations. 
Rather than sending one packet to each destination, one packet is sent to the multicast group identified 
by a single IP destination group address. GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards can learn 
up to a maximum of 1024 multicast groups. This includes groups on all the VLANs.

Internet Group Management Protocol (IGMP) snooping restricts the flooding of multicast traffic by 
forwarding multicast traffic to those interfaces where a multicast device is present.

When the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card receives an IGMP leave group message from 
a host, it removes the host port from the multicast forwarding table after generating group specific 
queries to ensure that no other hosts interested in traffic for the particular group are present on that port. 
Even in the absence of any “leave” message, the cards have a timeout mechanism to update the group 
table with the latest information. After a card relays IGMP queries from the multicast router, it deletes 
entries periodically if it does not receive any IGMP membership reports from the multicast clients.

In a multicast router, general queries are sent on a VLAN when Protocol Independent Multicast (PIM) 
is enabled on the VLAN. The GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card forwards queries to all 
ports belonging to the VLAN. All hosts interested in this multicast traffic send Join requests and are 
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added to the forwarding table entry. The Join requests are forwarded only to router ports. By default, 
these router ports are learned dynamically. However, they can also be statically configured at the port 
level in which case the static configuration overrides dynamic learning.

For information about interaction of IGMP with other protocols, see the “11.14.2 Protocol 
Compatibility list” section on page 11-62.

11.14.5.1 IGMP Snooping Guidelines and Restrictions

The following guidelines and restrictions apply to IGMP snooping on GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards:

• IGMP snooping V2 is supported as specified in RFC 4541.

• IGMP snooping V3 is not supported and the packets are flooded in the SVLAN.

• Layer 2 multicast groups learned through IGMP snooping are dynamic.

• GE_XP and 10GE_XP cards support IGMP snooping on 128 stacked VLANs and GE_XPE and 
10GE_XPE cards support up to 256 stacked VLANs that are enabled.

• IGMP snooping can be configured per SVLAN or CVLAN. By default, IGMP snooping is disabled 
on all SVLANs and CVLANs.

• IGMP snooping on CVLAN is enabled only when:

– MVR is enabled.

– UNI ports are in selective add and selective translate modes. For each UNI port, a CVLAN must 
be specified for which IGMP snooping is to be enabled.

• IGMP snooping can be enabled only on one CVLAN per port. If you enable IGMP snooping on 
CVLAN, you cannot enable IGMP snooping on the associated SVLAN and vice versa. The number 
of VLANs that can be enabled for IGMP snooping cannot exceed 128.

• When IGMP snooping is enabled on double-tagged packets, CVLAN has to be the same on all ports 
attached to the same SVLAN.

• When IGMP snooping is working with the Fast Automatic Protection Switch (FAPS) in a ring-based 
setup, it is advisable to configure all NNI ports as static router ports. This minimizes the multicast 
traffic hit when a FAPS switchover occurs.

The following conditions are raised from IGMP snooping at the card:

• MCAST-MAC-TABLE-FULL—This condition is raised when the multicast table is full and a new 
join request is received. This table is cleared when at least one entry gets cleared from the multicast 
table after the alarm is raised.

• MCAST-MAC-ALIASING—This condition is raised when there are multiple L3 addresses that map 
to the same L2 address in a VLAN. This is a transient condition.

For more information on severity level of these conditions and procedure to clear these alarms, refer to 
the Cisco ONS 15454 Troubleshooting Guide.

11.14.5.2 Fast-Leave Processing

Note Fast-Leave processing is also known as Immediate-Leave.
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IGMP snooping Fast-Leave processing allows the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE to 
remove an interface that sends a leave message from the forwarding table without first sending group 
specific queries to the interface. When you enable IGMP Fast-Leave processing, the card immediately 
removes a port from the IP multicast group when it detects an IGMP, version 2 (IGMPv2) leave message 
on that port.

11.14.5.3 Static Router Port Configuration

Multicast-capable ports are added to the forwarding table for every IP multicast entry. The card learns 
of such ports through the PIM method.

11.14.5.4 Report Suppression

Report suppression is used to avoid a storm of responses to an IGMP query. When this feature is enabled, 
a single IGMP report is sent to each multicast group in response to a single query. Whenever an IGMP 
snooping report is received, report suppression happens if the report suppression timer is running. The 
Report suppression timer is started when the first report is received for a general query. Then this time 
is set to the response time specified in general query.

11.14.5.5 IGMP Statistics and Counters

An entry in a counter contains multicasting statistical information for the IGMP snooping capable 
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card. It provides statistical information about IGMP 
messages that have been transmitted and received. IGMP statistics and counters can be viewed via CTC 
from the Performance > Ether Ports > Statistics tab.

This information can be stored in the following counters:

• cisTxGeneralQueries—Number of general queries transmitted through an interface.

• cisTxGroupSpecificQueries—Total group specific queries transmitted through an interface.

• cisTxReports—Total membership reports transmitted through an interface.

• cisTxLeaves—Total Leave messages transmitted through an interface.

• cisRxGeneralQueries—Total general queries received at an interface.

• cisRxGroupSpecificQueries—Total Group Specific Queries received at an interface.

• cisRxReports—Total Membership Reports received at an interface.

• cisRxLeaves—Total Leave messages received at an interface.

• cisRxValidPackets—Total valid IGMP packets received at an interface.

• cisRxInvalidPackets—Total number of packets that are not valid IGMP messages received at an 
interface.

11.14.5.6 Related Procedure for Enabling IGMP Snooping

To enable IGMP snooping on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the 
“NTP-G204 Enable IGMP Snooping on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards” section on 
page 11-433.
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11.14.6 Multicast VLAN Registration
Multicast VLAN Registration (MVR) is designed for applications using wide-scale deployment of 
multicast traffic across an Ethernet-ring-based service provider network (for example, the broadcast of 
multiple television channels over a service-provider network). MVR allows a subscriber on a port to 
subscribe and unsubscribe to a multicast stream on the network-wide multicast VLAN. It allows the 
single multicast VLAN to be shared in the network while subscribers remain in separate VLANs. MVR 
provides the ability to continuously send multicast streams in the multicast VLAN, but to isolate the 
streams from the subscriber VLANs for bandwidth and security reasons.

MVR assumes that subscriber ports subscribe and unsubscribe (“Join” and “Leave”) these multicast 
streams by sending out IGMP Join and Leave messages. These messages can originate from an IGMP 
version-2-compatible host with an Ethernet connection. MVR operates on the underlying mechanism of 
IGMP snooping. MVR works only when IGMP snooping is enabled.

The card identifies the MVR IP multicast streams and their associated MAC addresses in the card 
forwarding table, intercepts the IGMP messages, and modifies the forwarding table to include or remove 
the subscriber as a receiver of the multicast stream, even though the receivers is in a different VLAN 
than the source. This forwarding behavior selectively allows traffic to cross between different VLANs.

Note When MVR is configured, the port facing the router must be configured as NNI in order to allow the 
router to generate or send multicast stream to the host with the SVLAN. If router port is configured as 
UNI, the MVR will not work properly.

11.14.6.1 Related Procedure for Enabling MVR

To enable MVR on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the “NTP-G206 Enable 
MVR on a GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card” section on page 11-435.

11.14.7 MAC Address Learning
The GE_XPE and 10 GE_XPE cards support 32K MAC addresses. MAC address learning can be enabled 
or disabled per SVLAN on GE_XPE and 10 GE_XPE cards. The cards learn the MAC address of packets 
they receive on each port and add the MAC address and its associated port number to the MAC address 
learning table. As stations are added or removed from the network, the GE_XPE and 10 GE_XPE cards 
update the MAC address learning table, adding new dynamic addresses and aging out those that are 
currently not in use. 

MAC address learning can be enabled or disabled per SVLAN. When the configuration is changed from 
enable to disable, all the related MAC addresses are cleared. The following conditions apply:

• If MAC address learning is enabled on per port basis, the MAC address learning is not enabled on 
all VLANs, but only on VLANs that have MAC address learning enabled.

• If per port MAC address learning is disabled then the MAC address learning is disabled on all 
VLANs, even if it is enabled on some of the VLAN supported by the port.

• If the per port MAC address learning is configured on GE-XP and 10 GE-XP cards, before upgrading 
to GE-XPE or 10 GE-XPE cards, enable MAC address learning per SVLAN. Failing to do so 
disables MAC address learning.
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11.14.7.1 Related Procedure for MAC Address Learning

To enable MAC address learning on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the 
“DLP-G221 Enable MAC Address Learning on SVLANs for GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards” section on page 11-423.

11.14.8 MAC Address Retrieval
MAC addresses learned can be retrieved or cleared on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards provisioned in L2-over-DWDM mode. The MAC addresses can be retrieved using the CTC or TL1 
interface.

GE_XPE and 10GE_XPE cards support 32K MAC addresses and GE_XP and 10GE_XP cards support 
16K MAC addresses. To avoid delay in processing requests, the learned MAC addresses are retrieved 
using an SVLAN range. The valid SVLAN range is from 1 to 4093.

The MAC addresses of the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards can also be retrieved. 
The card MAC addresses are static and are used for troubleshooting activities. One MAC address is 
assigned to each client, trunk, and CPU ports of the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card. 
These internal MAC addresses can be used to determine if the packets received on the far-end node are 
generated by GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

For MAC address retrieval, the following conditions apply:

• The cards must be provisioned in L2-over-DWDM mode.

• MAC address learning must be enabled per SVLAN on GE_XPE or 10 GE_XPE cards.

• MAC address learning must be enabled per port on GE_XP or 10 GE_XP cards.

11.14.8.1 Related Procedure for MAC Address Retrieving

To retrieve and clear MAC addresses on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the 
“NTP-G237 Retrieve and Clear MAC Addresses on SVLANs for GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards” section on page 11-425.

11.14.9 Link Integrity
The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card support end-to-end Ethernet link integrity. This 
capability is integral to providing an Ethernet private line service and correct operation of Layer 2 and 
Layer 3 protocols on the attached Ethernet devices. 

The link integrity feature propagates a trunk fault on all the affected SVLAN circuits in order to squelch 
the far end client interface. Ethernet-Advanced IP Services (E-AIS) packets are generated on a 
per-port/SVLAN basis. An E-AIS format is compliant with ITU Y.1731. 

Note E-AIS packets are marked with a CoS value of 7 (also called .1p bits). Ensure that the network is not 
overloaded and there is sufficient bandwidth for this queue in order to avoid packet drops. 

When link integrity is enabled on a per-port SVLAN basis, E-AIS packets are generated when the 
following alarms are raised; 

• LOS-P
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• OTUKLOF/LOM

• SIGLOSS

• SYNCHLOSS

• OOS

• PPM not present

When link integrity is enabled, GE_XP and 10 GE_XP card supports up to128 SVLANs and GE_XPE, 
10 GE_XPE can support up to 256 SVLANs.

11.14.9.1 Related Procedure for Enabling Link Integrity

To enable link integrity on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the “NTP-G205 
Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards” section on page 11-428.

11.14.10 Ingress CoS
Ingress CoS functionality enables differentiated services across the GE_XPE and 10GE_XPE cards. A 
wide range of networking requirements can be provisioned by specifying the class of service applicable 
to each transmitted traffic. 

When a CVLAN is configured as ingress CoS, the per-port settings are not considered. A maximum of 
128 CVLAN and CoS relationships can be configured.

11.14.10.1 Related Procedure for Enabling Ingress CoS

To enable Ingress CoS on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the:

• “DLP-G380 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” 
section on page 11-403

• “DLP-G612 Modify the Parameters of the Channel Group Using CTC” section on page 11-369

11.14.11 CVLAN Rate Limiting
CVLAN rate limiting is supported on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards. CVLAN rate 
limiting is supported for QinQ service in selective add mode. The following limitations and restrictions 
apply to CVLAN rate limiting:

• CVLAN rate limiting is not supported for the following service types:

– Selective translate mode

– Transparent mode

– Selective double add mode

– Selective translate add mode

– Untagged packets

– CVLAN range

– Services associated with the channel group

• CVLAN rate limiting and SVLAN rate limiting cannot be applied to the same service instance.
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• Pseudo-IOS command line interface (PCLI) is not supported for CVLAN rate limiting.

• A VLAN profile with Link Integrity option enabled cannot be used to perform CVLAN rate limiting.

• On GE_XP and 10 GE_XP cards, CVLAN rate limiting can be applied to up to 128 services. 
However, the number of provisionable CVLAN rate limiting service instances is equal to 192 minus 
the number of SVLAN rate limiting service instances present on the card (subject to a minimum of 
64 CVLAN rate limiting service instances).

• On GE_XPE and 10 GE_XPE cards, CVLAN rate limiting can be applied to up to 256 services. 
However, the number of provisionable CVLAN rate limiting service instances is equal to 384 minus 
the number of SVLAN rate limiting service instances present on the card (subject to a minimum of 
128 CVLAN rate limiting service instances).

11.14.11.1 Related Procedure for Provisioning CVLAN Rate

To provision CVLAN rate on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the 
“NTP-G289 Provision CVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card” 
section on page 11-430.

11.14.12 DSCP to CoS Mapping
DSCP to CoS mapping can be configured for each port. You can configure the CoS of the outer VLAN 
based on the incoming DSCP bits. This feature is supported only on GE_XPE and 10GE_XPE cards. 
PCLI is not supported for DSCP to CoS mapping. 

DSCP to CoS mapping is supported for the following service types:

– Selective add mode

– Selective translate mode

– Transparent mode

– Selective double add mode

– Selective translate add mode

– Untagged packets

– CVLAN range

– Services associated with the channel group

11.14.12.1 Related Procedure for Provisioning CoS Based on DSCP

To provision CoS based on DSCP on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the 
“DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE QinQ Settings” section on 
page 11-421.

11.14.13 Link Aggregation Control Protocol
Link Aggregation Control Protocol (LACP) is part of the IEEE802.3ad standard that allows you to 
bundle several physical ports together to form a single logical channel. LACP allows a network device 
such as a switch to negotiate an automatic bundling of links by sending LACP packets to the peer device.
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LACP allows you to form a single Layer 2 link automatically from two or more Ethernet links. This 
protocol ensures that both ends of the Ethernet link are functional and agree to be members of the 
aggregation group before the link is added to the group. LACP must be enabled at both ends of the link 
to be operational.

For more information on LACP, refer to the IEEE802.3ad standard. For information about interaction of 
LACP with other protocols, see the “11.14.2 Protocol Compatibility list” section on page 11-62.

11.14.13.1 Advantages of LACP

LACP provides the following advantages:

• High-speed network that transfers more data than any single port or device.

• High reliability and redundancy. If a port fails, traffic continues on the remaining ports.

• Hashing algorithm that allows to apply load balancing policies on the bundled ports.

11.14.13.2 Functions of LACP

LACP performs the following functions in the system: 

• Maintains configuration information to control aggregation.

• Exchanges configuration information with other peer devices.

• Attaches or detaches ports from the link aggregation group based on the exchanged configuration 
information.

• Enables data flow when both sides of the aggregation group are synchronized.

11.14.13.3 Modes of LACP

LACP can be configured in the following modes:

• On — Default. In this mode, the ports do not exchange LACP packets with the partner ports.

• Active — In this mode, the ports send LACP packets at regular intervals to the partner ports.

• Passive — In this mode, the ports do not send LACP packets until the partner sends LACP packets. 
After receiving the LACP packets from the partner ports, the ports send LACP packets.

11.14.13.4 Parameters of LACP

LACP uses the following parameters to control aggregation:

• System Identifier—A unique identification assigned to each system. It is the concatenation of the 
system priority and a globally administered individual MAC address.

• Port Identification—A unique identifier for each physical port in the system. It is the concatenation 
of the port priority and the port number.

• Port Capability Identification—An integer, called a key, that identifies the capability of one port to 
aggregate with another port. There are two types of keys:

– Administrative key—The network administrator configures this key. 

– Operational key—The LACP assigns this key to a port, based on its aggregation capability.

• Aggregation Identifier—A unique integer that is assigned to each aggregator and is used for 
identification within the system.
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11.14.13.5 Unicast Hashing Schemes

LACP supports the following unicast hashing schemes:

• Ucast SA VLAN Incoming Port

• Ucast DA VLAN Incoming Port

• Ucast SA DA VLAN Incoming port

• Ucast Src IP TCP UDP

• Ucast Dst IP TCP UDP

• Ucast Src Dst IP TCP UDP

Note Unicast hashing schemes apply to unicast traffic streams only when the destination MAC address is 
already learned by the card. Hence, MAC learning must be enabled to support load balancing as per the 
configured hashing scheme. If the destination MAC address is not learned, the hashing scheme is Ucast 
Src Dst IP TCP UDP.

11.14.13.6 LACP Limitations and Restrictions

The LACP on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations and 
restrictions:

• Hot standby link state is not supported on the channel group.

• Marker protocol generator is not supported.

• ALS cannot be configured on the channel group.

• Loopback configuration cannot be applied on the channel group.

11.14.13.7 Related Procedure for LACP

To provision Channel Group using LACP, see the “NTP-G281 Manage the GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE Card Channel Group Settings” section on page 11-367.

11.14.14 Ethernet Connectivity Fault Management
Ethernet Connectivity Fault Management (CFM) is part of the IEEE 802.1ag standard. The Ethernet 
CFM is an end-to-end per service instance that supports the Ethernet layer Operations, Administration, 
and Management (OAM) protocol. It includes proactive connectivity monitoring, link trace on a per 
service basis, fault verification, and fault isolation for large Ethernet metropolitan-area networks 
(MANs) and WANs.

CFM is disabled on the card by default. CFM is enabled on all the ports by default.

For more information on CFM, refer to the IEEE 802.1ag standard. For information about interaction of 
CFM with other protocols, see the “11.14.2 Protocol Compatibility list” section on page 11-62. The 
following sections contain conceptual information about Ethernet CFM.
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11.14.14.1 Maintenance Domain

A maintenance domain is an administrative domain that manages and administers a network. You can 
assign a unique maintenance level (from 0 to 7) to define the hierarchical relationship between domains. 
The larger the domain, the higher the maintenance level for that domain. For example, a service provider 
domain would be larger than an operator domain and might have a maintenance level of 6, while the 
operator domain maintenance level would be 3 or 4.

Maintenance domains cannot intersect or overlap because that would require more than one entity to 
manage it, which is not allowed. Domains can touch or nest if the outer domain has a higher maintenance 
level than the nested domain. Maintenance levels of nesting domains must be communicated among the 
administrating organizations. For example, one approach would be to have the service provider assign 
maintenance levels to operators.

The CFM protocol supports up to eight maintenance domains on GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards. 

11.14.14.2 Maintenance Association

A maintenance association identifies a service within the maintenance domain. You can have any number 
of maintenance associations within each maintenance domain. The CFM protocol supports up to 1500 
maintenance associations on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Note Each maintenance association is mapped to a maintenance domain. This mapping is done to configure a 
Maintenance End Point (MEP). The CFM protocol supports up to 1000 mappings on GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

11.14.14.3 Maintenance End Points

Maintenance End Points (MEPs) reside at the edge of the maintenance domain and are active elements 
of the Ethernet CFM. MEPs transmit Continuity Check messages at periodic intervals and receive similar 
messages from other MEPs within a domain. MEPs also transmit Loopback and Traceroute messages at 
the request of the administrator. MEPs confine CFM messages within the boundary of a maintenance 
domain through the maintenance level. There are two types of MEPs: 

• Up (Inwards, towards the bridge) 

• Down (Outwards, towards the wire).

You can create up to 255 MEPs and MIPs together on GE_XP and 10GE_XP cards. You can create up 
to 500 MEPs and MIPs together on GE_XPE and 10GE_XPE cards.

The MEP continuity check database (CCDB) stores information that is received from other MEPs in the 
maintenance domain. The card can store up to 4000 MEP CCDB entries.

11.14.14.4 Maintenance Intermediate Points

Maintenance Intermediate Points (MIPs) are internal to the maintenance domain and are passive 
elements of the Ethernet CFM. They store information received from MEPs and respond to Linktrace 
and Loopback CFM messages. MIPs forward CFM frames received from MEPs and other MIPs, drop all 
CFM frames at a lower level, and forward all CFM frames at a higher level.

You can create up to 255 MEPs and MIPs together on GE_XP and 10GE_XP cards. You can create up 
to 500 MEPs and MIPs together on GE_XPE and 10GE_XPE cards.
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The MIP CCDB maintains the information received for all MEPs in the maintenance domain. The card 
can store up to 4000 MIP CCDB entries.

11.14.14.5 CFM Messages

The Ethernet CFM on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards supports the following 
messages:

• Continuity Check—These messages are exchanged periodically among MEPs. They allow MEPs to 
discover other MEPs within a domain and allow MIPs to discover MEPs. These messages are 
confined to a domain.

• Loopback—These messages are unicast messages that a MEP transmits, at the request of an 
administrator, to verify connectivity to a specific maintenance point. A reply to a loopback message 
indicates whether a destination is reachable.

• Traceroute—These messages are multicast messages that a MEP transmits, at the request of an 
administrator, to track the path to a destination MEP.

11.14.14.6 CFM Limitations and Restrictions

The CFM on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations and 
restrictions:

• CFM is not supported on channel groups.

• CFM is not enabled on protected ports running REP, FAPS, and 1+1.

• Y.1731 enhancements including AIS, LCK, and performance monitoring messages along with CFM 
are not supported.

• IEEE CFM MIB is not supported.

• L1 and CFM are mutually exclusive on a SVLAN because LI and CFM use the same MAC address.

• MAC security and CFM are mutually exclusive on the card due to hardware resource constraints.

11.14.14.7 Related Procedure for Ethernet CFM

For information about the supported Ethernet CFM features on the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards, see the “NTP-G283 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card 
CFM Settings” section on page 11-378.

11.14.15 Ethernet OAM
The Ethernet OAM protocol is part of the IEEE 802.3ah standard and is used for installing, monitoring, 
and troubleshooting Ethernet MANs and Ethernet WANs. This protocol relies on an optional sublayer in 
the data link layer of the OSI model. The Ethernet OAM protocol was developed for Ethernet in the First 
Mile (EFM) applications. The terms Ethernet OAM and EFM are interchangeably used and both mean 
the same.

Normal link operation does not require Ethernet OAM. You can implement Ethernet OAM on any 
full-duplex point-to-point or emulated point-to-point Ethernet link for a network or part of a network 
(specified interfaces). OAM frames, called OAM Protocol Data Units (OAM PDUs), use the slow 
protocol destination MAC address 0180.c200.0002. OAM PDUs are intercepted by the MAC sublayer 
and cannot propagate beyond a single hop within an Ethernet network.
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Ethernet OAM is disabled on all interfaces by default. When Ethernet OAM is enabled on an interface, 
link monitoring is automatically turned on.

For more information on Ethernet OAM protocol, refer to IEEE 802.3ah standard. For information about 
interaction of Ethernet OAM with other protocols, see the “11.14.2 Protocol Compatibility list” section 
on page 11-62.

11.14.15.1 Components of the Ethernet OAM

Ethernet OAM consists of two major components, the OAM Client and the OAM Sublayer.

11.14.15.1.1 OAM Client

The OAM client establishes and manages the Ethernet OAM on a link. The OAM client also enables and 
configures the OAM sublayer. During the OAM discovery phase, the OAM client monitors the OAM 
PDUs received from the remote peer and enables OAM functionality. After the discovery phase, the 
OAM client manages the rules of response to OAM PDUs and the OAM remote loopback mode.

11.14.15.1.2 OAM Sublayer

The OAM sublayer presents two standard IEEE 802.3 MAC service interfaces:

• One interface facing toward the superior sub-layers, which include the MAC client (or link 
aggregation).

• Other interface facing toward the subordinate MAC control sublayer.

The OAM sublayer provides a dedicated interface for passing OAM control information and OAM PDUs 
to and from the client.

11.14.15.2 Benefits of the Ethernet OAM

Ethernet OAM provides the following benefits:

• Competitive advantage for service providers

• Standardized mechanism to monitor the health of a link and perform diagnostics

11.14.15.3 Features of the Ethernet OAM

The Ethernet OAM protocol has the following OAM features:

• Discovery—Identifies devices in the network and their OAM capabilities. The Discovery feature 
uses periodic OAM PDUs to advertise the OAM mode, configuration, and capabilities. An optional 
phase allows the local station to accept or reject the configuration of the peer OAM entity.

• Link Monitoring—Detects and indicates link faults under a variety of conditions. It uses the event 
notification OAM PDU to notify the remote OAM device when it detects problems on the link.

• Remote Failure Indication—Allows an OAM entity to convey the failure conditions to its peer 
through specific flags in the OAM PDU.

• Remote Loopback—Ensures link quality with a remote peer during installation or troubleshooting.
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11.14.15.4 Ethernet OAM Limitations and Restrictions

The Ethernet OAM on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following 
limitations and restrictions:

• CFM, REP, link integrity, LACP, FAPS, IGMP on SVLAN and L2 1+1 protection are not supported 
with EFM.

• IEEE EFM MIB is not supported.

• EFM cannot be enabled or disabled at the card level.

• Unidirectional functionality is not supported.

• Errored Symbol Period, Rx CRC errors, Tx CRC errors are not supported.

• OAM PDUs are limited to 1 frame per second.

• Dying Gasp and critical events are not supported.

Note Dying Gasp RFI is not generated on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards. However, if 
the peer device sends a dying gasp RFI, the card detects it and raises an alarm.

11.14.15.5 Related Procedure for Ethernet OAM

For information about the supported Ethernet OAM features on the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards, see the “NTP-G285 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card 
EFM Settings” section on page 11-390.

11.14.16 Resilient Ethernet Protocol
The Resilient Ethernet Protocol (REP) is a protocol used to control network loops, handle link failures, 
and improve convergence time.

REP performs the following tasks:

• Controls a group of ports connected in a segment.

• Ensures that the segment does not create any bridging loops.

• Responds to link failures within the segment.

• Supports VLAN load balancing.

For information about interaction of REP with other protocols, see the “11.14.2 Protocol Compatibility 
list” section on page 11-62.

11.14.16.1 REP Segments

A REP segment is a chain of ports connected to each other and configured with a segment ID. Each 
segment consists of regular segment ports and two edge ports. A GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE card can have up to 2 ports that belong to the same segment, and each segment port can have 
only one external neighbor port.

A segment protects only against a single link failure. Any more failures within the segment result in loss 
of connectivity.
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11.14.16.2 Characteristics of REP Segments

REP segments have the following characteristics:

• If all the ports in the segment are operational, one port blocks traffic for each VLAN. If VLAN load 
balancing is configured, two ports in the segment control the blocked state of VLANs.

• If any port in the segment is not operational, all the other operational ports forward traffic on all 
VLANs to ensure connectivity.

• In case of a link failure, the alternate ports are immediately unblocked. When the failed link comes 
up, a logically blocked port per VLAN is selected with minimal disruption to the network.

11.14.16.3 REP Port States

Ports in REP segments take one of three roles or states: Failed, Open, or Alternate.

• A port configured as a regular segment port starts as a failed port.

• When the neighbor adjacencies are determined, the port transitions to the alternate port state, 
blocking all the VLANs on the interface. Blocked port negotiations occur and when the segment 
settles, one blocked port remains in the alternate role and all the other ports become open ports.

• When a failure occurs in a link, all the ports move to the failed state. When the alternate port receives 
the failure notification, it changes to the open state, forwarding all VLANs.

11.14.16.4 Link Adjacency

Each segment port creates an adjacency with its immediate neighbor. Link failures are detected and acted 
upon locally. If a port detects a problem with its neighbor, the port declares itself non-operational and 
REP converges to a new topology.

REP Link Status Layer (LSL) detects its neighbor port and establishes connectivity within the segment. 
All VLANs are blocked on an interface until the neighbor port is identified. After the neighbor port is 
identified, REP determines the neighbor port that must be the alternate port and the ports that must 
forward traffic.

Each port in a segment has a unique port ID. When a segment port starts, the LSL layer sends packets 
that include the segment ID and the port ID.

A segment port does not become operational if the following conditions are satisfied:

• No neighbor port has the same segment ID or more than one neighbor port has the same segment ID.

• The neighbor port does not acknowledge the local port as a peer.

11.14.16.5 Fast Reconvergence

REP runs on a physical link and not on per VLAN. Only one hello message is required for all VLANs 
that reduces the load on the protocol. 

REP Hardware Flood Layer (HFL) is a transmission mechanism that floods packets in hardware on an 
admin VLAN. HFL avoids the delay that is caused by relaying messages in software. HFL is used for 
fast reconvergence in the order of 50 to 200 milliseconds.
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11.14.16.6 VLAN Load Balancing

You must configure two edge ports in the segment for VLAN load balancing. One edge port in the REP 
segment acts as the primary edge port; the other edge port as the secondary edge port. The primary edge 
port always participates in VLAN load balancing in the segment. VLAN load balancing is achieved by 
blocking certain VLANs at a configured alternate port and all the other VLANs at the primary edge port.

11.14.16.7 REP Configuration Sequence

You must perform the following tasks in sequence to configure REP:

• Configure the REP administrative VLAN or use the default VLAN 1. The range of REP admin 
VLAN is 1 to 4093. VLAN 4094 is not allowed.

• Add ports to the segment in interface configuration mode.

• Enable REP on ports and assign a segment ID to it. REP is disabled on all ports by default. The range 
of segment ID is 1 to 1024.

• Configure two edge ports in the segment; one port as the primary edge port and the other as the 
secondary edge port.

• If you configure two ports in a segment as the primary edge port, for example, ports on different 
switches, REP selects one of the ports to serve as the primary edge port based on port priority. The 
Primary option is enabled only on edge ports.

• Configure the primary edge port to send segment topology change notifications (STCNs) and VLAN 
load balancing to another port or to other segments. STCNs and VLAN load balancing 
configurations are enabled only for edge ports.

Note A port can belong to only one segment. Only two ports can belong to the same segment. Both the ports 
must be either regular ports or edge ports. However, if the No-neighbor port is configured, one port can 
be an edge port and another port can be a regular port.

11.14.16.8 REP Supported Interfaces

REP supports the following interfaces:

• REP is supported on client (UNI) and trunk (NNI) ports.

• Enabling REP on client ports allows protection at the access or aggregation layer when the cards are 
connected to the L2 network.

• Enabling REP on trunk ports allows protection at the edge layer when the cards are connected in a 
ring.

11.14.16.9 REP Limitations and Restrictions

The REP on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards has the following limitations and 
restrictions:

• Fast re-convergence and VLAN load balancing are not supported on UNI ports in transparent mode.

• Native VLAN is not supported.

• CFM, EFM, link integrity, LACP, FAPS, and L2 1+1 protection are not supported on ports that are 
configured as part of REP segment and vice versa.
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• When a node installed with GE_XP, GE_XPE, 10GE_XP, or 10GE_XPE cards configured with REP 
or LACP is upgraded, traffic loss may occur. This traffic loss is due to reconvergence when the cards 
soft reset during the upgrade process.

• NNI ports cannot be configured as the primary edge port or blocking port at the access or 
aggregation layer.

• Only three REP segments can be configured on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

• Consider the following configuration:

More than one REP closed segment is configured on the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards and the same HFL admin VLAN is enabled on the switches.

If two different segments are configured on more than one common switch, the following 
consequences happen.

– Layer 1 loop

– Flooding of HFL packets across segments if one REP segment fails

– Segment goes down due to LSL time out even if the segment does not have faults

Hence, it is recommended not to configure two different segments on more than one common switch.

• Consider the following configuration:

– VLAN Load Balancing is configured on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards by 
specifying the VLB preempt delay.

– Primary and secondary edge ports are configured on the same switch.

– HFL or LSL is activated.

This configuration leads to high convergence time during manual premption, VLB activation, and 
deactivation (400 to 700 milliseconds).

11.14.16.10 Related Procedure for Managing the REP Settings

To manage the REP settings on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, see the 
“NTP-G287 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card REP Settings” section on 
page 11-395.

11.14.17 Related Procedures for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Cards

The following is the list of procedures and tasks related to the configuration of the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards:

• NTP-G165 Modify the GE_XP, 10GE_XP, GE_XPE, 10GE_XPE Cards Ethernet Parameters, Line 
Settings, and PM Thresholds, page 11-402

• NTP-G311 Provision the Storm Control Settings for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Cards, page 11-427

• NTP-G208 Provision SVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Card, page 11-431

• NTP-G314 Add a GE_XP or 10GE_XP Card on a FAPS Ring, page 11-445

• NTP-G75 Monitor Transponder and Muxponder Performance
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11.15 ADM-10G Card
The ADM-10G card operates on ONS 15454 SONET, ONS 15454 SDH, ONS 15454 M2, 
ONS 15454 M6, and DWDM networks to carry optical signals and Gigabit Ethernet signals over DWDM 
wavelengths for transport. The card aggregates lower bit-rate client SONET or SDH signals 
(OC-3/STM-1, OC-12/STM-4, OC-48/STM-16, or Gigabit Ethernet) onto a C-band tunable DWDM 
trunk operating at a higher OC-192/STM-64 rate. In a DWDM network, the ADM-10G card transports 
traffic over DWDM by mapping Gigabit Ethernet and SONET or SDH circuits onto the same wavelength 
with multiple protection options.

You can install and provision the ADM-10G card in a linear configuration in:

• Slots 1 to 5 and 12 to 16 in standard and high-density ONS 15454 ANSI shelves (15454-SA-ANSI 
or 15454-SA-HD), the ETSI ONS 15454 standard shelf assembly, or the ONS 15454 ETSI 
high-density shelf assembly

• Slot 2 in ONS 15454 M2 chassis

• Slots 2 to 6 in ONS 15454 M6 chassis

Caution Fan-tray assembly 15454E-CC-FTA (ETSI shelf)/15454-CC-FTA (ANSI shelf) must be installed in a 
shelf where the ADM-10G card is installed.

The card is compliant with ITU-T G.825 and ITU-T G.783 for SDH signals. It supports concatenated 
and non-concatenated AU-4 mapped STM-1, STM-4, and STM-16 signals as specified in ITU-T G.707. 
The card also complies with Section 5.6 of Telcordia GR-253-CORE and supports synchronous 
transport signal (STS) mapped OC-3, OC-12, and OC-48 signals as specified in the standard.

The client SFP and trunk XFP are compliant with interface requirements in Telcordia GR-253-CORE, 
ITU-T G.957 and/or ITU-T G.959.1, and IEEE 802.3.

11.15.1 Key Features
The ADM-10G card has the following high-level features:

• Operates with the TCC2, TCC2P, TCC3, TNC, TNCE, TSC, or TSCE.

• Interoperable with TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10EX_C, and OTU2_XP cards.

• Has built-in OC-192/STM-64 add/drop multiplexing function including client, trunk, and STS 
cross-connect.

• Supports both single-card and double-card (ADM-10G peer group) configuration.

• Supports path protection/SNCP on client and trunk ports for both single-card and double-card 
configuration. The card does not support path protection/SNCP between a client port and a trunk 
port. Path protection/SNCP is supported only between two client ports or two trunk ports.

• Supports 1+1 protection on client ports for double-card configuration only.

• Supports SONET, SDH, and Gigabit Ethernet protocols on client SFPs.

• Supports XFP DWDM trunk interface single wavelengths.

• Returns zero bit errors when a TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card switches from 
active to standby or when manual or forced protection switches occur.

• Has 16 SFP-based client interfaces (gray, colored, coarse wavelength division multiplexing 
(CWDM), and DWDM optics available).
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• Supports STM1, STM4, STM16, and Gigabit Ethernet client signals (8 Gigabit Ethernet maximum).

• Has one XFP-based trunk interface supporting E-FEC/FEC and ITU-T G.709 for double-card 
configuration.

• Has two XFP-based trunk interface supporting E-FEC/FEC and ITU-T G.709 for single-card 
configuration.

• Has two SR XFP interlink interfaces supporting redundancy connection with protection board and 
pass-through traffic for double-card configuration.

• Supports frame-mapped generic framing procedure (GFP-F) and LEX mapping for Ethernet over 
SONET or SDH.

• Can be installed or pulled from operation, in any slot, without impacting other service cards in the 
shelf.

• Supports client to client hairpinning, that is, creation of circuits between two client ports for both 
single-card and double-card configuration. See the “11.15.11 Circuit Provisioning” section on 
page 11-90 for more detailed information.

11.15.2 ADM-10G POS Encapsulation, Framing, and CRC
The ADM-10G card supports Cisco EoS LEX (LEX) and generic framing procedure framing (GFP-F) 
encapsulation on 8 POS ports corresponding to 8 GigE ports (Port 1 to Port 8) in both single-card and 
double-card (ADM-10G peer group) configuration.

You can provision framing on the ADM-10G card as either the default GFP-F or LEX framing. With 
GFP-F framing, you can configure a 32-bit cyclic redundancy check (CRC) or none (no CRC) (the 
default). LEX framing supports 16-bit or 32-bit CRC configuration. The framing type cannot be changed 
when there is a circuit on the port.

On the CTC, navigate to card view and click the Provisioning > Line> Ethernet Tab. To see the various 
parameters that can be configured on the ethernet ports, see the “CTC Display of ethernet Port 
Provisioning Status” section in the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card 
Software Feature and Configuration Guide. Parameters such as, admin state, service state, framing type, 
CRC, MTU and soak time for a port can be configured.

It is possible to create an end-to-end circuit between equipment supporting different kinds of 
encapsulation (for example, LEX on one side and GFP-F on other side). But, under such circumstances, 
traffic does not pass through, and an alarm is raised if there is a mismatch.

11.15.2.1 POS Overview

Ethernet data packets need to be framed and encapsulated into a SONET/SDH frame for transport across 
the SONET/SDH network. This framing and encapsulation process is known as packet over 
SONET/SDH (POS).

The Ethernet frame comes into the ADM-10G card on a standard Gigabit Ethernet port and is processed 
through the card’s framing mechanism and encapsulated into a POS frame. When the POS frame exits, 
the ADM-10G card is in a POS circuit, and this circuit is treated as any other SONET circuit (STS) or 
SDH circuit (VC) in the ONS node. It is cross-connected and rides the SONET/SDH signal out the port 
of an optical card and across the SONET/SDH network.

The destination of the POS circuit is a card or a device that supports the POS interface. Data packets in 
the destination card frames are removed and processed into ethernet frames. The Ethernet frames are 
then sent to a standard Ethernet port of the card and transmitted onto an Ethernet network.
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11.15.2.2 POS Framing Modes

A POS framing mode is the type of framing mechanism employed by the ADM-10G card to frame and 
encapsulate data packets into a POS signal. These data packets were originally encapsulated in Ethernet 
frames that entered the standard Gigabit Ethernet interface of the ADM-10G card. 

11.15.2.2.1 GFP-F Framing

The GFP-F framing represent standard mapped Ethernet over GFP-F according to ITU-T G.7041. GFP-F 
defines a standard-based mapping of different types of services onto SONET/SDH. GFP-F maps one 
variable length data packet onto one GFP packet. GFP-F comprises of common functions and payload 
specific functions. Common functions are those shared by all payloads. Payload-specific functions are 
different depending on the payload type. GFP-F is detailed in the ITU recommendation G.7041.

11.15.2.2.2 LEX Framing

LEX encapsulation is a HDLC frame based Cisco Proprietary protocol, where the field is set to values 
specified in Internet Engineering Task Force (IETF) RFC 1841. HDLC is one of the most popular Layer 
2 protocols. The HDLC frame uses the zero insertion/deletion process (commonly known as bit stuffing) 
to ensure that the bit pattern of the delimiter flag does not occur in the fields between flags. The HDLC 
frame is synchronous and therefore relies on the physical layer to provide a method of clocking and 
synchronizing the transmission and reception of frames. The HDLC framing mechanism is detailed in 
the IETF’s RFC 1662, “PPP in HDLC-like Framing.”

11.15.2.3 GFP Interoperability

The ADM-10G card defaults to GFP-F encapsulation that is compliant with ITU-T G.7041. This mode 
allows the card to operate with ONS 15310-CL, ONS 15310-MA, ONS 15310-MA SDH, or ONS 15454 
data cards (for example, ONS 15454 CE100T-8 or ML1000-2 cards). GFP encapsulation also allows the 
ADM-10G card to interoperate with other vendors Gigabit Ethernet interfaces that adhere to the 
ITU-T G.7041 standard. 

11.15.2.4 LEX Interoperability

The LEX encapsulation is compliant with RFC 1841. This mode allows the card to operate with 
ONS 15310-CL, ONS 15310-MA, ONS 15310-MA SDH, or ONS 15454 data cards (for example, 
G1000-4/G1K-4 cards, CE-1000-4, ONS 15454 CE100T-8 or ML1000-2 cards).

11.15.3 Faceplate and Block Diagram
Figure 11-20 shows the ADM-10G card faceplate.
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Figure 11-20 ADM-10G Card Faceplate and Block Diagram

11.15.4 Port Configuration Rules
ADM-10G card client and trunk port capacities are shown in Figure 11-21.
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Figure 11-21 ADM-10G Card Port Capacities

Port 17 acts as trunk2 or ILK1 interface based on single-card or double-card configuration.

11.15.5 Client Interfaces
The ADM-10G card uses LC optical port connectors and, as shown in Figure 11-21, supports up to 
16 SFPs that can be utilized for OC-N/STM-N traffic. Eight of the SFPs can be used for Gigabit Ethernet. 
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• Colored DWDM SFPs

– 1000Base-ZX SFP 1550 nm (ONS-SI-GE-ZX=)

– OC3/STM1 LR2 SFP 1550 nm (ONS-SI-155-L2=)

– OC48/STM16 LR2 SFP 1550 nm (ONS-SI-2G-L2=)

– OC48/STM16 SFP (ONS-SC-2G-xx.x)

Note xx.x = 28.7 to 60.6. ONS-SC-2G-28.7, ONS-SC-2G-33.4, ONS-SC-2G-41.3, 
ONS-SC-2G-49.3, and ONS-SC-2G-57.3 are supported from Release 8.5 and later.

• CWDM SFPs

– OC48/STM16/GE CWDM SFP (ONS-SC-Z3-xxxx)

• XFPs

– OC-192/STM-64/10GE XFP 1550 nm (ONS-XC-10G-I2)

11.15.6 Interlink Interfaces
Two 2R interlink interfaces, called ILK1 (Port 17) and ILK2 (Port 18), are provided for creation of 
ADM-10G peer groups in double-card configurations. In a single-card configuration, Port 17 
(OC-192/STM-64) and Port 18 (OC-192/STM-64 or OTU2 payload) must be configured as trunk 
interfaces. In a double-card configuration (ADM-10G peer group), Ports 17 and 18 must be configured 
as ILK1 and ILK2 interfaces, respectively. Physically cabling these ports between two ADM-10G cards, 
located on the same shelf, allows you to configure them as an ADM-10G peer group.The ILK ports carry 
10 Gb of traffic each.

The interlink interfaces support STM64 SR1 (ONS-XC-10G-S1=) XFP and 10GE BASE SR 
(ONS-XC-10G-SR-MM=) XFPs.

11.15.7 DWDM Trunk Interface 
The ADM-10G card supports OC-192/STM-64 signal transport and ITU-T G.709 digital wrapping 
according to the ITU-T G.709 standard.The ADM-10G card supports three trunk XFPs:

• Two DWDM trunks, and one trunk interface in a single-card configuration. 

• One DWDM trunk XFP in a double-card configuration.

The supported DWDM trunk XFPs are:

• 10G DWDM (ONS-XC-10G-xx.x=) (colored XFP)

• STM64 SR1 (ONS-XC-10G-S1=) (gray XFP)

11.15.8 Configuration Management
When using OC-48/STM-16 traffic, some contiguous port configurations, listed in Table 11-21, are 
unavailable due to hardware limitations. This limitation does not impact the Gigabit Ethernet payload.
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Note The ADM-10G card cannot be used in the same shelf with SONET or SDH cross-connect cards.

Note The total traffic rate for each trunk cannot exceed OC-192/STM-64 on each ADM-10G card, or for each 
ADM-10G peer group. 

Note Gigabit Ethernet is supported on Ports 1 through 8. Ports 9 through Port 12 support only OC-3/STM-1 
or OC-12/STM-4.

Additionally, the following guidelines apply to the ADM-10G card:

• Trunk Port 17 supports OC-192/STM-64.

• Trunk Ports 18 and 19 support OC-192/STM-64 and OTU2.

• The interlink port supports OC-192/STM-64.

• Up to six ADM-10G cards can be installed in one shelf.

• Up to 24 ADM-10G cards can be installed per network element (NE) regardless of whether the card 
is installed in one shelf or in multiple shelves.

• The card can be used in all 15454-SA-ANSI and 15454-SA-HD shelves as well as ETSI ONS 15454 
standard and high-density shelves.

• A lamp test function can be activated from CTC to ensure that all LEDs are functional. 

• The card can operate as a working protected or working non-protected card. 

• In a redundant configuration, an active card hardware or software failure triggers a switch to the 
standby card. This switch is detected within 10 ms and is completed within 50 ms. 

• ADM-10G cards support jumbo frames with MTU sizes of 64 to 9,216 bytes; the maximum is 9,216.

• After receiving a link or path failure, the ADM-10G card can shut down only the downstream 
Gigabit Ethernet port.

Note In ADM-10G cards, the Gigabit Ethernet port does not support flow control.

Table 11-21 OC-48/STM-16 Configuration Limitations

OC-48/STM-16 Port Number Ports Restricted from Optical Traffic 

OC-48/STM-16 on Port 13 No OC-N/STM-N on Port 1 through Port 3

OC-48/STM-16 on Port 14 No OC-N/STM-N on Port 4 through Port 6

OC-48/STM-16 on Port 15 No OC-N/STM-N on Port 7 through Port 9

OC-48/STM-16 on Port 16 No OC-N/STM-N on Port 10 through Port 12
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11.15.9 Security
The ADM-10G card that an SFP or XFP is plugged into implements the Cisco Standard Security Code 
Check Algorithm that keys on the vendor ID and serial number. 

If a pluggable port module (PPM) is plugged into a port on the card but fails the security code check 
because it is not a Cisco PPM, a minor NON-CISCO-PPM alarm is raised.

If a PPM with an unqualified product ID is plugged into a port on this card—that is, the PPM passes the 
security code as a Cisco PPM but it has not been qualified for use on the ADM-10G card— a minor 
UNQUAL-PPM alarm is raised.

11.15.10 Protection
The ADM-10G card supports 1+1 and SONET path protection and SDH SNCP protection architectures 
in compliance with Telcordia GR-253-CORE, Telcordia GR-1400-CORE, and ITU-T G.841 
specifications. 

11.15.10.1 Circuit Protection Schemes

The ADM-10G card supports path protection/SNCP circuits at the STS/VC4 (high order) level and can 
be configured to switch based on signal degrade calculations. The card supports path protection/SNCP 
on client and trunk ports for both single-card and double-card configuration. 

Note The ADM-10G card supports path protection/SNCP between client ports and trunk port 17. The card 
does not support path protection/SNCP between client ports and trunk ports 18 or 19. The card does not 
support path protection/SNCP between port 17 and trunk ports 18 and 19.

The card allows open-ended path protection/SNCP configurations incorporating other vendor 
equipment. In an open-ended path protection/SNCP, you can specify one source point and two possible 
endpoints (or two possible source points and one endpoint) and the legs can include other vendor 
equipment. The source and endpoints are part of the network discovered by CTC.

11.15.10.2 Port Protection Schemes

The ADM-10G card supports unidirectional and bidirectional 1+1 APS protection schemes on client 
ports for double-card configuration (ADM-10G peer group) only. 1+1 APS protection scheme is not 
supported in single-card configuration. For 1+1 optical client port protection, you can configure the 
system to use any pair of like facility interfaces that are on different cards of the ADM-10G peer group.

11.15.11 Circuit Provisioning
The ADM-10G card supports STS circuit provisioning both in single-card and double-card (ADM-10G 
peer group) configuration. The card allows you to create STS circuits between:

• Client and trunk ports

• Two trunk ports

• Two client ports (client-to-client hairpinning)
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Note Circuits between two trunk ports are called pass-through circuits. 

For an ADM-10G card in single-card configuration, if you are creating STS circuits between two client 
ports, the following limitation must be considered:

• Gigabit Ethernet to Gigabit Ethernet connections are not supported.

For an ADM-10G card that is part of an ADM-10G peer group, if you are creating STS circuits between 
two client ports or between client and trunk ports, the following limitations must be considered:

• Gigabit Ethernet to Gigabit Ethernet connections are not supported.

• Optical channel (OC) to OC, OC to Gigabit Ethernet, and Gigabit Ethernet to OC connections 
between two peer group cards are supported. Peer group connections use interlink port bandwidth, 
hence, depending on the availability/fragmentation of the interlink port bandwidth, it may not be 
possible to create an STS circuit from the Gigabit Ethernet/OC client port to the peer card trunk port. 
This is because, contiguous STSs (that is, STS-3c, STS-12c, STS-24c, and so on) must be available 
on the interlink port for circuit creation.

Note There are no limitations to create an STS circuit between two trunk ports.

The two ADM-10G cards used in a paired mode use interlink ports ILK1 (Port 17) and ILK2 (Port 18). 
A CCAT or VCAT circuit created between the peer ADM-10G cards uses the ILK1 port if the source or 
destination is Port 19. The circuits created with a single ADM-10G card uses the ILK2 port.

If the circuit is of type STS-nc (where n is an integer and can take values 3,6,9,12,18,24,36,48,96) and 
uses the ILK2 port, then the starting timeslot needs to use specific timeslots for traffic to flow. The 
timeslots can be 12m+1 for STS-12c circuits and 48m+1 (where m is an integer and can take values 
0,1,2,3...) for STS-48c circuits. The timeslots can be 3m+1 for the other STS-nc circuits.

The following example illustrates how to use the correct timeslot for an ILK2 port:

If there is no circuit on the ILK2 port and a STS-3c circuit is created, the circuit uses timeslots 1 to 3. 
An STS-12c circuit must be created on the ILK2 port later. The STS-12c circuit must have used timeslots 
4 to 15. However, the STS-12c circuit uses timeslots starting from 12m+1 (1, 13, 25, and so on) as 
defined in the above rule. Therefore, before creating the STS-12c circuit, dummy circuits must be 
created in CTC that consumes STS-9 bandwidth.

11.15.12 ADM-10G CCAT and VCAT Characteristics
The ADM-10G card supports high-order (HO) contiguous concatenation (CCAT) and HO virtual 
concatenation (VCAT) circuits on 8 GigE ports (Port 1 to Port 8) in both single-card and double-card 
(ADM-10G peer group) configuration.

To enable end-to-end connectivity in a VCAT circuit that traverses through a third-party network, you 
can use Open-Ended VCAT circuit creation.

The ADM-10G card supports flexible non-LCAS VCAT groups (VCGs). With flexible VCGs, the 
ADM-10G can perform the following operations: 

• Add or remove members from groups

• Put members into or out of service, which also adds/removes them from the group

• Add or remove cross-connect circuits from VCGs 
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Any operation on the VCG member is service effecting (for instance, adding or removing members from 
the VCG). Adding or removing cross-connect circuits is not service-affecting, if the associated members 
are not in the group 

The ADM-10G card allows independent routing and protection preferences for each member of a VCAT 
circuit. You can also control the amount of VCAT circuit capacity that is fully protected, unprotected, or 
uses Protection Channel Access (PCA) (when PCA is available). Alarms are supported on a per-member 
as well as per virtual concatenation group (VCG) basis. 

The ADM-10G card supports both automatic and manual routing for VCAT circuit, that is, all members 
are manually or automatically routed. Bidirectional VCAT circuits are symmetric, which means that the 
same number of members travel in each direction. With automatic routing, you can specify the 
constraints for individual members; with manual routing, you can select different spans for different 
members. Two types of automatic and manual routing are available for VCAT members: common fiber 
routing and split routing.

The ADM-10G card supports VCAT common fiber routing and VCAT split fiber (diverse) routing. With 
VCAT split fiber routing, each member can be routed independently through the SONET or SDH or 
DWDM network instead of having to follow the same path as required by CCAT and VCAT common 
fiber routing. This allows a more efficient use of network bandwidth, but the different path lengths and 
different delays encountered may cause slightly different arrival times for the individual members of the 
VCG. The VCAT differential delay is this relative arrival time measurement between members of a 
VCG. The maximum tolerable VCAT split fiber routing differential delay for the ADM-10G card is 
approximately 55 milliseconds. A loss of alignment alarm is generated if the maximum differential delay 
supported is exceeded. 

The differential delay compensation function is automatically enabled when you choose split fiber 
routing during the CTC circuit configuration process. CCAT and VCAT common fiber routing do not 
enable or need differential delay support. 

Caution Protection switches with switching time of less than 60 milliseconds are not guaranteed with the 
differential delay compensation function enabled. The compensation time is added to the switching time. 

Note For TL1, EXPBUFFERS parameter must be set to ON in the ENT-VCG command to enable support for 
split fiber routing. 

Available Circuit Sizes 

Table 11-22 and Table 11-23 show the circuit sizes available for the ADM-10G card.

Table 11-22 Supported SONET Circuit Sizes of ADM-10G card on ONS 15454 

CCAT VCAT High Order

STS-1 STS-1-1nV (n= 1 to 21)

STS-3c STS-3c-mv (m= 1 to 7)

STS-6c

STS-9c

STS-12c

STS-24c
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Note In ADM-10G cards, the Gigabit Ethernet port does not support flow control. When less than seven VC-4s 
are configured for the port, with the client traffic expected to be below the line rate, a burst in traffic 
beyond the supposed bandwidth leads to packet loss. It is, therefore, recommended to use an external 
flow control mechanism with less than seven VC-4s configured. Connecting a GE-XP or GE-XPE card 
between the client traffic and the ADM-10G Gigabit Ethernet interface enables such flow control.

11.15.12.1 Related Procedure for VCAT Circuit

The following is the list of procedures related to creating VCAT circuits:

• NTP-G245 Create an Automatically Routed VCAT Circuit, page 17-99

• NTP-G246 Create a Manually Routed VCAT Circuit, page 17-103

11.15.13 Intermediate Path Performance Monitoring
Intermediate path performance monitoring (IPPM) allows a node to monitor the constituent channel of 
an incoming transmission signal. You can enable IPPM for STS/VC-4s payload on OCn and Trunk ports 
of ADM-10G card. The IPPM is complaint with GR253/G.826.

Software Release 9.2 and higher enables the ADM-10G card to monitor the near-end and far-end PM 
data on individual STS/VC-4 payloads by enabling IPPM. After provisioning IPPM on the card, service 
providers can monitor large amounts of STS/VC-4 traffic through intermediate nodes, thus making 
troubleshooting and maintenance activities more efficient. IPPM occurs only on STS/VC-4 paths that 
have IPPM enabled, and TCAs are raised only for PM parameters on the selected IPPM paths.

For a CCAT circuit, you can enable IPPM only on the first STS/VC-4 of the concatenation group. For a 
VCAT circuit, you can enable IPPM independently on each member STS/VC-4 of the concatenation 
group.

11.15.13.1 Related Procedure for IPPM

To enable IPPM on the ADM-10G card, see the “NTP-G247 Enable or disable Path Performance 
Monitoring on Intermediate Nodes” section on page 17-105.

Table 11-23 Supported SDH Circuit Sizes of ADM-10G card on ONS 15454 SDH

CCAT VCAT High Order 

VC-4 VC-4-mv (m= 1 to 7)

VC-4-2c 

VC-4-3c 

VC-4-4c 

VC-4-8c 
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11.15.14 Pointer Justification Count Performance Monitoring 
Pointers are used to compensate for frequency and phase variations. Pointer justification counts indicate 
timing errors on SONET networks. When a network is out of synchronization, jitter and wander occur 
on the transported signal. Excessive wander can cause terminating equipment to slip.

Slips cause different effects in service. Voice service has intermittent audible clicks. Compressed voice 
technology has short transmission errors or dropped calls. Fax machines lose scanned lines or experience 
dropped calls. Digital video transmission has distorted pictures or frozen frames. Encryption service 
loses the encryption key, causing data to be transmitted again. 

Pointers provide a way to align the phase variations in STS and VC4 payloads. The STS payload pointer 
is located in the H1 and H2 bytes of the line overhead. Clocking differences are measured by the offset 
in bytes from the pointer to the first byte of the STS synchronous payload envelope (SPE) called the J1 
byte. Clocking differences that exceed the normal range of 0 to 782 can cause data loss. 

There are positive (PPJC) and negative (NPJC) pointer justification count parameters. PPJC is a count 
of path-detected (PPJC-PDET-P) or path-generated (PPJC-PGEN-P) positive pointer justifications. 
NPJC is a count of path-detected (NPJC-PDET-P) or path-generated (NPJC-PGEN-P) negative pointer 
justifications depending on the specific PM name. PJCDIFF is the absolute value of the difference 
between the total number of detected pointer justification counts and the total number of generated 
pointer justification counts. PJCS-PDET-P is a count of the one-second intervals containing one or more 
PPJC-PDET or NPJC-PDET. PJCS-PGEN-P is a count of the one-second intervals containing one or 
more PPJC-PGEN or NPJC-PGEN. 

A consistent pointer justification count indicates clock synchronization problems between nodes. A 
difference between the counts means that the node transmitting the original pointer justification has 
timing variations with the node detecting and transmitting this count. Positive pointer adjustments occur 
when the frame rate of the SPE is too slow in relation to the rate of the STS-1. 

You must enable PPJC and NPJC performance monitoring parameters for ADM-10Gcard. In CTC, the 
count fields for PPJC and NPJC PMs appear white and blank unless they are enabled on the card view 
Provisioning tab.

11.15.15 Performance Monitoring Parameter Definitions 
This section describes the STS and VC-4 path performance monitoring parameters that ADM-10G card 
support.

Table 11-24 lists the STS near-end path performance monitoring parameters.

Table 11-24 STS Near-end Path Performance Monitoring Parameters

Parameter Definition

CV-P Near-End STS Path Coding Violations (CV-P) is a count of BIP errors 
detected at the STS path layer (that is, using the B3 byte). Up to eight BIP 
errors can be detected per frame; each error increments the current CV-P 
second register. 

ES-P Near-End STS Path Errored Seconds (ES-P) is a count of the seconds when 
at least one STS path BIP error was detected. An AIS Path (AIS-P) defect (or 
a lower-layer, traffic-related, near-end defect) or a Loss of Pointer Path 
(LOP-P) defect can also cause an ES-P. 
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Table 11-25 gives the VC-4 near-end path performance monitoring parameters definition that ADM-10G 
card support.

SES-P Near-End STS Path Severely Errored Seconds (SES-P) is a count of the 
seconds when K (2400) or more STS path BIP errors were detected. An 
AIS-P defect (or a lower-layer, traffic-related, near-end defect) or an LOP-P 
defect can also cause an SES-P. 

UAS-P Near-End STS Path Unavailable Seconds (UAS-P) is a count of the seconds 
when the STS path was unavailable. An STS path becomes unavailable when 
ten consecutive seconds occur that qualify as SES-Ps, and continues to be 
unavailable until ten consecutive seconds occur that do not qualify as 
SES-Ps.

FC-P Near-End STS Path Failure Counts (FC-P) is a count of the number of 
near-end STS path failure events. A failure event begins when an AIS-P 
failure, an LOP-P failure, a UNEQ-P failure, or a Section Trace Identifier 
Mismatch Path (TIM-P) failure is declared. A failure event also begins if the 
STS PTE that is monitoring the path supports Three-Bit (Enhanced) Remote 
Failure Indication Path Connectivity (ERFI-P-CONN) for that path. The 
failure event ends when these failures are cleared. 

PPJC-PDET-P Positive Pointer Justification Count, STS Path Detected (PPJC-PDET-P) is a 
count of the positive pointer justifications detected on a particular path in an 
incoming SONET signal. 

PPJC-PGEN-P Positive Pointer Justification Count, STS Path Generated (PPJC-PGEN-P) is 
a count of the positive pointer justifications generated for a particular path 
to reconcile the frequency of the SPE with the local clock. 

NPJC-PDET-P Negative Pointer Justification Count, STS Path Detected (NPJC-PDET-P) is 
a count of the negative pointer justifications detected on a particular path in 
an incoming SONET signal. 

NPJC-PGEN-P Negative Pointer Justification Count, STS Path Generated (NPJC-PGEN-P) 
is a count of the negative pointer justifications generated for a particular path 
to reconcile the frequency of the SPE with the local clock. 

PJCDIFF-P Pointer Justification Count Difference, STS Path (PJCDIFF-P) is the 
absolute value of the difference between the total number of detected pointer 
justification counts and the total number of generated pointer justification 
counts. That is, PJCDiff-P is equal to (PPJC-PGEN-P - NPJC-PGEN-P) - 
(PPJC-PDET-P - NPJC-PDET-P). 

PJCS-PDET-P Pointer Justification Count Seconds, STS Path Detect (NPJCS-PDET-P) is a 
count of the one-second intervals containing one or more PPJC-PDET or 
NPJC-PDET. 

PJCS-PGEN-P Pointer Justification Count Seconds, STS Path Generate (PJCS-PGEN-P) is 
a count of the one-second intervals containing one or more PPJC-PGEN or 
NPJC-PGEN. 

Table 11-24 STS Near-end Path Performance Monitoring Parameters

Parameter Definition
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Table 11-25 VC-4 Near-end Path Performance Monitoring Parameters

Parameter Definition

HP-EB High-Order Path Errored Block (HP-EB) indicates that one or more bits are 
in error within a block. 

HP-BBE High-Order Path Background Block Error (HP-BBE) is an errored block not 
occurring as part of an SES. 

HP-ES High-Order Path Errored Second (HP-ES) is a one-second period with one 
or more errored blocks or at least one defect. 

HP-SES High-Order Path Severely Errored Seconds (HP-SES) is a one-second period 
containing 30 percent or more errored blocks or at least one defect. SES is a 
subset of ES. 

HP-UAS High-Order Path Unavailable Seconds (HP-UAS) is a count of the seconds 
when the VC path was unavailable. A high-order path becomes unavailable 
when ten consecutive seconds occur that qualify as HP-SESs, and it 
continues to be unavailable until ten consecutive seconds occur that do not 
qualify as HP-SESs. 

HP-BBER High-Order Path Background Block Error Ratio (HP-BBER) is the ratio of 
BBE to total blocks in available time during a fixed measurement interval. 
The count of total blocks excludes all blocks during SESs.

HP-ESR High-Order Path Errored Second Ratio (HP-ESR) is the ratio of errored 
seconds to total seconds in available time during a fixed measurement 
interval.

HP-SESR High-Order Path Severely Errored Second Ratio (HP-SESR) is the ratio of 
SES to total seconds in available time during a fixed measurement interval. 

HP-PPJC-PDET High-Order, Positive Pointer Justification Count, Path Detected 
(HP-PPJC-Pdet) is a count of the positive pointer justifications detected on 
a particular path on an incoming SDH signal. 

HP-NPJC-PDET High-Order, Negative Pointer Justification Count, Path Detected 
(HP-NPJC-Pdet) is a count of the negative pointer justifications detected on 
a particular path on an incoming SDH signal. 

HP-PPJC-PGEN High-Order, Positive Pointer Justification Count, Path Generated 
(HP-PPJC-Pgen) is a count of the positive pointer justifications generated for 
a particular path. 

HP-NPJC-PGEN High-Order, Negative Pointer Justification Count, Path Generated 
(HP-NPJC-Pgen) is a count of the negative pointer justifications generated 
for a particular path.

HP-PJCDIFF High-Order Path Pointer Justification Count Difference (HP-PJCDiff) is the 
absolute value of the difference between the total number of detected pointer 
justification counts and the total number of generated pointer justification 
counts. That is, HP-PJCDiff is equal to (HP-PPJC-PGen - HP-NPJC-PGen) 
- (HP-PPJC-PDet - HP-NPJC-PDet).
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11.15.16 ADM-10G Functions
The functions of the ADM-10G card are:

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-11 on page G-13

11.15.17 Related Procedures for ADM-10G Card
The following is the list of procedures and tasks related to the configuration of the ADM-10G card:

• NTP-G170 Provision the ADM-10G Card Peer Group, Ethernet Settings, Line Settings, PM 
Parameters, and Thresholds, page 11-257

• NTP-G200 Create, Delete, and Manage STS or VC Circuits for the ADM-10G Card, page 17-54

• NTP-G75 Monitor Transponder and Muxponder Performance

• NTP-G333 Add an ADM-10G card to an Existing Topology, page 11-281

11.16 OTU2_XP Card
The OTU2_XP card is a single-slot card with four ports with XFP-based multirate (OC-192/STM-64, 
10GE, 10G FC, IB_5G) Xponder for the ONS 15454 ANSI and ETSI platforms. The OTU2_XP card 
supports multiple configurations.

Table 11-26 describes the different configurations supported by the OTU2_XP card and the ports that 
must be used for these configurations.

HP-PJCS-PDET High-Order Path Pointer Justification Count Seconds (HP-PJCS-PDet) is a 
count of the one-second intervals containing one or more HP-PPJC-PDet or 
HP-NPJC-PDet. 

HP-PJCS-PGEN High-Order Path Pointer Justification Count Seconds (HP-PJCS-PGen) is a 
count of the one-second intervals containing one or more HP-PPJC-PGen or 
HP-NPJC-PGen. 

Table 11-25 VC-4 Near-end Path Performance Monitoring Parameters

Parameter Definition

Table 11-26 OTU2_XP Card Configurations and Ports

Configuration Port 1 Port 2 Port 3 Port 4

2 x 10G transponder Client port 1 Client port 2 Trunk port 1 Trunk port 2

2 x 10G standard regenerator 
(with enhanced FEC (E-FEC) 
only on one port)

Trunk port 1 Trunk port 2 Trunk port 1 Trunk port 2
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All the four ports are ITU-T G.709 compliant and support 40 channels (wavelengths) at 100-GHz 
channel spacing in the C-band (that is, the 1530.33 nm to 1561.42 nm wavelength range).

The OTU2_XP card can be installed in Slots 1 through 6 or 12 through 17. The OTU2_XP card supports 
SONET SR1, IR2, and LR2 XFPs, 10GE BASE SR, SW, LR, LW, ER, EW, and ZR XFPs, and 10G FC 
MX-SN-I and SM-LL-L XFPs.

Caution Fan-tray assembly 15454E-CC-FTA (ETSI shelf)/15454-CC-FTA (ANSI shelf) must be installed in a 
shelf where the OTU2_XP card is installed.

11.16.1 Key Features
The OTU2_XP card has the following high-level features:

• 10G transponder, regenerator, and splitter protection capability on the ONS 15454 DWDM 
platform.

• Compatible with the ONS 15454 ANSI high-density shelf assembly, the ETSI ONS 15454 shelf 
assembly, and the ETSI ONS 15454 high-density shelf assembly. Compatible with TCC2/TCC2P/ 
TCC3/TNC/TNCE/TSC/TSCE cards.

• Interoperable with TXP_MR_10E and TXP_MR_10E_C cards.

• Four port, multirate (OC-192/STM-64, 10G Ethernet WAN Phy, 10G Ethernet LAN Phy, 10G Fibre 
Channel, IB_5G) client interface. The client signals are mapped into an ITU-T G.709 OTU2 signal 
using standard ITU-T G.709 multiplexing.

• ITU-T G.709 framing with standard Reed-Soloman (RS) (255,237) FEC. Performance monitoring 
and ITU-T G.709 Optical Data Unit (ODU) synchronous mapping. Enhanced FEC (E-FEC) with 
ITU-T G.709 ODU with greater than 8 dB coding gain.

• The trunk rate remains the same irrespective of the FEC configuration. The error coding 
performance can be provisioned as follows:

– FEC—Standard ITU-T G.709.

– E-FEC—Standard ITU-T G.975.1 (subclause I.7)

• IEEE 802.3 frame format supported for 10 Gigabit Ethernet interfaces. The minimum frame size is 
64 bytes. The maximum frame size is user-provisionable.

10 GE LAN Phy to WAN Phy Client port Client port in 
transponder or 
trunk port in 
regenerator 
configuration 

Trunk port Trunk port in 
transponder or 
regenerator 
configuration

1 x 10G E-FEC regenerator 
(with E-FEC on two ports)

Not used Not used Trunk port Trunk port

1 x 10G splitter protected 
transponder

Client port Not used Trunk port 
(working)

Trunk port 
(protect)

Table 11-26 OTU2_XP Card Configurations and Ports (continued)

Configuration Port 1 Port 2 Port 3 Port 4
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• Supports fixed/no fixed stuff mapping (insertion of stuffing bytes) for 10G Ethernet LAN Phy 
signals (only in transponder configuration).

• Supports 10G Ethernet LAN Phy to 10G Ethernet WAN Phy conversion on Ports 1 (client port) and 
3 (trunk port).

• Supports 10G Ethernet LAN Phy to WAN Phy conversion using CTC and TL1. When enabled on 
the OTU2_XP card, the first Channel (Ports 1 and 3) supports LAN to WAN conversion. The second 
channel carries normal 10GE, 10G FC, and OC192/STM64 traffic. 

• The LAN Phy to WAN Phy conversion functions in accordance to WAN Interface Sublayer (WIS) 
mechanism as defined by IEEE802.3ae (IEEE Std 802.3ae-2002, Amendment to CSMA/CD).

• Default configuration is transponder, with trunk ports configured as ITU-T G.709 standard FEC.

• In transponder or regenerator configuration, if one of the ports is configured the corresponding port 
is automatically created.

• In regenerator configuration, only Ports 3 and 4 can be configured as E-FEC. Ports 1 and 2 can be 
configured only with standard FEC.

• When port pair 1-3 or 2-4 is configured as regenerator (that is, card mode is standard regenerator), 
the default configuration on Ports 3 and 4 is automatically set to standard FEC.

• When Ports 3 and 4 are configured as regenerator (that is, card mode is E-FEC regenerator), the 
default configuration on both these ports is automatically set to E-FEC.

• In a splitter-protected transponder configuration, the trunk ports (Port 3 and Port 4) are configured 
as ITU-T G.709 standard FEC or E-FEC. OCHCC circuits with different trunk wavelengths can be 
configured for the working and protect paths. The process of setting the trunk wavelengths is similar 
to the “DLP-G367 Change the 2.5G Multirate Transponder Trunk Wavelength Settings” task on 
page 11-197. OCHCC circuits having different trunk wavelengths on the working and protect paths 
can be upgraded to GMPLS circuits. 

• Supports protection through Y-cable protection scheme.

Note When enabled, the 10G Ethernet LAN Phy to WAN Phy conversion feature does not support 
Y-cable protection on the LAN to WAN interface (ports 1 and 3).

• Client ports support SONET SR1, IR2, and LR2 XFPs, 10GE BASE SR, SW, LR, LW, ER, EW, and 
ZR XFPs, and 10G FC MX-SN-I and SM-LL-L XFPs. 

• Following are the OTU2 link rates that are supported on the OTU2_XP trunk port:

– Standard G.709 (10.70923 Gbps) when the client is provisioned as “SONET” (including 10G 
Ethernet WAN PHY) (9.95328 Gbps).

– G.709 overclocked to transport 10GE as defined by ITU-T G. Sup43 Clause 7.2 (11.0491 Gbps) 
when the client is provisioned as “10G Ethernet LAN Phy” (10.3125 Gbps) with “No Fixed 
Stuff” enabled. 

– G.709 overclocked to transport 10GE as defined by ITU-T G. Sup43 Clause 7.1 (11.0957 Gbps) 
when the client is provisioned as “10G Ethernet LAN Phy” (10.3125 Gbps) with “No Fixed 
Stuff” disabled.

– G.709 proprietary overclocking mode to transport 10G FC (11.3168 Gbps) when the client is 
provisioned as “10G Fiber Channel” (10.518 Gbps).

– Proprietary rate at the trunk when the client is provisioned as IB_5G.
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• The MTU setting is used to display the ifInerrors and OverSizePkts counters on the receiving trunk 
and client port interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, 
from the client port to the trunk port and vice versa irrespective of the MTU setting.

• The OTU2_XP card configured in the Transponder or Mixed mode does not support egress Ethernet 
variables such as ifOutOctets, ifOutDiscards, ifOutMulticastPkts, and ifOutBroadcastPkts.

11.16.2 Faceplate and Block Diagram
Figure 11-22 shows the OTU2_XP card faceplate and block diagram.
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Figure 11-22 OTU2_XP Card Faceplate and Block Diagram

Note The Swan FPGA is automatically loaded when the LAN Phy to WAN Phy conversion feature is enabled 
on the OTU2_XP card. The Barile FPGA is automatically loaded when the LAN Phy to WAN Phy 
conversion feature is disabled on the OTU2_XP card. 
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11.16.3 OTU2_XP Card Interface
The OTU2_XP card is a multi-functional card that operates in different configurations, such as 
transponder, standard regenerator, E-FEC regenerator, and 10G Ethernet LAN Phy to WAN Phy 
conversion mode. The OTU2_XP card acts as a protected transponder, when the 10G Ethernet LAN Phy 
to WAN Phy is in splitter protected transponder configuration mode. 

Depending on the configuration of the OTU2_XP card, the ports act as client or trunk ports (see 
Table 11-26). This following section describes the client and trunk rates supported on the OTU2_XP 
card for different card configurations:

11.16.3.1 Client Interface

In transponder and 10G Ethernet LAN Phy to WAN Phy card configurations, Ports 1 and 2 act as client 
ports and in splitter protected transponder configuration, Port 1 acts as a client port. For these card 
configurations, the client rates supported are:

• OC-192/STM-64

• 10G Ethernet WAN Phy

• 10G Ethernet LAN Phy

• 10G Fibre Channel

• IB_5G

11.16.3.2 Trunk Interface

In transponder, 10G Ethernet LAN Phy to WAN Phy, and splitter protected transponder card 
configurations, Ports 3 and 4 act as trunk ports. For these card configurations, the trunk rates supported 
are:

• OC-192/STM-64

• 10G Ethernet WAN Phy

• 10G Ethernet LAN Phy

• 10G Fibre Channel

• OTU2 with ITU-T G.709 for OC-192 client interface

• OTU2e with ITU-T G.709 for 10G Ethernet LAN Phy client interface

• Proprietary rate at the trunk when the client is provisioned as IB_5G

In standard regenerator card configuration, all four ports act as trunk ports and in E-FEC regenerator 
configuration, Ports 3 and 4 act as the trunk ports. For these card configurations, the trunk rate supported 
is OTU2 G.709

Note The above mentioned OTU2 signal must be an OC-192/STM-64, 10G Ethernet WAN Phy, 
10G Ethernet LAN Phy, or 10G Fibre Channel signal packaged into an OTU2 G.709 frame. 
Additionally, the standard regenerator and E-FEC regenerator configuration supports an OTU2 signal 
that is OTU2 has been generated by multiplexing four ODU1 signals.
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11.16.4 Configuration Management
The OTU2_XP card supports the following configuration management parameters:

• Card Configuration—Provisionable card configuration: Transponder, Standard Regen, Enhanced 
FEC, or Mixed, or 10G Ethernet LAN Phy to WAN Phy. 

• Port Mode—Provisionable port mode when the card configuration is set as Mixed. The port mode 
can be chosen as either Transponder or Standard Regen for each port pair (1-3 and 2-4). For card 
configurations other than Mixed, CTC automatically sets the port mode depending on the selected 
card configuration. For 10G Ethernet LAN Phy to WAN Phy mode, CTC automatically selects the 
port pair (1-3) as 10G Ethernet LAN Phy to WAN Phy. Port pair (2-4) in 
10G Ethernet LAN Phy to WAN Phy mode is selected as Transponder or Standard Regen.

• Termination Mode—Provisionable termination mode when the card configuration is set as either 
Transponder or Mixed. The termination mode can be chosen as Transparent, Section, or Line. For 
Standard Regen and Enhanced FEC card configurations, CTC automatically sets the termination 
mode as Transparent. For 10G Ethernet LAN Phy to WAN Phy mode, CTC automatically selects the 
Termination Mode of port pair (1-3) as Line. You cannot provision the Termination Mode parameter. 

• AIS/Squelch—Provisionable AIS/Squelch mode configuration when the card configuration is set as 
either Transponder, Mixed, or Standard Regen. The AIS/Squelch mode configuration can be chosen 
as AIS or Squelch. For Enhanced FEC card configuration, CTC automatically sets the AIS/Squelch 
mode configuration as AIS. For 10G Ethernet LAN Phy to WAN Phy mode, the CTC automatically 
selects the AIS/Squelch of port pair (1-3) as Squelch. You cannot provision the AIS/Squelch 
parameter.

Note When AIS/Squelch is enabled in Standard Regen configuration with port pairs (1-3) and (2-4), 
Squelch is supported on ports 1 and 2 and AIS on ports 3 and 4.

Note When you choose the 10G Ethernet LAN Phy to WAN Phy conversion, the Termination mode is 
automatically set to LINE. The AIS/Squelch is set to SQUELCH and ODU Transparency is set to Cisco 
Extended Use for Ports 1 and 3.

• Regen Line Name—User-assigned text string for regeneration line name.

• ODU Transparency—Provisionable ODU overhead byte configuration, either Transparent Standard 
Use or Cisco Extended Use. See the “11.16.7 ODU Transparency” section on page 11-105 for more 
detailed information. For 10G Ethernet LAN Phy to WAN Phy mode, CTC automatically selects the 
ODU Transparency as Cisco Extended Use. You cannot provision the ODU Transparency parameter.

• Port name—User-assigned text string.

• Admin State/Service State—Administrative and service states to manage and view port status.

• ALS Mode—Provisionable ALS function.

• Reach—Provisionable optical reach distance of the port.

• Wavelength—Provisionable wavelength of the port.

• AINS Soak—Provisionable automatic in-service soak period.
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11.16.5 OTU2_XP Card Configuration Rules
The following rules apply to OTU2_XP card configurations:

• When you preprovision the card, port pairs 1-3 and 2-4 come up in the default Transponder 
configuration.

• The port pairs 1-3 and 2-4 can be configured in different modes only when the card configuration is 
Mixed. If the card configuration is Mixed, you must choose different modes on port pairs 1-3 and 
2-4 (that is, one port pair in Transponder mode and the other port pair in Standard Regen mode).

• If the card is in Transponder configuration, you can change the configuration to Standard Regen or 
Enhanced FEC.

• If the card is in Standard Regen configuration and you have configured only one port pair, then 
configuring payload rates for the other port pair automatically changes the card configuration to 
Mixed, with the new port pair in Transponder mode.

• If the card is in Standard Regen configuration, you cannot directly change the configuration to 
Enhanced FEC. You have to change to Transponder configuration and then configure the card as 
Enhanced FEC.

• If the card is in Enhanced FEC configuration, Ports 1 and 2 are disabled. Hence, you cannot directly 
change the configuration to Standard Regen or Mixed. You must remove the Enhanced FEC group 
by moving the card to Transponder configuration, provision PPM on Ports 1 and 2, and then change 
the card configuration to Standard Regen or Mixed.

• If the card is in Standard Regen or Enhanced FEC configuration, you cannot change the payload rate 
of the port pairs. You have to change the configuration to Transponder, change the payload rate, and 
then move the card configuration back to Standard Regen or Enhanced FEC.

• If any of the affected ports are in IS (ANSI) or Unlocked-enabled (ETSI) state, you cannot change 
the card configuration.

• If IB_5G payload has to be provisioned, the NE Default should match the values listed in the 
Table 11-27. For more information on editing the NE Default values, see the “NTP-G135 Edit 
Network Element Defaults” task on page 24-19.

• If the card is changed to 10G Ethernet LAN Phy to WAN Phy, the first PPM port is deleted and 
replaced by a 10G Ethernet port; the third PPM port is deleted and automatically replaced with 
OC192/STM64 (SONET/SDH) port. The third PPM port is automatically deleted and the third PPM 
port is replaced with OC192/STM64 (SONET/SDH).

Table 11-28 provides a summary of transitions allowed for the OTU2_XP card configurations.

Table 11-27 OTU2_XP Card Configuration for IB_5G Payload Provisioning

Parameter NE Default Name Value

FEC OTU2-XP.otn.otnLines.FEC Standard 

ITU-T G.709 OTN OTU2-XP.otn.otnLines.G709OTN Enable

Termination Mode OTU2-XP.config.port.TerminationMode Transparent 

ODU Transparency OTU2-XP.config.port.OduTransparency Cisco Extended Use

AIS/Squelch OTU2-XP.config.port.AisSquelchMode Squelch
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11.16.6 Security
The OTU2_XP card, when an XFP is plugged into it, implements the Cisco Standard Security Code 
Check Algorithm that keys on vendor ID and serial number. 

If a PPM is plugged into a port on the card but fails the security code check because it is not a Cisco 
PPM, a NON-CISCO-PPM Not Reported (NR) condition occurs.

If a PPM with a non-qualified product ID is plugged into a port on this card, that is, the PPM passes the 
security code as a Cisco PPM but it has not been qualified for use on the OTU2_XP card, a 
UNQUAL-PPM NR condition occurs.

11.16.7 ODU Transparency
A key feature of the OTU2_XP card is the ability to configure the ODU overhead bytes (EXP bytes and 
RES bytes 1 and 2) using the ODU Transparency parameter. The two options available for this parameter 
are:

• Transparent Standard Use—ODU overhead bytes are transparently passed through the card. This 
option allows the OTU2_XP card to act transparently between two trunk ports (when the card is 
configured in Standard Regen or Enhanced FEC).

• Cisco Extended Use—ODU overhead bytes are terminated and regenerated on both ports of the 
regenerator group.

Table 11-28 Card Configuration Transition Summary

Card 
Configuration

Transition To

Transponder Standard Regen Enhanced FEC Mixed 10G Ethernet LAN 
Phy to WAN Phy

Transponder — Yes Yes Yes Yes

Standard Regen Yes — No Yes Yes

Enhanced FEC Yes No — No No

Mixed Yes Yes No — Yes

10G Ethernet 
LAN Phy to 
WAN Phy

Yes Yes No The 10G Ethernet 
LAN Phy to WAN 
Phy to Mixed is 
supported if the 
Port pair 1-3 is 
chosen as 
Transponder.

The 10G Ethernet 
LAN Phy to WAN 
Phy to Mixed is 
not supported if 
the Port pair 1-3 
is chosen as 
Standard Regen.

—
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The ODU Transparency parameter is configurable only for Standard Regen and Enhanced FEC card 
configuration. For Transponder card configuration, this parameter defaults to Cisco Extended Use and 
cannot be changed.

Note The Forward Error Correction (FEC) Mismatch (FEC-MISM) alarm will not be raised on OTU2_XP card 
when you choose Transparent Standard Use.

11.16.8 OTU2_XP Functions
The functions of the OTU2_XP card are:

• G.2 Automatic Laser Shutdown, page G-7

• G.34.1 Y-Cable and Splitter Protection, page G-30

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-11 on page G-13

11.16.9 Related Procedures for OTU2_XP Card
The following is the list of procedures and tasks related to the configuration of the OTU2_XP card:

• NTP-G197 Provision the OTU2_XP Card Line Settings, PM Parameters, and Thresholds, 
page 11-448

• NTP-G33 Create a Y-Cable Protection Group, page 11-182

• NTP-G199 Create a Splitter Protection Group for the OTU2_XP Card, page 11-186

• NTP-G75 Monitor Transponder and Muxponder Performance

11.17 TXP_MR_10EX_C Card
The TXP_MR_10EX_C card is a multirate transponder for the ONS 15454 platform. The card is fully 
backward compatible with TXP_MR_10E_C cards (only when the error decorrelator is disabled in the 
CTC on the TXP_MR_10EX_C card). It processes one 10-Gbps signal (client side) into one 10-Gbps, 
100-GHz DWDM signal (trunk side). The TXP_MR_10EX_C card is tunable over the 82 channels of 
C-band (82 channels spaced at 50 GHz on the ITU grid).

You can install TXP_MR_10EX_C card in Slots 1 to 6 and 12 to 17. The card can be provisioned in 
linear, BLSR/MS-SPRing, path protection/SNCP configurations or as a regenerator. The card can be 
used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent 
termination mode. The TXP_MR_10EX_C card features an MLSE-based Universal Transponder 
1550-nm tunable laser and a separately orderable ONS-XC-10G-S1 1310-nm or ONS-XC-10G-L2 
1550-nm laser XFP module for the client port.

Note The PRE FEC BER performance of the TXP_MR_10EX_C card may be significantly low when 
compared to the TXP_MR_10E card. However, this does not affect the Post FEC BER performance, but 
could possibly affect any specific monitoring application that relies on the PRE FEC BER value (for 
example, protection switching). In this case, the replacement of TXP_MR_10E card with the 
TXP_MR_10EX_C may not work properly.
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Note When the ONS-XC-10G-L2 XFP is installed, the TXP_MR_10EX_C card must be installed in a 
high-speed slot (slot 6, 7, 12, or 13)

On its faceplate, the TXP_MR_10EX_C card contains two transmit and receive connector pairs, one for 
the trunk port and one for the client port. Each connector pair is labeled.

11.17.1 Key Features 
The key features of the TXP_MR_10EX_C card are:

• A multi-rate client interface (available through the ONS-XC-10G-S1 XFP, ordered separately):

– OC-192 (SR1) 

– 10GE (10GBASE-LR)

– 10G-FC (1200-SM-LL-L)

– (ONS-XC-10G-S1 version 3 only) IB_5G

• An MLSE-based UT module tunable through 82 channels of C-band. The channels are spaced at 
50 GHz on the ITU grid.

• OC-192 to ITU-T G.709 OTU2 provisionable synchronous and asynchronous mapping.

• Proprietary rate at the trunk when the client is provisioned as IB_5G.

• The MTU setting is used to display the OverSizePkts counters on the receiving trunk and client port 
interfaces. Traffic of frame sizes up to 65535 bytes pass without any packet drops, from the client 
port to the trunk port and vice versa irrespective of the MTU setting.

11.17.2 Faceplate and Block Diagram
Figure 11-23 shows the TXP_MR_10EX_C faceplate and block diagram.
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Figure 11-23 TXP_MR_10EX_C Faceplate and Block Diagram

For information about safety labels for the card, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10EX_C card in 
a loopback on the trunk port. Do not use direct fiber loopbacks with this card, because they can cause 
irreparable damage to the card.

11.17.3 TXP_MR_10EX_C Functions
The functions of the TXP_MR_10EX_C card are:

• G.5 Client Interface, page G-16

• G.7 DWDM Trunk Interface, page G-17

• G.8 FEC, page G-18

• G.9 Client-to-Trunk Mapping, page G-19

• G.2 Automatic Laser Shutdown, page G-7

• Card level indicators—Table G-1 on page G-8
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• Port level indicators—Table G-6 on page G-11.

11.17.4 Related Procedures for TXP_MR_10EX_C Card
The following is the list of procedures and tasks related to the configuration of the TXP_MR_10EX_C 
card:

• NTP-G96 Provision the 10G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 11-211

• NTP-G75 Monitor Transponder and Muxponder Performance

11.18 MXP_2.5G_10EX_C card
The MXP_2.5G_10EX_C card is a DWDM muxponder for the ONS 15454 platform that supports 
transparent termination mode on the client side. The faceplate designation of the card is “4x2.5G 
10EX MXP.” The card multiplexes four 2.5-Gbps client signals (4xOC48/STM-16 SFP) into a single 
10-Gbps DWDM optical signal on the trunk side. The card provides wavelength transmission service for 
the four incoming 2.5-Gbps client interfaces. The MXP_2.5G_10EX_C muxponder passes all 
SONET/SDH overhead bytes transparently.

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate PM.

The MXP_2.5G_10EX_C card works with OTN devices defined in ITU-T G.709. The card supports 
ODU1 to OTU2 multiplexing, an industry standard method for asynchronously mapping a SONET/SDH 
payload into a digitally wrapped envelope. See the “G.11 Multiplexing Function” section on page G-21.

The MXP_2.5G_10EX_C card is not compatible with the MXP_2.5G_10G card, which does not support 
transparent termination mode. 

You can install the MXP_2.5G_10EX_C card in slots 1 to 6 and 12 to 17. You can provision a card in a 
linear configuration, a BLSR/MS-SPRing, a path protection/SNCP, or a regenerator. The card can be 
used in the middle of BLSR/MS-SPRing or 1+1 spans when the card is configured for transparent 
termination mode.

The MXP_2.5G_10EX_C card features a tunable 1550-nm C-band laser on the trunk port. The laser is 
tunable across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. The card 
features four 1310-nm lasers on the client ports and contains five transmit and receive connector pairs 
(labeled) on the card faceplate. The card uses dual LC connectors on the trunk side and SFP modules on 
the client side for optical cable termination. The SFP pluggable modules are SR or IR and support an LC 
fiber connector.

Note When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous options. A 
4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode, which are necessary to 
provision the 4xOC-48 OCHCC circuit.

11.18.1 Key Features
The MXP_2.5G_10EX_C card has the following high-level features:
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• Four 2.5-Gbps client interfaces (OC-48/STM-16) and one 10-Gbps trunk. The four OC-48 signals 
are mapped into an ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and 
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the 
transmission range on these interfaces. The E-FEC functionality increases the correction capability 
of the transponder to improve performance, allowing operation at a lower OSNR compared to the 
standard RS (237,255) correction algorithm.

• Pluggable client-interface optic modules: The MXP_2.5G_10EX_C card has modular interfaces. 
Two types of optic modules can be plugged into the card. These modules include an OC-48/STM-16 
SR-1 interface with a 7-km (4.3-mile) nominal range (for short range and intra-office applications) 
and an IR-1 interface with a range of up to 40 km (24.9 miles). SR-1 is defined in Telcordia 
GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia GR-253-CORE and in 
S-16-1 (ITU-T G.957).

• High-level provisioning support: The card is initially provisioned using Cisco TransportPlanner 
software. Subsequently, the card can be monitored and provisioned using CTC software.

• Link monitoring and management: The card uses standard OC-48 OH (overhead) bytes to monitor 
and manage incoming interfaces. The card passes the incoming SDH/SONET data stream and its 
overhead bytes transparently. 

• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate 
regenerator section overhead, which eliminates forwarding of unneeded layer overhead. It can help 
reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_2.5G_10EX_C card normally synchronizes 
from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card. If for some reason, such as 
maintenance or upgrade activity, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE is not available, 
the card automatically synchronize to one of the input client-interface clocks.

• Configurable squelching policy: The card can be configured to squelch the client interface output if 
LOS occurs at the DWDM receiver or if a remote fault occurs. In the event of a remote fault, the 
card manages MS-AIS insertion.

• The card is tunable across the full C-band, thus eliminating the need to use different versions of each 
card to provide tunability across specific wavelengths in a band.

11.18.2 Faceplate and Block Diagram
Figure 11-24 shows the MXP_2.5G_10EX_C faceplate and block diagram. 
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Figure 11-24 MXP_2.5G_10EX_C Faceplate and Block Diagram

For information about safety labels for the card, see the “G.1.1 Class 1 Laser Product Cards” section on 
page G-2.

11.18.3 MXP_2.5G_10EX_C Functions
The functions of the MXP_2.5G_10EX_C card are:

• G.5 Client Interface, page G-16

• G.6 DWDM Interface, page G-16

• G.8 FEC, page G-18

• G.11 Multiplexing Function, page G-21

• G.10 Timing Synchronization, page G-19

• G.12 SONET/SDH Overhead Byte Processing, page G-21

• G.12 SONET/SDH Overhead Byte Processing, page G-21

• G.13 Client Interface Monitoring, page G-21

• G.2 Automatic Laser Shutdown, page G-7
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• G.14 Jitter, page G-22

• G.15 Lamp Test, page G-22

• G.16 Onboard Traffic Generation, page G-23

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-6 on page G-11

11.18.3.1 Wavelength Identification

The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU 
grid effectively. The MXP_2.5G_10EX_C card implements the MLSE-based UT module. The 
MXP_2.5G_10EX_C card uses a C-band version of the UT2.

Table 11-29 describes the required trunk transmit laser wavelengths for the MXP_2.5G_10EX_C card. 
The laser is tunable over 82 wavelengths in the C-band at 50-GHz spacing on the ITU grid.

Table 11-29 MXP_2.5G_10EX_C Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537
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11.18.4 Related Procedures for MXP_2.5G_10EX_C Card
The following is the list of procedures and tasks related to the configuration of the MXP_2.5G_10EX_C 
card:

• NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-282

• NTP-G75 Monitor Transponder and Muxponder Performance

11.19 MXP_MR_10DMEX_C Card
The MXP_MR_10DMEX_C card aggregates a mix of client SAN service-client inputs (GE, FICON, and 
Fibre Channel) into one 10-Gbps STM-64/OC-192 DWDM signal on the trunk side. It provides one 
long-reach STM-64/OC-192 port per card and is compliant with Telcordia GR-253-CORE and ITU-T 
G.957.

The card supports aggregation of the following signal types:

• 1-Gigabit Fibre Channel

• 2-Gigabit Fibre Channel

• 4-Gigabit Fibre Channel

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 11-29 MXP_2.5G_10EX_C Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
11-113
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_monitor-performance.html#task_ABA5BDBA34684C40A1F2B60AFA862C21


Chapter 11      Provision Transponder and Muxponder Cards
11.19   MXP_MR_10DMEX_C Card
• 1-Gigabit Ethernet

• 1-Gigabit ISC-Compatible (ISC-1)

• 2-Gigabit ISC-Peer (ISC-3)

Caution The card can be damaged by dropping it. Handle it carefully.

The MXP_MR_10DMEX_C muxponder passes all SONET/SDH overhead bytes transparently. 

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate PM. The 
MXP_MR_10DMEX_C card works with the OTN devices defined in ITU-T G.709. The card supports 
ODU1 to OTU2 multiplexing, an industry standard method for asynchronously mapping a SONET/SDH 
payload into a digitally wrapped envelope. See the “G.11 Multiplexing Function” section on page G-21.

Note You cannot disable ITU-T G.709 on the trunk side. If ITU-T G.709 is enabled, then FEC cannot be 
disabled.

Note Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up to 
a maximum limit of 10 Gbps.

You can install the MXP_MR_10DMEX_C card in slots 1 to 6 and 12 to 17. 

Note The MXP_MR_10DMEX_C card is not compatible with the MXP_2.5G_10G card, which does not 
support transparent termination mode.

The MXP_MR_10DMEX_C card features a tunable 1550-nm C-band laser on the trunk port. The laser 
is tunable across 82 wavelengths on the ITU grid with 50-GHz spacing between wavelengths. Each card 
features four 1310-nm lasers on the client ports and contains five transmit and receive connector pairs 
(labeled) on the card faceplate. The card uses dual LC connectors on the trunk side and SFP modules on 
the client side for optical cable termination. The SFP pluggable modules are SR or IR and support an LC 
fiber connector.

Table 11-30 shows the input data rate for each client interface, and the encapsulation method. The 
current version of the GFP-T G.7041 supports transparent mapping of 8B/10B block-coded protocols, 
including Gigabit Ethernet, Fibre Channel, ISC, and FICON.

In addition to the GFP mapping, 1-Gbps traffic on Port 1 or 2 of the high-speed SERDES is mapped to 
an STS-24c channel. If two 1-Gbps client signals are present at Port 1 and Port 2 of the high-speed 
SERDES, the Port 1 signal is mapped into the first STS-24c channel and the Port 2 signal into the second 
STS-24c channel. The two channels are then mapped into an OC-48 trunk channel.

Table 11-30 MXP_MR_10DMEX_C Client Interface Data Rates and Encapsulation

Client Interface Input Data Rate GFP-T G.7041 Encapsulation

2G FC 2.125 Gbps Yes

1G FC 1.06 Gbps Yes

2G FICON/2G ISC-Compatible (ISC-1)/ 
2G ISC-Peer (ISC-3)

2.125 Gbps Yes
11-114
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
11.19.1   Key Features
The MXP_MR_10DMEX_C card includes two FPGAs, and a group of four ports is mapped to each 
FPGA. Group 1 consists of Ports 1 through 4, and Group 2 consists of Ports 5 through 8. Table 11-31 
shows some of the mix and match possibilities on the various client data rates for Ports 1 through 4, and 
Ports 5 through 8. An X indicates that the data rate is supported in that port.

GFP-T PM is available through RMON and trunk PM is managed according to Telcordia GR-253-CORE 
and ITU G.783/826. Client PM is achieved through RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a port 
indicates the number of frames that can be sent to it (its buffer credit), before the sender is required to 
stop transmitting and wait for the receipt of a “ready” indication. The MXP_MR_10DMEX_C card 
supports FC credit-based flow control with a buffer-to-buffer credit extension of up to 1600 km (994.1 
miles) for 1G FC, up to 800 km (497.1 miles) for 2G FC, or up to 400 km (248.5 miles) for 4G FC. The 
feature can be enabled or disabled. 

The MXP_MR_10DMEX_C card features a 1550-nm laser for the trunk/line port and a 1310-nm or 
850-nm laser (depending on the SFP) for the client ports. The card contains eight 12.5-degree 
downward-tilt SFP modules for the client interfaces. For optical termination, each SFP uses two LC 
connectors, which are labeled TX and RX on the faceplate. The trunk port is a dual-LC connector with 
a 45-degree downward angle.

11.19.1 Key Features
The MXP_MR_10DMEX_C card has the following high-level features:

• Onboard E-FEC processor: The processor supports both standard RS (specified in ITU-T G.709) and 
E-FEC, which allows an improved gain on trunk interfaces with a resultant extension of the 
transmission range on these interfaces. The E-FEC functionality increases the correction capability 
of the transponder to improve performance, allowing operation at a lower OSNR compared to the 
standard RS (237,255) correction algorithm.

• Pluggable client-interface optic modules: The MXP_MR_10DMEX_C card has modular interfaces. 
Two types of optics modules can be plugged into the card. These modules include an 
OC-48/STM-16 SR-1 interface with a 7-km (4.3-mile) nominal range (for short range and 

1G FICON/1G ISC-Compatible (ISC-1)/ 
1G ISC-Peer (ISC-3)

1.06 Gbps Yes

Gigabit Ethernet 1.25 Gbps Yes

Table 11-30 MXP_MR_10DMEX_C Client Interface Data Rates and Encapsulation (continued)

Client Interface Input Data Rate GFP-T G.7041 Encapsulation

Table 11-31 Supported Client Data Rates for Ports 1 through 4 and Ports 5 through 8

Port (Group 1) Port (Group 2) Gigabit Ethernet 1G FC 2G FC 4G FC

1 5 X X X X

2 6 X X — —

3 7 X X X —

4 8 X X — —
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intra-office applications) and an IR-1 interface with a range of up to 40 km (24.9 miles). SR-1 is 
defined in Telcordia GR-253-CORE and in I-16 (ITU-T G.957). IR-1 is defined in Telcordia 
GR-253-CORE and in S-16-1 (ITU-T G.957).

• Y-cable protection: The card supports Y-cable protection between the same card type only, on ports 
with the same port number and signal rate. See the “G.34.1.1 Y-Cable Protection” section on 
page G-30 for more detailed information.

• High-level provisioning support: The card is initially provisioned using Cisco TransportPlanner 
software. Subsequently, the card can be monitored and provisioned using CTC software.

• ALS: This safety mechanism is used in the event of a fiber cut. For details regarding ALS 
provisioning for the MXP_MR_10DMEX_C card, see the “NTP-G162 Change the ALS 
Maintenance Settings” section on page 11-471.

• Link monitoring and management: The card uses standard OC-48 OH (overhead) bytes to monitor 
and manage incoming interfaces. The card passes the incoming SDH/SONET data stream and its 
OH (overhead) bytes transparently.

• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate 
regenerator section overhead, which eliminates forwarding of unneeded layer overhead. It can help 
reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_MR_10DMEX_C card normally synchronizes 
from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card. If for some reason, such as 
maintenance or upgrade activity, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE is not available, 
the card automatically synchronizes to one of the input client-interface clocks.

Note MXP_MR_10DMEX_C card cannot be used for line timing.

• Configurable squelching policy: The card can be configured to squelch the client-interface output if 
LOS occurs at the DWDM receiver or if a remote fault occurs. In the event of a remote fault, the 
card manages MS-AIS insertion.

• The card is tunable across the full C-band, thus eliminating the need to use different versions of each 
card to provide tunability across specific wavelengths in a band.

• You can provision a string (port name) for each fiber channel/FICON interface on the 
MXP_MR_10DMEX_C card, which allows the MDS Fabric Manager to create a link association 
between that SAN port and a SAN port on a Cisco MDS 9000 switch.

11.19.2 Faceplate and Block Diagram
Figure 11-25 shows the MXP_MR_10DMEX_C faceplate and block diagram.
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Figure 11-25 MXP_MR_10DMEX_C Faceplate and Block Diagram

For information about safety labels for the card, see the “G.1.2 Class 1M Laser Product Cards” section 
on page G-4.

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the card in a loopback on the 
trunk port. Do not use direct fiber loopbacks with the card, because they can cause irreparable damage 
to the MXP_MR_10DMEX_C card.

11.19.3 MXP_MR_10DMEX_C Functions
The functions of the MXP_MR_10DMEX_C card are:

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-9 on page G-12
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11.19.3.1 Wavelength Identification

The card uses trunk lasers that are wavelocked, which allows the trunk transmitter to operate on the ITU 
grid effectively. The MXP_MR_10DMEX_C card uses a C-band version of the MLSE-based UT 
module.

Table 11-32 describes the required trunk transmit laser wavelengths for the MXP_MR_10DMEX_C 
card. The laser is tunable over 82 wavelengths in the C-band at 50-GHz spacing on the ITU grid.

Table 11-32 MXP_MR_10DMEX_C Trunk Wavelengths

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 196.00 1529.55 42 193.95 1545.72

2 195.95 1529.94 43 193.90 1546.119

3 195.90 1530.334 44 193.85 1546.518

4 195.85 1530.725 45 193.80 1546.917

5 195.80 1531.116 46 193.75 1547.316

6 195.75 1531.507 47 193.70 1547.715

7 195.70 1531.898 48 193.65 1548.115

8 195.65 1532.290 49 193.60 1548.515

9 195.60 1532.681 50 193.55 1548.915

10 195.55 1533.073 51 193.50 1549.32

11 195.50 1533.47 52 193.45 1549.71

12 195.45 1533.86 53 193.40 1550.116

13 195.40 1534.250 54 193.35 1550.517

14 195.35 1534.643 55 193.30 1550.918

15 195.30 1535.036 56 193.25 1551.319

16 195.25 1535.429 57 193.20 1551.721

17 195.20 1535.822 58 193.15 1552.122

18 195.15 1536.216 59 193.10 1552.524

19 195.10 1536.609 60 193.05 1552.926

20 195.05 1537.003 61 193.00 1553.33

21 195.00 1537.40 62 192.95 1553.73

22 194.95 1537.79 63 192.90 1554.134

23 194.90 1538.186 64 192.85 1554.537

24 194.85 1538.581 65 192.80 1554.940

25 194.80 1538.976 66 192.75 1555.343

26 194.75 1539.371 67 192.70 1555.747

27 194.70 1539.766 68 192.65 1556.151

28 194.65 1540.162 69 192.60 1556.555

29 194.60 1540.557 70 192.55 1556.959
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11.19.4 Related Procedures for MXP_MR_10DMEX_C Card
The following is the list of procedures and tasks related to the configuration of the 
MXP_MR_10DMEX_C card:

• NTP-G148 Modify the 10G Data Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-321

• NTP-G75 Monitor Transponder and Muxponder Performance

11.20 AR_MXP, AR_XP, and AR_XPE Cards
The AR_MXP (Any-Rate Muxponder), AR_XP (Any-Rate Xponder), and AR_XPE (Any-Rate 
Enhanced Xponder) cards are supported on ONS 15454, ONS 15454 M2, and ONS 15454 M6 
platforms. The AR_MXP card supports a trunk bandwidth of up to 10 Gbps. The AR_XP and AR_XPE 
cards support a trunk bandwidth of up to 20 Gbps. The AR_MXP, AR_XP, and AR_XPE cards aggregate 
a mix of client SAN services (FC or FICON 1G/2G/4G/8G, ESCON and ISC3-STP 1G/2G), Ethernet 
(FE, GE, 10GE LAN), OCn (OC3/STM-1, OC12/STM-4, and OC48/STM-16), OTU (OTU1, 
OTU2e/1e), and Video (SD-SDI, HD-SDI, and 3G-SDI) into one 10 Gbps signal on the trunk side.

The cards support aggregation of the following signal types:

• SONET/SDH:

– STM-1/OC-3

– STM-4/OC-12

– STM-16/OC-48

30 194.55 1540.953 71 192.50 1557.36

31 194.50 1541.35 72 192.45 1557.77

32 194.45 1541.75 73 192.40 1558.173

33 194.40 1542.142 74 192.35 1558.578

34 194.35 1542.539 75 192.30 1558.983

35 194.30 1542.936 76 192.25 1559.389

36 194.25 1543.333 77 192.20 1559.794

37 194.20 1543.730 78 192.15 1560.200

38 194.15 1544.128 79 192.10 1560.606

39 194.10 1544.526 80 192.05 1561.013

40 194.05 1544.924 81 192.00 1561.42

41 194.00 1545.32 82 191.95 1561.83

Table 11-32 MXP_MR_10DMEX_C Trunk Wavelengths (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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• OTN:

– OTU-1

– OTU-2 (OTU1E/OTU2E)

• Ethernet:

– Fast Ethernet (FE)

– Gigabit Ethernet (GE)

• SAN:

– Enterprise Systems Connection (ESCON)

– 1 Gigabit Fiber Channel or fiber connectivity (FICON)

– 2 Gigabit Fiber Channel or FICON

– 4 Gigabit Fiber Channel or FICON

– 8 Gigabit Fiber Channel or FICON

– 1G ISC3-STP

– 2G ISC3-STP

• Video:

– SD-SDI (270 Mbps)

– HD-SDI (1.485 Gbps)

– Third-generation SDI (3G-SDI) (2.970 Gbps)

The AR_MXP, AR_XP, and AR_XPE cards pass all SONET/SDH overhead bytes transparently.

Caution The AR_MXP, AR_XP, and AR_XPE cards can be damaged if dropped. Handle it safely.

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate PM. The AR_MXP, AR_XP, and 
AR_XPE cards work with the OTN devices defined in ITU-T G.709. The client can be OTU1 with 
standard G.975 FEC or disabled FEC. The cards provide standard 4 x OTU1 to OTU2 multiplexing. The 
card is equipped with standard G.709 FEC, E-FEC I.4, E-FEC I.7 and disabled FEC. The cards support 
ODU0/ODU1 to OTU1 or OTU2 multiplexing, an industry standard method for asynchronously mapping 
a SONET/SDH payload into a digitally wrapped envelope. For more details on multiplexing, see 
“G.11 Multiplexing Function” section on page G-21.

Table 11-33 shows the input data rate for each client interface, and the encapsulation method. 

Table 11-33 AR_MXP, AR_XP, and AR_XPE Client Interface Data Rates and Encapsulation

Client Interface Input Data Rate GFP Encapsulation

OC3/ STM1 155.52 Mbps —

OC12/STM4 622.08 Mbps —

OC48/STM16 2.488 Gbps —

FE 100 Mbps GFP-F
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11.20.1 Key Features
The AR_MXP, AR_XP, and AR_XPE cards support the following key features:

• Multiple Operating Modes—The AR_MXP, AR_XP, or AR_XPE card can be configured into m
cards are equipped with pluggables for client and trunk options, and offer a large variety of conf
information about multiple operating modes, see 11.20.3 Multiple Operating Modes, page 11-1

• Operating Mode to Client Payload Mapping—Each operating mode supports a specific set of clie
Table 11-35 lists the supported payloads for each operating mode.

GE 1.125 Gbps GFP-F
GFP-T (as per G.709 mentioned in 
17.7.1.1 1000BASE-X transcoding) for 
AR_XPE card

10GE LAN 10.31 Gbps —

1GFC 1.06 Gbps GFP-T

2GFC 2.125 Gbps GFP-T

4GFC 4.25 Gbps GFP-T

8GFC 8.5 Gbps GFP-T for AR_MXP and AR_XP cards
GMP for AR_XPE card

OTU1 2.66 Gbps —

OTU2 10.7 Gbps —

ESCON 200 Mbps GFP-T

1G ISC3-STP 1.06 Gbps GFP-T

2G ISC3-STP 2.125 Gbps GFP-T

HD-SDI 1.485 Gbps GFP-F

SD-SDI 270 Mbps GFP-F

3G-SDI 2.970 Gbps GFP-F

Client Interface Input Data Rate GFP Encapsulation
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Table 11-34 AR_MXP, AR_XP, and AR_XPE Card Supported Client-Payload Mapping—SONET/SDH, Ethernet, OTU1, and FC

8G ESCO
N

Yes

No

Yes

N/A

No

No

Yes

Yes

Yes

Yes

No

No

No

No

No

 Video
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Card Mode Rate

SONET/SDH Ethernet OTU FC

OC3/
STM1

OC12/
STM4

OC48/
STM16 FE GE

10 G
E OTU1 OTU2e

FICON1G
/FC1G

FICON2G
/FC2G

FICON4G
/FC4G

FICON
/FC8G

TXP_MR LOW Yes Yes Yes Yes Yes N/A No No Yes Yes Yes No

HIGH No No No No No Yes No Yes No No No Yes

TXPP_MR LOW Yes Yes Yes Yes Yes N/A No No Yes Yes Yes No

HIGH N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A

MXP_DME HIGH No No No No Yes N/A No No Yes Yes Yes No

MXPP_DME HIGH No No No No Yes N/A No No Yes Yes Yes No

MXP_MR LOW Yes Yes No Yes Yes N/A No No Yes No No No

HIGH Yes Yes Yes Yes Yes N/A Yes No Yes Yes Yes No

MXPP_MR LOW Yes Yes No Yes Yes N/A No No Yes No No No

HIGH Yes Yes Yes Yes Yes N/A Yes No Yes Yes Yes No

MXP-4x2.5-1
0G

HIGH No No Yes No No N/A Yes No No No No No

MXPP-4x2.5-
10G

HIGH No No Yes No No N/A Yes No No No No No

MXP-VD-10G HIGH No No No No No N/A No No No No No No

RGN HIGH No No No No No N/A No Yes No No No No

LOW No No No No No N/A Yes No No No No No

Table 11-35 AR_MXP, AR_XP, and AR_XPE Card Supported Client-Payload Mapping—ISC and

ISC Video

Card Mode Rate ISC-1
ISC3_S
TP_1G

ISC3_S
TP_2G SD-SDI HD-SDI 3G-SDI

TXP_MR LOW No Yes Yes No No No

HIGH No No No No No No

TXPP_MR LOW No No N/A No No No

HIGH N/A N/A N/A N/A N/A N/A

MXP_DME HIGH No No No No No No
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• Auto Sensing—The AR_MXP, AR_XP, and AR_XPE cards support auto sensing of client payloads. 
The line card analyzes the received client signal and configures the payload on the client port 
automatically without user intervention. 

Auto sensing feature is supported on the Gigabit Ethernet, OC-3/STM-1, OC-12/STM-4, and 
OC-48/STM-16 payloads. Following operating card modes support the autosensing feature:

– TXP (low rate)

– TXPP (low rate)

– MXP_MR (low and high Rate)

– MXPP_MR (low and high rate) 

CTC supports the configuration of all the provisioning parameters supported by the autosensed 
payload. However, creation and deletion of the 

circuits are the only configurations supported on the “AUTO” payload.

• Video Multiplexing—The AR_XP and AR_XPE cards support the capability to multiplex SD-SDI, 
HD-SDI, and 3G-SDI signals over the OTU2 trunk interface allowing to maximize the wavelength 
bandwidth, maintain full transparency for uncompressed signals, and reduce latency. The video 
multiplexing of 3G-SDI signal is not supported on the AR_MXP card.

• Regenerator Mode—This mode regenerates the OTU2e or OTU1 signals with ODU transparent or 
CISCO Extended Use options. For OTU2e, FEC can be Disabled, Standard G.975, EFEC I.4 or 
EFEC I.7, and for OTU1, FEC can be Standard G.975 or Disabled.

• High Speed GCCs—The AR_MXP, AR_XP, and AR_XPE cards support the provisioning of GCC 
channel on OTN (OTU1/OTU2) enabled client and trunk ports. A maximum of five GCC channels 
on the Cisco ONS 15454 shelf and ten GCC channels on Cisco ONS 15454 M2 or 
Cisco ONS 15454 M6 shelf can be created. The high speed GCC enables you to create the GCC 
when both the NE and FE line cards are in Cisco ONS 15454 M2 or Cisco ONS 15454 M6 shelf. 
The legacy GCC on Cisco ONS 15454 shelf can be selected on one side and the Cisco ONS 15454, 
Cisco ONS 15454 M2 or Cisco ONS 15454 M6 shelf on the other side.

MXPP_DME HIGH No No No No No No

MXP_MR LOW No No No No No No

HIGH No No No Yes Yes No

MXPP_MR LOW No No No No No No

HIGH No No No Yes Yes No

MXP-4x2.5-10G HIGH No No No No No No

MXPP-4x2.5-10G HIGH No No No No No No

MXP-VD-10G HIGH No No No No No Yes

RGN HIGH No No No No No No

LOW No No No No No No

Table 11-35 AR_MXP, AR_XP, and AR_XPE Card Supported Client-Payload Mapping—ISC and Video

ISC Video

Card Mode Rate ISC-1
ISC3_S
TP_1G

ISC3_S
TP_2G SD-SDI HD-SDI 3G-SDI
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11.20.2   Faceplate and Block Diagram
• Y-cable protection—Y-cable protection between the same card type is supported only on ports with 
the same port number and signal rate. For more detailed information, see “G.34.1.1 Y-Cable 
Protection” section on page G-30.

• Splitter protection—For splitter protection, OCHCC circuits with different trunk wavelengths for 
the working and protect paths can be configured. The process of setting the trunk wavelengths is 
similar to the “DLP-G367 Change the 2.5G Multirate Transponder Trunk Wavelength Settings” task 
on page 11-197. OCHCC circuits having different trunk wavelengths on the working and protect 
paths can be upgraded to GMPLS circuits.

• SyncE Support—Customers using a packet network find it difficult to provide timing to multiple 
remote network elements (NEs) through an external time division multiplexed (TDM) circuit. The 
SyncE feature helps to overcome this problem by providing effective timing to the remote NEs 
through a packet network. SyncE leverages the physical layer of the Ethernet to transmit frequency 
to the remote sites. SyncE's functionality and accuracy resemble the SONET/SDH network because 
of its physical layer characteristic. 
The SyncE feature provides the required synchronization at the physical level. Operation messages 
maintain SyncE links and ensure that a node always derives timing from the most reliable source. 
SyncE uses the Ethernet Synchronization Message Channel (ESMC) to enable traceability of the 
best clock source to correctly define the timing source and prevent a timing loop. SyncE is not 
supported on the AR_XPE card.

• Licensing—The AR_MXP and AR_XP cards offer you an unprecedented flexibility. The cards 
support a wide range of different applications and configurations. To help you take advantage of 
such flexibility to lower capital expenditures (CapEx) on your network, Cisco provides a licensing 
model for AR_MXP and AR_XP cards. Licensing is not supported on the AR_XPE card. For more 
information on licensing, see the Cisco ONS 15454 DWDM Licensing Configuration Guide.

11.20.2 Faceplate and Block Diagram
Figure 11-26 shows the AXP_MXP, AR_XP, and AR_XPE faceplates.

The AR_MXP, AR_XP, and AR_XPE cards have eight SFP and two XFP ports. The client and trunk 
ports are either SFP (2.5 G) or XFP (10 G) based ports. 

The AR_MXP, AR_XP, or AR_XPE card can be tuned to any wavelength over the C-band by inserting 
the required DWDM SFP or XFP on client or trunk ports. For optical termination, each XFP/SFP uses 
two LC connectors, which are labeled TX and RX on the faceplate.
11-124
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
11.20.2   Faceplate and Block Diagram
Figure 11-26 AR_MXP, AR_XP, and AR_XPE Faceplates

Figure 11-27 shows the AXP_MXP, AR_XP, and AR_XPE block diagram.
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Figure 11-27 AR_MXP, AR_XP, and AR_XPE Block Diagram

For information on safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section on 
page G-4.

Caution A 15 to 20 dB fiber attenuator must be used when working with the cards in a loopback on the trunk port. 
Do not use direct fiber loopbacks with the cards. Using direct fiber loopbacks causes irreparable damage 
to the DWDM/CWDM XFP/SFPs plugged in AXP_MXP, AR_XP, or AR_XPE card.

The AR_MXP, AR_XP, and AR_XPE cards can be installed in Slot 1 to Slot 6 and Slot 12 to Slot 17 in 
the Cisco ONS 15454 chassis, the Slot 2 to Slot 7 in the Cisco ONS 15454 M6 chassis, and Slot 2 and 
Slot 3 in the Cisco ONS 15454 M2 chassis. The AR_MXP, AR_XP, and AR_XPE cards do not 
interoperate with all the existing TXP or MXP cards. The AR_MXP card allows you to configure only 
one high rate XFP port. This can be a muxponder mode where N [N= 1 to 8] client ports goes out via 1 
trunk XFP port or in a transponder mode where client and trunk are XFP ports. There is no limitation in 
the AR_XP and AR_XPE cards, where you can use both high rate trunk ports simultaneously.

The AR_XPE card does not interoperate with AR_MXP and AR_XP cards.
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11.20.3 Multiple Operating Modes
A single AR_MXP, AR_XP, or AR_XPE card can be configured into multiple operating modes. Criteria 
for selecting a particular operational mode are defined by the network level design. CTP helps you to 
choose the appropriate operational mode. Each operating mode is divided into two categories based on 
the trunk rate:

– Low rate (trunk rate < 5G)

– High rate (trunk rate > 5G) 

The AR_XP or AR_XPE card allows you to configure two high rate operational modes, where as you 
can configure only one high rate operational mode on the AR_MXP card.

When you configure the AR_MXP, AR_XP, or AR_XPE card in to multiple operational modes, make 
sure that the following tasks are completed:

• In order to make the ports operational and to correctly report alarms, OCHCC circuit must be created 
for the following operating modes:

– Low-rate MXP_MR

– High-rate MXP_MR 

– Low-rate MXPP_MR 

– High-rate MXPP_MR 

• Same operational mode is configured at both ends and ensure the port numbers are same on both 
ends.

• The OCHCC circuit should be created between the same client port numbers at the near and far end.

• Ensure ODU1 and timeslots are matching at both ends.

• For AR_XPE card that is configured with 1GE or 1GFC payload, ensure that ODU0 and ODU1 are 
matching at both ends.

• For auto sensing payloads created on auto ports, you should check the Auto Sensing checkbox in the 
provisioning pane.

• GMPLS circuits can be created on AR_MXP, AR_XP, and AR_XPE cards.

• PPMs must be provisioned on all ports before configuring the operational mode.

• The following conditions determine the maximum bandwidth at the client side when a 4GFC 
payload is configured in the TXP_MR or TXPP_MR mode:

– The maximum client bandwidth should not exceed 28G when TXP_MR or TXPP_MR operating 
mode is configured on the AR_MXP, AR_XP, or AR_XPE card and other operating modes, like 
low-rate or high-rate TXP_MR,TXPP_MR, MXP_DME, MXPP_DME, MXP_MR, 
MXPP_MR, MXP-4X2.5G-10G, MXPP-4X2.5G-10G, and MXP-VDC-10G, are configured on 
the same card.

– The maximum client bandwidth should not exceed 20G when a TXP_MR or TXPP_MR 
operating mode is configured on the AR_MXP, AR_XP, or AR_XPE card and if more than two 
or more combinations of Low-rate or high-rate TXP_MR,TXPP_MR, MXP_DME, 
MXPP_DME, MXP_MR, MXPP_MR, MXP-4X2.5G-10G, MXPP-4X2.5G-10G, and 
MXP-VDC-10G, operating modes are configured on the same card.

– The utilized client bandwidth is 8G when the TXP_MR operating mode is configured with a 
4GFC as payload.

– The utilized client bandwidth is 12G when the TXPP_MR operating mode is configured with a 
4GFC as payload.
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– There is no restriction on the bandwidth if only TXP_MR or TXPP_MR operating mode with 
4GFC payload is configured on the card. For example, four instances of TXP_MR mode with 
4GFC payload on one AR_MPX, AR_XP, or AR_XPE card.

– The low-rate or high-rate RGN operating mode does not add to the client side bandwidth. For 
example, four instances of TXP_MR mode with 4GFC and one instance of high-rate RGN mode 
on same card.

For all the other payloads and operating modes, the client bandwidth utilized is the client 
payload data rate.

• If you revert to a release earlier than Release 9.60, ensure that you delete the following card modes:

– Low-rate TXPP_MR if the client payload is 4GFC.

– High-rate TXP_MR if the client payload is 10 GE.

The AR_MXP, AR_XP, and AR_XPE cards support the following operating modes:

• TXP_MR (Unprotected Transponder), page 11-128

• TXPP_MR (Protected Transponder), page 11-130

• MXP_DME (Unprotected Data Muxponder), page 11-130

• MXPP_DME (Protected Data Muxponder), page 11-131

• MXP_MR (Unprotected Multirate Muxponder), page 11-132

• MXPP_MR (Protected Multirate Muxponder), page 11-134

• MXP-4x2.5-10G (OC48/OTU1 Unprotected Muxponder), page 11-136

• MXPP-4x2.5-10G (OC48/OTU1 Protected Muxponder), page 11-137

• RGN (OTU1/OTU2 Regenerator), page 11-137

• MXP-VD-10G (Video Muxponder), page 11-139

TXP_MR (Unprotected Transponder)

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or a high-rate TXP_MR card 
mode.

Note OTN cannot be enabled for 4GFC trunk ports.

• Low Rate—A maximum of four TXP_MR configurations can be provisioned on a single AR_MXP, 
AR_XP, or AR_XPE card (Figure 11-28). The AR_MXP, AR_XP, or AR_XPE card can be 
configured as a low-rate TXP_MR card by adhering to the following provisioning rules:

1. Two SFP ports must be grouped. The allowed port pairs are 1-2, 3-4, 5-6, 7-8, 1-5, 2-6, 3-7, 
and/or 4-8. 

2. Ports 2, 4, 5, 6, 7, or 8 can be configured as trunk ports.

3. Ports 1, 2, 3, 4, 5 or 7 can be configured as client ports.

Note The trunk port is not created when the low-rate TXP_MR card operating mode is configured. It is created 
after the client payload is created.
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Figure 11-28 Low-Rate TXP_MR Card Operating Mode Configuration

• High Rate—Only one TXP_MR configuration can be provisioned on a single AR_MXP, AR_XP, or 
AR_XPE card (Figure 11-29). The AR_MXP, AR_XP, or AR_XPE card can be configured as a 
high-rate TXP_MR card by adhering to the following provisioning rules:

1. XFP ports 9 and 10 must be grouped.

2. Port 10 must be configured as a trunk port.

3. Port 9 must be configured as a client port.

Figure 11-29 High-Rate TXP_MR Card Operating Mode Configuration
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TXPP_MR (Protected Transponder)

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate TXPP_MR card mode. A 
maximum of two TXPP_MR configurations can be provisioned on a single AR_MXP, AR_XP, or 
AR_XPE card (Figure 11-30). The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate 
TXPP_MR card by adhering to the following provisioning rules:

1. Three SFP ports must be grouped. The allowed port pairs are 1-5-6 or 2-7-8, or both.

2. Ports 5 and 6, and 7 and 8 must be configured as trunk ports, where 6 and 8 are the protect trunk 
ports for 5 and 6 respectively.

3. Ports 1 and 2 must be configured as client ports.

Splitter protection is automatically created between ports 5-6 and 7-8.

Figure 11-30 Low-Rate TXPP_MR Card Operating Mode Configuration

MXP_DME (Unprotected Data Muxponder)

The AR_XP or AR_XPE card can be configured as a high-rate 4:1 or 8:1 MXP_DME card mode. The 
AR_MXP card can be configured as a high rate 8:1 MXP_DME card mode.

• 4:1 MXP_DME mode—A maximum of two MXP_DME configurations can be provisioned on a 
single AR_XP or AR_XPE card (Figure 11-31). The AR_XP or AR_XPE card can be configured as 
a high-rate 4:1 MXP_DME card by adhering to the following provisioning rules:

1. Four SFP ports and one XFP port must be grouped. The allowed port pairs are 1-2-3-4-9 or 
5-6-7-8-10, or both.

2. Port 9 or 10 must be configured as a trunk port. 

3. Ports 1, 2, 3, and 4, or 5, 6, 7, and 8 must be configured as client ports.
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• 8:1 MXP_DME mode—Only one MXP_DME configuration can be provisioned on a single 
AR_MXP, AR_XP, or AR_XPE card (Figure 11-31). The AR_MXP, AR_XP, AR_XPE card can be 
configured as a high-rate 8:1 MXP_DME card by adhering to the following provisioning rules:

1. Eight SFP ports and one XFP port must be grouped. The allowed port pairs are 
1-2-3-4-5-6-7-8-9. 

2. Port 9 must be configured as a trunk port.

3. Ports 1 to 8 must be configured as client ports.

Figure 11-31 High-Rate MXP_DME Card Operating Mode Configuration

MXPP_DME (Protected Data Muxponder)

The AR_XP or AR_XPE card can be configured as a high-rate 4:2 or 8:2 MXPP_DME card mode.

• 4:2 MXP_DME mode—Only one MXPP_DME configuration can be provisioned on a single 
AR_XP or AR_XPE card (Figure 11-32). The AR_XP or AR_XPE card can be configured as a 
high-rate 4:2 MXPP_DME card by adhering to the following provisioning rules:

1. Four SFP ports and two XFP ports must be grouped. The allowed port pairs are 1-2-3-4-9-10 or 
5-6-7-8-9-10. 

2. Ports 9 and 10 must be configured as trunk ports.

3. Ports 1, 2, 3, and 4, or 5, 6, 7, and 8 must be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk 
port for port 9. 

• 8:2 MXPP_DME mode—Only one MXPP_DME configuration can be provisioned on a single 
AR_XP or AR_XPE card (Figure 11-32). The AR_XP or AR_XPE card can be configured as a 
high-rate 8:2 MXPP_DME card by adhering to the following provisioning rules:

1. Eight SFP ports and two XFP ports must be grouped. The allowed port pairs are 
1-2-3-4-5-6-7-8-9-10.

2. Ports 9 and 10 must be configured as trunk ports.

3. Ports 1 to 8 must be configured as client ports.
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Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk 
port for port 9.

Figure 11-32 High-Rate MXPP_DME Card Operating Mode Configuration

MXP_MR (Unprotected Multirate Muxponder) 

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or a high-rate MXP_MR card 
mode.

• Low Rate—A maximum of two MXP_MR configurations can be provisioned depending on the 
availability of client ports (Figure 11-33). The AR_MXP, AR_XP, or AR_XPE card can be 
configured as a low-rate MXP_MR card by adhering to the following provisioning rules:

1. N:1 muxponder must be created, where N varies from client ports 2 to 7.

2. Only ports 5, 6, 7, or 8 can be configured as trunk ports.

3. Ports 1 to 8 can be configured as client ports, if they are not configured as trunk ports.

Any client port can be added or deleted, if the trunk bandwidth supports the new payload without 
impacting the traffic on the existing services. Minimum of two client ports should be part of the 
operational mode group.

On the AR_XPE card, 1GE or 1G FC payload cannot be configured with other payloads. When a 1GE 
or 1GFC payload is configured on a port of MXP_MR (low rate) mode, then only 1GE or 1GFC payload 
can be configured on the other ports.
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Figure 11-33 Low-Rate MXP_MR Card Operating Mode Configuration

• High Rate—A maximum of two MXP_MR configurations can be provisioned on a AR_XP or 
AR_XPE card and only one such configuration can be provisioned on an AR_MXP card 
(Figure 11-34). The AR_MXP, AR_XP, or AR_XPE card can be configured as a high-rate MXP_MR 
card by adhering to the following provisioning rules:

1. N:1 muxponder must be created, where N varies from client ports 2 to 8.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1 to 8 can be configured as client ports.

Any client payload can be added or deleted, if the trunk bandwidth supports the new payload without 
impacting the traffic on the existing services.

On the AR_XPE card, when you create a OCHCC circuit using 1GE or 1GFC payload, only ODU0 
mapping is supported and timeslot mapping is not supported. When a OCHCC circuit is created on a 
particular ODU1 timeslot with payloads using timeslot mapping, OCHCC circuits cannot be created on 
payloads using ODU0 mapping, but can be created on the other ODU1 timeslot. In MXP_MR (high-rate) 
mode, while creating a OCHCC circuits on the GE or 1GFC client payload, you can select the ODU1 
and ODU0 timeslots instead of ODU1 and timeslot selection. 
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Figure 11-34 High-Rate MXP_MR Card Operating Mode Configuration

MXPP_MR (Protected Multirate Muxponder) 

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or a high-rate MXPP_MR card 
mode.

• Low Rate—A maximum of two MXPP_MR configurations can be provisioned depending on the 
availability of client ports (Figure 11-35). Any client payload can be added or deleted, if the trunk 
bandwidth supports the new payload without impacting the traffic on the existing services.

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate MXPP_MR card by adhering 
to the following provisioning rules:

1. N:2 muxponder must be created, where N varies from client ports 2 to 6. 

2. Only ports 5 and 6 or 7 and 8, or both can be configured as trunk port.

3. Ports 1 to 8 can be configured as client ports, if ports are not configured as a trunk ports and are 
not part of another muxponder.

Splitter protection is automatically created between ports 5 and 6 or 7 and 8.

On the AR_XPE card, 1GE or 1G FC payload cannot be configured with other payloads. When a 1GE 
or 1GFC payload is configured on a port of MXPP_MR (low rate) mode, then only 1GE or 1GFC payload 
can be configured on the other ports.
11-134
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
11.20.3   Multiple Operating Modes
Figure 11-35 Low-Rate MXPP_MR Card Operating Mode Configuration

• High Rate—A maximum of one MXPP_MR configuration can be provisioned on a AR_XP or 
AR_XPE card (Figure 11-36). Any client payload can be added or deleted, if the trunk bandwidth 
supports the new payload without impacting the traffic on the existing services.

The AR_XP or AR_XPE card can be configured as a high-rate MXPP_MR card by adhering to the 
following provisioning rules:

1. N:2 muxponder must be created, where N varies from client ports 2 to 8.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1 to 8 can be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk 
port for port 9.

On the AR_XPE card, when you create a OCHCC circuit using 1GE or 1GFC payload, only ODU0 
mapping is supported and timeslot mapping is not supported. When a OCHCC circuit is created on a 
particular ODU1 timeslot with payloads using timeslot mapping, OCHCC circuits cannot be created on 
payloads using ODU0 mapping, but can be created on the other ODU1 timeslot. 
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Figure 11-36 High-Rate MXPP_MR Card Operating Mode Configuration

MXP-4x2.5-10G (OC48/OTU1 Unprotected Muxponder)

The AR_MXP, AR_XP, or AR_XPE card can be configured as a high-rate MXP-4x2.5-10G card mode. 
Only one MXP-4x2.5-10G configuration can be provisioned on an AR_MXP card and a maximum of 
two on a AR_XP or AR_XPE card (Figure 11-37).

The AR_MXP, AR_XP, or AR_XPE card can be provisioned as MXP-4x2.5-10G card by adhering to the 
following provisioning rules:

1. The allowed port pairs are 1-2-3-4-9 or 5-6-7-8-10, or both. 

2. Ports 9 and 10 can be configured as trunk ports.

3. Ports 1-2-3-4 or 5-6-7-8 can be configured as client ports.

Figure 11-37 High-Rate MXP-4x2.5-10G Card Operating Mode Configuration
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MXPP-4x2.5-10G (OC48/OTU1 Protected Muxponder)

The AR_XP or AR_XPE card can be configured as a high-rate MXPP-4x2.5-10G card mode. Only one 
MXPP-4x2.5-10G configuration can be provisioned on a AR_XP or AR_XPE card (Figure 11-38).

The AR_XP or AR_XPE card can be configured as MXPP-4x2.5-10G card by adhering to the following 
provisioning rules:

1. Four SFP ports and two XFP ports must be configured. The allowed port pair is 1-2-3-4-9-10 or 
5-6-7-8-9-10, or both.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1-2-3-4 or 5-6-7-8 can be configured as client ports.

Splitter protection is automatically created between ports 9 and 10. Port 10 will be the protected trunk 
port for port 9. 

Figure 11-38 High-Rate MXPP-4x2.5-10G Card Operating Mode Configuration

RGN (OTU1/OTU2 Regenerator) 

The AR_MXP, AR_XP, or AR_XPE card can be configured as a low-rate or high-rate RGN card mode.
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• Low Rate—A maximum of four RGN configurations can be provisioned on a single AR_MXP, 
AR_XP, or AR_XPE card (Figure 11-39). The AR_MXP, AR_XP, or AR_XPE card can be 
configured as a low-rate RGN card by adhering to the following provisioning rules:

1. The allowed port pairs are 1-2, 3-4, 5-6, 7-8 or 1-5, 2-6, 3-7, 4-8.

Figure 11-39 Low-Rate RGN Card Operating Mode Configuration

• High Rate—Only one RGN configuration can be provisioned on a AR_MXP, AR_XP, or AR_XPE 
card (Figure 11-40). The AR_MXP, AR_XP, or AR_XPE card can be configured as a high rate RGN 
card by adhering to the following provisioning rules:

1. The allowed port pairs are 9-10.

Figure 11-40 High-Rate RGN Card Operating Mode Configuration

The 10 GE over OTU2e/OTU1e signal with disabled FEC, standard FEC, I.4 or I.7 EFEC mode can be 
regenerated. The ODU transparency can either be Transparent Standard Use or Cisco Extended Use.

Note Payload PMs are not supported in this operating mode.
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MXP-VD-10G (Video Muxponder) 

The AR_XP or AR_XPE card can be configured as a high-rate MXP-VD-10G card mode. A maximum 
of two MXP-VD-10G configurations can be provisioned on a AR_XP or AR_XPE card (Figure 11-41).

The AR_XP or AR_XPE card can be configured as MXP-VD-10G card by adhering to the following 
provisioning rules:

1. The allowed port pairs are 1-2-3-9 or 5-6-7-10.

2. Only ports 9 and 10 can be configured as trunk ports.

3. Ports 1-2-3 and 5-6-7 can be configured as client ports.

Figure 11-41 High-Rate MXP-VD-10G Card Operating Mode Configuration

11.20.4 Scenarios of Different Operational mode Configurations on a AR_MXP, 
AR_XP, or AR_XPE Card

The following section provides a few sample scenarios of different operational modes that can be 
configured on an AR_MXP, AR_XP, or AR_XPE card:

Scenario 1

In this example (Figure 11-43), the following three operational modes are configured on the AR_MXP 
card:

• Low-rate TXP_MR (Cl=1;Tr=5)

• Low-rate MXP_MR (Cl=3,4;Tr=7)

• High-rate 3:1 MXP_MR (Cl=2,6,8;Tr=9)
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Figure 11-42 Scenario 1

Scenario 2

In this example (Figure 11-43), the following four operational modes are configured on the AR_XP or 
AR_XPE card:

• Low-rate TXP_MR (Cl=1;Tr=2)

• 8G FC TXP (Cl=9;Tr=10)

• Low-rate MR_MXP (Cl=4;TR=7,8)

• Low-rate MR_MXP (Cl=3,6;TR=5)
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Figure 11-43 Scenario 2

Scenario 3

In this example (Figure 11-44), the following two operational modes are configured on the AR_XP card:

• High-rate MXP-4x2.5-10G (Cl=1,2,3,4;Tr=9)

• High-rate 4:1 MXP_DME (Cl=5,6,7,8;Tr=10)

Figure 11-44 Scenario 3
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Scenario 4

In this example (Figure 11-45), the following three operational modes are configured on the AR_XP or 
AR_XPE card:

• Low-rate MXP_MR (Cl=1,2,3;Tr=5)

• Low-rate MXP_MR (Cl=4,6,8; Tr=7)

• RGN(Cl=9;Tr=10)

Figure 11-45 Scenario 4

Scenario 5

In this example (Figure 11-46), the following two operational modes are configured on the AR_XP or 
AR_XPE card:

• Low-rate MXPP_MR (Cl=1,3,4;Tr=5,6)

• High-rate MXPP_MR (Cl=2,7,8;Tr=9,10)
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Figure 11-46 Scenario 5

11.20.5 AR_MXP, AR_XP, and AR_XPE Functions and Features
The AR_MXP, AR_XP, and AR_XPE cards have the following functions and features:

• Client Interface—G.5 Client Interface, page G-16

• DWDM Interface—G.6 DWDM Interface, page G-16

• DWDM Trunk Interface—G.7 DWDM Trunk Interface, page G-17

• FEC Feature—G.8 FEC, page G-18

• Timing Synchronization—G.10 Timing Synchronization, page G-19

• Y-Cable Protection—G.34.1.1 Y-Cable Protection, page G-30

• Jitter Considerations—G.36 Jitter Considerations, page G-36

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-9 on page G-12
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11.20.6 Related Procedures for AR_MXP, AR_XP, and AR_XPE Cards
The following is the list of procedures and tasks related to the configuration of the AR_MXP, AR_XP, 
and AR_XPE cards:

• “NTP-G321 Provision Multiple Operating Modes on AR_MXP, AR_XP, or AR_XPE Cards” section 
on page 11-480.

• “NTP-G322 Modify the AR_MXP, AR_XP, or AR_XPE Card Line Settings and PM Parameter 
Thresholds” section on page 11-481.

• NTP-G75 Monitor Transponder and Muxponder Performance

11.21 100G-LC-C,10x10G-LC, and CFP-LC Cards

11.21.1 100G-LC-C Card
The 100G-LC-C card is a tunable DWDM trunk card, which simplifies the integration and transport of 
100 Gigabit Ethernet and OTU-4 interfaces and services into enterprises or service provider optical 
networks. The 100G-LC-C card is supported on Cisco ONS 15454 M2 and Cisco ONS 15454 M6 
platforms.

The 100G-LC-C card transports 100 Gigabit Ethernet LAN-PHY and Optical Transport Network (OTN) 
Optical Transport Unit Level 4 (OTU4) over a 50-GHz spaced, 50-GHz stabilized, ITU-compliant 
wavelength. The card has a pluggable client interface that is used to provide transponder capabilities, 
mapping the client signal to a single DWDM line interface. The client port supports a standard CXP 
format pluggable compliant with 100G-BASE-SR10 LAN PHY or OTU4 equivalent interface. 

The card is tunable on 96 wavelength channels spaced at 50-GHz over the entire C-band. The card 
provides advanced capabilities necessary to deliver 100-Gbps services, which includes protocol 
transparency, wavelength tunability, flow-through timing, management and performance monitoring 
capabilities.

The digital wrapper function (ITU-T G.709-compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate performance monitoring. The 
100G-LC-C card works with the OTN devices defined in ITU-T G.709.

The trunk ports on the 100G-LC-C card support the Ultra Forward Error Correction (UFEC) standard 
G.975.1 (sub-clause I.7) with 20% overhead. The UFEC provides an estimated gain between 0.5 dB to 
1 dB for each span on the trunk interfaces with a resultant extension of the transmission range on these 
interfaces. The UFEC leverages on two orthogonally concatenated block code (BCH) algorithm super 
FEC codes. The constructed code is iteratively decoded to rebuild the original frame.

11.21.1.1 Benefits

The 100G-LC-C card provide the following benefits:

• Provides 100 Gbps wavelengths transport over fully uncompensated networks, with more than 2,500 
km of unregenerated optical links.

• Enables 100-Gbps transport over very high Polarization Mode Dispersion (PMD).

• Improves overall system density of up to 100 Gbps per slot, which is five times greater than what 
can be achieved with 40 Gbps units.
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• Provides a 100 G DWDM trunk interface that supports up to 70000 ps/nm of CD robustness.

• Enables configuration of the CD dispersion tolerance to 50000 ps/nm and 30000 ps/nm to reduce 
power consumption.

The card supports the following client signal types:

• 100 Gigabit Ethernet and OTU4 

• OTU4 from BP OTL4.10 (interconnect with 100G-LC-C and CFP client)

• 100 Gigabit Ethernet from BP CAUI (interconnect with CFP client)

• 3 x OTU3e(255/227) from BP OTL3.4 (interconnect with 10 x10G client)

• 2 x OTU3 from BP OTL3.4 (interconnect with CFP client)

• 2 x 40 Gigabit Ethernet from BP XLAUI (interconnect with CFP client)

11.21.1.2 Key Features

The key features of 100G-LC-C card are listed in the “11.21.3.5 Key Features of 100G-LC-C, 
10x10G-LC, and CFP-LC Cards” section on page 11-158.

11.21.1.3 Faceplate

Figure 11-47 shows the 100G-LC-C faceplate.
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Figure 11-47 100G-LC-C Faceplate
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11.21.1.4 100G-LC-C Block Diagram

For information on safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section on 
page G-4.

Caution A 20-dB fiber attenuator (15 to 25 dB) must be used when working with the cards in a loopback, on the 
trunk port. Do not use direct fiber loopbacks with the cards because it causes irreparable damage to the 
100G-LC-C card.

The 100G-LC-C card is a single-slot card and can be installed in Slot 2 to Slot 7 in the 
Cisco ONS 15454 M6 chassis and Slot 2 and Slot 3 in the Cisco ONS 15454 M2 chassis. The card has 
one DWDM port and one CXP port. 

The 100G-LC-C card interoperates with 10x10G-LC and CFP-LC cards through an ONS 15454 M6 or 
ONS 15454 M2 backplane.

Up to six 100G-LC-C cards can be installed per ONS 15454 M6 shelf assembly, supporting up to 42 
100-Gbps interfaces per 42-rack units (RU) bay frame. It is possible to place up to two 100 G TXPs, one 
100 G Regen, or one 100 G MXP in an ONS 15454 M2 shelf.

Note The fan-tray assembly 15454-M6-FTA2 (for the M6 chassis) or 15454-M2-FTA2 (for the M2 chassis) 
must be installed in the shelf where a 100G-LC-C card is installed. When an ONS-SC+-10G-C pluggable 
is used along with the 10x10G-LC card, the maximum operating temperature of the shelf must not 
exceed 50 degrees Celsius. 
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11.21.1.5 Operating Modes for 100G-LC-C Card

The 100G-LC-C card supports the following operating modes:

• TXP-100G (Standalone 100GE Transponder)

• RGN-100G (100G Regenerator)

Each operating mode can be configured using the specific set of cards and client payloads. Table 11-37 
describes how each mode can be configured, the supported payloads, and the valid port pair for a specific 
operating mode.

11.21.1.5.1 TXP-100G (Standalone 100GE Transponder)

The 100G-LC-C card can be configured as a standalone 100 Gigabit Ethernet transponder. The 
100 Gigabit Ethernet traffic is supported on the CXP and coherent optical trunk. The 100 Gigabit 
Ethernet or OTU4 payload traffic is routed from the CXP to the optical trunk, passing through the T100 
framer and vice versa.

The supported client signals in this mode are 100 Gigabit Ethernet LAN-PHY or OTU4 data rates.

11.21.1.5.2 RGN-100G (100G Regenerator)

The 100G-LC-C card can be configured as a regenerator. Two 100G-LC-C cards can be connected to 
work in a back-to-back mode connecting through the Cisco ONS 15454 M6 or Cisco ONS 15454 M2 
backplane in the same shelf. The allowed port pairs are 2-3, 4-5, or 6-7.

The client signals supported are 100 Gigabit Ethernet or OTU4. Regeneration is performed leveraging 
on the OTU4 backplane interconnection supported by the Cisco ONS 15454 M6 or 
Cisco ONS 15454 M2 chassis; OTU4 overhead is terminated, allowing ODU4 to transparently pass 
through. GCC0 is terminated, while GCC1 and GCC2 are allowed to pass through.

The CXP client is not required because communication between the two cards acting as a regeneration 
group is supported through the chassis backplane.

11.21.2 10x10G-LC Card
The 10x10G-LC card is a DWDM client card, which simplifies the integration and transport of 
10 Gigabit Ethernet interfaces and services into enterprises or service provider optical networks. The 
10x10G-LC card is supported on ONS 15454 M2 and ONS 15454 M6 platforms. The 10x10G-LC card 
provide 10 Gbps services to support 10x10G-LC card.

The 10x10G-LC card supports the following signal types:

• OC-192/STM-64 (9.95328 Gbps)

• 10 Gigabit Ethernet LAN PHY (10.3125 Gbps)

• 10 G FC (10.518 Gbps)

• 8 G FC

• OTU-2

• G.709 overclocked to transport 10 Gigabit Ethernet as defined by ITU-T G. Sup43 Clause 7.1 
(11.0957 Gbps)
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The digital wrapper function (ITU-T G.709-compliant) formats the DWDM wavelength so that it can be 
used to set up GCCs for data communications, enable FEC, or facilitate performance monitoring. The 
10x10G-LC card works with the OTN devices defined in ITU-T G.709.

11.21.2.1 Key Features

The key features of 10x10G-LC card are listed in 11.21.3.5 Key Features of 100G-LC-C, 10x10G-LC, 
and CFP-LC Cards, page 11-158.

11.21.2.2 Faceplate

Figure 11-48 shows the 10x10G-LC faceplate.
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Figure 11-48 10x10G-LC Faceplate
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11.21.2.3 10x10G-LC Block Diagram

For information on safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section on 
page G-4.

Caution A 20-dB fiber attenuator (15 to 25 dB) must be used when working with the cards in a loopback, on the 
trunk port. Do not use direct fiber loopbacks with the cards because it causes irreparable damage to the 
10x10G-LC card.

The 10x10G-LC card is a single-slot card and can be installed in Slot 2 to Slot 7 in the 
Cisco ONS 15454 M6 chassis and Slot 2 and Slot 3 in the Cisco ONS 15454 M2 chassis. The 
10x10G-LC card consists of a 10-port SFP+ based (gray, colored, coarse wavelength division 
multiplexing ([CWDM], and DWDM optics available) and one 100 G CXP-based port.

The 10x10G-LC card interoperates with 100G-LC -C cards through an ONS 15454 M6 or 
ONS 15454 M2 backplane.

Note The fan-tray assembly 15454-M6-FTA2 (for the M6 chassis) or 15454-M2-FTA2 (for the M2 chassis) 
must be installed in the shelf where a 10x10G-LC card is installed. When an ONS-SC+-10G-C pluggable 
is used along with the 10x10G-LC card, the maximum operating temperature of the shelf must not 
exceed 50 degrees Celsius. 
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11.21.2.4 Operating Modes for 10x10G-LC Card

The 10x10G-LC card supports the following operating modes:

• MXP-10x10G (10x10G Muxponder)

• RGN-10G (5x10G Regenerator)/TXP-10G (5x10G Transponder)

• Low Latency

• Fanout-10X10G

Each operating mode can be configured using the specific set of cards and client payloads. Table 11-37 
describes how each mode can be configured, the supported payloads, and the valid port pair for a specific 
operating mode.

11.21.2.4.1 MXP-10x10G (10x10G Muxponder)

The 10x10G-LC card can be configured as a 10x10G muxponder. It can be connected with a 100G-LC-C 
card to support 10-port 10 G muxponder capabilities. The 100G-LC-C card can be connected through 
the Cisco ONS 15454 M6 or Cisco ONS 15454 M2 backplane (no client CXP required) with the 
10x10G-LC card to provide OTN multiplexing of the 10 G data streams into a single 100 G DWDM 
OTU4 wavelength. The allowed port pairs are 2-3, 4-5, or 6-7.

The 10x10G muxponder mode supports client signals that are a mix and combination of any 
10 Gigabit Ethernet LAN-PHY, OC-192, STM-64, 10 G FC/FICON, 8 G FC/FICON, or OTU2 data 
rates. 

11.21.2.4.2 RGN-10G (5x10G Regenerator)/TXP-10G (5x10G Transponder)

The 10x10G-LC card works as a standalone supporting the multitransponder functionality. The 10 Gbps 
SFP+ ports should be paired to provide the 10 G transponder functionality for each of the couple of 
ports. By using the grey optics SFP+ to provide the client equipment connectivity and DWDM SFP+ on 
the WDM side, up to five 10 G transponders are supported by a single 10x10G-LC card. Up to 6 
10x10G-LC cards are supported on the Cisco ONS 15454 M6 chassis allowing for 30 10 Gbps 
transponders in a single shelf.

All the ports can be equipped with or without the G.709 Digital Wrapper function providing wide 
flexibility in terms of the supported services. 

As the client and trunk ports are completely independent, it is also possible to equip both the SFP+ of 
the same pair of ports with the DWDM SFP+ thereby allowing them to function as a WDM regenerator. 
The CXP pluggable is unused in this configuration.

Each of the SFP+ ports can be provisioned as a client or trunk. When one port is selected as a trunk, the 
other port of the pair is automatically selected as the client port. The allowed port pairs are 1-2, 3-4, 5-6, 
7-8, or 9-10.

For RGN-10G mode, both the ports are trunk ports.

It is not a constraint to provision 5 couple of TXP-10G mode or 5 couple of RGN-10G mode. A mix of 
TXP-10G and RGN-10G modes can be configured. For example, couple 1-2 and 5-6 can be configured 
as a TXP-10G mode and the remaining as the RGN-10G mode.

Table 11-36 shows the supported payload mapping on a particular port and its corresponding peer.
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11.21.2.4.3 Low Latency

The 10x10G-LC card can be configured in the low latency mode. This configuration minimizes the time 
spent by the signal to cross the card during the regeneration process. Adjacent SFP ports must be selected 
while provisioning this mode although each SFP port functions as a unidirectional regenerator. Both 
ports are trunk ports. The allowed ports are 1-2, 3-4, 5-6, 7-8, or 9-10. A mix of TXP-10G, RGN-10G, 
and low latency modes can be configured.

The low latency mode supports 10GE and 10G FC data rates. The same payload must be provisioned on 
both the SFP ports involved in this operating mode. GCC cannot be provisioned on the ports used in the 
low latency mode. The low latency mode does not support terminal and facility loopback.

11.21.2.4.4 Fanout-10X10G

The 10x10G-LC card can be configured in the fanout-10x10G mode.The fanout configuration configures 
the CXP side as the client and SFP side as the trunk. This configuration functions as ten independent 
transponders. The CXP lanes are managed independently and the payload for each CXP-lane-SPF+ pair 
is independent from the other pairs. 

The fanout configuration provides the following mapping for the port pairs:

• CXP lane 2-SFP1

• CXP lane 3-SFP2

• CXP lane 4-SFP3

• CXP lane 5-SFP4

• CXP lane 6-SFP5

• CXP lane 7-SFP6

• CXP lane 8-SFP7

• CXP lane 9-SFP8

• CXP lane 10-SFP9

• CXP lane 11-SFP10

Note CXP lane 1 and CXP lane 12 are not supported in this configuration.

The fanout configuration supports the following payload types and mapping modes:

• 10GE (CXP line), transparent (no mapping), 10GE (SFP)

• 10GE (CXP line), GFP mapping, OTU2 (SFP)

• 10GE (CXP line), CBR mapping, OTU2e (SFP) 

Table 11-36 Supported Payload Mapping Between Two SFP+ Ports

SFP+ Payload (Peer-1) SFP+ Payload (Peer -2)

10GE-LAN (CBR Mapped) OTU2e or 10GE-LAN (CBR Mapped)

OTU2 OC192 or OTU2
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11.21.3 CFP-LC Card
The CFP-LC card is a client card, which simplifies the integration and transport of 40 GE and 100 GE 
interfaces and services into enterprises or service provider optical networks. The CFP-LC card is 
supported on the Cisco ONS 15454 M6 platform. The CFP-LC card provides 100 Gbps services to 
support 100 G DWDM wavelengths generated by the 100G-LC-C card. The traffic coming from CFP 
interfaces is switched to the trunk port through a cross-switch. 

The CFP-LC card supports the following signal types:

• 100 Gigabit Ethernet

• 40 Gigabit Ethernet

• OTU-3

• OTU-4

Client ports can be equipped with a large variety of CFP pluggables.

The Digital Wrapper function (ITU-T G.709-compliant) formats the DWDM wavelength so that it can 
be used to set up GCCs for data communications, enable FEC, or facilitate performance monitoring. 

11.21.3.1 Key Features

The key features of CFP-LC card are listed in 11.21.3.5 Key Features of 100G-LC-C, 10x10G-LC, and 
CFP-LC Cards, page 11-158.

11.21.3.2 Faceplate

Figure 11-49 shows the CFP-LC faceplate.
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Figure 11-49 CFP-LC Faceplate
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11.21.3.3 Block Diagram

For information on safety labels for the cards, see the “G.1.2 Class 1M Laser Product Cards” section on 
page G-4.

Caution A 20-dB fiber attenuator (15 to 25 dB) must be used when working with the cards in a loopback, on the 
trunk port. Do not use direct fiber loopbacks with the cards because it causes irreparable damage to the 
CFP-LC card.

The CFP-LC card is a double-slot card and can be installed in Slot 3 or Slot 5 in the 
Cisco ONS 15454 M6 chassis, and the 100G-LC-C peers cards must be placed in the adjacent slots (2 
and 5 or 4 and 7). If the card is plugged in one of the unsupported slots or in a Cisco ONS 15454 M2 
chassis, the system raises an EQPT::MEA (Mismatch of Equipment Alarm) notification. Up to two 
CFP-LC cards can be installed per ONS 15454 M6 shelf assembly, supporting up to 28x 40-Gbps or 
14x 100 Gbps interfaces per 42-rack units (RU) bay frame.

The CFP-LC card is equipped with two 100 G CFP pluggable modules and a cross-bar embedded switch 
module. The CFP-LC card provides two backplane interfaces (working both at 100 Gb or 40 Gb) that 
are suitable for the cross-switch application on the incoming CFP signals. The CFP-LC card can be 
configured to send all the client CFP services towards the backplane to be connected with up to two 
100G-LC-C cards placed in the two adjacent slots (upper and lower) of the Cisco ONS 15454 M6 chassis 
in order to provide two 100 G transponders configurations.

Note The fan-tray assembly 15454-M6-FTA2 (for the M6 chassis) must be installed in the shelf where a 
CFP-LC card is installed.
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11.21.3.4 Operating Modes for CFP-LC Card

The CFP-LC card supports the following operating modes:

• 2x40G Muxponder

• CFP-TXP (100G Transponder)

Each operating mode can be configured using the specific set of cards and client payloads. Table 11-37 
describes how each mode can be configured, the supported payloads, and the valid port pair for a specific 
operating mode.

11.21.3.4.1 2x40G Muxponder

The CFP-LC card can be configured as a 2-port 40 G muxponder. It can be connected with the 
100G-LC-C card to support 2-port 40 G muxponder capabilities. The 100G-LC card can be connected 
through the Cisco ONS 15454 M6 backplane (no client CXP required) with the CFP-LC card to provide 
OTN multiplexing of the 40 G data streams into a single 100 G WDM OTU4 wavelength. 

The 2x40G muxponder mode supports client signals that are a mix and combination of any 40 Gigabit 
Ethernet LAN-PHY or OTU3 data rates.

11.21.3.4.2 CFP-TXP (100G Transponder)

The CFP-LC card can be configured as a 100 G transponder. It can be connected with the 100G-LC-C 
card to support 100GE-BASE-LR4 client interface for the 100-Gbps transponder capabilities. The 100G 
CXP pluggable available on the 100G-LC card supports only 100GE-BASE-SR10 client interface, while 
the 100GE-BASE-LR4 is supported using a CFP form factor only. 

The CFP-LC card can be connected through the Cisco ONS 15454 M6 backplane with up to two 
100G-LC cards placed in the upper or in the lower slot of the same shelf to provide the equivalent 
functionalities of two 100 G LR4 transponders, leveraging on CFP pluggables as client interface.
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11.21.3.5 Key Features of 100G-LC-C, 10x10G-LC, and CFP-LC Cards

The 100G-LC-C, 10x10G-LC, and CFP-LC cards support the following key features:
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• Operating Modes—The 100G-LC-C, 10x10G-LC, and CFP-LC cards can be configured into 
cards can be equipped with pluggables for client and trunk options, and offer a large variety 
configure the 100G-LC-C, 10x10G-LC, or CFP-LC card into multiple operational modes, ma
are completed: 

– The card must be preprovisioned and the modes must be configured. None of the modes 
default. All operating modes are created on the card level. These are card-specific provisio
of a particular card.

– Depending on the card mode selected, the supported payload for that particular card mod
PPMs.

– The payloads can be provisioned after configuring the operational mode on the card.

Each operating mode can be configured using the specific set of cards and client payloads. Table
can be configured, the supported payloads, and the valid port pair for a specific operating mode.

Table 11-37 Operating Modes and Supported Payloads for 100G-LC-C, 10x10G-LC, and CFP-LC Cards

Card 
(provisioning 
executed on this 
card) Operational Mode

 Peer Card (connected 
through backplane) 

Supported Client 
Payloads Valid Card Slot V

100G-LC-C TXP-100G (Standalone 
100GE Transponder)

— 100GE, OTU4 M2—Slots 2 and 3
M6—Slots 2 to 7

—

RGN-100G (100G 
Regenerator)

100G-LC-C card —
Regeneration of any 
100 G configuration

M2—Slot-2
M2-—Slot-3

M6—Slot-2
M6—Slot-3
M6—Slot-4
M6—Slot-5
M6—Slot-6
M6—Slot-7

M
M

M
M
M
M
M
M
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10x10G-LC MXP-10x10G (10x10G 
Muxponder)

100G-LC-C card OC192/STM-64, 
10GE-LAN Phy, 
10GE-WAN Phy 
(using OC192), 
OTU2, OTU2e, 
8G FC, 10G FC, 
FICON

M2—Slot-2
M2-—Slot-3

M6—Slot-2
M6—Slot-3
M6—Slot-4
M6—Slot-5
M6—Slot-6
M6—Slot-7

M2—
M2—

M6—
M6—
M6—
M6—
M6—
M6—

RGN-10G (5x10G 
Regenerator)

— 10GE-LAN Phy, 
OTU2

M2—Slots 2 and 3

M6—Slots 2 to 7

—

TXP-10G (5x10G 
Transponder)

— 10GE-LAN Phy, 
OTU2e, OTU2, 
OC192/STM-64, 
8G FC, 10G FC

M2—Slots 2 and 3

M6—Slots 2 to 7

—

Low Latency — 10GE, 10G FC M2—Slots 2 and 3

M6—Slots 2 to 7

—

Fanout-10X10G — 10GE M2—Slots 2 and 3

M6—Slots 2 to 7

—

CFP-LC 2x40G Muxponder 100G-LC-C card OTU3/40GE-LAN 
Phy

M6—Slot-3
M6—Slot-5

M6—
M6—

CFP-TXP (100G 
Transponder)—One port

CFP-TXP (100G 
Transponder)—Two ports

100G-LC-C card OTU4, 100GE M6—Slot-3
M6—Slot-5

M6—
M6—

Two 100G-LC-C 
cards

OTU4, 100GE M6—Slot-3
M6—Slot-5

M6—
M6—

(provisioning 
executed on this 
card) Operational Mode

 Peer Card (connected 
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Supported Client 
Payloads Valid Card Slot Vali



Chapter 11      Provision Transponder and Muxponder Cards
11.21.3   CFP-LC Card
For operating modes of the respective cards, see the “11.21.1.5 Operating Modes for 100G-LC-C 
Card” section on page 11-148, “11.21.2.4 Operating Modes for 10x10G-LC Card” section on 
page 11-152, and “11.21.3.4 Operating Modes for CFP-LC Card” section on page 11-157. 

• Protocol Transparency—The 100G-LC-C card delivers any 100 Gbps services for cost-effective, 
point-to-point networking for the Cisco ONS 15454 platform. Table 11-38 shows the transponder 
client configurations and mapping for 100G-LC-C card. The 10x10G-LC card delivers any 10 Gbps 
services for cost-effective, point-to-point networking for the Cisco ONS 15454 platform. In case of 
100 G muxponder clients that are mapped into OTU4 DWDM wavelength, Table 11-39 shows the 
transponder client configurations and mapping for the 10x10G-LC card. Table 11-40 shows the 
transponder client configurations and mapping for the CFP-LC card.

Table 11-38 Transponder Client Configurations and Mapping for 100G-LC-C Card

Client Trunk

Format Rate (Gbps) Mapping Format

Rate with 
7% GFEC, 
20% GFEC, 
or EFEC OH 
(Gbps)

100GE LAN-PHY 101.125 Bit transparent 
through standard 
G.709v3 mapping

OTU4 111.809  
OTU4 111.809 Transparent 

G.709 standard

Table 11-39 Transponder Client Configurations and Mapping for 10x10G-LC Card

Client Mapping

Format Rate (Gbps)

10GE LAN-PHY 10.3125 CBR-BMP clause 17.2.4 (ex G sup43 7.1) + 
GMP ODU2e to OPU3e4

10GE LAN-PHY 10.3125 GFP-F clause 17.4.1 (ex G sup43 7.3) + GMP 
ODU2 to OPU3e4

OC-192/STM-64 9.953 CBR-BMP clause 17.2.2 (Sync) + GMP ODU2 
to OPU3e4

10G FC 10.518 513b Transc + AMP GFP-F clause 17.8.2 + GMP 
ODU2e to OPU3e4

8G FC 8.500 CBR-BMP clause 17.9 (OduFlex) + GMP ODU2 
to OPU3e4 (8 timeslot mapping)

8G FC 8.500 GMP ODU2 to OPU3e4

OTU2 10.709 ODU transparent + GMP ODU2 to OPU3e4

OTU2e 11.095 ODU transparent + GMP ODU2e to OPU3e4
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• Flow-Through Timing—The 100G-LC-C, 10x10G-LC, and CFP-LC cards allow the timing to flow 
through from client to line optical interface. The received timing from client interface is used to time 
the line transmitter interface. This flow-through timing allows multiple cards to be placed in the 
same shelf but be fully independently timed, independent of the NE timing.

• Far-End Laser Control (FELC)—FELC is supported on the 100G-LC-C, 10x10G-LC, and CFP-LC 
cards. For more information on FELC, see the “G.35 Far-End Laser Control” section on page G-35.

• Performance Monitoring—The 100-Gbps DWDM trunk provides support for both transparent and 
non-transparent signal transport performance monitoring. The Digital Wrapper channel is 
monitored according to G.709 (OTN) and G.8021 standards. Performance Monitoring of optical 
parameters on the client and DWDM line interface include Loss Of Signal (LOS), Laser Bias 
Current, Transmit Optical Power, and Receive Optical Power. Calculation and accumulation of the 
performance monitoring data are supported in 15-minute and 24-hour intervals as per G.7710. 
Physical system parameter measured at the wavelength level like Mean PMD, accumulated 
Chromatic Dispersion, or Received OSNR are also included in the set of performance monitoring 
parameters. These can greatly simplify troubleshooting operations and enhance the set of data which 
can be collected directly from the equipment.
The performance monitoring for the CFP-LC card takes into account that the two CFP-LC cards are 
an host board supporting CFP client equipment, while the digital monitoring if the incoming client 
is implemented on the 100G-LC-C card. There is a virtual port connection that displays the Digital 
Wrapper monitoring according to G.709 (OTN) as well as the RMON for Ethernet signals, while the 
optical performance monitoring is directly available on the two CFP-LC cards. Calculation and 
accumulation of the performance monitoring data are supported in 15-minute and 24-hour intervals 
as per G.7710.

• Loopback—The terminal, facility, or backplane loopback can be provisioned on all the ports of the 
100G-LC-C and 10x10G-LC cards configured in any operating mode except for the low latency 
mode. The backplane facility loopback cannot be configured on the 10x10G -LC card configured in 
the MXP-10x10G mode. Loopback can be provisioned only when the port is in OOS-MT state. A 

Table 11-40 Client Configurations and Mapping for CFP-LC Card

Client Trunk

Format Rate (Gbps) Mapping Format

Rate with 
7% GFEC 
or EFEC 
OH 
(Gbps)

100GE LAN-PHY 101.125 Bit transparent 
through standard 
G.709v3 mapping

OTU4 111.809

OTU4 111.809 Transparent 
G.709 standard

40GE LAN-PHY 41.250 1024b/1027b 
transc + OPU4 
GMP G709 
Appendix VIII

OTU3 43.018 Transparent 
G.709 standard
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new port cannot be provisioned when the backplane loopback is configured on the 10x10G-LC card. 
For the CFP-LC card configured in the CFP-TXP or CFP-MXP mode, the facility or terminal 
loopback can be configured on the backplane of the peer 100G-LC-C card.

• Generalized Multiprotocol Label Switching — The Generalized Multiprotocol Label Switching 
(GMPLS) circuit can be created on the 100G-LC-C and 10 x10G-LC cards. However, this circuit 
cannot be created when the card is in 100 G regenerator mode. When the card is configured in 
MXP-10 x 10G card mode, only GMPLS Optical Channel Network Connections (OCHNCs) can be 
created.

• Automatic Laser Shutdown (ALS) can be configured on all the ports. ALS is supported only on the 
ports that are configured with OC192/STM64, OTU2, and OTU4 payloads.

• GCC channels—can be provisioned on the OTU2 client and trunk ports of the 10 x10G-LC card, 
OTU3 port (virtual port on the peer 100G-LC-C card) of the CFP-LC card, and the OTU4 client and 
trunk ports of the 100G-LC-C card. 

• 50 ms switching with PSM—A protection switch time of less than 50 ms can be achieved with two 
CFP-LC cards on their 100GE client ports using a PSM card that is configured in the standalone 
mode. The client ports of the CFP-LC cards are connected to the working and protect ports of the 
PSM card. An OCHCC circuit must be created between the two client ports.

• The optical TX power can be set to a value from -10.0 to +0.25 dBm on the trunk port of the 
100G-LC-C card to enable it to interoperate with ASR 9000 series routers and Cisco CRS-3 routers. 
The TX shutdown feature allows you to turn off the TX power on the 100G-LC-C cards when the 
trunk port in out of service or in maintenance. The 100G-LC-C cards have the ability to receive 
optical signals even when the TX power is turned off.

• Licensing—The 100G-LC-C card adds the capability to cost-effectively transport the 10 G service 
offering as a Pay-As-You-Grow licensing model for the 10 x 10G muxponder. A licensed card works 
in conjunction with a licensed 10 x10G line card. The two cards that can only work in this 
configuration and in combination of the other licensed pair card offers a price-sensitive solution with 
the ability to equip one 10 G service. For more information on licensing, see the 
Cisco ONS 15454 DWDM Licensing Configuration Guide.

Note Licensing is not supported on the CFP-LC card.

11.21.3.6 Functions and Features

The cards have the following functions and features:

• FEC Feature—G.8 FEC, page G-18

• Timing Synchronization—G.10 Timing Synchronization, page G-19

• Jitter Considerations—G.36 Jitter Considerations, page G-36

• Card level indicators—Table G-1 on page G-8

• Port level indicators—Table G-12 on page G-14
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11.22 Related Procedures for 100G-LC-C, 10x10G-LC, and CFP-LC 
Cards

• “NTP-G235 Provision an Operating Mode on the 100G-LC-C, 10x10G-LC, or CFP-LC Card” 
section on page 11-509.

• “NTP-G236 Modify the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings and PM Parameter 
Thresholds” section on page 11-510.

• NTP-G75 Monitor Transponder and Muxponder Performance.

11.23 MLSE UT
The maximum likelihood sequence estimation (MLSE) based universal transponder (UT) modules are 
added to the TXP_MR_10EX_C, MXP_2.5G_10EX_C, and MXP_MR_10DMEX_C cards to support 
the error decorrelator functionality to enhance system performance.

11.23.1 Error Decorrelator
The MLSE feature uses the error decorrelator functionality to reduce the chromatic dispersion (CD) and 
polarization mode dispersion (PMD), thereby extending the transmission range on the trunk interface. 
You can enable or disable the error decorrelator functionality using CTC or TL1. The dispersion 
compensation unit (DCU) is also used to reduce CD and PMD. The MLSE-based UT module helps to 
reduce CD and PMD without the use of a DCU.

11.24 SFP, SFP+, XFP, CXP, and CFP Modules
Small Form-factor Pluggable (SFP), Enhanced Small-Form-factor Pluggable (SFP+), 10-Gbps SFP 
(XFP), CXP, and C Form-factor pluggable (CFP) modules are integrated fiber optic transceivers that 
provide high-speed serial links from a port or slot to the network. For more information on SFP, SFP+, 
XFP, CXP, and CFP modules and for a list of SFP, SFP+, XFP, CXP, and CFP modules supported by the 
transponder and muxponder cards, see the Installing the GBIC, SFP, SFP+, XFP, CXP, and CFP Optical 
Modules in Cisco ONS Platforms.

In CTC, SFP, SFP+, XFP, CXP, and CFP modules are called pluggable port modules (PPMs). To 
provision SFP, SFP+, XFP, CXP, or CFP module and change the line rate for multirate PPMs, see the 
DLP-G726 Preprovisioning a Multirate PPM task.

11.25 Procedures for Transponder and Muxponder Cards
The procedures described below explain how to provision transponder (TXP), muxponder (MXP), 
Xponder (GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE), and ADM-10G cards. The provisioning must 
be performed before you provision the dense wavelength division multiplexing (DWDM) network and 
create circuits.
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11.25.1 Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary.

Caution Provisioning TXP and MXP cards can be service affecting. You should make all changes during a 
scheduled maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G128 Manage Pluggable Port Modules, page 11-166—Complete this procedure to provision a 
multirate pluggable port module (PPM), provision or change the optical line rate of a PPM, or delete 
a PPM. PPMs provide the fiber interface to the TXP, MXP, and ADM-10G cards. With the exception 
of the TXP_MR_10G card, all TXPs, MXPs, and ADM-10G cards accept PPMs.

2. NTP-G33 Create a Y-Cable Protection Group, page 11-182—As needed, complete this procedure 
for TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP cards that will be protected 
with Y-cable protection.

3. NTP-G199 Create a Splitter Protection Group for the OTU2_XP Card, page 11-186—As needed, 
complete this procedure to create a splitter protection group for an OTU2_XP card.

4. NTP-G198 Create 1+1 Protection for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards, 
page 11-188—As needed, complete this procedure to create 1+1 protection for GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

5. NTP-G98 Provision the 2.5G Multirate Transponder Card Line Settings and PM Parameter 
Thresholds, page 11-191—As needed, complete this procedure to change the transmission settings 
for TXP_MR_2.5G and TXPP_MR_2.5G cards.

6. NTP-G96 Provision the 10G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 11-211—As needed, complete this procedure to change the transmission settings 
for TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C 
cards.

7. NTP-G292 Provision the 40G Multirate Transponder Card Line Settings, PM Parameters, and 
Thresholds, page 6-72—As needed, complete this procedure to change the transmission settings for 
40E-TXP-C and 40ME-TXP-C cards.

8. NTP-G170 Provision the ADM-10G Card Peer Group, Ethernet Settings, Line Settings, PM 
Parameters, and Thresholds, page 11-257—As needed, complete this procedure to provision the 
transmission settings for ADM-10G cards.

9. NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-282—As needed, complete this procedure to change the transmission settings for 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C cards.

10. NTP-G99 Modify the 2.5G Data Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-303—As needed, complete this procedure to change the transmission settings for 
MXP_MR_2.5G and MXPP_MR_2.5G cards.

11. NTP-G148 Modify the 10G Data Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-321—As needed, complete this procedure to change the transmission settings for 
MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C cards.
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12. NTP-G293 Modify the 40G Muxponder Card Line Settings and PM Parameter Thresholds, 
page 11-342—As needed, complete this procedure to change the transmission settings for 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

13. NTP-G281 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Channel Group 
Settings, page 11-367—As needed, complete this procedure to change the channel group settings 
for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

14. NTP-G283 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card CFM Settings, 
page 11-378—As needed, complete this procedure to change the CFM settings for GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

15. NTP-G285 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card EFM Settings, 
page 11-390—As needed, complete this procedure to change the EFM settings for GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

16. NTP-G287 Manage the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card REP Settings, 
page 11-395—As needed, complete this procedure to change the REP settings for GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

17. NTP-G165 Modify the GE_XP, 10GE_XP, GE_XPE, 10GE_XPE Cards Ethernet Parameters, Line 
Settings, and PM Thresholds, page 11-402—As needed, complete this procedure to change the 
transmission settings for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

18. NTP-G314 Add a GE_XP or 10GE_XP Card on a FAPS Ring, page 11-445—As needed, complete 
this procedure to add a GE_XP or 10GE_XP Card on a FAPS Ring.

19. NTP-G197 Provision the OTU2_XP Card Line Settings, PM Parameters, and Thresholds, 
page 11-448—As needed, complete this procedure to change the transmission settings for 
OTU2_XP cards.

20. NTP-G162 Change the ALS Maintenance Settings, page 11-471—As needed, complete this 
procedure to change the automatic laser shutdown settings for a TXP or MXP card.

21. NTP-G302 Configure Loopback on 100G-LC-C, 10x10G-LC, and CFP-LC Cards, 
page 11-473—As needed, complete this procedure to configure the loopback on the 100G-LC or 
10x10G-LC card.

22. NTP-G299 Configure the Backplane Loopback on 100G-LC-C, 10x10G-LC, and CFP-LC Cards, 
page 11-475—As needed, complete this procedure to configure the backplane loopback on the 
100G-LC or 10x10G-LC card.

23. NTP-G192 Force FPGA Update, page 11-476—As needed, complete this procedure to force an 
upgrade of the FPGA image on the MXP_MR_10DME_C, MXP_MR_10DME_L, and 
MXP_MR_10DMEX_C cards.

24. NTP-G196 Force FPGA Update When the Card is Part of a Protection Group, page 11-477—As 
needed, complete this procedure to force an upgrade of the FPGA image on the 
MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C cards when the card is 
part of a protection group.

25. NTP-G232 Enabling Error Decorrelator, page 11-478—As needed, complete this procedure to 
enable error decorrelator on a TXP_MR_10EX_C, MXP_2.5G_10EX_C, or 
MXP_MR_10DMEX_C card.
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NTP-G128 Manage Pluggable Port Modules

Note If a single-rate PPM is installed, the PPM screen will autoprovision and no further steps are necessary.

Note When you autoprovision a PPM, initial alarm and TCA defaults are supplied by Cisco Transport 
Controller (CTC) depending on your port and rate selections and the type of PPM. These default values 
can be changed after you install the PPM.

Note The hardware device that plugs into a TXP, MXP, AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 
10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP card 
faceplate to provide a fiber interface to the card is called a Small Form-factor Pluggable (SFP, SFP+, 
XFP, or CXP) or C Form-factor pluggable (CFP). In CTC, SFPs, XFPs, CXPs, and CFPs are called 
pluggable port modules (PPMs). SFPs/XFPs/CXPs/CFPs are hot-swappable I/O devices that plug into a 
port to link the port with the fiber-optic network. Multirate PPMs have provisionable port rates and 
payloads. For more information about SFPs, XFPs, and CXPs, see the “11.24 SFP, SFP+, XFP, CXP, 
and CFP Modules” section on page 11-163.

Step 1 Complete the DLP-G46 Log into CTC task to log into an ONS 15454 on the network. If you are already 
logged in, continue with Step 2.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no unexplained conditions appear. If unexplained conditions appear, resolve them before 
continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

Step 3 If you are provisioning a MXP_MR_2.5G or MXPP_MR_2.5G card, complete the “DLP-G235 Change 
the 2.5G Data Muxponder Card Mode” task on page 11-167. If not, continue with Step 4

Step 4 If you are provisioning a MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C 
card, complete the “DLP-G332 Change the 10G Data Muxponder Port Mode” task on page 11-168. If 
not, continue with Step 5.

Step 5 If you are provisioning a GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card, complete the “DLP-G379 
Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on page 11-170. If not, 
continue with Step 6.

Step 6 If you are provisioning a OTU2_XP card, complete the “DLP-G452 Change the OTU2_XP Card Mode” 
task on page 11-172. If not, continue with Step 7.

Purpose Complete this procedure to provision a multirate PPM, provision the 
optical line rate of a multirate PPM, or delete a single-rate or multirate 
PPM. 

Tools/Equipment None

Prerequisite Procedures DLP-G723 Install PPM on a Line Card

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 If you are provisioning a PPM on an ADM-10G card, complete the “DLP-G411 Provision an ADM-10G 
PPM and Port” task on page 11-171. If not, continue with Step 10.

Step 8 If you are provisioning a PPM on an AR_MXP, AR_XP, or AR_XPE card, complete the “NTP-G321 
Provision Multiple Operating Modes on AR_MXP, AR_XP, or AR_XPE Cards” task on page 11-480. If 
not, continue with Step 10.

Step 9 If you are provisioning a PPM on an 100G-LC-C, 10x10G-LC, or CFP-LC card, complete the 
“NTP-G235 Provision an Operating Mode on the 100G-LC-C, 10x10G-LC, or CFP-LC Card” task on 
page 11-509. If not, continue with Step 10.

Step 10 Complete the DLP-G726 Preprovisioning a Multirate PPM task for TXP, MXP, AR_MXP, AR_XP, 
AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP 
ports with multirate PPMs. If you already preprovisioned the multirate PPM, skip this step and continue 
with Step 11.

Step 11 If you are provisioning an IBM ETR_CLO (External Time Reference – Control Link Oscillator) or 
InterSystem Coupling Link (ISC) service on the PPM, complete “DLP-G274 Verify Topologies for 
ETR_CLO and ISC Services” task on page 11-173. Otherwise, continue with Step 12.

Step 12 Complete the “DLP-G278 Provision the Optical Line Rate” task on page 11-175 to assign a line rate to 
a TXP, MXP, AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, or OTU2_XP port after 
the PPM is provisioned. (This task is not performed for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards.)

Step 13 If you need to delete a PPM at any point in this procedure, complete the DLP-G727 Delete PPM 
Provisioning task. 

Stop. You have completed this procedure.

DLP-G235 Change the 2.5G Data Muxponder Card Mode

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the card settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs.

Step 3 Locate the Trunk port table row and verify that the Service State column value is OOS-MA,DSBLD 
(ANSI) or Locked-enabled,disabled (ETSI). If the service state is correct, continue with Step 6. If not, 
complete the following steps:

a. Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Maintenance 
(ETSI).

b. Click Apply, then Yes.

Purpose This task changes the card mode for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. The card mode determines which 
PPMs can be provisioned for the card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click the Provisioning > Line > Client tabs.

Step 5 Locate the Trunk port table row and verify that the Service State column value is OOS-MA,DSBLD 
(ANSI) or Locked-enabled,disabled (ETSI). If the service state is correct, continue with Step 6. If not, 
complete the following steps:

a. Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Maintenance 
(ETSI).

b. Click Apply, then Yes.

Step 6 Click the Provisioning > Card tabs. 

Step 7 Change the Card Mode as needed:

• FC-GE—Choose this option if you will provision any of the following PPM port rates: FC1G (Ports 
1-1 and 2-1 only), FC2G (Port 1-1 only), FICON1G (Ports 1-1 and 2-1 only), FICON2G (Port 1-1 
only), and ONE_GE (Ports 1-1 through 8-1).

• Mixed—Choose this option if you will provision any of the following PPM port rates: FC1G and 
ONE_GE (Port 1–1 only), ESCON (Ports 5–1 through 8-1 only)

• ESCON—Choose this option if you will provision the ESCON PPM on Ports 1-1 through 8-1.

Note The Provisioning > Card tab also has the display-only Tunable Wavelengths field. This field shows the 
supported wavelengths of the trunk port after the card is installed in the format: 
first wavelength-last wavelength-frequency spacing-number of supported wavelengths. 
For example, 1529.55nm-1561.83nm-50gHz-82. 

Step 8 Click Apply. 

Step 9 Return to your originating procedure (NTP).

DLP-G332 Change the 10G Data Muxponder Port Mode

Note The MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C cards have two port 
mode groups, one for Ports 1 through 4, and the second for Ports 5 through 8. To change the port mode, 
all ports within the selected port group must be in OOS (out-of-service) service state. Ports in the second 
port group do not need to be in OOS service state if you are not changing the port mode for the second 
port group. Before you change the port mode, you must also ensure that any PPM port rate provisioned 
for the selected port group is deleted (see the DLP-G727 Delete PPM Provisioning).

Purpose This task changes the port mode for the MXP_MR_10DME_C, 
MXP_MR_10DME_L, and MXP_MR_10DMEX_C muxponder cards. 
The port mode determines which PPMs can be provisioned on the ports.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G332 Change the 10G Data Muxponder Port Mode
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C card where you want to 
change the port mode.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Change the port mode as described in Table 11-41. 

Note The PPM port rates are provisioned in the DLP-G726 Preprovisioning a Multirate PPM task.

Note The Provisioning > Cards tab also has a display-only Tunable Wavelengths field which shows the 
wavelengths supported by the card. If a MXP_MR_10DME_C card is installed, the 32 C-band 
wavelengths appear. If the MXP_MR_10DME_L card is installed, the 32 L-band wavelengths appear. If 
the MXP_MR_10DMEX_C card is installed, the 82 C-band wavelengths appear.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Note Loopbacks on MXP-MR-10DME are not applicable when Fiber Channel switches are present.

Table 11-41 10G Data Muxponder Card Port Modes

Parameter Description Options

Port 1-4 Mode Sets the mode of 
operation for Ports 
1-1 through 4-1. 

Chose one of the following:

• FC-GE_ISC—Choose this option if you will provision any 
of the following PPM port rates: FC1G (Ports 1-1 through 
4-1), FC2G (Ports 1-1 and 3-1 only), FICON1G (Ports 1-1 
through 4-1), FICON2G (Ports 1-1 and 3-1 only), 
ONE_GE (Ports 1-1 through 4-1), ISC3 COMPAT (Ports 
1-1 through 4-1), ISC3 PEER 1G (Ports 1-1 through 4-1), 
and ISC3 PEER 2G (Ports 1-1 and 3-1 only).

• FC4G—Choose this option if you will provision an FC4G 
or FICON4G PPM (Port 1-1 only).

Port 5-8 Mode Sets the mode of 
operation for 
Ports 5-1 through 
8-1.

Chose one of the following:

• FC-GE_ISC—choose this option if you will provision any 
of the following PPM port rates: FC1G (Ports 5-1 through 
8-1), FC2G (Ports 5-1 and 7-1 only), FICON1G (Ports 5-1 
through 8-1), FICON2G (Ports 5-1 and 7-1 only), 
ONE_GE (Ports 5-1 through 8-1), ISC3 COMPAT (Ports 
5-1 through 8-1), ISC3 PEER 1G (Ports 5-1 through 8-1), 
and ISC3 PEER 2G (Ports 5-1 and 7-1 only).

• FC4G—choose this option if you will provision an FC4G 
or FICON4G PPM port rate (Port 5-1 only).
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DLP-  G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode
Note If the Fiber Channel switch version is not present then the Distance Extension settings are not supported.

DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the card mode.

Step 2 In card view, click Provisioning > Ether Ports > Ports. 

Step 3 Verify that any provisioned client or trunk ports have an OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI) service state in the Service State column. If so, continue with Step 4. 
If not, complete the following substeps.

a. For the first port that is not out of service, in the Admin State column, choose OOS,DSBLD (ANSI) 
or Locked,disabled (ETSI).

b. Repeat Step a for each port that is not out of service.

c. Click Apply.

Step 4 Click the Provisioning > Card tabs.

Step 5 Choose one of the card modes shown in Table 11-42.

:

Purpose This task changes the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card 
mode. 10GE_XP and 10GE_XPE cards can be provisioned as a Layer 2 
Ethernet switch or a 10G Ethernet TXP. GE_XP and GE_XPE cards can be 
provisioned as a Layer 2 Ethernet switch, 10G Ethernet MXP, or 20G 
Ethernet MXP.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-42 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Modes

Mode Cards Description

L2 over DWDM GE_XP

10GE_XP

GE_XPE

10GE_XPE

Provisions the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE as 
a Layer 2 switch.

10GE TXP 10GE_XP

10GE_XPE

Provisions the 10GE_XP or 10GE_XPE as a 10 Gigabit 
Ethernet transponder. Traffic received on the 10GE client Port 
1-1 is sent to 10 Gigabit Ethernet trunk Port 3-1, and traffic 
received on 10 Gigabit Ethernet client Port 2-1 is sent to 
10 Gigabit Ethernet trunk Port 4-1.
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DLP-  G411 Provision an ADM-10G PPM and Port
The GE-XP and GE-XPE cards operating in 10GE MXP mode and configured for 100% traffic flow, do 
not drop frames when up to nine ports are in use. However, when all the ten ports are in use, some frames 
are dropped. When the tenth port is to be used, configure the Committed Info Rate (CIR) at 55% on any 
one of the ports. For more information about configuring the CIR, see the “DLP-G380 Provision the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403.

Step 6 Click Apply, then click Yes in the confirmation dialog box.

Step 7 Return to your originating procedure (NTP).

DLP-G411 Provision an ADM-10G PPM and Port

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to provision PPM settings. 

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.

Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose the SFP you want to install from the drop-down list.

• PPM Type—Choose the number of ports supported by your SFP from the drop-down list. If only one 
port is supported, PPM (1 port) is the only option. 

Step 5 Click OK. The newly created PPM appears in the Pluggable Port Modules area. The row in the Pluggable 
Port Modules area turns white and the Actual Equipment Type column lists the equipment name.

Step 6 In the Pluggable Ports area, click Create. The Create Ports dialog box appears.

10GE MXP GE_XP

GE_XPE

Provisions the GE_XP or GE_XPE as a 10 Gigabit Ethernet 
muxponder. Traffic received on Gigabit Ethernet client Ports 
1-1 through 10-1 is multiplexed and sent to 10 Gigabit 
Ethernet trunk Port 21-1, and traffic received on Gigabit 
Ethernet client Ports 11-1 through 20-1 is multiplexed and sent 
to 10 Gigabit Ethernet trunk Port 22-1.

20GE MXP GE_XP

GE_XPE

Provisions the GE_XP or GE_XPE as a 20 Gigabit Ethernet 
muxponder. Traffic received on Gigabit Ethernet client Ports 
1-1 through 20-1 is multiplexed and sent to 10 Gigabit 
Ethernet trunk Port 21-1. Trunk port 22-1 is not used.

Table 11-42 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Modes

Mode Cards Description

Purpose This task provisions a fixed-rate PPM and port on an ADM-10G PPM card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G452 Change the OTU2_XP Card Mode
Step 7 In the Create Ports dialog box, complete the following:

• Port—Choose the port you want to configure from the drop-down list.

• Port Type—Choose the port type, such as OC-3, OC-12, OC-48, or ONE-GE from the drop-down 
list. 

– Ports 1 - 8 can only be OC-3, OC-12, or ONE_GE

– Ports 9 - 12 can on be OC-3 or OC-12

– Ports 13 - 16 can only be OC-3, OC-12, or OC-48

Step 8 Click OK. The newly created port appears in the Pluggable Ports area. The port type you provisioned is 
listed in the Rate column.

Step 9 If you want to provision a PPM or another port, repeat Steps 4 through 8. 

Step 10 Return to your originating procedure (NTP).

DLP-G452 Change the OTU2_XP Card Mode

Caution Changing the card configuration to 10G Ethernet LAN Phy to WAN Phy automatically replaces the 
current port configurations (Ports 1 and 3) to 10G Ethernet and OC192. This resets and reboots the 
OTU2_XP card.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the card mode.

Step 2 In card view, click the Provisioning > Line > Ports tab.

Step 3 Verify that all provisioned client or trunk ports have an OOS-MA, DSBLD (ANSI) or Locked-enabled, 
disabled (ETSI) service state in the Service State column. If so, continue with Step 4. If not, complete 
the following substeps.

a. For the first port that is not out of service, in the Admin State column, choose OOS, DSBLD (ANSI) 
or Locked, disabled (ETSI).

b. Repeat Step a for each port that is not out of service.

c. Click Apply.

Step 4 Click the Provisioning > Card tab.

Step 5 Change the Card Configuration as needed:

• Transponder—Choose this option to provision the OTU2_XP card as a transponder. Port pairs 1-3 
and 2-4 are both configured as transponders. This is the default card configuration.

Purpose This task changes the OTU2_XP card mode. The card mode determines 
which PPMs can be provisioned for the card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G274 Verify Topologies for ETR_CLO and ISC Services
• Standard Regen—Choose this option to provision the OTU2_XP card as a standard regenerator 
(with E-FEC only on one port). Port pairs 1-3 and 2-4 are both configured as regenerators. 

• Enhanced FEC—Choose this option to provision the OTU2_XP card as an E-FEC regenerator 
(with E-FEC on two ports). Port pair 3-4 is configured as enhanced regenerator. Ports 1 and 2 are 
not used.

• Mixed—Choose this option to provision the OTU2_XP card as a transponder and a standard 
regenerator (mixed configuration). One of the port pair (1-3 or 2-4) is configured as a transponder 
and the other port pair as a standard regenerator.

• 10G Ethernet LAN Phy to WAN Phy—Choose this option to provision the OTU2_XP card to 
enable the 10G Ethernet LAN Phy to WAN Phy conversion. Port pair 1-3 supports LAN Phy to WAN 
Phy conversion. Port pair 2-4 can be configured either as a transponder or a standard regenerator.

Note If you revert to the previous release (release earlier than 9.10), be sure to disable the 10G 
Ethernet LAN Phy to WAN Phy conversion feature. If you do not disable the 10G Ethernet LAN 
Phy to WAN Phy feature, an error message stating that the user needs to disable 10G Ethernet 
LAN Phy to WAN Phy feature before reverting to the previous release is displayed.

Note Table 11-182 on page 11-462 lists the Ethernet variables supported on Ports 1 and 3 of the 
OTU2_XP card that has the 10G Ethernet LAN Phy to WAN Phy enabled. When the card is in 
the 10G Ethernet LAN Phy to WAN Phy mode, no 10G FC RMONS are supported on Ports 2 
and 4.

For more information on OTU2_XP card configuration rules, see the “11.16.5 OTU2_XP Card 
Configuration Rules” section on page 11-104.

Step 6 Click Apply. Then click Yes in the confirmation dialog box.

Step 7 Return to your originating procedure (NTP).

DLP-G274 Verify Topologies for ETR_CLO and ISC Services

Step 1 Display your site plan in Cisco TransportPlanner.

Step 2 Verify that the topology where you plan to run the ETR_CLO or ISC service can support the service. 
The following topologies support ETR_CLO or ISC: 

• Single span—Two terminal sites with no intermediate sites in between and one of the following sets 
of cards installed:

Purpose This task verifies that the DWDM network topology can support the IBM 
ETR_CLO and ISC services.

Tools/Equipment Cisco TransportPlanner site plan

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G274 Verify Topologies for ETR_CLO and ISC Services
– 32MUX-O and 32DMX-O cards

– 32WSS and 32DMX cards

– 32WSS and 32-DMX-O cards 

– 40-MUX-C and 40-DMX-C/40-DMX-CE cards

– 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards

Figure 11-50 shows a single-span topology as displayed in Cisco TransportPlanner.

Figure 11-50 Single-Span Topology

• Point-to-Point—Two terminal sites with one of the following sets of cards installed:

– 32MUX-O and 32DMX-O cards

– 32WSS and 32DMX cards

– 32WSS and 32-DMX-O cards 

– 40-MUX-C and 40-DMX-C/40-DMX-CE cards

– 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards

Line amplifiers can be installed between the terminal sites, but intermediate (traffic terminating) 
sites cannot be installed. Figure 11-51 shows a point-to-point topology as shown in 
Cisco TransportPlanner.

Figure 11-51 Point-to-Point Topology

• Two hubs—Two hub nodes in a ring with one of the following sets of cards installed:

– 32MUX-O and 32DMX-O cards

– 32WSS and 32DMX cards

– 32WSS and 32-DMX-O cards 

– 40-MUX-C and 40-DMX-C/40-DMX-CE cards

– 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards

Line amplifiers can be installed between the hubs. Figure 11-52 shows two hub nodes with no line 
amplifier nodes installed. Figure 11-53 shows two hub nodes with line amplifier nodes installed.
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DLP-  G278 Provision the Optical Line Rate
Figure 11-52 Hubs with No Line Amplifiers

Figure 11-53 Hubs with Line Amplifiers

Step 3 Return to your originating procedure (NTP).

DLP-G278 Provision the Optical Line Rate
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Purpose This task provisions the line rate for TXP, MXP, AR_MXP, AR_XP, 
AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G726 Preprovisioning a Multirate PPM

DLP-G274 Verify Topologies for ETR_CLO and ISC Services, 
page 11-173, if you are provisioning an ETR_CLO service.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G278 Provision the Optical Line Rate
Note The optical line rate for cards with single-rate PPMs is provisioned automatically when you complete 
the DLP-G726 Preprovisioning a Multirate PPM task if the trunk port is out of service. If the optical line 
rate was provisioned automatically, you do not need to complete this task for the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10EX_C, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP card. If the trunk port was in-service when you provisioned the 
PPM, complete this task to provision the optical line rate manually for those cards.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP, MXP, AR_MXP, 
AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
OTU2_XP card where you want to provision PPM ports. If the data rate that you are provisioning is 
DV-6000, HDTV, ESCON, SDI/D1 Video, ISC1, ISC3 (for TXP_MR_2.5G and TXPP_MR_2.5G cards), 
or ETR_CLO, complete the following steps. Otherwise, continue with Step 4.

a. Click the Provisioning > OTN > OTN Lines tabs.

b. In the ITU-T G.709 OTN field for the respective PPM, choose Disable.

c. In the FEC field for the respective PPM, choose Disable.

d. Click Apply.

Step 2 For the TXP_MR-10G card, click the Provisioning > Data Rate Selection tabs. For all other cards, go 
to Step 4.

Step 3 In the Data Rate Selection area, click Create and choose the type of port from the drop-down list. The 
supported port types are SONET (including 10G Ethernet WAN Phy) and 10G Ethernet LAN Phy.

Step 4 Click the Provisioning > Pluggable Port Modules tabs. 

Step 5 In the Pluggable Ports area, click Create. The Create Port dialog box appears.

Step 6 In the Create Port dialog box, complete the following:

• Port—Choose the port and port number from the drop-down list. The first number indicates the PPM 
in the Pluggable Port Modules area, and the second number indicates the port number on the PPM. 
For example, the first PPM with one port appears as 1-1 and the second PPM with one port appears 
as 2-1. The PPM number can be 1 to 4, but the port number is always 1. 

• Port Type—Choose the type of port from the drop-down list. The port type list displays the 
supported port rates on your PPM. See Table 11-43 on page 11-177 for definitions of the supported 
rates on the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 
10x10G-LC, CFP-LC, AR_MXP, AR_XP, or AR_XPE card. 

Step 7 Click OK. The row in the Pluggable Ports area turns white if the physical SFP is installed and light blue 
if the SFP is not installed. 
If the optical parameter values differ from the NE Default settings, change the port state to In-Service 
(for ANSI) or Unlocked (for ETSI) to synchronize the values with the NE Default settings. 

Step 8 Repeat Step 5 through Step 7 to configure the rest of the port rates as needed.
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DLP-  G278 Provision the Optical Line Rate
Table 11-43 PPM Port Types

Card Port Type

TXP_MR_2.5G 

TXPP_MR_2.5G

• OC-3/STM1—155 Mbps

• OC-12/STM4—622 Mbps

• OC-48/STM16—2.48 Gbps

• ONE_GE—One Gigabit Ethernet 1.125 Gbps

• ESCON—Enterprise System Connection 200 Mbps (IBM 
signal)

• DV6000—Proprietary signal from video vendor

• SDI_D1_VIDEO—Serial Digital Interface and Digital Video 
signal type 1

• HDTV—High Definition Television

• PASS-THRU—Not specified

• FC1G—Fibre Channel 1.06 Gbps

• FC2G—Fibre Channel 2.125 Gbps

• FICON1G—Fiber connectivity1.06 Gbps (IBM signal)

• FICON2G—Fiber connectivity 2.125 Gbps (IBM signal)

• ETR_CLO—External Time Reference–Control Link Oscillator

• ISC compat—InterSystem Coupling Link 1 (ISC1)

• ISC peer—InterSystem Coupling Link 3 (ISC3)

• DVB-ASI — Proprietary signal from video vendor. Digital 
Video Broadcast - Asynchronous Serial Interface

• ISC1— InterSystem Channel 1 Gbps (IBM signal)

MXP_2.5G_10G

MXP_2.5G_10E 

MXP_2.5G_10E_C 

MXP_2.5G_10E_L

MXP_2.5G_10EX_C

• OC-48/STM16—2.48 Gbps1

TXP_MR_10G2 • SONET (OC-192)/SDH (STM-64) including 10G Ethernet 
WAN Phy

• 10G Ethernet LAN Phy

TXP_MR_10E 

TXP_MR_10E_C 

TXP_MR_10E_L

TXP_MR_10EX_C

• SONET (OC-192)/SDH (STM-64) including 10G Ethernet 
WAN Phy—10 Gbps

• 10G Ethernet LAN Phy—10 Gbps Ethernet

• 10G Fibre Channel—10 Gbps Fibre Channel

• (TXP_MR_10EX_C only) IB_5G
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40E-TXP-C 
40ME-TXP-C

• SONET (OC-768)/SDH (STM-256)

• 40G Ethernet LAN Phy

• OTU3

MXP_MR_2.5G 

MXPP_MR_2.5G

If the card mode is FC_GE:

• FC1G ISL—Fibre Channel 1.06 Gbps (Ports 1-1 and 2-1)

• FC2G ISL—Fibre Channel 2.125 Gbps (Port 1-1 only)

• FICON1G ISL—Fiber connectivity 1.06 Gbps (IBM signal) 
(Ports 1-1 and 2-1)

• FICON2G ISL—Fiber connectivity 2.125 Gbps (IBM signal) 
(Port 1-1 only)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps (Ports 1-1 and 
2-1 only)

If the card mode is Mixed:

• FC1G ISL—Fibre Channel 1.06 Gbps (Port 1-1 only)

• FICON1G ISL—Fiber connectivity 1.06 Gbps (IBM signal) 
(Port1-1 only)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps (Port 1-1 only)

• ESCON—Enterprise System Connection 200 Mbps (IBM 
signal) (Ports 5-1 through 8-1)

If the card mode is ESCON:

• ESCON—Enterprise System Connection 200 Mbps (IBM 
signal) (Ports 1-1 through 8-1)

Table 11-43 PPM Port Types (continued)

Card Port Type
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MXP_MR_10DME_C 

MXP_MR_10DME_L

MXP_MR_10DMEX_C

If the port mode is FC_GE_ISC:

• FC1G—Fibre Channel 1.06 Gbps (Ports 1-1 through 8-1)

• FC2G—Fibre Channel 2.125 Gbps (Ports 1-1, 3-1, 5-1, and 7-1 
only; ports are not available if the port that follows—2-1, 4-1, 
6-1, or 8-1—has a PPM provisioned.)

• FICON1G—Fiber connectivity 1.06 Gbps (IBM signal) 
FICON2G—Fiber connectivity 2.125 Gbps (IBM signal) (Ports 
1-1, 3-1, 5-1, and 7-1 only; ports are not available if the port 
that follows—2-1, 4-1, 6-1, or 8-1—has a PPM provisioned.)

• ONE_GE—One Gigabit Ethernet 1.125 Gbps (Ports 1-1 
through 8-1)

• ISC COMPAT (Ports 1-1 through 8-1)

• ISC3 PEER 1G (Ports 1-1 through 8-1)

• ISC3 PEER 2G (Ports 1-1, 3-1, 5-1, and 7-1 only; ports are not 
available if the port that follows—2-1, 4-1, 6-1, or 8-1—has a 
PPM provisioned.)

If the port mode is FC4G:

• FC4G—Fibre Channel 4.25 Gbps (Ports 1-1 or 5-1 only; ports 
are not available if any of the three ports that follow has a PPM 
provisioned.)

• FICON4G—Fiber connectivity 4.25 Gbps (IBM signal) (Ports 
1-1 or 5-1 only; ports are not available if any of the three ports 
that follow has a PPM provisioned.)

40G-MXP-C
40E-MXP-C
40ME-MXP-C

• SONET (OC-192)/SDH (STM-64)

• FC8G

• FC10G

• TEN_GE

• OTU2

GE_XP

10GE_XP

GE_XPE

10GE_XPE

• GE_XP and GE_XPE client ports1

• 10GE_XP and 10GE_XPE client and trunk ports; GE_XP and 
GE_XPE trunk ports1

Table 11-43 PPM Port Types (continued)

Card Port Type
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OTU2_XP • SONET (including 10G Ethernet WAN Phy)—10 Gbps

• 10G Ethernet LAN Phy—10 Gbps Ethernet

• 10G Fiber Channel—10 Gbps Fibre Channel

• IB_5G—InfiniBand 5 Gbps

Note If you have an OTU2 signal in which the OPU2 has been 
generated by multiplexing four ODU1 signals, choose 
SONET as the port rate. This allows the OTU2 signal to be 
transported transparently in standard or E-FEC regenerator 
configuration.

Table 11-43 PPM Port Types (continued)

Card Port Type
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Step 9 Return to your originating procedure (NTP).

AR_MXP

AR_XP

AR_XPE

• OC-3/STM1—155 Mbps 

• OC-12/STM4—622 Mbps 

• OC-48/STM16—2.48 Gbps 

• Gigabit Ethernet—1.125 Gbps

• Fast Ethernet—100 Mbps

• ESCON-Enterprise System Connection 200 Mbps (IBM signal) 

• FC1G—Fibre Channel 1.06 Gbps 

• FC2G—Fibre Channel 2.125 Gbps 

• FC4G—Fibre Channel 4.25 Gbps

• FC8G—Fibre Channel 8.5 Gbps

• FICON1G—Fiber connectivity1.06 Gbps (IBM signal) 

• FICON2G—Fiber connectivity 2.125 Gbps (IBM signal) 

• FICON4G—Fiber connectivity 4.25 (IBM signal) 

• FICON8G—Fiber connectivity 8.5 Gbps (IBM signal) 

• SD-SDI—270 Mbps

• HD-SDI—1.485 Gbps

• Third-generation SDI (3G-SDI)—2.970 Gbps

• OTU2E —11.09 Gbps

• OTU1—2.66 Gbps

100G-LC-C

10x10G-LC

CFP-LC

• SONET (OC-192)/SDH (STM-64)

• 10G Ethernet LAN Phy

• 40G Ethernet LAN Phy

• 100 GE

• FC 8G

• FC 10G

• OTU2

• OTU3

• OTU4

1. Automatically provisioned when the PPM is created if the trunk port is out of service.

2. Provisioned on the Data Rate Selection tab.

Table 11-43 PPM Port Types (continued)

Card Port Type
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NTP-G33 Create a Y-Cable Protection Group

Note Y-cable protection is available for the 10x10G-LC card when it is provisioned in one of the following 
modes:

• TXP-10G mode—The client ports are provisioned with 10G Ethernet LAN Phy and 8G FC 
payloads.

• MXP-10G mode—The client ports are provisioned with 10GE, 8G FC, and OC192/STM-64 
payloads.

Note Y-cable protection is available for the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards when they are 
provisioned in the 10GE MXP, 20GE MXP, or 10GE TXP mode. If you are provisioning Y-cable 
protection for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, the Ethernet mode must be set to 
1000 and 10000 Mbps respectively. To provision the Ethernet mode, see the “DLP-G380 Provision the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403. Y-cable 
protection cannot be provisioned for the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards when they 
are provisioned in L2-over-DWDM mode.

Note Y-cable protection is available for the OTU2_XP card when it is provisioned in the TXP card mode. The 
OTU2-XP and 40E-MXP-C card cannot implement Y-cable protection for the client ports in 10 GE LAN 
PHY mode. Hence, a pair of OTU2_XP cards is used at each end in pass-through mode (Transponder 
mode with G.709 disabled) to implement Y-cable protection. The 40E-MXP-CE card can implement 

Purpose This procedure creates a Y-cable protection group between the client ports 
of two TXP, MXP, AR_XP, AR_MXP, AR_XPE, 10x10G-LC, CFP-LC, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP cards when the 
cards are provisioned in the TXP or MXP mode. For additional information 
about Y-cable protection, see “G.34.1.1 Y-Cable Protection” section on 
page G-30.

Tools/Equipment • Installed TXP, MXP, AR_MXP, AR_XP, AR_XPE, 10x10G-LC, 
CFP-LC, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP 
card.

• Cisco TransportPlanner Traffic Matrix

Prerequisite Procedures In the Cisco ONS 15454 Hardware Installation Guide:

• NTP-G15 Install the Common Control Cards

• NTP-G14 Install DWDM Equipment

• DLP-G46 Log into CTC

• NTP-G139 Verify Cisco Transport Planner Reports and Files, 
page 14-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Y-cable protection without the OTU2-XP card for the client ports in LAN PHY GFP mode. However, the 
40E-MXP-CE card cannot implement Y-cable protection without the OTU2-XP card for the client ports 
in LAN PHY WIS mode.

Note For SONET or SDH payloads, Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the 
ports are not in a Y-cable protection group.

Step 1 View the Cisco TransportPlanner Traffic Matrix (see the Table 14-1 on page 14-4) for your site. Verify 
the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, or OTU2_XP cards that need Y-cable protection groups. (Cards requiring Y-cable 
protection are indicated with “Y-Cable” in the Traffic Matrix table Protection Type column. For more 
information, see to the Cisco TransportPlanner DWDM Operations Guide.)

Step 2 Verify that the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP cards are installed according to the requirements specified in 
Table 14-7 on page 14-107. Table 11-44 lists the protection types available in the ONS 15454 for 
DWDM client cards. 
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Table 11-44 Protection Types

Protection Type Cards Description and Installation Requirements

Y-cable MXP_2.5_10G

MXP_2.5_10E

MXP_2.5_10E_C

MXP_2.5_10E_L

TXP_MR_10EX_C

TXP_MR_10G

TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_2.5G

40E-TXP-C

40ME-TXP-C

MXP_MR_2.5G

MXP_MR_10DME_C

MXP_MR_10DME_L

MXP_MR_10DMEX_C

40G-MXP-C

40E-MXP-C

40ME-MXP-C

GE_XP1

10GE_XP2

GE_XPE

10GE_XPE

OTU2_XP

AR_MXP

AR_XP

AR_XPE

10x10G-LC

CFP-LC

Pairs a working transponder or muxponder card or port with a protect 
transponder or muxponder card or port. The protect port must be on a 
different card than the working port and it must be the same card type as 
the working port. The working and protect port numbers must be the 
same, that is, Port 1 can only protect Port 1, Port 2 can only protect Port 
2, and so on.

Note The working and protect card must be in the same shelf for a 
multishelf node.
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Step 3 Verify that pluggable ports are provisioned for the same payload and payload rate on the TXP, MXP, 
AR_MXP, AR_XP, AR_XPE, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
OTU2_XP cards where you want to create the Y-cable protection group:

a. Display the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP card in card view. 

b. Click the Provisioning > Pluggable Port Module tab. 

c. Verify that a pluggable port is provisioned in the Pluggable Port Module area, and the payload type 
and rate is provisioned for it in the Pluggable Ports area. If they are not the same, for example, if the 
pluggable port and rate are not the same, you must either delete the provisioned rate and create a 
new rate to match using the DLP-G725 Preprovisioning PPM Slot task or replace the pluggable port 
(SFP or XFP) using the DLP-G728 Remove PPM from the Line Card task.

Step 4 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Protection 
tabs.

Step 5 In the Protection Groups area, click Create.

Step 6 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric 
(a-z, A-Z, 0-9) characters. Special characters are permitted. For TL1 compatibility, do not use 
question mark (?), backslash (\), or double quote (“) characters.

• Type—Choose Y Cable from the drop-down list.

• Protect Port—From the drop-down list, choose the port that will be the standby or protection port to 
the active port. The list displays the available transponder or muxponder ports. If transponder or 
muxponder cards are not installed, no ports appear in the drop-down list. 

Splitter TXPP_MR_2.5G

MXPP_MR_2.5G

AR_MXP

AR_XP

AR_XPE

A splitter protection group is automatically created when a 
TXPP_MR_2.5G, MXPP_MR_2.5G, AR_MXP, AR_XP, or AR_XPE 
card is installed. You can edit the splitter protection group name.

OTU2_XP A splitter protection group is configurable for the OTU2_XP card. You 
can create a splitter protection group on ports 3 and 4 of the OTU2_XP 
card using the “NTP-G199 Create a Splitter Protection Group for the 
OTU2_XP Card” procedure on page 11-186.

1+1 GE_XP

10GE_XP

GE_XPE

10GE_XPE

In the Layer 2 (L2) card mode 1+1 protection is provided to protect the 
card against client port and card failure. 

1. When provisioned in 10GE MXP or 20GE MXP card mode.

2. When provisioned in 10GE TXP card mode.

Table 11-44 Protection Types

Protection Type Cards Description and Installation Requirements
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After you choose the protect port, a list of available working ports appear in the Available Ports list. If 
no cards are available, no ports appear. If this occurs, you can not complete this task until you install the 
physical cards or preprovision the ONS 15454 slots using the “DLP-G353 Preprovision a Slot” task on 
page 14-54.

Step 7 From the Available Ports list, select the port that will be protected by the port you selected in 
Protect Ports. Click the top arrow button to move the port to the Working Ports list.

Step 8 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range 
is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will 
elapse before the traffic reverts to the working card. The reversion timer starts after conditions 
causing the switch are cleared.

Note The bidirectional switching option is available for Y-cable protection groups only in the following cases:

• On the MXP_MR_10DME card when ISC3_PEER_1G/ISC3_PEER_2G is the client payload.

• On the MXP_MR_10DME and MXP_MR_2.5G cards when Fibre Channel is the client payload. In 
this case bidirectional switching is:

– Automatically enabled when Distance Extension is enabled.

– Automatically disabled when Distance Extension is disabled.

The bidirectional switching option is available for all SONET and SDH 1+1 protection groups.

Step 9 Click OK.

Step 10 Repeat this procedure for every Y-cable protection group indicated in the Cisco TransportPlanner Traffic 
Matrix.

Stop. You have completed this procedure. 

NTP-G199 Create a Splitter Protection Group for the OTU2_XP 
Card

Purpose This procedure creates a splitter protection group between the trunk ports 
of an OTU2_XP card. For additional information about splitter protection, 
see the “G.34.1.2 Splitter Protection” section on page G-33.

Tools/Equipment Installed OTU2_XP card

Cisco TransportPlanner Traffic Matrix
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Note A splitter protection group is automatically created when a TXPP_MR_2.5G, MXPP_MR_2.5G, or PSM 
card is installed. You can edit the splitter protection group name for these cards. The splitter protection 
group is deleted when you delete the TXPP_MR_2.5G, MXPP_MR_2.5G, or PSM card.

Note Splitter protection is available for the OTU2_XP card when it is provisioned in Transponder 
configuration only. In a splitter-protected Transponder configuration, Port 1 is the client port, Port 3 is 
the working trunk port, and Port 4 is the standby trunk port.

Note For SONET or SDH payloads, Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the 
ports are not in a splitter protection group.

Step 1 View the Cisco TransportPlanner Traffic Matrix (see the Table 14-1 on page 14-4) for your site. Verify 
which OTU2_XP card needs a splitter protection group. (Cards requiring splitter protection are indicated 
with “Splitter” in the Traffic Matrix table Protection Type column. Refer to the Cisco TransportPlanner 
DWDM Operations Guide for more information.)

Step 2 Verify that the OTU2_XP card is installed according to the requirements specified in Table 14-7 on 
page 14-107. 

Step 3 Verify that the pluggable port (SFP or XFP) slot is provisioned for the same payload rate as the pluggable 
port on the OTU2_XP card where you will create the splitter protection group:

a. Display the OTU2_XP card in card view. 

b. Click the Provisioning > Pluggable Port Module tabs. 

c. Verify that a pluggable port (SFP or XFP) slot is provisioned in the Pluggable Port Module area, and 
that the payload rate of the pluggable port (SFP or XFP) slot is same as the payload rate of the 
pluggable port on the OTU2_XP card provisioned in the Pluggable Ports area. If they are not the 
same, you must either delete the provisioned rate and create a new rate to match using the DLP-G725 
Preprovisioning PPM Slot task or replace the pluggable port (SFP or XFP) using the DLP-G728 
Remove PPM from the Line Card task.

Step 4 In node view (single-shelf mode) or shelf view (multishelf view), click the Provisioning > Protection 
tabs.

Step 5 In the Protection Groups area, click Create.

Step 6 In the Create Protection Group dialog box, enter the following:

Prerequisite Procedures In the Cisco ONS 15454 Hardware Installation Guide:

• NTP-G15 Install the Common Control Cards

• NTP-G14 Install DWDM Equipment

DLP-G46 Log into CTC

NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 
0-9) characters. Special characters are permitted. For TL1 compatibility, do not use question mark 
(?), backslash (\), or double quote (“) characters.

• Type—Choose Splitter from the drop-down list.

• Protect Card—From the drop-down list, choose the port that will be the standby or protection port 
to the active port. The list displays the available OTU2_XP ports. If transponder or muxponder cards 
are not installed or if the trunk ports of the card are part of a regenerator group, no ports appear in 
the drop-down list. 

After you choose the protect port, a list of available working ports appear in the Available Cards list. If 
no cards are available, no ports appear. If this occurs, you cannot complete this task until you install the 
physical cards or preprovision the ONS 15454 slots using the “DLP-G353 Preprovision a Slot” task on 
page 14-54.

Step 7 From the Available Cards list, select the port that will be protected by the port you selected in 
Protect Cards. Click the top arrow button to move the port to the Working Cards list.

Step 8 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range 
is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will 
elapse before the traffic reverts to the working card. The reversion timer starts after conditions 
causing the switch are cleared.

Note The Bidirectional Switching option is not applicable for splitter protection groups.

Step 9 Click OK.

Step 10 Repeat this procedure for every splitter protection group indicated in the Cisco TransportPlanner Traffic 
Matrix.

Stop. You have completed this procedure. 

NTP-G198 Create 1+1 Protection for GE_XP, 10GE_XP, GE_XPE, 
or 10GE_XPE Cards

Purpose This procedure creates a 1+1 protection group to protect against client port 
and card failure of GE_XP, 10GE_XP, GE_XPE, 10GE_XPE cards. For 
additional information about 1+1 protection, see the “G.34.2 1+1 
Protection” section on page G-34.

Tools/Equipment None

Prerequisite Procedures In the Cisco ONS 15454 Hardware Installation Guide:

• NTP-G15 Install the Common Control Cards 

• NTP-G14 Install DWDM Equipment

NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4
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Step 1 Complete the” DLP-G46 Log into CTC” task at the node where you want to protect the card against 
client port and card failure. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed according to the 
requirements specified in Table 14-7 on page 14-107.

Step 3 Complete the NTP-G242 Create an Internal Patchcord Manually, page 14-112 by selecting the Trunk to 
Trunk (L2) option, at the trunk port where you want to create 1+1 protection.

Step 4 Complete the “NTP-G461 Create a 1+1 Protection Group for GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards” task on page 11-189 to create a protection group.

Step 5 Configure the standby port behavior, by setting the Protection Action to None or Squelch. For detailed 
information on how to configure the standby port behavior, see the, “DLP-G380 Provision the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403.

Note Do not enable squelch in a 1 + 1 protection group, if the 100FX, 100LX SFP, and 
ONS-SE-ZE-EL SFP is used in the protection group and is connected to the peer via the parallel 
cable (not Y-cable)

Note When you configure L2 1 + 1 protection on 10GE_XP and 10GE_XPE cards, set the Protection 
Action to None on the client ports. Setting the Protection Action as Squelch results in 
unexpected switching behavior.

Step 6 Configure the standby and active port speed, by setting the mode parameter to Auto or 1000 or any other 
values. For detailed information on how to configure the standby port behavior, see the “DLP-G380 
Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” task on 
page 11-403.

Stop. You have completed this procedure. 

NTP-G461 Create a 1+1 Protection Group for GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE Cards

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a 1+1 protection group for GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE slots where internal patchcords were created.

Tools/Equipment None

Prerequisite Procedures DLP-G344 Verify Provisionable and Internal Patchcords, page 17-67

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Protection tabs.

Step 2 In the Protection Groups area, click Create.

Step 3 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 
0-9) characters. Special characters are permitted. For TL1 compatibility, do not use question mark 
(?), backslash (\), or double quote (“) characters.

• Type—Choose L2 1+1 (port) from the drop-down list.

• Protect Port—From the drop-down list, choose the port that will be the standby or protection port 
for the active port. The list displays the available transponder or muxponder ports. If transponder or 
muxponder cards are not installed, no ports appear in the drop-down list. 

After you choose the protect port, a list of available working ports appear in the Available Ports list. If 
no cards are available, no ports appear. If this occurs, you cannot complete this task until you install the 
physical cards or preprovision the ONS 15454 slots using the “DLP-G353 Preprovision a Slot” task on 
page 14-54.

Step 4 From the Available Ports list, select the port that will be protected by the port you selected in the 
Protected Port drop-down list. Click the top arrow button to move the port to the Working Ports list.

Step 5 Complete the remaining fields:

• Revertive—Check this check box if you want traffic to revert to the working port after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range 
is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will 
elapse before the traffic reverts to the working card. The reversion timer starts after conditions 
causing the switch are cleared.

The bidirectional switching option is available for SONET and SDH 1+1 protection groups. 

Step 6 Click OK.

Step 7 Repeat this procedure for every 1+1 protection group indicated in the Cisco TransportPlanner Traffic 
Matrix.

Step 8 Return to your originating procedure (NTP).
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NTP-G98 Provision the 2.5G Multirate Transponder Card Line 
Settings and PM Parameter Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the transponder card 
settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G229 Change the 2.5G Multirate Transponder Card Settings, page 11-192

• DLP-G230 Change the 2.5G Multirate Transponder Line Settings, page 11-193

• DLP-G231 Change the 2.5G Multirate Transponder Line Section Trace Settings, page 11-196

• DLP-G232 Change the 2.5G Multirate Transponder SONET or SDH Line Threshold Settings, 
page 11-198

• DLP-G320 Change the 2.5G Multirate Transponder Line RMON Thresholds for 1G Ethernet or 1G 
FC/FICON Payloads, page 11-201

• DLP-G305 Provision the 2.5G Multirate Transponder Trunk Port Alarm and TCA Thresholds, 
page 11-202

• DLP-G306 Provision the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds, 
page 11-204

• DLP-G234 Change the 2.5G Multirate Transponder OTN Settings, page 11-208

• DLP-G367 Change the 2.5G Multirate Transponder Trunk Wavelength Settings, page 11-197

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for TXP_MR_2.5G 
and TXPP_MR_2.5G transponder cards.

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

DLP-G726 Preprovisioning a Multirate PPM (if necessary)

DLP-G278 Provision the Optical Line Rate, page 11-175 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G229 Change the 2.5G Multirate Transponder Card Settings
DLP-G229 Change the 2.5G Multirate Transponder Card Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 11-45. 

Note The Card subtab Framing Type and Tunable Wavelengths fields are display-only. Framing Type 
shows the card framing type, either SONET or SDH, depending on whether the card is installed 
in an ANSI or ETSI chassis. The Tunable Wavelengths field shows the tunable wavelengths for 
the physical TXP_MR_2.5G or TXPP_MR_2.5G that is installed.

Purpose This task changes the card settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G230 Change the 2.5G Multirate Transponder Line Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G230 Change the 2.5G Multirate Transponder Line Settings

Table 11-45 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation (option only 
supported for SONET/SDH payloads).

• Transparent

• Section (ANSI) or Regeneration 
Section (ETSI)

• Line (ANSI) or Multiplex Section 
(ETSI)

Regeneration 
Peer Slot

Sets the slot containing another 
TXP_MR_2.5G or TXPP_MR_2.5G card 
to create a regeneration peer group. A 
regeneration peer group facilitates the 
management of two TXP_MR_2.5G or 
TXPP_MR_2.5G cards that are needed to 
perform a complete signal regeneration.

The regeneration peer group 
synchronizes provisioning of the two 
cards. Payload type and ITU-T G.709 
optical transport network (OTN) changes 
made on one TXP_MR_2.5G or 
TXPP_MR_2.5G card are reflected on the 
peer TXP_MR_2.5G or TXPP_MR_2.5G 
card.

Note Y-cable protection groups cannot 
be created on TXP_MR_2.5G or 
TXPP_MR_2.5G cards that are in 
a regeneration peer group.

• None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

Regeneration 
Group Name

Sets the regeneration peer group name. User defined

Purpose This task changes the line settings for the client port of the TXP_MR_2.5G 
and TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G230 Change the 2.5G Multirate Transponder Line Settings
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the line settings.

Step 2 Click the Provisioning > Line > SONET tabs.

Step 3 Modify any of the settings described in Table 11-46. 

Note The 2.5G multirate transponder trunk settings are provisioned in the “DLP-G305 Provision the 
2.5G Multirate Transponder Trunk Port Alarm and TCA Thresholds” task on page 11-202.

Table 11-46 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings

Parameter Description Options

Port (Display only) Displays the port number. • 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G card only)

Port Name The user can assign a logical name for each of the 
ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see the Administrative and 
Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI)

• OOS,MT (ANSI) or Locked,maintenance 
(ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of the 
port. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER (OC-N and STM-N payloads only) Sets the signal 
fail bit error rate.

• 1E-3

• 1E-4

• 1E-5

SD BER (OC-N and STM-N payloads only) Sets the signal 
degrade bit error rate.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G230 Change the 2.5G Multirate Transponder Line Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

ALS Mode Sets the automatic laser shutdown (ALS) function. • Disabled (default)

• Auto Restart

• Manual Restart

• Manual Restart for Test

Reach Displays the optical reach distance of the client port. Options: ANSI/ETSI

• Autoprovision/Autoprovision (default)

• SR

• SR 1/I-1—Short reach up to 2-km distance

• IR 1/S1—Intermediate reach, up to 15-km 
distance

• IR 2/S2—Intermediate reach up to 40-km 
distance

• LR 1/L1—long reach, up to 40-km distance

• LR 2/L2—long reach, up to 80-km distance

• LR 3/L3—long reach, up to 80-km distance

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths: 1310 nm through 
1560.61 nm, 100-GHz ITU spacing; coarse 
wavelength division multiplexing (CWDM) 
spacing

Note: supported wavelengths are marked by 
asterisks (**) 

AINS Soak (OC-N and STM-N payloads only) Sets the 
automatic in-service soak period.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type (OC-N and STM-N payloads only) The optical 
transport type.

• SONET

• SDH

Table 11-46 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings (continued)

Parameter Description Options
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DLP-  G231 Change the 2.5G Multirate Transponder Line Section Trace Settings
DLP-G231 Change the 2.5G Multirate Transponder Line Section Trace Settings

Note This task only applies to SONET services.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. 

Step 3 Modify any of the settings described in Table 11-47. 

Purpose This task changes the section trace settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-47 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace 

Settings

Parameter Description Options

Port (Display only) Port number. • 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If an TIM on Section overhead alarm 
arises because of a J0 overhead string 
mismatch, no alarm indication signal is 
sent to downstream nodes if this box is 
checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size
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DLP-  G367 Change the 2.5G Multirate Transponder Trunk Wavelength Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G367 Change the 2.5G Multirate Transponder Trunk Wavelength Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.

Step 3 Modify any of the settings as described in Table 11-48. 

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this display updated automatically.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 seconds.

Checked/unchecked (default)

Purpose This task changes the trunk wavelength settings for the TXP_MR_2.5G 
and TXPP_MR_2.5G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-47 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace 

Settings (continued)

Parameter Description Options
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DLP-  G232 Change the 2.5G Multirate Transponder SONET or SDH Line Threshold Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G232 Change the 2.5G Multirate Transponder SONET or SDH Line 
Threshold Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs.

Note You must modify Near End and Far End independently; 15 Min and 1 Day independently; and 
Line and Section independently. To do so, choose the appropriate radio button and click Refresh.

Step 3 Modify any of the settings in Table 11-49. 

Table 11-48  TXP_MR_2.5G and TXPP_MR_2.5G Card Wavelength Trunk Settings

Parameter Description Options

Port (Display only) Displays the port number. • 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

Wavelength The wavelength provisioned for the trunk. • First Tunable Wavelength

• Further wavelengths in 100-GHz 
ITU-T, C-band spacing. The 
wavelengths supported by the 
SFPs/XFPs plugged to the card are 
identified with two asterisks. Other 
wavelengths have a dark grey 
background. If the card is not 
installed, all wavelengths appear 
with a dark grey background.

Purpose This task changes the line threshold settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards carrying OC-3/STM-1, 
OC-12/STM-4, and OC-48/STM-16 payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G232 Change the 2.5G Multirate Transponder SONET or SDH Line Threshold Settings
Note Some parameters and options in Table 11-49 do not apply to all TXP_MR_2.5G or 
TXPP_MR_2.5G cards. If a parameter or option does not apply, that parameter or option does 
not appear in CTC.

Table 11-49 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads

Parameter Description Options - ANSI Options - ETSI

Port (Display only) Port 
number

• 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

• 1

• 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G only)

EB Path Errored Block 
indicates that one or 
more bits are in error 
within a block

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 
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DLP-  G232 Change the 2.5G Multirate Transponder SONET or SDH Line Threshold Settings
SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

SEFS (Near End Section or 
Regeneration Section 
only) Severely 
errored framing 
seconds 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

—

UAS Unavailable seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

BBE Background block 
errors

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Table 11-49 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads (continued)

Parameter Description Options - ANSI Options - ETSI
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DLP-  G320 Change the 2.5G Multirate Transponder Line RMON Thresholds for 1G Ethernet or 1G FC/FICON Payloads
Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-G320 Change the 2.5G Multirate Transponder Line RMON Thresholds for 
1G Ethernet or 1G FC/FICON Payloads

Step 1 In card view, display the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the line 
threshold settings.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 11-50 for a list of available 
Ethernet variables.

Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

Purpose This task changes the line remote monitoring (RMON) threshold settings 
for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards carrying the 
1G Ethernet or 1G FC/FICON payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-50 TXP_MR_2.5G and TXPP_MR_2.5G Card 1G Ethernet and 1G FC/FICON

Thresholds

Variable Description

ifInErrors Number of inbound packets that contained errors preventing 
them from being delivered to a higher-layer protocol.

rxTotalPkts Total number of received packets.

8b10bStatsEncodingDispErrors Number of IETF 8b10b disparity violations on the Fibre Channel 
line side.

8b10bIdleOrderedSets Number of received packets containing idle ordered sets.

8b10bNonIdleOrderedSets Number of received packets containing non-idle ordered sets.

8b10bDataOrderedSets Number of received packets containing data ordered sets.
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DLP-  G305 Provision the 2.5G Multirate Transponder Trunk Port Alarm and TCA Thresholds
Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Enter the appropriate number of seconds for the Sample Period.

Step 9 Enter the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Step 12 Return to your originating procedure (NTP).

DLP-G305 Provision the 2.5G Multirate Transponder Trunk Port Alarm and TCA 
Thresholds

Note In this task, trunk port refers to Port 2 for TXP_MR_2.5G cards, and to Ports 2 and 3 for 
TXPP_MR_2.5G cards. 

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Pluggable Port Modules tab. Under Pluggable Ports, record the Rate that is provisioned. 

Step 3 Look up the rate in Table 11-51 and note whether it is 2R or 3R.

Purpose This task changes the TXP_MR_2.5G and TXPP_MR_2.5G trunk port 
alarm and threshold crossing alert (TCA) thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G305 Provision the 2.5G Multirate Transponder Trunk Port Alarm and TCA Thresholds
Step 4 Click the Provisioning > Optics Thresholds tabs. 

Step 5 Under Types, verify that the TCA radio button is checked. If not, check it and click Refresh.

Step 6 Referring to Table 11-52, verify the trunk port TCA thresholds for RX Power High and RX Power Low 
depending on whether the rate is 2R or 3R. Provision new thresholds as needed by double-clicking the 
threshold value you want to change, deleting it, entering a new value, and hitting Enter.

Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 7 Click Apply.

Step 8 Under Types, click the Alarm radio button and click Refresh.

Table 11-51 2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

Client Interface Input Bit Rate 3R vs. 2R ITU-T G.709

OC-48/STM-16 2.488 Gbps 3R On or Off

DV-6000 2.38 Gbps 2R —

2 Gigabit Fibre Channel (2G-FC)/fiber 
connectivity (FICON)

2.125 Gbps 3R1

1. No monitoring

On or Off

High-Definition Television (HDTV) 1.48 Gbps 2R —

Gigabit Ethernet (GE) 1.25 Gbps 3R On or Off

1 Gigabit Fibre Channel (1G-FC)/FICON 1.06 Gbps 3R On or Off

OC-12/STM-4 622 Mbps 3R On or Off

OC-3/STM-1 155 Mbps 3R On or Off

Enterprise System Connection (ESCON) 200 Mbps 2R —

SDI/D1 video 270 Mbps 2R —

ISC-1 Compact 1.06 Gbps 3R Off

ISC-3 1.06 or 
2.125 Gbps

2R —

ETR_CLO 16 Mbps 2R —

Table 11-52 TXP_MR_2.5G and TXPP_MR_2.5G Trunk Port TCA Thresholds

Signal TCA RX Power Low TCA RX Power High

3R –23 dBm –9 dBm

2R –24 dBm –9 dBm
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DLP-  G306 Provision the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds
Step 9 Verify the trunk port Alarm thresholds for RX Power High is –7 dBm, and for RX Power Low is 
–26 dBm. Provision new thresholds as needed by double-clicking the threshold value you want to 
change, deleting it, entering a new value, and hitting Enter.

Step 10 Click Apply. 

Step 11 Return to your originating procedure (NTP).

DLP-G306 Provision the 2.5G Multirate Transponder Client Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 11-53, verify the Port 1 (client) TCA thresholds for RX Power High, RX Power Low, 
TX Power High, and TX Power Low based on the client interface at the other end. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and hitting Enter.

Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Purpose This task provisions the client port alarm and TCA thresholds for the 
TXP_MR_2.5G and TXPP_MR_2.5G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G306 Provision the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds
Table 11-53 TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

TCA RX
Power Low

TCA RX
Power High

TCA TX
Power Low

TCA TX
Power High

OC-3 15454-SFP3-1-IR –23 –8 –21 –2

STM-1 15454E-SFP-L.1.1 –24 –10 –21 –2

OC-12 15454-SFP12-4-IR –28 –7 –21 –2

STM-4 15454E-SFP-L.4.1 –28 –8 –21 –2

OC-48 ONS-SE-2G-S1 –18 –3 –16 3

15454-SFP-OC48-IR –18 0 –11 6

STM-16 ONS-SE-2G-S1

15454E-SFP-L.16.1

–18 –3 –16 3

ONE_GE 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

ESCON 15454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

–21 –14 –35 –8

DV6000 15454-SFP-OC48-IR –18 0 –11 6

15454E-SFP-L.16.1 –18 –3 –16 3

SDI_D1_ 
VIDEO

15454-SFP12-4-IR –28 –7 –21 –2

15454E-SFP-L.4.1 –28 –8 –21 –2

HDTV 15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

PASS-THRU 2R MODE 
(not specified)

— — — —

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–15 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3
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DLP-  G306 Provision the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds
Step 4 Click Apply.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Step 6 Referring to Table 11-54, verify the Alarm thresholds for RX Power High, RX Power Low, TX Power 
High, and TX Power Low based on the client interface that is provisioned. Provision new thresholds as 
needed by double-clicking the threshold value you want to change, deleting it, entering a new value, and 
hitting Enter.

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–15 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

ETR_CLO 15454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

–17 0 –16 3

ISC compat 15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

ISC peer 15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

Table 11-54 TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm 

Thresholds

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

OC-3 15454-SFP3-1-IR –26 –5 –17 –6

STM-1 15454E-SFP-L.1.1 –27 –7 –17 –6

OC-12 15454-SFP12-4-IR –31 –4 –17 –6

STM-4 15454E-SFP-L.4.1 –31 –5 –17 –6

OC-48 ONS-SE-2G-S1 –21 0 –12 –1

15454-SFP-OC48-IR –21 3 –7 2

STM-16 ONS-SE-2G-S1

15454E-SFP-L.16.1

–21 0 –12 –1

Table 11-53 TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface TCA Thresholds (continued)

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

TCA RX
Power Low

TCA RX
Power High

TCA TX
Power Low

TCA TX
Power High
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DLP-  G306 Provision the 2.5G Multirate Transponder Client Port Alarm and TCA Thresholds
ONE_GE 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –12 –2

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

ESCON 15454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

–24 –11 –31 –12

DV6000 15454-SFP-OC48-IR –21 3 –7 2

15454E-SFP-L.16.1 –21 0 –12 –5

SDI_D1_ 
VIDEO

15454-SFP12-4-IR –31 –4 –17 –6

15454E-SFP-L.4.1 –31 –5 –17 –6

HDTV 15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

PASS-THRU 2R MODE 
(not specified)

— — — —

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –12 –2

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–18 3 –12 –2

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –12 –2

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–18 3 –12 –2

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

Table 11-54 TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm 

Thresholds (continued)

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High
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DLP-  G234 Change the 2.5G Multirate Transponder OTN Settings
Step 7 Click Apply.

Step 8 Return to your originating procedure (NTP).

DLP-G234 Change the 2.5G Multirate Transponder OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_2.5G or 
TXPP_MR_2.5G card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, G.709 
Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in Tables 11-55 through 11-58. 

Note You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM settings 
independently. To do so, choose the appropriate radio button and click Refresh.

Table 11-55 describes the values on the Provisioning > OTN > OTN Lines tab.

ETR_CLO 15454-SFP-200
15454E-SFP-200
ONS-SE-200-MM

–20 3 –12 –2

ISC compat 15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

ISC peer 15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –12 –1

Purpose This task changes the OTN settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-54 TXP_MR_2.5G and TXPP_MR_2.5G Card Client Interface Alarm 

Thresholds (continued)

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High
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DLP-  G234 Change the 2.5G Multirate Transponder OTN Settings
Table 11-56 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 11-57 describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 11-55 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card OTN Line Settings

Parameter Description Options

Port (Display only) Displays the port number. • 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

G.709 OTN Sets the OTN lines according to 
ITU-T G.709.

• Enable

• Disable

FEC Sets the OTN lines to forward error 
correction (FEC).

• Enable

• Disable

SF BER (Display only) The signal fail bit error 
rate.

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Table 11-56 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port1 

1. Latency for a 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is 40 microseconds. Latency 
for a 2G-FC payload without ITU-T G.709 is 2 microseconds, and with ITU-T G.709 is 20 microseconds. Consider these 
values when planning a FC network that is sensitive to latency.

(Display only) Port number. • 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 
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Table 11-58 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 11-57 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Port number. • 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 11-58 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier 

Settings

Parameter Description Options

Port (Display only) Port number. • 2 (Trunk)

• 3 (Trunk) (TXPP_MR_2.5G)

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable FDI on 
TIM

If an TIM on Section overhead alarm 
arises because of a J0 overhead string 
mismatch, no alarm indication signal is 
sent to downstream nodes if this box is 
checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size
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DLP-  G234 Change the 2.5G Multirate Transponder OTN Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G96 Provision the 10G Multirate Transponder Card Line 
Settings, PM Parameters, and Thresholds

Note The TXP_MR_10G card does not support PPMs.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the transponder card 
settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 If you are provisioning a TXP_MR_10G card, complete the “DLP-G365 Provision the TXP_MR_10G 
Data Rate” task on page 11-212, and if you are provisioning a TXP_MR_10E or TXP_MR_10EX_C 
card, complete the “DLP-G712 Provision the TXP_MR_10E or TXP_MR_10EX_C Data Rate” task on 
page 11-213. If not, continue with Step 4.

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 minutes.

Checked/unchecked (default)

Purpose This procedure changes the line and threshold settings for 10G multirate 
transponder cards including the TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

DLP-G726 Preprovisioning a Multirate PPM (if necessary) 

DLP-G278 Provision the Optical Line Rate, page 11-175 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-58 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier 

Settings (continued)

Parameter Description Options
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DLP-  G365 Provision the TXP_MR_10G Data Rate
Step 4 Perform any of the following tasks as needed:

• DLP-G216 Change the 10G Multirate Transponder Card Settings, page 11-213

• DLP-G217 Change the 10G Multirate Transponder Line Settings, page 11-215

• DLP-G218 Change the 10G Multirate Transponder Line Section Trace Settings, page 11-220

• DLP-G219 Change the 10G Multirate Transponder Line Thresholds for SONET or SDH Payloads 
Including 10G Ethernet WAN Phy, page 11-222

• DLP-G319 Change the 10G Multirate Transponder Line RMON Thresholds for 10G Ethernet LAN 
Phy Payloads, page 11-225

• DLP-G301 Provision the 10G Multirate Transponder Trunk Port Alarm and TCA Thresholds, 
page 11-229

• DLP-G302 Provision the 10G Multirate Transponder Client Port Alarm and TCA Thresholds, 
page 11-230

• DLP-G221 Change the 10G Multirate Transponder OTN Settings, page 11-232

• DLP-G368 Change the 10G Multirate Transponder Trunk Wavelength Settings, page 11-221

Stop. You have completed this procedure.

DLP-G365 Provision the TXP_MR_10G Data Rate

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G card 
where you want to change the card data rate settings.

Step 2 Click the Provisioning > Data Rate Selection tabs.

Step 3 Click Create.

Step 4 In the Create Port dialog box, choose one of the following data rates:

• SONET (ANSI) or SDH (ETSI) (including 10G Ethernet WAN Phy)

• 10G Ethernet LAN Phy

Step 5 Click Ok.

Step 6 Return to your originating procedure.

Purpose This task changes the TXP_MR_10G card data rate.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G712 Provision the TXP_MR_10E or TXP_MR_10EX_C Data Rate
DLP-G712 Provision the TXP_MR_10E or TXP_MR_10EX_C Data Rate

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10E or 
TXP_MR_10EX_C card where you want to change the card data rate settings.

Step 2 Click the Provisioning > Pluggable Port Modules tabs.

Step 3 In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.

Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose the SFP you want to install from the drop-down list.

• PPM Type—Choose the number of ports supported by your SFP from the drop-down list. If only one 
port is supported, PPM (1 port) is the only option.

Step 5 Click OK. The newly created PPM appears in the Pluggable Port Modules area. The row in the Pluggable

Step 6 Port Modules area turns white and the Actual Equipment Type column lists the equipment name.

Step 7 In the Pluggable Ports area, click Create. The Create Ports dialog box appears.

Step 8 In the Create Port dialog box, choose one of the following data rates:

• SONET (ANSI) or SDH (ETSI) (including 10G Ethernet WAN Phy)

• 10G Ethernet LAN Phy

• 10G FIBER Channel

• (TXP-MR-10EX_C card only) IB_5G

Step 9 Click Ok.

Step 10 Return to your originating procedure.

DLP-G216 Change the 10G Multirate Transponder Card Settings

Purpose This task changes the TXP_MR_10E or TXP_MR_10EX_C card data rate.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the card settings for the TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G216 Change the 10G Multirate Transponder Card Settings
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, or TXP_MR_10E_L card where you want to change the card 
settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 11-59. 

Table 11-59 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Settings

Parameter Description ONS 15454 Options  ONS 15454 SDH Options

Termination 
Mode

Sets the mode of operation. (This option is 
only available for SONET/SDH payloads).

• Transparent

• Section (TXP_MR_10E 
only)

• Line

• Transparent

• Regeneration Section 
(TXP_MR_10E only)

• Multiplex Section

AIS/Squelch 
Configuration 

(TXP_MR_10E, TXP_MR_10E_C, 
TXP_MR_10E_L, or TXP_MR_10EX_C 
only) Sets the transparent termination mode 
configuration.

• Squelch

• AIS

• Squelch

• AIS

Regeneration 
Peer Slot

Sets the slot containing another 
TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, or 
TXP_MR_10EX_C card to create a 
regeneration peer group. A regeneration peer 
group facilitates the management of two 
TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, or 
TXP_MR_10EX_C cards that are needed to 
perform a complete signal regeneration.

The regeneration peer group synchronizes 
provisioning of the two cards. Payload type 
and ITU-T G.709 optical transport network 
(OTN) changes made on one TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, 
TXP_MR_10E_L, or TXP_MR_10EX_C card 
are reflected on the peer TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, 
TXP_MR_10E_L, or TXP_MR_10EX_C 
card.

Note Y-cable protection groups cannot be 
created on TXP cards that are in a 
regeneration peer group.

• None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

• None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17
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DLP-  G217 Change the 10G Multirate Transponder Line Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G217 Change the 10G Multirate Transponder Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to 
change the line settings.

Step 2 Click the Provisioning > Line > SONET/SDH/Ethernet tabs. SONET is the option for ANSI shelves 
when 10G Ethernet WAN phy is the Pluggable Port Rate, SDH is the option for ETSI shelves when 10G 
Ethernet WAN phy is the Pluggable Port Rate, and Ethernet is the option for ANSI or ETSI shelves when 
10GE LAN Phy is the Pluggable Port Rate. 

Step 3 Modify any of the settings described in Table 11-60. 

Regeneration 
Group Name

(Display only) The regeneration peer group 
name.

— —

Tunable 
Wavelengths

(Display only) Shows the supported 
wavelengths of the trunk port after the card is 
installed. For the TXP_MR_10E_C, or 
TXP_MR_10E_L cards, the first and last 
supported wavelength, frequency spacing, and 
number of supported wavelengths are shown in 
the format: first wavelength-last 
wavelength-frequency spacing-number of 
supported wavelengths. For example, the 
TXP_MR_10E_C card would show: 
1529.55nm-1561.83nm-50gHz-82. The 
TXP_MR_10E show the four wavelengths 
supported by the card that is installed. The 
TXP_MR_10G show the two wavelengths 
supported by the card that is installed.

— —

Purpose This task changes the line settings for TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-59 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Settings 

Parameter Description ONS 15454 Options  ONS 15454 SDH Options
11-215
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
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DLP-  G217 Change the 10G Multirate Transponder Line Settings
Note In Table 11-60, some parameter tabs do not always apply to all 10G multirate transponder cards. 
If a tab does not apply, it will not appear in CTC.

Table 11-60 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Line Settings

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) 
Displays the port 
number.

• 1 (OC192) (10G Ethernet WAN 
Phy) (if TXP_MR_10G)

• 1 (TEN_GE) (if Ethernet LAN is 
provisioned on the TXP_MR_10G 
card)

• 1-1 (OC192) (10G Ethernet WAN 
Phy on the TXP_MR_10E card)

• 1-1 (TEN_GE) (if Ethernet LAN is 
provisioned on the TXP_MR_10E 
card)

• 1-1 (FC10G) (if 10G fiber channel 
is provisioned on the 
TXP_MR_10E card)

• 2 (Trunk)

• (TXP_MR_10EX_C only) IB_5G

• 1 (STM-64) (10G Ethernet WAN 
Phy) (if TXP_MR_10G)

• 1 (TEN_GE) (if Ethernet LAN is 
provisioned on the TXP_MR_10G 
card)

• 1-1 (STM-64) (10G Ethernet WAN 
Phy on the TXP_MR_10E card)

• 1-1 (TEN_GE) (if Ethernet LAN is 
provisioned on the TXP_MR_10E 
card)

• 1-1 (FC10G) (if 10G fiber channel is 
provisioned on the TXP_MR_10E 
card)

• 2 (Trunk)

• (TXP_MR_10EX_C only) IB_5G

Port Name Provides the ability to 
assign the specified 
port a name.

User-defined. Name can be up to 
32 alphanumeric/special characters. 
Blank by default.

See the “DLP-G104 Assign a Name to a 
Port” task on page 17-16.

User-defined. Name can be up to 
32 alphanumeric/special characters. 
Blank by default.

See the “DLP-G104 Assign a Name to a 
Port” task on page 17-16.

Admin State Sets the port service 
state. For more 
information about 
administrative states, 
see the 
Administrative and 
Service States.

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance
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DLP-  G217 Change the 10G Multirate Transponder Line Settings
Service State (Display only) 
Identifies the 
autonomously 
generated state that 
gives the overall 
condition of the port. 
Service states appear 
in the format: 
Primary 
State-Primary State 
Qualifier, Secondary 
State. For more 
information about 
service states, see the 
Administrative and 
Service States.

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance

SF BER (SONET [ANSI] or 
SDH [ETSI] 
including 10G 
Ethernet WAN Phy 
only) Sets the signal 
fail bit error rate.

• 1E-3

• 1E-4 

• 1E-5

• 1E-3

• 1E-4 

• 1E-5

SD BER (SONET [ANSI] or 
SDH [ETSI] 
including 10G 
Ethernet WAN Phy 
only) Sets the signal 
degrade bit error rate.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Type (SONET [ANSI] or 
SDH [ETSI] 
including 10G 
Ethernet WAN Phy 
only) The optical 
transport type.

• SONET

• SDH

• SONET

• SDH

Table 11-60 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Line Settings 

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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DLP-  G217 Change the 10G Multirate Transponder Line Settings
ALS Mode Sets the ALS function 
mode. The DWDM 
transmitter supports 
ALS according to 
ITU-T G.644 
(06/99). ALS can be 
disabled, or it can be 
set for one of three 
mode options.

• Disabled (default): ALS is off; the 
laser is not automatically shut 
down when traffic outages (LOS) 
occur.

• Auto Restart: ALS is on; the laser 
automatically shuts down when 
traffic outages (LOS) occur. It 
automatically restarts when the 
conditions that caused the outage 
are resolved.

•  Manual Restart: ALS is on; the 
laser automatically shuts down 
when traffic outages (LOS) occur. 
However, the laser must be 
manually restarted when 
conditions that caused the outage 
are resolved.

• Manual Restart for Test: Manually 
restarts the laser for testing.

• Disabled (default): ALS is off; the 
laser is not automatically shut down 
when traffic outages (LOS) occur.

• Auto Restart: ALS is on; the laser 
automatically shuts down when 
traffic outages (LOS) occur. It 
automatically restarts when the 
conditions that caused the outage are 
resolved.

•  Manual Restart: ALS is on; the laser 
automatically shuts down when 
traffic outages (LOS) occur. 
However, the laser must be manually 
restarted when conditions that 
caused the outage are resolved.

• Manual Restart for Test: Manually 
restarts the laser for testing.

AINS Soak (SONET [ANSI] or 
SDH [ETSI] 
including 10G 
Ethernet WAN Phy 
only) Sets the 
automatic in-service 
soak period. 
Double-click the time 
and use the up and 
down arrows to 
change settings.

• Duration of valid input signal, in 
hh.mm format, after which the card 
becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute 
increments 

• Duration of valid input signal, in 
hh.mm format, after which the card 
becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

ProvidesSync (TXP_MR_10E, 
OC192 only) Sets the 
ProvidesSync card 
parameter. If 
checked, the card is 
provisioned as a 
network element 
(NE) timing 
reference.

Checked or unchecked Checked or unchecked

Table 11-60 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Line Settings 

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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DLP-  G217 Change the 10G Multirate Transponder Line Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

SyncMsgIn (TXP_MR_10E, 
OC192 only) Sets the 
EnableSync card 
parameter. Enables 
synchronization 
status messages (S1 
byte), which allow 
the node to choose 
the best timing 
source.

Checked or unchecked Checked or unchecked

Max Size (TXP_MR_10E, 
TXP_MR_10G LAN 
Phy only) Sets the 
maximum Ethernet 
packet size.

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

Incoming 
MAC Address

(TXP_MR_10E, 
TXP_MR_10G LAN 
Phy only) Sets the 
incoming MAC 
address.

Value of MAC address. Six bytes in 
hexadecimal format.

Value of MAC address. Six bytes in 
hexadecimal format.

Wavelength Displays the 
wavelength of the 
client port.

• First Tunable Wavelength

• Further wavelengths: 1310 nm 
through 1560.61 nm, 100-GHz 
ITU spacing; coarse wavelength 
division multiplexing (CWDM) 
spacing

Note: supported wavelengths are 
marked by asterisks (**) 

• First Tunable Wavelength

• Further wavelengths: 1310 nm 
through 1560.61 nm, 100-GHz ITU 
spacing; coarse wavelength division 
multiplexing (CWDM) spacing

Note: supported wavelengths are marked 
by asterisks (**) 

Reach Displays the optical 
reach distance of the 
client port.

The Reach options depend on the traffic 
type that has been selected.

The Reach options depend on the traffic 
type that has been selected.

Table 11-60 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Line Settings 

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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DLP-G218 Change the 10G Multirate Transponder Line Section Trace Settings

Note The Section Trace tab is available for the 10G Multirate Transponder cards only if no PPMs are 
provisioned, or the OC192 PPM is provisioned. The tab is not available if a 10G Ethernet LAN Phy or 
10G Fibre Channel PPM is provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to 
change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.

Step 3 Modify any of the settings described in Table 11-61. 

Purpose This task changes the line section trace settings for the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and 
TXP_MR_10EX_C transponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-61 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Section Trace Settings

Parameter Description ONS 15454 Options Options — ONS 15454 SDH

Port Sets the port number. • 1-1 (OC192)

• 2—Trunk

• 1-1 (STM64)

• 2—Trunk

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

• 1 byte

• 16 byte

Transmit Displays the current transmit string; sets a 
new transmit string. You can click the 
button on the right to change the display. Its 
title changes, based on the current display 
mode. Click Hex to change the display to 
hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII 
(button changes to Hex).

String of trace string size String of trace string size

Disable 
AIS/RDI on 
TIM-S

If an TIM on Section overhead alarm arises 
because of a J0 overhead string mismatch, 
no alarm indication signal is sent to 
downstream nodes if this box is checked.

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G368 Change the 10G Multirate Transponder Trunk Wavelength Settings

Note Before modifying the wavelength settings, change the port state to OOS,DSBLD (for ANSI) or 
Locked,disabled (for ETSI) and delete the circuit and patchcord provisioning present on the port. 
Payload or communication channel provisioning can be retained.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C card where you want to 
change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.

Step 3 Modify any of the settings as described in Table 11-62. 

Expected Displays the current expected string; sets a 
new expected string. You can click the 
button on the right to change the display. Its 
title changes, based on the current display 
mode. Click Hex to change the display to 
hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII 
(button changes to Hex).

String of trace string size String of trace string size

Received (Display only) Displays the current received 
string. You can click Refresh to manually 
refresh this display, or check the 
Auto-refresh every 5 sec check box to keep 
this panel updated.

String of trace string size String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 seconds.

Checked/unchecked (default) Checked/unchecked (default)

Purpose This task changes the trunk wavelength settings for the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and 
TXP_MR_10EX_C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-61 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Section Trace Settings 

Parameter Description ONS 15454 Options Options — ONS 15454 SDH
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G219 Change the 10G Multirate Transponder Line Thresholds for SONET or 
SDH Payloads Including 10G Ethernet WAN Phy

Table 11-62  TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C 

Card Wavelength Trunk Settings

Parameter Description Options

Port (Display only) Displays the port number. Port 2 (Trunk)

Band Indicates the wavelength band that can be 
provisioned. If the physical 
TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, 
and TXP_MR_10EX_C is installed, this 
field is display-only. 

• C—The C-band wavelengths are 
available in the Wavelength field.

• L—The L-band wavelengths are 
available in the Wavelength field.

Even/Odd Sets the wavelengths available for 
provisioning for TXP_MR_10E_C, and 
TXP_MR_10E_L cards. (This field does 
not apply to TXP_MR_10G or 
TXP_MR_10E cards.)

• Even—Displays even C-band or 
L-band wavelengths in the 
Wavelength field.

• Odd—Displays odd C-band or 
L-band wavelengths in the 
Wavelength field.

Wavelength The wavelength provisioned for the trunk. • First Tunable Wavelength

• Further wavelengths in 100-GHz 
ITU-T C-band or L-band spacing, 
depending on the card that is 
installed. For TXP_MR_10G and 
TXP_MR_10E cards, the 
wavelengths carried by the card are 
identified with two asterisks. If the 
card is not installed, all wavelengths 
appear with a dark grey background.

Purpose This task changes the line threshold settings for TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and 
TXP_MR_10EX_C transponder cards carrying SONET or SDH payloads, 
including the physical 10G Ethernet WAN Phy payload. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G219 Change the 10G Multirate Transponder Line Thresholds for SONET or SDH Payloads Including 10G Ethernet
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to 
change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings described in Table 11-63. 

Note Parameters shown in Table 11-63 do not apply to all 10G multirate transponder cards. If the 
parameter or option does not apply, it is not shown in CTC.

Table 11-63 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Line Threshold 

Settings

Parameter Description Options - ANSI Options - ETSI

Port (Display only) Port 
number

• 1-1 (OC192)

• 2 (Trunk)

• 1-1 (STM64)

• 2 (Trunk)

EB Path Errored Block 
indicates that one or 
more bits are in error 
within a block

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 
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SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SEFS (Near End Section or 
Regeneration Section 
only) Severely 
errored framing 
seconds 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

OFS (Near End Section or 
Regeneration Section 
only) Out of frame 
seconds 

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

BBE Background block 
errors

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Table 11-63 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Line Threshold 

Settings (continued)

Parameter Description Options - ANSI Options - ETSI
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G319 Change the 10G Multirate Transponder Line RMON Thresholds for 
10G Ethernet LAN Phy Payloads

Step 1 Display the TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or 
TXP_MR_10EX_C card where you want to change the line threshold settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Purpose This task changes the line threshold settings for TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and 
TXP_MR_10EX_C transponder cards carrying the physical 10G Ethernet 
LAN payload.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-63 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C Card Line Threshold 

Settings (continued)

Parameter Description Options - ANSI Options - ETSI
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Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 11-64 for a list of available 
Ethernet variables.

Table 11-64 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card GE LAN Phy Variables

Variable Description

ifInOctets Total number of octets received on the interface, including framing 
characters.

rxTotalPkts Total number of received packets.

ifInMulticastPkts Number of multicast frames received error free.

ifInBroadcastPkts Number of packets, delivered by a sublayer to an higher sublayer, 
that were addressed to a broadcast address at this sublayer.

ifInErrors Number of inbound packets that contained errors preventing them 
from being delivered to a higher-layer protocol.

ifInErrorBytePkts 
(TXP_MR_10G only)

Number of receive error bytes.

ifInFramingErrorPkts 
(TXP_MR_10G only)

Number of receive framing error counters. 

ifInJunkInterPkts 
(TXP_MR_10G only) 

Number of receive interpacket junk counters.

ifOutOctets 
(TXP_MR_10G only)

Total number of octets transmitted out of the interface, including 
framing characters.

txTotalPkts 
(TXP_MR_10G only)

Total number of transmit packets.

ifOutMulticastPkts 
(TXP_MR_10G only)

Number of multicast frames transmitted error free.

ifOutBroadcastPkts 
(TXP_MR_10G only)

Total number of packets that higher-level protocols requested be 
transmitted, and that were addressed to a broadcast address at this 
sublayer, including those that were discarded or not sent.

dot3StatsFCSErrors Number of frames with frame check errors, that is, there is an 
integral number of octets, but an incorrect Frame Check Sequence 
(FCS).

dot3StatsFrameTooLong 
(TXP_MR_10G only)

Number of received frames that were larger than the maximum size 
permitted.

etherStatsUndersizePkts Total number of packets received that were less than 64 octets long 
(excluding framing bits, but including FCS octets) and were 
otherwise well formed.
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etherStatsFragments Total number of packets received that were less than 64 octets in 
length (excluding framing bits but including FCS octets) and had 
either a bad FCS with an integral number of octets (FCS Error) or 
a bad FCS with a non-integral number of octets (Alignment Error). 
Note that it is entirely normal for etherStatsFragments to 
increment. This is because it counts both runts (which are normal 
occurrences due to collisions) and noise hits.

etherStatsPkts64Octets Total number of packets (including bad packets) received that were 
64 octets in length (excluding framing bits but including FCS 
octets).

etherStatsPkts65to127Octets Total number of packets (including bad packets) received that were 
between 65 and 127 octets in length inclusive (excluding framing 
bits but including FCS octets).

etherStatsPkts128to255Octets The total number of packets (including bad packets) received that 
were between 128 and 255 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsPkts256to511Octets Total number of packets (including bad packets) received that were 
between 256 and 511 octets in length inclusive (excluding framing 
bits but including FCS octets).

etherStatsPkts512to1023Octets Total number of packets (including bad packets) received that were 
between 512 and 1023 octets in length inclusive (excluding framing 
bits but including FCS octets).

etherStatsPkts1024to1518Octets Total number of packets (including bad packets) received that were 
between 1024 and 1518 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsBroadcastPkts Total number of good packets received that were directed to the 
broadcast address. Note that this does not include multicast 
packets.

etherStatsMulticastPkts Total number of good packets received that were directed to a 
multicast address. Note that this number does not include packets 
directed to the broadcast address.

etherStatsOversizePkts The total number of packets received that were longer than 
1518 octets (excluding framing bits, but including FCS octets) and 
were otherwise well formed.

etherStatsJabbers Total number of packets received that were longer than 1518 octets 
(excluding framing bits, but including FCS octets), and had either 
a bad FCS with an integral number of octets (FCS Error) or a bad 
FCS with a nonintegral number of octets (Alignment Error).

etherStatsOctets Total number of octets of data (including those in bad packets) 
received on the network (excluding framing bits but including FCS 
octets).

Table 11-64 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card GE LAN Phy Variables (continued)
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Note To view all RMON thresholds, click Show All RMON thresholds. 

Step 12 Return to your originating procedure (NTP).

etherStatsCRCAlignErrors 
(TXP_MR_10G only)

Total number of packets received that had a length (excluding 
framing bits, but including FCS octets) of between 64 and 
1518 octets, inclusive, but had either a bad FCS with an integral 
number of octets (FCS Error) or a bad FCS with a non-integral 
number of octets (Alignment Error).

rxPauseFrames 
(TXP_MR_10G only)

Number of received IETF 802.x pause frames.

rxControlFrames Number of MAC control frames passed by the MAC sublayer to the 
MAC control sublayer.

rxUnknownOpcodeFrames 
(TXP_MR_10G only)

Number of MAC control frames received that contain an opcode 
that is not supported by the device. 

Table 11-64 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card GE LAN Phy Variables (continued)
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DLP-G301 Provision the 10G Multirate Transponder Trunk Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to 
change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.

Step 4 Referring to Table 11-65, verify the trunk port (Port 2) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the 
threshold value you want to change, deleting the existing value, and entering the new value. Hit Enter, 
then click Apply.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Purpose This task provisions the TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C trunk port 
alarm and threshold cross alert (TCA) thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-65 10G Multirate Transponder Trunk Port TCA Thresholds

Card
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

TXP_MR_10G –8 dBm –18 dBm 7 dBm –1 dBm

TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_10EX_
C

–9 dBm –18 dBm 9 dBm 0 dBm
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Step 7 Referring to Table 11-66, verify the trunk port (Port 2) Alarm thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the 
threshold value you want to change, deleting the existing value, and entering the new value. Hit Enter, 
then click Apply.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 8 Click Apply. 

Step 9 Return to your originating procedure (NTP).

DLP-G302 Provision the 10G Multirate Transponder Client Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to 
change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.

Table 11-66 10G Multirate Transponder Trunk Port Alarm Thresholds

Card
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

TXP_MR_10G –8 dBm –20 dBm 4 dBm 2 dBm

TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_10EX_
C

–8 dBm –20 dBm 7 dBm 3 dBm

Purpose This task provisions the client port alarm and TCA thresholds for the 
TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and 
TXP_MR_10EX_C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Referring to Table 11-67, verify the Port 1 (Client) TCA thresholds for RX Power High, RX Power Low, 
TX Power High, and TX Power Low based on the client interface at the other end. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting the existing 
value, and entering the new value. Hit Enter, then click Apply.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-68, provision the Port 1 (Client) Alarm thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

Table 11-67 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card Client Interface TCA Thresholds

Pluggable Port 
Rate

Pluggable Port 
Module (XFP)

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

SONET (or SDH) TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G
(XFP not present)

–1 –11 –1 –6

10G Ethernet 
LAN Phy

TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G
(XFP not present)

0.5 –14.4 –1 –6

10G Fibre 
Channel

TXP_MR_10E uses
ONS-XC-10G-S1

0.5 –14.4 –1 –6

IB_5G1

1. Only the TXP_MR_10EX_C card supports IB_5G.

TXP_MR_10EX_C 
uses 
ONS-XC-10G-S1 
Version 3

1.0 –14.0 5.0 12.0
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Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 8 Click Apply.

Step 9 Return to your originating procedure (NTP).

DLP-G221 Change the 10G Multirate Transponder OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C card where you want to 
change the OTN settings.

Table 11-68 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card Client Interface Alarm Thresholds

Pluggable Port 
Rate 

Pluggable Port 
Module (XFP)

Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

SONET (or SDH) TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G
(XFP not present)

3 –16 1 –8

10G Ethernet 
LAN Phy

TXP_MR_10E uses
ONS-XC-10G-S1

TXP_MR_10G
(XFP not present)

3 –16 1 –8

10G Fibre 
Channel

TXP_MR_10E uses
ONS-XC-10G-S1

3 –16 1 –8

IB_5G1

1. Only the TXP_MR_10EX_C card supports IB_5G.

TXP_MR_10EX_C 
uses 
ONS-XC-10G-S1 
Version 3

3.0 –16 1.0 –8

Purpose This task changes the line OTN settings for the TXP_MR_10G, 
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and 
TXP_MR_10EX_C transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning > OTN tabs, then click one of the following subtabs: OTN Lines, 
G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier. 

Step 3 Modify any of the settings described in Tables 11-69 through 11-72. 

Note You must modify Near End and Far End independently, 15 Min and 1 Day independently, and 
SM and PM independently. To do so, choose the appropriate radio button and click Refresh.

Table 11-69 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 11-70 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 11-69 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card OTN Lines Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

2

G.709 OTN Sets the OTN lines according to 
ITU-T G.709. Check the box to enable. 
For TXP-MR-10EX_C cards, the G.709 
OTN should be enabled.

• Enable

• Disable

FEC Sets the OTN lines FEC mode. FEC mode 
can be Disabled, Enabled, or, for the 
TXP_MR_10E, Enhanced FEC mode can 
be enabled to provide greater range and 
lower bit error rate. For TXP_MR_10E 
cards, Standard is the same as enabling 
FEC. For TXP-MR-10EX_C cards, the 
FEC should be enabled.

• Enable—(TXP_MR_10G only) FEC 
is on.

• Disable—FEC is off.

• Standard—(TXP_MR_10E only) 
Standard FEC is on.

• Enhanced—(TXP_MR_10E only) 
Enhanced FEC is on.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

SF BER (Display only) Indicates the signal fail bit 
error rate.

• 1E-5

Asynch/Synch 
Mapping

(TXP_MR_10E only) Sets how the 
ODUk (client payload) is mapped to the 
optical channel (OTUk).

• Asynch mapping

• Synch mapping
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Table 11-70 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name. 

2

ES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC, 
overhead management, and PM using 
OTUk. Selecting the PM radio button 
selects path PM using ODUk.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and 
click Refresh. 

Note SM (OTUk) is the ITU-T G.709 
optical channel transport unit 
order of k overhead frame used 
for management and performance 
monitoring. PM (ODUk) is the 
ITU-T G.709 optical channel data 
unit order of k overhead frame 
unit used for path performance 
monitoring.

SES Severely errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

UAS Unavailable seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 
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Table 11-71 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 11-72 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

BBE Background block errors Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

FC Failure counter Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Table 11-70 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card ITU-T G.709 Threshold Settings (continued)

Parameter Description Options

Table 11-71 TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, or TXP_MR_10EX_C 

Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

2

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Uncorrectable 
Words

Displays the number of uncorrectable 
words in the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Table 11-72 10G Multirate Transponder Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 minutes.

Checked/unchecked (default)

Table 11-72 10G Multirate Transponder Trail Trace Identifier Settings (continued)

Parameter Description Options
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NTP-G292 Provision the 40G Multirate Transponder Card Line 
Settings, PM Parameters, and Thresholds

Note The 40E-TXP-C and 40ME-TXP-C cards does not support PPMs.

Note The maximum ambient operating temperature for 40E-TXP-C, and 40ME-TXP-C cards is 500 Celsius.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the transponder card 
settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 If you are provisioning a 40E-TXP-C or 40ME-TXP-C card, complete the “DLP-G656 Provision the 
40E-TXP-C and 40ME-TXP-C Data Rate” task on page 11-238. If not, continue with Step 4.

Step 4 Perform any of the following tasks as needed:

• DLP-G657 Change the 40G Multirate Transponder Card Settings, page 11-238

• DLP-G658 Change the 40G Multirate Transponder Line Settings, page 11-239

• DLP-G659 Change the 40G Multirate Transponder SONET, SDH, or Ethernet Line Settings, 
page 11-241

• DLP-G660 Change the 40G Multirate Transponder Line Section Trace Settings, page 11-245

• DLP-G661 Change the 40G Multirate Transponder Line Thresholds for SONET or SDH Payloads 
Including 40G Ethernet WAN Phy, page 11-248

• DLP-G663 Provision the 40G Multirate Transponder Trunk Port Alarm and TCA Thresholds, 
page 11-250

• DLP-G664 Provision the 40G Multirate Transponder Client Port Alarm and TCA Thresholds, 
page 11-251

• DLP-G665 Change the 40G Multirate Transponder OTN Settings, page 11-252

Purpose This procedure changes the line settings, PM parameters, and threshold 
settings for 40G multirate transponder cards (40E-TXP-C, 40ME-TXP-C).

Tools/Equipment None

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary) 

• DLP-G278 Provision the Optical Line Rate, page 11-175 (if 
necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Stop. You have completed this procedure.

DLP-G656 Provision the 40E-TXP-C and 40ME-TXP-C Data Rate

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the card data rate settings.

Step 2 Click the Provisioning > Data Rate Selection tabs.

Step 3 Click Create.

Step 4 In the Create Port dialog box, choose one of the following data rates:

• SONET (ANSI) OC-768 or SDH (ETSI) STM-256

• 40G Ethernet LAN Phy (only when overclock mode is ON)

• OTU3

Step 5 Click Ok.

Step 6 Return to your originating procedure.

DLP-G657 Change the 40G Multirate Transponder Card Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 11-73. 

Purpose This task changes the 40E-TXP-C and 40ME-TXP-C card data rate.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the card settings of the 40E-TXP-C and 40ME-TXP-C 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G658 Change the 40G Multirate Transponder Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the line settings.

Table 11-73 40E-TXP-C and 40ME-TXP-C Card Settings

Parameter Description ONS 15454(ANSI) Options
 ONS 15454 SDH(ETSI) 
Options

Regeneration 
Peer Slot

Sets the slot containing another 40E-TXP-C 
or 40ME-TXP-C card to create a regeneration 
peer group. A regeneration peer group 
facilitates the management of two 
40E-TXP-C or 40ME-TXP-C cards that are 
needed to perform a complete signal 
regeneration.

The regeneration peer group synchronizes 
provisioning of the two cards. Payload type 
and ITU-T G.709 optical transport network 
(OTN) changes made on one 40E-TXP-C or 
40ME-TXP-C card is reflected on the peer 
40E-TXP-C or 40ME-TXP-C card.

Note Y-cable protection groups cannot be 
created on TXP cards that are in a 
regeneration peer group.

• None

• 1

• 2

• 3

• 4

• 5

• 12

• 13

• 14

• 15

• 16

• None

• 1

• 2

• 3

• 4

• 5

• 12

• 13

• 14

• 15

• 16

Regeneration 
Group Name

(Display only) The regeneration peer group 
name.

— —

Trunk 
Wavelengths

(Display only) Shows the supported 
wavelengths of the trunk port after the card is 
installed. The 40E-TXP-C, or 40ME-TXP-C 
that is installed shows the C-band 
wavelengths that it supports.

— —

Purpose This task changes the line settings of the 40E-TXP-C and 40ME-TXP-C 
cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning > Line > Ports tabs.

Step 3 Modify any of the settings for the Client tab as described in Table 11-74. 

Table 11-74  Line Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description Options

Port (Display only) Displays the port number. 1 and 2

Port Name Assigns a logical name for each of the ports 
shown by filling in this field.

User-defined. The port name can be up to 32 alphanumeric or 
special characters, or both. The port name is blank by default.

For information about assigning a port name, see the 
“DLP-G104 Assign a Name to a Port” task on page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about service states, see the 
Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall 
condition of the port. Service states appear 
in the format: Primary State-Primary State 
Qualifier, Secondary State. For more 
information about service states, see the 
Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled 
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance 
(ETSI)

ALS Mode (Client port only) Sets the ALS function 
mode.

• Disabled (default)—ALS is off; the laser is not 
automatically shut down when traffic outage or loss of 
signal (LOS) occurs.

• Auto Restart: (OC-768/STM-256/OTU-3 only) ALS is on; 
the laser automatically shuts down when traffic outages 
(LOS) occur. It automatically restarts when the conditions 
that caused the outage are resolved.

• Manual Restart—ALS is on; the laser automatically shuts 
down when traffic outage or LOS occurs. However, the 
laser must be manually restarted when conditions that 
caused the outage are resolved.

• Manual Restart for Test—Manually restarts the laser for 
testing.

Reach (Display only) Displays the optical reach 
distance of the port.

• Autoprovision—(trunk port only) The system 
automatically provisions the reach.

• VSR—(client port only) The system provisions very short 
reach (VSR) for the port.

Wavelength Provisions the wavelength for the port. • First Tunable Wavelength

• Further wavelengths:
Further wavelengths in 100-GHz ITU-T C-band spacing. 
The wavelengths carried by the card are identified with 
two asterisks. If the card is not installed, all wavelengths 
appear with a dark grey background.
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G659 Change the 40G Multirate Transponder SONET, SDH, or Ethernet Line 
Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the SONET, SDH, or Ethernet line settings.

Step 2 Click the Provisioning > Line > SONET/SDH/Ethernet tabs.

Step 3 Modify any of the settings described in Table 11-75. 

Squelch (Display only) Applicable only to 
client port 1. When the termination mode is 
set to transparent, squelch is enabled. For 
section/line termination mode, AIS is 
enabled.
For trunk port, squelch is disabled.

• Squelch

• AIS

• Disable

Note Both Squelch and AIS options are supported when the 
selected Termination Mode is Transparent. If the 
Termination Mode selected is Section or Line, then 
only AIS is supported. This is applicable for 
OC-192/STM-64 and OC-768/STM-256.
For OTN payloads, both Squelch and AIS options are 
supported.

Overclock Enables or disables overclock mode on 
trunk port.

• OFF (default)

• ON

Rx Wavelength Provisions the wavelength of the trunk port. • First Tunable Wavelength

• Further wavelengths:
Further wavelengths in 100-GHz ITU-T C-band spacing. 
The wavelengths carried by the card are identified with 
two asterisks. If the card is not installed, all wavelengths 
appear with a dark grey background.

Purpose This task changes the SONET, SDH, or Ethernet line settings for 
40E-TXP-C and 40ME-TXP-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-74  Line Settings (continued)of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description Options
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Note In Table 11-75, some parameter tabs do not always apply to all 40G multirate transponder cards. 
If a tab does not apply, it will not appear in CTC.

Table 11-75 SONET, SDH Line Settings of the 40E-TXP-C and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Port (Display only) Displays the port 
number.

• 1 (OC-768)

• 1 (40G Ethernet LAN Phy)

• 1 (OTU3)

• 1 (STM-256)

• 1 (40G Ethernet LAN 
Phy)

• 1 (OTU3)

SF BER (SONET [ANSI] or SDH [ETSI] 
only) Sets the signal fail bit error 
rate.

• 1E-3

• 1E-4 

• 1E-5

• 1E-3

• 1E-4 

• 1E-5

SD BER (SONET [ANSI] or SDH [ETSI] 
only) Sets the signal degrade bit 
error rate.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

ProvidesSync (OC-768/STM-256 only) Sets the 
ProvidesSync card parameter. If 
checked, the card is provisioned as 
a network element (NE) timing 
reference.

Checked or unchecked Checked or unchecked

SyncMsgIn (OC-768/STM-256 only) Sets the 
EnableSync card parameter. 
Enables synchronization status 
messages (S1 byte), which allow 
the node to choose the best timing 
source.

Checked or unchecked Checked or unchecked

Admin SSM 
In

Overrides the synchronization 
status message (SSM) and the 
synchronization traceability 
unknown (STU) value. If the node 
does not receive an SSM signal, it 
defaults to STU.

• PRS—Primary Reference Source 
(Stratum 1)

• STU—Sync traceability unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing 
synchronization

• RES—Reserved; quality level set 
by user

• G811—Primary reference 
clock

• STU—Sync traceability 
unknown

• G812T—Transit node clock 
traceable

• G812L—Local node clock 
traceable

• SETS—Synchronous 
equipment

• DUS—Do not use for 
timing synchronization
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Send 
DoNotUse

(OC-768/STM-256 only) Sets the 
Send DoNotUse card state. When 
checked, sends a do not use (DUS) 
message on the S1 byte.

Checked or unchecked Checked or unchecked

Type (SONET [ANSI] or SDH [ETSI] 
only) Indicates the optical transport 
type.

• SONET

• SDH

• SONET

• SDH

Termination 
Mode

(OC-768/STM-256 only) Sets the 
mode of operation.

Note This option is only 
available for SONET/SDH 
payloads.

• Transparent

• Section

• Line

• Transparent

• Regeneration Section 
(RS)

• Multiplex Section (MS)

Table 11-76 Ethernet Line Settings of the 40E-TXP-C and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Displays the port 
number.

• 1-1 to 1-16 
(OC3/OC12/OC48/GE)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 17 and Port 18 are 
trunk ports that support 
OC192 payload in a 
single-card configuration. 
These ports are interlink 
ports in a double-card 
configuration (ADM-10G 
peer group).

• 1-1 to 1-16 
(STM1/STM4/STM16/GE
)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 17 and Port 18 are 
trunk ports that 
support STM64 
payload in a 
single-card 
configuration. These 
ports are interlink 
ports in a double-card 
configuration 
(ADM-10G peer 
group).

Port Name Provides the ability to assign the 
specified port a name.

User-defined. Name can be up to 
32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on 
page 17-16.

User-defined. Name can be up 
to 32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on 
page 17-16.

Table 11-75 SONET, SDH Line Settings of the 40E-TXP-C and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options
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Admin State Sets the port service state. For more 
information about administrative 
states, see the Administrative and 
Service States document.

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

• Unlocked

• Unlocked,automaticInServic
e

• Locked,disabled

• Locked,maintenance

Service State (Display only) Identifies the 
autonomously generated state that 
gives the overall condition of the 
port. Service states appear in the 
format: Primary State-Primary 
State Qualifier, Secondary State. 
For more information about service 
states, see the Administrative and 
Service States document.

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenanc
e

ALS Mode Sets the ALS function mode. The 
DWDM transmitter supports ALS 
according to ITU-T G.644 (06/99). 
ALS can be disabled, or it can be set 
for one of three mode options.

• Disabled (default): ALS is off; 
the laser is not automatically 
shut down when traffic 
outages (LOS) occur.

• Manual Restart: ALS is on; the 
laser automatically shuts down 
when traffic outages (LOS) 
occur. However, the laser must 
be manually restarted when 
conditions that caused the 
outage are resolved.

• Manual Restart for Test: 
Manually restarts the laser for 
testing.

• Disabled (default): ALS is 
off; the laser is not 
automatically shut down 
when traffic outages 
(LOS) occur.

• Manual Restart: ALS is 
on; the laser automatically 
shuts down when traffic 
outages (LOS) occur. 
However, the laser must 
be manually restarted 
when conditions that 
caused the outage are 
resolved.

• Manual Restart for Test: 
Manually restarts the laser 
for testing.

AINS Soak Sets the automatic in-service soak 
period. Double-click the time and 
use the up and down arrows to 
change settings.

• Duration of valid input signal, 
in hh.mm format, after which 
the card becomes in service 
(IS) automatically

• 0 to 48 hours, 15-minute 
increments 

Note The AINS service state is 
not supported on interlink 
ports.

• Duration of valid input 
signal, in hh.mm format, 
after which the card 
becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute 
increments 

Note The AINS service state 
is not supported on 
interlink ports.

Reach Displays the optical reach distance 
of the client port.

The Reach options depend on the 
traffic type that has been selected.

The Reach options depend on 
the traffic type that has been 
selected.

Table 11-76 Ethernet Line Settings of the 40E-TXP-C and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G660 Change the 40G Multirate Transponder Line Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the line section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.

Step 3 Modify any of the settings described in Table 11-77. 

Purpose This task changes the line section trace settings of the 40E-TXP-C, and 
40ME-TXP-C transponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-77 Section Trace Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port Sets the port number. • 1 (OC-768)

• 2 (OC-768)

• 1 (STM-256)

• 2 (STM-256)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If a TIM on Section overhead alarm is raised 
because of a J0 overhead string mismatch, 
no alarm indication signal is sent to 
downstream nodes if this box is checked.

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

• 1 byte

• 16 byte
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Step 4 Click Apply. 

Step 5 Click Default to restore default values.

Step 6 Return to your originating procedure (NTP).

DLP-G692 Change the 40G Multirate Transponder OTU Settings

Transmit Displays the current transmit string; sets a 
new transmit string. You can click the 
button on the right to change the display. Its 
title changes, based on the current display 
mode. In Transmit String Type, click 
Hex Mode to change the display to 
hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII 
(button changes to Hex Mode).The 
supported range for 1 bit Hex TX trace is 20 
to 7E. If TX trace is provisioned outside this 
range, client transmits 00.

String of trace string size String of trace string size

Expected Displays the current expected string; sets a 
new expected string. You can click the 
button on the right to change the display. Its 
title changes, based on the current display 
mode. In Expected String Type, click 
Hex Mode to change the display to 
hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII 
(button changes to Hex Mode).

String of trace string size String of trace string size

Received (Display only) Displays the current received 
string. You can click Refresh to manually 
refresh this display, or check the 
Auto-refresh every 5 sec check box to keep 
this panel updated.

String of trace string size String of trace string size

Auto-refresh Refreshes the display automatically every 5 
seconds, if checked.

Checked or unchecked 
(default)

Checked or unchecked 
(default)

Purpose This task changes the OTU settings of the 40E-TXP-C, and 40ME-TXP-C 
transponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-77 Section Trace Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C or 
40ME-TXP-C card where you want to change the OTU settings.

Step 2 Click the Provisioning > Line > OTU tabs.

Step 3 Modify any of the settings described in Table 11-78. 

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

Table 11-78 OTU Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Displays the port 
number that is applicable only for 
OC-192/STM-64 payloads.

• 1-1

• 2-1

• 3-1

• 4-1

• 1-1

• 2-1

• 3-1

• 4-1

SyncMsgIn (Display only) (OC-768/STM-256 
only) Sets the EnableSync card 
parameter. Enables synchronization 
status messages (S1 byte), which 
allow the node to choose the best 
timing source.

Checked or unchecked Checked or unchecked

Admin SSM Overrides the synchronization status 
message (SSM) and the 
synchronization traceability 
unknown (STU) value. If the node 
does not receive an SSM signal, it 
defaults to STU.

• PRS—Primary Reference 
Source (Stratum 1)

• STU—Sync traceability 
unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum 
clock

• ST4—Stratum 4

• DUS—Do not use for 
timing synchronization

• RES—Reserved; quality 
level set by user

• G811—Primary reference 
clock

• STU—Sync traceability 
unknown

• G812T—Transit node clock 
traceable

• G812L—Local node clock 
traceable

• SETS—Synchronous 
equipment

• DUS—Do not use for timing 
synchronization

ProvidesSync (Display only) (OC-768/STM-256 
only) Sets the ProvidesSync card 
parameter. If checked, the card is 
provisioned as a network element 
(NE) timing reference.

Checked or unchecked Checked or unchecked
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DLP-G661 Change the 40G Multirate Transponder Line Thresholds for SONET or 
SDH Payloads Including 40G Ethernet WAN Phy

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings described in Table 11-79. 

Purpose This task changes the line threshold settings of 40E-TXP-C and 
40ME-TXP-C transponder cards carrying SONET or SDH payloads, 
including the physical 40G Ethernet WAN Phy payload. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-79 Line Threshold Settings for the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Port 
number

• 1 (OC-768)

• 2 (OC-768)

• 1 (STM-256)

• 2 (STM-256)

CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 
11-248
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G661 Change the 40G Multirate Transponder Line Thresholds for SONET or SDH Payloads Including 40G Ethernet
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

—

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

Table 11-79 Line Threshold Settings for the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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DLP-G663 Provision the 40G Multirate Transponder Trunk Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Under Types area, verify that the TCA radio button is selected. If not, click it, then click Refresh.

Step 4 Referring to Table 11-80, verify the trunk port (Port 2) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the 
threshold value you want to change, deleting the existing value, and entering the new value. Press Enter, 
then click Apply.

Step 5 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Click Apply.

Step 7 Under Types area, click the Alarm radio button and click Refresh.

Step 8 Referring to Table 11-80, verify the trunk port (Port 2) alarm thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the 
threshold value you want to change, deleting the existing value, and entering the new value. Press Enter, 
then click Apply.

Step 9 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Purpose This task provisions the 40E-TXP-C, and 40ME-TXP-C trunk port alarm 
and threshold cross alert (TCA) thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-80 Trunk Port TCA Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

Card
TCA RX Power 
High (dbm)

TCA RX Power 
Low (dbm)

TCA TX Power 
High (dbm)

TCA TX Power 
Low (dbm)

40E-TXP-C
40ME-TXP-C

–9.0 –22.0 9.0 0.0
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Step 10 Click Apply. 

Step 11 Click Default to restore default values.

Step 12 Return to your originating procedure (NTP).

DLP-G664 Provision the 40G Multirate Transponder Client Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Under Types area, verify that the TCA radio button is selected. If not, click it, then click Refresh.

Step 4 Referring to Table 11-82, verify the client port (Port 1) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low based on the client interface at the other end. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting the existing 
value, and entering the new value. Press Enter, then click Apply.

Step 5 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Note Do not modify the Laser Bias parameters.

Table 11-81 Trunk Port Alarm Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

Card
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

40E-TXP-C
40ME-TXP-C

–9.0 –22.0 9.0 0.0

Purpose This task provisions the client port alarm and TCA thresholds for the 
40E-TXP-C, and 40ME-TXP-C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
11-251
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G665 Change the 40G Multirate Transponder OTN Settings
Step 6 Click Apply.

Step 7 Under Types area, click the Alarm radio button and click Refresh.

Step 8 Referring to Table 11-83, provision the client port (Port 1) alarm thresholds for RX Power High, RX 
Power Low, TX Power High, and TX Power Low based on the client interface that is provisioned.

Step 9 Under Intervals area, select 15 Min or 1 Day, then click Refresh.

Step 10 Click Apply.

Step 11 Return to your originating procedure (NTP).

DLP-G665 Change the 40G Multirate Transponder OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40E-TXP-C card 
where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then click one of the following subtabs: OTN Lines, 
ITU-T G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier. 

Table 11-82 Client Interface TCA Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards 

Pluggable Port 
Rate

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

40G Ethernet LAN 
Phy

3.0 –6.0 6.0 –3.0

OC-768/STM-256 3.0 –6.0 6.0 –3.0

OTU3 3.0 –6.0 6.0 –3.0

Table 11-83 Card Client Interface Alarm Thresholds of the 40E-TXP-C, and 40ME-TXP-C Cards

Pluggable Port 
Rate 

Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

40G Ethernet 
LAN Phy

5.0 –8.0 4.0 –1.0

OC-768/STM-256 5.0 –8.0 4.0 –1.0

OTU3 5.0 –8.0 4.0 –1.0

Purpose This task changes the line OTN settings of the 40E-TXP-C, and 
40ME-TXP-C transponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Modify any of the settings described in Tables 11-84 through 11-87. 

Note You must modify Near End and Far End, 15 Min and 1 Day, and SM and PM independently. To 
do so, select the appropriate radio button and click Refresh.

Table 11-84 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 11-85 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 11-84 OTN Line Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

• 1 (only when data rate is set to 
OTU3)

• 2

ITU-T G.709 
OTN

(Display only) Displays the OTN lines 
according to ITU-T G.709.

• Enable

• Disable

FEC Sets the OTN line FEC mode. FEC mode 
can be Standard or Enhanced. Standard is 
the same as enabling FEC. Enhanced FEC 
mode can be enabled to provide greater 
range and lower bit error rate.

• Standard
Standard FEC is on.

• Enhanced
Enhanced FEC is on.

SF BER (Display only) Sets the signal fail bit 
error rate.

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9
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Table 11-85 ITU-T G.709 Threshold Settings of the 40E-TXP-C, and 40ME-TXP-C Cards 

Parameter Description Options

Port (Display only) Displays the port number 
and optional name. 

2

ES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC, 
overhead management, and PM using 
OTUk. Selecting the PM radio button 
selects path PM using ODUk.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

Note SM (OTUk) is the ITU-T G.709 
optical channel transport unit 
order of k overhead frame used 
for management and performance 
monitoring. PM (ODUk) is the 
ITU-T G.709 optical channel data 
unit order of k overhead frame 
unit used for path performance 
monitoring.

SES Severely errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

UAS Unavailable seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.
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Table 11-86 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 11-87 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

BBE Background block errors Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

FC Failure counter Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

Table 11-85 ITU-T G.709 Threshold Settings of the 40E-TXP-C, and 40ME-TXP-C Cards 

Parameter Description Options

Table 11-86 FEC Threshold Settings of the 40E-TXP-C, and 40ME-TXP-C Cards 

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

2

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.

Uncorrectable 
Words

Displays the number of uncorrectable 
words in the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Choose an option in each category and 
click Refresh.

Click Reset to Default to restore default 
values.
11-255
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G665 Change the 40G Multirate Transponder OTN Settings
Step 4 Click Apply.

Step 5 Click Default to restore default settings.

Step 6 Return to your originating procedure (NTP).

Table 11-87 Trail Trace Identifier Settings of the 40E-TXP-C, and 40ME-TXP-C Cards

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Port Sets the port number. • 1 (OTU3)

• 2 (Trunk)

• 1 (OTU3)

• 2 (Trunk)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If a TIM on Section overhead alarm is raised 
because of a J0 overhead string mismatch, 
no alarm indication signal is sent to 
downstream nodes if this box is checked.

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

• 1 byte

• 16 byte

Transmit Displays the current transmit string; sets a 
new transmit string. You can click the 
button on the right to change the display. Its 
title changes, based on the current display 
mode. In Transmit String Type, click 
Hex Mode to change the display to 
hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII 
(button changes to Hex Mode).

String of trace string size String of trace string size

Expected Displays the current expected string; sets a 
new expected string. You can click the 
button on the right to change the display. Its 
title changes, based on the current display 
mode. In Transmit String Type, click 
Hex Mode to change the display to 
hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII 
(button changes to Hex Mode).

String of trace string size String of trace string size

Received (Display only) Displays the current received 
string. You can click Refresh to manually 
refresh this display, or check the 
Auto-refresh every 5 sec check box to keep 
this panel updated.

String of trace string size String of trace string size

Auto-refresh Refreshes the display automatically every 5 
seconds, if checked.

Checked or unchecked 
(default)

Checked or unchecked 
(default)
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NTP-G170 Provision the ADM-10G Card Peer Group, Ethernet 
Settings, Line Settings, PM Parameters, and Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the ADM-10G card 
settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 To provision a peer group, complete the “DLP-G403 Create the ADM-10G Peer Group” task on 
page 11-258.

Step 4 To provision Ethernet settings, complete the “DLP-G469 Provision the ADM-10G Card Ethernet 
Settings” task on page 11-259.

Step 5 To change line settings, complete the following tasks as needed:

• DLP-G397 Change the ADM-10G Line Settings, page 11-260

• DLP-G398 Change the ADM-10G Line Section Trace Settings, page 11-265

• DLP-G399 Change the ADM-10G Line Thresholds for SONET and SDH Payloads, page 11-267

• DLP-G412 Change the ADM-10G Line RMON Thresholds for the 1G Ethernet Payload, 
page 11-271

Step 6 To change thresholds, complete the following tasks as needed:

• DLP-G400 Provision the ADM-10G Interlink or Trunk Port Alarm and TCA Thresholds, 
page 11-274

• DLP-G401 Provision the ADM-10G Client Port Alarm and TCA Thresholds, page 11-275

• DLP-G402 Change the ADM-10G OTN Settings, page 11-276

Stop. You have completed this procedure.

Purpose This procedure creates an ADM-10G peer group and changes line settings, 
PM parameters, and threshold settings for ADM-10G cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

DLP-G411 Provision an ADM-10G PPM and Port, page 11-171 (if 
necessary)

DLP-G278 Provision the Optical Line Rate, page 11-175 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G403 Create the ADM-10G Peer Group

Note You cannot perform this task on a single ADM-10G card; it is only available if a second ADM-10G card 
can be accessed through the interlink ports (Port 17 and Port 18).

Note Due to a hardware limitation, you cannot provision the SDCC/LDCC on Port 17.

Note Perform this task on only one of the two peer cards.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the card settings.

Step 2 Click the Provisioning > Card tabs.

Step 3 In the ADM Group Peer drop-down list, choose the slot number (for example, 14) where the companion 
ADM-10G card is located.

Step 4 In the ADM Peer Group field, enter a group name.

Step 5 Click Apply.

Note The Card Parameters Tunable Wavelengths area is read-only and does not contain any 
wavelengths until circuits are separately provisioned for the card.

Step 6 Return to your originating procedure (NTP).

Purpose This task creates peer group protection for two ADM-10G cards within the 
same node, located on the same shelf.

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69, for two ADM-10G cards (located on the same shelf) for which 
a peer group is desired.

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G469 Provision the ADM-10G Card Ethernet Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Line > Ethernet tabs.

Step 3 Modify any of the settings for the Ethernet tab as described in Table 11-88. The parameters that appear 
depend on the card mode.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the Ethernet settings for the ADM-10G card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-88 ADM-10G Card Ethernet Settings

Parameter Description Options

Port (Display only) The Port number (n-n) and 
rate.

—

MTU The maximum size of the Ethernet frames 
accepted by the port.

Jumbo. Default: 64 to 9216

Numeric: 1548

Mode Sets the Ethernet mode. • 1000 Mbps

Framing Sets the framing type. • GFP-F

• HDLC 

CRC Encap Sets the CRC encap values for the framing 
type. 

CRC encap value for GFP-F:

• None (default)

• 32-Bit

CRC encap value for HDLC:

• 16-Bit

• 32-Bit (default) 

AINS Soak Automatic in-service soak time. The duration 
of time that must pass with an uninterrupted 
signal before the traffic/termination 
transitions to the IS-NR (ANSI) or 
unlocked-enabled (ETSI) service state.

• Duration of valid input signal, in hh.mm format, after 
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments
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DLP-G397 Change the ADM-10G Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs. 

Step 3 Modify any of the settings described in Table 11-89 as needed. 

Note In Table 11-89, some parameter tabs do not always apply to all ADM-10G cards. If a tab does 
not apply, it will not appear in CTC.

Purpose This task changes the line settings for ADM-10G cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-89 ADM-10G Line Port Tab Settings

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Port (Display only) Displays 
the port number.

• 1-1 to 1-16 
(OC3/OC12/OC48/GE)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 17 and Port 18 
are trunk ports that 
support OC192 
payload in a 
single-card 
configuration. These 
ports are interlink 
ports in a double-card 
configuration 
(ADM-10G peer 
group).

• 1-1 to 1-16 
(STM1/STM4/STM16/G
E)

• 17-1 (Trunk/Interlink)

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 17 and Port 18 
are trunk ports that 
support STM64 
payload in a 
single-card 
configuration. These 
ports are interlink 
ports in a double-card 
configuration 
(ADM-10G peer 
group).

Port Name Provides the ability to 
assign the specified port 
a name.

User-defined. Name can be 
up to 
32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on 
page 17-16.

User-defined. Name can be 
up to 
32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on 
page 17-16.

Admin 
State

Sets the port service 
state. For more 
information about 
administrative states, 
see the Administrative 
and Service States 
document.

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

• Unlocked

• Unlocked,automaticInServ
ice

• Locked,disabled

• Locked,maintenance
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Service 
State

(Display only) 
Identifies the 
autonomously 
generated state that 
gives the overall 
condition of the port. 
Service states appear in 
the format: Primary 
State-Primary State 
Qualifier, Secondary 
State. For more 
information about 
service states, see the 
Administrative and 
Service States 
document.

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenan
ce

ALS Mode Sets the ALS function 
mode. The DWDM 
transmitter supports 
ALS according to 
ITU-T G.644 (06/99). 
ALS can be disabled, or 
it can be set for one of 
three mode options.

• Disabled (default): ALS 
is off; the laser is not 
automatically shut down 
when traffic outages 
(LOS) occur.

• Auto Restart: (Not 
applicable for Gigabit 
Ethernet client 
interfaces) ALS is on; 
the laser automatically 
shuts down when traffic 
outages (LOS) occur. It 
automatically restarts 
when the conditions that 
caused the outage are 
resolved.

• Manual Restart: ALS is 
on; the laser 
automatically shuts 
down when traffic 
outages (LOS) occur. 
However, the laser must 
be manually restarted 
when conditions that 
caused the outage are 
resolved.

• Manual Restart for Test: 
Manually restarts the 
laser for testing.

• Disabled (default): ALS 
is off; the laser is not 
automatically shut down 
when traffic outages 
(LOS) occur.

• Auto Restart: (Not 
applicable for Gigabit 
Ethernet client 
interfaces) ALS is on; 
the laser automatically 
shuts down when traffic 
outages (LOS) occur. It 
automatically restarts 
when the conditions that 
caused the outage are 
resolved.

• Manual Restart: ALS is 
on; the laser 
automatically shuts 
down when traffic 
outages (LOS) occur. 
However, the laser must 
be manually restarted 
when conditions that 
caused the outage are 
resolved.

• Manual Restart for Test: 
Manually restarts the 
laser for testing.

Table 11-89 ADM-10G Line Port Tab Settings (continued)

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options
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Step 4 Click Apply. 

Step 5 Click the Provisioning > Line > SONET or SDH tabs.

Step 6 Modify any of the settings described in Table 11-90 as needed. 

AINS Soak Sets the automatic 
in-service soak period. 
Double-click the time 
and use the up and down 
arrows to change 
settings.

• Duration of valid input 
signal, in hh.mm format, 
after which the card 
becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute 
increments 

Note The AINS service 
state is not supported 
on interlink ports.

• Duration of valid input 
signal, in hh.mm format, 
after which the card 
becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute 
increments 

Note The AINS service 
state is not supported 
on interlink ports.

Reach Displays the optical 
reach distance of the 
client port.

The Reach options depend on 
the traffic type that has been 
selected.

The Reach options depend on 
the traffic type that has been 
selected.

Wavelength Tunable wavelength. Shows the supported 
wavelengths of the trunk port 
after the card is installed in 
the format: first 
wavelength-last 
wavelength-frequency 
spacing-number of supported 
wavelengths. For example, 
1529.55nm-1561.83nm-50g
Hz-8 are supported 
wavelengths. 

Shows the supported 
wavelengths of the trunk port 
after the card is installed in 
the format: first 
wavelength-last 
wavelength-frequency 
spacing-number of supported 
wavelengths. For example, 
1529.55nm-1561.83nm-50g
Hz-8 are supported 
wavelengths. 

Table 11-89 ADM-10G Line Port Tab Settings (continued)

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options
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Table 11-90 ADM-10G Line SONET or SDH Tab Settings

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Port (Display only) Displays 
the client and trunk port 
number.

• 1-1 to 1-16 
(OC3/OC12/OC48/GE)

• 17-1 (OC192)

• 18-1 (OC192/Interlink)

• 19-1 (OC192)

Note Port 17 and Port 18 
are trunk ports that 
support OC192 
payload in a 
single-card 
configuration. These 
ports are interlink 
ports in a double-card 
configuration 
(ADM-10G peer 
group).

• 1-1 to 1-16 
(STM1/STM4/STM16/G
E)

• 17-1(STM64)

• 18-1 (STM64/Interlink)

• 19-1 (STM64)

Note Port 17 and Port 18 
are trunk ports that 
support STM64 
payload in a 
single-card 
configuration. These 
ports are interlink 
ports in a double-card 
configuration 
(ADM-10G peer 
group).

ProvidesSync When checked, the card is 
provisioned as an NE 
timing reference.

Checked or unchecked Checked or unchecked

SyncMsgIn Enables synchronization 
status messages (S1 byte), 
which allow the node to 
choose the best timing 
source.

Checked or unchecked Checked or unchecked

SF BER Sets the signal fail bit 
error rate.

• 1E-3

• 1E-4

• 1E-5

• 1E-3

• 1E-4

• 1E-5

Send 
DoNotUse

When checked, sends a 
DUS message on the S1 
byte.

Checked or unchecked Checked or unchecked

SD BER Sets the signal degrade bit 
error rate.

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9
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Step 7 Return to your originating procedure (NTP).

DLP-G398 Change the ADM-10G Line Section Trace Settings 

Note The Section Trace tab is available for ports configured as OC-N (Ports 1 through 16, Ports 17 and 18 
[only in a single-card configuration] and Port 19). Section trace is not available on interlink ports.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the section trace settings. The card view appears.

Step 2 Click the Provisioning > Line > Section Trace tabs.

Step 3 Modify any of the settings described in Table 11-91. 

Type (Display only) Type of 
node.

• SONET

• SDH

• SDH

Admin SSM 
In

Overrides the 
synchronization status 
message (SSM) 
synchronization 
traceability unknown 
(STU) value. If the node 
does not receive an SSM 
signal, it defaults to STU.

• PRS—Primary Reference 
Source (Stratum 1)

• ST2—Stratum 2

• TNC—Transit node clock

• ST3E—Stratum 3E

• ST3—Stratum 3

• SMC—SONET minimum 
clock

• ST4—Stratum 4

• DUS—Do not use for 
timing synchronization

• RES—Reserved; quality 
level set by user

• G811—Primary reference 
clock

• STU—Sync traceability 
unknown

• G812T—Transit node clock 
traceable

• G812L—Local node clock 
traceable

• SETS—Synchronous 
equipment

• DUS—Do not use for 
timing synchronization

Purpose This task changes the line section trace settings for the ADM-10G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-90 ADM-10G Line SONET or SDH Tab Settings (continued)

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options
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Table 11-91 ADM-10G Section Trace Settings

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Port Sets the port number. • 1-1 to 1-16 
(OC3/OC12/OC48/G
E)

• 17-1 (OC 192)

• 18-1 (OC192)

• 19-1 (OC192)

Note Port 17 and Port 
18 are trunk ports 
that support 
OC192 payload in 
a single-card 
configuration. 
These ports are 
interlink ports in a 
double-card 
configuration 
(ADM-10G peer 
group).

• 1-1 to 1-16 
(STM1/STM4/STM1
6/GE)

• 17-1 (STM64)

• 18-1 (STM64)

• 19-1 (STM64)

Note Port 17 and Port 
18 are trunk ports 
that support 
STM64 payload 
in a single-card 
configuration. 
These ports are 
interlink ports in a 
double-card 
configuration 
(ADM-10G peer 
group).

Received 
Trace 
Mode

Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Transmit 
Section 
Trace 
String 
Size

Sets the trace string size. • 1 byte

• 16 byte

• 64 byte

• 1 byte

• 16 byte

• 64 byte

Current Current Transmit String 
displays the current 
transmit string; New 
Transmit String sets a 
new transmit string. 
Current String Type 
allows you to choose 
between ASCII or 
Hexadecimal format. 
Click Hex to change the 
display to hexadecimal 
(button changes to 
ASCII); click ASCII to 
change the display to 
ASCII (button changes to 
Hex).

String of trace string size String of trace string size
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G399 Change the ADM-10G Line Thresholds for SONET and SDH Payloads

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the line threshold settings. The card view appears.

Step 2 Click the Provisioning > Line Thresholds > SONET or SDH Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-92. 

Received (Display only) Current 
Received String displays 
the current received 
string. You can click 
Refresh to manually 
refresh this display, or 
check the Auto-refresh 
every 5 sec check box to 
keep this panel updated.

String of trace string size String of trace string size

Auto-refr
esh

If checked, automatically 
refreshes the display 
every 5 seconds.

Checked/unchecked 
(default)

Checked/unchecked 
(default)

Purpose This task changes the line threshold settings for ADM-10G cards carrying 
SONET payloads. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-91 ADM-10G Section Trace Settings (continued)

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options
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Table 11-92 ADM-10G Card Line Threshold Settings

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Port 
number

• 1-1 to 1-16 
(OC3/OC12/OC48/GE)

• 17-1 (OC 192)

• 18-1 (OC192)

• 19-1 (OC192)

Note Port 17 and Port 18 
are trunk ports that 
support OC192 
payload in a 
single-card 
configuration. These 
ports are interlink 
ports in a double-card 
configuration 
(ADM-10G peer 
group).

• 1-1 to 1-16 
(STM1/STM4/STM16/GE)

• 17-1 (STM 64)

• 18-1 (STM64)

• 19-1 (STM64)

Note Port 17 and Port 18 are 
trunk ports that support 
STM64 payload in a 
single-card 
configuration. These 
ports are interlink ports 
in a double-card 
configuration 
(ADM-10G peer group).

EB Path Errored Block 
indicates that one or 
more bits are in error 
within a block

— Numeric. Threshold display 
options include:

• Direction—Near End or Far 
End

• Interval—15 Min (minutes) 
or 1 day

• Types—Multiplex Section 
or Regeneration Section 
(near end only) 

Choose an option in each 
category and click Refresh.

CV Coding violations Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh. 

—
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ES Errored seconds Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh.

Numeric. Threshold display 
options include:

• Direction—Near End or Far 
End

• Interval—15 Min (minutes) 
or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh. 

SES Severely errored 
seconds

Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh.

Numeric. Threshold display 
options include:

• Direction—Near End or Far 
End

• Interval—15 Min (minutes) 
or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh. 

BBE Background block 
errors

— Numeric. Threshold display 
options include:

• Direction—Near End or Far 
End

• Interval—15 Min (minutes) 
or 1 day

• Types—Multiplex Section 
or Regeneration Section 
(near end only) 

Choose an option in each 
category and click Refresh. 

FC (Line Section only) 
Failure count

Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh. 

—

Table 11-92 ADM-10G Card Line Threshold Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
11-269
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G399 Change the ADM-10G Line Thresholds for SONET and SDH Payloads
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

PSC Protection Switching 
Count

Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

Choose an option in each 
category and click Refresh.

—

PSD Protection Switching 
Duration

Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

Choose an option in each 
category and click Refresh.

—

UAS (Line Section only) 
Unavailable seconds

Numeric. Threshold display 
options include:

• Direction—Near End or 
Far End

• Interval—15 Min 
(minutes) or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh.

Numeric. Threshold display 
options include:

• Direction—Near End or Far 
End

• Interval—15 Min (minutes) 
or 1 day

• Types—Line or Section 
(near end only) 

Choose an option in each 
category and click Refresh. 

Table 11-92 ADM-10G Card Line Threshold Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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DLP-G412 Change the ADM-10G Line RMON Thresholds for the 1G Ethernet 
Payload

Note This task can only be performed if the ADM-10G card has at least one PPM port provisioned for Gigabit 
Ethernet.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the line RMON thresholds. The card view appears.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose the applicable Ethernet variable. See Table 11-93 for a list of 
available Ethernet variables.

Purpose This task changes the line RMON threshold settings for an ADM-10G card 
carrying the 1G Ethernet payload.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC 

DLP-G411 Provision an ADM-10G PPM and Port, page 11-171

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-93 ADM-10G Gigabit Ethernet Thresholds

Variable Description

ifInOctets Total number of octets received on the interface, including 
framing characters.

ifInErrors Number of inbound packets that contained errors preventing 
them from being deliverable to a higher-layer protocol. 

ifOutOctets Total number of octets transmitted out of the interface, including 
framing characters.

ifInMulticastPkts Number of multicast frames received error-free.

ifInBroadcastPkts Number of packets, delivered by a sublayer to a higher layer or 
sublayer, that were addressed to a broadcast address at this 
sublayer.

ifInErrorBytePkts Number of receive error bytes.

dot3StatsFCSErrors Number of frames with frame check errors; that is, there is an 
integral number of octets, but there is also an incorrect frame 
check sequence (FCS).

dot3StatsFrameTooLong Number of received frames that were larger than the permitted 
maximum size.
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dot3ControlInUnknownOpcodes A count of MAC control frames received on this interface that 
contain an opcode not supported by this device.

dot3InPauseFrames A count of MAC control frames received on this interface with an 
opcode indicating the PAUSE operation.

dot3OutPauseFrames A count of MAC control frames transmitted on this interface with 
an opcode indicating the PAUSE operation.

etherStatsUndersizePkts Total number of packets received that were well-formed and less 
than 64 octets long (excluding framing bits and including FCS 
octets).

etherStatsFragments Total number of packets received that were less than 64 octets in 
length (excluding framing bits but including FCS octets) and had 
either a bad FCS with an integral number of octets (FCS error) or 
a bad FCS with a non-integral number of octets (alignment error).

Note It is normal for etherStatsFragments to increment. This is 
because it counts both runts (which are normal 
occurrences due to collisions) and noise hits.

etherStatsPkts64Octets Total number of packets (including bad packets) transmitted and 
received by the interface that were 64 octets in length (excluding 
framing bits and including FCS octets).

etherStatsPkts65to127Octets Total number of packets (including bad packets) transmitted and 
received by the interface that were between 65 and 127 octets in 
length, inclusive.

etherStatsPkts128to255Octets The total number of packets (including bad packets) transmitted 
and received by the interface that were between 128 and 255 
octets in length, inclusive, excluding framing bits and including 
FCS octets.

etherStatsPkts256to511Octets Total number of packets (including bad packets) transmitted and 
received by the interface that were between 256 and 511 octets in 
length, inclusive.

etherStatsPkts512to1023Octets Total number of packets (including bad packets) transmitted and 
received by the interface that were between 512 and 1023 octets 
in length, inclusive, excluding framing bits and including FCS 
octets.

etherStatsPkts1024to1518Octets Total number of packets (including bad packets) transmitted and 
received by the interface that were between 1024 and 1518 octets 
in length, inclusive, excluding framing bits and including FCS 
octets.

etherStatsBroadcastPkts Total number of good packets transmitted and received by the 
interface that were directed to the broadcast address. 

Note Multicast packets are not included.

Table 11-93 ADM-10G Gigabit Ethernet Thresholds (continued)
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type an appropriate number of seconds for the Sample Period.

Step 9 Type the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Step 12 Return to your originating procedure (NTP).

etherStatsMulticastPkts Total number of good packets transmitted and received by the 
interface that were directed to a multicast address. 

Note This number does not include packets directed to the 
broadcast address.

etherStatsOversizePkts Total number of packets transmitted and received by the interface 
that were well-formed and longer than 1518 octets, excluding 
framing bits and including FCS octets.

etherStatsJabbers Total number of packets received that were longer than 1518 
octets (excluding framing bits and including FCS octets), and had 
a bad FCS with an integral number of octets (FCS error) or a bad 
FCS with a non-integral number of octets (alignment error).

rxTotalPkts Total number of received packets.

txTotalPkts Total number of transmit packets.

Table 11-93 ADM-10G Gigabit Ethernet Thresholds (continued)
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DLP-G400 Provision the ADM-10G Interlink or Trunk Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the interlink or trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.

Step 4 Referring to Table 11-94, verify the interlink or trunk port TCA thresholds for RX Power High, RX 
Power Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking 
the threshold value you want to change, deleting it, entering a new value, and pressing Enter.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-95, verify the interlink or trunk port alarm thresholds for RX Power High, 
RX Power Low, TX Power High, and TX Power Low. Provision new thresholds as needed by 
double-clicking the threshold value you want to change, deleting it, entering a new value, and pressing 
Enter.

Purpose This task provisions the ADM-10G interlink or trunk port alarm and 
threshold crossing alert (TCA) thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-94 ADM-10G Interlink and Trunk Port TCA Thresholds

Port
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

17-1 and 18-1 (Trunk/Interlink)

Note Port 17 and Port 18 are trunk ports in 
single-card configuration and an 
interlink port in double-card 
configuration (ADM-10G peer group).

–7.0 dBm –27.0 dBm 6.0 dBm –4.0 dBm

19-1 (Trunk) –7.0 dBm –27.0 dBm 6.0 dBm –4.0 dBm
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Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 8 Click Apply. 

Step 9 Return to your originating procedure (NTP).

DLP-G401 Provision the ADM-10G Client Port Alarm and TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Under Types, verify that the TCA radio button is checked. If not, check it, then click Refresh.

Step 4 Referring to Table 11-53 on page 11-205 and Table 11-54 on page 11-206, verify the Port 1 to 16 
(Client) Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX Power Low 
based on the client interface that is provisioned. Provision new thresholds as needed by double-clicking 
the threshold value you want to change, deleting it, entering a new value, and pressing Enter.

Table 11-95 ADM-10G Interlink and Trunk Port Alarm Thresholds

Port 
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

17-1 (Trunk/Interlink)

Note Port 17 is a trunk port in single-card 
configuration and an interlink port in 
double-card configuration (ADM-10G 
peer group).

1.0 dBm –13.0 dBm 1.0 dBm –8.0 dBm

18-1 (Trunk/Interlink)

Note Port 18 is a trunk port in single-card 
configuration and an interlink port in 
double-card configuration (ADM-10G 
peer group).

–5.0 dBm –30.0 dBm 5.0 dBm –3.0 dBm

19-1 (Trunk) –5.0 dBm –30.0 dBm 5.0 dBm –3.0 dBm

Purpose This task provisions the client port alarm and TCA thresholds for the 
ADM-10G card.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-53 and Table 11-54 on page 11-206, verify the interlink ports 17-1 and 18-1 for 
RX Power High, RX Power Low, TX Power High, and TX Power Low settings. Provision new thresholds 
as needed by double-clicking the threshold value you want to change, deleting it, entering a new value, 
and pressing Enter.

Step 8 Click Apply.

Step 9 Return to your originating procedure (NTP).

DLP-G402 Change the ADM-10G OTN Settings 

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the ADM-10G card where 
you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then click one of the following subtabs: OTN Lines, 
ITU-T G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier. 

Step 3 Modify any of the settings described in Tables 11-96 through 11-99. 

Note You must modify Near End and Far End independently; 15 Min and 1 Day independently; and 
SM and PM independently. To do so, choose the appropriate radio buttons and click Refresh.

Table 11-96 describes the values on the Provisioning > OTN > OTN Lines tab.

Purpose This task changes the line OTN settings for the ADM-10G cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-97 describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 11-96 ADM-10G Card OTN Lines Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 18 is a trunk port in 
single-card configuration and an 
interlink port in double-card 
configuration (ADM-10G peer 
group).

ITU-TG.709 
OTN

Sets the OTN lines according to 
ITU-T G.709. 

• Enable

• Disable

FEC Sets the OTN lines FEC mode. FEC mode 
can be Disabled, Enabled, or, for the 
TXP_MR_10E, Enhanced FEC mode can 
be enabled to provide greater range and 
lower bit error rate. For TXP_MR_10E 
cards, Standard is the same as enabling 
FEC.

• Disable—FEC is off.

• Standard—Standard FEC is on.

• Enhanced—Enhanced FEC is on.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

SF BER (Display only) Indicates the signal fail bit 
error rate.

• 1E-5

Synch 
Mapping

Sets how the ODUk (client payload) is 
mapped to the optical channel (OTUk).

Synch mapping
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Table 11-97 ADM-10G Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name. 

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 18 is a trunk port in 
single-card configuration and an 
interlink port in double-card 
configuration (ADM-10G peer 
group).

ES Errored seconds. Selecting the SM 
(OTUk) radio button selects FEC, 
overhead management, and PM using 
OTUk. Selecting the PM radio button 
selects path PM using ODUk.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and 
click Refresh. 

Note SM (OTUk) is the ITU-T G.709 
optical channel transport unit 
order of k overhead frame used 
for management and performance 
monitoring. PM (ODUk) is the 
ITU-T G.709 optical channel data 
unit order of k overhead frame 
unit used for path performance 
monitoring.

SES Severely errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

UAS Unavailable seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 
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Table 11-98 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 11-99 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

BBE Background block errors Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

FC Failure counter Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Table 11-97 ADM-10G Card ITU-T G.709 Threshold Settings (continued)

Parameter Description Options

Table 11-98 ADM-10G Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

• 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 18 is a trunk port in 
single-card configuration and an 
interlink port in double-card 
configuration (ADM-10G peer 
group).

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the selected time period.

Numeric display. Can be set for 
15-minute or 1 day intervals. 

Uncorrectable 
Words

Displays the number of uncorrectable 
words in the selected time period.

Numeric display. Can be set for 
15-minute or 1 day intervals. 
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Table 11-99 ADM-10GTrail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. • 18-1 (Trunk/Interlink)

• 19-1 (Trunk)

Note Port 18 is a trunk port in 
single-card configuration and an 
interlink port in double-card 
configuration (ADM-10G peer 
group).

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on 
Section/Path overhead alarm arises 
because of a J0/J1 overhead string 
mismatch, no Forward Defect Indication 
(FDI) signal is sent to the downstream 
nodes if this box is checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Transmit Current Transmit String displays the 
current transmit string; New sets a new 
transmit string. You can click the button 
on the right to change the display. Its title 
changes, based on the current display 
mode. In Transmit String Type, click Hex 
to change the display to hexadecimal 
(button changes to ASCII); click ASCII 
to change the display to ASCII (button 
changes to Hex).

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Current Expected String displays the 
current expected string; New sets a new 
expected string. You can click the button 
on the right to change the display. Its title 
changes, based on the current display 
mode. In Expected String Type, click Hex 
to change the display to hexadecimal 
(button changes to ASCII); click ASCII 
to change the display to ASCII (button 
changes to Hex).

String of trace string size

Received (Display only) Current Received String 
displays the current received string. You 
can click Refresh to manually refresh this 
display, or check the Auto-refresh every 
5 sec check box to keep this panel 
updated.

String of trace string size

Auto-refresh 
(every 5 sec)

If checked, automatically refreshes the 
display every 5 seconds.

Checked/unchecked (default)
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G333 Add an ADM-10G card to an Existing Topology

Step 1 If path protected circuits exist between Node A and Node B, complete the DLP-A197 Initiate a Path 
Protection Force Switch task. This task applies a force switch on the path between Node A and Node B.

Step 2 Complete the NTP-G129 Add a DWDM Node task to add Node C.

Step 3 Complete the DLP-G106 Delete Optical Channel Network Connections, page 17-49 task to delete 
OCHNC circuit between Node A and Node B.

Step 4 Complete the NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40, 
task to create OCHNC circuit between Node A-->Node C and Node C-->Node B for wavelength 
connectivity.

Note The ports on the card in Node C must be tuned to the same wavelength as Node A and Node B. 

Step 5 Create DCC terminations on Node C. See the DLP-A377 Provision Section DCC Terminations task.

Alternatively, if additional bandwidth is needed for CTC management, complete the DLP-A378 
Provision Line DCC Terminations task.

Step 6 Ensure that the DCCs are functional between Node A-->Node C and Node C-->Node B. See the 
DLP-G76 Provision DCC/GCC Terminations, page 17-87 task.

Step 7 Complete the NTP-G200 Create, Delete, and Manage STS or VC Circuits for the ADM-10G Card, 
page 17-54 to create pass-through STS or VC circuits in Node C.

Step 8 Complete the NTP-A301 Merge Circuits task for each circuit created.

Step 9 If path protected circuits exist between Node A and Node B, complete the DLP-A198 Clear a Path 
Protection Force Switch task. This task clears a force switch on the path between Node A and Node B.

Purpose This procedure adds an ADM-10G card to an existing topology. Perform 
the steps in this procedure when OCHNC and DCC are present in the 
network. In case of OCH trails, delete all the circuits in Step 3 that 
traverses the port before deleting the OCH-trail.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC.

• Complete the turn up procedures in Turn Up a Node, page 14-1 for the 
node to be added.

• An updated Cisco Transport Planner network plan recalculated with 
the new node.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 10 Stop. You have completed this procedure.

NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and 
PM Parameter Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the muxponder card 
settings. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G222 Change the 4x2.5G Muxponder Card Settings, page 11-283

• DLP-G223 Change the 4x2.5G Muxponder Line Settings, page 11-285

• DLP-G224 Change the 4x2.5G Muxponder Section Trace Settings, page 11-287

• DLP-G225 Change the 4x2.5G Muxponder Trunk Settings, page 11-289

• DLP-G226 Change the 4x2.5G Muxponder SONET/SDH Line Thresholds Settings, page 11-292

• DLP-G303 Provision the 4x2.5G Muxponder Trunk Port Alarm and TCA Thresholds, page 11-294

• DLP-G304 Provision the 4x2.5G Muxponder Client Port Alarm and TCA Thresholds, page 11-296

• DLP-G228 Change the 4x2.5G Muxponder Line OTN Settings, page 11-298

• DLP-G369 Change the 4x2.5G Muxponder Trunk Wavelength Settings, page 11-290

Step 4 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for the 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, and MXP_2.5G_10EX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69.

DLP-G723 Install PPM on a Line Card

DLP-G726 Preprovisioning a Multirate PPM (if necessary)

DLP-G278 Provision the Optical Line Rate, page 11-175 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G222 Change the 4x2.5G Muxponder Card Settings
DLP-G222 Change the 4x2.5G Muxponder Card Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 11-100. 

Note Parameters shown in Table 11-100 do not apply to all 4x2.5G muxponder cards. If the parameter 
or option does not apply, it is not shown in CTC.

Purpose This task changes the card settings for the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C muxponder cards, including payload type, 
termination mode, and wavelength. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G222 Change the 4x2.5G Muxponder Card Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-100 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation. Options that 
do not apply to a card do not display.

The MXP_2.5G_10G card is based on 
SONET/SDH multiplexing. The 
transparent mode terminates and rebuilds 
the B1 byte (as well as other bytes) of the 
incoming OC-48/STM-16 signal. The B2 
byte is not touched.

The MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, 
and MXP_2.5G_10EX_C cards are fully 
transparent in transparent mode based on 
the OTN/ITU-T G.709 multiplexing 
scheme. It does not terminate the B1 byte 
or other bytes. 

It encapsulates OC-48/STM-16 bytes into 
ODU1 first, then multiplexes them into an 
OTU2.

For ANSI platforms:

• Transparent

• Section (MXP_2.5G_10E, 
MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C only)

• Line (MXP_2.5G_10G only)

For ETSI platforms:

• Transparent

• Multiplex Section (MXP_2.5G_10G, 
only)

• Regeneration Section 
(MXP_2.5G_10E, 
MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C only)

AIS/Squelch (MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C only) Sets the 
transparent termination mode 
configuration.

• Ais

• Squelch

Tunable 
Wavelengths

(Display only) Shows the supported 
wavelengths of the trunk port after the 
card is installed. For the 
MXP_2.5G_10E_C, or 
MXP_2.5G_10E_L cards, the first and 
last supported wavelength, frequency 
spacing, and number of supported 
wavelengths are shown in the format: first 
wavelength-last wavelength-frequency 
spacing-number of supported 
wavelengths. For example, the 
MXP_2.5G_10E_C card would show: 
1529.55nm-1561.83nm-50gHz-82. The 
MXP_2.5G_10G and MXP_2.5G_10E 
show the four wavelengths supported by 
the card that is installed.

—
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G223 Change the 4x2.5G Muxponder Line Settings
DLP-G223 Change the 4x2.5G Muxponder Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the line settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs. 

Note The SONET tab appears only if you have created a PPM for a given port.

Step 3 Modify any of the settings described in Table 11-101. 

Note You must modify Near End and Far End independently; 15 Min and 1 Day independently; and 
Line and Section independently. To do so, choose the appropriate radio button and click Refresh.

Purpose This task changes the line settings for the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-101 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line 

Settings

Parameter Description Options

Port (Display only) Port number. Ports 1 to 4 are client 
ports (OC-48/STM-16). Port 5 is the DWDM trunk 
(OC-192/STM-64) that provides wavelength 
services. Client ports will not appear of the 
pluggable port module is not provisioned for it.

• 1 

• 2

• 3

• 4

• 5 (Trunk) (MXP_2.5G_10G only)

Port Name Provides the ability to assign the specified port a 
logical name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G223 Change the 4x2.5G Muxponder Line Settings
Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER Sets the signal fail bit error rate. • 1E-3

• 1E-4

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

ALS Mode Sets the ALS function mode. The DWDM 
transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or can 
be set for one of three mode options.

• Disable (default): ALS is off; the laser is not 
automatically shut down when traffic outages 
(LOS) occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted 
when conditions that caused the outage are 
resolved.

• Manual Restart for Test: Manually restarts the 
laser for testing.

AINS Soak Sets the automatic in-service soak period. 
Double-click the time and use the up and down 
arrows to change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type Sets the optical transport type. • SONET

• SDH

SyncMsgIn Enables synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source. (This parameter does not appear for the 
MXP_2.5G_10E trunk port.)

Checked or unchecked

Table 11-101 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line 

Settings (continued)

Parameter Description Options
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G224 Change the 4x2.5G Muxponder Section Trace Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G224 Change the 4x2.5G Muxponder Section Trace Settings

Note The Section Trace tab appears only if you have created a PPM for the card.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the section trace settings.

ProvidesSync Sets the ProvidesSync card parameter. If checked, 
the card is provisioned as an NE timing reference. 
(This parameter does not appear for the 
MXP_2.5G_10E trunk port.)

Checked or unchecked

Reach Displays the optical reach distance of the client 
port.

Options: ANSI/ETSI

• Autoprovision/Autoprovision (default)

• SR

• SR 1/I-1—Short reach up to 2-km distance

• IR 1/S1—Intermediate reach, up to 15-km 
distance

• IR 2/S2—Intermediate reach up to 40-km distance

• LR 1/L1—long reach, up to 40-km distance

• LR 2/L2—long reach, up to 80-km distance

• LR 3/L3—long reach, up to 80-km distance

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths: 850 nm through 1560.61 nm
100-GHz ITU spacing CWDM spacing

Purpose This task changes the section trace settings for the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-101 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line 

Settings (continued)

Parameter Description Options
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G224 Change the 4x2.5G Muxponder Section Trace Settings
Step 2 Click the Provisioning > Line > Section Trace tabs. 

Step 3 Modify any of the settings described in Table 11-102. 

Step 4 Click Apply. 

Table 11-102 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Card Section Trace Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

• 3

• 4

• 5 (Trunk; MXP_2.5G_10G only)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If an TIM on Section overhead alarm 
arises because of a J0 overhead string 
mismatch, no alarm indication signal is 
sent to downstream nodes if this box is 
checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. Select either 
radio button.

• 1 byte

• 16 byte

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 minutes.

Checked/unchecked (default)
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G225 Change the 4x2.5G Muxponder Trunk Settings
Step 5 Return to your originating procedure (NTP).

DLP-G225 Change the 4x2.5G Muxponder Trunk Settings

Note This task does not apply to the MXP_2.5G_10G card.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you want to change the 
trunk settings.

Step 2 Click the Provisioning > Line > Trunk tabs. 

Step 3 Modify any of the settings described in Table 11-103. 

Purpose This task provisions the trunk settings for the MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C 
muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-103 MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Trunk Settings

Parameter Description Options

Port (Display only) Displays the port number. Port 5 is 
the DWDM trunk (OC-192/STM-64) that provides 
wavelength services. 

5 (Trunk)

Port Name Provides the ability to assign the specified port a 
logical name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see the Administrative and 
Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI)

• OOS,MT (ANSI) or Locked,maintenance 
(ETSI)
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G369 Change the 4x2.5G Muxponder Trunk Wavelength Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G369 Change the 4x2.5G Muxponder Trunk Wavelength Settings

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of the 
port. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

ALS Mode Sets the ALS function mode. The DWDM 
transmitter supports ALS according to ITU-T G.644 
(06/99). ALS can be disabled or can be set for one of 
three mode options.

• Disabled (default): ALS is off; the laser is not 
automatically shut down when traffic outages 
(LOS) occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser 
automatically shuts down when traffic outages 
(LOS) occur. However, the laser must be 
manually restarted when conditions that caused 
the outage are resolved.

• Manual Restart for Test: Manually restarts the 
laser for testing.

AINS Soak (OC-N and STM-N payloads only) Sets the 
automatic in-service soak period.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Purpose This task changes the trunk wavelength settings for the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-103 MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Trunk Settings 

Parameter Description Options
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G369 Change the 4x2.5G Muxponder Trunk Wavelength Settings
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C card where you 
want to change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.

Step 3 Modify any of the settings described in Table 11-104. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-104  MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 

MXP_2.5G_10EX_C Card Wavelength Trunk Settings

Parameter Description Options

Port (Display only) Displays the port number. 5 (Trunk)

Band (Display only) Indicates the wavelength 
band available from the card that is 
installed. If the card is preprovisioned, 
the field can be provisioned to the band of 
the card that will be installed.

• C—The C-band wavelengths are 
available in the Wavelength field.

• L—The L-band wavelengths are 
available in the Wavelength field.

Even/Odd Sets the wavelengths available for 
provisioning for MXP_2.5G_10E_C and 
MXP_2.5G_10E_L cards. (This field 
does not apply to MXP_2.5G_10G or 
MXP_2.5G_10E cards.)

• Even—Displays even C-band or 
L-band wavelengths in the 
Wavelength field.

• Odd—Displays odd C-band or 
L-band wavelengths in the 
Wavelength field.

Wavelength The wavelength provisioned for the trunk. • First Tunable Wavelength

• Further wavelengths in 100-GHz 
ITU-T C-band or L-band spacing, 
depending on the card that is 
installed. For MXP_2.5G_10G and 
MXP_2.5G_10E cards, the 
wavelengths carried by the card are 
identified with two asterisks. If the 
card is not installed, all wavelengths 
appear with a dark grey background.
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G226 Change the 4x2.5G Muxponder SONET/SDH Line Thresholds Settings
DLP-G226 Change the 4x2.5G Muxponder SONET/SDH Line Thresholds Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-105. 

Note In Table 11-105, some parameter tabs or selections do not always apply to all 4x2.5G muxponder 
cards. If the tabs or selections do not apply, they do not appear in CTC.

Purpose This task changes the SONET (ANSI) or SDH (ETSI) line threshold 
settings for the MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, and MXP_2.5G_10EX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-105 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line 

Threshold Settings

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH

Port (Display only) Port 
number

• 1

• 2

• 3

• 4

• 5 (MXP_2.5G_10G only)

• 1

• 2

• 3

• 4

• 5 (MXP_2.5G_10G only)

EB Path Errored Block 
indicates that one or 
more bits are in error 
within a block

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 
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DLP-  G226 Change the 4x2.5G Muxponder SONET/SDH Line Thresholds Settings
CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SEFS (Near End Section or 
Regeneration Section 
only) Severely 
errored framing 
seconds 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

Table 11-105 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line 

Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
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DLP-  G303 Provision the 4x2.5G Muxponder Trunk Port Alarm and TCA Thresholds
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G303 Provision the 4x2.5G Muxponder Trunk Port Alarm and TCA 
Thresholds

BBE Background block 
errors

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Purpose This task changes the MXP_2.5G_10G, MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C trunk 
port alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Table 11-105 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C Card Line 

Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
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DLP-  G303 Provision the 4x2.5G Muxponder Trunk Port Alarm and TCA Thresholds
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Select TCA (if not already selected), a 15 Min or 1 Day PM interval radio button and then click Refresh.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 4 Referring to Table 11-106, verify the trunk port (Port 5) TCA thresholds for RX Power High, RX Power 
Low, TX Power High, and TX Power Low. Provision new thresholds as needed by double-clicking the 
threshold value you want to change, deleting it, entering a new value, and hitting Enter.

Note Do not modify the Laser Bias parameters.

Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-107, verify the trunk port (Port 5) Alarm thresholds for RX Power High, 
RX Power Low, TX Power High, and TX Power Low. Provision new thresholds as needed by 
double-clicking the threshold value you want to change, deleting it, entering a new value, and hitting 
Enter.

Note Do not modify the Laser Bias parameters.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-106 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Trunk Port TCA Thresholds

Card
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

MXP_2.5G_10G –8 dBm –18 dBm 7 dBm –1 dBm

MXP_2.5G_10E –9 dBm –18 dBm 9 dBm 0 dBm

MXP_2.5G_10E_C –9 dBm –18 dBm 9 dBm 0 dBm

MXP_2.5G_10E_L –9 dBm –18 dBm 9 dBm 0 dBm

MXP_2.5G_10EX_
C

–9 dBm –18 dBm 9 dBm 0 dBm
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DLP-  G304 Provision the 4x2.5G Muxponder Client Port Alarm and TCA Thresholds
Step 8 Click Apply.

Step 9 Return to your originating procedure (NTP).

DLP-G304 Provision the 4x2.5G Muxponder Client Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 11-108, verify the client Port N (where N = 1 through 4) TCA thresholds for RX 
Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the 
other end. Provision new thresholds as needed by double-clicking the threshold value you want to 
change, deleting it, entering a new value, and hitting Enter.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Table 11-107 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Trunk Port Alarm Thresholds

Card
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

MXP_2.5G_10G –8 dBm –20 dBm 4 dBm 2 dBm

MXP_2.5G_10E –8 dBm –20 dBm 7 dBm 3 dBm

MXP_2.5G_10E_C –8 dBm –20 dBm 7 dBm 3 dBm

MXP_2.5G_10E_L –8 dBm –20 dBm 7 dBm 3 dBm

MXP_2.5G_10EX_
C

–8 dBm –20 dBm 7 dBm 3 dBm

Purpose This task provisions the client port alarm and TCA thresholds for the 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
11-296
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G304 Provision the 4x2.5G Muxponder Client Port Alarm and TCA Thresholds
Note Do not modify the Laser Bias parameters.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Step 4 Repeat Step 3 to provision each additional client port.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Step 6 Referring to Table 11-109, verify the client Port N (where N = 1 through 4) Alarm thresholds for RX 
Power High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned. Provision new thresholds as needed by double-clicking the threshold value you want to 
change, deleting it, entering a new value, and hitting Enter.

Note Do not modify the Laser Bias parameters.

Step 7 Click Apply.

Step 8 Repeat Steps 6 and 7 to provision each additional client port. 

Table 11-108 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Card Client Interfaces TCA Thresholds

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

OC-48 ONS-SE-2G-S1 –3 –18 3 –16

15454-SFP-OC48-IR 0 –18 6 –11

STM-16 ONS-SE-2G-S1 –3 –18 3 –16

15454E-SFP-L.16.1 0 –18 6 –11

Table 11-109 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, or MXP_2.5G_10E_L Card Client 

Interfaces Alarm Thresholds

Port Type
(by CTC)

Pluggable Port Module 
(SFP)

Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

OC-48 ONS-SE-2G-S1 0 –21 0 –13

15454-SFP-OC48-IR 3 –21 3 –8

STM-16 ONS-SE-2G-S1 0 –21 0 –13

15454E-SFP-L.16.1 3 –21 3 –8
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DLP-  G228 Change the 4x2.5G Muxponder Line OTN Settings
Step 9 Return to your originating procedure (NTP).

DLP-G228 Change the 4x2.5G Muxponder Line OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card where you 
want to change the line OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, 
OTN G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier. 

Step 3 Modify any of the settings described in Tables 11-110 through 11-113. 

Note You must modify Near End and Far End independently, 15 Min and 1 Day independently, and 
SM and PM independently. To do so, choose the appropriate radio button and click Refresh.

Table 11-110 describes the values on the Provisioning > OTN > OTN Lines tab.

Note In Table 11-110, some parameter tabs or values do not always apply to all MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, or MXP_2.5G_10E_L cards. If the tabs or values do not 
apply, they do not appear in CTC.

Purpose This task changes the line OTN settings for MXP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and 
MXP_2.5G_10EX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-110 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Card Line OTN Settings

Parameter Description Options

Port (Display only) Displays the port 
number.

5 (Trunk)

G.709 OTN Sets the OTN lines according to 
ITU-T G.709.

• Enable

• Disable
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DLP-  G228 Change the 4x2.5G Muxponder Line OTN Settings
Table 11-111 describes the values on the Provisioning > OTN > OTN G.709 Thresholds tab.

FEC Sets the OTN line FEC mode. FEC 
mode can be Disabled or Enabled. 
With the MXP_2.5G_10E card, 
Enhanced FEC (E-FEC) mode can be 
enabled to provide greater range and 
lower bit error rate. E-FEC applies 
only to the MXP_2.5G_10E card.

• Enable—(MXP_2.5G_10G only) 
FEC is on.

• Disable—FEC is off.

• Standard—(MXP_2.5G_10E only) 
FEC is on.

• Enhanced—(MXP_2.5G_10E only) 
Enhanced FEC is on.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

SF BER (Display only) Sets the signal fail bit 
error rate.

• 1E-5

Asynch/Synch 
Mapping 

(MXP_2.5G_10E only) The 
MXP_2.5G_10E can perform 
standard ODU multiplexing 
according to ITU-T G.709. The card 
uses this to aggregate the four OC-48 
client signals.

• ODU Multiplex

Table 11-110 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Card Line OTN Settings (continued)

Parameter Description Options
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DLP-  G228 Change the 4x2.5G Muxponder Line OTN Settings
Table 11-111 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Port number 5 (Trunk)

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Note SM (OTUk) is the ITU-T G.709 
optical channel transport unit 
order of k overhead frame used 
for management and performance 
monitoring. PM (ODUk) is the 
ITU-T G.709 optical channel data 
unit order of k overhead frame 
unit used for path performance 
monitoring.

SES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC, 
overhead management, and PM using 
OTUk. Selecting the PM radio button 
selects path PM using ODUk.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

UAS Unavailable seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 
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DLP-  G228 Change the 4x2.5G Muxponder Line OTN Settings
Table 11-112 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 11-113 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

BBE Background block errors Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

FC Failure counter Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Table 11-111 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C ITU-T G.709 Threshold Settings (continued)

Parameter Description Options

Table 11-112 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. 5 (Trunk)

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the interval selected. 
The interval can be set for 15 minutes or 
one day.

Numeric

Uncorrectable 
Words

Displays the number of uncorrectable 
words during the interval selected. The 
interval can be set for 15 minutes or one 
day.

Numeric 
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DLP-  G228 Change the 4x2.5G Muxponder Line OTN Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-113 MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, or 

MXP_2.5G_10EX_C Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. The trail trace 
identifier is applicable only to the trunk 
interface, which handles ITU-T G.709 
frames.

5 (Trunk)

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec box to keep 
this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 minutes.

Checked/unchecked (default)
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DLP-  G228 Change the 4x2.5G Muxponder Line OTN Settings
NTP-G99 Modify the 2.5G Data Muxponder Card Line Settings 
and PM Parameter Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the muxponder card 
settings. If you are already logged in, proceed to Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G236 Change the 2.5G Data Muxponder Client Line Settings, page 11-304

• DLP-G237 Change the 2.5G Data Muxponder Distance Extension Settings, page 11-306

• DLP-G238 Change the 2.5G Data Muxponder SONET (OC-48)/SDH (STM-16) Settings, 
page 11-308

• DLP-G239 Change the 2.5G Data Muxponder Section Trace Settings, page 11-310

• DLP-G240 Change the 2.5G Data Muxponder SONET or SDH Line Thresholds, page 11-313

• DLP-G321 Change the 2.5G Data Muxponder Line Thresholds for 1G Ethernet or 1G FC/FICON 
Payloads, page 11-315

• DLP-G307 Provision the 2.5G Data Muxponder Trunk Port Alarm and TCA Thresholds, 
page 11-317

• DLP-G308 Provision the 2.5G Data Muxponder Client Port Alarm and TCA Thresholds, 
page 11-318

• DLP-G370 Change the 2.5G Data Muxponder Trunk Wavelength Settings, page 11-312

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the 
Alarm and TCA Monitoring and Management document.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for the 
MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

DLP-G726 Preprovisioning a Multirate PPM (if necessary)

DLP-G278 Provision the Optical Line Rate, page 11-175 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G236 Change the 2.5G Data Muxponder Client Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the line settings.

Step 2 Click the Provisioning > Line > Client tabs. Tabs and parameter selections vary according to PPM 
provisioning.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163. 

Step 3 Modify any of the settings for the Client tab as described in Table 11-114. 

Purpose This task changes the client line settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-114  MXP_MR_2.5G or MXPP_MR_2.5G Card Client Settings

Parameter Description Options

Port (Display only) Port number. • 1

• 2 

Port Name The user can assign a logical name for 
each of the ports shown by filling in this 
field.

User-defined. Name can be up to 32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on page 17-16.

Note You can provision a string (port name) for each fiber 
channel/FICON interface on the MXP_MR_2.5G and 
MXPP_MR_2.5G cards, which allows the MDS Fabric 
Manager to create a link association between that SAN port 
and a SAN port on a Cisco MDS 9000 switch.

Admin 
State

Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, 
see the Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)
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Service 
State

Identifies the autonomously generated 
state that gives the overall condition of the 
port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information 
about service states, see the 
Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled 
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)

ALS Mode Sets the ALS function. • Disabled (default): ALS is off; the laser is not automatically 
shut down when traffic outages (LOS) occur.

• Auto Restart: (MXP_MR_2.5G only) ALS is on; the laser 
automatically shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that caused the 
outage are resolved.

• Manual Restart: ALS is on; the laser automatically shuts down 
when traffic outages (LOS) occur. However, the laser must be 
manually restarted when conditions that caused the outage are 
resolved.

• Manual Restart for Test: Manually restarts the laser for testing.

Table 11-114  MXP_MR_2.5G or MXPP_MR_2.5G Card Client Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G237 Change the 2.5G Data Muxponder Distance Extension Settings

Reach Displays the optical reach distance of the 
client port.

The reach distances that appear in the drop-down list depend on the 
card:

• Autoprovision—The system to automatically provision the 
reach from the pluggable port module (PPM) reach value on 
the hardware.

• SX—Short laser wavelength on multimode fiber optic cable 
for a maximum length of 550 meters. The operating 
wavelength range is 770-860 nm.

•  LX—Long wavelength for a long haul fiber optic cable for a 
maximum length of 10 km. The operating wavelength range is 
1270-1355 nm.

•  CX—Two pairs of 150-ohm shielded twisted pair cable for a 
maximum length of 25 meters.

•  T—Four pairs of Category 5 Unshielded Twisted Pair cable 
for a maximum length of 100 meters.

•  DX—Single mode up to 40 km. The operating wavelength 
range is 1430-1580 nm.

•  HX—Single mode up to 40 km. The operating wavelength 
range is 1280-1335 nm.

•  ZX—Extended wavelength single-mode optical fiber for up to 
100 km. The operating wavelength range is 1500-1580 nm.

•  VX—Single mode up to 100 km. The operating wavelength 
range is 1500-1580 nm.

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths:850 nm through 1560.61 nm; 100-GHz 
ITU spacing; CWDM spacing

Purpose This task changes the distance extension settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-114  MXP_MR_2.5G or MXPP_MR_2.5G Card Client Settings (continued)

Parameter Description Options
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Note Distance extension settings can be changed only if the facilities are out of service (OOS,DSBLD).

Note The distance extension parameters only apply to client ports (Ports 1 to 8) and not to the trunk ports 
(Port 9 for MXP_MR_2.5G card or Ports 9 and 10 for the MXPP_MR_2.5G card).

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the distance extension settings.

Step 2 Click the Provisioning > Line > Client tabs. A client port must be provisioned for the tab to be present.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Step 3 Locate the Client port table row and verify that the Service State column value is OOS-MA,DSBLD 
(ANSI) or Locked-enabled,disabled (ETSI). If yes, continue with Step 4. If not, complete the following 
substeps:

a. Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Maintenance 
(ETSI).

b. Click Apply, then Yes.

Step 4 Click the Provisioning > Line > Distance Extension tabs. Tabs and parameter selections vary according 
to PPM provisioning.

Step 5 Modify any of the settings for the Distance Extension tab as described in Table 11-115. 

Table 11-115  MXP_MR_2.5G or MXPP_MR_2.5G Card Line Distance Extension Settings

Parameter Description Options

Port (Display only) Port number • 1

• 2 

Enable 
Distance 
Extension

Allows end-to-end distances of up to 
1600 km for FC1G and up to 800 km for 
FC2G. If Distance Extension is enabled, 
set the connected Fibre Channel switches 
to Interop or Open Fabric mode, 
depending on the Fibre Channel switch. 
By default, the MXP_MR_2.5G and 
MXPP_MR_2.5G card will interoperate 
with the Cisco Multilayer Director 
Switch (MDS) storage products.

Checked or unchecked

Auto Detect 
Credits

Allows automatic detection of buffer 
credits for Fibre Channel flow control.

Checked or unchecked
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Step 6 Click Apply. 

Step 7 Return to your originating procedure (NTP).

DLP-G238 Change the 2.5G Data Muxponder SONET (OC-48)/SDH (STM-16) 
Settings

Note SONET (OC-48)/SDH (STM-16) settings apply only to the trunk ports (Port 9 for the MXP_MR_2.5G 
card and Ports 9 and 10 for the MXPP_MR_2.5G card.)

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the OC-48/STM-64 settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameter selections vary 
according to PPM provisioning.

Step 3 Modify any of the settings for the SONET or SDH tab as described in Table 11-116. 

Credits 
Available

(Display only) Displays the number of 
buffer credits available.

Numeric (range depends on the client 
equipment attached to the card)

Autoadjust 
GFP Buffer 
Threshold

Allows the threshold of the generic 
framing procedure (GFP) buffer between 
two MXP_MR_2.5G or two 
MXPP_MR_2.5G cards to be 
automatically adjusted.

Checked or unchecked

GFP Buffers 
Available

Displays the number of GFP buffers 
available between two MXP_MR_2.5G 
or two MXPP_MR_2.5G cards.

Numeric

Purpose This task changes the SONET (OC-48) or SDH (STM-16) settings for 
MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-115  MXP_MR_2.5G or MXPP_MR_2.5G Card Line Distance Extension Settings (continued)

Parameter Description Options
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Table 11-116 MXP_MR_2.5G or MXPP_MR_2.5G Card Line SONET or SDH Settings

Parameter Description Options

Port (Display only) Port number. 9 (trunk for MXP_MR_2.5G) or 9 and 10 (trunks for 
MXPP_MR_2.5G)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information about 
service states, see the Administrative and Service 
States document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER1 Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5

SD BER1 Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

ALS Mode Sets the ALS function mode. The DWDM 
transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or 
can be set for one of three mode options.

• Disable (default): ALS is off; the laser is not 
automatically shut down when traffic outages (LOS) 
occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser 
for testing.
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G239 Change the 2.5G Data Muxponder Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to 
PPM provisioning.

AINS Soak Sets the automatic in-service soak period. 
Double-click the time and use the up and down 
arrows to change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type. • SONET (ANSI)

• SDH (ETSI)

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source.

Checked or unchecked

Send 
DoNotUse

Sets the Send DoNotUse card state. When 
checked, sends a DUS message on the S1 byte.

Checked or unchecked

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as an NE timing 
reference.

Checked or unchecked

1. SF BER and SD BER thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9 and 10 for MXPP_MR_2.5G).

Purpose This task changes the section trace settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-116 MXP_MR_2.5G or MXPP_MR_2.5G Card Line SONET or SDH Settings (continued)

Parameter Description Options
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Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Step 3 Modify any of the settings in the Section Trace tab as described in Table 11-117. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-117 MXP_MR_2.5G or MXPP_MR_2.5G Card Line Section Trace Settings

Parameter Description Options

Port (Display only) Port number. • 9 (trunk port for MXP_MR_2.5G) 

• 9 and 10 (trunk ports for 
MXPP_MR_2.5G)

Received Trace 
Mode

Sets the received trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If an TIM on Section overhead alarm arises because of a J0 
overhead string mismatch, no alarm indication signal is sent to 
downstream nodes if this box is checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; sets a new transmit string. 
You can click the button on the right to change the display. Its 
title changes, based on the current display mode. Click Hex to 
change the display to hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII (button changes to 
Hex).

String of trace string size

Expected Displays the current expected string; sets a new expected string. 
You can click the button on the right to change the display. Its 
title changes, based on the current display mode. Click Hex to 
change the display to hexadecimal (button changes to ASCII); 
click ASCII to change the display to ASCII (button changes to 
Hex).

String of trace string size

Received (Display only) Displays the current received string. You can 
click Refresh to manually refresh this display, or check the 
Auto-refresh every 5 sec check box to keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the display every 5 seconds. Checked/unchecked (default)
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DLP-G370 Change the 2.5G Data Muxponder Trunk Wavelength Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the trunk wavelength settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.

Step 3 Modify any of the settings as described in Table 11-118. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the trunk wavelength settings for the MXP_MR_2.5G 
and MXPP_MR_2.5G.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-118  MXP_MR_2.5G or MXPP_MR_2.5G Card Wavelength Trunk Settings

Parameter Description Options

Port (Display only) Displays the port number. 9 (Trunk)

10 (Trunk) (MXPP_MR_2.5G only)

Band (Display only) Indicates the wavelength 
band that can be provisioned. 

C—Only the C band is available

Even/Odd Sets the wavelengths available for 
provisioning. This field does not apply to 
MXP_MR_2.5G or MXPP_MR_2.5G 
cards

—

Wavelength The wavelength provisioned for the trunk. • First Tunable Wavelength

• Further wavelengths in 100-GHz 
ITU-T, C-band spacing. If the card is 
installed, the wavelengths it carries 
are identified with two asterisks. 
Other wavelengths have a dark grey 
background. If the card is not 
installed, all wavelengths appear 
with a dark grey background.
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DLP-G240 Change the 2.5G Data Muxponder SONET or SDH Line Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings as shown in Table 11-119.

Note You must modify Near End and Far End independently, 15 Min and 1 Day independently, and 
Line and Section independently. To do so, choose the appropriate radio button and click Refresh.

Note In Table 11-119, some parameters or options do not apply to all MXP_MR_2.5G or 
MXPP_MR_2.5G cards. If the parameters or options do not apply, they do not appear in CTC.

Purpose This task changes the SONET or SDH line threshold settings for 
MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-119 MXP_MR_2.5G or MXPP_MR_2.5G Card Line Threshold Settings

Field Description ONS 15454 Options ONS 15454 SDH Options

Port (Display only) 
Port number

• 9 (MXP_MR_2.5G)

• 9 and 10 (MXPP_MR_2.5G)

• 9 (MXP_MR_2.5G)

• 9 and 10 (MXPP_MR_2.5G)

EB Path Errored 
Block indicates 
that one or 
more bits are in 
error within a 
block

— Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and click 
Refresh. 

CV Coding 
violations

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only) 

Choose an option in each category and click 
Refresh. 

—
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ES Errored 
seconds

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only) 

Choose an option in each category and click 
Refresh. 

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and click 
Refresh. 

SES Severely 
errored seconds

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end only) 

Choose an option in each category and click 
Refresh. 

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and click 
Refresh. 

BBE Background 
block errors

— Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and click 
Refresh. 

SEFS (Section or 
Regeneration 
Section only) 
Severely 
errored framing 
seconds

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Section only

Choose an option in each category and click 
Refresh. 

—

FC (Line or 
Multiplex 
Section only) 
Failure count

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Section only

Choose an option in each category and click 
Refresh. 

—

UAS (Line or 
Multiplex 
Section only) 
Unavailable 
seconds

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Section only

Choose an option in each category and click 
Refresh. 

Numeric. Threshold display options include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Regeneration Section (only) 

Choose an option in each category and click 
Refresh. 

Table 11-119 MXP_MR_2.5G or MXPP_MR_2.5G Card Line Threshold Settings (continued)

Field Description ONS 15454 Options ONS 15454 SDH Options
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Step 5 Return to your originating procedure (NTP).

DLP-G321 Change the 2.5G Data Muxponder Line Thresholds for 1G Ethernet or 
1G FC/FICON Payloads

Step 1 Display the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the line threshold 
settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 11-120 for a list of available 
Ethernet variables.

Purpose This task changes the line threshold settings for MXP_MR_10G and 
MXPP_MR_2.5G transponder cards carrying the 1G Ethernet or 
1G FC/FICON payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-120 MXP_MR_2.5G and MXPP_MR 2.5G Card 1G Ethernet or 1G, 2G FC/FICON Variables           

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of receive packets.

ifInDiscards Number of inbound packets that were chosen to be discarded 
even though no errors had been detected to prevent their 
being deliverable to a higher-layer protocol.

ifInErrors Total number of receive errors.

ifOutOctets The total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

ifOutDiscards Number of outbound packets that were chosen to be 
discarded even though no errors had been detected to prevent 
their being transmitted.
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Step 12 Return to your originating procedure (NTP).

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes. 
This value is a part of high-level data link control (HDLC) 
and GFP port statistics.

mediaIndStatsRxFramesTooLong Number of received frames that exceed the maximum 
transmission unit (MTU). This value is part of HDLC and 
GFP port statistics.

mediaIndStatsRxFramesBadCRC Number of receive data frames with payload cyclic 
redundancy check (CRC) errors when HDLC framing is 
used.

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC errors 
when HDLC framing is used.

8b10bInvalidOrderedSets Number of 8b10b disparity violations on the Fibre Channel 
line side.

8b10bStatsEncodingDispErrors Number of 8b10b disparity violations on the Fibre Channel 
line side.

Table 11-120 MXP_MR_2.5G and MXPP_MR 2.5G Card 1G Ethernet or 1G, 2G FC/FICON Variables            

(continued)
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DLP-G307 Provision the 2.5G Data Muxponder Trunk Port Alarm and TCA 
Thresholds

Note Throughout this task, trunk port refers to Port 9 (MXP_MR_2.5G and MXPP_MR_2.5G) and Port 10 
(MXPP_MR_2.5G only).

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Step 3 Verify the trunk port TCA thresholds for RX Power High is –9 dBm and for RX Power Low is –23 dBm. 
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting 
it, entering a new value, and hitting Enter.

Step 4 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 5 Verify the trunk port Alarm thresholds for RX Power High is –7 dBm and for RX Power Low is –26 dBm. 
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting 
it, entering a new value, and hitting Enter.

Step 6 Click Apply. 

Step 7 Return to your originating procedure (NTP).

Purpose This task changes the MXP_MR_2.5G and MXPP_MR_2.5G trunk port 
alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G308 Provision the 2.5G Data Muxponder Client Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the MXP_MR_2.5G or 
MXPP_MR_2.5G card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 11-121, verify the client port (Ports 1 through 8) TCA thresholds for RX Power High, 
RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. 
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting 
it, entering a new value, and hitting Enter.

Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Purpose This task provisions the client port alarm and TCA thresholds for the 
MXP_MR_2.5G and MXPP_MR_2.5G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Step 5 Repeat Steps 3 and 4 to provision each additional client port.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-122, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned. Provision new thresholds as needed by double-clicking the threshold value you want to 
change, deleting it, entering a new value, and hitting Enter.

Table 11-121 MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface TCA Thresholds

Port Type
(by CTC)

Pluggable Port 
Module (XFP)

TCA RX
Power Low

TCA RX
Power High

TCA TX
Power Low

TCA TX
Power High

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–15 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

ONE_GE 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–17 0 –16 3

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–20 –3 –16 3

ESCON ONS-SE-200-MM –21 –14 –32 –11
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Step 8 Click Apply.

Step 9 Repeat Steps 7 and 8 to provision each additional client port. When you have finished provisioning client 
ports, continue with Step 10.

Step 10 Return to your originating procedure (NTP).

Table 11-122 MXP_MR_2.5G and MXPP_MR_2.5G Card Client Interface Alarm Thresholds

Port Type
(by CTC)

Pluggable Port 
Module (XFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–18 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

ONE_GE 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

ESCON ONS-SE-200-MM –24 –11 –35 –8
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NTP-G148 Modify the 10G Data Muxponder Card Line Settings 
and PM Parameter Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the muxponder card 
settings. If you are already logged in, proceed to Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G333 Change the 10G Data Muxponder Client Line Settings, page 11-322

• DLP-G334 Change the 10G Data Muxponder Distance Extension Settings, page 11-324

• DLP-G340 Change the 10G Data Muxponder Trunk Wavelength Settings, page 11-326

• DLP-G335 Change the 10G Data Muxponder SONET (OC-192)/SDH (STM-64) Settings, 
page 11-327

• DLP-G336 Change the 10G Data Muxponder Section Trace Settings, page 11-329

• DLP-G341 Change the 10G Data Muxponder SONET or SDH Line Thresholds, page 11-330

• DLP-G337 Change the 10G Data Muxponder Line RMON Thresholds for Ethernet, 1G FC/FICON, 
or ISC/ISC3 Payloads, page 11-332

• DLP-G338 Provision the 10G Data Muxponder Trunk Port Alarm and TCA Thresholds, 
page 11-335

• DLP-G339 Provision the 10G Data Muxponder Client Port Alarm and TCA Thresholds, 
page 11-337

• DLP-G366 Change the 10G Data Muxponder OTN Settings, page 11-340

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the 
Alarm and TCA Monitoring and Management document.

Purpose This procedure changes the line and threshold settings for the 
MXP_MR_10DME_C, MXP_MR_10DME_L, and 
MXP_MR_10DMEX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

DLP-G726 Preprovisioning a Multirate PPM (if necessary)

DLP-G278 Provision the Optical Line Rate, page 11-175 (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Stop. You have completed this procedure.

DLP-G333 Change the 10G Data Muxponder Client Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C card where you want to 
change the line settings.

Step 2 Click the Provisioning > Line > Client tabs. Tabs and parameter selections vary according to PPM 
provisioning.

Step 3 Modify any of the settings for the Client tab as described in Table 11-123. 

Purpose This task changes the line settings for the MXP_MR_10DME_C, 
MXP_MR_10DME_L, and MXP_MR_10DMEX_C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-123 MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C Card Line Client Settings

Parameter Description Options

Port (Display only) Port number. 1 through 8

Port Name The user can assign a logical name for each 
of the ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ special 
characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on page 17-16.

Note You can provision a string (port name) for each fiber 
channel/FICON interface on the MXP_MR_10DME_C, 
MXP_MR_10DME_L, and MXP_MR_10DMEX_C cards, 
which allows the MDS Fabric Manager to create a link 
association between that SAN port and a SAN port on a 
Cisco MDS 9000 switch.

Admin 
State

Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
the Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)
11-322
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_administrative_service_states.html


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G333 Change the 10G Data Muxponder Client Line Settings
Service 
State

(Display only) Identifies the autonomously 
generated state that gives the overall 
condition of the port. Service states appear 
in the format: Primary State-Primary State 
Qualifier, Secondary State. For more 
information about service states, see the 
Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled 
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance (ETSI)

ALS Mode Sets the ALS function mode. • Disabled (default): ALS is off; the laser is not automatically 
shut down when traffic outages (LOS) occur.

• Manual Restart: ALS is on; the laser automatically shuts down 
when traffic outages (LOS) occur. However, the laser must be 
manually restarted when conditions that caused the outage are 
resolved.

• Manual Restart for Test: Manually restarts the laser for testing.

Reach Sets the optical reach distance of the client 
port.

The reach distances that appear in the drop-down list depend on the 
card:

• Autoprovision—The system to automatically provision the 
reach from the pluggable port module (PPM) reach value on 
the hardware.

• SX—Short laser wavelength on multimode fiber optic cable 
for a maximum length of 550 meters. The operating 
wavelength range is 770-860 nm.)

•  LX—Long wavelength for a long haul fiber optic cable for a 
maximum length of 10 km. The operating wavelength range is 
1270-1355 nm.)

•  CX—Two pairs of 150-ohm shielded twisted pair cable for a 
maximum length of 25 meters.)

•  T—Four pairs of Category 5 Unshielded Twisted Pair cable 
for a maximum length of 100 meters.)

•  DX—Single mode up to 40 km. The operating wavelength 
range is 1430-1580 nm.)

•  HX—Single mode up to 40 km. The operating wavelength 
range is 1280-1335 nm.)

•  ZX—Extended wavelength single-mode optical fiber for up to 
100 km. The operating wavelength range is 1500-1580 nm.)

•  VX—Single mode up to 100 km. The operating wavelength 
range is 1500-1580 nm.)

Table 11-123 MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C Card Line Client Settings (continued)

Parameter Description Options
11-323
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_administrative_service_states.html


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G334 Change the 10G Data Muxponder Distance Extension Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G334 Change the 10G Data Muxponder Distance Extension Settings

Note The distance extension parameters only apply to client ports (Ports 1 to 8) and not to the trunk port 
(Port 9).

Note The client port must be in the OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state in order to change 
the distance extension settings. If a Y-cable is provisioned on the client port, both the working and 
protect client ports must be in OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state before you change 
the distance extension settings.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C card where you want to 
change the distance extension settings.

Step 2 Click the Provisioning > Line > Distance Extension tabs.

Step 3 Modify any of the settings as described in Table 11-124. 

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths:
850 nm through 1560.61 nm
100-GHz ITU spacing
CWDM spacing

Squelch Shuts down the far-end laser in response to 
certain defects. (Squelch does not apply to 
ISC COMPACT payloads.)

• Squelch

• Disable

Purpose This task changes the distance extension settings for the 
MXP_MR_10DME_C, MXP_MR_10DME_L, and 
MXP_MR_10DMEX_C muxponder card ports provisioned for Fibre 
Channel or FICON payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-123 MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C Card Line Client Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-124 MXP_MR_10DME_C, MXP_MR_10DME_L, or MXP_MR_10DMEX_C Card Line Distance 

Extension Settings

Parameter Description Options

Port (Display only) Port number. Up to eight 
ports might appear based on the number 
of pluggable port modules that are 
provisioned. 

—

Enable 
Distance 
Extension

Allows end-to-end distances of up to 
1600 km for FC1G and up to 800 km for 
FC2G. If Distance Extension is enabled, 
set the connected Fibre Channel switches 
to Interop or Open Fabric mode, 
depending on the Fibre Channel switch. 
By default, the MXP_MR_10DME_C 
and MXP_MR_10DME_L card will 
interoperate with the Cisco MDS storage 
products.

Checked or unchecked

Fast Switch If unchecked, the end-to-end fiber 
channel link is reinitialized every time a 
Y-cable protection switch occurs. If 
checked, reinitialization of the link is 
avoided when a Y-cable protection switch 
occurs, thus reducing the traffic hit 
considerably. 

This feature is supported for FC1G, 
FC2G, FC4G, FICON1G, FICON2G, and 
FICON4G trunk failures as well as 
user-initiated Y-cable protection switch 
such as, Manual, Force, or Lockout. It is 
recommended that you do not enable the 
Fast Switch option as the link may not 
come up after a Y-cable protection switch 
in certain cases.

Note This option can be used only if 
you have unchecked Enable 
Distance Extension option.

Checked or unchecked (default)
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DLP-G340 Change the 10G Data Muxponder Trunk Wavelength Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C or MXP_MR_10DME_L card where you want to change the trunk wavelength 
settings.

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.

Step 3 Modify any of the settings for the Wavelength Trunk Settings tab as described in Table 11-125. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the trunk wavelength settings for the 
MXP_MR_10DME_C and MXP_MR_10DME_L.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-125 MXP_MR_10DME_C or MXP_MR_10DME_L Card Wavelength Trunk Settings

Parameter Description Options

Port (Display only) Displays the port number. Port 9 (Trunk)

Band Indicates the wavelength band that can be 
provisioned. The field is display-only 
when a physical MXP_MR_10DME_C or 
MXP_MR_10DME_L is installed. If the 
card is provisioned in CTC only, you can 
provision the band for the card that will 
be installed. 

• C—The C-band wavelengths are 
available in the Wavelength field.

• L—The L-band wavelengths are 
available in the Wavelength field.

Even/Odd Sets the wavelengths available for 
provisioning.

• Even—Displays even C-band or 
L-band wavelengths in the 
Wavelength field.

• Odd—Displays odd C-band or 
L-band wavelengths in the 
Wavelength field.

Wavelength The wavelength provisioned for the trunk. • First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
spacing
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DLP-G335 Change the 10G Data Muxponder SONET (OC-192)/SDH (STM-64) 
Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C or MXP_MR_10DME_L card where you want to change the SONET 
(OC-192)/SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameter selections vary 
according to PPM provisioning.

Step 3 Modify any of the settings as described in Table 11-126. 

Purpose This task changes the OC-192 (ANSI)/STM-64 (ETSI) settings for the 
MXP_MR_10DME_C and MXP_MR_10DME_L muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-126 MXP_MR_10DME_C or MXP_MR_10DME_L Card Line SONET or SDH Settings

Parameter Description Options

Port (Display only) Port number. 9 (Trunk)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information about 
service states, see the Administrative and Service 
States document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER1 Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

SD BER1 Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Type The optical transport type. • SONET (ANSI)

• SDH (ETSI)

ALS Mode Sets the ALS function mode. The DWDM 
transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or 
can be set for one of three mode options.

• Disabled (default): ALS is off; the laser is not 
automatically shut down when traffic outages (LOS) 
occur.

• Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser 
for testing.

AINS Soak Sets the automatic in-service soak period. 
Double-click the time and use the up and down 
arrows to change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a NE timing 
reference.

Checked or unchecked

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source.

Checked or unchecked

Send 
DoNotUse

Sets the Send DoNotUse card state. When 
checked, sends a DUS (do not use) message on 
the S1 byte.

Checked or unchecked

1. SF BER and SD BER thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9 and 10 for MXPP_MR_2.5G).

Table 11-126 MXP_MR_10DME_C or MXP_MR_10DME_L Card Line SONET or SDH Settings (continued)

Parameter Description Options
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DLP-G336 Change the 10G Data Muxponder Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C or MXP_MR_10DME_L card where you want to change the section trace 
settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to 
PPM provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in Table 11-127. 

Purpose This task changes the section trace settings for the MXP_MR_10DME_C 
and MXP_MR_10DME_L muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-127 MXP_MR_10DME_C or MXP_MR_10DME_L Card Line Section Trace Settings

Parameter Description Options

Port (Display only) Port number. • 9 (trunk only)

Received 
Trace Mode

Sets the received trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If a TIM on section overhead alarm arises because of a J0 
overhead string mismatch, no alarm indication signal is sent to 
downstream nodes if this box is checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; sets a new transmit string. 
You can click the button on the right to change the display. Its title 
changes, based on the current display mode. Click Hex to change 
the display to hexadecimal (button changes to ASCII); click 
ASCII to change the display to ASCII (button changes to Hex).

String of trace string size

Expected Displays the current expected string; sets a new expected string. 
You can click the button on the right to change the display. Its title 
changes, based on the current display mode. Click Hex to change 
the display to hexadecimal (button changes to ASCII); click 
ASCII to change the display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current received string. You can click 
Refresh to manually refresh this display, or select the 
Auto-refresh every 5 sec check box to keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the display every 5 seconds. Checked/unchecked (default)
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G341 Change the 10G Data Muxponder SONET or SDH Line Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C or MXP_MR_10DME_L card where you want to change the line threshold 
settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings as shown in Table 11-128.

Note You must modify Near End and Far End independently; 15 Min and 1 Day independently; and 
Line and Section independently. To do so, choose the appropriate radio button and click Refresh.

Note In Table 11-128, some parameters and options do not apply to all MXP_MR_10DME cards. If 
the parameter or options do not apply, they do not appear in CTC.

Purpose This task changes the SONET or SDH line threshold settings for the 
MXP_MR_10DME_C and MXP_MR_10DME_L muxponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-128 MXP_MR_10DME_C or MXP_MR_10DME_LCard Line Threshold Settings

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH

Port (Display only) Port 
number

• 9 (Trunk) • 9 (Trunk)

EB Path Errored Block 
indicates that one or 
more bits are in error 
within a block

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 
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CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SEFS (Near End Section or 
Regeneration Section 
only) Severely 
errored framing 
seconds 

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

BBE Background block 
errors

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Table 11-128 MXP_MR_10DME_C or MXP_MR_10DME_LCard Line Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G337 Change the 10G Data Muxponder Line RMON Thresholds for Ethernet, 
1G FC/FICON, or ISC/ISC3 Payloads

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), display the MXP_MR_10DME_C or 
MXP_MR_10DME_L card where you want to change the line threshold settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1 
(ONE_GE)”, or the equivalent ITU-T G.7041 GFP (Generic Frame Procedure) port.

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Purpose This task changes the line threshold settings for MXP_MR_10DME_C and 
MXP_MR_10DME_L cards carrying Ethernet, FC/FICON, or ISC/ISC3 
payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-128 MXP_MR_10DME_C or MXP_MR_10DME_LCard Line Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
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Step 5 From the Variable drop-down list, choose an Ethernet, FC, FICON, or ISC variable. See Table 11-129 
for a list of available Ethernet variables, Table 11-130 for a list of FC and FICON variables, 
Table 11-131 for a list of ISC and ISC3 variables, and Table 11-132 for a list of GFP variables.

Table 11-129 MXP_MR_10DME_C or MXP_MR_10DME_L Ethernet Variables

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of receive packets.

ifInErrors Total number of receive errors.

ifOutOctets The total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes. 
This value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong Number of received frames that exceed the MTU1. This 
value is part of HDLC and GFP port statistics.

1. Frames larger than the MTU, including Jumbo frames, pass through. The MTU, however, is not 
specified by the user.

mediaIndStatsRxFramesBadCRC Number of receive data frames with payload CRC errors 
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC 
errors when HDLC framing is used.

8b10bInvalidOrderedSetsDispErrorsSu
m

Number of code violations/running disparity errors in the 
8b/10b encoded characters received.

Table 11-130 MXP_MR_10DME_C or MXP_MR_10DME_L FC/FICON Variables

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of receive packets.

ifInErrors Total number of receive errors.

ifOutOctets The total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

ifOutOversizePkts Total number of oversized packets output from the 
interface.

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes. 
This value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong Number of received frames that exceed the MTU. This 
value is part of HDLC and GFP port statistics.
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mediaIndStatsRxFramesBadCRC Number of receive data frames with payload CRC errors 
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC 
errors when HDLC framing is used.

fcStatsZeroTxCredits This is a count that increments when the FC/FICON Tx 
credits go from a non-zero value to zero.

fcStatsRxRecvrReady Number of received RDY (Receive Ready) order set.

fcStatsTxRecvrReady Number of transmitted RDY (Receive Ready) order set.

8b10bInvalidOrderedSetsDispErrorsSu
m

Number of Code Violations/Running Disparity errors in 
the 8b/10b encoded characters received.

Table 11-131 MXP_MR_10DME_C or MXP_MR_10DME_L ISC and ISC3Variables

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of receive packets.

ifOutOctets The total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

8b10bInvalidOrderedSetsDispErrorsSu
m

Number of Code Violations/Running Disparity errors in 
the 8b/10b encoded characters received.

Table 11-132 MXP_MR_10DME_C or MXP_MR_10DME_L GFP RMON Variables

Variable Description

gfpStatsRxSBitErrors Received generic framing protocol (GFP) frames with 
single bit errors in the core header (these errors are 
correctable).

gfpStatsRxTypeInvalid Received GFP frames with invalid type (these are 
discarded). For example, receiving GFP frames that 
contain Ethernet data when we expect Fibre Channel data.

gfpStatsRxSblkCRCErrors Total number of superblock CRC errors with the receive 
transparent GFP frame. A transparent GFP frame has 
multiple superblocks which each contain Fibre Channel 
data. 

gfpStatsCSFRaised Number of Rx client management frames with Client 
Signal Fail indication.

Table 11-130 MXP_MR_10DME_C or MXP_MR_10DME_L FC/FICON Variables (continued)

Variable Description
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Note To view all RMON thresholds, click Show All RMON thresholds. 

Step 12 Return to your originating procedure (NTP).

DLP-G338 Provision the 10G Data Muxponder Trunk Port Alarm and TCA 
Thresholds

gfpStatsLFDRaised The number of Core HEC CRC Multiple Bit Errors.

Note This count is only for cHEC multiple bit error 
when in frame. It is a count of when the state 
machine goes out of frame.

Table 11-132 MXP_MR_10DME_C or MXP_MR_10DME_L GFP RMON Variables (continued)

Purpose This task changes the MXP_MR_10DME_C and MXP_MR_10DME_L 
trunk port alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed
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Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C or MXP_MR_10DME_L card where you want to change the trunk port alarm and 
TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 3 If TCA is not selected, click TCA and then click Refresh. If it is selected, continue with Step 4.

Step 4 Verify the trunk port (Port 9) TCA thresholds are set at the values shown as follows. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and press Enter.

• RX Power High: –9 dBm

• RX Power Low: –18 dBm

• TX Power High: 9 dBm

• TX Power Low: 0 dBm

Step 5 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Verify the trunk port (Port 9) Alarm thresholds are set at the values shown as follows. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and press Enter.

• RX Power High: –8 dBm

• RX Power Low: –20 dBm

• TX Power High: 7 dBm

• TX Power Low: 3 dBm

Step 7 Click Apply. 

Step 8 Return to your originating procedure (NTP).

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G339 Provision the 10G Data Muxponder Client Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C and MXP_MR_10DME_L card where you want to change the client port alarm 
and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 11-133, verify the client ports (Ports 1 through 8) TCA thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. 
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting 
it, entering a new value, and hitting Enter.

Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Purpose This task provisions the client port alarm and TCA thresholds for the 
MXP_MR_10DME_C and MXP_MR_10DME_L cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Step 5 Repeat Steps 3 and 4 to provision each additional client port.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-134, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned. Provision new thresholds as needed by double-clicking the threshold value you want to 
change, deleting it, entering a new value, and hitting Enter.

Table 11-133 MXP_MR_10DME_C and MXP_MR_10DME_L Card Client Interfaces TCA Thresholds

PPM Port 
Rate

Pluggable Port Module 
(XFP)

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

0 –17 3 –16

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–3 –20 3 –16

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

0 –15 3 –16

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–3 –20 3 –16

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

0 –17 3 –16

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–3 –20 3 –16

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

0 –17 3 –16

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–3 –20 3 –16

ISC3 
PEER 1G

ISC3 
PEER 2G

ONS-SE-G2F-SX 0 –17 3 –16

ONS-SE-G2F-LX 0 –20 3 –16

FC4G ONS-SE-4G-MM 0 –12 4 –15

ONS-SE-4G-SM –1 –15 4 –15

FICON4G ONS-SE-4G-MM 0 –12 4 –15

ONS-SE-4G-SM –1 –15 4 –15
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Step 8 Click Apply.

Step 9 Repeat Steps 7 and 8 to provision each additional client port. 

Step 10 Return to your originating procedure (NTP).

Table 11-134 MXP_MR_10DME_C and MXP_MR_10DME_L Card Client Interface Alarm 

Thresholds

PPM Port 
Rate

Pluggable Port Module 
(XFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

FC1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

FC2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–18 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

FICON1G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

FICON2G 15454-SFP-GEFC-SX
15454E-SFP-GEFC-S
ONS-SE-G2F-SX

–20 3 –13 –1

15454-SFP-GE+-LX
15454E-SFP-GE+-LX
ONS-SE-G2F-LX

–23 0 –13 0

ISC3 
PEER 1G

ISC3 
PEER 2G

ONS-SE-G2F-SX –20 3 –13 –1

ONS-SE-G2F-LX –23 0 –13 0

FC4G ONS-SE-4G-MM –15 3 –11 –1

ONS-SE-4G-SM –18 2 –11 0

FICON4G ONS-SE-4G-MM –15 3 –11 –1

ONS-SE-4G-SM –18 2 –11 0
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DLP-G366 Change the 10G Data Muxponder OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 
MXP_MR_10DME_C and MXP_MR_10DME_L card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, G.709 
Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in Tables 11-135 through 11-138. 

Note You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To 
do so, choose the appropriate radio button and click Refresh.

Table 11-135 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 11-136 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Purpose This task changes the OTN settings for the MXP_MR_10DME_C and 
MXP_MR_10DME_L cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-135 MXP_MR_10DME_C and MXP_MR_10DME_L Card OTN Line Settings

Parameter Description Options

Port (Display only) Displays the port number. 9 (Trunk)

G.709 OTN Sets the OTN lines according to 
ITU-T G.709.

• Enable

• Disable

FEC Sets the OTN lines to forward error 
correction (FEC).

• Standard

• Enhanced

SF BER (Display only) Sets the signal fail bit 
error rate.

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Asynch/Synch 
Mapping

Sets how the ODUk (client payload) is 
mapped to the optical channel (OTUk).

• Asynch mapping

• Synch mapping
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Table 11-137 describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 11-138 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 11-136 MXP_MR_10DME_C and MXP_MR_10DME_L Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port1 

1. Latency for a 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is 40 microseconds. Latency 
for a 2G-FC payload without ITU-T G.709 is 2 microseconds, and with ITU-T G.709 is 20 microseconds. Consider these 
values when planning a FC network that is sensitive to latency.

(Display only) Port number. 9 (Trunk)

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

Table 11-137 MXP_MR_10DME_C and MXP_MR_10DME_L Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Port number. 2

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 11-138 MXP_MR_10DME_C and MXP_MR_10DME_L Card Trail Trace Identifier 

Settings

Parameter Description Options

Port (Display only) Port number. 2

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G293 Modify the 40G Muxponder Card Line Settings and 
PM Parameter Thresholds

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Purpose This procedure changes the line and parameter threshold settings of the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponder cards.

Tools/Equipment None

Table 11-138 MXP_MR_10DME_C and MXP_MR_10DME_L Card Trail Trace Identifier 

Settings (continued)

Parameter Description Options
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Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the muxponder card 
settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to save the existing settings 
before modifying.

Step 3 Perform any of the following tasks as needed:

• DLP-G662 Change the 40G Multirate Muxponder Card Settings, page 11-344

• DLP-G666 Change the 40G Muxponder Line Settings, page 11-345

• DLP-G735 Provision the 40G Muxponder Ethernet Settings, page 11-347

• DLP-G667 Change the 40G Muxponder SONET (OC-192)/SDH (STM-64) Settings, page 11-348

• DLP-G668 Change the 40G Muxponder Section Trace Settings, page 11-350

• DLP-G669 Change the 40G Muxponder SONET or SDH Line Thresholds, page 11-353

• DLP-G670 Change the 40G Muxponder Line RMON Thresholds for Ethernet, 8G FC, or 10G FC 
Payloads, page 11-355

• DLP-G671 Provision the 40G Muxponder Trunk Port Alarm and TCA Thresholds, page 11-359

• DLP-G672 Provision the 40G Muxponder Client Port Alarm and TCA Thresholds, page 11-360

• DLP-G673 Change the 40G Muxponder OTN Settings, page 11-364

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the 
Alarm and TCA Monitoring and Management document.

Stop. You have completed this procedure.

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (Optional)

• DLP-G278 Provision the Optical Line Rate, page 11-175 (Optional)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G662 Change the 40G Multirate Muxponder Card Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the card settings.

Step 2 Click the Provisioning > Card tabs.

Step 3 Modify either of the settings described in Table 11-139.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the card settings of the 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-139 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Card Settings

Parameter Description ONS 15454 (ANSI) Options
 ONS 15454 SDH (ETSI) 
Options

Card Mode Sets the card mode. • Muxponder

• Unidirectional Regen
Set the mode to 
Unidirectional Regen 
under the following 
conditions:

– Trunk port is in 
OOS,DSBLD state.

– Pluggable port 
modules of the card 
must not be 
configured for 
payload.

– Regeneration peer 
slot must be set to 
None.

• Muxponder

• Unidirectional Regen
Set the mode to 
Unidirectional Regen 
under the following 
conditions:

– Trunk port is in 
locked,disabled 
state.

– Pluggable port 
modules of the card 
must not be 
configured for 
payload.

– Regeneration peer 
slot must be set to 
None.

Trunk 
Wavelengths

(Display only) Shows supported wavelengths 
of the trunk port after the card is installed. The 
40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C card that is installed shows the 
C-band wavelengths that it supports.

— —
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DLP-G666 Change the 40G Muxponder Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C or 
40E-MXP-C card where you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs. Tabs and parameters vary according to the PPM 
provisioning.

Step 3 Modify any of the settings as described in Table 11-140.

Purpose This task changes the line settings of the 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-140 Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options

Port (Display only) Displays the port number. • 1 through 4 (client)

• 5 (trunk)

Port Name Assigns a logical name for each of the port. User-defined. This can be up to 32 alphanumeric or special 
characters, or both. The port name is blank by default. 

For information about assigning a port name, see the 
“DLP-G104 Assign a Name to a Port” task on page 17-16.

Note You can assign a port name for each fiber 
channel/FICON interface on the 40G-MXP-C, 
40E-MXP-C, and 40ME-MXP-C card, enabling the 
MDS Fabric Manager to associate the SAN port and a 
SAN port on the Cisco MDS 9000 switch.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information, see the Administrative and 
Service States document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)

Service State (Display only) Shows the general condition 
of the port. Service states appear in the 
format: Primary State-Primary State 
Qualifier, Secondary State. For more 
information about service states, see the 
Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled 
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance 
(ETSI)
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ALS Mode (Client ports only) Activates the ALS 
mode.

• Disabled (default)—ALS is off; the laser is not 
automatically shut down when traffic outage or loss of 
signal (LOS) occurs.

• Auto Restart—(OC-192/STM-64 only) ALS is on; the 
laser automatically shuts down during LOS. It 
automatically restarts when the conditions that caused the 
outage are resolved.

• Manual Restart—ALS is on; the laser automatically shuts 
down when traffic outage or LOS occurs. However, the 
laser must be manually restarted when conditions that 
caused the outage are resolved.

• Manual Restart for Test—Manually restarts the laser for 
testing.

AINS Soak Sets the automatic in-service soak period. 
Double-click the time and use the up and 
down arrows to the change settings.

• Duration of valid input signal, in hh.mm format, after 
which the card status changes to in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Reach Sets the optical reach distance of the client 
port.

• Autoprovision—The system automatically provisions the 
reach from the pluggable port module (PPM) reach value 
on the hardware.

• EW

• LW

• SW

• LRM

• ER

• LR

• SR

• ZR

• IR 2

• LR 2

• DWDM

• CWDM40km

Wavelength Provisions the port wavelength. • First Tunable Wavelength

• Further wavelengths:
Further wavelengths in the 100-GHz ITU-T C-band 
spacing. The card wavelengths are marked by asterisks. If 
the card is not installed, all wavelengths appear with a 
dark grey background.

Table 11-140 Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G735 Provision the 40G Muxponder Ethernet Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G Muxponder card 
(40G-MXP-C, 40E-MXP-C, or 40ME-MXP-C card) where you want to change the Ethernet settings. 
The card view appears.

Squelch Shuts down the far-end laser in response to 
certain defects.

• Squelch

Note Squelch does not apply to ISC COMPACT payloads.

• Disable

Note Both Squelch and AIS options are supported when the 
selected Termination Mode is Transparent. If the 
Termination Mode selected is Section or Line, then 
only AIS is supported. This is applicable for 
OC-192/STM-64 and OC-768/STM-256.
For OTN payloads, both Squelch and AIS options are 
supported.

Overclock (Trunk port only) Enables or disables 
overclock mode on the trunk port.

• OFF (default)

• ON

Note Before the overclock is changed, delete any existing 
10G Ethernet LAN-Phy payload that is present on the 
40E-MXP-C and 40ME-MXP-C cards.

Rx Wavelength (Trunk port only) Provisions the trunk port 
wavelength.

• First Tunable Wavelength

• Further wavelengths:
Further wavelengths in the 100-GHz ITU-T C-band 
spacing. The card wavelengths are marked by asterisks. If 
the card is not installed, all wavelengths appear with a 
dark grey background.

Purpose This task changes the Ethernet settings for the 40G-MXP-C, 40E-MXP-C, 
and 40ME-MXP-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-140 Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options
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Step 2 Click the Provisioning > Line > Ethernet tabs. The Ethernet tab is available once the 
10G Ethernet LAN Phy payload is selected as the port rate for the pluggable port module.

Step 3 Modify any of the settings for the Ethernet tab as described in Table 11-141.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G667 Change the 40G Muxponder SONET (OC-192)/SDH (STM-64) Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the SONET (OC-192) or SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI). Tabs and parameters vary according 
to the PPM provisioning.

Step 3 Modify any of the settings described in Table 11-142. 

Table 11-141 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Card Ethernet Settings

Parameter Description Options

Port (Display only) The Port number (n-n) and 
rate.

—

Port Name Allows you to enter a port name. —

MTU (Display only) The maximum size of the 
Ethernet frames accepted by the port.

Jumbo: 64 to 9216 bytes (Default)

Mapping 
Mode

Sets the Ethernet mapping mode. • GFP

• WIS

• CBR (only for 40E-MXP-C and 40ME-MXP-C)

Note CBR is automatically mapped when a 
10G Ethernet LAN Phy payload is configured with 
overclock on the trunk port turned ON. This mapping 
cannot be changed.

Enable Flow 
Control

Activates flow control when the check box is 
selected.

—

Purpose This task changes the SONET OC-192 or SDH STM-64 settings for the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-142 Line SONET or SDH Settings  of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards 

Parameter Description Options

Port (Display only) Displays the port number. 5 (Trunk)

Port Name Assigns a logical name assigned to a port. This 
field is blank by default.

User-defined. This can be up to 32 alphanumeric or 
special characters, or both. The port name is blank by 
default. 

For information about assigning a port name, see the 
“DLP-G104 Assign a Name to a Port” task on 
page 17-16.

SF BER Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

ProvidesSync (Display only) Displays the ProvidesSync card 
parameter state.

Checked or unchecked

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source.

Checked or unchecked

Send 
DoNotUse

Sets the Send DoNotUse card state. When 
checked, sends a DUS (do not use) message on 
the S1 byte.

Checked or unchecked

Type Indicates the optical transport type. • SONET (ANSI)

• SDH (ETSI)

Termination 
Mode

(Display-only for Standard Regeneration and 
Enhanced FEC card configurations) Sets the 
mode of operation.

• Transparent 

• Section (ANSI) or Regeneration Section (RS) 
(ETSI)

• Line (ANSI) or Multiplex Section (MS) (ETSI)
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DLP-G668 Change the 40G Muxponder Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to 
the PPM provisioning.

Step 3 Modify any of the settings described in Table 11-143. 

Purpose This task changes the section trace settings of the 40G-MXP-C, 
40E-MXP-C, and 40ME-MXP-C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-143 Line Section Trace Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options

Port (Display only) Displays the port number that is applicable only 
for OC-192/STM-64 payloads.

• 1-1

• 2-1

• 3-1

• 4-1

Received 
Trace Mode

Sets the trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

Disables the alarm indication signal. • Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays and sets the current transmit string.
You can click the button on the right to change the display. Its title 
changes, based on the current display mode. In Transmit String 
Type, click Hex Mode to change the display to hexadecimal 
(button changes to ASCII); click ASCII to change the display to 
ASCII (button changes to Hex Mode). The supported range for 1 
bit Hex TX trace is 20 to 7E. If TX trace is provisioned outside 
this range, client transmits 00.

Transmit string size
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Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-G691 Change the 40G Muxponder OTU Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the OTU settings.

Step 2 Click the Provisioning > Line > OTU tabs. Tabs and parameter selections vary according to the PPM 
provisioning.

Step 3 Modify any of the settings described in Table 11-144. 

Expected Displays and sets the current expected string.
You can click the button on the right to change the display. Its title 
changes, based on the current display mode. In Expected String 
Type, click Hex Mode to change the display to hexadecimal 
(button changes to ASCII); click ASCII to change the display to 
ASCII (button changes to Hex Mode). The supported range for 1 
bit Hex TX trace is 20 to 7E. If TX trace is provisioned outside 
this range, client transmits 00.

Expected string size

Received (Display only) Displays the current received string. Click 
Refresh to manually refresh this display, or check the 
Auto-refresh every 5 sec check box to keep this panel updated.

Received string size

Auto-refresh Automatically refreshes the display every 5 seconds. • Checked

• Unchecked (default)

Purpose This task changes the OTU settings of the 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-143 Line Section Trace Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options
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Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

Table 11-144 OTU Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Displays the port 
number that is applicable only for 
OC-192/STM-64 payloads.

• 1-1

• 2-1

• 3-1

• 4-1

• 1-1

• 2-1

• 3-1

• 4-1

SyncMsgIn (Display only) (OC-768/STM-256 
only) Sets the EnableSync card 
parameter. Enables synchronization 
status messages (S1 byte), which 
allow the node to choose the best 
timing source.

Checked or unchecked Checked or unchecked

Admin SSM Overrides the synchronization status 
message (SSM) and the 
synchronization traceability 
unknown (STU) value. If the node 
does not receive an SSM signal, it 
defaults to STU.

• PRS—Primary Reference 
Source (Stratum 1)

• STU—Sync traceability 
unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum 
clock

• ST4—Stratum 4

• DUS—Do not use for 
timing synchronization

• RES—Reserved; quality 
level set by user

• G811—Primary reference 
clock

• STU—Sync traceability 
unknown

• G812T—Transit node clock 
traceable

• G812L—Local node clock 
traceable

• SETS—Synchronous 
equipment

• DUS—Do not use for timing 
synchronization

ProvidesSync (Display only) (OC-768/STM-256 
only) Sets the ProvidesSync card 
parameter. If checked, the card is 
provisioned as a network element 
(NE) timing reference.

Checked or unchecked Checked or unchecked
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DLP-G669 Change the 40G Muxponder SONET or SDH Line Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings shown in Table 11-145.

Note In Table 11-145, some parameters and options do not apply to all 40-G-MXP-C cards. If the 
parameter or options do not apply, they do not appear in CTC.

Purpose This task changes the SONET or SDH line threshold settings of the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C muxponder cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-145 Line Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Port 
number.
Applicable for only 
OC-192/STM-64 
payloads.

• 1-1

• 2-1

• 3-1

• 4-1

• 1-1

• 2-1

• 3-1

• 4-1

CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option individually in each 
category and click Refresh. 

—
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Step 4 Click Apply. 

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option individually in each 
category and click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option individually in each 
category and click Refresh. 

SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option individually in each 
category and click Refresh.

Click Reset to Default to restore default 
values.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option individually in each 
category and click Refresh.

Click Reset to Default to restore default 
values.

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option individually in each 
category and click Refresh.

Click Reset to Default to restore default 
values.

—

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option individually in each 
category and click Refresh.

Click Reset to Default to restore default 
values.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option individually in each 
category and click Refresh.

Click Reset to Default to restore default 
values.

Table 11-145 Line Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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Step 5 Return to your originating procedure (NTP).

DLP-G670 Change the 40G Muxponder Line RMON Thresholds for Ethernet, 
8G FC, or 10G FC Payloads

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), display the 40G-MXP-C, or 
40E-MXP-C card where you want to change the line threshold settings in the card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the payload port— for example “1-1 (TEN_GE)”, or the equivalent 
ITU-T G.7041 GFP (Generic Frame Procedure) port.

Step 5 From the Variable drop-down list, choose an Ethernet or FC variable. See Table 11-146 for a list of 
available Ethernet variables, Table 11-147 for a list of FC, and Table 11-147 for a list of GFP variables.

Purpose This task changes the line threshold settings of 40G-MXP-C, or 
40E-MXP-C card carrying Ethernet, 8G FC, or 10G FC payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-146 Ethernet Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of received packets.

ifInUcastPkts Number of packets, delivered by this sub-layer to a higher 
sub-layer, which were not addressed to a multicast or broadcast 
address at this sub-layer.

inInMulticastPkts Number of packets, delivered by this sub-layer to a higher 
sub-layer, which were addressed to a multicast address at this 
sub-layer. For a MAC layer protocol, this includes both Group 
and Functional addresses.

ifInBroadcastPkts Number of packets, delivered by this sub-layer to a higher 
sub-layer, which were addressed to a broadcast address at this 
sub-layer.

ifInErrors Total number of received errors.

ifOutOctets Total number of octets transmitted out of the interface, 
including framing characters.
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txTotalPkts Total number of transmitted packets.

dot3StatsFCSErrors Count of frames received on a particular interface that are an 
integral number of octets in length but do not pass the Frame 
Check Sequence (FCS) check.

dot3StatsFrameTooLong Count of frames received on a particular interface that exceed 
the maximum permitted frame size.

dot3StatsInPauseFrames Count of frames received on this interface with an opcode 
indicating the PAUSE operation.

dot3StatsOutPauseFrames Count of MAC control frames transmitted on this interface with 
an opcode indicating the PAUSE operation.

etherStatsUndersizePkts Total number of packets transmitted and received by the 
interface that were less than 64 octets long (excluding framing 
bits, but including FCS octets) and were otherwise well formed.

etherStatsFragments Total number of packets received that were less than 64 octets 
in length (excluding framing bits but including FCS octets) and 
had either a bad Frame Check Sequence (FCS) with an integral 
number of octets (FCS Error) or a bad FCS with a non-integral 
number of octets.

etherStatsPkts Total number of packets (including bad packets, broadcast 
packets, and multicast packets) transmitted and received by the 
interface.

etherStatsPkts64Octets Total number of packets (including bad packets) transmitted 
and received by the interface that were 64 octets in length 
(excluding framing bits but including FCS octets).

etherStatsPkts65to127Octets Total number of packets (including error packets) transmitted 
and received by the interface that were between 65 and 127 
octets in length inclusive (excluding framing bits but including 
FCS octets).

etherStatsPkts128to255Octets Total number of packets (including error packets) transmitted 
and received by the interface that were between 128 and 255 
octets in length inclusive (excluding framing bits but including 
FCS octets).

etherStatsPkts256to511Octets Total number of packets (including error packets) transmitted 
and received by the interface that were between 256 and 511 
octets in length inclusive (excluding framing bits but including 
FCS octets).

etherStatsPkts512to1023Octets Total number of packets (including error packets) transmitted 
and received by the interface that were between 512 and 1023 
octets in length inclusive (excluding framing bits but including 
FCS octets).

Table 11-146 Ethernet Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Variable Description
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etherStatsPkts1024to1518Octet
s

Total number of packets (including error packets) transmitted 
and received by the interface that were between 1024 and 1518 
octets in length inclusive (excluding framing bits but including 
FCS octets).

etherStatsBroadcastPkts Total number of good packets transmitted and received by the 
interface that were directed to the broadcast address.

etherStatsMulticastPkts Total number of good packets transmitted and received by the 
interface that were directed to a multicast address. Note that 
this number does not include packets directed to the broadcast 
address.

etherStatsOversizePkts Total number of packets transmitted and received by the 
interface that were longer than 1518 octets (excluding framing 
bits, but including FCS octets) and were otherwise well formed.

etherStatsJabbers Total number of packets transmitted and received by the 
interface that were longer than 1518 octets (excluding framing 
bits, but including FCS octets), and were not an integral number 
of octets in length or had a bad FCS.

etherStatsOctets Total number of octets of data (including those in bad packets) 
transmitted and received by the interface on the network 
(excluding framing bits but including FCS octets).

Table 11-147 FC Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of received packets.

ifInErrors Total number of received errors.

ifOutOctets Total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

ifOutErrors Number of outbound packets or transmission units that 
could not be transmitted because of errors.

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes. 
This value is a part of HDLC and GFP port statistics.

mediaIndStatsRxFramesTooLong Number of received frames that exceed the MTU. This 
value is part of HDLC and GFP port statistics.

mediaIndStatsRxFramesBadCRC Number of receive data frames with payload CRC errors 
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC 
errors when HDLC framing is used.

Table 11-146 Ethernet Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Variable Description
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Step 6 From the Alarm Type drop-down list, choose an alarm type. The alarm type indicates whether or not an 
event is triggered by the type of threshold.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Enter the number of Sample Period occurrences.

Step 9 Enter the number of Rising Threshold occurrences.

mediaIndStatsTxFramesTooLong Total number of transmitted data frames that are less than 
5 bytes. This value is a part of HDLC and GFP port 
statistics.

mediaIndStatsTxFramesTruncated Number of transmitted data frames that exceed the MTU. 
This value is part of HDLC and GFP port statistics.

Table 11-148 GFP RMON Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Variable Description

gfpStatsRxFrame Total number of received data frames.

gfpStatsTxFrame Total number of transmitted data frames.

gfpStatsRxSblkCRCErrors Total number of superblock CRC errors with the receive 
transparent GFP frame. A transparent GFP frame has 
multiple superblocks where each contains Fibre Channel 
data. 

gfpStatsRxOctets Total number of GFP data octets received.

gfpStatsTxOctets Total number of GFP data octets transmitted.

gfpStatsRxSBitErrors Received GFP frames with single bit errors in the core 
header (these errors can be corrected).

gfpStatsRxMBitErrors Received GFP frames with multiple bit errors in the core 
header (these errors cannot be corrected).

gfpStatsRxTypeInvalid Received GFP frames with invalid type (these are 
discarded). For example, receiving GFP frames that 
contain Ethernet data when we expect Fibre Channel data.

gfpStatsLFDRaised Count of core HEC CRC multiple bit errors.

Note This count is only of eHec multiple bit errors when 
in frame. This can be looked at as a count of when 
the state machine goes out of frame.

gfpRxCmfFrame —

gfpTxCmfFrame —

Table 11-147 FC Variables of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Variable Description
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To trigger the alarm, the measured value of a threshold must always move from below the falling 
threshold to above the rising threshold. For example, if a network moves from below a rising threshold 
of 1000 collisions every 15 seconds to 1001 collisions.

Step 10 Enter the appropriate number of occurrences for the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the exact opposite of a rising threshold. When the number of occurrences is above 
the rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded.

Step 11 Click OK.

Step 12 Return to your originating procedure (NTP).

DLP-G671 Provision the 40G Muxponder Trunk Port Alarm and TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Note You must modify 15 Min and 1 Day independently. To do so, select the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 3 If TCA is not selected, click TCA and then click Refresh. If it is selected, continue with Step 4.

Step 4 Verify the trunk port (Port 5) TCA thresholds are set at the values shown as follows:

• Laser Bias High (%): 95.0

• RX Power High (dBm): –9.0

• RX Power Low (dBm): –22.0

• TX Power High (dBm): 9.0

Purpose This task changes the trunk port alarm and TCA thresholds of the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• TX Power Low (dBm): 0.0

Provision new thresholds as needed by replacing the old values with new ones.

Step 5 Under Types area, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Verify the trunk port (Port 5) alarm thresholds are set at the values shown as follows:

• Laser Bias High (%): 98.0

• RX Power High (dBm): –8.0

• RX Power Low (dBm): –24.0

• TX Power High (dBm): 7.0

• TX Power Low (dBm): 3.0

Provision new thresholds as needed replacing the old values with new ones.

Step 7 Click Apply. 

Step 8 Return to your originating procedure (NTP).

DLP-G672 Provision the 40G Muxponder Client Port Alarm and TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs.

Step 3 If TCA is not selected, click TCA and then click Refresh. If it is selected, continue with Step 4.

Step 4 Referring to Table 11-149, verify the client ports (Ports 1 through 4) TCA thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. 
Provision new thresholds as needed by replacing the old values with new ones.

Note Do not modify the Laser Bias parameters.

Purpose This task provisions the client port alarm and TCA thresholds of the 
40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C cards.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• DLP-G278 Provision the Optical Line Rate, page 11-175

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note You must modify 15 Min and 1 Day independently. To do so, select the appropriate radio button 
and click Refresh.

Table 11-149 Client Interfaces TCA Thresholds of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C 

Cards

PPM Port Rate
Pluggable Port Module1

(XFP)
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

FC8G ONS-XC-8G-FC-SM –9 –22 9.0 0.0

FC10G ONS-XC-10G-1470 
through 
ONS-XC-10G-1610
ONS-XC-10G-C
ONS-XC-10G-S1

–9 –22 9.0 0.0

ONS-XC-10G-I2 2.0 –15.8 8.0 –7.0

ONS-XC-10G-L2 1.0 –14.0 5.0 –12.0

ONS-XC-10G-SR-MM 0.0 0.0 6.0 –6.0

10GE ONS-XC-10G-30.3 
through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-SR-M
ONS-XC-10G-S1

–9 –22 9.0 0.0

ONS-XC-10G-I2 2.0 –15.8 8.0 –7.0

ONS-XC-10G-L2 –7.0 –24.0 6.5 –2.5
11-361
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G672 Provision the 40G Muxponder Client Port Alarm and TCA Thresholds
Step 5 Click Apply.

Step 6 Repeat Steps 3 and 4 to provision the additional client ports.

Step 7 Under Types area, click the Alarm radio button and click Refresh.

Step 8 Referring to Table 11-150, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned. Provision new thresholds as needed replacing the old values with new ones.

OC-192 ONS-XC-10G-30.3 
through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 
through 
ONS-XC-10G-1610
ONS-XC-10G-I2
ONS-XC-10G-SR-MM

–9 –22 9.0 0.0

ONS-XC-10G-L2 –9.0 –26.0 8.0 –8.0

ONS-XC-10G-S1 –1.0 –11.0 5.0 –12.0

OTU2 ONS-XC-10G-30.3 
through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 
through 
ONS-XC-10G-1610
ONS-XC-10G-I2
ONS-XC-10G-L2
ONS-XC-10G-SR-MM
ONS-XC-10G-S1

–9 –22 9.0 0.0

1. In CTC, SFPs, and XFPs are called pluggable port modules (PPMs). For more information about SFPs and XFPs, see the 
“11.24 SFP, SFP+, XFP, CXP, and CFP Modules” section on page 11-163.

Table 11-149 Client Interfaces TCA Thresholds of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C 

Cards

PPM Port Rate
Pluggable Port Module1

(XFP)
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low
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Table 11-150 Client Interface Alarm Thresholds of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C 

Cards 

PPM Port Rate
Pluggable Port Module1

(XFP)

1. In CTC, SFPs and XFPs are called pluggable port modules (PPMs). For more information about SFPs and XFPs, see the 
“11.24 SFP, SFP+, XFP, CXP, and CFP Modules” section on page 11-163.

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

FC8G ONS-XC-8G-FC-SM 
ONS-XC-10G-S1

–9 –22 9.0 0.0

FC10G ONS-XC-10G-30.3 through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 
through 
ONS-XC-10G-1610
ONS-XC-10G-S1

–9 –22 9.0 0.0

ONS-XC-10G-I2 4.5 –18.3 4.5 –3.5

ONS-XC-10G-L2 –4.5 –26.5 6.5 –2.5

ONS-XC-10G-SR-MM 2.0 –2.0 2.0 –2.0

10GE ONS-XC-10G-30.3 through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-S1
ONS-XC-10G-SR-MM

–9 –22 9.0 0.0

ONS-XC-10G-I2 4.5 –18.3 4.5 –3.5

ONS-XC-10G-L2 –4.5 –26.5 6.5 –2.5

OC-192 ONS-XC-10G-30.3 through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 
through 
ONS-XC-10G-1610
ONS-XC-10G-I2
ONS-XC-8G-FC-SM
ONS-XC-10G-SR-MM

–9 –22 9.0 0.0

ONS-XC-10G-L2 –7.0 –28.0 4.0 –4.0

ONS-XC-10G-S1 –1.0 –13.0 1.0 –8.0

OTU2 ONS-XC-10G-30.3 through 
ONS-XC-10G-61.4
ONS-XC-10G-C
ONS-XC-10G-1470 
through 
ONS-XC-10G-1610
ONS-XC-10G-S1
ONS-XC-10G-I2
ONS-XC-10G-L2
ONS-XC-8G-FC-SM
ONS-XC-10G-SR-MM

–9 –22 9.0 0.0
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Step 9 Click Apply.

Step 10 Repeat Steps 7 and 8 to provision additional client ports. 

Step 11 Return to your originating procedure (NTP).

DLP-G673 Change the 40G Muxponder OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 40G-MXP-C, or 
40E-MXP-C card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, 
ITU-T G.709 Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in Tables 11-151 through 11-154. 

Note You must modify Near End and Far End, 15 Min and 1 Day, and SM and PM independently. To 
do so, select the appropriate radio button and click Refresh.

Table 11-151 describes the values on the Provisioning > OTN > OTN Lines tab.

Purpose This task changes the OTN settings for the 40G-MXP-C, 40E-MXP-C, and 
40ME-MXP-C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-151 OTN Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options

Port (Display only) Displays the port number.

Applicable for trunk ports and ports with 
OTU2 payload.

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

ITU-T G.709 
Thresholds

Sets the OTN lines according to 
ITU-T G.709.

• Enable

• Disable

FEC Sets the OTN lines to forward error 
correction (FEC).

• Standard

• Enhanced
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Table 11-152 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 11-153 describes the values on the Provisioning > OTN > FEC Threshold tab.

SF BER (Display only) Sets the signal fail bit 
error rate.

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Table 11-151 OTN Line Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options

Table 11-152 ITU-T G.709 Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C 

Cards

Parameter Description Options

Port (Display only) Displays the 
port number.

Applicable for trunk ports and 
ports with OTU2 payload.

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select the radio button individually and 
click Refresh.

Click Reset to Default to restore default values.

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select the radio button individually and 
click Refresh.

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select the radio button individually and 
click Refresh.

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select the radio button individually and 
click Refresh.

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select radio button individually and 
click Refresh.
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Table 11-154 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 11-153 FEC Threshold Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards

Parameter Description Options

Port (Display only) Displays the port number.

Applicable for trunk ports and ports with 
OTU2 payload.

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 11-154 Trail Trace Identifier Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards 

Parameter Description Options

Port (Display only) Displays the port number.

Applicable for trunk ports and ports with 
OTU2 payload.

• 1-1

• 2-1

• 3-1

• 4-1

• 5 (Trunk)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

Disables alarm indication signal. • Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays and sets the current transmit 
string.
You can click the button on the right to 
change the display. Its title changes, 
based on the current display mode. In 
Transmit String Type, click Hex Mode to 
change the display to hexadecimal 
(button changes to ASCII); click ASCII 
to change the display to ASCII (button 
changes to Hex Mode).

Transmit string size
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G281 Manage the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Channel Group Settings

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the channel group 
settings. If you are already logged in, continue with Step 2.

Expected Displays and sets the current expected 
string.
You can click the button on the right to 
change the display. Its title changes, 
based on the current display mode. In 
Expected String Type, click Hex Mode to 
change the display to hexadecimal 
(button changes to ASCII); click ASCII 
to change the display to ASCII (button 
changes to Hex Mode).

Expected string size

Received (Display only) Displays the current 
received string. Click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box 
to keep this panel updated.

Received string size

Auto-refresh Refreshes the display automatically every 
5 seconds.

• Checked

• Unchecked (default)

Purpose This procedure changes the channel group settings for GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-154 Trail Trace Identifier Settings of the 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C Cards 

Parameter Description Options
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Step 2 Perform any of the following tasks as needed:

• DLP-G611 Create a Channel Group Using CTC, page 11-368

• DLP-G612 Modify the Parameters of the Channel Group Using CTC, page 11-369

• DLP-G613 Add or Remove Ports to or from an Existing Channel Group Using CTC, page 11-373

• DLP-G614 Delete a Channel Group Using CTC, page 11-374

• DLP-G615 Retrieve Information on Channel Group, REP, CFM, and EFM Using CTC, page 11-375

• DLP-G616 View Channel Group PM Parameters for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Cards Using CTC, page 11-376

• DLP-G617 View Channel Group Utilization PM Parameters for GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Cards Using CTC, page 11-377

• DLP-G618 View Channel Group History PM Parameters for GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Cards Using CTC, page 11-377

• DLP-G619 Create a Channel Group on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards 
Using PCLI

• DLP-G620 Add Ports to a Channel Group on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards 
Using PCLI

Step 3 Stop. You have completed this procedure.

DLP-G611 Create a Channel Group Using CTC

Note You can create up to 11 channel groups on the GE_XP and GE_XPE cards and up to 2 channel groups 
on the 10GE_XP and 10GE_XPE cards. You can create a channel group with ports only when the ports 
do not have any UNI QinQ settings or NNI SVLAN settings. Otherwise, the channel group will be 
created with empty ports.

For information about interaction of LACP with other protocols, see the “11.14.2 Protocol 
Compatibility list” section on page 11-62.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to create a channel group. If 
you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed according to the 
requirements specified in Table 14-7 on page 14-107.

Purpose This task creates a channel group on the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 4 In card view, click the Provisioning > Channel Groups tabs.

Step 5 Click Create. The Channel Group Creation dialog box appears.

Step 6 Enter the name of the channel group in the Name field.

Step 7 From the Stand Alone list, choose the ports that will belong to this channel group and click the right 
arrow button to move the selected ports to the Bundled list.

Step 8 From the LACP Mode drop-down list, choose the LACP mode as needed:

• On—Default mode. In this mode, the ports will not exchange LACP packets with the partner ports.

• Active—In this mode, the ports will send LACP packets at regular intervals to the partner ports.

• Passive—In this mode, the ports will not send LACP packets until the partner ports send LACP 
packets. After receiving the LACP packets from the partner ports, the ports will send LACP packets. 

Step 9 From the LACP Hashing drop-down list, select the LACP hashing algorithm that the protocol uses to 
perform the load balancing task between the bundled ports.

The following hashing algorithms are supported:

• Ucast SA VLAN Incoming Port

• Ucast DA VLAN Incoming Port

• Ucast SA DA VLAN Incoming port

• Ucast Src IP TCP UDP

• Ucast Dst IP TCP UDP

• Ucast Src Dst IP TCP UDP

Step 10 Click Create.

A new row is added in the LACP table and all the other parameters in the channel group are set to default 
values. The default values of these parameters are taken from the first port that is attached to the channel 
group.

Step 11 Return to your originating procedure (NTP).

DLP-G612 Modify the Parameters of the Channel Group Using CTC

Purpose This task modifies the parameters of the channel group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Ports cannot be added or removed using this procedure. For adding or removing the ports, see the 
“DLP-G613 Add or Remove Ports to or from an Existing Channel Group Using CTC” task on 
page 11-373.

Step 1 Complete the “DLP-G46 Log into CTC” task the node where you want to modify the parameters of the 
channel group. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to modify the parameters of the channel group.

Step 3 In card view, click the Provisioning > Channel Groups tabs.

Step 4 Choose a channel group from the existing channel groups.

Step 5 Modify the channel group settings as described in Table 11-155.

Table 11-155 Channel Group Settings

Parameter Description Options

Channel Group (Display only) ID and name of the channel group. N.A.

Name Sets the name of the channel group. —

Ports (Display only) Port number (n-n) and rate (GE or 
TEN_GE of the channel group).

N.A.

LACP Mode Sets the LACP mode. The channel group must be in 
OOS-DSBLD admin state.

• On

• Active

• Passive

Hashing Sets the LACP hashing algorithm. The channel 
group must be in OOS-DSBLD admin state.

• Ucast SA VLAN 
Incoming Port

• Ucast DA VLAN 
Incoming Port

• Ucast SA DA VLAN 
Incoming port

• Ucast Src IP TCP 
UDP

• Ucast Dst IP TCP 
UDP

• Ucast Src Dst IP 
TCP UDP

Admin State Sets the administrative state on the channel group. • IS

• OOS, DSBLD

Service State (Display only) Sets the service state that indicates 
the operational state of the channel group.

• IS-NR

• OOS-MA, DSBLD
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MTU Sets the maximum transfer unit (MTU), which sets 
the maximum number of bytes per frame accepted 
on the port. The member ports must be in 
OOS-DSBLD admin state. The default MTU value 
in the channel group is taken from the default 
settings in the node.

Numeric. Default: 9700 

Range: 64 to 9700 

Mode Sets the provisional port mode. If the port mode is 
Auto, the Expected Speed field determines which 
ports can belong to the bundle. The member ports 
must be in OOS-DSBLD admin state.

• Auto

• 1000 Mbps

Expected Speed Sets the expected speed of ports of the channel 
group. The channel group must be in OOS-DSBLD 
admin state.

• 10 Mbps

• 100 Mbps

• 1000 Mbps

Duplex (Display only) Expected duplex capability of ports 
of the channel group.

• Full

Committed Info 
Rate

Sets the guaranteed information rate based on the 
service-level agreement of the service provider. The 
channel group must be in OOS-DSBLD admin 
state.

Numeric. Default: 100%

Range: 0 to 100% 

Granularity: 0.1%

Committed 
Burst Size

Sets the maximum number of bits transferred per 
second. The channel group must be in OOS-DSBLD 
admin state.

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1M

• 2M

• 4M

• 8M

• 16M

Table 11-155 Channel Group Settings

Parameter Description Options
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DLP-  G612 Modify the Parameters of the Channel Group Using CTC
Excess Burst 
Size

Sets the maximum number of bits credited for later 
transfer if the committed burst rate cannot be 
transmitted. The channel group must be in 
OOS-DSBLD admin state.

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1M

• 2M

• 4M

• 8M

• 16M

NIM Sets the network interface mode (NIM) for the 
channel group. The member ports must be in 
OOS-DSBLD admin state. 

The channel group NIM is set to UNI or NNI based 
on the mode of the first port that is added to the 
channel group.

• UNI Mode 
(Default)—provision
s the port as a 
User-Network 
Interface (UNI). This 
is the interface that 
faces the subscriber. 

• NNI 
Mode—provisions 
the port as a 
Network-to-Network 
Interface (NNI). This 
is the interface that 
faces the service 
provider network.

Ingress CoS Provisions the IEEE 802.1p ingress class of service 
(CoS). Ingress CoS is used to set the priority of the 
Ethernet frame in the service provider network. The 
member ports must be in OOS-DSBLD admin state.

• 0

• 1

• 2

• 3

• 4

• 5

• 6

• 7

• Trust

• CVLAN

• DSCP

Table 11-155 Channel Group Settings

Parameter Description Options
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DLP-  G613 Add or Remove Ports to or from an Existing Channel Group Using CTC
Note When you set the Committed Info Rate above 40% on 10GE_XP and 10GE_XPE cards, the Committed 
Burst Size and Excess Burst Size must be set to at least 32K. The Committed Burst Size and Excess Burst 
Size can be increased based on the packet size and Committed Info Rate value.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).

DLP-G613 Add or Remove Ports to or from an Existing Channel Group Using CTC

Inner Ethertype 
(Hex)

Defines the inner Ethertype field. The Ethertype 
field indicates which protocol is being transported 
in an Ethernet frame. The member ports must be in 
OOS-DSBLD admin state to modify the Inner 
Ethertype value to a non-default value.

Numeric. 

Default: 8100 (IEEE Std 
802.1Q customer VLAN 
tag type)

Range: 0x600 to 0xffff.

Outer Ethertype 
(Hex)

Defines the outer Ethertype field. The Ethertype 
field identifies which protocol is being transported 
in an Ethernet frame. The member ports must be in 
OOS-DSBLD admin state.

Numeric. 

Default: 8100 (IEEE 
standard 802.1Q service 
provider VLAN tag type)

Range: 0x600 to 0xffff

MAC Learning Enables or disables MAC learning for the port on 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards. MAC learning is used by Layer 2 switches to 
learn the MAC addresses of network nodes so that 
the Layer 2 switches send traffic to the right 
location. In GE_XPE or 10GE_XPE cards, enable 
MAC address learning per SVLAN.

• Checked—MAC 
learning is enabled 
for this port.

• Unchecked—(Default) 
MAC learning is 
disabled for this port.

Table 11-155 Channel Group Settings

Parameter Description Options

Purpose This task adds or removes ports to or from an existing channel group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G614 Delete a Channel Group Using CTC
Before You Begin
• You can assign up to eight ports to a channel group on GE_XP and GE_XPE cards and up to three 

ports on the 10GE_XP and 10GE_XPE cards.

• You can assign the ports to a channel group only if the ports are in OOS-DSBLD admin state. The 
ports must not have any UNI QinQ rule or NNI SVLAN configuration.

• If the channel group is configured in UNI mode, only the UNI ports can be added to the channel 
group. If the channel group is configured in NNI mode, only the NNI ports can be added to the 
channel group.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want add ports to an existing channel 
group. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to add ports to an existing channel group.

Step 3 In card view, click the Provisioning > Channel Groups tabs.

Step 4 Choose a channel group from the existing channel groups.

Step 5 Click Add/Remove Ports. The Add/Remove Ports dialog box appears.

Step 6 To add ports to an existing channel group, complete the following:

From the Stand Alone list, choose the required ports and click the right arrow button to move the selected 
ports to the Bundled list.

Step 7 To remove ports from an existing channel group, complete the following:

From the Bundled list, choose the required ports and click the left arrow button to move the selected ports 
to the Stand Alone list.

Step 8 Click Apply.

Step 9 Return to your originating procedure (NTP).

DLP-G614 Delete a Channel Group Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to delete the channel group. If 
you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XP card where you want to delete the channel group.

Step 3 In card view, click the Provisioning > Channel Groups tabs.

Purpose This task deletes a channel group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G615 Retrieve Information on Channel Group, REP, CFM, and EFM Using CTC
Step 4 Choose a channel group that you want to delete.

Step 5 Click Delete.

Step 6 Return to your originating procedure (NTP).

DLP-G615 Retrieve Information on Channel Group, REP, CFM, and EFM Using 
CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view and retrieve 
information on the channel group, REP, CFM, and EFM. If you are already logged in, continue with Step 
2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Maintenance > Show Commands tabs.

Step 4 From the Command drop-down list, choose a command.

The following commands are supported:

• ETH LACP—Displays detailed LACP information from the GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards.

• REP TOPO—Displays the topology information for a specific REP segment.

• REP TOPO ARCHIVE—Displays the previous topology information for a specific REP segment.

• REP INTERFACE—Displays information on the REP interface status and configuration. You can 
retrieve detailed information for each segment by selecting Detailed from the Level drop-down list 
and providing the segment ID.

• OAM DISCOVERY—Displays discovery information for all the EFM interfaces or for a specific 
EFM interface.

• OAM SUMMARY—Displays the active EFM sessions on a device.

• OAM STATISTICS—Displays detailed information about the EFM packets.

• OAM STATUS—Displays information about the EFM configurations for all the EFM interfaces or 
for a specific interface.

For more information, see the Pseudo Command Line Interface Reference document.

Purpose This task enables you to view and retrieve information on the channel 
group, Resilient Ethernet Protocol (REP), Connectivity Fault 
Management (CFM), and Ethernet in the First Mile (EFM) on the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G616 View Channel Group PM Parameters for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards Using CTC
Step 5 From the Level drop-down list, choose Normal or Detailed.

Step 6 Click Show. Depending on the command, the appropriate output appears in the text area.

Step 7 Return to your originating procedure (NTP).

DLP-G616 View Channel Group PM Parameters for GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE Cards Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view the channel group PM 
counts on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to view the channel group statistics. The card view 
appears.

Step 3 Click the Performance > Channel Groups > Statistics tabs.

Step 4 Click Refresh. Performance monitoring statistics for each channel group on the card appear in the 
Statistics tab.

View the PM parameter names in the Param column. The current PM parameter values appear in the Port 
# (CHGRP) column. For PM parameter definitions, see the Monitor Performance document.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure.

Return to your originating procedure (NTP).

Purpose This task enables you to view current statistical performance monitoring 
(PM) counts on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards 
and channel groups to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G617 View Channel Group Utilization PM Parameters for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards Using
DLP-G617 View Channel Group Utilization PM Parameters for GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Cards Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view the channel group 
utilization PM parameters on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Step 2 In node view, double-click the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card where you want to view 
the channel group utilization. The card view appears.

Step 3 Click the Performance > Channel Groups > Utilization tabs.

Step 4 Click Refresh. The utilization percentages for each channel group on the card appear in the Utilization 
tab.

View the Port # column to find the channel group you want to monitor.

The transmit (Tx) and receive (Rx) bandwidth utilization values, for the previous time intervals, appear 
in the Prev-n columns. For PM parameter definitions, see the Monitor Performance document.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure.

Return to your originating procedure (NTP).

DLP-G618 View Channel Group History PM Parameters for GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Cards Using CTC

Purpose This task enables you to view line utilization PM counts on the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards and channel groups to detect 
possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task enables you to view historical PM counts at selected time 
intervals on GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards and 
channel groups to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G618 View Channel Group History PM Parameters for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Cards Using CTC
Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view the channel group 
history PM parameters on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE card where you want to view the channel group history PM data. The card 
view appears.

Step 3 Click the Performance > Channel Groups > History tabs.

Step 4 From the Port field, choose a channel group.

Step 5 Click Refresh. Performance monitoring statistics for each channel group on the card appear in the 
History tab.

View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Prev-n columns. For PM parameter definitions, see the Monitor Performance document.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure.

Return to your originating procedure (NTP).

NTP-G283 Manage the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card CFM Settings

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the CFM settings. 
If you are already logged in, continue with Step 2.

Step 2 Perform any of the following tasks as needed:

• DLP-G621 Enable or Disable CFM on the Card Using CTC, page 11-379

• DLP-G622 Enable or Disable CFM for Each Port Using CTC, page 11-380

• DLP-G623 Create a Maintenance Domain Profile Using CTC, page 11-381

• DLP-G624 Delete a Maintenance Domain Profile Using CTC, page 11-382

Purpose This procedure changes the CFM settings for GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G621 Enable or Disable CFM on the Card Using CTC
• DLP-G625 Create a Maintenance Association Profile Using CTC, page 11-383

• DLP-G626 Modify a Maintenance Association Profile Using CTC, page 11-384

• DLP-G627 Delete a Maintenance Association Profile Using CTC, page 11-384

• DLP-G628 Map a Maintenance Association Profile to a Maintenance Domain Profile Using CTC, 
page 11-385

• DLP-G629 Create a MEP Using CTC, page 11-386

• DLP-G630 Delete a MEP Using CTC, page 11-387

• DLP-G631 Create a MIP Using CTC, page 11-387

• DLP-G632 Delete a MIP Using CTC, page 11-388

• DLP-G633 Ping MEP Using CTC, page 11-389

• DLP-G634 Traceroute MEP Using CTC, page 11-389

• DLP-G615 Retrieve Information on Channel Group, REP, CFM, and EFM Using CTC, page 11-375

• DLP-G635 Enable CFM on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G636 Create a Maintenance Domain on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards 
Using PCLI

• DLP-G637 Create a Maintenance Intermediate Point on the GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards Using PCLI

• DLP-G638 Create a Maintenance End Point on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Cards Using PCLI

Step 3 Stop. You have completed this procedure.

DLP-G621 Enable or Disable CFM on the Card Using CTC

Note CFM is disabled on the card by default. CFM must be enabled at both card and port levels for the CFM 
service to work.

For information about interaction of CFM with other protocols, see the “11.14.2 Protocol Compatibility 
list” section on page 11-62.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable or disable CFM on 
the card. If you are already logged in, continue with Step 2.

Purpose This task allows you to enable or disable CFM on GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G622 Enable or Disable CFM for Each Port Using CTC
Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > Security tab.

Step 4 Uncheck the MAC security check box to disable MAC security.

Step 5 In card view, click the Provisioning > CFM > Configuration > Global Settings tabs.

Step 6 Check the Enable CFM check box that is present at the bottom of the screen.

Step 7 Choose the value for CC Timer field. The value can be 1 second, 10 seconds, or 1 minute.

Note Continuity Check (CC) messages are periodically exchanged between maintenance end points (MEPs). 
The CC Timer field is used to set the time frequency for transmission of CC messages.

Step 8 Click Apply to enable CFM on the card.

Note Uncheck the Enable CFM check box to disable CFM on the card.

Step 9 Return to your originating procedure (NTP).

DLP-G622 Enable or Disable CFM for Each Port Using CTC

Note CFM must be enabled at both card and port levels for the CFM service to work. However, CFM is 
enabled on all the ports by default.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable or disable CFM for 
each port. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > Global Settings tabs.

Step 4 If you want to enable CFM on a specific port, check the Enable CFM check box against that port.

Step 5 Choose the value for CC Timer field. The value can be 1 second, 10 seconds, or 1 minute.

Purpose This task allows you to enable or disable CFM for each port on GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note Continuity Check (CC) messages are periodically exchanged between MEPs. The CC Timer field is used 
to set the time frequency for transmission of CC messages.

Step 6 Click Apply to enable CFM on the port.

Note Uncheck the Enable CFM check box against the port to disable CFM on the port.

Step 7 Return to your originating procedure (NTP).

DLP-G623 Create a Maintenance Domain Profile Using CTC

Before You Begin
• You can create up to eight maintenance domain profiles on the GE_XP, 10GE_XP, GE_XPE, or 

10GE_XPE cards. 

• The maximum number of characters for the maintenance domain profile and the maintenance 
association profile must not exceed 43 characters.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to create a maintenance domain 
profile. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > Domain Profiles tabs or in 
node/network view, click the Provisioning > CFM Profiles > Domain Profiles tabs.

Note Use the network view to store the domain profile on multiple nodes.

Step 4 Click Add row(s).

Step 5 Enter the name of the domain in the Domain Name field.

Purpose This task allows you to create a maintenance domain profile on the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G624 Delete a Maintenance Domain Profile Using CTC
Step 6 Enter the level of the domain profile in the Level field. The range of the domain profile level is from 0 
to 7.

Step 7 Click Store.

Step 8 Choose the card slot where you want to store this domain profile and click OK.

Step 9 Return to your originating procedure (NTP).

DLP-G624 Delete a Maintenance Domain Profile Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to delete a maintenance domain 
profile. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > Domain Profiles tabs or in 
node/network view, click the Provisioning > CFM Profiles > Domain Profiles tabs.

Step 4 Select the domain profiles that you want to delete.

Step 5 Check the on Node check box.

Step 6 Click Delete Sel. row(s). The CFM Profile Deleting dialog box appears.

Step 7 Choose the card slot where you want to delete this profile and click OK. The Deleting Profile dialog 
box appears.

Step 8 In the Deleting Profile dialog box, click Yes.

Step 9 Return to your originating procedure (NTP).

Purpose This task allows you to delete a maintenance domain profile on the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G625 Create a Maintenance Association Profile Using CTC
DLP-G625 Create a Maintenance Association Profile Using CTC

Note You can create up to 1500 maintenance association profiles on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to create a maintenance 
association profile. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MA Profiles tabs or in node/network 
view, click the Provisioning > CFM Profiles > MA Profiles tabs.

Note Use the network view to store the maintenance association profile on multiple nodes.

Step 4 Click Add row(s).

Step 5 Enter the name of the maintenance association in the Maintenance Profile Name field.

Step 6 Enter the VLAN ID in the VLAN ID field. The range of the VLAN ID is from 1 to 4093.

Step 7 Check the CC Enable check box to receive Continuity Check messages.

Step 8 Click Store.

Step 9 Choose the card slot where you want to store this maintenance association profile and click OK.

Step 10 Return to your originating procedure (NTP).

Purpose This task allows you to create a maintenance association profile on 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G626 Modify a Maintenance Association Profile Using CTC
DLP-G626 Modify a Maintenance Association Profile Using CTC

Note Ensure that the maintenance association profile you want to modify is not associated with a maintenance 
domain profile.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to modify a maintenance 
association profile. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MA Profiles tabs or in node/network 
view, click the Provisioning > CFM Profiles > MA Profiles tabs.

Step 4 Select the maintenance association profiles that you want to modify.

Step 5 Click Modify Selected Profile(s). The Modify MA Profile dialog box appears.

Step 6 Modify the values as required and click OK.

Step 7 Return to your originating procedure (NTP).

DLP-G627 Delete a Maintenance Association Profile Using CTC

Note Ensure that the maintenance association profile you want to delete is not associated with a maintenance 
domain profile.

Purpose This task allows you to modify a maintenance association profile on 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task allows you to delete a maintenance association profile on 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G628 Map a Maintenance Association Profile to a Maintenance Domain Profile Using CTC
Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to delete a maintenance 
association profile. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MA Profiles tabs or in node/network 
view, click the Provisioning > CFM Profiles > MA Profiles tabs.

Step 4 Select the maintenance association profiles that you want to delete.

Step 5 Check the on Node check box.

Step 6 Click Delete Sel. row(s). The CFM Profile Deleting dialog box appears.

Step 7 Choose the card slot where you want to delete this profile and click OK. The Deleting Profile dialog 
box appears.

Step 8 In the Deleting Profile dialog box, click Yes.

Step 9 Return to your originating procedure (NTP).

DLP-G628 Map a Maintenance Association Profile to a Maintenance Domain 
Profile Using CTC

Note Ensure that you have already created maintenance domain profiles and maintenance association profiles.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to map a maintenance 
association profile to a maintenance domain profile. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MA-Domain Mapping tabs.

Step 4 From the main drop-down list, choose a maintenance domain profile.

Step 5 Click Link MA Profiles. The Link MA Profiles dialog box appears.

Step 6 From the Available Profiles list, choose the required MA profiles and click the right arrow button to 
move the MA profiles to the Linked Profiles list and click OK.

Purpose This task allows you to map a maintenance association profile to a 
maintenance domain profile on the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G629 Create a MEP Using CTC
Note The maintenance association profiles that are mapped with a specific maintenance domain 
profile must have a unique SVLAN ID.

Step 7 Return to your originating procedure (NTP).

DLP-G629 Create a MEP Using CTC

Note You can create up to 255 MEPs and MIPs on the GE_XP and 10GE_XP cards. You can create up to 500 
MEPs and MIPs on the GE_XPE and 10GE_XPE cards.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to create a MEP. If you are 
already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MEP tabs.

Step 4 Click Create. The Create MEP dialog box appears.

Step 5 From the Port drop-down list, choose a port where you want to create the MEP. 

Note CFM must be enabled on the port to create a MEP. The port must not belong to a channel group.

Step 6 From the Domain drop-down list, choose a maintenance domain.

Step 7 Enter the SVLAN ID in the Vlan Id field. 

Note The specified VLAN must be configured on the selected port. The specified VLAN must also appear in 
the MA-Domain Mapping table.

Step 8 Enter the MP ID (identifier of the maintenance end point) in the MPID field and click OK. The range of 
the MP ID is from 1 to 8191.

The MP ID must not be the same between the maintenance end points.

Purpose This task allows you to create a Maintenance End Point (MEP) for a 
given VLAN range on a specific maintenance domain.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G630 Delete a MEP Using CTC
Step 9 Return to your originating procedure (NTP).

DLP-G630 Delete a MEP Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to delete a MEP. If you are 
already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MEP tabs.

Step 4 Select the MEPs that you want to delete.

Step 5 Click Delete.

Step 6 Return to your originating procedure (NTP).

DLP-G631 Create a MIP Using CTC

Note You can create up to 255 MEPs and MIPs on the GE_XP and 10GE_XP cards. You can create up to 500 
MEPs and MIPs on the GE_XPE and 10GE_XPE cards.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to create a MIP. If you are 
already logged in, continue with Step 2.

Purpose This task allows you to delete a MEP on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task allows you to create a Maintenance Intermediate Point (MIP) 
for a given VLAN range with a specific maintenance level.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G632 Delete a MIP Using CTC
Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MIP tabs.

Step 4 Click Create. The Create MIP dialog box appears.

Step 5 From the Port drop-down list, choose a port where you want to create the MIP.

Note The port must not belong to a channel group.

Step 6 From the Level drop-down list, choose a maintenance level. The range of the maintenance level is from 
0 to 7.

Step 7 Enter the SVLAN range in the Vlan range field. The range of the SVLAN is from 1 to 4093.

Note The specified SVLAN must be configured on the selected port. 

Step 8 Click OK.

Step 9 Return to your originating procedure (NTP).

DLP-G632 Delete a MIP Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to delete a MIP. If you are 
already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Configuration > MIP tabs.

Step 4 Select the MIPs that you want to delete.

Step 5 Click Delete.

Step 6 Return to your originating procedure (NTP).

Purpose This task allows you to delete a MIP on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G633 Ping MEP Using CTC
DLP-G633 Ping MEP Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to ping MEP. If you are already 
logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Ping tabs.

Step 4 Enter the MP ID value in the MPID field. The range of the MP ID is from 1 to 8191.

Note Remote MP ID user cannot ping local MP ID.

Step 5 (Optional) Enter the MAC address of the remote maintenance point in the Mac Addr field. The format 
of MAC address is abcd.abcd.abcd.

Step 6 Enter the SVLAN ID in the VLAN ID field. The range of the SVLAN ID is from 1 to 4093.

Step 7 Enter the domain name in the Domain Name field.

Step 8 Enter the size of the ping packet in the DataGram Size field. The default value is 100.

Step 9 Enter the number of ping packets in the No of Requests field. The default value is 5.

Step 10 Click Ping. The output of the ping command appears in the Ping Response area.

Step 11 Return to your originating procedure (NTP).

DLP-G634 Traceroute MEP Using CTC

Purpose This task allows you to display the output of the ping command on the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task allows you to display the output of the traceroute command on 
the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G634 Traceroute MEP Using CTC
Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view the output of the 
traceroute command. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > CFM > Traceroute tabs.

Step 4 Enter the remote MP ID value in the MPID field. The range of the MP ID is from 1 to 8191.

Step 5 (Optional) Enter the MAC address of the remote maintenance point in the Mac Addr field. The format 
of MAC address is abcd.abcd.abcd.

Step 6 Enter the SVLAN ID in the VLAN ID field. The range of the SVLAN ID is from 1 to 4093.

Step 7 Enter the domain name in the Domain Name field.

Step 8 Click TraceRoute Response.

The output of the traceroute command appears in the TraceRoute Response area.

• Verify the RlyHit message is shown in the traceroute display and LTM reaches a maintenance point 
whose MAC address matches the target MAC address.

• Verify the RlyFDB message is shown in the traceroute display when the next hop address is found 
in the forwarding database.

• Verify the RlyMPDB message is shown in the traceroute display when the next hop address is found 
in the CCDN.

Step 9 Return to your originating procedure (NTP).

NTP-G285 Manage the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card EFM Settings

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the EFM settings. 
If you are already logged in, continue with Step 2.

Purpose This procedure changes the EFM settings of the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G639 Enable or Disable EFM for Each Port Using CTC
Step 2 Perform any of the following tasks as needed:

• DLP-G639 Enable or Disable EFM for Each Port Using CTC, page 11-391

• DLP-G640 Configure EFM Parameters Using CTC, page 11-392

• DLP-G641 Configure EFM Link Monitoring Parameters Using CTC, page 11-393

• DLP-G642 Enable Remote Loopback for Each Port Using CTC, page 11-395

• DLP-G615 Retrieve Information on Channel Group, REP, CFM, and EFM Using CTC, page 11-375

• DLP-G643 Enable EFM on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G644 Configure the EFM Mode on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards 
Using PCLI

Stop. You have completed this procedure.

DLP-G639 Enable or Disable EFM for Each Port Using CTC

Before You Begin
• You can enable EFM on both UNI and NNI ports.

• You cannot enable or disable EFM for ports that belong to a channel group.

• For information about interaction of EFM with other protocols, see the “11.14.2 Protocol 
Compatibility list” section on page 11-62.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable or disable EFM for 
each port. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > EFM > Configuration tabs. The EFM details appear for each 
port.

Step 4 From the EFM State drop-down list, choose Enabled.

Step 5 Click Apply to enable EFM for that port.

Purpose This task allows you to enable or disable EFM for each port on the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note From the EFM State drop-down list, choose Disabled to disable EFM for that port.

Step 6 Return to your originating procedure (NTP).

DLP-G640 Configure EFM Parameters Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to configure EFM parameters. 
If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > EFM > Configuration tabs.

Step 4 Modify the EFM parameter settings as described in Table 11-156.

Purpose This task allows you to configure EFM parameters on the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Table 11-156 EFM Parameter Settings

Parameter Description Options

Port (Display only) Port number (n-n) and rate (GE or 
TEN_GE).

—

EFM State Sets the state of the EFM protocol for each port. • Enabled

• Disabled

Mode Sets the operating mode of the port. If the mode is 
Active, the port sends OAM Protocol Data Units 
(OAMPDUs) at regular intervals to the partner 
ports. If the mode is Passive, the port will not send 
OAMPDUs until the partner ports send OAMPDUs.

• Active

• Passive
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Step 5 Click Apply to save the changes.

Step 6 Return to your originating procedure (NTP).

DLP-G641 Configure EFM Link Monitoring Parameters Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to configure EFM link 
monitoring parameters. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > EFM > Link Monitoring tabs.

Link Fault Sets the Remote Failure Indication (RFI) action. If 
the link is down on a port, the link fault RFI is sent 
to the partner port through OAMPDU. An alarm 
indicating the remote failure indication link fault 
(RFI-LF) is raised. The alarm is cleared after you 
clear the link fault condition.

You can specify the following actions for link fault 
RFI:

• Error Block—The interface is placed in the 
error-block state and the RFI-LF alarm is 
raised. 

• None—Only the RFI-LF alarm is raised.

Note Dying Gasp and critical events are not 
supported.

• Error Block

• None

Session Timer Sets the duration up to when the EFM session is 
retained with the partner port without receiving 
OAMPDUs.

Default: 5 seconds

Range: 2 to 30 seconds

Table 11-156 EFM Parameter Settings

Parameter Description Options

Purpose This task allows you to configure EFM link monitoring parameters for 
each port on the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G641 Configure EFM Link Monitoring Parameters Using CTC
Step 4 Modify the EFM link monitoring parameter settings as described in Table 11-157.

Step 5 Click Apply to save the changes.

Step 6 Return to your originating procedure (NTP).

Table 11-157 EFM Link Monitoring Parameter Settings

Parameter Description Options

Port (Display only) Port number (n-n) and rate (GE or 
TEN_GE).

—

EF Max Sets the threshold value for the maximum number 
of errored frames to detect during a specific period.

Range: 1 to 65535

EF Min Sets the threshold value for the minimum number of 
errored frames to detect during a specific period.

Range: 0 to 65535

EF Action Specifies that when the parameter value exceeds the 
maximum threshold value, the applicable action is 
None.

When the parameter value falls below the minimum 
threshold value, a threshold crossing alert (transient 
condition) is generated.

• None

• Squelch

EF Window Period in which the errored frame parameters are 
monitored.

Range: 10 to 600

EFP Max Sets the threshold value for the maximum number 
of errored frames within the last n frames.

Range: 1 to 65535

EFP Min Sets the threshold value for the minimum number of 
errored frames within the last n frames.

Range: 0 to 65535

EFP Action Specifies that when the parameter value exceeds the 
maximum threshold value, the applicable action is 
None.

When the parameter value falls below the minimum 
threshold value, a threshold crossing alert (transient 
condition) is generated.

• None

• Squelch

EFP Window Period in which the EFP parameters are monitored. Range: 1 to 65535

EFSS Max Sets the threshold value for the maximum number 
of errored seconds within the last m seconds.

Range: 1 to 900

EFSS Min Sets the threshold value for the minimum number of 
errored seconds within the last m seconds.

Range: 0 to 900

EFSS Action Specifies that when the parameter value exceeds the 
maximum threshold value, the applicable action is 
None.

When the parameter value falls below the minimum 
threshold value, a threshold crossing alert (transient 
condition) is generated.

• None

• Squelch

EFSS Window Specifies the period when the EFSS parameters are 
monitored.

Range: 100 to 9000
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DLP-G642 Enable Remote Loopback for Each Port Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable the remote loopback 
for each port. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > EFM > Loopback tabs.

The remote loopback type details appear for each port.

Step 4 From the Remote Loopback Type drop-down list, choose Remote Loopback.

Step 5 Click Apply to save the changes.

Step 6 Return to your originating procedure (NTP).

NTP-G287 Manage the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card REP Settings

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the REP settings. If 
you are already logged in, continue with Step 2.

Purpose This task allows you to enable remote loopback for each port on the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This procedure changes the REP settings for the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G713 Provision Administrative VLAN for Ports in a REP Segment Using CTC
Step 2 Perform any of the following tasks as needed:

• DLP-G713 Provision Administrative VLAN for Ports in a REP Segment Using CTC, page 11-396

• DLP-G645 Create a Segment Using CTC, page 11-397

• DLP-G646 Edit a Segment Using CTC, page 11-400

• DLP-G647 Activate VLAN Load Balancing Using CTC, page 11-400

• DLP-G648 Deactivate VLAN Load Balancing Using CTC, page 11-401

• DLP-G615 Retrieve Information on Channel Group, REP, CFM, and EFM Using CTC, page 11-375

• DLP-G649 Create a Segment on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G650 Configure STCN on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

• DLP-G651 Configure Preemption Delay on the Primary Edge Port Using PCLI

• DLP-G652 Configure VLAN Load Balancing on the Primary Edge Port Using PCLI

Stop. You have completed this procedure.

DLP-G713 Provision Administrative VLAN for Ports in a REP Segment Using CTC

Note One administrative CVLAN and one administrative SVLAN can be provisioned for each card. The REP 
segments using NNI ports send Hardware Flood Layer (HFL) messages using the administrative 
SVLAN. The REP segments using UNI ports send HFL messages using the administrative CVLAN. The 
two VLANs need not be the same.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to provision administrative 
VLAN. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > REP > Admin VLAN Configuration tabs.

Step 4 To provision administrative VLAN for NNI ports in a REP segment, perform the following steps:

a. From the SVLAN drop-down list, choose a SVLAN. The following table describes the REP 
convergence time for SVLANs.

Purpose This task allows you to provision administrative VLAN for NNI and 
UNI ports in a REP segment on the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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b. Click Apply.

c. To associate the chosen SVLAN with the NNI ports, see “DLP-G382 Add and Remove SVLANS 
to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE NNI Ports” task on page 11-418.

Step 5 To provision administrative VLAN for UNI ports in a REP segment, perform the following steps:

a. Enter the CVLAN in the CVLAN field.

b. Click Apply.

c. To associate the CVLAN with the UNI ports, see “DLP-G384 Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE QinQ Settings” task on page 11-421.

Step 6 Return to your originating procedure (NTP).

DLP-G645 Create a Segment Using CTC

Before You Begin
• You can create up to three segments on a card. Each segment can have up to two ports on the same 

switch.

• You must configure the REP administrative VLAN to activate the Hardware Flood Layer (HFL).

• Before creating REP segments, you must configure the administrative VLAN or use the default 
VLAN 1 and add the ports to the segment. Only one SVLAN can be configured per card for all the 
three segments. REP uses the administrative VLAN to flood its own control traffic.

• The administrative CVLAN is required if a REP port is configured as a UNI port. However, the REP 
ports are configured as NNI ports in many configurations, and hence the administrative CVLAN is 
not required in these configurations. The option to configure the administrative CVLAN is present 
in CTC.

• You must configure two edge ports in the segment. A segment has only one primary edge port. If 
you configure two ports in a segment as the primary edge port, for example, ports on different 
switches, REP selects one of the ports to serve as the primary edge port based on port priority.

Table 11-158 REP Convergence Time for SVLANs

SVLAN Administrative VLAN REP Convergence Time

0 (default) Not configured 4 to 5 seconds

1 to 4093 Configured Less than 200 milliseconds

Purpose This task allows you to create a segment on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-  G645 Create a Segment Using CTC
• If REP is enabled on two ports on a switch, both the ports must be either regular ports or edge ports. 
However, if the No-neighbor port is configured, one port can be an edge port and another port can 
be a regular port.

• You can also optionally configure where to send segment topology change notifications (STCNs) 
and VLAN load balancing (VLB). STCNs are enabled only for primary edge ports. VLB 
configurations are enabled on any edge ports.

• For information about interaction of REP with other protocols, see the “11.14.2 Protocol 
Compatibility list” section on page 11-62.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to create a segment. If you are 
already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > REP > Segment tabs.

Step 4 Click Create. The Create Segment wizard appears.

Step 5 Enter the segment ID in the Segment field. The range of the segment ID is from 1 to 1024.

Step 6 From the Port drop-drown list, choose a REP port that must belong to this segment.

Note A REP port can belong to only one segment.

Step 7 From the Port Role area, choose whether you want to configure the port as an edge port or a regular port. 
The options are:

a. Edge—The port is configured as an edge port. 

• Check the Primary check box to configure the edge port as a primary edge port. A segment can 
have only one primary edge port.

Note If an edge port is configured as primary edge port, the other edge port in the ring 
automatically becomes secondary edge port. If neither edge port is configured as primary 
edge port, one edge port is automatically selected as primary edge port, and the other edge 
port is secondary edge port. Configuring an edge port as a primary edge port is not 
mandatory. However, it is recommended since VLAN load balancing must be configured on 
the node with the primary edge port.

• Uncheck the Primary check box to configure the edge port as a secondary edge port. 

• (Optional) Check the Preferred check box to configure the regular or edge port as a preferred 
alternate port (alternate to primary edge port). This port blocks a range of SVLANs for VLAN 
load balancing. There is no limit on the number of preferred ports in a REP ring. The preferred 
port, if configured, is relevant even without VLAN load balancing, as it takes priority over 
non-preferred ports for alternate port election.

Note Configuring a port as preferred does not ensure that it becomes the alternate port; it only 
gets preference over the other ports that are not configured as preferred when an alternate 
port is elected.
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• Check the NoNeighbor check box if the edge port must not have a neighbor port. REP does not 
check for neighbor adjacency.

Note When the NoNeighbor check box is checked, ensure that only one segment is created.

b. None—The port is configured as a regular port. If you choose this option, Segment Topology 
Change Notifications (STCN) and VLAN Load Balancing (VLB) configurations are disabled.

Check the Preferred check box to configure the regular port as a preferred alternate port.

Step 8 From the STCN area, configure the destination of STCN messages:

a. Check the Enable check box to enable sending STCN messages.

b. From the Port drop-down list, choose the STCN port to send STCN messages or enter the segment 
ID in the Segment field to send STCN messages. The STCN port and REP port must be unique.

Step 9 From the VLAN Load Balancing area, configure VLAN Load Balancing on the primary edge port:

a. Check the Enable check box to enable VLB.

b. Enter a single SVLAN or range of SVLANs in the SVLAN field. These SVLANs are blocked at the 
alternate ports. The primary edge port blocks the remaining VLANs.

c. Enter the Rep PortId in the Rep PortId field to identify the VLAN blocking alternate port. This 
unique port ID is automatically generated when REP is enabled.

d. Check the Preferred check box to select the segment port previously identified as the preferred 
alternate port for VLAN load balancing.

When you check Preferred under VLAN Load Balancing area, you configure VLAN load balancing 
to use one of the previously configured preferred ports (under the Port Role area) to be the load 
balancing port. This restricts the load balancing port to be one among the preferred ports, but you 
cannot select a specific preferred port.

Step 10 From the VLB Preempt Delay area, enter the trigger delay for automatic VLB activation. The range is 
15 to 300 seconds.

Step 11 Click Next.

Step 12 Enter the details of the second port to add it to the segment.

Repeat Step 6 to 10 when the first port is configured as a regular port and the second port is configured 
as a primary edge port. Repeat Step 6 to 7 when the first port is configured as a primary edge port and 
the second port is configured as a regular port.

Step 13 Click Finish.

Step 14 Return to your originating procedure (NTP).
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DLP-G646 Edit a Segment Using CTC

Note You can edit only the STCN and VLB entries for a segment.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to edit a segment. If you are 
already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > REP > Segment tabs. The list of segments appear.

Step 4 Choose a segment from the list of segments.

Step 5 Click Edit.

Step 6 Modify the values as required and click Finish.

Step 7 Return to your originating procedure (NTP).

DLP-G647 Activate VLAN Load Balancing Using CTC

Note When VLAN load balancing is activated, the default configuration is manual preemption with the delay 
timer disabled.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to activate VLAN load 
balancing. If you are already logged in, continue with Step 2.

Purpose This task allows you to edit a segment on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task allows you to activate VLAN load balancing on the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > REP > Segment tabs. The list of segments appear.

Step 4 Choose a segment from the list of segments.

Step 5 Click Activate VLB.

Step 6 Return to your originating procedure (NTP).

DLP-G648 Deactivate VLAN Load Balancing Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to deactivate VLAN load 
balancing. If you are already logged in, continue with Step 2.

Step 2 Verify that the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card is installed in L2-over-DWDM mode. 
See the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on 
page 11-170.

Step 3 In card view, click the Provisioning > REP > Segment tabs. The list of segments appear.

Step 4 Choose a segment from the list of segments.

Step 5 Click Deactivate VLB.

Step 6 Return to your originating procedure (NTP).

Purpose This task allows you to deactivate VLAN load balancing on the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-G165 Modify the GE_XP, 10GE_XP, GE_XPE, 10GE_XPE 
Cards Ethernet Parameters, Line Settings, and PM Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the card settings. If 
you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 Verify the card mode:

a. Display the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card in card view.

b. Click the Provisioning > Card tabs.

c. Verify that the card mode is set to the mode designated by your site plan:

– L2-over-DWDM (GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE)

– 10GE TXP (10GE_XP or 10 GE_XPE)

– 10GE MXP (GE_XP or GE_XPE)

– 20GE MXP (GE_XP or GE_XPE)

If the card mode is set correctly, continue with Step 4. If not, complete the “DLP-G379 Change the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on page 11-170.

Step 4 Complete the “DLP-G380 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet 
Settings” task on page 11-403.

Step 5 If the ONS-SC-E1-T1-PW or ONS-SC-E3-T3-PW SFP is inserted in the GE_XPE card, complete the 
following tasks, as needed.

• DLP-G684 Provision the GE_XPE Card PDH Ethernet Settings, page 11-411

• DLP-G685 Provision the GE_XPE Card Electrical Lines Settings, page 11-413

Step 6 If the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card mode is L2-over-DWDM, complete the 
following tasks, as needed. If the card mode is not L2-over-DWDM, continue with Step 7.

• DLP-G381 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Layer 2 Protection Settings, 
page 11-415

• DLP-G421 Create and Store an SVLAN Database, page 17-84

• DLP-G382 Add and Remove SVLANS to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE NNI 
Ports, page 11-418

Purpose This procedure changes Ethernet, line, and PM threshold settings for the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• DLP-G383 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Quality of Service Settings, 
page 11-419

• DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE QinQ Settings, page 11-421

• NTP-G205 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards, 
page 11-428.

• DLP-G385 Provision the MAC Filter Settings for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Card, page 11-424

• NTP-G204 Enable IGMP Snooping on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards, 
page 11-433 or NTP-G220 Enable IGMP Snooping on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Cards Using PCLI.

• NTP-G206 Enable MVR on a GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card, page 11-435 or 
NTP-G224 Enable MVR on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI.

• DLP-G460 Enable MAC Address Learning on SVLANs for GE_XPE or 10GE_XPE Cards Using 
CTC, page 11-423 or NTP-G226 Enable MAC Address Learning on SVLANs for GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI.

Step 7 Complete the following tasks, as needed:

• DLP-G386 Provision the Gigabit Ethernet Trunk Port Alarm and TCA Thresholds, page 11-436

• DLP-G387 Provision the Gigabit Ethernet Client Port Alarm and TCA Thresholds, page 11-438

• DLP-G388 Change the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card RMON Thresholds, 
page 11-439

• DLP-G389 Change the Gigabit Ethernet Optical Transport Network Settings, page 11-442

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the 
Alarm and TCA Monitoring and Management document.

Stop. You have completed this procedure.

DLP-G380 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet 
Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the Ethernet settings. The card view appears.

Purpose This task changes the Ethernet settings for the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning > Ether Ports > Ethernet tabs.

Step 3 Modify any of the settings for the Ethernet tab as described in Table 11-159. The parameters that appear 
depend on the card mode.

Table 11-159 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Ethernet Settings

Parameter Description Card Mode Options

Port (Display only) The Port number (n-n) 
and rate (GE or TEN_GE).

• L2-over-DWDM

• 10GE TXP

• 10GE MXP

• 20GE MXP

—

MTU The maximum size of the Ethernet 
frames accepted by the port. The port 
must be in OOS/locked state.

• L2-over-DWDM

• 10GE TXP

• 10GE MXP

• 20GE MXP

Numeric. Default: 9700

Range 64 to 9700 (for R9.1 and later) (jumbo 
frame)

Mode Sets the Ethernet mode. The port 
must be in OOS/locked state before 
setting the card mode.

Note For GE_XP and GE_XPE 
cards that are in Y-cable 
protection groups, Mode 
must be set to 1000 Mbps for 
those client ports that are 
configured in Y-cable. 
For 10GE_XP and 
10GE_XPE cards that are in 
Y-cable protection groups, 
Mode must be set to 10000 
Mbps.

• L2-over-DWDM

• 10GE TXP

• 10GE MXP

• 20GE MXP

• Auto (default)

• Display Only

• 1000 Mbps

• 10000 Mbps

• Auto_Fdx (10Mbps Full). This option 
applies to ONS-SE-ZE-EL copper SFP that 
carries traffic from GE_XP and GE_XPE 
cards.

Note If Mode is set to Auto on the GE_XP or 
GE_XPE port, autonegotiation gets 
enabled on the peer port.

Note On GE_XP card, the copper Pluggable 
Port Module (PPM) interface can 
auto-negotiate and carry traffic even 
when the peer interface operates at 
rates other than 1000 Mbps.
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Flow Control Enables/disables flow control 
messaging with its peer port. When 
enabled, the port can send and 
receive PAUSE frames when buffer 
congestion occurs. When disabled, 
no PAUSE frames are transmitted 
and the PAUSE frames received are 
discarded.

Note Flow control messaging is 
symmetric and not 
negotiated. When flow 
control is enabled on one 
port, the other end of the link 
(peer port) is not considered. 
That is, even if flow control is 
disabled on the peer port, the 
GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE 
card will send PAUSE 
frames.

• L2-over-DWDM

• 10GE MXP

• 10GE TXP

• 20GE MXP

• ON—Flow control is enabled.

• OFF (default)—Flow control is disabled.

• Display Only.

Media Type (GE_XPE card only) Sets the Media 
Type.

Note PROV-MISMATCH alarm is 
raised if the Media Type is 
not set to Ethernet Over DS1 
(ANSI) or Ethernet Over E1 
(ETSI) for 
ONS-SC-EOP1,Ethernet 
Over DS3 (ANSI) or Ethernet 
Over E3 (ETSI) for 
ONS-SC-EOP3, or DS1 Over 
Ethernet (ANSI) or E1 Over 
Ethernet (ETSI) for 
ONS-SC-E1-T1-PW or DS3 
Over Ethernet (ANSI) or E3 
Over Ethernet (ETSI) 
ONS-SC-E3-T3-PW. Set the 
correct Media Type to clear 
the PROV-MISMATCH 
alarm.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

• Ethernet Over DS1 (ANSI) (for 
ONS-SC-EOP1)

• Ethernet Over E1 (ETSI) (for 
ONS-SC-EOP1)

• Ethernet Over DS3 (ANSI) (for 
ONS-SC-EOP3)

• Ethernet Over E3 (ETSI) (for 
ONS-SC-EOP3)

• DS1 over Ethernet (ANSI) (for 
ONS-SC-E1-T1-PW)

• DS3 over Ethernet (ANSI) (for 
ONS-SC-E3-T3-PW)

• E1 Over Ethernet (ETSI) (for 
ONS-SC-E1-T1-PW)

• E3 Over Ethernet (ETSI) (for 
ONS-SC-E3-T3-PW)

Committed 
Info Rate

Sets the guaranteed information rate 
based on the service-level agreement 
of the service provider. The port must 
be in OOS/locked state.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Numeric. Default: 100%

Range: 0 to 100%

Granularity: 0.1%

Table 11-159 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Ethernet Settings (continued)

Parameter Description Card Mode Options
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Committed 
Burst Size

Sets the maximum number of bits 
that will be transferred per second. 
The port must be in OOS/locked state 
before the Committed Burst Size is 
provisioned.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1MB

• 2MB

• 8MB

• 16MB

Excess Burst 
Size

The maximum number of bits that are 
credited for later transfer in the event 
the committed burst rate cannot be 
transmitted. The port must be in 
OOS/locked state before the Excess 
Burst Size is provisioned.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

• None

• 4k (default)

• 8k

• 16k

• 32k

• 64k

• 128k

• 256k

• 512k

• 1MB

• 2MB

• 8MB

• 16MB

NIM Sets the port network interface mode 
(NIM). This parameter classifies port 
types designed for the Metro 
Ethernet market to simplify 
deployment, management, and 
troubleshooting. The port must be in 
OOS/locked state before the NIM is 
provisioned.

L2-over-DWDM • UNI Mode—provisions the port as a 
user-to-network interface (UNI). This is 
the interface that faces the subscriber.

• NNI Mode—provisions the port as a 
network-to-network interface. This is the 
interface that faces the service provider 
network.

Egress QoS Enables Quality of Service (QoS) on 
the port’s egress or output queues. 
The port must be in OOS/locked state 
before the Egress QoS is provisioned.

L2-over-DWDM • Checked—QoS is enabled on the port’s 
egress queues.

• Unchecked—(Default) QoS is disabled on 
the port’s egress queues. 

Table 11-159 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Ethernet Settings (continued)

Parameter Description Card Mode Options
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MAC 
Learning

Enables or disables MAC learning 
for the port on GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards. 
MAC learning is used by Layer 2 
switches to learn the MAC addresses 
of network nodes so the Layer 2 
switches send traffic to the right 
location. Layer 2 switches, including 
the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards in L2-over-DWDM 
mode with MAC Learning 
configured, maintain a MAC learning 
table that associates the MAC 
addresses and VLANs with a given 
port.

Note MAC addresses on SVLANs 
attached to the port must also 
be enabled to provision MAC 
address learning on GE_XPE 
and 10GE_XPE cards.

Note MAC address table aging is 
300 seconds. It cannot be 
changed.

L2-over-DWDM • Checked—MAC learning is enabled for 
this port.

• Unchecked—(Default) MAC learning is 
disabled.

Table 11-159 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Ethernet Settings (continued)

Parameter Description Card Mode Options
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Ingress CoS Provisions the IEEE 802.1p ingress 
Class of Service (CoS). The CoS .1p 
bits set the Ethernet frame priority. 
The port must be in OOS/locked state 
before the Ingress CoS is 
provisioned.

Ingress CoS is used to set the priority 
of the Ethernet frame in the service 
provider network, This parameter is 
used to set the CoS.1p bits in the 
SVLAN tag.

Ingress CoS applies only to ports 
provisioned as UNI mode. It does not 
apply to ports provisioned as NNI 
mode.

L2-over-DWDM • 0—(default) All incoming frames on the 
port will have the CoS.1p bits in the 
SVLAN tag set to 0.

• 1—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 1.

• 2—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 2.

• 3—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 3.

• 4—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 4.

• 5—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 5.

• 6—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 6.

• 7—All incoming frames on the port will 
have the CoS.1p bits in the SVLAN tag set 
to 7.

• Trust—Automatically copies customer 
VLAN tag into the service provider VLAN 
tag.

• CVLAN—CoS can be provisioned based 
on CVLAN. For information on how CoS 
can be provisioned on the IEEE 802.1QinQ 
CVLAN tags, refer to the “DLP-G384 
Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE QinQ Settings” 
task on page 11-421.

If CVLAN CoS is configured on a GE_XP 
or a 10GE_XP card, a PROV-MISMATCH 
alarm is raised. Until this alarm is cleared, 
provisioning on the card is not possible.

The CVLAN CoS configuration takes 
effect only after QinQ is configured.

Table 11-159 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Ethernet Settings (continued)

Parameter Description Card Mode Options
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Inner 
Ethertype 
(Hex)

Defines the inner Ethertype field. 
The Ethertype field indicates which 
protocol is being transported in an 
Ethernet frame.

The inner Ethertype applies to ports 
provisioned in UNI mode only. It 
does not apply to ports provisioned as 
NNI mode. The ports must be 
OOS/locked before the inner 
Ethertype is provisioned.

L2-over-DWDM Numeric. 

Default: 8100 (IEEE Std 802.1Q customer 
VLAN tag type)

Range: 0x0600 to 0xFFFF

Outer 
Ethertype 
(Hex)

Defines the outer Ethertype field. 
The Ethertype field identifies which 
protocol is being transported in an 
Ethernet frame. The ports must be 
OOS/locked before the Outer 
Ethertype is provisioned.

Note The PROV-MISMATCH 
alarm is raised on GE_XPE 
and 10GE_XPE cards if more 
than four different Outer 
Ethertype options are 
configured per card.

L2-over-DWDM Numeric. 

Default: 8100 (IEEE 802.1Q customer VLAN 
tag type)

Range: 0x0600 to 0xFFFF

IGMP Static 
Router Port

Adds multicast-capable ports to the 
forwarding table for every IP 
multicast.

L2-over-DWDM • Checked—IGMP static router port is 
enabled.

• Unchecked—(Default) IGMP static router 
port is disabled. 

AIS Action Defines the AIS action type 
provisioned on the port.

L2-over-DWDM • None—No action.

• Squelch—When an AIS packet is received 
on a SVLAN terminating on the UNI-port, 
the UNI port is squelched.

Protection 
Action

Configures the standby port 
behavior.

Set Protection Action to None if 
Media Type is set to Ethernet Over 
DS1 (ANSI) or Ethernet Over E1 
(ETSI) for ONS-SC-EOP1, Ethernet 
Over DS3 (ANSI) or Ethernet Over 
E3 (ETSI) for ONS-SC-EOP3, or 
DS1 Over Ethernet (ANSI) or E1 
Over Ethernet (ETSI) for 
ONS-SC-E1-T1-PW or DS3 Over 
Ethernet (ANSI) or E3 Over Ethernet 
(ETSI) for ONS-SC-E3-T3-PW.

L2-over-DWDM • None—No action.

• Squelch—The laser on the standby port in 
a 1+1 protection group is squelched. This 
setting has no effect if the port is not part 
of the 1+1 protection group.

Table 11-159 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Ethernet Settings (continued)

Parameter Description Card Mode Options
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Table 11-160 shows the inner and outer Ethertype behavior based on the NIM setting (either NNI mode 
or UNI mode). When the NIM is set to UNI, and the QinQ mode is set to Selective, the Ethertype 
behavior depends on the SVLAN/CVLAN operation that is provisioned, either Add or Translate. (QinQ 
parameters are provisioned in the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE QinQ Settings” task on page 11-421.)

Note A packet can exit out of any UNI/NNI port if the outermost tag in the packet matches with the SVLAN 
provisioned on that port. In other words, in the egress path, the inner tags (even if present) of the packet 
are not matched with the inner SVLAN or CVLAN provisioned on the port.

Note The Committed Burst Size and Excess Burst Size must be configured based on the expected packet size 
to ensure that no packets are dropped when Flow Control is enabled. For example, if the CIR is 40% and 
packet size is 1 KB, the Committed Burst Size and Excess Burst Size should be set to 1 MB.

Note When you set the Committed Info Rate above 40% on 10GE_XP and 10GE_XPE cards, the Committed 
Burst Size and Excess Burst Size must be set to at least 32K. The Committed Burst Size and Excess Burst 
Size can be increased based on the packet size and Committed Info Rate value.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-160 Ethertype Behavior

Port Type/
Ethertype NNI Mode

UNI Mode

Transparent
Selective
Operation: Add

Selective
Operation: Translate

Inner 
Ethertype

Not applicable: the 
outer Ethertype 
value is used.

Not applicable: all packets 
are mapped over the SVLAN.

Working (card-based) Working (card-based)

Outer 
Ethertype

Working (per port) Not applicable: the outer 
Ethertype is contained in the 
inner VLAN (same as UNI 
Selective mode).

Not applicable: the outer 
Ethertype is the one 
contained in the inner VLAN.

This cannot be set by port, 
only by card. The outer 
Ethertype is automatically set 
to the inner Ethertype.
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DLP-G684 Provision the GE_XPE Card PDH Ethernet Settings

Note The Provisioning > Ether Ports > PDH Ethernet Parameters tab is available in GE_XPE card view only, 
provided the PPM for GE_XPE port is created in FE mode.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XPE card where 
you want to change the PDH Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Ether Ports > PDH Ethernet Parameters tabs. The PDH Ethernet Parameters 
tab appear only when the ONS-SC-E1-T1-PW or ONS-SC-E3-T3-PW SFP is inserted.

Step 3 Modify any of the settings for the PDH Ethernet Parameters tab as described in Table 11-161.

Purpose This task changes the PDH Ethernet settings for the GE_XPE card.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• Set the Media Type as DS1 Over Ethernet in Provisioning > Ether 
Ports > Ethernet tab in DLP-G380 Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Ethernet Settings, page 11-403

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-161 GE_XPE Card PDH Ethernet Settings

Parameter Description Card Mode Options

Port (Display only) The Port number (n-n) 
and rate.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

—

Port Name (Display only) The port name. • L2-over-DWDM

• 10GE MXP

• 20GE MXP

—

MPLS Inner 
Label

Sets the MPLS Inner Label value. • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default: 16

Range: 16-65535.

MPLS Outer 
Label

Sets the MPLS Outer Label value. • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default: 16

Range: 16-65535.
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Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

Jitter Buffer Sets the jitter buffer value. • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default: 1500

Range: 400-200000.

Table 11-162 provides jitter buffer values for 
different payloads.

Note The traffic is down if the jitter buffer is 
set to >=192000 when Media Type is 
set to DS1 over Ethernet (ANSI) (for 
ONS-SC-E1-T1-PW) and E1 Over 
Ethernet (ETSI) (for 
ONS-SC-E1-T1-PW).

RX 
Sensitivity

(ONS-SC-E1-T1-PW only) Sets the 
RX sensitivity value.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default: –36 (ANSI), –12 (ETSI)

Range: –36 to –15 (ANSI), –12 to –43 (ETSI)

Source IP 
Address

Enter the source IP address. Only 
Unicast IP addresses are accepted.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

—

Peer IP 
Address

Enter the peer IP address. Only 
Unicast IP addresses are accepted.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

—

Table 11-162 Jitter Buffer Values for Various Payload Types

Payload Type

Jitter Buffer Value

Lower Limit Upper Limit

T1 (DS1) 1500 20000

T3 (DS3) 400 4500

E1 1500 200000

E3 400 60000

Table 11-161 GE_XPE Card PDH Ethernet Settings (continued)

Parameter Description Card Mode Options
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DLP-G685 Provision the GE_XPE Card Electrical Lines Settings

Note The Provisioning > Ether Ports > Electrical Lines tab is available in GE_XPE card view only, provided 
the PPM for GE_XPE port is created in FE mode.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XPE card where 
you want to change the Electrical Lines settings. The card view appears.

Step 2 Click the Provisioning > Ether Ports > Electrical Lines tabs. The Electrical Lines tab appear only 
when the ONS-SC-E1-T1-PW or ONS-SC-E3-T3-PW SFP is inserted.

Step 3 Modify any of the settings for the Electrical Lines > DS1 or Electrical Lines > DS3 tab as described in 
Table 11-163.

Purpose This task changes the Electrical Lines settings for the GE_XPE card.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• Set the Media Type as DS1 Over Ethernet in Provisioning > Ether 
Ports > Ethernet tab in DLP-G380 Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Ethernet Settings, page 11-403

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-163 GE_XPE Card Electrical Lines Settings

Parameter Description Card Mode Options

Port (Display only) The Port number (n-n) 
and rate.

• L2-over-DWDM

• 10GE MXP

• 20GE MXP

—

Port Name (Display only) The port name. • L2-over-DWDM

• 10GE MXP

• 20GE MXP

—

Clock Source Sets the Clock Source • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default:

• Internal (for ONS-SC-E3-T3-PW)

• Adaptive (for ONS-SC-E1-T1-PW)

Options:

• Loopback Timing

• Internal

• Adaptive
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Step 4 Click Apply. 

Line Type Sets the Line Type • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default:

• C-BIT (for ONS-SC-E3-T3-PW ANSI)

• Unframed (for ONS-SC-E3-T3-PW ETSI)

• ESF (for ONS-SC-E1-T1-PW ANSI)

• Framed (for ONS-SC-E1-T1-PW ETSI)

Options:

• G.751 (ETSI)

• G.832 (ETSI)

• C-BIT (ANSI)

• ESF (ANSI)

• M23 (ANSI)

• Framed (ETSI)

• Unframed (ETSI)

Line Coding Sets the Line Coding • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Default:

• B3ZS (for ONS-SC-E3-T3-PW ANSI)

• HDB3 (for ONS-SC-E3-T3-PW ETSI)

• B8ZS (for ONS-SC-E1-T1-PW ANSI)

• HDB3 (for ONS-SC-E1-T1-PW ETSI)

Options:

• AMI (ETSI)

• B3ZS (ANSI)

• B8ZS (ANSI)

• HDB3 (ETSI)

Line Length (ANSI only) Sets the Line Length • L2-over-DWDM

• 10GE MXP

• 20GE MXP

Defaults:

• 0-225 ft (for ONS-SC-E3-T3-PW ANSI)

• 266-399 ft (for ONS-SC-E1-T1-PW ANSI)

Options (ANSI only):

• 0-133 ft

• 0-225 ft

• 133-266 ft

• 225-450 ft

• 266-399 ft

• 399-533 ft

• 533-655 ft

Table 11-163 GE_XPE Card Electrical Lines Settings (continued)

Parameter Description Card Mode Options
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Step 5 Return to your originating procedure (NTP).

DLP-G381 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Layer 2 
Protection Settings

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM 
mode. To change the card mode, complete the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170.

Note GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Layer 2 protection settings must be planned for the entire 
VLAN ring. One card in the ring is provisioned as the master card and one of its port is set to Blocking. 
The master card coordinates the protection switching for the GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE in a VLAN ring. 

Note You can choose to enable another card in the ring to be the master card. However, only one card in the 
ring can be provisioned as master card. Make sure that the provisioning settings on the card that was 
previously configured as the master are disabled as soon as another card is enabled as the master card. 
To perform this task complete the “DLP-G507 Enable a Different GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Card as the Master Card” procedure on page 11-417

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the protection settings. The card view appears.

Step 2 Click the Provisioning > Protection tabs.

Step 3 In the Status column, modify the port protection status by clicking the appropriate table cell and 
choosing one of the following from the drop-down list:

• Forwarding—Forwards the Ethernet packets that are received by the port.

• Blocking—Blocks the Ethernet packets that are received by the port.

Note One port of the master card within a VLAN ring must be set to Blocking. All other ports must 
be set to Forwarding.

Purpose This task provisions the Layer 2 protection settings for the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards when the cards are provisioned 
in L2-over-DWDM mode.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Check the Master check box if you want the card to serve as the protection coordinator for the VLAN 
ring. If not, continue with Step 5.

Step 5 From the Protection drop-down list, choose one of the following:

• Enabled—Enables protection.

• Disabled—Disables protection.

• Forced—Converts all the SVLANs to protected SVLANs irrespective of the SVLAN protection 
configuration in the SVLAN database. This is applicable to a point-to-point linear topology. The 
SVLAN protection must be forced to move all SVLANs, including protected and unprotected 
SVLANs, to the protect path irrespective of provisioned SVLAN attributes.

Step 6 From the Hold Off Time drop-down list, choose one of the following:

• Disabled (default)—A FAPS switchover occurs immediately.

• 50 msec, 100 msec, 200 msec, 500 msec, 1 sec, 2 sec, or 5 sec—Holds off FAPS protection for the 
selected duration. 

Note To get consistent results ensure Hold Off Time values are the same throughout the ring.

Note FAPS is an Layer 2 protection enabled on a VLAN. When a fiber fault occurs, Layer 1 protection 
is triggered immediately to restore the traffic. Setting the Hold Off Time option prevents Layer 2 
FAPS protection from triggering at the same time as Layer 1 protection thereby avoiding traffic 
hits.

Step 7 Set the following parameters for FAPS switching with CRC errors:

a. Switch with CRC Alarm—Check this check box to enable FAPS switching with CRC errors.

b. CRC Threshold—Threshold for CRC error count. The default CRC threshold value is 10(-e)2. The 
available options are 10(-e)2, 10(-e)3, and 10(-e)4.

c. CRC Soak Count—Number of times the CRC error rate exceeds the CRC threshold value before 
raising the DATA-CRC alarm. The default CRC Soak Count is 10. The valid range is from 3 to 10.

d. CRC Poll Interval—Time interval (in seconds) between the successive polls. The default CRC Poll 
Interval is 60 seconds.

For example, if the CRC Threshold value = 10(-e)2, CRC Soak Count = 10, and CRC Poll Interval 
= 60 seconds, then FAPS occurs when the incoming CRC error rate is more than 10(-e)2 
continuously across 10 poll intervals (10*60 = 600 seconds).

e. Clear/Suppress CRC Alarm—Uncheck the Clear/Suppress CRC Alarm check box for FAPS to 
occur. If you check this check box, the DATA-CRC alarm gets cleared and FAPS does not occur.

Note As along as the Clear/Suppress CRC Alarm checkbox is checked, the DATA-CRC alarm is not 
raised on that port and FAPS does not occur.

Note For consistent result, ensure that all the values that are set in Step 7 are same throughout the ring.

Step 8 Click Apply.
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Step 9 Return to your originating procedure (NTP).

DLP-G507 Enable a Different GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card as 
the Master Card

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM 
mode. To change the card mode, complete the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170.

Note GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Layer 2 protection must be enabled for the entire VLAN 
ring. One card in the ring is provisioned as the master card and one of its port is set to Blocking. The 
master card coordinates the protection switching for the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
cards in a VLAN ring. 

Note You can choose to enable another card in the ring to be the master card. However, only one card in the 
ring can be provisioned as master card. Make sure that the provisioning settings on the card that was 
previously configured as the master are disabled as soon as another card is enabled as the master card. 

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card in a VLAN ring where you want to enable master card provisioning. The 
card view appears. Perform the following steps:

a. Click the Provisioning > Protection tabs.

b. From the Status drop-down list, choose Blocking for a trunk port.

Note One port of the master card within a VLAN ring must be set to Blocking. All other ports must 
be set to Forwarding.

c. Check the Master check box for the card that serves as the protection coordinator for the VLAN 
ring.

Purpose This task provisions another GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
card on a stable VLAN ring, to be the master card when the cards are 
provisioned in L2-over-DWDM mode.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G381 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Layer 2 Protection Settings, page 11-415

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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d. From the Protection drop-down list, choose Enabled.

e. Click Apply.

Step 2 The master card provisioning on the other card must be disabled. Perform the following steps:

a. Click the Provisioning > Protection tabs.

b. Uncheck the Master check box for the card where Master node provisioning must be disabled.

c. Click Apply.

d. From the Protection drop-down list, choose Disabled.

e. Click Apply.

Step 3 The protection on the card that was disabled in Step 2 must be enabled again. Perform the following 
steps:

a. Click the Provisioning > Protection tabs.

b. From the Protection drop-down list, choose Enabled.

c. Click Apply.

d. From the Status drop-down list, choose Forwarding on both ports.

e. Click Apply.

Step 4 Return to your originating procedure (NTP).

DLP-G382 Add and Remove SVLANS to/from GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE NNI Ports

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM 
mode. To change the card mode, complete the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170.

Note This task can only be performed on ports provisioned as NNI. See the “DLP-G380 Provision the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403. 

Purpose This task adds or removes service provider VLAN (SVLAN) provisioning 
to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE ports. This task 
only applies to GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards in 
L2-over- DWDM mode.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G421 Create and Store an SVLAN Database, page 17-84

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
11-418
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G383 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Quality of Service Settings
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the SVLAN port settings. The card view 
appears.

Step 2 Click the Provisioning > SVLAN tabs.

Step 3 For each SVLAN shown in the table, click the check box under the Port [port name] table cell to include 
the SVLAN in that port. If you do not want the SVLAN included, uncheck the check box.

Note If no SVLANs appear in the SVLAN tab, complete the “DLP-G421 Create and Store an SVLAN 
Database” task on page 17-84.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G383 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Quality of 
Service Settings

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM 
mode and the port must have QoS enabled. Refer to the “DLP-G379 Change the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Mode” task on page 11-170 and the “DLP-G380 Provision the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403, if needed.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the QoS settings.

Step 2 Click the Provisioning > QoS tabs.

Step 3 In the Port field at the bottom of the window, choose the port where you want to provision the QoS 
settings. 

Step 4 For each CoS egress queue, 0 through 7, define the following:

• WRR weight—sets the Weighted Round Robin (WRR) level for the CoS egress queue. The default 
is 1. The range is 0 to 15, where 0 is Strict Priority.) 

Purpose This task provisions the Weighted Round Robin (WRR) value and 
bandwidth for QoS Class of Service (CoS) egress queues on a GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE card port.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE define a set of eight queues, one queue 
for each CoS. Only one of the queues can be assigned the 0 WRR weight (Strict Priority).

• Bandwidth—sets the bandwidth allocated for the CoS egress queue, 100 is the default. This 
bandwidth value is the percentage (%) of bandwidth with respect to the SFP, XFP, or port speed (100 
Mbps for FE, 1 Gbps for GE, and 10 Gbps for 10GE) of the interface.

Step 5 Click Apply. Click Yes in the confirmation dialog box.

Step 6 Return to your originating procedure (NTP).

DLP-G470 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Class of 
Service (CoS) Settings

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE card must be in L2-over-DWDM 
mode and the port must be in OOS state.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the CoS settings.

Step 2 Complete the following task:

• Refer to Ingress CoS section in the “DLP-G380 Provision the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Ethernet Settings” task on page 11-403

Step 3 Return to your originating procedure (NTP).

Purpose This task provisions Class of Service (CoS) settings on the GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE QinQ 
Settings

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE must be in L2-over-DWDM mode. 
To change the card mode, complete the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170.

Note This task can only be performed on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards UNI ports. 
(To provision the port Ethernet parameters, see the “DLP-G380 Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403.)

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the QinQ settings.

Step 2 Click the Provisioning > QinQ tabs.

Step 3 Click the Port field and choose the port where you want to provision QinQ.

Channel groups configured in UNI mode appear in the Port field along with the physical ports.

Step 4 Click the Mode field and choose one of the following modes from the drop-down list: 

• Selective—The incoming Ethernet packet is checked against the CVLAN and SVLAN table. If the 
CVLAN is not found, the packet is dropped. If you choose Selective, add an entry in the QinQ tab 
to map the administrative CVLAN to the SVLAN (if it is not same as the one used for data).

• Transparent—All incoming packets are transported with the additional VLAN chosen in the 
SVLAN field. If you choose transparent, the traffic on administrative CVLAN will pass through.

Step 5 Click the BPDU field and choose one of the following bridge protocol data unit (BPDU) modes from the 
drop-down list: 

• Drop (default)—If checked, drops incoming packets with any of the following destination MAC 
addresses. The BPDU default can be applied for any UNI port.

– 01-80-c2-00-00-00—IEEE 802.1D

– 01-80-c2-00-00-02—Link Aggregation Control Protocol (LACP)

Purpose This task provisions the IEEE 802.1QinQ VLAN tags on the GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE card UNI ports. QinQ tags expand the 
VLAN capability by tagging the tagged packets to produce a 
“double-tagged” Ethernet frame. For service providers the expanded 
VLAN allows specific services to be provided on specific VLANs for 
specific customers, while other types of services can be provided to other 
customers on other VLANs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G421 Create and Store an SVLAN Database, page 17-84

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– 01-80-0c-cc-cc-cc—VLAN Spanning Tree Plus (PVST+)

– 01-00-c-cc-cc-cc—Cisco Discovery Protocol (CDP) type 0x2000, VLAN Trunk Protocol (VTP) 
type 0x2003, Port Aggregation Protocol (PAgP), type 0x0104, Uni-Directional Link Detection 
(UDLD) type 0x111, Dynamic Trunking Protocol (DTP) type 0x2004

• Tunnel—If checked, transparently sends any of the destination MAC addresses listed above.

Step 6 If the Mode was set to Selective, complete the following steps. If not, continue with Step 7.

a. To add a row, click Add.

b. Click the CVLAN table and type in the CVLAN range. You can enter a single value or a range using 
“–” between the two ends of the range.

Note If you are using Software Release 8.5 or earlier, it is recommended that you do not specify 
a CVLAN range due to certain limitations in the feature.

c. Click the SVLAN table cell and choose an SVLAN from the drop-down list.

d. Click the Operation table cell and choose an operation:

– Add (default)—Adds the SVLAN on top of the CVLAN. The operation default can be applied 
for any UNI port.

– Translate—CVLAN is translated with the SVLAN value.

– Double Add—(GE_XPE and 10GE_XPE cards only) Adds an inner and an outer SVLAN to 
double tagged packets only. CVLAN settings are not required. If this double tagged selective 
operation is present on a port, no other selective operation can be present.

– Translate Add—(GE_XPE and 10GE_XPE cards only) CVLAN gets translated to inner 
SVLAN and the SVLAN is added.

Note If Double Add and Translate Add are configured on a GE_XP or a 10GE_XP card, a 
PROV-MISMATCH alarm is raised. Until this alarm is cleared, provisioning on the card is 
not possible.

Note A CVLAN with a value of 0 means “untagged packet”. 

Note Two or more CVLANs cannot be translated over the same SVLAN.

e. (GE_XPE and 10GE_XPE cards only) Click the COS table cell and choose a value from the drop 
down list.

f. Click Apply. 

g. Continue with Step 10.

Step 7 If the Mode was set to Transparent, in the SVLAN field, choose the SVLAN to be added to incoming 
packets.

Step 8 Click DSCP-Cos mapping Table to provision CoS based on DSCP for each port. 

Step 9 For each DSCP, choose a CoS value from 0 to 7 and click OK.
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Step 10 Return to your originating procedure (NTP).

DLP-G221 Enable MAC Address Learning on SVLANs for GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE Cards

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable MAC Address 
Learning. If you are already logged in, continue with Step 2.

Step 2 Complete the following tasks, as needed:

• DLP-G460 Enable MAC Address Learning on SVLANs for GE_XPE or 10GE_XPE Cards Using 
CTC, page 11-423

• NTP-G226 Enable MAC Address Learning on SVLANs for GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards Using PCLI

Stop. You have completed this procedure.

DLP-G460 Enable MAC Address Learning on SVLANs for GE_XPE or 10GE_XPE 
Cards Using CTC

Note To perform this task, the GE_XPE or 10GE_XPE card must be in L2-over-DWDM mode. Refer to the 
“DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on page 11-170 
if needed.

Purpose This task enables MAC address learning on SVLANS for GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures VLANs must already be created on the selected card.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables MAC address learning on SVLANs attached to the port 
of a GE_XPE or 10GE_XPE card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card 
Mode, page 11-170

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G385 Provision the MAC Filter Settings for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card
Note MAC address learning is applicable only for GE_XPE and 10GE_XPE cards. If MAC address learning 
is configured on a GE_XP or a 10GE_XP card, a PROV-MISMATCH alarm is raised. Until this alarm is 
cleared, provisioning on the card is not possible. 

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XPE or 
10GE_XPE card where you want to enable MAC address learning.

Step 2 Enable MAC address learning on the port. Perform the following steps:

a. Click Provisioning > Ethernet.

b. Check the MAC Learning check box.

Note If the per port MAC address learning is configured on a GE_XP or 10 GE_XP cards, before upgrading 
to a GE_XPE or 10 GE_XPE card, enable MAC address learning per SVLAN. Not doing so disables 
MAC address learning.

Step 3 Enable MAC address learning on the SVLAN attached to the port. Perform the following steps:

a. Click SVLAN > SVLAN DB tabs. 

b. Click Load. This loads an SVLAN database from a network node or local file and replaces any 
SVLANs that are in the network view VLAN DB table.

c. Check the MAC Learning check box related to the SVLAN (one or more than one SVLAN) to be 
configured with MAC address learning.

d. Click Store. This records and enables the new configuration.

Step 4 Return to your originating procedure (NTP).

DLP-G385 Provision the MAC Filter Settings for GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Card

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM 
mode. To change the card mode, complete the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170.

Purpose This task provisions the MAC address filter for the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE cards when the cards are provisioned in 
L2-over-DWDM mode. The MAC address filter is a list of MAC addresses 
whose packets should be accepted or dropped.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G385 Provision the MAC Filter Settings for GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the MAC filter settings.

Step 2 Click the Provisioning > Security > MAC Filter tabs.

Step 3 Click the port for which you want to create a MAC filter.

Step 4 Click Edit.

Step 5 In the Edit MAC Address dialog box, click Add. A new table entry appears with the MAC address 
00-00-00-00-00-00.

Step 6 In the MAC Address Port field, type in the MAC address you want to filter over the default 
00-00-00-00-00-00 address.

Step 7 If you want to add more MAC addresses, repeat Steps 5 and 6. (Up to eight MAC addresses can be added 
for each port.) If not, click OK.

Step 8 On the MAC Filter table, provision the Allowed check box:

• Checked—All MAC addresses different from the address(es) entered in the table will be dropped.

• Unchecked—All MAC addresses matching the address(es) entered in the table will be dropped.

Step 9 Click Apply. 

Step 10 Repeat Steps 3 through 9 for each port of the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card that you 
want to set up. 

Step 11 Return to your originating procedure (NTP).

NTP-G237 Retrieve and Clear MAC Addresses on SVLANs for 
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards

Caution Retrieving and clearing learned MAC addresses are CPU intensive and traffic affecting. You must clear 
the MAC addresses only during a scheduled maintenance window.

Purpose This procedure retrieves and clears MAC addresses learned on GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Card Mode, page 11-170

• DLP-G221 Enable MAC Address Learning on SVLANs for GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Cards, page 11-423

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G546 View Card MAC Addresses on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Note It is not possible to simultaneously retrieve learned MAC addresses from both CTC and TL1 interfaces.

Step 1 In the node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE card where you want to retrieve the MAC addresses.

Step 2 To retrieve the MAC addresses learned, perform the following steps:

a. Click Maintenance > MAC Addresses > Learned.

b. In the SVLAN field, type a valid SVLAN range. The SVLAN range is from 1 to 4093.

c. Click Refresh.

The table displays the following fields:

– MAC Address—Displays the MAC address for the port.

– VLAN—Displays the VLAN identifier for the port.

– Port—Displays the port number.

Right-click the column heading to display the following options:

– Row Count—Displays the number of learned MAC addresses retrieved.

– Sort Column—Sorts the table by the column’s values.

– Hide Column—Hides the column from view.

– Reorder Columns Visibility—Displays all hidden columns.

Step 3 Click Refresh to refresh the list of MAC addresses learned.

Step 4 Click Clear to clear the MAC addresses learned on all the SVLANS of the card. 

Note It is not possible to delete the MAC addresses learned on a per SVLAN basis.

Step 5 To view card MAC addresses, complete the “DLP-G546 View Card MAC Addresses on GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Cards” task on page 11-426.

Stop. You have completed this procedure.

DLP-G546 View Card MAC Addresses on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards

Purpose This task allows you to view the MAC addresses for each client and trunk 
port and the CPU port of the card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G546 View Card MAC Addresses on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Step 1 To view the card MAC addresses, click Maintenance > MAC Addresses > Card. The MAC addresses 
for each client and trunk port and the CPU port are displayed.

The table displays the following fields:

• Port—Displays the port number.

• MAC Address—Displays the MAC address for the port.

Step 2 Return to your originating procedure.

NTP-G311 Provision the Storm Control Settings for GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Cards

Note To perform this task, the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card must be in L2-over-DWDM 
mode. To change the card mode, complete the “DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Mode” task on page 11-170.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the storm control settings.

Step 2 Click the Provisioning > Security > Storm Control tabs.

Step 3 Modify any of the settings as described in Table 11-164.

Purpose This task provisions the storm control settings for the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE cards when the cards are provisioned in 
L2-over-DWDM mode.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-164 Storm Control Settings

Parameter Description Options

Port (Display only) The Port number (n-n) and rate 
(GE or TEN_GE).

DLF Storm Control Enables or disables DLF storm control on the 
card.

• Checked—DLF storm 
control is enabled.

• Unchecked—DLF 
storm control is 
disabled.

DLF Storm Control 
Threshold (pps)

Threshold value to set the number of unknown 
unicast packets per second.

Range: 0 to 16777215 
packets per second
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G546 View Card MAC Addresses on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards
Step 4 Click Apply.

Stop. You have completed this procedure.

NTP-G205 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Cards

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable link integrity. If you 
are already logged in, continue with Step 2.

Step 2 Complete the following tasks, as needed:

• DLP-G509 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using CTC, 
page 11-429

• NTP-G216 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI

Mcast Storm Control Enables or disables Multicast storm control on the 
card.

• Checked—Multicast 
storm control is 
enabled.

• Unchecked—Multicast 
storm control is 
disabled.

Mcast Storm Control 
Threshold (pps)

Threshold value to set the number of multicast 
packets per second.

Range: 0 to 16777215 
packets per second

Bcast Storm Control Enables or disables Broadcast storm control on 
the card.

• Checked—Broadcast 
storm control is 
enabled.

• Unchecked—Broadcast 
storm control is 
disabled.

Bcast Storm Control 
Threshold (pps)

Threshold value to set the number of broadcast 
packets per second.

Range: 0 to 16777215 
packets per second

Table 11-164 Storm Control Settings

Parameter Description Options

Purpose This task enables link integrity on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G509 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using CTC
Stop. You have completed this procedure.

DLP-G509 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Cards Using CTC

Step 1 From the View menu, choose Go to Network View.

Step 2 Create or load an SVLAN profile. To create a SVLAN profile see the DLP-G471 Create a SVLAN or 
CVLAN Profile, page 11-432. 

Note Make sure the Link Integrity check box is selected to enable link integrity for a profile and save it to 
the node.

Step 3 Associate the SVLAN profile (with Link Integrity enabled) to a SVLAN on a port. To do this perform 
the following steps:

a. In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE card. The card view appears.

b. Click the Provisioning > Profiles Mapping > SVLAN tabs.

c. Enter the SVLANs or SVLAN range in the SVLAN to View text box. 

A table appears that displays SVLANs and available ports. The SVLAN profiles that was created 
must be applied to a SVLAN and a port. However, make sure the SVLAN has already been 
associated with the port via the QinQ tab (For information on how to associate a SVLAN to a port, 
see the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE QinQ Settings” 
task on page 11-421). 

d. Select the SVLAN for a port and choose the available SVLAN profile from the drop-box.

e. Click Apply.

Step 4 AIS action must be set on a per-UNI port basis. Select None or Squelch from the AIS action drop-down 
list. For detailed instructions, see the “DLP-G380 Provision the GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Card Ethernet Settings” task on page 11-403.

Step 5 Return to your originating procedure (NTP).

Purpose This task enables link integrity on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G509 Enable Link Integrity on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using CTC
NTP-G289 Provision CVLAN Rate Limiting on the GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Card

Note You cannot provision CVLAN rate limiting on channel groups.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to provision CVLAN rate 
limiting. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Create or load a CVLAN profile by setting Committed Info Rate, Committed Burst, Excess Info, Excess 
Burst. To create a CVLAN Profile see the “DLP-G471 Create a SVLAN or CVLAN Profile” task on 
page 11-432.

Step 4 Associate the CVLAN profile to a CVLAN on a UNI port. To do this perform the following steps:

a. In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE card. The card view appears.

b. Click the Provisioning > Profiles Mapping > CVLAN tabs. 

c. Enter the CVLANs or CVLAN range in the CVLANS to View text box. 

A table appears that displays CVLANs and available ports. The CVLAN profiles that were created 
must be applied to a CVLAN and port. However, make sure the CVLAN has already been associated 
with the port via the QinQ tab (For information on how to associate a CVLAN profile to a UNI port, 
see the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE QinQ Settings” 
task on page 11-421). 

d. Select the CVLAN for a given port and choose the available CVLAN profile from the drop-down 
list.

e. Click Apply.

Stop. You have completed this procedure. 

Purpose This task provisions CVLAN rate limiting on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G515 Provision SVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Using CTC
NTP-G208 Provision SVLAN Rate Limiting on the GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Card

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable SVLAN rate limiting. 
If you are already logged in, continue with Step 2.

Step 2 Complete the following tasks, as needed:

• DLP-G515 Provision SVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Card Using CTC, page 11-431

• NTP-G225 Provision SVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Card Using PCLI

Stop. You have completed this procedure.

DLP-G515 Provision SVLAN Rate Limiting on the GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Card Using CTC

Step 1 From the View menu, choose Go to Network View.

Step 2 Create or load a SVLAN profile by setting Committed Info Rate, Committed Burst, Excess Info, Excess 
Burst. To create a SVLAN Profile see the “DLP-G471 Create a SVLAN or CVLAN Profile” task on 
page 11-432.

Step 3 Associate the SVLAN profile to a SVLAN on a port. To do this, perform the following steps:

a. In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE card. The card view appears.

Purpose This task provisions SVLAN rate limiting on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task provisions SVLAN rate limiting on the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G471 Create a SVLAN or CVLAN Profile
b. Click the Provisioning > Profiles Mapping > SVLAN tabs. 

c. Enter the SVLANs or SVLAN range in the SVLAN to View text box. 

A table appears that displays SVLANs and available ports. The SVLAN profiles that were created 
must be applied to a SVLAN and port. However, make sure the SVLAN has already been associated 
with the port via the QinQ tab (For information on how to associate a SVLAN profile to a UNI port, 
see the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE QinQ Settings” 
task on page 11-421 and to a NNI port see the “DLP-G382 Add and Remove SVLANS to/from 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE NNI Ports” task on page 11-418). 

d. Select the SVLAN for a given port and choose the available SVLAN profile from the drop-down list.

e. Click Apply.

Stop. You have completed this procedure. 

DLP-G471 Create a SVLAN or CVLAN Profile

Note You cannot associate SVLAN or CVLAN profiles to channel groups. You can associate a CVLAN profile 
only to a UNI port.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > SVLAN > Profiles tabs.

Step 3 Click Add and a profile is added to the Profiles tab. Modify any of the settings as follows:

• Name—The profile name can be up to 32 alphanumeric/special characters.

• Committed Info Rate—Sets the guaranteed information rate based on the service-level agreement of 
the service provider. The valid value ranges from 0 to 100% with 0.1% granularity. The default value 
is 100%.

• Committed Burst—Sets the maximum number of bits that will be transferred per second.

• Peak Info rate—Sets the maximum access rate based on the service-level agreement of the service 
provider. The valid value ranges from 0 to 100% with 0.1% granularity. The default value is 100%. 
However, the value must be greater than or equal to the Committed Info Rate.

• Peak Burst Size—The maximum number of bits that are credited for later transfer in the event the 
committed burst rate cannot be transmitted.

• Link Integrity—Enables link integrity for the SVLAN profile. Do not check this check box if you 
are creating a CVLAN profile.

Purpose This task creates an SVLAN profile.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G471 Create a SVLAN or CVLAN Profile
Note When you set the Committed Info Rate above 40% on 10GE_XP and 10GE_XPE cards, the Committed 
Burst Size and Excess Burst Size must be set to at least 32K. The Committed Burst Size and Excess Burst 
Size can be increased based on the packet size and Committed Info Rate value.

Step 4 Click Store.

Step 5 In the Store Profile(s) dialog box, choose one of the following:

• To Node(s)—Stores the SVLAN profile at one or more network nodes. Choose the network nodes 
where you want to store the SVLAN profile. To choose more than one node, press the Shift key, or 
click Select All.

• To File—Stores the SVLAN profile in a file. Enter a file name, then click Browse to navigate to a 
local or network drive where you want to store the file.

Step 6 Click OK.

Step 7 Return to your originating procedure (NTP).

NTP-G204 Enable IGMP Snooping on GE_XP, 10GE_XP, GE_XPE, 
or 10GE_XPE Cards

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable IGMP snooping. If 
you are already logged in, continue with Step 2.

Step 2 Complete the following tasks, as needed:

• “DLP-G511 Enable IGMP Snooping, IGMP Fast Leave and IGMP Report Suppression on GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE Cards Using CTC” task on page 11-434.

• NTP-G220 Enable IGMP Snooping on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using 
PCLI.

• NTP-G217 Enable IGMP Fast-Leave Processing on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
Cards Using PCLI.

• NTP-G219 Enable IGMP Report Suppression on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards 
Using PCLI.

Stop. You have completed this procedure.

Purpose This procedure enables Internet Group Management Protocol (IGMP) 
snooping on a per-SVLAN basis on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G511 Enable IGMP Snooping, IGMP Fast Leave and IGMP Report Suppression on GE_XP, 10GE_XP, GE_XPE, or 
DLP-G511 Enable IGMP Snooping, IGMP Fast Leave and IGMP Report 
Suppression on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using CTC

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > SVLAN > SVLAN DB tabs. Click Load to load the SVLANs on the card 
where IGMP must be enabled.

Step 3 For each SVLAN shown in the table, select the following:

• IGMP—Check the IGMP check box to enable IGMP for the selected SVLAN.

• IGMP Fast Leave—Checking the IGMP Fast Leave causes the switch to immediately remove a port 
from the IP multicast group when it detects an IGMP, version 2 (IGMPv2) leave message on that 
port.

• IGMP Suppression—Check the IGMP Suppression check box to enable a single IGMP report to be 
sent to each multicast group in response to a single query.

Step 4 Click Store SVLAN DB.

Step 5 In the Store SVLAN DB dialog box, choose one of the following:

• To Node/Shelf/Card—Select the node and shelf. All the GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards in L2 over DWDM mode are displayed. Select the card where you want to store 
the SVLAN DB.

• Stores the SVLAN database at one or more network nodes. Choose the network nodes where you 
want to store the SVLAN database. To choose more than one node, press the Shift key, or click 
Select All.

• To File—Stores the SVLAN database in a file. Enter a file name, then click Browse to navigate to 
a local or network drive where you want to store the file.

• Select the card on which you want to save the changes made in step 3.

Step 6 Click OK.

Note If you want to add the multicast-capable ports to the forwarding table for every IP multicast, select the 
IGMP Static Router Port check box as described in the “DLP-G380 Provision the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Ethernet Settings” task on page 11-403.

Stop. You have completed this procedure. 

Purpose This procedure explains how to enable IGMP snooping, IGMP fast leave 
and IGMP report suppression on GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G513 Enable MVR on a GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Using CTC
NTP-G206 Enable MVR on a GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE Card

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to enable IGMP snooping. If 
you are already logged in, continue with Step 2.

Step 2 Complete the following tasks, as needed:

• “DLP-G513 Enable MVR on a GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Using CTC” task 
on page 11-435.

• NTP-G224 Enable MVR on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Cards Using PCLI.

Stop. You have completed this procedure.

DLP-G513 Enable MVR on a GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Using 
CTC

Step 1 In node view (single-shelf mode), or shelf view (multishelf mode), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to enable MVR. The card view appears.

Note At least one SVLAN must be configured on the card.

Step 2 Click the Provisioning > MVR tabs. The MVR Settings tab appears.

Step 3 Check the Enabled check box and enter the following information:

Purpose This procedure enables Multicast VLAN Registration (MVR) on GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure enables Multicast VLAN Registration (MVR) on GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE cards using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G382 Add and Remove SVLANS to/from GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE NNI Ports, page 11-418

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G386 Provision the Gigabit Ethernet Trunk Port Alarm and TCA Thresholds
• IGMP CVLAN—Check box to enable IGMP snooping on CVLAN. This check box is enabled only 
when MVR is enabled through the Enabled check box.

• Multicast SVLAN—Select the MVR SVLAN ID. The default value is the SVLAN with the lowest 
ID configured on the card. The drop box lists all the SVLANs on the GE_XP, 10GE_XP, GE_XPE, 
or 10GE_XPE card.

Note SVLAN selected here can not be used for UNI port, make sure that the corresponding SVLAN 
on the NNI port is checked.

• Multicast Address—Sets the specified multicast group address as the MVR multicast group. The 
default address is 239.255.255.255 and the range is 224.0.0.0 to 239.255.255.255. Except the 
subrange [224-239].[0/128].0.x.

• Count—Sets the range of any additional multicast group addresses. The default is 1, and range is 
1 to 256.

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

DLP-G386 Provision the Gigabit Ethernet Trunk Port Alarm and TCA Thresholds

Note The GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards have two trunk ports. The GE_XP and GE_XPE 
trunk ports are 21-1 and 22-1 on the card graphic and 21 (Trunk) and 22 (Trunk) on the Optics 
Thresholds table. The 10GE_XP and 10GE_XPE card trunk ports are 3-1 and 4-1 on the card graphic 
and 3 (Trunk) and 4 (Trunk) on the Optics Thresholds table.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Purpose This task changes the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card 
trunk port alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G386 Provision the Gigabit Ethernet Trunk Port Alarm and TCA Thresholds
Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor 
Pluggable (SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). 
SFPs/XFPs are hot-swappable input/output devices that plug into a port to link the port with the 
fiber-optic network. Multirate PPMs have provisionable port rates and payloads. For more 
information about SFPs and XFPs, see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” 
section on page 11-163.

Step 3 If TCA is not selected, click TCA and then click Refresh. When TCA is selected, continue with Step 4.

Step 4 Verify the trunk port TCA thresholds are provisioned as shown in Table 11-165. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and hitting Enter.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Verify the trunk port alarm thresholds are provisioned as shown in Table 11-166. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and hitting Enter.

Step 7 Click Apply. 

Step 8 Repeat Steps 3 through 7 to provision the second trunk port. 

Step 9 Return to your originating procedure (NTP).

Table 11-165 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Trunk Interface TCA Thresholds

Pluggable Port Module 
(XFP)

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

XFP WDM no FEC –7 –23 6 –4

XFP WDM standard FEC –7 –27 6 –4

XFP WDM Enhanced FEC –7 –27 6 –4

Table 11-166 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Trunk Interface Alarm Thresholds

Pluggable Port Module 
(XFP)

Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

XFP WDM no FEC –5 –26 5 –3

XFP WDM standard FEC –5 –30 5 –3

XFP WDM Enhanced FEC –5 –30 5 –3
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DLP-  G387 Provision the Gigabit Ethernet Client Port Alarm and TCA Thresholds
DLP-G387 Provision the Gigabit Ethernet Client Port Alarm and TCA Thresholds

Note The GE_XP card has 20 client ports. The ports are 1-1 through 20-1 on the card graphic and 1 (Client) 
through 20 (Client) on the Optics Thresholds table. The 10GE_XP card has 2 client ports. The ports are 
1-1 and 2-1 on the card graphic and 1 (Client) and 2 (Client) on the Optics Thresholds table.

Note The hardware device that plugs into a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G card faceplate to provide a fiber interface to the card is called a Small Form-factor Pluggable 
(SFP or XFP). In CTC, SFPs and XFPs are called pluggable port modules (PPMs). SFPs/XFPs are 
hot-swappable input/output devices that plug into a port to link the port with the fiber-optic network. 
Multirate PPMs have provisionable port rates and payloads. For more information about SFPs and XFPs, 
see the “11.24 SFP, SFP+, XFP, CXP, and CFP Modules” section on page 11-163.

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the client port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 If TCA is not selected, click TCA and then click Refresh. When TCA is selected, continue with Step 4.

Step 4 Verify the client port TCA thresholds are provisioned as shown in Table 11-167. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and hitting Enter.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Purpose This task provisions the client port alarm and TCA thresholds for the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G726 Preprovisioning a Multirate PPM 

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-167 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card Client Interface TCA Thresholds

Pluggable Port Module (XFP)
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

10GE LAN PHY 10GBASE-LR 1 –14 5 –12

1000Base-SX (1Gbps)1

1. Gigabit Ethernet client

0 –17 3 –16

1000Base-LX 1 –3 –20 3 –16
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G388 Change the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card RMON Thresholds
Step 5 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Verify the client port Alarm thresholds are provisioned as shown in Table 11-168. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and hitting Enter.

Step 7 Click Apply.

Step 8 Repeat Steps 3 through 7 to provision each additional client port. 

Step 9 Return to your originating procedure (NTP).

DLP-G388 Change the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card RMON 
Thresholds 

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), display the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the RMON thresholds.

Step 2 Click the Provisioning > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose an individual port, or choose All to provision RMON thresholds 
for all ports. 

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 11-169 for a list of available 
Ethernet RMON variables. 

Table 11-168 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card Client Interface Alarm Thresholds

Pluggable Port Module (XFP)
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

10GE LAN PHY 10GBASE-LR 3 –16 1 –8

1000Base-SX (1Gbps)1

1. Gigabit Ethernet client

3 –20 –2 –12

1000Base-SX (2Gbps)1 3 –18 –2 –12

1000Base-LX 1 0 –23 –1 –12

Purpose This task changes the GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card 
RMON threshold settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Variable descriptions were obtained from the following Internet Engineering Task Force (IETF) 
Requests for Comment (RFCs): RFC 3635, RFC 2233, and RFC 1757. Refer to the RFCs for 
additional information.

Table 11-169 Gigabit Ethernet RMON Variables

Variable Description

rxTotalPkts Total number of receive packets.

ifInUcastPkts The number of packets, delivered by this sub-layer to a higher (sub-)layer, which were 
not addressed to a multicast or broadcast address at this sub-layer.

ifInMulticastPkts The number of packets, delivered by this sub-layer to a higher (sub-)layer, which were 
addressed to a multicast address at this sub-layer. For a MAC layer protocol, this 
includes both Group and Functional addresses.

ifInBroadcastPkts The number of packets, delivered by this sub-layer to a higher (sub-)layer, which were 
addressed to a broadcast address at this sub-layer.

ifInDiscards The number of inbound packets which were chosen to be discarded even though no 
errors had been detected to prevent their being deliverable to a higher-layer protocol. 
One possible reason for discarding such a packet could be to free up buffer space.

ifInOctets Total number of octets received on the interface, including framing characters.

ifOutOctets Total number of octets transmitted out of the interface, including framing characters.

txTotalPkts Total number of transmitted packets.

ifOutMulticastPkts The total number of packets that higher-level protocols requested be transmitted, and 
which were addressed to a multicast address at this sub-layer, including those that were 
discarded or not sent. For a MAC layer protocol, this includes both group and functional 
addresses.

ifOutBroadcastPkts The total number of packets that higher-level protocols requested be transmitted, and 
which were addressed to a broadcast address at this sub-layer, including those that were 
discarded or not sent.

ifOutDiscards The number of outbound packets which were chosen to be discarded even though no 
errors had been detected to prevent their being transmitted. One possible reason for 
discarding such a packet could be to free up buffer space.

IfOutErrors Number of outbound packets or transmission units that could not be transmitted because 
of errors.

dot3StatsFCSErrors A count of frames received on a particular interface that are an integral number of octets 
in length but do not pass the FCS check.

dot3StatsFrameTooLong A count of frames received on a particular interface that exceed the maximum permitted 
frame size.

dot3ControlInUnknownOpCode A count of MAC control frames received on this interface that contain an opcode that is 
not supported by this device.

dot3InPauseFrames A count of MAC control frames received on this interface with an opcode indicating the 
PAUSE operation.

dot33StatsFCSErrors A count of frames received on a particular interface that are an integral number of octets 
in length but do not pass the FCS check.
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dot3StatsFrameTooLong A count of frames received on a particular interface that exceed the maximum permitted 
frame size.

dot3ControlInUnknownOpCode A count of MAC control frames received on this interface that contain an opcode that is 
not supported by this device.

dot3InPauseFrames A count of MAC control frames received on this interface with an opcode indicating the 
PAUSE operation.

dot3OutPauseFrames A count of MAC Control frames transmitted on this interface with an opcode indicating 
the PAUSE operation.

etherStatsCRCAlignErrors Total number of packets received that had a length (excluding framing bits, but including 
FCS octets) of between 64 and 1518 octets, inclusive, but had either a bad FCS with an 
integral number of octets (FCS Error) or a bad FCS with a non-integral number of octets 
(Alignment Error).

etherStatsUndersizePkts The total number of packets received that were less than 64 octets long (excluding 
framing bits, but including FCS octets) and were otherwise well formed.

etherStatsFragments The total number of packets received that were less than 64 octets in length (excluding 
framing bits but including FCS octets) and had either a bad Frame Check Sequence 
(FCS) with an integral number of octets (FCS Error) or a bad FCS with a non-integral.

etherStatsPkts The total number of packets (including bad packets, broadcast packets, and multicast 
packets) received.

etherStatsPkts64Octets The total number of packets (including bad packets) received that were 64 octets in 
length (excluding framing bits but including FCS octets).

etherStatsPkts65to127Octets The total number of packets (including error packets) received that were between 65 and 
127 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts128to255Octets The total number of packets (including error packets) received that were between 128 
and 255 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts256to511Octets The total number of packets (including error packets) received that were between 256 
and 511 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts512to1023Octets The total number of packets (including error packets) received that were between 512 
and 1023 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts1024to1518Octets The total number of packets (including error packets) received that were between 1024 
and 1518 octets in length inclusive (excluding framing bits but including FCS octets).

etherStatsPkts1519to1522Octets The total number of packets (including error packets) received that were between 1519 
and 1522 octets in length inclusive (excluding framing bits but including FCS octets).

Note This variable is supported only on client ports.

etherStatsBroadcastPkts The total number of good packets received that were directed to the broadcast address

etherStatsMulticastPkts The total number of good packets received that were directed to a multicast address. 
Note that this number does not include packets directed to the broadcast address.

etherStatsOversizePkts The total number of packets received that were longer than 1518 octets (for untagged 
packets) or 1522 octets (for tagged packets) (excluding framing bits, but including FCS 
octets) and were otherwise well formed.

Table 11-169 Gigabit Ethernet RMON Variables (continued)

Variable Description
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Type in an appropriate number of seconds for the Sample Period.

Step 9 Type in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Step 12 To view all RMON thresholds, click Show All RMON thresholds. If not, continue with Step 12

Step 13 Return to your originating procedure (NTP).

DLP-G389 Change the Gigabit Ethernet Optical Transport Network Settings

etherStatsJabbers The total number of packets received that were longer than 1518 octets (for untagged 
packets) or 1522 octets (for tagged packets) (excluding framing bits, but including FCS 
octets), and were not an integral number of octets in length or had a bad FCS.

etherStatsOctets The total number of octets of data (including those in bad packets) received on the 
network (excluding framing bits but including FCS octets).

Table 11-169 Gigabit Ethernet RMON Variables (continued)

Variable Description

Purpose This task changes the optical transport network (OTN) settings for the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, G.709 
Thresholds, FEC Thresholds, or Trail Trace Identifier.

Step 3 Modify any of the settings described in Tables 11-170 through 11-173. 

Note You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To 
do so, choose the appropriate radio button and click Refresh.

Table 11-170 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 11-171 describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 11-170 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card OTN Line Settings

Parameter Description Options

Port (Display only) Port number and 
description:

3 (Trunk) and 4 (Trunk). 10GE_XP and 
10GE_XPE cards

21 (Trunk) and 22 (Trunk). GE_XP and 
GE_XPE cards

ITU-T G.709 
OTN

Sets the OTN lines according to 
ITU-T G.709.

• Enable

• Disable

FEC Sets the OTN lines to forward error 
correction (FEC).

• Standard

• Enhanced

SF BER (Display only) Sets the signal fail bit 
error rate.

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Table 11-171 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Port number 
and description:

3 (Trunk) and 4 (Trunk). 10GE_XP and 10GE_XPE 
cards

21 (Trunk) and 22 (Trunk). GE_XP and GE_XPE 
cards

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 
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Table 11-172 describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 11-173 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select a bullet and click Refresh. 

Table 11-171 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card ITU-T G.709 Threshold Settings

Parameter Description Options

Table 11-172 GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Port number and 
description:

3 (Trunk) and 4 (Trunk). 10GE_XP and 
10GE_XPE cards

21 (Trunk) and 22 (Trunk). GE_XP and 
GE_XPE cards

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 11-173 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPECard Trail Trace Identifier Settings

Parameter Description Options

Port (Display only) Port number. 2

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual
11-444
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G389 Change the Gigabit Ethernet Optical Transport Network Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G314 Add a GE_XP or 10GE_XP Card on a FAPS Ring

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Table 11-173 GE_XP, 10GE_XP, GE_XPE, and 10GE_XPECard Trail Trace Identifier Settings 

Parameter Description Options

Purpose This procedure adds a GE_XP or 10GE_XP card on a FAPS ring.

Tools/Equipment Installed GE_XP or 10GE_XP cards.
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Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to add a GE_XP or 10GE_XP 
card on a FAPS ring. If you are already logged in, continue with Step 2.

Step 2 Perform any of the following tasks as needed:

• DLP-G687 Add a GE_XP or 10GE_XP Card Facing Master Card on a FAPS Ring, page 11-446

• DLP-G688 Add a GE_XP or 10GE_XP Card Between the Slave Cards on a FAPS Ring, page 11-447

Stop. You have completed this procedure.

DLP-G687 Add a GE_XP or 10GE_XP Card Facing Master Card on a FAPS Ring

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to add a GE_XP or 10GE_XP 
card on a FAPS ring.

Step 2 Verify that the GE_XP or 10GE_XP card is installed according to the requirements specified in 
Table 14-7 on page 14-107.

Step 3 Insert the new GE-XP card with XFP on the slot.

Step 4 Change the GE_XP card mode to L2-over-DWDM. See the “DLP-G379 Change the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Mode” task on page 11-170.

Step 5 Create and store an SVLAN database on the new GE_XP card. See the DLP-G421 Create and Store an 
SVLAN Database, page 17-84.

Step 6 Enable FAPS protection on the new card.

Step 7 Attach SVLAN to the trunk ports of the new card.

Prerequisite Procedures DLP-G46 Log into CTC

“NTP-G15 Install the Common Control Cards” in the Cisco ONS 15454 
Hardware Installation Guide

NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card 
Mode, page 11-170

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure adds a GE_XP or 10GE_XP card that faces the master card 
on a FAPS ring.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Choose OOS,DSBLD from the Admin State column for port 22 on the master card that is facing toward 
the new card. This action places port 22 in the blocking state and port 21 in the forwarding state.

FAPS configuration mismatch alarm is raised on the master card.

Step 9 Switch the traffic to the protect path.

Step 10 Choose OOS,DSBLD from the Admin State column for port 21 on the slave card that is facing toward 
the new card.

Step 11 Connect the fiber from the slave card (that is facing toward the new card) to the new card in segment B.

Step 12 Connect the fiber from the master card to the new card in segment A.

Step 13 Choose IS from the Admin State column for port 21 on the slave card that is facing toward the new card.

Step 14 Choose IS from the Admin State column for port 22 on the new card to bring up segment B.

Step 15 Choose IS from the Admin State column for port 21 on the new card.

Note The FAPS state of the new card will be in the forwarding state for both the ports and port 21 of 
the slave card will be in the blocking state.

Step 16 Choose IS from the Admin State column for port 22 on the master card to bring up segment A.

Note The FAPS state of port 21 on the master card will be in the blocking state and port 22 will be in 
the forwarding state. The trunk ports of the remaining GE_XP cards will be in the forwarding 
state. The port 21 of the slave card (that is facing toward the new card) will change to the 
forwarding state.

Step 17 Return to your originating procedure (NTP).

DLP-G688 Add a GE_XP or 10GE_XP Card Between the Slave Cards on a FAPS 
Ring

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to add a GE_XP or 10GE_XP 
card on a FAPS ring.

Step 2 Verify that the GE_XP or 10GE_XP card is installed according to the requirements specified in 
Table 14-7 on page 14-107.

Step 3 Insert the new GE-XP card with XFP on the slot.

Purpose This procedure adds a GE_XP or 10GE_XP card between the two slave 
cards on a FAPS ring.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Change the GE_XP card mode to L2-over-DWDM. See the DLP-G379 Change the GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE Card Mode, page 11-170.

Step 5 Create and store an SVLAN database on the new GE_XP card. See the DLP-G421 Create and Store an 
SVLAN Database, page 17-84.

Step 6 Attach SVLAN to the trunk ports of the new card.

Step 7 Choose OOS,DSBLD from the Admin State column for port 22 on both the slave cards that are facing 
toward the new card.

Step 8 Connect the fiber from the slave card to the new card in segment B.

Step 9 Connect the fiber from the master card to the new card in segment A.

Step 10 Choose IS from the Admin State column for port 22 on the slave card.

Step 11 Choose IS from the Admin State column for port 22 on the new card to bring up segment B.

Step 12 Choose IS from the Admin State column for port 21 on the new card.

Step 13 Choose IS from the Admin State column for port 21 on the slave card to bring up segment A.

Step 14 Return to your originating procedure (NTP).

NTP-G197 Provision the OTU2_XP Card Line Settings, PM 
Parameters, and Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to change the card settings. If 
you are already logged in, continue with Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card.

Step 4 Verify the card mode:

a. Display the OTU2_XP card in card view.

b. Click the Provisioning > Card tabs.

c. Verify that the card mode is set to the mode designated by your site plan:

– Transponder

Purpose This procedure changes line settings, PM parameters, and threshold setting 
for the OTU2_XP card.

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G723 Install PPM on a Line Card

DLP-G452 Change the OTU2_XP Card Mode, page 11-172

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– Standard Regen 

– Enhanced FEC

– Mixed

– 10G Ethernet LAN Phy to WAN Phy

If the card mode is set correctly, continue with Step 6. If not, complete the “DLP-G452 Change the 
OTU2_XP Card Mode” task on page 11-172.

Step 5 Refer to the “11.16.5 OTU2_XP Card Configuration Rules” section on page 11-104 before performing 
any task listed in Step 6.

Step 6 Perform any of the following tasks as needed.

• DLP-G453 Change the OTU2_XP Card Settings, page 11-449

• DLP-G454 Change the OTU2_XP Line Settings, page 11-450

• DLP-G455 Change the OTU2_XP Line Section Trace Settings, page 11-454

• DLP-G456 Change the OTU2_XP Line Thresholds for SONET or SDH Payloads, page 11-456

• DLP-G457 Provision the OTU2_XP Port Alarm and TCA Thresholds, page 11-458

• DLP-G462 Change the OTU2_XP Line RMON Thresholds for the 10G Ethernet and 10G FC 
Payloads, page 11-460

• DLP-G458 Change the OTU2_XP OTN Settings, page 11-463

• DLP-G523 Change the OTU2_XP Path Trace Settings, page 11-469

• DLP-G524 Provision the OTU2_XP Path Settings for 10G Ethernet LAN Phy to WAN Phy 
Configuration, page 11-470

Stop. You have completed this procedure.

DLP-G453 Change the OTU2_XP Card Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the card settings.

Step 2 Click the Provisioning > Card tab. 

Step 3 Modify any of the settings described in Table 11-174. 

Purpose This task changes the card settings for the OTU2_XP card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G454 Change the OTU2_XP Line Settings

Table 11-174 OTU2_XP Card Settings

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Card 
Configuration

Sets the card configuration. • Transponder

• Standard Regen

• Enhanced FEC

• Mixed

• 10G Ethernet LAN Phy 
to WAN Phy

• Transponder

• Standard Regen

• Enhanced FEC

• Mixed

• 10G Ethernet LAN Phy 
to WAN Phy

Port Mode Sets the port configuration when the card 
configuration is set as Mixed. For card 
configurations other than Mixed, this is a 
display-only parameter. You can configure 
Ports 2 and 4 as port mode, when the card is in 
10G Ethernet LAN Phy to WAN Phy mode.

• Transponder

• Standard Regen

• Transponder

• Standard Regen

Termination 
Mode

Sets the mode of operation. (This option is 
only available for SONET/SDH payloads). For 
Standard Regen and Enhanced FEC card 
configurations, this is a display-only 
parameter.

• Transparent

• Section

• Line

• Transparent

• Regeneration Section 
(RS)

• Multiplex Section (MS)

Framing Type (Display only) The card framing type, either 
SONET or SDH.

— —

AIS/Squelch Sets the transparent termination mode 
configuration.

• AIS

• Squelch

• AIS

• Squelch

Regen Line 
Name

Sets the regeneration line name. — —

ODU 
Transparency

Sets the ODU overhead byte configuration. For 
Transponder card configuration, this is a 
display-only parameter.

• Transparent Standard 
Use

• Cisco Extended Use

• Transparent Standard 
Use

• Cisco Extended Use

Proactive 
Protection 
Regen

Enables or disables the proactive protection 
regen mode.

• Enable

• Disable

• Enable

• Disable

Purpose This task changes the line settings for OTU2_XP card. 

Tools/Equipment None
11-450
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G454 Change the OTU2_XP Line Settings
Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports/SONET/Ethernet tabs.

Step 3 Modify any of the settings described in Table 11-175. 

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-175 OTU2_XP Line Settings

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Displays the port 
number.

• 1-1 (OC192/10G Ethernet WAN 
Phy/10G Ethernet LAN 
Phy/10G FC)

• 2-1 (OC192/10G Ethernet WAN 
Phy/10G Ethernet LAN 
Phy/10G FC)

• 3-1 (OC192/10G Ethernet WAN 
Phy/10G Ethernet LAN 
Phy/10G FC)

• 4-1 (OC192/10G Ethernet WAN 
Phy/10G Ethernet LAN 
Phy/10G FC)

• IB_5G

• 1-1 (STM-64/10G Ethernet 
WAN Phy/10G Ethernet LAN 
Phy/10G FC)

• 2-1 (STM-64/10G Ethernet 
WAN Phy/10G Ethernet LAN 
Phy/10G FC)

• 3-1 (STM-64/10G Ethernet 
WAN Phy/10G Ethernet LAN 
Phy/10G FC)

• 4-1 (STM-64/10G Ethernet 
WAN Phy/10G Ethernet LAN 
Phy/10G FC)

• IB_5G

Port Name Provides the ability to assign the 
specified port a name.

User-defined. Name can be up to 
32 alphanumeric/special characters. 
Blank by default.

See the “DLP-G104 Assign a Name 
to a Port” task on page 17-16.

User-defined. Name can be up to 
32 alphanumeric/special 
characters. Blank by default.

See the “DLP-G104 Assign a 
Name to a Port” task on 
page 17-16.

Admin State Sets the port service state. For 
more information about 
administrative states, see the 
Administrative and Service 
States document.

• IS

• IS,AINS

• OOS,DSBLD

• OOS,MT

• Unlocked

• Unlocked,automaticInService

• Locked,disabled

• Locked,maintenance

Service State (Display only) Identifies the 
autonomously generated state 
that gives the overall condition 
of the port. Service states appear 
in the format: Primary 
State-Primary State Qualifier, 
Secondary State. For more 
information about service states, 
see the Administrative and 
Service States document.

• IS-NR

• OOS-AU,AINS

• OOS-MA,DSBLD

• OOS-MA,MT

• Unlocked-enabled

• Unlocked-disabled,
automaticInService

• Locked-enabled,disabled

• Locked-enabled,maintenance
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ALS Mode Sets the ALS function mode. The 
DWDM transmitter supports 
ALS according to ITU-T G.644 
(06/99). ALS can be disabled, or 
it can be set for one of three 
mode options.

• Disabled (default): ALS is off; 
the laser is not automatically 
shut down when traffic outages 
(LOS) occur.

• Auto Restart: ALS is on; the 
laser automatically shuts down 
when traffic outages (LOS) 
occur. It automatically restarts 
when the conditions that caused 
the outage are resolved.

•  Manual Restart: ALS is on; the 
laser automatically shuts down 
when traffic outages (LOS) 
occur. However, the laser must 
be manually restarted when 
conditions that caused the 
outage are resolved.

• Manual Restart for Test: 
Manually restarts the laser for 
testing.

• Disabled (default): ALS is off; 
the laser is not automatically 
shut down when traffic 
outages (LOS) occur.

• Auto Restart: ALS is on; the 
laser automatically shuts 
down when traffic outages 
(LOS) occur. It automatically 
restarts when the conditions 
that caused the outage are 
resolved.

•  Manual Restart: ALS is on; 
the laser automatically shuts 
down when traffic outages 
(LOS) occur. However, the 
laser must be manually 
restarted when conditions that 
caused the outage are 
resolved.

• Manual Restart for Test: 
Manually restarts the laser for 
testing.

Reach Displays the optical reach 
distance of the client/trunk ports.

The Reach options depend on the 
traffic type that has been selected.

The Reach options depend on the 
traffic type that has been selected.

Wavelength Displays the wavelength of the 
client/trunk ports.

• First Tunable Wavelength

• Further wavelengths: 850 nm 
through 1610 nm, 100-GHz ITU 
spacing; coarse wavelength 
division multiplexing (CWDM) 
spacing

Note Supported wavelengths are 
marked by asterisks (**).

• First Tunable Wavelength

• Further wavelengths: 850 nm 
through 1610 nm, 100-GHz 
ITU spacing; CWDM spacing

Note Supported wavelengths are 
marked by asterisks (**).

AINS Soak Sets the automatic in-service 
soak period. Double-click the 
time and use the up and down 
arrows to change settings.

• Duration of valid input signal, in 
hh.mm format, after which the 
card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute 
increments 

• Duration of valid input signal, 
in hh.mm format, after which 
the card becomes IS 
automatically

• 0 to 48 hours, 15-minute 
increments 

SF BER (SONET [ANSI] or SDH [ETSI] 
only) Sets the signal fail bit error 
rate.

• 1E-3

• 1E-4 

• 1E-5

• 1E-3

• 1E-4 

• 1E-5

Table 11-175 OTU2_XP Line Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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SD BER (SONET [ANSI] or SDH [ETSI] 
only) Sets the signal degrade bit 
error rate.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Type (SONET [ANSI] or SDH [ETSI] 
only) The optical transport type.

• SONET

• SDH

Note When Type is set to SDH in a 
SONET (ANSI) 
provisioning, SDCC or 
LDCC on OTU2_XP cards 
cannot be provisioned.

• SONET

• SDH

MTU The maximum size of the 
Ethernet frames accepted by the 
port. The port must be in 
OOS/locked state.

MTU stands for “Maximum 
Transmission Unit” typically 
meant for configuring the 
maximum frame size allowed. 
However, the OTU2_XP card 
does not block the frames based 
on Ethernet frame size and 
Jumbo frames are supported 
irrespective of the MTU setting. 
In 10G LAN Phy to WAN Phy 
mode, MTU can be set only to 
1548 bytes.

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

Incoming 
MAC Address

Sets the incoming MAC address. Value of MAC address. Six bytes in 
hexadecimal format.

Value of MAC address. Six bytes 
in hexadecimal format.

Table 11-175 OTU2_XP Line Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
11-453
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G455 Change the OTU2_XP Line Section Trace Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G455 Change the OTU2_XP Line Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs.

Step 3 Modify any of the settings described in Table 11-176. 

Flow Control 
(Only when 
the card is in 
10G Ethernet 
LAN Phy to 
WAN Phy 
mode)

Enables/disables flow control 
messaging with its peer port. 
When enabled, the port can send 
and receive PAUSE frames when 
buffer congestion occurs. When 
disabled, no PAUSE frames are 
transmitted and the PAUSE 
frames received are discarded.

• ON (default)—Flow control is 
enabled.

• OFF—Flow control is disabled.

• ON (default)—Flow control is 
enabled.

• OFF—Flow control is 
disabled.

Client 
Distance 
(Only when 
the card is in 
10G Ethernet 
LAN Phy to 
WAN Phy 
mode)

Sets the fiber distance between 
the client of OTU2_XP card and 
the LAN port that is connected to 
the OTU2_XP client port.

• 10 km (default)

• 30 km

• 10 km (default)

• 30 km

Purpose This task changes the line section trace settings for the OTU2_XP card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-175 OTU2_XP Line Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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Table 11-176 OTU2_XP Section Trace Settings

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port Sets the port number. • 1-1 (OC192)

• 2-1 (OC192)

• 3-1 (OC192)

• 4-1 (OC192)

• 1-1 (STM-64)

• 2-1 (STM-64)

• 3-1 (STM-64)

• 4-1 (STM-64)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If a TIM on Section overhead alarm 
arises because of a J0 overhead string 
mismatch, no alarm indication signal 
is sent to downstream nodes if this box 
is checked.

This is a display-only parameter under 
the following conditions:

• Received Trace Mode is Off/None

• Termination Mode is set to 
Transparent or Section (see the 
“DLP-G453 Change the 
OTU2_XP Card Settings” task on 
page 11-449)

• Checked (AIS/RDI on 
TIM-S is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

• Checked (AIS/RDI on TIM-S 
is disabled)

• Unchecked (AIS/RDI on 
TIM-S is not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

• 1 byte

• 16 byte

Transmit Displays the current transmit string; 
sets a new transmit string. You can 
click the button on the right to change 
the display. Its title changes, based on 
the current display mode. Click Hex to 
change the display to hexadecimal 
(button changes to ASCII); click 
ASCII to change the display to ASCII 
(button changes to Hex).

String of trace string size String of trace string size

Expected Displays the current expected string; 
sets a new expected string. You can 
click the button on the right to change 
the display. Its title changes, based on 
the current display mode. Click Hex to 
change the display to hexadecimal 
(button changes to ASCII); click 
ASCII to change the display to ASCII 
(button changes to Hex).

String of trace string size String of trace string size
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G456 Change the OTU2_XP Line Thresholds for SONET or SDH Payloads

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Note If you have enabled 10G Ethernet LAN Phy to WAN Phy on the OTU2_XP card, the STS option is 
automatically enabled. 
Only near end STS thresholds are supported. No STS thresholds are support for Far End. 

Step 3 Modify any of the OTU2_XP card path threshold settings on a LAN Phy to WAN Phy mode, as seen in 
Table 11-177. 

Received (Display only) Displays the current 
received string. You can click Refresh 
to manually refresh this display, or 
check the Auto-refresh check box to 
automatically refresh the display every 
5 seconds.

String of trace string size String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 seconds.

Checked/unchecked (default) Checked/unchecked (default)

Purpose This task changes the line threshold settings for the OTU2_XP card 
carrying SONET or SDH payload. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-177 OTU2_XP Card Path Threshold Settings on a 10G Ethernet LAN Phy to WAN Phy Mode

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Port 
number. 

• Ports 3-1 (Trunk), STS-1

• Ports 4-1 (Trunk), STS-1

• Port 3-1 (Trunk), VC4-1

• Port 4-1 (Trunk), VC4-1

Table 11-176 OTU2_XP Section Trace Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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Step 4 Modify any of the OTU2_XP Card Line Threshold settings described in Table 11-178

Table 11-178 OTU2_XP Card Line Threshold Settings

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port (Display only) Port 
number

• 1-1 (OC192)

• 2-1 (OC192)

• 3-1 (OC192)

• 4-1 (OC192)

• 1-1 (STM-64)

• 2-1 (STM-64)

• 3-1 (STM-64)

• 4-1 (STM-64)

CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or 
Section

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex 
Section or Regeneration Section

Choose an option in each category and 
click Refresh. 

ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or 
Section

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex 
Section or Regeneration Section

Choose an option in each category and 
click Refresh. 

SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or 
Section

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex 
Section or Regeneration Section

Choose an option in each category and 
click Refresh. 
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Step 5 Click Apply. 

Step 6 Return to your originating procedure (NTP).

DLP-G457 Provision the OTU2_XP Port Alarm and TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the trunk port alarm and TCA settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Under Types, verify that the TCA radio button is checked. If not, select it, then click Refresh.

Step 4 Refer to Table 11-179 to provision the port TCA thresholds for RX Power High, RX Power Low, TX 
Power High, and TX Power Low.

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or 
Section

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex 
Section or Regeneration Section

Choose an option in each category and 
click Refresh. 

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Line or 
Section

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—(Near end only) Multiplex 
Section or Regeneration Section

Choose an option in each category and 
click Refresh. 

Purpose This task provisions the OTU2_XP port alarm and threshold crossing alert 
(TCA) thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-178 OTU2_XP Card Line Threshold Settings (continued)

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options
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Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 5 Click Apply.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Refer to Table 11-180 to provision the port alarm thresholds for RX Power High, RX Power Low, TX 
Power High, and TX Power Low.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Table 11-179 OTU2_XP Port TCA Thresholds

Port
TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

1-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

1.0 dBm –14.0 dBm 5.0 dBm –12.0 dBm

2-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

1.0 dBm –14.0 dBm 5.0 dBm –12.0 dBm

3-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

1.0 dBm –14.0 dBm 5.0 dBm –12.0 dBm

4-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

1.0 dBm –14.0 dBm 5.0 dBm –12.0 dBm

Table 11-180 OTU2_XP Port Alarm Thresholds

Port 
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low

1-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

3.0 dBm –16.0 dBm 1.0 dBm –8.0 dBm

2-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

3.0 dBm –16.0 dBm 1.0 dBm –8.0 dBm
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Step 8 Click Apply. 

Step 9 Return to your originating procedure (NTP).

DLP-G462 Change the OTU2_XP Line RMON Thresholds for the 10G Ethernet and 
10G FC Payloads

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the line threshold in the card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port.

Step 5 From the Variable drop-down list, choose an Ethernet variable. See Table 11-181 and Table 11-182 for 
a list of available Ethernet variables.

3-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

3.0 dBm –16.0 dBm 1.0 dBm –8.0 dBm

4-1 (OC-192/10G Ethernet WAN 
Phy/10G Ethernet LAN Phy/10G 
FC/IB_5G)

3.0 dBm –16.0 dBm 1.0 dBm –8.0 dBm

Purpose This task changes the line threshold settings for OTU2_XP card carrying 
the 10G Ethernet or 10G FC payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-181 OTU2_XP Card 10G Ethernet Variables

Variable Description

ifInOctets Total number of octets received on the interface, including 
framing characters.

rxTotalPkts Total number of received packets. rxTotalPkts increments for 10G 
FC payload packets with FCS errors. However, 10G Ethernet 
LAN Phy payload packets with CRC errors are not counted.

ifInMulticastPkts Number of multicast frames received error free.

Table 11-180 OTU2_XP Port Alarm Thresholds (continued)

Port 
Alarm RX
Power High

Alarm RX
Power Low

Alarm TX
Power High

Alarm TX
Power Low
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ifInBroadcastPkts Number of packets, delivered by a sublayer to an higher sublayer, 
that were addressed to a broadcast address at this sublayer.

ifInErrors Number of inbound packets that contained errors preventing them 
from being delivered to a higher-layer protocol.

dot3StatsFCSErrors Number of frames with frame check errors, that is, there is an 
integral number of octets, but an incorrect Frame Check Sequence 
(FCS).

etherStatsUndersizePkts Total number of packets received that were less than 64 octets 
long (excluding framing bits, but including FCS octets) and were 
otherwise well formed.

etherStatsFragments Total number of packets received that were less than 64 octets in 
length (excluding framing bits but including FCS octets) and had 
either a bad FCS with an integral number of octets (FCS Error) or 
a bad FCS with a non-integral number of octets (Alignment 
Error). Note that it is entirely normal for etherStatsFragments to 
increment. This is because it counts both runts (which are normal 
occurrences due to collisions) and noise hits.

etherStatsPkts64Octets Total number of packets (including bad packets) received that 
were 64 octets in length (excluding framing bits but including 
FCS octets).

etherStatsPkts65to127Octets Total number of packets (including bad packets) received that 
were between 65 and 127 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsPkts128to255Octets The total number of packets (including bad packets) received that 
were between 128 and 255 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsPkts256to511Octets Total number of packets (including bad packets) received that 
were between 256 and 511 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsPkts512to1023Octets Total number of packets (including bad packets) received that 
were between 512 and 1023 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsPkts1024to1518Octets Total number of packets (including bad packets) received that 
were between 1024 and 1518 octets in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsBroadcastPkts Total number of good packets received that were directed to the 
broadcast address. Note that this does not include multicast 
packets.

etherStatsMulticastPkts Total number of good packets received that were directed to a 
multicast address. Note that this number does not include packets 
directed to the broadcast address.

Table 11-181 OTU2_XP Card 10G Ethernet Variables (continued)
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Step 6 From the Alarm Type drop-down list, choose the event triggers. The available options are rising 
threshold, falling threshold, or rising and falling thresholds.

etherStatsOversizePkts Total number of packets received that were longer than 1518 
octets (excluding framing bits, but including FCS octets) and 
were otherwise well formed.

etherStatsJabbers Total number of packets received that were longer than 1518 
octets (excluding framing bits, but including FCS octets), and had 
either a bad FCS with an integral number of octets (FCS Error) or 
a bad FCS with a non-integral number of octets (Alignment 
Error).

etherStatsOctets Total number of octets of data (including those in bad packets) 
received on the network (excluding framing bits but including 
FCS octets).

rxControlFrames Number of MAC control frames passed by the MAC sublayer to 
the MAC control sublayer.

Table 11-182 OTU2_XP Card 10G FC Variables

Variable Description

ifInOctets Total number of octets received on the interface, including 
framing characters.

mediaIndStatsRxFramesTruncated Total number of fiber channel frames received that are less than 
the minimum 36-byte frame. This is inclusive of header, SOF, 
EOF, and CRC with no data bytes.

mediaIndStatsRxFramesTooLong Total number of fiber channel frames received that exceed the 
maximum 2148-byte frame. This is inclusive of header, SOF, 
EOF, CRC, and data bytes.

mediaIndStatsRxFramesBadCRC Total number of fiber channel frames received with CRC errors.

ifInDiscards The number of inbound packets, which were chosen to be 
discarded even though no errors had been detected to prevent 
their being delivered to a higher-layer protocol. One possible 
reason for discarding such a packet could be to free up buffer 
space.1

1. This variable is supported when the 10G Ethernet LAN Phy to WAN Phy mode is enabled on the OTU2_XP card.

ifOutOctets Total number of octets transmitted out of the interface, including 
framing characters.1

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC errors 
when HDLC framing is used.1

transmitPauseFrames Number of transmitted pause frames.1

txTotalPkts Total number of transmit packets.1

Table 11-181 OTU2_XP Card 10G Ethernet Variables (continued)
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Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Enter an appropriate number of seconds for the Sample Period.

Step 9 Enter in the appropriate number of occurrences for the Rising Threshold. 

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Note To view all RMON thresholds, click Show All RMON thresholds. 

Step 12 Return to your originating procedure (NTP).

DLP-G458 Change the OTU2_XP OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs. Then click one of the following subtabs: OTN Lines, 
ITU-T G.709 Thresholds, FEC Thresholds, Trail Trace Identifier, or Proactive Protection Regen. 

Step 3 Modify any of the settings described in Tables 11-69 through 11-72. 

Note You must modify Near End and Far End independently, 15 Min and 1 Day independently, and 
SM and PM independently. To do so, select the appropriate radio button and click Refresh.

Purpose This task changes the OTN line settings for the OTU2_XP card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-183 describes the values on the Provisioning > OTN > OTN Lines tabs.

Table 11-184 describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 11-183 OTU2_XP Card OTN Lines Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

—

ITU-T G.709 
OTN

Sets the OTN lines according to 
ITU-T G.709. Check the box to enable.

• Enable

• Disable

FEC Sets the OTN lines FEC mode. Enhanced 
FEC mode can be enabled to provide 
greater range and lower bit error rate. 

• Disable—FEC is off.

• Standard—Standard FEC is on.

• Enhanced—Enhanced FEC is on.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

SF BER (Display only) Indicates the signal fail bit 
error rate.

• 1E-5

No Fixed Stuff Sets the insertion of stuffing bytes. This 
parameter only applies to 10G Ethernet 
LAN Phy signals in transponder card 
configuration. This is a display-only 
parameter for all other card 
configurations.

When the “No Fixed Stuff” parameter is 
disabled, the bit rate is 11.09 Gbps.

When the “No Fixed Stuff” parameter is 
enabled, the bit rate is 11.05 Gbps.

• Disable

• Enable
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Table 11-184 OTU2_XP Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name. 

—

ES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC, 
overhead management, and PM using 
OTUk. Selecting the PM radio button 
selects path PM using ODUk.

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk)

Choose an option in each category and 
click Refresh. 

Note SM (OTUk) is the ITU-T G.709 
optical channel transport unit 
order of k overhead frame used 
for management and performance 
monitoring. PM (ODUk) is the 
ITU-T G.709 optical channel data 
unit order of k overhead frame 
unit used for path performance 
monitoring.

SES Severely errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh.

UAS Unavailable seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 
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Table 11-185 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 11-186 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Note You cannot change the Path Trail Trace Identifier settings when the OTU2_XP card is in the Standard 
Regen mode, and if the ODU transparency is set to “Transparent Standard Use”.
You can change the Path Trail Trace Identifier settings when the OTU2_XP card is in the Standard Regen 
mode, and if the ODU transparency is set to “Cisco Extended Use”.

BBE Background block errors Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

FC Failure counter Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—SM (OTUk) or PM (ODUk) 

Choose an option in each category and 
click Refresh. 

Table 11-184 OTU2_XP Card ITU-T G.709 Threshold Settings (continued)

Parameter Description Options

Table 11-185 OTU2_XP Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and optional name.

—

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Uncorrectable 
Words

Displays the number of uncorrectable 
words in the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Table 11-186 OTU2_XP Card Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. —

Level Sets the level. • Section

• Path
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Table 11-187 describes the values on the Provisioning > OTN > Proactive Protection Regen tabs.

Note Proactive protection regen is supported on ports of OTU2_XP only in Standard Regen and Enhanced 
FEC mode.

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
enabled)

Transmit Displays the current transmit string; sets 
a new transmit string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string; sets 
a new expected string. You can click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 minutes.

Checked/unchecked (default)

Table 11-186 OTU2_XP Card Trail Trace Identifier Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Table 11-187 OTU2_XP Card Proactive Protection Regen Settings

Parameter Description Options

Port (Display only) Displays the port number 
and name (optional).

—

Trigger 
threshold 

Sets the maximum BER threshold to 
trigger proactive protection.

• 1E-3

• 9E-4 to 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

Trigger 
window (ms)

Sets the duration for which BER is 
monitored before triggering the proactive 
protection. 

The trigger window value must be a 
multiple of:

• 10 ms for trigger thresholds between 
1E-3 and 6E-6 

• 100 ms for trigger threshold between 
5E-6 to 1E-7 

Trigger window must be less than or 
equal to 10000 ms.

Time in milliseconds.

Revert 
Threshold

Sets the revert threshold value of BER.

Note Revert Threshold settings must be 
less than the Trigger Threshold 
values.

• 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

• 9E-8 to 5E-8

Revert window 
(ms)

Sets the duration for which BER is 
monitored for settings that are less than 
the revert threshold value before which 
proactive protection provided to the 
router is removed.

Revert Window value must be at least 
2000ms and a multiple of:

• 10ms for a Revert Threshold of 1E-4 
to 6E-7

• 100ms for a Revert Threshold of 
5E-7 to 5E-8.

The revert window must be less than or 
equal to 10000ms.

Time in milliseconds.
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Step 5 Return to your originating procedure (NTP).

DLP-G523 Change the OTU2_XP Path Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the path trace settings.

Step 2 Click the Provisioning > Path> J1 Path Trace tabs.

Step 3 Modify any of the settings described in Table 11-188. 

Purpose This task changes the path trace settings for the OTU2_XP card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-188 OTU2_XP Path Trace Settings

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Port Sets the port number. • 3-1 (OC192)

• 4-1 (OC192)

• 3-1 (STM-64)

• 4-1 (STM-64)

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual

• Off/None

• Manual

Transmit Displays the current transmit 
string; sets a new transmit 
string. You can click the 
button on the right to change 
the display. Its title changes, 
based on the current display 
mode. Click Hex to change 
the display to hexadecimal 
(button changes to ASCII); 
click ASCII to change the 
display to ASCII (button 
changes to Hex).

String of trace string size String of trace string size
11-469
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G524 Provision the OTU2_XP Path Settings for 10G Ethernet LAN Phy to WAN Phy Configuration
Step 4 Click Apply. 

Return to your originating procedure (NTP).

DLP-G524 Provision the OTU2_XP Path Settings for 10G Ethernet LAN Phy to 
WAN Phy Configuration

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OTU2_XP card where 
you want to change the path settings.

Expected Displays the current expected 
string; sets a new expected 
string. You can click the 
button on the right to change 
the display. Its title changes, 
based on the current display 
mode. Click Hex to change 
the display to hexadecimal 
(button changes to ASCII); 
click ASCII to change the 
display to ASCII (button 
changes to Hex).

String of trace string size String of trace string size

Received (Display only) Displays the 
current received string. You 
can click Refresh to manually 
refresh this display, or check 
the Auto-refresh check box to 
automatically refresh the 
display every 5 seconds.

String of trace string size String of trace string size

Auto-refresh If checked, automatically 
refreshes the display every 5 
seconds.

Checked/unchecked 
(default)

Checked/unchecked 
(default)

Table 11-188 OTU2_XP Path Trace Settings (continued)

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI) 
Options

Purpose This task changes the path settings of the OTU2_XP card for 10G Ethernet 
LAN Phy to WAN Phy configuration.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning > Path > SONET/SDH tab. You can now provision the SF BER and SD BER 
values.

Step 3 Modify any of the OTU2_XP path settings described in Table 11-189.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G162 Change the ALS Maintenance Settings

Note The automatic laser shutdown (ALS) function is normally disabled for TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, and AR_XPE 
cards. Enable ALS only when the cards are directly connected to each other.

Note ALS is applicable only for OCn and OTN payloads.

Table 11-189 OTU2_XP Path Settings

Parameter Description ONS 15454 (ANSI) Options ONS 15454 SDH (ETSI) Options

Port Sets the port number. • Port 3-1 (trunk)

• Port 4-1 trunk

• Port 3-1 (trunk)

• Port 4-1 trunk

SF BER Sets the signal fail bit 
error rate (SONET [ANSI] 
or SDH [ETSI]).

• 1E-3

• 1E-4 

• 1E-5

• 1E-3

• 1E-4 

• 1E-5

SD BER Sets the signal degrade bit 
error rate (SONET [ANSI] 
or SDH [ETSI]).

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Purpose This procedure changes the ALS maintenance settings for the TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 
10x10G-LC, CFP-LC, AR_MXP, AR_XP, and AR_XPE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, or 
AR_XPE card where you want to change the ALS maintenance settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 11-190. The provisionable parameters are listed in the 
Options column in the table.

Step 4 Click Apply. If the change affects traffic, a warning message displays. Click Yes to complete the change.

Stop. You have completed this procedure.

Table 11-190 ALS Settings

Parameter Description Options

Port (Display only) Displays the port name. —

ALS Mode Automatic laser shutdown. ALS provides 
the ability to shut down the TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, OTU2_XP, 100G-LC-C, 
10x10G-LC, CFP-LC, AR_MXP, 
AR_XP, and AR_XPE TX laser when the 
card detects an LOS or LOS-P.

From the drop-down list, choose one 
of the following:

• Disable—Deactivates ALS.

• Auto Restart—(Default) ALS is 
active. The power is 
automatically shut down when 
needed and automatically tries to 
restart using a probe pulse until 
the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
an amplifier restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays the current status 
of the laser. 

—

Request Laser 
Restart

If checked, allows you to restart the laser 
for maintenance. 

Checked or unchecked
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NTP-G302 Configure Loopback on 100G-LC-C, 10x10G-LC, and 
CFP-LC Cards

Caution This procedure is traffic-affecting.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC card where you want to change the loopback settings. The card view appears.

Step 2 Click Maintenance > Loopback tabs.

Step 3 Modify any of the settings described in Table 11-191. The provisionable parameters are listed in the 
Options column of the table.

Note Before you configure a loopback, the port admin state must be set to OOS,MT(ANSI) or 
Locked,maintenance (ETSI).

Purpose This procedure configures or clears terminal or facility loopback on the 
100G-LC-C, 10x10G-LC, or CFP-LC cards. 

Note The loopback on the CFP-LC card can be configured on the 
backplane of the peer 100G-LC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Stop. You have completed this procedure.

Table 11-191 Loopback Settings

Parameter Description Options

Port (Display only) Name of the port. —

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, 
see the Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,MT (ANSI) or 
Locked,maintenance (ETSI)

• OOS,DSBLD (ANSI) or 
Locked,disabled (ETSI)

• IS,AINS (ANSI) or 
Unlocked,AutomaticInService 
(ETSI)

Service State (Display only) Identifies the 
autonomously generated state that gives 
the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary 
State. For more information about service 
states, see the Administrative and Service 
States document.

• IS-NR (ANSI) or 
Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or 
Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance 
(ETSI)

Loopback Configures or clears a port for a terminal 
(inward) or facility (line) loopback on the 
required port.

• None—Clears loopback

• Terminal (Inward)

• Facility (Line)
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NTP-G299 Configure the Backplane Loopback on 100G-LC-C, 
10x10G-LC, and CFP-LC Cards

Note This procedure is traffic-affecting.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC card where you want to change the backplane loopback settings. The card view 
appears.

Step 2 Click Maintenance > Card tabs.

Step 3 Modify any of the settings described in Table 11-192. The provisionable parameters are listed in the 
Options column in the table.

Note Before you configure a backplane loopback, the port admin state must be set to OOS,MT(ANSI) 
or Locked,maintenance (ETSI).

Purpose This procedure configures or clears the backplane loopback on the 
100G-LC-C, 10x10G-LC, and CFP-LC cards. 

Note The loopback on the CFP-LC card can be configured on the 
backplane of the peer 100G-LC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-192 Backplane Loopback Settings

Parameter Description Options

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, 
see the Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,MT (ANSI) or 
Locked,maintenance (ETSI)
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Step 4 Click Apply.

Stop. You have completed this procedure.

NTP-G192 Force FPGA Update

Note Perform Step 1 through Step 4 if you are updating the node software. Otherwise continue with Step 5 to 
force FPGA image upgrade on MXP_MR_10DME_C or MXP_MR_10DME_L card.

Step 1 Close the CTC window, if open.

Step 2 Delete the CTC Cache from the CTC Launcher browser window.

Step 3 Close the CTC Launcher browser window.

Step 4 Relaunch the CTC Launcher browser window.

Step 5 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 
MXP_MR_10DME_C or MXP_MR_10DME_L card to be upgraded.

Step 6 For all ports being provisioned on the card, click the Provisioning > Line tabs.

a. Click the Admin State table cell and choose OOS,DSBLD (ANSI) or Locked,Disabled (ETSI).

b. Click Apply, then Yes.

Service State (Display only) Identifies the 
autonomously generated state that gives 
the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary 
State. For more information about service 
states, see the Administrative and Service 
States document.

• IS-NR (ANSI) or 
Unlocked-enabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance 
(ETSI)

Loopback Configures or clears backplane terminal 
(Inward) or facility (Line) loopback on 
the card. You can configure the backplane 
loopback only if the card is removed from 
service.

• None

• Backplane Facility

• Terminal Facility

Table 11-192 Backplane Loopback Settings (continued)

Parameter Description Options

Purpose This procedure forces an upgrade of the FPGA image on the 
MXP_MR_10DME_C and MXP_MR_10DME_L cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Click the Provisioning > Card tabs.

Step 8 Change the Card Mode as needed:

• FC-GE_ISC—Choose this option if you will provision any of the following PPM port rates: FC1G 
(Ports 1-1 through 4-1), FC2G (Ports 1-1 and 3-1 only), FICON1G (Ports 1-1 through 4-1), 
FICON2G (Ports 1-1 and 3-1 only), ONE_GE (Ports 1-1 through 4-1), ISC3 COMPAT (Ports 1-1 
through 4-1), ISC3 PEER 1G (Ports 1-1 through 4-1), and ISC3 PEER 2G (Ports 1-1 and 3-1 only).

• FC4G—Choose this option if you will provision an FC4G or FICON4G PPM (Port 1-1 only).

Step 9 Click the Force FPGA Update button. This upgrades the FPGA image in the MXP_MR_10DME_C or 
MXP_MR_10DME_L card, as appropriate. The MXP_MR_10DME_C or MXP_MR_10DME_L card 
reboots and the FPGA now contains the updated image.

Step 10 For all ports being provisioned on the card, click the Provisioning > Line tabs.

a. Click the Admin State table cell and choose IS (ANSI) or Unlocked (ETSI).

b. Click Apply, then Yes.

Stop. You have completed this procedure.

NTP-G196 Force FPGA Update When the Card is Part of a 
Protection Group

Note This procedure applies to a near-end node that has two MXP_MR_10DME_C or MXP_MR_10DME_L 
cards, one card acting as the working card and the other as the protect card. The far-end node has a 
similar configuration. The near-end working card trunk port is connected to the far-end working card 
trunk port. The near-end protect card trunk port is connected to the far-end protect card trunk port.

Note Perform Step 1 through Step 4 if you are updating the node software. Otherwise, continue with Step 5 
to force FPGA image upgrade on MXP_MR_10DME_C or MXP_MR_10DME_L card.

Step 1 Close the CTC window, if open.

Step 2 Delete the CTC Cache from the CTC Launcher browser window.

Step 3 Close the CTC Launcher browser window.

Step 4 Relaunch the CTC Launcher browser window.

Purpose This procedure forces an upgrade of the FPGA image on the 
MXP_MR_10DME_C and MXP_MR_10DME_L cards when the card is 
part of a protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Ensure traffic is running on the near-end and far-end working cards for each protection group on the 
MXP_MR_10DME_C or MXP_MR_10DME_L card.

Step 6 In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
Protection tab.

Step 7 For each protection group, verify that the working card client port is reported as working/active and the 
protect card client port is reported as protect/standby.

Step 8 Repeat Steps 6 and 7 for the far-end node.

Step 9 For each protection group on the near-end and far-end nodes, complete the “DLP-G182 Apply a 
Lockout” task to prevent traffic from switching to the protect card.

Step 10 At the near-end and far-end nodes, complete the “NTP-G192 Force FPGA Update” procedure on 
page 11-476 to force an upgrade of the FPGA image on the protect card.

Step 11 For each protection group on the near-end and far-end nodes, complete the “DLP-G183 Clear a Lock-On 
or Lockout” task to remove a lockout and return a protection group to its usual switching method.

Step 12 For each protection group on the near-end and far-end nodes, complete the “DLP-G179 Apply a Force 
Y-Cable or Splitter Protection Switch” task to move traffic from the working to the protect card.

Step 13 At the near-end and far-end nodes, complete the “NTP-G192 Force FPGA Update” procedure on 
page 11-476 to force an upgrade of the FPGA image on the working card.

Step 14 For each protection group on the near-end and far-end nodes, complete the “DLP-G180 Clear a Manual 
or Force Y-Cable or Splitter Protection Switch” task to clear a Force protection switch on the working 
card. If the protection group is revertive, this operation causes the traffic to revert to the working card. 
If the protection group is non-revertive, this operation causes the traffic to remain on the protect card.

Stop. You have completed this procedure.

NTP-G232 Enabling Error Decorrelator

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP_MR_10EX_C, 
MXP_2.5G_10EX_C, or MXP_MR_10DMEX_C card where you want to enable error decorrelator.

Step 2 Click the Provisioning > Line> Error Decorrelator Settings tabs. 

Step 3 In the Error Decorrelator Settings area, Select Enable.

Note To inter-operate with other cards, disable the error decorrelator.
Click the Provisioning > Line> Error Decorrelator Settings tabs and then select Disable.

Purpose This task enables error decorrelator on a TXP_MR_10EX_C, 
MXP_2.5G_10EX_C, or MXP_MR_10DMEX_C card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G315 Enable or Disable the Wavelength Drifted Channel 
Automatic Shutdown Feature

Step 1 In the node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults tabs. The Node Defaults page opens.

Step 2 Select the card from the Defaults Selector pane where you want to enable or disable the wavelength 
drifted channel automatic shutdown feature.

Step 3 Select the <card name>.config.card.WavelengthDrift from the Default Name column. Choose Disable or 
Enable from the Default Value drop-down list for the selected card.

For example, if you select 40-SMR2-C card from the Defaults Selector folder, the Default Name column 
reads “40-SMR2-C.config.card.WavelengthDrift”.

Step 4 Click Apply to save changes.

Stop. You have completed this procedure.

NTP-G316 Enable REP and FAPS on the same port

Note The FAPS master node on the edge ring should never be the node that has a common FAPS and REP port.

You can configure REP and FAPS on port 22 and 21 for GE_XP cards, and port 4 and 3 for 10GE_XP 
cards.

Step 1 To enable REP, complete the following procedures:

a. DLP-G645 Create a Segment Using CTC, page 11-397 

Purpose This procedure allows you to enable or disable the wavelength drifted 
channel automatic shutdown feature for 40-SMR1-C, 40-SMR2-C, 
80-WXC-C, 40-WXC-C, and 40-WSS-C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task allows you enable REP and FAPS on the same port for the 
GE_XP and 10GE_XP cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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b. DLP-G647 Activate VLAN Load Balancing Using CTC, page 11-400

Step 2 To enable FAPS, complete the DLP-G381 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Layer 2 Protection Settings, page 11-415.

Stop. You have completed this procedure.

NTP-G321 Provision Multiple Operating Modes on AR_MXP, 
AR_XP, or AR_XPE Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to provision an operating mode. The card view appears.

Step 2 Click the Provisioning > Card tabs.

Step 3 In the Card tab, click Create. The Operating Mode Configuration Creation window appears.

Step 4 From the Card Config Rate Selection section, select Low Rate Mode or High Rate Mode.

Step 5 In the Card Config Selection section:

a. Choose the Operating Mode from the drop-down list.

The Operating Mode options vary depending on the Card Type (AR_MXP, AR_XP, or AR_XPE) 
and Card Config Rate Selection.

b. For MXP_DME and MXPP_DME card modes, choose the Client Trunk Mapping from the 
drop-down list. For other card modes, CTC automatically selects the client trunk mapping.

Step 6 Click Next. 

Step 7 Select the appropriate trunk port that is available and click Next.

Step 8 Select the appropriate client port that is available and click Finish.

The selected operating mode is provisioned on the AR_MXP, AR_XP, or AR_XPE card.

Purpose This procedure enables you to provision multiple operating modes on the 
AR_MXP, AR_XP, or AR_XPE cards.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• DLP-G726 Preprovisioning a Multirate PPM 

• DLP-G278 Provision the Optical Line Rate, page 11-175

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note When you want to upgrade the FPGA image on the AR_MXP, AR_XP, or AR_XPE card, click the 
FPGA/FIRMWARE Upgrade button. This upgrades the FPGA image on the AR_MXP, AR_XP, or 
AR_XPE card as appropriate, without the need of upgrading the whole network.

Stop. You have completed this procedure.

NTP-G322 Modify the AR_MXP, AR_XP, or AR_XPE Card Line 
Settings and PM Parameter Thresholds

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the AR_MXP, AR_XP, 
or AR_XPE card line and PM threshold settings. If you are already logged in, proceed to Step 2.

Step 2 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 3 Perform any of the following tasks as needed:

• DLP-G695 Change the AR_MXP, AR_XP, or AR_XPE Card Line Settings, page 11-482

• DLP-G696 Change the AR_MXP, AR_XP, or AR_XPE Card Ethernet Settings, page 11-484

• DLP-G697 Change the AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings, page 11-486

• DLP-G698 Change the AR_MXP, AR_XP, or AR_XPE Card Section Trace Settings, page 11-489

• DLP-G699 Enable Auto Sensing for AR_MXP, AR_XP, or AR_XPE Cards, page 11-490

• DLP-G700 Change the AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line Thresholds, 
page 11-491

• DLP-G701 Change the AR_MXP, AR_XP, or AR_XPE Card Line RMON Thresholds, page 11-493

• DLP-G702 Provision the AR_MXP, AR_XP, or AR_XPE Card with Trunk Port Alarm and TCA 
Thresholds, page 11-498

Purpose This procedure changes the line and PM parameter threshold settings of the 
AR_MXP, AR_XP, or AR_XPE cards. 

Tools/Equipment None

Prerequisite Procedures • NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provision the Optical Line Rate, page 11-175 (if 
necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• DLP-G703 Provision the AR_MXP, AR_XP, or AR_XPE Card Client Port Alarm and TCA 
Thresholds, page 11-499

• DLP-G704 Change the AR_MXP, AR_XP, or AR_XPE Card OTN Settings, page 11-503

• DLP-G734 View the Mapping of ODU Object with Client Port, page 11-508

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the 
Alarm and TCA Monitoring and Management document.

Stop. You have completed this procedure.

DLP-G695 Change the AR_MXP, AR_XP, or AR_XPE Card Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs. Tabs and parameter selections vary according to PPM 
provisioning.

Step 3 Modify any of the line settings in the Ports tab as described in Table 11-193. 

Purpose This task changes the line settings of the AR_MXP, AR_XP, or AR_XPE 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-193 AR_MXP, AR_XP, or AR_XPE Card Line Settings

Parameter Description Options

Port (Display only) Displays the port number. 1 through 10

Port Name Assigns a logical name for the specified 
port.

User-defined. Name can be up to 32 alphanumeric or special 
characters, or both. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Note You can provision a string (port name) for each fiber 
channel/FICON interface on the AR_MXP, AR_XP, or 
AR_XPE card, which allows the MDS Fabric Manager 
to create a link association between that SAN port and 
a SAN port on a Cisco MDS 9000 switch.
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Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
the Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall 
condition of the port. Service states appear 
in the format: Primary State-Primary State 
Qualifier, Secondary State. For more 
information about service states, see the 
Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled 
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance 
(ETSI)

ALS Mode Sets the ALS function mode. • Disabled (default)— ALS is off; the laser is not 
automatically shut down when traffic outage or loss of 
signal (LOS) occurs.

• Manual Restart— ALS is on; the laser automatically shuts 
down when traffic outage or loss of signal (LOS) occurs. 
However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test— Manually restarts the laser for 
testing.

AINS Soak Sets the automatic in-service soak period. 
Double-click the time and use the up and 
down arrows to change settings.

• Duration of valid input signal, in hh.mm format, after 
which the card state changes to in service (IS) 
automatically.

• 0 to 48 hours, 15-minute increments.

Reach Sets the optical reach distance of the client 
port.

The reach distances that appear in the drop-down list depend 
on the card:

• Autoprovision—The system automatically provisions the 
reach from the pluggable port module (PPM) reach value 
on the hardware.

• I1—Intermediate reach

• S1—Short reach, up to 15-km distance

• S2—Short reach up to 40-km distance

• L1—long reach, up to 40-km distance 

• L2—long reach, up to 80-km distance 

• L3—long reach, up to 80-km distance

• CWDM— CWDM Reach

• MM—

• ULH—Ultra long-haul (ULH)

• DWDM—DWDM Reach

Table 11-193 AR_MXP, AR_XP, or AR_XPE Card Line Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G696 Change the AR_MXP, AR_XP, or AR_XPE Card Ethernet Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Line > Ethernet tabs.

Step 3 Modify any of the Ethernet settings in the Ethernet tab as described in Table 11-194. The parameters that 
appear depend on the card mode.

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths:

– 850 nm through 1561.83 nm

– 100-GHz ITU spacing

– CWDM spacing

Squelch Shuts down the far-end laser in response to 
certain defects. (Squelch does not apply to 
ISC COMPACT payloads.)

• G AIS

• Squelch

• NOS

• None

Termination 
Mode

Sets the mode of operation. (This option is 
only available for SONET/SDH payloads).

• Transparent

Purpose This task changes the Ethernet settings of the AR_MXP, AR_XP, or 
AR_XPE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-193 AR_MXP, AR_XP, or AR_XPE Card Line Settings (continued)

Parameter Description Options
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Table 11-194 AR_MXP, AR_XP, and AR_XPE Card Ethernet Settings

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI)
Options

Port (Display only) Displays the port 
number (n-n) and rate.

— —

Port Name (Display only) Displays the port 
Name.

— —

MTU Sets the maximum size of the 
Ethernet frames accepted by the port. 
The port must be in OOS/locked 
state.

Numeric. Default: 9700

Range 64 to 9700 (for R9.4 and later) 

Numeric. Default: 9700

Range 64 to 9700 (for R9.4 
and later)

Speed Sets the expected speed of the ports. 100 Mbps for FE ports and 
1000 Mbps for GE ports

100 Mbps for FE ports and 
1000 Mbps for GE ports

Duplex (Display only) Displays expected 
duplex capability of ports.

Full Full

Auto 
negotiation

If checked, enables autonegotiation 
on the same port.

Checked or unchecked Checked or unchecked

ProvidesSync Sets the ProvidesSync card 
parameter. If checked, the card is 
provisioned as a network element 
(NE) timing reference.

Checked or unchecked Checked or unchecked

SyncMsgIn Sets the EnableSync card parameter.

Enables synchronization status 
messages (S1 byte), which allow the 
node to choose the best timing 
source.

Checked or unchecked Checked or unchecked

Admin SSM 
In

Overrides the synchronization status 
message (SSM) and the 
synchronization traceability 
unknown (STU) value. If the node 
does not receive an SSM signal, it 
defaults to STU.

• PRS—Primary Reference 
Source (Stratum 1)

• ST2—Stratum 2

• TNC—Transit node clock

• ST3E—Stratum 3E

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing 
synchronization

• RES—Reserved; quality level 
set by user

• G811—Primary 
reference clock

• STU—Sync traceability 
unknown

• G812T—Transit node 
clock traceable

• G812L—Local node 
clock traceable

• SETS—Synchronous 
equipment

• DUS—Do not use for 
timing synchronization

Termination 
Mode

(Display-only for Standard 
Regeneration and Enhanced FEC 
card configurations) Sets the mode of 
operation.

— —
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DLP-G697 Change the AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the SONET (OC-192)/SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs. Tabs and parameter selections 
vary according to PPM provisioning.

Step 3 Modify any of the settings as described in Table 11-195. 

Send 
DoNotUse

When checked, sends a DUS 
message on the S1 byte.

Checked or unchecked Checked or unchecked

ESMC 
Enable

Enables the timing to be taken from 
the Ethernet port.

Checked or unchecked Checked or unchecked

Video Type Video — —

Purpose This task changes the SONET /SDH settings of the AR_MXP, AR_XP, or 
AR_XPE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-195 AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Port Name Assign a name for the specified port. User-defined. Name can be up to 32 alphanumeric or 
special characters, or both. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Table 11-194 AR_MXP, AR_XP, and AR_XPE Card Ethernet Settings (continued)

Parameter Description ONS 15454 (ANSI) Options
ONS 15454 SDH (ETSI)
Options
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Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information about 
service states, see the Administrative and Service 
States document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER1 Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5

SD BER1 Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Type Sets the optical transport type. • SONET (ANSI)

• SDH (ETSI)

ALS Mode Sets the ALS function mode. The DWDM 
transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or 
enabled for one of the three mode options.

• Disabled (default)—ALS is off; the laser is not 
automatically shut down when traffic outage or loss 
of signal (LOS) occurs.

• Auto Restart—ALS is on; the laser automatically 
shuts down when traffic outage or loss of signal 
(LOS) occurs. It automatically restarts when the 
conditions that caused the outage are resolved.

• Manual Restart—ALS is on; the laser automatically 
shuts down when traffic outage or loss of signal 
(LOS) occurs. However, the laser must be manually 
restarted when conditions that caused the outage are 
resolved.

• Manual Restart for Test—Manually restarts the laser 
for testing.

AINS Soak Sets the automatic in-service soak period. 
Double-click the time and use the up and down 
arrows to change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card state changes to in service (IS) 
automatically.

• 0 to 48 hours, 15-minute increments.

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a NE timing 
reference.

Checked or unchecked

Table 11-195 AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source.

Checked or unchecked

Admin SSM In Overrides the synchronization status message 
(SSM) and the synchronization traceability 
unknown (STU) value. If the node does not 
receive an SSM signal, it defaults to STU.

STU

Reach Sets the optical reach distance of the client port. The reach distances that appear in the drop-down list 
depend on the card:

• Autoprovision—The system to automatically 
provision the reach from the pluggable port module 
(PPM) reach value on the hardware.

• I1/IR1—Intermediate Reach

• S1/SR1—Intermediate reach, up to 15-km distance

• S2/SR2—Intermediate reach up to 40-km distance

• L1/LR1—long reach, up to 40-km distance 

• L2/LR2—long reach, up to 80-km distance 

• L3/LR3—long reach, up to 80-km distance

• CWDM—CWDM Reach

• MM

• SR—Short Reach

• ULH—Ultra long-haul (ULH)

• DWDM—DWDM Reach

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths:

– 850 nm through 1561.83 nm

– 100-GHz ITU spacing

– CWDM spacing

1. SF BER and SD BER thresholds apply only to trunk ports.

Table 11-195 AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Settings (continued)

Parameter Description Options
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DLP-G698 Change the AR_MXP, AR_XP, or AR_XPE Card Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to 
PPM provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in Table 11-196. 

Purpose This task changes the section trace settings of the AR_MXP, AR_XP, or 
AR_XPE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-196 AR_MXP, AR_XP, or AR_XPE Card Line Section Trace Settings

Parameter Description Options

Port (Display only) Displays the port number. • Client Ports (1-8)

Received 
Trace Mode

Sets the received trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S

If a TIM on section overhead alarm arises because of a J0 
overhead string mismatch, no alarm indication signal is sent to 
downstream nodes if this box is checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string or sets a new transmit string. 
Click the button on the right to change the display. Its title 
changes, based on the current display mode. Click Hex to change 
the display to hexadecimal (button changes to ASCII); click 
ASCII to change the display to ASCII (button changes to Hex).

Note For OCn and OTU traces, the junk squares appear in the 
New Transmit String field when you click the default 
button. Ignore the junk squares that appear in the New 
Transmit String field.

String of trace string size
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DLP-  G699 Enable Auto Sensing for AR_MXP, AR_XP, or AR_XPE Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G699 Enable Auto Sensing for AR_MXP, AR_XP, or AR_XPE Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to enable auto sensing.

Step 2 Click the Provisioning > Line > Auto Ports tabs. Tabs and parameter selections vary according to PPM 
provisioning.

Step 3 Modify any of the settings in the Auto Ports tab as described in Table 11-197. 

Expected Displays the current expected string or sets a new expected string. 
Click the button on the right to change the display. Its title 
changes, based on the current display mode. Click Hex to change 
the display to hexadecimal (button changes to ASCII); click 
ASCII to change the display to ASCII (button changes to Hex).

Note For OCn and OTU traces, the junk squares appear in the 
New Expected String field when you click the default 
button. Ignore the junk squares that appear in the New 
Expected String field.

String of trace string size

Received (Display only) Displays the current received string. Click 
Refresh to manually refresh this display, or select the 
Auto-refresh every 5 sec check box to keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the display every 5 seconds. Checked or unchecked (default)

Purpose This task enables the auto sensing for AR_MXP, AR_XP, or AR_XPE 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-197 AR_MXP, AR_XP, or AR_XPE Auto Sensing Settings

Parameter Description Options

Port (Display only) Displays the port number. Client Ports (1-8)

Auto Sensing If checked, enables auto sensing. Checked or Unchecked

Actual Port 
Type

Displays the auto-sensed signal type. —

Table 11-196 AR_MXP, AR_XP, or AR_XPE Card Line Section Trace Settings (continued)

Parameter Description Options
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DLP-G700 Change the AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the SONET/SDH line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings as shown in Table 11-198.

Note You must modify Near End and Far End independently; 15 Min and 1 Day independently; and 
Line and Section independently. To do so, choose the appropriate radio button and click Refresh.

I

Purpose This task changes the SONET/SDH line threshold settings of AR_MXP, 
AR_XP, or AR_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-198 AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line Threshold Settings

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH

Port (Display only) 
Displays the port 
number.

• Client Ports (1-8) • Client Ports (1-8)

EB Path Errored Block 
indicates that one or 
more bits are in error 
within a block.

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

CV Coding violations Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—
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ES Errored seconds Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SES Severely errored 
seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SEFS (Near End Section or 
Regeneration Section 
only) Severely 
errored framing 
seconds 

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

BBE Background block 
errors

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Table 11-198 AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G701 Change the AR_MXP, AR_XP, or AR_XPE Card Line RMON 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the line RMON threshold settings in card view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1 
(ONE_GE)”, or the equivalent ITU-T G.7041 GFP (Generic Frame Procedure) port.

FC (Line or Multiplex 
Section only) Failure 
count

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

UAS (Line or Multiplex 
Section only) 
Unavailable seconds

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Purpose This task changes the line threshold settings for AR_MXP, AR_XP, or 
AR_XPE cards carrying Ethernet, FC/FICON, or ISC/ISC3 payloads.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-198 AR_MXP, AR_XP, or AR_XPE Card SONET/SDH Line Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
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Step 5 From the Variable drop-down list, choose an Ethernet, FC, FICON, or ISC variable. See Table 11-199 
for a list of available Ethernet variables, Table 11-200 for a list of FC and FICON variables, 
Table 11-201 for a list of ISC and ISC3 variables, and Table 11-202 for a list of GFP variables.

Table 11-199 AR_MXP, AR_XP, or AR_XPE Card Ethernet Variables

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of received packets.

ifInUcastPkts Number of packets delivered by this sublayer to a higher 
sublayer that are not addressed to a multicast or broadcast 
address.

ifInMulticastPkts Number of packets delivered by this sublayer to a higher 
sublayer that are addressed to a multicast address. For a 
MAC layer protocol, this includes both group and 
functional addresses.

ifInBroadcastPkts Number of packets delivered by this sublayer to a higher 
sublayer that are addressed to a broadcast address.

ifInErrors Total number of received errors.

ifOutOctets Total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

IfOutUcastPkts Total count of good frames transmitted to a unicast group 
destination address.

ifOutMulticastPkts Total number of packets that higher-level protocols 
requested to be transmitted, which were addressed to a 
multicast address at this sublayer. These include packets 
that were discarded or not sent. For a MAC layer protocol, 
this includes both group and functional addresses.

ifOutBroadcastPkts Total number of packets that higher-level protocols 
requested to be transmitted, which were addressed to a 
broadcast address at this sublayer. These include packets 
that were discarded or not sent.

dot3StatsFCSErrors Number of frames received on a particular interface that 
are an integral number of octets in length but do not pass 
the FCS check.

dot3StatsAlignmentErrors Total number of frames received on a particular interface 
that are not an integral number of octets in length and do 
not pass the FCS check. This counter is only valid for FE 
modes of operation.

dot3StatsFrameTooLong Number of frames received on a particular interface that 
exceed the maximum permitted frame size.
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dot3StatsSymbolErrors Number of frames received on an associated RX_ER 
assertion during a data reception error event (MII) or data 
reception error event, or carrier extension error (GMII) 
from the PCS.

dot3StatsLayer1Errors Number of Layer 1 errors as defined within the following 
conditions: 

• During Packet Reception—Layer 1 errors are only 
counted one time per packet. The Layer 1 error is 
indicated as a direct result of a line side protocol 
violation in which RX_DV is asserted. This is an 
uncommon event from which may be the reason why 
the device loses synchronization. 

• During Interpacket Reception—The Layer 1 error is 
indicated as a direct result of a line side protocol 
violation in which RX_DV is de-asserted. This is an 
uncommon event. The Layer 1 error is also asserted on 
detection of a False Carrier indication and is asserted 
on detection of Erred byte (interpacket) signal 
encoding. When the Layer 1 error is asserted during 
inter-packet reception, it is only statistically asserted 
in the vector.

dot3StatsLCVErrors Number of received line code violations at the PCS layer.

etherStatsUndersizePkts Total number of packets received that were less than 64 
octets long (excluding framing bits, but including FCS 
octets) and were otherwise well formed.

etherStatsFragments Total number of packets received that were less than 64 
octets in length (excluding framing bits but including FCS 
octets) and had either a bad FCS with an integral number 
of octets (FCS Error) or a bad FCS with a non-integral 
number of octets (Alignment Error). Note that it is entirely 
normal for etherStatsFragments to increment. This is 
because it counts both runts (which are normal 
occurrences due to collisions) and noise hits.

etherStatsPkts64Octets Total number of packets (including bad packets) received 
that were 64 octets in length (excluding framing bits but 
including FCS octets).

etherStatsPkts65to127Octets Total number of packets (including bad packets) received 
that were between 65 and 127 octets in length inclusive 
(excluding framing bits but including FCS octets).

etherStatsPkts128to255Octets Total number of packets (including bad packets) received 
that were between 128 and 255 octets in length inclusive 
(excluding framing bits but including FCS octets).

etherStatsPkts256to511Octets Total number of packets (including bad packets) received 
that were between 256 and 511 octets in length inclusive 
(excluding framing bits but including FCS octets).

Table 11-199 AR_MXP, AR_XP, or AR_XPE Card Ethernet Variables (continued)
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etherStatsPkts512to1023Octets Total number of packets (including bad packets) received 
that were between 512 and 1023 octets in length inclusive 
(excluding framing bits but including FCS octets).

etherStatsPkts1024to1518Octets Total number of packets (including bad packets) received 
that were between 1024 and 1518 octets in length inclusive 
(excluding framing bits but including FCS octets).

etherStatsPkts1519toMaxSizeOctets Total number of packets (including bad packets) received 
that were between 1519 and the maximum frame size as 
programmed within the RMAC Max Frame Length 
Configuration Register in length inclusive (excluding 
framing bits but including FCS octets).

etherStatsBroadcastPkts Total number of good packets received that were directed 
to the broadcast address. Note that this does not include 
multicast packets.

etherStatsMulticastPkts Total number of good packets received that were directed 
to a multicast address. Note that this number does not 
include packets directed to the broadcast address.

etherStatsOversizePkts Total number of packets received that were longer than 
1518 octets (excluding framing bits, but including FCS 
octets) and were otherwise well-formed.

etherStatsOversizePkts Total number of packets received that were longer than 
1518 octets (excluding framing bits, but including FCS 
octets) and were otherwise well formed.

etherStatsJabbers Total number of packets received that were longer than 
1518 octets (excluding framing bits, but including FCS 
octets), and had either a bad FCS with an integral number 
of octets (FCS Error) or a bad FCS with a non-integral 
number of octets (Alignment Error).

etherStatsOctets Total number of octets of data (including those in bad 
packets) received on the network (excluding framing bits, 
but including FCS octets).

etherStatsPkts1519tomaxOctets Total number of packets (including bad packets) received 
that were 1591 octets in length (excluding framing bits, but 
including FCS octets).

mediaIndStatsTXShortPkts Number of transmitted frames containing less than the 
minimum permitted frame size as programmed with the 
transmit MAC Min Frame Length Configuration Register.

Table 11-200 AR_MXP, AR_XP, or AR_XPE FC/FICON Variables

Variable Description

rxTotalPkts Total number of received packets.

txTotalPkts Total number of transmitted packets.

Table 11-199 AR_MXP, AR_XP, or AR_XPE Card Ethernet Variables (continued)
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mediaIndStatsRxFramesBadCRC Number of received data frames with payload CRC errors 
when HDLC framing is used.

mediaIndStatsTxFramesBadCRC Number of transmitted data frames with payload CRC 
errors when HDLC framing is used.

mediaIndStatsRxLcvErrors Number of L1 line code violations received for lower rate 
FC, which equate to invalid 8b10b ordered sets.

mediaIndStatsTxLcvErrors Number of L1 line code violations transmitted for lower 
rate FC, which equate to invalid 8b10b ordered sets.

rx8b10bWords Number of 8B/10B words received.

tx8b10bWords Number of 8B/10B words transmitted.

Table 11-201 AR_MXP, AR_XP, and AR_XPE ISC Variables

Variable Description

mediaIndStatsRxLcvErrors Number of L1 line code violations received for constant bit 
rate protocols, which equate to invalid 8b10b ordered sets.

mediaIndStatsTxLcvErrors Number of L1 line code violations transmitted for constant 
bit rate protocols, which equate to invalid 8b10b ordered 
sets.

Table 11-202 AR_MXP, AR_XP, and AR_XPE GFP RMON Variables

Variable Description

gfpStatsRxCRCErrors Total number of CRC errors with the receive transparent 
GFP frame.

gfpStatsRxSblkCRCErrors Total number of superblock CRC errors with the receive 
transparent GFP frame. A transparent GFP frame has 
multiple superblocks which each contain fiber channel 
data. 

gfpStatsCSFRaised Number of Rx client management frames with Client 
Signal Fail indication.

gfpStatsLFDRaised Number of Core HEC CRC Multiple Bit Errors.

Note This count is only for cHEC multiple bit error 
when in frame. It is a count of when the state 
machine goes out of frame.

gfpStatscHecRxMBitErrors Number of received GFP frames with single bit errors in 
the core header (these errors are uncorrectable).

gfpStatstHecRxMBitErrors Number of received GFP frames with single bit errors in 
the tHec (these errors are uncorrectable).

Table 11-200 AR_MXP, AR_XP, or AR_XPE FC/FICON Variables (continued)

Variable Description
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
the falling threshold, or both the rising and falling thresholds.

The available options are Rising Threshold, Falling Threshold, and Both Rising and Falling Threshold

Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Enter the appropriate number of seconds in the Sample Period field.

Step 9 Enter the appropriate number of occurrences in the Rising Threshold field.

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Note To view all RMON thresholds, click Show All RMON thresholds. 

Step 12 Return to your originating procedure (NTP).

DLP-G702 Provision the AR_MXP, AR_XP, or AR_XPE Card with Trunk Port 
Alarm and TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to provision the trunk port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Purpose This task provisions the AR_MXP, AR_XP, or AR_XPE card with trunk 
port alarm and TCA thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 3 If TCA is not checked, check the TCA check box and then click Refresh. If it is checked, continue with 
Step 4.

Step 4 Verify if the trunk port (Port 9) TCA thresholds are set. Provision new thresholds as needed by 
double-clicking the threshold value you want to change, deleting it, entering a new value, and pressing 
Enter.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Verify if the trunk port (Port 9) Alarm thresholds are set. Provision new thresholds as needed by 
double-clicking the threshold value you want to change, deleting it, entering a new value, and pressing 
Enter.

Step 7 Click Apply. 

Step 8 Return to your originating procedure (NTP).

DLP-G703 Provision the AR_MXP, AR_XP, or AR_XPE Card Client Port Alarm 
and TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the client port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Referring to Table 11-133, verify the TCA thresholds for client ports (ports 1 through 8) for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface at the other end. 
Provision new thresholds as needed by double-clicking the threshold value you want to change, deleting 
it, entering a new value, and pressing Enter.

Purpose This task provisions the client port alarm and TCA thresholds for the 
AR_MXP, AR_XP, and AR_XPE cards.

Tools/Equipment None

Prerequisite Procedures DLP-G278 Provision the Optical Line Rate, page 11-175

DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Do not modify the Laser Bias parameters.

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note The hardware device that plugs into a AR_MXP, AR_XP, or AR_XPE card faceplate to provide 
a fiber interface to the card is called a Small Form-factor Pluggable (SFP or XFP). In CTC, SFPs 
and XFPs are called pluggable port modules (PPMs). SFPs/XFPs are hot-swappable I/O devices 
that plug into a port to link the port with the fiber-optic network. Multirate PPMs have 
provisionable port rates and payloads. For more information about SFPs and XFPs, see the 
“11.24 SFP, SFP+, XFP, CXP, and CFP Modules” section on page 11-163.

Table 11-203 AR_MXP, AR_XP, and AR_XPE Card Client Interfaces TCA Thresholds

PPM Port Rate
Pluggable Port Module 
(XFP)

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low

FC1G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –17 3 –16

FC2G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –15 3 –16

FICON1G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –17 3 –16

FICON2G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –17 3 –16

FC4G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –12 4 –15

FICON4G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –12 4 –15

FC8G ONS-XC-8G-MM
ONS-XC-8G-SM

0 –12 4 –15

FICON8G ONS-XC-8G-MM
ONS-XC-8G-SM

0 –12 4 –15

1GE ONS-SI-GE-SX
ONS-SI-GE-LX
ONS-SI-GE-ZX
ONS-SE-ZE-EL

FE ONS-SE-GE-BXU
ONS-SE-GE-BXD
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DLP-  G703 Provision the AR_MXP, AR_XP, or AR_XPE Card Client Port Alarm and TCA Thresholds
Step 4 Click Apply.

Step 5 Repeat Steps 3 and 4 to provision each additional client port.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Referring to Table 11-204, verify the client port (Ports 1 through 8) Alarm thresholds for RX Power 
High, RX Power Low, TX Power High, and TX Power Low based on the client interface that is 
provisioned. Provision new thresholds as needed by double-clicking the threshold value you want to 
change, deleting it, entering a new value, and hitting Enter.

ESCON ONS-SE-200-MM 

OC3/STM1 ONS-SC-155-EL
ONS-SI-155-SR-MM
ONS-SI-155-I1
ONS-SI-155-L1
ONS-SI-155-L2

OC12 ONS-SI-622-SR-MM

OC12/STM4 ONS-SI-622-I1
ONS-SI-622-L1
ONS-SI-622-L2

OC48/STM16 ONS-SI-2G-S1
ONS-SI-2G-L1
ONS-SI-2G-L2

OTU1 ONS-SI-2G-S1
ONS-SE-Z1
ONS-SI-2G-L2
ONS-SC-2G-xxxx

OTU2 ONS-XC-10G-96C

3G-SDI, 
HD-SDI, 
SD-SDI

ONS-SC-HD3GV-RX=

Table 11-204 AR_MXP, AR_XP, and AR_XPE Card Client Interface Alarm 

Thresholds

PPM Port 
Rate

Pluggable Port Module 
(XFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High

FC1G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –17 3 –16

FC2G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –15 3 –16

Table 11-203 AR_MXP, AR_XP, and AR_XPE Card Client Interfaces TCA Thresholds (continued)

PPM Port Rate
Pluggable Port Module 
(XFP)

TCA RX
Power High

TCA RX
Power Low

TCA TX
Power High

TCA TX
Power Low
11-501
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
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FICON1G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –17 3 –16

FICON2G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –17 3 –16

FC4G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –12 4 –15

FICON4G ONS-SE-4G-SM
ONS-SC-2G-XX.X
ONS-SC-4G-XX.X

0 –12 4 –15

FC8G ONS-XC-8G-MM
ONS-XC-8G-SM

0 –12 4 –15

FICON8G ONS-XC-8G-MM
ONS-XC-8G-SM

0 –12 4 –15

1GE ONS-SI-GE-SX
ONS-SI-GE-LX
ONS-SI-GE-ZX
ONS-SE-ZE-EL

FE ONS-SE-GE-BXU
ONS-SE-GE-BXD

ESCON ONS-SE-200-MM 

OC3/STM
1

ONS-SC-155-EL
ONS-SI-155-SR-MM
ONS-SI-155-I1
ONS-SI-155-L1
ONS-SI-155-L2

OC12 ONS-SI-622-SR-MM

OC12/ST
M4

ONS-SI-622-I1
ONS-SI-622-L1
ONS-SI-622-L2

OC48/ST
M16

ONS-SI-2G-S1
ONS-SI-2G-L1
ONS-SI-2G-L2

OTU1 ONS-SI-2G-S1
ONS-SE-Z1
ONS-SI-2G-L2
ONS-SC-2G-xxxx

3G-SDI, 
HD-SDI, 
SD-SDI

ONS-SC-HD3GV-RX=

Table 11-204 AR_MXP, AR_XP, and AR_XPE Card Client Interface Alarm 

Thresholds (continued)

PPM Port 
Rate

Pluggable Port Module 
(XFP)

Alarm RX
Power Low

Alarm RX
Power High

Alarm TX
Power Low

Alarm TX
Power High
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DLP-  G704 Change the AR_MXP, AR_XP, or AR_XPE Card OTN Settings
Step 8 Click Apply.

Step 9 Repeat Steps 7 and 8 to provision each additional client port. 

Step 10 Return to your originating procedure (NTP).

DLP-G704 Change the AR_MXP, AR_XP, or AR_XPE Card OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_MXP, AR_XP, 
or AR_XPE card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, 
G.709 Thresholds, FEC Thresholds, Trail Trace Identifier, or Proactive Protection Regen.

Step 3 Modify any of the settings described in Tables 11-205 through 11-209. 

Note You must modify Near End and Far End; 15 Min and 1 Day; and SM and PM independently. To 
do so, choose the appropriate radio button and click Refresh.

Table 11-205 describes the values on the Provisioning > OTN > OTN Lines tab.

Purpose This task changes the OTN settings for the AR_MXP, AR_XP, or AR_XPE 
cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-205 AR_MXP, AR_XP, and AR_XPE Card OTN Line Settings

Parameter Description Options

Port (Display only) Displays the port number. All client and trunk ports

G.709 OTN Sets the OTN lines according to 
ITU-T G.709.

Enabled by default

FEC Sets the OTN lines to forward error 
correction (FEC).

• Disable

• Standard

• Enhanced-I.4

• Enhanced-I.7

SF BER (Display only) Displays the signal fail bit 
error rate.

• 1E-5
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DLP-  G704 Change the AR_MXP, AR_XP, or AR_XPE Card OTN Settings
Table 11-206 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Asynch/Synch 
Mapping

Sets how the ODUk (client payload) is 
mapped to the optical channel (OTUk).

• Asynch mapping

• Synch mapping

OTU Mapping Sets the client payload mapping to the 
trunk

• ODU1e

• ODU2e

• CBR10G

• ODU1Mux

• ODU1

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a NE 
timing reference.

Checked or unchecked

SyncMsgIn Sets the EnableSync card parameter. 
Enables synchronization status messages 
(S1 byte), which allow the node to choose 
the best timing source.

Checked or unchecked

Admin SSM In Overrides the synchronization status 
message (SSM) and the synchronization 
traceability unknown (STU) value. If the 
node does not receive an SSM signal, it 
defaults to STU.

STU

Send 
DoNotUse

If checked, sends a DUS message on the 
S1 byte.

Checked or unchecked

ODU 
Transparency

Sets the ODU overhead byte 
configuration.

• Transparent Standard Use

• Cisco Extended Use

Proactive 
Protection 
Regen

Enables or disables the proactive 
protection regen mode.

• Enable

• Disable

Table 11-205 AR_MXP, AR_XP, and AR_XPE Card OTN Line Settings (continued)

Parameter Description Options
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Table 11-207 describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 11-208 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 11-206 AR_MXP, AR_XP, and AR_XPE ITU-T G.709 Threshold Settings

Parameter Description Options

Port1 

1. Latency for a 1G-FC payload without ITU-T G.709 is 4 microseconds, and with ITU-T G.709 is 40 microseconds. Latency 
for a 2G-FC payload without ITU-T G.709 is 2 microseconds, and with ITU-T G.709 is 20 microseconds. Consider these 
values when planning a FC network that is sensitive to latency.

(Display only) Displays the 
port number.

9 (Trunk)

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

Table 11-207 AR_MXP, AR_XP, and AR_XPE Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. 2

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 11-208 AR_MXP, AR_XP, and AR_XPE Card Trail Trace Identifier Settings

Parameter Description Options

Port (Display only) Displays the port number. 2

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual
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Table 11-209 describes the values on the Provisioning > OTN > Proactive Protection Regen tabs.

Note Proactive protection regen is supported only when the AR_MXP, AR_XP, or AR_XPE card is in 
high-rate REGEN card mode.

Transmit Displays the current transmit string or 
sets a new transmit string. Click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Disable FDI on 
TTIM

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Expected Displays the current expected string or 
sets a new expected string. Click the 
button on the right to change the display. 
Its title changes, based on the current 
display mode. Click Hex to change the 
display to hexadecimal (button changes to 
ASCII); click ASCII to change the 
display to ASCII (button changes to Hex).

String of trace string size

Received (Display only) Displays the current 
received string. You can click Refresh to 
manually refresh this display, or check 
the Auto-refresh every 5 sec check box to 
keep this panel updated.

String of trace string size

Auto-refresh If checked, automatically refreshes the 
display every 5 seconds.

Checked

Unchecked (default)

Table 11-208 AR_MXP, AR_XP, and AR_XPE Card Trail Trace Identifier Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Table 11-209 AR_MXP, AR_XP, and AR_XPE Card Proactive Protection Regen Settings

Parameter Description Options

Port (Display only) Displays the port number 
and name (optional).

—

Trigger 
threshold 

Sets the maximum BER threshold to 
trigger proactive protection.

• 1E-3

• 9E-4 to 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

Trigger 
window (ms)

Sets the duration for which BER is 
monitored before triggering the proactive 
protection. 

The trigger window value must be a 
multiple of:

• 10 ms for trigger thresholds between 
1E-3 and 6E-6 

• 100 ms for trigger threshold between 
5E-6 to 1E-7 

Trigger window must be less than or 
equal to 10000 ms.

Time in milliseconds.

Revert 
Threshold

Sets the revert threshold value of BER.

Note Revert Threshold settings must be 
less than the Trigger Threshold 
values.

• 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

• 9E-8 to 5E-8

Revert window 
(ms)

Sets the duration for which BER is 
monitored for settings that are less than 
the revert threshold value before which 
proactive protection provided to the 
router is removed.

Revert Window value must be at least 
2000ms and a multiple of:

• 10ms for a Revert Threshold of 1E-4 
to 6E-7

• 100ms for a Revert Threshold of 
5E-7 to 5E-8.

The revert window must be less than or 
equal to 10000ms.

Time in milliseconds.
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Step 5 Return to your originating procedure (NTP).

DLP-G734 View the Mapping of ODU Object with Client Port

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the AR_XPE card to view 
the ODU object mapping with the corresponding client port. The card view appears.

Step 2 Click the Provisioning > Card > ODU Interfaces tabs. Displays the parameters as described in 
Table 11-211. 

Step 3 Return to your originating procedure (NTP).

Purpose This procedure allows you to view the mapping of ODU object with the 
corresponding client port for the AR_XPE card.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-210 ODU Object and Client Port Mapping

Parameter Description

ODU Object Displays the ODUk(k=0) AID that is used to raise the ODU0 level alarms.

Trunk Port Number Displays the physical trunk port details that map to the virtual ODUk(k=0) port or object.

ODU1 Displays the ODU1 frame number within the ODU-2 frame, which has the corresponding 
ODUk(k=0) frame.

ODU0 Displays the ODU0 frame number within a ODU1 frame.

Client Port Number Displays the physical client port number that maps to the virtual ODUk(k=0) port or object.
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NTP-G235 Provision an Operating Mode on the 100G-LC-C, 
10x10G-LC, or CFP-LC Card

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC card where you want to provision an operating mode. The card view appears.

Step 2 Click the Provisioning > Card tabs.

Step 3 In the Card tab, click Create. The Operating Mode Configuration Creation window appears.

Step 4 Choose the configuration from the Card Configuration drop-down list. The card configuration options 
vary depending on the card. For more information about the card configurations, see Table 11-37. If the 
TXP-10G, RGN-10G, or LOW LATENCY mode was selected on the 10x10G-LC card, go to Step 6. If 
the FANOUT-10x10G mode was selected in the 10x10G-LC card, go to Step 7.

Step 5 Choose the slot number from the Peer Card drop-down list where the 100G-LC-C card is located. This 
field is enabled only if a peer card is required for the configuration. 

Step 6 Select the port pair in the Card Configuration Dialog area. The 10x10G-LC card supports a maximum 
of five TXP-10G modes, five RGN-10G modes, five LOW LATENCY modes or a combination of five 
TXP-10G, RGN-10G, and LOW LATENCY modes.

Step 7 Click Finish. The selected operating mode is provisioned on the 100G-LC-C, 10x10G-LC, or CFP-LC 
card.

Step 8 Complete the DLP-G726 Preprovisioning a Multirate PPM task.

Step 9 Complete the “DLP-G278 Provision the Optical Line Rate” task on page 11-175

Stop. You have completed this procedure.

Purpose This procedure enables you to provision an operating mode on the 
100G-LC-C, 10x10G-LC, or CFP-LC card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G236 Modify the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line 
Settings and PM Parameter Thresholds

Step 1 As needed, complete the “NTP-G103 Back Up the Database” procedure on page 24-2 to preserve the 
existing transmission settings.

Step 2 Perform any of the following tasks as needed:

• DLP-G714 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings, page 11-511

• DLP-G715 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Ethernet Settings, page 11-515

• DLP-G716 Change the 10x10G-LC Card SONET/SDH Settings, page 11-517

• DLP-G717 Change the 10x10G-LC Card Section Trace Settings, page 11-519

• DLP-G718 Change the 10x10G-LC Card SONET/SDH Line Thresholds, page 11-520

• DLP-G719 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line RMON Thresholds, 
page 11-522

• DLP-G720 Provision the 100G-LC-C Card with Trunk Port Alarm and TCA Thresholds, 
page 11-527

• DLP-G721 Provision the 100G-LC-C, 10x10G-LC, or CFP-LC Client Port Alarm and TCA 
Thresholds, page 11-528

• DLP-G722 Change the 100G-LC-C Card OTN Settings, page 11-529

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see the 
Alarm and TCA Monitoring and Management document.

Stop. You have completed this procedure.

Purpose This procedure changes the line and PM parameter threshold settings of the 
100G-LC-C, 10x10G-LC, or CFP-LC cards. 

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

• DLP-G723 Install PPM on a Line Card

• DLP-G726 Preprovisioning a Multirate PPM (if necessary)

• DLP-G278 Provision the Optical Line Rate, page 11-175 (if 
necessary)

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G714 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC card where you want to change the line settings.

Step 2 Click the Provisioning > Line > Ports tabs. Tabs and parameter selections vary according to pluggable 
port modules (PPM) provisioning.

Step 3 Modify any of the line settings in the Ports tab as described in Table 11-211. 

Purpose This task changes the line settings of the 100G-LC-C, 10x10G-LC, or 
CFP-LC cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-211 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings

Parameter Description Options

Port (Display only) Displays the port number. 1 through 10

Port Name Assigns a logical name for the specified 
port.

User-defined. Name can be up to 32 alphanumeric or special 
characters, or both. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
the Administrative and Service States 
document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall 
condition of the port. Service states appear 
in the format: Primary State-Primary State 
Qualifier, Secondary State. For more 
information about service states, see the 
Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled 
(ETSI)

• OOS-MA,MT (ANSI) or Locked-enabled,maintenance 
(ETSI)

• OOS-MA,LPBK&MT (ANSI) or 
Locked-enabled,loopback & maintenance (ETSI)
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ALS Mode Sets the automatic laser shutdown (ALS) 
function mode.

• Disabled (default)— ALS is off; the laser is not 
automatically shut down when traffic outage or loss of 
signal (LOS) occurs.

• Manual Restart— ALS is on; the laser automatically shuts 
down when traffic outage or LOS occurs. However, the 
laser must be manually restarted when conditions that 
caused the outage are resolved.

• Manual Restart for Test— Manually restarts the laser for 
testing.

AINS Soak Sets the automatic in-service (AINS) soak 
period. Double-click the time and use the 
up and down arrows to change settings.

• Duration of valid input signal, in hh.mm format, after 
which the card state changes to in-service (IS) 
automatically.

• 0 to 48 hours, 15-minute increments.

Reach Sets the optical reach distance of the client 
port.

• Autoprovision—The system automatically provisions the 
reach from the pluggable port module (PPM) reach value 
on the hardware.

Table 11-212 provides the reach distances for different 
payloads on the 10x10G-LC, 100G-LC-C, and CFP-LC cards.

Note The reach distances that appear in the drop-down list 
depend on the card.

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths:

– 850 nm through 1610 nm

OverClock

(100G-LC-C 
and 
10x10G-LC)

Enables or disables overclock mode. • OFF

• ON

Note When an OTU2 payload is provisioned on the 
10x10G-LC card in the TXP-10G or RGN-10G 
operating mode, the overclock parameter is 
automatically set to ON.

Cd low
(100G-LC-C)

(100G-LC-C cards only) Sets the threshold 
for minimum chromatic dispersion.

—

Cd high
(100G-LC-C)

(100G-LC-C cards only) Sets the threshold 
for maximum chromatic dispersion.

—

TX 
SHUTDOWN
(100G-LC-C)

If checked, the Tx optical power is turned 
off. This can be done when the port is out 
of service or in maintenance.

—

TX Power
(100G-LC-C)

Sets the Tx power to a specific value. The range is from -10.0 to 0.25 dBm.

Table 11-211 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings (continued)

Parameter Description Options
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DLP-  G714 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings
Squelch Shuts down the far-end laser in response to 
certain defects. (Squelch does not apply to 
ISC COMPACT payloads.)

•  AIS

• Squelch

Note When the 100G-LC-C card is used in the standalone 
mode or with the CFP-LC card configured in the 
CFP-TXP mode, the value can be set to Squelch or AIS 
on the trunk port of the 100G-LC-C card. When the 
100G-LC-C card is used with the CFP-LC card 
configured CFP-MXP mode, the value can be set to 
AIS on the trunk port of the 100G-LC-C card.

Mapping 
Mode 
(10x10G-LC)

Sets the mapping mode. • CBR

• GFP

Note The mapping mode can be configured to GFP for 
10GE payloads. The GFP port is placed in service 
when both the client and trunk ports of the 10x10G-LC 
card are in service.

Termination 
Mode

Sets the termination mode. • Transparent

Table 11-211 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings (continued)

Parameter Description Options
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DLP-  G714 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 11-212 Reach Distances for 10x10G-LC, 100G-LC-C, and CFP-LC Cards

Card Payload Reach 

10x10G-LC OTU2 SR-MM

P1I1-2D1

P1S1-2D2b

P1L1-2D2

DWDM

OC192 SR-MM

SR-1

IR-2

LR-2

DWDM

10G FC 10GFC-SW

10GFC-LW

10GFC-EW

10GFC-ZW

DWDM

8G FC 8GFC-SW

8GFC-LW

10 GE TEN_GE_SR

TEN_GE_LR

TEN_GE_ER

TEN_GE_ZR

DWDM

100G-LC-C 100 GE 100GBASE-SR10

CFP-LC 40 GE 40GBASE-FR

40GBASE-LR4

100 GE 100GBASE-LR4

OTU3 VSR2000-3R2

C4S1-2D1

OTU4 4I1-9D1F
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DLP-  G715 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Ethernet Settings
DLP-G715 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Ethernet Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC card where you want to change the Ethernet settings. The card view appears.

Step 2 Click the Provisioning > Line > Ethernet tabs.

Step 3 Modify any of the Ethernet settings in the Ethernet tab as described in Table 11-213. The parameters that 
appear depend on the card mode.

Purpose This task changes the Ethernet settings of the 100G-LC-C, 10x10G-LC, or 
CFP-LC cards. 

Note The ethernet settings of the CFP-LC card can be changed on the 
virtual port of the peer 100G-LC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-213 100G-LC-C or 10x10G-LC Card Ethernet Settings

Parameter Description Options

Port (Display only) Displays the port number (n-n) and rate. —

Port Name (Display only) Displays the port name. —

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see the Administrative and 
Service States document.

• IS (ANSI) or Unlocked (ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI)

• OOS,MT (ANSI) or Locked,maintenance 
(ETSI)

• IS,AINS (ANSI) or 
Unlocked,AutomaticInService (ETSI)

Service State (Display only) Identifies the autonomously generated 
state that gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information about 
service states, see the Administrative and Service States 
document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or 
Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

• OOS-MA,LPBK&MT (ANSI) or 
Locked-enabled,loopback & maintenance 
(ETSI)
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Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G715 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Ethernet Settings
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

ALS Mode Sets the automatic laser shutdown (ALS) function 
mode.

• Disabled (default)— ALS is off; the laser is 
not automatically shut down when traffic 
outage or loss of signal (LOS) occurs.

• Manual Restart— ALS is on; the laser 
automatically shuts down when traffic 
outage or LOS occurs. However, the laser 
must be manually restarted when conditions 
that caused the outage are resolved.

• Manual Restart for Test— Manually restarts 
the laser for testing.

AINS Soak Sets the automatic in-service (AINS) soak period. 
Double-click the time and use the up and down arrows 
to change settings.

• Duration of valid input signal, in hh.mm 
format, after which the card state changes to 
in-service (IS) automatically.

• 0 to 48 hours, 15-minute increments.

Reach Sets the optical reach distance of the client port. • Autoprovision—The system automatically 
provisions the reach from the pluggable port 
module (PPM) reach value on the hardware.

Note The reach distances that appear in the 
drop-down list depend on the card.

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

• Further wavelengths:

– 850 nm through 1610 nm

MTU Sets the maximum size of the Ethernet frames accepted 
by the port. The port must be in OOS/locked state.

Numeric. Default: 1548

Range 64 to 9700 

Incoming MAC 
address

Sets the MAC address of the incoming Ethernet signal. Value of the MAC address. Six bytes in 
hexadecimal format.

Mapping Mode

(10x10G-LC)

Sets the mapping mode. • CBR

Termination 
Mode

(Display-only) Sets the mode of operation. • Transparent

Video Type Video —

Table 11-213 100G-LC-C or 10x10G-LC Card Ethernet Settings (continued)

Parameter Description Options
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DLP-G716 Change the 10x10G-LC Card SONET/SDH Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 10x10G-LC card 
where you want to change the SONET (OC-192)/SDH (STM-64) settings.

Step 2 Click the Provisioning > Line > SONET (ANSI) or SDH (ETSI) tabs. Tabs and parameter selections 
vary according to PPM provisioning.

Step 3 Modify any of the settings as described in Table 11-214. 

Purpose This task changes the SONET (OC-192)/SDH (STM-64) settings of the 
10x10G-LC card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-214 10x10G-LC Card SONET/SDH Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Port Name Assign a name for the specified port. User-defined. Name can be up to 32 alphanumeric or 
special characters, or both. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

• IS (ANSI) or Unlocked (ETSI)

• IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI)

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)

• OOS,MT (ANSI) or Locked,maintenance (ETSI)

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information about 
service states, see the Administrative and Service 
States document.

• IS-NR (ANSI) or Unlocked-enabled (ETSI)

• OOS-AU,AINS (ANSI) or Unlocked-disabled,
automaticInService (ETSI)

• OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI)

• OOS-MA,MT (ANSI) or 
Locked-enabled,maintenance (ETSI)

SF BER Sets the signal fail (SF) bit error rate (BER). • 1E-3

• 1E-4 (default)

• 1E-5
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Chapter 11      Provision Transponder and Muxponder Cards
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SD BER Sets the signal degrade (SD) bit error rate (BER). • 1E-5

• 1E-6

• 1E-7 (default)

• 1E-8

• 1E-9

Type Sets the optical transport type. • SONET (ANSI)

• SDH (ETSI)

ALS Mode Sets the automatic laser shutdown (ALS) 
function mode. The DWDM transmitter supports 
ALS according to ITU-T G.644 (06/99). ALS can 
be disabled or enabled for one of the three mode 
options.

• Disabled (default)—ALS is off; the laser is not 
automatically shut down when traffic outage or loss 
of signal (LOS) occurs.

• Auto Restart—ALS is on; the laser automatically 
shuts down when traffic outage or LOS occurs. It 
automatically restarts when the conditions that 
caused the outage are resolved.

• Manual Restart—ALS is on; the laser automatically 
shuts down when traffic outage or LOS occurs. 
However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test—Manually restarts the laser 
for testing.

AINS Soak Sets the automatic in-service (AINS) soak 
period. Double-click the time and use the up and 
down arrows to change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card state changes to in-service (IS) 
automatically.

• 0 to 48 hours, 15-minute increments.

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a NE timing 
reference.

• Checked

• Unchecked

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), 
which allow the node to choose the best timing 
source.

• Checked

• Unchecked

Admin SSM In Overrides the synchronization status message 
(SSM) and the synchronization traceability 
unknown (STU) value. If the node does not 
receive an SSM signal, it defaults to STU.

STU

Reach Sets the optical reach distance of the client port. • Autoprovision—The system to automatically 
provision the reach from the pluggable port module 
(PPM) reach value on the hardware.

Note The reach distances that appear in the drop-down 
list depend on the card.

Wavelength Displays the wavelength of the client port. • First Tunable Wavelength

Table 11-214 10x10G-LC Card SONET/SDH Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G717 Change the 10x10G-LC Card Section Trace Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 10x10G-LC card 
where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tabs. Tabs and parameter selections vary according to 
PPM provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in Table 11-215. 

Purpose This task changes the section trace settings of the 10x10G-LC cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-215 10x10G-LC Card Line Section Trace Settings

Parameter Description Options

Port (Display only) Displays the port number. —

Received 
Trace Mode

Sets the received trace mode. • Off/None

• Manual

Disable 
AIS/RDI on 
TIM-S?

If a trace identifier mismatch (TIM) on a section overhead alarm 
arises because of a J0 overhead string mismatch, no alarm 
indication signal (AIS) is sent to the downstream nodes if this box 
is checked.

If the Received Trace Mode field is set to Manual, the Disable 
AIS/RDI on TIM-S? checkbox is automatically checked.

• Checked (AIS/RDI on TIM-S is 
disabled)

• Unchecked (AIS/RDI on TIM-S is 
not disabled)

Transmit 
Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string or sets a new transmit string.

Note The transmit string cannot be configured when the 
termination mode is transparent.

• Hex Mode— Click to change the 
display to hexadecimal (button 
changes to ASCII Mode).

• ASCII Mode— Click to change the 
display to ASCII (button changes to 
Hex Mode).

Note The button title changes based on 
the current display mode.
11-519
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G718 Change the 10x10G-LC Card SONET/SDH Line Thresholds
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G718 Change the 10x10G-LC Card SONET/SDH Line Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 10x10G-LC card 
where you want to change the SONET/SDH line threshold settings.

Step 2 Click the Provisioning > Line Thresholds > SONET Thresholds (ANSI) or SDH Thresholds (ETSI) 
tabs. 

Step 3 Modify any of the settings as shown in Table 11-216.

Expected Displays the current expected string or sets a new expected string. • Hex Mode— Click to change the 
display to hexadecimal (button 
changes to ASCII Mode).

• ASCII Mode— Click to change the 
display to ASCII (button changes to 
Hex Mode).

Note The button title changes based on 
the current display mode.

Received (Display only) Displays the current received string. • Hex Mode— Click to change the 
display to hexadecimal (button 
changes to ASCII Mode).

• ASCII Mode— Click to change the 
display to ASCII (button changes to 
Hex Mode).

Note The button title changes based on 
the current display mode.

Auto-refresh If checked, automatically refreshes the display every 5 seconds. • Checked

• Unchecked (default)

Purpose This task changes the SONET/SDH line threshold settings of the 
10x10G-LC card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-215 10x10G-LC Card Line Section Trace Settings (continued)

Parameter Description Options
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Note You must modify each of these options independently: Near End and Far End, 15 Min and 1 Day, 
and Line and Section. To do so, choose the appropriate radio button and click Refresh.

I
Table 11-216 10x10G-LC Card SONET/SDH Line Threshold Settings

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH

Port (Display only) 
Displays the port 
number.

• Client Ports • Client Ports

CV Coding violations 
(CV)

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

EB Errored Block (EB) — Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh.

ES Errored seconds (ES) Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

SES Severely errored 
seconds (SES)

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 
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DLP-  G719 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line RMON Thresholds
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G719 Change the 100G-LC-C, 10x10G-LC, or CFP-LC Card Line RMON 
Thresholds

FC (Line or Multiplex 
Section only) Failure 
count (FC)

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

—

BBE Background block 
error (BBE)

— Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh.

UAS (Line or Multiplex 
Section only) 
Unavailable seconds 
(UAS)

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Line or Section (near end 
only) 

Choose an option in each category and 
click Refresh. 

Numeric. Threshold display options 
include:

• Direction—Near End or Far End

• Interval—15 Min (minutes) or 1 day

• Types—Multiplex Section or 
Regeneration Section (near end only) 

Choose an option in each category and 
click Refresh. 

Purpose This task changes the line RMON threshold settings for 100G-LC-C, 
10x10G-LC, or CFP-LC cards carrying Ethernet or FC payloads.

Note The RMON threshold settings for the CFP-LC card can be changed 
on the virtual port of the peer 100G-LC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Table 11-216 10x10G-LC Card SONET/SDH Line Threshold Settings (continued)

Parameter Description Options - ONS 15454 Options - ONS 15454 SDH
11-522
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
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Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC card where you want to change the line RMON threshold settings in the card 
view.

Step 2 Click the Provisioning > Line Thresholds > RMON Thresholds tabs. 

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Port drop-down list, choose the applicable port, either the payload port, for example “1-1 
(ONEHUNDRED_GE)” port.

Step 5 From the Variable drop-down list, choose an Ethernet, FC, FICON, or GFP variable. See Table 11-217 
for a list of available Ethernet variables, Table 11-218 for a list of FC and FICON variables, and 
Table 11-219 for a list of GFP variables.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-217 100G-LC-C, 10x10G-LC, and CFP-LC Card Ethernet Variables

Variable Description

ifInOctets Number of bytes received since the last counter reset. 

rxTotalPkts Total number of received packets.

ifInUcastPkts1 Total number of packets delivered by this sublayer to a 
higher sublayer that are not addressed to a multicast or 
broadcast address.

ifInMulticastPkts1 Total number of packets delivered by this sublayer to a 
higher sublayer that are addressed to a multicast address. 
For a MAC layer protocol, this includes both group and 
functional addresses.

ifInBroadcastPkts1 Total number of packets delivered by this sublayer to a 
higher sublayer that are addressed to a broadcast address.

ifInErrors Total number of received errors.

ifOutOctets Total number of octets transmitted out of the interface, 
including framing characters.

txTotalPkts Total number of transmitted packets.

IfOutUcastPkts Total count of packets transmitted to a unicast group 
destination address.

ifOutMulticastPkts Total number of packets that higher-level protocols 
requested to be transmitted, which were addressed to a 
multicast address at this sublayer. These include packets 
that were discarded or not sent. For a MAC layer protocol, 
this includes both group and functional addresses.

ifOutBroadcastPkts Total number of packets that higher-level protocols 
requested to be transmitted, which were addressed to a 
broadcast address at this sublayer. These include packets 
that were discarded or not sent.
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dot3StatsAlignmentErrors Total number of frames received on a particular interface 
that are not an integral number of octets in length and do 
not pass the FCS check. This counter is only valid for FE 
modes of operation.

dot3StatsFCSErrors Total number of frames received on a particular interface 
that are an integral number of octets in length but do not 
pass the FCS check.

dot3StatsFrameTooLong Total number of frames received on a particular interface 
that exceed the maximum permitted frame size.

etherStatsUndersizePkts Total number of packets received that were less than 64 
octets long (excluding framing bits, but including FCS 
octets) and were otherwise well-formed.

etherStatsFragments Total number of packets received that were less than 64 
octets in length (excluding framing bits, but including FCS 
octets) and had either a bad FCS with an integral number 
of octets (FCS error) or a bad FCS with a non-integral 
number of octets (alignment error). Note that it is entirely 
normal for etherStatsFragments to increment. This is 
because it counts both runts (which are normal 
occurrences due to collisions) and noise hits.

etherStatsPkts Total number of frames received on an interface in both Rx 
and Tx directions.

etherStatsPkts64Octets Total number of packets (including bad packets) received 
that were 64 octets in length (excluding framing bits, but 
including FCS octets).

etherStatsPkts65to127Octets Total number of packets (including bad packets) received 
that were between 65 and 127 octets in length inclusive 
(excluding framing bits, but including FCS octets).

etherStatsPkts128to255Octets Total number of packets (including bad packets) received 
that were between 128 and 255 octets in length inclusive 
(excluding framing bits, but including FCS octets).

etherStatsPkts256to511Octets Total number of packets (including bad packets) received 
that were between 256 and 511 octets in length inclusive 
(excluding framing bits, but including FCS octets).

etherStatsPkts512to1023Octets Total number of packets (including bad packets) received 
that were between 512 and 1023 octets in length inclusive 
(excluding framing bits, but including FCS octets).

etherStatsPkts1024to1518Octets Total number of packets (including bad packets) received 
that were between 1024 and 1518 octets in length inclusive 
(excluding framing bits, but including FCS octets).

etherStatsBroadcastPkts Total number of good packets received that were directed 
to the broadcast address. Note that this number does not 
include multicast packets.

Table 11-217 100G-LC-C, 10x10G-LC, and CFP-LC Card Ethernet Variables (continued)
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etherStatsMulticastPkts Total number of good packets received that were directed 
to a multicast address. Note that this number does not 
include packets directed to the broadcast address.

etherStatsOversizePkts Total number of packets received that were longer than 
1518 octets (excluding framing bits, but including FCS 
octets) and were otherwise well-formed.

etherStatsJabbers Total number of packets received that were longer than 
1518 octets (excluding framing bits, but including FCS 
octets), and had either a bad FCS with an integral number 
of octets (FCS error) or a bad FCS with a non-integral 
number of octets (alignment error).

etherStatsOctets Total number of octets of data (including those in bad 
packets) received on the network (excluding framing bits, 
but including FCS octets).

etherStatsPkts1519tomaxOctets Total number of packets (including bad packets) received 
that were 1591 octets in length (excluding framing bits, but 
including FCS octets).

pcs49RxErrBer —

pcs49RxErrDec —

1. The counter does not increment for traffic with incorrect Ethertype and packet size of more than 64 bytes on the 10x10G-LC 
and 100G-LC-C cards.

Table 11-218 10x10G-LC FC/FICON Variables

Variable Description

rxTotalPkts Total number of received packets.

txTotalPkts Total number of transmitted packets.

mediaIndStatsRxFramesBadCRC Total number of received data frames with payload CRC 
errors when HDLC framing is used.

mediaIndStatsTxFramesBadCRC Total number of transmitted data frames with payload 
CRC errors when HDLC framing is used.

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes. 
This value is a part of the high-level data link control 
(HDLC) and GFP port statistics.

mediaIndStatsTxFramesTruncated Total number of transmitted data frames that exceed the 
MTU. This value is a part of the HDLC and GFP port 
statistics.

mediaIndStatsRxFramesTooLong Total number of received frames that exceed the maximum 
transmission unit (MTU). This value is a part of the HDLC 
and GFP port statistics.

Table 11-217 100G-LC-C, 10x10G-LC, and CFP-LC Card Ethernet Variables (continued)
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Step 6 From the Alarm Type drop-down list, indicate whether the event will be triggered by the rising threshold, 
falling threshold, or both the rising and falling thresholds.

The available options are Rising Threshold, Falling Threshold, and Both Rising and Falling Threshold

mediaIndStatsTxFramesTooLong Total number of transmitted data frames that are less than 
5 bytes. This value is a part of the HDLC and GFP port 
statistics.

ifInOctets Total number of octets received on the interface, including 
the framing octet.

ifOutOctets Total number of octets transmitted out of the interface, 
including framing characters.

ifInErrors Total number of inbound packets that contained errors 
preventing them from being delivered to a higher-layer 
protocol.

ifOutErrors Total number of outbound packets or transmission units 
that could not be transmitted because of errors.

pcs49RxErrBer —

pcs49RxErrDec —

Table 11-219 10x10G-LC GFP RMON Variables

Variable Description

gfpStatsRxFrame Total number of received data frames.

gfpStatsTxFrame Total number of transmitted data frames.

gfpStatsRxCRCErrors Total number of CRC errors with the receive transparent 
GFP frame.

gfpStatsRxOctets Total number of GFP data octets received.

gfpStatsTxOctets Total number of GFP data octets transmitted.

gfpStatsRxSBitErrors Received GFP frames with single bit errors in the core 
header (these errors can be corrected).

gfpStatsRxMBitErrors Received GFP frames with multiple bit errors in the core 
header (these errors cannot be corrected).

gfpStatsRxTypeInvalid Received GFP frames with invalid type (these are 
discarded). For example, receiving GFP frames that 
contain Ethernet data when we expect Fibre Channel data.

gfpRxCmfFrame —

gfpRxCmfFrame —

Table 11-218 10x10G-LC FC/FICON Variables (continued)

Variable Description
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Step 7 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 8 Enter the appropriate number of seconds in the Sample Period field.

Step 9 Enter the appropriate number of occurrences in the Rising Threshold field.

For a rising type of alarm, the measured value must move from below the falling threshold to above the 
rising threshold. For example, if a network is running below a rising threshold of 1000 collisions every 
15 seconds and a problem causes 1001 collisions in 15 seconds, the excess occurrences trigger an alarm. 

Step 10 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 seconds subsides and creates only 
799 collisions in 15 seconds, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15-second period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise, a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 11 Click OK.

Note To view all RMON thresholds, check the Show All RMON thresholds checkbox. 

Step 12 Return to your originating procedure (NTP).

DLP-G720 Provision the 100G-LC-C Card with Trunk Port Alarm and TCA 
Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C card 
where you want to provision the trunk port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Purpose This task provisions the 100G-LC-C card with trunk port alarm and TCA 
thresholds. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Do not modify the Laser Bias parameters.

Step 3 If TCA is not checked, check the TCA check box and then click Refresh. If it is checked, continue with 
Step 4.

Step 4 Verify if the trunk port (Port 2) TCA thresholds for RX Power High, RX Power Low, TX Power High, 
TX Power Low, OSNR Power High, OSNR Power low, PMD High, PMD Low are set. Provision new 
thresholds as needed by double-clicking the threshold value you want to change, deleting it, entering a 
new value, and pressing Enter.

Step 5 Under Types, click the Alarm radio button and click Refresh.

Note Do not modify the Laser Bias parameters.

Step 6 Verify if the trunk port (Port 2) Alarm thresholds for RX Power High, RX Power Low, TX Power High, 
TX Power Low are set. Provision new thresholds as needed by double-clicking the threshold value you 
want to change, deleting it, entering a new value, and pressing Enter.

Step 7 Click Apply. 

Step 8 Return to your originating procedure (NTP).

DLP-G721 Provision the 100G-LC-C, 10x10G-LC, or CFP-LC Client Port Alarm and 
TCA Thresholds

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C, 
10x10G-LC, or CFP-LC where you want to change the client port alarm and TCA threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. The TCA thresholds are shown by default.

Step 3 Verify if the TCA thresholds for client ports for RX Power High, RX Power Low, TX Power High, and 
TX Power Low parameters are set based on the client interface at the other end. Provision new thresholds 
as needed by double-clicking the threshold value you want to change, deleting it, entering a new value, 
and pressing Enter.

Note Do not modify the Laser Bias parameters.

Purpose This task provisions the client port alarm and TCA thresholds for the 
100G-LC-C, 10x10G-LC, or CFP-LC cards.

Tools/Equipment None

Prerequisite Procedures • DLP-G278 Provision the Optical Line Rate, page 11-175

• DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note You must modify 15 Min and 1 Day independently. To do so, choose the appropriate radio button 
and click Refresh.

Note The hardware device that plugs into a 100G-LC-C, 10x10G-LC, or CFP-LC card faceplate to 
provide a fiber interface to the card is called a Small Form-factor Pluggable (SFP, XFP, or CXP) 
or a C Form-factor Pluggable (CFP). In CTC, SFPs, XFPs, CXPs, and CFPs are called pluggable 
port modules (PPMs). SFPs/XFPs/CXPs/CFPs are hot-swappable I/O devices that plug into a 
port to link the port with the fiber-optic network. Multirate PPMs have provisionable port rates 
and payloads. For more information about SFPs, XFPs, CXPS, and CFPs, see the “11.24 SFP, 
SFP+, XFP, CXP, and CFP Modules” section on page 11-163.

Step 4 Click Apply.

Step 5 Repeat Steps 3 and 4 to provision each additional client port.

Step 6 Under Types, click the Alarm radio button and click Refresh.

Step 7 Verify if the client port Alarm thresholds for RX Power High, RX Power Low, TX Power High, and TX 
Power Low parameters are set based on the client interface that is provisioned. Provision new thresholds 
as needed by double-clicking the threshold value you want to change, deleting it, entering a new value, 
and hitting Enter.

Step 8 Click Apply.

Step 9 Repeat Steps 7 and 8 to provision each additional client port. 

Step 10 Return to your originating procedure (NTP).

DLP-G722 Change the 100G-LC-C Card OTN Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the 100G-LC-C card 
where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs, then choose one of the following subtabs: OTN Lines, ITU-T 
G.709 Thresholds, FEC Thresholds, Trail Trace Identifier, or Proactive Protection Regen.

Step 3 Modify any of the settings described in Tables Table 11-220 through Table 11-224. 

Note You must modify each of these options independently: Near End and Far End, 15 Min and 1 Day, 
and SM and PM. To do so, choose the appropriate radio button and click Refresh.

Purpose This task changes the OTN settings for the 100G-LC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
11-529
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G722 Change the 100G-LC-C Card OTN Settings
Table 11-220 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 11-220 100G-LC-C Card OTN Line Settings

Parameter Description Options

Port (Display only) Displays the port number. All client and trunk ports

ITU-T G.709 
OTN

Sets the OTN lines according to 
ITU-T G.709.

Enabled by default

FEC Sets the OTN lines to forward error 
correction (FEC).

• Client ports (OTU4 payload on 
100G-LC-C configured as 
TXP-100G):

– Disable

– Standard

– Enhanced

• Trunk ports:

– Standard

– 7% High Gain FEC

– 20% High Gain FEC

Note The 20% high gain FEC is not 
supported on the 
15454-M-100G-ME-C card.

SF BER (Display only) Displays the signal fail 
(SF) bit error rate (BER).

• 1E-5

SD BER Sets the signal degrade (SD) bit error rate 
(BER).

• 1E-5

• 1E-6

• 1E-7 (Default)

• 1E-8

• 1E-9

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a NE 
timing reference.

• Checked 

• Unchecked

SyncMsgIn Sets the EnableSync card parameter. 
Enables synchronization status messages 
(S1 byte), which allow the node to choose 
the best timing source.

• Checked 

• Unchecked

Admin SSM In Overrides the synchronization status 
message (SSM) and the synchronization 
traceability unknown (STU) value. If the 
node does not receive an SSM signal, it 
defaults to STU.

• STU—Sync traceability unknown

• ST2—Stratum 2

• ST3—Stratum 3

• SMC—SONET minimum clock

• ST4—Stratum 4

• DUS—Do not use for timing

• RES—Reserved; quality level set
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Table 11-221 describes the values on the Provisioning > OTN > ITU-T G.709 Thresholds tab.

Table 11-222 describes the values on the Provisioning > OTN > FEC Thresholds tab.

Table 11-223 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Table 11-221 100G-LC-C ITU-T G.709 Threshold Settings

Parameter Description Options

Port (Display only) Displays the 
port number.

2 (Trunk)

ES Errored seconds (ES) Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

SES Severely errored seconds 
(SES)

Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

UAS Unavailable seconds (UAS) Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

BBE Background block errors 
(BBE)

Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

FC Failure counter (FC) Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) or 
PM (ODUk). Select an option and click Refresh. 

Table 11-222 100G-LC-C and 10x10G-LC Card FEC Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number. 2

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 11-223 100G-LC-C Card Trail Trace Identifier Settings

Parameter Description Options

Port Displays the port number. 2 (Trunk)

Level Sets the level. • Section

• Path

Received Trace 
Mode

Sets the trace mode. • Off/None

• Manual
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Disable FDI on 
TTIM?

If a Trace Identifier Mismatch on Section 
overhead alarm arises because of a J0 
overhead string mismatch, no Forward 
Defect Indication (FDI) signal is sent to 
the downstream nodes if this box is 
checked.

This field is enabled only if the Received 
Trace Mode is set to Manual.

• Checked (FDI on TTIM is disabled)

• Unchecked (FDI on TTIM is not 
disabled)

Transmit Displays the current transmit string or 
sets a new transmit string. 

• Hex Mode—Click to change the 
display to hexadecimal (button 
changes to ASCII Mode).

• ASCII Mode—Click to change the 
display to ASCII (button changes to 
Hex Mode).

Note The button title changes based on 
the current display mode.

Expected Displays the current expected string or 
sets a new expected string.

• Hex Mode—Click to change the 
display to hexadecimal (button 
changes to ASCII Mode).

• ASCII Mode—Click to change the 
display to ASCII (button changes to 
Hex Mode).

Note The button title changes based on 
the current display mode.

Received (Display only) Displays the current 
received string. 

• Hex Mode—Click to change the 
display to hexadecimal (button 
changes to ASCII Mode).

• ASCII Mode—Click to change the 
display to ASCII (button changes to 
Hex Mode).

Note The button title changes based on 
the current display mode.

Auto-refresh If checked, automatically refreshes the 
display every 5 seconds.

• Checked

• Unchecked (default)

Table 11-223 100G-LC-C Card Trail Trace Identifier Settings (continued)

Parameter Description Options
11-532
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



Chapter 11      Provision Transponder and Muxponder Cards
DLP-  G722 Change the 100G-LC-C Card OTN Settings
Table 11-224 describes the values on the Provisioning > OTN > Proactive Protection Regen tabs.

Note The Proactive Protection Regen feature is supported only when the 100G-LC-C card is in the TXP-100G 
or the RGN-100G card mode.

Table 11-224 100G-LC-C Card Proactive Protection Regen Settings

Parameter Description Options

Port (Display only) Displays the port number 
and name (optional).

—

Trigger 
Threshold 

Sets the maximum BER threshold to 
trigger proactive protection.

• 1E-3

• 9E-4 to 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

Trigger 
Window (ms)

Sets the duration when BER is monitored 
before triggering the proactive protection. 

The trigger window value must be a 
multiple of:

• 10 ms for trigger thresholds between 
1E-3 and 6E-6 

• 100 ms for trigger threshold between 
5E-6 to 1E-7 

Trigger window must be less than or 
equal to 10000 ms.

Time in milliseconds.

Revert 
Threshold

Sets the revert threshold value of BER.

Note The revert threshold settings must 
be less than the trigger threshold 
values.

• 1E-4

• 9E-5 to 1E-5

• 9E-6 to 1E-6

• 9E-7 to 1E-7

• 9E-8 to 5E-8
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Revert 
Window (ms)

Sets the duration when BER is monitored 
for settings that are less than the revert 
threshold value before which proactive 
protection provided to the router is 
removed.

The revert window value must be at least 
2000 ms and a multiple of:

• 10 ms for a revert threshold of 1E-4 
to 6E-7

• 100 ms for a revert threshold of 5E-7 
to 5E-8.

The revert window must be less than or 
equal to 10000 ms.

Time in milliseconds.

Enable 
Proactive 
Protection

Enables proactive protection. • Checked

• Unchecked

Table 11-224 100G-LC-C Card Proactive Protection Regen Settings (continued)

Parameter Description Options
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Node Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) node types that 
are available for the ONS 15454. The DWDM node type is determined by the type of amplifier and filter 
cards that are installed in an ONS 15454. The chapter also explains the DWDM automatic power control 
(APC), reconfigurable optical add/drop multiplexing (ROADM) power equalization, span loss 
verification, and automatic node setup (ANS) functions.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note In this chapter, “OPT-BST” refers to the OPT-BST, OPT-BST-E, OPT-BST-L cards, and to the 
OPT-AMP-L and OPT-AMP-17-C cards when they are provisioned in OPT-LINE (optical booster) 
mode. “OPT-PRE” refers to the OPT-PRE card and to the OPT-AMP-L and OPT-AMP-17-C cards 
provisioned in OPT-PRE (preamplifier) mode.

Note In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to 
the 15454-M-RAMAN-COP card.

Note In this chapter, the “NFV view” refers to the “DWDM Network Functional View (NFV)”. The “GMPLS 
view” refers to the “DWDM Network Functional View (GMPLS)”.

Chapter topics include:

• 12.1 DWDM Node Configurations, page 12-2

• 12.2 Supported Node Configurations for OPT-RAMP-C and OPT-RAMP-CE Cards, page 12-40

• 12.3 Supported Node Configurations for PSM Card, page 12-45

• 12.4 Multishelf Node, page 12-49

• 12.6 Optical Sides, page 12-52

• 12.7 Configuring Mesh DWDM Networks, page 12-61

• 12.8 DWDM Node Cabling, page 12-82

• 12.9 Automatic Node Setup, page 12-98

• 12.10 DWDM Network Functional View, page 12-108
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12.1   DWDM Node Configurations
12.1 DWDM Node Configurations
The ONS 15454 supports the following DWDM node configurations: hub, terminal, optical add/drop 
multiplexing (OADM), reconfigurable OADM (ROADM), anti-amplified spontaneous emission 
(anti-ASE), line amplifier, optical service channel (OSC) regeneration line, multishelf nodes, and node 
configurations for mesh networks. All node configurations can be provisioned with C-band or L-band 
cards except the OADM and anti-ASE nodes. These nodes require AD-xB-xx.x or AD-xC-xx.x cards, 
which are C-band only. All node configurations can be single-shelf or multishelf.

Note The Cisco TransportPlanner tool creates a plan for amplifier placement and proper node equipment. 

Note To support multiple optical sides in mesh DWDM networks, east and west are no longer used to reference 
the left and right sides of the ONS 15454 shelf. If a network running a previous software release is 
upgraded to this release, west will be mapped to A and east to B. In two-sided nodes, such as a hub or 
ROADM node, Side A refers to Slots 1 through 6 and Side B refers to Slots 12 through 17. Terminal 
nodes have one side labeled “A,” regardless of which slots have cards installed. For more information 
about configuring the ONS 15454 in mesh DWDM networks, see the “12.7 Configuring Mesh DWDM 
Networks” section on page 12-61.

12.1.1 Terminal Node
A terminal node is a single ONS 15454 node equipped with two 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and one of the following combinations:

• One 32MUX-O card and one 32DMX-O card

• One 32WSS card and either a 32DMX or a 32DMX-O card

• One 40-WSS-C or 40-WSS-CE card and one 40-DMX-C or 40-DMX-CE card

• One 40-MUX-C and one 40-DMX-C or 40-DMX-CE card

• One 80-WXC-C card, one 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch 
panel, and one 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN 
(ONS 15216 40 or 48-channel mux/demux patch panel), and 15216-MD-ID-50 or 
15216-MD-48-CM

• One 40-SMR1-C and one 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch 
panel 

• One 40-SMR2-C and one 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch 
panel

Note Although it is recommended that you use the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panel along with the 40-SMR1-C and 40-SMR2-C cards, you can 
alternatively use the 40-MUX-C and 40-DMX-C cards instead of the 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panel.

Cards in the terminal nodes can be installed in Slots 1 through 6 or Slots 12 through 17. The side where 
cards are installed is always assigned as Side A. 
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12.1.1   Terminal Node
Figure 12-1 shows an example of a terminal configuration with a 2MUX-O card installed. The channel 
flow for a terminal node is the same as the hub node (Figure 12-31).

Figure 12-1 Terminal Node Configuration With 32MUX-O Cards Installed

Figure 12-2 shows an example of a terminal configuration with a 40-WSS-C card installed.
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12.1.1   Terminal Node
Figure 12-2 Terminal Node Configuration with 40-WSS-C Cards Installed

Figure 12-3 shows an example of a terminal configuration with a 40-MUX-C card installed.
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12.1.1   Terminal Node
Figure 12-3 Terminal Node with 40-MUX-C Cards Installed

Figure 12-4 shows an example of a terminal configuration with a 40-SMR1-C card installed.
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12.1.1   Terminal Node
Figure 12-4 Terminal Node with 40-SMR1-C Card Installed - Cisco ONS 15454 and Cisco ONS 15454 M6

Figure 12-5 shows an example of a terminal configuration with 40-SMR1-C and booster amplifier cards 
installed.
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12.1.1   Terminal Node
Figure 12-5 Terminal Node with 40-SMR1-C and Booster Amplifier Cards Installed - Cisco ONS 15454 and Cisco ONS 

15454 M6

Note When you use the 40-SMR1-C card along with a booster amplifier, the OSCM card must be connected 
to the booster amplifier.

Figure 12-6 shows an example of a terminal configuration with a 40-SMR2-C card installed.
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Figure 12-6 Terminal Node with 40-SMR2-C Card Installed - Cisco ONS 15454 and Cisco ONS 15454 M6

Figure 12-7 shows an example of a 80-channel terminal configuration with RAMAN-CTP and 
RAMAN-COP cards installed.
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Figure 12-7 80-Channel Terminal Node with RAMAN-CTP and RAMAN-COP Cards Installed - Cisco 

ONS 15454 M6

12.1.2 OADM Node
An OADM node is a single ONS 15454 node equipped with cards installed on both sides and at least one 
AD-xC-xx.x (or FLD-4-xx.x) card or one AD-xB-xx.x card (plus their related 4MD-xx.x cards) and two 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards. This configuration supports 32 channels. In an 
OADM node, channels can be added or dropped independently from each direction and then passed 
through the reflected bands of all OADMs in the DWDM node (called express path). They can also be 
passed through one OADM card to another OADM card without using a TDM ITU-T line card (called 
optical pass-through) if an external patchcord is installed. 

Unlike express path, an optical pass-through channel can be converted later to an add/drop channel in an 
altered ring without affecting another channel. OADM amplifier placement and required card placement 
is determined by the Cisco TransportPlanner tool or your site plan.

OADM nodes can be amplified or passive. In amplified OADMs, booster and preamplifier cards are 
installed on bode sides of the node. Figure 12-8 shows an example of an amplified OADM node 
configuration. In addition, OADM nodes can be asymmetric. Amplifiers may be installed in one side, 
but not the other. Or preamplifiers may be installed in one side, and a booster in the other.
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12.1.2   OADM Node
Figure 12-8 Amplified OADM Node Configuration Example

Figure 12-9 shows an example of the channel flow on the amplified OADM node. Since the 
32-wavelength plan is based on eight bands (each band contains four channels), optical adding and 
dropping can be performed at the band level and/or at the channel level (meaning individual channels 
can be dropped). 
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12.1.3   ROADM Node
Figure 12-9 Amplified OADM Node Channel Flow Example

Specifying the number of circuits that are currently present on an amplifier that is receiving the power 
directly from the15216-FLD-4 passive units (in case of an OADM node with FLD-4 cards and when an 
APC domain is in passive state) enables an accurate calculation of the power gain on the amplified port. 
This also ensures that the amplifier works effectively when the number of circuits is lesser than the actual 
circuits provisioned (where APC does not run in those domains. 

To provision the number of active circuits, in CTC go to the card view, click > Maintenance > 
Manual Gain Calc tabs and enter the number of circuits currently active and then click Apply. 
Changing the value forces the system to recalculate the gain in order to obtain a more suitable output 
power.

You can manually provision the number of active circuits only if one of the following conditions are 
satisfied:

• The amplified port that belongs to the APC domain is in passive state (an APC domain involving the 
OADM with 15216-FLD-4 passive modules and the APC is disabled).

• The APC in the active domain where the APC is temporarily disabled by an alarm.

12.1.3 ROADM Node
A ROADM node adds and drops wavelengths without changing the physical fiber connections. A 
ROADM node is equipped with two TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and one of the 
following combinations:

• Two 32WSS cards and either, two 32DMX or 32DMX-O cards
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• Two 40-WSS-C or 40-WSS-CE cards and either, two 40-DMX-C or 40-DMX-CE cards

• Two 40-SMR1-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD 
(ONS 15216 40 or 48-channel mux/demux) patch panels

• Two 40-SMR1-C cards, two line amplifiers (OPT-BST, OPT-BST-E, OPT-AMP-C, or 
OPT-AMP-17C cards), two OPT-RAMP-C or OPT-RAMP-CE cards, and two 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD patch panels

• Two 40-SMR2-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panels

• Two 80-WXC-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, 15216-MD-48-ODD, 
15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN patch panels

Note Although it is recommended that you use the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panel along with the 40-SMR1-C and 40-SMR2-C cards, you can 
alternatively use the 40-MUX-C and 40-DMX-C cards instead of the 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD patch panel.

Transponders (TXPs) and muxponders (MXPs) can be installed in Slots 6 and 12 and, if amplification is 
not used, in any open slot. 

Note Although not required, 32DMX-O can be used in a ROADM node. Cisco TransportPlanner automatically 
chooses the demultiplexer card that is best for the ROADM node based on the network requirements.

Figure 12-10 shows an example of an amplified ROADM node configuration with 32DMX cards 
installed.
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Figure 12-10 ROADM Node with 32DMX Cards Installed

Figure 12-11 shows an example of an amplified ROADM node configuration with 40-WSS-C cards 
installed.
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Figure 12-11 ROADM Node with 40-WSS-C Cards Installed

Figure 12-12 shows an example of a ROADM node with 40-SMR1-C cards installed.
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Figure 12-12 ROADM Node with 40-SMR1-C Cards Installed - Cisco ONS 15454 and Cisco ONS 15454 M6

Figure 12-13 shows an example of a ROADM node with 40-SMR1-C and booster amplifier cards 
installed.

24
89

90

ECU

1
2

3
4

5
6

7
8

Fan
tray

TNC/TSC

TNC/TSC

Power module Power module

Available

Available

Available

40-SMR1-C

LCD

Cisco ONS 15454 M6Cisco ONS 15454

40-SMR1-C

Available

Cable
guide

Air
filter

15216 Odd Patch Panel

15216 Odd Patch Panel

40-S
M

R
1-C

A
vailable

DCM-xxx

Air Ramp

DCM-xxx

T
C

C
2

A
vailable

A
vailable

A
vailable

A
vailable

A
vailable

A
vailable

40-S
M

R
1-C

A
vailable

O
S

C
M

O
S

C
M

T
C

C
2

A
IC

-I

M
S

-IS
C

M
S

-IS
C

15216 Odd Patch Panel

15216 Odd Patch Panel

Fan Tray

Fibre Routing Panel

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

1

1 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch panel
12-15
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.1.3   ROADM Node
Figure 12-13 ROADM Node with 40-SMR1-C and Booster Amplifier Cards Installed - Cisco ONS 15454 and Cisco ONS 

15454 M6

Note When you use the 40-SMR1-C card along with a booster amplifier, the OSCM card must be connected 
to the booster amplifier.

Figure 12-14 shows an example of a ROADM node with 40-SMR1-C and OPT-RAMP-C cards installed.
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Figure 12-14 ROADM Node with 40-SMR1-C and OPT-RAMP-C Cards Installed

Figure 12-15 shows an example of a ROADM node with 40-SMR2-C cards installed.
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Figure 12-15 ROADM Node with 40-SMR2-C Cards Installed - Cisco ONS 15454 and Cisco ONS 15454 M6

Figure 12-16 shows an example of a colored two-degree ROADM node using 80-WXC-C cards with 
booster and preamplifier cards. The 80-WXC-C cards are inserted in Slots 3 and 14, and function in the 
bidirectional mode.
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Figure 12-16 Colored Two-Degree ROADM Node with 80-WXC-C, Booster, and Preamplifier Cards

Figure 12-17 shows an example of an ONS 15454 M6 80-channel colored two-degree ROADM node.
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Figure 12-17 ONS 15454 M6 80-Channel Colored Two-degree ROADM Node

Figure 12-18 shows the layout of an 80-channel n-degree ROADM node with omni-directional side.
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Figure 12-18 80-Channel n-degree ROADM node with Omni-directional Side

Figure 12-19 shows the layout of an ONS 15454 M6 80-channel n-degree ROADM node with 
omni-directional side.
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Figure 12-19 ONS 15454 M6 80-Channel n-degree ROADM Node with Omni-directional Side

Figure 12-20 shows the layout of a 40-channel n-degree ROADM node with a 40-WXC-C based 
colorless side.

Figure 12-20 40-Channel n-degree ROADM Node with 40-WXC-C Based Colorless Side

The 80-WXC-C cards are connected to the ADD/DROP ports of the 40-WXC-C card and function as 
colorless multiplexer and demultiplexer units.
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Figure 12-21 shows the layout of a 40-channel four-degree ROADM node with a 40-SMR2-C based 
colorless side.

Figure 12-21 40-Channel Four-degree ROADM Node with 40-SMR2-C Based Colorless Side

The 80WXC-C (multiplexer) card is inserted in Slot 3 and the 80-WXC-C (demultiplexer) card is 
inserted in Slot 5. The 80-WXC-C cards are connected to the ADD/DROP ports of the 40-SMR2-C card 
and function as the colorless multiplexer and demultiplexer units.

Figure 12-22 shows the layout for an 80-channel colorless ROADM node.
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Figure 12-22 80-Channel Colorless ROADM Node

An 80 channel colorless two-degree ROADM node requires the following cards: 80-WXC-C, 
15216-MD-40-ODD, 15216-EF-40-ODD, 15216-MD-48-ODD, 15216-MD-40-EVEN, 
15216-EF-40-EVEN, 15216-MD-48-EVEN, preamplifiers, and boosters. 

The 80-WXC-C cards can be used at two levels; level1 (L1) and level2 (L2).

The L1 80WXC-C (multiplexer) card is inserted in Slot 3 and the L1 80-WXC-C (demultiplexer) card is 
inserted in Slot 5. The L2 80WXC-C (multiplexer) card is inserted in Slot 12 and the L2 80-WXC-C 
(demultiplexer) card is inserted in Slot 14.

Figure 12-23 shows an example of the optical signal flow in an 80-channel colorless two-degree 
ROADM node from Side A to Side B using 80-WXC-C cards. The optical signal flow from Side B to 
Side A follows an identical path.
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Figure 12-23 80-Channel Colorless Two-degree ROADM Node

Figure 12-24 shows the layout for an 80-channel colorless ROADM node with OPT-RAMP-C cards.

1 The booster on Side A receives the composite optical signal. It separates the optical service channel from the optical 
payload and sends the payload to the preamplifier on Side A. 

2 The preamplifier compensates for chromatic dispersion, amplifies the optical payload and sends it to the L1 80-WXC-C 
card (demultiplexer).

3 Up to eight colorless ports are available on the L1 80-WXC-C card if no colored wavelength is terminated. In 
Figure 12-23, two EAD ports are connected to 40-DMX-C or 40-DMX-CE cards, 15216-MD-40-ODD, 
15216-EF-40-ODD, 15216-MD-48-ODD, 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN units 
where the colored odd and even wavelengths are dropped. The express wavelengths are sent to the L1 80-WXC-C card 
(multiplexer) on Side B where the wavelengths are multiplexed with other colored or colorless wavelengths.

4 The L1-80-WXC-C card on Side B sends the composite signal to the booster on Side B.

5 The booster on Side B receives the composite optical signal, adds the optical service channel to the optical payload and 
sends it to the transmission line.

6 It is possible to configure more colorless ports by cascading the 80-WXC-C cards at two levels. For example, to get 14 
colorless ports connect one of the EAD ports of the L1 80-WXC-C card to another 80-WXC-C cards at level 2. There are 
five colorless ports on the L1 80-WXC-C card and nine colorless ports on the L2 80-WXC-C card. To achieve an 80 
channel colorless configuration, connect nine L2 80-WXC-C cards to the nine EAD ports of the L1 80-WXC-C card.
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Figure 12-24 80-Channel Colorless ROADM Node with OPT-RAMP-C Card

Figure 12-25 shows an example of an ONS 15454 M6 80-channel two degree colorless ROADM node.
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Figure 12-25 ONS 15454 M6 80-Channel Two-degree Colorless ROADM Node

The L1 80WXC-C (multiplexer) card is inserted in Slot 4 and the L1 80-WXC-C (demultiplexer) is 
inserted in Slot 6. The L2 80WXC-C (multiplexer) card is inserted in Slot 2 and the L2 80-WXC-C 
(demultiplexer) is inserted in Slot 4.

Figure 12-27 shows an example of a ROADM optical signal flow from Side A to Side B using the 32WSS 
or 40-WSS-C cards. The optical signal flow from Side B to Side A follows an identical path through the 
Side B OSC-CSM and 32WSS or 40-WSS-C cards. In this example, OSC-CSM cards are installed, hence 
OPT-BSTs are not needed.

Figure 12-26 shows an example of an ONS 15454 M6 80-channel ROADM node with RAMAN-CTP 
cards installed.
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Figure 12-26 Cisco ONS 15454 M6 80-Channel ROADM Node Using RAMAN-CTP Cards
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Figure 12-27 ROADM Optical Signal Flow Example Using 32WSS or 40-WSS-C Card

Figure 12-28 shows an example of an ROADM optical signal flow from Side A to Side B using the 
40-SMR1-C card. The optical signal flow from Side B to Side A follows an identical path through the 
Side B booster and 40-SMR1-C card.

1 The OSC-CSM receives the optical signal. It separates the optical service channel from the optical payload and sends the 
payload to the OPT-PRE module.

2 The OPT-PRE compensates for chromatic dispersion, amplifies the optical payload, and sends it to the 32WSS or 
40-WSS-C/40-WSS-CE.

3 The 32WSS or 40-WSS-C/40-WSS-CE splits the signal into two components. The 80 percent component is sent to the 
DROP-TX port and the 20 percent component is sent to the EXP-TX port. 

4 The drop component goes to the 32DMX card or 40-DMX-C/40-DMX-CE card where it is demultiplexed and dropped.

5 The express wavelength aggregate signal goes to the 32WSS or 40-WSS-C/40-WSS-CE on the other side where it is 
demultiplexed. Channels are stopped or forwarded based upon their switch states. Forwarded wavelengths are merged 
with those coming from the ADD path and sent to the OSC-CSM module.

6 The OSC-CSM combines the multiplexed payload with the OSC and sends the signal out the transmission line.
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Figure 12-28 ROADM Optical Signal Flow Example Using 40-SMR1-C Card

12.1.4 Hub Node
A hub node is a single ONS 15454 node equipped with two 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and one of the following combinations:

• Two 32MUX-O cards and two 32DMX-O or 32DMX cards

• Two 32WSS cards and two 32DMX or 32DMX-O cards

1 The booster receives the optical signal. It separates the optical service channel from the optical payload and sends the 
payload to the preamplifier module within the 40-SMR1-C card.

2 The preamplifier module compensates for chromatic dispersion, amplifies the optical payload, and sends it to the 70/30 
splitter within the 40-SMR1-C card.

3 The 70/30 splitter splits the signal into two components. The 70 percent component is sent to the DROP-TX port and the 
30 percent component is sent to the EXP-TX port. 

4 The drop component goes to the 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD unit where it is 
demultiplexed and dropped.

5 The express wavelength aggregate signal goes to the 40-SMR1-C card on the other side where it is demultiplexed. 
Channels are stopped or forwarded based upon their switch states. Forwarded wavelengths are merged with those coming 
from the ADD path and sent to the booster module.

6 The booster combines the multiplexed payload with the OSC, amplifies it, and sends the signal out the transmission line.
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• Two 40-WSS-C or 40-WSS-CE cards and two 40-DMX-C or 40DMX-CE cards

• Two 40-SMR1-C and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD 
(ONS 15216 40 or 48-channel mux/demux patch panel)

• Two 40-SMR2-C and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD

Note Although it is recommended that you use the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panel along with the 40-SMR1-C and 40-SMR2-C cards, you can 
alternatively use the 40-MUX-C and 40-DMX-C cards instead of the 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD patch panel.

Note The configuration for a hub node using 40-SMR1-C or 40-SMR2-C cards is identical to the 
ROADM node, except that there is no patchcord connecting the two 40-SMR1-C or 
40-SMR2-C cards. For more details on the ROADM node configuration, see the 
“12.1.3 ROADM Node” section on page 12-11.

Note The 32WSS/40-WSS-C/40-WSS-CE and 32DMX/32DMX-L/40-DMX-C/ 40-DMX-CE cards 
are normally installed in ROADM nodes, but they can also be installed in hub and terminal 
nodes. If the cards are installed in a hub node, the 32WSS/32WSS-L/ 40-WSS-C/40-WSS-CE 
express ports (EXP RX and EXP TX) are not cabled.

A dispersion compensation unit (DCU) can also be added, if necessary. Figure 12-29 shows a hub node 
configuration with 32MUX-O and 32DMX-O cards installed. 
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12.1.4   Hub Node
Figure 12-29 Hub Node Configuration Example with 32-Channel C-Band Cards

Figure 12-30 shows a 40-channel hub node configuration with 40-WSS-C cards installed.
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12.1.4   Hub Node
Figure 12-30 Hub Node Configuration Example with 40-WSS-C Cards

Figure 12-31 shows the channel flow for a hub node. Up to 32 channels from the client ports are 
multiplexed and equalized onto one fiber. Then, multiplexed channels are transmitted to the OPT-BST 
amplifier. The OPT-BST output is combined with an output signal from the OSCM card and transmitted 
to the other side.

Received signals are divided between the OSCM card and an OPT-PRE card. Dispersion compensation 
is applied to the signal received by the OPT-PRE amplifier, and it is then sent to the 32DMX-O card, 
which demultiplexes and attenuates the input signal. 
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12.1.5   Anti-ASE Node
Figure 12-31 Hub Node Channel Flow Example

12.1.5 Anti-ASE Node
In a mesh ring network, the ONS 15454 requires a node configuration that prevents ASE accumulation 
and lasing. An anti-ASE node can be created by configuring a hub node or an OADM node with some 
modifications. No channels can travel through the express path, but they can be demultiplexed and 
dropped at the channel level on one side and added and multiplexed on the other side. 

The hub node is the preferred node configuration when some channels are connected in pass-through 
mode. For rings that require a limited number of channels, combine AD-xB-xx.x and 4MD-xx.x cards, 
or cascade AD-xC-xx.x cards. See Figure 12-9 on page 12-11.

Figure 12-32 shows an anti-ASE node that uses all wavelengths in the pass-through mode. Use 
Cisco TransportPlanner to determine the best configuration for anti-ASE nodes.
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12.1.6   Line Amplifier Node
Figure 12-32 Anti-ASE Node Channel Flow Example

12.1.6 Line Amplifier Node
A line amplifier node is a single ONS 15454 node that is used to amplify the optical signal in long spans. 
The line amplifier node can be equipped with one of the following sets of cards:

• Two OPT-PRE cards, two OPT-BST cards, and two OSCM cards

• Two OPT-PRE cards and two OSC-CSM cards

• Two OPT-AMP-17-C cards and two OSCM cards

• Two OPT-AMP-C cards and two OSCM cards

Attenuators might also be required between each preamplifier and OPT-BST amplifier to match the 
optical input power value and to maintain the amplifier gain tilt value.

Two OSCM cards are connected to the OPT-BST cards to multiplex the OSC signal with the pass-though 
channels. If the node does not contain a booster card, OSC-CSM cards must be installed instead of 
OSCM cards. Figure 12-33 shows an example of a line amplifier node configuration using OPT-BST, 
OPT-PRE, and OSCM cards.
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12.1.6   Line Amplifier Node
Figure 12-33 Line Amplifier Node Configuration Example - Cisco ONS 15454 M6 and Cisco ONS 15454 M2

The line amplifier can be equipped with OPT-RAMP-C or OPT-RAMP-CE cards to achieve in fiber 
amplification. Figure 12-34 shows an example of a line amplifier node with Raman amplification using 
OPT-RAMP-C cards.

Figure 12-34 Line Amplifier Node with OPT-RAMP-C Cards

A node layout equipped with OPT-RAMP-C or OPT-RAMP-CE cards without post-amplifiers is used 
when post-amplification of the optical signal is not required. 

This layout is used in the following scenarios:

• The fiber is non-linear with high Raman gain (12.5 dB)

• The span length is 13 to 22 dB
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12.1.6   Line Amplifier Node
There are three node layouts without post-amplifiers:

1. Line amplifier node equipped with OPT-RAMP-C or OPT-RAMP-CE cards on Side A and Side B.

2. Line amplifier node equipped with OPT-RAMP-C or OPT-RAMP-CE and booster cards on Side A 
and OPT-RAMP-C or OPT-RAMP-CE cards on Side B and vice-versa.

3. Line amplifier node equipped with OPT-RAMP-C or OPT-RAMP-CE and booster cards on Side A 
and OSC-CSM cards on Side B and vice-versa.

Figure 12-35 shows an example of a line amplifier node with OPT-RAMP-C cards on Side A and Side B.

Figure 12-35 Line Amplifier Node with OPT-RAMP-C Cards on Sides A and B

Figure 12-36 shows an example of a line amplifier node with a standard Raman configuration 
(OPT-RAMP-C or OPT-RAMP-CE and booster cards) on Side A and a Raman only configuration 
(OPT-RAMP-C or OPT-RAMP-CE cards) on Side B.
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12.1.6   Line Amplifier Node
Figure 12-36 Line Amplifier Node with OPT-RAMP-C and Booster Cards (Side A) and OPT-RAMP-C Cards (Side B)

Figure 12-37 shows an example of a line amplifier node with a standard Raman configuration 
(OPT-RAMP-C or OPT-RAMP-CE and booster cards) on Side A and an OSC-CSM configuration on 
Side B.

Figure 12-37 Line Amplifier Node with OPT-RAMP-C and Booster Cards (Side A) and OSC-CSM Cards (Side B)
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12.1.7   OSC Regeneration Node
12.1.7 OSC Regeneration Node
The OSC regeneration node is added to the DWDM networks for two purposes: 

• To electrically regenerate the OSC channel whenever the span links are 37 dB or longer and payload 
amplification and add/drop capabilities are not present. Cisco TransportPlanner places an OSC 
regeneration node in spans longer than 37 dB. The span between the OSC regeneration node and the 
next DWDM network site cannot be longer than 31 dB. 

• To add data communications network (DCN) capability wherever needed within the network.

OSC regeneration nodes require two OSC-CSM cards, as shown in Figure 12-38. The cards are installed 
in each side of the shelf.

Figure 12-38 OSC Regeneration Line Node Configuration Example - Cisco ONS 15454, Cisco ONS 15454 M6, and Cisco 

ONS 15454 M2

Figure 12-39 shows the OSC regeneration line node signal flow. 
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12.2   Supported Node Configurations for OPT-RAMP-C and OPT-RAMP-CE Cards
Figure 12-39 OSC Regeneration Line Node Flow

12.2 Supported Node Configurations for OPT-RAMP-C and 
OPT-RAMP-CE Cards

The OPT-RAMP-C and OPT-RAMP-CE cards can be equipped in the following network element type 
configurations:

• C-band odd systems:

– C-band terminal site with 32-MUX-O and 32-DMX-O cards

– C-band hub node with 32-MUX-O and 32-DMX-O cards

– C-band fixed OADM node

– C-band line site

– C-band 32-channel reconfigurable OADM (ROADM)

– C-band terminal site using a 32-WSS and 32-DMX cards

– C-band flexible terminal site using AD-xC cards

– C-band hub node using a 32-WSS and 32-DMX cards

– C-band 40-channel ROADM

– C-band terminal site using a 40-WSS-C and 40-DMX-C cards

– C-band terminal site using 40-MUX-C and 40-DMX-C cards

– C-band hub node using a 40-WSS-C and 40-DMX-C cards

– C-band up to 4 degree mesh node

– C-band up to 8 degree mesh node

– C-band multiring/mesh with MMU node

– C-band 4 degree multiring/mesh node (MMU based)

• C-band odd and even systems:

– C-band 64-channel terminal site

– C-band 72-channel terminal site
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12.2.1   OPT-RAMP-C or OPT-RAMP-CE Card in an Add/Drop Node
– C-band 80-channel terminal site

– C-band 64-channel hub site

– C-band 72-channel hub site

– C-band 80-channel hub site

– C-band 64-channel ROADM site

– C-band 72-channel ROADM site

– C-band 80-channel ROADM site

The following amplifier cards are defined as booster or preamplifiers:

• Booster:

– OPT-BST

– OPT-BST-E

– OPT-AMP-17-C

– OPT-AMP-C

• Preamplifier:

– OPT-PRE

– OPT-AMP-C

– OPT-BST

– OPT-BST-E

Note When the booster is not needed, it must be replaced with an OSC-CSM card.

12.2.1 OPT-RAMP-C or OPT-RAMP-CE Card in an Add/Drop Node
When the OPT-RAMP-C or OPT-RAMP-CE card is equipped in an add/drop node, the booster amplifier 
is mandatory and cannot be replaced by an OSC-CSM card. The preamplifier is an OPT-BST, 
OPT-BST-E, or OPT-AMP-C card, and must be cabled as an unidirectional card. Note that the COM-TX 
and LINE-RX ports must not be used for any other connections. If a single module ROADM 
40-SMR-1-C is used as an add/drop card, a preamplifier is not required. If a single module ROADM 
40-SMR-2-C is used as an add/drop card, both the preamplifier and booster are not required.

Figure 12-40 shows the OPT-RAMP-C or OPT-RAMP-CE card in an add/drop node.
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12.2.2   OPT-RAMP-C or OPT-RAMP-CE Card in a Line Site Node with Booster Amplification
Figure 12-40 OPT-RAMP-C or OPT-RAMP-CE Card in an Add/Drop Node

When required, a DCN extension can be used on A/D Side (i) in Figure 12-40.

Side (i) in Figure 12-40 can be equipped with the following cards:

• WSS + DMX

• AD-xC

• 40-WXC-C or 80-WXC-C + MUX + DMX

• Single module ROADM

12.2.2 OPT-RAMP-C or OPT-RAMP-CE Card in a Line Site Node with Booster 
Amplification

The OPT-RAMP-C or OPT-RAMP-CE card can be equipped in a line site node with a booster amplifier 
in the following configurations:

• OPT-BST and OPT-BST-E can be used as booster in a line site node with OPT-RAMP-C or 
OPT-RAMP-CE. The booster cards need to be cabled as bidirectional units. Figure 12-41 shows the 
OPT-RAMP-C or OPT-RAMP-CE card in a line site configuration.

Figure 12-41 OPT-RAMP-C Card or OPT-RAMP-CE Card in a Line Site Configuration
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12.2.3   OPT-RAMP-C or OPT-RAMP-CE Card in a Line Site Node Without Post - Amplification
• The OPT-AMP-C can be used as a booster in a line site node with OPT-RAMP-C or OPT-RAMP-CE 
and needs to be cabled as a bidirectional unit. An additional DCU unit can be equipped between the 
OPT-AMP-C DC ports. Figure 12-42 shows a line site configured with OPT-AMP-C card and an 
additional DCU unit.

Figure 12-42 Line Site Configured with OPT-AMP-C

• A line site can be configured with OPT-RAMP-C or OPT-RAMP-CE card on one side only. 
Figure 12-43 shows the line site configured with OPT-RAMP-C or OPT-RAMP-CE on side A only. 
The booster is configured on side B.

Figure 12-43 Line Site with OPT-RAMP-C or OPT-RAMP-CE On One Side

In all configurations, the booster amplifier facing the OPT-RAMP-C or OPT-RAMP-CE card is 
mandatory for safety reasons.

12.2.3 OPT-RAMP-C or OPT-RAMP-CE Card in a Line Site Node Without Post - 
Amplification

The OPT-RAMP-C or OPT-RAMP-CE card can be equipped in a line site node in the following 
configurations:

• A symmetric Raman configuration without post-amplifiers with an OPT-RAMP-C or 
OPT-RAMP-CE card on Side A and Side B in a line site node (see Figure 12-44). In this 
configuration, the OPT-RAMP-C or OPT-RAMP-CE cards do not support DCU units.
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12.2.3   OPT-RAMP-C or OPT-RAMP-CE Card in a Line Site Node Without Post - Amplification
Figure 12-44 Symmetric Raman Configuration Without Post-Amplifiers

• An asymmetric configuration of a line site node where Side A is a standard Raman configuration 
equipped with OPT-RAMP-C or OPT-RAMP-CE and booster cards and Side B is a Raman 
configuration without post-amplifiers and is equipped with OPT-RAMP-C or OPT-RAMP-CE cards 
(see Figure 12-45). Side B does not support DCU units. 

Figure 12-45 Asymmetric Configuration With Standard Raman on Side A and Raman Without 

Post-Amplifier on Side B

• An asymmetric configuration of a line site node where Side A is a Raman configuration without 
post-amplifier equipped with OPT-RAMP-C or OPT-RAMP-CE cards (without DCU units) and Side 
B is configured with OSC-CSM cards (see Figure 12-46).
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12.3   Supported Node Configurations for PSM Card
Figure 12-46 Asymmetric configuration With One Side Configured as Raman Without 

Post-Amplifier

12.3 Supported Node Configurations for PSM Card
The PSM card supports the following node configurations:

• 12.3.1 Channel Protection

• 12.3.2 Multiplex Section Protection

• 12.3.3 Line Protection

• 12.3.4 Standalone

12.3.1 Channel Protection
In a channel protection configuration, the PSM card is used in conjunction with a TXP/MXP card. The 
PSM card in a channel protection configuration can be used in any site apart from a terminal site. 

Figure 12-47 shows the DWDM functional view of a PSM card in channel protection configuration.
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12.3.1   Channel Protection
Figure 12-47 PSM Channel Protection Configuration

In this configuration, the COM-RX and COM-TX ports of the PSM card are connected to the TXP/MXP 
trunk ports. This configuration is applicable to an n-degree MSTP node, for example, a two-degree 
ROADM, an n-degree ROADM, or an OADM node. The example block diagram shows a two-degree 
node with Side A and Side B as the two sides. The Side A and Side B fiber-stage block can be DWDM 
cards that are used to amplify transmitted or received signal (see the “12.6.1.1 Fiber Stage” section on 
page 12-53 for the list of cards). The Side A and Side B add/drop stage block can be DWDM cards that 
can add and drop traffic (see the “12.6.1.2 A/D Stage” section on page 12-55 for the list of cards).

In the transmit direction, the traffic originating from a TXP/MXP trunk port is split by the PSM card on 
to the W-TX and P-TX ports. The W-TX and P-TX ports are connected to the ADD-RX ports of the 
add/drop stage cards in Side A and Side B respectively. The add/drop stage cards multiplex traffic on 
Side A and Side B line ports that become the working and protect paths respectively. 

In the receive direction, the W-RX and P-RX ports of the PSM card are connected to the DROP-TX ports 
of the add/drop stage cards on Side A and Side B respectively. The add/drop stage cards demultiplex 
traffic received from Side A and Side B line ports that are the working and protect paths respectively. 
The PSM card selects one of the two input signals on the W-RX and P-RX ports to be transmitted to the 
COM-RX port of the PSM card.

Note All traffic multiplexed or demultiplexed by the two add/drop stage cards is not protected.
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12.3.2 Multiplex Section Protection
The PSM card performs multiplex section protection when connected between a 
multiplexer/demultiplexer card in a terminal site. The multiplexer/demultiplexer stage can be built using 
WSS and DMX or 40MUX and 40DMX cards. The terminal sites can be 50/100 Ghz band. The number 
of supported channels can therefore be 32/40 or 72/80.

Figure 12-48 shows the block diagram of a PSM card in multiplex section protection configuration.

Figure 12-48 PSM Multiplex Section Protection Configuration

In the transmit direction, the traffic originating from a TXP trunk port is multiplexed by the Side A 
multiplexer. The PSM card splits traffic on to the W-TX and P-TX ports, which are independently 
amplified by two separated booster amplifiers. 

In the receive direction, the signal on the line ports is preamplified by two separate preamplifiers and the 
PSM card selects one of the two input signals on the W-RX and P-RX ports to be transmitted to the 
COM-RX port of the PSM card. The received signal is then demultiplexed to a TXP card. 

The presence of a booster amplifier is not mandatory. However, if a DCN extension is used, the W-TX 
and P-TX ports of the PSM card can be connected directly to the line. The presence of a preamplifier is 
also not mandatory.

Note The PSM card cannot be used with Raman amplification in a line protection or section protection 
configuration.

12.3.3 Line Protection
In a line protection configuration, the working and protect ports of the PSM card are connected directly 
to the external line. This configuration is applicable to any MSTP node that is configured as a terminal 
site. The multiplexer/demultiplexer stage can be built using WSS and DMX, 40MUX and 40DMX, 
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40-SMR1-C and 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD, or 40-SMR2-C and 
15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD units. The terminal sites can be 
50/100 Ghz band. The number of supported channels can therefore be 32/40 or 72/80.

Figure 12-49 shows the block diagram of a PSM card in line protection configuration.

Figure 12-49 PSM Line Protection Configuration

In the transmit direction, the traffic originating from a transponder trunk port is multiplexed by the Side 
A multiplexer and amplified by a booster amplifier. The Line-TX port of the amplifier is connected to 
the COM-RX port of the PSM card. The PSM card splits traffic received on the COM-RX port on to the 
W-TX and P-TX ports, which form the working and protect paths.

In the receive direction, the PSM card selects one of the two input signals on the W-RX and P-RX ports 
to be transmitted to the COM-RX port of the PSM card. The received signal is then preamplified and 
demultiplexed to the TXP card.

The presence of a booster amplifier is not mandatory. However, if a DCN extension is used, the COM-RX 
port of the PSM card is connected to the multiplex section. The presence of a preamplifier is also not 
mandatory; the COM-TX port of the PSM card can be connected to the demultiplexer. 

Note The PSM card cannot be used with Raman amplification in a line protection or section protection 
configuration.

12.3.4 Standalone
In a standalone configuration, the PSM card can be equipped in any slot and supports all node 
configurations. In this configuration, the PSM card provides only basic functionality, such as, protection 
against a fiber cut, optical safety, and automatic laser shutdown (ALS). It does not provide other 
functionalities such as, automatic power control (APC), automatic node setup (ANS), network and node 
alarm correlation, circuit management, and so on.
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12.4 Multishelf Node
In a multishelf configuration, the ONS 15454 M6 node or the ONS 15454 DWDM node with TCC3 card 
as the node controller can manage up to 49 subtending shelves as a single entity. The subtending shelves 
can be ONS 15454 M6 or ONS 15454 DWDM nodes.

The node controller is the main shelf with the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards 
running the multishelf functions. Each subtending shelf must be equipped with 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, which run the shelf functions. For internal data 
exchange between the node controller shelf and subtending shelves, the node controller shelf must be 
equipped with redundant MS-ISC-100T cards, external connection unit (ECU), or external connection 
unit2 (ECU2) modules. As an alternative, the Catalyst 2950 or the Catalyst 3560 switch can be used for 
internal data exchange between the node controller shelf and subtending shelves. It is recommend that 
you use the MS-ISC-100T cards. If using the Catalyst 2950 or the Catalyst 3560 switch, it is installed 
on one of the multishelf racks. All subtending shelves must be located in the same site at a maximum 
distance of 100 meters or 328 feet from the Ethernet switches used to support the communication LAN.

Figure 12-50 shows an example of a multishelf node configuration. 
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Figure 12-50 Multishelf Node Configuration

A multishelf node has a single public IP address for all client interfaces (Cisco Transport Controller 
[CTC], Transaction Language One [TL1], Simple Network Management Protocol [SNMP], and HTTP); 
a client can only connect to the node controller shelf, not to the subtending shelves. The user interface 
and subtending shelves are connected to a patch panel using straight-through (CAT-5) LAN cables.

The node controller shelf has the following functions:

• IP packet routing and network topology discovery at the node controller level.

• Open Shortest Path First (OSPF) centralized on the node controller shelf.

The subtending shelves have the following functions:

• Overhead circuits are not routed within a multishelf node but are managed at the subtending 
controller shelf only. To use overhead bytes, the AIC-I must be installed on the subtending shelf 
where it is terminated.

• Each subtending shelf will act as a single shelf node that can be used as a timing source line, 
TCC/TCC2P/TCC3/TNC/TNCE/TSC/TSCE clock, or building integrated timing supply (BITS) 
source line.
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12.4.1 Multishelf Node Layout
Multishelf configurations are configured by Cisco TransportPlanner and are automatically discovered by 
the CTC software. In a typical multishelf installation, all optical units are equipped on the node 
controller shelf and TXP/MXP cards are equipped in the aggregated subtended shelves. In addition, all 
empty slots in the node controller shelf can be equipped with TXP/MXP cards. In a DWDM mesh 
network, up to eight optical sides can be configured with client and optical cards installed in different 
shelves to support mesh and ring-protected signal output.

Note When a DWDM ring or network has to be managed through a Telcordia operations support system 
(OSS), every node in the network must be set up as multi-shelf. OLA sites and nodes with one shelf must 
be set up as “multi-shelf stand-alone” to avoid the use of LAN switches.

12.4.2 DCC/GCC/OSC Terminations 
A multishelf node provides the same communication channels as a single-shelf node:

• OSC links terminate on OSCM/OSC-CSM cards. Two links are required between each ONS 15454 
node. An OSC link between two nodes cannot be substituted by an equivalent generic 
communications channel/data communications channel (GCC/DCC) link terminated on the same 
pair of nodes. OSC links are mandatory and they can be used to connect a node to a gateway network 
element (GNE). 

• GCC/DCC links terminate on TXP/MXP cards. 

The maximum number of DCC/GCC/OSC terminations that are supported in a multishelf node is 48.

Note Optical Service Channel can be created on the OC3 port of the TNC and TNCE cards.

12.5 Connecting Passive Modules to a ONS 15454 M2 or 
ONS 15454 M6 Node

The non-volatile flash memory of the passive optical modules store inventory and insertion loss (IL) data 
of the optical paths. The stored data can be retrieved through the USB port of the passive optical module 
by connecting it to the transport node controller card (TNC) of the Cisco ONS 15454 M2 or 
Cisco ONS 15454 M6 shelf assembly. 

You can connect the following passive modules to an USB port of the Cisco ONS 15454 M2 or 
Cisco ONS 15454 M6 node:

• 15216-FLD-4

• 15216-MD-40-EVEN

• 15216-EF-40-EVEN

• 15216-MD-48-EVEN

• 15216-MD-40-ODD

• 15216-EF-40-ODD

• 15216-MD-48-ODD
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• 15216-MD-ID-50

• 15216-MD-48-CM

• 15216-FBGDCU

For the related procedure, see NTP-G319 Connect a Passive Module to the Cisco ONS 15454 M2 or 
Cisco ONS 15454 M6 Node, page 12-125.

12.6 Optical Sides
From a topological point of view, all DWDM units equipped in an MSTP node belongs to a side. A side 
can be identified by a letter (A, B, C, D, E, F, G, or H), or by the ports (called as side line ports, see 
12.6.2 Side Line Ports, page 12-56) that are physically connected to the spans. An MSTP node can be 
connected to a maximum of 8 different spans. Each side identifies one of the spans the MSTP node is 
connected to.

Note Side A and Side B replace “west” and “east” when referring to the two sides of the ONS 15454 shelf. 
Side A refers to Slots 1 through 6 (formerly “west”), and Side B refers to Slots 12 through 17 (formerly 
“east”). The line direction port parameter, East-to-West and West-to-East, has been removed.

Sides are viewed and managed from the Provisioning > WDM-ANS > Optical Sides tab in CTC. 

12.6.1 Optical Side Stages
All MSTP nodes can be modelled according to Figure 12-51. 
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Figure 12-51 Interconnecting Sides Conceptual View

According to Figure 12-51, each MSTP node side includes DWDM units that can be conceptually 
divided into three stages.

• Fiber stage—The set of DWDM cards with ports that directly or indirectly face the span.

• A/D stage—The add/drop stage.

• TXP/MXP stage—The virtual grouping of all TXP or MXP cards with signals multiplexed or 
demultiplexed to and from the physical fiber stage.

12.6.1.1 Fiber Stage

The fiber stage includes DWDM cards that are used to amplify transmitted or received signals and cards 
that are used to add optical supervision channels. The fiber stage cards are:

• Booster amplifier cards that directly connect to the span, such as:

– OPT-BST

– OPT-BST-E

– OPT-BST-L

– OPT-AMP-C, when provisioned in OPT-LINE (booster amplifier) mode

– OPT-AMP-L, when provisioned in OPT-LINE (booster amplifier) mode

– OPT-AMP-17-C, when provisioned in OPT-LINE (booster amplifier) mode

• Preamplifier cards, such as:

– OPT-PRE

– OPT-AMP-C, when provisioned in OPT-PRE (preamplifier) mode
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– OPT-AMP-L, when provisioned in OPT-PRE (preamplifier) mode

– OPT-AMP-17-C, when provisioned in OPT-PRE (preamplifier) mode

• OSC cards, such as:

– OSCM

– OSC-CSM

• OPT-RAMP-C card

Table 12-1 shows the commonly deployed fiber stage layouts supported by DWDM mesh nodes. In the 
table, OPT-BST includes the OPT-BST, OPT-BST-E, and OPT-BST-L cards. OPT-AMP includes the 
OPT-AMP-L and OPT-AMP-17-C cards configured in either OPT-PRE or OPT-LINE mode.

Note In the table, L and C suffix is not reported because C-band and L-band amplifiers cannot be mixed in the 
same layout.

Table 12-1 Supported Fiber Stage Configurations

Layout Cards Configurations

A OPT-BST <-> OPT-PRE/OPT-AMP 
(OPT-PRE mode)

• OPT-BST OSC ports connected to OSCM OSC ports or 
OSC-CSM LINE ports

• OPT-BST LINE ports connected to the span

• OPT-BST COM-TX ports connected to OPT-AMP (OPT-PRE 
mode) or OPT-PRE COM-RX ports

• OPT-AMP (OPT-PRE mode) or OPT-PRE LINE-TX or 
COM-TX ports connected to the next stage (for example, a 
40-WSS-C/40-WSS-CE COM-RX port in a ROADM node)

• OPT-BST COM-RX ports connected to the next stage (for 
example, a 40-WSS-C/40-WSS-CE COM-TX port in a 
ROADM node) 

B OPT-AMP (OPT-BST mode) <-> 
OPT-PRE/OPT-AMP (OPT-PRE mode)

• OPT-AMP (BST) OSC ports connected to OSCM OSC ports or 
OSC-CSM LINE ports

• OPT-AMP (BST) LINE ports connected to the span

• OPT-AMP (BST) COM-TX ports connected to OPT-AMP 
(PRE)/OPT-PRE COM-RX ports

• OPT-AMP (PRE)/OPT-PRE LINE-TX/COM-TX port 
connected to the next stage (for example, a 
40-WSS-C/40-WSS-CE COM-RX port in a ROADM node)

• OPT-AMP (BST) COM-RX port connected to the next stage 
(for example, a 40-WSS-C/40-WSS-CE COM-TX port in a 
ROADM node) 
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12.6.1.2 A/D Stage

The A/D stage includes DWDM cards that can add and drop traffic. The A/D stage is divided into three 
node types:

• Mesh nodes—ONS 15454 nodes configured in multishelf mode can connect to eight different sides. 
For more detail on mesh node, see 12.7 Configuring Mesh DWDM Networks, page 12-61.

• Legacy—Half of a ROADM node or an OADM node with cascaded AD-xB-xx-x or AD-xC-xx.x 
cards

• Non-A/D—A line node or a side that does not have A/D capability is included in the A/D stage

Stages are built by active cards and patchcords. However, the interconnecting sides are completed by the 
mesh patch panels (four-degree patch panel or eight-degree patch panel) in mesh nodes, or by patchcords 
connected to EXP-RX/EXP-TX ports in legacy nodes.

C OSC-CSM <-> 
OPT-PRE/OPT-AMP(OPT-PRE mode)

• OSC-CSM LINE ports connected to the span

• OSC-CSM COM-TX ports connected to OPT-AMP COM-RX 
ports

• OPT-AMP(PRE)/OPT-PRE LINE-TX/COM-TX port 
connected to the next stage (for example, 
40-WSS-C/40-WSS-CE COM-RX ports in ROADM)

• OSC-CSM COM-RX port connected to the next stage (for 
example, a 40-WSS-C/40-WSS-CE COM-TX port in a 
ROADM node) 

D OPT-BST • OPT-BST OSC ports connected to OSCM OSC ports or 
OSC-CSM LINE ports

• OPT-BST LINE ports connected to the span

• OPT-BST COM ports connected to the next stage (for example, 
a 40-WSS-C/40-WSS-CE COM port in a ROADM node) 

E OPT-AMP (OPT-BST mode) • OPT-AMP OSC ports connected to OSCM OSC ports or 
OSC-CSM LINE ports

• OPT-AMP LINE ports connected to the span

• OPT-AMP COM ports connected to the next stage (for 
example, a 40-WSS-C/40-WSS-CE COM port in a ROADM 
node)

F OSC-CSM • OSC-CSM LINE ports connected to the span

• OSC-CSM COM ports connected to the next stage (for 
example, a 40-WSS-C/40-WSS-CE COM port in a ROADM 
node)

Table 12-1 Supported Fiber Stage Configurations (continued)

Layout Cards Configurations
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12.6.2 Side Line Ports
Side line ports are ports that are physically connected to the spans. Side line ports can be: 

• All ports terminating the fiber stage and physically labeled as LINE, such as ports on the following 
cards:

– Booster amplifier (OPT-BST, OPT-BST-E, or OPT-BST-L cards, and the OPT-AMP-C, 
OPT-AMP-L, or OPT-AMP-17-C cards when provisioned in OPT-LINE mode)

– OSC-CSM

– OPT-RAMP-C

• All ports that can be physically connected to the external span using DCN terminations, such as:

– Booster amplifier LINE-RX and LINE-TX ports 

– OSC-CSM LINE-RX and LINE-TX ports 

– 40-WXC-C COM-RX and COM-TX ports 

– MMU EXP-A-RX and EXP-A-TX ports 

• All ports that can be physically connected to the external span using DCN terminations in a line 
node, such as:

– Preamplifier (OPT-PRE card and the OPT-AMP-C, OPT-AMP-L, or OPT-AMP-17-C cards 
when provisioned in OPT-PRE mode) COM-RX and COM-TX ports

– Booster amplifier COM-TX port

– OSC-CSM COM-TX port

• All ports that can be physically connected to the external span using DCN terminations in a 
40-channel MUX/DMX terminal node, such as:

– 40-MUX-C COM-TX port

– 40-DMX-C COM-RX port

• All ports that can be physically connected to the external span when PSM cards implement line 
protection:

– PSM W-TX and W-RX ports

– PSM P-TX and P-RX ports

Note PSM card will support two sides A(w) and A(p).

12.6.3 Optical Side Configurations
You can use the following Side IDs depending on the type of node layout:

• In legacy nodes (that is, a node with no provisioned or installed 40-WXC-C cards), the permissible 
Side IDs are only A and B.

• In four-degree mesh nodes with four or less 40-WXC-C cards installed, the permissible Side IDs are 
A, B, C, and D. 

• In eight-degree mesh nodes with eight or less 40-WXC-C cards installed, the allowed Side IDs are 
A, B, C, D, E, F, G, and H. 
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The system automatically assigns Side IDs when you import the CTP XML configuration file into CTC. 
You can create a side manually using CTC or TL1 if the following conditions are met:

• You use a permissible side identifier, A through H.

• The shelf contains a TX and an RX side line port (see the “12.6.2 Side Line Ports” section on 
page 12-56).

• The side line ports are not connected to an internal patchcord.

Note We do not recommend that you manually create or modify ONS 15454 optical sides. 

The following tables show examples of how the system automatically assigns Side IDs for common 
DWDM layouts.

Table 12-2 shows a standard ROADM shelf with Sides A and B provisioned. The shelf is connected to 
seven shelves containing TXP, MXP, ADM-10G, GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards.

Table 12-3 shows a protected ROADM shelf. In this example, Side A and B are Slots 1 through 6 in 
Shelves 1 and 2. 40-WSS-C/40-WSS-CE/40-DMX-C or 40-WSS-CE/40-DMX-CE cards are installed in 
Sides A and B. Slots 12 through 17 in Shelves 1 and 2 contain TXP, MXP, ADM-10G, GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE cards.

Table 12-2 Multishelf ROADM Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WSS+DMX A WSS+DMX B

2 TXP/MXP — TXP/MXP —

3 TXP/MXP — TXP/MXP —

4 TXP/MXP — TXP/MXP —

5 TXP/MXP — TXP/MXP —

6 TXP/MXP — TXP/MXP —

7 TXP/MXP — TXP/MXP —

8 TXP/MXP — TXP/MXP —

Table 12-3 Multishelf Protected ROADM Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WSS+DMX A TXP/MXP —

2 WSS+DMX B TXP/MXP —

3 TXP/MXP n/a TXP/MXP —

4 TXP/MXP n/a TXP/MXP —

5 TXP/MXP n/a TXP/MXP —

6 TXP/MXP n/a TXP/MXP —

7 TXP/MXP n/a TXP/MXP —

8 TXP/MXP n/a TXP/MXP —
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Table 12-4 shows a four-degree mesh node. Side A is Shelf 1, Slots 1 through 6. Side B and C are Shelf 2, 
Slots 1 through 6 and 12 through 17, and Side D is Shelf 3, Slots 1 through 6. 40-WXC-C cards in line 
termination mode are installed in Sides A through D. 

Table 12-5 shows a protected four-degree mesh node example. In the example, Sides A through D are 
assigned to Slots 1 through 6 in Shelves 1 through 4. 

Table 12-6 shows a protected four-degree mesh node example. In the example, Sides A through D are 
assigned to Slots 1 through 4 in Shelves 1 through 4, and TXP, MXP, ADM-10G, GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE cards are installed in Shelves 1 through 4, Slots 12-17, and Shelves 5 through 
8, Slots 1 through 6 and 12 through 17.

Table 12-4 Multishelf Four-Degree Mesh Node Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC Line 
Termination

A TXP/MXP —

2 WXC Line 
Termination

B WXC Line 
Termination

C

3 WXC Line 
Termination

D TXP/MXP —

4 TXP/MXP n/a TXP/MXP —

5 TXP/MXP n/a TXP/MXP —

6 TXP/MXP n/a TXP/MXP —

7 TXP/MXP n/a TXP/MXP —

8 TXP/MXP n/a TXP/MXP —

Table 12-5 Multishelf Four-Degree Protected Mesh Node Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC Line 
Termination

A TXP/MXP —

2 WXC Line 
Termination

B TXP/MXP —

3 WXC Line 
Termination

C TXP/MXP —

4 WXC Line 
Termination

D TXP/MXP —

5 TXP/MXP — TXP/MXP —

6 TXP/MXP — TXP/MXP —

7 TXP/MXP — TXP/MXP —

8 TXP/MXP — TXP/MXP —
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Table 12-7 shows a four-degree mesh node provisioned as an upgrade. In the example, Sides A through 
D are assigned to Slots 1 through 4. and 12 through 17 in Shelves 1and 2. 40-WXC-C cards in XC 
termination mode are installed in Sides A and B, and 40-WXC-C cards in line termination mode are 
installed in Sides C and D.

Table 12-8 shows an eight-degree mesh node. In the example, Sides A through H are assigned to Slots 1 
through 6 in Shelf 1, Slots 1 through 6 and 12 through 17 in Shelves 2 through 4, and Slots 1 through 6 
in Shelf 5. 40-WXC-C cards in line termination mode are installed in Sides A through H.

Table 12-6 Multishelf Four-Degree Protected Mesh Node Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC Line 
Termination

A TXP/MXP —

2 WXC Line 
Termination

B TXP/MXP —

3 WXC Line 
Termination

C TXP/MXP —

4 WXC Line 
Termination

D TXP/MXP —

5 TXP/MXP — TXP/MXP —

6 TXP/MXP — TXP/MXP —

7 TXP/MXP — TXP/MXP —

8 TXP/MXP — TXP/MXP —

Table 12-7 Multishelf Four-Degree Mesh Node Upgrade Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC XC 
Termination

A WXC XC 
Termination

B

2 WXC Line 
Termination

C WXC Line 
Termination

D

3 TXP/MXP — TXP/MXP —

4 TXP/MXP — TXP/MXP —

5 TXP/MXP — TXP/MXP —

6 TXP/MXP — TXP/MXP —

7 TXP/MXP — TXP/MXP —

8 TXP/MXP — TXP/MXP —
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Table 12-9 shows another eight-degree mesh node. In the example, Sides A through H are assigned to 
Slots 1 through 6 in all shelves (Shelves 1 through 8). 40-WXC-C cards in line termination mode are 
installed in Sides A through H.

Table 12-10 shows a four-degree mesh node with a user-defined side. Because the software assigns sides 
consecutively, and because the mesh node is four-degrees, the side assigned to Shelf 5, Slots 1 through 6 
is “Unknown.” 

Table 12-8 Multishelf Eight-Degree Mesh Node Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC Line 
Termination

A TXP/MXP —

2 WXC Line 
Termination

B WXC Line 
Termination

C

3 WXC Line 
Termination

D WXC Line 
Termination

E

4 WXC Line 
Termination

F WXC Line 
Termination

G

5 WXC Line 
Termination

H TXP/MXP —

6 TXP/MXP — TXP/MXP —

7 TXP/MXP — TXP/MXP —

8 TXP/MXP — TXP/MXP —

Table 12-9 Multishelf Four-Degree Mesh Node Upgrade Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC Line 
Termination

A TXP/MXP —

2 WXC Line 
Termination

B TXP/MXP —

3 WXC Line 
Termination

C TXP/MXP —

4 WXC Line 
Termination

D TXP/MXP —

5 WXC Line 
Termination

E TXP/MXP —

6 WXC Line 
Termination

F TXP/MXP —

7 WXC Line 
Termination

G TXP/MXP —

8 WXC Line 
Termination

H TXP/MXP —
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12.7 Configuring Mesh DWDM Networks
ONS 15454 shelves can be configured in mesh DWDM networks using the 40-WXC-C or 80-WXC-C 
wavelength cross-connect cards and four-degree patch panel or eight-degree patch panels. Mesh DWDM 
networks can also be configured using the 40-SMR2-C cards and the four-degree patch panel.

ONS 15454 DWDM mesh configurations can be up to four degrees (four optical directions) when the 
four-degree patch panel is installed, and up to eight degrees (eight optical directions) when the 
eight-degree patch panel is installed. Two mesh node types are available, the line termination mesh node 
and the cross-connect (XC) termination mesh node.

Note Mesh nodes using the 40-WXC-C or 80-WXC-C card requires multishelf management.

12.7.1 Line Termination Mesh Node Using 40-WXC-C Cards
The line termination mesh node is installed in mesh networks. Line termination mesh nodes can support 
between one and eight line terminations. Each line direction requires the following cards: 40-WXC-C, 
40-MUX-C, 40-DMX-C or 40-DMX-CE, a preamplifier and a booster. Within this configuration, the 
following substitutions can be used:

• The 40-MUX-C cards can be replaced with 40-WSS-C/40-WSS-CE cards.

• The OPT-BST cards can be replaced with OPT-AMP-17-C (in OPT-BST mode) and/or OPT-BST-E 
cards. 

• The OPT-PRE can be replaced with an OPT-AMP-17-C (in OPT-LINE mode) card.

Each side of the line termination mesh node is connected as follows:

• The 40-WXC-C COM-RX port is connected to the preamplifier output port.

Table 12-10 Multishelf Four-Degree Mesh Node User-Defined Layout Example

Shelf Slots 1–6 Side Slots 12–17 Side

1 WXC Line 
Termination

A TXP/MXP —

2 TXP/MXP — WXC Line 
Termination

C1

1. User-defined

3 WXC Line 
Termination

D TXP/MXP —

4 TXP/MXP — TXP/MXP —

5 WXC Line 
Termination

U2

2. Unknown

TXP/MXP —

6 TXP/MXP — TXP/MXP —

7 TXP/MXP — TXP/MXP —

8 TXP/MXP — TXP/MXP —
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• The 40-WXC-C COM-TX port is connected to the booster amplifier COM-RX port.

• The 40-WXC-C DROP TX port is connected to the 40-DMX-C or 40-DMX-CE COM-RX port.

• The 40-WXC-C ADD-RX port is connected to the 40-MUX-C COM-TX port.

• The 40-WXC-C EXP-TX port is connected to the mesh patch panel.

• The 40-WXC-C EXP-RX port is connected to the mesh patch panel.

Figure 12-52 shows one shelf from a line termination node.

Figure 12-52 Line Termination Mesh Node Shelf

Figure 12-53 shows a functional block diagram of one line termination side using 40-WXC-C and 
40-MUX-C cards.
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12.7.1   Line Termination Mesh Node Using 40-WXC-C Cards
Figure 12-53 Line Termination Mesh Node Side—40-MUX-C Cards

Figure 12-54 shows a functional block diagram line termination side using 40-WXC-C and 40-WSS-C 
cards.
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12.7.1   Line Termination Mesh Node Using 40-WXC-C Cards
Figure 12-54 Line Termination Mesh Node Side—40-WSS-C Cards

Figure 12-55 shows a functional block diagram of a node that interconnects a ROADM with MMU cards 
with two native line termination mesh sides.
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Figure 12-55 Line Termination Mesh Nodes—ROADM With MMU Cards
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12.7.1.1 40-Channel Omni-directional n-degree ROADM Node

Any side in the line termination mesh node can be configured as an omni-directional side. The side that 
is configured as the omni-directional side is connected to a local multiplexer and demultiplexer that can 
add or drop traffic to or from any of the node directions. 

In Figure 12-56 side D is configured as the omni-directional side. Wavelengths from the local 
multiplexer on side D is routed to sides A, B, or C by the patch panel. Wavelengths from sides A, B, or 
C can be dropped on side D. The maximum number of omni-directional channels is 40.

Figure 12-56 40-Channel Omni-directional Four-Degree ROADM Node

12.7.1.2 40-Channel Colorless n-Degree ROADM Node

Any side in the line termination mesh node can be configured as a colorless side where any wavelength 
can be added or dropped. The side that is configured as the colorless side is connected to two 80-WXC-C 
cards configured as a multiplexer and demultiplexer respectively. In Figure 12-57 side D is configured 
as the colorless side. The 80-WXC-C cards are connected to the add and drop ports of the 40-WXC-C 
cards and function as a colorless multiplexer and demultiplexer.

A combination of wavelengths from any of the nine ports is sent to the common output port of the 
80-WXC-C card (multiplexer) that is connected to the 40-WXC-C card. The wavelengths entering the 
40-WXC-C card are sent to the common input port of the 80-WXC-C card (demultiplexer) and dropped 
at any of the nine output ports.
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12.7.1   Line Termination Mesh Node Using 40-WXC-C Cards
Figure 12-57 40-Channel Colorless Four-Degree ROADM Node

12.7.1.3 40-Channel Colorless and Omni-directional n-Degree ROADM Node

Any side in the line termination mesh node can be configured as a colorless and omni-directional side. 
The side that is configured as the colorless and omni-directional side is connected to a multiplexer 
(80-WXC-C) and demultiplexer (80-WXC-C) that can add or drop traffic to or from any of the node 
directions. 

Figure 12-58 shows the layout of a 40-channel n-degree ROADM node with colorless and 
omni-directional side.
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Figure 12-58 40-Channel n-Degree ROADM Node with Colorless and Omni-directional Side

In Figure 12-59 side D is configured as the colorless and omni-directional side. 

A combination of wavelengths from any of the nine ports is sent to the common output port of the 
80-WXC-C card (multiplexer) and then routed to the preamplifier. The preamplifier sends the 
wavelengths to the 40-WXC-C card that is connected to the patch panel. The patch panel routes the 
wavelengths to sides A, B, or C.

Wavelengths from sides A, B, or C are dropped on side D. The incoming wavelengths from the 
40-WXC-C card are sent to the preamplifier. The preamplifier amplifies the signal and sends it to the 
common input port of the 80-WXC-C card (demultiplexer). The wavelengths are then dropped at any of 
the nine output ports.
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12.7.2   Line Termination Mesh Node Using 80-WXC-C Cards
Figure 12-59 40-Channel Colorless and Omni-directional Four-Degree ROADM Node

12.7.2 Line Termination Mesh Node Using 80-WXC-C Cards
Line termination mesh nodes using 80-WXC-C cards can support between one and eight line 
terminations. Each line direction requires the following units: 80-WXC-C, 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD, and 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 
15216-MD-48-EVEN, 15216-MD-ID-50 or 15216-MD-48-CM, a preamplifier, and a booster. 

• The OPT-BST cards can be replaced with OPT-AMP-17-C (in OPT-BST mode) or OPT-BST-E 
cards.

• The OPT-PRE can be replaced with an OPT-AMP-17-C (in OPT-LINE mode) card.

 Each side of the line termination mesh node is connected as follows:

• The 80-WXC-C COM-RX port is connected to the preamplifier output port.

• The 80-WXC-C COM port is connected to the booster amplifier COM-RX port.

• The 80-WXC-C DROP TX port is connected to the COM-RX (ODD+EVEN-RX) port of 
15216-MD-ID-50 or 15216-MD-48-CM. The ODD-TX port of the 15216-MD-ID-50 or 
15216-MD-48-CM is connected to the COM-RX port of 15216-MD-40-ODD, 15216-EF-40-ODD, 
or 15216-MD-48-ODD; and the EVEN-TX port of the 15216-MD-ID-50 or 15216-MD-48-CM is 
connected to the COM-RX port of 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 
15216-MD-48-EVEN.

• The 80-WXC-C AD port is connected to the COM-TX (ODD+EVEN-TX) port of 15216-MD-ID-50 
or 15216-MD-48-CM. The ODD-RX port of the 15216-MD-ID-50 or 15216-MD-48-CM is 
connected to the COM-TX port of 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD; and the EVEN-RX port of the 15216-MD-ID-50 or 15216-MD-48-CM is 
connected to the COM-TX port of 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 
15216-MD-48-EVEN.
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• The 80-WXC-C EXP-TX port is connected to the mesh patch panel.

Figure 12-60 shows the layout for a line termination node.

Figure 12-60 Line Termination Node

Figure 12-61 shows the functional block diagram of a four-degree line termination mesh node using 
80-WXC-C, 15216-MD-40-ODD, 15216-EF-40-ODD, 15216-MD-48-ODD, 15216-MD-40-EVEN, 
15216-EF-40-EVEN, or 15216-MD-48-EVEN and a PP MESH-4. Wavelengths entering from side(i) can 
be routed to any of the other n-1 sides where n is defined by the PP MESH type.

24
88

81

B
ooster

P
ream

plifier

DCM-xxx

Air ramp

DCM-xxx

T
C

C
2P

A
vailable

A
vailable

P
ream

plifier

B
ooster

A
vailable

A
vailable

O
S

C
M

O
S

C
M

T
C

C
2P

A
IC

-I

80-W
X

C
-C

80-W
X

C
-C

Fiber routing panel

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Fan tray

15216 Odd Patch Panel

15216 Odd Patch Panel

15216 Even Patch Panel

15216 Even Patch Panel

PP-MESH-4

1

1

2

2

1 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN patch panel

2 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch panel
12-70
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.7.2   Line Termination Mesh Node Using 80-WXC-C Cards
Figure 12-61 Four-Degree Line Termination Mesh Node Functional Diagram

12.7.2.1 80-Channel Omni-directional n-degree ROADM Node

Any side in the line termination mesh node can be configured as a omni-directional side. The side that 
is configured as the omni-directional side is connected to a local multiplexer and demultiplexer that can 
add or drop traffic to or from any of the node directions. 

In Figure 12-62, side D is configured as the omni-directional side. Wavelengths from the local 
multiplexer on side D are routed to sides A, B, or C by the patch panel. Wavelengths from sides A, B, or 
C are dropped on side D.
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Figure 12-62 80-Channel Omni-directional Four-Degree ROADM Node

12.7.2.2 80-Channel Colorless n-degree ROADM Node

Any side in the line termination mesh node can be configured as a colorless side where any wavelength 
can be added or dropped. The side that is configured as the colorless side is connected to two 80-WXC-C 
cards configured as a multiplexer and demultiplexer respectively. In Figure 12-63, side D is configured 
as the colorless side. The 80-WXC-C cards are connected to the add and drop ports of the 80-WXC-C 
cards as a colorless multiplexer and demultiplexer.

A combination of wavelengths from any of the nine ports is sent to the common output port of the 
80-WXC-C card (multiplexer) that is connected to the 80-WXC-C card. The wavelengths entering the 
80-WXC-C card is passed to the common input port of the 80-WXC-C card (demultiplexer) and dropped 
at any of the nine output ports.
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Figure 12-63 80-Channel Colorless Four-Degree ROADM Node 

12.7.2.3 80-Channel Colorless and Omni-directional n-Degree ROADM Node

Any side in the line termination mesh node can be configured as a colorless and omni-directional side. 
The side that is configured as the colorless and omni-directional side is connected to a multiplexer 
(80-WXC-C) and demultiplexer (80-WXC-C) that can add or drop traffic to or from any of the node 
directions. 

Figure 12-64 shows the layout of a 80-channel n-degree ROADM node with colorless and 
omnidirectional side.
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Figure 12-64 80-Channel n-degree ROADM Node with Colorless and Omnidirectional Side

In Figure 12-65 side D is configured as the colorless and omni-directional side. 

A combination of wavelengths from any of the nine ports is sent to the common output port of the 
80-WXC-C card (multiplexer) and is then routed to the preamplifier. The preamplifier sends the 
wavelengths to the 80-WXC-C card that is connected to the patch panel. The patch panel routes the 
wavelengths to sides A, B, or C.

Wavelengths from sides A, B, or C can be dropped on side D. The incoming wavelengths from the 
80-WXC-C card are sent to the preamplifier. The preamplifier amplifies the signal and sends it to the 
common input port of the 80-WXC-C card (demultiplexer). The wavelengths are then dropped at any of 
the nine output ports. 
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Figure 12-65 80-Channel Colorless and Omni-directional Four-Degree ROADM Node

12.7.3 Line Termination Mesh Node Using 40-SMR2-C Cards
Line termination mesh nodes using the 40-SMR2-C cards can support between one and four line 
terminations. Each line direction requires the 40-SMR2-C and 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD units. Although it is recommended that you use the 
15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch panel along with the 
40-SMR2-C card, you can alternatively use the 40-MUX-C and 40-DMX-C cards instead of the 
15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch panel.

Each side of the line termination mesh node is connected as follows:

• The 40-SMR2-C LINE-RX port is connected to the external line.

• The 40-SMR2-C LINE-TX port is connected to the external line.

• The 40-SMR2-C DROP TX port is connected to the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD (or 40-DMX-C) COM-RX port.

• The 40-SMR2-C ADD-RX port is connected to the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD (or 40-MUX-C) COM-TX port.

• The 40-SMR2-C EXP-TX port is connected to the mesh patch panel.

• The 40-SMR2-C EXPi-RX (where i = 1, 2, 3) port is connected to the mesh patch panel.

Figure 12-66 shows the layout for a line termination node.
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Figure 12-66 Line Termination Mesh Node Shelf

Figure 12-67 shows the functional block diagram of a four-degree line termination mesh node using 
40-SMR2-C, 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD, and 15454-PP-4-SMR 
patch panel.
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12.7.4   XC Termination Mesh Node
Figure 12-67 Four-Degree Line Termination Mesh Node Functional Diagram

12.7.4 XC Termination Mesh Node
The XC termination mesh node, shown in Figure 12-68, is the second mesh node type. It is used to 
upgrade a non-mesh node to a mesh node or to interconnect two non-mesh nodes. The XC termination 
mesh nodes contain the following cards:

• 40-WXC-C cards

• OPT-AMP-17-C cards configured in OPT-PRE mode

The XC termination mesh node is connected as follows:

• The 40-WXC-C COM-RX port is connected to the MMU EXP-A-TX port. 

• The 40-WXC-C COM-TX port is connected to the MMU EXP-A-RX port. 

• The 40-WXC-C EXP-TX port is connected to the OPT-AMP-17-C COM-RX port.

• The 40-WXC-C EXP-RX port is connected to the OPT-AMP-17-C COM-TX port.

• The 40-WXC-C EXP-TX port is connected to the mesh patch panel.

• The 40-WXC-C EXP-RX port is connected to the mesh patch panel.

27
64

61

40-SMR2-C

40-SMR2-C

40-SMR2-C

40-SMR2-C

15454-PP-4-SMR 

MUX

DDMUX

DCU

MUX

MUX

DCU

MUX

DDMUX

DCU

MUX

MUX

DCU

3

4

1

2

12-77
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.7.5   Mesh Patch Panels and Shelf Layouts
Figure 12-68 XC Termination Mesh Node Shelf

12.7.5 Mesh Patch Panels and Shelf Layouts
ONS 15454 mesh topologies require the installation of a four-degree patch panel, PP-MESH-4 (for 
40-WXC-C cards) or 15454-PP-4-SMR (for 40-SMR2-C cards) or an eight-degree patch panel, 
PP-MESH-8 (for 40-WXC-C cards). If the four-degree patch panel is installed, mesh topologies of up to 
four degrees can be created. If the eight-degree patch panel is installed, mesh topologies of up to eight 
degrees can be created. The four-degree patch panel contains four 1x4 optical splitters, and the 
eight-degree patch panel contains eight 1x8 splitters. Each mesh patch panel contains a 2x8 splitter that 
is used for the test access transmit and receive ports. Figure 12-69 shows a block diagram for the 
PP-MESH-4 patch panel.
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12.7.5   Mesh Patch Panels and Shelf Layouts
Figure 12-69 PP-MESH-4 Patch Panel Block Diagram

At the mesh patch panel, the signal is split into four signals (if a four-degree patch panel is used) or eight 
signals (if an eight-degree patch panel is used). Figure 12-70 shows the signal flow at the four-degree 
PP-MESH-4 patch panel. 40-WXC-C cards connect to the four-degree patch panel at the EXP TX and 
COM RX ports.

Figure 12-70 PP-MESH-4 Patch Panel Signal Flow
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12.7.5   Mesh Patch Panels and Shelf Layouts
The mesh patch panels interconnect 40-WXC-C cards to create mesh networks, including four-degree 
and eight-degree mesh topologies. In addition, shelves with 40-WXC-C cards can be configured with 
mesh patch panels to create multiring, MMU-based mesh nodes. 40-WXC-C cards can be installed in 
ROADM nodes with MMU cards to upgrade a two-degree MMU-based ROADM node into four-degree 
or eight-degree mesh nodes. 

Figure 12-71 shows the block diagram of the four-degree 15454-PP-4-SMR patch panel connected to 
one 40-SMR2-C card. The 40-SMR2-C cards connect to the 15454-PP-4-SMR patch panel at the EXP 
RX ports.

Figure 12-71 15454-PP-4-SMR Patch Panel Block Diagram

You can use the 15454-PP-4-SMR patch panel to connect up to four 40-SMR2-C cards in a four-degree 
mesh node. The optical splitters inside the patch panel forward the output signal (EXP-TX port) of the 
40-SMR2-C card on each side of the mesh node to the input port of the 40-SMR2-C cards on the other 
three sides of the mesh node. The 4x1 WXC block inside the 40-SMR2-C card selects which wavelength 
from which side must be propagated at the output of each side. Figure 12-70 shows the signal flow at the 
four-degree 15454-PP-4-SMR patch panel. 40-SMR2-C cards connect to the four-degree patch panel at 
the EXP-TX and EXP-RX ports.
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12.7.6   Using a Mesh Node With Omni-Directional Add/Drop Section
Figure 12-72 15454-PP-4-SMR Patch Panel Signal Flow

12.7.6 Using a Mesh Node With Omni-Directional Add/Drop Section
Normally, multidegree mesh node use four or eight 40-WXC-C cards and a four-degree or eight-degree 
patch panel. Each of the 40-WXC-C cards uses a 40-MUX-C card to add wavelengths going to the span 
and a 40-DMX-C card to drop wavelengths coming in from the span. The 40-MUX-C and 40-DMX-C 
cards are connected to only one of the node directions. These cards can add/drop traffic only to/from the 
side that is associated to the 40-WXC-C card. The omni-directional configuration allows you to install 
a local multiplexer/demultiplexer that can add/drop traffic to/from any of the node directions. 
Figure 12-73 shows an example of how to set up a omni-directional add/drop configuration.

By setting up a NE as shown in the figure, it is possible to connect the transmit ports of TXP or MXP 
cards to a 40-MUX-C card and then connect the output of the 40-MUX-C card to an OPT-BST card. The 
OPT-BST card then connects to a preferred 40-WXC-C card in the four-degree or eight-degree ROADM 
node (40-WXC-C connected to port 4 of PP-MESH-4, as shown in the figure).

The patch panel splits the traffic coming from the OPT-BST card in all the node directions, through the 
software configuration. The wavelengths entering the 40-WXC-C cards (ports 1, 2, and 3) can be 
selectively sent out in any desired outbound direction. In the inbound direction, the patch panel on the 
preferred 40-WXC-C card, splits any of the wavelengths entering the NE through the 40-WXC-C cards 
(ports 1, 2, and 3). Through the software configuration, the wavelength can be passed to an OPT-PRE 
card or stopped. This whole configuration can be managed using a single IP address

An example of using a mesh node for omni-directional add/drop section is shown in Figure 12-73.
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12.8   DWDM Node Cabling
Figure 12-73 Mesh Node With Omni-Directional Add/Drop Section

12.8 DWDM Node Cabling
DWDM node cabling is specified by the Cisco TransportPlanner Internal Connections table. The 
following sections provide examples of the cabling that you will typically install for common DWDM 
node types. 

Note The cabling illustrations shown in the following sections are examples. Always install fiber-optic cables 
based on the Cisco TransportPlanner Internal Connections table for your site.

12.8.1 OSC Link Termination Fiber-Optic Cabling
OSC link termination cabling include the following characteristics:

• The OPT-BST and OSC-CSM cards are the only cards that directly interface with the line (span) 
fiber.

• The OSCM card only carries optical service channels, not DWDM channels.

• The OSCM and OSC-CSM cards cannot both be installed on the same side of the shelf (Side B or 
Side A). You can have different cards on each side, for example an OSCM card on Side A and an 
OSC-CSM card on Side B.

• When an OPT-BST card and an OSC-CSM card are both used on the same side of the node, the 
OPT-BST card combines the supervision channel with the DWDM channels and the OSC-CSM card 
acts as an OSCM card; it does not carry DWDM traffic.
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12.8.1   OSC Link Termination Fiber-Optic Cabling
• If an OPT-BST and an OSCM card are installed on Side B, the Side B OPT-BST OSC RX port is 
connected to the Side B OSCM TX port, and the Side B OPT-BST OSC TX port is connected to the 
Side B OSCM RX port.

• If an OPT-BST and an OSC-CSM card are installed on Side B, the Side B OPT-BST OSC RX port 
is connected to the Side B OSC-CSM LINE TX port, and the Side B OPT-BST OSC TX port is 
connected to the Side B OSC-CSM LINE RX port.

• If an OPT-BST and an OSCM card are installed on Side A, the Side A OPT-BST OSC TX port is 
connected to the Side A OSCM RX port, and the Side A OPT-BST OSC RX port is connected to the 
Side A OSCM TX port.

• If an OPT-BST and an OSC-CSM card are installed on Side A, the Side A OPT-BST OSC TX port 
is connected to the Side A OSC-CSM LINE RX port, and the Side A OPT-BST OSC RX port is 
connected to the Side A OSC-CSM LINE TX port.

Figure 12-74 shows an example of OSC fibering for a hub node with OSCM cards installed.
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12.8.1   OSC Link Termination Fiber-Optic Cabling
Figure 12-74 Fibering OSC Terminations—Hub Node with OSCM Cards
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12.8.2   Hub Node Fiber-Optic Cabling
12.8.2 Hub Node Fiber-Optic Cabling
The following rules generally apply to hub node cabling:

• The Side A OPT-BST or OSC-CSM card common (COM) TX port is connected to the Side A 
OPT-PRE COM RX port or the Side A 32DMX-O/40-DMX-C/40-DMX-CE COM RX port.

• The Side A OPT-PRE COM TX port is connected to the Side A 32DMX-O/40-DMX-C/40-DMX-CE 
COM RX port.

• The Side A 32MUX-O/32WSS/32WSS-L COM TX port is connected to the Side A OPT-BST or 
Side A OSC-CSM COM RX port.

• The Side B 32MUX-O/32WSS/32WSS-L COM TX port is connected to the Side B OPT-BST or 
Side B OSC-CSM COM RX port.

• The Side B OPT-BST or Side B OSC-CSM COM TX port is connected to the Side B OPT-PRE COM 
RX port or the Side B 32DMX-O/32DMX COM RX port.

• The Side B OPT-PRE COM TX port is connected to the Side B 32DMX-O/32DMX COM RX port.

Figure 12-75 shows an example of a hub node with cabling. In the example, OSCM cards are installed. 
If OSC-CSM cards are installed, they are usually installed in Slots 1 and 17.

2 Side A OPT-BST LINE TX to Side B OPT-BST or 
OSC-CSM LINE RX on adjacent node

6 Side B OSCM RX to Side B OPT-BST OSC TX

3 Side A OPT-BST OSC TX to Side A OSCM RX 7 Side B OPT-BST LINE TX to Side A OPT-BST 
or OSC-CSM LINE RX on adjacent node

4 Side A OPT-BST OSC RX to Side A OSCM TX 8 Side B OPT-BST LINE RX to Side A OPT-BST 
or OSC-CSM LINE TX on adjacent node
12-85
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.8.2   Hub Node Fiber-Optic Cabling
Figure 12-75 Fibering a Hub Node
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12.8.3   Terminal Node Fiber-Optic Cabling
12.8.3 Terminal Node Fiber-Optic Cabling
The following rules generally apply to terminal node cabling:

• A terminal site has only one side (as compared to a hub node, which has two sides). The terminal 
side can be either Side B or Side A.

• The terminal side OPT-BST or OSC-CSM card COM TX port is connected to the terminal side 
OPT-PRE COM RX port or the 32DMX-O/40-DMX-C/40-DMX-CE COM RX port.

• The terminal side OPT-PRE COM TX port is connected to the terminal side 
32DMX-O/40-DMX-C/40-DMX-CE COM RX port.

• The terminal side 32MUX-O/40-MUX-C COM TX port is connected to the terminal side OPT-BST 
or OSC-CSM COM RX port.

12.8.4 Line Amplifier Node Fiber-Optic Cabling
The following rules generally apply to line amplifier node cabling:

• The line amplifier node layout allows all combinations of OPT-PRE and OPT-BST cards and allows 
you to use asymmetrical card choices in Side A-to-Side B and Side B-to-Side A configurations. For 
a given line direction, you can configure the four following possibilities:

– Only preamplification (OPT-PRE)

– Only booster amplification (OPT-BST)

– Both preamplification and booster amplification (where a line amplifier node has amplification 
in at least one direction)

– Neither preamplification nor booster amplification

• If a Side A OPT-PRE card is installed:

– The Side A OSC-CSM or OPT-BST COM TX is connected to the Side A OPT-PRE COM RX 
port.

– The Side A OPT-PRE COM TX port is connected to the Side B OSC-CSM or OPT-BST COM 
RX port.

• If a Side A OPT-PRE card is not installed, the Side A OSC-CSM or OPT-BST COM TX port is 
connected to the Side B OSC-CSM or OPT-BST COM RX port.

• If a Side B OPT-PRE card is installed:

– The Side B OSC-CSM or OPT-BST COM TX port is connected to the Side B OPT-PRE COM 
RX port.

3 Side A OPT-BST COM TX to Side A OPT-PRE 
COM RX

8 Side B OPT-PRE COM RX to Side B OPT-BST COM 
TX

4 Side A OPT-BST COM RX to Side A 32MUX-O 
COM TX

9 Side B DCU TX to Side B OPT-PRE DC RX1 

5 Side A OPT-PRE COM TX to Side A 32DMX-O 
COM RX

10 Side B DCU RX to Side B OPT-PRE DC TX1

1. If a DCU is not installed, a 4-dB attenuator loop, +/– 1 dB must be installed between the OPT-PRE DC ports.
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12.8.4   Line Amplifier Node Fiber-Optic Cabling
– The Side B OPT-PRE COM TX port is connected to the Side A OSC-CSM or OPT-BST COM 
RX port.

• If an Side B OPT-PRE card is not installed, the Side B OSC-CSM or OPT-BST COM TX port is 
connected to the Side A OSC-CSM or OPT-BST COM RX port.

Figure 12-76 shows an example of a line amplifier node with cabling.

Figure 12-76 Fibering a Line Amplifier Node
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12.8.5 OSC Regeneration Node Fiber-Optic Cabling
The following rules generally apply to OSC regeneration node cabling:

• The Side A OSC-CSM COM TX port connects to the Side B OSC-CSM COM RX port.

• The Side A OSC-CSM COM RX port connects to the Side B OSC-CSM COM TX port.

• Slots 2 through 5 and 12 through 16 can be used for TXP and MXP cards.

Figure 12-77 shows an example of an OSC regeneration node with cabling.

1 Side A DCU TX to Side A OPT-PRE DC RX1 

1. If a DCU is not installed, a 4-dB attenuator loop, +/– 1 dB, must be installed between the OPT-PRE DC ports.

5 Side A OPT-BST COM RX to Side B OPT-PRE 
COM TX

2 Side A DCU RX to Side A OPT-PRE DC TX1 6 Side A OPT-BST COM RX to Side B OPT-PRE 
COM TX

3 Side A OPT-BST COM TX to Side A OPT-PRE 
COM RX

7 Side B DCU TX to Side B OPT-PRE DC RX1

4 Side A OPT-PRE COM TX to Side B OPT-BST 
COM RX

8 Side B DCU RX to Side B OPT-PRE DC TX1
12-89
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.8.5   OSC Regeneration Node Fiber-Optic Cabling
Figure 12-77 Fibering an OSC Regeneration Node
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12.8.6 Amplified or Passive OADM Node Fiber-Optic Cabling
The two sides of the OADM node do not need to be symmetrical. On each side, Cisco TransportPlanner 
can create one of the following four configurations:

• OPT-BST and OPT-PRE

• OSC-CSM and OPT-PRE

• Only OSC-CSM

• Only OPT-BST

Note Amplified OADM nodes contain OPT-PRE cards and/or OPT-BST cards. Passive OADM nodes do not. 
Both contain add/drop channel or band cards.

The following rules generally apply for OADM node express path cabled connections:

• TX ports should only be connected to RX ports.

• EXP ports are connected only to COM ports in between AD-xC-xx.x or AD-xB-xx.x cards that all 
belong to Side B (that is, they are daisy-chained).

• EXP ports are connected only to COM ports in between AD-xC-xx.x or AD-xB-xx.x cards that all 
belong to Side A (that is, they are daisy-chained).

• The EXP port of the last AD-xC-xx.x or AD-xB-xx.x card on Side A is connected to the EXP port 
of the first AD-xC-xx.x or AD-xB-xx.x card on Side B.

• The OPT-BST COM RX port is connected to the nearest (in slot position) AD-xC-xx.x or 
AD-xB-xx.x COM TX port.

• The OPT-PRE COM TX port is connected to the nearest (in slot position) AD-xC-xx.x or 
AD-xB-xx.x COM RX port.

• If OADM cards are located in adjacent slots, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card 
assumes that they are connected in a daisy-chain between the EXP ports and COM ports as noted 
previously.

• The first Side A AD-xC-xx.x or AD-xB-xx.x card COM RX port is connected to the Side A 
OPT-PRE or OSC-CSM COM TX port.

• The first Side A AD-xC-xx.x or AD-xB-xx.x card COM TX port is connected to the Side A 
OPT-BST or OSC-CSM COM RX port.

• The first Side B AD-xC-xx.x or AD-xB-xx.x card COM RX port is connected to the Side B 
OPT-PRE or OSC-CSM COM TX port.

1 Side A OSC-CSM LINE RX to Side B 
OSC-CSM or OPT-BST LINE TX on adjacent 
node

4 Side A OSC-CSM COM RX to Side B OSC-CSM 
COM TX 

2 Side A OSC-CSM LINE TX to Side B 
OSC-CSM or OPT-BST LINE RX on adjacent 
node

5 Side B OSC-CSM LINE RX to Side A OSC-CSM or 
OPT-BST LINE TX on adjacent node

3 Side A OSC-CSM COM TX to Side B 
OSC-CSM COM RX 

6 Side B OSC-CSM LINE TX to Side A OSC-CSM or 
OPT-BST LINE RX on adjacent node
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• The first Side B AD-xC-xx.x or AD-xB-xx.x card COM TX port is connected to the Side B 
OPT-BST or OSC-CSM RX port.

• If a Side A OPT-PRE is present, the Side A OPT-BST or OSC-CSM COM TX port is connected to 
the Side A OPT-PRE COM RX port.

• If a Side B OPT-PRE is present, the Side B OPT-BST or OSC-CSM COM TX port is connected to 
the Side B OPT-PRE COM RX port.

The following rules generally apply for OADM node add/drop path cabled connections:

• AD-xB-xx.x add/drop (RX or TX) ports are only connected to the following ports:

– 4MD-xx.x COM TX or 4MD-xx.x COM RX ports

– Another AD-xB-xx.x add/drop port (a pass-through configuration)

• An AD-xB-xx.x add/drop band port is only connected to a 4MD-xx.x card belonging to the same 
band.

• For each specific AD-xB-xx.x card, the add and drop ports for that band card are connected to the 
COM TX and COM RX ports of the same 4MD-xx.x card.

• The AD-xB-xx.x and 4MD-xx.x cards are located in the same side (the connected ports all have the 
same line direction).

The following rules generally apply for OADM node pass-through path cabled connections:

• Pass-through connections are only established between add and drop ports on the same band or 
channel and in the same line direction.

• AD-xC-xx.x or AD-xB-xx.x add/drop ports must be connected to other AD-xC-xx.x or AD-xB-xx.x 
add/drop ports (as pass-through configurations).

• Add (RX) ports must be connected to drop (TX) ports.

• 4MD-xx.x client input/output ports must be connected to other 4MD-xx.x client input/output ports.

• A Side A AD-xB-xx.x drop (TX) port is connected to the corresponding Side A 4MD-xx.x COM 
RX port.

• A Side A AD-xB-xx.x add (RX) port is connected to the corresponding Side A 4MD-xx.x COM TX 
port.

• An Side B AD-xB-xx.x drop (TX) port is connected to the corresponding Side B 4MD-xx.x 
COM RX port.

• An Side B AD-xB-xx.x add (RX) port is connected to the corresponding Side B 4MD-xx.x COM TX 
port.

Figure 12-78 shows an example of an amplified OADM node with AD-1C-xx.x cards installed. 

Note Figure 12-78 is an example. Always install fiber-optic cables based on the 
Cisco TransportPlanner Internal Connections table for your site.
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Figure 12-78 Fibering an Amplified OADM Node

1 Side A DCU TX to Side A OPT-PRE DC RX1 9 Side A AD-1C-xx.x EXP RX to Side B AD-1C-xx.x 
EXP TX

2 Side A DCU RX to Side A OPT-PRE DC TX1 10 Side B TXP_MR_2.5G DWDM RX to Side B 
AD-1C-xx.x (15xx.xx) TX

3 Side A OPT-BST COM TX to Side A OPT-PRE 
COM RX

11 Side B TXP_MR_2.5G DWDM TX to Side B 
AD-1C-xx.x (15xx.xx) RX
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Figure 12-79 shows an example of a passive OADM node with two AD-1C-xx.x cards installed.

4 Side A OPT-BST COM RX to Side A AD-1C-xx.x 
COM TX

12 Side B AD-1C-xx.x COM RX to OPT-PRE COM TX

5 Side A OPT-PRE COM TX to Side A AD-1C-xx.x 
COM RX

13 Side B AD-1C-xx.x COM TX to OPT-BST COM RX

6 Side A AD-1C-xx.x (15xx.xx) RX to Side A 
TXP_MR_2.5G DWDM TX

14 Side B OPT-PRE COM RX to Side B OPT-BST 
COM TX

7 Side A AD-1C-xx.x (15xx.xx) TX to Side A 
TXP_MR_2.5G DWDM RX

15 Side B DCU TX to Side B OPT-PRE DC RX1

8 Side A AD-1C-xx.x EXP TX to Side B AD-1C-xx.x 
EXP RX

16 Side B DCU RX to Side B OPT-PRE DC TX1

1. If a DCU is not installed, a 4-dB attenuator loop, +/ 1 dB, must be installed between the OPT-PRE DC ports.
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Figure 12-79 Fibering a Passive OADM Node

1 Side A OSC-CSM COM TX to Side A AD-1C-xx.x 
COM RX

4 Side A OSC-CSM EXP RX to Side B AD-1C-xx.x 
EXP TX

2 Side A OSC-CSM COM RX to Side A AD-1C-xx.x 
COM TX

5 Side B AD-1C-xx.x COM TX to Side B OSC-CSM 
COM RX

3 Side A OSC-CSM EXP TX to Side B AD-1C-xx.x 
EXP RX

6 Side B AD-1C-xx.x COM RX to Side B OSC-CSM 
COM TX 
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12.8.7 ROADM Node Fiber-Optic Cabling
The following rules generally apply to ROADM node cabling:

• The Side A OPT-BST or OSC-CSM COM TX port is connected to the Side A OPT-PRE COM RX 
port.

• The Side A OPT-PRE COM TX port is connected to the Side A 32WSS COM RX port.

• The Side A OPT-BST or OSC-CSM COM RX port is connected to the Side A 32WSS COM TX port.

• The Side A OPT-BST (if installed) OSC TX port is connected to the Side A OSCM RX port.

• The Side A OPT-BST (if installed) OSC RX port is connected to the Side A OSCM TX port.

• The Side A 32WSS EXP TX port is connected to the Side B 32WSS EXP RX port.

• The Side A 32WSS EXP RX port is connected to the Side B 32WSS EXP TX port.

• The Side A 32WSS DROP TX port is connected to the Side A 32DMX COM RX port.

• The Side A 40-WSS-C/40-WSS-CE DROP TX port is connected to the Side A 40-DMX-C or 
40-DMX-CE COM RX port.

• The Side B OPT-BST or OSC-CSM COM TX port is connected to the Side B OPT-PRE COM RX 
port.

• The Side B OPT-PRE COM TX port is connected to the Side B 32WSS COM RX port.

• The Side B OPT-BST or OSC-CSM COM RX port is connected to the Side B 32WSS COM TX port.

• The Side B OPT-BST (if installed) OSC TX port is connected to the Side B OSCM RX port.

• The Side B OPT-BST (if installed) OSC RX port is connected to the Side B OSCM TX port.

• The Side B 32WSS DROP TX port is connected to the Side B 32DMX COM RX port.

• The Side B 40-WSS-C/40-WSS-CE DROP TX port is connected to the Side B 40-DMX-C or 
40-DMX-CE COM RX port.

Figure 12-80 shows an example of an amplified ROADM node with cabling. 

Note Figure 12-80 is an example. Always install fiber-optic cables based on the 
Cisco TransportPlanner Internal Connections table for your site.
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Figure 12-80 Fibering a ROADM Node

1 Side A DCU TX to Side A OPT-PRE DC RX1 8 Side A 32WSS EXP RX to Side B 32WSS EXP TX

2 Side A DCU RX to Side A OPT-PRE DC TX1 9 Side B 32DMX COM RX to Side B 32WSS DROP TX

3 Side A OPT-BST COM TX to Side A OPT-PRE 
COM RX

10 Side B 32WSS COM RX to Side B OPT-PRE 
COM TX
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12.9 Automatic Node Setup
Automatic node setup (ANS) is a TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE function that adjusts 
values of the variable optical attenuators (VOAs) on the DWDM channel paths to equalize the per 
channel power at the amplifier input. This power equalization means that at launch, all channels have the 
same amplifier power, independent of the input signal on the client interface and independent of the path 
crossed by the signal inside the node. This equalization is needed for two reasons:

• Every path introduces a different penalty on the signal that crosses it.

• Client interfaces add their signal to the ONS 15454 DWDM ring with different power levels.

To support ANS, integrated VOAs and photodiodes are provided in the following cards:

• AD-xB-xx.x card express and drop paths

• AD-xC-xx.x card express and add paths

• 4MD-xx.x card add paths

• 32MUX-O card add paths

• 32WSS/40-WSS-C/40-WSS-CE/40-WXC-C/80-WXC-C add, drop, and pass through paths

• 32DMX-O card drop paths

• 32DMX, 40-DMX-C, 40-DMX-CE card input port

• 40-MUX-C card output port

• 40-SMR1-C/40-SMR2-C add, drop, and pass through ports

• PSM card input and output ports (both working and protect path)

Optical power is equalized by regulating the VOAs. Based on the expected per channel power, ANS 
automatically calculates the VOA values by:

• Reconstructing the different channel paths.

• Retrieving the path insertion loss (stored in each DWDM transmission element).

VOAs operate in one of three working modes:

• Automatic VOA Shutdown—In this mode, the VOA is set at maximum attenuation value. Automatic 
VOA shutdown mode is set when the channel is not provisioned to ensure system reliability in the 
event that power is accidentally inserted.

• Constant Attenuation Value—In this mode, the VOA is regulated to a constant attenuation 
independent from the value of the input signal. Constant attenuation value mode is set on VOAs 
associated to aggregated paths.

4 Side A 32WSS COM TX to Side A OPT-BST 
COM RX

11 Side B 32WSS COM TX to Side B OPT-BST 
COM RX

5 Side A 32WSS COM RX to Side A OPT-PRE 
COM TX

12 Side B OPT-BST COM TX to Side B OPT-PRE 
COM RX 

6 Side A 32DMX COM RX to Side A 32WSS DROP TX 13 Side B DCU RX to Side B OPT-PRE DC TX1

7 Side A 32WSS EXP TX to Side B 32WSS EXP RX 14 Side B DCU TX to Side B OPT-PRE DC RX1

1. If a DCU is not installed, a 4-dB attenuator loop, +/–1 dB must be installed between the OPT-PRE DC ports.
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• Constant Power Value—In this mode, the VOA values are automatically regulated to keep a constant 
output power when changes occur to the input power signal. This working condition is set on VOAs 
associated to a single channel path.

ANS calculates the following VOA provisioning parameters:

• Target attenuation

• Target power

Optical patchcords are passive devices that are modeled by the two termination points, each with an 
assigned slot and port. If user-provisioned optical patchcords exist, ANS checks if the new connection 
is feasible according to internal connection rules. If the user connection violates one of the rules, ANS 
returns a denied message. ANS requires the expected wavelength to be provisioned. When provisioning 
the expected wavelength, the following rules apply:

• The card family generically characterizes the card name, and not the particular wavelengths 
supported (for example, AD-2C-xx.x for all two-channel OADMs).

• At the provisioning layer, you can provision a generic card for a specific slot using CTC or TL1. 

• Wavelength assignment is done at the port level.

• An equipment mismatch alarm is raised when a mismatch between the identified and provisioned 
value occurs. The default value for the provisioned attribute is AUTO.

ONS 15454 ANS parameters set the values required for the node to operate successfully. 
Cisco Transport Planner calculates the ANS parameters based on the requirements of a planned network. 
Cisco Transport Planner exports the parameters to NE update file. When the NE update file is imported 
in CTC, the Provisioning > WDM-ANS > Provisioning tab is populated with the ANS parameters to 
provision the node for the network. These ANS parameters can be modified even when the card port is 
in IS state. All the ANS parameters are mapped to the physical ports of the cards. ANS parameters can 
also be manually added, modified, or deleted in the Provisioning tab. ANS parameters cannot be deleted 
when the port is in IS state and if any active circuit uses the ANS parameters. If the new or updated value 
is not within the default range as shown in Table 12-11, an error message is displayed. For more 
information on how to add, modify, or delete an ANS parameter, see the “NTP-G328 Add, Modify, or 
Delete ANS Parameters” procedure on page 14-59. 

Note The Provisioning > WDM-ANS > Provisioning tab in CTC is empty if the NE update file is not imported.

Note It is recommended that you use the Cisco Transport Planner NE Update file to provision the ANS 
parameters instead of manually adding all the parameters in CTC. ANS provisioning parameters must 
be manually changed by Cisco qualified personnel only. Setting incorrect ANS provisioning (either as 
preamplifier or booster input power thresholds) may impact traffic.

Table 12-11 Ranges, Values, and Edit Options for the ANS Parameters

ANS Parameter Range/Value Editable with Port in IS

OSC LOS Threshold -50.0 to +30.0 dBm Yes

Channel LOS Threshold -50.0 to +30.0 dBm Yes

Amplifier Working Mode Control Power, Control Gain, 
Fixed Gain

Yes1
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ANS parameters can be viewed in the node view Provisioning > WDM-ANS > Provisioning tab, as 
shown in Figure 12-81.

Amplifier Gain 0.0 to 40.0 dB No

Amplifier Tilt -15.0 to +15.0 dB No

OSC Power -24.0 to 0.0 dBm No

Raman Ratio 0.0 to 100.0% Yes

Raman Total Power 100 to 450 mW Yes

Raman Expected Gain2 0.0 to 12.0 dB Yes

Power -30.0 to +50 dBm Yes3

WXC Dithering 0 to 33 No

Min Expected Span Loss 0.0 to 60.0 dB No

Max Expected Span Loss 0.0 to 60.0 dB No

VOA Attenuation 0 to 30 dB Yes4

Raman Installation Gain 
(RAMAN-COP only)

30.0 to 8.0 dB Yes

DFB Power (RAMAN-CTP 
only)

+6.0 to -5.0 dBm Yes

DFB LOS Optical Threshold 
(RAMAN-CTP only) 

-20.0 to -70.0 dBm Yes

1. Per-channel power and tilt can be edited when the Amplifier Working Mode is Control Gain or Control Power and 
Fixed Gain when Amplifier Working Mode is Fixed Gain

2. Editable only on OPT-RAMP-C and OPT-RAMP-CE cards.

3. The APC increases or decreases power by 0.5 dB till the new power setpoint is reached. The 
APC-OUT-OF-RANGE alarm is raised if the updated power setpoint is outside the expected range.

4. VOA Attenuation associated with a single channel path can be edited when the working mode is 
Constant Power Value; VOA Attenuation associated with aggregated paths can be edited when the working mode 
is Constant Attenuation Value.

Table 12-11 Ranges, Values, and Edit Options for the ANS Parameters

ANS Parameter Range/Value Editable with Port in IS
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Figure 12-81 WDM-ANS Provisioning

The Provisioning > WDM-ANS > Provisioning tab presents the following information:

• Selector—Presents the ANS parameters in a tree view based on physical position. Clicking the + or 
– expands or collapses individual tree elements. Clicking a tree element displays the element 
parameters in the table on the right. For example, clicking the node name at the top displays all the 
node ANS parameters or clicking Slot 1 (PSM) displays the PSM amplifier parameters only. The 
ANS parameters can be sorted according to physical position. 

• Parameter—Displays the ANS parameter name.

• Origin—Indicates how the parameter was calculated:

– Imported—The value was set by importing the CTP XML file.

– Provisioned—The value was manually provisioned.

– Automatic—The value is automatically calculated by the system using the Raman provisioning 
wizard. For more information on how to provision using a wizard, see the “DLP-G468 
Configure the Raman Pump Using the Installation Wizard” task on page 16-5.

• Value—Displays the ANS parameter value. The values can be modified manually, although 
manually modifying the ANS parameters is not recommended.

• Note—Displays information for parameters that could not be calculated, that is, parameters with 
Unknown appearing in the Value column.

• Port —Displays the port value. Port is represented as Slot.Port.

• Active Value —Displays the active parameter value. The active value cannot be modified manually. 
When you modify the parameter value in the Value field, the active value is updated with the 
modified value after you run ANS.

The Provisioning > WDM-ANS > Port Status tab presents the following information:

• Port—Displays the port value. The port is represented as Slot.Port.
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• Parameter—Displays the ANS parameter name.

• Result—After you run ANS, the status for each ANS parameter in the Results column is provided:

– Success - Changed—The parameter setpoint was recalculated successfully.

– Fail - Out of Range—The calculated setpoint is outside the expected range.

– Fail - Missing Input Parameter—The parameter could not be calculated because the required 
provisioning data is unknown or unavailable.

– Not Applicable State—Ports are not in use.

• Value—Displays the parameter value.

• Set By—Displays the application that sets this parameter. This field can take the following values:

– ANS

– APC

– Circuit Creation

– Raman Wizard

A parameter could be set by more than one application. For example, VOA Attenuation parameter could 
be set by both ANS and APC. In this case, individual entries will be displayed for ANS and APC.

• Last Change—Displays the date and time when the parameter was last modified.

12.9.1 ANS Parameters in a Raman Node With Post-Amplifiers
The following ANS parameters drive the node regulations in the Raman node:

• Power (DC-TX port)—It is the per channel output power level that is allowed on the embedded 
erbium-doped fiber amplifier (EDFA) amplification stage of the OPT-RAMP-C or OPT-RAMP-CE 
card. The power can be measured accurately only when the value of the internal VOA is set to 0 dB. 
During circuit creation, the Power (DC-TX port) setpoint is used to calculate the Gain of the 
embedded EDFA(GEDFA) in the OPT-RAMP-C or OPT-RAMP-CE card. The GEDFA setpoint has a 
direct impact on the actual gain tilt that the embedded EDFA generates. If the value of the GEDFA is 
greater than or less than the optimum Gain (G OPTIMUM) setpoint of the OPT-RAMP-C or 
OPT-RAMP-CE card, the output spectrum is affected by a positive or negative gain tilt.

The G OPTIMUM setpoints for the OPT-RAMP-C or OPT-RAMP-CE cards are:

– OPT-RAMP-C —14 dB

– OPT-RAMP-CE —11 dB

The APC automatically calculates the gain tilt. The difference between the G OPTIMUM and GEDFA 
values of every 1 dB causes a gain tilt of 0.7 dB. Setting an appropriate counter-tilt setpoint on the 
first amplifier card that is present downstream of the embedded EDFA, compensates the gain tilt.

• Power (COM-TX port)—It is the per channel power level that is allowed on the COM-TX port of 
the OPT-RAMP-C or OPT-RAMP-CE card. The Power (COM-TX port) setpoint and the DCU 
insertion loss is used to calculate the attenuation value of the internal VOA of the OPT-RAMP-C or 
OPT-RAMP-CE card when the first circuit is provisioned. The Power (COM-TX port) setpoint 
ensures that the power levels at the input port of the amplifier cards (configured in the OPT-PRE or 
the OPT-LINE mode) downstream are stable. CTP generates the setpoint to suit the optimum Gain 
range of the amplifier card used.
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• Power (LINE-TX port)—It is the per channel power setpoint that is allowed on the LINE-TX output 
port. The amplifiers that are present downstream of the OPT-RAMP-C card can be configured as 
OPT-PRE in ROADM nodes or as OPT-LINE in optical line amplifier (OLA) nodes. When the first 
circuit is provisioned, the Power (LINE-TX port) setpoint is used to automatically calculate the 
Gain.

• Amplifier Tilt (LINE-TX port)—It is the gain tilt (TILT CTP) that CTP calculates based on the output 
power of the amplifier configured as OPT-PRE in ROADM nodes or as OPT-LINE in OLA nodes. 
This is the target value to be reached after circuit creation. The APC dynamically adjusts the tilt 
reference (TILT REFERENCE) value to meet the target taking into consideration the Raman tilt 
(TILT RAMAN) that the Raman installation wizard calculates and the EDFA tilt (TILT EDFA) that is 
calculated by the OPT-RAMP-C or OPT-RAMP-CE card based on its GEDFA value:

TILT CTP setpoint = TILT RAMAN + TILT EDFA + TILT REFERENCE 

12.9.2 ANS Parameters in a Raman Node Without Post-Amplifiers
The TCC automatically identifies the node layout as “Raman Only” and regulates the amplifiers and 
VOA.

The following ANS parameters drive the node regulations in the Raman node without post-amplifiers:

• Amplifier Tilt (DC-TX port)—CTP configures a predefined tilt value in the range of +/- 1.5 dB on 
the embedded EDFA, based on the optical characteristics of the fiber downstream of the 
OPT-RAMP-C or OPT-RAMP-CE card. The embedded EDFA amplifier in OPT-RAMP-C or 
OPT-RAMP-CE cards work in the fixed gain mode. The GEDFA is equal to the G OPTIMUM setpoint by 
default and ensures a flat output spectrum.

The G OPTIMUM setpoints of the OPT-RAMP-C or OPT-RAMP-CE cards are:

– OPT-RAMP-C—14 dB

– OPT-RAMP-CE—11 dB

If the tilt reference value is not equal to zero, it has a direct impact on the GEDFA. The APC changes 
the tilt reference value and consequently the GEDFA by taking the system tilt contribution 
accumulated along the transmission line.

• POWER (LINE-TX port)—It is the maximum per channel power level that is allowed on the 
LINE-TX port of the OPT-RAMP-C, OPT-RAMP-CE, or OSC-CSM card in accordance to the node 
layout. CTP calculates this setpoint to ensure that the system does not suffer from non-linear effects. 
The APC can change the power levels based on the traffic pattern and fiber type but never exceeds 
the setpoint value.

12.9.3 Raman Setup and Tuning
Raman amplification occurs in the optical fiber and the consequent Raman gain depends on the 
characteristics of the span (attenuator presence, fiber type, junctions, etc.). As two Raman pumps at two 
different wavelengths are used to stimulate the Raman effect, not only is the total signal power 
calculation significant, but the right mix of power to ensure gain flatness is crucial. These set points of 
the total Raman power and Raman ratio can be configured on the OPT-RAMP-C or OPT-RAMP-CE card 
in three ways:

• Raman installation wizard

• CTP XML file
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• CTC/TL1 interface

Raman amplification on OPT-RAMP-C or OPT-RAMP-CE cards depends on the optical fiber installed. 
Therefore, Raman total power and Raman ratio values calculated using the Raman installation wizard 
via CTC is more accurate than the values provisioned by loading the CTP XML file. For this reason, the 
value provisioned using the wizard cannot be overridden by the CTP XML file. However, the values 
provisioned using the wizard or the CTP XML file can be overriden by manually provisioning the 
parameters.

When the Raman installation is completed, a report of the status of Raman configuration on a node in 
the OPT-RAMP-C or OPT-RAMP-CE card can be viewed in the Maintenance > Installation tab when 
you are in card view.

The Installation tab displays the following fields:

• User—Name of user who configured the Raman pump.

• Date—Date when the Raman pump was configured.

• Status

– Raman Not Tuned—The OPT-RAMP-C or OPT-RAMP-CE card was provisioned but ANS was 
not launched.

– Tuned by ANS—ANS was run successfully and the basic ANS parameters were applied.

– Tuned by Wizard—The Raman installation wizard was run successfully without errors.

– Tuned by User Acceptance—The Raman installation wizard was completed with errors and the 
user accepted the values that the wizard calculated.

– Raman is Tuning—The Raman installation wizard is running.

• S1Low (dBm)—See Table 12-12.

• S1High (dBm)—See Table 12-12.

• S2Low (dBm)—See Table 12-12.

• S2High (dBm)—See Table 12-12.

• Power (mW)—Total Raman power set points. 

• Ratio—Raman pump ratio setpoint.

• Gain—Expected Raman gain that the wizard calculated.

• Actual Tilt—Expected Raman tilt that the wizard calculated.

• Fiber Cut Recovery—Status of the fiber cut restoration.

– Executed—The restore procedure was completed successfully.

– Pending—The restore procedure is not complete.

– Failed—The system failed to execute the procedure.

• Fiber Cut Date—Date when the fiber cut occured.

The Raman pump is equipped with two different Raman pumps transmitting powers (P1 and P2) at two 
different wavelengths 1 and 2. During installation, the two pumps alternatively turn ON and OFF at 
two different power values. 1 and 2 signals are used as probes at the end of spans to measure Raman 
gain efficiency of the two Raman pumps separately. 

The example in Figure 12-82 shows the Raman gain on an OPT-RAMP-C or OPT-RAMP-CE card in 
Node B that was measured by setting the wavelength and power measurements as follows:

1=1530.33 nm signal probe at Node A

λ λ
λ λ

λ
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2=1560.61 nm signal probe at Node A

P1 = 1425 nm power at Node B 

P2 = 1452 nm power at Node B

Plow = 100 mW

Phigh = 280 mW

Pmin = 8 mW

Pmax = 450 mW

Figure 12-82 Raman Gain on Node B

The S1low, S1high, S2low, and S2low values in the Maintenance > Installation tab are based on the 
power values read on the LINE-RX port of Node B.
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Table 12-12 Example of Raman Power Measurements

Input P1 P2
Probe Signal Power 
Received at Node B

1=1530.33 nm at 
Node A

Plow = 100 mW Pmin = 8 mW S1low

Phigh = 250 mW Pmin = 8 mW S1high

2=1560.61 nm at 
Node A

Pmin = 8 mW Plow = 100 mW S2low

Pmin = 8 mW Phigh = 250 mW S2low

λ

λ
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12.9.4 RAMAN-CTP and RAMAN-COP Card Start Up and Fiber Link Turn Up
The local and remote nodes, equipped with RAMAN-CTP and RAMAN-COP cards, must follow this 
sequence to startup the card and complete the Raman link turn up.

1. The distributed feedback laser must be enabled—The RAMAN-CTP cards are equipped with 
embedded distributed feedback (DFB) lasers that operate at 1568.77 nm. The DFB RX port is 
capable of detecting very low power levels (-55 dBm or -60 dBm). By default, the DFB laser is 
disabled and the DFB ports are in IS-AINS (ANSI)/Unlocked,automaticInService (ETSI) state. The 
DFB ports are moved to IS (ANSI)/Unlocked (ETSI) state and the laser is enabled in pulse mode, 
by performing either one of the following:

a. In a DCN Extension layout, ANS is launched. A side-to-side OTS provisionable patchcord 
(PPC) is created on the side of the node where the RAMAN-CTP card is installed after the DFB 
ports are successfully regulated (ports are in service). During the creation of the PPC, the TNC 
card moves the following ports to the IS (ANSI)/Unlocked (ETSI) state:

– Ports included in the optical path—LINE ports of the RAMAN-CTP card

– RAMAN-TX and ASE-RX ports of the RAMAN-CTP card

– RAMAN-TX port of the RAMAN-COP card (if the card is installed)

Note At this stage, the RAMAN ports do not emit power pulses even though they are in 
IS (ANSI)/Unlocked (ETSI) state.

b. In an OSC based layout, ANS is launched. An OSC termination is created on the side of the 
node where the RAMAN-CTP card is installed after the DFB ports are successfully regulated. 
During creation of the OSC termination, the TNC card moves the following ports to the 
IS (ANSI)/Unlocked (ETSI) state:

– Ports included in the optical path—LINE and COM ports of the RAMAN-CTP card and the 
LINE ports of the line amplifier

– RAMAN-TX and ASE-RX ports of the RAMAN-CTP card

– RAMAN-TX port of the RAMAN-COP card (if the card is installed)

Note At this stage, the RAMAN ports do not emit power pulses even though they are in 
IS (ANSI)/Unlocked (ETSI) state.

The DFB laser from the local node emits a 5-second pulse every 100 seconds and waits for a similar 
5-second pulse in response from the DFB laser on the remote node.

Note For short spans, the DFB optical power level must be regulated by the internal VOA (working in 
constant power mode) using the provisioned value of the DFB power setpoint. The DFB power 
setpoint is limited to a maximum of +3 dBm.

2. The DFB laser link continuity is checked—The acknowledgement mechanism between the peer 
DFB modules works in the following manner:

– The DFB laser on the local node emits a 5-second pulse.

– The remote node detects a valid signal (value above the DFB LOS Optical Threshold) on the 
DFB-RX port and responds with a 9-second DFB laser pulse.
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– The local node detects a signal from the remote DFB laser on the DFB-RX port and starts a 
counter to check the duration of the remote pulse.

– If the signal is detected for at least 9 seconds, link continuity is verified and the local node 
moves the DFB laser to steady (active) state.

– The remote node performs a similar signal validation and eventually the DFB link is active. 

Note If the DFB-RX port detects a drop in the power below the threshold value before 9 seconds have 
elapsed, the procedure to check DFB link continuity is restarted.

Note If one of the fibers is down, the DFB signal must be in OFF state in the opposite fiber too. The 
acknowledgement mechanism automatically performs this action.

3. A check for short spans is performed—When the DFB signal is active, a point-to-point measurement 
of the span loss is done. The node measures the loss on the incoming span because the DFB signal 
is co-propagating. The insertion loss is the difference between the power value on the DFB-TX port 
of the remote node and the power value on the DFB-RX port of the local node. If the span loss is 
less than 20 dB, the RAMAN-CTP card raises the PWR-PROT-ON alarm on the RAMAN-TX port 
and the Raman pumps stop the startup procedure.

4. Excessive back reflection on RAMAN-CTP cards is checked—After the span loss check is 
complete, the Raman pumps on the RAMAN-CTP card on the local node are turned on in Automatic 
Power Reduction (APR) mode at reduced power (10 mW) lasting for 200 ms. The RAMAN-CTP 
cards perform a back reflection power test using an embedded fail threshold, which is configured 
during card production. The back reflection test lasts for 500 ms at the maximum. If the back 
reflection test is successful, the sequence continues with Step 5. If the check fails, the RAMAN-CTP 
get stuck with the DFB laser in ON state and the Raman pumps do not switch to full power. A Raman 
Laser Shutdown (RLS) alarm is raised on the RAMAN-TX port, where the failure is detected.

5. Excessive back reflection on RAMAN-COP cards is checked, if the RAMAN-COP cards are 
installed—The Raman pumps on the RAMAN-CTP card on the local node must shut down after the 
back reflection test is successful. This allows the same check to be executed by the RAMAN-COP 
card on the local node without any interference from the RAMAN-CTP card remnant signal.

When the Raman pumps on the RAMAN-CTP card shut down, a specific command is sent through 
the backplane lines to the RAMAN-COP card on the local node to turn on the Raman pumps on the 
RAMAN-COP card to APR mode and perform a back reflection test on the internal connection 
(RAMAN-TX port of the RAMAN-COP card to the RAMAN-RX port of the RAMAN-CTP card). 
The back reflection test lasts for a maximum of 500 ms. If the back reflection test is successful, the 
Raman pumps on RAMAN-COP cards are immediately moved from the APR state to full power 
using the Total Power setpoint. If the back reflection check fails, the RAMAN-COP pumps get stuck 
in APR state and a RLS alarm is raised on the RAMAN-TX port, where the failure is detected.

6. The Raman pumps of the RAMAN-CTP card on the local node are moved to full power after the 
waiting time elapses—When the local RAMAN-CTP card, in Step 5 shuts down its Raman pumps 
to initiate Raman pump startup of the RAMAN-COP card, it transitions to a waiting mode. After the 
expiry of 12 seconds, the RAMAN-CTP card must turn up its Raman pumps and move them to full 
power using the Total Power setpoint irrespective of any alarm that is raised by the RAMAN-COP 
card in Step 5. 

7. The Raman link is tuned—A manual Raman Day 0 tuning procedure must be executed before 
creating the OCH circuits. The Raman link can also be tuned by the ANS parameters. The Raman 
amplified span is now ready for traffic provisioning.
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8. The OSC link is turned up and the ALS condition is removed on the line amplifiers—When the 
RAMAN-CTP (and RAMAN-COP, if present) Raman pumps are tuned, the amplification provided 
in the fiber is sufficient to detect a valid OSC signal, even in very long spans. The OSC detection 
clears the LOS-O alarm and results in the removal of the ALS condition on the line amplifiers. If an 
OSC signal is not available, the amplified spontaneous emission (ASE) Raman noise power received 
at the LINE-RX port of the line amplifier is sufficient to remove the LOS-O alarm and enable the 
line amplifier startup.

The RAMAN-CTP and RAMAN-COP (if installed) cards on the remote node must perform the same 
start up sequence (Steps 4 through 8) in asynchronous mode with respect to the local node.

12.10 DWDM Network Functional View
The DWDM network functional view displays a graphical representation of the DWDM cards, internal 
connections, circuits, optical power, and alarms in the DWDM network. The DWDM network functional 
view is similar to the DWDM functional view in its graphical layout and behavior at the node level.

The DWDM network functional view consists of two views:

• NFV view—Enables you to view the circuit connections and the flow of signals at the network level.

• GMPLS view—Enables you to create Generalized Multiprotocol Label Switching (GMPLS) circuits 
that are optically feasible. These circuit connections can be viewed at the network level. The 
GMPLS view also helps to reroute a circuit on an alternate path. For more information about 
GMPLS circuits, see the “12.10.1 GMPLS Control Plane” section on page 12-108.

The DWDM network functional view offers dual options to view the network:

• Graphical view—Displays the circuit connections, optical power, and alarms on a circuit through a 
graphical representation. To view the graphical display of the circuit connections, select the circuit 
in the Circuits tab in the Network Data pane. In the toolbar, click the dB, SL, or PV tool to view the 
optical power in the nodes, span loss values of the spans, or insertion loss of the patchcords, 
respectively. For more information about the use of the graphical view, see the “12.10.2.1 Graphical 
View Pane” section on page 12-114.

• Tabular format—Displays the circuit connections, optical power, and alarms of a circuit in a tabular 
format in the Network Data pane. For more information about the Network Data pane, see the 
“12.10.2.3 Network Data Pane” section on page 12-116.

For information on how to view optical power values and alarms of the circuit selected in the 
Circuits tab of the Network Data pane, see the “NTP-G231 View Optical Power Values and Alarms 
Using Network Functional View” task on page 12-123.

You can export the DWDM network functional view reports to .html, .csv, or .tsv format. For more 
information on exporting the reports, see the “DLP-G529 Export Network Functional View Reports” 
task on page 12-124.

12.10.1 GMPLS Control Plane
This section describes the GMPLS-based control plane. The GMPLS control plane can be used to 
provision optical channels for the ONS 15454 DWDM platform.

When a circuit is created using the Circuit Creation wizard in CTC, the circuit gets provisioned but might 
not be able to carry traffic due to optical signal degradation caused by optical impairments such as:

• Optical Signal-to-Noise Ratio (OSNR)
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• Chromatic Mode Dispersion (CMD)

• Polarization Mode Dispersion (PMD)

• Four-Wave Mixing (FWM)

• Self-Phase Modulation (SPM)

• Polarization Dependent Loss (PDL)

• Xtalk

To overcome this problem, a GMPLS-based control plane is now supported that has the capability to 
validate the optical channel feasibility before a circuit is provisioned. The GMPLS control plane is 
available with the Cisco ONS 15454 DWDM WSON package and is supported on the Cisco ONS 15454, 
Cisco ONS 15454 M6, and Cisco ONS 15454 M2 platforms. A GMPLS circuit is provisioned only if the 
optical feasibility is established ensuring transmission of client traffic on the network.

The optical plane uses the GMPLS routing and signalling protocols, such as 
Open Shortest Path First - Traffic Engineering (OSPF-TE) and 
Resource Reservation Protocol - Traffic Engineering (RSVP-TE) to determine available optical routes. 

Bandwidth, network protection, traffic engineering, and optimal utilization of network resources are 
taken into consideration during path computation, validation, and provisioning.

The functions of the GMPLS control plane are:

• Identifying network topology

• Discovering automatically resources, such as Network Elements (NEs), links, paths, wavelengths, 
and OCH ports

• Calculating optical paths

• Validating optical circuits taking into account the optical impairments

• Provisioning optical channels (OCHCC, OCHNC, and OCH Trail)

• Rerouting wavelength for traffic restoration

In mesh networks consisting of omnidirectional and colorless ROADM nodes, it is possible to provision 
a circuit using any path and wavelength, without recabling or physical intervention on the site. The 
GMPLS control plane controls and provisions the DWDM optical interfaces installed on routers by 
defining the appropriate wavelength.

When resources are added to or removed from the network, the control plane can reroute existing 
connections through an alternate path having optical feasibility to make the best use of the newly 
available resources. 

These topics provide additional information on the usage of GMPLS control plane:

• 12.10.1.1 Card Support

• 12.10.1.2 Acceptance Thresholds

• 12.10.1.3 Validation Modes

• 12.10.1.4 GMPLS Optical Restoration
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12.10.1.1 Card Support

Table 12-13 lists the card supported by the GMPLS control plane.

12.10.1.2 Acceptance Thresholds

The GMPLS control plane validates the optical feasibility of an OCH circuit to ensure that the circuit is 
operational after provisioning. The optical feasibility is determined based on the optical impairments. 
The optical feasibility is represented by the following colors:

• Green—Indicates that the channel failure risk is 0%.

• Yellow—Indicates that the channel failure risk is between 0% and 16%.

• Orange—Indicates that the channel failure risk is between 16% and 50%.

• Red—Indicates that the channel failure risk is greater that 50%.

During circuit creation, you can define the acceptance threshold value in the Circuit Parameters pane of 
the GMPLS view in CTC. The circuit is provisioned only if the evaluated feasibility is greater than or 
equal to the user-defined threshold. 

After the circuit is created, its acceptance threshold and optical feasibility is displayed in the 
Acpt Threshold and the Opt Valid columns in the Circuits tab in CTC.

12.10.1.3 Validation Modes

In GMPLS view, the validation mode can be set during circuit creation. The validation modes are:

• Full—The circuit gets created when the circuit validation result is greater than or equal to the 
acceptance threshold value.

• None—The circuit is created without considering the acceptance threshold value. The Opt Valid 
column in the Circuits tab displays the value, “No Valid”.

12.10.1.4 GMPLS Optical Restoration

The GMPLS optical restoration feature helps to restore optical circuits from a failed path to a new path 
using the Generalized Multiprotocol Label Switching (GMPLS) control plane. The optical failure is 
indicated through any signal alarm such as Loss of Signal (LOS), Loss Of Signal due to absence of 
payload (LOS-P), and signal failure. The GMPLS control plane initiates restoration after a failure is 
detected on the circuit. Restoration is supported for OCHNC and OCH trail circuits. The OCHCC 
restoration is provided by the underlying OCH Trail circuits. 

Table 12-13 Cards Supported by the GMPLS Control Plane

Unit Type Card Name

TXP/MXPs All the TXP/MXP cards except AR-MXP and AR-XP cards.

Amplifiers OPT_BST, OPT_BST_E, OPT_AMP_17_C, OPT_PRE, OPT_AMP_C, 
OPT_RAMP_C, OPT_RAMP_E, OPT_EDFA_17, and OPT_EDFA_24

Filters DMX40, DMX32, MUX40, 15216-MD_40_ODD, and 15216-MD_40_EVEN

Deinterleavers MD_ID_50 and 15216_ID_50

ROADMs 32WSS, 40WSS-C, 40-WXC-C, 80-WXC-C, 40-SMR1-C, and 40-SMR2-C

Patch panels 15454-PP-4-SMR, PP-MESH-4, PP-MESH-8
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The GMPLS control plane is available with the Cisco ONS 15454 DWDM WSON package and is 
supported on the Cisco ONS 15454, Cisco ONS 15454 M6, and Cisco ONS 15454 M2 platforms. 

12.10.1.4.1 Determining an Alternate Path

The GMPLS control plane attempts to determine an alternate path based on the alarm types:

• Link Alarms: The original path constraints, excluding the failed link, are used to determine an 
alternate path.

• Transponder Alarms: The control plane does not have information about the link or node that 
degraded the circuit. Links are excluded to determine an alternate path.

The GMPLS control plane attempts to determine an alternate path with the same wavelength. If it fails, 
it attempts to determine an alternate path using a different wavelength. The alternate path activation 
takes few minutes depending on the various parameters of the network and therefore affects traffic.

If the GMPLS control plane fails to find an alternate or better path, the original circuit remains in place. 
The restoration is re-attempted at periodic intervals until a new route is found or the failure in the original 
working path is fixed.

The circuit restoration is enabled by checking the Restoration check box while creating or editing the 
circuit in CTC. In case of a failure, if the Restoration check box is not checked, the GMPLS control plane 
does not attempt to discover the new path to restore traffic that is affected. See NTP-G334 Configure 
GMPLS Optical Restoration, page 17-41 to configure GMPLS optical restoration for the circuits. 

12.10.1.4.2 Types of Restoration

• 1+R Restoration—This type of restoration is enabled for an unprotected optical circuit. If the 
original path fails and restoration is enabled, the GMPLS control plane establishes an alternate 
restored path and traffic flows on the restored path. If revertive restoration mode is enabled, traffic 
is switched back to the original path and the restored path is deleted. If non-revertive restoration 
mode is enabled, the original path is deleted and the restored path becomes the working path.

• 1+1+R Restoration—This type of restoration is enabled for a protected optical circuit. 1+1+R 
supports the Protection Switching Module (PSM), Y-cable, and splitter protection schemes.

If the working path fails, traffic is switched to the protect path. If restoration is enabled, the GMPLS 
control plane establishes an alternate restored path and the restored path becomes the new working 
path. If revertive restoration mode is enabled, traffic is switched back to the working path and the 
restored path is deleted. If non-revertive restoration mode is enabled, the working path is deleted 
and the restored path becomes the new working path.

If a protect path fails, traffic continues to flow on the working path. If restoration is enabled, the 
GMPLS control plane establishes an alternate restored path and the restored path becomes the new 
protect path. Traffic continues to flow on the working path. If revertive restoration mode is enabled, 
traffic is switched back to the original protect path and the restored protect path is deleted. If 
non-revertive restoration mode is enabled, the original protect path is deleted and the restored 
protect path becomes the new protect path.

For more information on revertive and non-revertive restoration, see “12.10.1.5 Restoration Modes” 
section on page 12-111.

12.10.1.5 Restoration Modes

The GMPLS control plane supports the following modes of optical restoration:
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• 12.10.1.5.1 Revertive restoration

• 12.10.1.5.2 Non-revertive Restoration

12.10.1.5.1 Revertive restoration

In revertive restoration mode, the circuit is switched back from the restored path to the original path after 
the following conditions.

• Failure is fixed on the original path or the alarms listed in the WSON tab are acknowledged.

• Soak time expires and one of the above conditions are met.

Revertive restoration can be one of the following types:

• Auto Revert—If the auto revert option is selected, the circuit automatically reverts from the restored 
path to the original path. The restored path is deleted.

• Manual Revert—If the manual revert option is selected, the circuit does not automatically revert to 
the original path from the restored path. The circuit must be manually restored on the original path 
by checking the Manual Revert check box in CTC. The restored path is deleted. The circuit can be 
reverted manually only when the restoration status of the circuit is REST-REVERTIBLE.

12.10.1.5.2 Non-revertive Restoration

In non-revertive restoration, traffic flows on the restored path and does not revert to the original path. In 
this mode, the restored path becomes the working path even after the failure is fixed on the original 
working path. The original path is deleted.

12.10.1.6 Soak Time

After the failure on the original path is resolved, the circuit on the restored path waits until the specified 
soak time period expires before moving to the original path. The soak time starts after the alarms are 
acknowledged.

12.10.1.7 Restoration Status

The restoration status of the circuit can be viewed while editing the circuit. The status of the circuit can 
be in one of the following states:

• REST_ST_RESTORED—A failure is detected on the original path. A restored path is established 
to carry traffic only when the Revertive option is selected. When the original path fails, traffic flows 
on the restored path.

• REST_ST_FAILED—A failure is detected on the original path. The restored path does not exist or 
is not feasible. Restoration is retried at periodic intervals.

• REST_REVERTIBLE—A failure is detected on the original path and the restored path is 
established. Traffic flows on the restored path. The failure on the original path is fixed and the traffic 
can be reverted to the original path after the soak time expires.

• REST_NONE—The circuit does not have a restored path due to the following:

– The circuit was never restored.

– The circuit was restored and reverted to the original path.

– The circuit was restored and reverted to the original path.
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• REST_RESTORING—A failure is detected on the original path. The GMPLS control plane 
attempts to find an alternate feasible path. The status of the circuit becomes REST_ST_RESTORED 
or REST_ST_FAILED or REST_NONE (if the circuit is non-revertible).

12.10.1.8 WSON Alarms

When there is a failure in the original path of the circuit, alarms are raised to indicate failure. After all 
the circuits are moved to the restored path, the port on the original path moves to OOS,DSBLD (ANSI) 
or Locked,disabled (ETSI) state. The alarms disappear on the original path irrespective of whether the 
failure is fixed. These alarms appear in the WSON tab and are referred to as unverified alarms. These 
unverified alarms appear at the network, node, and circuit levels in CTC. Acknowledge these alarms 
manually to clear them after fixing the failure on the original path.

When the port moves to OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state, the alarms disappear on 
the original path and the CP-UNVER-CLEARED alarm is raised. This alarm indicates the presence of 
unverified alarms for the node in the WSON tab. After the failure on the original path is fixed, 
acknowledge the alarms listed in the WSON tab. The CP-UNVER-CLEARED alarm is automatically 
cleared after acknowledging the unverified alarms in the WSON tab.

12.10.1.9 GMPLS UNI

The GMPLS User-Network Interface (UNI) is a signaling interface that is set up between the client such 
as the Cisco Carrier Routing System (CRS) or the Cisco ASR 9000 series router and the DWDM 
network. The GMPLS UNI allows the router to request bandwidth from the DWDM network.

The client side of the UNI is called UNI-C and the network side of the UNI is called UNI-N. Typically, 
UNI-C nodes are the router nodes and UNI-N nodes are the optical nodes. The router and the DWDM 
network exchange information only through the UNIs.

The GMPLS UNI allows GMPLS circuit created on the router to interact with the DWDM network. The 
UNI must be configured on both the router and the DWDM network to exchange information.

The GMPLS UNI provides the following benefits:

• If a router needs more bandwidth to connect to another router, the router can signal the request to a 
DWDM network through the GMPLS UNI and the optical channel is automatically set.

• Service parameters, such as bandwidth, can be easily modified.

When DWDM interfaces such as transponders are located on the router, the UNI-N notifies the UNI-C 
if a different wavelength (other than the one signaled by the UNI-C) is used after restoration. This allows 
the router to reconfigure the transponder with the new wavelength.

12.10.2 DWDM Network Functional View (NFV)
This section describes the NFV view. 

To navigate to the NFV view, go to the network view in CTC and click the FV icon in the toolbar. The 
NFV view opens.

The NFV view has the following panes:

• 12.10.2.1 Graphical View Pane

• 12.10.2.2 Overview Pane

• 12.10.2.3 Network Data Pane
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12.10.2.1 Graphical View Pane

The graphical view displays all the nodes and devices in the network. Use the graphical view to gather 
information on circuits, optical power, and alarms for nodes. 

To expand a node, double-click the node in the network functional view map or right-click the node and 
choose Open Node FV. The node opens and the sides of the nodes are displayed showing the various 
cards and patch panels present on each side. To open only one side of a node, right-click the node and 
choose Open Side > Side:x from the context menu. 

Place the mouse over a card to view the card information. For example, when the mouse is placed over 
the OPT-BST card of a side, the tooltip text displays OPT-BST: shelf1/s1, indicating that the OPT-BST 
card is located in Shelf 1, Slot 1. Double-click a card to bring up the CTC card view.

To view the port information, place the mouse over a card port. For example, when the mouse is placed 
over the first port of the 40-MUX card, the tooltip text displays CARD_PORT-BAND-1-RX, indicating 
that the port is for the first band of wavelengths (wavelengths 1 to 8) to be added into the optical path on 
the 40-MUX card. These wavelengths come into the 40-MUX card from a transponder (TXP) or 
muxponder (MXP) on the patch panel.

Place the mouse over a patchcord to see the state of the output and input port associated with that 
patchcord. 

When you right-click inside a side view, a context menu appears with the options listed in Table 12-14.

Table 12-14 Side View Context Menu Options

Additionally, to zoom-in and zoom-out of the map, press Ctrl and scroll up and down with the scroll 
wheel on your mouse. The keystroke commands provide the keyboard shortcuts for graphical control of 
the NFV. To access the keystroke commands, click Help > Keystroke commands.

When you have multiple node functional views opened, you cannot view the graphical details of the 
individual nodes due to overlapping. To avoid overlapping of the nodes:

1. Select the entire node by clicking on the title bar of the node and pressing Ctrl+A. Drag the node 
away from other nodes. 

2. Select the individual side of the node and drag it away from other sides.

12.10.2.1.1 DWDM NFV Toolbar Options

Table 12-15 lists the tools available in the DWDM NFV toolbar.

Option Description

Close Node FV Closes the node functional view.

Node DoubleZoomIN Magnifies the node view to double its size.

Node DoubleZoomOUT Reduces the node view to half of its size.

Node Select all Selects the complete node.

Rotate Left Rotates the side 90 degrees counterclockwise (all connections are 
maintained).

Rotate Right Rotates the side 90 degrees clockwise (all connections are maintained).

Close Side Closes the side view.

Open Side Opens the side view.
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Table 12-15 DWDM NFV Toolbar Options

Tool Icon Description

Pan Enables you to select and move the whole network view.

Select Enables you to select entities by clicking on them or by dragging a 
rectangular area around them.

Zoom in rect Enables you to zoom in the area defined by drawing a rectangle.

Zoom in Zooms in the circuit map.

Zoom out Zooms out the circuit map.

Reset Nodes 
Zoom

Resets the graphical view to the default zoom size.

Fit to View Resizes the view to fit all the nodes in the graphical view.

Print Prints the functional view data.

Magnifier Displays a virtual magnifying glass which zooms in the area underneath. 
Hold the left mouse button to see the magnifying glass.

dB
(Show Power)

Displays the optical power (dBm) for the card ports in the form of power 
balloons. This information is available only for the nodes that have the 
functional view open.
To open the node FV, right-click the node and choose Open Node FV. 
Right-click the internal patchcord link and select the Flip Power 
Balloons option to change the position of power balloon on the selected 
patchcord. The power balloon is flipped and you can see the power 
details of the selected patchcord without the power balloons overlapping 
with each other.

SL (Show 
Spanloss)

Displays the span loss value on the spans.
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12.10.2.2 Overview Pane

The Overview pane displays the complete network. A rectangle is displayed in the Overview pane. The 
area enclosed by the rectangle is enlarged and displayed in the graphical view. To view a specific area 
of the network in the graphical view, move the rectangle to that location in the Overview pane. To zoom 
in or zoom out the network in the graphical view, resize the rectangle by dragging its corners in the 
Overview pane.

12.10.2.3 Network Data Pane

The Network Data pane displays the following three tabs that provide information about circuits:

• Circuits—Displays the list of circuits in the network. Choose the circuit from the list to view the 
circuit information. A graphical display of the selected circuit and the associated span is visible in 
the map. Additionally, you can view the general information (type, source, and destination), state 
(IS,OOS [ANSI] or unlocked, locked [ETSI]), and physical connection details (wavelength, 
direction, and span) of the selected circuit.

The circuit can be in any one of the following states:

– DISCOVERED

PV (Verify 
Patchcords)

• Displays the insertion loss of the patchcord. The PV calculates the 
input and output power of the patchcord. You can view the insertion 
loss of the patchcord only for those nodes that have the FV open. To 
open the node FV, right-click the node and choose Open Node FV. 
The insertion loss should not exceed 2 dBm. The patchcord lines are 
colored to indicate the insertion loss:

– Red—Indicates that the insertion loss of the patchcords 
exceeded 2 dBm.

– White—Indicates that the system was not able to calculate the 
insertion loss of the patchcord.

– Black—Indicates that the insertion loss of the patchcords is 
within the limit and not more than 2 dBm.

Refresh Power 
Info

Refreshes the optical power and span loss information. The optical 
power and span loss information is calculated and is refreshed in the 
graphical display and optical power table.

Close 
Expanded 
Nodes

Closes all the opened nodes in the functional view.

Make node 
invisible

Hides the nodes that are not part of the selected circuit.

Reset To 
Default

Restores the panes in the network functional view to its default locations.

Tool Icon Description
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– PARTIAL

– DISCOVERED_TL1

– PARTIAL_TL1

– TO_BE_UPGRADED

When you upgrade from Release 9.21 to Release 9.3 and later releases, some OCHNC circuits do 
not automatically upgrade during the software activation process. To manually upgrade these 
circuits, select the Reconfigure Circuits option in the CTC Tools > Circuits menu. During 
reconfiguration, CTC reassembles all connections of the selected circuits based on path size, 
direction, and alignment.

When you switch the selection between the circuits, and if both the circuits are in 
DISCOVERED_TL1 status, the circuit details of the new selection may not be displayed as the 
previously selected circuit details are not refreshed. 

If you find that the current selection is not refreshed, do either of the following:

– Deselect the selected circuit before selecting the another circuit.

– Update all the selected circuits using the Reconfigure Circuits option.

• Optical Power—Displays the optical link and span loss of the circuits. This tab lists the aggregated 
power-in and power-out of all the internal patchcords for the nodes that have the functional view 
open.

• Alarms—Displays all the alarms present on the network. If a card has one or more alarms (that is 
part of the selected circuit), the node turns either yellow or red, depending on the severity of the 
alarm. The alarm in red indicates a major alarm and yellow indicates a minor alarm. If there is an 
alarm present in the card that is not part of the selected circuit, then the node appears gray. 

If a node has alarms that is not part of the selected circuits, then the alarms are not listed in the table, 
but the node is colored in the map.

12.10.3 DWDM Network Functional View (GMPLS)
This section explains the GMPLS view. 

The GMPLS view uses the GMPLS control plane to provision circuits. For more information about the 
GMPLS control plane, see the “12.10.1 GMPLS Control Plane” section on page 12-108.

To navigate to the GMPLS view, go to the network view in the CTC and click the FV icon in the toolbar. 
Choose GMPLS from the Perspective View drop-down list. The GMPLS view opens.

The GMPLS view has the following panes:

• 12.10.2.1 Graphical View Pane

• 12.10.2.2 Overview Pane

• 12.10.2.3 Network Data Pane

• Circuit Parameters Pane—Options in this pane are used to provision a GMPLS circuit.

• Working/Protect Port Parameters Pane—Options in this pane are used to provision working and 
protect port parameters for the GMPLS circuit.

• Alien Wavelength Selection Pane—Options in this pane are used to provision the alien class 
wavelength.
12-117
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.10.3   DWDM Network Functional View (GMPLS)
• Wavelength Re-route Pane—Options in this pane are used to reroute a GMPLS circuit on an 
alternate path. For more information about wavelength rerouting, see the “12.10.3.4 Wavelength 
Rerouting” section on page 12-121.

• GMPLS/WSON Restoration Configuration Pane—Options in this pane are used to configure the 
restoration and revertive parameters for the OCHNC or OCH trail circuit. For more information 
about restoration parameters, see the 12.10.3.6 GMPLS Restoration Configuration, page 12-122.

12.10.3.1 GMPLS View Toolbar Options

The GMPLS view has the same set of tools as the NFV view as listed in Table 12-15. The additional 
toolbar options are described in Table 12-16.

Table 12-16 GMPLS View Toolbar Options

12.10.3.2 GMPLS Path Constraints

During GMPLS circuit creation or wavelength rerouting, it is possible to force specific nodes and links 
to be included or excluded in the circuit path by applying specific constraints. The GMPLS circuit is 
created if a feasible path is found that complies with the specified constraints. 

In the GMPLS view, the W&P Constraints Config drop-down list in the toolbar provides the constraint 
options listed in Table 12-17 during circuit creation. Choose the required option and select the node or 
span in the graphical view to which the constraint must be applied.

Table 12-17 Working and Protect Path Constraint Options

Tools Description

W&P Constraints Config Displays the list of constraints to be applied on the nodes or links. For 
information about path constraints, see the “12.10.3.2 GMPLS Path 
Constraints” section on page 12-118.

S/D Configuration Displays the options to define the source or destination port during GMPLS 
circuit creation. For more information about configuring the source and 
destination ports, see the “12.10.3.3 Source and Destination Port 
Configuration” section on page 12-119.

Wavelength re-routing Displays the Wavelength re-routing view that can be used to reroute a 
GMPLS circuit on an alternate path. For more information about 
wavelength rerouting, see the “12.10.3.4 Wavelength Rerouting” section on 
page 12-121

Option Description

exclude W Node The working path does not pass through the selected node.

exclude P Node The protect path does not pass through the selected node.

exclude W&P Node The working and protected path do not pass through the selected node.

include W Node The working path passes through the selected node.

include P Node The protect path passes through the selected node.

exclude W Link The working path does not use the selected span.

exclude P Link The protect path does not use the selected span.

exclude W&P Link The working and protected path do not use the selected span.
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In the Wavelength re-routing view, the Constraints Config drop-down list provides constraint options 
listed in Table 12-18. Choose the required option and select the node or span in the graphical view to 
which the constraint must be applied.

Table 12-18 Reroute Path Constraint Options

Note The constraint options can also be accessed by right-clicking the node or span.

12.10.3.3 Source and Destination Port Configuration

During GMPLS circuit creation, the source and destination ports at the circuit endpoints must be defined 
in the map. The circuit endpoints can be channel ports (on line cards) or TXP/MXP ports depending on 
the circuit type being created. 

Use either of the following methods to define the source and destination ports:

Method 1:

1. From the S/D Configuration drop-down list, choose either of the following:

– Working S/D—The selected ports are defined as the source and destination ports on the working 
path.

– Protected S/D—The selected ports are defined as the source and destination ports on the protect 
path.

2. Click a node in the map to open the node functional view. The sides of the nodes are displayed 
showing the various cards and patch panel present on each side. To open only one side of the node, 
right-click the node and choose Open Side > Side:x from the context menu.

3. Click the patch panel to open it. All the patchcords and cards connected to the patch panel are 
displayed. 

4. Use the zoom tools in the toolbar to manage the graphical view. 

5. Click the card port that is associated with the wavelength for which the circuit is being created. A 
pop-up menu displays the available options: 

– If the port is on a TXP/MXP card, available client and trunk interfaces are displayed. Select the 
required interface.

– If the port is an add/drop port, a list of supported wavelengths is displayed. Select the required 
wavelength.

include W Link The working path uses the selected span.

include P Link The protect path uses the selected span.

Option Description

Option Description

exclude Node The rerouted path does not pass through the selected node.

include Node The rerouted path passes through the selected node.

exclude Link The rerouted path does not use the selected span.

include Link The rerouted path uses the selected span.
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Method 2:

1. Open the node functional view on the map by using either one of the following:

– Double-click the node. 

– Right-click the node and select Open Node FV from the context menu.

– The various cards and patch panel connected to each side are displayed.

2. Use the zoom tools in the toolbar to manage the graphical view.

3. Double-click the patch panel. The patch panel opens displaying all the patchcords and cards 
connected to it.

4. Click the card port that is associated with the wavelength for which the circuit is being created. A 
pop-up menu displays the available options: 

– If the port is on a TXP/MXP card, available client and trunk interfaces are displayed. Select the 
required interface.

– If the port is an add/drop port, a list of supported wavelengths is displayed. Select the required 
wavelength.

5. A pop-up menu appears that displays one of the following pair of options:

– Work. Bid Src/Dst Port—The selected port is the bidirectional source and destination port on 
the working path.

– Prot. Bid Src/Dst Port—The selected port is the bidirectional source and destination port on the 
protect path.

– Work. Source Port—The selected port is the source port on the working path.

– Prot. Source Port—The selected port is the source port on the protect path.

– Work. Destination Port—The selected port is the destination port on the working path.

– Prot. Destination Port—The selected port is the destination port on the protect path.

– Select the required option.

After the port is defined as the source or destination, a balloon is displayed on the map. The balloon 
indicates that the port is the source (S), destination (D), or both (S/D) for the circuit endpoint along with 
the associated wavelength. If the port is on the working path, the balloon is light blue in color; if the port 
is on the protect path, the balloon is deep blue in color.

Note During the creation of a Y-cable protected OCHCC circuit, the protected port gets selected automatically 
when the working port is selected because both the ports are in the same protection group. 

12.10.3.3.1 Working and Protect Port Parameters

After a port is selected in the map as the source or destination endpoint, the Working Port Parameters 
pane, or Protected Port Parameters pane, or both are displayed depending on whether the selected ports 
are on the working or protect path. Table 12-19 lists the port parameters relevant to the selected port that 
are displayed in these panes.
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Table 12-19 Working and Protect Port Parameters

The working and protect port parameters on the source and destination endpoints must match with each 
other. Otherwise, the mismatched parameters are displayed in red in the port parameters pane. If feasible, 
align the parameters by using the various drop-down lists available in this pane. Choose Apply to 
confirm selection.

12.10.3.4 Wavelength Rerouting

A GMPLS circuit can be rerouted through an alternate path that adheres to all the parameters that were 
defined during the circuit creation. Additional path constraints also must be specified based on which 
alternate route is computed. For more information about reroute path constraints, see Table 12-18. The 
wavelength re-routing feature provides an efficient solution for circuit restoration during path failure. 
For more information on wavelength rerouting, see the “DLP-G710 Reroute Wavelength of GMPLS 
Circuits” task on page 17-53.

12.10.3.5 Fiber Attributes and Alien Wavelength Provisioning

Choose the Provisioning > WDM-ANS > GMPLS/WSON tab to define and view fiber and alien 
wavelength parameters to be used during GMPLS circuit creation or upgrade of an a non-GMPLS Circuit 
to a GMPLS circuit. The GMPLS/WSON tab contains two subtabs, namely Fiber Attributes and Alien 
Wavelength.

The parameters available in the Fiber Attributes and Alien Wavelength are populated in CTC after 
importing the Cisco Transport Planner NE Update configuration file. For more information, see 
“NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” task on page 14-47. If 
required, additional changes can be made to these parameters in the Fiber Attributes and Alien 
Wavelength tabs.

The Fiber Attributes tab is used to view and define the fiber parameters, which are displayed in a tabular 
format as shown in Table 12-20.

Item Description

Client Port Displays the client port information.

ITU-T G709 Sets the ITU-T G.709 monitoring setting on the optical 
transport network. The available options are Enable or Disable.

FEC Mode
(OCHCC and OCH trail only) 

Sets the FEC mode for OTN lines. FEC mode can be Disabled, 
Standard, or Enhanced (provides greater range and lower bit 
error rate).

Mapping Type Sets the mapping for the card. The options available are Not 
used, Asynchronous, Synchronous, ODU Multiplex (client 
SONET/SDH payload), or No Fixed Stuff. The choices 
available depend on the card.

MLSE Setting If checked, sets the maximum likelihood sequence estimation 
(MLSE) parameter on the trunk port of the MXP_MR_10DME, 
MXP_MR_10DMEX, TXP_MR_10E, TXP_MR_10EX, 
MXP_2.5G_10E, and MXP_2.5G_10EX cards. The options 
available are Enable and Disable.

Overclock Setting Enables or disables overclock mode on the trunk port.
12-121
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 12      Node Reference
12.10.3   DWDM Network Functional View (GMPLS)
Table 12-20 Fiber Attributes Tab Parameters

Use the Side drop-down list to choose a side; the attributes of the fibers that are connected to that side 
are displayed in the table. The Unit drop-down list enables you to choose the measurement unit for the 
fiber length. If required, the fiber type and the fiber length can be modified in the table. Click Apply to 
apply the changes.

The Alien Wavelength tab is used to view the port and wavelength parameters for the alien wavelength. 
The alien wavelength has to be configured for both source and destination ports. The alien wavelength 
has to be configured for each UNI interface. Table 12-21 lists the options available in the Alien 
Wavelength > Create tab. After making the necessary settings, click OK to apply the changes.

Table 12-21 Alien Wavelength Tab Options

12.10.3.6 GMPLS Restoration Configuration

Choose DWDM Network Functional View (GMPLS) in CTC to configure the restoration parameters. 
Table 12-22 lists the GMPLS restoration parameters.

Parameter Description

Side Displays the optical side where the fiber is connected.

Fiber Type Allows to choose the fiber type from the drop-down list.

Topology Direction Displays whether the link is entering or exiting the node.

Fiber Number Displays the fiber sequence number. Useful when different types of fiber are 
present on the span.

Length Allows to edit the fiber length.

Option Description

Type Choose the type of card where the alien wavelength is configured. The 
available options are optical card and passive card. The passive card option is 
available only if there are passive cards available on the network.

Shelf Choose the shelf where the card resides.

Slot Choose the slot where the card resides.

Port Choose the card port where the alien wavelength is configured.

Alien Wavelength Choose the alien wavelength class.

Lambda Displays the alien wavelength value.

FEC Sets the forward error correction (FEC) mode on the alien wavelength channel. 
The available modes are:

• Disabled

• Standard 

• Enhanced 

• Enhanced I.4

• Enhanced I.7

• 7% High Gain FEC
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12.10.4   Related Procedures
Table 12-22 GMPLS Restoration Parameters

12.10.4 Related Procedures
NTP-G151 Create, Delete, and Manage Optical Channel Client Connections, page 17-15

NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-33

NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-40

NTP-G58 Locate and View Optical Channel Circuits, page 17-70

NTP-G231 View Optical Power Values and Alarms Using Network Functional View, page 12-123

NTP-G334 Configure GMPLS Optical Restoration, page 17-41

NTP-G231 View Optical Power Values and Alarms Using 
Network Functional View

Step 1 From the View menu, choose Go to Network View and click the FV icon in the toolbar.

Step 2 Click the Circuits tab to view the list of circuits present in the network.

Option Description

Restoration Check this check box to switch the circuit from the original path to an alternate 
path because of failure in the original path.

Revert Check this check box to revert the circuit from the restored path to the original 
path after the failure is fixed.

Auto Revert Click this radio button to automatically revert the circuit from the restored 
path to the original path after the failure is fixed, WSON alarms are 
acknowledged, and the soak time expires.

Manual Revert Click this radio button to manually revert the circuit from the restored path to 
the original path after the failure is fixed, the WSON alarms are 
acknowledged, and the soak time expires.

Soak Time Enter the time (in hours, minutes, and seconds) in the Soak Time field. Soak 
time is the period that the circuit on the restored path must wait before 
switching to the original path after the failure is fixed. The circuit can revert 
to the original path after the soak time expires. The minimum value of soak 
time must be 00:00:01.

Purpose This procedure enables you to view optical power values and alarms of the 
circuit selected in the Network Functional View.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superusers only
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DLP-  G529 Export Network Functional View Reports
Step 3 Select the circuit from the list. A new pane with the Circuit:circuit name appears.

Step 4 View the following information in the Circuit:circuit name pane.

• General info—Displays circuit type, source, and destination information.

• Status—Displays the circuit protection type, administrative state, and circuit status.

• Physical—Displays the wavelength, number of spans, and circuit direction. 

• Span and Power Level tab—Displays the span loss and node power level.

• Circuit Alarms tab—Displays alarms.

Step 5 To view the power, span loss, and insertion loss of a circuit in the map, click the following icons on the 
toolbar: 

• dB—Displays the power of the circuit.

• SL—Displays the loss of signal of the desired span.

• PV—Displays the insertion loss of the patch cord.

Step 6 Complete the “DLP-G529 Export Network Functional View Reports” task on page 12-124, as needed.

Stop. You have completed this procedure.

DLP-G529 Export Network Functional View Reports

Step 1 From the View menu, choose Go to Network View and click the FV icon in the toolbar.

Step 2 Click File > Export to open the Export dialog.

Step 3 You can export the files in any of the following formats:

• As HTML —The exported file is saved as an HTML file. Also, a .png file is saved that provides 
graphical representation of the site layout.

• AS CSV—The file is saved in the Comma Separated Values (.csv) format. The circuit information 
is saved in a text file where the data is separated with a comma.

• TSV—The file is saved in a Tab Separated Values (.tsv) file. The circuit information is saved in a 
file where the data is separated by tabs. 

The exported file contains details about the aggregated power and alarms at the network level. If 
specific circuits are selected in the network before exporting the file, the alarms and power of these 
circuits are also exported. 

Step 4 Click OK.

Step 5 Specify the file name and the folder to save the export data and click Save.

Purpose This task exports the Network Functional View report in .html, .csv, and 
.tsv formats.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superusers only
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DLP-  G529 Export Network Functional View Reports
Stop. You have completed this procedure.

NTP-G319 Connect a Passive Module to the 
Cisco ONS 15454 M2 or Cisco ONS 15454 M6 Node

Step 1 Complete the DLP-G46 Log into CTC at the Cisco ONS 15454 M2 or Cisco ONS 15454 M6 node where 
you want to connect the passive module. If you are already logged in, continue with Step 2.

Step 2 In the multishelf view (multishelf mode), click Provisioning > WDM-ANS tabs.

Step 3 Click the Passive Cards subtab.

Step 4 Click Create button. The Create Passive Card dialogue box appears. 

Step 5 From the Card Type drop-down list, select the passive module that you want to connect to the USB port 
of the ONS 15454 M2 or ONS 15454 M6 node. For each passive module, CTC displays a table listing 
with Passive, Equipment Type, and Locations columns. Selecting the passive module from the 
Equipment Type column displays the port list of the passive module and its associated wavelength, and 
MPO.

Note Perform the above step (Step 5) only if the passive module has not been already provisioned by the 
CTP xml files).

The available passive modules that can be connected to the USB port are:

• PASSIVE MD 40 ODD

• PASSIVE MD 40 EVEN

• PASSIVE EF 40 ODD

• PASSIVE EF 40 EVEN

• PASSIVE MD 48 ODD

• PASSIVE MD 48 EVEN

• PASSIVE MD ID 50

• PASSIVE 15216 48 CM

Purpose This procedure connects the passive module to the USB port of the 
Cisco ONS 15454 M2 or Cisco ONS 15454 M6 node. 

Tools/Equipment Either 15216-FLD-4, 15216-MD-40-EVEN, 15216-MD-40-ODD, 
15216-EF-40-ODD, 15216-MD-48-ODD, 15216-MD-40-EVEN, 
15216-EF-40-EVEN, 15216-MD-48-EVEN, 15216-MD-ID-50, 
15216-MD-48-CM, or 15216-FBGDCU.

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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12.11   Not-DWDM Networks (Enhancements)
• MESH-PPR-SMR

• PASSIVE FBG DCU

• PASSIVE 15126 ID 50

• PASSIVE FLD4 30 3

• PASSIVE FLD4 33 4

• PASSIVE FLD4 36 6

• PASSIVE FLD4 39 7

• PASSIVE FLD4 42 9

• PASSIVE FLD4 46 1

• PASSIVE FLD4 49 3

• PASSIVE FLD4 52 5

• PASSIVE FLD4 55 5

• PASSIVE FLD4 58 9

Step 6 Click OK. 

Step 7 In the Equipment Type column, select the passive module that you want to connect to the USB port and 
click Associate to USB Port. The Associate USB Port dialogue box appears.

Step 8 From the USB Port drop-down list, select the USB port that is connected to the passive module and click 
OK.

The USB is connected to the selected passive module. The insertion loss (IL) attribute, value, and units 
values are displayed in a table.

Stop. You have completed this procedure.

12.11 Not-DWDM Networks (Enhancements)
Not-DWDM (TDM) Networks take synchronous and asynchronous signals and multiplexes them to a 
single higher bit rate for transmission at a single wavelength over fiber. When the node is configured as 
a Not-DWDM Network, the supported MSTP cards are used in the standalone mode. MSTP applications 
like Circuit Provisioning, NLAC and APC are not supported in amplified TDM networks. For more 
information on how to configure a node as a Non-DWDM network, see the “NTP-G320 Configure the 
Node as a Non-DWDM Network” procedure on page 14-56.

All DWDM cards can be installed in a network element configured as Not-DWDM. The cards must 
complete the Software Boot and Default Provisioning operations successfully. In NOT-DWDM mode, 
you must configure significant optical parameters and thresholds before launching the ANS application. 
For information on how to configure the amplifier, see the “DLP-G693 Configure the Amplifier” 
procedure on page 14-57. For information on how to configure the PSM behavior, see the “DLP-G694 
Configure the PSM” procedure on page 14-58.

When the ANS application is launched, the supported cards become optically operative during service 
and report all the proper alarms. The list of supported cards are:

• OPT-PSM

• All optical amplifiers
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12.11   Not-DWDM Networks (Enhancements)
• All transponder and muxponder Cards

You can import a standard xml configuration file when the network type is Not-DWDM. Node Layout 
and Card Parameters list must be populated. Software Patchcords and Optical Sides must not be 
configured.

Note You cannot transition a node from Metro-Core network type to Not-DWDM, if the Software Patchcords 
and Optical Sides have already been provisioned on the node.

ANS with ports in IS feature is not applicable to NOT-DWDM networks. For information on how to add, 
modify, or delete the ANS Parameters, see the “NTP-G328 Add, Modify, or Delete ANS Parameters” 
procedure on page 14-59. The available procedures in Not-DWDM networks for physical shutdown of 
an active device (like Lasers and VOAs) inside a WDM card are:

• Removing the incoming signal 

• Configuring optical thresholds (usually Input Power Fail) values suitable to keep the device off

• Forcing disable conditions (OSRI) via software commands.

For information on the procedure to erase the current card provisioning and to change port state to the 
default state (IS-AINS), see the “DLP-G351 Delete a Card in CTC” procedure on page 14-51. Once 
deleted, the card can be removed or re-provisioned. 

Note PSM Card must be moved to NORMAL state before deleting.

Note OPT-EDFA-17, OPT-EDFA-24, 40-SMR-1C, 40-SMR-2C cards have a different behavior associated to 
IS-AINS state on input ports (COM-RX, LINE-RX). When the port is in IS-AINS, the amplifier is forced 
to the OFF state despite the input power level (physical card shutdown). 

If you revert the Network Type from NOT-DWDM to METRO-CORE with ports in IS state, TCC 
recognizes the transition and sets all the ports (of Amplifiers and PSM) to IS-AINS state.
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12.11   Not-DWDM Networks (Enhancements)
12-128
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Cisco ON
78-20702-02
C H A P T E R 13

Network Reference

This chapter explains the Cisco ONS 15454 dense wavelength division multiplexing (DWDM) network 
applications and topologies. The chapter also provides network-level optical performance references. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note In this chapter, “OPT-BST” refers to the OPT-BST, OPT-BST-E, OPT-BST-L cards, and to the 
OPT-AMP-L, OPT-AMP-C, and OPT-AMP-17-C cards when they are provisioned in OPT-LINE (optical 
booster) mode. “OPT-PRE” refers to the OPT-PRE card and to the OPT-AMP-L, OPT-AMP-C, and 
OPT-AMP-17-C cards provisioned in OPT-PRE (preamplifier) mode.

Note OPT-BST-L, 32WSS-L, 32DMX-L, and OPT-AMP-L cards can be installed only in L-band compatible 
nodes and networks. OPT-BST, OPT-BST-E, 32WSS, 32DMX, 40-DMX-C, 40-DMX-CE, 40-MUX-C, 
40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-SMR1-C, 40-SMR2-C, OPT-AMP-C, 
OPT-AMP-17-C, OPT-RAMP-C and OPT-RAMP-CE cards can be installed only in C-band compatible 
nodes and networks.

Note In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to 
the 15454-M-RAMAN-COP card.

Chapter topics include:

• 13.1 Network Applications, page 13-2

• 13.2 Network Topologies, page 13-2

• 13.5 Network Topologies for the OPT-RAMP-C and OPT-RAMP-CE Cards, page 13-18

• 13.6 Network Topologies for the PSM Card, page 13-19

• 13.7 Optical Performance, page 13-19

• 13.8 Automatic Power Control, page 13-20

• 13.9 Power Side Monitoring, page 13-26

• 13.10 Span Loss Verification, page 13-28

• 13.11 Network Optical Safety, page 13-30
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13.1   Network Applications
• 13.12 Network-Level Gain—Tilt Management of Optical Amplifiers, page 13-49

• 13.13 Optical Data Rate Derivations, page 13-55

• 13.14 Even Band Management, page 13-57

13.1 Network Applications
Cisco ONS 15454 nodes can be provisioned for metro core DWDM network applications. Metro core 
networks often include multiple spans and amplifiers, so the optical signal-to-noise ratio (OSNR) is the 
limiting factor for channel performance.

Within DWDM networks, the ONS 15454 uses a communications protocol, called Node Services 
Protocol (NSP), to communicate with other nodes. NSP automatically updates nodes whenever a change 
in the network occurs. Each ONS 15454 DWDM node can: 

• Identify other ONS 15454 DWDM nodes in the network.

• Identify the different types of DWDM networks.

• Identify when the DWDM network is complete and when it is incomplete.

13.2 Network Topologies
The ONS 15454 DWDM network topologies include ring networks, linear networks, mesh networks, 
interconnected rings and spurs.

13.2.1 Ring Networks
Ring networks support hubbed, multi-hubbed, any-to-any, and mesh traffic topologies.

13.2.1.1 Hubbed Traffic Topology

In the hubbed traffic topology (Figure 13-1), a hub node terminates all the DWDM channels. A channel 
can be provisioned to support protected traffic between the hub node and any node in the ring. Both 
working and protected traffic use the same wavelength on both sides of the ring. Protected traffic can 
also be provisioned between any pair of optical add/drop multiplexing (OADM) nodes, except that either 
the working or the protected path must be regenerated in the hub node. 

Protected traffic saturates a channel in a hubbed topology, that is, no channel reuse is possible. However, 
the same channel can be reused in different sections of the ring by provisioning unprotected multihop 
traffic. From a transmission point of view, this network topology is similar to two bidirectional 
point-to-point links with OADM nodes.

For more information about hub nodes, see the “12.1.4 Hub Node” section on page 12-30.
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13.2.1   Ring Networks
Figure 13-1 Hubbed Traffic Topology

13.2.1.2 Multihubbed Traffic Topology

A multihubbed traffic topology (Figure 13-2) is based on the hubbed traffic topology, except that two or 
more hub nodes are added. Protected traffic can only be established between the two hub nodes. 
Protected traffic can be provisioned between a hub node and any OADM node only if the allocated 
wavelength channel is regenerated through the other hub node. Multihop traffic can be provisioned on 
this ring. From a transmission point of view, this network topology is similar to two or more 
point-to-point links with OADM nodes.
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13.2.1   Ring Networks
Figure 13-2 Multihubbed Traffic Topology

13.2.1.3 Any-to-Any Traffic Topology

The any-to-any traffic topology (Figure 13-3) contains only reconfigurable OADM (ROADM) nodes 
(with or without optical service channel [OSC] regeneration) or optical amplifier nodes. This topology 
potentially allows you to route every wavelength from any source to any destination node inside the 
network.

See the “12.1.3 ROADM Node” section on page 12-11 for more information.
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13.2.1   Ring Networks
Figure 13-3 Any-to-Any Traffic Topology

13.2.1.4 Meshed Traffic Topology

The meshed traffic topology (Figure 13-4) does not use hubbed nodes; only amplified and passive 
OADM nodes are present. Protected traffic can be provisioned between any two nodes; however, the 
selected channel cannot be reused in the ring. Unprotected multihop traffic can be provisioned in the 
ring. A meshed ring must be designed to prevent amplified spontaneous emission (ASE) lasing. This is 
done by configuring a particular node as an anti-ASE node. An anti-ASE node can be created in two 
ways:

• Equip an OADM node with 32MUX-O cards and 32DMX-O cards. This solution is adopted when 
the total number of wavelengths deployed in the ring is higher than ten. OADM nodes equipped with 
32MUX-O cards and 32DMX-O cards are called full OADM nodes.

• When the total number of wavelengths deployed in the ring is lower than ten, the anti-ASE node is 
configured by using an OADM node where all the channels that are not terminated in the node are 
configured as “optical pass-through.” In other words, no channels in the anti-ASE node can travel 
through the express path of the OADM node. 

For more information about OADM nodes, see the “12.1.2 OADM Node” section on page 12-9. For 
more information about anti-ASE nodes, see the “12.1.5 Anti-ASE Node” section on page 12-34.
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13.2.2   Linear Networks
Figure 13-4 Meshed Traffic Topology

13.2.2 Linear Networks
Linear configurations are characterized by the use of two terminal nodes, east and west. The 32-channel 
terminal nodes can be equipped with a 32MUX-O card and a 32DMX-O card, or with a 32WSS card and 
a 32DMX or 32DMX-O card. The 40-channel terminal nodes can be equipped with a 40-MUX-C card 
and a 40-DMX-C/40-DMX-CE card, a 40-WSS-C/40-WSS-CE card with a 40-DMX-C/40-DMX-CE 
card, or a 40-SMR1-C/40-SMR2-C card with a 15216-MD-40-ODD card. OADM or line amplifier nodes 
can be installed between the two terminal nodes. Only unprotected traffic can be provisioned in a linear 
configuration. Figure 13-5 shows five ONS 15454 nodes in a linear configuration with an amplified and 
a passive OADM node. 

Figure 13-5 Linear Configuration with an OADM Node

Figure 13-6 shows five ONS 15454 nodes in a linear configuration without an OADM node. See the 
“12.1.1 Terminal Node” section on page 12-2 for more information.
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13.2.3   Mesh Networks
Figure 13-6 Linear Configuration without an OADM Node

A single-span link is a type of linear configuration characterized by a single-span link with 
preamplification and post-amplification. A single-span link is also characterized by the use of two 
terminal nodes, east and west. Only unprotected traffic can be provisioned on a single-span link. 

Figure 13-7 shows two ONS 15454s in a single-span link. Eight channels are carried on one span. 
Single-span link losses apply to OC-192/STM-64 LR ITU cards. The optical performance values are 
valid assuming that the sum of the OADM passive node insertion losses and the span losses does not 
exceed 35 dB.

Figure 13-7 Single-Span Link

13.2.3 Mesh Networks
A mesh network can be native or multiring. In a native mesh network (Figure 13-8), any combination of 
four-degree and eight-degree mesh nodes can work together. Four-degree mesh nodes transmit an optical 
signal in four directions, while an eight-degree mesh node transmits an optical signal in eight directions. 
For additional information about mesh nodes, see the “12.7 Configuring Mesh DWDM Networks” 
section on page 12-61. The intermediate nodes are ROADM nodes. In a mesh node, all wavelengths can 
be routed through four (four-degree mesh node) to eight (eight-degree mesh node) different optical line 
termination ports using a 40-WXC-C, 80-WXC-C, or 40-SMR2-C card without any 
optical-electrical-optical (OEO) regeneration. It is possible to combine 40-WSS-C/40-WSS-CE, 
40-WXC-C, 40-SMR2-C, and 32WSS cards in the same mesh network without impacting system 
performance. For nodes equipped with 32WSS cards, the maximum system capacity is 32 channels. 
Terminal sites are connected to the mesh network as a spur. 
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13.2.3   Mesh Networks
Figure 13-8 Mesh Network

In a multiring mesh network (Figure 13-9), several rings are connected with four-degree or eight-degree 
mesh nodes. The intermediate ROADM nodes are equipped with MMU cards. All wavelengths can be 
routed among two or more rings using a 40-WXC-C or 40-SMR2-C card without any 
optical-electrical-optical (OEO) regeneration. As in a native mesh network, it is possible to combine 
40-WSS-C/40-WSS-CE, 40-WXC-C, 40-SMR2-C, and 32WSS cards in the same multiring network 
without impacting system performance. For nodes equipped with 32WSS cards, maximum system 
capacity is limited to 32 channels. A terminal node is connected to a multiring node as a spur. 

For information on node configurations for both native mesh and multiring networks, see the 
“12.7 Configuring Mesh DWDM Networks” section on page 12-61.
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13.3   Interconnected Rings
Figure 13-9 Multiring Network

13.3 Interconnected Rings
The interconnected ring configuration allows you to connect two different nodes using external ports to 
allow traffic flow between different subnets. In Figure 13-10, the main ring consists of nodes R, R1, and 
R2 and the tributary ring consists of nodes r, r1, and r2. It is possible to connect more than one tributary 
ring to the main ring at the same point. Node R of the main ring can forward wavelengths to the node r 
of the tributary ring and vice-versa.

Node R is either a colorless and omni-directional n-degree ROADM node (Figure 13-11) or a two-degree 
colorless ROADM node (Figure 13-12) equipped with 80-WXC-C cards. See the “12.7 Configuring 
Mesh DWDM Networks” section on page 12-61 for more information about colorless and 
omni-directional n-degree ROADM nodes and two-degree colorless ROADM nodes.

Node r of the tributary ring is a two-degree ROADM node equipped with 40-SMR1-C, 40-SMR2-C, 
40-WSS-C, or 40-WSS-CE cards. OTS PPCs are provisioned between the EAD ports of the 80-WXC-C 
card on node R and the EXP or ADD/DROP ports of the 40-SMR1-C, 40-SMR2-C, 40-WSS-C, or 
40-WSS-CE cards on node r. All the nodes are managed by different IP addresses.
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13.3   Interconnected Rings
Figure 13-10 Interconnected Rings

Figure 13-11 Colorless and Omni-directional n- Degree ROADM Node
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13.3.1   Interconnected Ring Scenarios
Figure 13-12 Colorless Two-Degree ROADM Node

13.3.1 Interconnected Ring Scenarios
In the following sections, three interconnected ring scenarios are given:

13.3.1.1 Scenario A: Interconnect Traffic from Tributary Ring to Main Ring without Local Add/Drop 
in the Tributary Ring

In scenario A-1(Figure 13-13), node R is a three-degree colorless and omni-directional ROADM node 
and node r is a two-degree 40-SMR1-c based ROADM node. The EAD ports of the 80-WXC-C cards on 
node R are connected to the ADD/DROP ports of the 40-SMR1-C card on node r. Traffic from node r 
can be routed to side A or B of node R. Traffic from side a cannot be added or dropped at node r but can 
be routed to side b using the express path.
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13.3.1   Interconnected Ring Scenarios
Figure 13-13 Interconnected Ring - Scenario A-1

In scenario A-2 (Figure 13-14), node R is a two-degree colorless ROADM node and node r is a 
two-degree 40-SMR1-C based ROADM node. The EAD ports of the 80-WXC-C cards on node R are 
connected to the ADD/DROP ports of the 40-SMR1-C card on node r. Traffic from node r can be routed 
to one side of node R. For example, traffic can be routed from side a to side A or from side b to side B. 
Traffic from side a cannot be added or dropped at node r but can be routed to side b using the express 
path.

Figure 13-14 Interconnected Ring - Scenario A-2
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13.3.1.2 Scenario B: Interconnect Traffic from Tributary Ring to Main Ring with Local Add/Drop in 
the Tributary Ring

In scenario B-1(Figure 13-15), node R is a three-degree colorless and omni-directional ROADM node 
and node r is a hub node with two terminal sides equipped with 40-SMR1-C or 40-WSS-C cards. The 
EAD ports of the 80-WXC-C cards on node R are connected to the EXP ports of the 40-SMR1-C 
or40-WSS-C card on node r. Traffic from node r can be routed to side A or B of node R. Traffic local to 
the tributary ring can be added or dropped at node r. For example, traffic from side a can be dropped at 
node r but cannot be routed to side b since the EXP ports are not available.

Figure 13-15 Interconnected Ring - Scenario B-1

In scenario B-2 (Figure 13-16), node R is a two-degree colorless ROADM node and node r is a hub node 
with two terminal sides equipped with 40-SMR1-C or 40-WSS-C cards. The EAD ports of the 
80-WXC-C cards on node R are connected to the EXP ports of the 40-WSS-C card on node r. Traffic 
from node r can be routed to one side of node R. For example, traffic can be routed from side a to side 
A or from side b to side B. Traffic local to the tributary ring can be added or dropped at node r. For 
example, traffic from side a can be dropped at node r but cannot be routed to side b since the EXP ports 
are not available.
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Figure 13-16 Interconnected Ring - Scenario B-2

13.3.1.3 Scenario C: Interconnect Traffic Between Tributary Rings Using the Main Ring

In scenario C-1(Figure 13-17), nodes R1 and R2 are n-degree colorless and omni-directional ROADM 
nodes. Node r is a terminal site. The EXP ports of the 40-SMR-1C card in node r are connected to the 
EAD ports of the 80-WXC-C card in nodes R1 and R2. Traffic from node r is routed to side A and B of 
nodes R1 and R2. Traffic local to the tributary ring can be added or dropped at node r.
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Figure 13-17 Interconnected Ring - Scenario C-1

In scenario C-2(Figure 13-18), node R is an n-degree colorless and omni-directional ROADM node with 
2 omni-directional sides. Nodes r1 and r2 are hub sites. The ADD/DROP ports of 40-SMR-1-C cards in 
node r1 and r2 are connected to the EAD ports of 80-WXC-C cards in node R. Traffic can be routed from 
node r1 to node r2 through node R. Traffic local to the tributary ring can be added or dropped at node r1 
and r2.

Figure 13-18 Interconnected Ring - Scenario C-2
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13.4   Spur Configuration
13.4 Spur Configuration
Remote terminal sites can be connected to the main network using a spur. In a spur configuration, the 
multiplexer (MUX) and demultiplexer (DMX) units associated with one of the sides of node R in the 
main network (Figure 13-19) are moved to the remote terminal site T. This helps to aggregate traffic from 
the terminal site. The MUX and DMX units in terminal site T are connected to node R with a single fibre 
couple. Node R is a n-degree ROADM node equipped with 40-SMR1-C, 40-SMR2-C, or 80-WXC-C 
cards. Traffic from terminal site T can be routed to side A or side B on node R. Amplification on the spur 
link is not allowed. PSM is not supported on terminal site T. 

Figure 13-19 Spur

13.4.1 Spur Configuration Scenarios
In the following sections, three spur scenarios are provided:

13.4.1.1 Scenario A: Spur Configuration without 15454 Chassis in Remote Terminal T

In Figure 13-20, node R is a two-degree ROADM node equipped with 40-SMR1-C card. The remote 
terminal site T does not have a 15454 chassis and is not shown in the network map in CTC. The terminal 
site is built using passive MUX and DMX units. All OCHNC circuits originating from 40-SMR1-C on 
Side A of node R to the remote terminal site are terminated on 40-SMR1-C ADD/DROP ports. 
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Figure 13-20 Scenario A: Spur Without 15454 Chassis in Remote Terminal T

13.4.1.2 Scenario B: Spur Configuration with Passive MUX and DMX Units in Remote Terminal T

In Figure 13-21, node R is a two-degree ROADM node equipped with 40-SMR1-C card. The terminal 
site T is built with a 15454 chassis equipped with TXP units and passive MUX and DMX units. Terminal 
site T is connected to node R on the network map in CTC. All OCHNC circuits originating from 
40-SMR1-C on Side A of node R to the remote site are terminated on 40-SMR1-C ADD/DROP ports. 
OCHCC and OCHTRAIL circuits are supported on the TXP units in terminal site T.

Figure 13-21 Scenario B: Spur With Passive MUX and DMX Units in Remote Terminal T
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13.5   Network Topologies for the OPT-RAMP-C and OPT-RAMP-CE Cards
13.4.1.3 Scenario C: Spur Configuration with Active MUX and DMX Units in Remote Terminal T

In Figure 13-22, node R is a two-degree ROADM node equipped with 40-SMR1-C card. The terminal 
site T is built with a 15454 chassis equipped with TXP units and active MUX and DMX units. Terminal 
site T is connected to node R on the network map in CTC. DCN extension is supported between the 
ADD/DROP ports of 40-SMR1-C and the COM ports of the active MUX and DMX units. OCHNC 
circuits are terminated on the CHAN ports of the MUX and DMX units of terminal site T. OCHCC and 
OCHTRAIL circuits are supported on the TXP units in terminal site T.

Figure 13-22 Scenario C: Spur with Active MUX and DMX Units in Remote Terminal T

13.5 Network Topologies for the OPT-RAMP-C and 
OPT-RAMP-CE Cards

The OPT-RAMP-C or OPT-RAMP-CE card can be equipped in any of the following network topologies:

• Open (hubbed) ring network

• Multi-hubbed ring network

• Closed (meshed) ring network

• Any-to-any ring network

• Linear network topology

• Point-to-point linear network topology

• Multi-ring network

• Mesh network

• Hybrid network

For more information about the OPT-RAMP-C or OPT-RAMP-CE card, see Chapter 5, “Provision 
Optical Amplifier Cards.”.
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13.6 Network Topologies for the PSM Card
The PSM card is supported in the following network topologies:

• The PSM card in a channel protection configuration is supported in all network topologies except 
linear networks as it is not possible to configure a working and protect path.

• The PSM card in a multiplex section protection configuration is supported in linear point-to-point 
network topologies.

• The PSM card in a line protection configuration is supported in the following network topologies:

– Linear point-to-point in a single span network (if the OSC card is used).

– Linear point-to-point multispan network when a DCN extension is used (on all spans). In this 
case, the maximum number of span links can be divided into three according to the DCN 
extension optical safety requirements.

• The PSM card in a standalone configuration is supported in all network topologies.

13.7 Optical Performance
This section provides optical performance information for ONS 15454 DWDM networks. The 
performance data is a general guideline based upon the network topology, node type, client cards, fiber 
type, number of spans, and number of channels. The maximum number of nodes that can be in an 
ONS 15454 DWDM network is 16. The DWDM topologies and node types that are supported are shown 
in Table 13-1.

Table 13-1 Supported Topologies and Node Types

Number of Channels Fiber Topologies Node Types

32 channels SMF-281

E-LEAF2

TW-RS3

1. SMF-28 = single-mode fiber 28.

2. E-LEAF = enhanced large effective area fiber.

3. TW-RS = TrueWave reduced slope fiber.

Ring

Linear

Linear without OADM

Hub

Active OADM

Passive OADM

Terminal

Line

OSC regeneration

16 channels SMF-28 Ring

Linear

Linear without OADM

Hub

Active OADM

Passive OADM

Terminal

Line

OSC regeneration

8 channels SMF-28 Linear without OADM Terminal

Line
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13.8 Automatic Power Control
The ONS 15454 automatic power control (APC) feature performs the following functions:

• Maintains constant per channel power when desired or accidental changes to the number of channels 
occur. Constant per channel power increases optical network resilience.

• Compensates for optical network degradation (aging effects).

• Simplifies the installation and upgrade of DWDM optical networks by automatically calculating the 
amplifier setpoints.

Note APC algorithms manage the optical parameters of the OPT-BST, OPT-PRE, OPT-AMP-17-C, 32DMX, 
40-DMX-C, 40-DMX-CE, 40-SMR1-C, 40-SMR2-C, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, and 
32DMX-L cards.

Amplifier software uses a control gain loop with fast transient suppression to keep the channel power 
constant regardless of any changes in the number of channels. Amplifiers monitor the changes to the 
input power and change the output power proportionately according to the calculated gain setpoint. The 
shelf controller software emulates the control output power loop to adjust for fiber degradation. To 
perform this function, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE needs to know the channel 
distribution, which is provided by a signaling protocol, and the expected per channel power, which you 
can provision. The TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card compares the actual amplifier 
output power with the expected amplifier output power and modifies the setpoints if any discrepancies 
occur.

13.8.1 APC at the Amplifier Card Level
In constant gain mode, the amplifier power out control loop performs the following input and output 
power calculations, where G represents the gain and t represents time.

Pout (t) = G * Pin (t) (mW)

Pout (t) = G + Pin (t) (dB)

In a power-equalized optical system, the total input power is proportional to the number of channels. The 
amplifier software compensates for any variation of the input power due to changes in the number of 
channels carried by the incoming signal. 

Amplifier software identifies changes in the read input power in two different instances, t1 and t2, as a 
change in the traffic being carried. The letters m and n in the following formula represent two different 
channel numbers. Pin/ch represents the input power per channel.

Pin (t1)= nPin/ch

Pin (t2) = mPin/ch

Amplifier software applies the variation in the input power to the output power with a reaction time that 
is a fraction of a millisecond. This keeps the power constant on each channel at the output amplifier, even 
during a channel upgrade or a fiber cut.

The per channel power and working mode (gain or power) are set by automatic node setup (ANS). The 
provisioning is conducted on a per-side basis. A preamplifier or a booster amplifier facing Side i is 
provisioned using the Side i parameters present in the node database, where i - A, B, C, D, E, F, G, or H.
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13.8.2   APC at the Shelf Controller Layer
Starting from the expected per channel power, the amplifiers automatically calculate the gain setpoint 
after the first channel is provisioned. An amplifier gain setpoint is calculated in order to make it equal 
to the loss of the span preceding the amplifier itself. After the gain is calculated, the setpoint is no longer 
changed by the amplifier. Amplifier gain is recalculated every time the number of provisioned channels 
returns to zero. If you need to force a recalculation of the gain, move the number of channels back to 
zero.

13.8.2 APC at the Shelf Controller Layer
Amplifiers are managed through software to control changes in the input power caused by changes in 
the number of channels. The software adjusts the output total power to maintain a constant per channel 
power value when the number of input channel changes.

Changes in the network characteristics have an impact on the amplifier input power. Changes in the input 
power are compensated for only by modifying the original calculated gain, because input power changes 
imply changes in the span loss. As a consequence, the gain to span loss established at amplifier start-up 
is no longer satisfied, as shown in Figure 13-23.

Figure 13-23 Using Amplifier Gain Adjustment to Compensate for System Degradation

In Figure 13-23, Node 1 and Node 2 are equipped with booster amplifiers and preamplifiers. The input 
power received at the preamplifier on Node 2 (Pin2) depends on the total power launched by the booster 
amplifier on Node1, Pout1(n) (where n is the number of channels), and the effect of the span attenuation 
(L) between the two nodes. Span loss changes due to aging fiber and components or changes in operating 
conditions. The power into Node 2 is given by the following formula:

Pin2 = LPout1(n)

The phase gain of the preamplifier on Node 2 (GPre-2) is set during provisioning in order to compensate 
for the span loss so that the Node 2 preamplifier output power (Pout-Pre-2) is equal to the original 
transmitted power, as represented in the following formula:

Pout-Pre-2 = L x GPre-2 x Pout1(n)

In cases of system degradation, the power received at Node 2 decreases due to the change of span 
insertion loss (from L to L'). As a consequence of the preamplifier gain control working mode, the 
Node 2 preamplifier output power (Pout-Pre-2) also decreases. The goal of APC at the shelf controller 
layer is simply to detect if an amplifier output change is needed because of changes in the number of 
channels or to other factors. If factors other than changes in the number of channels occur, APC 
provisions a new gain at the Node 2 preamplifier (GPre-2') to compensate for the new span loss, as shown 
in the formula:

GPre-2' = GPre-2 (L/ L') = GPre-2 + [Pout-Pre-2 –Exp(Pout-Pre-2)]

Generalizing on the above relationship, APC is able to compensate for system degradation by adjusting 
working amplifier gain or variable optical attenuation (VOA) and to eliminate the difference between the 
power value read by the photodiodes and the expected power value. The expected power values are 
calculated using:

• Provisioned per channel power value
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• Channel distribution (the number of express, add, and drop channels in the node)

• ASE estimation

Channel distribution is determined by the sum of the provisioned and failed channels. Information about 
provisioned wavelengths is sent to APC on the applicable nodes during circuit creation. Information 
about failed channels is collected through a signaling protocol that monitors alarms on ports in the 
applicable nodes and distributes that information to all the other nodes in the network.

ASE calculations purify the noise from the power level reported from the photodiode. Each amplifier can 
compensate for its own noise, but cascaded amplifiers cannot compensate for ASE generated by 
preceding nodes. The ASE effect increases when the number of channels decreases; therefore, a 
correction factor must be calculated in each amplifier of the ring to compensate for ASE build-up.

APC is a network-level feature that is distributed among different nodes. An APC domain is a set of 
nodes that is controlled by the same instance of APC at the network level. An APC domain optically 
identifies a portion of the network that can be independently regulated. An optical network can be 
divided into several different domains, with the following characteristics:

• Every domain is terminated by two node sides. The node sides terminating domains are:

– Terminal node (any type)

– ROADM node

– Hub node

– Cross-connect (XC) termination mesh node

– Line termination mesh node

• APC domains are shown in both Cisco Transport Controller (CTC) and Transaction Language One 
(TL1).

• In CTC, domains are shown in the network view and reported as a list of spans. Each span is 
identified by a node/side pair, for example:

APC Domain Node_1 Side A, Node_4 Side B
+ Span 1: Node_1 Side A, Node_2 Side B
+ Span 2: Node_2 Side A, Node_3 Side B
+ Span 3: Node_3 Side A, Node_4 Side B 

• APC domains are not refreshed automatically; instead, they are refreshed using a Refresh button.

Inside a domain, the APC algorithm designates a master node that is responsible for starting APC hourly 
or every time a new circuit is provisioned or removed. Every time the master node signals APC to start, 
gain and VOA setpoints are evaluated on all nodes in the network. If corrections are needed in different 
nodes, they are always performed sequentially following the optical paths starting from the master node.

APC corrects the power level only if the variation exceeds the hysteresis thresholds of +/– 0.5 dB. Any 
power level fluctuation within the threshold range is skipped since it is considered negligible. Because 
APC is designed to follow slow time events, it skips corrections greater than 3 dB. This is the typical 
total aging margin that is provisioned during the network design phase. After you provision the first 
channel or the amplifiers are turned up for the first time, APC does not apply the 3 dB rule. In this case, 
APC corrects all the power differences to turn up the node. 

To avoid large power fluctuations, APC adjusts power levels incrementally. The maximum power 
correction is +/– 0.5 dB. This is applied to each iteration until the optimal power level is reached. For 
example, a gain deviation of 2 dB is corrected in four steps. Each of the four steps requires a complete 
APC check on every node in the network. APC can correct up to a maximum of 3 dB on an hourly basis. 
If degradation occurs over a longer time period, APC compensates for it by using all margins that you 
provision during installation.
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13.8.3   APC in a Raman Node with Post-Amplifiers
If no margin is available, adjustments cannot be made because setpoints exceed the ranges. APC 
communicates the event to CTC, Cisco Transport Manager (CTM), and TL1 through an APC Fail 
condition. APC clears the APC fail condition when the setpoints return to the allowed ranges.

APC can be manually disabled. In addition, APC automatically disables itself when:

• An Hardware Fail (HF) alarm is raised by any card in any of the domain nodes.

• A Mismatch Equipment Alarm (MEA) is raised by any card in any of the domain nodes.

• An Improper Removal (IMPROPRMVL) alarm is raised by any card in any of the domain nodes.

• Gain Degrade (GAIN-HDEG), Power Degrade (OPWR-HDEG), and Power Fail (PWR-FAIL) 
alarms are raised by the output port of any amplifier card in any of the domain nodes.

• A VOA degrade or fail alarm is raised by any of the cards in any of the domain nodes.

• The signaling protocol detects that one of the APC instances in any of the domain nodes is no longer 
reachable.

The APC state (Enable/Disable) is located on every node and can be retrieved by the CTC or TL1 
interface. If an event that disables APC occurs in one of the network nodes, APC is disabled on all the 
other nodes and the APC state changes to DISABLE - INTERNAL. The disabled state is raised only by 
the node where the problem occurred to simplify troubleshooting. 

APC raises the following minor, non-service-affecting alarms at the port level in CTC, TL1, and Simple 
Network Management Protocol (SNMP):

• APC Out of Range—APC cannot assign a new setpoint for a parameter that is allocated to a port 
because the new setpoint exceeds the parameter range.

• APC Correction Skipped—APC skipped a correction to one parameter allocated to a port because 
the difference between the expected and current values exceeds the +/– 3 dB security range.

• APC Disabled—APC is disabled, either by a user or internal action.

After the error condition is cleared, the signaling protocol enables APC on the network and the APC 
DISABLE - INTERNAL condition is cleared. Because APC is required after channel provisioning to 
compensate for ASE effects, all optical channel network connection (OCHNC) and optical channel client 
connection (OCHCC) circuits that you provision during the disabled APC state are kept in the 
Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS) (ANSI) or 
Unlocked-disabled,automaticInService (ETSI) service state until APC is enabled. OCHNCs and 
OCHCCs automatically go into the In-Service and Normal (IS-NR) (ANSI) or Unlocked-enabled (ETSI) 
service state only after APC is enabled.

13.8.3 APC in a Raman Node with Post-Amplifiers
After the Raman gain is calculated and the Raman and OSC links are turned up, APC performs the 
following sequence of events:

1. The line amplifier that is downstream of the OPT-RAMP-C or OPT-RAMP-CE card is the first card 
that the APC regulates. The line amplifier is configured as OPT-PRE in ROADM nodes or as 
OPT-LINE in OLA nodes.

After Automatic Power Reduction (APR) is implemented, the working mode of the line amplifier is 
forced to Control Power and remains in the same mode until all the node regulations are complete. 
This ensures that the calculation of the Gain setpoint is accurate during Raman node internal 
regulations. The amplifier signal output power is regulated using the Power (LINE-TX port) 
setpoint.
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13.8.4   APC in a Raman Node without Post-Amplifiers
2. The APC changes the Gain setpoint of the embedded EDFA to reach the value that is equal to Power 
(DC-TX port) value multiplied by the number of active channels.

The APC can set the Gain setpoint of the embedded EDFA (GEDFA) in the following ranges:

– OPT-RAMP-C 10 dB < GEDFA < 18 dB

– OPT-RAMP-CE 7 dB < GEDFA < 13 dB

The internal VOA is set to 0 dB on the DC-TX port. The VOA attenuation is set to zero because the 
actual DCU insertion loss is unknown until the optical payload is transmitted to the card. Therefore 
a proper attenuation setpoint cannot be estimated. When the attenuation value is set to 0 dB, it 
ensures that the system turns up in any circumstance.

3. After the GEDFA is set, APC regulates the power on the VOA (DC-TX port) of the OPT-RAMP-C or 
OPT-RAMP-CE card to match the target Power (COM-TX port) value, and accounts for the actual 
DCU loss.

4. After Steps 2 and 3 are completed, the optical power received on the line amplifier that is 
downstream of the OPT-RAMP-C or OPT-RAMP-CE card becomes fully regulated and stable. The 
Raman tilt and GEDFA tilt are fixed. The APC regulates the value of the Total Power on the LINE-TX 
port of the line amplifier and accounts for the ASE noise contribution.

5. After the value of the total power on the line amplifier becomes a stable value, APC stops the 
regulations and the automatic gain calculation procedure is completed on the line amplifier card. 
The TCC checks if the gain setpoint is within range and eventually changes the working mode of 
the OPT-RAMP-C or OPT-RAMP-CE card to Gain Control mode.

Note If the value of the Raman Total Power was manually provisioned or set by ANS instead of the Raman 
installation wizard, a fiber cut recovery procedure is automatically performed, before APC regulation.

13.8.4 APC in a Raman Node without Post-Amplifiers
After the Raman gain is calculated and the Raman and OSC links are turned up, APC performs the 
following sequence of events:

1. The APC adjusts the VOA attenuation of the OPT-RAMP-C or OPT-RAMP-CE card if the Total 
Power (LINE-TX port) does not match the expected value that is equal to the maximum power 
multiplied by the number of active channels. The VOA attenuation value on the OPT-RAMP-C or 
OPT-RAMP-CE cards is set to 15 dB. This value ensures that the system turns up in any 
circumstance.

2. If a short span is used, the embedded EDFA in the downstream node receives excessive input power 
and is unable to maintain proper per channel power value on its output port as the number of 
channels increase. The APC detects output power saturation on the EDFA of the downstream node 
and increases the value of the VOA attenuation on the upstream node thereby reducing the Power 
(LINE-TX port) value.

13.8.5 Managing APC
The APC status is indicated by four APC states shown in the node view status area:

• Enabled—APC is enabled.

• Disabled—APC was disabled manually by a user.
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• Disable - Internal—APC has been automatically disabled for an internal cause.

• Not Applicable—The node is provisioned to Not DWDM, which does not support APC.

You can view the APC information and disable and enable APC manually on the Maintenance > 
DWDM > APC tab.

Caution When APC is disabled, aging compensation is not applied and circuits cannot be activated. Do not 
disable APC unless it is required for specific maintenance or troubleshooting tasks. Always enable APC 
as soon as the tasks are completed.

The APC subtab provides the following information:

• Position—The slot number, card, and port for which APC information is shown.

• Last Modification—Date and time APC parameter setpoints were last modified. 

• Parameter—The parameter that APC last modified.

• Last Check—Date and time APC parameter setpoints were last verified.

• Side—The side where the APC information for the card and port is shown.

• State—The APC state.

A wrong use of maintenance procedures (for example, the procedures to be applied in case of fiber cut 
repair) can lead the system to raise the APC Correction Skipped alarm. The APC Correction Skipped 
alarm strongly limits network management (for example, a new circuit cannot be turned into IS). The 
Force APC Correction button helps to restore normal conditions by clearing the APC Correction Skipped 
alarm.

The Force APC Correction button must be used under the Cisco TAC surveillance since its misuse can 
lead to traffic loss.

The Force APC Correction button is available in the Card View > Maintenance > APC tab pane in CTC 
for the following cards:

• OPT-PRE

• OPT-BST-E

• OPT-BST

• OPT-AMP-C

• OPT-AMP-17C

• AD-xB

• AD-xC

• 40-SMR1-C

• 40-SMR2-C

This feature is not available for the TL1 interface.
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13.9 Power Side Monitoring
DWDM nodes allow you to view bar graphs of the input and output spectrum on each optical side of the 
node in the Maintenance > DWDM > Side Power Monitoring tab. When you place the mouse over each 
wavelength in the bar chart, the power level and wavelength type are displayed. This feature is available 
on nodes that are installed with cards with Optical Channel Monitoring (OCM) capability.

The Side Power Monitoring panel is divided into Optical Side X subtabs, where X is the optical side. The 
number of subtabs is equal to the number of optical sides in the node. Each subtab displays two bar 
graphs. 

The IN bar graph displays the optical spectrum at the input port (LINE-RX) of the side in the direction 
from the fiber to the node provided the OCM functionality is available on this port else the graph displays 
the aggregate signal spectral distribution on the first port in the signal flow (indicated in the title of the 
bar chart) that is downstream of the LINE-RX port where an OCM measurement is available (For 
example, in node using a booster and a 40-SMR1-C card, the measurement is done on the EXP port of 
the 40-SMR1-C card). 

The OUT bar graph displays the optical spectrum at the output port (LINE-TX) of the side in the 
direction from the node to the fiber provided the OCM functionality is available on this port else the 
graph displays the aggregate signal spectral distribution on the first port (indicated in the title of the bar 
chart) that is upstream of the LINE-TX port where an OCM measurement is available.

Note Depending on the side layout, the LINE-TX port (output) and the LINE-RX port (input) of the card 
facing the fiber cannot measure the optical spectrum in a reliable manner if the OCM functionality is not 
available on these ports. 

When you place the mouse over each wavelength in the bar chart, the power level and the wavelength 
type (local ADD/DROP or EXPRESS) are displayed as a ScreenTip.

• IN graph: The Screen Tip displays the destination side of each wavelength. The wavelength is either 
dropped locally or expressed to another side (see Figure 13-24).

• OUT graph: The Screen Tip displays the source side of each wavelength. The wavelength is either 
added locally or expressed from another side (see Figure 13-25).
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13.9   Power Side Monitoring
Figure 13-24 Side Power Monitoring Subtab
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13.10   Span Loss Verification
Figure 13-25 Side Power Monitoring Subtab

13.10 Span Loss Verification
Span loss measurements can be performed from the Maintenance > DWDM > WDM Span Check tab. 
The CTC span check compares the far-end OSC power with the near-end OSC power. A Span Loss Out 
of Range condition is raised when the measured span loss is higher than the maximum expected span 
loss. It is also raised when the measured span loss is lower than the minimum expected span loss and the 
difference between the minimum and maximum span loss values is greater than 1 dB. The minimum and 
maximum expected span loss values are calculated by Cisco TransportPlanner for the network and 
imported into CTC. However, you can manually change the minimum and expected span loss values.

CTC span loss measurements provide a quick span loss check and are useful whenever changes to the 
network occur, for example after you install equipment or repair a broken fiber. CTC span loss 
measurement resolutions are:

• +/– 1.5 dB for measured span losses between 0 and 25 dB

• +/– 2.5 dB for measured span losses between 25 and 38 dB

For ONS 15454 span loss measurements with higher resolutions, an optical time domain reflectometer 
(OTDR) must be used. 
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13.10.1   Span Loss Measurements on Raman Links
Note From Software Release 9.0 onwards, span loss measurement is performed using C-band channels 
(whenever available), instead of OSC signals. Software Release 9.0 is not interoperable with earlier 
releases that are only OSC-based. Therefore, span loss measurement cannot be done on a span if the 
adjacent nodes are running different software releases; for example one node running Software Release 
8.0 or an earlier release and the second node running Software Release 9.0 or a later release.

13.10.1 Span Loss Measurements on Raman Links
Span loss measurement when Raman amplification is active is less accurate than a standard link as it is 
based on a mathematical formula that uses the Raman noise and Raman gain.

Span loss on a Raman link is measured in the following states:

• Automatically during Raman link setup (without Raman amplification)

• Automatically during fiber cut restore (without Raman amplification)

• Periodically or upon request (with Raman amplification) 

CTC reports three values in the Maintenance > DWDM > WDM Span Check tab:

• Current Span Measure with Raman—Estimated span loss with Raman pump turned ON.

• Wizard Span Measure with Raman Off—Span loss with Raman pump turned OFF, during Raman 
installation.

• Last Span Measure with Raman—Span loss after a fiber cut restoration procedure. 

Measurements are performed automatically on an hourly basis. 

A Span Loss Out of Range condition is raised under the following conditions:

• Span loss is greater than the maximum expected span loss + resolution

• Span loss is less than the minimum expected span loss – resolution

The minimum and maximum expected span loss values are calculated by Cisco Transport Planner for the 
network and imported into CTC. However, you can manually change the minimum and maximum 
expected span loss values.

Note During Raman installation using a wizard, the Span Loss Out of Range alarm is not raised when the out 
of range condition is raised. In such a case, the wizard fails and an error message is displayed, and the 
span is not tuned.

CTC span loss measurements provide a quick span loss check and are useful whenever changes to the 
network occur, for example after you install equipment or repair a broken fiber. CTC span loss 
measurement resolutions are:

• +/– 1.5 dB for span loss measurements between 0 and 26 dB

• +/– 2.0 dB for span loss measurements between 26 and 31 dB

• +/– 3.0 dB for span loss measurements between 31 and 34 dB

• +/– 4.0 dB for span loss measurements between 34 and 36 dB
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13.11 Network Optical Safety
If a fiber break occurs on the network, automatic laser shutdown (ALS) automatically shuts down the 
OSCM and OSC-CSM OSC laser output power and the optical amplifiers contained in the OPT-BST, 
OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C, OPT-RAMP-C, 
OPT-RAMP-CE, 40-SMR1-C, and 40-SMR2-C cards, and the TX VOA in the protect path of the PSM 
card (in line protection configuration only). (Instead, the PSM active path will use optical safety 
mechanism implemented by the booster amplifier or OSC-CSM card that are mandatory in the line 
protection configuration.)

The Maintenance > ALS tab in CTC card view provide the following ALS management options for 
OSCM, OSC-CSM, OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C, 
OPT-RAMP-C, OPT-RAMP-CE, 40-SMR1-C, 40-SMR2-C, and PSM (on the protect path, only in line 
protection configuration) cards:

• Disable—ALS is off. The OSC laser transmitter and optical amplifiers are not automatically shut 
down when a traffic outage loss of signal (LOS) occurs.

• Auto Restart—ALS is on. The OSC laser transmitter and optical amplifiers automatically shut down 
when traffic outages (LOS) occur. It automatically restarts when the conditions that caused the 
outage are resolved. Auto Restart is the default ALS provisioning for OSCM, OSC-CSM, OPT-BST, 
OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C, OPT-RAMP-C, 
OPT-RAMP-CE, 40-SMR1-C, 40-SMR2-C, and PSM (on the protect path, only in line protection 
configuration) cards.

• Manual Restart—ALS is on. The OSC laser transmitter and optical amplifiers automatically shut 
down when traffic outages (LOS) occur. However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

• Manual Restart for Test—Manually restarts the OSC laser transmitter and optical amplifiers for 
testing.

13.11.1 Automatic Laser Shutdown
When ALS is enabled on OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, 
OPT-AMP-17-C, OPT-RAMP-C, OPT-RAMP-CE, 40-SMR1-C, 40-SMR2-C, PSM (on the protect path, 
only in line protection configuration), OSCM, OSC-CSM, TNC, and TNCE cards, a network safety 
mechanism will occur in the event of a system failure. ALS provisioning is also provided on the 
transponder (TXP) and muxponder (MXP) cards. However, if a network uses ALS-enabled OPT-BST, 
OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C, OPT-RAMP-C, 
OPT-RAMP-CE, 40-SMR1-C, 40-SMR2-C, PSM (on the protect path, only in line protection 
configuration), OSCM, and OSC-CSM cards, ALS does not need to be enabled on the TXP cards or MXP 
cards. ALS is disabled on TXP and MXP cards by default and the network optical safety is not impacted.

If TXP and MXP cards are connected directly to each other without passing through a DWDM layer, 
ALS should be enabled on them. The ALS protocol goes into effect when a fiber is cut, enabling some 
degree of network point-to-point bidirectional traffic management between the cards.

If ALS is disabled on the OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, 
OPT-AMP-17-C, OPT-RAMP-C, OPT-RAMP-CE, 40-SMR1-C, 40-SMR2-C, PSM (on the protect path, 
only in line protection configuration), OSCM, and OSC-CSM cards (the DWDM network), ALS can be 
enabled on the TXP and MXP cards to provide laser management in the event of a fiber break in the 
network between the cards.
13-30
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 13      Network Reference
13.11.2   Automatic Power Reduction
13.11.2 Automatic Power Reduction
Automatic power reduction (APR) is controlled by the software and is not user configurable. During 
amplifier restart after a system failure, the amplifier (OPT-BST, for example) operates in pulse mode and 
an APR level is activated so that the Hazard Level 1 power limit is not exceeded. This is done to ensure 
personnel safety.

When a system failure occurs (cut fiber or equipment failure, for example) and ALS Auto Restart is 
enabled, a sequence of events is placed in motion to shut down the amplifier laser power, then 
automatically restart the amplifier after the system problem is corrected. As soon as a loss of optical 
payload and OSC is detected at the far end, the far-end amplifier shuts down. The near-end amplifier 
then shuts down because it detects a loss of payload and the OSC shuts down due to the far-end amplifier 
shutdown. At this point, the near end attempts to establish communication to the far end using the OSC 
laser transmitter. To do this, the OSC emits a two-second pulse at very low power (maximum of 0 dBm) 
and waits for a similar two-second pulse in response from the far-end OSC laser transmitter. If no 
response is received within 100 seconds, the near end tries again. This process continues until the near 
end receives a two-second response pulse from the far end, indicating the system failure is corrected and 
full continuity in the fiber between the two ends exists.

After the OSC communication is established, the near-end amplifier is configured by the software to 
operate in pulse mode at a reduced power level. It emits a nine-second laser pulse with an automatic 
power reduction to +8 dBm. (For 40-SMR1-C and 40-SMR2-C cards, the pulse is not +8 dBm but it is 
the per channel power setpoint.) This level assures that Hazard Level 1 is not exceeded, for personnel 
safety, even though the establishment of successful OSC communication is assurance that any broken 
fiber is fixed. If the far-end amplifier responds with a nine-second pulse within 100 seconds, both 
amplifiers are changed from pulse mode at reduced power to normal operating power mode.

For a direct connection between TXP or MXP cards, when ALS Auto Restart is enabled and the 
connections do not pass through a DWDM layer, a similar process takes place. However, because the 
connections do not go through any amplifier or OSC cards, the TXP or MXP cards attempt to establish 
communication directly between themselves after a system failure. This is done using a two-second 
restart pulse, in a manner similar to that previously described between OSCs at the DWDM layer. The 
power emitted during the pulse is below Hazard Level 1.

APR is also implemented on the PSM card (on the protect path, only in line protection configuration). 
In the PSM line protection configuration, when a system failure occurs on the working path (cut fiber or 
equipment failure, for example), the ALS and APR mechanisms are implemented by the booster 
amplifier or the OSC-CSM card. Alternately, when a system failure occurs on the protect path, and ALS 
Auto Restart is enabled on the PSM card, a sequence of events is placed in motion to shut down the TX 
VOA on the protect path, and then automatically restart it after the system failure is corrected. During 
protect path restart, the TX VOA on the protect path operates in pulse mode and limits the power to 
maximum +8 dBm so that the Hazard Level 1 power limit is not exceeded on protect TX path.

When ALS is disabled, the warning Statement 1056 is applicable.

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Note If you must disable ALS, verify that all fibers are installed in a restricted location. Enable ALS 
immediately after finishing the maintenance or installation process.
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13.11.3   Network Optical Safety on OPT-RAMP-C and OPT-RAMP-CE Cards
Note For the line amplifier to start up automatically, disable the ALS on the terminal node that is 
unidirectional.

13.11.3 Network Optical Safety on OPT-RAMP-C and OPT-RAMP-CE Cards
Optical safety on the OPT-RAMP-C and OPT-RAMP-CE cards is implemented in the RAMAN-TX and 
COM-TX ports. RAMAN-TX will report safety settings associated to the Raman pump while the 
COM-TX port will report safety settings associated with the embedded EDFA.

13.11.3.1 RAMAN-TX Settings on Raman Pump

The Raman pump is automatically turned off as soon as the LOS alarm is detected on the LINE-RX port. 
The Raman pump is automatically turned on at APR power every 100 secs for a duration of 9 seconds at 
a pulse power of at 8 dBm, as soon as the LINE-RX port is set to IS-NR/unlocked-enabled. 

Note Optical safety cannot be disabled on the OPT-RAMP-C and OPT-RAMP-CE cards and cannot be 
disabled on OSCM cards when connected to a OPT-RAMP-C or OPT-RAMP-CE card.

The system periodically verifies if the signal power is present on the LINE-RX port. If signal power is 
present, the following occurs:

• Pulse duration is extended.

• Raman pumps are turned on at APR power, if the laser was shut down. 

The Raman power is then moved to setpoint if power is detected for more than 10 seconds. During 
Automatic Laser Restart (ALR) the safety is enabled. The laser is automatically shut down if LOS is 
detected on the receiving fiber. In general Raman pump turns on only when Raman signals are detected. 
However, the Raman pump can be configured to turn on to full power even when OSC power is detected 
for more than 9 seconds on OSC-RX port.

13.11.3.2 COM-TX Safety Setting on EDFA

EDFA is shutdown automatically under the following conditions:

• The Raman pumps shut down. 

• An LOS-P alarm is detected on the COM-RX port.

If EDFA was shut down because of Raman pump shut down, the EDFA restarts by automatically turning 
on the EDFA lasers as soon as the Raman loop is closed. 

• Pulse duration: 9 seconds

• Pulse power: 8 dB (maximum APR power foreseen by safety regulation)

• Exit condition: Received power detected on the DC-RX port at the end of APR pulse. If power is 
detected on DC-RX (so DCU is connected) EDFA moves to set-point; otherwise, it keeps 9 dB as 
the output power at restart 

• EDFA moves to the power setpoint when power is detected on the DC-RX port.

If EDFA was shutdown because of an LOS-P alarm. The EDFA restarts by automatically turning on the 
EDFA laser as soon as an LOS-P alarm on the COM-RX port is cleared, and the Raman loop is closed.
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• Pulse duration: 9 seconds

• Pulse power: 8 dB (maximum APR power foreseen by safety regulation)

• Exit condition: Received power detected on the LINE-RX port at the end of the APR pulse 

Warning All ONS 15454 users must be properly trained on laser safety hazards in accordance with IEC 60825-2, 
or ANSI Z136.1.

13.11.4 Fiber Cut Scenarios
In the following paragraphs, four ALS scenarios are given: 

• 13.11.4.1 Scenario 1: Fiber Cut in Nodes Using OPT-BST/OPT-BST-E Cards, page 13-33

• 13.11.4.2 Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards, page 13-35

• 13.11.4.3 Scenario 3: Fiber Cut in Nodes Using OPT-BST-L Cards, page 13-37

• 13.11.4.4 Scenario 4: Fiber Cut in Nodes Using OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C 
(OPT-LINE Mode), 40-SMR1-C, or 40-SMR2-C Cards, page 13-38

• 13.11.4.5 Scenario 5: Fiber Cut in Nodes Using DCN Extension, page 13-40

• 13.11.4.6 Scenario 6: Fiber Cut in Nodes Using OPT-RAMP-C or OPT-RAMP-CE Cards, 
page 13-41

• 13.11.4.7 Scenario 7: Fiber Cut in Optical Line Amplifier Nodes Using OPT-RAMP-C or 
OPT-RAMP-CE Cards, page 13-43

13.11.4.1 Scenario 1: Fiber Cut in Nodes Using OPT-BST/OPT-BST-E Cards

Figure 13-26 shows nodes using OPT-BST/OPT-BST-E cards with a fiber cut between them.
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Figure 13-26 Nodes Using OPT-BST/OPT-BST-E Cards

Two photodiodes at Node B monitor the received signal strength for the optical payload and OSC signals. 
When the fiber is cut, an LOS is detected at both of the photodiodes. The AND function then indicates 
an overall LOS condition, which causes the OPT-BST/OPT-BST-E transmitter, OPT-PRE transmitter, 
and OSCM lasers to shut down. This in turn leads to an LOS for both the optical payload and OSC at 
Node A, which causes Node A to turn off the OSCM, OPT-PRE transmitter, and OPT-BST/OPT-BST-E 
transmitter lasers. The sequence of events after a fiber cut is as follows (refer to the numbered circles in 
Figure 13-26):

1. Fiber is cut.

2. The Node B power monitoring photodiode detects a Loss of Incoming Payload (LOS-P) on the 
OPT-BST/OPT-BST-E card. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

3. On the OPT-BST/OPT-BST-E card, the simultaneous LOS-O and LOS-P detection triggers a 
command to shut down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O 
and LOS-P are demoted. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

4. The OPT-BST/OPT-BST-E card amplifier is shut down within one second.

5. The OSCM laser is shut down.

6. The OPT-PRE card automatically shuts down due to a loss of incoming optical power. 

7. The Node A power monitoring photodiode detects a LOS-O on the OPT-BST/OPT-BST-E card and 
the OSCM card detects a LOS (OC3) at the SONET layer. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide.

8. The Node A power monitoring photodiode detects a LOS-P on the OPT-BST/OPT-BST-E card. 
Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

OPT-BST/OPT-BST-E OPT-BST/OPT-BST-E

P

P

P

OSCM

PP
OSCM

= power monitoring photodiode

= logical AND function

Node A
Side B

Node B
Side A

X
11

1

7

13

10

9 8

12

6

2 3

4

5

2

8

12
09

88

OPT-PRE

OPT-PRE
13-34
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 13      Network Reference
13.11.4   Fiber Cut Scenarios
9. On the OPT-BST/OPT-BST-E, the simultaneous LOS-O and LOS-P detection triggers a command 
to shut down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P 
are demoted. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

10. The OPT-BST/OPT-BST-E card amplifier is shut down within one second.

11. The OSCM laser is shut down.

12. The Node A OPT-PRE card automatically shuts down due to a loss of incoming optical power.

When the fiber is repaired, either an automatic or manual restart at the Node A OPT-BST/OPT-BST-E 
transmitter or at the Node B OPT-BST/OPT-BST-E transmitter is required. A system that has been shut 
down is reactivated through the use of a restart pulse. The pulse is used to signal that the optical path has 
been restored and transmission can begin. For example, when the far end, Node B, receives a pulse, it 
signals to the Node B OPT-BST/OPT-BST-E transmitter to begin transmitting an optical signal. The 
OPT-BST/OPT-BST-E receiver at Node A receives that signal and signals the Node A 
OPT-BST/OPT-BST-E transmitter to resume transmitting.

Note During a laser restart pulse, APR ensures that the laser power does not exceed Class 1 limits. See the 
“13.11.2 Automatic Power Reduction” section on page 13-31 for more information about APR.

13.11.4.2 Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards

Figure 13-27 shows nodes using OSC-CSM cards with a fiber cut between them.
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Figure 13-27 Nodes Using OSC-CSM Cards

Two photodiodes at the Node B OSC-CSM card monitor the received signal strength for the received 
optical payload and OSC signals. When the fiber is cut, LOS is detected at both of the photodiodes. The 
AND function then indicates an overall LOS condition, which causes the Node B OSC laser to shut down 
and the optical switch to block traffic. This in turn leads to LOS for both the optical payload and OSC 
signals at Node A, which causes Node A to turn off the OSC laser and the optical switch to block 
outgoing traffic. The sequence of events after a fiber cut is as follows (refer to the numbered circles in 
Figure 13-27):

1. Fiber is cut.

2. The Node B power monitoring photodiode detects a LOS-P on the OSC-CSM card. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

3. On the OSC-CSM, the simultaneous LOS-O and LOS-P detection triggers a change in the position 
of the optical switch. CTC reports a LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

4. The optical switch blocks outgoing traffic.

5. The OSC laser is shut down.

6. The Node A power monitoring photodiode detects a LOS-O on the OSC-CSM card. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

7. The Node A power monitoring photodiode detects a LOS-P on the OSC-CSM card. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide.
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8. On the OSC-CSM, the simultaneous LOS-O and LOS-P detection triggers a change in the position 
of the optical switch. CTC reports a LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

9. The OSC laser is shut down.

10. The optical switch blocks outgoing traffic.

When the fiber is repaired, either an automatic or manual restart at the Node A OSC-CSM card OSC or 
at the Node B OSC-CSM card OSC is required. A system that has been shut down is reactivated through 
the use of a restart pulse. The pulse indicates the optical path is restored and transmission can begin. For 
example, when the far-end Node B receives a pulse, it signals to the Node B OSC to begin transmitting 
its optical signal and for the optical switch to pass incoming traffic. The OSC-CSM at Node A then 
receives the signal and tells the Node A OSC to resume transmitting and for the optical switch to pass 
incoming traffic.

13.11.4.3 Scenario 3: Fiber Cut in Nodes Using OPT-BST-L Cards

Figure 13-28 shows nodes using OPT-BST-L cards with a fiber cut between them.

Figure 13-28 Nodes Using OPT-BST-L Cards

Two photodiodes at Node B monitor the received signal strength for the optical payload and OSC signals. 
When the fiber is cut, an LOS is detected at both of the photodiodes. The AND function then indicates 
an overall LOS condition, which causes the OPT-BST-L transmitter and OSCM lasers to shut down. This 
in turn leads to an LOS for both the optical payload and the OSC at Node A, which causes Node A to 
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turn off the OSCM OSC transmitter and OPT-BST-L amplifier lasers. The sequence of events after a fiber 
cut is as follows (refer to the numbered circles in Figure 13-28):

1. Fiber is cut.

2. The Node B power monitoring photodiode detects an LOS-P on the OPT-BST-L card. For more 
information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

3. On the OPT-BST-L card, the simultaneous LOS-O and LOS-P detection triggers a command to shut 
down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. For more information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting 
Guide.

4. The OPT-BST-L card amplifier is shut down within one second.

5. The OSCM laser is shut down.

6. The OPT-AMP-L, OPT-AMP-C, or OPT-AMP-17-C card automatically shuts down due to a loss of 
incoming optical power. 

7. The Node A power monitoring photodiode detects an LOS-O on the OPT-BST-L card and the OSCM 
card detects an LOS (OC3) at the SONET layer. For more information on alarms, refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

8. The Node A power monitoring photodiode detects an LOS-P on the OPT-BST-L card. For more 
information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

9. On the OPT-BST-L, the simultaneous LOS-O and LOS-P detection triggers a command to shut down 
the amplifier. CTC reports an LOS alarm (loss of continuity), while the LOS-O and LOS-P are 
demoted. For more information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting 
Guide.

10. The OPT-BST-L card amplifier is shut down within one second.

11. The OSCM laser is shut down.

12. The Node A OPT-AMP-L, OPT-AMP-C, or OPT-AMP-17-C card automatically shuts down due to 
an LOS for the incoming optical power.

When the fiber is repaired, either an automatic or manual restart at the Node A OPT-BST-L transmitter 
or at the Node B OPT-BST-L transmitter is required. A system that has been shut down is reactivated 
through the use of a restart pulse. The pulse indicates the optical path is restored and transmission can 
begin. For example, when the far end, Node B, receives a pulse, it signals to the Node B OPT-BST-L 
transmitter to begin transmitting an optical signal. The OPT-BST-L receiver at Node A receives that 
signal and signals the Node A OPT-BST-L transmitter to resume transmitting.

Note During a laser restart pulse, APR ensures that the laser power does not exceed Class 1 limits. See the 
“13.11.2 Automatic Power Reduction” section on page 13-31 for more information about APR.

13.11.4.4 Scenario 4: Fiber Cut in Nodes Using OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C (OPT-LINE 
Mode), 40-SMR1-C, or 40-SMR2-C Cards

Figure 13-29 shows nodes using OPT-AMP-L, OPT-AMP-C, OPT-AMP-17-C (in OPT-LINE mode), 
40-SMR1-C, or 40-SMR2-C cards with a fiber cut between them. 

Note A generic reference to the OPT-AMP card refers to the OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, 
40-SMR1-C, or 40-SMR2-C cards.
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Figure 13-29 Nodes Using OPT-AMP Cards

Two photodiodes at Node B monitor the received signal strength for the optical payload and OSC signals. 
When the fiber is cut, an LOS is detected at both of the photodiodes. The AND function then indicates 
an overall LOS condition, which causes the OPT-AMP card amplifier transmitter and OSCM card OSC 
lasers to shut down. This in turn leads to an LOS for both the optical payload and OSC at Node A, which 
causes Node A to turn off the OSCM card OSC and OPT-AMP card amplifier lasers. The sequence of 
events after a fiber cut is as follows (refer to the numbered circles in Figure 13-29):

1. Fiber is cut.

2. The Node B power monitoring photodiode detects an LOS-P on the OPT-AMP card. For more 
information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

3. On the OPT-AMP card, the simultaneous LOS-O and LOS-P detection triggers a command to shut 
down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. For more information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting 
Guide.

4. The OPT-AMP card amplifier is shut down within one second.

5. The OSCM card laser is shut down.

6. The Node A power monitoring photodiode detects an LOS-O on the OPT-AMP card and the OSCM 
card detects an LOS (OC3) at the SONET layer. For more information on alarms, refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

7. The Node A power monitoring photodiode detects an LOS-P on the OPT-AMP card. For more 
information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.
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8. On the OPT-AMP card, the simultaneous LOS-O and LOS-P detection triggers a command to shut 
down the amplifier. CTC reports an LOS alarm (loss of continuity), while LOS-O and LOS-P are 
demoted. For more information on alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting 
Guide.

9. The OPT-AMP card amplifier is shut down within one second.

10. The OSCM card laser is shut down.

When the fiber is repaired, either an automatic or manual restart at the Node A OPT-AMP card 
transmitter or at the Node B OPT-AMP card transmitter is required. A system that has been shut down 
is reactivated through the use of a restart pulse. The pulse indicates that the optical path is restored and 
transmission can begin. For example, when the far end, Node B, receives a pulse, it signals to the Node B 
OPT-AMP card transmitter to begin transmitting an optical signal. The OPT-AMP card receiver at Node 
A receives that signal and signals the Node A OPT-AMP card transmitter to resume transmitting.

Note During a laser restart pulse, APR ensures that the laser power does not exceed Class 1 limits. See the 
“13.11.2 Automatic Power Reduction” section on page 13-31 for more information about APR.

13.11.4.5 Scenario 5: Fiber Cut in Nodes Using DCN Extension

Figure 13-30 shows a fiber cut scenario for nodes that do not have OSC connectivity. In the scenario, 
references to the OPT-BST cards refers to the OPT-BST, OPT-BST-L, OPT-BST-E, OPT-AMP-L, 
OPT-AMP-C, OPT-AMP-17-C, 40-SMR1-C, and 40-SMR2-C cards when provisioned in OPT-LINE 
mode.

Figure 13-30 Fiber Cut With DCN Extension
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Two photodiodes at Node B monitor the received signal strength for the optical payload. When the fiber 
is cut, an LOS is detected on the channel photodiode while the other one never gets a signal because the 
OSC is not present. The AND function then indicates an overall LOS condition, which causes the 
OPT-BST amplifier transmitter to shut down. This in turn leads to a LOS for the optical payload at 
Node A, which causes Node A to turn off the OPT-BST amplifier lasers. 

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-30):

1. Fiber is cut.

2. The Node B power monitoring photodiode detects an LOS on the OPT-BST card. Refer to the Cisco 
ONS 15454 DWDM Troubleshooting Guide for LOS troubleshooting procedures.

3. On the OPT-BST card, the LOS detection triggers a command to shut down the amplifier. Refer to 
the Cisco ONS 15454 DWDM Troubleshooting Guide for alarm troubleshooting procedures.

4. The OPT-BST card amplifier is shut down within one second.

5. The Node A power monitoring photodiode detects a LOS on the OPT-BST card. Refer to the Cisco 
ONS 15454 DWDM Troubleshooting Guide for alarm troubleshooting procedures.

6. On the OPT-BST, the LOS detection triggers a command to shut down the amplifier. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

7. The OPT-BST card amplifier is shut down within one second.

When the fiber is repaired, a manual restart with 9 sec restart pulse time (MANUAL RESTART) is 
required at the Node A OPT-BST transmitter and at the Node B OPT-BST transmitter. A system that has 
been shut down is reactivated through the use of a 9 sec restart pulse. The pulse indicates that the optical 
path is restored and transmission can begin. 

For example, when the far end, Node B, receives a pulse, it signals to the Node B OPT-BST transmitter 
to begin transmitting an optical signal. The OPT-BST receiver at Node A receives that signal and signals 
the Node A OPT-BST transmitter to resume transmitting.

Note During a laser restart pulse, APR ensures that the laser power does not exceed Class 1 limits. See the 
“13.11.2 Automatic Power Reduction” section on page 13-31 for more information about APR.

13.11.4.6 Scenario 6: Fiber Cut in Nodes Using OPT-RAMP-C or OPT-RAMP-CE Cards

Figure 13-31 shows a fiber cut scenario for nodes using OPT-RAMP-C or OPT-RAMP-CE cards.
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Figure 13-31 Nodes Using OPT-RAMP-C or OPT-RAMP-CE Cards

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-31):

1. Fiber is cut in the direction of Node A to Node B.

2. No alarms are initially detected on Node B. The Raman pumps are still in ON state and continue to 
pump power on to the broken fiber. The residual Raman noise propagated towards the LINE-RX port 
keeps the embedded EDFA active. The LOS alarm is not raised on the DC-TX port because the 
EDFA continues to transmit minimum output power to the line amplifier that it is connected to.

3. On Node A, the OPT-RAMP-C card no longer receives the Raman remnant pump signal on the 
LINE-TX port. The RAMAN-RX port detects an LOS-R alarm on the OPT-RAMP-C or 
OPT-RAMP-CE card. The OSCM card that is connected to the OPT-RAMP-C card detects OSC 
failure and raises a LOS alarm at the OC-3 level. For the LOS-R troubleshooting procedures, see the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

4. On the OPT-RAMP-C or OPT-RAMP-CE card, the LOS-R alarm triggers a command to shut down 
the Raman pump on Node A.

5. On Node A, the LOS alarm on the OSCM card causes a laser TX shutdown because ALS is always 
enabled on the OSCM card. This results in the OPT-RAMP-C or OPT-RAMP-CE card raising the 
LOS-O alarm on the OSC-RX port.

6. Because the Raman pump on Node A is shutdown, the RAMAN-RX port detects an LOS-R alarm 
on Node B.

7. The LOS-R alarm triggers a command to shut down the Raman pump on Node B.

8. The embedded EDFA on Node B no longer receives residual power Raman noise. An LOS alarm is 
detected on the input port of the EDFA that causes the embedded EDFA to shut down.

9. The LINE-RX port of the line amplifier on Node B that receives the payload signal from the 
embedded EDFA of the OPT-RAMP-C card detects an LOS alarm.

10. The LOS alarm triggers an ALS and causes the line amplifier to shut down. 

11. The COM-RX port of the OPT-RAMP-C card on Node B and consequently the LINE-TX port that 
is connected to Node A through the safe fiber, no longer receive power.
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12. Because the OSCM card on Node A is in the ALS condition, there is no OSC signal on the LINE-TX 
port of the OSCM card on Node B that raises an LOS alarm.

13. The LOS alarm on the OSCM card causes a laser TX shutdown that raises an LOS-O alarm on the 
OSC-RX port of the OPT-RAMP-C card on Node B. The simultaneous presence of an LOS-O alarm 
on the OSC-RX port and an LOS-R alarm on the RAMAN-RX port of the OPT-RAMP-C card can 
be interpreted as a fiber cut and an LOS alarm is generated on the LINE-RX port.

14. On Node A, the LINE-RX port of the OPT-RAMP-C card detects an LOS alarm because the C-band 
payload is absent and triggers a command to shut down the embedded EDFA.

15. The line amplifier that receives the payload signal from the embedded EDFA of the OPT-RAMP-C 
card detects an LOS alarm on its LINE-RX port and causes the line amplifier to shut down. The 
C-band power is no longer transmitted to the COM-RX port of the OPT-RAMP-C card and 
subsequently to the LINE-TX port that connected to the broken fiber.

An Automatic Laser Restart (ALR) on the Raman pump is detected when the fiber is restored. This turns 
both the Raman pumps to ON state, on both the nodes. When the power on the Raman pump is restored, 
it turns on the embedded EDFA also. The booster amplifiers on both Node A and Node B detect power 
on the LINE-RX port. This restarts the booster amplifier. 

Once the active TCC of the Raman node detects a stable condition, the link is automatically revaluated. 
The TCC initiates a fiber restoration procedure as described in 13.11.4.8 Fiber Cut Recovery in Nodes 
Using OPT-RAMP-C or OPT-RAMP-CE Cards, page 13-48. The procedure takes a maximum of one or 
two minutes and causes a temporary transient condition on C-band signals.

13.11.4.7 Scenario 7: Fiber Cut in Optical Line Amplifier Nodes Using OPT-RAMP-C or OPT-RAMP-CE 
Cards 

In the following sections, fiber cut scenarios for three node layouts are given:

13.11.4.7.1 Scenario 7A—Node Equipped With OPT-RAMP-C or OPT-RAMP-CE Cards on Side A and Side B.

Figure 13-32 shows a fiber cut scenario for a node equipped with OPT-RAMP-C or OPT-RAMP-CE 
cards on Side A and Side B.
13-43
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 13      Network Reference
13.11.4   Fiber Cut Scenarios
Figure 13-32 Nodes Using OPT-RAMP-C or OPT-RAMP-CE Cards on Side A and B

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-32):

1. The fiber that is connected to the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on 
Side A of Node A is cut. The Raman link goes down.

2. The RAMAN-RX port detects an LOS-R alarm on the OPT-RAMP-C or OPT-RAMP-CE card on 
Side A. For LOS-R troubleshooting procedures, see the Cisco ONS 15454 DWDM Troubleshooting 
Guide.

3. On the OPT-RAMP-C or OPT-RAMP-CE card, the LOS-R alarm triggers a command to shut down 
the Raman pump on Side A.

4. No power is detected by the embedded EDFA on the LINE-RX port of the OPT-RAMP-C or 
OPT-RAMP-CE card on Side A.

5. The embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE card on Side A is automatically 
shutdown.

6. An LOS-P alarm is detected on the COM-RX port of the OPT-RAMP-C or OPT-RAMP-CE card on 
Side B of Node A.

7. The LOS-P alarm triggers an ALS of the embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE 
card on Side B.

8. No C-band power is transmitted out of the COM-TX port of the OPT-RAMP-C or OPT-RAMP-CE 
card on Side B, to the COM-RX port and subsequently to the LINE-TX port of the OPT-RAMP-C 
or OPT-RAMP-CE card on Side A that is connected to the broken fiber.

For information about fiber cut recovery, see the “13.11.4.8 Fiber Cut Recovery in Nodes Using 
OPT-RAMP-C or OPT-RAMP-CE Cards” section on page 13-48.
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13.11.4.7.2 Scenario 7B—Node Equipped With OPT-RAMP-C or OPT-RAMP-CE and Booster Cards on Side A and OPT-RAMP-C 
or OPT-RAMP-CE Cards on Side B.

Scenario 1—Fiber cut on the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on Side A 
(Figure 13-33).

Figure 13-33 Nodes Using OPT-RAMP-C or OPT-RAMP-CE and Booster Cards on Side A and 

OPT-RAMP-CE Cards on Side B - Scenario 1

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-33):

1. The fiber that is connected to the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on 
Side A of Node A is cut.The Raman link goes down.

2. The RAMAN-RX port detects an LOS-R alarm on the OPT-RAMP-C or OPT-RAMP-CE card. For 
LOS-R troubleshooting procedures, see the Cisco ONS 15454 DWDM Troubleshooting Guide.

3. On the OPT-RAMP-C or OPT-RAMP-CE card, the LOS-R alarm triggers a command to shut down 
the Raman pump on Side A.

4. No power is detected by the embedded EDFA on the LINE-RX port of the OPT-RAMP-C or 
OPT-RAMP-CE card on Side A.

5. The embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE card on Side A is automatically 
shutdown.

6. An LOS alarm is detected on the downstream line amplifier on Side A of Node A since it no longer 
receives the optical payload from the embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE 
card. 

7. The ALS mechanism causes the line amplifier to shut down. 

8. The C-band power is no longer transmitted out of the line amplifier to the COM-RX port and 
subsequently to the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card that is connected 
to the broken fiber.
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For information about fiber cut recovery, see the “13.11.4.8 Fiber Cut Recovery in Nodes Using 
OPT-RAMP-C or OPT-RAMP-CE Cards” section on page 13-48.

Scenario 2—Fiber cut on the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on Side B 
(Figure 13-34).

Figure 13-34 Nodes Using OPT-RAMP-C or OPT-RAMP-CE and Booster Cards on Side A and 

OPT-RAMP-CE Cards on Side B - Scenario 2

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-34):

1. The fiber that is connected to the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on 
Side B of Node A is cut. 

2. An LOS-R alarm is detected on the OPT-RAMP-C or OPT-RAMP-CE card on Side B because it no 
longer receives the Raman remnant signal from Node B.

3. On the OPT-RAMP-C or OPT-RAMP-CE card, the LOS-R alarm triggers a command to shut down 
the Raman pump on Side B.

4. The embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE card on Side B no longer receives 
residual Raman power and causes it to shut down.

5. A very low C-band signal reaches the OPT-RAMP-C or OPT-RAMP-CE card on Side A. An LOS-P 
alarm is detected on the COM-RX port of the OPT-RAMP-C or OPT-RAMP-CE card on Side A.

6. The embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE card on Side A is automatically 
shutdown.

7. The C-band power is no longer transmitted to the line amplifier through the DC-TX port of the 
OPT-RAMP-C or OPT-RAMP-CE card on Side A, to the COM-RX port and subsequently to the 
LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on Side B that is connected to the 
broken fiber.

For information about fiber cut recovery, see the “13.11.4.8 Fiber Cut Recovery in Nodes Using 
OPT-RAMP-C or OPT-RAMP-CE Cards” section on page 13-48.

LINE-TX Raman remnant pump photodiode

OSC-RX photodiode

LINE-RX C-band photodiode

COM-RX C-band photodiode

6

25
49

09Raman pumps

Embedded EDFA

Side A Side B

5

4

Node A

OPT-RAMP-C/CE LINE-AMP OPT-RAMP-C/CE

3

27 1
X

13-46
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 13      Network Reference
13.11.4   Fiber Cut Scenarios
13.11.4.7.3 Scenario 7C—Node Equipped With OPT-RAMP-C or OPT-RAMP-CE and Booster Cards on Side A and OSC-CSM Cards 
on Side B.

Scenario 1—Fiber cut on the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on Side A 
(Figure 13-35).

Figure 13-35 Nodes Using OPT-RAMP-C or OPT-RAMP-CE and Booster Cards on Side A and 

OSC-CSM Cards on Side B - Scenario 1

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-35):

1. The fiber that is connected to the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card on 
Side A of Node A is cut. The Raman link goes down.

2. The RAMAN-RX port detects an LOS-R alarm on the OPT-RAMP-C or OPT-RAMP-CE card. For 
LOS-R troubleshooting procedures, see the Cisco ONS 15454 DWDM Troubleshooting Guide.

3. On the OPT-RAMP-C or OPT-RAMP-CE card, the LOS-R alarm triggers a command to shut down 
the Raman pump on Side A.

4. No power is detected by the embedded EDFA on the LINE-RX port of the OPT-RAMP-C or 
OPT-RAMP-CE card on Side A.

5. The embedded EDFA of the OPT-RAMP-C or OPT-RAMP-CE card on Side A is automatically 
shutdown.

6. An LOS alarm is detected on the downstream line amplifier on Side A of Node A because it no 
longer receives the optical payload from the embedded EDFA of the OPT-RAMP-C or 
OPT-RAMP-CE card. 

7. The ALS mechanism causes the line amplifier to shut down. 

8. The C-band power is no longer transmitted out of the line amplifier to the COM-RX port and 
subsequently to the LINE-TX port of the OPT-RAMP-C or OPT-RAMP-CE card that is connected 
to the broken fiber on Side A.
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For information about fiber cut recovery, see the “13.11.4.8 Fiber Cut Recovery in Nodes Using 
OPT-RAMP-C or OPT-RAMP-CE Cards” section on page 13-48.

Scenario 2—Fiber cut on the LINE-RX port of the OSC-CSM card on Side B (Figure 13-36).

Figure 13-36 Nodes Using OPT-RAMP-C or OPT-RAMP-CE and Booster Cards on Side A and 

OSC-CSM Cards on Side B - Scenario 2

The sequence of events after a fiber cut is as follows (refer to the numbered circles in Figure 13-36):

1. The fiber that is connected to the LINE-RX port of the OSC-CSM card on Side B of Node A is cut. 

2. An LOS alarm is detected on the OSC-CSM card on Side B because it no longer receives the OSC 
signal.

3. The power is shut down by means of a 1x1 optical switch in the OSC-CSM card.

Note During a laser restart pulse, APR ensures that the laser power does not exceed Class 1 limits. For more 
information about APR, see the “13.11.2 Automatic Power Reduction” section on page 13-31.

13.11.4.8 Fiber Cut Recovery in Nodes Using OPT-RAMP-C or OPT-RAMP-CE Cards

A fiber cut recovery procedure is automatically performed after the OCH channels are restored to 
measure the actual Raman gain on the span.

1. Node A sends a message through OSC or DCN to Node B to be ready for Raman Gain measurement. 

2. The TCC configures the Raman pumps on Node A to operate at APR power (+8 dBm). In this state, 
no Raman amplification is generated on the input fiber of Node A and a reliable span loss 
measurement is performed. The Raman pumps must not be shut down completely to avoid an 
improper fiber cut event.

3. Node B acknowledges the message and reports the value of the Raman power received on the 
channel to Node A.
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4. On Node A, the TCC configures the line amplifiers in power control mode and APR state (+8 dBm). 
The C-band power received with Raman pumps in OFF state is recorded.

5. The TCC turns the Raman pumps to full power maintaining the Raman ratio calculated by the 
Raman installation wizard. The Raman total power is adjusted, so that the Raman gain setpoint is 
reached. The actual Raman gain is calculated using the C-band power values.

6. When the Raman gain setpoint is reached, the value of the Power field gets updated and the status 
of the Fiber Cut Recovery field changes to “Executed” in CTC.

If the provisioned Raman gain setpoint is not reached by setting the Raman total power to the maximum 
value of 450 mW, the procedure stops and the RAMAN-G-NOT-REACHED alarm is raised on the 
OPT-RAMP-C or OPT-RAMP-CE card.

13.11.5 Network Optical Safety on RAMAN-CTP and RAMAN-COP Cards
Bidirectional optical safety mechanisms for Raman and C-band signals have been independently 
implemented. The Raman pump laser shutdown and restart is managed by the RAMAN-CTP card. The 
RAMAN-COP card is controlled by the RAMAN-CTP card using two backplane wires. The 
RAMAN-COP card can be absent in some node configurations.

The C-band signal shutdown and restart is managed by an MSTP card, such as 40-SMR1-C, 40-SMR-2C, 
OPT-EDFA-17, or OPT-EDFA-24.

The optical safety mechanism on the RAMAN-CTP and RAMAN-COP cards is managed by:

• DFB signal (1568.77 nm) and detection of DFB related signals—The RAMAN-CTP card on the 
local node transmits a DFB signal and waits for a similar response from the remote side. If a valid 
DFB signal is not detected, the RAMAN-CTP card switches off its transmitting DFB laser that 
causes a loss of DFB signal on the remote RAMAN-CTP card which in turn switches off its DFB 
laser. Both the RAMAN-CTP cards must turn off the DFB signals, when a fiber cut occurs.

• Raman pump laser back reflection mechanism on the RAMAN-CTP and RAMAN-COP cards—This 
mechanism uses the ratio between the back-reflected optical power and the total output Raman pump 
power to reduce the output power when patchcords are removed. If excessive back-reflection occurs, 
a Raman Laser Shutdown (RLS) alarm is raised on the RAMAN port where the failure is detected.

• Photodiode (P8) on the RAMAN-CTP card—The photodiode (P8) detects the Raman pump power 
transmitted by the RAMAN-COP card and is used to check for optical continuity between the 
RAMAN-CTP and RAMAN-COP cards. The RAMAN-COP card is shut down if the cards get 
disconnected.

13.12 Network-Level Gain—Tilt Management of Optical 
Amplifiers

The ability to control and adjust per channel optical power equalization is a principal feature of 
ONS 15454 DWDM metro core network applications. A critical parameter to assure optical spectrum 
equalization throughout the DWDM system is the gain flatness of erbium-doped fiber amplifiers 
(EDFAs).

Two items, gain tilt and gain ripple, are factors in the power equalization of optical amplifier cards such 
as the OPT-BST and OPT-PRE. Figure 13-37 shows a graph of the amplifier output power spectrum and 
how it is affected by gain tilt and gain ripple.
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Figure 13-37 Effect of Gain Ripple and Gain Tilt on Amplifier Output Power

Gain ripple and gain tilt are defined as follows:

• Gain ripple is random and depends on the spectral shape of the amplifier optical components.

• Gain tilt is systematic and depends on the gain setpoint (Gstp) of the optical amplifier, which is a 
mathematical function F(Gstp) that relates to the internal amplifier design.

Gain tilt is the only contribution to the power spectrum disequalization that can be compensated at the 
card level. A VOA internal to the amplifier can be used to compensate for gain tilt.

An optical spectrum analyzer (OSA) is used to acquire the output power spectrum of an amplifier. The 
OSA shows the peak-to-peak difference between the maximum and minimum power levels, and takes 
into account the contributions of both gain tilt and gain ripple.

Note Peak-to-peak power acquisition using an OSA cannot be used to measure the gain tilt, because gain 
ripple itself is a component of the actual measurement.

13.12.1 Gain Tilt Control at the Card Level
The OPT-BST and OPT-PRE amplifier cards have a flat output (gain tilt = 0 dB) for only a specific gain 
value (Gdesign), based on the internal optical design (see Figure 13-38).
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13.12.1   Gain Tilt Control at the Card Level
Figure 13-38 Flat Gain (Gain Tilt = 0 dB)

If the working gain setpoint of the amplifier is different from Gdesign, the output spectrum begins to 
suffer a gain tilt variation.

In order to compensate for the absolute value of the increase of the spectrum tilt, the OPT-BST and 
OPT-PRE cards automatically adjust the attenuation of the VOA to maintain a flat power profile at the 
output, as shown in Figure 13-39.

Figure 13-39 Effect of VOA Attenuation on Gain Tilt

The VOA attenuator automatic regulation guarantees (within limits) a zero tilt condition in the EDFA 
for a wide range of possible gain setpoint values.
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13.12.2   System Level Gain Tilt Control
Table 13-2 shows the flat output gain range limits for the OPT-BST and OPT-PRE cards, as well as the 
maximum (worst case) values of gain tilt and gain ripple expected in the specific gain range.

If the operating gain value is outside of the range shown in Table 13-2, the EDFA introduces a tilt 
contribution for which the card itself cannot directly compensate. This condition is managed in different 
ways, depending the amplifier card type:

• OPT-BST—The OPT-BST amplifier is, by design, not allowed to work outside the zero tilt range. 
Cisco TransportPlanner network designs use the OPT-BST amplifier card only when the gain is less 
than or equal to 20 dB.

• OPT-PRE—Cisco TransportPlanner allows network designs even if the operating gain value is equal 
to or greater than 21 dB. In this case, a system-level tilt compensation strategy is adopted by the 
DWDM system. A more detailed explanation is given in 13.12.2 System Level Gain Tilt Control, 
page 13-52.

13.12.2 System Level Gain Tilt Control
System level gain tilt control for OPT-PRE cards is achievable with two main scenarios:

• Without an ROADM node

• With an ROADM node

13.12.2.1 System Gain Tilt Compensation Without ROADM Nodes

When an OPT-PRE card along a specific line direction (Side A-to-Side B or Side B-to-Side A) is 
working outside the flat output gain range (G > 21 dB), the unregulated tilt is compensated for in spans 
that are not connected to ROADM nodes by configuring an equal but opposite tilt on one or more of the 
amplifiers in the downstream direction. The number of downstream amplifiers involved depends on the 
amount of tilt compensation needed and the gain setpoint of the amplifiers that are involved. See 
Figure 13-40.

Table 13-2 Flat Output Gain Range Limits

Amplifier 
Card Type

Flat Output
Gain Range

Gain Tilt 
(Maximum)

Gain Ripple 
(Maximum)

OPT-BST G < 20 dB 0.5 dB 1.5 dB

OPT-PRE G < 21 dB 0.5 dB 1.5 dB
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Figure 13-40 System Tilt Compensation Without an ROADM Node

The proper Tilt Reference value is calculated by Cisco TransportPlanner and inserted in the Installation 
Parameter List imported during the node turn-up process (see Chapter 14, “Turn Up a Node”). For both 
OPT-PRE and OPT-BST cards, the provisionable Gain Tilt Reference range is between –3 dB and +3 dB.

During the ANS procedure, the Tilt value for the OPT-BST or OPT-PRE card is provisioned by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card (see Figure 13-41). The provisioned Tilt Reference 
Value is reported in the CTC OPT-PRE or OPT-BST card view (in the Provisioning > Opt. Ampli. Line 
> Parameters > Tilt Reference tab).
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13.12.2   System Level Gain Tilt Control
Figure 13-41 Cisco TransportPlanner Installation Parameters

13.12.2.2 System Gain Tilt Compensation With ROADM Nodes

When a ROADM node is present in the network, as shown in Figure 13-42, a per channel dynamic gain 
equalization can be performed. Both gain tilt and gain ripple are completely compensated using the 
following techniques:

• Implementing the per channel VOAs present inside the 32WSS card

• Operating in Power Control Mode with the specific power setpoint designed by 
Cisco TransportPlanner
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Figure 13-42 System Tilt Compensation With an ROADM Node

13.13 Optical Data Rate Derivations
This section discusses the derivation of several data rates commonly used in optical networking.

13.13.1 OC-192/STM-64 Data Rate (9.95328 Gbps)
The SONET OC-1 rate is 51.84 Mbps. This rate results from a standard SONET frame, which consists 
of 9 rows of 90 columns of 8-bit bytes (810 bytes total). The transmission rate is 8000 frames per second 
(125 microseconds per frame). This works out to 51.84 Mbps, as follows:

(9) x (90 bytes/frame) x (8 bits/byte) x (8000 frames/sec) = 51.84 Mbps

OC-192 is 192 x 51.84 Mbps = 9953.28 Mbps = 9.95328 Gbps

STM-64 is an SDH rate that is equivalent to the SONET OC-192 data rate.

13.13.2 10GE Data Rate (10.3125 Gbps)
10.3125 Gbps is the standard 10 Gbps Ethernet LAN rate. The reason the rate is higher than 10.000 Gbps 
is due to the 64-bit to 66-bit data encoding. The result is 10 Gbps x 66/64 = 10.3125 Gbps. The reason 
for 64-bit to 66-bit encoding is to ensure that there are adequate data transitions to ensure proper 
operation of a clock and data recovery circuit at the far end. Additionally, the encoding assures a data 
stream that is DC balanced.

13.13.3 10G FC Data Rate (10.51875 Gbps)
The Fibre Channel rate is based on the OC-192 rate of 9.95328 Gbps, with the addition of 64-bit to 66-bit 
encoding and WAN Interconnect Sublayer (WIS) overhead bytes.
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13.13.4   ITU-T G.709 Optical Data Rates
The rate is derived from the basic 9.95328 Gbps OC-192 rate. First, it has the 64-bit to 66-bit encoding 
added, which brings it to the 10.3125 Gbps rate (10 Gbps x 66/64 = 10.3125 Gbps). Beyond that, the 
WIS overhead is added, which is an additional two percent on top of the 10.3125 Gbps. This yields:

10.3125 Gbps x 0.02 = 0.20625 Gbps

10.3125 Gbps + 0.20625 Gbps = 10.51875 Gbps 

13.13.4 ITU-T G.709 Optical Data Rates
To understand optical networking data rates, an understanding of the ITU-T G.709 frame structure, 
shown in Figure 13-43, is needed.

Figure 13-43 ITU-T G.709 Frame Structure

Each of the sub-rows in Figure 13-43 contains 255 bytes. Sixteen are interleaved horizontally 
(16 x 255 = 4080). This is repeated four times to make up the complete ITU-T G.709 frame.

The Reed Solomon (RS) (255,239) designation indicates the forward error correction (FEC) bytes. There 
are 16 FEC, or parity, bytes. The ITU-T G.709 protocol uses one overhead byte and 238 data bytes to 
compute 16 parity bytes to form 255 byte blocks—the RS (255,239) algorithm. Interleaving the 
information provides two key advantages. First, the encoding rate of each stream is reduced relative to 
the line transmission rate and, second, it reduces the sensitivity to bursts of error. The interleaving 
combined with the inherent correction strength of the RS (255,239) algorithm enables the correction of 
transmission bursts of up to 128 consecutive errored bytes. As a result, the ITU-T G.709 contiguous burst 
error correcting capability is enhanced 16 times above the capacity of the RS(255,239) algorithm by 
itself.

ITU-T G.709 defines the Optical Transport Unit 2 (OTU2) rate as 10.70923 Gbps. ITU-T G.709 defines 
three line rates:

1. 2,666,057.143 kbps—Optical Transport Unit 1 (OTU1)
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2. 10,709,225.316 kbps—Optical Transport Unit 2 (OTU2)

3. 43,018,413.559 kbps—Optical Transport Unit 3 (OTU3) 

The OTU2 rate is higher than OC-192 because the OTU2 has to carry overhead and FEC bytes in its 
frame; the bits must be sent faster to carry the payload information at the OC-192 rate.

The ITU-T G.709 frame has two parts. Two are similar to a SDH/SONET frame:

1. Overhead area for operation, administration, and maintenance functions

2. Payload area for customer data 

In addition, the ITU-T G.709 frame also includes FEC bytes.

13.13.4.1 OC-192 Packaged Into OTU2 G.709 Frame Data Rate (10.70923 Gbps)

In this case, an OC-192 frame is being transported over a OTU2 G.709 frame, which adds the benefit of 
FEC. The OC-192 data rate (9.95328 Gbps) must increase in order to transport more bytes (OC-192 plus 
ITU-T G.709 overhead plus ITU-T G.709 FEC bytes) in the same amount of time. In an OTU2 
transmission, 237 of the 255 bytes are OC-192 payload. This means the resultant data rate is:

9.95328 x 255/237 = 10.70923 Gbps

13.13.4.2 10GE Packaged Into OTU2 G.709 Frame Data Rate (Nonstandard 11.0957 Gbps)

Encapsulating Ethernet data into an OTU2 G.709 frame is considered nonstandard. The goal is to add 
the benefit of ITU-T G.709 encapsulation to achieve better burst error performance. However, this means 
adding overhead and FEC bytes, so more bytes must be transmitted in the same amount of time, so the 
data rate must increase. The new date rate is:

10.3215 x 255/237 = 11.0957 Gbps

13.13.4.3 10G FC Packaged Into OTU2 G.709 Frame Data Rate (Nonstandard 11.31764 Gbps)

Encapsulating Fibre Channel in an OTU2 frame is considered nonstandard. The rate is higher than the 
10.51875 rate because OTU2 includes FEC bytes. The bits must run at a faster rate so that the payload 
is provided at the standard Fibre Channel rate. The rate is:

10.51875 x 255/237 = 11.31764 Gbps

13.14 Even Band Management
With the introduction of the following cards, it is now possible to transport 72, 80, 104, or 112 
wavelength channels in the same network:

• 40-WSS-CE (40-channel Wavelength Selective Switch, C-band, even channels)

• 40-DMX-CE (40-channel Demultiplexer, C-band, even channels)

By using these new cards along with the 40-WSS-C and 40-DMX-C cards (which handle 40 C-band odd 
channels), the 32WSS and 32DMX cards (which handle 32 C-band odd channels), and the 32WSS-L and 
32DMX-L (which handle 32 L-band odd channels), it is possible to cover 80 C-band channels (40 even 
and 40 odd channels) and 32 L-band odd channels, for a maximum of 112 channels. The following 
channel coverage combinations are possible:

• 72 C-band channels, using the 32WSS, 32DMX, 40-WSS-CE, and 40-DMX-CE cards
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• 80 C-band channels, using the 40-WSS-C, 40-DMX-C, 40-WSS-CE, and 40-DMX-CE cards

• 104 channels (32 L-band odd channels and 72 C-band channels), using the 32WSS-L and 32DMX-L 
cards as a set to cover 32 L-band odd channels and the 32WSS, 32DMX, 40-WSS-CE, and 
40-DMX-CE cards as a set to cover 72 C-band odd and even channels

• 112 channels (32 L-band odd channels and 80 C-band even channels), using the 32WSS-L and 
32DMX-L cards as a set to cover 32 L-band odd channels and the 40-WSS-C, 40-DMX-C, 
40-WSS-CE, and 40-DMX-CE, cards as a set to cover 80 C-band odd and even channels

The following node topologies are available for even channel management or odd-plus-even channel 
management:

• Terminal node

• Hub node

• ROADM node

• OSC regeneration and optical line amplification node

The external ONS 15216-ID-50 module is a 50 GHz/100GHz optical interleaver/deinterleaver that is 
required to combine or separate odd and even C-band channels. This module increases capacity by 
combining two optical data streams into a single, more densely spaced stream. The module can be used 
in multiplexer mode to combine two 100-GHz optical signal streams into one 50-GHz stream, and in 
demultiplexer mode to separate the 50-GHz stream into two 100-GHz streams. 

The ONS 15216-SC-CL module is an external C-band and L-band splitter/combiner module that 
combines and separates the C-band odd/even channels and the L-band odd channels.

An example of a 104-channel C-band plus L-band ROADM node is shown in Figure 13-44 on 
page 13-59. There are 72 C-band even channels and 32 L-band odd channels. The signal flow from the 
left side of the diagram to the right side is given in the following steps. The signal flow from the right 
side to the left is identical.

1. All the C-band and L-band signals enter the ONS 15216-SC-CL.

2. When the signals exit the ONS 15216-SC-CL, the 72 C-band even and odd channel signals are sent 
to the upper set of blocks and the 32 L-band odd channel signals are sent to the lower set of blocks.

3. The 72 C-band even and odd channel signals pass through a preamplifier, then through an 
ONS 15261-ID-50 and wavelength selective switch (WSS). Only the channels to be dropped are sent 
to the demultiplexer (DMX) block. There are two such sets of blocks, one set for the 32 odd C-band 
channels, and one set for the 40 even C-band channels.

4. The 32 L-band odd channel signals pass through a preamplifier, then through two 32-channel 
wavelength selective switch (32WSS-L) cards. Only the channels to be dropped are sent to the 
32-channel demultiplexer (32DMX-L) card.

5. At the upper set of blocks, the ONS 15261-ID-50 deinterleaves the 32 C-band odd channels from 
the 40 C-band even channels. The 32 C-band odd channels are routed through the top blocks (two 
32WSS cards and one 32DMX card), while the 40 C-band even channels are routed through the 
lower blocks (two 40-WSS-CE cards and one 40-DMX-CE card).

6. When a signal enters a 32WSS-L or 40-WSS-CE card, it is split. Part of the signal (the channels that 
are to be dropped) goes to the32 DMX-L card or 40-DMX-CE card so that channels can be dropped 
for use by the client equipment. The other part of the signal goes to the next 32WSS-L card or 
40_DMX-CE card, where the channels can be passed through or blocked, and channels can be added 
to the stream from the client equipment.
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7. After the channels leave the last 32WSS-L card or 40-WSS-CE card, the C-band even and odd 
channels are interleaved back into a single stream by the ONS 15216-ID-50 module, sent through a 
booster amplifier, and then they enter the ONS 15216-SC-CL module, where they are combined with 
the L-band signals from the lower set of blocks and sent out onto the optical fiber.

Figure 13-44 104-Channel C-Band plus L-Band ROADM Node
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An example of a 112-channel C-band plus L-band ROADM node is shown in Figure 13-45. It operates 
in a similar manner to the 104-channel ROADM node shown in Figure 13-44 on page 13-59, except that 
there are 40 odd C-band channels instead of 32.

Figure 13-45 112-Channel C-Band plus L-Band ROADM Node
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13.15 Wavelength Drifted Channel Automatic Shutdown
The wavelength drifted channel automatic shutdown feature detects wavelength instability or 
wavelength drift on the source port of the card connected to an MSTP multiplexer. The channel 
photodiode or optical channel monitor (OCM) associated with a variable optical attenuator (VOA) is 
used to detect the power fluctuation.

The wavelength drifted channel automatic shutdown feature is supported on 40-SMR1-C, 40-SMR2-C, 
80-WXC-C, 40-WXC-C, and 40-WSS-C cards. The 40-SMR1-C, 40-SMR2-C, and 80-WXC-C cards 
have the OCM devices connected to the ADD port, which detect the power fluctuation. The 40-WSS-C 
and 40-WXC-C cards do not detect the power fluctuation on their ADD ports because the Add 
photodiode is located before the filtering stage. The different ports on each card detect the power 
fluctuation. Table 13-3 lists the ports on which the power fluctuation is detected.

When the card exceeds the OPT-PWR-DEG-LOW threshold value 16 times in 24 hours, the 
WVL-DRIFT-CHAN-OFF alarm is raised. When the WVL-DRIFT-CHAN-OFF alarm is raised, the 
VOA associated to that port is moved to the automatic VOA shutdown (AVS) state, which shuts down 
the channel.

For more information on the severity level of the conditions and procedure to clear the alarms, see 
Cisco ONS 15454 DWDM Troubleshooting Guide.

For more information on how to enable or disable this feature, see the “NTP-G315 Enable or Disable the 
Wavelength Drifted Channel Automatic Shutdown Feature” procedure on page 11-479.

Table 13-3 Detection of Power Fluctuation

Card Port Circuit

40-SMR1-C
40-SMR2-C

LINE-TX ADD/DROP
EXP/PT

80-WXC-C COM/EAD/AD ADD/DROP
EXP/PT 

40-WXC-C COM-TX ADD/DROP
EXP/PT

40-WSS-C CHAN-RX ADD/DROP

PT PT
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C H A P T E R 14

Turn Up a Node

This chapter explains how to provision a single Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) node and turn it up for service, including assigning the node name, date, and 
time; provisioning timing references; provisioning network attributes such as IP address and default 
router; setting up users and user security; installing cards; and creating DWDM connections.

Note The procedures and tasks described in this chapter for the Cisco ONS 15454 platform is applicable to 
the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.

Note Procedures in this chapter require that you have a network plan calculated for your DWDM network with 
Cisco Transport Planner, Release 9.2. Cisco Transport Planner is a DWDM planning tool that is available 
from your Cisco account representative. Cisco Transport Planner prepares a shelf plan for each network 
node and calculates the power and attenuation levels for the DWDM cards installed in the node. For 
information about Cisco Transport Planner, contact your Cisco account representative. For instructions 
on using Cisco Transport Planner, refer to the Cisco Transport Planner DWDM Operations Guide.

Note Unless otherwise specified, in this document “ONS 15454” refers to both ANSI (ONS 15454) and ETSI 
(ONS 15454 SDH) shelf assemblies.

Note Cisco Transport Controller (CTC) views referenced in these procedures depend on the ONS 15454 mode. 
In single-shelf mode, the views are network, node, and card. In multishelf mode, the views are network, 
multishelf, shelf, and card. For more information about CTC views, refer to CTC Enhancements, 
Operations, and Shortcuts.

Note In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the 
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card. 
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Before You Begin
This section lists the non-trouble procedures (NTPs) needed to turn up a DWDM node. Turn to an NTP 
for applicable detail-level procedures (DLPs), known as tasks.

1. NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4—Complete this procedure 
first.

2. NTP-G22 Verify Common Card Installation, page 14-5—Complete this procedure next.

3. NTP-G250 Verify Digital Image Signing (DIS) Information, page 14-6—Complete this procedure 
to retrieve the software signature information and version of the digitally signed software. You can 
also retrieve the public keys installed on the node using this procedure.s

4. NTP-G144 Provision a Multishelf Node, page 14-8—Complete this procedure as needed.

5. NTP-G23 Create Users and Assign Security, page 14-11—Complete this procedure to create CTC 
users and assign their security levels.

6. NTP-G24 Set Up Name, Date, Time, and Contact Information, page 14-13—Continue with this 
procedure to set the node name, date, time, location, and contact information.

7. NTP-G25 Set Battery Power Monitor Thresholds, page 14-16—Continue with this procedure to set 
the node battery power thresholds.

8. NTP-G26 Set Up CTC Network Access, page 14-17—Continue with this procedure to provision the 
IP address, default router, subnet mask, and other network configuration settings.

9. NTP-G194 Set Up EMS Secure Access to the ONS 15454, page 14-31—Continue with this 
procedure to connect the CTC in secure mode.

10. NTP-G341 Set Up Secure Access to the ONS 15454 TL1, page 14-32—Continue with this 
procedure to enable secure access to TL1.

11. NTP-G27 Set Up the ONS 15454 for Firewall Access, page 14-32—Continue with this procedure if 
the ONS 15454 will be accessed behind firewalls.

12. NTP-G28 Create FTP Host, page 14-33—Continue with this procedure if to create FTP host for 
ENE database backup.

13. NTP-G132 Provision OSI, page 14-36—Continue with this procedure if the ONS 15454 will be 
installed in networks with third-party, Open Systems Interconnection (OSI)-based network elements 
(NEs).

14. NTP-G29 Set Up SNMP, page 14-46—Complete this procedure if Simple Network Management 
Protocol (SNMP) will be used for network monitoring.

15. “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” procedure on 
page 14-48—Complete this procedure to preprovision the ONS 15454 slots and install the card and 
automatic node setup (ANS) parameters.

16. NTP-G328 Add, Modify, or Delete ANS Parameters, page 14-60—Complete this procedure, as 
needed, to add or delete ANS parameters.

17. NTP-G30 Install the DWDM Cards, page 14-64—Complete this procedure to install the DWDM 
cards, including the OSCM, OSC-CSM, 32WSS, 32WSS-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 
80-WXC-C, 40-SMR1-C, 40-SMR2-C, OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-PRE, 32MUX-O, 
40-MUX-C, 32DMX-O, 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 4MD-xx.x, AD-1C-xx.x, 
AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, MMU, PSM, TDC-CC and TDC-FC.

18. NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-68—Complete this 
procedure, as needed, to install a dispersion compensating unit (DCU).
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19. NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, 
ADM-10G, and OTU2_XP Cards, page 14-69—Complete this procedure, as needed, to install 
transponder (TXP), muxponder (MXP), 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE, ADM-10G, or OTU2_XP cards.

20. NTP-G123 Install the Filler Cards, page 14-72—Complete this procedure, as needed, to install 
ONS 15454 filler cards.

21. NTP-G239 Add and Delete Passive Units, page 14-73—Complete this procedure, as needed, to add 
or delete passive units.

22. NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 14-75—Complete this 
procedure, as needed, to install the fiber-optic cables on the DWDM cards.

23. NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, 
page 14-80—Complete this procedure, as needed, to connect TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE, ADM-10G, or OTU2_XP cards to DWDM cards in a terminal, hub, or 
reconfigurable optical add-drop multiplexer (ROADM) node through the patch panel.

24. NTP-G185 Install Fiber-Optic Cables between Mesh Nodes, page 14-99—Complete this procedure, 
as needed, to connect 40-WXC-C or 80-WXC-C cards in a mesh node to the 4-degree or 8-degree 
patch panel.

25. NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules, page 14-106—Complete 
this procedure, as needed, to connect fiber-optic cables to Y-cable modules from client TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards.

26. NTP-G152 Create and Verify Internal Patchcords, page 14-111—Complete this procedure to 
calculate the DWDM cable connections.

27. NTP-G209 Create, Edit, and Delete Optical Sides, page 14-121—Complete this procedure to create, 
edit, and delete an optical side.

28. NTP-G38 Provision OSC Terminations, page 14-124—Complete this procedure next.

29. NTP-G37 Run Automatic Node Setup, page 14-126—Complete this procedure next.

30. NTP-G39 Verify OSCM Transmit Power, page 14-127—Complete this procedure next.

31. NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 14-129—Complete this 
procedure as needed.

32. NTP-G332 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode with TCC2P Cards as 
Subtending Shelf Controller, page 14-132—Complete this procedure as needed.

33. NTP-G210 Provision Node for SNMPv3, page 14-134 —Complete this procedure if Simple 
Network Management Protocol version 3(SNMPv3) will be used for network monitoring.
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NTP-G139 Verify Cisco Transport Planner Reports and Files

Step 1 Verify that you have the Cisco Transport Planner reports and files shown in Table 14-1 for the node that 
you will provision. The reports and files can be provided in one of the following ways:

• If you have Cisco Transport Planner, verify that you have the electronic network design plan from 
which you can generate the reports in Cisco Transport Planner. For information about generating the 
reports, refer to the Cisco Transport Planner DWDM Operations Guide. 

• If you do not have Cisco Transport Planner, you must have printouts of all reports listed in 
Table 14-1 except the Assisted Configuration Setup file. Assisted Configuration Setup is an 
electronic file that will be imported into CTC. You must be able to access it from the CTC computer 
used to provision the node

• If you not do not have all the reports and files listed in Table 14-1, do not continue. See your site 
planner or network planner for the required information and files.

Purpose This procedure verifies that you have the Cisco Transport Planner reports 
and files needed to turn up the node.

Tools/Equipment None

Prerequisite Procedures Chapter 1, “Install the Cisco ONS 15454, ONS 15454 M2, and ONS 15454 
M6 Shelf” in the Cisco ONS 15454 Hardware Installation Guide

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher

Table 14-1 Cisco Transport Planner Node Setup Information and Files

Source Format Description

Shelf layout JPG file Cisco Transport Planner provides a shelf layout showing the 
cards that should be installed in each ONS 15454, 
ONS 15454 M2, and ONS 15454 M6 slot. Cisco Transport 
Planner can export each of these cards as a JPG file with a 
user-defined name.

Installation Parameters Table Provides the target reference values for the variable optical 
attenuators (VOAs), output power, optical thresholds, and 
amplifier configuration parameters.

Internal Connections Table Identifies the patchcords that must be installed within the shelf.

NE Update 
Configuration file

XML file The Cisco Transport Planner NE Update configuration file is 
an electronic file with an XML extension and a name assigned 
by the network designer for the network you are provisioning. 
The file is imported into CTC where it preprovisions internal 
patchcords, optical sides and card parameters for optical cards, 
transponders, and passive units (DCUs and patch panels). It 
configures the ANS parameters based on the network 
calculated by Cisco Transport Planner.
14-4
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html


 

Chapter 14      Turn Up a Node
  Before You Begin
Step 2 Print Table 14-1 for reference. You will need information from the reports during node turn-up.

Stop. You have completed this procedure.

NTP-G22 Verify Common Card Installation

Step 1 Verify the following:

• TCC2/TCC2P/TCC3 cards are installed in Slots 7 and 11 on the ONS 15454 shelf.

• Two TNC/TNCE/TSC/TSCE cards are installed in Slots 1 and 8 on the ONS 15454 M6 shelf. 

• A stand-alone TNC/TNCE/TSC/TSCE card is installed in Slot 1 on the ONS 15454 M2 shelf.

Step 2 Verify that the FAIL LED is off on both TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards. 

Step 3 Verify that the green ACT (active) LED is illuminated on one 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card and that the amber STBY (standby) LED is 
illuminated on the other TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card. 

Note If the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards are not installed, or if their LEDs are 
not operating as described, do not continue. Complete the “DLP-G33 Install the TCC2, TCC2P, 
or TCC3 Card” or “DLP-G604 Install the TNC TNCE, TSC, or TSCE Card” task in the 
Cisco ONS 15454 Hardware Installation Guide or refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide to resolve installation problems before proceeding to Step 4.

Traffic Matrix Table Shows the traffic flow within the node. During node turn-up, 
this report is used to identify the location of Y-cable protection 
groups.

Cable list Table or list A list of cables needed to provision the node. The list can be 
derived from the Internal Connections Report or from the Bill 
of Materials report prepared by Cisco Transport Planner.

Table 14-1 Cisco Transport Planner Node Setup Information and Files (continued)

Source Format Description

Purpose This procedure verifies that the Cisco ONS 15454 shelf has two TCC2/ 
TCC2P/TCC3 cards installed. This procedure also verifies that the Cisco 
ONS 15454 M6 and the Cisco ONS 15454 M2 shelves have 
TNC/TNCE/TSC/TSCE cards installed. It also verifies the installation of 
the AIC-I and MS-ISC-100T cards, if they are installed.

Tools/Equipment None

Prerequisite Procedures Chapter 1, “Install the Cisco ONS 15454, ONS 15454 M2, and ONS 15454 
M6 Shelf” in the Cisco ONS 15454 Hardware Installation Guide

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher
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Step 4 (On 15454-DWDM shelf) If the AIC-I card is installed, verify that it is installed in Slot 9 and that its 
ACT (active) LED displays a solid green light.

Note If the AIC-I card is not installed and the card is required by the Cisco Transport Planner shelf 
layout, or if it is installed and its LEDs are not operating as described, do not continue. Complete 
the “DLP-G34 Install the AIC-I Card” task in the Cisco ONS 15454 Hardware Installation 
Guide or refer to the Cisco ONS 15454 DWDM Troubleshooting Guide to resolve installation 
problems before proceeding to Step 5.

Step 5 Verify that the software release shown on the LCD matches the software release required for your 
network. On the LCD, the software release is shown under the platform (SONET or SDH) and 
date/temperature. If the release does not match, perform one of the following procedures:

• Perform a software upgrade using a ONS 15454 software CD or ONS 15454 SDH software CD. 
Refer to the release-specific software upgrade document.

• On ONS 15454, replace the TCC2/TCC2P/TCC3 cards with cards containing the correct release.

• On ONS 15454 M6, replace the LCD and TNC/TNCE/TSC/TSCE cards with cards containing the 
correct release.

• On ONS 15454 M2, replace the power module and TNC/TNCE/TSC/TSCE cards with cards 
containing the correct release.

Step 6 (On ONS 15454 shelf) If the node will be configured as a multishelf node, verify that redundant 
MS-ISC-100T cards are installed (Slots 6 and 12 are recommended) and that the green ACT (active) LED 
is illuminated on both cards. 

Note If the MS-ISC-100T card is not installed and the card is required by the Cisco Transport Planner 
shelf layout, or if the card’s LEDs are not operating as described, do not continue. Complete the 
“DLP-G309 Install the MS-ISC-100T Card” task in the Cisco ONS 15454 Hardware Installation 
Guide or refer to the Cisco ONS 15454 DWDM Troubleshooting Guide to resolve installation 
problems before proceeding to the next procedure.

Stop. You have completed this procedure.

NTP-G250 Verify Digital Image Signing (DIS) Information

Purpose This procedure retrieves the following information on the ONS 15454 M2 
and ONS 15454 M6 platforms: 

• Software signature information

• Version of the digitally signed software

• Public keys installed 

Note In a hybrid multi-shelf configuration involving ONS 15454 and 
ONS 15454 M6 shelf assemblies, DIS information is available for 
the ONS 15454 M6 shelf only.

Tools/Equipment None

Prerequisite Procedures “NTP-G22 Verify Common Card Installation” task on page 14-5

Required/As Needed As Needed
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Note The DIS information is applicable for TNC/TNCE/TSC/TSCE cards in the ONS 15454 M2 and ONS 
15454 M6 platforms.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to verify the DIS information.

Step 2 Do the following as applicable: 

a. To retrieve the digitally signed software version, go to Step 3.

b. To retrieve the software signature information, go to Step 4.

c. To retrieve the public keys installed on the node, go to Step 5.

Step 3 In node view (single-shelf mode) or multishelf view (multishelf mode), click Maintenance > Software 
tab to retrieve the digitally signed software version. The following columns appear in the pane:

• Node—Displays the node name or IP address.

• Type—Displays the node type.

• Node Status—Displays the node status, which is based on the highest alarm level at the node.

• Working Version—Displays the working ONS node software version (the general software release 
number [n.n.n] followed by the specific software release identification number). For example, 9.2.0 
(09.20-X10E-02.06).

• Protect Version—Displays the protect ONS node software version (the general software release 
number [n.n.n] followed by the specific software release identification number). For example, 9.2.0 
(09.20-X10E-02.06).

• Download Status—Displays the status of any in-progress network software downloads. 

Step 4 In node view (single-shelf mode) or shelf view (multishelf view), click Maintenance > DIS > Info > 
Retrieve Signature Information tab to retrieve signature information. The following information is 
displayed in the pane:

• Attribute—The following information is displayed:

– Organization Name—Displays the owner of the software image.

– Organization Unit—Displays the business unit within Cisco.

– Serial Number—Displays the serial number of the certificate with the digital signature.

– Common Name—Displays the name of the platform.

– Hash Algorithm—Displays the hashing algorithm used.

– Image Type—Shows the type of the image-Development or Production.

– Key Version—Indicates the key version used to digitally sign the image. A key version is 
identified with an alphabetical character that ranges from A to Z.

– Sign Algorithm—Refers to the RSA algorithm.

• Working Software Information—Displays the signature information of the working software.

• Protect Software Information—Displays the signature information of the protect software.

Note To refresh the signature information, click Refresh Signature Information.

Onsite/Remote Onsite or remote

Security Level Retrieve user
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Step 5 In node view (single-shelf mode) or shelf view (multishelf mode), click Maintenance > DIS > Available 
Keys > Retrieve All Keys tabs to retrieve public key information. The following information is 
displayed in the pane:

• Key Type—Displays the public key available on the system for verification:

– Release Key—Verifies release images.

– Development Key—Verifies the development images.

• Public Key Algorithm—Displays the name of the algorithm used for public key cryptography.

• Exponent—Displays the exponent of the public key algorithm—release or development keys.

• Key Version—Displays the key version used for verification.

• Modulus—Displays the modulus of the public key algorithm with a size of 2048 bits.

Note To refresh the public key information, click Refresh All Keys.

Stop. You have completed this procedure.

NTP-G144 Provision a Multishelf Node

Purpose This procedure provisions a multishelf node from CTC. A multishelf node 
consists of a control node and subtending shelves that are configured to 
operate as a single node.

Tools/Equipment None

Prerequisite Procedures • NTP-G22 Verify Common Card Installation, page 14-5

• Cisco ONS 15454 Hardware Installation Guide:

– “NTP-G301 Connect the ONS 15454 Multishelf Node and 
Subtending Shelves to an MS-ISC-100T Card”

– “NTP-G302 Connect the ONS 15454 Multishelf Node and 
Subtending Shelves to a Catalyst 2950”

– “NTP-G295 Connect the ONS 15454 Multishelf Node and 
Subtending Shelves to a Catalyst 3560”

– “NTP-G296 Upgrade the ONS 15454 Multishelf with MS-ISC 
Card Configuration Using the Catalyst 3560”

– “NTP-G297 Upgrade the ONS 15454 Multishelf with Catalyst 
2950 Configuration Using the Catalyst 3560”

– “NTP-G308 Connect the ONS 15454 M6 Multishelf Node and the 
ONS 15454 M6 Subtending Shelves” 

– “NTP-G309 Connect the ONS 15454 M6 and the ONS 15454 in a 
Mixed Multishelf Configuration”

– NTP-G310 Upgrade the ONS 15454 Multishelf Configuration 
using the ONS 15454 M6

Required/As Needed As needed
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Chapter 14      Turn Up a Node
  Before You Begin
Caution An optical shelf in a multishelf configuration must be provisioned as the node controller shelf and not 
as a subtending shelf. Otherwise, traffic will be dropped. If there are no slots available on the optical 
shelf to install the MS-ISC-100T cards (needed for a node controller shelf), install and configure the 
Cisco Catalyst 2950 or Cisco Catalyst 3560. See the “NTP-G302 Connect the ONS 15454 Multishelf 
Node and Subtending Shelves to a Catalyst 2950” procedure or the “NTP-G295 Connect the ONS 15454 
Multishelf Node and Subtending Shelves to a Catalyst 3560” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If you are using an ONS 15454 M6, then refer to the applicable procedure 
for connecting the ONS 15454 M6 as the node controller in the Cisco ONS 15454 Hardware Installation 
Guide.

Step 1 Complete the DLP-G46 Log into CTC task at the node that you want to configure as a multishelf node.

Step 2 If you want to set up the login node as the node controller, complete the following steps. If not, continue 
with Step 3.

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
General > Multishelf Config tabs.

b. Click Enable as Node Controller. 

c. From the LAN Config drop-down list, complete one of the following:

• Choose Ethernet Switch if MS-ISC-100T cards or the Catalyst 2950 or the Catalyst 3560 
switches are already installed and configured. Choose the public VLAN ID and private VLAN 
ID for the ONS 15454 multishelf node. In case of an ONS 15454 M6, the public VLAN ID and 
private VLAN ID are static (1 and 2 respectively).

Note Public VLAN ID is used by the node controller to communicate with the external network. 
Private VLAN ID is used by the node controller to communicate with the subtending shelves.

Note If the ONS 15454 M6 shelf is used as the node controller, then you can connect the subtending 
shelves directly to the MSM ports on the ECU. However, a Catalyst 3560 switch can also be used 
along with the ONS 15454 M6 node controller to extend the number of subtending shelves.

• Choose Stand-Alone if MS-ISC-100T cards are not installed yet but will be included in the final 
layout. This option will allow a safe migration of the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card database when the multishelf configuration 
is complete. 

d. Click Apply.

e. In the confirmation dialog box, click Yes to allow the node to reboot. The CTC view changes to 
network view and the node icon changes to gray. Wait for the reboot to finish. (This might take 
several minutes.) 

f. After the node reboots, double-click the node. The multishelf view appears.

Note The shelf ID of the node controller is automatically assigned as 1.

Onsite/Remote Onsite or remote

Security Level Superuser only
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Chapter 14      Turn Up a Node
  Before You Begin
Step 3 If you want to add a node as a subtending shelf (either ONS 15454 or ONS 15454 M6) in the multishelf 
configuration, complete the following steps. If not, you have completed this procedure.

Note A Cisco ONS 15454 node configured with TCC2P and TCC3 cards must not be added to a multishelf 
configuration containing either of the following configurations:

• Cisco ONS 15454 node with TCC3 as the node controller

• Cisco ONS 15454 M6 node with TNC as the node controller

a. In multishelf view, right-click the white space in the rack and choose Add Shelf from the shortcut 
menu.

b. Select the type of subtending shelf (ONS 15454 or ONS 15454 M6).

c. In the Shelf ID Selection dialog box, choose a shelf ID (from 2 to 30) from the drop-down list. 

d. Click OK. The shelf appears in multishelf view.

e. Disconnect the cross-over (CAT-5) LAN cable from the RJ-45 LAN (TCP/IP) port of the 
ONS 15454 subtending shelf TCC2/TCC2P/TCC3 card in Slot 11 or Slot 7, or from the EMS RJ-45 
LAN (TCP/IP) on the ONS 15454 M6 subtending shelf that correspond to the 
TNC/TNCE/TSC/TSCE card.

f. Connect your Windows PC or Solaris workstation network interface card (NIC) to the RJ-45 LAN 
(TCP/IP) port on the TCC2/TCC2P/TCC3 card in Slot 11 or Slot 7, or to the EMS RJ-45 LAN 
(TCP/IP) on the ONS 15454 M6 subtending shelf that correspond to the TNC/TNCE/TSC/TSCE 
card.

g. Complete the DLP-G46 Log into CTC task at the subtending shelf.

h. Click the Provisioning > General > Multishelf Config tabs.

i. Click Enable as Subtended Shelf. 

j. From the Shelf ID drop-down list, choose the shelf ID that you created in Step c.

k. Click Apply. 

l. In the confirmation dialog box, click Yes to reboot the shelf. The CTC view changes to network view 
and the node icon changes to gray. Wait for the reboot to finish. (This might take several minutes.) 

m. Disconnect your Windows PC or Solaris workstation NIC from the RJ-45 LAN (TCP/IP) port of the 
ONS 15454 subtending shelf TCC2/TCC2P/TCC3 card in Slot 11 or Slot 7, or from the EMS RJ-45 
LAN (TCP/IP) on the ONS 15454 M6 subtending shelf that correspond to the 
TNC/TNCE/TSC/TSCE card.

n. Reconnect the cross-over (CAT-5) LAN cable (disconnected in Step e) to the RJ-45 LAN (TCP/IP) 
port of the subtending shelf TCC2/TCC2P/TCC3 card in Slot 11 or Slot 7, or to the EMS RJ-45 LAN 
(TCP/IP) on the ONS 15454 M6 subtending shelf that correspond to the TNC/TNCE/TSC/TSCE 
card.

o. Repeat Steps a through n to set up additional subtending shelves.

Note To connect the subtending shelves to the node controller, refer to the applicable procedures in the 
Cisco ONS 15454 Hardware Installation Guide.
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Chapter 14      Turn Up a Node
DLP-  G54 Create a New User on a Single Node
Note Non-LAN connected Multishelf nodes are not manageable from CTC unless SOCKS Proxy is enabled 
on the node.

Stop. You have completed this procedure.

NTP-G23 Create Users and Assign Security

Step 1 Complete the DLP-G46 Log into CTC task at the node where you need to create users. If you are already 
logged in, continue with Step 2.

Note You must log in as a Superuser to create additional users. The CISCO15 user provided with each 
ONS 15454 can be used to set up other ONS 15454 users. You can add up to 500 users to one 
ONS 15454.

Step 2 Complete the “DLP-G54 Create a New User on a Single Node” task on page 14-11 or the “DLP-G55 
Create a New User on Multiple Nodes” task on page 14-12 as needed.

Note You must add the same user name and password to each node that a user will access.

Step 3 If you want to modify the security policy settings, including password aging and idle user timeout 
policies, complete the NTP-G88 Modify Users and Change Security procedure.

Stop. You have completed this procedure.

DLP-G54 Create a New User on a Single Node

Purpose This procedure creates ONS 15454 users and assigns their security levels.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task creates a new user for one ONS 15454.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC 

Required/As Needed As needed
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DLP-  G55 Create a New User on Multiple Nodes
Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Security > Users tabs.

Step 2 In the Users window, click Create.

Step 3 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of two and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) characters. 

• Password—Type the user password. The password length, by default, is set to a minimum of six and 
a maximum of 20 characters. You can configure the default values in node view using the 
Provisioning > NE Defaults > Node > security > passwordComplexity tabs. The minimum length 
can be set to two, four, eight, ten or twelve characters, and the maximum length to 80 characters. 
The password must be a combination of alphanumeric (a-z, A-Z, 0-9) and special (+, #,%) 
characters, where at least two characters are not alphabetic and at least one character is a special 
character; or the password can contain any character.

Note The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. 

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before the password must be reentered. The defaults are: Retrieve user = unlimited, 
Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes. 
To change the idle times, see the NTP-G88 Modify Users and Change Security procedure.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-G55 Create a New User on Multiple Nodes

Note All nodes where you want to add users must be accessible in network view.

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task adds a new user to multiple ONS 15454 nodes.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-  G55 Create a New User on Multiple Nodes
Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Security > Users tabs.

Step 3 In the Users window, click Create.

Step 4 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of two and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) characters. 

• Password—Type the user password. The password length, by default, is set to a minimum of six and 
a maximum of 20 characters. You can configure the default values in node view through 
Provisioning > NE Defaults > Node > security > passwordComplexity. The minimum length can be 
set to two, four, eight, ten or twelve characters, and the maximum length to 80 characters. The 
password must be a combination of alphanumeric (a-z, A-Z, 0-9) and special (+, #,%) characters, 
where at least two characters are not alphabetic and at least one character is a special character; or 
the password can contain any character. The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. 

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before it locks up and the password must be reentered. The defaults are: Retrieve 
user = unlimited, Maintenance user = 60 minutes, Provisioning user = 30 minutes, and 
Superuser = 15 minutes. To change the idle times, refer to the NTP-G88 Modify Users and 
Change Security procedure.

Step 5 In the Select Applicable Nodes area, deselect any nodes where you do not want to add the user (all 
network nodes are selected by default).

Step 6 Click OK.

Step 7 In the User Creation Results dialog box, verify that the user was added to all the nodes chosen in Step 5. 
If not, click OK and repeat Steps 2 through 6. If the user was added to all nodes, click OK and continue 
with the next step.

Step 8 Return to your originating procedure (NTP).

NTP-G24 Set Up Name, Date, Time, and Contact Information

Purpose This procedure provisions identification information for the node, 
including the node name, a contact name and phone number, the location 
of the node, and the date, time, and time zone. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G55 Create a New User on Multiple Nodes
Step 1 Complete the DLP-G46 Log into CTC task for the node you will turn up. If you are already logged in, 
continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
General > General tabs.

Step 3 In the Node Name/TID field, type a name for the node. For TL1 compliance, names must begin with an 
alpha character and have no more than 20 alphanumeric (a-z, A-Z, 0-9) characters.

Note To avoid errors when you import the Cisco Transport Planner configuration file using the 
“NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” procedure on 
page 14-48, the CTC node name and the Cisco Transport Planner site name should be the same 
(or at least easy to identify).

Step 4 (Optional) In the Contact field, type the name of the node contact person and the phone number, up to 
255 characters.

Step 5 (Optional) In the Latitude field, enter the node latitude: N (north) or S (south), degrees, and minutes.

Step 6 (Optional) In the Longitude field, enter the node longitude: E (east) or W (west), degrees, and minutes.

Note The latitude and longitude values only indicate the geographical position of the nodes in the 
actual network and not the CTC node position. 

Step 7 (Optional) In the Description field, type a description of the node. The description can be a maximum 
of 255 characters. 

Step 8 (Optional) Check the Use NTP/SNTP Server check box if you want CTC to use a Network Time Protocol 
(NTP) or Simple Network Time Protocol (SNTP) server to set the date and time of the node. Using an 
NTP or SNTP server ensures that all ONS 15454 network nodes use the same date and time reference. 
The server synchronizes the node’s time after power outages or software upgrades.

a. If you check the Use NTP/SNTP Server check box, complete the following fields:

– Use NTP/SNTP Server—Type the IP address of the primary NTP/SNTP server connected to the 
ONS 15454 or of another ONS 15454/15600/15310-CL/15310-MA as GNE with NTP/SNTP 
enabled that is connected to the ONS 15454 ENE.

– Backup NTP/SNTP Server—Type the IP address of the secondary NTP/SNTP server connected 
to the ONS 15454 or of another ONS 15454/15600/15310-CL/15310-MA as GNE with 
NTP/SNTP enabled that is connected to the ONS 15454 ENE. 

When the primary NTP/SNTP server fails or is not reachable, the node uses the secondary 
NTP/SNTP server to synchronize its date and time. If both the primary and secondary 
NTP/SNTP servers fail or are not reachable, an SNTP-FAIL alarm is raised. The node checks 
for the availability of the primary or secondary NTP/SNTP server at regular intervals until it can 
get the time from any one of the NTP/SNTP servers. After the node gets the time from any one 
server, it synchronizes its date and time with the server’s date and time and the SNTP-FAIL 
alarm is cleared. For each retry and resynchronization, the node checks the availability of the 
primary NTP/SNTP server first, followed by the secondary NTP/SNTP server. The node 
synchronizes its date and time every hour.

Note You will not be able to identify which NTP/SNTP server is being used for 
synchronization.
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Note If you plan to check gateway network element (GNE) for the ONS 15454 SOCKS proxy 
server (see “DLP-G56 Provision IP Settings” task on page 14-18), external ONS 15454 
nodes must reference the gateway ONS 15454 for NTP/SNTP timing. For more information 
about the ONS 15454 gateway settings, refer to Chapter 22, “Manage Network 
Connectivity.”

Caution If you reference another ONS 15454 for the NTP/SNTP server, make sure that the second ONS 15454 
references an NTP/SNTP server and not the first ONS 15454 (that is, do not create an NTP/SNTP timing 
loop by having two ONS 15454 nodes reference each other).

b. If you do not check Use SNTP/NTP Server, complete the Date and Time fields. The ONS 15454 will 
use these fields for alarm dates and times. By default, CTC displays all alarms in the CTC computer 
time zone for consistency. To change the display to the node time zone, complete the DLP-G118 
Display Alarms and Conditions Using Time Zone task.

• Date—Type the current date in the format m/d/yyyy, for example, September 24, 2002 is 
9/24/2002.

• Time—Type the current time in the format hh:mm:ss, for example, 11:24:58. The ONS 15454 
uses a 24-hour clock, so 10:00 PM is entered as 22:00:00.

Step 9 Click the Time Zone field and choose a city within your time zone from the drop-down list. The list 
displays the 80 World Time Zones from –11 through 0 (GMT) to +14. Continental United States time 
zones are GMT-05:00 (Eastern), GMT-06:00 (Central), GMT-07:00 (Mountain), and GMT-08:00 
(Pacific).

Step 10 Check the Use Daylight Savings Time check box if the time zone that you chose uses Daylight Savings 
Time.

Note The Insert AIS-V on STS-1 SD-P and SD-P BER field are not used in DWDM networks.

Step 11 Click Apply.

Step 12 In the confirmation dialog box, click Yes.

Step 13 Review the node information. If you need to make corrections, repeat Steps 3 through 12 to enter the 
corrections. If the information is correct, continue with the “NTP-G25 Set Battery Power Monitor 
Thresholds” procedure on page 14-16.

Stop. You have completed this procedure.
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NTP-G25 Set Battery Power Monitor Thresholds

Caution The default battery power thresholds are normally not changed. Threshold changes should only be 
performed at the direction of your site administrator.

Note When the thresholds are crossed, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card generates 
warning alarms in CTC. For ONS 15454 power specifications, see the Hardware Specifications.

Step 1 Complete the DLP-G46 Log into CTC task for the node that you will set up. If you are already logged 
in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > General > 
Power Monitor tabs.

Note In multishelf mode, power monitor thresholds must be provisioned separately for each shelf 
within the multishelf including the node controller and all subtending shelves.

Step 3 To change the extreme low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
ELWBATVGVdc drop-down list.

Step 4 To change the low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
LWBATVGVdc drop-down list.

Step 5 To change the high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
HIBATVGVdc drop-down list.

Step 6 To change the extreme high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
EHIBATVGVdc drop-down list.

Step 7 Click Apply.

Stop. You have completed this procedure.

Purpose This procedure provisions extreme high, low, and extreme low input 
battery power thresholds within a –48 VDC environment. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G26 Set Up CTC Network Access

Step 1 Complete the DLP-G46 Log into CTC task. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G56 Provision IP Settings” task on page 14-18 to provision the ONS 15454 IP 
address, subnet mask, default router, DHCP server, IIOP listener port, and SOCKS proxy server settings. 

Tip If you cannot log into the node, you can change its IP address, default router, and network mask 
by using the LCD on the ONS 15454 fan-tray assembly (unless LCD provisioning is 
suppressed). See the “DLP-G57 Set the IP Address, Default Router, and Network Mask Using 
the LCD” task on page 14-23 for instructions. However, you cannot use the LCD to provision 
any other network settings. In an ONS 15454 M2 shelf assembly, the LCD is on the fan-tray 
assembly. In an ONS 15454 M6 shelf assembly, the LCD is a separate unit installed above the 
external connection unit (ECU). 

Note When accessing CTC from a machine running Windows XP operating system, CTC may sometimes fail 
to reconnect to a GNE when the GNE proxies for several ENE nodes (approximately 15 ENE nodes). 
This can happen when there is a side switch or when the LAN is enabled/disabled. This is due to the 
Windows XP operating system limiting the number of simultaneous TCP/IP connection attempts. As a 
workaround, close the existing CTC session and relaunch CTC on the GNE node. You can configure a 
designated socks server list on the CTC to mitigate the problem.

Step 3 If TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards are installed and you want to turn on the ONS 15454 
secure mode, which allows two IP addresses to be provisioned for the node, complete the “DLP-G264 
Enable Node Security Mode” task on page 14-25. Secure mode is not available if TCC2 cards are 
installed.

Step 4 If static routes are needed, complete the “DLP-G58 Create a Static Route” task on page 14-27. For more 
information about static routes, refer to Chapter 22, “Manage Network Connectivity.” 

Step 5 If the ONS 15454 is connected to a LAN or WAN that uses OSPF and you want to share routing 
information between the LAN or WAN and the ONS network, complete the “DLP-G59 Set Up or Change 
Open Shortest Path First Protocol” task on page 14-28.

Step 6 If the ONS 15454 is connected to a LAN or WAN that uses RIP, complete the “DLP-G60 Set Up or 
Change Routing Information Protocol” task on page 14-30.

Step 7 Complete the “DLP-G439 Provision the Designated SOCKS Servers” task on page 14-21 after the 
network is provisioned and one or more of the following conditions exist:

Purpose This procedure provisions network access for a node, including its subnet 
mask, default router, Dynamic Host Configuration Protocol (DHCP) 
server, Internet Inter-Orb Protocol (IIOP) listener port, gateway settings, 
static routes, Open Shortest Path First (OSPF) protocol, Routing 
Information Protocol (RIP), and designated SOCKS servers.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Superuser only
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• SOCKS proxy is enabled.

• The ratio of ENEs to GNEs is greater than eight to one.

• Most ENEs do not have LAN connectivity.

Stop. You have completed this procedure.

DLP-G56 Provision IP Settings

Caution All network changes should be approved by your network (or LAN) administrator.

Caution Verify that the IPv4 or IPv6 addresses assigned to the node are unique in the network. Duplicate IP 
addresses in the same network cause loss of visibility.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > General tabs.

Step 2 Complete the following information in the fields listed:

• IP Address—Type the IP address assigned to the ONS 15454 node.

Note If TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards are installed, dual IP addressing is available 
using the secure mode. When secure mode is off (sometimes called repeater mode), the IP 
address entered in the IP Address field applies to the backplane LAN port (ONS 15454), 
EMS RJ-45 port or Craft port on the ECU (ONS 15454 M6), EMS RJ-45 port on the power 
module (ONS 15454 M2), and the TCC2P/TCC3/TNC/TNCE/TSC/TSCE TCP/IP (LAN) 
port. When secure mode is on, the IP Address field shows the address assigned to the 
TCC2P/TCC3/TNC/TNCE/TSC/TSCE TCP/IP (LAN) port and the Superuser can enable or 
disable display of the backplane IP address. See the “DLP-G264 Enable Node Security 
Mode” task on page 14-25 as needed. Refer to Chapter 22, “Manage Network Connectivity,” 
for more information about secure mode.

• Net/Subnet Mask Length—Type the subnet mask length (decimal number representing the subnet 
mask length in bits) or click the arrows to adjust the subnet mask length. The subnet mask length is 
the same for all ONS 15454 nodes in the same subnet.

• MAC Address—(Display only) Displays the ONS 15454 IEEE 802 MAC address.

Purpose This task provisions IP settings, which includes the IP address, IP address 
version, default router, DHCP access, firewall access, and SOCKS proxy 
server settings for an ONS 15454 node.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note In secure mode, the front and back TCP/IP (LAN) ports are assigned different MAC 
addresses, and the backplane information can be hidden or revealed by a Superuser.

• Default Router—If the ONS 15454 is connected to a LAN, enter the IP address of the default router. 
The default router forwards packets to network devices that the ONS 15454 cannot directly access. 
This field is ignored if any of the following are true:

– The ONS 15454 is not connected to a LAN.

– The SOCKS proxy server is enabled and the ONS 15454 is provisioned as an end network 
element (ENE).

– OSPF is enabled on both the ONS 15454 and the LAN where the ONS 15454 is connected. 
(OSPF is provisioned in the “DLP-G59 Set Up or Change Open Shortest Path First Protocol” 
task on page 14-28.)

• LCD IP Setting—Choose one of the following:

– Allow Configuration—Displays the node IP address on the LCD and allows users to change 
the IP settings using the LCD. This option enables the “DLP-G57 Set the IP Address, Default 
Router, and Network Mask Using the LCD” task on page 14-23.

– Display Only—Displays the node IP address on the LCD but does not allow users to change the 
IP settings using the LCD.

– Suppress Display—Suppresses the node IP address display on the LCD.

• Suppress CTC IP Display—Check this check box if you want to prevent the node IP address from 
appearing in CTC to users with Provisioning, Maintenance, or Retrieve security levels. (The IP 
address suppression is not applied to users with Superuser security level.)

Note IP address suppression is not applied to users with Superuser security level. However, in 
secure mode the backplane IP address visibility can be restricted to only a locally connected 
Superuser viewing the routing table. In this case, the backplane IP address is not revealed to 
any user at any other NE, either on the routing table or in autonomous messages (such as the 
TL1 REPT DBCHG message, alarms, and performance monitoring [PM] reporting).

• IPv6 Configuration—Allows provisioning of IPv6 addresses. After you provision an IPv6 address, 
you can access the device using the IPv6 address. Configure these settings only if you want to enable 
IPv6 on the node. IPv6 cannot be configured using the LCD push buttons.

– Enable IPv6—Select this check box to assign an IPv6 address to the node. The IPv6 Address, 
Prefix Length, and IPv6 Default Router fields are enabled only if this check box is selected. The 
check box is disabled by default.

Note Enable SOCKS Proxy on Port check box is enabled when you enable IPv6 and can be disabled 
only when IPv6 is disabled.

Note By default, when IPv6 is enabled, the node processes both IPv4 and IPv6 packets on the 
LAN interface. If you want the node to process only IPv6 packets, you need to disable IPv4 
on the node. For more information, see DLP-G317 Change Node Access and PM Clearing 
Privilege. 
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– IPv6 Address—Enter the IPv6 address that you want to assign to the node. This IP address is 
the global unicast IPv6 address. This field is disabled if the Enable IPv6 check box is not 
selected.

– Prefix Length—Enter the prefix length of the IPv6 address. This field is disabled if the Enable 
IPv6 check box is not selected.

– IPv6 Default Router—Enter the IPv6 address of the default router of the IPv6 NE. This is 
optional. This field is disabled if the Enable IPv6 check box is not selected.

Note The ONS 15454 DWDM uses NAT-PT internally to support native IPv6. NAT-PT uses the 
IPv4 address range 128.0.0.0 to 128.0.1.254 for packet translation. Do not use this address 
range when you enable IPv6 feature.

Note You can provision IPv6 in secure or nonsecure mode. To enable secure mode, see 
“DLP-G264 Enable Node Security Mode” task on page 14-25.

• Forward DHCP Request To—Check this check box to enable DHCP. Also, enter the DHCP server 
IP address in the Request To field. Unchecked is the default. If you will enable any of the gateway 
settings to implement the ONS 15454 SOCKS proxy server features, do not check this check box.

Note If you enable DHCP, computers connected to an ONS 15454 node can obtain temporary IP 
addresses from an external DHCP server. The ONS 15454 only forwards DHCP requests; it 
does not act as a DHCP server.

• Gateway Settings—Provisions the ONS 15454 SOCKS proxy server features. (SOCKS is a standard 
proxy protocol for IP-based applications.) Do not change these options until you review Scenario 7 
“Provisioning the ONS 15454 Proxy Server” in Chapter 22, “Manage Network Connectivity.” In 
SOCKS proxy server networks, the ONS 15454 is either an ENE, a GNE, or a proxy-only server. 
Provisioning must be consistent for each NE type.

• Enable SOCKS proxy server on port—If checked, the ONS 15454 serves as a proxy for connections 
between CTC clients and ONS 15454 nodes that are connected by data communications channels 
(DCCs) to the proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes 
through the proxy node. The CTC client does not require IP connectivity to the DCC-connected 
nodes; it only requires IP connectivity to the proxy ONS 15454. If the Enable SOCKS proxy server 
on port check box is unchecked, the node does not proxy for any CTC clients. When this box is 
checked, you can provision one of the following options:

– External Network Element (ENE)—Choose this option when the ONS 15454 is not connected 
to a LAN but has DCC connections to other ONS nodes. A CTC computer connected to the ENE 
through the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card TCP/IP (craft) port can manage 
nodes that have DCC connections to the ENE. However, the CTC computer does not have direct 
IP connectivity to these nodes or to any LAN or WAN that those nodes might be connected to.

– Gateway Network Element (GNE)—Choose this option when the ONS 15454 is connected to 
a LAN and has DCC connections to other nodes. A CTC computer connected to the LAN can 
manage all nodes that have DCC connections to the GNE, but the CTC computer does not have 
direct IP connectivity to them. The GNE option isolates the LAN from the DCC network so that 
IP traffic originating from the DCC-connected nodes and any CTC computers connected to 
them is prevented from reaching the LAN.
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– SOCKS proxy only—Choose this option when the ONS 15454 is connected to a LAN and the 
LAN is separated from the node by a firewall. The SOCKS proxy only option is the same as the 
GNE option, except that the SOCKS proxy only option does not isolate the DCC network from 
the LAN.

Note If a node is provisioned in secure mode, it is automatically provisioned as a GNE with SOCKS 
proxy enabled. However, this provisioning can be overridden, and the secure node can be 
changed to an ENE. In secure mode, SOCKS cannot be disabled. For information about 
provisioning, including GNE and ENE status, see the “DLP-G264 Enable Node Security Mode” 
task on page 14-25.

Step 3 Click Apply.

Step 4 Click Yes in the confirmation dialog box.

The TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards reboot one at a time if changes were made to 
the IP address, subnet mask, or gateway settings. During this time (approximately 5 to 6 minutes), the 
active and standby TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card LEDs will blink, turn on, and turn 
off at different intervals. Eventually, a “Lost node connection, switching to network view” message 
appears.

Step 5 Click OK. The network view appears. The node icon appears in gray, during which time you cannot 
access the node.

Step 6 Double-click the node icon when it becomes green. 

Step 7 Return to your originating procedure (NTP). 

DLP-G439 Provision the Designated SOCKS Servers

Note To complete this task, you must have either the IP addresses or DNS names of all ONS 15454s in the 
network with LAN access that have SOCKS proxy enabled.

Purpose This task identifies the ONS 15454 SOCKS servers in 
SOCKS-proxy-enabled networks. Identifying the SOCKS servers reduces 
the amount of time required to log into a node and have all NEs appear in 
network view (NE discovery time). The task is recommended when the 
combined CTC login and NE discovery time is greater than five minutes in 
networks with SOCKS proxy enabled. Long (or failed) login and NE 
discovery times can occur in networks that have a high ENE-to-GNE ratio 
and a low number of ENEs with LAN connectivity.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note SOCKS proxy servers can be any accessible ONS network nodes that have LAN access, including the 
ONS 15310-MA, ONS 15310-CL, ONS 15454, ONS 15454 SDH, ONS 15600, ONS 15600 SDH, ONS 
15454 M6, and ONS 15454 M2 nodes.

Note You must repeat this task any time that changes to SOCKS proxy server nodes occur, for example, 
whenever LAN connectivity is added to or removed from a node, or when nodes are added or removed 
from the network.

Note If you cannot log into a network node, complete the DLP-G46 Log into CTC task choosing the Disable 
Network Discovery option. Complete this task, then login again with network discovery enabled.

Step 1 From the CTC Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the SOCKS tab.

Step 3 In the Designated SOCKS Server field, type the IP address or DNS node name of the first ONS 15454 
SOCKS server. The ONS 15454 that you enter must have SOCKS proxy server enabled, and it must have 
LAN access. 

Step 4 Click Add. The node is added to the SOCKS server list. If you need to remove a node on the list, click 
Remove.

Step 5 Repeat Steps 3 and 4 to add all qualified ONS 15454s within the network. Add all ONS nodes that have 
SOCKS proxy enabled and are connected to the LAN. 

Step 6 Click Check All Servers. CTC verifies that all nodes can perform as SOCKS servers. Once verified, a 
check is placed next to the node IP address or node name in the SOCKS server list. An X placed next to 
the node indicates one or more of the following:

• The entry does not correspond to a valid DNS name.

• The numeric IP address is invalid.

• The node cannot be reached.

• The node can be reached, but the SOCKS port cannot be accessed, for example, a firewall problem 
might exist.

Step 7 Click Apply. The list of ONS 15454 nodes, including ones that received an X in Step 6, are added as 
SOCKS servers.

Step 8 Click OK to close the Preferences dialog box.

Step 9 Return to your originating procedure (NTP). 
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DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD

Note You cannot perform this task if the LCD IP Display field on the node view Provisioning > Network tab 
is set to Display Only or Suppress Display. See the “DLP-G56 Provision IP Settings” task on page 14-18 
to view or change the LCD IP Display field. If the node is locked in secure mode with the LCD display 
disabled, you will not be able to change this provisioning unless the lock is disabled by Cisco Technical 
Support. Refer to Chapter 22, “Manage Network Connectivity,” for more information about secure 
mode. 

Note The LCD reverts to normal display mode after 5 seconds of button inactivity.

Step 1 On the ONS 15454 front panel, repeatedly press the Slot button until SHELF appears on the first line of 
the LCD. You are in the Shelf menu.

Note In an ONS 15454 M2 shelf assembly, the LCD panel and the Slot, Port, and Status buttons are present 
on the fan-tray assembly. In an ONS 15454 M6 shelf assembly, the LCD is a separate unit installed above 
the external connection unit (ECU); the Slot, Port, and Status buttons are present on the LCD unit.

Step 2 Repeatedly press the Port button until the following information appears:

• To change the node IP address, Node Status=IpAddress (Figure 14-1)

• To change the node network mask, Node Status=Net Mask

• To change the default router IP address, Node Status=Default Rtr

Figure 14-1 Selecting the IP Address Option—ONS 15454 Shelf Assembly

Purpose This task changes the ONS 15454 IP address, default router, and network 
mask using the LCD on the fan-tray assembly. Use this task if you cannot 
log into CTC. In an ONS 15454 M2 shelf assembly, the LCD is on the 
fan-tray assembly. In an ONS 15454 M6 shelf assembly, the LCD is a 
separate unit installed above the external connection unit (ECU). 

Tools/Equipment None

Prerequisite Procedures “DLP-G33 Install the TCC2, TCC2P, or TCC3 Card” in the Cisco ONS 
15454 Hardware Installation Guide

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

FAN FAIL

Slot

Node
Status=IpAddress

15
15

62CRIT MAJ MIN

Status Port
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Step 3 Press the Status button to display the node IP address (Figure 14-2), the node subnet mask length, or the 
default router IP address.

Figure 14-2 Changing the IP Address—ONS 15454 Shelf Assembly

Step 4 Push the Slot button to move to the digit of the IP address, subnet mask, or default router that you want 
to change. The selected digit flashes.

Tip The Slot, Status, and Port button positions correspond to the positions of the commands shown 
on the LCD. For example, in Figure 14-2, you press the Slot button to invoke the Next command 
and the Status button to invoke the Done command.

Step 5 Press the Port button to cycle the IP address, subnet mask, or default router to the correct digit.

Step 6 When the change is complete, press the Status button to return to the relevant Node Status menu.

Step 7 Repeatedly press the Port button until the Shelf Save Configuration option appears (Figure 14-3).

Figure 14-3 Selecting the Save Configuration Option—ONS 15454 Shelf Assembly 

Step 8 Press the Status button to choose the Save Configuration option.

A Save and REBOOT message appears (Figure 14-4).

Figure 14-4 Saving and Rebooting the TCC2/TCC2P/TCC3—ONS 15454 Shelf Assembly

Step 9 Press the Slot button to apply the new IP address, subnet mask, or default router configuration or press 
Port to cancel the configuration.

Note The IP address and default router must be on the same subnet. If not, you cannot apply the 
configuration. 

FAN FAIL

Slot

172.020.214.107
<Next   Done      Mod>

44
09

0CRIT MAJ MIN

Status Port

FAN FAIL

Slot

Shelf
Status=Save Cfg.

15
15

63CRIT MAJ MIN

Status Port

FAN FAIL

Slot

Save and REBOOT?
<Apply            Revert>

44
09

2CRIT MAJ MIN

Status Port
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Step 10 Saving the new configuration causes the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards to reboot. 
During the reboot, a “TCC may Reset” message appears on the LCD. The LCD returns to the normal 
alternating display after both TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards finish rebooting.

Step 11 Return to your originating procedure (NTP).

DLP-G264 Enable Node Security Mode

Caution The IP address assigned to the TCC2P/TCC3/TNC/TNCE/TSC/TSCE TCP/IP (LAN) port must reside 
on a different subnet from the backplane LAN port (ONS 15454) and the EMS port (ONS 15454 M2 and 
M6). Verify that the new TCC2P/TCC3/TNC/TNCE/TSC/TSCE IP address meets this requirement.

Note The node will reboot after you complete this task, causing a temporary disconnection between the CTC 
computer and the node.

Note If an OTS-to-OTS PPC is created between nodes, it will no longer function if the node Security Mode is 
enabled (see DLP-G264 Enable Node Security Mode, page 14-25). The reason for this is that if the 
Secure mode is enabled, it is no longer possible for the DCN extension feature to use the LAN interface 
to extend the internal network (due to the network isolation in this configuration mode). The result is 
that the topology discovery on the OTS-to-OTS PPC no longer operates.

Step 1 Click the Provisioning > Security > Data Comm tabs. 

Note The security mode options are not available in CTC if TCC2 cards or a mix of TCC2 and TCC2P 
cards are installed.

Step 2 Click Change Mode.

Step 3 Review the information on the Change Secure Mode page, then click Next.

Purpose This task enables the security mode. When security mode is enabled, two 
IP addresses are assigned to the node. One address is assigned to the 
backplane LAN port (ONS 15454) or to the EMS port (ONS 15454 M2 and 
M6). The other address is assigned to the 
TCC2P/TCC3/TNC/TNCE/TSC/TSCE RJ-45 TCP/IP (LAN) port. The 
TCC2 card does not support security mode.

Tools/Equipment TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards must be installed. Do not 
install a mix of TCC2 and TCC2P cards.

Prerequisite Procedures NTP-G103 Back Up the Database, page 24-2

DLP-G46 Log into CTC task

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 4 On the TCC Ethernet Port page, enter the IP address and subnet mask for the 
TCC2P/TCC3/TNC/TNCE/TSC/TSCE TCP/IP (LAN) port. The IP address cannot reside on the same 
subnet as the backplane LAN port (ONS 15454) and the EMS port (ONS 15454 M2 and M6).

Step 5 Click Next.

Step 6 If needed, on the Backplane Ethernet Port page, modify the backplane IP address, subnet mask, and 
default router. (You normally do not modify these fields if no network changes have occurred.)

Step 7 Click Next. 

Step 8 On the SOCKS Proxy Server Settings page, choose one of the following options:

• External Network Element (ENE)—If selected, the CTC computer is only visible to the 
ONS 15454 where the CTC computer is connected. The CTC computer is not visible to the nodes 
connected to the DCC. In addition, firewall is enabled, which means that the node prevents IP traffic 
from being routed between the DCC and the LAN port. 

• Gateway Network Element (GNE)—If selected, the CTC computer is visible to other 
DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and the 
LAN port. 

Note The SOCKS proxy server is automatically enabled when you enable secure mode.

Step 9 Click Finish.

Within the next 30 to 40 seconds, the TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards reboot. CTC switches 
to network view, and the CTC Alerts dialog box appears. In network view, the node changes to gray and 
a DISCONNECTED condition appears in the Alarms tab. 

Step 10 In the CTC Alerts dialog box, click Close. Wait for the reboot to finish. (This might take several 
minutes.) 

Step 11 After the DISCONNECTED condition clears, complete the following steps to suppress the backplane IP 
address from appearing in CTC and the LCD. If you do not want to suppress the backplane IP address 
display, continue with Step 12.

a. Display the node in node view (single-shelf mode) or multishelf view (multishelf mode).

b. Click the Provisioning > Security > Data Comm tabs. 

c. In the LCD IP Setting field, choose Suppress Display. The IP address will not appear on the 
ONS 15454 LCD.

d. Check the Suppress CTC IP Address check box. The IP address will not appear in the CTC 
information area or the Provisioning > Security > Data Comm tabs.

e. Click Apply.

Note After you turn on secure mode, the TCC2P/TCC3/TNC/TNCE/TSC/TSCE IP address becomes 
the node IP address.

Step 12 Return to your originating procedure (NTP).
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DLP-G58 Create a Static Route

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network tabs.

Step 2 Click the Static Routing tab. Click Create.

Step 3 In the Create Static Route dialog box, enter the following: 

• Destination—Enter the IP address of the computer running CTC. To limit access to one computer, 
enter the full IP address and a subnet mask of 255.255.255.255. To allow access to all computers on 
the 192.168.1.0 subnet, enter 192.168.1.0 and a subnet mask of 255.255.255.0. You can enter a 
destination of 0.0.0.0 to allow access to all CTC computers that connect to the router.

• Mask—Enter a subnet mask. If the destination is a host route (that is, one CTC computer), enter a 
32-bit subnet mask (255.255.255.255). If the destination is a subnet, adjust the subnet mask 
accordingly, for example, 255.255.255.0. If the destination is 0.0.0.0, CTC automatically enters a 
subnet mask of 0.0.0.0 to provide access to all CTC computers. You cannot change this value.

• Next Hop—Enter the IP address of the router port or the node IP address if the CTC computer is 
connected to the node directly.

• Cost—Enter the number of hops between the ONS 15454 and the computer. 

Step 4 Click OK. Verify that the static route appears in the Static Route window.

Note Static route networking examples are provided in the Chapter 22, “Manage Network 
Connectivity.”

Step 5 Return to your originating procedure (NTP).

Purpose This task creates a static route to establish CTC connectivity to a computer 
on another network. This task is performed when one of the following 
conditions exists:

• CTC computers on one subnet need to connect to ONS 15454 nodes 
that are connected by a router to ONS 15454 nodes residing on another 
subnet. 

• OSPF is not enabled (the OSPF Active on LAN check box is not 
checked on the Provisioning > Network > OSPF tab) and the External 
Network Element (ENE) gateway setting is not checked.

• You need to enable multiple CTC sessions among ONS 15454 nodes 
residing on the same subnet and the External Network Element (ENE) 
gateway setting is not checked.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G59 Set Up or Change Open Shortest Path First Protocol

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > OSPF tabs.

Step 2 On the top left side of the OSPF area, complete the following:

• DCC/GCC OSPF Area ID Table—In dotted decimal format, enter the number that identifies the 
ONS 15454 nodes as a unique OSPF area ID. The Area ID can be any number between 
000.000.000.000 and 255.255.255.255, but must be unique to the LAN OSPF area.

ANSI Nodes

• SDCC Metric—This value is normally unchanged. It sets a cost for sending packets across the 
Section DCC, which is used by OSPF routers to calculate the shortest path. This value should always 
be higher than the LAN metric. The default SDCC metric is 100. 

• LDCC Metric—Sets a cost for sending packets across the Line DCC. This value should always be 
lower than the SDCC metric. The default LDCC metric is 33. It is usually not changed.

ETSI Nodes

• RS-DCC Metric—This value is normally unchanged. It sets a cost for sending packets across the 
regenerator section DCC (RS-DCC), which is used by OSPF routers to calculate the shortest path. 
This value should always be higher than the LAN metric. The default RS-DCC metric is 100. 

• MS-DCC Metric—Sets a cost for sending packets across the multiplex section DCC (MS-DCC). 
This value should always be lower than the SDCC metric. The default MS-DCC metric is 33. It is 
usually not changed.

Step 3 In the OSPF on LAN area, complete the following:

• OSPF active on LAN—When checked, enables the ONS 15454 OSPF topology to be advertised to 
OSPF routers on the LAN. Enable this field on ONS 15454 nodes that directly connect to OSPF 
routers.

• LAN Port Area ID—Enter the OSPF area ID (dotted decimal format) for the router port where the 
ONS 15454 is connected. (This number is different from the DCC/GCC OSPF Area ID.)

Step 4 By default, OSPF is set to No Authentication. If the OSPF router requires authentication, complete the 
following steps. If not, continue with Step 5.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

Purpose This task enables the OSPF routing protocol on the ONS 15454. Perform 
this task if you want to include the ONS 15454 in OSPF-enabled networks.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

You will need the OSPF Area ID, Hello and Dead intervals, and 
authentication key (if OSPF authentication is enabled) provisioned on the 
router to which the ONS 15454 is connected.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Enter Authentication Key—Enter the password.

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 5 Provision the OSPF priority and interval settings. The OSPF priority and interval defaults are the 
defaults most commonly used by OSPF routers. Verify that these defaults match the ones used by the 
OSPF router where the ONS 15454 is connected.

• Router Priority—Provision the router priority, which determines the designated router for a subnet.

• Hello Interval (sec)—Provision the number of seconds between OSPF hello packet advertisements 
sent by OSPF routers. Ten seconds is the default.

• Dead Interval—Provision the number of seconds that will pass while an OSPF router’s packets are 
not visible before its neighbors declare the router down. Forty seconds is the default.

• Transit Delay (sec)—Provision the service speed. One second is the default.

• Retransmit Interval (sec)—Provision the number of seconds that will elapse before a packet is 
resent. Five seconds is the default.

• LAN Metric—Provision the cost for sending packets across the LAN. This value should always be 
lower than the SDCC or RS-DCC metric. Ten is the default.

Step 6 Under OSPF Area Range Table, create an area range table if one is needed:

Note Area range tables consolidate the information that is outside an OSPF area border. One 
ONS 15454 in the ONS 15454 OSPF area is connected to the OSPF router. An area range table 
on this node points the router to the other nodes that reside within the ONS 15454 OSPF area. 

a. Click Create.

b. In the Create Area Range dialog box, enter the following:

• Range Address—Enter the area IP address for the ONS 15454 nodes that reside within the 
OSPF area. For example, if the ONS 15454 OSPF area includes nodes with IP addresses 
10.10.20.100, 10.10.30.150, 10.10.40.200, and 10.10.50.250, the range address would be 
10.10.0.0.

• Range Area ID—Enter the OSPF area ID for the ONS 15454 nodes. This is either the ID in the 
DCC OSPF Area ID field or the ID in the Area ID for LAN Port field.

• Mask Length—Enter the subnet mask length. In the Range Address example, this is 16. 

• Advertise—Check this box if you want to advertise the OSPF range table.

c. Click OK.

Step 7 All OSPF areas must be connected to Area 0. If the ONS 15454 OSPF area is not physically connected 
to Area 0, use the following steps to create a virtual link table that will provide the disconnected area 
with a logical path to Area 0:

a. Under the OSPF Virtual Link Table, click Create.

b. In the Create Virtual Link dialog box, complete the following fields. OSPF settings must match 
OSPF settings for the ONS 15454 OSPF area:

• Neighbor—Enter the router ID of the Area 0 router.

• Transit Delay (sec)—Enter the service speed. One second is the default.
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• Hello Int (sec)—Provision the number of seconds between OSPF hello packet advertisements 
sent by OSPF routers. Ten seconds is the default.

• Auth Type—If the router where the ONS 15454 is connected uses authentication, choose 
Simple Password. Otherwise, choose No Authentication.

• Retransmit Int (sec)—Provision the time that will elapse, in seconds, before a packet is resent. 
Five seconds is the default.

• Dead Int (sec)—Provision the number of seconds that will pass while an OSPF router’s packets 
are not visible before its neighbors declare the router down. Forty seconds is the default.

c. Click OK.

Step 8 After entering the ONS 15454 OSPF area data, click Apply.

If you changed the Area ID, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards reset, one at a time. 
The reset takes approximately 10 to 15 minutes.

Step 9 Return to your originating procedure (NTP).

DLP-G60 Set Up or Change Routing Information Protocol

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > RIP tabs. 

Step 2 Check the RIP Active check box if you are activating RIP. 

Step 3 Choose either RIP Version 1 or RIP Version 2 from the drop-down list, depending on which version is 
supported in your network. 

Step 4 Set the RIP metric. The RIP metric can be set to a number between 1 and 15 and represents the number 
of hops. 

Step 5 By default, RIP is set to No Authentication. If the router that the ONS 15454 is connected to requires 
authentication, complete the following steps. If not, continue with Step 6.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password.

Purpose This task enables RIP on the ONS 15454. Perform this task if you want to 
include the ONS 15454 in RIP-enabled networks.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

You need to create a static route to the router adjacent to the ONS 15454 
for the ONS 15454 to communicate its routing information to 
non-DCC-connected nodes.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 6 If you want to complete an address summary, complete the following steps. If not, continue with Step 7. 
Complete the address summary only if the ONS 15454 is a gateway NE with multiple external 
ONS 15454 NEs attached with IP addresses in different subnets.

a. In the RIP Address Summary area, click Create.

b. In the Create Address Summary dialog box, complete the following:

• Summary Address—Enter the summary IP address.

• Mask Length—Enter the subnet mask length using the up and down arrows.

• Hops—Enter the number of hops. The smaller the number of hops, the higher the priority.

c. Click OK.

Step 7 Return to your originating procedure (NTP).

NTP-G194 Set Up EMS Secure Access to the ONS 15454 

Step 1 In node view, click the Provisioning > Security > Access pane.

Step 2 Under the EMS Access area, change the Access State to Secure.

Step 3 Click Apply. The CTC disconnects and reconnects through a secure socket connection.

Step 4 To create a secure connection, enter https://node-address.

Note After setting up a CTC connection in secure mode, http requests are automatically redirected to https 
mode.

Step 5 A first time connection is authenticated by the Website Certification is Not Known dialog box. Accept 
the certificate and click OK. The Security Error: Domain Name Mismatch dialog box appears. Click 
OK to continue.

Stop. You have completed this procedure.

Purpose This procedure provisions ONS 15454s and CTC computers for secure 
access.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 14-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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NTP-G341 Set Up Secure Access to the ONS 15454 TL1

Step 1 In the node view, click the Provisioning > Security > Access pane.

Step 2 Under the TL1 Access area, change the Access State to Secure.

Step 3 Click Apply. 

Existing non-secure TL1 sessions, if any, are terminated.

Step 4 To create a secure TL1 connection, enter the following command at the UNIX or Linux prompt:

ssh -l username node-ip -p port-number

The port number for secure TL1 is 4083.

Note Use any SSH client on Windows.

Stop. You have completed this procedure.

NTP-G27 Set Up the ONS 15454 for Firewall Access

Step 1 Log into a node that is behind the firewall. See the DLP-G46 Log into CTC task for instructions. If you 
are already logged in, continue with Step 2.

Step 2 If the ONS 15454 node is in a protected network and the CTC computer is in an external network, 
complete the “DLP-G61 Provision the IIOP Listener Port on the ONS 15454” task on page 14-34.

Figure 14-5 shows ONS 15454 nodes in a protected network and the CTC computer in an external 
network. For the computer to access the ONS 15454 nodes, you must provision the IIOP listener port 
specified by your firewall administrator on the ONS 15454. 

Purpose This procedure provisions ONS 15454s for secure access to TL1.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 14-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This procedure provisions ONS 15454 nodes and CTC computers for 
access through firewalls.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 14-5 Nodes Behind a Firewall

Step 3 If the CTC computer resides behind a firewall, complete the “DLP-G62 Provision the IIOP Listener Port 
on the CTC Computer” task on page 14-35.

Figure 14-6 shows a CTC computer and ONS 15454 behind firewalls. For the computer to access the 
ONS 15454, you must provision the IIOP port on the CTC computer and on the ONS 15454. 

Figure 14-6 CTC Computer and ONS 15454 Nodes Residing Behind Firewalls

Stop. You have completed this procedure.

NTP-G28 Create FTP Host
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Purpose This procedure provisions an FTP Host that you can use to perform 
database backup and restore or software download to an End Network 
Element (ENE) when proxy or firewall is enabled.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 14-17

NTP-G27 Set Up the ONS 15454 for Firewall Access, page 14-32

Required/As Needed As needed
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Step 1 Complete the DLP-G46 Log into CTC task. If you are already logged in, continue with Step 2.

Step 2 If you want to turn on the ONS 15454 secure mode, which allows two IPv4 addresses to be provisioned 
for the node if TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards are installed, complete the “DLP-G264 
Enable Node Security Mode” task on page 14-25. Refer to the Chapter 22, “Manage Network 
Connectivity,” for information about secure mode.

Step 3 In Node view, click the Provisioning > Network > FTP Hosts tabs.

Step 4 Click Create.

Step 5 Enter a valid IP address in the FTP Host Address field. A maximum of 12 host can be entered.

Note In ONS 15454 Software Release 9.1 and later, you can configure an IPv6 address for an FTP server, in 
addition to an IPv4 address.

Step 6 The Mask is automatically set according to the Net/Subnet Mask length specified in “DLP-G56 
Provision IP Settings” section on page 14-18. To change the Mask, click the Up/Down arrows on the 
Length menu.

Step 7 Check the FTP Relay Enable radio button to allow FTP commands at the GNE relay. If you will enable 
the relay at a later time, go to Step 9. Certain TL1 commands executed on an ENE require FTP access 
into the Data Communication Network (DCN), the FTP relay on the GNE provides this access. The FTP 
hosts that you have configured in CTC can be used with the TL1 COPY-RFILE (for database backup and 
restore or software download) or COPY-IOSCFG (for Cisco IOS Configuration File backup and restore) 
commands.

Step 8 Enter the time, in minutes, that FTP Relay will be enabled. A valid entry is a number between 0 and 60. 
The number 0 disallows FTP command relay. After the specified time has elapsed the FTP Relay Enable 
flag is unset and FTP command relay is disallowed.

Step 9 Click OK.

Step 10 Repeat Step 4 through Step 9 to provision additional FTP Hosts.

Stop. You have completed this procedure.

DLP-G61 Provision the IIOP Listener Port on the ONS 15454

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task sets the IIOP listener port on the ONS 15454, ONS 15454 M2, 
and ONS 15454 M6 which enables you to access nodes that reside behind 
a firewall.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note If the Enable SOCKS proxy on port 1080 check box is checked, CTC will use Port 1080 and ignore the 
configured IIOP port setting. If the check box is later unchecked, the configured IIOP listener port will 
be used.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Security > Access tabs.

Step 2 In the TCC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - TCC Fixed—Uses Port 57790 to connect to ONS 15454 nodes on the same side of the 
firewall or if no firewall is used (default). This option can be used for access through a firewall if 
Port 57790 is available.

• Standard Constant—Uses Port 683, the Common Object Request Broker Architecture (CORBA) 
default port number.

• Other Constant—If Port 683 is not used, type the IIOP port specified by your firewall 
administrator. 

Step 3 Click Apply.

Step 4 When the Change Network Configuration message appears, click Yes. 

The TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards reboot, one at a time. The reboot takes 
approximately 15 minutes. 

Step 5 Return to your originating procedure (NTP).

DLP-G62 Provision the IIOP Listener Port on the CTC Computer

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Firewall tab.

Step 3 In the CTC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - Variable—Use to connect to ONS 15454 nodes from within a firewall or if no firewall is 
used (default).

• Standard Constant—Use Port 683, the CORBA default port number.

• Other Constant—If Port 683 is not used, enter the IIOP port defined by your administrator.

Step 4 Click Apply. A warning appears telling you that the port change will apply during the next CTC login.

Purpose This task selects the IIOP listener port for CTC and must be completed if 
the computer running CTC resides behind a firewall.

Tools/Equipment IIOP listener port number from LAN or firewall administrator

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click OK. 

Step 6 In the Preferences dialog box, click OK.

Step 7 To access the ONS 15454 using the IIOP port, log out of CTC then log back in. (To log out, choose Exit 
from the File menu).

Step 8 Return to your originating procedure (NTP).

NTP-G132 Provision OSI

Caution This procedure requires an understanding of OSI protocols, parameters, and functions. Before you begin, 
review the OSI reference sections in Chapter 22, “Manage Network Connectivity” and ensure that you 
know the role of the ONS 15454 within the OSI and IP network.

Note This procedure requires provisioning of non-ONS equipment including routers and third party NEs. Do 
not begin until you have the capability to complete that provisioning.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to provision the OSI. If you are 
already logged in, continue with Step 2.

Step 2 As needed, complete the following tasks: 

• DLP-G283 Provision OSI Routing Mode, page 14-37—Complete this task first.

• DLP-G284 Provision the TARP Operating Parameters, page 14-38—Complete this task second.

• DLP-G285 Add a Static TID-to-NSAP Entry to the TARP Data Cache, page 14-40—Complete this 
task as needed.

• DLP-G287 Add a TARP Manual Adjacency Table Entry, page 14-41—Complete this task as needed.

• DLP-G288 Provision OSI Routers, page 14-42—Complete this task as needed.

• DLP-G289 Provision Additional Manual Area Addresses, page 14-43—Complete this task as 
needed.

• DLP-G290 Enable the OSI Subnet on the LAN Interface, page 14-43—Complete this task as 
needed.

Purpose This procedure provisions the ONS 15454 so it can be installed in networks 
with other vendor NEs that use the OSI protocol stack for data 
communications network (DCN) communications. This procedure 
provisions the Target Identifier Address Resolution Protocol (TARP), OSI 
routers, manual area addresses, subnetwork points of attachment, and 
IP-over-Connectionless Network Service (CLNS) tunnels.

Tools/Equipment None

Prerequisite Procedures “NTP-G15 Install the Common Control Cards” section on page 3-35”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• DLP-G291 Create an IP-Over-CLNS Tunnel, page 14-44—Complete this task as needed.

Stop. You have completed this procedure.

DLP-G283 Provision OSI Routing Mode

Caution Do not complete this task until you confirm the role of the node within the network. It will be either an 
End System, Intermediate System Level 1, or IS Level 1/Level 2. This decision must be carefully 
considered. For additional information about OSI provisioning, refer to Chapter 22, “Manage Network 
Connectivity.”

Caution Link State Protocol (LSP) buffers must be the same at all NEs within the network, or loss of visibility 
might occur. Do not modify the LSP buffers unless you confirm that all NEs within the OSI have the 
same buffer size.

Caution LSP buffer sizes cannot be greater than the LAP-D maximum transmission unit (MTU) size within the 
OSI area.

Note For ONS 15454 nodes, three virtual routers can be provisioned. The node primary Network Service 
Access Point (NSAP) address is also the Router 1 primary manual area address. To edit the primary 
NSAP, you must edit the Router 1 primary manual area address. After you enable Router 1 on the Routers 
subtab, the Change Primary Area Address button is available to edit the address.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI 
tabs.

Step 2 Choose a routing mode:

• End System—The ONS 15454 performs OSI end system (ES) functions and relies upon an 
intermediate system (IS) for communication with nodes that reside within its OSI area.

Note The End System routing mode is not available if more than one virtual router is enabled. 

Purpose This task provisions the OSI routing mode. Complete this task when the 
ONS 15454 is connected to networks with third party NEs that use the OSI 
protocol stack for DCN communication.

Tools/Equipment None

Prerequisite Procedures “NTP-G15 Install the Common Control Cards” section on page 3-35”

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Intermediate System Level 1—The ONS 15454 performs OSI IS functions. It communicates with 
IS and ES nodes that reside within its OSI area. It depends upon an IS L1/L2 node to communicate 
with IS and ES nodes that reside outside its OSI area.

• Intermediate System Level 1/Level 2—The ONS 15454 performs IS functions. It communicates 
with IS and ES nodes that reside within its OSI area. It also communicates with IS L1/L2 nodes that 
reside in other OSI areas. Before choosing this option, verify the following:

– The node is connected to another IS Level 1/Level 2 node that resides in a different OSI area.

– The node is connected to all nodes within its area that are provisioned as IS L1/L2.

Step 3 If needed, change the LSP data buffers:

• L1 LSP Buffer Size—Adjusts the Level 1 link state protocol data unit (PDU) buffer size. The default 
is 512. It should not be changed.

• L2 LSP Buffer Size—Adjusts the Level 2 link state PDU buffer size. The default is 512. It should 
not be changed.

Step 4 Return to your originating procedure (NTP).

DLP-G284 Provision the TARP Operating Parameters

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI > 
TARP > Config tabs.

Step 2 Provision the following parameters, as needed:

• TARP PDUs L1 Propagation—If checked (default), TARP Type 1 PDUs that are received by the 
node and are not excluded by the LDB are propagated to other NEs within the Level 1 OSI area. 
(Type 1 PDUs request a protocol address that matches a target identifier [TID] within a Level 1 
routing area.) The propagation does not occur if the NE is the target of the Type 1 PDU, and PDUs 
are not propagated to the NE from which the PDU was received.

Note The TARP PDUs L1 Propagation parameter is not used when the Node Routing Area (on the 
Provisioning > OSI > Main Setup tab) is set to End System.

• TARP PDUs L2 Propagation—If checked (default), TARP Type 2 PDUs that are received by the 
node and are not excluded by the LDB are propagated to other NEs within the Level 2 OSI areas. 
(Type 2 PDUs request a protocol address that matches a TID within a Level 2 routing area.) The 
propagation occurs if the NE is not the target of the Type 2 PDU, and PDUs are not propagated to 
the NE from which the PDU was received.

Purpose This task provisions the TARP operating parameters including TARP PDU 
propagation, timers, and loop detection buffer (LDB).

Tools/Equipment None

Prerequisite procedures  DLP-G46 Log into CTC

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note The TARP PDUs L2 Propagation parameter is only used when the Node Routing Area is 
provisioned to Intermediate System Level 1/Level 2.

• TARP PDUs Origination—If checked (default), the node performs all TARP origination functions 
including:

– TID-to-NSAP resolution requests (originate TARP Type 1 and Type 2 PDUs)

– NSAP-to-TID requests (originate Type 5 PDUs)

– TARP address changes (originate Type 4 PDUs)

Note TARP Echo and NSAP to TID are not supported.

• TARP Data Cache—If checked (default), the node maintains a TARP data cache (TDC). The TDC 
is a database of TID-to-NSAP pairs created from TARP Type 3 PDUs received by the node and 
modified by TARP Type 4 PDUs (TID-to-NSAP updates or corrections). TARP 3 PDUs are 
responses to Type 1 and Type 2 PDUs. The TDC can also be populated with static entries entered 
on the TARP > Static TDC tab.

Note TARP Data Cache is only used when the TARP PDUs Origination parameter is enabled.

• L2 TARP Data Cache—If checked (default), the TIDs and NSAPs of NEs originating Type 2 
requests are added to the TDC before the node propagates the requests to other NEs. 

Note The L2 TARP Data Cache parameter is designed for Intermediate System Level 1/Level 2 
nodes that are connected to other Intermediate System Level 1/Level 2 nodes. Enabling the 
parameter for Intermediate System Level 1 nodes is not recommended.

• LDB—If checked (default), enables the TARP loop detection buffer. The LDB prevents TARP PDUs 
from being sent more than once on the same subnet.

Note The LDB parameter is not used if the Node Routing Mode is provisioned to End System or 
if the TARP PDUs L1 Propagation parameter is not enabled. 

• LAN TARP Storm Suppression—If checked (default), enables TARP storm suppression. This 
function prevents redundant TARP PDUs from being unnecessarily propagated across the LAN 
network.

• Send Type 4 PDU on Startup—If checked, a TARP Type 4 PDU is originated during the initial 
ONS 15454 startup. Type 4 PDUs indicate that a TID or NSAP change has occurred at the NE. (The 
default setting is not enabled.)

• Type 4 PDU Delay—Sets the amount of time that will pass before the Type 4 PDU is generated when 
Send Type 4 PDU on Startup is enabled. 60 seconds is the default. The range is 0 to 255 seconds.

Note The Send Type 4 PDU on Startup and Type 4 PDU Delay parameters are not used if TARP 
PDUs Origination is not enabled.
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• LDB Entry—Sets the TARP loop detection buffer timer. The loop detection buffer time is assigned 
to each LDB entry for which the TARP sequence number (tar-seq) is zero. The default is 5 minutes. 
The range is 1 to 10 minutes.

• LDB Flush—Sets the frequency period for flushing the LDB. The default is 5 minutes. The range is 
0 to 1440 minutes. 

• T1—Sets the amount of time to wait for a response to a Type 1 PDU. Type 1 PDUs seek a specific 
NE TID within an OSI Level 1 area. The default is 15 seconds. The range is 0 to 3600 seconds.

• T2—Sets the amount of time to wait for a response to a Type 2 PDU. TARP Type 2 PDUs seek a 
specific NE TID value within OSI Level 1 and Level 2 areas. The default is 25 seconds. The range 
is 0 to 3600 seconds.

• T3—Sets the amount of time to wait for an address resolution request. The default is 40 seconds. 
The range is 0 to 3600 seconds.

• T4—Sets the amount of time to wait for an error recovery. This timer begins after the T2 timer 
expires without finding the requested NE TID. The default is 20 seconds. The range is 
0 to 3600 seconds.

Note The T1, T2, and T4 timers are not used if the TARP PDUs Origination check box is not 
checked. 

Step 3 Click Apply.

Step 4 Return to your originating procedure (NTP).

DLP-G285 Add a Static TID-to-NSAP Entry to the TARP Data Cache

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI > 
TARP > Static TDC tabs.

Step 2 Click Add Static Entry.

Step 3 In the Add Static Entry dialog box, enter the following:

• TID—Enter the TID of the NE. (For ONS nodes, the TID is the Node Name parameter on the node 
or multishelf view Provisioning > General tab.)

• NSAP—Enter the OSI NSAP address in the NSAP field or, if preferred, click Use Mask and enter 
the address in the Masked NSAP Entry dialog box.

Purpose This task adds a static TID-to-NSAP entry to the TDC. The static entries 
are required for NEs that do not support TARP and are similar to static 
routes. For a specific TID, you must force a specific NSAP. 

Tools/Equipment None

Prerequisite procedures  DLP-G46 Log into CTC

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioner or higher
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Step 4 Click OK to close the Masked NSAP Entry dialog box, if used, and then click OK to close the 
Add Static Entry dialog box.

Step 5 Return to your originating procedure (NTP).

DLP-G287 Add a TARP Manual Adjacency Table Entry

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI > 
TARP > MAT tabs.

Step 2 Click Add.

Step 3 In the Add TARP Manual Adjacency Table Entry dialog box, enter the following:

• Level—Sets the TARP Type Code that will be sent:

– Level 1—Indicates that the adjacency is within the same area as the current node. The entry 
generates Type 1 PDUs.

– Level 2—Indicates that the adjacency is in a different area than the current node. The entry 
generates Type 2 PDUs.

• NSAP—Enter the OSI NSAP address in the NSAP field or, if preferred, click Use Mask and enter 
the address in the Masked NSAP Entry dialog box.

Step 4 Click OK to close the Masked NSAP Entry dialog box, if used, and then click OK to close the Add Static 
Entry dialog box.

Step 5 Return to your originating procedure (NTP).

Purpose This task adds an entry to the TARP manual adjacency table (MAT). Entries 
are added to the MAT when the ONS 15454 must communicate across 
routers or NEs that lack TARP capability. 

Tools/Equipment None

Prerequisite procedures  DLP-G46 Log into CTC

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G288 Provision OSI Routers

Note Router 1 must be enabled before you can enable and edit the primary manual area addresses for 
Routers 2 and 3.

Note The Router 1 manual area address, System ID, and Selector “00” create the node NSAP address. 
Changing the Router 1 manual area address changes the node NSAP address.

Note The System ID for Router 1 is the node MAC address. The System IDs for Routers 2 and 3 are created 
by adding 1 and 2 respectively to the Router 1 System ID. You cannot edit the System IDs.

Step 1 Click the Provisioning > OSI > Routers > Setup tabs. 

Step 2 Chose the router you want provision and click Edit. The OSI Router Editor dialog box appears.

Step 3 In the OSI Router Editor dialog box:

a. Check Enable Router to enable the router and make its primary area address available for editing.

b. Click the manual area address, then click Edit.

c. In the Edit Manual Area Address dialog box, edit the primary area address in the Area Address field. 
If you prefer, click Use Mask and enter the edits in the Masked NSAP Entry dialog box. The address 
(hexadecimal format) can be 8 to 24 alphanumeric characters (0–9, a–f) in length.

d. Click OK successively to close the following dialog boxes: Masked NSAP Entry (if used), Edit 
Manual Area Address, and OSI Router Editor.

Step 4 Return to your originating procedure (NTP).

Purpose This task enables an OSI router and edits its primary manual area address.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G289 Provision Additional Manual Area Addresses

Step 1 Click the Provisioning > OSI > Routers > Setup tabs. 

Step 2 Chose the router where you want provision an additional manual area address and click Edit. The OSI 
Router Editor dialog box appears.

Step 3 In the OSI Router Editor dialog box:

a. Check Enable Router to enable the router and make its primary area address available for editing.

b. Click the manual area address, then click Add.

c. In the Add Manual Area Address dialog box, enter the primary area address in the Area Address 
field. If you prefer, click Use Mask and enter the address in the Masked NSAP Entry dialog box. 
The address (hexadecimal format) can be 2 to 24 alphanumeric characters (0–9, a–f) in length.

d. Click OK successively to close the following dialog boxes: Masked NSAP Entry (if used), Add 
Manual Area Address, and OSI Router Editor.

Step 4 Return to your originating procedure (NTP).

DLP-G290 Enable the OSI Subnet on the LAN Interface

Note When you create communication channels (optical service channel [OSC] or generic communications 
channel [GCC]), OSI subnetwork points of attachment are enabled on the communication channels. See 
the “NTP-G38 Provision OSC Terminations” procedure on page 14-124 and the “DLP-G76 Provision 
DCC/GCC Terminations” task on page 17-87.

Purpose This task provisions the OSI manual area addresses. One primary area and 
two additional manual areas can be created for each virtual router.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

DLP-G288 Provision OSI Routers, page 14-42

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables the OSI subnetwork point of attachment on the LAN 
interface.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The OSI subnetwork point of attachment cannot be enabled for the LAN interface if the OSI routing 
mode is set to ES.

Note If secure mode is on, the OSI subnet is enabled on the backplane LAN port, not the front 
TCC2P/TCC3/TNC/TNCE/TSC/TSCE TCP/IP (LAN) port.

Step 1 Click the Provisioning > OSI > Routers > Subnet tabs. 

Step 2 Click Enable LAN Subnet.

Step 3 In the Enable LAN Subnet dialog box, complete the following fields:

• ESH—Sets the End System Hello (ESH) propagation frequency. An ES NE transmits ESHs to 
inform other ESs and ISs about the NSAPs it serves. The default is 10 seconds. The range is 10 to 
1000 seconds.

• ISH—Sets the Intermediate System Hello (ISH) PDU propagation frequency. An intermediate 
system NE sends ISHs to other ESs and ISs to inform them about the IS NEs it serves. The default 
is 10 seconds. The range is 10 to 1000 seconds.

• IIH—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation frequency. 
The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default is 3 seconds. The 
range is 1 to 600 seconds.

• IS-IS Cost—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the cost 
to calculate the shortest routing path. The default IS-IS cost for LAN subnets is 20. It normally 
should not be changed.

• DIS Priority—Sets the designated intermediate system (DIS) priority. In IS-IS networks, one router 
is elected to serve as the DIS (LAN subnets only). Cisco router DIS priority is 64. For the 
ONS 15454 LAN subnet, the default DIS priority is 63. It normally should not be changed.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-G291 Create an IP-Over-CLNS Tunnel

Purpose This task creates an IP-over-CLNS tunnel to allow ONS 15454 nodes to 
communicate across equipment and networks that use the OSI protocol 
stack. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution IP-over-CLNS tunnels require two endpoints. You will create one point on an ONS 15454. The other 
endpoint is generally provisioned on non-ONS equipment including routers and other vendor NEs. 
Before you begin, verify that you have the capability to create an OSI-over-CLNS tunnel on the other 
equipment location.

Step 1 Click the Provisioning > OSI > Tunnels tabs. 

Step 2 Click Create.

Step 3 In the Create IP Over CLNS Tunnel dialog box, complete the following fields:

• Tunnel Type—Choose a tunnel type:

– Cisco—Creates the proprietary Cisco IP tunnel. Cisco IP tunnels add the CLNS header to the 
IP packets.

– GRE—Creates a generic routing encapsulation (GRE) tunnel. GRE tunnels add the CLNS 
header and a GRE header to the IP packets.

The Cisco proprietary tunnel is slightly more efficient than the GRE tunnel because it does not add 
the GRE header to each IP packet. The two tunnel types are not compatible. Most Cisco routers 
support the Cisco IP tunnel, while only a few support both GRE and Cisco IP tunnels. You generally 
should create Cisco IP tunnels if you are tunneling between two Cisco routers or between a Cisco 
router and an ONS node.

Caution Always verify that the IP-over-CLNS tunnel type that you choose is supported by the equipment at the 
other end of the tunnel.

• IP Address—Enter the IP address of the IP-over-CLNS tunnel destination.

• IP Mask—Enter the IP address subnet mask of the IP-over-CLNS destination.

• OSPF Metric—Enter the OSPF metric for sending packets across the IP-over-CLNS tunnel. The 
OSPF metric, or cost, is used by OSPF routers to calculate the shortest path. The default is 110. 
Normally, it is not be changed unless you are creating multiple tunnel routes and want to prioritize 
routing by assigning different metrics.

• NSAP Address—Enter the destination NE or OSI router NSAP address. 

Step 4 Click OK.

Step 5 Provision the other tunnel endpoint using the documentation provided by the manufacturer of the third 
party vendor NE.

Step 6 Return to your originating procedure (NTP).
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NTP-G29 Set Up SNMP

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to set up SNMP. If you are 
already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > SNMP 
tabs.

Step 3 In the Trap Destinations area, click Create.

Step 4 Complete the following in the Create SNMP Trap Destination dialog box (Figure 14-7):

• Destination IP Address—Type the IP address of your network management system (NMS). If the 
node you are logged into is an ENE, set the destination address to the GNE. 

Note In ONS 15454 Software Release 9.1 and later, you can configure IPv6 addresses for SNMPv2/v3 trap 
destinations and SNMPv3 proxy targets, in addition to IPv4 addresses.

• Community—Type the SNMP community name. For a description of SNMP community names, 
refer to the SNMP document. 

Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the 
NMS.

• UDP Port—The default User Datagram Protocol (UDP) port for SNMP is 162.

• Trap version—Choose either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine 
which version to use.

Figure 14-7 Creating an SNMP Trap

Purpose This procedure provisions the SNMP parameters so that you can use 
SNMP management software with the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if SNMP is used at your site.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click OK. The node IP address of the node where you provisioned the new trap destination appears in 
the Trap Destinations area.

Step 6 Click the node IP address in the Trap Destinations area. Verify the SNMP information that appears in 
the Selected Destination list.

Step 7 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 8 If you want to set up the SNMP proxy feature to allow network management, message reporting, and 
performance statistic retrieval across ONS firewalls, click the Allow SNMP Proxy check box located on 
the SNMP tab.

Note The Use Generic MIB check box is normally not checked for MSTP. It is checked only when the 
ONS 15454 resides in networks with multiple ONS products, and the network management 
system requires MIBs with the same name to have the same object IDs. By default, the 
ONS 15454 uses the CERENT-454-MIBs. Other ONS products, such as the ONS 15600, the 
ONS 15327, and ONS 15310-CL, use the CERENT-GENERIC-MIBs. If Use Generic MIB is 
checked, the ONS 15454 will use the CERENT-GENERIC-MIBs so the object IDs will be the 
same for all products. 

Note Using the ONS firewall proxy feature effectively breaches the ONS firewall to exchange 
management information.

For more information about the SNMP proxy feature, refer to SNMP.

Step 9 Click Apply.

Step 10 If you are setting up SNMP proxies, you can set up to three relays that send SNMP trap error counts back 
to the NE for each trap destination address:

a. Click the first trap destination IP address. The address and its community name appear in the 
Destination fields.

b. Enter up to three SNMP Proxy relay addresses and community names in the fields for Relay A, 
Relay B, and Relay C.

Note The community names specified for each relay node must match one of the provisioned 
SNMP community names in the NE. 

Note The SNMP proxy directs SNMP traps from this node through Relay A to Relay B to Relay C 
to the trap destination. Ensure that you enter the IP addresses in the correct order so that this 
sequence runs correctly.

Step 11 Click Apply.

Stop. You have completed this procedure.
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NTP-G143 Import the Cisco Transport Planner NE Update 
Configuration File

Caution Verify that you have the correct Cisco Transport Planner network file before you begin this procedure. 
The file will have an XML extension and a name assigned by your network planner. Check with your 
network planner or administrator if you have any questions.

Note The Cisco Transport Planner configuration file contains parameters for the node, shelf, card type, port 
(including the card’s wavelength), pluggable port module (PPM), as well as OTN and FEC parameters. 
Only the values present in XML format appear in the configuration file parameters; if the values are not 
in XML format, a column appears blank. The XML file values are independently reported and do not 
affect any configuration changes that you apply.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to import the Cisco Transport 
Planner configuration file. If you are already logged in, continue with Step 2.

Step 2 If you choose the Provision Node Layout option to preprovision the cards in the shelf, complete the 
following steps. If not, continue with Step 3.

a. Display the node in node view (single-shelf mode) or multishelf view (multishelf mode). 

b. Verify that the common control cards (TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE, AIC-I and 
MSC-ISC) cards are the only cards installed. If in single or multishelf mode, verify that each shelf 
in the multishelf has two TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards. 

• If common control cards are the only cards installed, continue with Step 3. 

• If other cards appear, continue with Step c.

c. If a physical card other than the common control cards is installed, remove it from the shelf.

d. If preprovisioned DWDM cards are present, delete them using the “DLP-G351 Delete a Card in 
CTC” task on page 14-52, then repeat Steps a and b.

Purpose This procedure imports the Cisco Transport Planner NE Update 
configuration file and creates a log file. The configuration file, which is 
provided in XML format, provisions internal patchcords, optical sides and 
card parameters for optical units, transponders, and passive units (DCUs 
and patch panels). Finally, the NE Update file installs the ANS parameters 
calculated by Cisco Transport Planner. The log file, which is a text 
document records the results of the NE update.

Tools/Equipment A Cisco Transport Planner NE Update file for the network where the node 
is installed must be accessible to the CTC computer.

Prerequisite Procedures NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 3 If you have not created a log file to record the results of the NE update, complete the following steps. If 
a log file has been created, continue with Step 4.

a. Open a text editor or word processing application.

b. Create a new text (TXT) document with a file name of your choosing. 

c. Save the text document in a directory that is easy to navigate to from CTC.

Step 4 In CTC node view (single-shelf mode) or multishelf view, click the Provisioning > WDM-ANS > 
Node Setup tabs.

Step 5 Choose Load latest installation file from node to reload the latest XML file that was applied and stored 
in the node. Continue with Step 8.

Step 6 Choose Load installation file from network repository and navigate to the Cisco Transport Planner 
node setup file containing the parameters for the network where the node resides. This option downloads 
the XML file from the remote server. Continue with Step 8.

Step 7 In the field under Select XML file, type the path to the Cisco Transport Planner node setup file 
containing the parameters for the network where your node resides, or click Browse and navigate to the 
file on your computer. Click the file, then click Open. The file will have an XML extension. Continue 
with Step 8.

Step 8 In the field under Select Log file, type the path to the text file that you created in Step 3, or click Browse 
and navigate to the file on your computer or a network server where you want the node setup results 
recorded. 

Note The log file records the parameters that were updated successfully and provides an explanation 
of why an update could not be completed. Each node setup session overwrites the log file 
contents. If you want to save the results from a previous NE update, save the log file with new 
name.

Step 9 Click Apply.

Step 10 When Load installation file from network repository option is chosen, the FTP Remote Installation 
File Node-Name page appears. 

a. When the node is configured as a Gateway Network Element (GNE) node, enter the parameters (host 
name, port, user name, password, remote directory, and XML file name of the remote server) and 
click Next.

b. When the node is configured as a Elementary Network Element (ENE) node, an additional 
parameter called GNE Selector appear. From the GNE Selector drop-down list, select the 
appropriate GNE in the network. The FTP relay must be configured on the selected GNE to the 
remote server where the XML file is stored. See “NTP-G28 Create FTP Host” procedure on 
page 14-33 to configure the FTP relay on the selected GNE.

Step 11 When the Node Setup Selection for Node-Name page appears, complete the following steps. If not, 
continue with Step 12. 

a. Choose the node profile that you want to apply to the node. The Cisco Transport Planner XML file 
contains profiles for all nodes in the network. Choose the profile that applies to the node you are 
provisioning.

b. Click Next.

Step 12 On the Node Setup for node name page, choose one or more of the following:
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• Node Layout—Preprovisions the slots in each shelf in CTC for the cards defined in the network 
plan. Choose this option when no DWDM cards are installed. (Errors will occur if cards are installed 
or the slots are preprovisioned.) Preprovisioning the slots before the physical cards are installed 
ensures that card installers place the cards in the correct slots. Preprovisioning the slots is also useful 
if you want to set up the network prior to card installation. The node layout also preprovisions the 
chassis and passive units.

• Card Parameters—If checked, provisions the following parameters, if the cards are installed.

– TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP 
cards—Provisions the OTN and FEC parameters.

– OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, OPT-EDFA-24, GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE cards—Provisions the card mode.

• Pluggable Port Modules— If checked, allows the provisioning of PPMs on TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP cards, including PPM payloads.

• Internal Patchcords—If checked, allows creation of internal patchcords among cards provisioned in 
the node.

• Optical Sides—If checked, allows the provisioning of optical sides.

• ANS Parameters—If checked, installs the ANS parameters. ANS parameters provision the values 
required for the node to function within the specified network design. ANS parameters include span 
losses, optical power, optics thresholds, amplifier working mode, gain, tilt, and many others. Refer 
to Chapter 12, “Node Reference” for a list of ONS 15454 ANS parameters.

Note If you are importing the Cisco Transport Planner configuration file for the first time, you 
normally choose all available options.

• Skip Interactive Mode—If checked, CTC provisions all the chosen setup components automatically 
without allowing you to view the results after each one.

• Save Installation Files (XML and log) On Node—If checked, CTC saves the XML and log files on 
the node.

Step 13 Click Next. If you chose Skip Interactive Mode, continue with Step 14. If not, the wizard page that 
appears depends on the options chosen in Step 12: Complete the steps shown in Table 14-2 for each 
option.
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Table 14-2 NE Update Wizard Options

NE Update Function

Node/Shelves Layout View the cards and slots on the left side of the page and verify that they are the same as the layout in 
the Cisco Transport Planner Shelf Layout (see Table 14-1 on page 14-4). If the cards and slots match, 
click Apply. If not, click Cancel. and contact your next level of support to verify that you have the 
correct node setup file. If the site has a multishelf configuration, click Next and repeat this step for 
each shelf at the site.

CTC preprovisions the slots. (This might take a few seconds.) The results appear in the Log window. 
Slots that are successfully provisioned display an “Applied” status. A “Slot not empty” status appears 
if slots cannot be provisioned because a card is physically installed or the slot is already provisioned. 
If this occurs, complete the following steps. Otherwise, continue with the next NE Update function.

1. Click Cancel, then click Yes in the confirmation dialog box. The slot preprovisioning does not 
revert when you click Cancel.

2. If a physical card is installed, remove it from the shelf. 

3. Perform one of the following steps: 

– Delete all the preprovisioned slots using the “DLP-G351 Delete a Card in CTC” task on 
page 14-52, then repeat Steps 2 through Step 13.

– Delete the slot where the Slot Not Empty error occurred using the “DLP-G351 Delete a Card 
in CTC” task on page 14-52. Complete the “DLP-G353 Preprovision a Slot” task on 
page 14-54 to provision the slot manually, then repeat Steps 2 through 13 making sure to 
uncheck the Provision Node Layout option in Step 12.

Note When you preprovision a slot, the card is purple in the CTC shelf graphic and “NP” (not 
present) appears on the card. After the physical card is installed, the card changes to white and 
“NP” is removed from the CTC shelf graphic.

Passive Units Layout 1. Review the passive unit settings.

2. Click Apply.

3. Click Next.

Pluggable Port Modules 1. Review the PPM settings for each TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and 
OTU2_XP card.

2. Click Apply.

3. Click Next.

Card Parameters 1. Review the OTN, FEC, and card mode settings for each TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, and OTU2_XP card.

2. Click Apply.

3. Click Next.

Internal Patchcords 1. Review the internal patchcords. 

2. Click Apply.

3. Click Next.
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Step 14 Click Finish, then click OK in the Wizard Complete confirmation dialog box. The confirmation box 
indicates whether the xml import process was completed successfully.

Note Common control cards are not provisioned by Cisco Transport Planner.

Stop. You have completed this procedure.

DLP-G351 Delete a Card in CTC

Note It is recommended that the card be physically removed from its slot before deleting it from CTC.

Step 1 Verify that the following conditions are not present. (During node turn-up, these conditions are normally 
not present):

• The card is a TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card. 

• The card is part of a protection group.

• The card has optical channels or overhead circuits provisioned.

Optical Sides 1. Review the optical side assignments. 

2. Click Apply.

3. Click Next.

ANS Parameters 1. Review the ANS parameters on the left half of the page.

c. Click Apply. The log file displays the results. At the end, a Done status will appear. If a parameter 
could not be applied, a Setting Refused status appears. If this occurs, contact your next level of 
support.

Select All 1. If checked, selects all the options.

Skip Interactive Mode If checked, CTC provisions all the chosen setup components automatically without allowing you to 
view the results after each one.

Save Installation Files 
(XML and log) On 
Node

If checked, CTC saves the XML and log files on the node.

Table 14-2 NE Update Wizard Options

NE Update Function

Purpose This task deletes a card from an ONS 15454 slot that is provisioned in 
CTC.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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• The card is being used for timing.

• The card has an OSC/GCC termination.

• A port on the card is being used for a Link Management Protocol (LMP) channel or link.

• The card is part of an optical side.

• The card is assigned to DWDM patchcords.

• If a port on the card is in service.

• If a port on the card is part of a circuit. 

If any of these conditions exist, do not continue. You will not be able to delete the card until the card is 
removed from protection groups; circuits, DCC, and GCCs are deleted; a different timing source is 
provisioned, and the LMP link or channel is deleted.

• To replace a TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card, refer to the Cisco 
ONS 15454 DWDM Troubleshooting Guide. 

• To delete a protection group, see the NTP-G83 Modify or Delete Card Protection Settings 
procedure.

• To delete optical channels see the “DLP-G347 Delete Optical Channel Client Connections” task on 
page 17-26 and the “DLP-G106 Delete Optical Channel Network Connections” task on page 17-49; 
to delete overhead circuits, see the “DLP-G112 Delete Overhead Circuits” task on page 17-94. 

• To remove the card as a timing source, see the NTP-G87 Change Node Timing Parameters 
procedure.

• To remove OSC or GCC terminations, see the NTP-G85 Modify or Delete OSC Terminations, GCC 
Terminations, and Provisionable Patchcords procedure.

• To delete LMP channels or links, see “NTP-G164 Configure Link Management Protocol” procedure 
on page 16-36.

• To remove a DWDM patchcord, see the “DLP-G355 Delete an Internal Patchcord” procedure on 
page 14-121.

• To remove an optical side, see the “DLP-G480 Delete an Optical Side” procedure on page 14-123.

Step 2 On the shelf graphic in CTC, right-click the card that you want to remove and choose Delete Card. 

Note A deleted card no longer reboots and reappears in CTC after R5.0. 

Step 3 Return to your originating procedure (NTP). 
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DLP-G353 Preprovision a Slot

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), right-click an empty slot where 
you want to install a card.

Step 2 From the Add Card shortcut menu, choose the card type that will be installed based on the 
Cisco Transport Planner shelf layout (see Table 14-1 on page 14-4). Only cards that can be installed in 
the slot appear in the Add Card shortcut menu. Table 14-3 shows the Add Card shortcut menu, submenu, 
card groups, and menu options or cards that they reference. 

Purpose This task preprovisions a ONS 15454 slot in CTC. Preprovisioning of all 
the slots in the shelf is normally performed when you complete the 
“NTP-G143 Import the Cisco Transport Planner NE Update Configuration 
File” procedure on page 14-48. Use this task if you need to manually 
preprovision a slot. All slot preprovisioning must be based on the 
Cisco Transport Planner shelf layout prepared for your site. 

Tools/Equipment Cisco Transport Planner shelf layout table or JPG file.

Prerequisite Procedures NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 14-3 CTC Add Card Shortcut Menu for DWDM Cards

Menu Item
Submenu 
Category Card Group Submenu Item 1 Submenu Item 2 Cards

DWDM

nXP

Transponder and Muxponder

— 10GE_XP 10GE_XP

— 10GE_XPE 10GE_XPE

— OTU2_XP OTU2_XP

— ADM-10G ADM-10G

— GE_XP GE_XP

— GE_XPE GE_XPE

— MXPP_MR_2.5G MXPP_MR_2.5G

— MXP_2.5G_10E MXP_2.5G_10E

MXP_2.5G_10E_C

MXP_2.5G_10E_L

MXP_2.5G_10EX_C

— MXP_2.5G_10G MXP_2.5G_10G

— MXP_MR_10DME MXP_MR_10DME_C

MXP_MR_10DME_L

MXP_MR_10DMEX_C

— MXP_MR_2.5G MXP_MR_2.5G

— TXPP_MR_2.5G TXPP_MR_2.5G

— TXP_MR_10E TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

TXP_MR_10EX_C

— TXP_MR_10G TXP_MR_10G

— TXP_MR_2.5G TXP_MR_2.5G

— 40G-MXP-C 40G-MXP-C

— 40E-MXP-C 40E-MXP-C
40ME-MXP-C

— 40E-TXP-C 40E-TXP-C
40ME-TXP-C

— AR_MXP AR_MXP

— AR_XP AR_XP

— AR_XPE AR_XPE

— 100G-LC-C 100G-LC-C

— 10x10G-LC 10x10G-LC

— CFP-LC CFP-LC
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DWDM MD Multiplexer and 
Demultiplexer

C Band 32 DMXO 32DMX-O

40 WSS 40-WSS-C or 40-WSS-CE

32 MUXO 32MUX-O

32 WSS 32WSS

4MD 4MD-xx.x

32 DMX 32DMX

40-MUX-C 40-MUX-C

32 MUXO 32MUX-O

40-DMX-C, or
40-DMX-CE

40-DMX-C, or
40-DMX-CE

L Band 32 WSS L 32WSS-L

32 DMXL 32DMX-L

MESH — C Band 40 WXC 40-WXC-C

80 WXC 80-WXC-C

40 SMR1 C 40-SMR1-C

40 SMR2 C 40-SMR2-C

OSC Optical Service 
Channel

— MMU MMU

— OSC-CSM OSC-CSM

OADM Optical Add/Drop 
Multiplexer

— AD-1B AD-1B-xx.x

— AD-1C AD-1C-xx.x

— AD-2C AD-2C-xx.x

— AD-4B AD-4B-xx.x

— AD-4C AD-4C-xx.x

Ampli Optical Amplifier C Band OPT-BST E OPT-BST-E

OPT-AMP-17 OPT-AMP-17-C

OPT-RAMP-C OPT-RAMP-C

OPT-RAMP-CE OPT-RAMP-CE

OPT-AMP C OPT-AMP-C

OPT-BST OPT-BST

OPT-PRE OPT-PRE

OPT-EDFA-17 OPT-EDFA-17

OPT-EDFA-24 OPT-EDFA-24

L Band OPT-BST L OPT-BST-L

OPT-AMP L OPT-AMP-L

OTHER — — PSM PSM

Table 14-3 CTC Add Card Shortcut Menu for DWDM Cards (continued)

Menu Item
Submenu 
Category Card Group Submenu Item 1 Submenu Item 2 Cards
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Note When you preprovision a slot, the card appears purple in the CTC shelf graphic (the card appears 
as white when a card is installed in the slot). NP on the card graphic indicates that the card is not 
physically installed.

Step 3 Repeat Step 2 until all the cards shown in the Cisco Transport Planner shelf layout are provisioned in 
CTC.

Stop. You have completed this procedure.

NTP-G320 Configure the Node as a Non-DWDM Network

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 From the Selector area, select Network Type.

Step 3 Choose Not-DWDM, from the Value drop-down list. Click Apply.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs.

Step 5 Click the Launch ANS button. The relevant ports in the node will be in IS state.

Step 6 Click OK.

Ethernet — — — MS-ISC-100T MS-ISC-100T

G1000 G1000

OSCM — — — — OSCM (Slots 8 and 10 only)

TNC
TSC1

— Control Cards — — TNC, TNCE, TSC, and TSCE

1. Choose the menu option TNC for both TNC and TNCE preprovision. The CTC displays the TNC or TNCE card name according to the inserted card. Same 
applies for TSCE card also.

Table 14-3 CTC Add Card Shortcut Menu for DWDM Cards (continued)

Menu Item
Submenu 
Category Card Group Submenu Item 1 Submenu Item 2 Cards

Purpose This tasks configures a node as a Non-DWDM network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Return to your originating procedure (NTP).

DLP-G693 Configure the Amplifier

Step 1 Display the amplifier card in card view.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Select the working mode from the Card Working Mode drop-down list.

Step 4 Change to node view (single-shelf mode) or multishelf view (multishelf mode), then click the 
Provisioning > WDM-ANS > Provisioning tabs. 

Step 5 From the Selector area, select the amplifier slot. If the default parameters are present, continue with 
Step 6. If not, click Add to add the Channel LOS Threshold, Amplifier Tilt, Power, and Amplifier 
Working Mode parameters. To add the ANS parameters, see the “DLP-G541 Add an ANS Parameter” 
task on page 14-61 for instructions.

Step 6 Click the value of the ANS parameter that you want to modify and enter the new value specified in 
Table 14-4. To modify the ANS parameters, see the “DLP-G681 Modify an ANS Parameter” task on 
page 14-61 for instructions.

Step 7 Click Apply.

Step 8 Click the Provisioning > WDM-ANS > Port Status tabs.

Step 9 Click Launch ANS.

Step 10 In the Apply Launch ANS dialog box, click Yes.

Step 11 In the Launch ANS confirmation dialog box, click OK.

Step 12 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Purpose This task configures the optical parameters and threshold values of the 
amplifier card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 14-4 Values for the ANS Parameters (amplifier)

Port ANS Parameter Value

Slot 16 (OPT-AMP C).Port COM-RX Channel LOS Threshold 35.0 dBm

Slot 16 (OPT-AMP C).Port LINE-TX Amplifier Working Mode Control Gain

Slot 16 (OPT-AMP C).Port LINE-TX Amplifier Tilt 0.0 dB

Slot 16 (OPT-AMP C).Port LINE-TX Power 1.0 dBm
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Step 13 Verify the following in the Results column:

• Success - Changed —The parameter has been successfully changed with the ports in IS.

Step 14 Verify that the Set By column displays t he value “ANS” or “APC” as the application that sets the 
ANS parameter.

Step 15 Return to your originating procedure (NTP).

DLP-G694 Configure the PSM

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 From the Selector area, select the PSM slot. If the default parameters are present, continue with Step 3. 
If not, click Add to add the Channel LOS Threshold and VOA Attenuation parameters. To add the ANS 
parameters, see the “DLP-G541 Add an ANS Parameter” task on page 14-61 for instructions.

Step 3 Click the value of the ANS parameter that you want to modify and enter the new value specified in 
Table 14-4. To modify the ANS parameters, see the “DLP-G681 Modify an ANS Parameter” task on 
page 14-61 for instructions.

Step 4 Click Apply.

Step 5 Click the Provisioning > WDM-ANS > Port Status tabs.

Step 6 Click Launch ANS.

Step 7 In the Apply Launch ANS dialog box, click Yes.

Step 8 In the Launch ANS confirmation dialog box, click OK.

Step 9 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Purpose This tasks configures the PSM behavior.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 14-5 Values for the ANS Parameters (PSM)

Port ANS Parameter Value

Slot 14(PSM).Port W-RX VOA Attenuation 3.0 dB

Slot 14(PSM).Port W-RX Channel LOS Threshold 15.0 dB

Slot 14(PSM).Port P-RX VOA Attenuation 10.0 dB

Slot 14(PSM).Port P-RX Channel LOS Threshold 20.0 dB
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Step 10 Verify the following in the Results column:

• Success - Changed —The parameter has been successfully changed with the ports in IS.

Step 11 Verify that the Set By column displays t he value “ANS” or “APC” as the application that sets the 
ANS parameter.

Step 12 Return to your originating procedure (NTP).

NTP-G328 Add, Modify, or Delete ANS Parameters

Note It is recommended that you use the Cisco Transport Planner XML configuration file to provision the 
ANS parameters instead of manually adding all the parameters in CTC. ANS provisioning parameters 
must be manually changed only by Cisco qualified personnel. Provisioning the ANS parameters 
incorrectly (either as preamplifier or booster input power thresholds) may impact traffic.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to add, modify, or delete the ANS 
parameters. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the following tasks:

• Complete the “DLP-G541 Add an ANS Parameter” task on page 14-61.

• Complete the “DLP-G681 Modify an ANS Parameter” task on page 14-61.

• Complete the “DLP-G542 Delete an ANS Parameter” task on page 14-63.

Stop. You have completed this procedure.

Purpose This procedure allows you to add, modify, or delete ANS parameters for a 
DWDM node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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DLP-G541 Add an ANS Parameter

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 Click Add. The Add ANS Parameter dialog box appears.

Step 3 Select the ANS parameter from the Parameter drop-down list.

Step 4 In the Port Selection area, complete the following fields:

• Type—Displays the card type.

• Shelf—Choose the shelf from the drop-down list.

• Slot—Choose the card from the Slot drop-down list. The drop-down list lists all the cards that 
support the ANS parameter selected in Step 3.

• Port—Choose the port from the Port drop-down list. The drop-down list lists all the ports for the 
card selected in Step 4 that support the ANS parameter selected in Step 3. 

Step 5 Choose the granularity as OTS or OCH from the Granularity drop-down list.

Note Granularity can be set only for the ANS parameters applied to the LINE-RX, LINE-TX, 
COM-RX, or COM-TX ports.

Step 6 Type or choose the value for the ANS parameter in the Value field.

Step 7 Click OK.

Step 8 Return to your originating procedure (NTP).

DLP-G681 Modify an ANS Parameter

Purpose This tasks adds an ANS parameter.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task modifies ANS parameters.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Do not begin this procedure until the Cisco Transport Planner NE Update file is created for the node. 
You must import the new NE Update file and run ANS to recalculate the ANS parameters for the node.

Caution Modifying ANS parameters on one node requires ANS upgrades on all the other nodes within the 
network. Do not begin this procedure until you are prepared to complete the upgrade on all the network 
nodes.

Caution This procedure will affect the service of unprotected circuits that pass through the node.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 Click the value of the ANS parameter that you want to modify and enter the new value.

Note If the new or updated value is not within the default range specified in Table 14-6, an error 
message is displayed.

Note When you modify the parameter value in the Value field, the active value is updated with the 
modified value after you run ANS.

Table 14-6 Ranges, Values, and Edit Options for the ANS Parameters

ANS Parameter Range/Value Editable with Port in IS

OSC LOS Threshold -50.0 to +30.0 dBm Yes

Channel LOS Threshold -50.0 to +30.0 dBm Yes

Amplifier Working Mode Control Power, Control Gain, 
Fixed Gain

Yes1

Amplifier Gain 0.0 to 40.0 dB No

Amplifier Tilt -15.0 to +15.0 dB No

OSC Power -24.0 to 0.0 dBm No

Raman Ratio 0.0 to 100.0% Yes

Raman Total Power 100 to 450 mW Yes

Raman Expected Gain2 0.0 to 12.0 dB Yes

Power -30.0 to +50 dBm Yes3

WXC Dithering 0 to 33 No

Min Expected Span Loss 0.0 to 60.0 dB No

Max Expected Span Loss 0.0 to 60.0 dB No

VOA Attenuation 0 to 30 dB Yes4
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Step 3 Click Apply.

Step 4 Click the Provisioning > WDM-ANS > Port Status tabs.

Step 5 Click Launch ANS.

Step 6 In the Apply Launch ANS dialog box, click Yes.

Step 7 In the Launch ANS confirmation dialog box, click OK.

Step 8 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 9 Verify the following in the Results column:

• Success - Changed —The parameter has been successfully changed with the ports in IS.

Step 10 Verify that the Set By column displays t he value “ANS” or “APC” as the application that sets the 
ANS parameter.

Step 11 Return to your originating procedure (NTP).

DLP-G542 Delete an ANS Parameter

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 Click the ANS parameter you want to remove.

Note Only threshold related ANS parameters can be removed if the port is in service state.

Step 3 Click Remove, and then Yes.

Step 4 Return to your originating procedure (NTP).

1. Per-channel power and tilt can be edited when the Amplifier Working Mode is Control Gain or Control Power and 
Fixed Gain when Amplifier Working Mode is Fixed Gain

2. Editable only on OPT-RAMP-C and OPT-RAMP-CE cards.

3. The APC increases or decreases power by 0.5dB till the new power setpoint is reached. The APC-OUT-OF-RANGE 
alarm is raised if the updated power setpoint is outside the expected range.

4. VOA Attenuation associated with a single channel path can be edited when the working mode is 
Constant Power Value; VOA Attenuation associated with aggregated paths can be edited when the working mode 
is Constant Attenuation Value.

Purpose This tasks removes an ANS parameter.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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NTP-G30 Install the DWDM Cards

Warning This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. To see translations of the warnings that appear in 
this publication, refer to the Regulatory Compliance and Safety Information document for the 
appropriate Cisco chassis. Statement 274

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Purpose This procedure describes how to install the DWDM multiplexer, 
demultiplexer, wavelength selective switch, wavelength cross-connect, 
OADM, OSC, PSM, and optical amplifier cards. 

Tools/Equipment • Cisco Transport Planner shelf layout 

• The following C-band or L-band cards, as required by your site plan:

– C-band: OPT-PRE, OPT-BST, OPT-BST-E, 32MUX-O, 
40-MUX-C, 32DMX-O, 32DMX, 40-DMX-C, 40-DMX-CE, 
32WSS, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 
TDC-CC, TDC-FC, 40-SMR1-C, 40-SMR2-C, OPT-AMP-17-C, 
OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, 
OPT-EDFA-24, MMU, 4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, 
AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, OSCM, OSC-CSM, and 
PSM cards (as applicable)

– L-band: 32WSS-L, 32DMX-L, OPT-BST-L, OPT-AMP-L, and 
PSM cards (as applicable)

• The ONS 15454 NE defaults file if the node uses custom NE defaults

Prerequisite Procedures • “NTP-G15 Install the Common Control Cards” section on page 3-35

• “NTP-G14 Install DWDM Equipment” in the Cisco ONS 15454 
Hardware Installation Guide

• NTP-G139 Verify Cisco Transport Planner Reports and Files, 
page 14-4

• NTP-G143 Import the Cisco Transport Planner NE Update 
Configuration File, page 14-48

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Warning High-performance devices on this card can get hot during operation. To remove the card, hold it by 
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before 
placing it in an antistatic bag. Statement 201

Caution Always use the supplied electrostatic discharge (ESD) wristband when working with a powered 
ONS 15454. For detailed instructions on how to wear the ESD wristband, refer to the Electrostatic 
Discharge and Grounding Guide for Cisco CPT and Cisco ONS Platforms.

Note For United States installations, complies with the United States Federal Drug Administration Code of 
Federal Regulations Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser 
Notice No. 50, dated July 26, 2001. 

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 If the node requires a custom NE default settings to be installed on the node, complete the “NTP-G136 
Import Network Element Defaults” procedure on page 24-20. If not, continue with Step 2. (For 
information about the ONS 15454 NE defaults, refer to Appendix H, “Network Element Defaults.”)

Caution If custom NE defaults are required, they must be installed before you install the DWDM cards.

Step 2 Verify that you have one of the following guides for the DWDM card installation:

• The slots that were preprovisioned when you completed the “NTP-G143 Import the Cisco Transport 
Planner NE Update Configuration File” procedure on page 14-48. 

• The Cisco Transport Planner shelf layout report (see Table 14-1 on page 14-4). 

Step 3 If the slots are preprovisioned, continue with Step 4. If you are using the Cisco Transport Planner shelf 
layout report, complete the “DLP-G348 Use the Cisco Transport Planner Shelf Layout Report” task on 
page 14-67.

Step 4 Remove a DWDM card from its packaging, then remove the protective caps from the backplane 
connectors. (Safety caps are typically yellow.)

Step 5 Open the card latches/ejectors. 
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Step 6 Use the latches/ejectors to firmly slide the card along the slot guide rails until the card plugs into the 
receptacle at the back of the slot. The correct slot is designated by the Cisco Transport Planner shelf 
layout.

Step 7 Verify that the card is inserted correctly. Simultaneously close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged in. Ensure 
that you cannot insert the card any further.

After installing the card, the following LED activity will occur:

• The card’s LEDs will go through a sequence of activities (turn on, turn off, blinking.) This will take 
2 to 3 minutes. 

• The ACT LED turns on. 

• The signal fail (SF) LED might persist until all card ports connect to their far-end counterparts and 
a signal is present.

Step 8 If the card does not boot up properly or the LED activity is not similar to the activity in Step 7, check 
the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If a DWDM card does not boot, open CTC and ensure that the slot is not provisioned 
for a different card type before assuming that the card is faulty.

• When the ONS-15454-M6 shelf is powered by the 15454-M6-DC20 power module, the power 
consumption is limited to 960 W. During the boot up process, if a new line card causes the power 
consumption of the shelf to exceed 960 W that line card will not boot up. 
The PWR-CON-LMT alarm is raised in the Alarms tab in CTC when the installation or 
pre-provisioning of a card causes the power consumption to exceed the limit of 960 W. The card due 
to which the PWR-CON-LMT alarm is raised must be immediately removed from the shelf and 
de-provisioned in CTC.
The calculated power consumption of the shelf can be viewed in CTC under the Provisioning > 
Power Monitor tab. For details about power calculation, see the “Power Calculation” section in the 
Cisco ONS 15454 Hardware Installation Guide.

• If the red FAIL LED does not turn on, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDs turn off and a minor 
equipment mismatch alarm appears on the CTC Alarms tab.

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed.

If any of conditions are present, remove the card and repeat Steps 4 to 7. If the card does not boot up 
properly the second time, it might be defective. Contact your next level of support.

Step 9 Repeat Steps 5 through 8 until all the DWDM cards are installed in the node.

Step 10 If an OPT-PRE card (or OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, or OPT-EDFA-24 
card in OPT-PRE card mode) is installed, complete one of the following steps for each OPT-PRE card 
based on the Cisco Transport Planner shelf layout. If an OPT-PRE is not installed, you have completed 
this procedure.

• If the Cisco Transport Planner shelf layout does not include DCUs, install a patchcord and 4-dB 
attenuator with a tolerance of +/–1 dB between the OPT-PRE or OPT-AMP-L DC TX and RX ports 
for each OPT-PRE or OPT-AMP-L card installed in the shelf.

• If the shelf layout includes DCUs, complete the “NTP-G31 Install the DWDM Dispersion 
Compensating Units” procedure on page 14-68 for each side of the shelf that requires a DCU.
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Stop. You have completed this procedure. 

DLP-G348 Use the Cisco Transport Planner Shelf Layout Report

Step 1 Display the Cisco Transport Planner shelf layout report for your site. The report can be viewed in 
Cisco Transport Planner. It can also be viewed as a JPEG graphic. Refer to the Cisco Transport Planner 
DWDM Operations Guide for information about generating shelf layout reports.

Step 2 Review the following installation information:

• Rack—Indicates the rack in the node where the cards must be installed.

• Shelf—Indicates the shelf in the rack where the cards must be installed. Shelf options include:

– Flex Shelf—The ONS 15216 FlexLayer mechanical shelf houses Y-cable modules. Flex shelf 
positions are numbered 1 to 4 from left to right.

– DCU Shelf—The Cisco ONS 15216 dispersion compensation shelf assembly houses DCUs. 
DCU positions are numbered 1 to 2 from left to right.

– Shelf-ANSI-n or Shelf-ETSI-n—The ONS 15454 shelf assembly houses ONS 15454 common, 
DWDM, and client cards. Positions in this type of shelf are numbered 1 to 17 from left to right. 
Multiple shelves might appear.

• Slot—Indicates the slot in the specific shelf where the cards must be installed:

– Unit Name (Product ID)— Identifies the card by its Product ID.

– Unit Description—Identifies the card by its name.

• Unit Side—Identifies the side of the node that the specific card is serving: A, B, C, D, E, F, G, or H.

• Unit Plug-in Modules—Identifies the type and number of PPMs that will be used with specific TXP, 
MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP cards.

Step 3 Return to your originating procedure (NTP).

Purpose This task describes how to use the Cisco Transport Planner shelf layout 
report to install cards in a DWDM node.

Tools/Equipment None

Prerequisite Procedures NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-G31 Install the DWDM Dispersion Compensating Units

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. For detailed 
instructions on how to wear the ESD wristband, refer to the Electrostatic Discharge and Grounding 
Guide for Cisco CPT and Cisco ONS Platforms.

Note For US installations, complies with the US Federal Drug Administration Code of Federal Regulations 
Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Step 1 Remove the DCU from its packaging, then remove the protective caps from the connectors. (Safety caps 
are typically yellow.)

Step 2 Use both hands to push the DCU all the way into the chassis until the connector spring lock on the right 
side of the module clicks into place. 

Step 3 Open the cover with the laser warning on the connector adapter and then connect the cable connector.

Note The Side A DCU is commonly installed on the left side and the Side B DCU is commonly 
installed on the right side.

Note Double-check the placement of the DCU card(s) with your Cisco Transport Planner shelf layout. 
If you install the wrong DCU in a slot, remove the DCU and install the correct one.

Purpose This procedure describes how to install the DCUs for DWDM shelves.

Tools/Equipment DCUs

Prerequisite Procedures “NTP-G15 Install the Common Control Cards” section on page 3-35

“NTP-G14 Install DWDM Equipment” in the Cisco ONS 15454 Hardware 
Installation Guide

NTP-G30 Install the DWDM Cards, page 14-64

NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Stop. You have completed this procedure. 

NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning Class 1 laser product. Statement 1008

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Purpose This procedure describes how to install the ONS 15454 TXP, MXP, 
AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, and OTU2_XP cards.

Tools/Equipment TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, 
TXP_MR_10EX_C, TXP_MR_2.5G, TXPP_MR_2.5G, 40E-TXP-C, 
40ME-TXP-C, MXP_2.5G_10G, MXPP_2.5G_10G, MXP_2.5G_10E, 
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10EX_C, 
MXP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, 
MXP_MR_10DMEX_C, 40G-MXP-C, 40E-MXP-C, 40ME-MXP-C, 
AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP cards (as 
applicable)

Prerequisite Procedures • “NTP-G15 Install the Common Control Cards” section on page 3-35

• “NTP-G14 Install DWDM Equipment” in the Cisco ONS 15454 
Hardware Installation Guide

• NTP-G139 Verify Cisco Transport Planner Reports and Files, 
page 14-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Caution Always use the supplied ESD wristband when working with a powered ONS 15454. For detailed 
instructions on how to wear the ESD wristband, see the Electrostatic Discharge and Grounding Guide 
for Cisco CPT and Cisco ONS Platforms.

Caution A fan-tray assembly (15454E-CC-FTA for the ETSI shelf or 15454-CC-FTA for the ANSI shelf) must 
be installed in a shelf where a GE, ADM-10G, or OTU2_XP card is installed.

Caution The fan-tray assembly 15454-M6-FTA2 (for the M6 chassis) or 15454-M2-FTA2 (for the M2 chassis) 
must be installed in the shelf where a 100G-LC-C or 10x10G-LC card is installed. The fan-tray assembly 
15454-M6-FTA2 (for the M6 chassis) must be installed in the shelf where a CFP-LC card is installed.

Note The 100G-LC-C, 10x10G-LC, or CFP-LC cards can be installed on the Cisco ONS 15454 M2 or 
Cisco ONS 15454 M6 chassis mounted with either of the following:

• Standard brackets on a 19-inch or 23-inch ANSI rack configuration or on an ETSI rack 
configuration.

• Inlet air deflectors on a 23-inch ANSI rack configuration or on an ETSI rack configuration. The 
exhaust air deflectors cannot be used.

Note • An M6 chassis with AC power supply can be equipped with a maximum of four cards (a combination 
of 100G-LC-C and 10x10G-LC cards). The remaining two slots in the M6 chassis must be left 
empty.

• An M2 chassis with AC power supply can be equipped with a maximum of one 100G-LC-C or 
10x10G-LC card. The remaining slot can be equipped with a card that has a maximum power of 
90 W.

Note For US installations, complies with the US Federal Drug Administration Code of Federal Regulations 
Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Display the Cisco Transport Planner shelf layout (see Table 14-1 on page 14-4) for the node where you 
will install the card.
14-70
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/esd_grounding/guide/esd_grounding.html
http://www.cisco.com/en/US/docs/optical/esd_grounding/guide/esd_grounding.html


 

Chapter 14      Turn Up a Node
DLP-  G348 Use the Cisco Transport Planner Shelf Layout Report
Step 2 Remove the card from its packaging, then remove the protective clips from the backplane connectors.

Step 3 Open the card latches/ejectors. 

Step 4 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot designated by the Cisco Transport Planner shelf layout.

Step 5 Verify that the card is inserted correctly and simultaneously close the latches/ejectors on the card.

Note It is possible to close the latches and ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Note If you install the card in the wrong slot, CTC will raise a MEA (EQPT) alarm. To clear this 
alarm, open the latches, slide the card out, then insert it in the correct slot. 

After you install the card, the FAIL, ACT, and SF LEDs will go through a sequence of activities. They 
will turn on, turn off, and blink at different points. After approximately 2 to 3 minutes, the ACT or 
ACT/STBY LED turns on. The SF LED might persist until all card ports connect to their far-end 
counterparts and a signal is present.

Note Until a card is provisioned, the card is in the standby condition and the ACT/STBY LED remains 
amber in color.

Step 6 If the card does not boot up properly or the LEDs do not progress through the activities described in 
Step 5, check the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot and CTC will show a MEA (EQPT) alarm. If the card does not boot, open CTC and 
ensure that the slot is not provisioned for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power.

• If you insert a card into a slot provisioned for a different card, all LEDs turn off.

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed 
properly.

If any of these conditions are present, remove the card and repeat Steps 3 to 5. If the card does not boot 
up properly the second time, contact your next level of support.

Step 7 If the card requires a Small Form-factor Pluggable (SFP, SFP+, XFP, or CXP) or a C Form -factor 
Pluggable (CFP) connector, complete one of the following tasks:

• DLP-G723 Install PPM on a Line Card—Complete this task to install the physical SFP, SFP+, XFP, 
CXP, or CFP into the TXP, MXP, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, ADM-10G, or OTU2_XP card.

• DLP-G725 Preprovisioning PPM Slot—(Optional) Complete this task if you do not have the 
physical SFP, SFP+, XFP, CXP, or CFP and need to preprovision the SFP, SFP+, XFP, CXP, or CFP 
slot. 
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Note SFP, SFP+, XFP, CXP, and CFP modules are hot-swappable input/output devices that plug into 
a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, 100G-LC-C, 
10x10G-LC, or CFP-LC line card port, to link the port with the fiber-optic network. For more 
information, see the Hardware Specifications and the Installing GBIC, SFP, SFP+, and XFP 
Optics Modules in ONS Platforms documents.

Note PPM provisioning determines how the SFP, SFP+, XFP, CXP, and CFP modules are used in CTC. 
PPM provisioning procedures are provided in Chapter 11, “Provision Transponder and 
Muxponder Cards.”

Step 8 If you need to remove an SFP, SFP+, XFP, CXP, or CFP, complete the DLP-G728 Remove PPM from 
the Line Card task.

Note You must provision the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP cards after you complete all node turn-up procedures. TXP and MXP provisioning 
procedures are provided in Chapter 11, “Provision Transponder and Muxponder Cards.”

Note Until a card is provisioned, the card is in the standby condition and the ACT/STBY LED remains 
amber in color.

Stop. You have completed this procedure. 

NTP-G123 Install the Filler Cards

Purpose This procedure explains how to install the filler cards (blank faceplates). 
The filler card aids in maintaining proper air flow and electro-magnetic 
interference (EMI) requirements.

Tools/Equipment Filler cards

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-68

NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Warning Blank faceplates (filler panels) serve three important functions: they prevent exposure to hazardous 
voltages and currents inside the chassis; they contain electromagnetic interference (EMI) that might 
disrupt other equipment; and they direct the flow of cooling air through the chassis. Do not operate 
the system unless all cards and faceplates are in place. Statement 156

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. For detailed 
instructions on how to wear the ESD wristband, refer to the Electrostatic Discharge and Grounding 
Guide for Cisco CPT and Cisco ONS Platforms.

Caution In an ONS 15454 shelf assembly, a filler card (Cisco P/N 15454-FILLER) can be installed in any unused 
traffic or AIC-I card slots (Slots 1 through 6, 9, and 12 through 17). These cards are detected by CTC in 
Software Release 6.0 and later. 

Note In an ONS 15454 M6 shelf assembly, the line card fillers (15454-M-FILLER) can be installed in any 
unused line card slots (Slots 1 through 7), and a control card filler (15454-MT-FILLER) can be installed 
in any unused control card slot (Slot 1 or Slot 8). In an ONS 15454 M2 shelf assembly, the line card filler 
(15454-M-FILLER) can be installed in any unused line card slots (Slot 2 or Slot 3). CTC does not detect 
the filler card in Release 9.2; however, CTC may detect it in later software releases.

Step 1 Open the card ejectors. 

Step 2 Slide the card along the guide rails into the correct slot.

Step 3 Close the ejectors.

Step 4 Repeat for any remaining unused card slots. 

Stop. You have completed this procedure. 

NTP-G239 Add and Delete Passive Units

Step 1 Complete the DLP-G46 Log into CTC task to log in to an ONS 15454 node on the network.

Purpose This procedure explains how to add or delete passive units on a DWDM 
node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Complete the “DLP-G543 Add Passive Units Manually” task on page 14-74 to manually preprovision a 
passive unit.

Step 3 Complete the “DLP-G544 Delete a Passive Unit” task on page 14-75 to delete a passive unit.

Stop. You have completed this procedure. 

DLP-G543 Add Passive Units Manually

Step 1 In the node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Passive Cards tabs.

Step 2 Click Create. The Create Passive Card dialog box appears. 

Step 3 Choose the passive unit from the Card Type drop-down list and click OK.

The passive unit is installed in the first available slot in the rack.

Note You can also add a passive unit in the multishelf view by right-clicking the slot inside the rack. 
Refer to the NTP-G146 Add a Rack, Passive Unit, or Shelf to a Multishelf Node procedure.

Note If you need to view the details of the passive units that have been installed on a node, click the 
Inventory tab.

Step 4 Return to your originating procedure (NTP).

Purpose This task preprovisions passive units (patch panels and DCUs) in CTC. 
Preprovisioning of the passive units is normally performed when you 
complete the“NTP-G143 Import the Cisco Transport Planner NE Update 
Configuration File” section on page 14-48. Use this task if you need to 
manually preprovision a passive unit. All slot preprovisioning must be 
based upon the Cisco Transport Planner shelf layout prepared for your site.

Tools/Equipment Cisco Transport Planner shelf layout table or JPG file.

Prerequisite Procedures  DLP-G46 Log into CTC 

NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G544 Delete a Passive Unit

Step 1 In the node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Passive Cards tabs.

Step 2 Click the passive unit you want to delete.

Step 3 Click Delete, then click Yes.

Note You can also delete a passive unit in the multi-shelf view. Refer to NTP-G147 Delete a Passive 
Unit, Shelf, or Rack from a Multishelf Node procedure.

Step 4 Return to your originating procedure (NTP).

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Caution To comply with the Telcordia GR-1089 NEBS, Issue 5 standard, do not use optical fibers with exposed 
metallic ferrules. Exposed metallic ferrules may result in ESD damage to the system and can be service 
affecting.

Purpose This task deletes a passive unit.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure attaches fiber-optic cables on the DWDM cards and DCUs.

Tools/Equipment Fiber-optic cables

Cisco Transport Planner Internal Connections Report

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

NTP-G31 Install the DWDM Dispersion Compensating Units, page 14-68 
(as applicable)

NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note For US installations, complies with the US Federal Drug Administration Code of Federal Regulations 
Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Note In this procedure, you will generally connect fibers in an Side B-to-Side A or Side B-to-Side B pattern 
only. “Side A” refers to cards and ports in Slots 1 through 8. “Side B” refers to cards and ports installed 
in Slots 10 through 17.

Note You will install fiber-optic cables on TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, 
and OTU2_XP cards later in the chapter during the “NTP-G140 Install Fiber-Optic Cables Between 
Terminal, Hub, or ROADM Nodes” procedure on page 14-80.

Step 1 Refer to the “DLP-G349 Use the Cisco Transport Planner Internal Connections Report” task on 
page 14-78 to install cables to the DWDM cards.

Step 2 Verify that the appropriate fiber optic cables are available to complete the connections shown in the 
Cisco Transport Planner Internal Connections report:

a. Count the number of connections listed in the Internal Connections and verify that you have the 
same number of cables.

b. Measure the distance between Origination Position and Destination Position for each connection, 
then verify that the fiber lengths will fit each one.

Step 3 Complete the for all fiber connections, even new fiber. Dust particles can degrade performance. Put caps 
on any fiber connectors that are not used.

Step 4 On the front of the fiber-storage tray (usually installed below the node you are fibering), push the tabs 
on the left and right sides inward to release the lock on the tray. 

Step 5 Pull the fiber-storage tray away from the shelf until it is fully opened.

Step 6 Open the fold-down door that at the bottom of the shelf assembly to expose the cable-routing channel 
(Figure 14-8).
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Figure 14-8 Managing Cables on the Front Panel 

Step 7 Using the Cisco Transport Planner Internal Connections Report, connect one end of the fiber cable plug 
into the Origination Position.

Step 8 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX, 32DMX-O, OSCM, OSC-CSM, OPT-PRE, 
OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
OPT-RAMP-CE, OPT-EDFA-17, and OPT-EDFA-24 cards.)

Step 9 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary.

Step 10 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 14-9).

Figure 14-9 Fiber-Storage Tray

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 11 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 12 Plug the other end of the cable into the Destination position. 

FAN FAIL
CRIT

MAJ
MIN

14
52

62

Cable-routing
channel posts

Fold down
front door

13
46

09

West
entry/exit

East
entry/exit
14-77
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 14      Turn Up a Node
DLP-  G349 Use the Cisco Transport Planner Internal Connections Report
Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations” procedure on page 14-124) if transmit and receive fibers are not connected 
correctly. For example, an RX port is connected to another RX port or a TX port is connected to 
another TX port. 

Step 13 Repeat Steps 4 through 12 until you have connected the intra-shelf fibers according to the 
Cisco Transport Planner Internal Connections report.

Step 14 To close the fiber-storage tray, push the tray back toward the rack until it locks into place.

Stop. You have completed this procedure. 

DLP-G349 Use the Cisco Transport Planner Internal Connections Report

Step 1 Display the Cisco Transport Planner Internal Connections report for the node that you are provisioning. 
The Internal Connections report is presented in two views, a patchcord installation view and a software 
provisioning view. The Patchcord installation view lists all the patchcord connections that the installer 
has to mechanically cable within the site between the different ports of the DWDM cards. The SW 
Provisioning view contains all the connections to be manually set or removed via CTC with respect to 
the default connections that are automatically generated by the system software running on the node.

The tables identify the patchcords that you must cable by their endpoints. Starting from the left side of 
report, Position identifies the fiber origination point. The location shown in the next Position to right is 
the destination point for the fiber connection. The patchcord endpoints are identified by site, assembly 
shelf, slot, and port number. Information provided by the Internal Connections Software report includes:

• Name—Displays the name of the site. On the SW provisioning view, this column indicates whether 
the connection was automatically set, or should be manually set or removed via CTC.

• Position—The cable origination in the format is Rack.Shelf.Slot. For example, Rack#1.Shelf 
Assembly 1.Slot 2 refers to Slot 2 in shelf assembly 1(DWDM) shelf of Rack 1. Refer to the Cisco 
Transport Planner Site Dialog box for rack and shelf names and locations. 

• Unit—The ONS 15454 DWDM card (unit) that is installed in the Position’s slot. This is where the 
patchcord originates.

• Port Number—The port number where the patchcord connection originates.

• Port ID—(Software provisioning view only) The port identifier shown in TL1 for the Position-1 
connection.

• Port Label—The name of the physical port printed on the DWDM card’s front panel and shown in 
CTC card view.

Purpose This task describes how to use the Cisco Transport Planner Internal 
Connections report to install cables on the DWDM cards.

Tools/Equipment None

Prerequisite Procedures NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Attenuator—If attenuation is required, the product ID (PID) of the bulk fixed attenuator is shown. 
“Att-Lpbk-4dB” indicates that the DC TX and DC RX ports on an OPT-PRE (or OPT-AMP-L, 
OPT-AMP-17-C, or OPT-AMP-C card provisioned in OPT-PRE card mode) card are to be connected 
with an attenuated loopback that is shipped with the OPT-PRE card. This parameter also indicates 
when an internal attenuator must be placed between the OPT-PRE DC-TX and DC-RX ports on the 
when a DCU is equipped.

Note If the Attenuator field is blank, no attenuation is needed.

• Position—The cable termination in the format is Rack.Shelf.Slot.

• Unit—The ONS 15454 DWDM card that is installed in the Position’s slot. This is where the cabling 
terminates.

• Port—The port number where the patchcord connection terminates.

• Port ID—(Software provisioning view only) The port identifier shown in TL1 for the Position-2 
connection.

• Port Label—The name of the physical port printed on the DWDM card’s front panel and shown in 
CTC card view.

• P/F—Indicates whether you must create the connection manually in CTC. A Yes appearing in this 
column means that you must create the connection manually.

Caution Failure to create the required manual connections will prevent the node from turning up properly

Step 2 Return to your originating procedure (NTP).
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NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or 
ROADM Nodes

Step 1 Determine which type of node you are fibering. 

The following node types require the listed equipment. The cards and patch panels should already be 
installed before you begin this procedure.

• Terminal node:

– One of 32DMX-O card and 32MUX-O card, and one standard or deep patch panel tray

– One of 32WSS card and 32DMX or 32DMX-O card, and one standard or deep patch panel tray

– One of 32WSS-L card and 32DMX-L card, and one standard or deep patch panel tray

– One of 40-WSS-C or 40-WSS-CE card and 40-DMX-C or 40-DMX-CE card, and one standard 
or deep patch panel tray

– One of 40-MUX-C card and 40-DMX-C or 40-DMX-CE card, and one standard or deep patch 
panel tray

– One 40-SMR1-C card and one 15216-MD-40-ODD,15216-EF-40-ODD, or 
15216-MD-48-ODD (ONS 15216 40 or 48-channel mux/demux) patch panel

– One 40-SMR2-C card and one 15216-MD-40-ODD,15216-EF-40-ODD, or 
15216-MD-48-ODD (ONS 15216 40 or 48-channel mux/demux) patch panel

– One 80-WXC-C card, one 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD 
unit, and one 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN unit, and 
one 15216-MD-ID-50 or 15216-MD-48-CM unit

• Hub node: 

Purpose This procedure routes fiber-optic cables from the DWDM optical cards in 
a terminal, hub, or ROADM node to the patch panel, and from the patch 
panel to TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G cards.

Tools/Equipment • See Step 1 for a list of equipment specific to each node type.

• All node types require fiber-optic cables, terminated with a single 
LC-type connector on each end.

• Cisco Transport Planner Internal Connections Report

Prerequisite Procedures • In the Cisco ONS 15454 Hardware Installation Guide

– “DLP-G28 Install the Fiber Patch-Panel Tray”

– “DLP-G29 Install the Fiber-Storage Tray”

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

• DLP-G348 Use the Cisco Transport Planner Shelf Layout Report, 
page 14-67

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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– Two of 32MUX-O cards and 32DMX-O or 32DMX cards, and two standard or deep patch panel 
trays

– Two of 32WSS cards and 32DMX or 32DMX-O cards, and two standard or deep patch panel 
trays

– Two of 32WSS-L cards and 32DMX-L cards, and two standard or deep patch panel trays

– Two of 40-WSS-C or 40-WSS-CE cards and 40-DMX-C or 40DMX-CE cards, and two standard 
or deep patch panel trays

– Two 40-SMR1-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panels

– Two 40-SMR2-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panels

• ROADM node: 

– Two 32WSS cards, optionally, two 32DMX or 32DMX-O cards, and two standard or deep patch 
panel trays

– Two 32WSS-L cards, optionally, two 32DMX-L cards, and two standard or deep patch panel 
trays

– Two 40-WSS-C or 40-WSS-CE cards, optionally, two 40-DMX-C or 40-DMX-CE cards, and 
two standard or deep patch panel trays

– Two 40-SMR1-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panels

– Two 40-SMR2-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD patch panels

– Two 80-WXC-C cards and two 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD units and 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 
15216-MD-48-EVEN units and two 15216-MD-ID-50 or 15216-MD-48-CM units

• Expanded ROADM node:

– Two of 40-WSS-C/40-WSS-CE cards and 40-DMX-C/40-DMX-CE cards, and two 40-channel 
patch panel trays, preinstalled with MPO-LC cables

Note If you are using standard patch panels, you will also need eight multifiber push-on (MPO) 
cables per standard patch panel. MPO cables are fiber-optic cables terminated on one end 
with one MPO connector and with eight LC-type connectors on the other end. Deep patch 
panel trays come preinstalled with MPO cables.

Step 2 On the front of the patch panel tray, push the tabs on the left and right sides inward to release the lock 
on the tray. 

Step 3 Pull the patch panel tray away from the shelf until it is fully opened. 

Note The red latch inside the patch panel tray at the top left corner will automatically click and lock 
the tray in the open position when you have fully opened the tray.

Step 4 Depending on the type of patch panel tray you are using:

• Standard patch panel tray:
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– Complete the “DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Standard Patch Panel Tray” task on page 14-83.

– Complete the “DLP-G316 Install Fiber-Optic Cables from TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP Cards to the Standard Patch Panel Tray” task 
on page 14-87.

• Deep patch panel tray:

– Complete the “DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Deep Patch Panel Tray” task on page 14-88.

– Complete the “DLP-G357 Install Fiber-Optic Cables from the TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP Cards to the Deep Patch Panel Tray or 
40-Channel Patch Panel Tray” task on page 14-95.

• 40-channel patch panel tray:

– As needed, complete the “DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel 
Tray” task on page 14-91 to route the MPO cables out of the right side of the tray so they can 
be easily connected to cards installed on the right side of the shelf (Slots 12 through 17).

– Complete the “DLP-G428 Install Fiber-Optic Cables from the 40-WSS-C/40-WSS-CE and 
40-DMX-C/40-DMX-CE Cards in an Expanded ROADM, Terminal, or Hub Node to the 
40-Channel Patch Panel Tray” task on page 14-93.

• 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch panel:

– Complete the “DLP-G530 Install Fiber-Optic Cables from the 40-SMR1-C, 40-SMR2-C, or 
80-WXC-C Cards in a ROADM, Terminal, or Hub Node to the 15216-MD-40 or 15216-MD-48 
Patch Panel Tray” task on page 14-97

Step 5 To close the patch panel tray, unlock it by pressing the red latch in the top left corner, and then push the 
tray back toward the rack until it locks into place.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Stop. You have completed this procedure.
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DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Standard Patch Panel Tray

Note For a ROADM or hub node, two patch panels will be used, one for Side B side and one for Side A. The 
Side B 32WSS/32DMX card will connect to the Side B patch panel. The Side A 32WSS/32DMX card 
will connect to the Side A patch panel.

Step 1 Choose either the Side B or Side A to cable the 32MUX-O and 32DMX-O cards (or the 32WSS and 
32DMX cards for a ROADM node).

Purpose This task describes how to route fiber-optic cables from 32MUX-O, 
32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM node 
to the standard patch panel.

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Terminal node:

• One 32DMX-O card

• One 32MUX-O card

• One standard patch panel tray

• Eight fiber-optic MPO cables: each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors

Hub node:

• Two 32DMX-O cards

• Two 32MUX-O cards

• Two standard patch panel trays

• Sixteen fiber-optic MPO cables: each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors

ROADM node:

• Two 32WSS cards

• Two 32DMX cards

• Two standard patch panel trays

• Sixteen fiber-optic MPO cables: each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 2 On the patch panel, pull up firmly on the two latches and use them to slide the patch panel up until it 
snaps in place above the tray (Figure 14-10).

Figure 14-10 Using the Patch Panel Latches to Slide the Patch Panel Away from the Tray

Step 3 At the 32WSS or 32MUX-O card in the node, plug the MPO connector of an MPO cable (Figure 14-11) 
into the top Add RX (30.3–36.6) port of the card. If you are connecting a subsequent MPO cable, plug 
the MPO connector into the first vacant Add RX card port below the last MPO cable that was installed.
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Figure 14-11 MPO Cable
.

Step 4 Route the MPO cable slack through the patch panel tray as necessary.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 5 While facing the front of the patch panel, at the rear side of the patch panel, plug the eight LC-connector 
fan-out cables on the MPO cable into their corresponding connectors on the bottom row of the patch 
panel. You should plug the fan-out cables from left to right (as you face the patch panel), following the 
numbers tagged (1 through 8) on the cables. 

Figure 14-12 shows the patch panel connectors from the rear of the patch panel tray. Figure 14-13 shows 
the assigned wavelengths for each port on the patch panel, as indicated at the top of the patch panel bar. 
The numbers on the patch panel bar correspond to a wavelength on the ITU grid.
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Figure 14-12 Rear View of the Patch Panel
.

Figure 14-13 Top View of the Patch Panel Bar

Step 6 As necessary, repeat Steps 3 through 5 for the remaining three Add RX ports on the 32WSS or 
32MUX-O card, until all 32 LC connectors on the bottom row of the rear of the patch panel are 
connected. 

Step 7 At the adjacent 32DMX or 32DMX-O card in the same side of the shelf, plug the MPO connector of an 
MPO cable into the top Drop TX (30.3–36.6) port of the 32DMX or 32DMX-O card. If you are 
connecting a subsequent MPO cable, plug the MPO connector into the first vacant Drop TX card port 
below the last MPO cable that was installed.

Step 8 Route the MPO cable slack through the patch panel tray as necessary.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 9 While facing the front of the patch panel, at the rear of the patch panel, plug the eight LC-connector 
fan-out cables on the MPO cable into their corresponding connectors on the top row of the patch panel. 
You should plug the fan-out cables from left to right (as you face the patch panel), following the numbers 
tagged (1 through 8) on the cables.

Step 10 As necessary, repeat Steps 7 through 9 for the remaining three Drop TX ports on the 32DMX or DMX-O 
card, until all 32 LC connectors on the top row of the rear of the patch panel are connected.

Step 11 For a hub or ROADM node, repeat Steps 2 through 10 to cable the other side of the shelf to the second 
patch panel. For a terminal node, go to Step 12.

Step 12 Return to your originating procedure (NTP).
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Chapter 14      Turn Up a Node
DLP-  G316 Install Fiber-Optic Cables from TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP
DLP-G316 Install Fiber-Optic Cables from TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, ADM-10G, or OTU2_XP Cards to the Standard Patch Panel Tray

Step 1 At the appropriate TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP 
card, plug one end of a fiber-optic cable into the TX port of the DWDM adapter.

Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray.

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3 On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the 
bottom row that corresponds to the wavelength to which the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, ADM-10G, or OTU2_XP port is tuned. (See Figure 14-13 on page 14-86 for a view of the 
wavelengths assigned to the patch panel connectors). 

Figure 14-14 shows the patch panel connectors from the front of the patch panel tray. 

Figure 14-14 Front View of the Patch Panel
.

Step 4 Plug one end of a fiber-optic cable into the RX port of the DWDM adapter on the TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP card.

Purpose This task describes how to route fiber-optic cables from the patch panel to 
TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP cards.

Tools/Equipment TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP card(s)

Fiber-optic cable(s)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Deep Patch Panel 
Step 5 On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the 
top row that corresponds to the wavelength to which the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, ADM-10G, or OTU2_XP card is tuned.

Step 6 Repeat Steps 1 through 5 for all of the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, 
ADM-10G, or OTU2_XP cards that you want to connect to this patch panel.

Step 7 Return to your originating procedure (NTP).

.

DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Deep Patch Panel Tray

Purpose This task describes how to route fiber-optic cables from 32MUX-O, 
32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM node 
to the deep patch panel tray.

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

For terminal nodes, one of the following card sets:

• One 32MUX-O card and one 32DMX-O or 32DMX card

• One 32WSS card and one 32DMX or 32DMX-O card

• One 32WSS-L cards and one 32DMX-L card

Plus one deep patch panel tray, preinstalled with MPO cables (each MPO 
cable is terminated on one end with one MPO connector and on the other 
end with eight LC-type connectors)

For hub nodes, one of the following card sets:

• Two 32MUX-O cards and two 32DMX-O or 32DMX cards

• Two 32WSS cards and two 32DMX or 32DMX-O cards

• Two 32WSS-L cards and two 32DMX-L cards

Plus two deep patch panel trays, preinstalled with MPO cables (each MPO 
cable is terminated on one end with one MPO connector and on the other 
end with eight LC-type connectors)

For ROADM nodes, one of the following card sets:

• Two 32WSS cards and two 32DMX or 32DMX-O cards

• Two 32WSS-L cards and two 32DMX-L cards

Plus two deep patch panel trays, preinstalled with MPO cables (each MPO 
cable is terminated on one end with one MPO connector and on the other 
end with eight LC-type connectors)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Deep Patch Panel
Note For a ROADM or hub node, two patch panels will be used, one for Side A (Slots 1 through 6) and one 
for Side B (Slots 12 through 17). The Side B 32WSS/32DMX card will connect to the Side B patch panel. 
The Side A 32WSS/32DMX card will connect to the Side A patch panel. The MPO cables in the patch 
panel are preinstalled and routed out of the right side of the patch panel tray.

Step 1 Choose either Side A or Side B of the shelf to cable the 32MUX-O and 32DMX-O cards (or the 32WSS 
and 32DMX cards for a ROADM node).

Step 2 On the patch panel, locate the MPO connectors (Figure 14-11 on page 14-85).

Step 3 Route the preinstalled MPO cables out of the tray to the right or left (Figure 14-15).

Figure 14-15 Deep Patch Panel Tray

Step 4 At the 32WSS or 32MUX-O card in the node, plug the MPO connector labeled 1 RX on an MPO cable 
(Figure 14-11 on page 14-85) into the top Add RX (30.3–36.6) port of the card. 

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 5 Plug the MPO connector labeled 2-RX into the Add RX (38.1–44.5) port on the card. 

Step 6 Plug the MPO connector labeled 3-RX into the Add RX (46.1–52.5) port on the card. 

Step 7 Plug the MPO connector labeled 4-RX into the Add RX (54.1–60.6) port on the card. 

Figure 14-16 shows the deep patch panel ports and corresponding wavelengths.
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Chapter 14      Turn Up a Node
DLP-  G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 32MUX-O/32DMX-O Cards to the Deep Patch Panel 
Figure 14-16 Deep Patch Panel Port Wavelengths

Step 8 At the adjacent 32DMX or 32DMX-O card in the same side of the shelf, plug the MPO connector labeled 
1 TX on the MPO cable (Figure 14-11 on page 14-85) into the top Drop TX (30.3–36.6) port of the card 
(Figure 14-16). 

Step 9 Plug the MPO connector labeled 2-TX into the Drop TX (38.1–44.5) port on the card. 

Step 10 Plug the MPO connector labeled 3-TX into the Drop TX (46.1–52.5) port on the card. 

Step 11 Plug the MPO connector labeled 4-TX into the Drop TX (54.1–60.6) port on the card. 

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 12 For a hub or ROADM node, repeat Steps 2 through 11 to cable the other side of the shelf to the second 
patch panel. For a terminal node, go to Step 13.

Step 13 Return to your originating procedure (NTP).
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Chapter 14      Turn Up a Node
DLP-  G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray
DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray

Step 1 Carefully unwind all of the MPO cables in the patch panel tray and gently set the cables to the side of 
the tray, out of the way of the internal hardware.

Figure 14-17 and Figure 14-18 show the 40-channel patch panel tray.

Figure 14-17 40-Channel Patch Panel Tray, Side View

Purpose This task reroutes the MPO cables that are preinstalled in the 40-channel 
patch panel tray. The cables exit to the left when shipped; this task reroutes 
the cables out of the right side of the tray. Use this task when you want to 
connect these MPO cables to cards installed on the right side of the shelf 
(Slots 12 through 17).

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray
Figure 14-18 40-Channel Patch Panel Tray, Top View

Step 2 Slide each of the ten LC-port adapter packs upward.

Step 3 Unscrew the two screws in the bottom left bending limiter and remove the bending limiter.

Step 4 Remove the single screw below the center of the patch panel to free the patch panel hardware.

Step 5 Slide the patch panel to the left, and reinstall the screw below the center of the patch panel.

Step 6 Install the bending limiter to the right of the patch panel by installing the two screws.

Step 7 Carefully route all of the MPO cables around the bending limiter and out the exit on the right side of the 
patch panel tray.

Step 8 Slide each of the ten LC-port adapter packs downward.

Step 9 Return to your originating procedure (NTP).
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Chapter 14      Turn Up a Node
DLP-  G428 Install Fiber-Optic Cables from the 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE Cards in an Expanded
DLP-G428 Install Fiber-Optic Cables from the 40-WSS-C/40-WSS-CE and 
40-DMX-C/40-DMX-CE Cards in an Expanded ROADM, Terminal, or Hub Node to 
the 40-Channel Patch Panel Tray

Note For a ROADM node, two patch panels will be used, one for the Side A (Slots 1 through 6) and one for 
Side B (Slots 12 through 17). The Side B 40-WSS-C/40-WSS-CE card will connect to the Side B patch 
panel. The Side A 40-WSS-C/40-WSS-CE will connect to the Side A patch panel. The MPO cables in 
the patch panel are preinstalled and routed out of the left side of the patch panel tray.

Step 1 Choose either the Side A or Side B side of the shelf to cable the 40-WSS-C/40-WSS-CE and 
40-DMX-C/40-DMX-CE cards.

Note If you are cabling cards on Side B of the shelf, you must first perform the “DLP-G427 Reroute 
Fiber-Optic Cables in the 40-Channel Patch Panel Tray” task on page 14-91 to route the MPO 
cables out of the right side of the patch panel tray, or route the cables through a fiber storage 
panel.

Purpose This task describes how to route fiber-optic cables from 
40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards in an 
expanded ROADM, terminal, or hub node to the 40-channel (80-port) patch 
panel tray (15454-PP-80).

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Expanded terminal nodes:

• One 40-WSS-C or 40-WSS-CE card

• One 40-DMX-C or 40-DMX-CE card

Plus one 40-channel patch panel tray, preinstalled with MPO cables (each 
MPO cable is terminated on one end with one MPO connector and on the 
other end with eight LC-type connectors)

Expanded hub or ROADM nodes:

• Two 40-WSS-C or 40-WSS-CE cards

• Two 40-DMX-C or 40-DMX-CE cards

Plus two 40-channel patch panel trays, preinstalled with MPO cables (each 
MPO cable is terminated on one end with one MPO connector and on the 
other end with eight LC-type connectors)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray, 
page 14-91

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G428 Install Fiber-Optic Cables from the 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE Cards in an Expanded 
Step 2 On the patch panel, locate the MPO cables and connectors.

Step 3 At the 40-WSS-C/40-WSS-CE card in the node, plug the MPO connector labeled 1 RX on an MPO cable 
(Figure 14-11 on page 14-85) into the top Add RX (30.3–35.8) port of the card. 

Step 4 Plug the MPO connector labeled 2-RX into the Add RX (36.6–42.1) port on the card.

Step 5 Plug the MPO connector labeled 3-RX into the Add RX (42.9–48.5) port on the card.

Step 6 Plug the MPO connector labeled 4-RX into the Add RX (49.3–54.9) port on the card.

Step 7 Plug the MPO connector labeled 5-RX into the Add RX (55.7–61.4) port on the card.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Figure 14-19 shows the 40-channel patch panel ports and corresponding wavelengths.

Figure 14-19 40-Channel (15454-PP-80) Patch Panel Port Wavelengths

Step 8 At the adjacent 40-DMX-C/40-DMX-CE card in the same side of the shelf, plug the MPO connector 
labeled 1 TX on the MPO cable into the top Drop TX (30.3–35.8) port of the card. 

Step 9 Plug the MPO connector labeled 2-TX into the Drop TX (36.6–42.1) port on the card.

Step 10 Plug the MPO connector labeled 3-TX into the Drop TX (42.9–48.5) port on the card.

Step 11 Plug the MPO connector labeled 4-TX into the Drop TX (49.3–54.9) port on the card.

Step 12 Plug the MPO connector labeled 5-TX into the Drop TX (55.7–61.4) port on the card.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 13 Repeat Steps 2 through 12 to cable the other side of the shelf to the second patch panel. 
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Chapter 14      Turn Up a Node
DLP-  G357 Install Fiber-Optic Cables from the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP
Step 14 Return to your originating procedure (NTP).

DLP-G357 Install Fiber-Optic Cables from the TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP Cards to the Deep Patch Panel Tray 
or 40-Channel Patch Panel Tray

Step 1 Refer to the Cisco Transport Planner Internal Connections Report to connect the TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP card to the proper (Side A or Side B) patch 
panel. Cisco Transport Planner designates Side A as Slots 1 to 6 and Side B as Slots 12 to 17. At the 
appropriate TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP card, plug 
one end of a fiber-optic cable into the TX port of the DWDM adapter. 

Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray.

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3 Plug the other end of the cable into the RX connector on the patch panel that corresponds to the 
wavelength to which the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP port is tuned. (See Figure 14-16 on page 14-90 for a view of the wavelengths assigned to the 
deep patch panel connectors or Figure 14-19 on page 14-94 for a view of the wavelengths assigned to 
the 40-channel patch panel connectors). 

Step 4 On the patch panel tray, slide each of the ten LC-port adapter packs upward.

Step 5 Plug one end of a fiber-optic cable into the RX port of the DWDM adapter on the TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP card.

Step 6 Plug the other end of the cable into the TX connector on the patch panel that corresponds to the 
wavelength to which the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP port is tuned.

Purpose This task describes how to route fiber-optic cables from the deep patch 
panel (32-channel) or 40-channel patch panel to TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP cards.

Tools/Equipment TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP card(s)

Deep (32-channel) patch panel tray or 40-channel patch panel tray

Fiber-optic cable(s)

Cisco Transport Planner Internal Connections Report

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G357 Install Fiber-Optic Cables from the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or OTU2_XP 
Step 7 Repeat Steps 1 through 6 for each TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, or 
OTU2_XP card that you want to connect to this patch panel.

Step 8 Return to your originating procedure (NTP).
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Chapter 14      Turn Up a Node
DLP-  G530 Install Fiber-Optic Cables from the 40-SMR1-C, 40-SMR2-C, or 80-WXC-C Cards in a ROADM, Terminal, or
DLP-G530 Install Fiber-Optic Cables from the 40-SMR1-C, 40-SMR2-C, or 
80-WXC-C Cards in a ROADM, Terminal, or Hub Node to the 15216-MD-40 or 
15216-MD-48 Patch Panel Tray

Purpose This task describes how to route fiber-optic cables from the 40-SMR1-C1, 
40-SMR2-C1, or 80-WXC-C2 cards in a ROADM, terminal, or hub node to 
the 15216-MD-40 or 15216-MD-48 patch panel tray.

1. The 40-SMR1-C and 40-SMR2-C cards can be connected only to the odd patch panel (15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD).

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Terminal nodes:

• One 40-SMR1-C1 and one 15216 Odd patch panel3

• One 40-SMR2-C1 and one 15216 Odd patch panel3

• One 80-WXC-C2 card, one 15216 Odd patch panel3, and one 
15216 Even patch panel4, and one 15216-MD-ID-50 or 
15216-MD-48-CM unit

Hub nodes:

• Two 40-SMR1-C1 cards and two 15216 Odd patch panels3

• Two 40-SMR2-C1 cards and two 15216 Odd patch panels3

ROADM nodes:

• Two 40-SMR1-C1 cards and two 15216 Odd patch panels3

• Two 40-SMR2-C1 cards and two 15216 Odd patch panels3

• Two 80-WXC-C2 cards, two 15216 Odd patch panels3, and 
15216 Even patch panels4 and 15216-MD-ID-50 or 15216-MD-48-CM 
units

Prerequisite Procedures Install and route fiber-optic cables on the patch panel. For more 
information, see the required installation guide:

• Installing the Cisco ONS 15216-MD-40-ODD and 
15216-MD-40-EVEN Mux/Demux Patch Panels

• Installing the Cisco ONS 15216-EF-40-ODD and 15216-EF-40-EVEN 
Mux/Demux Patch Panels

• Installing the Cisco ONS 15216-MD-48-ODD and 
15216-MD-48-EVEN Mux/Demux Patch Panels

• Installing Cisco ONS 15216-MD-ID-50 Optical Interleaver and 
Deinterleaver Pluggable

• Installing the Cisco ONS 15216-MD-48-CM Interleaver and 
Deinterleaver Pluggable

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G530 Install Fiber-Optic Cables from the 40-SMR1-C, 40-SMR2-C, or 80-WXC-C Cards in a ROADM, Terminal, or 
Note For optical interconnections between the odd patch panel, interleaver and deinterleaver module, and the 
even patch panel, see the “Installing Cisco ONS 15216-MD-ID-50 Optical Interleaver and Deinterleaver 
Pluggable” or “Installing the Cisco ONS 15216-MD-48-CM Interleaver and Deinterleaver Pluggable” 
guide.

Note For a ROADM node, two patch panels will be used, one for the Side A (Slots 1 through 6) and one for 
Side B (Slots 12 through 17). The Side B 40-SMR1-C1 or 40-SMR2-C1card will connect to the Side B 
patch panel. The Side A 40-SMR1-C1 or 40-SMR2-C1 will connect to the Side A patch panel.

Step 1 Choose Side A or Side B of the shelf to route the cables from the 40-SMR1-C1, 40-SMR2-C1, or 
80-WXC-C2 card.

Step 2 On the 15216 patch panel1,2, locate the COM TX port and insert one end of an LC-LC cable.

Step 3 Route the LC-LC cable through the 15216 patch panel1,2 to the 40-SMR1-C1 card, 40-SMR2-C1 card, or 
80-WXC-C2 card on Side A of the node.

Step 4 Connect the other end of the LC-LC cable to the ADD RX port on the 40-SMR1-C1 or 40-SMR2-C1 
cards or the AD port on the 80-WXC-C2 card.

Step 5 On the 15216 patch panel1,2, locate the COM RX port and insert one end of an LC-LC cable.

Step 6 Route the LC-LC cable through the 15216 patch panel1,2 to the 40-SMR1-C1, 40-SMR2-C1 or 
80-WXC-C2 card on Side A of the node.

Step 7 Connect the other end of the LC-LC cable to the DROP TX port on the 40-SMR1-C1, 40-SMR2-C1, or 
80-WXC-C2 card.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 8 For a hub or ROADM node, repeat Steps 2 through 7 to cable the other side of the shelf to the second 
patch panel. For a terminal node, go to Step 9.

Note For a ROADM node using 40-SMR2-C1 cards, you must use a special reversed MPO cable 
(15454-MPO-XMPO-2=) to connect the EXP ports of the Side A 40-SMR2-C1 to the EXP ports of the 
Side B 40-SMR2-C1.

Step 9 Return to your originating procedure (NTP).

2. The 80-WXC-C card can be connected to the odd patch panel (15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD) and the even patch panel (15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN) in the 
presence of interleaver and deinterleaver pluggable (15216-MD-ID-50 or 15216-MD-48-CM).

3. 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD patch panel.

4. 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN patch panel.
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Chapter 14      Turn Up a Node
DLP-  G530 Install Fiber-Optic Cables from the 40-SMR1-C, 40-SMR2-C, or 80-WXC-C Cards in a ROADM, Terminal, or
NTP-G185 Install Fiber-Optic Cables between Mesh Nodes

Step 1 Open the patch panel tray:

• 40-channel patch panel tray—On the front of the patch panel tray, push the tabs on the left and right 
sides inward to release the lock on the tray. Pull the patch panel tray away from the shelf until it is 
fully opened.

• Mesh patch panel tray—On the front of the patch panel tray, push the tabs on the left and right sides 
inward to open the front door. Raise the plunger located to the right of the TEST ACCESS TX port 
and pull the tray away from the rack.

Purpose This procedure describes how to install fiber-optic cables to create mesh 
nodes. You must route fiber-optic cables from:

• 40-MUX-C and 40-DMX-C cards in a mesh node to the 40-channel 
(80-port) patch panel tray (15454-PP-80)

• 40-WXC-C or 80-WXC-C cards in a mesh node to one of the mesh 
patch panel trays (four-degree or eight-degree)

• 40-SMR2-C cards in a mesh node to the 15454-PP-4-SMR patch panel 
tray.

Tools/Equipment Mesh nodes require the following equipment. The cards and patch panels 
should already be installed before you begin this procedure.

• One 40-MUX-C card per side of the mesh node (up to 8 sides per node)

• One 40-DMX-C card per side of the mesh node (up to 8 sides per node)

• One 40-channel patch panel tray per side of the mesh node (up to 8 
sides per node) 

• One 40-WXC-C card per side (up to 8 sides per node)

• One 80-WXC-C card per side (up to 8 sides per node)

• One 40-SMR2-C card per side (up to 4 sides per node)

• One MPO-MPO fiber-optic cable per side (up to 8 sides per node)

• One LC-LC fiber-optic cable per side (up to 8 sides per node)

• One PP-MESH-4 (four-degree), PP-MESH-8 (eight-degree), or 
15454-PP-4-SMR (four-degree) mesh patch panel tray depending on 
the type of mesh node you want to install

Note Use the PP-MESH-4 or PP-MESH-8 mesh patch panel trays for the 
40-WXC-C or 80-WXC-C cards and the 15454-PP-4-SMR mesh 
patch panel tray for the 40-SMR2-C card.

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray, 
page 14-91

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G430 Install Fiber-Optic Cables from the 40-MUX-C and 40-DMX-C Cards in a Mesh Node to the 40-Channel Patch 
Step 2 Complete the “DLP-G430 Install Fiber-Optic Cables from the 40-MUX-C and 40-DMX-C Cards in a 
Mesh Node to the 40-Channel Patch Panel Tray” task on page 14-100.

Step 3 Complete the “DLP-G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in a 
Mesh Node to a Mesh Patch Panel Tray” task on page 14-102.

Step 4 Close the patch panel tray:

• 40-channel patch panel tray: Push the tray back toward the rack until it locks into place. 

• Mesh patch panel tray: Raise the plunger located on the right of the TEST ACCESS Tx port and 
push the tray until the plunger locks into the closed position.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the tray, make sure that adequate cable slack remains.

Stop. You have completed this procedure.

DLP-G430 Install Fiber-Optic Cables from the 40-MUX-C and 40-DMX-C Cards in 
a Mesh Node to the 40-Channel Patch Panel Tray

Step 1 Choose Side A of the shelf to cable the 40-MUX-C and 40-DMX-C cards.

Purpose This task describes how to route fiber-optic cables from 40-MUX-C and 
40-DMX-C cards in mesh node to the 40-channel (80-port) patch panel tray 
(15454-PP-80). In a mesh node, one 40-channel patch panel tray is required 
for each direction. The Side A 40-MUX-C and 40-DMX-C cards will 
connect to the Side A 40-channel patch panel. The Side B 40-MUX-C and 
40-DMX-C cards will connect to the Side B 40-channel patch panel, and so 
forth, up to a maximum of an eight-degree mesh node (Sides A through H). 

Tools/Equipment The cards and patch panels should already be installed before you begin 
this procedure.

• One 40-MUX-C card per side of the mesh node

• One 40-DMX-C card per side of the mesh node

• One 40-channel patch panel trays per side of the mesh node, 
preinstalled with MPO cables (each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray, 
page 14-91

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G430 Install Fiber-Optic Cables from the 40-MUX-C and 40-DMX-C Cards in a Mesh Node to the 40-Channel Patch
Note If you are cabling any cards from the right side of the shelf (Slots 12 through 17), you must first 
perform the “DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch Panel Tray” task 
on page 14-91 to route the MPO cables out of the right side of the patch panel tray, or route the 
cables through a fiber storage panel.

Step 2 On the patch panel, locate the MPO cables and connectors.

Step 3 At the 40-MUX-C card in the node, plug the MPO connector labeled 1 RX on an MPO cable into the top 
Add RX (30.3–35.8) port of the card. 

Step 4 Plug the MPO connector labeled 2-RX into the Add RX (36.6–42.1) port on the card. 

Step 5 Plug the MPO connector labeled 3-RX into the Add RX (42.9–48.5) port on the card. 

Step 6 Plug the MPO connector labeled 4-RX into the Add RX (49.3–54.9) port on the card. 

Step 7 Plug the MPO connector labeled 5-RX into the Add RX (55.7–61.4) port on the card. 

Step 8 At the adjacent 40-DMX-C card in the same side of the shelf, plug the MPO connector labeled 1 TX on 
the MPO cable. 

Step 9 Plug the MPO connector labeled 2-TX into the Drop TX (36.6–42.1) port on the card. 

Step 10 Plug the MPO connector labeled 3-TX into the Drop TX (42.9–48.5) port on the card. 

Step 11 Plug the MPO connector labeled 4-TX into the Drop TX (49.3–54.9) port on the card. 

Step 12 Plug the MPO connector labeled 5-TX into the Drop TX (55.7–61.4) port on the card. 

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Step 13 Repeat Steps 2 through 12 for the remaining sides of the mesh node (Sides B through H, depending on 
the type of mesh node you want to cable).

Step 14 Return to your originating procedure (NTP).
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Chapter 14      Turn Up a Node
DLP-  G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in a Mesh Node to a Mesh Patch Panel 
DLP-G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in 
a Mesh Node to a Mesh Patch Panel Tray

Step 1 Choose Side A of the shelf to cable the 40-WXC-C, or 40-SMR2-C card to the mesh patch panel.

Step 2 On the mesh patch panel, locate the EXP TX A port (for PP-MESH-4 and PP-MESH-8) or EXP-A port 
(for 15454-PP-4-SMR) and insert one end of an MPO-MPO cable. 

Step 3 Route the MPO cable through the mesh patch panel and out to the 40-WXC-C, or 40-SMR2-C card on 
Side A of the node.

Step 4 Connect the other end of the MPO cable to the EXP RX port on the 40-WXC-C, or EXP port on the 
40-SMR2-C card. 

Purpose This task connects fiber-optic cables from the 40-WXC-C or 40-SMR2-C 
cards in a mesh node to the 4-degree (PP-MESH-4 or 15454-PP-4-SMR) or 
8-degree (PP-MESH-8) mesh patch panel. The four-degree patch panel 
allows up to 4 sides to be used per node, while the eight-degree patch panel 
allows up to 8 sides to be used per node.

Tools/Equipment The cards and patch panel trays should already be installed before you 
begin this procedure.

• One 40-WXC-C card per side (up to 8 sides per node)

• One 40-SMR2-C card per side (up to 4 sides per node)

• One MPO-MPO fiber-optic cable per side

• One LC-LC fiber-optic cable per side

• One PP-MESH-4 (four-degree), PP-MESH-8 (eight-degree), or 
15454-PP-4-SMR (four-degree) mesh patch panel tray

• Cisco Transport Planner Internal Connections Report

Note Use the PP-MESH-4 or PP-MESH-8 mesh patch panel trays for the 
40-WXC-C or 80-WXC-C cards and the 15454-PP-4-SMR mesh 
patch panel tray for the 40-SMR2-C card.

Prerequisite Procedures • In the Cisco ONS 15454 Hardware Installation Guide

– “DLP-G28 Install the Fiber Patch-Panel Tray” i

– “DLP-G29 Install the Fiber-Storage Tray”

• NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

• DLP-G348 Use the Cisco Transport Planner Shelf Layout Report, 
page 14-67

• Install and route fiber-optic cables on the 15454-PP-4-SMR mesh 
patch panel. For more information, see the Installing Cisco ONS 
15454-PP-4-SMR Patch Panel.

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-  G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in a Mesh Node to a Mesh Patch Panel
Note If you are connecting a 40-SMR2-C card to the 15454-PP-4-SMR mesh patch panel, skip steps 
5 through 7.

Step 5 On the PP-MESH-4 or PP-MESH-8 mesh patch panel, locate the COM RX A port and insert one end of 
an LC-LC cable. 

Step 6 Route the LC cable through the mesh patch panel to the 40-WXC-C card on Side A of the node.

Step 7 Connect the other end of the LC cable to the EXP TX port on the 40-WXC-C.

Step 8 Repeat Steps 1 through 7 as necessary to cable Sides B through D for a 4-degree patch panel, and Sides B 
through H for an 8-degree patch panel.

Caution When you close the patch panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch panel tray, make sure that adequate cable slack remains.

Stop. You have completed this procedure.

NTP-G191 Install Fiber-Optic Cables on Passthrough ROADM 
Nodes

Step 1 Choose either the East or West side of the first shelf to cable the 32WSS card for the first ROADM node.

Purpose This procedure routes fiber-optic cables from a 32WSS card in a ROADM 
node in one shelf to the corresponding 32WSS card in a ROADM node in 
another shelf. The purpose of this routing is to connect East and West 
intershelf ROADMs in a passthrough configuration.

Tools/Equipment Each ROADM node requires the listed equipment. The cards and 
fiber-storage trays should already be installed before you begin this 
procedure.

• One 32WSS card 

• One fiber-storage tray

• Two 3-meter fiber-optic cables, each terminated with a single LC 
connector on each end.

• Cisco Transport Planner Internal Connections Report

Prerequisite Procedures “DLP-G29 Install the Fiber-Storage Tray” in the Cisco ONS 15454 
Hardware Installation Guide

DLP-G348 Use the Cisco Transport Planner Shelf Layout Report, 
page 14-67

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 14      Turn Up a Node
DLP-  G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in a Mesh Node to a Mesh Patch Panel 
Step 2 Choose the corresponding West or East side of the second shelf to cable the 32WSS card for the second 
ROADM node.

Step 3 On the front of the fiber-storage tray that will be used for routing the fiber-optic cable, push the tabs on 
the left and right sides inward to release the lock on the tray. 

Step 4 Pull the fiber-storage tray away from the shelf until it is fully opened.

Step 5 Open the fold-down door located at the bottom of both shelf assemblies to expose the cable-routing 
channels for each (Figure 14-20).

Figure 14-20 Managing Cables on the Front Panel 

Step 6 Plug one end of the first 3-meter fiber-optic cable into the EXP-TX connector on the first 32WSS card.

Step 7 Route the fiber-optic cable through the shelf cable-routing channel and cutout on the appropriate side of 
the shelf assembly, as necessary.

Step 8 Route the fiber-optic cable through the vertical fiber guide as needed to reach the entry to the 
fiber-storage tray.

Step 9 Thread the cable into the fiber-storage tray at the appropriate side and around the first bend radius 
delimiter as shown (Figure 14-21).

Step 10 As needed, route slack fiber-optic cable around the slack management cable retainers in the fiber-storage 
tray (Figure 14-21).
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DLP-  G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in a Mesh Node to a Mesh Patch Panel
Figure 14-21 Fiber-Storage Tray

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 11 Thread the fiber cable through the second bend delimiter and out the appropriate side of the fiber-storage 
tray as necessary. 

Step 12 Route the fiber-optic cable through the vertical fiber guide as needed to reach the second ROADM shelf 
where the second 32WSS is located.

Step 13 Route the fiber-optic cable through the shelf cutout and through the shelf cable routing channel as 
needed.

Step 14 Plug the end of the 3-meter fiber-optic cable into the EXP-RX port of the second 32WSS card. 

Step 15 Plug one end of the second 3-meter fiber-optic cable into the EXP-TX connector on the second 32WSS 
card.

Step 16 Follow Step 7 through Step 14 to connect the EXP-TX connector of the second 32WSS card to the 
EXP-RX port of the first 32WSS card.

Step 17 Close the fold-down doors located at the bottom of both shelf assemblies and slide the fiber-storage tray 
back into its normal locked position.

Stop. You have completed this procedure.
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Chapter 14      Turn Up a Node
DLP-  G431 Install Fiber-Optic Cables from the 40-WXC-C, or 40-SMR2-C Cards in a Mesh Node to a Mesh Patch Panel 
NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection 
Modules

Note For more information about Y-cable protection, see Chapter 1, “Install the Cisco ONS 15454, ONS 
15454 M2, and ONS 15454 M6 Shelf” and Chapter 11, “Provision Transponder and Muxponder Cards”.

Note To use Y-cable protection for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, the cards must be 
provisioned in 10GE MXP, 20GE MXP, or 10GE TXP mode. (See the “DLP-G379 Change the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE Card Mode” task on page 11-170.) Y-cable protection cannot be 
used for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards that are provisioned in L2-over-DWDM 
mode. 

Step 1 As needed, complete the “DLP-G375 Install Fiber-Optic Cables on the Y-Cable Modules in the 
FlexLayer Shelf” task on page 14-107.

Step 2 As needed, complete the “DLP-G376 Install Fiber-Optic Cables on the Y-Cable Modules in the Y-Cable 
Module Tray” task on page 14-108.

Stop. You have completed this procedure.

Purpose This procedure installs and routes fiber-optic cables from the client signal 
to the Y-cable protection module (single mode or multimode), and from the 
Y-cable module to the transponder node. Using one Y-cable protection 
module, you can protect one client signal with two TXP, MXP, AR_MXP, 
AR_XP, AR_XPE, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
OTU2_XP cards, and two client signals with four TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP cards. You can use Y-cable 
protection modules that you have installed in a FleyLayer shelf, or Y-cable 
modules installed in a Y-cable module tray.

Tools/Equipment Fiber-optic cables

Cisco Transport Planner Internal Connections Report

Prerequisite Procedures See Cisco ONS 15454 Hardware Installation Guide:

• “DLP-G32 Install the Y-Cable Protection Modules in the FlexLayer 
Shelf”

• “DLP-G377 Install the Y-Cable Protection Modules in the Y-Cable 
Module Tray”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-  G375 Install Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer Shelf
DLP-G375 Install Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer 
Shelf

Step 1 Referring to the Cisco Transport Planner Internal Connections Report, install a fiber-optic cable between 
a TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, AR_MXP, AR_XP, or AR_XPE card and a 
Y-cable module.

If you want to protect one client signal, connect the fiber-optic cables according to either Table 14-7 or 
Table 14-8. To protect two client signals using a single Y-cable module, connect the cables according to 
both Table 14-7 and Table 14-8.

Purpose This task installs fiber-optic cables from the TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, 10GE_XPE, AR_MXP, AR_XP, or AR_XPE cards to 
the Y-cable modules installed in the FlexLayer shelves, and from the 
Y-cable modules to the client devices.

Tools/Equipment Fiber-optic cables

Cisco Transport Planner Internal Connections Report

Prerequisite Procedures “DLP-G32 Install the Y-Cable Protection Modules in the FlexLayer Shelf” 
in the Cisco ONS 15454 Hardware Installation Guide

NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 14-7 Cable Connections for Y-Cable Protection of One Client Signal

From To (Y-Cable Port Number)

Client 1 TX port 10

Client 1 RX port 5

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE 1 TX port 1

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE 1 RX port 2

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE 2TX port 6

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE2RX port 7

Table 14-8 Cable Connections for Y-Cable Protection of a Second Client Signal

From To (Y-Cable Port Number)

Client 2 TX port 12

Client 2 RX port 11

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE3 TX port 3

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE 3 RX port 4
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DLP-  G376 Install Fiber-Optic Cables on the Y-Cable Modules in the Y-Cable Module Tray
Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray as you 
install cables between the Y-cable module and the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE cards (Figure 14-9 on page 14-77). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3 Install a fiber-optic cable between the client device and the Y-cable module where you just installed a 
fiber-optic cable to the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card. 

Step 4 Repeat Steps 1 through 3 for each Y-cable module you need to use for Y-cable protection.

Step 5 Return to your originating procedure (NTP).

DLP-G376 Install Fiber-Optic Cables on the Y-Cable Modules in the Y-Cable 
Module Tray

Step 1 Open the drawer of the tray by pushing inward on the latches located at the left and right front of the tray.

Step 2 On each Y-cable module you will connect, use the tab to slide the module up so that it is fully extended 
and easily accessible in the tray.

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE 4 TX port 8

TXP/MXP/GE_XP/GE_XPE/10GE_XP/10GE_XPE 4 RX port 9

Purpose This task installs fiber-optic cables from the TXP, MXP, GE_XP, 
10GE_XP, GE_XPE, or 10GE_XPE cards to the Y-cable modules installed 
in the Y-cable module tray, and from the Y-cable modules to the client 
devices.

Tools/Equipment Fiber-optic cables (4-meter [13.12-foot]), single-mode or multimode as 
appropriate

Cisco Transport Planner Internal Connections Report

Prerequisite Procedures “DLP-G32 Install the Y-Cable Protection Modules in the FlexLayer Shelf” 
in the Cisco ONS 15454 Hardware Installation Guide

NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

Required/As Needed As needed

Onsite/Remote Onsite 

Security Level None

Table 14-8 Cable Connections for Y-Cable Protection of a Second Client Signal (continued)

From To (Y-Cable Port Number)
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Step 3 Referring to the Cisco Transport Planner Internal Connections Report, install a 4-meter (13.12-foot) 
fiber-optic cable (single-mode or multimode, as appropriate) between a TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, or 10GE_XPE card and the Y-cable module installed farthest to the left. Proceed according to 
the port label affixed to the front of the tray to identify the ports on each installed module (Figure 14-22). 

Figure 14-22 Y-Cable Protection Port Label

Note You can use the label shown in Figure 14-22 to take notes as to which wavelength/port you are 
connecting to each Y-cable module. “W” denotes the indicated Working port on the TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card. “P” denotes the indicated Protect port on the 
TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card. 

Note Protective covers are installed over the third and fourth ports on the Y-cable modules because 
they are not used.

As needed, route slack fiber-optic cable around the round cable retainers in theY-cable module tray as 
you install cables between the Y-cable module and the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE card (Figure 14-23). 

Client TX

Client RX

TXP W TX

TXP W RX TXP W RX TXP W RX TXP W RXTXP W RX TXP W RX TXP W RX TXP W RX

TXP P RX

TXP P TX TXP P TX TXP P TX TXP P TX TXP P TX TXP P TX TXP P TX TXP P TX

TXP P RX TXP P RX TXP P RX TXP P RX TXP P RX TXP P RX TXP P RX

TXP W TX TXP W TX TXP W TX TXP W TX TXP W TX TXP W TX TXP W TX

Client RX Client RX Client RX Client RX Client RX Client RX Client RX

Client TX Client TX Client TX Client TX Client TX Client TX Client TX

#1 #2 #3 #4 #5 #6 #7 #8
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Figure 14-23 Y-Cable Protection Module Tray

Caution When you close the Y-cable module tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the tray, make sure that adequate cable slack remains.

Step 4 Referring to the Cisco Transport Planner Internal Connections Report, install a fiber-optic cable of 
adequate length (single-mode or multimode, as appropriate) between the Y-cable module and the client 
signal that you want to protect. 

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in theY-cable module tray as 
you install cables between the Y-cable module and the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 
10GE_XPE card.

Step 6 Repeat Steps 2 through 5 for each Y-cable module you need to use for Y-cable protection.

Step 7 To close the tray, unlock the drawer from the open position by depressing the red lock at the back left of 
the tray and push the tray closed.

Step 8 Return to your originating procedure (NTP).

14
46
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NTP-G152 Create and Verify Internal Patchcords

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to provision the DWDM cable 
connections. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” procedure 
on page 14-48 to import the Cisco Transport Planner NE update file.

Step 3 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcords tabs.

Note The Internal Patchcords tab does not show OPT-PRE DCU connections or span connections.

Note The number of rows in the Provisioning > WDM-ANS > Internal Patchcords tab are created 
dynamically, as per the number of sides present in a node.

Note On the 15454-M2 and the 15454-M6 shelves, you can create internal patchcords between the 
TNC and TNCE cards and the optical amplifier cards.

Step 4 Verify that the connections in the Internal Patchcords tab match the connections in the Cisco Transport 
Planner Internal Connections Report for the DWDM cards (see the “DLP-G349 Use the Cisco Transport 
Planner Internal Connections Report” task on page 14-78). The Internal Patchcords tab will not show 
OPT-PRE DCU connections or span connections.

Step 5 Complete the “NTP-G242 Create an Internal Patchcord Manually” procedure on page 14-112 for any 
connections that require manual provisioning, for example, to create patchcords between TXP and MXP 
trunk ports and OCH filter ports. If you need to delete a connection, complete the “DLP-G355 Delete an 
Internal Patchcord” task on page 14-121.

Note Connections related to optical bypass circuits must be manually provisioned. 

Stop. You have completed this procedure.

Purpose This procedure imports the internal patchcords using the CTP XML file. 
Internal patchcords can also be manually provisioned.

Tools/Equipment • Cisco Transport Planner shelf layout

• Cisco Transport Planner Internal Connections Report

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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NTP-G242 Create an Internal Patchcord Manually

Note Use only one management interface to complete the creation of internal patchcords. For example, do not 
begin the internal patchcord creation using the TL1 interface or CTP XML file and end the internal 
patchcord creation using CTC.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 Choose one of the following link types for the internal patchcord:

• Trunk to Trunk (L2)—Creates a bidirectional patchcord between the trunk ports of GE_XP and 
10GE_XP cards. If you choose this option, complete “DLP-G354 Create an Internal Patchcord 
Manually Using the Trunk to Trunk (L2) Option” task on page 14-113.

• OCH-Trunk to OCH-Filter—Creates an internal patchcord between an optical channel trunk port on 
a TXP/MXP stage card (which includes TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, 
ADM-10G, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE or ITU-T 
line cards) and an optical channel filter port on an add/drop stage card (which includes 32MUX, 
40-MUX-C, 32WSS, 40-WSS-C/40-WSS-CE, 32DMX, 32DMX-O, 40DMX, 40-SMR1-C, or 
40-SMR2-C cards). 

You can use this option to also create an internal patchcord between an optical channel trunk port 
on a TXP/MXP stage card (which includes TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, 
ADM-10G, OTU2_XP, AR_MXP, AR_XP, AR_XPE or ITU-T line cards) and the COM port on a 
PSM card in channel protection configuration (where, PSM card is equipped between one 
TXP/MXP stage and two add/drop stages). In this case, the Internal Patchcord Creation wizard will 
prompt you to create patchcords between the working and protect ports on the PSM card and the 
ports on the two different add/drop stage cards (which includes 32MUX, 40-MUX-C, 32WSS, 
40-WSS-C/40-WSS-CE, 32DMX, 32DMX-O, 40DMX, 40-SMR1-C, 40-SMR2-C, or 80-WXC-C 
cards). If you choose this option, complete “DLP-G547 Create an Internal Patchcord Manually 
Using the OCH-Trunk to OCH-Filter Option” task on page 14-114.

• OCH-Filter to OCH-Filter—Creates an unidirectional or bidirectional internal patchcord between a 
MUX input port and a DMX output port. If you choose this option, complete “DLP-G548 Create an 
Internal Patchcord Manually Using the OCH-Filter to OCH-Filter Option” task on page 14-116.

• OTS to OTS—Creates a unidirectional or bidirectional internal patchcord between two optical 
transport section (OTS) ports, between two optical cards, between an optical card and a passive card, 
between two passive cards, or between the TNC or TNCE cards and an optical amplifier card. This 
option also includes OSC ports. If you choose this option, complete “DLP-G549 Create an Internal 
Patchcord Manually Using the OTS to OTS Option” task on page 14-118.

Purpose This procedure creates an internal patchcord manually.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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• Optical Path—Creates an internal patchcord between two optical cards, or between an optical card 
and a passive card. If you choose this option, complete “DLP-G531 Create an Internal Patchcord 
Manually Using the Optical Path Option” task on page 14-120. 

Note Manual creation of OTS/OCH to OTS/OCH internal patchcords is not required for standard 
DWDM nodes. However, manual creation might be required for non-standard nodes, for 
example, a hub node that has wavelength selective switches installed. In such cases, manual 
creation is recommended by Cisco Transport Planner.

Note To successfully create an internal patchcord between WSS/DMX channel port and TXP trunk 
port, choose the TXP as the source endpoint and WSS/DMX as the destination endpoint.

Stop. You have completed this procedure.

DLP-G354 Create an Internal Patchcord Manually Using the Trunk to Trunk (L2) 
Option

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 On the Internal Patchcord Type Selection page, choose the patchcord type as Trunk to Trunk (L2) and 
click Next.

Step 4 On the Internal Patchcord Origination page, provision the internal patchcord origination parameters:

• Slot—Choose the slot containing the card where the internal patchcord originates. 

• Tx Port—Choose the TX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 5 Click Next.

Step 6 In the Internal Patchcord Termination page, provision the internal patchcord termination parameters:

• Slot—Choose the slot containing the card where the internal patchcord terminates. 

• Port—Choose the RX port where the internal patchcord terminates. CTC automatically displays the 
list of ports that are available depending on the link type you choose.

Purpose This task creates a bidirectional internal patchcord between the trunk ports 
of two GE_XP or 10GE_XP cards.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 7 Click Next.

Step 8 Review the display-only information on the Internal Patchcord Origination Reverse page. This page 
shows the slot, and port that CTC will use for the opposite internal patchcord origination route.

Step 9 Click Next.

Step 10 Review the information displayed on the Internal Patchcord Termination Reverse page. This 
display-only page shows the slot, and port that CTC will use for the reverse internal patchcord 
termination route.

Step 11 Click Finish. The new internal patchcord appears in the Internal Patchcord table.

Step 12 Return to your originating procedure (NTP).

DLP-G547 Create an Internal Patchcord Manually Using the OCH-Trunk to 
OCH-Filter Option

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 On the Internal Patchcord Type Selection page, choose the patchcord type as OCH-Trunk to OCH-Filter 
option and click Next.

Step 4 On the Internal PatchcordOCH Attributes page, provision the following parameters:

• OCHNC Wavelength—Sets the OCHNC wavelength for the OCH trunk to OCH filter internal 
patchcord. Use the unnamed band selection box below to display C-band or L-band wavelengths in 
the OCHNC Wavelength field. Provision the OCHNC wavelength to the wavelength provisioned for 
the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE, ADM-10G, OTU2_XP, 100G-LC-C, 
10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE or ITU-T line card trunk port. 

• PSM Protection—Select this check box if you have provisioned a PSM card in channel protection 
configuration. 

• Colorless—Select this check box if you want to create a colorless patchcord. 

Step 5 Click Next.

Step 6 On the Internal Patchcord Origination page, provision the internal patchcord origination parameters:

• Slot—Choose the slot containing the card where the internal patchcord originates. 

• Tx Port—Choose the TX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Purpose This task creates a bidirectional internal patchcord between a TXP, MXP, 
or XP trunk and a DWDM add and drop channel port.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 7 In the Internal Patchcord Termination page, provision the internal patchcord termination parameters:

• Type—Choose the type of card (optical or passive card) where the internal patchcord terminates.

• Side—Choose the side where the internal patchcord terminates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord terminates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord terminates. This field is visible only if 
you have chosen the type as Passive Card.

• Rx Port—Choose the RX port where the internal patchcord terminates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 8 Click Next.

Step 9 In the Internal Patchcord Origination Reverse page, provision the internal patchcord parameters for the 
reverse internal patchcord origination route:

• Type—Choose the type of card (optical or passive card) where the internal patchcord originates.

• Side—Choose the side where the internal patchcord originates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord originates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord originates. This field is visible only if 
you have chosen the type as Passive Card.

Note Choose the same passive card that you chose in Step 7.

• Tx Port—Choose the TX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 10 Click Next.

Step 11 In the internal Patchcord Termination Reverse page, provision the internal patchcord parameters for the 
reverse internal patchcord termination route:

• Slot—Choose the slot containing the card where the internal patchcord originates. 

• Rx Port—Choose the RX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 12 Click Next.

Step 13 Click Finish. The new internal patchcord appears in the Internal Patchcord table.

Return to your originating procedure (NTP).
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DLP-G548 Create an Internal Patchcord Manually Using the OCH-Filter to 
OCH-Filter Option

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 On the Internal Patchcord Type Selection page, choose the patchcord type as OCH-Filter to OCH-Filter 
option and click Next.

Step 4 On the Internal Patchcord OCH Attributes page, provision the following parameters:

• OCHNC Wavelength—Sets the OCHNC wavelength for the OCH trunk to OCH filter internal 
patchcord. Use the unnamed band selection box below to display C-band or L-band wavelengths in 
the OCHNC Wavelength field. Provision the OCHNC wavelength to the wavelength provisioned for 
the TXP, MXP, GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE, ADM-10G, OTU2_XP, 100G-LC-C, 
10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE or ITU-T line card trunk port. 

• Bidirectional—If checked, creates a bidirectional internal patchcord.

• PSM Protection—Select this check box if you have provisioned a PSM card in channel protection 
configuration.

Step 5 Click Next.

Step 6 On the Internal Patchcord Origination page, provision the internal patchcord origination parameters:

• Type—Choose the type of card (optical or passive card) where the internal patchcord terminates.

• Side—Choose the side where the internal patchcord terminates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord terminates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord terminates. This field is visible only if 
you have chosen the type as Passive Card.

• Tx Port—Choose the TX port where the internal patchcord terminates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 7 In the Internal Patchcord Termination page, provision the internal patchcord termination parameters:

• Type—Choose the type of card (optical or passive card) where the internal patchcord terminates.

• Side—Choose the side where the internal patchcord terminates. This field is visible only if you have 
chosen the type as Optical Card.

Purpose This task creates a unidirectional or bidirectional internal patchcord 
between two DWDM add and drop channel ports.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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• Slot—Choose the slot containing the card where the internal patchcord terminates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord terminates. This field is visible only if 
you have chosen the type as Passive Card.

• Rx Port—Choose the RX port where the internal patchcord terminates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 8 If you did not choose bidirectional in Step 4, continue with Step 13. Otherwise, continue with the next 
step.

Step 9 Click Next.

Step 10 In the Internal Patchcord Origination Reverse page, provision the internal patchcord parameters for the 
reverse internal patchcord origination route:

• Type—Choose the type of card (optical or passive card) where the internal patchcord originates.

• Side—Choose the side where the internal patchcord originates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord originates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord originates. This field is visible only if 
you have chosen the type as Passive Card.

Note Choose the same passive card that you chose in Step 7.

• Tx Port—Choose the TX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 11 Click Next.

Step 12 In the internal Patchcord Termination Reverse page, provision the internal patchcord parameters for the 
reverse internal patchcord termination route:

• Type—Choose the type of card (optical or passive card) where the internal patchcord terminates.

• Side—Choose the side where the internal patchcord terminates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord terminates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord terminates. This field is visible only if 
you have chosen the type as Passive Card.

Note Choose the same passive card that you chose in Step 6.

• Rx Port—Choose the RX port where the internal patchcord terminates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 13 Click Finish. The new internal patchcord appears in the Internal Patchcord table.

Return to your originating procedure (NTP).
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DLP-G549 Create an Internal Patchcord Manually Using the OTS to OTS Option

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 On the Internal Patchcord Type Selection page, choose the patchcord type as OTS to OTS and click Next.

Step 4 On the Internal Patchcords OTS Attributes page, provision the following parameters: 

• Bidirectional—If checked, creates a bidirectional internal patchcord.

• MPO Connection—Creates all the patchcords between two MPO connectors. If this option is 
checked, the bidirectional option is disabled.

• Exclude Used Port—If checked, excludes the used ports for patchcord creation. If unchecked, more 
than one patchcord can be created starting from the same port.

• Grid Filter—Select the grid option from the drop-down list.

• Port Type—Select the port type from the drop-down list. The options are:

– OSC only—Cards with OSC ports and OSCM cards are available for patchcord creation. The 
MPO Connection and Exclude Used Ports checkboxes are disabled and the Bidirectional option 
is checked.

– DC only—Cards with DC ports and passive DCUs are available for patchcord creation. The 
MPO Connection and Exclude Used Ports checkboxes are disabled and the Bidirectional option 
is checked. Allows to create an internal patchcord between an optical card and a passive card.

Step 5 Click Next.

Step 6 On the Internal Patchcord Origination page, provision the internal patchcord origination parameters:

• Type—Choose the type of card (optical or passive card) where the internal patchcord originates.

• Slot—Choose the slot containing the card where the internal patchcord originates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord originates. This field is visible only if 
you have chosen the type as Passive Card.

• Tx Port—Choose the TX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

• MPO—Choose the port where the internal patchcord originates.CTC automatically displays the list 
of ports that are available depending on the link type you choose. This field is visible only if you 
have chosen MPO connection in Step 4.

Step 7 Click Next.

Purpose This task creates a unidirectional or bidirectional internal patchcord 
between two optical transport section (OTS) ports.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 8 In the Internal Patchcord Termination page, provision the internal patchcord termination parameters:

• Type—Choose the type of card (optical or passive card) where the internal patchcord terminates.

• Slot—Choose the slot containing the card where the internal patchcord terminates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord terminates. This field is visible only if 
you have chosen the type as Passive Card.

• Rx Port—Choose the RX port where the internal patchcord terminates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

• MPO—Choose the port where the internal patchcord originates.CTC automatically displays the list 
of ports that are available depending on the link type you choose. This field is visible only if you 
have chosen MPO connection in Step 4.

Step 9 If you did not choose bidirectional in Step 4, continue with Step 14. Otherwise, continue with the next 
step.

Step 10 Click Next.

Step 11 In the Internal Patchcord Origination Reverse page, provision the internal patchcord parameters for the 
reverse internal patchcord origination route:

• Type—Choose the type of card (optical or passive card) where the internal patchcord originates.

• Side—Choose the side where the internal patchcord originates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord originates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord originates. This field is visible only if 
you have chosen the type as Passive Card.

Note Choose the same passive card that you chose in Step 8.

• Tx Port—Choose the TX port where the internal patchcord originates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.

Step 12 Click Next.

Step 13 In the internal Patchcord Termination Reverse page, provision the internal patchcord parameters for the 
reverse internal patchcord termination route:

• Type—Choose the type of card (optical or passive card) where the internal patchcord terminates.

• Side—Choose the side where the internal patchcord terminates. This field is visible only if you have 
chosen the type as Optical Card.

• Slot—Choose the slot containing the card where the internal patchcord terminates. This field is 
visible only if you have chosen the type as Optical Card. 

• Unit—Choose the passive card where the internal patchcord terminates. This field is visible only if 
you have chosen the type as Passive Card.

Note Choose the same passive card that you chose in Step 6.

• Rx Port—Choose the RX port where the internal patchcord terminates. CTC automatically displays 
the list of ports that are available depending on the link type you choose.
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Step 14 Click Finish. The new internal patchcord appears in the Internal Patchcord table.

Return to your originating procedure (NTP).

DLP-G531 Create an Internal Patchcord Manually Using the Optical Path Option

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 On the Internal Patchcord Type Selection page, choose the patchcord type as Optical Path and click Next.

Step 4 On the Internal Patchcord Card List page, provision the following parameters:

• Card From Selection area:

– Type—Choose the type of card (optical or passive card) where the internal patchcord originates.

– Shelf—(Multishelf nodes only) Choose the shelf where the internal patchcord originates.

– Slot—Choose the slot containing the card where the internal patchcord originates.

• Card To Selection area:

– Type—Choose the type of card (optical or passive card) where the internal patchcord 
terminates.

– Shelf—(Multishelf nodes only) Choose the shelf where the internal patchcord terminates.

– Slot—Choose the slot containing the card where the internal patchcord terminates.

• Choose the required patchcord from the list that CTC generates.

Step 5 Click Next to continue creating internal patchcords between cards and repeat Step 4. In the Internal 
Patchcord Card List page that follows, CTC automatically populates the Card From Selection fields with 
the values you entered in the Card To Selection fields in the previous page.

Step 6 After creating all the internal patchcords between cards, click Finish. The new internal patchcords 
appear on the Internal Patchcord table.

Step 7 Return to your originating procedure (NTP).

Purpose This task creates an internal patchcord manually between two optical cards 
or between an optical card and a passive card.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G355 Delete an Internal Patchcord 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click the connection you want to delete.

Step 3 Click Delete, then click Yes.

Step 4 Return to your originating procedure (NTP).

NTP-G209 Create, Edit, and Delete Optical Sides

Note For any node type including mesh nodes, the association between the shelf, line card and side is reported 
in the left top window of CTC (Vital Status Pane) in the mode view.

Note For mesh nodes, the association between sides and the 40-WXC-C cards can be found in the 
Provisioning > WDM-ANS > Internal Patchcords screen. 
For example:
PP-MESH, LC (A): Shelf 1, Slot 3 (40 WXC), port EXP-TX
PP-MESH, MPO (A): Shelf 1, Slot 3 (40 WXC), port EXP-RX
The above rows indicate that the: 
WXC port located in Shelf 1, Slot 3 is connected to the LC connector A (Side A) on PP-MESH.
WXC port located in Shelf 1, Slot 3 is connected to the MPO connector A (Side A) on PP-MESH. 

Purpose This task deletes an internal patchcord.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This procedure allows you to create, edit, and delete optical sides on a 
DWDM node.

Tools/Equipment None

Prerequisite Procedures NTP-G143 Import the Cisco Transport Planner NE Update Configuration 
File, page 14-48

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to provision the optical side. If 
you are already logged in, continue with Step 2.

Step 2 As needed, complete the following tasks:

• Complete the “DLP-G491 Create an Optical Side” task on page 14-122.

• Complete the “DLP-G492 Edit an Optical Side” task on page 14-123.

• Complete the “DLP-G480 Delete an Optical Side” task on page 14-123.

Stop. You have completed this procedure.

DLP-G491 Create an Optical Side

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Optical Sides tabs.

Step 2 Click Create.

Step 3 In the Create Side dialog box, enter the following:

• Side ID—Choose a side ID (A, B,C, D, E, F, G, or H) from the drop-down list.

• Line In—Choose an RX port from the drop-down list.

• Line Out—Choose a TX port from the drop-down list.

Note For a terminal node equipped with a PSM card in line or multiplex section protection 
configuration, you can only choose the W-RX and W-TX ports while creating an optical side. 
After you create the working (w) optical side, the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
card automatically creates the protected (p) optical side involving the P-RX and P-TX ports of 
the PSM card. CTC refreshes the Optical Sides tab with both the working and protected optical 
sides.

Step 4 Return to your originating procedure (NTP).

Purpose This task creates an optical side. For more details on optical sides, refer to 
Chapter 12, “Node Reference.”.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
14-122
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G492 Edit an Optical Side
DLP-G492 Edit an Optical Side

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Optical Sides tabs.

Step 2 Click the optical side that you want to edit.

Step 3 Click Edit.

Step 4 In the Edit Side ID dialog box, choose a side ID (A, B,C, D, E, F, G, or H) from the drop-down list.

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

DLP-G480 Delete an Optical Side

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click Provisioning > 
WDM-ANS > Optical Sides tabs.

Step 2 Click the optical side that you want to delete.

Step 3 Click Delete.

Step 4 In the confirmation dialog box, click Yes to continue.

Step 5 Return to your originating procedure (NTP).

Purpose This task edits the side ID of an optical side.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task deletes an optical side.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
14-123
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G480 Delete an Optical Side
NTP-G38 Provision OSC Terminations

Note Before provisioning OSC terminations on TNC ports carrying Fast Ethernet (FE) payloads, ensure to set 
the ALS mode on these ports to Disabled.

Note This procedure automatically turns on any OPT-RAMP-C, OPT-RAMP-CE, or RAMAN-CTP cards 
installed in the DWDM ring.

Note The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes 
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication 
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Note In a pure ONS 15454 M6 network configuration, provision the OSC in GE or FE SFP mode. If an OC3 
OSC is mandatory, then the network must be timing-synchronized as SONET. Identify the master node 
and provide external timing signal to the BITS input pins of the master node and provision line timing 
to the remaining nodes in the network. 
In a mixed ONS 15454 and ONS 15454 M6 network configuration, provision the OSC only in OC3 SFP 
mode. Identify the master node and provide external timing signal to the BITS input pins of the master 
node and provision line timing to the remaining nodes in the network.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to provision the OSC 
terminations. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Comm Channels > OSC tabs.

Step 3 In the OSC Terminations area, click Create.

Step 4 In the Create OSC Terminations dialog box, choose the ports where you want to create the OSC 
termination. To select more than one port, press the Shift key (to select a range of ports) or the Ctrl key 
(to select multiple individual ports).

Purpose This procedure provisions the OSC terminations. The OSC provides a 
bidirectional channel that connects all nodes within a DWDM ring. The 
OSC carries a supervisory data channel and synchronizes clocking at 
network nodes. The OSC also carries a user data channel.

Tools/Equipment None

Prerequisite Procedures NTP-G143 Import the Cisco Transport Planner NE Update Configuration 
File, page 14-48

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
14-124
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G480 Delete an Optical Side
Note The number of OSC terminations that you create depends on the node type defined by 
Cisco Transport Planner. Terminal nodes require one OSC termination. Hub, OADM, and 
ROADM nodes require two OSC terminations.

Step 5 In the Layer 3 area, check the OSI box if the following conditions are met:

• The OSC termination is between the ONS 15454 and another ONS node.

• Third party NEs that use the OSI protocol stack are on the same network. 

If you checked OSI, complete the following steps. If not, continue with Step 6.

a. Click Next.

b. Provision the following fields:

• Router—Choose the OSI router.

• ESH—Set the ESH propagation frequency. End system NEs transmit ESHs to inform other ESs 
and ISs about the NSAPs they serve. The default is 10 seconds. The range is 10 to 1000 seconds.

• ISH—Sets the ISH PDU propagation frequency. Intermediate system NEs send ISHs to other 
ESs and ISs to inform them about the IS NETs it serves. The default is 10 seconds. The range 
is 10 to 1000 seconds.

• IIH—Sets the IIH PDU propagation frequency. The IS-IS Hello PDUs establish and maintain 
adjacencies between ISs. The default is 3 seconds. The range is 1 to 600 seconds.

• Metric—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the cost 
to calculate the shortest routing path. The default metric cost for LAN subnets is 20. It normally 
should not be changed.

Step 6 Click Finish. Ports are automatically placed in service. The following alarms might appear in the node 
view (single-shelf mode) or multishelf view (multishelf mode) Alarms tab Description field. They will 
remain until all the network OSC connections between the adjacent nodes are created:

• SDCC Termination Failure (ANSI) or RS-DCC Termination Failure (ETSI) on the OSCM or 
OSC-CSM card

• LOS on the OC-3 port (Port 1) on the OSCM, OSC-CSM, or OPT-BST card

• OPWR-LFAIL on the OPT-BST or OSC-CSM card

Note After the OSC termination is created, the line ports are placed in service and span power levels 
are checked.

Stop. You have completed this procedure.
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NTP-G37 Run Automatic Node Setup

Note ANS provisioning parameters must be calculated by Cisco Transport Planner. ANS provisioning 
parameters must be manually changed only by Cisco qualified personnel. Setting wrong ANS 
provisioning (either as preamplifier or booster input power thresholds) may impact traffic.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to run ANS. If you are already 
logged in, continue with Step 2.

Step 2 Referring to the Cisco Transport Planner Installation Parameters (see Table 14-1 on page 14-4), identify 
the parameters that have a Yes in the Manually Set column. If there are no parameters that have a Yes in 
the Manually Set column, continue with Step 6.

Step 3 In CTC, display the card where the parameter is to be manually provisioned in card view.

Step 4 Enter the specified Calibration parameter from the Cisco Transport Planner Installation Parameters 
table. Click Apply.

Step 5 Repeat Steps 2 through 4 for each parameter in the Cisco Transport Planner Installation Parameters table 
that displays Yes in the Manually Set field.

Step 6 Change to node view (single-shelf mode) or multishelf view (multishelf mode).

Step 7 Click the Provisioning > WDM-ANS > Port Status tabs. 

Step 8 Click Launch ANS. 

Step 9 In the Apply Launch ANS dialog box, click Yes. 

Step 10 In the Launch ANS confirmation dialog box, click OK. 

Step 11 Verify that one of the following status appears in the Result column for all the ports:

• Success - Changed—The parameter setpoint was recalculated successfully.

• Success - Unchanged—The parameter setpoint did not need recalculation.

• Not applicable—When ports are not in use.

Purpose This procedure runs the Launch ANS function. Launch ANS applies the 
ANS parameters (calculated in the “NTP-G143 Import the Cisco Transport 
Planner NE Update Configuration File” procedure on page 14-48) to the 
node and to the ports for cards installed in the node. The applied ANS 
parameters include span loss values, threshold values, power references, 
and others. Launch ANS also sets the VOA references based on the 
calculated power references.

Tools/Equipment The Cisco Transport Planner Installation Parameters file

Prerequisite Procedures NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

NTP-G30 Install the DWDM Cards, page 14-64

NTP-G152 Create and Verify Internal Patchcords, page 14-111

NTP-G143 Import the Cisco Transport Planner NE Update Configuration 
File, page 14-48

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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If one of the following statuses is shown, complete the provided instructions:

• Fail - Out of Range—The calculated setpoint is outside the expected range. If this status appears, do 
not continue until you have investigated and cleared the cause. This status might appear because of 
an error in the Cisco Transport Planner file. It could also appear because the insertion loss of the 
installed cards is greater than the estimated insertion loss calculated by Cisco Transport Planner. If 
so, the Cisco Transport Planner file will need to be recalculated. All of these possible causes should 
be investigated. Contact your next level of support if you are unable to clear this status.

• Fail - Missing Input Parameter—The parameter could not be calculated because the required 
provisioning data is unknown or unavailable. If this status appears, check if the correct Cisco 
Transport Planner file was imported.

• Unchanged - Port in IS—The parameter could not be calculated because the port is in service. This 
status should normally not appear at this point in node turn-up. If it does, display the card in card 
view, change the port administrative state to OOS,DSLB (ANSI) or Locked,disabled (ETSI), and 
repeat Steps 6 through 11. 

Note If the ports that are in service carry circuits, you must delete the circuits before you can place 
the ports out of service. See the “DLP-G347 Delete Optical Channel Client Connections” task 
on page 17-26, the “DLP-G418 Delete an Optical Channel Trail” task on page 17-37, or the 
“DLP-G106 Delete Optical Channel Network Connections” task on page 17-49.

Stop. You have completed this procedure.

NTP-G39 Verify OSCM Transmit Power

Note Throughout this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to verify the OSCM or OSC-CSM 
transmit power. If you are already logged in, continue with Step 2.

Step 2 Disable automatic laser shutdown (ALS) on Side A or (for terminal nodes) the terminal side OSCM or 
OSC-CSM card: 

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the Side A or 
terminal-side OSCM or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Disable. 

Purpose This procedure verifies that the transmit power for the ONS 15454 OSCM 
and the OSC-CSM cards is correct.

Tools/Equipment None

Prerequisite Procedures NTP-G37 Run Automatic Node Setup, page 14-126

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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d. Click Apply. Click Yes in the confirmation dialog box.

Step 3 If an OSC-CSM or OSCM card is installed on Side B, complete the following steps. If not, continue with 
Step 4.

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the Side B 
OSCM or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Disable. 

d. Click Apply. Click Yes in the confirmation dialog box.

Step 4 Complete the “DLP-G314 Verify OSCM Transmit Power” task on page 14-128.

Step 5 Change ALS to Auto Restart on the Side A or (for terminal nodes) the terminal side OSCM or OSC-CSM 
card: 

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the Side A or 
terminal-side OSCM or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Auto Restart. 

d. Click Apply. Click Yes in the confirmation dialog box.

Step 6 If an OSC-CSM or OSCM card is installed on Side B, complete the following steps. If not, you have 
completed this procedure.

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click Side B OSCM 
or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Auto Restart. 

d. Click Apply. Click Yes in the confirmation dialog box.

Stop. You have completed this procedure.

DLP-G314 Verify OSCM Transmit Power

Step 1 Display the OSCM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Record the Port 3 (OSC TX) Power value: _____.

Step 4 Change to node view (single-shelf mode) or multishelf view (multishelf mode), then click the 
Provisioning > WDM-ANS > Provisioning tabs.

Purpose This task verifies that the transmit power of the OSCM card is correct.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 5 Record the OSC Power value under the OSCM card in the tree view.

Step 6 If the power value recorded in Step 3 is not within the range of +/– 0.5 dBm recorded in Step 5, complete 
the following steps. Otherwise, continue with Step 7.

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI Off. If not, choose 
Off from the drop-down list. Click Apply, then click Yes.

b. Clean the optical connections.

c. Complete the following procedures:

• Delete the two OSC channels using the DLP-G186 Delete an OSC Termination.

• Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

• Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

d. Repeat Step 3 through Step 6. If the power level is still not within the specified range, contact your 
next level of support.

Step 7 Return to your originating procedure (NTP).

NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf 
Mode

Purpose This procedure upgrades nodes in single-shelf mode to multishelf mode.

Tools/Equipment The node you plan to use as the node controller must be equipped with 
optical units and cannot have a cross-connect card installed. Any nodes 
that you plan to add to the multishelf configuration as subtending shelves 
can be equipped with transponder and muxponder units. For more 
information on multishelf configurations, see Chapter 12, “Node 
Reference.”

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

One of the following procedures in the Cisco ONS 15454 Hardware 
Installation Guide:

• “NTP-G301 Connect the ONS 15454 Multishelf Node and Subtending 
Shelves to an MS-ISC-100T Card”, or

• “NTP-G302 Connect the ONS 15454 Multishelf Node and Subtending 
Shelves to a Catalyst 2950”

• “NTP-G308 Connect the ONS 15454 M6 Multishelf Node and the 
ONS 15454 M6 Subtending Shelves”

• “DLP-G682 Connect the ONS 15454 M6 as the Node Controller in a 
Mixed Multishelf Configuration”

Required/As Needed As needed

Onsite/Remote Onsite 

Security Level Superuser only
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Caution An optical shelf in a multishelf configuration must be provisioned as the node controller shelf and not a 
subtending shelf, otherwise traffic will be dropped. If no slots are available on an optical shelf to install 
the MS-ISC-100T cards needed for a node controller shelf, install and configure the Cisco Catalyst 2950. 
See the “NTP-G302 Connect the ONS 15454 Multishelf Node and Subtending Shelves to a Catalyst 
2950” procedure in the Cisco ONS 15454 Hardware Installation Guide.

Step 1 Complete the DLP-G46 Log into CTC task at the node that you want to configure as a multishelf node.

Step 2 If you want to configure a shelf as the node controller, continue with Step 3. If you want to configure a 
shelf as a subtending shelf, continue with Step 4. 

Step 3 To set up the login node as the node controller, complete the following steps:

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
General > Multishelf Config tabs.

b. Click Enable as Node Controller. 

c. From the LAN Config drop-down list, complete one of the following:

• Choose Ethernet Switch if MS-ISC-100T cards or the Catalyst 2950 switches are already 
installed and configured.

• Choose Stand-Alone if MS-ISC-100T cards are not installed yet but will be in the final layout 
or if this is a line amplifier or an OSC-only site. This option will allow a safe migration of the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE database when the multishelf configuration is 
complete. 

d. Click Apply.

e. In the confirmation dialog box, click Yes to allow the node to reboot. The CTC view changes to 
network view and the node icon changes to gray. Wait for the reboot to finish. (This might take 
several minutes.) 

f. After the node reboots, double-click the node. The multishelf view appears.

Note The shelf ID of the node controller is automatically assigned as 1.

Step 4 To add a node as a subtending shelf in the multishelf configuration, complete the following:

a. In multishelf view, right-click in the white space in the rack and choose Add Shelf.

b. Select the type of subtending shelf (ONS 15454 or ONS 15454 M6).

c. In the Shelf ID Selection dialog box, choose a shelf ID (from 2 to 50 if the controller card is TNC, 
TNCE, TSC, TSCE, or TCC3 card, from 2 to 12 if the controller card is TCC2P card) from the 
drop-down list.

d. Click OK. The shelf appears in the multishelf view.

e. Preprovision the new shelf so that it has the same provisioning as the actual shelf that you will add 
as the subtending shelf:

Caution If the subtending shelf is not preprovisioned, traffic will be lost.

• Cards, PPMs, administrative states, client and trunk port configuration—For more information 
on card and port settings, see Chapter 11, “Provision Transponder and Muxponder Cards.”
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• Timing—For more information, see the “NTP-G53 Set Up Timing” procedure.

• GCC—For more information, see the “DLP-G76 Provision DCC/GCC Terminations” task on 
page 17-87.

f. Disconnect the cross-over (CAT-5) LAN cable from the RJ-45 (LAN) port of the ONS 15454 
subtending shelf TCC2/TCC2P/TCC3 card in Slot 7 or Slot 11, or from the EMS port of ONS 15454 
M6 subtending shelf.

g. Connect your Windows PC or Solaris workstation NIC to the RJ-45 (LAN) port on the subtending 
shelf ONS 15454 TCC2/TCC2P/TCC3 card in Slot 7 or Slot 11, or to the EMS port of the ONS 
15454 M6 subtending shelf.

h. Complete the DLP-G46 Log into CTC task at the subtending shelf.

i. Click the Provisioning > General > Multishelf Config tabs.

j. Click Enable as Subtended Shelf. 

k. Select the appropriate subtending shelf (ONS 15454 or ONS 15454 M6).

l. From the Shelf ID drop-down list, choose the shelf ID that you created in Step c.

m. Click Apply. 

n. In the confirmation dialog box, click Yes to reboot the shelf. The CTC view changes to network view 
and the node icon changes to gray. Wait for the reboot to finish. (This might take several minutes.) 

o. Disconnect your Windows PC or Solaris workstation network interface card (NIC) from the RJ-45 
(LAN) port of the subtending shelf TCC2/TCC2P/TCC3 card in Slot 7 or Slot 11, or from the EMS 
port of the ONS 15454 M6 subtending shelf.

p. Reconnect the cross-over (CAT-5) LAN cable (disconnected in Step f) to the RJ-45 (LAN) port of 
the subtending shelf TCC2/TCC2P/TCC3 card in Slot 7 or Slot 11, or to the EMS port of the ONS 
15454 M6 subtending shelf.

Note The Ethernet cable must be connected to the subtended shelf 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card soon after this 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card completes its boot phase (when it 
becomes active and its peer TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card starts 
rebooting). Connecting it before the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card 
completes its boot phase is a risk in the conversion process. Connecting it long time after 
completion of the boot phase might affect traffic due to missing provisioning.

q. Repeat Steps a through p to set up additional subtending shelves.

Note Cisco Transport Manager (CTM) users can use the CTM NE Explorer to monitor and configure 
single-shelf and multishelf nodes. When the upgrade is complete, the original individual 
subtending shelves will remain the CTM network view and must be manually deleted. For 
detailed information, refer to the Cisco Transport Manager User Guide, Appendix B, “NE 
Explorer Information.”

Stop. You have completed this procedure.
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NTP-G332 Upgrade Nodes in Single-Shelf Mode to Multishelf 
Mode with TCC2P Cards as Subtending Shelf Controller

Caution An optical shelf in a multishelf configuration must be provisioned as the node controller shelf and not a 
subtending shelf, otherwise traffic will be dropped. If no slots are available on an optical shelf to install 
the MS-ISC-100T cards needed for a node controller shelf, install and configure the Cisco Catalyst 2950. 
See the “NTP-G302 Connect the ONS 15454 Multishelf Node and Subtending Shelves to a Catalyst 
2950” procedure in the Cisco ONS 15454 Hardware Installation Guide.

Step 1 Complete the DLP-G46 Log into CTC task at the node that you want to configure as a multishelf node.

Step 2 Complete the “NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode” task on 
page 14-129 to configure a single-shelf as a subtending shelf in the multishelf configuration.

Step 3 Connect the subtending shelf to the multishelf node controller. Complete the following tasks in the Cisco 
ONS 15454 Hardware Installation Guide as appropriate:

• NTP-G301 Connect the ONS 15454 Multishelf Node and Subtending Shelves to an MS-ISC-100T 
Card.

• NTP-G302 Connect the ONS 15454 Multishelf Node and Subtending Shelves to a Catalyst 2950.

• NTP-G308 Connect the ONS 15454 M6 Multishelf Node and the ONS 15454 M6 Subtending 
Shelves.

Purpose This procedure upgrades nodes in single-shelf mode to multishelf mode 
subtending shelf with ONS 15454 nodes with TCC2P cards in R9.60 or 
later releases.

Tools/Equipment The node you plan to use as the node controller must be equipped with 
optical units and cannot have a cross-connect card installed. Any nodes 
that you plan to add to the multishelf configuration as subtending shelves 
can be equipped with transponder and muxponder units. For more 
information on multishelf configurations, see Chapter 12, “Node 
Reference.”

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

One of the following procedures in the Cisco ONS 15454 Hardware 
Installation Guide:

• “NTP-G301 Connect the ONS 15454 Multishelf Node and Subtending 
Shelves to an MS-ISC-100T Card”, or

• “NTP-G302 Connect the ONS 15454 Multishelf Node and Subtending 
Shelves to a Catalyst 2950”

• “NTP-G308 Connect the ONS 15454 M6 Multishelf Node and the 
ONS 15454 M6 Subtending Shelves”

• “DLP-G682 Connect the ONS 15454 M6 as the Node Controller in a 
Mixed Multishelf Configuration”

Required/As Needed As needed

Onsite/Remote Onsite 

Security Level Superuser only
14-132
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html


 

Chapter 14      Turn Up a Node
DLP-  G730 Edit the Shelf ID of the Subtending Shelf in a Multishelf Configuration Using the LCD
• DLP-G682 Connect the ONS 15454 M6 as the Node Controller in a Mixed Multishelf 
Configuration.

Step 4 Complete the “DLP-G730 Edit the Shelf ID of the Subtending Shelf in a Multishelf Configuration Using 
the LCD” task on page 14-133 to change the Shelf ID of the subtended shelf in the range between 2 and 
50.

Caution The traffic is lost when you change the Shelf ID of the subtending shelf in a multishelf configuration.

Stop. You have completed this procedure.

DLP-G730 Edit the Shelf ID of the Subtending Shelf in a Multishelf Configuration 
Using the LCD

Caution The traffic is lost when you change the Shelf ID of the subtending shelf in a multishelf configuration.

Note The LCD reverts to normal display mode after 5 seconds of button inactivity.

Step 1 On the ONS 15454 front panel, repeatedly press the Slot button until SHELF appears on the first line of 
the LCD. You are in the Shelf menu.

Note In an ONS 15454 M6 shelf assembly, the LCD is a separate unit installed above the external connection 
unit (ECU); the Slot, Port, and Status buttons are present on the LCD unit.

Step 2 Repeatedly press the Port button until the “Controller Status = MS Configuration” appears on the LCD.

Step 3 Press the Status button to display the current multishelf configuration settings (Figure 14-24).

Purpose This task edits the Shelf ID of a subtending shelf using LCD on the fan try 
assembly. In an ONS 15454 M6 shelf assembly, the LCD panel is a 
separate unit installed above the external connection unit (ECU).

Tools/Equipment None

Prerequisite Procedures NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, 
page 14-129

Required/As Needed As needed.

Onsite/Remote Onsite

Security Level Superuser only
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Figure 14-24 Changing the Multishelf Configuration —ONS 15454 Shelf Assembly

Step 4 Push the Slot button to move to the ID field that you want to change. The selected digit flashes.

Tip The Slot, Status, and Port button positions correspond to the positions of the commands shown 
on the LCD. For example, in Figure 14-24, you press the Slot button to invoke the Next 
command and the Status button to invoke the Done command.

Step 5 Press the Port button to change the Shelf ID to the desired number.

Step 6 When the change is complete, press the Status button to return to the relevant Controller Status menu.

Step 7 Repeatedly press the Port button until the Shelf Save Configuration option appears (Figure 14-3).

Step 8 Press the Status button to choose the Save Configuration option.

A Save and REBOOT message appears (Figure 14-4).

Step 9 Press the Slot button to apply the new Shelf ID or press Port to cancel the configuration.

Step 10 Saving the new configuration causes the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards to reboot. 
During the reboot, a “TCC may Reset” message appears on the LCD. The LCD returns to the normal 
alternating display after both TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards finish rebooting.

Step 11 Return to your originating procedure (NTP).

NTP-G210 Provision Node for SNMPv3

Step 1 Complete the DLP-G46 Log into CTC task on the node on which you want to set up SNMPv3. If you 
are already logged in, go to Step 2.

Step 2 In node view, click the Provisioning > SNMP > SNMP V3 tabs.

Step 3 Complete the following tasks as required:

• DLP-G496 Create an SNMPv3 User, page 14-139

• DLP-G498 Create Group Access, page 14-140

FAN FAIL

Slot

33
40

21CRIT MAJ MIN

Status Port

MS =Y    ID=08    VLN=Y
<Next    Done    Mod>

Purpose This procedure provisions the node to allow SNMPv3 access.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if you want to implement SNMPv3 on your network.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note A group named default_group is defined in the initial configuration. The default group has read 
and notify access to the complete MIB tree.

• DLP-G497 Create MIB Views, page 14-140

Note A view named full_view is defined in the initial configuration. It includes the complete MIB tree 
supported on the node.

Stop. You have completed this procedure.

NTP-G211 Provision Node to Send SNMPv3 Traps

Step 1 Complete the DLP-G46 Log into CTC task on the node on which you want to set up SNMPv3. If you 
are already logged in, go to Step 2.

Step 2 In node view, click the Provisioning > SNMP > SNMP V3 tabs.

Step 3 Complete the following tasks as required:

• DLP-G496 Create an SNMPv3 User, page 14-139

• DLP-G498 Create Group Access, page 14-140

• DLP-G497 Create MIB Views, page 14-140

• DLP-G501 Create Notification Filters, page 14-143

• DLP-G499 Configure SNMPv3 Trap Destination, page 14-141. When you configure an SNMPv3 
trap destination, use the IP address of the NMS, and the port number on which the NMS is listening 
for traps.

Stop. You have completed this procedure.

Purpose This procedure provisions a node to send SNMP v3 traps. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if you want to implement SNMPv3 on your network.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G212 Manually Provision a GNE/ENE to Manage an ENE 
using SNMPv3

Step 1 Complete the DLP-G46 Log into CTC task on the node on which you want to set up SNMPv3. If you 
are already logged in, go to Step 2.

Step 2 Go to network view.

Step 3 Double-click the ENE.

Step 4 Click Provisioning > SNMP > SNMP V3 > General and note the context engine ID. The is required in 
Step 8.

Step 5 Double-click the GNE.

Step 6 Complete the “DLP-G496 Create an SNMPv3 User” task on page 14-139 to create an SNMPv3 user on 
the GNE.

Step 7 Complete the following tasks as needed on the ENE:

• DLP-G496 Create an SNMPv3 User, page 14-139

• DLP-G498 Create Group Access, page 14-140

• DLP-G497 Create MIB Views, page 14-140

Step 8 Complete the “DLP-G502 Manually Configure the SNMPv3 Proxy Forwarder Table” task on 
page 14-143. Use the from Step 4, the local user details created in Step 6, and the remote user created in 
Step 7. 

Stop. You have completed this procedure.

Purpose This procedure describes how to manually configure a GNE/ENE to allow 
the NMS to manage an ENE using SNMPv3. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if you want to implement SNMPv3 on your network.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G213 Automatically Provision a GNE to Manage an ENE 
using SNMPv3

Step 1 Complete the DLP-G46 Log into CTC task on the node on which you want to set up SNMPv3. If you 
are already logged in, go to Step 2.

Step 2 Go to network view.

Step 3 Double-click the GNE.

Step 4 Complete the “DLP-G496 Create an SNMPv3 User” task on page 14-139 to create an SNMPv3 user on 
the GNE.

Step 5 Complete the “DLP-G503 Automatically Configure the SNMPv3 Proxy Forwarder Table” task on 
page 14-144. Use the GNE user that you defined in Step 4 when you configure the Proxy Forwarder 
table.

Note When you use the automatic procedure, CTC automatically creates an ons_proxy user on the ENE, 
provides ENE user details for the proxy configuration, and provides the of the ENE.

Stop. You have completed this procedure.

NTP-G214 Manually Provision a GNE/ENE to Send SNMPv3 
Traps from an ENE using SNMPv3

Step 1 Complete the DLP-G46 Log into CTC task on the node on which you want to set up SNMPv3. If you 
are already logged in, go to Step 2.

Purpose This procedure describes how to automatically configure a GNE to allow 
an NMS to manage an ENE using SNMPv3. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if you want to implement SNMPv3 on your network.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure describes how to manually configure the GNE/ENE to 
allow an ENE to send SNMPv3 traps to the NMS. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if you want to implement SNMPv3 on your network.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Go to network view.

Step 3 Double-click the GNE.

Step 4 Complete the “DLP-G496 Create an SNMPv3 User” task on page 14-139 to create an SNMPv3 user on 
the GNE.

Step 5 On the GNE, complete the “DLP-G499 Configure SNMPv3 Trap Destination” task on page 14-141. The 
target IP address must be the IPv4 or IPv6 address of the NMS. For the UDP Port number, use the port 
number on which the NMS is listening for traps. Use the user name configured in Step 4. Also, specify 
a target tag name.

Step 6 Double-click the ENE.

Step 7 Complete the “DLP-G496 Create an SNMPv3 User” task on page 14-139 to create an SNMPv3 user on 
the ENE.

Step 8 Complete the following tasks as required:

• DLP-G498 Create Group Access, page 14-140 to create a group on the ENE

• DLP-G497 Create MIB Views, page 14-140 to create a MIB view on the ENE

• DLP-G501 Create Notification Filters, page 14-143

Step 9 On the ENE, complete the “DLP-G499 Configure SNMPv3 Trap Destination” task on page 14-141. The 
target IP address should be the IP address of the GNE. The UDP port number is 161. Use the user name 
configured in Step 7.

Step 10 From the network view, click the Provisioning > SNMPv3 tabs. 

Step 11 Complete the “DLP-G504 Manually Configure the SNMPv3 Proxy Trap Forwarder Table” task on 
page 14-145. 

The source of the trap must be the IP address of the ENE. For the field, provide the of the ENE. Also, 
you need to specify the target tag defined in Step 5, and the incoming user details configured in Step 7.

Stop. You have completed this procedure.

NTP-G215 Automatically Provision a GNE/ENE to Send SNMPv3 
Traps from an ENE Using SNMPv3

Step 1 Complete the DLP-G46 Log into CTC task on the node on which you want to set up SNMPv3. If you 
are already logged in, go to Step 2.

Step 2 Go to Network View.

Purpose This procedure describes how to automatically configure the GNE/ENE to 
allow an ENE to send SNMPv3 traps to the NMS.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 14-5

Required/As Needed Required if you want to implement SNMPv3 on your network.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
14-138
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G496 Create an SNMPv3 User
Step 3 Double-click the GNE.

Step 4 Complete the task “DLP-G496 Create an SNMPv3 User” task on page 14-139 to create an SNMPv3 user 
on the GNE.

Step 5 On the GNE, complete the following tasks:

• DLP-G499 Configure SNMPv3 Trap Destination, page 14-141. The target IP address must be the 
IPv4 or IPv6 address of the NMS. For the UDP Port number, use the port number on which the NMS 
is listening for traps. Also, specify a target tag name.

• DLP-G505 Automatically Configure the SNMPv3 Proxy Trap Forwarder Table, page 14-146. Use 
the target tag configured in Step 4. Use the IP address of the ENE as the source of trap. The 
following details are created automatically:

– A user named ons_trap_user on the ENE

– Trap destination on the ENE with an IP address of the GNE as the target IP and 161 as the UDP 
port number

– Remote user details of the ENE on the GNE

Stop. You have completed this procedure.

DLP-G496 Create an SNMPv3 User

Step 1 In node view, click the Provisioning > SNMP > SNMP V3 > User tabs.

Step 2 Click Create.

Step 3 In the Create User dialog box, enter the following information:

• User Name—Specify the name of the user on the host that connects to the agent. The user name must 
be a minimum of six and a maximum of 20 alphanumeric (a-z, A-Z, 0-9) characters. For TL1 
compatibility, the user name must be of 6 to 10 characters. 

• Group Name—Specify the group to which the user belongs. 

• Authentication

– Protocol—Select the authentication algorithm that you want to use. The options are NONE, 
MD5, and SHA. 

– Password—Enter a password if you select MD5 or SHA. By default, the password length is set 
to a minimum of eight characters. 

• Privacy—Initiates a privacy authentication level setting session that enables the host to encrypt the 
contents of the message that is sent to the agent.

– Protocol—Select NONE or DES as the privacy authentication algorithm. 

Purpose This procedure creates an SNMPv3 user.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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– Password—Enter a password if you select DES. 

Step 4 Click OK to save the information.

Step 5 Return to your originating procedure (NTP).

DLP-G497 Create MIB Views

Step 1 In node view, click the Provisioning > SNMP > SNMP V3 > MIB views tabs.

Step 2 Click Create.

Step 3 In the Create Views dialog box, enter the following information:

• Name—Name of the view.

• Subtree OID—The MIB subtree which, when combined with the mask, defines the family of 
subtrees.

• Bit Mask—A family of view subtrees. Each bit in the bit mask corresponds to a sub-identifier of the 
subtree OID.

• Type—Select the view type. Options are Include and Exclude. Type defines whether the family of 
subtrees that are defined by the subtree OID and the bit mask combination are included or excluded 
from the notification filter.

Step 4 Click OK to save the information.

Step 5 Return to your originating procedure (NTP).

DLP-G498 Create Group Access

Step 1 In node view, click the Provisioning > SNMP > SNMP V3 > Group Access tabs.

Purpose This procedure creates an SNMPv3 MIB view.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Purpose This procedure creates a user group and configures the access parameters 
for the users in the group.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 2 Click Create.

Step 3 In the Create Group Access dialog box, enter the following information:

• Group Name—The name of the SNMP group, or collection of users, who share a common access 
policy.

• Security Level—The security level for which the access parameters are defined. Select from the 
following options:

– noAuthNoPriv—Uses a user name match for authentication.

– AuthNoPriv—Provides authentication based on the HMAC-MD5 or HMAC-SHA algorithms. 

– AuthPriv—Provides authentication based on the HMAC-MD5 or HMAC-SHA algorithms. 
Provides DES 56-bit encryption based on the CBC-DES (DES-56) standard, in addition to 
authentication. 

If you select authNoPriv or authPriv for a group, the corresponding user must be configured with an 
authentication protocol and password, with privacy protocol and password, or both.

• Views

– Read View Name—Read view name for the group. 

– Notify View Name—Notify view name for the group.

• Allow SNMP Sets—Select this check box if you want the SNMP agent to accept SNMP SET 
requests. If this check box is not selected, SET requests are rejected. 

Note SNMP SET request access is implemented for very few objects.

Step 4 Click OK to save the information.

Step 5 Return to your originating procedure (NTP).

DLP-G499 Configure SNMPv3 Trap Destination

Step 1 In node view, click the Provisioning > SNMP > SNMP V3 > Trap Destinations (V3) tabs.

Step 2 Click Create.

Step 3 In the Configure SNMPv3 Trap dialog box, enter the following information:

• Target Address—Target to which the traps should be sent. Use an IPv4 or an IPv6 address.

• UDP Port—UDP port number that the host uses. Default value is 162.

• User Name—Specify the name of the user on the host that connects to the agent.

Purpose This procedure provisions SNMPv3 trap destination.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
14-141
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G500 Delete SNMPv3 Trap Destination
• Security Level—Select one of the following options:

– noAuthNoPriv—Uses a user name match for authentication.

– AuthNoPriv—Provides authentication based on the HMAC-MD5 or HMAC-SHA algorithms. 

– AuthPriv—Provides authentication based on the HMAC-MD5 or HMAC-SHA algorithms. 
Provides DES 56-bit encryption based on the CBC-DES (DES-56) standard, in addition to 
authentication. 

• Filter Profile—Select this check box and enter the filter profile name. Traps are sent only if you 
provide a filter profile name and create a notification filter. For more information, see “DLP-G501 
Create Notification Filters” task on page 14-143. 

• Proxy Traps Only—If selected, forwards only proxy traps from the ENE. Traps from this node are 
not sent to the trap destination identified by this entry.

• Proxy Tags—Specify a list of tags. The tag list is needed on a GNE only if an ENE needs to send 
traps to the trap destination identified by this entry, and wants to use the GNE as the proxy.

Step 4 Click OK to save the information.

Step 5 Return to your originating procedure (NTP).

DLP-G500 Delete SNMPv3 Trap Destination

Step 1 In node view, click the Provisioning > SNMP> SNMPv3 > Trap Destination tabs. 

Step 2 In the Trap Destinations area, select the trap you want to delete. 

Step 3 Click Delete. A confirmation dialog box appears. 

Step 4 Click Yes. 

Step 5 Return to your originating procedure (NTP). 

Purpose This procedure deletes an SNMPv3 trap destination.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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DLP-G501 Create Notification Filters

Step 1 In node view, click the Provisioning > SNMP > SNMP V3 > Notification Filters tabs.

Step 2 Click Create.

Step 3 In the Create Notify dialog box, enter the following information:

• Filter Profile Name—Specify a name for the filter.

• Subtree OID—The MIB subtree which, when combined with the mask, defines the family of 
subtrees.

• Bit Mask—A family of view subtrees. Each bit in the bit mask corresponds to a sub-identifier of the 
subtree OID.

• View Type—Select the view type. Options are Include and Exclude. Type defines whether the family 
of subtrees that are defined by the subtree OID and the bit mask combination are included or 
excluded from the notification filter.

Step 4 Click OK to save the information.

Step 5 Return to your originating procedure (NTP).

DLP-G502 Manually Configure the SNMPv3 Proxy Forwarder Table

Step 1 In network view, click Provisioning > SNMPv3.

Step 2 In the SNMPv3 Proxy Server area, complete the following:

• Select the GNE to be used as the SNMPv3 proxy server from the drop-down list. 

• Select the Enable IPv6 Target/Trap check box if the nodes and the NMS stations are on an IPv6 
network.

Step 3 In the SNMPv3 Proxy Forwarder Table area, click Manual Create.

Step 4 In the Manual Configuration of SNMPv3 Proxy Forwarder dialog box, enter the following information:

Purpose This procedure creates SNMPv3 notification filters.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Purpose This procedure creates an entry in the SNMPv3 Proxy Forwarder Table. 

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Target IP Address—Target to which the request should be forwarded. Use an IPv4 or an IPv6 
address.

• Context Engine ID—The context engine ID of the ENE to which the request is to be forwarded. The 
context engine ID should be the same as the context engine ID of the incoming request.

• Proxy Type—Type of SNMP request that needs to be forwarded. The options are Read and Write.

• Local User Details—The details of the local user who proxies on behalf of the ENE user.

– User Name—Specify the name of the user on the host that connects to the agent.

– Local Security Level—Select the security level of the incoming requests that are to be 
forwarded. The options are noAuthNoPriv, AuthNoPriv, and AuthPriv. 

• Remote User Details—User to which the request is forwarded.

– User Name—Specify the user name of the remote user.

– Remote Security Level—Select the security level of the outgoing requests. The options are 
noAuthNoPriv, AuthNoPriv, and AuthPriv.

• Authentication 

– Protocol—Select the authentication algorithm you want to use. The options are NONE, MD5, 
and SHA. 

– Password—Enter the password if you select MD5 or SHA. 

• Privacy—Enables the host to encrypt the contents of the message that is sent to the agent.

– Protocol—Select NONE or DES as the privacy authentication algorithm.

– Password—Enter the password if you select DES. The password should not exceed 64 
characters. 

Step 5 Click OK to save the information.

Step 6 Return to your originating procedure (NTP).

DLP-G503 Automatically Configure the SNMPv3 Proxy Forwarder Table

Step 1 In network view, click Provisioning > SNMPv3 tabs.

Step 2 In the SNMPv3 Proxy Server area, complete the following:

• Select the GNE to be used as the SNMPv3 proxy server from the drop-down list. 

• Select the Enable IPv6 Target/Trap check box if the nodes and the NMS stations are on an IPv6 
network.

Step 3 In the SNMPv3 Proxy Forwarder Table area, click Auto Create.

Purpose This procedure creates an entry in the SNMPv3 Proxy Forwarder Table. 

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
14-144
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G504 Manually Configure the SNMPv3 Proxy Trap Forwarder Table
Step 4 In the Automatic Configuration of SNMPv3 Proxy Forwarder dialog box, enter the following 
information:

• Proxy Type—Select the type of proxies to be forwarded. The options are Read and Write. 

• Security Level—Select the security level for the incoming requests that are to be forwarded. The 
options are:

– noAuthNoPriv—Uses a username match for authentication.

– AuthNoPriv—Provides authentication based on the HMAC-MD5 or HMAC-SHA algorithms. 

– AuthPriv—Provides authentication based on the HMAC-MD5 or HMAC-SHA algorithms. 
Provides DES 56-bit encryption based on the CBC-DES (DES-56) standard, in addition to 
authentication. 

• Target Address List—Select the proxy destination.

• Local User Name—Select the user name from the list of users. 

Note When you configure SNMPv3 Proxy Forwarder Table automatically, the default_group is used on the 
ENE. The default_group does not have write access. To enable write access and allow SNMP sets, you 
need to edit the default_group on ENE.

Step 5 Click OK to save the settings.

Step 6 Return to your originating procedure (NTP).

DLP-G504 Manually Configure the SNMPv3 Proxy Trap Forwarder Table

Step 1 In network view, click Provisioning > SNMPv3 tabs.

Step 2 In the SNMPv3 Proxy Server area, complete the following:

• Select the GNE to be used as the SNMPv3 proxy server from the drop-down list. 

• Select the Enable IPv6 Target/Trap check box if the nodes and the NMS stations are on an IPv6 
network.

Step 3 In the SNMPv3 Proxy Trap Forwarder Table area, click Manual Create.

Step 4 In the Manual Configuration of SNMPv3 Proxy Trap Forwarder dialog box, enter the following 
information:

• Remote Trap Source—Select the IP address from which the traps are sent. If the IP address is not 
listed, enter the IP address manually.

Purpose This procedure creates an entry in the SNMPv3 Proxy Trap Forwarder 
Table. 

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Context Engine ID—Specify the context engine ID of the ENE from which traps need to be 
forwarded. This field is automatically populated if the source of trap is selected. If the source of trap 
is not specified, you need to manually enter the context engine ID.

• Target Tag—Specify the tag name. The tag identifies the list of NMS that should receive the 
forwarded traps. Traps are forwarded to all GNE Trap destinations whose proxy tags list contains 
this tag.

• Remote User Details

– User Name—Specify the user name. 

– Security Level—Select the security level for the user. The options are noAuthNoPriv, 
AuthNoPriv, and AuthPriv.

• Authentication—Select the authentication algorithm. 

– Protocol—Select the authentication algorithm you want to use. The options are NONE, MD5, 
and SHA. Default is None.

– Password—Enter the password if you select MD5 or SHA. 

• Privacy—Enables the host to encrypt the contents of the message that is sent to the agent.

– Protocol—Select NONE or DES as the privacy authentication algorithm. Encryption is disabled 
if NONE is selected.

– Password—Enter the password if you select DES. The password should not exceed 64 
characters. 

Step 5 Click OK to save the information.

Step 6 Return to your originating procedure (NTP).

DLP-G505 Automatically Configure the SNMPv3 Proxy Trap Forwarder Table

Step 1 In network view, click Provisioning > SNMPv3 tabs.

Step 2 In the SNMPv3 Proxy Server area, complete the following:

• Select the GNE to be used as the SNMPv3 proxy server from the drop-down list. 

• Select the Enable IPv6 Target/Trap check box if the nodes and the NMS stations are on an IPv6 
network.

Step 3 In the SNMPv3 Proxy Trap Forwarder Table area, click Auto Create.

Step 4 In the Automatic Configuration of SNMPv3 Proxy Trap Forwarder dialog box, enter the following 
information:

Purpose This procedure creates an entry in the SNMPv3 Proxy Trap Forwarder 
Table automatically.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
14-146
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 14      Turn Up a Node
DLP-  G505 Automatically Configure the SNMPv3 Proxy Trap Forwarder Table
• Target Tag—Specify the tag name. The tag identifies the list of NMS that should receive the 
forwarded traps. All GNE Trap destinations that have this tag in their proxy tags list are chosen.

• Source of Trap—The list of ENEs whose traps are forwarded to the SNMPv3 Trap destinations that 
are identified by the Target Tag.

Step 5 Click OK to save the information.

Step 6 Return to your originating procedure (NTP).
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C H A P T E R 15

Perform Node Acceptance Tests

This chapter provides test procedures to verify that installed cards are operating correctly in a 
Cisco ONS 15454 dense wavelength division multiplexing (DWDM) node. The procedures are optional.

Note The procedures and tasks described in this chapter for the Cisco ONS 15454 platform is applicable to 
the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI (SONET) and ETSI (SDH) shelf 
assemblies.

Note This chapter does not test the transponder (TXP), muxponder (MXP), GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE, or ADM-10G card installation. Installation and verification for those cards is performed in 
Chapter 11, “Provision Transponder and Muxponder Cards.”

Before You Begin
This section lists the non-trouble procedures (NTPs) required to validate a DWDM node. Turn to a 
procedure for applicable detailed level procedures (DLPs).

1. NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 32DMX-O Cards Acceptance 
Test, page 15-3—Complete this procedure to test terminal and hub nodes with 32MUX-O and 
32DMX-O cards installed.

2. NTP-G168 Perform the Terminal or Hub Node with 40-MUX-C and 40-DMX-C Cards Acceptance 
Test, page 15-8—Complete this procedure to test terminal and hub nodes with 40-MUX-C and 
40-DMX-C cards installed. This procedure can also be performed for 40-MUX-C and 40-DMX-CE 
cards.

3. NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test, 
page 15-11—Complete this procedure to test terminal nodes with 32WSS and 32DMX cards 
installed.

4. NTP-G167 Perform the Terminal Node with 40-WSS-C and 40-DMX-C Cards Acceptance Test, 
page 15-16—Complete this procedure to test terminal nodes with 40-WSS-C and 40-DMX-C cards 
installed. This procedure can also be performed to test terminal nodes for 40-WSS-CE and 
40-DMX-CE cards
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5. NTP-G153 Perform the Terminal Node with 32WSS-L and 32DMX-L Cards Acceptance Test, 
page 15-21—Complete this procedure to test terminal nodes with 32WSS-L and 32DMX-L cards 
installed.

6. NTP-G43 Perform the ROADM Node with 32WSS and 32DMX Cards Acceptance Test, 
page 15-28—Complete this procedure to test reconfigurable optical add/drop multiplexing 
(ROADM) nodes with 32WSS and 32DMX cards installed.

7. NTP-G154 Perform the ROADM Node with 32WSS-L and 32DMX-L Cards Acceptance Test, 
page 15-40—Complete this procedure to test ROADM nodes with 32WSS-L and 32DMX-L cards 
installed.

8. NTP-G180 Perform the ROADM Node with 40-WSS-C and 40-DMX-C Cards Acceptance Test, 
page 15-63—Complete this procedure to test a ROADM node with 40-WSS-C and 40-DMX-C cards 
installed. This procedure can also be performed for 40-WSS-CE and 40-DMX-CE cards.

9. NTP-G276 Perform the 80-Channel n-degree ROADM Node Acceptance Tests, 
page 15-68—Complete this procedure to test a n- degree ROADM node with 80-WXC-C cards 
installed.

10. NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test, page 15-72—Complete this procedure 
to test anti-amplified spontaneous emission (anti-ASE) hub nodes.

11. NTP-G45 Perform the C-Band and L-Band Line Amplifier Node with OSCM Cards Acceptance 
Test, page 15-75—Complete this procedure to test C-band and L-Band line amplifier nodes with 
OSCM cards installed on both Side A and Side B of the shelf. 

12. NTP-G46 Perform the C-Band Line Amplifier Node with OSC-CSM Cards Acceptance Test, 
page 15-79—Complete this procedure to test C-band line amplifier nodes with OSC-CSM cards 
installed on both Side A and Side B of the shelf.

13. NTP-G156 Perform the L-Band Line Amplifier Node with OSC-CSM Cards Acceptance Test, 
page 15-83—Complete this procedure to test L-band line amplifier nodes with OSC-CSM cards 
installed on both Side A and Side B of the shelf.

14. NTP-G47 Perform the C-Band Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance 
Test, page 15-87—Complete this procedure to test C-band line amplifier nodes with OSCM and 
OSC-CSM cards installed.

15. NTP-G157 Perform the L-Band Line Amplifier Node with OSCM and OSC-CSM Cards Acceptance 
Test, page 15-91—Complete this procedure to test L-band line amplifier nodes with OSCM and 
OSC-CSM cards installed.

16. NTP-G48 Perform the OADM Node Acceptance Test on a Symmetric Node with OSCM Cards, 
page 15-95—Complete this procedure to test optical add/drop multiplexing (OADM) nodes with 
OSCM cards installed on both Side A and Side B of the shelf.

17. NTP-G49 Perform the Active OADM Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards, page 15-107—Complete this procedure to test OADM nodes with OSC-CSM and OPT-BST 
or OPT-BST-E cards installed on both Side A and Side B of the shelf.

18. NTP-G50 Perform the Passive OADM Node Acceptance Test on a Symmetric Node with OSC-CSM 
Cards, page 15-113—Complete this procedure to test OADM nodes with OSC-CSM cards installed 
on both Side A and Side B of the shelf and no OPT-BST or OPT-BST-E cards installed.

19. NTP-G186 Perform the Four-Degree and Eight-Degree Mesh Patch Panel Acceptance Test, 
page 15-115—Complete this procedure to test four-degree or eight-degree mesh nodes.

20. NTP-G187 Perform the Multiring Site Acceptance Test, page 15-127—Complete this procedure to 
test multiring sites.
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21. NTP-G188 Perform the Native Mesh Node Acceptance Test, page 15-135—Complete this 
procedure to test native mesh nodes.

22. NTP-G189 Perform the Node Upgrade Acceptance Test, page 15-140—Complete this procedure to 
test an upgraded node. The upgraded node connects an existing in-service ROADM node with two 
sides (each equipped with MMU cards) to a native mesh node with two sides.

23. NTP-G243 Perform the Two-Degree ROADM Node with 40-SMR-1-C and OPT-AMP-17-C Cards 
Acceptance Test, page 15-148—Complete this procedure to test ROADM nodes with 40-SMR-1-C 
and OPT-AMP-17-C cards installed.

24. NTP-G244 Perform the Four Degree ROADM Node with 40-SMR-2-C Cards Acceptance Test, 
page 15-152—Complete this procedure to test ROADM nodes with 40-SMR-2-C cards installed.

NTP-G41 Perform the Terminal or Hub Node with 32MUX-O and 
32DMX-O Cards Acceptance Test

Note Throughout this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Note This procedure tests Side A of hub nodes first, then Side B. If you are testing a terminal node, apply 
instructions for Side A of the hub node to the terminal side (Side B or Side A) of the terminal node.

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the hub or terminal node that you want to test. If you are 
already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Purpose This procedure tests a DWDM terminal or hub node with 32MUX-O and 
32DMX-O cards installed.

Tools/Equipment One of the following: 

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Note If optical service channel (OSC) terminations are created, there will be two alarms, one for 
low power on the OPT-BST or OPT-BST-E card and one for the OSC channel.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If a different status appears, complete the “NTP-G37 Run Automatic Node 
Setup” procedure on page 14-126. 

Step 5 Create a physical loopback on the Side A (or terminal) OSC-CSM, OPT-BST or OPT-BST-E amplifier 
by using a patchcord with 10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will appear due to the OSC signal 
loopback.

Step 6 Wait approximately two minutes, then verify that the OSC link is active on the Side A OSCM or 
OSC-CSM card by observing whether or not the LOS alarm on the OSCM or OSC-CSM (and the 
OPT-BST or OPT-BST-E card, if present) clears. (The OSC termination must already be provisioned. If 
not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.)

Note If the LOS alarm does not clear on the OSC-CSM card, verify that the opwrMin (dBm) Optic 
Thresholds setting for the OSC-RX port is not higher than the port's Optical Line power value. 
In the OSC-CSM card view, click the Provisioning > Optical Line > Optic Thresholds tabs 
and record the opwrMin (dBm) setting and compare it to the value found in the Power column 
for the OSC-RX port in the Provisioning > Optical Line > Parameters tabs. Reduce the Optic 
Thresholds setting for the opwrMin (dBm) value temporarily until the loopback test has been 
completed to clear the LOS alarm. Reset the Optic Thresholds setting to its original value after 
clearing the physical loopback.

Step 7 Set the tunable laser or the TXP_MR_10E_C card to the first wavelength of the 100-GHz ITU-T C-band 
grid (1530.33 nm). Refer to the tunable laser manufacturer’s documentation or the “DLP-G358 
Provision TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 8 Connect the tunable laser transmitter or TXP_MR_10E_C card DWDM TX port to the CHAN RX 01 
port on the Side A (or terminal) 32MUX-O card using the available patch panel. 

Step 9 Display the Side A (or terminal) 32MUX-O card in card view.

Step 10 Click the Provisioning > Optical Chn > Parameters tabs.

Step 11 Change the Port 1 administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 12 Verify that the Port 1 power level reaches the provisioned VOA Power Ref set point. 
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Note The tunable laser minimum optical output power (Pout) must be 6 dBm. If the output power is 
lower than the specified value, the 32MUX-O card might not reach the provisioned set point.

Step 13 If an OPT-BST, OPT-BST-E, or OPT-BST-L card is installed, complete the “DLP-G79 Verify the 
OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on page 15-5 on the Side A (or 
terminal) OPT-BST, OPT-BST-E, or OPT-BST-L to ensure that the amplifier is working properly. If an 
OSC-CSM card is installed, go to Step 15.

Step 14 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 on the 
Side A (or terminal) OPT-PRE card to ensure that the amplifier is working properly.

Step 15 Complete the “DLP-G78 Verify the 32MUX-O or 40-MUX-C Card Power” task on page 15-7 to verify 
that the 32MUX-O is powered correctly. 

Step 16 Complete the “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7 to verify 
that the 32DMX-O card is powered correctly.

Step 17 Restore the default IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state to the 
32MUX-O card port that was changed to OOS,MT (ANSI) or Locked,maintenance (ETSI) in Step 11.

Step 18 Repeat Steps 7 through 17 for the remaining 31 wavelengths of the 100-GHz grid to verify the correct 
behavior of all variable optical attenuators (VOAs) inside the 32MUX-O card.

Step 19 Remove the loopback created in Step 5.

Step 20 If the node is a hub node, repeat Steps 5 through 19 for the Side B cards. 

Step 21 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 22 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure.

DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and 
Power

Purpose This task verifies that the OPT-BST, OPT-BST-E, or OPT-BST-L amplifier 
laser is on and provisioned to the correct power.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 Complete the “DLP-G46 Log into CTC” task at the node that you want to test. If you are already logged 
in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier to display the card view. 

Step 3 Click the Maintenance > ALS tabs. If the value in the Currently Shutdown field is NO, continue with 
Step 4. If not, complete the following steps:

a. Check the optical safety remote interlock (OSRI) setting. If it is set to On, change it to Off. If the 
OSRI setting is set to Off and the Currently Shutdown field is Yes, contact your next level of support.

b. Click Apply, then click Yes.

c. Check the Currently Shutdown field. If it changes to NO, continue with Step 4. If not, contact your 
next level of support. The amplifier might need to be replaced.

Note The Currently Shutdown field will not change to NO until an active channel is flowing 
through the OPT-BST, OPT-BST-E, or OPT-BST-L amplifier.

Step 4 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 5 Click Reset.

Step 6 Scroll to the right and locate the Signal Output Power parameter for Port 6 (LINE-TX). Verify that the 
Signal Output Power value is greater than or equal to the Channel Power Ref.

If the Signal Output Power is not greater than or equal to 1.5 dBm, do not continue. Begin 
troubleshooting or contact your next level of support.

Step 7 Return to your originating procedure (NTP).

DLP-G80 Verify the OPT-PRE Amplifier Laser and Power

Step 1 In node view (single-shelf view) or shelf view (multishelf view), double-click the OPT-PRE amplifier to 
display the card view. 

Step 2 Click the Maintenance > ALS tabs.

Step 3 If the value shown in the Currently Shutdown field is NO, continue with Step 4. If not, complete the 
following steps:

a. Check the OSRI setting. If it is set to ON, click the table cell and chose OFF from the drop-down 
list. If the OSRI setting is set to OFF and the Currently Shutdown field is Yes, contact your next 
level of support.

Purpose This task verifies that the OPT-PRE amplifier laser is on and provisioned 
to the correct power.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-  G78 Verify the 32MUX-O or 40-MUX-C Card Power
b. Click Apply, then click Yes.

c. Check the Currently Shutdown field. If it changes to NO, continue with Step 4. If not, contact your 
next level of support. The amplifier might need to be replaced.

Step 4 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 5 Locate the Signal Output Power parameter for Port 2 (COM-TX). Verify that the Signal Output Power 
value is greater than or equal to the Channel Power Ref. If the Signal Output Power is greater than or 
equal to the Channel Power Ref, continue with Step 6. If the Signal Output Power is less than the 
Channel Power Ref, check your connections and clean the fibers using the “NTP-G115 Clean Fiber 
Connectors” procedure in the Cisco ONS 15454 Hardware Installation Guide. If this does not change 
the power value, consult your next level of support.

Step 6 Scroll to the right to locate the DCU Insertion Loss parameter. Verify that the DCU Insertion Loss value 
is less than or equal to 10 dB.

If the DCU Insertion Loss is greater than 10 dB, do not continue. Begin troubleshooting or contact your 
next level of support.

Step 7 Return to your originating procedure (NTP).

DLP-G78 Verify the 32MUX-O or 40-MUX-C Card Power

Step 1 Display the 32MUX-O or 40-MUX-C card in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the administrative state of the corresponding port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI).

Step 4 Click Apply, then click Yes.

Step 5 Check that the value in the Power column for the port reaches the value shown in the VOA Power Ref 
column.

Step 6 Return to your originating procedure (NTP).

DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power

Purpose This task verifies 32MUX-O or 40-MUX-C card power.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies that the 32DMX-O or 40-DMX-C card is provisioned to 
the correct power.

Tools/Equipment None
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Step 1 Display the 32DMX-O or 40-DMX-C card in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the administrative state for the appropriate port to OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI).

Step 4 Click Apply, then click Yes.

Step 5 Verify that the value in the Power table cell is the same as the VOA Power Ref table cell value for the 
port under test.

Step 6 Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the physical optical 
power value coming from drop Port 1 on the Side A 32DMX-O card is consistent with the value read 
(the maximum allowed error is +/– 0.5 dBm).

Step 7 Return to your originating procedure (NTP).

NTP-G168 Perform the Terminal or Hub Node with 40-MUX-C 
and 40-DMX-C Cards Acceptance Test

Note Throughout this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Note This procedure tests Side A of hub nodes first, then Side B. If you are testing a terminal node, apply 
instructions for Side A of the hub node to the terminal side (Side B or Side A) of the terminal node.

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This procedure tests a DWDM terminal or hub node with 40-MUX-C and 
40-DMX-C cards installed.

Tools/Equipment One of the following: 

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the hub or terminal node that you want to test. If you are 
already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Note If OSC terminations are created, there will be two alarms, one for low power on the 
OPT-BST or OPT-BST-E card, and the other an OSC channel alarm.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If a different status appears, complete the “NTP-G37 Run Automatic Node 
Setup” procedure on page 14-126. 

Step 5 Create a physical loopback on the Side A (or terminal) OPT-BST or OPT-BST-E amplifier by using a 
patchcord with 10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will appear due to the OSC signal 
loopback.

Step 6 Verify that the OSC link becomes active on the Side A OSCM or OSC-CSM card. (The OSC termination 
must already be provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure 
on page 14-124.)

Step 7 Set the tunable laser or the TXP_MR_10E_C card to the first wavelength of the 100-GHz ITU-T C-band 
grid (1530.33 nm). Refer to the tunable laser manufacturer’s documentation or the “DLP-G358 
Provision TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 8 Connect the tunable laser transmitter or TXP_MR_10E_C card DWDM TX port to the CHAN RX 01 
port on the Side A (or terminal) 40-MUX-C card using the available patch panel. 

Step 9 Display the Side A (or terminal) 40-MUX-C card in card view.

Step 10 Click the Provisioning > Optical Chn > Parameters tabs.

Step 11 Change the Port 1 administrative state to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 12 Verify that the Port 1 power level reaches the provisioned VOA Power Ref set point. 

Note The tunable laser minimum optical output power (Pout) must be 6 dBm. If the output power is 
lower than the specified value, the 40-MUX-C card might not reach the provisioned set point.
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Step 13 If an OPT-BST, OPT-BST-E, or OPT-BST-L card is installed, complete the “DLP-G79 Verify the 
OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on page 15-5 on the Side A (or 
terminal) OPT-BST, OPT-BST-E, or OPT-BST-L to ensure that the amplifier is working properly.

Step 14 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 on the 
Side A (or terminal) OPT-PRE card to ensure that the amplifier is working properly.

Step 15 Complete the “DLP-G78 Verify the 32MUX-O or 40-MUX-C Card Power” task on page 15-7 to verify 
that the 40-MUX-C card is powered correctly. 

Step 16 Complete the “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7 to verify 
that the 40-DMX-C card is powered correctly.

Step 17 Restore the default IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) administrative state to the 
40-MUX-C port that was changed to OOS,MT (ANSI) or Locked,maintenance (ETSI) in Step 11.

Step 18 Repeat Steps 7 through 17 for the remaining 31 wavelengths of the 100-GHz grid to verify the correct 
behavior of all variable optical attenuators (VOAs) inside the 40-MUX-C card.

Step 19 Remove the loopback created in Step 5.

Step 20 If the node is a hub node, repeat Steps 5 through 19 for the Side B cards. 

Step 21 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 22 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure.
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NTP-G42 Perform the Terminal Node with 32WSS and 32DMX 
Cards Acceptance Test

Note Throughout this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Note This procedure creates an optical loopback on the OPT-BST or OPT-BST-E line. An optical signal is sent 
from the 32WSS input (add) to the OPT-BST or OPT-BST-E common receive (RX) port and back out 
the OPT-BST or OPT-BST-E transmit (TX) line. The OPT-BST or OPT-BST-E line receives the looped 
signal from the OPT-BST or OPT-BST-E TX port. It then passes the signal to the OPT-BST or 
OPT-BST-E common TX port and into the OPT-PRE common RX line. The OPT-PRE sends the signal 
to the 32DMX card. The optical signal from the tunable laser or TXP_MR_10E_C card must pass 
successfully through the 32WSS card and out the 32DMX card.

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the terminal node that you want to test. If you are already 
logged in, continue with Step 2.

Step 2 Display the terminal node in node view (single-shelf mode) or multishelf view (multishelf mode).

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

Purpose This acceptance test verifies that a terminal node with 32WSS and 32DMX 
cards installed is operating properly before you connect it to the network. 
The test verifies the operation of the amplifiers and also verifies that each 
32WSS and 32DMX add/drop and pass-through port operates properly. 
The test also checks the power levels at each transmit and receive port to 
ensure that power loss in the cabling is within tolerance. If MMU cards are 
installed, the test verifies that the MMU insertion loss does not impact add, 
drop, or pass-through circuits.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

1 bulk attenuator (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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b. Verify that no equipment alarms (indicated by EQPT in the Cond column) appear indicating 
equipment failure or other hardware problems. If equipment failure alarms appear, investigate and 
resolve them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Note If OSC terminations are created, an OSC channel alarm will appear.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If a different status appears, or if errors (indicated in red) appear, delete the 
OSC channels and complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126. 
Provision the OSC channels when automatic node setup (ANS) is complete.

Step 5 Create a physical loopback on the OPT-BST, OPT-BST-E, or OSC-CSM card by using a patchcord with 
10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will appear due to the OSC signal 
loopback. This is observed as an alarm on Port 1 of the OSCM or OSC-CSM card.

Step 6 Wait approximately two minutes, then verify that the OSC link is active on the Side A OSCM or 
OSC-CSM card by observing whether or not the loss of signal (LOS) alarm on the OSCM or OSC-CSM 
(and the OPT-BST or OPT-BST-E card, if present) clears. (The OSC termination must already be 
provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.)

Note If the LOS alarm does not clear on the OSC-CSM card, verify that the opwrMin (dBm) Optic 
Thresholds setting for the OSC-RX port is not higher than the port's Optical Line power value. 
In the OSC-CSM card view, click the Provisioning > Optical Line > Optic Thresholds tabs 
and record the opwrMin (dBm) setting and compare it to the value found in the Power column 
for the OSC-RX port in the Provisioning > Optical Line > Parameters tabs. Reduce the Optic 
Thresholds setting for the opwrMin (dBm) value temporarily until the loopback test has been 
completed to clear the LOS alarm. Reset the Optic Thresholds setting to its original value after 
clearing the physical loopback.

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following 
substeps. If you are using a TXP_MR_10E_C card, continue with Step 8.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 9.

Step 8 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. Refer to Table 15-1 on page 15-42, if needed.

Step 9 Using the available patch panel, connect the tunable laser transmitter or the TXP_MR_10E_C card 
DWDM TX port to the CHAN RX 01 port on the 32WSS card. 

Note The tunable laser minimum Pout must be –6 dBm. If the output power is lower than –6 dBm, the 
32WSS card might not reach the provisioned set point.

Step 10 Display the 32WSS card in card view.
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Step 11 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-1 on page 15-42, if 
needed.

Step 12 Click the Admin State table cell for the add (CHAN-RX) port carrying the tested wavelength, then 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the 
tested wavelength is 1530.33 nm (shown as 1530.3), you would click the Port 1 (CHAN-RX) 
Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list. 

Step 13 Change the administrative state of the pass-through port corresponding to the port in Step 9 to OOS,MT 
(ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1530.33 nm (shown 
as 1530.3), you would click the Port 33 (PASS-THROUGH) Admin State field and choose OOS,MT or 
Locked,maintenance from the drop-down list. Refer to Table 15-1 on page 15-42, if needed. 

Step 14 Click Apply, then click Yes.

Step 15 Click the Maintenance tab.

Step 16 For Channel #1, change the Operating Mode to Add Drop.

Step 17 Click Apply, then click Yes.

Step 18 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelength under test.

Step 19 Verify that the actual power coming from the tunable laser or TXP_MR_10E_C card shown under the 
Power column is equal to the specified VOA Power Ref power (+/– 0.2 dB) shown in the same row.

Step 20 Click the Optical Line tab.

Step 21 Verify that the Port 83 (COM-TX) Power column value is the same as the VOA Power Ref set point in 
Step 19 (+/– 0.5 dB). This verifies that the optical signal is traveling correctly through the 32WSS card.

Step 22 If an OPT-BST or OPT-BST-E card is installed, complete the “DLP-G79 Verify the OPT-BST, 
OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on page 15-5 on the OPT-BST or 
OPT-BST-E to ensure that the amplifier is working properly.

Step 23 If an OSC-CSM is installed, continue with Step 25. If an OPT-BST is installed, verify the connection 
between Port 67 (COM-TX) on the 32WSS and Port 1 (COM-RX) on the OPT-BST or OPT-BST-E cards:

a. Display the 32WSS card in card view.

b. Click the Provisioning > Optical Line tabs.

c. Record the value in the Power table cell for Port 83 (COM-TX).

d. Display the OPT-BST or OPT-BST-E card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST or 
OPT-BST-E card and the 32WSS cards. Check the values again. If they still do not match, contact 
your next level of support.

Step 24 If an OPT-BST, OPT-BST-E, or OPT-BST-L card is installed on the Side A or terminal side, complete 
the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on 
page 15-5 to ensure that the amplifier is working properly.

Step 25 Complete the following steps to verify the connection between Port 67 (COM-TX) on the 32WSS and 
Port 2 (COM-RX) on the OSC-CSM card:

a. Display the 32WSS card in card view.

b. Click the Provisioning > Optical Line tabs.
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c. Record the value in Power table cell for Port 67 (COM-TX).

d. Display the OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 2 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OSC-CSM and 
32WSS cards. Check the values again. If they still do not match, contact your next level of support.

Step 26 Complete the following steps to verify the connection between Port 2 (COM-TX) on the OPT-PRE card 
and Port 33 (COM-RX) on the 32DMX card:

a. Display the OPT-PRE card in card view.

b. Click the Provisioning > OptAmpliLine > Parameters tabs.

c. Record the value in Power table cell for Port 2 (COM-TX).

d. Display the 32DMX card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 33 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-PRE and 
32DMX cards. Check the values again. If they still do not match, contact your next level of support.

Step 27 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 on the 
OPT-PRE to ensure that the amplifier is working properly.

Step 28 Complete the “DLP-G270 Verify the 32DMX or 40-DMX-C Power” task on page 15-15 to verify that 
the 32DMX card is powered correctly.

Step 29 Display the 32WSS in card view.

Step 30 Click the Maintenance tab.

Step 31 For the circuit (channel) under test, click the Operating Mode table cell and choose Not Assigned from 
the drop-down list.

Step 32 Click Apply, then Yes.

Step 33 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelength under test.

Step 34 Click the Admin State table cell. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) 
from the drop-down list for all ports that were changed to OOS,MT or Locked,maintenance.

Step 35 Click Apply, then Yes.

Step 36 Repeat Steps 7 through 35 for the remaining 31 wavelengths of the 100-Ghz grid to verify the correct 
behavior of all VOAs inside the 32WSS card.

Step 37 Disconnect the TXP card or tunable laser from the 32WSS card.

Step 38 Remove the loopback created in Step 5.

Step 39 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 40 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.
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b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure.

DLP-G270 Verify the 32DMX or 40-DMX-C Power

Step 1 Display the 32DMX or 40-DMX-C card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the administrative state for the COM TX (Port 33 for the 32DMX or Port 41 for the 40-DMX-C) 
to OOS,MT (ANSI) or Locked,maintenance (ETSI)

Step 4 Click Apply, then Yes.

Step 5 Verify that the value shown in the power column is equal to the specified VOA Power Ref column 
(+/- 0.2dB).

Step 6 (Optional) Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the 
physical optical power value coming from the 32DMX or 40-DMX-C drop Port 1 is consistent with the 
Power value on the Parameters tab, +/– 1.0 dBm.

Step 7 Change the administrative state for the COM TX port to IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI).

Step 8 Return to your originating procedure (NTP).

Purpose This task verifies that the 32DMX or 40-DMX-C card is provisioned to the 
correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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NTP-G167 Perform the Terminal Node with 40-WSS-C and 
40-DMX-C Cards Acceptance Test

Note Throughout this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Note This procedure creates an optical loopback on the OPT-BST or OPT-BST-E line. An optical signal is sent 
from the 40-WSS-C input (add) to the OPT-BST or OPT-BST-E common receive (RX) port and back out 
the OPT-BST or OPT-BST-E transmit (TX) line. The OPT-BST or OPT-BST-E line receives the looped 
signal from the OPT-BST or OPT-BST-E TX port. It then passes the signal to the OPT-BST or 
OPT-BST-E common TX port and into the OPT-PRE common RX line. The OPT-PRE sends the signal 
to the 40-DMX-C. The optical signal from the tunable laser or TXP_MR_10E_C must pass successfully 
through the 40-WSS-C and out the 40-DMX-C.

Note If the shelf is equipped with an OSC-CSM, this procedure creates an optical loopback on the OSC-CSM 
line. An optical signal is sent from the 40-WSS-C input (add) to the OSC-CSM common receive (RX) 
port and back out the OSC-CSM transmit (TX) line. The OSC-CSM line receives the looped signal from 
the OSC-CSM-TX port. It then passes the signal to the OSC-CSM common TX port and sends the signal 
to the 40DMX-C. The optical signal from the tunable lase or TXP_MR_!)E_C must pass successfully 
through the 40-WSS-C and out the 40DMX-C.

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Purpose This acceptance test verifies that a terminal node with 40-WSS-C and 
40-DMX-C cards installed is operating properly before you connect it to 
the network. The test verifies the operation of the amplifiers and also 
verifies that each 40-WSS-C and 40-DMX-C add/drop and pass-through 
port operates properly. The test also checks the power levels at each 
transmit and receive port to ensure that power loss in the cabling is within 
tolerance. If MMU cards are installed, the test verifies that the MMU 
insertion loss does not impact add, drop, or pass-through circuits.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

1 bulk attenuator (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Warning The OSC-RX port opwrMin (dBm) Optic Thresholds setting provisioned by CTP can be set too high and 
generate LOS and Power Fail alarms for this port while performing an optical loopback on the 
OSC-CSM card. CTP provisions the opwrMin (dBm) Optic Thresholds value higher than the power 
received during the loopback test, because CTP calculates the thresholds based on the incoming 
amplified signal from an adjacent node instead of a loopbacked signal from the OSC-CSM card. To 
clear the alarms, reduce the Optic Thresholds setting for the opwrMin (dBm) value temporarily until 
the loopback test has been completed. Reset the Optic Thresholds setting to its original value after 
clearing the physical loopback.

Step 1 Complete the DLP-G46 Log into CTC at the terminal node that you want to test. If you are already 
logged in, continue with Step 2.

Step 2 Display the terminal node in node view (single-shelf mode) or multishelf view (multishelf mode).

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms (indicated by EQPT in the Cond column) appear indicating 
equipment failure or other hardware problems. If equipment failure alarms appear, investigate and 
resolve them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Note The OSC terminations created during node turn-up will generate LOS alarms on the OPT-BST, 
OPT-BST-E, or OPT-AMP-17-C cards, and on the OSC-CSM and OSCM cards. If OSCM cards 
are installed in ANSI shelves, EOC SDCC Termination Failure alarms will appear.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If other statuses appear, or if errors (indicated in red) appear, delete the OSC 
channels and complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126. Provision 
the OSC channels when ANS is complete.

Step 5 If no OSC terminations are present, complete the “NTP-G38 Provision OSC Terminations” procedure 
on page 14-124.

Step 6 Create a physical loopback on the OPT-BST, OPT-BST-E, OPT-AMP-17, or OSC-CSM card by 
connecting a fiber optic jumper between the LINE TX and RX ports. For OPT-BST or OPT-BST-E cards, 
connect a 10 dB bulk attenuator to each end of the jumper. The OSC-CSM card does not require 
attenuation.

Note For ANSI shelves, an EOC SDCC Termination Failure alarm will appear due to the OSC signal 
loopback. This is observed as an alarm on Port 1 of the OSCM or OSC-CSM card.

Step 7 Provision OSC terminations. Complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 8 Wait approximately two minutes, then verify that the OSC link is active on the Side A OSCM or 
OSC-CSM card by observing whether or not the LOS alarm on the OSCM or OSC-CSM (and the 
OPT-BST or OPT-BST-E card, if present) clears. (The OSC termination must already be provisioned. If 
not, complete the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.)
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Note If the LOS alarm does not clear on the OSC-CSM card, verify that the opwrMin (dBm) Optic 
Thresholds setting for the OSC-RX port is not higher than the port's Optical Line power value. 
In the OSC-CSM card view, click the Provisioning > Optical Line > Optic Thresholds tabs 
and record the opwrMin (dBm) setting and compare it to the value found in the Power column 
for the OSC-RX port in the Provisioning > Optical Line > Parameters tabs. Reduce the Optic 
Thresholds setting for the opwrMin (dBm) value temporarily until the loopback test has been 
completed to clear the LOS alarm. Reset the Optic Thresholds setting to its original value after 
clearing the physical loopback.

Step 9 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following 
substeps. If you are using a TXP_MR_10E_C card, continue with Step 10.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 11.

Step 10 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. Refer to Table 15-1 on page 15-42, if needed.

Step 11 Using the available patch panel, connect the tunable laser transmitter or the TXP_MR_10E_C card 
DWDM TX port to the correct CHAN RX port on the 40-WSS-C card for the wavelength that you want 
to test. Refer to Table 4-1 on page 4-28, if needed. For example, if the tested wavelength is 1530.33 nm 
(shown as 1530.3), then connect the TXP_MR_10E_C card DWDM TX port to the Optical Connector 
1, CHAN RX 01 port on the 40-WSS-C card. 

Note The tunable laser minimum Pout must be –6 dBm. If the output power is lower than –6 dBm, the 
40-WSS-C card might not reach the provisioned set point.

Step 12 Display the 40-WSS-C card in card view.

Step 13 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-1 on page 15-42, if 
needed.

Step 14 Click the Admin State table cell for the add (CHAN-RX) port carrying the tested wavelength, then 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the 
tested wavelength is 1530.33 nm (shown as 1530.3), you would click the Port 1 (CHAN-RX) 
Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list. 

Step 15 Change the administrative state of the pass-through port corresponding to the port in Step 11 to 
OOS,MT (ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1530.33 nm 
(shown as 1530.3), you would click the Port 41 (PASS-THROUGH) Admin State field and choose 
OOS,MT or Locked,maintenance from the drop-down list. Refer to Table 15-1 on page 15-42, if needed. 

Step 16 Click Apply, then click Yes.

Step 17 Click the Maintenance tab.

Step 18 For Channel #1, change Operating Mode to Add Drop.

Step 19 Click Apply, then click Yes.

Step 20 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelength under test.

Step 21 Verify that the actual power coming from the tunable laser or TXP_MR_10E_C card shown under the 
Power column is equal to the specified VOA Power Ref power (+/– 0.2 dB) shown in the same row.
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Step 22 Click the Optical Line tab.

Step 23 Verify that the Port 83 (COM-TX) Power column value is the same as the VOA Power Ref set point in 
Step 21 (+/– 0.5 dB). This verifies that the optical signal is traveling correctly through the 40-WSS-C 
card.

Step 24 If an OPT-BST, OPT-BST-E, or OPT-BST-L card is installed, complete the “DLP-G79 Verify the 
OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on page 15-5 on the OPT-BST 
or OPT-BST-E to ensure that the amplifier is working properly. If an OSC-CSM is installed, complete 
the “DLP-G84 Verify the OSC-CSM Incoming Power” task on page 15-104.

Step 25 If an OSC-CSM is installed, continue with Step 27. If an OPT-BST is installed, verify the connection 
between Port 83 (COM-TX) on the 40-WSS-C and Port 1 (COM-RX) on the OPT-BST or OPT-BST-E 
cards:

a. Display the 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line tabs.

c. Record the value in the Power column for Port 83 (COM-TX).

d. Display the OPT-BST or OPT-BST-E card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power column for Port 1 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST or 
OPT-BST-E card and the 40-WSS-C cards. Check the values again. If they still do not match, contact 
your next level of support.

Step 26 If an OPT-BST, OPT-BST-E, or OPT-BST-L card is installed on the Side A or terminal side, complete 
the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on 
page 15-5 to ensure that the amplifier is working properly. Continue with Step 29.

Step 27 Complete the following steps to verify the connection between Port 83 (COM-TX) on the 40-WSS-C and 
the Port 2 (COM-RX) on the OSC-CSM card:

a. Display the 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line tabs.

c. Record the value in Power table cell for Port 83 (COM-TX).

d. Display the OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 2 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OSC-CSM and 
40-WSS-C cards. Check the values again. If they still do not match, contact your next level of 
support.

Step 28 Complete the following steps to verify the connection between Port 2 (COM-TX) on the OPT-PRE card 
and Port 41 (COM-RX) on the 40-DMX-C card:

a. Display the OPT-PRE card in card view.

b. Click the Provisioning > OptAmpliLine > Parameters tabs.

c. Record the total output power in Power column for Port 2 (COM-TX).

d. Display the 40-DMX-C card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.
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f. Verify that the value in the Power column for Port 41 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-PRE and 
40-DMX-C cards. Check the values again. If they still do not match, contact your next level of 
support.

Step 29 If an OPT-PRE card is installed on the Side A or terminal side, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 15-6 on the OPT-PRE card to ensure that the 
amplifier is working properly. If OSC-CSM cards are installed, complete the “DLP-G84 Verify the 
OSC-CSM Incoming Power” task on page 15-104.

Step 30 Complete the “DLP-G270 Verify the 32DMX or 40-DMX-C Power” task on page 15-15 to verify that 
the 40-DMX-C card is powered correctly.

Step 31 Display the 40-WSS-C card in card view.

Step 32 Click the Maintenance tab.

Step 33 For the circuit (channel) under test, click the Operating Mode table cell and choose Not Assigned from 
the drop-down list.

Step 34 Click Apply, then Yes.

Step 35 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelength under test.

Step 36 Click the Admin State table cell. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) 
from the drop-down list for all ports that were changed to OOS,MT or Locked,maintenance in Steps 13 
and 14 of this procedure. For example, if the tested wavelength is 1430-33 nm (shown as 1530.3), you 
would click the Admin State field and choose IS,ANSI (ANSI) or Unlocked,AutomaticInService (ETSI) 
from the drop-down list for both Port 1 (CHAN-RX) and Port 41 (PASS-THROUGH).

Step 37 Repeat Steps 9 through 36 for the remaining 39 wavelengths of the 100-Ghz grid to verify the correct 
behavior of all VOAs inside the 40-WSS-C card.

Step 38 Disconnect the TXP card or tunable laser from the 40-WSS-C card.

Step 39 Remove the loopback created in Step 6.

Step 40 Complete the“NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 41 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure.
15-20
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html#task_4B9E3FA74B7D4D759A8BB5CED1311F46


 

Chapter 15      Perform Node Acceptance Tests
DLP-  G270 Verify the 32DMX or 40-DMX-C Power
NTP-G153 Perform the Terminal Node with 32WSS-L and 
32DMX-L Cards Acceptance Test

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Note This procedure creates an optical loopback on the OPT-BST-L line. An optical signal is sent from the 
32WSS-L input (add) to the OPT-BST-L common RX port and back out the OPT-BST-L TX line. The 
OPT-BST-L line receives the looped signal from the OPT-BST-L TX port. It then passes the signal to the 
OPT-BST-L common TX port and into the OPT-AMP-L (when provisioned in OPT-PRE mode) common 
RX port. The OPT-AMP-L card sends the signal to the 32DMX-L card. The optical signal from the 
tunable laser or TXP_MR_10E_L card must pass successfully through the 32WSS-L card and out the 
32DMX-L card.

Step 1 Complete the “DLP-G46 Log into CTC” task at the hub or terminal node that you want to test. If you are 
already logged in, continue with Step 2.

Step 2 Display the terminal node in node view (single-shelf mode) or multishelf view (multishelf mode).

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Purpose This acceptance test verifies that a terminal node provisioned for L-band 
wavelengths is operating properly before you connect it to the network. 
The test verifies the operation of the amplifiers and also verifies that each 
add/drop and pass-through port on the 32WSS-L and 32DMX-L cards 
operates properly. The test also checks the power levels at each transmit 
and receive port to ensure that power loss in the cabling is within tolerance. 
If MMU cards are installed, the test verifies that the MMU insertion loss 
does not impact add, drop, or pass-through circuits. 

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_L

An optical power meter or optical spectrum analyzer

1 bulk attenuator (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note If OSC terminations are created, an OSC channel alarm will appear.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - 
Changed, or Success - Unchanged. If a different status appears, or if errors (indicated in red) appear, 
delete the OSC channels and complete the “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. Provision the OSC channels when ANS is complete.

Step 5 Create a physical loopback on the OPT-BST-L, OCSM, or OSC-CSM card by using a patchcord with 
10-dB bulk attenuators to connect the LINE TX port to the LINE RX port.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will appear due to the OSC signal 
loopback. This is observed as an alarm on Port 1 of the OSCM or OSC-CSM card.

Step 6 Wait approximately two minutes, then verify that the OSC link is active on the Side A OSCM or 
OSC-CSM card by observing whether or not the LOS alarm on the OSCM or OSC-CSM card (and the 
OPT-BST-L card, if present) clears. (The OSC termination must already be provisioned. If not, complete 
the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.)

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following 
substeps. If you are using a TXP_MR_10E_L card, continue with Step 8.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 9.

Step 8 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. 

Step 9 Using the available patch panel, connect the tunable laser transmitter or the TXP_MR_10E_L card 
DWDM TX port to the CHAN RX 01 port on the 32WSS-L card. 

Note The tunable laser minimum Pout must be –6 dBm. If the output power is lower than –6 dBm, the 
32WSS-L card might not reach the provisioned set point.

Step 10 Display the 32WSS-L card in card view.

Step 11 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-1 on page 15-42, if 
needed.

Step 12 Click the Admin State table cell for the add (CHAN-RX) port carrying the tested wavelength, then 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the 
tested wavelength is 1577.86 nm (shown as 1577.8), you would click the Port 1 (CHAN-RX) 
Admin State field and choose OOS,MT or Locked,maintenance from the drop-down list. 

Step 13 Change the administrative state of the pass-through port corresponding to the port in Step 9 to OOS,MT 
(ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1577.86 nm (shown 
as 1577.86), you would click the Port 33 (PASS-THROUGH) Admin State field and choose OOS,MT or 
Locked,maintenance from the drop-down list. Refer to Table 15-1 on page 15-42, if needed. 

Step 14 Click Apply, then click Yes.

Step 15 Click the Maintenance tab.
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Step 16 For channel under test, change Operating Mode to Add Drop.

Step 17 Click Apply, then click Yes.

Step 18 Click the Provisioning > Optical Chn > Parameters n tabs where n = the optical connector number that 
carries the wavelength under test.

Step 19 Verify that the actual power coming from the tunable laser or TXP_MR_10E_L card shown under the 
Power column is equal to the specified VOA Power Ref power (+/– 0.2 dB) shown in the same row.

Step 20 Click the Optical Line tab.

Step 21 Verify that the Port 67 (TX COM) has the same Power column value as the VOA Power Ref set point 
(+/– 0.5 dB) in Step 19. This verifies that the optical signal is traveling correctly through the 32WSS-L 
card.

Step 22 If an OPT-BST-L card is installed, complete the “DLP-G359 Verify the OPT-BST-L or OPT-AMP-L 
(OPT-Line Mode) Amplifier Laser and Power” task on page 15-26 on the OPT-BST-L card to ensure that 
the amplifier is working properly.

Step 23 If an OSC-CSM is installed, continue with Step 24. If an OPT-BST-L card is installed, verify the 
connection between Port 67 (COM-TX) on the 32WSS-L and Port 1 (COM-RX) on the OPT-BST-L 
cards:

a. Display the 32WSS-L card in card view.

b. Click the Provisioning > Optical Line tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. Display the OPT-BST-L card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST-L and 
32WSS-L cards. Check the values again. If they still do not match, contact your next level of 
support.

Step 24 If an OPT-BST-L card is installed on the Side A or terminal side, complete the “DLP-G79 Verify the 
OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on page 15-5 to ensure the 
amplifier is working properly.

Step 25 Complete the following steps to verify the connection between Port 67 (COM-TX) on the 32WSS-L and 
the Port 2 (COM-RX) on the OSC-CSM card:

a. Display the 32WSS-L card in card view.

b. Click the Provisioning > Optical Line tabs.

c. Record the value in Power table cell for Port 67 (COM-TX).

d. Display the OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 2 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OSC-CSM and 
32WSS-L cards. Check the values again. If they still do not match, contact your next level of 
support.
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Step 26 Complete the following steps to verify the connection between Port 2 (COM-TX) on the OPT-AMP-L 
card provisioned in OPT-PRE mode and Port 33 (COM-RX) on the 32DMX-L card:

a. Display the OPT-AMP-L card in card view.

b. Click the Provisioning > OptAmpliLine > Parameters tabs.

c. Record the value in Power table cell for Port 2 (COM-TX).

d. Display the 32DMX-L card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 33 (COM-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-AMP-L and 
32DMX-L cards. Check the values again. If they still do not match, contact your next level of 
support.

Step 27 Complete the “DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task 
on page 15-26 on the OPT-PRE card to ensure that the amplifier is working properly.

Step 28 Complete the “DLP-G361 Verify the 32DMX-L Power” task on page 15-27 to verify that the 32DMX 
card is powered correctly.

Step 29 Display the 32WSS-L in card view.

Step 30 Click the Maintenance tab.

Step 31 For the circuit (channel) under test, click the Operating Mode table cell and choose Not Assigned from 
the drop-down list.

Step 32 Click Apply, then Yes.

Step 33 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelength under test.

Step 34 Click the Admin State table cell. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) 
from the drop-down list for all ports that were changed to OOS,MT or Locked,maintenance.

Step 35 Repeat Steps 7 through 34 for the remaining wavelengths of the 100-Ghz grid to verify the correct 
behavior of all VOAs inside the 32WSS-L card.

Step 36 Disconnect the TXP card or tunable laser from the 32WSS-L card.

Step 37 Remove the loopback created in Step 5.

Step 38 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 39 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure.
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DLP-G358 Provision TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance 
Testing

Step 1 If you have installed and verified the TXP_MR_10E_L or TXP_MR_10E_C card, continue with Step 2. 
If you have not installed it, install the cards using the “NTP-G179 Install the TXP, MXP, AR_MXP, 
AR_XP, AR_XPE, 100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards” procedure on 
page 14-69. 

Step 2 In Cisco Transport Controller (CTC), display the TXP_MR_10E_L or TXP_MR_10E_C card in card 
view.

Step 3 Click the Provisioning > Line > Service-Type tabs.

Step 4 Click the Admin State table cell for the trunk port and choose OOS,DSBLD (ANSI) or 
Locked,disabled (ETSI) from the drop-down list.

Step 5 Click Apply, then click Yes.

Step 6 Click the Provisioning > Card tabs.

Step 7 In the Wavelength field, choose the first wavelength required by the acceptance test.

Step 8 Click Apply.

Step 9 Click the Provisioning > Line > Service-Type tabs.

Step 10 Click the Admin State table cell for the trunk port and choose OOS,MT (ANSI) or 
Locked,maintenance (ETSI) from the drop-down list.

Step 11 Click Apply, then click Yes.

Step 12 Connect a power meter to the DWDM TX port. Verify that the output power falls within –4.5 dBm and 
1.0 dBm. If it does not fall within this range, replace the card or contact your next level of support.

Step 13 Return to your originating procedure (NTP).

Purpose This procedure provisions a TXP_MR_10E_L and TXP_MR_10E_C cards 
for acceptance testing when a tunable laser is not available.

Tools/Equipment TXP_MR_10E_L and TXP_MR_10E_C

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, 
page 14-75

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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DLP-G359 Verify the OPT-BST-L or OPT-AMP-L (OPT-Line Mode) Amplifier 
Laser and Power

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-BST-L or 
OPT-AMP-L amplifier to display the card view. 

Step 2 Click the Maintenance > ALS tabs. If the value in the Currently Shutdown field is NO, continue with 
Step 3. If not, complete the following steps:

a. Check the OSRI setting. If it is set to On, change it to Off and click Apply.

b. Check the Currently Shutdown field. If it changes to NO, continue with Step 3. If not, contact your 
next level of support. The amplifier might need to be replaced.

Step 3 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 4 Click Reset.

Step 5 Scroll to the right and locate the Signal Output Power parameter for Port 6. Verify that the Signal Output 
Power value is greater than or equal to 1.5 dBm.

If the Signal Output Power is not greater than or equal to 1.5 dBm, do not continue. Begin 
troubleshooting or contact your next level of support.

Step 6 Return to your originating procedure (NTP).

DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power

Step 1 In node view (single-shelf view) or shelf view (multishelf view), double-click the OPT-AMP-L amplifier 
to display the card view. 

Step 2 Click the Maintenance > ALS tabs.

Purpose This task verifies that the OPT-BST-L or OPT-AMP-L (when provisioned 
in OPT-Line mode) amplifier laser is on and provisioned to the correct 
power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies that the OPT-AMP-L (when provisioned in OPT-PRE 
mode) amplifier laser is on and provisioned to the correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 3 If the value shown in the Currently Shutdown field is NO, continue with Step 4. If not, complete the 
following steps:

a. If the OSRI setting is set to ON, click the table cell and choose OFF from the drop-down list. 

b. Click Apply.

c. Check the Currently Shutdown field. If it changes to NO, continue with Step 4. If not, contact your 
next level of support.

Step 4 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 5 Locate the Signal Output Power parameter for Port 2. Verify that the Signal Output Power value is 
greater than or equal to 1.5 dBm. If the optical power is greater than or equal to 1.5 dBm, continue with 
Step 6. If the optical power is less than 1.5 dBm, check your connections and clean the fibers using the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation Guide. 
If this does not change the power value, consult your next level of support.

Step 6 Scroll to the right to locate the DCU Insertion Loss parameter. Verify that the DCU Insertion Loss value 
is less than or equal to 10 dB.

If the optical power is not greater than or equal to 10 dB, do not continue. Begin troubleshooting or 
contact your next level of support.

Step 7 Return to your originating procedure (NTP).

DLP-G361 Verify the 32DMX-L Power

Step 1 Display the 32DMX-L card in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the administrative state for Port 33 to OOS,MT (ANSI) or Locked,maintenance (ETSI)

Step 4 Verify that the VOA Power Ref reaches the provisioned set point.

Step 5 Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the physical optical 
power value coming from drop Port 1 on the Side A 32DMX card is consistent with the value read (the 
maximum allowed error is +/– 1.0 dBm).

Step 6 Change the administrative state for Port 1 to OOS,DSBLD (ANSI) or Locked,disabled (ETSI).

Step 7 Return to your originating procedure (NTP).

Purpose This task verifies that the 32DMX-L card is provisioned to the correct 
power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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NTP-G43 Perform the ROADM Node with 32WSS and 32DMX 
Cards Acceptance Test 

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Note Because the node is isolated and no line-side fibers are connected during the test, the power levels going 
into the line-side cards will not be the same as the levels after the node is connected to the network. 
Therefore, if the ROADM shelf does not contain either OPT-BST or OPT-BST-E amplifiers, and 
OPT-PRE amplifiers on both Side B and Side A, lower the OPT-PRE power thresholds so that it turns 
on properly. At the end of the test, you will run ANS to configure the node with the correct parameters 
for the network acceptance test.

Note Throughout this procedure, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17.

Step 1 Complete the “DLP-G46 Log into CTC” task at the ROADM node that you want to test. If you are 
already logged in, continue with Step 2.

Step 2 Display the ROADM node in node view (single-shelf mode) or multishelf view (multishelf mode). 

Step 3 Import the Xml file to fully configure node: layout, patchcords, parameters. See the NTP-G143 Import 
the Cisco TransportPlanner NE Update Configuration File as necessary.

Step 4 Install the cards and fiber up the node according with the xml file settings.

Purpose This acceptance test verifies that a ROADM node provisioned for C-band 
wavelengths is operating properly before you connect it to the network. 
The test verifies the operation of the amplifiers and also verifies that each 
add/drop and pass-through port on the 32WSS and 32DMX cards operates 
properly. The test also checks the power levels at each transmit and receive 
port to ensure that power loss in the cabling is within tolerance. If MMU 
cards are installed, the test verifies that the MMU insertion loss does not 
impact add, drop, or pass through circuits.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 5 Run the ANS at node level and verify no errors are present. See “NTP-G37 Run Automatic Node Setup” 
procedure on page 14-126 as necessary.
In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are either Success - Changed, 
or Success - Unchanged. If any are not, complete the following step: “NTP-G37 Run Automatic Node 
Setup” procedure on page 14-126.

Step 6 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.

Step 7 Click the Alarms tab.

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate two alarms for each side of the 
shelf: one an LOS alarm on the OPT-BST or OPT-BST-E card, and the other an LOS alarm on 
the OSC-CSM or OSCM card. If OSCM cards are installed in ANSI shelves, EOC DCC 
Termination Failure alarms will appear.

Step 8 Complete the “DLP-G310 Verify ROADM Node C-Band Pass-Through Channels with 32WSS and 
40-WSS-C Cards” task on page 15-30.

Step 9 Complete the following tasks for channels that will be added or dropped on the node.

• DLP-G311 Verify the Side A or Side B ROADM C-Band Add/Drop Channels with 32WSS and 
40-WSS-C Cards, page 15-35

Step 10 Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task.

Step 11 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

Step 12 Create the two OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 13 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment failure alarms appear on the node. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Stop. You have completed this procedure.
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DLP-G310 Verify ROADM Node C-Band Pass-Through Channels with 32WSS 
and 40-WSS-C Cards

Note Throughout this task, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17. 

Step 1 Create a physical loopback on the Side A OPT-BST, OPT-BST-E, or OSC-CSM card by connecting the 
LINE TX port to its LINE RX port. For OPT-BST or OPT-BST-E cards, connect a 10-dB bulk attenuator 
to the fiber. (OSC-CSM cards do not require attenuation.)

Caution Failure to use proper attenuation might damage the equipment.

Step 2 If an OPT-PRE amplifier or OSC-CSM card is installed on Side A (where the physical loopback was 
created), perform the following steps. If not, continue with Step 3.

a. Display the OPT-PRE card in card view, then click the Provisioning > Optical Line > 
Optics Thresholds tabs.

b. In the Types area, click Alarm, then click Refresh. The alarm thresholds for the OPT-PRE card will 
appear. 

c. Double-click the Power Failure Low table cell for Port 1 (COM-RX) and delete the current value.

d. Type a new value of –30.0 and press the Enter key.

e. In the CTC window, click Apply, then click Yes in the confirmation dialog box.

Purpose This task verifies the signal flow through a ROADM node for C-band 
pass-through channels. Pass-through channels pass through both the 
32WSS or both 40-WSS-C cards. The channels pass through the first 
32WSS or 40-WSS-C from the COM-RX port to the EXP-TX port. In the 
second 32WSS or 40-WSS-C, the channel goes from the EXP-RX port to 
the COM-TX port. The channel is not terminated inside the node. If MMU 
cards are installed, the channel passes through the MMU COM-RX and 
EXP-TX ports to the 32WSS or the 40-WSS-C COM-RX and EXP-TX 
ports on one side. On the other side, the channel goes from the 32WSS or 
40-WSS-C EXP-RX and COM-TX ports to the MMU EXP-RX and 
COM-TX ports.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures DLP-G46 Log into CTC

NTP-G38 Provision OSC Terminations, page 14-124

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 3 If an OPT-PRE or OSC-CSM card is installed on Side B, complete the following steps. If not, continue 
with Step 4.

a. Display the Side B OPT-PRE card in card view, then click the Provisioning > Optical Line > 
Optics Thresholds tabs.

b. In the Types area, click Alarm, then click Refresh. The alarm thresholds for the OPT-PRE card will 
appear. 

c. Double-click the Power Failure Low table cell for Port 1 (COM-RX) and delete the current value.

d. Type a new value of –30.0 and press the Enter key.

e. In the CTC window, click Apply, then click Yes in the confirmation dialog box.

Step 4 Wait 2 to 3 minutes, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarms on the Side A OSCM or OSC-CSM card and the OPT-BST 
or OPT-BST-E card have cleared. The clearing of the LOS alarms indicates that the OSC link is active 
on Side A. If the alarms do not clear, contact your next level of support.

Note For ANSI shelves, an EOC SDCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

Step 5 Create an OCH-DCN circuit for channel 1 on side A related to EXP path.
The circuit is bidirectional and goes from LINE-RX port of the OPT-BST (or OSC-CSM) side B to the 
LINE-TX port of the OPT-BST (or OSC-CSM) on the opposite side A.

Step 6 Connect the tunable laser transmitter or the TXP_MR_10E_C card TRUNK-TX port to the Side B 
OPT-BST, OPT-BST-E, or OSC-CSM LINE RX port. If a Side B OPT-PRE is installed, insert a 10-dB 
attenuator on the fiber coming from the TXP_MR_10E_C card.

Caution Failure to use proper attenuation might damage the equipment.

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with Step 8.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 9.

Step 8 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP transmitting the 
wavelength you will test.

Step 9 If an OPT-PRE card is installed on Side B, complete the following steps. If not, continue with Step 10.

a. Display the Side B OPT-PRE in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1 (COM-RX). Record the value.

d. Display the Side B OPT-BST, OPT-BST-E, or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 2 (COM-TX) (OPT-BST or OPT-BST-E) or Port 3 (COM-TX) 
(OSC-CSM). Verify that the value matches the power recorded in Step c., +/– 2.0 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
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Guide to clean the fiber connection between the OPT-PRE card and the OPT-BST, OPT-BST-E, or 
OSC-CSM card. Check the values again. If they still do not match, contact your next level of 
support.

g. For the Side B OPT-PRE card, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and 
Power” task on page 15-6.

Step 10 If an MMU card is installed on Side B, complete the following steps, then continue with Step 12. If an 
MMU card is not installed, continue with Step 11

a. Display the Side B MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 3 (COM-RX) power parameter. Record the value.

d. If a Side B OPT-PRE card is installed, display it in card view and complete Step e. If not, continue 
with Step f.

e. Click the OPT-PRE Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output 
Power value for Port 2 (COM-TX), then continue with Step i.

f. If a Side B OPT-BST or OPT-BST-E card is installed, display it in card view and complete Step g. 
If not, continue with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that value in the Step e, g, or h matches the power recorded in Step c, +/– 1.0 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the MMU card and the OPT-BST, OPT-BST-E, 
OPT-PRE, or OSC-CSM cards. Check the values again. If they still do not match, contact your next 
level of support.

j. Display the Side B MMU card in card view.

k. Click the Provisioning > Optical Line > Parameters tabs.

l. Record the value in the Power table cell for Port 2 (EXP-TX) of the Side B MMU card.

m. Display the Side B 32WSS or 40-WSS-C card in card view.

n. Click the Provisioning > Optical Line > Parameters tabs.

o. Verify that the value in the Power table cell for Port 68 (COM-RX) is equal to the value recorded in 
Step l, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 40-WSS-C and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

p. Continue with Step 12.

Step 11 Verify the Side B 32WSS or 40-WSS-C card to OPT-BST, OPT-PRE, or OSC-CSM card cable 
connection:

a. Display the Side B 32WSS or 40-WSS-C in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) (for 32WSS card) or Port 84 (COM-RX) (for 40-WSS-C card) Power 
parameter. Record the value.

d. If a Side B OPT-PRE card is installed, display it in card view and complete Step e. If not, continue 
with Step f. 
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e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2 (COM-TX), then continue with Step i.

f. If an OPT-BST or OPT-BST-E card is installed on Side B, display it in card view and complete Step 
g. If not, continue with Step g.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for 
Port 2 (COM-TX), then continue with Step i.

h. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that the value in Step e, g, or g matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the 32WSS or 40-WSS-C card and the OPT-PRE, 
OPT-BST, OPT-BST-E, or OSC-CSM card. Check the values again. If they still do not match, 
contact your next level of support.

Step 12 Verify the EXPRESS cable connection between the two 32WSS or two 40-WSS-C cards:

a. Display the Side B 32WSS or 40-WSS-C in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 65 (EXP-TX) (for 32WSS card) or Port 81 (EXP-TX) (for 40-WSS-C card) Power 
parameter. Record the value.

d. Display the Side A 32WSS or 40-WSS-C in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for EXPRESS Port 66 (EXP-RX) (for 32WSS card) or Port 82 (EXP-RX) 
(for 40-WSS-C card). Verify that the value matches the power recorded in Step c, +/–1 dB. If not, 
use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware 
Installation Guide to clean the fiber connection between the 32WSS or 40-WSS-C cards. Check the 
values again. If they still do not match, contact your next level of support.

Step 13 Display the Side A 32WSS or 40-WSS-C card in card view. 
Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the connector 
number containing the wavelength you are testing. Refer to Table 15-2 on page 15-65, if needed. Wait 
60 to 70 seconds (or click Reset), then locate the Power and VOA Power Ref parameters for the tested 
PASS-THROUGH port. Verify that the Power value is equal to the VOA Power Ref value, +/– 1.5 dBm. 
If the Power value is not equal to the VOA Power Ref value +/–1.5 dBm, contact your next level of 
support.

Step 14 If an MMU card is installed on Side A, complete the following steps. If an MMU card is not installed on 
Side A, continue with Step 15.

a. Display the Side A 32WSS or 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX) (for 32WSS card) or Port 83 
(COM-TX) (for 40-WSS-C card).

d. Display the Side A MMU card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (EXP-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS or 40-WSS-C 
and MMU cards. Check the values again. If they still do not match, contact your next level of 
support.
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g. Record the value in the Power table cell for Port 4 (COM-TX).

h. If a Side A OPT-BST or OPT-BST-E card is installed, display it in card view and complete Step i. 
If not, continue with Step j.

i. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step k.

j. Display the Side A OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step k.

k. Verify that the value in Step i or j matches the power recorded in Step g, +/– 1.5 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST, OPT-BST-E, or OSC-CSM card and the 
MMU cards. Check the values again. If they still do not match, contact your next level of support.

l. Continue with Step 18.

Step 15 For OPT-BST, OPT-BST-E, or OSC-CSM card is installed on Side A, complete the following steps.

a. Display the Side A OPT-BST, OPT-BST-E, or OSC-CSM in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 1 (COM-RX) Power parameter (OPT-BST or OPT-BST-E cards) or the Port 2 
(COM-RX) Power parameter (OSC-CSM cards). Record the value.

d. Display the Side A 32WSS or 40-WSS-C in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 67 (COM-TX) (for 32WSS card) or Port 83 (COM-TX) (for 
40-WSS-C card). Verify that the value matches the power recorded in Step c, +/–1 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST, OPT-BST-E, or OSC-CSM card and the 
40-WSS-C card. Check the values again. If they still do not match, contact your next level of 
support.

Step 16 If on Side A an OPT-BST or OPT-BST-E card is installed, complete the “DLP-G79 Verify the OPT-BST, 
OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” task on page 15-5. If instead an OSC-CSM is 
installed, no action is needed.

Step 17 Repeat steps from Step 9 to Step 16 for the same wavelength running on opposite direction (side A-> 
side B)

Step 18 Complete Step 13 for the additional wavelengths that you want to test. If you have tested all the 
wavelengths, continue with Step 19.

Step 19 Delete the OCH-DCN circuit created on Step 5.

Step 20 If you used a tunable laser or an installed TXP_MR_10E_C card for this test, disconnect it from the Side 
A OPT-BST, OPT-BST-E, or OSC-CSM line side RX ports.

Step 21 Remove the loopback fiber from the line RX and TX in the Side A OPT-BST, OPT-BST-E, or OSC-CSM 
card.

Step 22 Return to your originating procedure (NTP).
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DLP-G311 Verify the Side A or Side B ROADM C-Band Add/Drop Channels with 
32WSS and 40-WSS-C Cards

Note Throughout this task Side X refers to side you want to test (Side A or Side B) and Side Y refers to the 
opposite side.

Note Throughout this task, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), display the Alarms tab.

Step 2 Create a physical loopback on the Side X OPT-BST, OPT-BST-E, or OSC-CSM card by connecting the 
LINE TX port to its LINE RX port. For OPT-BST or OPT-BST-E cards, connect a 10-dB bulk attenuator 
to the fiber. (OSC-CSM cards do not require attenuation.)

Caution Failure to use proper attenuation might damage the equipment.

Step 3 Wait 2 to 3 minutes, then click the Alarms tab. Verify that the LOS alarms on the Side X OSCM or 
OSC-CSM card and the OPT-BST or OPT-BST-E card have cleared. The clearing of the LOS alarms 
indicates that the OSC link is active on Side X.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

Step 4 Create an OCH-DCN circuit for channel 1 on Side X related to ADD/DROP path. The circuit is 
bidirectional and goes from CHAN-RX port (Add) of the 32WSS or 40-WSS-C Side X to the LINE-TX 
port of the OPT-BST (or OSC-CSM) on the same side and backward from LINE-RX port of the 
OPT-BST (or OSC-CSM) on Side Y to the CHAN-TX port (Drop) of the 32DMX or 40-WSS-C card 
belonging to Side X.

Step 5 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with .

a. Set the output power to a nominal value, such as –3 dBm. 

Purpose This task verifies the signal flow through Side A or Side B of a ROADM 
node for C-band add/drop channels.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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b. Set the tuner to the wavelength you are testing, then continue with Step 8.

Step 6 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP transmitting the 
wavelength you will test. Refer to Table 11-41 on page 11-169, if needed.

Step 7 If you are using a TXP_MR_10E_C card, complete the following steps. If you are using a tunable laser 
continue with Step 8. 

a. Display the TXP_MR_10E_C in card view.

b. Click the Performance > Optics PM > Current Values tabs. 

c. Locate the Port 2 (Trunk) table cell for the TX Optical Pwr parameter. Record the value.

Step 8 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the Side X fiber 
patch panel MUX port that is connected to the Side X 32WSS or 40-WSS-C card CHAN RX port 
carrying the tested wavelength. (If the TXP_MR_10E_C card was installed during Chapter 14, “Turn Up 
a Node” simply verify the cable connection.)

Step 9 Connect the TXP_MR_10E_C DWDM RX port or the power meter RX port to the Side X fiber patch 
panel DMX port that is connected with the Side X 32DMX or 40-DMX-C card CHAN-TX port carrying 
the tested wavelength. (If the TXP_MR_10E_C card was installed during Chapter 14, “Turn Up a Node” 
simply verify the cable connection.)

Step 10 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 11-41 on page 11-169, if 
needed.

Step 11 Find the tested wavelength CHAN RX port, then scroll to the right until you see the Power Add 
parameter. Verify that the Power Add value for the tested port CHAN RX is equal to the output power 
level of the tunable laser or the TXP_MR_10E_C card measured in Step 7, +/– 1.0 dBm.

Step 12 Click the Provisioning > Optical Line > Parameters tabs and record the value in the Power table cell 
for Port 67 (COM-TX) for the wavelength under test.

Step 13 Verify that the power value from Step 12 reaches the Shelf i Slot i (32WSS or 40-WSS-C).Port 
COM-TX. Power set point +/– 1.0 dBm on Side X. To view this set point:

a. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 32WSS or 40-WSS-C card on Side X.

c. Expand the Port COM-TX category.

d. Select Power.

e. View the value of the Shelf i Slot i (32WSS or 40-WSS-C).Port COM-TX. Power parameter on the 
right pane.

f. If the power value does not match the value recorded in Step 12 (+/– 2.0 dBm), contact your next 
level of support.

Step 14 If an MMU card is installed on Side X, complete the following steps. If an MMU card is not installed on 
Side X, continue with Step 15.

a. Display the Side X 32WSS or 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. Display the Side X MMU card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.
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f. Verify that the value in the Power table cell for Port 1 (EXP-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS or 40-WSS-C 
and MMU cards. Check the values again. If they still do not match, contact your next level of 
support.

g. Record the value in the Power table cell for Port 4 (COM-TX).

h. If a Side X OPT-BST or OPT-BST-E card is installed, display it in card view and complete Step i. 
If not, continue with Step j.

i. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step k.

j. Display the Side X OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step k.

k. Verify that the value in Step i or j matches the power recorded in Step g, +/– 1.5 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST, OPT-BST-E, or OSC-CSM card and the 
MMU cards. Check the values again. If they still do not match, contact your next level of support.

l. Continue with Step 16.

Step 15 Verify the connection between the 32WSS or 40-WSS-C card and the OPT-BST, OPT-BST-E or 
OSC-CSM cards:

a. Display the Side X 32WSS or 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. If a OPT-BST or OPT-BST-E card is installed on Side X, display it in card view and complete Step 
e. If not, continue with Step f.

e. Click the Provisioning > Optical Line >   Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step g.

f. Display the Side X OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step g.

g. Verify that the value in Step e or f matches the power recorded in Step c, +/– 1.0 dB. If so, continue 
with Step 16. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST, 
OPT-BST-E, or OSC-CSM card and the 32WSS or 40-WSS-C cards. Check the values again. If they 
still do not match, contact your next level of support.

Step 16 If an OPT-PRE card is installed on Side X, complete the following steps. If not, continue with Step 17.

a. Display the Side X OPT-PRE in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1 (COM-RX). Record the value.

d. Display the Side X OPT-BST, OPT-BST-E, or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Port 2 (COM-TX) Power value (for OPT-BST or OPT-BST-E cards) or Port 3 (COM-TX) 
Power value (for OSC-CSM cards). Verify that the value matches the power recorded in Step c, +/– 
1.5 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
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Hardware Installation Guide to clean the fiber connection between the OPT-PRE card and the 
OPT-BST, OPT-BST-E, or OSC-CSM card. Check the values again. If they still do not match, 
contact your next level of support.

g. For the Side X OPT-PRE card, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and 
Power” task on page 15-6.

Step 17 If an MMU card is installed on Side X, complete the following steps. If an MMU card is not installed on 
Side X, continue with Step 18.

a. Display the Side X MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If an OPT-PRE card is installed on Side X, display it in card view and complete Step e. If not, 
continue with Step f.

e. Click the OPT-PRE Provisioning > Opt.Ampli.Line > Parameters tabs. Record the Total Output 
Power value for Port 2 (COM-TX), then continue with Step i.

f. If a Side X OPT-BST or OPT-BST-E card is installed, display it in card view and complete Step g. 
If not, continue with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display a Side X OSC-CSM card in card view, click the Provisioning > Optical Line > Parameters 
tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that value in the Step e, g, or h matches the power recorded in Step c, +/– 1.0 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the MMU card and the OPT-BST, OPT-BST-E, or 
OSC-CSM cards. Check the values again. If they still do not match, contact your next level of 
support.

j. Display the Side X MMU card in card view.

k. Click the Provisioning > Optical Line > Parameters tabs.

l. Record the value in the Power table cell for Port 2 (EXP-TX).

m. Display the Side X 32WSS or 40-WSS-C card in card view.

n. Click the Provisioning > Optical Line > Parameters tabs.

o. Verify that the value in the Power table cell for Port 68 (COM-RX) is equal to the value recorded in 
Step l, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS or 40-WSS-C 
and MMU cards. Check the values again. If they still do not match, contact your next level of 
support.

p. Continue with Step 19.

Step 18 Verify the connection between the Side X 32WSS or 40-WSS-C card and the OPT-BST, OPT-BST-E, 
OPT-PRE, or OSC-CSM card:

a. Display the Side X 32WSS or 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If a Side X OPT-PRE card is installed, display it in card view and complete Step e. If not, continue 
with Step f.
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e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2 (COM-TX), then continue with Step i.

f. If a Side X OPT-BST or OPT-BST-E card is installed, display it in card view and complete Step g. 
If not, continue with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side X OSC-CSM card in card view. Click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the 32WSS or 40-WSS-C card and the OPT-PRE, 
OPT-BST, or OSC-CSM card.

Step 19 Verify the Side X 32WSS or 40-WSS-C and 32DMX or 40-DMX-C connection:

a. Display the Side X 32WSS or 40-WSS-C card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs and record the value in the Power table 
cell for Port 69 (DROP-TX).

c. Display the Side X 32DMX or 40-DMX-C card in card view.

d. Click the Provisioning > Optical Line > Parameters tabs. Record the value in the Port 2 for Side A 
and Port 33 for Side B for a 32DMX or 40-DMX-C card.

e. (COM-RX) table cell. Verify that the value is equal to the value recorded in b, +/– 1.0 dBm. If not, 
use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware 
Installation Guide to clean the fiber connection between the 32WSS and 32DMX cards. Check the 
values again. If they still do not match, contact your next level of support.

Step 20 Display the Side X 32DMX or 40-DMX-C card in card view.

Step 21 Click the Provisioning > Optical Chn > Parameters tab. Record the CHAN-TX port value under the 
Power parameter for the wavelength under test.

Step 22 Verify that the power value from Step 21 reaches the Shelf i Slot i (32DMX or 40-DMX-C).Port 
CHAN-TX.Power set point +/– 2 dBm on Side X. To view this set point: 

a. Go to node view (single-shelf mode) or multishelf view (multishelf mode) and click the 
Provisioning > WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 32DMX or 40-DMX-C card on Side X.

c. Expand the Port CHAN-TX category.

d. Select Power.

e. View the value of the Shelf i Slot i (32DMX or 40-DMX-C).Port CHAN-TX.Power parameter on 
the right pane.

f. If the power value does not match the value recorded in Step 21 (+/– 2 dBm), contact your next level 
of support.

Step 23 If you are using a TXP_MR_10E_C card, display it in card view. If not, read the values called for in 
Step 25 from the optical test set or tunable laser you are using.

Step 24 Click the Performance > Optics PM > Current Values tabs. 
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Step 25 In the Port 2 (Trunk) column, locate the RX Optical Power value. Verify that the value matches the power 
recorded in Step 21, +/– 2 dBm. If the power values do not match (+/– 2 dBm), complete the following 
steps:

a. Remove, clean, and replace the cable connecting the TXP_MR_10E_C RX port to the Side X fiber 
patch panel DMX port for the tested wavelength. See the “NTP-G115 Clean Fiber Connectors” 
procedure in the Cisco ONS 15454 Hardware Installation Guide.

b. Repeat this step. If the power values still do not match (+/– 2 dBm) contact your next level of 
support. 

Step 26 Repeat Steps 5 through 25 for the remaining wavelengths. 

Step 27 Delete the OCH-DCN circuit created on Step 4

Step 28 If you used a tunable laser or installed a TXP_MR_10E_C card for this test, disconnect it from the 
Side X patch panel.

Step 29 Unplug the physical loopback fiber from the line TX and RX in the OPT-BST, OPT-BST-E, or OSC-CSM 
card.

Step 30 Return to your originating procedure (NTP).

NTP-G154 Perform the ROADM Node with 32WSS-L and 
32DMX-L Cards Acceptance Test 

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Purpose This acceptance test verifies that a ROADM node provisioned for L-band 
wavelengths is operating properly before you connect it to the network. 
The test verifies the operation of the amplifiers and also verifies that each 
add/drop and pass-through port on the 32WSS-L and 32DMX-L cards 
operates properly. The test also checks the power levels at each transmit 
and receive port to ensure that power loss in the cabling is within tolerance. 
If MMU cards are installed, the test verifies that the MMU insertion loss 
does not impact add, drop, or pass-through traffic.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_L

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note Because the node is isolated and no line-side fibers are connected during the test, the power levels going 
into the line-side components will not be the same as they would be in a real network setup. Therefore, 
if the ROADM shelf does not contain OPT-BST-L and OPT-AMP-L (provisioned in OPT-PRE mode) 
amplifiers on both Side B and Side A, you must lower the OPT-AMP-L power thresholds so that it turns 
on properly. At the end of the test, you will run ANS to configure the node with the correct parameters 
for the network acceptance test.

Step 1 Make a copy of Table 15-1 on page 15-42 and place it in a convenient location for reference throughout 
this procedure. The table shows the 32WSS-L ports and the wavelengths assigned to them. The 
32 wavelengths are divided among four physical MPO connectors on the 32WSS-L card. Each MPO 
connector is assigned eight wavelengths. In CTC, the MPO connector appears in the card view 
Provisioning > Optical Connector tab. Each Optical Connector subtab represents an MPO connector. 
Ports 1 through 32 are the channel RX (add) ports; Ports 33 through 64 are the pass-through ports. 
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Step 2 Complete the DLP-G46 Log into CTC at the ROADM node that you want to test. If you are already 
logged in, continue with Step 3.

Table 15-1 32WSS-L Ports and Wavelengths Test Checklist

32WSS-L Provisioning 
Subtab Port # Wavelength

Tested: 
Pass-Through

Tested: 
Add/Drop 
Side A

Tested: 
Add/Drop 
Side B

Optical Chn: 

Optical Connector 1

RX 1, PT 33 1577.86

RX 2, PT 34 1578.69

RX 3, PT 35 1579.52

RX 4, PT 36 1580.35

RX 5, PT 37 1581.18

RX 6, PT 38 1582.02

RX 7, PT 39 1582.85

RX 8, PT 40 1583.69

Optical Chn: 

Optical Connector 2

RX 9, PT 41 1584.53

RX 10, PT 42 1585.36

RX 11, PT 43 1586.20

RX 12, PT 44 1587.04

RX 13, PT 45 1587.88

RX 14, PT 46 1588.73

RX 15, PT 47 1589.57

RX 16, PT 48 1590.41

Optical Chn: 

Optical Connector 3

RX 17, PT 49 1591.26

RX 18, PT 50 1592.10

RX 19, PT 51 1592.95

RX 20, PT 52 1593.79

RX 21, PT 53 1594.64

RX 22, PT 54 1595.49

RX 23, PT 55 1596.34

RX 24, PT 56 1597.19

Optical Chn: 

Optical Connector 4

RX 25, PT 57 1598.04

RX 26, PT 58 1598.89

RX 27, PT 59 1599.75

RX 28, PT 60 1600.60

RX 29, PT 61 1601.46

RX 30, PT 62 1602.31

RX 31, PT 63 1603.17

RX 32, PT 64 1604.03
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Step 3 Display the ROADM node in node view (single-shelf mode) or multishelf view (multishelf mode). 

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate two alarms for each side of the 
shelf, one for an LOS on the OPT-BST-L card, and the other for an LOS on the OSC-CSM or 
OSCM card. If OSCM cards are installed on ANSI shelves, EOC DCC Termination Failure 
alarms will appear.

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If any are not, complete the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 6 If MMU cards are installed, complete the following steps. If not, continue with Step 7.

a. Display the Side B MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs. 

c. Click the Admin State table cell for the COM RX, COM TX, EXP RX, and EXP TX ports and 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list.

d. Click Apply, then click Yes to confirm. 

e. Display the Side A MMU card in card view.

f. Click the Provisioning > Optical Line > Parameters tabs. 

g. Click the Admin State table cell for the COM RX, COM TX, EXP RX, and EXP TX ports and 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list.

Step 7 Display the Side B 32WSS-L in card view.

Step 8 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-1 on page 15-42, if 
needed.

Step 9 Click the Admin State table cell for the add port carrying the tested wavelength, then choose OOS,MT 
(ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the tested wavelength 
is 1530.33 nm (shown as 1530.3), you would click the Port 1 (CHAN-RX) Admin State field and choose 
OOS,MT or Locked,maintenance from the drop-down list. 

Step 10 Change the administrative state of the pass-through port corresponding to the port in Step 9 to OOS,MT 
(ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1577.86 nm (shown 
as 1577.8), you would click the Port 33 (PASS-THROUGH) Admin State field and choose OOS,MT or 
Locked,maintenance from the drop-down list. Refer to Table 15-1 on page 15-42, if needed.

Step 11 Click Apply, then click Yes to confirm. 
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Step 12 Repeat Steps 8 through 11 for all wavelengths that you will test. 

Step 13 Display the Side A 32WSS-L in card view.

Step 14 Repeat Steps 8 through 12 for the Side A 32WSS-L card.

Step 15 Display the Side B 32DMX-L in card view and complete the following steps:

a. Choose the Provisioning > Optical Line > Parameters tabs.

b. For Port 33 (COM-RX), click the Admin State table cell and choose OOS,MT (ANSI) or 
Locked,maintenance (ETSI) from the drop-down list.

c. Click Apply, then click Yes to confirm. 

Step 16 Repeat Step 15 for the Side A 32DMX-L card.

Step 17 Complete the “DLP-G362 Verify ROADM Node L-Band Pass-Through Channels” task on page 15-45. 

Step 18 Complete the following tasks for channels that will be added or dropped on the node.

• DLP-G363 Verify the Side B ROADM L-Band Add/Drop Channels, page 15-53

• DLP-G364 Verify the Side A ROADM L-Band Add/Drop Channels, page 15-58

Step 19 If MMU cards are installed, complete the following steps. If not, continue with Step 20.

a. Display the Side B MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs. 

c. Click the Admin State table cell for the COM RX, COM TX, EXP RX, and EXP TX ports and 
choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) from the drop-down list.

d. Click Apply, then click Yes to confirm. 

e. Display the Side A MMU card in card view.

f. Click the Provisioning > Optical Line > Parameters tabs. 

g. Click the Admin State table cell for the COM RX, COM TX, EXP RX, and EXP TX ports and 
choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) from the drop-down list.

Step 20 Display the Side B 32WSS-L card in card view.

Step 21 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you tested. 

Step 22 Click the Admin State table cell then choose IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI) from the drop-down list for all ports that were changed to OOS,MT or Locked,Maintenance.

Step 23 Click Apply.

Step 24 Repeat Steps 21 through 23 for all the ports that are OOS,MT or Locked,maintenance on the Side B 
32WSS-L card. 

Step 25 Display the Side A 32WSS-L card in card view. 

Step 26 Repeat Steps 21 through 24 for all ports on the Side A 32WSS-L card. 

Step 27 Display the Side B 32DMX-L card in card view.

Step 28 Choose the Provisioning > Optical Line > Parameters tabs.

Step 29 For Port 33, click the Admin State table cell and choose IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI) from the drop-down list.

Step 30 Click Apply.

Step 31 Display the Side A 32DMX-L card in card view.

Step 32 Repeat Steps 28 through 30 for the Side A 32DMX-L card.
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Step 33 Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task.

Step 34 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

Step 35 Create the two OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 36 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment failure alarms appear on the node. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Stop. You have completed this procedure.

DLP-G362 Verify ROADM Node L-Band Pass-Through Channels

Note Throughout this task, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17. 

Step 1 Create a physical loopback on the Side A OPT-BST-L or OSC-CSM card by connecting the LINE TX 
port to its LINE RX port. For OPT-BST-L cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM 
cards do not require attenuation.)

Caution Failure to use proper attenuation might damage the equipment.

Purpose This task verifies the signal flow through a ROADM node for L-band 
pass-through channels. Configuring a channel pass-through mode means 
that the channel passes through both 32WSS-L cards. The channel passes 
through the first 32WSS-L card from the COM RX port to the EXP TX 
port. In the second 32WSS-L card, the channel goes from the EXP RX port 
to the COM TX port. The channel is not terminated inside the node. If 
MMU cards are installed, the channel passes through the MMU COM RX 
and EXP TX ports to the 32WSS-L COM RX and EXP TX ports on one 
side. On the other side, the channel goes from the 32WSS-L EXP RX and 
32WSS-L COM TX ports to the MMU EXP RX and COM TX.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_L

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 2 If an OPT-AMP-L amplifier (provisioned in OPT-PRE mode) is installed on Side A (where the physical 
loopback was created), perform the following steps. If not, continue with Step 3.

a. Display the OPT-AMP-L card in card view, then click the Provisioning > Optical Line > 
Optics Thresholds tabs.

b. In the Types area, click Alarm, then click Refresh. The alarm thresholds for the OPT-AMP-L card 
will appear. 

c. Double-click the Power Failure Low table cell for Port 1 (1-Line-2-1 RX) and delete the current 
value.

d. Type a new value of –30. Press the Enter key.

e. In the CTC window, click Apply, then click Yes in the confirmation dialog box.

Step 3 If an OPT-AMP-L amplifier (provisioned in OPT-PRE mode) is installed on Side B (where the physical 
loopback was created), perform the following steps. If not, continue with Step 4.

a. Display the OPT-AMP-L card in card view, then click the Provisioning > Optical Line > 
Optics Thresholds tabs.

b. In the Types area, click Alarm, then click Refresh. The alarm thresholds for the OPT-AMP-L card 
will appear. 

c. Double-click the Power Failure Low table cell for Port 1 (1-Line-2-1 RX) and delete the current 
value.

d. Type a new value of –30. Press the Enter key. 

e. In the CTC window, click Apply, then click Yes in the confirmation dialog box.

Step 4 Wait 2 to 3 minutes, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarms on the Side A OSCM or OSC-CSM card and the OPT-BST-L 
card have cleared. The clearing of the LOS alarms indicates that the OSC link is active on Side A. If the 
alarms do not clear, contact your next level of support.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

Step 5 Display the Side A 32WSS-L card in card view.

Step 6 Click the Maintenance tab.

Step 7 Click the Operating Mode table cell and choose Pass Through from the drop-down list.

Step 8 Click Apply, then click Yes to confirm.

Step 9 Display the Side B 32WSS-L card in card view.

Step 10 Repeat Steps 6 through 8 for the Side B 32WSS-L card.

Step 11 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_L card, continue with Step 12.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you will test, then continue with Step 13.

Step 12 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test.
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Step 13 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the Side B 
OPT-BST-L or OSC-CSM LINE RX port. If a Side B OPT-AMP-L card is installed, insert a 10-dB 
attenuator on the fiber coming from the TXP_MR_10E_L card.

Caution Failure to use proper attenuation might damage the equipment.

Step 14 If an OPT-AMP-L card configured as an OPT-PRE is installed on Side B, complete the following steps. 
If not, continue with Step 15.

a. Display the Side B OPT-AMP-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1. Record the value.

d. Display the Side B OPT-BST-L or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 2 (if an OPT-BST-L card) or Port 3 (if an OSC-CSM card). Verify 
that the value matches the power recorded in Step c, +/– 1.5 dB. If not, use the “NTP-G115 Clean 
Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation Guide to clean the fiber 
connection between the OPT-AMP-L card and the OPT-BST-L or OSC-CSM card. Check the values 
again. If they still do not match, contact your next level of support.

g. Complete the “DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” 
task on page 15-26.

Step 15 If MMU cards are installed complete the following steps. If an MMU cards are not installed, continue 
with Step 16.

a. Display the Side B MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 3 (COM-RX) power parameter. Record the value.

d. If a Side B OPT-AMP-L card provisioned as an OPT-PRE is installed, display it in card view and 
complete Step e. If not, continue with Step f.

e. Click the OPT-AMP-L Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total 
Output Power value for Port 2 (COM-TX), then continue with Step i.

f. If a Side B OPT-BST-L card is installed, display it in card view and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that value in Step e, g, or h matches the power recorded in Step c, +/– 1.0 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the MMU card and the OPT-BST-L, OPT-AMP-L, or 
OSC-CSM cards. Check the values again. If they still do not match, contact your next level of 
support.

j. Display the Side B MMU card in card view.

k. Click the Provisioning > Optical Line > Parameters tabs.

l. Record the value in the Power table cell for Port 2 (EXP-TX) of the Side B MMU card.
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m. Display the Side B 32WSS-L card in card view.

n. Click the Provisioning > Optical Line > Parameters tabs.

o. Verify that the value in the Power table cell for Port 68 (COM-RX) is equal to the value recorded in 
Step l, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

p. Continue with Step 17.

Step 16 Verify the Side B 32WSS-L to OPT-BST-L, OPT-AMP-L, or OSC-CSM card cable connection:

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 Power parameter. Record the value.

d. If a Side B OPT-AMP-L card provisioned as an OPT-PRE is installed, display it in card view and 
complete Step e. If not, continue with Step f. 

e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2, then continue with Step i.

f. If a Side B OPT-BST-L card is installed, display it in card view and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Power value for Port 3, 
then continue with Step i.

h. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2, then continue with Step i.

i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the 32WSS-L card and the OPT-AMP-L, OPT-BST-L, 
or OSC-CSM card. Check the values again. If they still do not match, contact your next level of 
support.

Step 17 Verify the EXPRESS cable connection between the two 32WSS-L cards:

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 65 (EXP-TX) Power parameter. Record the value.

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power value for Port 66 (EXP-RX). Verify that the value matches the power recorded in 
Step c, +/–1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS-L cards. 
Check the values again. If they still do not match, contact your next level of support.

Step 18 Display the Side A 32WSS-L card in card view.

Step 19 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the connector 
number containing the wavelength you are testing. Refer to Table 15-1 on page 15-42, if needed.

Step 20 Wait 60 to 70 seconds, then locate the Power and VOA Power Ref parameters for the tested 
PASS-THROUGH port. Verify that the Power value is equal to the VOA Power Ref value, +/– 1.5 dBm. 
If the Power value is not equal to the VOA Power Ref value, +/– 1.5 dBm, contact your next level of 
support.
15-48
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html
http://www.cisco.com/en/US/docs/optical/hardware/15454install/guide/hig15454.html


 

Chapter 15      Perform Node Acceptance Tests
DLP-  G362 Verify ROADM Node L-Band Pass-Through Channels
Step 21 If an MMU card is installed on Side A, complete the following steps. If an MMU card is not installed on 
Side A, continue with Step 22.

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. Display the Side A MMU card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (EXP-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

g. Record the value in the Power table cell for Port 4 (COM-TX).

h. If an OPT-BST-L card is installed on Side A, display it in card view and complete Step i. If not, 
continue with Step j.

i. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step k.

j. Display the Side A OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step k.

k. Verify that the value in Step i or j matches the power recorded in Step g, +/– 1.5 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST-L or OSC-CSM card, and the MMU card. 
Check the values again. If they still do not match, contact your next level of support.

l. Continue with Step 23.

Step 22 If an OPT-BST-L card is installed on Side B, complete the following steps. If not, continue with Step 23.

a. Display the Side B OPT-BST-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 1 Power parameter. Record the value.

d. Display the Side B 32WSS-L card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 67. Verify that the value matches the power recorded in Step c, 
+/–1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide to clean the fiber connection between the OPT-BST-L and 32WSS-L 
cards. Check the values again. If they still do not match, contact your next level of support.

g. Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and 
Power” task on page 15-5.

Step 23 If a Side A OPT-AMP-L card provisioned as an OPT-PRE is installed, complete the following steps. If 
not, continue with Step 24.

a. Display the Side A OPT-AMP-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1 (COM-RX). Record the value.

d. Display the Side A OPT-BST-L or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.
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f. Locate the Power value for Port 2 (COM-TX) (OPT-BST-L) or Port 3 (COM-TX) (OSC-CSM). 
Verify that the value matches the power recorded in Step c, +/– 2.0 dB. If not, use the “NTP-G115 
Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation Guide to clean 
the fiber connection between the OPT-AMP-L card and the OPT-BST-L or OSC-CSM card. Check 
the values again. If they still do not match, contact your next level of support.

g. For the Side A OPT-AMP-L card provisioned as an OPT-PRE, complete the “DLP-G360 Verify the 
OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task on page 15-26.

Step 24 If an MMU card is installed on Side A, complete the following steps, then continue with Step 26. If an 
MMU card is not installed on Side A, continue with Step 25.

a. Display the Side A MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 3 (COM-RX) power parameter. Record the value.

d. If a Side A OPT-AMP-L card provisioned in OPT-PRE mode is installed, display it in card view and 
complete Step e. If not, continue with Step f.

e. Click the OPT-AMP-L Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total 
Output Power value for Port 2 (COM-TX), then continue with Step i.

f. If an OPT-BST-L card is installed on Side A, display it in card view and complete Step g. If not, 
continue with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side A OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that value in the Step e, g, or h matches the power recorded in Step c, +/– 1.0 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the MMU card and the OPT-BST-L, OPT-AMP-L, or 
OSC-CSM cards. Check the values again. If they still do not match, contact your next level of 
support.

j. Display the Side B MMU card in card view.

k. Click the Provisioning > Optical Line > Parameters tabs.

l. Record the value in the Power table cell for Port 2 (EXP-TX) of the Side A MMU card.

m. Display the Side A 32WSS-L card in card view.

n. Click the Provisioning > Optical Line > Parameters tabs.

o. Verify that the value in the Power table cell for Port 68 (COM-RX) is equal to the value recorded in 
Step l, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS and cards and 
the MMU cards. Check the values again. If they still do not match, contact your next level of support.

p. Continue with Step 26.

Step 25 Verify the Side A 32WSS-L card to OPT-BST-L, OPT-AMP-L, or OSC-CSM card cable connection:

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If a Side A OPT-AMP-L card is installed, display it in card view, and complete Step e. If not, 
continue with Step f. 
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e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2 (COM-TX), then continue with Step i.

f. If a Side A OPT-BST-L card is installed, display it in card view, and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side A OSC-CSM card in card view, click the Provisioning > Opt.Ampli.Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/–1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the 32WSS-L card and the OPT-AMP-L, OPT-BST-L, 
or OSC-CSM card. Check the values again. If they still do not match, contact your next level of 
support.

Step 26 Verify the EXPRESS cable connection between the two 32WSS-L cards:

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 65 (EXP-TX) Power parameter. Record the value.

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power value for Port 66 (EXP-RX). Verify that the value matches the power recorded in 
Step c, +/– 1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS-L cards. 
Check the values again. If they still do not match, contact your next level of support.

Step 27 Display the Side B 32WSS-L card in card view.

Step 28 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the connector 
number containing the wavelength you are testing. Refer to Table 15-1 on page 15-42, if needed.

Step 29 Wait 60 to 70 seconds (or click Reset), then locate the Power and VOA Power Ref parameters for the 
tested PASS-THROUGH port. Verify that the Power value is equal to the VOA Power Ref value, 
+/– 1.5 dBm. If the Power value is not equal to the VOA Power Ref value +/– 1.5 dBm, consult your next 
level of support.

Step 30 If an MMU card is installed on Side B, complete the following steps. If an MMU card is not installed on 
Side B, continue with Step 31.

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. Display the Side B MMU card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (EXP-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS-L and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

g. Record the value in the Power table cell for Port 4 (COM-TX).
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h. If a Side B OPT-BST-L card is installed, display it in card view and complete Step i. If not, continue 
with Step j.

i. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step k.

j. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step k.

k. Verify that the value in Step i or j matches the power recorded in Step g, +/– 1.5 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST-L or OSC-CSM card and the MMU cards. 
Check the values again. If they still do not match, contact your next level of support.

l. Continue with Step 32.

Step 31 If an OPT-BST-L or OSC-CSM card is installed on Side B, complete the following steps. If not, continue 
with Step 32.

a. Display the Side B OPT-BST-L or OSC-CSM card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 1 (COM-RX) Power parameter (OPT-BST-L card) or the Port 2 (COM-RX) Power 
parameter (OSC-CSM card). Record the value.

d. Display the Side B 32WSS-L card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Power value for Port 67 (COM-TX). Verify that the value matches the power recorded in 
Step c, +/–1 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST-L card and 
the OSC-CSM or 32WSS-L card. Check the values again. If they still do not match, contact your 
next level of support.

g. Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and 
Power” task on page 15-5.

Step 32 Repeat Steps 18 through 20 and 27 through 29 for the remaining wavelengths to be tested. If you have 
tested all the wavelengths, continue with Step 33.

Step 33 Display the Side B 32WSS-L card in card view.

Step 34 Click the Maintenance tab.

Step 35 In the Operating Mode, click the table cell and choose Not Assigned from the drop-down list for all 
wavelengths.

Step 36 Click Apply, then click Yes to confirm.

Step 37 Display the Side A 32WSS-L in card view.

Step 38 Repeat Steps 34 through 36 for the Side A 32WSS-L card.

Step 39 Remove the TXP or tunable laser from the Side B OPT-BST-L or OSC-CSM line side TX and RX ports.

Step 40 Remove the loopback fiber from the line RX and TX in the Side A OPT-BST-L or OSC-CSM card.

Step 41 Return to your originating procedure (NTP).
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DLP-G363 Verify the Side B ROADM L-Band Add/Drop Channels

Note Throughout this task, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), display the Alarms tab.

Step 2 Create a physical loopback on the Side B OPT-BST-L or OSC-CSM card by connecting the LINE TX 
port to its LINE RX port. For OPT-BST-L cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM 
cards do not require attenuation.)

Caution Failure to use proper attenuation might damage the equipment.

Step 3 Wait 2 to 3 minutes, then click the Alarms tab. Verify that the LOS alarms on the Side B OSCM or 
OSC-CSM card and the OPT-BST-L card have cleared. The clearing of the LOS alarms indicates that the 
OSC link is active on Side B. 

Note For ANSI shelves, EOC DCC Termination Failure alarm will continue to appear due to the OSC 
signal loopback.

Step 4 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_L card, continue with Step 5.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you are testing, then continue with Step 7.

Step 5 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. See Table 15-1 on page 15-42, if needed.

Step 6 If you are using a TXP_MR_10E_L card, complete the following steps. If you are using a tunable laser, 
continue with Step 7. 

a. Display the TXP_MR_10E_L in card view.

b. Click the Performance > Optics PM > Current Values tabs. 

c. Locate the Port 2 (Trunk) table cell for the TX Optical Pwr parameter. Record the value.

Purpose This procedure verifies the signal flow through Side B of a ROADM node 
for L-band add/drop channels.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_L

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 7 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the Side B fiber 
patch panel MUX port that corresponds to the Side B 32WSS-L card port carrying the tested wavelength.

Step 8 Connect the TXP_MR_10E_L DWDM RX port or the power meter RX port to the Side B fiber patch 
panel DMX port that is connected with the Side B 32DMX-L card CHAN-TX port carrying the tested 
wavelength. (If the TXP_MR_10E_L card was installed during Chapter 14, “Turn Up a Node” simply 
verify the cable connection.)

Step 9 Display the 32WSS-L card in card view.

Step 10 Click the Maintenance tab.

Step 11 For each wavelength that you will test, click the table cell in the Operating Mode column and choose 
Add Drop from the drop-down list.

Step 12 Click Apply and then Yes, to confirm.

Step 13 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-1 on page 15-42, if 
needed.

Step 14 Find the tested wavelength CHAN RX port, then scroll to the right until you see the Power Add 
parameter. Verify that the Power Add value for the tested port CHAN RX is equal to the output power 
level of the tunable laser or the TXP_MR_10E_L card measured in Step 6, +/– 1.0 dBm.

Step 15 Click the Provisioning > Optical Line > Parameters tabs and record the value in the Power table cell 
for Port 67 (COM-TX) for the wavelength under test.

Step 16 Verify that the power value from Step 15 reaches the Shelf i Slot i (32WSS-L).Port COM-TX.Power set 
+/– 1.0 dBm on Side B. To view this set point:

a. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 32WSS-L card on Side B.

c. Expand the COM-TX category.

d. Select Power.

e. View the value of the Shelf i Slot i (32WSS-L).Port COM-TX.Power parameter on the right pane.

f. If the power value does not match the value recorded in Step 15 (+/– 2.0 dBm), contact your next 
level of support.

Step 17 If an MMU card is installed on Side B, complete the following steps. If an MMU card is not installed on 
Side B, continue with Step 18.

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. Display the Side B MMU card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (EXP-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS-L and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

g. Record the value in the Power table cell for Port 4 (COM-TX).

h. If a Side B OPT-BST-L card is installed, display it in card view and complete Step i. If not, continue 
with Step j.
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i. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step k.

j. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step k.

k. Verify that the value in Step i or j matches the power recorded in Step g, +/– 1.5 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST-L or OSC-CSM card and the MMU cards. 
Check the values again. If they still do not match, contact your next level of support.

l. Continue with Step 19.

Step 18 Verify the connection between the 32WSS-L card and the OPT-BST-L or OSC-CSM cards:

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. If a OPT-BST-L card is installed on Side B, display it in card view and complete Step e. If not, 
continue with Step f.

e. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step g.

f. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step g.

g. Verify that the value in Step e or f matches the power recorded in Step c, +/– 1.0 dB. If so, continue 
with Step 19. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST-L or 
OSC-CSM card and the 32WSS-L cards. Check the values again. If they still do not match, contact 
your next level of support.

Step 19 If an OPT-AMP-L card provisioned in OPT-PRE mode is installed on Side B, complete the following 
steps. If not, continue with Step 20.

a. Display the Side B OPT-AMP-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1 (COM-RX). Record the value.

d. Display the Side B OPT-BST-L or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Port 2 (COM-TX) Power value (for OPT-BST-L cards) or Port 3 (COM-TX) Power value 
(for OSC-CSM cards). Verify that the value matches the power recorded in Step c, +/– 1.5 dB. If 
not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware 
Installation Guide to clean the fiber connection between the OPT-AMP-L card and the OPT-BST-L 
or OSC-CSM card. Check the values again. If they still do not match, contact your next level of 
support.

g. For the Side B OPT-AMP-L card, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and 
Power” task on page 15-6.

Step 20 If an MMU card is installed on Side B, complete the following steps. If an MMU card is not installed on 
Side B, continue with Step 21.

a. Display the Side B MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.
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c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If an OPT-AMP-L card provisioned in OPT-PRE mode is installed on Side B, display it in card view 
and complete Step e. If not, continue with Step f.

e. Click the OPT-PRE Provisioning > Opt.Ampli.Line > Parameters tabs. Record the Total Output 
Power value for Port 2 (COM-TX), then continue with Step i.

f. If a Side B OPT-BST-L card is installed, display it in card view and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side B OSC-CSM card in card view, click the Provisioning > Optical Line > Parameters 
tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that value in the Step e, g, or h matches the power recorded in Step c, +/– 1.0 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the MMU card and the OPT-BST-L or OSC-CSM cards. 
Check the values again. If they still do not match, contact your next level of support.

j. Display the Side B MMU card in card view.

k. Click the Provisioning > Optical Line > Parameters tabs.

l. Record the value in the Power table cell for Port 2 (EXP-TX).

m. Display the Side B 32WSS-L card in card view.

n. Click the Provisioning > Optical Line > Parameters tabs.

o. Verify that the value in the Power table cell for Port 68 (COM-RX) is equal to the value recorded in 
Step l, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS-L and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

p. Continue with Step 22.

Step 21 Verify the connection between the Side B 32WSS-L card and the OPT-BST-L, OPT-AMP-L (in 
OPT-PRE mode), or OSC-CSM card:

a. Display the Side B 32WSS-L in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If a Side B OPT-AMP-L card provisioned in OPT-PRE mode is installed, display it in card view and 
complete Step e. If not, continue with Step f.

e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2 (COM-TX), then continue with Step i.

f. If a Side B OPT-BST-L card is installed, display it in card view and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side B OSC-CSM card in card view. Click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.
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i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the 32WSS-L card and the OPT-AMP-L, OPT-BST-L, 
or OSC-CSM card.

Step 22 Verify the Side B 32WSS-L and 32DMX-L connection:

a. Display the Side B 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs and record the value in the Power table 
cell for Port 69 (DROP-TX).

c. Display the Side B 32DMX-L card in card view.

d. Click the Provisioning > Optical Line > Parameters tabs. Record the value in the Port 2 
(COM-RX) table cell. Verify that the value is equal to the value recorded in b, +/– 1.0 dBm. If not, 
use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware 
Installation Guide to clean the fiber connection between the 32WSS-L and 32DMX-L cards. Check 
the values again. If they still do not match, contact your next level of support.

Step 23 Display the Side B 32DMX-L card in card view.

Step 24 Click the Provisioning > Optical Chn > Parameters tab. Record the CHAN-TX port value under the 
Power parameter for the wavelength under test.

Step 25 Verify that the power value from Step 24 reaches the Shelf i Slot i (32DMX-L).Port CHAN-TX.Power 
set point +/– 2 dBm on Side B. To view this set point: 

a. Go to node view (single-shelf mode) or multishelf view (multishelf mode) and click the 
Provisioning > WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 32DMX-L card.

c. Expand the CHAN-TX category.

d. Select Power.

e. View the value of the Side B Shelf i Slot i (32DMX-L).Port CHAN-TX.Power parameter on the right 
pane.

f. If the power value does not match the value recorded in Step 24 (+/– 2 dBm), contact your next level 
of support.

Step 26 Display the TXP_MR_10E_L card in card view. 

Step 27 Click the Performance > Optics PM > Current Values tabs. 

Step 28 In the Port 2 (Trunk) column, locate the RX Optical Power value. Verify that the value matches the power 
in Step 24, +/– 2 dBm. If the power values do not match (+/– 2 dBm), complete the following steps:

a. Remove, clean, and replace the cable connecting the TXP_MR_10E_C RX port to the Side B fiber 
patch panel DMX port for the tested wavelength. See the “NTP-G115 Clean Fiber Connectors” 
procedure in the Cisco ONS 15454 Hardware Installation Guide. 

b. Repeat this step. If the power values still do not match (+/– 2 dBm) contact your next level of 
support. 

Step 29 Repeat Steps 4 through 28 for the remaining wavelengths. 

Step 30 Display the Side B 32WSS-L card in card view.

Step 31 Click the Maintenance tab.

Step 32 Click the table cell in the Operating Mode column and choose Not Assigned from the drop-down list for 
all wavelengths.

Step 33 Click Apply, then click Yes to confirm.
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Step 34 Disconnect the TXP or tunable laser from the Side B patch panel.

Step 35 Unplug the physical loopback fiber from the line TX and RX in the OPT-BST-L or OSC-CSM card.

Step 36 Return to your originating procedure (NTP).

DLP-G364 Verify the Side A ROADM L-Band Add/Drop Channels

Note Throughout this task, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), display the Alarms tab.

Step 2 Create a physical loopback on the Side A OPT-BST-L or OSC-CSM card by connecting the LINE TX 
port to its LINE RX port. For OPT-BST-L cards, connect a 10-dB bulk attenuator to the fiber. (OSC-CSM 
cards do not require attenuation.)

Caution Failure to use proper attenuation might damage the equipment.

Step 3 Wait 2 to 3 minutes, then click the Alarms tab. Verify that the LOS alarms on the Side A OSCM or 
OSC-CSM card and the OPT-BST-L card have cleared. The clearing of the LOS alarms indicates that the 
OSC link is active on Side A. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

Step 4 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_L card, continue with Step 5.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength you are testing, then continue with Step 7.

Purpose This procedure verifies the signal flow through Side A of a ROADM node 
for L-band add/drop channels.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_L

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 5 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. Refer to Table 15-1 on page 15-42, if needed.

Step 6 If you are using a TXP_MR_10E_L card, complete the following steps. If you are using a tunable laser, 
continue with Step 7. 

a. Display the TXP_MR_10E_L in card view.

b. Click the Performance > Optics PM > Current Values tabs. 

c. Locate the Port 2 (Trunk) table cell for the TX Optical Pwr parameter. Record the value.

Step 7 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the Side A fiber 
patch panel MUX port that corresponds to the Side A 32WSS-L card port carrying the tested wavelength.

Step 8 Connect the TXP_MR_10E_L DWDM RX port or the power meter RX port to the Side A fiber patch 
panel DMX port that is connected with the Side A 32DMX-L card CHAN-TX port carrying the tested 
wavelength. (If the TXP_MR_10E_L card was installed during Chapter 14, “Turn Up a Node” simply 
verify the cable connection.)

Step 9 Display the 32WSS-L card in card view.

Step 10 Click the Maintenance tab.

Step 11 For each wavelength that you will test, click the table cell in the Operating Mode column and choose 
Add Drop from the drop-down list.

Step 12 Click Apply and then Yes, to confirm.

Step 13 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-1 on page 15-42, if 
needed.

Step 14 Find the tested wavelength CHAN RX port, then scroll to the right until you see the Power Add 
parameter. Verify that the Power Add value for the tested port CHAN RX is equal to the output power 
level of the tunable laser or the TXP_MR_10E_L card measured in Step 6, +/– 1.0 dBm.

Step 15 Click the Provisioning > Optical Line > Parameters tabs and record the value in the Power table cell 
for Port 67 (COM-TX) for the wavelength under test.

Step 16 Verify that the power value from Step 15 reaches the Shelf i Slot i (32WSS-L).Port COM-TX.Power +/– 
1.0 dBm on Side A. To view this set point:

a. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 32WSS-L card on Side A.

c. Expand the Port COM-TX category.

d. Select Power.

e. View the Shelf i Slot i (32WSS-L).Port COM-TX.Power parameter on the right pane.

f. If the power value does not match the value recorded in Step 15 (+/– 2.0 dBm), contact your next 
level of support.

Step 17 If an MMU card is installed on Side A, complete the following steps. If an MMU card is not installed on 
Side A, continue with Step 18.

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. Display the Side A MMU card in card view.
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e. Click the Provisioning > Optical Line > Parameters tabs.

f. Verify that the value in the Power table cell for Port 1 (EXP-RX) is equal to the value recorded in 
Step c, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide  to clean the fiber connection between the 32WSS-L and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

g. Record the value in the Power table cell for Port 4 (COM-TX).

h. If a Side A OPT-BST-L card is installed, display it in card view and complete Step i. If not, continue 
with Step j.

i. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step k.

j. Display the Side A OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step k.

k. Verify that the value in Step i or j matches the power recorded in Step g, +/– 1.5 dB. If not, use the 
“NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the OPT-BST-L or OSC-CSM card and the MMU cards. 
Check the values again. If they still do not match, contact your next level of support.

l. Continue with Step 19.

Step 18 Verify the connection between the 32WSS-L card and the OPT-BST-L or OSC-CSM cards:

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Record the value in the Power table cell for Port 67 (COM-TX).

d. If a OPT-BST-L card is installed on Side A, display it in card view and complete Step e. If not, 
continue with Step f.

e. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 1 
(COM-RX), then continue with Step g.

f. Display the Side A OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 2 (COM-RX), then continue with Step g.

g. Verify that the value in Step e or f matches the power recorded in Step c, +/– 1.0 dB. If so, continue 
with Step 19. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the OPT-BST-L or 
OSC-CSM card and the 32WSS-L cards. Check the values again. If they still do not match, contact 
your next level of support.

Step 19 If an OPT-AMP-L card provisioned in OPT-PRE mode is installed on Side A, complete the following 
steps. If not, continue with Step 20.

a. Display the Side A OPT-AMP-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Power parameter for Port 1 (COM-RX). Record the value.

d. Display the Side A OPT-BST-L or OSC-CSM card in card view.

e. Click the Provisioning > Optical Line > Parameters tabs.

f. Locate the Port 2 (COM-TX) Power value (for OPT-BST-L cards) or Port 3 (COM-TX) Power value 
(for OSC-CSM cards). Verify that the value matches the power recorded in Step c, +/– 1.5 dB. If 
not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware 
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Installation Guide to clean the fiber connection between the OPT-AMP-L card and the OPT-BST-L 
or OSC-CSM card. Check the values again. If they still do not match, contact your next level of 
support.

g. For the Side A OPT-AMP-L card, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and 
Power” task on page 15-6.

Step 20 If an MMU card is installed on Side A, complete the following steps. If an MMU card is not installed on 
Side A, continue with Step 21.

a. Display the Side A MMU card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If an OPT-AMP-L card provisioned in OPT-PRE mode is installed on Side A, display it in card view 
and complete Step e. If not, continue with Step f.

e. Click the OPT-PRE Provisioning > Opt.Ampli.Line > Parameters tabs. Record the Total Output 
Power value for Port 2 (COM-TX), then continue with Step i.

f. If a Side A OPT-BST-L card is installed, display it in card view and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side A OSC-CSM card in card view, click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that value in the Step e, g, or h matches the power recorded in Step c, +/– 1.0 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the MMU card and the OPT-BST-L or OSC-CSM cards. 
Check the values again. If they still do not match, contact your next level of support.

j. Display the Side A MMU card in card view.

k. Click the Provisioning > Optical Line > Parameters tabs.

l. Record the value in the Power table cell for Port 2 (EXP-TX).

m. Display the Side A 32WSS-L card in card view.

n. Click the Provisioning > Optical Line > Parameters tabs.

o. Verify that the value in the Power table cell for Port 68 (COM-RX) is equal to the value recorded in 
Step l, +/– 1.0 dB. If not, use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 
15454 Hardware Installation Guide to clean the fiber connection between the 32WSS-L and MMU 
cards. Check the values again. If they still do not match, contact your next level of support.

p. Continue with Step 22.

Step 21 Verify the connection between the Side A 32WSS-L card and the OPT-BST-L, OPT-AMP-L (in 
OPT-PRE mode), or OSC-CSM card:

a. Display the Side A 32WSS-L in card view.

b. Click the Provisioning > Optical Line > Parameters tabs.

c. Locate the Port 68 (COM-RX) Power parameter. Record the value.

d. If a Side A OPT-AMP-L card provisioned in OPT-PRE mode is installed, display it in card view and 
complete Step e. If not, continue with Step f.

e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs and read the Total Output Power 
value for Port 2 (COM-TX), then continue with Step i.
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f. If a Side A OPT-BST-L card is installed, display it in card view and complete Step g. If not, continue 
with Step h.

g. Click the Provisioning > Optical Line > Parameters tabs and read the Power value for Port 2 
(COM-TX), then continue with Step i.

h. Display the Side A OSC-CSM card in card view. Click the Provisioning > Optical Line > 
Parameters tabs and read the Power value for Port 3 (COM-TX), then continue with Step i.

i. Verify that the value in Step e, g, or h matches the power recorded in Step c, +/– 1.5 dB. If not, use 
the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation 
Guide to clean the fiber connection between the 32WSS-L card and the OPT-AMP-L, OPT-BST-L, 
or OSC-CSM card.

Step 22 Verify the Side A 32WSS-L and 32DMX-L connection:

a. Display the Side A 32WSS-L card in card view.

b. Click the Provisioning > Optical Line > Parameters tabs and record the value in the Power table 
cell for Port 69 (DROP-TX).

c. Display the Side A 32DMX-L card in card view.

d. Click the Provisioning > Optical Line > Parameters tabs. Record the value in the Port 2 
(COM-RX) table cell. Verify that the value is equal to the value recorded in b, +/– 1.0 dBm. If not, 
use the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware 
Installation Guide to clean the fiber connection between the 32WSS-L and 32DMX-L cards. Check 
the values again. If they still do not match, contact your next level of support.

Step 23 Display the Side A 32DMX-L card in card view.

Step 24 Click the Provisioning > Optical Chn > Parameters tab. Record the CHAN-TX port value under the 
Power parameter for the wavelength under test.

Step 25 Verify that the power value from Step 24 reaches the Shelf i Slot i (32DMX-L).Port CHAN-TX.Power 
set point +/– 2 dBm on Side A. To view this set point: 

a. Go to node view (single-shelf mode) or multishelf view (multishelf mode) and click the 
Provisioning > WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 32DMX-L card on Side A.

c. Expand the Port CHAN-TX category.

d. Select Power.

e. View the value of the Shelf i Slot i (32DMX-L).Port CHAN-TX.Power parameter on the right pane.

f. If the power value does not match the value recorded in Step 24 (+/– 2 dBm), contact your next level 
of support.

Step 26 Display the TXP_MR_10E_L card in card view. 

Step 27 Click the Performance > Optics PM > Current Values tabs. 

Step 28 In the Port 2 (Trunk) column, locate the RX Optical Power value. Verify that the value matches the power 
in Step 24, +/– 2 dBm. If the power values do not match (+/– 2 dBm), complete the following steps:

a. Remove, clean, and replace the cable connecting the TXP_MR_10E_L RX port to the Side A fiber 
patch panel DMX port for the tested wavelength. See the “NTP-G115 Clean Fiber Connectors” 
procedure in the Cisco ONS 15454 Hardware Installation Guide 

b. Repeat this step. If the power values still do not match (+/– 2 dBm) contact your next level of 
support. 

Step 29 Repeat Steps 4 through 28 for the remaining wavelengths. 
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Step 30 Display the Side A 32WSS-L card in card view.

Step 31 Click the Maintenance tab.

Step 32 Click the table cell in the Operating Mode column and choose Not Assigned from the drop-down list for 
all wavelengths.

Step 33 Click Apply, then click Yes to confirm.

Step 34 Disconnect the TXP or tunable laser from the Side A patch panel.

Step 35 Unplug the physical loopback fiber from the line TX and RX in the OPT-BST-L or OSC-CSM card.

Step 36 Return to your originating procedure (NTP).

NTP-G180 Perform the ROADM Node with 40-WSS-C and 
40-DMX-C Cards Acceptance Test 

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node” they can be used for this procedure. No additional cabling changes are needed.

Note Because the node is isolated and no line-side fibers are connected during the test, the power levels going 
into the line-side cards will not be the same as the levels after the node is connected to the network. 
Therefore, if the ROADM shelf does not contain either OPT-BST or OPT-BST-E amplifiers, and 
OPT-PRE amplifiers on both the Side B and Side A sides, lower the OPT-PRE power thresholds so that 
the ROADM shelf turns on properly. At the end of the test, you will run ANS to configure the node with 
the correct parameters for the network acceptance test.

Purpose This acceptance test verifies that a ROADM node provisioned for C-band 
wavelengths is operating properly before you connect it to the network. 
The test verifies the operation of the amplifiers and also verifies that each 
add/drop and pass-through port on the 40-WSS-C and 40-DMX-C cards 
operates properly. The test also checks the power levels at each transmit 
and receive port to ensure that power loss in the cabling is within tolerance. 
If MMU cards are installed, the test verifies that the MMU insertion loss 
does not impact add, drop, or pass through circuits.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note Throughout this procedure, Side A refers to Slots 1 through 8, and Side B refers to Slots 10 through 17.

Step 1 Make a copy of Table 15-2 on page 15-65 and place it in a convenient location for reference throughout 
this procedure. The table shows the 40-WSS-C ports and the wavelengths assigned to them. The 
40 wavelengths are divided among five physical multi-fiber push on (MPO) connectors on the 
40-WSS-C card. Each MPO connector is assigned eight wavelengths. In Cisco Transport controller 
(CTC), the MPO connector appears in the card view Provisioning > Optical Chn:Optical Connector tab. 
Each Optical Connector subtab represents an MPO connector. Ports 1 through 40 are the channel 
(CHAN) RX (add) ports; Ports 41 through 80 are the pass-through ports.

Step 2 Complete the “DLP-G46 Log into CTC” task at the ROADM node that you want to test. If you are 
already logged in, continue with Step 3.

Step 3 Display the ROADM node in node view (single-shelf mode) or multishelf view (multishelf mode). 

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate LOS alarms on the OPT-BST, 
OPT-BST-E, or OPT-AMP-C cards, and on the OSC-CSM and OSCM cards. If OSCM cards are 
installed in ANSI shelves, EOC SDCC Termination Failure alarms will also appear.

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are either Success - Changed 
or Success - Unchanged. If any are not, complete the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Note The OSC terminations created will generate LOS alarms on the OPT-BST, OPT-BST-E, 
OPT-AMP-C cards and on the OSC-CSM and OSCM cards. If OSCM cards are installed in 
ANSI shelves, EOC DCC Termination Failure alarms will also appear.

Step 6 If MMU cards are installed, complete the following steps. If not, continue with Step 7.

a. Display the Side B MMU in card view.

b. Click the Provisioning > Optical Line > Parameters tabs. 

c. Click the Admin State table cell for the COM RX, COM TX, EXP RX, and EXP TX ports and 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list.

d. Click Apply, then click Yes to confirm. 

e. Display the Side A MMU in card view.
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f. Click the Provisioning > Optical Line > Parameters tabs. 

g. Click the Admin State table cell for the COM RX, COM TX, EXP RX, and EXP TX ports and 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the drop-down list.

Step 7 Display the Side B 40-WSS-C in card view.

Step 8 Click the Provisioning > Optical Chn Optical Connector n > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you will test. Refer to Table 15-2, if needed.

Step 9 Click the Admin State table cell for the add port carrying the tested wavelength, then choose OOS,MT 
(ANSI) or Locked,maintenance (ETSI) from the drop-down list. For example, if the tested wavelength 
is 1530.33 nm (shown as 1530.3), you would click the Port 1 (CHAN-RX) Admin State field and choose 
OOS,MT or Locked,maintenance from the drop-down list. 

Step 10 Change the administrative state of the pass-through port corresponding to the port in Step 9 to OOS,MT 
(ANSI) or Locked,maintenance (ETSI). For example, if the tested wavelength is 1530.33 nm (shown 
as 1530.3), you would click the Port 33 (PASS-THROUGH) Admin State field and choose OOS,MT or 
Locked,maintenance from the drop-down list. Refer to Table 15-2, if needed.

Table 15-2 40-WSS-C Ports and Wavelengths Test Checklist

40-WSS-C Provisioning 
Subtab Port # Wavelength

Tested: 
Pass-Through

Tested: 
Add/Drop 
Side A

Tested: 
Add/Drop 
Side B

Optical Chn: 

Optical Connector 1

RX 1, PT 41 1530.33

RX 2, PT 42 1531.12

RX 3, PT 43 1531.90

RX 4, PT 44 1532.68

RX 5, PT 45 1533.47

RX 6, PT 46 1533.47

RX 7, PT 47 1535.04

RX 8, PT 48 1535.82

Optical Chn: 

Optical Connector 2

RX 9, PT 49 1536.81

RX 10, PT 50 1537.40

RX 11, PT 51 1538.19

RX 12, PT 52 1538.98

RX 13, PT 53 1539.77

RX 14, PT 54 1540.56

RX 15, PT 55 1541.35

RX 16, PT 56 1542.14
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Step 11 Click Apply, then click Yes to confirm. 

Step 12 Repeat Steps 8 through 11 for each wavelength that you will test. 

Step 13 Display the Side A 40-WSS-C in card view.

Step 14 Repeat Steps 8 through 12 for the Side A 40-WSS-C card.

Step 15 Display the Side B 40-DMX-C card in card view and complete the following steps:

a. Choose the Provisioning > Optical Line > Parameters tabs.

b. For Port 41 (COM-RX), click the Admin State table cell and choose OOS,MT (ANSI) or 
Locked,maintenance (ETSI) from the drop-down list.

c. Click Apply, then click Yes to confirm. 

Step 16 Repeat Step 15 for the Side A 40-DMX-C card.

Optical Chn: 

Optical Connector 3

RX 17, PT 57 1542.19

RX 18, PT 58 1543.73

RX 19, PT 59 1544.53

RX 20, PT 60 1545.32

RX 21, PT 61 1546.12

RX 22, PT 62 1546.92

RX 23, PT 63 1547.72

RX 24, PT 64 1548.51

Optical Chn: 

Optical Connector 4

RX 25, PT 65 1549.32

RX 26, PT 66 1550.12

RX 27, PT 67 1550.92

RX 28, PT 68 1551.72

RX 29, PT 69 1552.52

RX 30, PT 70 1553.33

RX 31, PT 71 1554.13

RX 32, PT 72 1554.94

Optical Chn: 

Optical Connector 5

RX 33, PT 73 1555.75

RX 34, PT 74 1556.55

RX 35, PT 75 1557.36

RX 36, PT 76 1558.17

RX 37, PT 77 1558.98

RX 38, PT 78 1559.71

RX 39, PT 79 1560.61

RX 40, PT 80 1561.42

Table 15-2 40-WSS-C Ports and Wavelengths Test Checklist

40-WSS-C Provisioning 
Subtab Port # Wavelength

Tested: 
Pass-Through

Tested: 
Add/Drop 
Side A

Tested: 
Add/Drop 
Side B
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Step 17 Complete the “DLP-G310 Verify ROADM Node C-Band Pass-Through Channels with 32WSS and 
40-WSS-C Cards” task on page 15-30. 

Step 18 Complete the following tasks for channels that will be added or dropped on the node.
DLP-G311 Verify the Side A or Side B ROADM C-Band Add/Drop Channels with 32WSS and 
40-WSS-C Cards, page 15-35

Step 19 If MMU cards are installed, complete the following steps. If not, continue with Step 20.

a. Display the Side B MMU in card view.

b. Click the Provisioning > Optical Line > Parameters tabs. 

c. Click Admin State for the COM RX, COM TX, EXP RX, and EXP TX ports and choose IS,AINS 
(ANSI) or Unlocked,automaticInService (ETSI) from the drop-down list.

d. Click Apply, then click Yes to confirm. 

e. Display the Side A MMU in card view.

f. Click the Provisioning > Optical Line > Parameters tabs. 

g. Click Admin State for the COM RX, COM TX, EXP RX, and EXP TX ports and choose IS,AINS 
(ANSI) or Unlocked,automaticInService (ETSI) from the drop-down list.

Step 20 Display the Side B 40-WSS-C in card view.

Step 21 Click the Provisioning > Optical Chn Optical Connectorn > Parameters tabs, where n = the optical 
connector number that carries the wavelengths you tested. 

Step 22 Click the Admin State table cell then choose IS,AINS (ANSI) or Unlocked,automaticInService 
(ETSI) from the drop-down list for all ports that were changed to OOS,MT or Locked,Maintenance in 
Steps 9 and 10.

Step 23 Click Apply.

Step 24 Repeat Steps 21 through 23 for all the ports that are in OOS,MT or Locked,maintenance state on the 
Side B 40-WSS-C card. 

Step 25 Display the Side A 40-WSS-C in card view. 

Step 26 Repeat Steps 21 through 23 for all ports on the Side A 40-WSS-C card. 

Step 27 Display the Side B 40-DMX-C in card view.

Step 28 Choose the Provisioning > Optical Line > Parameters tabs.

Step 29 For Port 33, click the Admin State table cell and choose IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI) from the drop-down list.

Step 30 Click Apply.

Step 31 Display the Side A 40-DMX-C card in card view.

Step 32 Repeat Steps 28 through 30 for the Side A 40-DMX-C card.

Step 33 Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task.

Step 34 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

Step 35 Create the two OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 36 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.
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b. Verify that no equipment failure alarms appear on the node. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Stop. You have completed this procedure.

NTP-G276 Perform the 80-Channel n-degree ROADM Node 
Acceptance Tests

Note Identify the sides that are already carrying traffic and the sides that are going to be tested.

Step 1 Complete the “DLP-G46 Log into CTC” task at the mesh native node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab.

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(An equipment alarm is indicated in the Alarms tab, Cond column as EQPT.) If equipment failure 
alarms are present, investigate and resolve them before continuing. For information on how to clear 
an alarm, see the Cisco ONS 15454 DWDM Troubleshooting Guide.

Purpose This procedure checks the power values and the optical connections for an 
80 channel n-degree ROADM node. Use this test for both existing and new 
installations of 80 channel ROADM nodes. Use this procedure to also test 
the installation of a new side to a node. This procedure cannot be 
performed on the node on which the OPT-RAMP-C or OPT-RAMP-CE 
card is installed.

Tools/Equipment • Fully C-band tunable transponder or tunable laser source with an LC 
patchcord

• 1 LC-LC adapter

• 15dB optical attenuator

• Optical power meter

Prerequisite Procedures • All sides must be completely fibered (including mesh patch panels); 
for more information, see Chapter 14, “Turn Up a Node”

• “NTP-G186 Perform the Four-Degree and Eight-Degree Mesh Patch 
Panel Acceptance Test” section on page 15-115 (optional)

• “NTP-G37 Run Automatic Node Setup” procedure on page 14-126

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 4 Insert a full C-band tunable transponder into an available slot on the side that you want to test.

Note In this procedure Side A through H is referred as Side x.

Step 5 Connect the TX port of the transponder to the EADi (where i=1) port of the 80-WXC-C card on the side 
to be tested.

Step 6 Select a wavelength that is not already used by a side carrying traffic. Select 1530.33 nm for a new 
installation. Set the transponder wavelength to the selected wavelength yyyy.yy by completing the 
“DLP-G432 Set the Transponder Wavelength” task on page 15-125.

Step 7 Place the trunk port of the transponder in the In-Service (IS) state.

Step 8 In node view, click the Provisioning > WDM-ANS > Provisioning tabs and record the Power value of 
the COM port of the 80-WXC-C card for the side you are verifying.

Step 9 On Side x, go to the card view of the 80-WXC-C card and complete the following steps:

a. Click the Provisioning > WXC Line > Parameters tabs and record the Power value of the EADi 
port.

b. Click the Maintenance > OCHNC tabs.

• Set the Target Power to the value recorded in Step 8.

Note The target power is not set if the power value recorded in Step 8 is higher than the channel power 
that is allocated and equalized.

• From the Port pull-down menu, select EADi and from the Wavelength pull-down menu, select 
yyyy.yy

c. Click Refresh and verify that the target power is reached.

d. Place the trunk port of the transponder in OutofService (OOS) state.

Step 10 To check the wavelengths for the EAD1 port, repeat from Step 6 and Step 9d for the remaining 79 
wavelengths.

Note It is not mandatory to test the 80 wavelengths for all the ports (EADi where i = 1 to 8).

Step 11 Disconnect the transponder from EADi port and restore the fiber connection to the EADi port.

Step 12 Repeat Step 5 through Step 11 for the remaining EADi ports where i = 2 to 8.

Step 13 Plug a 15-dB LC attenuator into the trunk TX port of the transponder card.

Step 14 Select a wavelength that is not already used by a side carrying traffic. Select 1530.33 nm for a new 
installation. Set the transponder wavelength to the selected wavelength yyyy.yy by completing the 
“DLP-G432 Set the Transponder Wavelength” task on page 15-125.

Step 15 Connect the optical power meter to the trunk TX port of the transponder card.

Step 16 Complete the “DLP-G433 Record Transponder Optical Power” task on page 15-126.

Step 17 Disconnect the optical power meter from the TX port of the transponder card.

Step 18 In card view, display the OPT-AMP-C card configured as LINE for Side x (slot 1 or 17) and complete 
the following steps:

a. Click the Maintenance > ALS tabs and from the OSRI pull-down menu, select OFF.
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b. From the ALS Mode pull-down menu, select Disable.

Step 19 Make the following connections:

a. Connect the transponder output port (with the 15-dB attenuator) to the Line RX port of the booster 
amplifier (OPT-AMP-C configured as LINE in slot 1 or 17) on Side x.

b. Connect the optical power meter to the LINE-TX port of the booster amplifier (OPT-AMP-C 
configured as LINE in slot 1 or 17) on Side x.

c. Use a fiber jumper to connect the DROP-TX port to the AD port of the 80-WXC-C card for Side x.

Step 20 Create an OCHNC DCN circuit for wavelength yyyy.yy from LINE amplifier of Side x to local add/drop 
ports of the 80-WXC-C card of Side x using the “DLP-G105 Provision Optical Channel Network 
Connections” task on page 17-44 and wait till all the alarms clear.

Step 21 In card view, display the booster amplifier card for Side x. Click the Inventory > Info tabs and record 
the IL02 (LINE RX->COM TX) insertion loss value.

Step 22 In card view, display the transponder card and click the Provisioning > Line tabs. For the trunk port, 
choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the Admin State drop-down list and 
click Apply.

Step 23 In card view, display the booster amplifier card for Side x, and complete the following steps:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

b. Verify the power value of the COM-TX port = (Optical power meter value in Step 16) – (LINE 
RX->COM TX insertion loss value read in Step 21) (+\– 1 dB).

Step 24 In card view, display the preamplifier card (OPT-AMP-C configured as PRE in slot 2 or 16) for Side x 
and complete the following steps:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the COM-RX power value matches the value in Step 23 b(+\– 1 dB).

c. Click the Provisioning > Opt. Ampli. Line > Parameters tabs and record the Total Output Power 
value of the LINE-TX port.

Step 25 In card view, display the 80-WXC-C card for Side x and complete the following steps:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the value matches the LINE-TX port power value in Step 24c (+/- 1dB).

c. Click the Inventory > Info tabs and record the COM-RX -> EXP-TX insertion loss.

d. Record the COM-RX -> DROP-TX insertion loss.

e. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.

f. Record the Power value of the DROP-TX port.

g. Verify that the EXP-TX Power value inStep 25e = (COM-RX value in Step 25a) – (COM-RX -> 
EXP-TX value in Step 25c) (+\– 1 dB).

h. Click the Provisioning > WXC Line > Parameters tabs and record the Power value of the AD port.

i. Verify that the value matches the DROP-TX port power value in Step 25f (+/- 1dB).

j. Click the Provisioning > WXC Line > Parameters tabs and record the Power value of the COM 
port.
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k. Verify that the power value in Step 25j matches the COM port power value in the node view > 
Provisioning > WDM-ANS > Provisioning tabs for the 80-WXC-C card under test.

Step 26 In card view, display the 80-WXC-C card for a side different from Side x and complete the following 
steps:

Note This step must be performed for a single wavelength yyyy.yy only that is not used on any of the installed 
sides.

a. Click the Maintenance > Wavelength Power tabs and select PORT EADi, where i depends on the 
value of x. (x,i) = (A,1) (B,2) (C,3) (D,4) (E,5) (F,6) (G,7) (H,8)

b. Record the power value for wavelength yyyy.yy.

c. Verify if the power value in Step 26b is equal to the (power value recorded in Step 25e - 8dB) if a 
PP-MESH-4 is used or is equal to the (power value recorded in Step 25e - 12dB) if a PP-MESH-8 
is used.

Step 27 In card view, display the booster amplifier card for Side x, and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify COM-RX Power value matches the COM Power value in Step 25j (+\– 1 dB).

c. Click the Provisioning > Opt. Ampli. Line > Parameters tabs and record the Power value of the 
LINE-TX port.

d. Verify that the LINE-TX value matches the power on the LINE-TX port power value in node view 
> Provisioning > WDM-ANS > Provisioning tabs (+\– 2 dB).

e. Record the optical power meter value.

f. Verify that the optical power meter value matches the LINE-TX value in Step 27c (+\– 1 dB).

Step 28 Delete the OCHNC DCN circuit on wavelength yyyy.yy from LINE amplifier of Side x to local add/drop 
ports of the 80-WXC-C card of Side x using the “DLP-G106 Delete Optical Channel Network 
Connections” task on page 17-49.

Step 29 In card view, display the transponder card and click the Provisioning > Line tabs. For the trunk port, 
choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list and 
click Apply.

Step 30 To test all wavelengths, repeat Step 6 through Step 29 for each wavelength. In Step 6, set the wavelength 
to the next wavelength.

Step 31 Remove the fiber jumper connected between the DROP-TX port and the AD port in the 80-WXC-C card 
on Side x.

Step 32 Restore the original connections between the AD and DROP-TX ports of the 80-WXC-C card and the 
respective ports of the 15216 40 or 48-channel mux/demux patch panel according to the Cisco Transport 
Planner Internal Connections Report.

Step 33 Use a fiber jumper to connect the TX port to the RX port associated to the wavelength yyyy.yy to be tested 
in the 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD or in the 15216-MD-40-EVEN, 
15216-EF-40-EVEN, or 15216-MD-48-EVEN unit for Side x (depending on which 15216 40 or 
48-channel mux/demux patch panel the wavelength yyyy.yy is managed).

Step 34 Select a wavelength yyyy.yy on the full C band tunable transponder. Complete the “DLP-G432 Set the 
Transponder Wavelength” task on page 15-125 to tune the transponder for the selected wavelength 
yyyy.yy.
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Step 35 Create an OCHNC DCN circuit on wavelength yyyy.yy from LINE amplifier of side x to local add/drop 
ports of the 80-WXC-C card of Side x using the “DLP-G105 Provision Optical Channel Network 
Connections” task on page 17-44 and wait till all the alarms clear on the node.

Step 36 In card view, display the 80-WXC-C card for Side x and complete the following steps:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
DROP-TX port.

b. Click the Provisioning > WXC Line > Parameters tabs and record the Power value of the AD port.

c. Verify that the Power value of the AD port in Step 36b is > the Power value of the DROP-TX port 
in Step 36a – 18dB.

Step 37 Delete the OCHNC DCN circuit on wavelength yyyy.yy from LINE amplifier of Side x to local add/drop 
ports of the 80-WXC-C card of Side x using the “DLP-G106 Delete Optical Channel Network 
Connections” task on page 17-49.

Step 38 In card view, display the transponder card and click the Provisioning > Line tabs. For the trunk port, 
choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list and 
click Apply.

Step 39 Remove the fiber jumper that was connected in Step 33 between the TX and RX ports associated to the 
tested wavelength yyyy.yy on the 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD or 
the 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN unit for Side x.

Step 40 To verify all the 40 ports of the 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD unit 
and the 40 ports of the 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN unit, repeat 
the previous steps from Step 33 through Step 38 by changing the wavelength yyyy.yy to cover all other 
79 available wavelengths.

Step 41 Disconnect the optical power meter from the LINE-TX port of the booster amplifier of the Side x.

Step 42 Disconnect the transponder output port (with the 15-dB attenuator) from the LINE-RX port of the 
booster amplifier of the Side x.

Step 43 Repeat Step 4 through Step 42 for all the others sides that are being installed.

Step 44 In card view, display the OPT-AMP-C card configured as LINE for Side x (slot 1 or 17) and complete 
the following:

a. Click the Maintenance > ALS tabs and from the OSRI pull-down menu, select OFF.

b. From the ALS Mode pull-down menu, select Auto Restart.

Stop. You have completed this procedure.

NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test

Purpose This procedure tests an anti-ASE hub node. 

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed
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Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If alarms appear, 
investigate and resolve them before continuing. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate two alarms for each side of the 
shelf: one for LOS on the OPT-BST or OPT-BST-E card, and the other for LOS on the OSC-CSM 
or OSCM card.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed or 
Success - Unchanged. If any are not, complete the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 5 From your Cisco TransportPlanner site configuration file, identify the dropped and added channels that 
are configured in pass-through mode in both directions. 

Note Configuring a channel pass-through mode means that the channel is dropped along one direction 
by a 32DMX-O/32DMX or 40-DMX-C (15xx.xx TX port) located on one side (Side A or 
Side B) of the shelf, and then added by a 32MUX-O/40-DMX-C (1522.22 RX port) on the 
opposite side of the shelf but in the same direction. The channel is not terminated inside the site.

Step 6 Create a loopback on the Side A OPT-BST or OPT-BST-E amplifier by connecting a patchcord from the 
LINE TX port to the LINE RX port with a 10-dB bulk attenuator.

Step 7 Verify that the OSC link becomes active on the Side A OSCM or OSC-CSM card. (The OSC termination 
must already be provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure 
on page 14-124.)

Step 8 For pass-through channels, continue with Step 9. For add and drop channels, continue with Step 18.

Onsite/Remote Onsite

Security Level Superuser only
15-73
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html#task_4B9E3FA74B7D4D759A8BB5CED1311F46
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_A03F893E3EFB4CC5A4035130606A00BF


 

Chapter 15      Perform Node Acceptance Tests
DLP-  G364 Verify the Side A ROADM L-Band Add/Drop Channels
Step 9 Verify the first channel connection configured in pass-through mode in both directions:

a. If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If you are 
using a TXP_MR_10E_C card, continue with Step b.

b. Set the tunable laser or TXP_MR_10E_C card to a corresponding wavelength on the 100-GHz 
ITU-T grid. Refer to the tunable laser manufacturer’s documentation or the “DLP-G358 Provision 
TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

c. Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the LINE RX 
port of the Side B OPT-BST or OPT-BST-E using a 10-dB bulk attenuator.

Step 10 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 for the 
Side B OPT-PRE amplifier.

Step 11 Complete the “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7 for the 
Side A 32MUX-O or 40-MUX-C cards.

Step 12 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the Side A OPT-BST or OPT-BST-E amplifier.

Step 13 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 for the 
Side A OPT-PRE amplifier.

Step 14 Complete the “DLP-G269 Verify the 32DMX-O or 40-DMX-C Card Power” task on page 15-7 for the 
Side A 32DMX-O or 40-DMX-C cards.

Step 15 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the Side B OPT-BST or OPT-BST-E amplifier.

Step 16 Repeat Steps 9 through 15 for the remaining wavelengths on the 100-GHz grid that are pass-through 
wavelengths. 

Step 17 If you have add and drop channels, continue with Step 18 to verify the channels. If not, continue with 
Step 30.

Step 18 Set the tunable laser or TXP_MR_10E_C card to the first wavelength of the 100-GHz ITU-T grid that is 
not a pass-through wavelength. Refer to the tunable laser manufacturer’s documentation or the 
“DLP-G358 Provision TXP_MR_10E_L and TXP_MR_10E_C Cards for Acceptance Testing” task on 
page 15-25.

Step 19 Connect the tunable laser or TXP_MR_10E_C card to the CHAN RX nn port on the Side A 32MUX-O 
card, where nn is the first add or drop channel.

Step 20 Display the Side A 32MUX-O or 40-MUX-C card in card view.

Step 21 Click the Provisioning > Optical Chn > Parameters tabs.

Step 22 Change the administrative state of Port nn to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 23 Check that the power value on Port nn reaches the provisioned set point (VOA Power Ref).

Step 24 Display the Side A 32DMX-O/32DMX OR 40-DMX-C card in card view.

Step 25 Click the Provisioning > Optical Chn > Parameters tabs.

Step 26 Change the administrative state of Port nn to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 27 Check that the power value on Port nn reaches the provisioned set point (VOA Power Ref).

Step 28 Connect a power meter to the CHAN TX nn port through the patch panel and verify that the physical 
optical power coming out of drop Port nn on the Side A 32DMX-O/32DMX or 40-DMX-C card is 
consistent with the value read on the meter within 0.5 dB.

Step 29 Repeat Steps 18 through 28 for the remaining wavelengths on the 100-GHz grid that are not pass-through 
wavelengths. 
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Step 30 Remove the loopback connection on the Side A OPT-BST or OPT-BST-E card.

Step 31 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 32 Create a loopback on the Side B OPT-BST or OPT-BST-E amplifier by connecting a patchcord from the 
LINE TX port to the LINE RX port with 10-dB bulk attenuator.

Step 33 Verify that the OSC link becomes active on the Side B OSCM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.)

Step 34 Repeat 18 through 31 for Side B add and drop cards.

Step 35 Remove the loopback on the Side B OPT-BST or OPT-BST-E card.

Step 36 Restore the default administrative state (IS,AINS/Unlocked,automaticInService) on all the ports 
previously set to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Stop. You have completed this procedure.

NTP-G45 Perform the C-Band and L-Band Line Amplifier Node 
with OSCM Cards Acceptance Test

Note To perform L-Band line amplifier node with OSCM cards acceptance test, repeat all the procedures in 
this NTP by replacing the TXP_MR_10E_C card with TXP_MR_10E_L card and OPT-BST card with 
the OPT-BST-L

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Purpose This procedure tests the C-band and L-band line amplifier node with 
OSCM cards installed on both the Side B and Side A sides of the shelf by 
looping a single wavelength through the shelf.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C for C-band testing

• TXP_MR_10E_L for L-band testing

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_10E_C cards, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Home View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If alarms appear, 
investigate and resolve them before continuing. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate two alarms for each side of the 
shelf, one for LOS on the OPT-BST or OPT-BST-E card and the other for LOS on the OSCM 
card.

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If any are not, complete the following steps:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 6 Create a loopback on the Side A OPT-BST or OPT-BST-E card by using a fiber with a 10-dB bulk 
attenuator to connect the LINE TX port to the LINE RX port.

Step 7 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with Step 8.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 9.

Step 8 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25, for the TXP transmitting the 
wavelength you will test. Refer to Table 11-41 on page 11-169, if needed.

Step 9 Connect the tunable laser transmitter, the TXP_MR_10E_C card, or DWDM TX port to the LINE RX 
port of the Side B OPT-BST or OPT-BST-E card using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 10 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarms on the Side A OPT-BST or OPT-BST-E and OSCM cards 
have cleared. The clearing of the LOS alarms indicates that the OSC link is active on Side A. 
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Note For ANSI shelves, an EOC DCC Termination Failure alarm continues to appear due to the OSC 
signal loopback. An LOS-O alarm appears on the Side B OPT-BST or OPT-BST-E card, and an 
LOS alarm appears on the Side B OCSM card.

If the alarms clear, continue with Step 11. If not, perform the following steps:

a. Display the Side A OPT-BST or OPT-BST-E card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. In the Types area, click Alarms, then click Refresh. 

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarm on the Side A OPT-BST or OPT-BST-E card has 
cleared. If so, continue with Step 11. If not, disconnect the OSCM card from the OPT-BST card.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

i. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarm on the Side A OSCM card has cleared. If so, replace 
the OPT-BST or OPT-BST-E card. If not, replace the OSCM card. See the “NTP-G30 Install the 
DWDM Cards” procedure on page 14-64.

Step 11 If an OPT-PRE card or an OPT-AMP-L card (provisioned as an OPT-PRE) is installed on Side B, 
complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6. If not, 
continue with Step 12.

Step 12 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the Side A OPT-BST or OPT-BST-E amplifier.

Step 13 If an OPT-PRE amplifier or an OPT-AMP-L amplifier (provisioned as an OPT-PRE) is installed on 
Side A, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6. It 
not, continue with continue with Step 14.

Step 14 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the Side B OPT-BST or OPT-BST-E amplifier.

Step 15 Disconnect the TXP card or tunable laser from the Side B OPT-BST or OPT-BST-E card.

Step 16 Remove the loopback on the Side A OPT-BST or OPT-BST-E card created in Step 6.

Step 17 Create a loopback on the Side B OPT-BST or OPT-BST-E card by connecting a patchcord from the LINE 
TX port to the LINE RX port with a 10-dB bulk attenuator.

Step 18 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with Step 19.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 20.

Step 19 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25, for the TXP transmitting the 
wavelength you will test. Refer to Table 11-41 on page 11-169, if needed.
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Step 20 Connect the tunable laser transmitter, the TXP_MR_10E_C card, or DWDM TX port to the LINE RX 
port of the Side A OPT-BST or OPT-BST-E card using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 21 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarms on the Side B OPT-BST or OPT-BST-E card and the Side B 
OSCM cards have cleared. The clearing of the LOS alarms indicates that the OSC link is active on 
Side B.

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback. An LOS-O alarm appears on the Side A OPT-BST or OPT-BST-E card, 
and an LOS alarm appears on the Side A OCSM card. 

If the alarms clear, continue with Step 22. If not, perform the following steps:

a. Display the Side B OPT-BST or OPT-BST-E card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. In the Types area, click Alarms, then click Refresh. 

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarms on the Side B OPT-BST or OPT-BST-E card has 
cleared. If so, continue with Step 22. If not, disconnect the OSCM card from the OPT-BST or 
OPT-BST-E card.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

i. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarms on the Side B OSCM card has cleared. If so, 
replace the OPT-BST or OPT-BST-E card. If not, replace the OSCM card. See the “NTP-G30 Install 
the DWDM Cards” procedure on page 14-64.

Step 22 If an OPT-PRE card or an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on Side A, 
complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6. If not, 
continue with Step 23.

Step 23 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the Side B OPT-BST or OPT-BST-E amplifier.

Step 24 If an OPT-PRE amplifier or an OPT-AMP-L (provisioned in OPT-PRE mode) amplifier is installed on 
Side B, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6. It 
not, continue with continue with Step 25.

Step 25 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the Side A OPT-BST or OPT-BST-E amplifier.

Step 26 Disconnect the TXP or tunable laser from the Side A OPT-BST or OPT-BST-E card.

Step 27 Remove the loopback on the Side B OPT-BST or OPT-BST-E amplifier created in Step 17.
15-78
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 15      Perform Node Acceptance Tests
DLP-  G364 Verify the Side A ROADM L-Band Add/Drop Channels
Step 28 Delete both OSC channels using the “DLP-G186 Delete an OSC Termination” task.

Step 29 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 30 Create the two OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Stop. You have completed this procedure.

NTP-G46 Perform the C-Band Line Amplifier Node with 
OSC-CSM Cards Acceptance Test

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_10E_C cards, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Home View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If alarms appear, 
investigate and resolve them before continuing. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for procedures.

Purpose This procedure tests a C-band line amplifier node with OSC-CSM cards 
installed on both Side B and Side A of the shelf by looping a single 
wavelength through the shelf.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_C card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note The OSC terminations created during node turn-up will generate an LOS alarm on the 
OSC-CSM card.

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If any are not, complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 6 Create a physical loopback on the Side A OSC-CSM card by connecting the LINE TX port to the 
LINE RX port with a fiber and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 7 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarm on the Side A OSC-CSM card has cleared. The clearing of 
the LOS alarm indicates that the OSC link is active on Side A. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback, and an LOS alarm will appear for the Side B OSC-CSM card, Port 1 
(OSC).

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patchcord. 

b. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the Side A OSC-CSM card clears, continue with Step 8. If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. In the Types area, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the Side A OSC-CSM card clears, continue with Step 8. If not, replace the OSC-CSM 
card.

Step 8 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with Step 9.

a. Set the output power to a nominal value, such as –3 dBm. 
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b. Set the tuner to the wavelength under test, then continue with Step 10.

Step 9 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. Refer to Table 15-1 on page 15-42, if needed.

Step 10 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the Side B 
OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 11 If an OPT-PRE card is installed on Side B, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser 
and Power” task on page 15-6. If not, continue with Step 12.

Step 12 Display the Side A OSC-CSM card in card view. 

Step 13 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 14 If an OPT-PRE card is installed on Side A of the shelf, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 15-6. If not, continue with Step 15.

Step 15 Display the Side B OSC-CSM card in card view. 

Step 16 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 2 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 17 Disconnect the TXP or tunable laser from the Side B OSC-CSM card.

Step 18 Remove the physical loopback created on the Side A OSC-CSM card in Step 6. 

Step 19 Create a loopback on the Side B OSC-CSM card by connecting the LINE TX port with LINE RX port 
using a patchcord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 20 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarm on the Side B OSC-CSM card has cleared. The clearing of 
the LOS alarm indicates that the OSC link is active on Side B. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback, and an LOS alarm will appear for the Side A OSC-CSM card, Port 1 
(OSC).

If the alarm clears, continue with Step 21. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patchcord. 

b. Wait 90 to 100 seconds then, in node view (single-shelf mode) or multishelf view (multishelf mode), 
click the Alarms tab. If the LOS alarm on the Side B OSC-CSM card clears, continue with Step 21. 
If not, continue with Step c.
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c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. In the Types area, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the Side B OSC-CSM card clears, continue with Step 21. If not, replace the 
OSC-CSM card.

Step 21 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with Step 22.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 23.

Step 22 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. Refer to Table 15-1 on page 15-42, if needed.

Step 23 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the Side A 
OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 24 If an OPT-PRE card is installed on Side A, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser 
and Power” task on page 15-6. If not, continue with Step 25.

Step 25 Display the Side B OSC-CSM card in card view. 

Step 26 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 27 If an OPT-PRE is installed on Side B of the shelf, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 15-6 for the Side B OPT-PRE amplifier. If not, continue with 
Step 28.

Step 28 Display the Side A OSC-CSM card in card view. 

Step 29 Click the Provisioning > Optical Line > Parameters tabs and locate the Power value for Port 2. Verify 
that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your 
connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco 
ONS 15454 Hardware Installation Guide. If this does not change the power value, consult your next level 
of support.

Step 30 Disconnect the TXP card or tunable laser from the Side A OSC-CSM card.

Step 31 Remove the loopback created on the Side B OSC-CSM card in Step 19. 

Step 32 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task.

Step 33 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.
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Step 34 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.

Stop. You have completed this procedure.

NTP-G156 Perform the L-Band Line Amplifier Node with 
OSC-CSM Cards Acceptance Test

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_10E_L cards, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Home View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If alarms appear, 
investigate and resolve them before continuing. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate an LOS alarm on the 
OSC-CSM card.

Purpose This procedure tests a L-band line amplifier node with OSC-CSM cards 
installed on both Side B and Side A of the shelf by looping a single 
wavelength through the shelf.

Tools/Equipment One of the following:

• A tunable laser

• TXP_MR_10E_L card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If any are not, complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 6 Create a physical loopback on the Side A OSC-CSM by connecting the LINE TX port to the LINE RX 
port with a fiber and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 7 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarm on the Side A OSC-CSM card has cleared. The clearing of 
the LOS alarm indicates that the OSC link is active on Side A. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback, and an LOS alarm will appear for the Side B OSC-CSM card, Port 1 
(OSC).

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patchcord. 

b. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the Side A OSC-CSM card clears, continue with Step 8. If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. In the Types area, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the Side A OSC-CSM card clears, continue with Step 8. If not, replace the OSC-CSM 
card.

Step 8 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_L card, continue with Step 9.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 10.

Step 9 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the wavelength you will test. 
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Step 10 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the Side B 
OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 11 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on Side B, complete the “DLP-G360 
Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task on page 15-26. If not, 
continue with Step 12.

Step 12 Display the Side A OSC-CSM card in card view. 

Step 13 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 14 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on Side A of the shelf, complete the 
“DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task on page 15-26. 
If not, continue with Step 15.

Step 15 Display the Side B OSC-CSM card in card view. 

Step 16 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 2 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 17 Disconnect the TXP card or tunable laser from the Side B OSC-CSM card.

Step 18 Remove the physical loopback created on the Side A OSC-CSM card in Step 6. 

Step 19 Create a loopback on the Side B OSC-CSM by connecting the LINE TX port with LINE RX port using 
a patchcord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 20 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarm on the Side B OSC-CSM card has cleared. The clearing of 
the LOS alarm indicates that the OSC link is active on Side B. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback, and an LOS alarm will appear for the Side A OSC-CSM card, Port 1 
(OSC).

If the alarm clears, continue with Step 21. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patchcord. 

b. Wait 90 to 100 seconds then, in node view (single-shelf mode) or multishelf view (multishelf mode), 
click the Alarms tab. If the LOS alarm on the Side B OSC-CSM card clears, continue with Step 21. 
If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.
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e. In the Types area, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the Side B OSC-CSM card clears, continue with Step 21. If not, replace the 
OSC-CSM card.

Step 21 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_L card, continue with Step 22.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 23.

Step 22 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the wavelength you will test. 

Step 23 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the Side A 
OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 24 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on Side A, complete the 
“DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task on page 15-26. 
If not, continue with Step 25.

Step 25 Display the Side B OSC-CSM card in card view. 

Step 26 Click the Provisioning > Optical Line > Parameters tabs. Locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 27 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on Side B, complete the “DLP-G360 
Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task on page 15-26. If not, 
continue with Step 28.

Step 28 Display the Side A OSC-CSM card in card view. 

Step 29 Click the Provisioning > Optical Line > Parameters tabs and locate the Power value for Port 2. Verify 
that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your 
connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco 
ONS 15454 Hardware Installation Guide. If this does not change the power value, consult your next level 
of support.

Step 30 Disconnect the TXP card or tunable laser from the Side A OSC-CSM card.

Step 31 Remove the loopback created on the Side B OSC-CSM card in Step 19. 

Step 32 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task.

Step 33 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 34 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.
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Stop. You have completed this procedure.

NTP-G47 Perform the C-Band Line Amplifier Node with OSCM 
and OSC-CSM Cards Acceptance Test

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Note Because the node is isolated and no line-side fibers are connected during the test, the power levels going 
into the line-side cards will not be the same as the levels when the node is connected to the network. 
Therefore, if the line amplifier shelf does not contain OPT-BST or OPT-BST-E amplifiers and OPT-PRE 
amplifiers on both Side B and Side A, you must lower the OPT-PRE power thresholds so that it turns on 
properly. At the end of the test, you will run ANS to configure the node with the correct parameters for 
the network acceptance test.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_10E_C cards, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25. If not, continue with Step 3.

Step 3 Display the terminal node in node view (single-shelf mode) or multishelf view (multishelf mode).

Purpose This procedure tests a C-band line amplifier node provisioned with an 
OSC-CSM card installed on one side of the shelf and an OSCM card 
installed on the other. This test verifies that a line amplifier node 
provisioned is operating properly before you connect it to the network. The 
test verifies the operation of the amplifiers and checks the power levels at 
each transmit and receive port to ensure that power loss in the cabling is 
within tolerance.

Tools/Equipment One of the following:

• A tunable laser or 

• TXP_MR_10E_C card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If alarms appear, 
investigate and resolve them before continuing. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate two alarms for each side of the 
shelf, one for an LOS on the OPT-BST or OPT-BST-E card, and the other for an LOS on the 
OSC-CSM or OSCM card.

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If any are not, complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 6 Create a loopback on the OSC-CSM card by connecting the LINE TX port to the LINE RX port using a 
patchcord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 7 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarm on the OSC-CSM card has cleared. The clearing of the LOS 
alarm indicates that the OSC link is active for this side of the shelf. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patchcord. 

b. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the OSC-CSM card clears, continue with Step 8. If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. In the Types area, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.
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i. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the OSC-CSM card clears, continue with Step 8. If not, replace the OSC-CSM card.

Step 8 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_C card, continue with Step 9.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 10.

Step 9 If you are using a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the TXP containing the 
wavelength you will test. Refer to Table 15-1 on page 15-42, if needed.

Step 10 Measure the TXP output power by connecting the TXP DWDM TX port to a test meter. Record the 
results for future reference.

Step 11 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the OPT-BST or 
OPT-BST-E LINE RX port using a fiber patchcord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 12 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 15-6. If not, continue with Step 13.

Step 13 Display the OSC-CSM card in card view. 

Step 14 Click the Provisioning > Optical Line > Parameters tabs and locate the Port 2 (COM-RX) Power 
value. Verify that the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check 
your connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the 
Cisco ONS 15454 Hardware Installation Guide. If this does not change the power value, consult your 
next level of support.

Step 15 If an OPT-PRE card is installed on the same Side As the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 15-6. If not, continue with Step 16.

Step 16 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the OPT-BST or OPT-BST-E card.

Step 17 Disconnect the TXP or tunable laser from the OPT-BST or OPT-BST-E card.

Step 18 Remove the loopback fiber on the OSC-CSM card.

Step 19 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task.

Step 20 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 21 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.

Step 22 Create a loopback on the OPT-BST or OPT-BST-E card by connecting the LINE TX port with LINE RX 
port using a patchcord and 10-dB bulk attenuator.

Step 23 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarms on the OPT-BST or OPT-BST-E card and the OSCM card 
have cleared. The clearing of the LOS alarms indicates that the OSC link is active for this side of the 
shelf. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.
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If the alarms clear, continue with Step 24. If not, perform the following steps:

a. Display the OPT-BST or OPT-BST-E card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. In the Types area, click Alarms, then click Refresh. 

d. Locate the Port 2 (COM-TX) Power Failure Low parameter. Double-click the table cell and change 
the value to –30 dBm.

e. Locate the Port 4 (OSC-TX) Power Failure Low parameter. Double-click the table cell and change 
the value to –40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarms on the OPT-BST or OPT-BST-E card has cleared. 
If so, continue with Step 24. If not, disconnect the OSCM card from the OPT-BST or OPT-BST-E 
card.

h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

i. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarm on the OSCM card has cleared. If not, check your 
connections and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the 
Cisco ONS 15454 Hardware Installation Guide. If this does not change the power value, consult 
your next level of support.

Step 24 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the OSC-CSM 
LINE RX port using a fiber patchcord and 10-dB bulk attenuator.

Step 25 If an OPT-PRE is installed on the same side of the shelf as the OSC-CSM, complete the “DLP-G80 
Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6. If not, continue with Step 26.

Step 26 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the OPT-BST or OPT-BST-E card.

Step 27 Display the OSC-CSM card in card view.

Step 28 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 3 
(COM-TX) is equal to the optical power from the tunable laser or TXP_MR_10E_C card (measured in 
Step 10) –10 dB, +/– 2 dB. If not, check your connections and clean the fibers using the “NTP-G115 
Clean Fiber Connectors” procedure in the Cisco ONS 15454 Hardware Installation Guide. If this does 
not change the power value, consult your next level of support.

Step 29 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 15-6. If not, continue with Step 30.

Step 30 Disconnect the TXP or tunable laser from the OSC-CSM card.

Step 31 Remove the loopback fiber on the OPT-BST or OPT-BST-E amplifier card.

Step 32 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task.

Step 33 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 34 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.

Stop. You have completed this procedure.
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NTP-G157 Perform the L-Band Line Amplifier Node with OSCM 
and OSC-CSM Cards Acceptance Test

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 If you are using TXP_MR_10E_L cards, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Home View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If alarms appear, 
investigate and resolve them before continuing. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for procedures.

Note The OSC terminations created during node turn-up will generate two alarms for each side of the 
shelf, one for an LOS on the OPT-BST-L card, and the other for an LOS on the OSC-CSM or 
OSCM card. If OSCM cards are installed on ANSI shelves, EOC DCC Termination Failure 
alarms will appear.

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are listed as Success - Changed 
or Success - Unchanged. If any are not, complete the following:

a. Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task.

b. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

Purpose This procedure tests a L-band line amplifier node with an OSC-CSM card 
installed on one side of the shelf and an OSCM card installed on the other.

Tools/Equipment One of the following:

• A tunable laser or 

• TXP_MR_10E_L card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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c. Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 6 Create a loopback on the OSC-CSM card by connecting the LINE TX port to the LINE RX port using a 
fiber patchcord and 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 7 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarm on the OSC-CSM card has cleared. The clearing of the LOS 
alarm indicates that the OSC link is active for this side of the shelf. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

If the alarm clears, continue with Step 8. If not, perform the following steps:

a. Remove the 10-dB bulk attenuator on the OSC-CSM LINE TX and LINE RX ports and reconnect 
using only the patchcord. 

b. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the OSC-CSM card clears, continue with Step 8. If not, continue with Step c.

c. Display the OSC-CSM card in card view.

d. Click the Provisioning > Optical Line > Optics Thresholds tabs.

e. In the Types area, click Alarm, then click Refresh.

f. Locate the Port 3 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

g. Locate the Port 6 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

h. Click Apply, and then Yes.

i. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. If the 
LOS alarm on the OSC-CSM card clears, continue with Step 8. If not, replace the OSC-CSM card.

Step 8 If you are using a tunable laser, follow the manufacturer’s instructions to complete the following steps. 
If you are using a TXP_MR_10E_L card, continue with Step 9.

a. Set the output power to a nominal value, such as –3 dBm. 

b. Set the tuner to the wavelength under test, then continue with Step 10.

Step 9 If you are using a TXP_MR_10E_L card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25 for the wavelength you will test.

Step 10 Measure the TXP card output power by connecting the TXP card DWDM TX port to a test meter. Record 
the results for future reference.

Step 11 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the OPT-BST-L 
LINE RX port using a 10-dB bulk attenuator.

Caution Failure to use proper attenuation might damage the equipment.

Step 12 Display the OPT-BST-L card in card view.
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Step 13 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 2 
(Out Com) is equal to the optical power from the tunable laser or TXP_MR_10E_L card (measured in 
Step 10), +/– 1.0 dBm.

Step 14 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on the side opposite the OSC-CSM 
card, complete the “DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” 
task on page 15-26. If not, continue with Step 15.

Step 15 Display the OSC-CSM card in card view. 

Step 16 Click the Provisioning > Optical Line > Parameters tabs and locate the Port 3 Power value. Verify that 
the value is higher than –30 dBm. If the power value is not higher than –30 dBm, check your connections 
and clean the fibers using the “NTP-G115 Clean Fiber Connectors” procedure in the Cisco ONS 15454 
Hardware Installation Guide. If this does not change the power value, consult your next level of support.

Step 17 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on the same Side As the OSC-CSM, 
complete the “DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task 
on page 15-26. If not, continue with Step 18.

Step 18 Complete the “DLP-G359 Verify the OPT-BST-L or OPT-AMP-L (OPT-Line Mode) Amplifier Laser and 
Power” task on page 15-26 for the OPT-BST-L card.

Step 19 Disconnect the TXP card or tunable laser from the OPT-BST-L card.

Step 20 Remove the loopback fiber on the OSC-CSM card.

Step 21 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task.

Step 22 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 23 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.

Step 24 Create a loopback on the OPT-BST-L card by connecting the LINE TX port with LINE RX port using a 
patchcord and 10-dB bulk attenuator.

Step 25 Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) click 
the Alarms tab. Verify that the LOS alarms on the OPT-BST-L and OSCM cards have cleared. The 
clearing of the LOS alarms indicates that the OSC link is active for this side of the shelf. 

Note For ANSI shelves, an EOC DCC Termination Failure alarm will continue to appear due to the 
OSC signal loopback.

If the alarms clear, continue with Step 26. If not, perform the following steps:

a. Display the OPT-BST-L card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. In the Types area, click Alarms, then click Refresh. 

d. Locate the Port 2 Power Failure Low parameter. Double-click the table cell and change the value to 
–30 dBm.

e. Locate the Port 4 Power Failure Low parameter. Double-click the table cell and change the value to 
–40 dBm.

f. Click Apply, and then Yes.

g. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode) 
click the Alarms tab. Verify that the LOS alarms on the OPT-BST-L card has cleared. If so, continue 
with Step 26. If not, disconnect the OSCM card from the OPT-BST-L card.
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h. Create a loopback on the OSCM card by connecting a patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

i. Wait 90 to 100 seconds, then in node view (single-shelf mode) or multishelf view (multishelf mode), 
click the Alarms tab. Verify that the LOS alarm on the OSCM card has cleared. If so, replace the 
OPT-BST-L card. If not, replace the OSCM card. See the “NTP-G30 Install the DWDM Cards” 
procedure on page 14-64.

Step 26 Connect the tunable laser transmitter or the TXP_MR_10E_L card DWDM TX port to the OSC-CSM 
LINE RX port using a 10-dB bulk attenuator.

Step 27 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on the same side of the shelf as the 
OSC-CSM, complete the “DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and 
Power” task on page 15-26. If not, continue with Step 28.

Step 28 Complete the “DLP-G359 Verify the OPT-BST-L or OPT-AMP-L (OPT-Line Mode) Amplifier Laser and 
Power” task on page 15-26 for the OPT-BST-L card.

Step 29 Display the OSC-CSM card in card view.

Step 30 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 3 
(Out Com) is equal to the optical power from the tunable laser or TXP_MR_10E_L card (measured in 
Step 10), +/– 1.0 dBm.

Step 31 If an OPT-AMP-L card (provisioned in OPT-PRE mode) is installed on the side opposite the OSC-CSM, 
complete the “DLP-G360 Verify the OPT-AMP-L (OPT-PRE Mode) Amplifier Laser and Power” task 
on page 15-26. If not, continue with Step 32.

Step 32 Disconnect the TXP card or tunable laser from the OSC-CSM card.

Step 33 Remove the loopback fiber on the OPT-BST-L amplifier card.

Step 34 Delete both OSC channels. See the “DLP-G186 Delete an OSC Termination” task.

Step 35 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to restore the original 
configuration.

Step 36 Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on page 14-124.

Stop. You have completed this procedure.
15-94
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_A03F893E3EFB4CC5A4035130606A00BF


 

Chapter 15      Perform Node Acceptance Tests
DLP-  G364 Verify the Side A ROADM L-Band Add/Drop Channels
NTP-G48 Perform the OADM Node Acceptance Test on a 
Symmetric Node with OSCM Cards

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the OADM node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed or 
Success - Unchanged. If not, complete the “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. 

Step 5 Check your Cisco TransportPlanner site configuration file to verify the presence of added and dropped 
bands (including four channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means that the band is dropped in one direction by an 
AD-xB-xx.x card on one side (Side B or Side A) of the node, then added by another AD-xB-x.xx 
card on the opposite side in the same direction. The band is not terminated inside the node.

Purpose This procedure checks the integrity of all the optical connections inside an 
OADM node with OSCM cards installed on both Side B and Side A of the 
shelf. Three connection types are tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco TransportPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Note Configuring a channel in pass-through mode means that the channel is dropped in one direction 
by an AD-xC-xx.x card on one side (Side B or Side A) of the node, then added by another 
AD-xC-x.xx card on the opposite side in the same direction. The channel is not terminated inside 
the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the Side A OPT-BST or OPT-BST-E card by connecting the LINE TX port to the 
LINE RX port using a patchcord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the Side A OSCM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.) If the OSC link becomes active, continue with Step 11. If the OSC link does not turn up, 
complete the following steps:

a. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 4 opwrMin (minimum power) to –40 dBm.

b. Modify the COM TX Fail Low Threshold. Change the Port 2 opwrMin (minimum power) to 
–30 dBm.

c. If the OSC link turns up, continue with Step 11. If the OSC link is still down, disconnect the OSCM 
card from the OPT-BST or OPT-BST-E card.

d. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

e. If the OSC link turns up, replace the OPT-BST or OPT-BST-E card. If the OSC link does not turn 
up, replace the OSCM card.

Note Due to the OSC signal loopback, an EOC DCC Termination Failure alarm might be raised on 
ANSI shelves.

Step 11 If the node has express bands or channels, complete the “DLP-G85 Verify Express Channel Connections 
on an OADM Node with OSCM Cards” task on page 15-97. If the node does not have express bands or 
channels, continue with Step 12.

Step 12 If connections configured in pass-through mode are present (noted in Steps 6 and 8), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 15-100. If not, 
continue with Step 13.

Step 13 If connections have add/drop connections, complete the “DLP-G93 Verify Add and Drop Connections 
on an OADM Node with OSCM Cards” task on page 15-105.

Stop. You have completed this procedure.
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DLP-  G85 Verify Express Channel Connections on an OADM Node with OSCM Cards
DLP-G85 Verify Express Channel Connections on an OADM Node with OSCM 
Cards

Step 1 If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If not, continue 
with Step 2.

Step 2 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the Side B 
OPT-BST or OPT-BST-E LINE RX port.

Step 3 Based on the Cisco TransportPlanner site configuration file, tune the tunable laser of the 
TXP_MR_10E_C card to a wavelength (on the 100-GHz ITU-T grid) that runs on the express path of all 
AD-xB-xx.x and AD-xC-xx.x cards on the Side B-to-Side A and Side A-to-Side B directions. Refer to 
the tunable laser manufacturer’s documentation or the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 4 If an OPT-PRE card is installed on Side B, insert a 10-dB bulk attenuator on the COM RX port and 
complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6. If an 
OPT-PRE card is not installed on Side B, continue with Step 5.

Step 5 If AD-xB-xx.x cards are installed on Side B, complete the “DLP-G87 Verify the AD-xB-xx.x Output 
Express Power” task on page 15-98 for each Side B card. If not, continue with Step 6.

Note If AD-xB-xx.x and AD-xC-xx.x cards are both installed in one direction, the received express 
channels will go into the AD-xB-xx.x cards first, then into the AD-xC-xx.x cards.

Step 6 If AD-xC-xx.x cards are installed on Side B, complete the “DLP-G88 Verify the AD-xC-xx.x Output 
Express Power” task on page 15-98 for each Side B card. If not, continue with Step 7.

Step 7 If AD-xC-xx.x cards are installed on Side A, complete the “DLP-G271 Verify the AD-xC-xx.x Output 
Common Power” task on page 15-99 for each Side A card. If not, continue with Step 8.

Step 8 If AD-xB-xx.x cards are installed on Side A, complete the “DLP-G272 Verify the AD-xB-xx.x Output 
Common Power” task on page 15-99 for each Side A card. If not, continue with Step 9.

Step 9 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the OPT-BST or OPT-BST-E card installed on Side B.

Step 10 If an OPT-PRE card is installed on Side A, complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser 
and Power” task on page 15-6. If an OPT-PRE card is not installed, continue with Step 11.

Step 11 Repeat Steps 5 through 8 for the AD-xB-xx.x and AD-xC-xx.x cards along the Side A-to-Side B 
direction.

Step 12 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 for the OPT-BST or OPT-BST-E card installed on Side A.

Purpose This task verifies the express channel connections during an OADM node 
acceptance test.

Tools/Equipment A tunable laser or a TXP_MR_10E_C

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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DLP-  G87 Verify the AD-xB-xx.x Output Express Power
Step 13 Return to the originating procedure (NTP).

DLP-G87 Verify the AD-xB-xx.x Output Express Power

Step 1 Display the AD-xB-xx.x card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Output Express port administrative state to OOS,MT (ANSI) or Locked,maintenance 
(ETSI). Click Apply.

Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –28 dBm.

Step 5 Return to your originating procedure (NTP).

DLP-G88 Verify the AD-xC-xx.x Output Express Power

Step 1 Display the AD-xC-xx.x card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Output Express port administrative state to OOS,MT (ANSI) or Locked,maintenance 
(ETSI). Click Apply.

Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –30 dBm.

Step 5 Return to your originating procedure (NTP).

Purpose This task verifies the output express power of AD-xB-xx.x cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies the output express power of the AD-xC-xx.x cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G271 Verify the AD-xC-xx.x Output Common Power

Step 1 Display the AD-xC-xx.x card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Output Com port Power value is greater than the default no-power value of –30 dBm.

Step 4 Return to your originating procedure (NTP).

DLP-G272 Verify the AD-xB-xx.x Output Common Power

Step 1 Display the AD-xB-xx.x card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Output Com port Power value is greater than the default no-power value of –28 dBm.

Step 4 Return to your originating procedure (NTP).

Purpose This task verifies the common power of the AD-xC-xx.x cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies the output common power of the AD-xB-xx.x cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-  G89 Verify OADM Node Pass-Through Channel Connections
DLP-G89 Verify OADM Node Pass-Through Channel Connections

Step 1 Identify the first band connection configured in pass-through mode in both directions.

Step 2 Set the tunable laser or TXP_MR_10E_C card to the wavelength of the band to be tested. Refer to the 
tunable laser manufacturer’s documentation or the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 3 Complete the “DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power” task on page 15-102 
for the first pass-through connection.

Step 4 Complete one of the following:

• If OSCM cards are installed, connect a power meter to the Side B OPT-BST or OPT-BST-E LINE 
TX port and verify that the Side B amplifier is turned on by the pass-through wavelength.

• If OSC-CSM cards are installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 15-104 for the Side B OSC-CSM card.

Step 5 Complete Steps 2 through 4 for each band connection configured in pass-through mode in both 
directions.

Step 6 If channel pass-through connections are not present, continue with Step 15. If channel pass-through 
connections are present, continue with one of the following steps: 

• If the pass-through channel connections use an AD-xC-xx.x card, continue with Step 7.

• If the pass-through channel connections use a 4MD-xx.x card, continue with Step 11.

Step 7 Tune the tunable laser on a wavelength (1 of 4) belonging to the channel to be tested.

Step 8 Complete the “DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection” task on page 15-103 for the 
first pass-through connection.

Step 9 Complete one of the following:

• If an OSCM card is installed, connect a power meter to LINE TX port on the front-pane and verify 
that the Side B OPT-BST or OPT-BST-E amplifier is turned on by the pass-through wavelength.

• If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 15-104 for the Side B OSC-CSM card.

Step 10 If the pass-through connections use a 4MD-xx.x card, continue with Step 11. If not, continue with 
Step 15.

Step 11 Identify the first channel connection that is configured in pass-through mode using the 4MD-xx.x cards 
in both directions.

Step 12 Tune the tunable laser on the corresponding wavelength.

Step 13 Complete the “DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power” task on page 15-101.

Step 14 Perform one of the following:

Purpose This task verifies the pass-through channel connections during an OADM 
node acceptance test. 

Tools/Equipment A tunable laser or a TXP_MR_10E_C

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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• If an OSCM card is installed, connect a power meter to LINE TX port on the card front panel and 
verify that the Side B OPT-BST or OPT-BST-E amplifier is turned on by the pass-through 
wavelength.

• If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 15-104 for the Side B OSC-CSM card.

Step 15 Return to your originating procedure (NTP).

DLP-G92 Verify 4MD-xx.x Pass-Through Connection Power

Step 1 Verify the TX band power on the related Side B AD-xB-xx.x card: 

a. Display the Side B AD-xB-xx.x card in card view. 

b. Click the Provisioning > Optical Band > Parameters tabs. 

c. Change the administrative state of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 2 Verify the TX power on the Side B 4MD-xx.x card (Side B-to-Side A):

a. Display the Side B 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 3 Verify the RX band power on the related Side A AD-xB-xx.x card (Side B-to-Side A):

a. Display the Side A AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the BAND RX Power value is higher than the default no-power values of –30 dBm.

Step 4 Verify the Side A 4MD-xx.x card (Side B-to-Side A):

a. Display the Side A 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the administrative state of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned set point (VOA Power 
Ref).

Purpose This task verifies 4MD-xx.x pass-through connection power. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-  G90 Verify an AD-xB-xx.x Pass-Through Connection Power
Step 5 Verify the TX band power on the Side A AD-xB-xx.x card (Side A-to-Side B):

a. Display the Side A AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the administrative state of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 6 Verify the Side A 4MD-xx.x card (Side A-to-Side B):

a. Display the Side A 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 7 Verify the Side B 4MD-xx.x card (Side A-to-Side B):

a. Display the Side B 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the administrative state of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned set point (VOA Power 
Ref).

Step 8 Return to your originating procedure (NTP).

DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power

Step 1 Verify the Side B AD-xB-xx.x band TX power:

a. Display the Side B AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the administrative state of the BAND TX (Side B-to-Side A) port related to the wavelength 
selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

d. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 2 Verify the Side A AD-xB-xx.x card RX and TX power:

a. Display the Side A AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

Purpose This task verifies an AD-xB-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-  G91 Verify an AD-xC-xx.x Pass-Through Connection
c. Verify that the Power value of the BAND RX (Side B-to-Side A) port is higher than the default 
no-power value of –30 dBm.

d. Change the administrative state of the BAND TX (Side A-to-Side B) port related to the wavelength 
selected on the tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

e. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 3 Verify the BAND RX port on the Side B AD-xB-xx.x card:

a. Display the Side B AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the Power value of the BAND RX (Side A-to-Side B) port is higher than the default 
no-power value of –30 dBm.

Step 4 Return to your originating procedure (NTP).

DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection

Step 1 Verify the Side B AD-xC-xx.x channel TX power:

a. Display the Side B AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be activated in Step e.

e. Change the administrative state of the CHAN TX port related to the wavelength selected on the 
tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

f. Verify that the power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 2 Verify the channel power for the corresponding Side A AD-xC-xx.x card:

a. Display the Side A AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. Verify that the Power value of the CHAN RX port reaches the provisioned set point (VOA Power 
Ref).

Purpose This task verifies an AD-xC-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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e. Change the administrative state of the CHAN TX port related to the wavelength selected on the 
tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

f. If the AD-xC-xx.x is an AD-4C-W card, a VOA (applying to all four channels) is installed along the 
drop path and needs to be activated in Step g.

g. Change the administrative state of the CHAN TX port related to the wavelength selected on the 
tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

h. Verify that the power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 3 Verify the Side B AD-xC-xx.x channel RX power:

a. Display the Side B AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the administrative state of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned set point (VOA Power 
Ref).

Step 4 Return to your originating procedure (NTP).

DLP-G84 Verify the OSC-CSM Incoming Power

Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Power value for Port 2 is higher than the default no-power value of –30 dBm. The 
calculated expected power for Port 2 is the OPT-PRE card Pout COM TX value. Normally, this is + 
2 dBm.

Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 4 Return to your originating procedure (NTP).

Purpose This task verifies the OSC-CSM card incoming power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G93 Verify Add and Drop Connections on an OADM Node with OSCM Cards

Note In this task, you will verify add and drop connections in the following order: Side B-to-Side A add and 
Side A-to-Side B drop, Steps 1 through 15; Side A-to-Side B add and Side B-to-Side A drop, Steps 16 
through 17.

Step 1 Based on the Cisco TransportPlanner site configuration file, tune the tunable laser or TXP_MR_10E_C 
card to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path 
of the first Side A AD-xC-xx.x or Side A 4MD-xx.x card in the Side B-to-Side A direction. Refer to the 
tunable laser manufacturer’s documentation or the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 2 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the corresponding 
15xx.x RX port (on the card front panel) of the Side A AD-xC-xx.x or 4MD-xx.x card.

Step 3 Verify the Side A AD-xC-xx.x or 4MD-xx.x card (Side B-to-Side A):

a. Display the Side A AD-xC-xx.x or 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the administrative state of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength chosen on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned set point (VOA Power 
Ref).

Step 4 Complete the “DLP-G79 Verify the OPT-BST, OPT-BST-E, or OPT-BST-L Amplifier Laser and Power” 
task on page 15-5 on the Side A OPT-BST or OPT-BST-E amplifier to verify that the added wavelength 
turns on the laser.

Step 5 If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an 
AD-xC-xx.x card, move to Step 10.

Step 6 Verify the RX band port on the Side A AD-xB-xx.x card:

a. Display the Side A AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

Step 7 Verify that the BAND RX Power value is higher than the default no-power value of –30 dBm.

Step 8 Verify the band TX port on the Side A AD-xB-xx.x (Side A-to-Side B):

a. Display the Side A AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

Purpose This task verifies the add and drop channel connections for an OADM node 
with OSCM cards installed.

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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c. Change the administrative state of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser or TXP_MR_10E_C 
card.

d. Verify that the Power value of the BAND TX port is higher than the default no-power value of 
–30 dBm.

Step 9 Verify the Side A 4MD-xx.x card (Side A-to-Side B):

a. Display the Side A 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–30 dBm.

Step 10 Verify the Side A AD-xC-xx.x (Side A-to-Side B) card:

a. Display the Side A AD-xC-xx.x card in card view.

b. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be activated according to Step g.

c. Click the Provisioning > Optical Chn > Parameters tabs.

d. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

e. Display the Side B AD-xC-xx.x card in card view.

f. Click the Provisioning > Optical Chn > Parameters tabs.

g. Change the administrative state of the CHAN TX port related to the wavelength selected on the 
tunable laser or TXP_MR_10E_C card to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click 
Apply.

h. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

i. Perform the output power check.

Step 11 Connect a power meter to the proper 15xx.x TX port on the front panel (the dual port compared with the 
port where the tunable laser or TXP_MR_10E_C card is connected). Verify that the physical optical 
power value from that port is consistent with the value displayed on the Provisioning > Optical Chn > 
Parameters tab for the proper CHAN TX power value +/– 0.5 dB.

Step 12 Repeat Steps 5 through 11 for all add paths of any Side A AD-xC-xx.x or 4MD-xx.x cards along the 
Side B-to-Side A direction.

Step 13 Remove the loopback on the Side A OPT-BST or OPT-BST-E amplifier and create a loopback on the 
Side B OPT-BST or OPT-BST-E amplifier. 

Step 14 Verify that the OSC link becomes active on the Side B OSCM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.) If the OSC link becomes active, continue with Step 15. If the OSC link does not become 
active, perform the following steps:

a. Modify the OSC Fail Low thresholds by clicking the Provisioning > Optical Line > 
Optics Thresholds tabs and changing the Port 2 opwrMin (minimum power) to –40 dBm.

b. If the OSC link turns up, continue with Step 15. If the OSC link remains down, disconnect the 
OSCM card from the OPT-BST or OPT-BST-E card.

c. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.
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d. If the OSC link turns up, replace the OPT-BST or OPT-BST-E card. If the OSC link does not turn 
up, replace the OSCM card. See the “NTP-G30 Install the DWDM Cards” procedure on page 14-64.

Note Due to the OSC signal loopback, an EOC DCC Termination Failure might be raised on ANSI 
shelves.

Step 15 Based on the Cisco TransportPlanner site configuration file, tune the tunable laser or TXP_MR_10E_C 
card to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path 
of the first add path of the first AD-xC-xx.x or 4MD-xx.x card on the Side A-to-Side B direction. Refer 
to the tunable laser manufacturer’s documentation or the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 16 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the correspondent 
15xx.x RX port (on the card front panel) of the Side B AD-xC-xx.x or Side B 4MD-xx.x card.

Step 17 Repeat Steps 3 through 15, applying the steps to the Side A-to-Side B direction.

Step 18 Remove the loopback connection and restore the default administrative state (IS,AINS or 
Unlocked,automaticInService) on all the ports previously set to OOS,MT (ANSI) or 
Locked,maintenance (ETSI).

Step 19 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to recover the correct 
node configuration.

Step 20 Return to your originating procedure (NTP).

NTP-G49 Perform the Active OADM Node Acceptance Test on a 
Symmetric Node with OSC-CSM Cards 

Purpose This procedure checks the integrity of all the optical connections in an 
OADM node with OSC-CSM cards and OPT-BST or OPT-BST-E cards 
installed on both Side B and Side A of the shelf. Three connection types 
are tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the OADM node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed or 
Success - Unchanged. If not, complete the “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. 

Step 5 Check the Cisco TransportPlanner site configuration file to verify the presence of added and dropped 
bands (including four channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means that the band is dropped in one direction by an 
AD-xB-xx.x card on one side (Side B or Side A) of the node, then added by another AD-xB-x.xx 
card on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco TransportPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Note Configuring a channel in pass-through mode means that the channel is dropped in one direction 
by an AD-xC-xx.x card on one side (Side B or Side A) of the node, then added by another 
AD-xC-x.xx card on the opposite side in the same direction. The channel is not terminated inside 
the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the Side A OSC-CSM card by connecting the LINE TX port to the LINE RX port 
using a patchcord and a 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the Side A OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.)
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Note Due to the OSC signal loopback, an EOC Termination Failure alarm might be raised on ANSI 
shelves.

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 12. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 12. If it does not turn up, replace the OSC-CSM card. 

Step 12 If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel Connections 
on an OADM Node with OSC-CSM Cards” task on page 15-109. If the node does not have express bands 
or channels, continue with Step 13.

Step 13 If connections configured in pass-through mode are present (noted in Steps 6 and 8), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 15-100. If not, 
continue with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections 
on an OADM Node with OSC-CSM Cards” task on page 15-111.

Stop. You have completed this procedure.

DLP-G86 Verify Express Channel Connections on an OADM Node with 
OSC-CSM Cards

Step 1 If you are using a tunable laser, set the output power to a nominal value, such as –3 dBm. If not, continue 
with Step 2.

Step 2 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the LINE RX port 
of the Side B OSC-CSM card.

Step 3 If an OPT-PRE amplifier card is installed on Side B, install a 10-dB bulk attenuator on the COM RX 
port.

Purpose This task verifies the express channel connections for an OADM node with 
OSC-CSM cards during a node acceptance test.

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 4 Based on the Cisco TransportPlanner site configuration file, tune the tunable laser or TXP_MR_10E_C 
card to a wavelength (on the 100-GHz ITU-T grid) that runs on the express path of all AD-xB-xx.x and 
AD-xC-xx.x cards on the Side B-to-Side A and Side A-to-Side B directions. Refer to the tunable laser 
manufacturer’s documentation or the “DLP-G358 Provision TXP_MR_10E_L and TXP_MR_10E_C 
Cards for Acceptance Testing” task on page 15-25.

Step 5 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 for the 
OPT-PRE amplifier card installed on Side A.

Step 6 If AD-xB-xx.x cards are installed on Side B, complete the “DLP-G87 Verify the AD-xB-xx.x Output 
Express Power” task on page 15-98 for each Side B card. If not, continue with Step 7.

Note If AD-xB-xx.x and AD-xC-xx.x cards are both installed in one direction, the received express 
channels will go into the AD-xB-xx.x cards first, then into the AD-xC-xx.x cards.

Step 7 If AD-xC-xx.x cards are installed on Side B, complete the “DLP-G88 Verify the AD-xC-xx.x Output 
Express Power” task on page 15-98 for each Side B card. If not, continue with Step 8.

Step 8 If AD-xC-xx.x cards are installed on Side A, complete the “DLP-G271 Verify the AD-xC-xx.x Output 
Common Power” task on page 15-99 for each Side A card. If not, continue with Step 9.

Step 9 If AD-xB-xx.x cards are installed on Side A, complete the “DLP-G272 Verify the AD-xB-xx.x Output 
Common Power” task on page 15-99 for each Side A card. If not, continue with Step 10.

Step 10 Complete the “DLP-G83 Verify the OSC-CSM Power on OADM Nodes” task on page 15-110 for the 
OSC-CSM card installed on Side A.

Step 11 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 for the 
OPT-PRE card installed on Side B.

Step 12 Repeat Steps 6 through 11 for the AD-xB-xx.x and AD-xC-xx.x cards along the Side A-to-Side B 
direction.

Step 13 Return to your originating procedure (NTP).

DLP-G83 Verify the OSC-CSM Power on OADM Nodes

Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Power value for Port 3 is higher than the default no-power value of –30 dBm. The 
calculated expected power value for Port 3 is:

Pout COM TX of last AD-xy-xx.x – IL02 OSC-CSM (COM RX > LINE TX) – 10 dB (bulk attenuator)

Purpose This task verifies the OSC-CSM card power on OADM nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 4 Double-check the value.

Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 5 Return to your originating procedure (NTP).

DLP-G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM 
Cards

Step 1 Based on the Cisco TransportPlanner site configuration file, tune the tunable laser or TXP_MR_10E_C 
card to a wavelength (belonging to the 100-GHz ITU-T grid) of the channel running on the first add path 
of the first Side A AD-xC-xx.x or Side A 4MD-xx.x card on the Side B-to-Side A direction. Refer to the 
tunable laser manufacturer’s documentation or the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25.

Step 2 Connect the tunable laser transmitter or the TXP_MR_10E_C card DWDM TX port to the corresponding 
15xx.x RX port (on the card front panel) of the Side A AD-xC-xx.x or 4MD-xx.x card.

Step 3 Verify the Side A AD-xC-xx.x or 4MD-xx.x card (Side B-to-Side A):

a. Display the Side A AD-xC-xx.x or 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the administrative state of the CHAN RX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned set point (VOA Power 
Ref).

Step 4 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 15-6 on the 
Side A OPT-PRE amplifier to verify that the added wavelength turns on the laser.

Step 5 If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an 
AD-xC-xx.x card, move to Step 10.

Step 6 Verify the Side A AD-xB-xx.x card:

a. Display the Side A AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the administrative state of the BAND TX port to OOS,MT (ANSI) or Locked,maintenance 
(ETSI) for the channel related to the wavelength selected on the tunable laser.

Purpose This task verifies the add and drop channel connections for an OADM node 
with OSC-CSM cards installed.

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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d. Verify that the Power value of the BAND TX port is higher than the default no-power value of 
–30 dBm.

Step 7 Display the related AD-xB-xx.x card (Side A-to-Side B direction) in card view.

Step 8 Change the administrative state of the drop BAND TX port related to the wavelength selected on the 
tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 9 (Optional) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value displayed on the Provisioning > Optical Chn > 
Parameters tab for the proper CHAN TX power value, +/– 0.5 dB.

Step 10 Verify the Side A AD-xC-xx.x (Side A-to-Side B) card:

a. Display the Side A AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. Display the Side B AD-xC-xx.x card in card view.

e. Click the Provisioning > Optical Chn > Parameters tabs.

f. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

g. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be activated in Step h.

h. Change the administrative state of the CHAN TX port related to the wavelength selected on the 
tunable laser to OOS,MT (ANSI) or Locked,maintenance (ETSI). Click Apply.

i. Perform the output power check.

Step 11 (Optional) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value on Provisioning > Optical Chn > Parameters tab for the 
proper CHAN TX power value, +/– 0.5 dB.

Step 12 Repeat Steps 10 through 11 for all add paths of any Side A AD-xC-xx.x cards along the Side B-to-Side A 
direction.

Step 13 Remove the loopback on the Side A OSC-CSM card. 

Step 14 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs.

Step 15 Click Launch ANS.

Step 16 Create a loopback on the Side B OSC-CSM card by connecting the OSC-CSM LINE RX and LINE TX 
ports using a patchcord and 10-dB bulk attenuator.

Step 17 Verify that the OSC link becomes active on the Side A OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.)

Note Due to the OSC signal loopback, an EOC Termination Failure alarm might be raised on ANSI 
shelves.
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Step 18 If the OSC link becomes active, continue with Step 19. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 19. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 19. If it does not turn up, replace the OSC-CSM card. 

Step 19 Check the site configuration file from Cisco TransportPlanner and identify the wavelength (belonging to 
the 100 Ghz ITU-T grid) of the channel running on the first add path of the first AD-xC-xx.x or 
4MD-xx.x card on the Side A-to-Side B direction.

Step 20 Connect the tunable laser to the corresponding 15xx.x RX port (on the card front panel) of the Side B 
AD-xC-xx.x or Side B 4MD-xx.x card.

Step 21 Repeat Steps 3 through 20, applying the steps to the Side B-to-Side A direction.

Step 22 Restore the default administrative state (IS,AINS/Unlocked,automaticInService) on all the ports 
previously set to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 23 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 to recover the correct 
node configuration.

Step 24 Return to your originating procedure (NTP).

NTP-G50 Perform the Passive OADM Node Acceptance Test on 
a Symmetric Node with OSC-CSM Cards 

Purpose This procedure checks the integrity of all the optical connections inside an 
OADM node with OSC-CSM cards and no OPT-BST or OPT-BST-E cards 
installed on Side B and Side A of the shelf. Three connection types are 
tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment A tunable laser or a TXP_MR_10E_C card

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the OADM node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Verify that all statuses under Link Status are Success - Changed or 
Success - Unchanged. If not, complete the “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. 

Step 5 Check the Cisco TransportPlanner site configuration file to verify the presence of a dropped or added 
bands (including four channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means that the band is dropped in one direction by an 
AD-xB-xx.x card on one side (Side B or Side A) of the node, then added by another AD-xB x.xx 
card on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco TransportPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Note Configuring a channel in pass-through mode means that the channel is dropped in one direction 
by an AD-xC-xx.x card on one side (Side B or Side A) of the node, then added by another 
AD-xC-x.xx card on the opposite side in the same direction. The channel is not terminated inside 
the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the Side A OSC-CSM card by connecting the LINE TX port to the LINE RX port 
using a patchcord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the Side A OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.)
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Note Due to the OSC signal loopback, an EOC Termination Failure alarm might be raised on ANSI 
shelves.

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 12. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 12. If it does not turn up, replace the OSC-CSM card. 

Step 12 If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel Connections 
on an OADM Node with OSC-CSM Cards” task on page 15-109. If the node does not have express bands 
or channels, continue with Step 13.

Step 13 If connections configured in pass-through mode are present (noted in Steps 5 through 8), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 15-100. If not, 
continue with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections 
on an OADM Node with OSC-CSM Cards” task on page 15-111.

Stop. You have completed this procedure.

NTP-G186 Perform the Four-Degree and Eight-Degree Mesh 
Patch Panel Acceptance Test 

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Purpose This procedure checks the insertion loss for a four-degree or eight-degree 
patch panel.

Tools/Equipment 1 fully-tunable transponder or tunable laser source with an LC patchcord

1 optical power meter with LC input connector

1 MPO-LC multicable (LC if the optical power meter has LC input)

Prerequisite Procedures • The mesh patch panel must be installed. See the “DLP-G28 Install the 
Fiber Patch-Panel Tray” in the Cisco ONS 15454 Hardware 
Installation Guide.

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 4 If you are installing a TXP_MR_10E_C card, complete the “DLP-G358 Provision TXP_MR_10E_L and 
TXP_MR_10E_C Cards for Acceptance Testing” task on page 15-25. Refer to Table 15-1 on page 15-42, 
if needed.

Step 5 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
to a wavelength not used in any of the sides already carrying traffic (1530.33 nm, for example).

Step 6 Complete the “DLP-G433 Record Transponder Optical Power” task on page 15-126.

Step 7 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 8 Connect the transponder to the COM-RX A port of the four-degree or eight-degree patch panel.

Step 9 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,MT (ANSI) 
or Locked,maintenance (ETSI) from the Admin State drop-down list. Click Apply.

Step 10 Verify the COM-RX port power results for Side A (Table 15-3).

Step 11 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 12 Connect the transponder to the COM-RX B port of the four-degree or eight-degree patch panel.

Step 13 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 14 Verify the COM-RX port power results for Side B (Table 15-4).

Table 15-3 From COM-RX Side A Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-11 on page 15-121

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TEST ACCESS TX Table 15-12 on page 15-122
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Step 15 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 16 Connect the transponder to the COM-RX C port of the four-degree or eight-degree patch panel.

Step 17 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 18 Verify the COM-RX port power results for Side C (Table 15-5).

Step 19 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 20 Connect the transponder to the COM-RX D port of the four-degree or eight-degree patch panel.

Step 21 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 22 Verify the COM-RX port power results for Side D (Table 15-6).

Table 15-4 From COM-RX Side B Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-11 on page 15-121

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TEST ACCESS TX Table 15-13 on page 15-122

Table 15-5 From COM-RX Side C Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-11 on page 15-121

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TAP TX Table 15-14 on page 15-123
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Step 23 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 24 If you are testing a four-degree patch panel, continue with Step 77. If you are testing an eight-degree 
patch panel, continue with Step 25.

Step 25 Connect the transponder to the COM-RX E port of the eight-degree patch panel.

Step 26 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 27 Verify the COM-RX port power results for Side E (Table 15-7).

Step 28 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 29 Connect the transponder to the COM-RX F port of the eight-degree patch panel.

Step 30 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 31 Verify the COM-RX port power results for Side F (Table 15-8).

Table 15-6 From COM-RX Side D Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-11 on page 15-121

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TEST ACCESS TX Table 15-15 on page 15-123

Table 15-7 From COM-RX Side E Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-11 on page 15-121

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TEST ACCESS TX Table 15-16 on page 15-123
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Step 32 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 33 Connect the transponder to the COM-RX G port of the eight-degree patch panel.

Step 34 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 35 Verify the COM-RX port power results for Side G (Table 15-9).

Step 36 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 37 Connect the transponder to the COM-RX H port of the eight-degree patch panel.

Step 38 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 39 Verify the COM-RX port power results for Side H (Table 15-10).

Table 15-8 From COM-RX Side F Verification Table

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-11 on page 15-121

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TEST ACCESS TX Table 15-17 on page 15-124

Table 15-9 From COM-RX Side G Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-11 on page 15-121

EXP H TX (eight-degree patch panel only) Table 15-19 on page 15-125

TEST ACCESS TX Table 15-18 on page 15-124
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Step 40 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 41 Connect the transponder to the test access RX port of the four- or eight-degree patch panel.

Note There are two local access RX ports on the 8-degree patch panel. Select the left Local Access 
port for testing.

Step 42 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list. Click Apply.

Step 43 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP A TX port of the four- 
or eight-degree patch-panel.

Step 44 Connect the optical power meter to the fan-out cable 1.

Step 45 Collect the actual reading from the optical power meter.

Step 46 Verify the IL is less than 11dB for an 8-degree patch panel or less than 8dB for a 4-degree patch panel.

Step 47 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP B TX port of the four- 
or eight-degree patch panel.

Step 48 Connect the optical power meter to the fan-out cable 2.

Step 49 Collect the actual reading from the optical power meter.

Step 50 Verify the IL is less than 11dB for an 8-degree patch panel or less than 8dB for a 4-degree patch panel.

Step 51 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP C TX port of the four- 
or eight-degree patch panel.

Step 52 Connect the optical power meter to the fan-out cable 3.

Step 53 Collect the actual reading from the optical power meter.

Step 54 Verify the IL is less than 11dB for an 8-degree patch panel or less than 8dB for a 4-degree patch panel.

Step 55 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP D TX port of the four- 
or eight-degree patch panel.

Step 56 Connect the optical power meter to the fan-out cable 4.

Step 57 Collect the actual reading from the optical power meter.

Table 15-10 From COM-RX Side H Verification

Connect MPO Connector to Patch Panel Port Refer to...

EXP A TX Table 15-12 on page 15-122

EXP B TX Table 15-13 on page 15-122

EXP C TX Table 15-14 on page 15-123

EXP D TX Table 15-15 on page 15-123

EXP E TX (eight-degree patch panel only) Table 15-16 on page 15-123

EXP F TX (eight-degree patch panel only) Table 15-17 on page 15-124

EXP G TX (eight-degree patch panel only) Table 15-18 on page 15-124

EXP H TX (eight-degree patch panel only) Table 15-11 on page 15-121

TEST ACCESS TX Table 15-19 on page 15-125
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Step 58 Verify the IL is less than 11dB for an 8-degree patch panel or less than 8dB for a 4-degree patch panel.

Step 59 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP E TX port of the four- 
or eight-degree patch panel.

Step 60 Connect the optical power meter to the fan-out cable 5.

Step 61 Collect the actual reading from the optical power meter.

Step 62 Verify the IL is less than 11dB for an 8-degree patch panel.

Step 63 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP F TX port of the four- 
or eight-degree patch panel.

Step 64 Connect the optical power meter to the fan-out cable 6.

Step 65 Collect the actual reading from the optical power meter.

Step 66 Verify the IL is less than 11dB for an 8-degree patch panel.

Step 67 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP G TX port of the four- 
or eight-degree patch panel.

Step 68 Connect the optical power meter to the fan-out cable 7.

Step 69 Collect the actual reading from the optical power meter.

Step 70 Verify the IL is less than 11dB for an 8-degree patch panel.

Step 71 Connect the MPO connector of the MPO-LC (FC or SC) multifiber fan-out to EXP H TX port of the four- 
or eight-degree patch panel.

Step 72 Connect the optical power meter to the fan-out cable 8.

Step 73 Collect the actual reading from the optical power meter.

Step 74 Verify the IL is less than 11dB for an 8-degree patch panel.

Step 75 In card view for the transponder card, click the Provisioning > Line tabs and choose OOS,DSBLD 
(ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 76 Repeat Steps 41 through 75 for the right side Local Access RX port.

Step 77 Complete the “NTP-G188 Perform the Native Mesh Node Acceptance Test” procedure on page 15-135.

The tables below are used for verification in Steps 10 through 39 of this procedure.

Table 15-11 Same Side Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 No power No power

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —
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DLP-  G94 Verify Add and Drop Connections on an OADM Node with OSC-CSM Cards
Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-12 Side A Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 IL < 11 dB IL < 8 dB

Cable 2 No power No power

Cable 3 No power No power

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-13 Side B Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 IL < 11 dB IL < 8 dB

Cable 3 No power No power

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-11 Same Side Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel
15-122
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 15      Perform Node Acceptance Tests
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Table 15-14 Side C Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 IL < 11 dB IL < 8 dB

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-15 Side D Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 No power No power

Cable 4 IL < 11 dB IL < 8 dB

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-16 Side E Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 No power No power

Cable 4 No power No power
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Cable 5 (eight-degree patch 
panel only)

IL < 11 dB —

Cable 6 (eight-degree patch 
panel only)

No power —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-17 Side F Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 No power No power

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

IL < 11 dB —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-18 Side G Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 No power No power

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —

Table 15-16 Side E Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel
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DLP-  G432 Set the Transponder Wavelength
Stop. You have completed this procedure.

DLP-G432 Set the Transponder Wavelength

Step 1 In card view, display the transponder card. 

Step 2 Click the Provisioning > Line > Wavelength Trunk Settings tabs.

Step 3 In the Wavelength field, choose the desired wavelength (C-Band, odd) from the drop-down list. 

Cable 7 (eight-degree patch 
panel only)

IL < 11 dB —

Cable 8 (eight-degree patch 
panel only)

No power —

Table 15-19 Side H Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Cable 1 No power No power

Cable 2 No power No power

Cable 3 No power No power

Cable 4 No power No power

Cable 5 (eight-degree patch 
panel only)

No power —

Cable 6 (eight-degree patch 
panel only)

No power —

Cable 7 (eight-degree patch 
panel only)

No power —

Cable 8 (eight-degree patch 
panel only)

IL < 11 dB —

Table 15-18 Side G Power Verification

Optical Power Meter Connected 
to Fan Out

Power Result for Eight-Degree 
Patch Panel

Power Result for Four-Degree 
Patch Panel

Purpose This task tunes transponder wavelength.

Tools/Equipment Fully C-band tunable transponder or tunable laser source with an LC 
patchcord

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 4 Click Apply.

Step 5 Click the Provisioning > Pluggable Port Module > Pluggable Port Module tabs and click Create to 
preprovision a pluggable port module (PPM), if necessary.

Step 6 Click Ok, then Apply.

Step 7 Return to your originating procedure (NTP).

DLP-G433 Record Transponder Optical Power

Step 1 Connect the optical power meter to the transponder output. 

Step 2 Display card view for the transponder card.

Step 3 Click the Provisioning > Line tabs, and choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from 
the Admin State drop-down list.

Step 4 Record the optical power meter value.

Step 5 Choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list.

Step 6 Disconnect the optical power meter from the TX port of the transponder card.

Step 7 Return to your originating procedure (NTP).

Purpose This task checks and records optical power.

Tools/Equipment Fully C-band tunable transponder or tunable laser source with an LC 
patchcord

Optical power meter

Prerequisite Procedures DLP-G46 Log into CTC

ANS successfully completed

All sides completely wired (including patch panels)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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NTP-G187 Perform the Multiring Site Acceptance Test 

Note Optical power measurements require either a tunable laser or a multirate transponder to generate the 
proper optical wavelength. If multirate transponders were installed during completion of Chapter 14, 
“Turn Up a Node,” they can be used for this procedure. No additional cabling changes are needed.

Step 1 Complete the “DLP-G46 Log into CTC” task at the multiring node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 4 Insert a full C-band tunable transponder card into an available slot.

Step 5 Plug a 15 dB LC attenuator to the TX port of the transponder card.

Step 6 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
to a wavelength yyyy.yy (1530.33 nm, for example).

Step 7 Complete the “DLP-G433 Record Transponder Optical Power” task on page 15-126.

Step 8 Disconnect the optical power meter from the TX port of the transponder card.

Purpose This procedure checks the connections and the output power values for a 
multiring node. A multiring node connects two existing in-service 
two-sides ROADM nodes with two sides (each equipped with MMU 
cards).

Tools/Equipment Fully C-band tunable transponder or tunable laser source 

1 15-dB LC attenuator

1 optical power meter with LC input connector

1 MPO-LC multicable (LC if the optical power meter has LC input)

3 LC-LC adapters

Prerequisite Procedures Chapter 14, “Turn Up a Node”

All sides must be completely wired (including patch panels), except the 
connections with the MMU cards in the existing in-service ROADM node; 
for more information, see Chapter 14, “Turn Up a Node”

NTP-G186 Perform the Four-Degree and Eight-Degree Mesh Patch Panel 
Acceptance Test, page 15-115 (as needed)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 9 Make the following connections: 

a. Connect the transponder card output port (with the 15 dB attenuator) to the COM-RX port of the 
40-WXC-C card on Side A.

b. Connect the optical power meter to the COM-TX port of the 40-WXC-C card on Side A.

c. Connect, using an LC-LC adapter, the patchcord from the COM-TX port to the patchcord in the 
COM-RX port of the Side B 40-WXC-C card.

d. Connect, using an LC-LC adapter, the patchcord from the COM-TX port to the patchcord in the 
COM-RX port of the Side C 40-WXC-C card.

e. Connect, using an LC-LC adapter, the patchcord from the COM-TX port to the patchcord in the 
COM-RX port of the Side D 40-WXC-C card.

Step 10 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs. Complete the following:

a. Record the values of the following parameters: 

– Power on the COM-TX port of the preamplifier on Side A

– Power on the COM-RX port of the 40-WXC-C card on Side A

– Power on the COM-TX port of the 40-WXC-C card on Side A

– Power Fail Low Th on the COM-RX port of the preamplifier on Side A

– Power on the COM-TX port of the preamplifier on Side B

– Power on the COM-RX port of the 40-WXC-C card on Side B

– Power on the COM-TX port of the 40-WXC-C card on Side B

– Power Fail Low Th on the COM-RX port of the preamplifier on Side B

– Power on the COM-TX port of the preamplifier on Side C

– Power on the COM-RX port of the 40-WXC-C card on Side C

– Power on the COM-TX port of the 40-WXC-C card on Side C

– Power Fail Low Th on the COM-RX port of the preamplifier on Side C

– Power on the COM-TX port of the preamplifier on Side D

– Power on the COM-RX port of the 40-WXC-C card on Side D

– Power on the COM-TX port of the 40-WXC-C card on Side D

– Power Fail Low Th on the COM-RX port of the preamplifier on Side D

b. Change the values of the parameters as follows:

– Power on the COM-TX port of the preamplifier on Side A = 1 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side A = –15 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side A = –15 dBm

– Power Fail Low Th on the COM-RX port of the preamplifier on Side A = –30 dBm

– Power on the COM-TX port of the preamplifier on Side B = 1 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side B = –15 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side B = –15 dBm

– Power Fail Low Th on the COM-RX port of the preamplifier on Side B = –30 dBm

– Power on the COM-TX port of the preamplifier on Side C = 1 dBm 
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– Power on the COM-RX port of the 40-WXC-C card on Side C = –15 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side C = –15 dBm

– Power Fail Low Th on the COM-RX port of the preamplifier on Side C = –30 dBm

– Power on the COM-TX port of the preamplifier on Side D = 1 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side D = –15 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side D = –15 dBm

– Power Fail Low Th on the COM-RX port of the preamplifier on Side D = –30 dBm

Step 11 In card view, display the transponder card and click the Provisioning > Line tabs. Choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list.

Step 12 In card view, display the 40-WXC-C card for Side A and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs. Record the Power value of the COM-RX 
port.

b. Verify that the COM-RX value matches the transponder card optical power meter value recorded in 
the “DLP-G433 Record Transponder Optical Power” task on page 15-126 (+\–1dB).

c. Click the Inventory > Info tabs and record the CRX -> EXP insertion loss.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.

e. Verify that the EXP-TX port power value = (COM-RX port power value in Step a) – (CRX -> EXP 
insertion loss value in Step d) (+\– 1dB).

Step 13 In card view, display the OPT-AMP-17 card for Side A and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 14 In card view, display the 40-WXC-C card for Side B and complete the following: 

a. Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133. Set the 
Input Port on the Maintenance > OCHNC > Insert Value tabs to 1.

b. Complete the “DLP-436 Record the 40-WXC-C Power Value” task on page 15-134.

Step 15 In card view, display the OPT-AMP-17 card for Side B and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 16 In card view, display the 40-WXC-C card for Side C and complete the following:

a. Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133. Set the 
Input Port on the Maintenance > OCHNC > Insert Value tabs to 1.

b. Complete the “DLP-436 Record the 40-WXC-C Power Value” task on page 15-134.

Step 17 In card view, display the OPT-AMP-17 card for Side C and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 18 In card view, display the 40-WXC-C card for Side D and complete the following: 

a. Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133. Set the 
Input Port on the Maintenance > OCHNC > Insert Value tabs to 1.

b. Complete the “DLP-436 Record the 40-WXC-C Power Value” task on page 15-134.

Step 19 In card view, display the OPT-AMP-17 card for Side D and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 20 In card view, display the 40-WXC-C card for Side A and complete the “DLP-435 Set the 40-WXC-C 
OCHNC Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert 
Value tabs to 2.
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Step 21 In card view, display the OPT-AMP-17 card for Side A and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 22 Record the optical power meter value and verify that the optical power meter value matches the value 
recorded in the “DLP-G433 Record Transponder Optical Power” task on page 15-126 (+\– 1dB).

Step 23 In card view, display the 40-WXC-C card for Side A. Click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete. Repeat for Sides B, 
C, and D of the 40-WXC-C card.

Step 24 To test all wavelengths, repeat Steps 6, 11, 18, and 20 for all supported wavelengths.

Step 25 In card view, display the transponder card and choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) 
from the Admin State drop-down list.

Step 26 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port for Side B of 
the 40-WXC-C card.

Step 27 Connect, using an LC-LC adapter, the patchcord from the COM-TX port with the patchcord in the 
COM-RX port for Side A of the 40-WXC-C card.

Step 28 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
card to the wavelength set in Step 6.

Step 29 Connect the transponder card output port (with the 15-dB-attenuator) to the COM-RX port of the 
40-WXC-C card for Side B.

Step 30 In card view, display the transponder card. Click the Provisioning > Line tabs, and choose IS (ANSI) 
or Unlocked (ETSI) from the Admin State drop-down list.

Step 31 Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 for Sides C and 
D of the 40-WXC-C card. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs to 2.

Step 32 Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 for Side B of the 
40-WXC-C card. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs to 3.

Step 33 In card view, display the 40-WXC-C card for Side B. Click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete. Repeat for Sides A, 
C, and D.

Step 34 To test all wavelengths, repeat Steps 28 through 33 (omit Step 29) for all supported wavelengths.

Step 35 In card view, display the transponder card. Click the Provisioning > Line tabs, and choose 
OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list.

Step 36 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side C of the 
40-WXC-C card.

Step 37 Connect, using an LC-LC adapter, the patchcord from the COM-TX port to the patchcord in the 
COM-RX port for Side B of the 40-WXC-C card.

Step 38 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
card to the wavelength set in Step 6.

Step 39 Connect the transponder card output port (with the 15-dB attenuator) to the COM-RX port of the 
40-WXC-C card for Side C.

Step 40 In card view for the transponder card, click the Provisioning > Line tabs and choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list.

Step 41 Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 for Sides A 
and D of the 40-WXC-C card. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 3.
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Step 42 Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 for Side C of the 
40-WXC-C card. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs to 4.

Step 43 In card view, display the 40-WXC-C card and click the Maintenance > OCHNC tabs. In the Return 
Value COM-TX on selected Wavelength area, click Refresh and then Delete. Repeat for Sides A, B, and 
D.

Step 44 To test all wavelengths, repeat Steps 38 through 43 (omit Step 39) for all supported wavelengths.

Step 45 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side D of the 
40-WXC-C card.

Step 46 Connect, using an LC-LC adapter, the patchcord from the COM-TX port to the patchcord in the 
COM-RX of Side C of the 40-WXC-C card.

Step 47 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
card to the desired wavelength for testing.

Step 48 Connect the transponder card output port (with the 15-dB attenuator) to the COM-RX port of the 
40-WXC-C card of Side D.

Step 49 In card view, display the transponder card. Click the Provisioning > Line tabs, and choose IS (ANSI) 
or Unlocked (ETSI) from the Admin State drop-down list.

Step 50 Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 for Sides A and 
B of the 40-WXC-C card. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs to 4.

Step 51 Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 for Side C of the 
40-WXC-C card. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs to 1.

Step 52 In card view, display the 40-WXC-C card for Side D. Click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete. Repeat for Sides 
A, B, and C of the 40-WXC-C card.

Step 53 To test all wavelengths, repeat Steps 47 through 52 for all supported wavelengths, except Step 48.

Step 54 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs. Restore the values recorded in Step 10a for the following parameters: 

• Power on the COM-TX port of the preamplifier on Side A

• Power on the COM-RX port of the 40-WXC-C card on Side A

• Power on the COM-TX port of the 40-WXC-C card on Side A

• Power Fail Low Th on the COM-RX port of the preamplifier on Side B

• Power on the COM-TX port of the preamplifier on Side B

• Power on the COM-RX port of the 40-WXC-C card on Side B

• Power on the COM-TX port of the 40-WXC-C card on Side B

• Power Fail Low Th on the COM-RX port of the preamplifier on Side B

• Power on the COM-TX port of the preamplifier on Side C

• Power on the COM-RX port of the 40-WXC-C card on Side C

• Power on the COM-TX port of the 40-WXC-C card on Side C

• Power Fail Low Th on the COM-RX port of the preamplifier on Side C

• Power on the COM-TX port of the pre-amplifier on Side D

• Power on the COM-RX port of the 40-WXC-C card on Side D

• Power on the COM-TX port of the 40-WXC-C card on Side D
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• Power Fail Low Th on the COM-RX port of the preamplifier on Side D

Step 55 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS. 

Step 56 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side A of the 
40-WXC-C card.

Step 57 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side B of the 
40-WXC-C card.

Step 58 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side C of the 
40-WXC-C card.

Step 59 Restore the connections to the MMU cards of the eight sides using the patchcords tested in this 
procedure:

a. Connect the patchcord from the COM-TX port of the 40-WXC-C card on Side A to the EXP-A-RX 
port of the MMU in the lowest slot of the upgraded ROADM Node 1.

b. Connect the patchcord from the COM-RX port of the 40-WXC-C card on Side A to the EXP-A-TX 
port of the MMU in the lowest slot of the upgraded ROADM Node 1.

c. Connect the patchcord from the COM-TX port of the 40-WXC-C card on Side B to the EXP-A-RX 
port of the MMU in the highest slot of the upgraded ROADM Node 1. 

d. Connect the patchcord from the COM-RX port of the 40-WXC-C card on Side B to the EXP-A-TX 
port of the MMU in the highest slot of the upgraded ROADM Node 1. 

e. Connect the patchcord from the COM-TX port of the 40-WXC-C card on Side C to the EXP-A-RX 
port of the MMU in the lowest slot of the upgraded ROADM Node 2.

f. Connect the patchcord from the COM-RX port of the 40-WXC-C card on Side C to the EXP-A-TX 
port of the MMU in the lowest slot of the upgraded ROADM Node 2.

g. Connect the patchcord from the COM-TX port of the 40-WXC-C card on Side D to the EXP-A-RX 
port of the MMU in the highest slot of the upgraded ROADM Node 2.

h. Connect the patchcord from the COM-RX port of the 40-WXC-C card on Side D to the EXP-A-TX 
port of the MMU in the highest slot of the upgraded ROADM Node 2.

Stop. You have completed this procedure.

DLP-434 Record the OPT-AMP-17-C Power Value 

Purpose This task records the power value of the OPT-AMP-17 card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-436 Record the 40-WXC-C Power Value, page 15-134

ANS successfully completed

All sides completely wired (including patch panels)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 1 In card view for the OPT-AMP-17 card for Side x, complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify the COM-RX port power value matches the value of the EXP-TX port of the 40-WXC-C card 
in the “DLP-436 Record the 40-WXC-C Power Value” task on page 15-134 (+\– 1 dB). 

c. Click the Provisioning > Op. Ampli. Line > Parameters tabs and record the Total Output Power 
value of the COM-TX port.

d. Verify that the value is 1 dBm (+\– 1 dB).

Step 2 Return to your originating procedure (NTP).

DLP-435 Set the 40-WXC-C OCHNC Parameters

Step 1 In the 40-WXC-C card view for Side x, complete the following:

a. Click the Maintenance > OCHNC > Insert Value tabs and set the parameters as follows:

– Target Power (dBm) = –15.0

Note The target power is not set if the power value is higher than the channel power that is allocated 
and equalized.

– Input Port = x (EXP-RX) (for x, refer to the step in the originating procedure)

– VOA Attenuation (dB) = 13 

– Wavelength = Value set in the originating procedure

b. Click Apply.

c. Click Refresh. In the Return Value COM-TX on selected Wavelength field, verify that the Actual 
Power (dBm) is –15 +\– 0.5dB.

Step 2 Return to your originating procedure (NTP).

Purpose This task sets the OCHNC parameters for the 40-WXC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

ANS successfully completed

All sides completely wired (including patch panels)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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DLP-436 Record the 40-WXC-C Power Value 

Step 1 In card view for the 40-WXC-C card for Side x, complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

b. Verify that the COM-TX port value matches Return Value COM-TX on selected Wavelength value 
retrieved in the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133 (+\– 1 dB).

c. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.

d. Click the Inventory > Info tabs and record the CRX -> EXP insertion loss value.

e. Verify that the EXP-TX port power value = (COM-TX port power value) – (CRX -> EXP insertion 
loss value) (+\– 1 dB).

Step 2 Return to your originating procedure (NTP).

Purpose This task records the power value of the 40-WXC-C card for a multiring 
configuration.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G433 Record Transponder Optical Power, page 15-126

DLP-435 Set the 40-WXC-C OCHNC Parameters, page 15-133

ANS successfully completed

All sides completely wired (including patch panels)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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NTP-G188 Perform the Native Mesh Node Acceptance Test

Step 1 Identify the sides that are already carrying traffic and which sides are going to be tested.

Step 2 Complete the “DLP-G46 Log into CTC” task at the mesh native node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(An equipment alarm is indicated in the Alarms tab, Cond column as EQPT.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 5 Insert a full C-band tunable transponder into an available slot of the side that you want to test (Side A 
through H, referred to as Side x in this procedure).

Step 6 Plug a 15-dB LC attenuator into the trunk TX port of the transponder card.

Step 7 Select a wavelength that is not used on any of the sides for carrying traffic (or 1530.33 nm if it is a new 
installation). Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune 
the transponder for the selected wavelength yyyy.yy.

Step 8 Connect the optical power meter to the trunk TX port of the transponder card.

Step 9 Complete the “DLP-G433 Record Transponder Optical Power” task on page 15-126. 

Step 10 Disconnect the optical power meter from the TX port of the transponder card.

Step 11 In card view, display the OSC-CSM or OSCM card for Side x and complete the following:

a. Click the Maintenance > ALS tabs and from the OSRI pull-down menu, select OFF.

b. From the ALS Mode pull-down menu, select Disable.

Purpose This procedure checks the power values and the optical connections for a 
native mesh node. Use this test for both new installations and directional 
upgrades of native mesh nodes. Use this to also test the installation of a 
new side n to a node.

Tools/Equipment • Fully C-band tunable transponder or tunable laser source with an LC 
patchcord

• 1 MPO-LC multicable (LC if the optical power meter has LC input)

• 1 LC-LC adapter

Prerequisite Procedures • All sides must be completely fibered (including mesh patch panels); 
for more information, see Chapter 14, “Turn Up a Node”

• NTP-G186 Perform the Four-Degree and Eight-Degree Mesh Patch 
Panel Acceptance Test, page 15-115 (optional)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 12 Make the following connections: 

a. Connect the transponder output port (with the 15-dB attenuator) to the Line RX port of the booster 
amplifier (OPT-BST, OPT-BST-E, OPT-AMP-C, OPT-AMP-17-C, or OSC-CSM) of Side x.

b. Connect the optical power meter to the LINE-TX port of the booster amplifier (OPT-BST, 
OPT-BST-E, OPT-AMP-C, OPT-AMP-17-C, or OSC-CSM) of Side x.

c. Use a fiber to connect the 40-DMX-C TX port to the 40-MUX-C RX port for the selected 
wavelength yyyy.yy in the 15454-PP-80-LC patch panel for Side x.

Step 13 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs. Complete the following:

a. Record the actual values of the following parameters:

– Power on the COM-TX port of preamplifier on Side X

– Power on the COM-RX port of the 40-WXC-C card on Side X

– Power on the COM-TX port of the 40-WXC-C card on Side X

– Power on the LINE-TX port of the booster amplifier on Side X

b. Set the previous values of the parameters as follows:

– Power on the COM-TX port of preamplifier on Side X = +8 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side X = +8 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side X = –18 dBm

– Power on the LINE-TX port of the booster amplifier on Side X = –1 dBm

c. Click Apply.

Step 14 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS. 

Step 15 In card view, display the 40-DMX-C card for Side x and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the VOA Attenuation Ref. 
value y.

b. Set the VOA Attenuation Calib. to –y.

c. Choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the Admin State drop-down list.

d. Click Apply.

Step 16 In card view, display the 40-MUX-C card for Side x. Click the Provisioning > Optical Line > 
Parameters tabs, and choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the Admin State 
drop-down list. Click Apply.

Step 17 In card view, display the booster amplifier card for Side x. Click the Inventory > Info tabs and record 
the IL02 (LINE RX->COM TX) insertion loss value.

Step 18 In card view, display the transponder card and click the Provisioning > Line tabs. For trunk port, choose 
OOS,MT (ANSI) or Locked,maintenance (ETSI) from the Admin State drop-down list and click 
Apply.

Step 19 In card view, display the booster amplifier card for Side x, and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

b. Verify the power value of the COM-TX port = (Optical power meter value in Step 9) – (LINE 
RX->COM TX insertion loss value read in Step 17) (+\– 1 dB).
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Step 20 In card view, display the preamplifier card (OPT-PRE, OPT-AMP-C, or OPT-AMP-17C) for Side x and 
complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the COM-RX power value matches the value in Step 19b (+\– 1 dB).

c. Click the Provisioning > Opt. Ampli. Line > Parameters tabs and record the Total Output Power 
value of the COM-TX port. 

d. Verify that the value is +8 dBm (+\– 1 dB).

Step 21 In card view, display the 40-WXC-C card for Side x and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the value matches the COM-TX port power value in Step 20c (+/- 1dB).

c. Click the Inventory > Info tabs and record the CRX -> EXP insertion loss.

d. Record the CRX -> DROP insertion loss.

e. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.

f. On the same screen, record the Power value of the DROP-TX port.

g. Verify that the EXP-TX Power value in Step 21e = (COM-RX value in Step 21a) – (CRX -> EXP 
value in Step 21c) (+\– 1 dB).

h. Verify that the DROP-TX value in Step 21f = (COM-RX value in Step 21a) – (CRX -> DROP value 
in Step 21d) (+\– 1 dB).

Step 22 In card view, display the 40-DMX-C card for Side x and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the COM-RX power value in Step a matches the value in Step 21f (+\– 1 dB).

c. Click the Inventory > Info tabs and record the 1RX -> xTX insertion loss (where x is the channel 
number associated with yyyy.yy wavelength).

d. Click the Provisioning > Optical Chn > Parameters tabs and record the Power value of the 
CHAN-TX port associated with yyyy.yy wavelength.

e. Verify that the CHAN-TX port Power value = (COM-RX power value in Step 22a) – (1RX -> xTX 
insertion loss value in Step 22c) (+\– 1 dB).

Step 23 In card view, display the 40-MUX-C card for Side x and complete the following:

a. Click the Provisioning > Optical Chn > Parameters tabs and record the Power value of the 
CHAN-RX port associated with the selected yyyy.yy wavelength.

b. Verify that the CHAN-RX value in Step 23a = (CHAN-TX value in Step 22d) (+\– 1.5 dB).

c. Click the Inventory > Info tabs and record the xRX -> 1TX insertion loss (where x is the channel 
number associated with yyyy.yy wavelength).

d. Click the Provisioning > Optical Line > Parameters tabs, record the Power value of the COM-TX 
port.

e. Verify that the COM-TX Power value = (CHAN-RX value in Step 23a) – (yRX -> 1TX value in 
Step 23c) (+\– 1 dB).
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Step 24 In card view, display the 40-WXC-C card for Side x and complete the following:

a. Click the Maintenance > OCHNC tabs, and in the Insert Value section, set the available parameters 
as follows:

– Target Power (dBm) = –18.0

Note The target power is not set if the power value is higher than the channel power that is allocated 
and equalized.

– Input port = 9 (ADD-RX)

– VOA Attenuation (dB) = 13

– Wavelength = yyyy.yy (wavelength selected in Step 7)

b. Click Apply.

c. In the Return Value COM-TX section on selected Wavelength area, click Refresh and verify that the 
Actual Power (dBm) is the Target Power from Step 24a +\– 0.5 dB. If the channel does not come up, 
reduce VOA Attenuation by 5dB in Step 24a until the target power is reached.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

e. Verify that the COM-TX Power value matches the Actual Power value in Step 24c (+\– 1 dB).

Step 25 In card view, display the booster amplifier card for Side x, and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify COM-RX Power value matches the COM-TX Power value in Step 24d (+\– 1 dB).

c. Click the Provisioning > Opt. Ampli. Line > Parameters tabs and record the Power value of the 
LINE-TX port.

d. Verify that the LINE-TX value matches the power on the LINE-TX port of the booster amplifier on 
Side x recorded in Step 13b (+\– 1 dB).

e. Record the optical power meter value.

f. Verify that the optical power meter value matches the LINE-TX value in Step 25c (+\– 1 dB).

Step 26 Select the 40-WXC-C card on Side n where n is A, B, C, D, E, F, G, or H but n is not equal to x, go to 
the card view and complete the following:

a. Click the Maintenance > OCHNC tabs, and in the Insert Values section, set the available 
parameters as follows:

– Target Power (dBm) = –22.0

Note The target power is not set if the power value is higher than the channel power that is allocated 
and equalized.

– Input port = x (EXP-RX)

– VOA Attenuation (dB) = 20

– Wavelength = yyyy.yy (wavelength selected in Step 7)

b. Click Apply.
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c. In the Return Value COM-TX on selected Wavelength area, click Refresh and verify that the 
Actual Power (dBm) is Target Power of Step 26a +\– 0.5 dB. If the channel does not come up, reduce 
VOA Attenuation by 5dB in Step 26a until the target power is reached.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

e. Verify that the value of the COM-TX port matches the Actual Power value in Step 26c (+\– 1 dB).

f. Click the Maintenance > OCHNC tabs. In the Return Value COM-TX on selected Wavelength area, 
click Refresh and then Delete.

Step 27 Repeat Step 26 for all the others of Side n, where n is A, B, C, D, E, F, G, or H but n not equal to x.

Step 28 In card view, display the 40-WXC-C card for Side x and click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete.

Step 29 In card view, display the transponder card and click the Provisioning > Line tabs. For trunk port, choose 
OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list. Click Apply.

Step 30 To test all wavelengths, repeat Step 7 through Step 29 for each wavelength. In Step 7, set the wavelength 
to the next odd wavelength.

Step 31 Disconnect the optical power meter from the LINE-TX port of the booster amplifier of the Side x.

Step 32 Disconnect the transponder output port (with the 15-dB attenuator) from the LINE-RX port of the 
booster amplifier of the Side x.

Step 33 In card view, display the 40-DMX-C card for Side x and click the Provisioning > Optical Line > 
Parameters tabs. Complete the following:

a. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) from the Admin State 
drop-down list.

b. Change the VOA Attenuation Calib. from the existing value to 0 (zero).

c. Click Apply.

Step 34 In card view, display the 40-MUX-C card for Side x and click the Provisioning > Optical Line > 
Parameters tabs. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) from the Admin 
State drop-down list and click Apply.

Step 35 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs and restore the values recorded in Step 13a for the following 
parameters:

• Power on the COM-TX port of preamplifier on Side X

• Power on the COM-RX port of the 40-WXC-C on Side X

• Power on the COM-TX port of the 40-WXC-C on Side X

• Power on the LINE-TX port of the booster amplifier on Side X

Step 36 Repeat Steps 5 through 35 for all the others sides that are being installed.

Step 37 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS.

Stop. You have completed this procedure.
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NTP-G189 Perform the Node Upgrade Acceptance Test 

Step 1 Complete the “DLP-G46 Log into CTC” task at the upgrade node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. Complete the “DLP-G128 Disable Alarm Filtering” task as 
necessary.

b. Verify that no equipment alarms appear indicating equipment failure or other hardware problems. 
(Equipment alarms are indicated by an EQPT in the Alarms tab Cond column.) If equipment failure 
alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 4 Insert a full C-band tunable transponder into an available slot for the node that you want to test.

Step 5 Plug a 15-dB LC attenuator to the TX port of the transponder.

Step 6 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
to a wavelength yyyy.yy that is not used in any of the sides already carrying traffic (or 1530.33 nm if it 
is a new installation).

Step 7 Complete the “DLP-G433 Record Transponder Optical Power” task on page 15-126.

Step 8 Disconnect the optical power meter from the TX port of the transponder card.

Step 9 Make the following connections: 

a. Connect the transponder card output port (with the 15-dB attenuator) to the COM-RX port of the 
40-WXC-C card on Side A.

Purpose This procedure checks the connections and the output power values for a 
node in an upgraded ring. The upgraded node connects an existing 
in-service ROADM node with two sides (each equipped with MMU cards) 
to a native mesh node with two sides.

Tools/Equipment Fully C-band tunable transponder or tunable laser source with an LC 
patchcord

1 15-dB LC attenuator

1 optical power meter with LC input connector

2 LC-LC patchcords (or at least one for each native side)

1 LC-LC adapter

Prerequisite Procedures Chapter 14, “Turn Up a Node”

All sides completely wired (including patch panels), except the 
connections with the MMU cards in the existing in-service ROADM node; 
for more information, see Chapter 14, “Turn Up a Node”

NTP-G186 Perform the Four-Degree and Eight-Degree Mesh Patch Panel 
Acceptance Test, page 15-115

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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b. Connect the optical power meter to the COM-TX port of the 40-WXC-C card on Side A.

c. Connect, using the LC-LC adapter, the patchcord from the COM-TX port with the patchcord from 
the COM-RX port of the Side B 40-WXC-C card.

Step 10 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs. Complete the following:

a. Record the values of the following parameters:

– Power on the COM-TX port of the preamplifier on Side A

– Power on the COM-RX port of the 40-WXC-C card on Side A

– Power on the COM-TX port of the 40-WXC-C card on Side A

– Power Fail Low Th on the COM-RX port of the preamplifier on Side A

– Power on the COM-TX port of the preamplifier on Side B

– Power on the COM-RX port of the 40-WXC-C card on Side B

– Power on the COM-TX port of the 40-WXC-C card on Side B

– Power Fail Low Th on the COM-RX port of the preamplifier on Side B

b. Change the values of the parameters as follows:

– Power on the COM-TX port of the preamplifier on Side A = 1 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side A = –15 dBm 

– Power on the COM-TX port of the 40-WXC-C card on Side A = –15 dBm 

– Power Fail Low Th on the COM-RX port of the preamplifier on Side A = –30 dBm 

– Power on the COM-TX port of the preamplifier on Side B = 1 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side B = –15 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side B = –15 dBm

– Power Fail Low Th on the COM-RX port of the preamplifier on Side B = –30 dBm

c. Click Apply.

d. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS.

Step 11 Display card view for the OPT-AMP-17 card on Side A and click the Provisioning > Card tabs. From 
the Working Card Mode drop-down list, verify that OPT-PRE appears and if not, choose it. Click Apply. 
Repeat for Side B.

Step 12 Display card view for the transponder card and click the Provisioning > Line tabs. Choose IS (ANSI) 
or Unlocked (ETSI) from the Admin State drop-down list and click Apply.

Step 13 In card view, display the 40-WXC-C card of Side A and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs. Record the Power value of the COM-RX 
port.

b. Verify that the COM-RX value matches the transponder card optical power meter value recorded in 
Step 7 (+\– 1 dB).

c. Click the Inventory > Info tabs and record the CRX -> EXP insertion loss.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.
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e. Verify that the EXP-TX port power value = (COM-RX port power value in Step a) - (EXP-TX Power 
value in Step d) (+\– 1 dB).

Step 14 In card view, display the OPT-AMP-17 card for Side A and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 15 In card view, display the 40-WXC-C card for Side B and complete the following: 

a. Complete the “DLP-435 Set the 40-WXC-C OCHNC Parameters” task on page 15-133. Set the 
Input Port on the Maintenance > OCHNC > Insert Value tabs to 1.

b. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

c. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

d. Verify that the COM-RX Power value matches the COM-TX port Power value in b (+\– 1 dB).

e. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.

f. Click the Inventory > Info tabs and record the CRX -> EXP insertion loss value.

g. Verify that the EXP-TX port power value = (COM-RX port power value) - (CRX -> EXP insertion 
loss value) (+\– 1 dB)

Step 16 In card view, display the OPT-AMP-17 card for Side B and complete the “DLP-434 Record the 
OPT-AMP-17-C Power Value” task on page 15-132.

Step 17 In card view, display the 40-WXC-C for Side A and complete the “DLP-435 Set the 40-WXC-C OCHNC 
Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 2.

Step 18 In card view, display the 40-WXC-C for Side C and complete the “DLP-435 Set the 40-WXC-C OCHNC 
Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 1. 

Step 19 In card view, display the 40-WXC-C for Side D and complete the “DLP-435 Set the 40-WXC-C OCHNC 
Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 1.

Step 20 In card view, display the 40-WXC-C for Side A and click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete. Repeat for Sides B, 
C, and D of the 40-WXC-C card. 

Step 21 Display card view for the transponder card and choose OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI) from the Admin State drop-down list.

Step 22 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side B of the 
40-WXC-C card.

Step 23 Connect, using the LC-LC adapter, the patchcord from the COM-TX port with the patchcord in the 
COM-RX port for Side A of the 40-WXC-C card.

Step 24 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
to the wavelength set in Step 6.

Step 25 Connect the transponder card output port (with the 15-dB attenuator) to the COM-RX port of the 
40-WXC-C card on Side B.

Step 26 Display card view for the transponder card. Click the Provisioning > Line tabs, and choose IS (ANSI) 
or Unlocked (ETSI) from the Admin State drop-down list.
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Step 27 In card view, display the 40-WXC-C card for Side A and complete the “DLP-435 Set the 40-WXC-C 
OCHNC Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert 
Value tabs to 2.

Step 28 In card view, display the 40-WXC-C for Side B and complete the “DLP-435 Set the 40-WXC-C OCHNC 
Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 1.

Step 29 In card view, display the 40-WXC-C for Side C and complete the “DLP-435 Set the 40-WXC-C OCHNC 
Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 2. 

Step 30 In card view, display the 40-WXC-C for Side D and complete the “DLP-435 Set the 40-WXC-C OCHNC 
Parameters” task on page 15-133. Set the Input Port on the Maintenance > OCHNC > Insert Value tabs 
to 2.

Step 31 In card view, display the 40-WXC-C for Side B and click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete. Repeat for Sides 
A, C, and D of the 40-WXC-C card.

Step 32 Display the card view for the transponder card. Click the Provisioning > Line tabs, and choose 
OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the Admin State drop-down list.

Step 33 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs. Restore the values recorded in Step 10a for the following parameters: 

• Power on the COM-TX port of the preamplifier on Side A

• Power on the COM-RX port of the 40-WXC-C card on Side A

• Power on the COM-TX port of the 40-WXC-C card on Side A

• Power Fail Low Th on the COM-RX port of the preamplifier on Side A

• Power on the COM-TX port of the preamplifier on Side B

• Power on the COM-RX port of the 40-WXC-C card on Side B

• Power on the COM-TX port of the 40-WXC-C card on Side B

• Power Fail Low Th on the COM-RX port of the preamplifier on Side B

Step 34 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS. 

Step 35 Disconnect the patchcord in the COM-TX port from the patchcord in the COM-RX port of Side A of the 
40-WXC-C card.

Step 36 Make the following connections:

a. Connect the transponder output port (with the 15-dB attenuator) to the LINE-RX port of the booster 
amplifier of Side C.

b. Connect the optical power meter to the LINE-TX port of the booster amplifier of Side C.

c. Connect the client TX of lambda yyyy.yy to the client RX of lambda yyyy.yy on the Side C patch 
panel. 

Step 37 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs and complete the following:

a. Record the actual values of the following parameters:

– Power on the COM-TX port of the preamplifier on Side X

– Power on the COM-RX port of the 40-WXC-C card on Side X

– Power on the COM-TX port of the 40-WXC-C card on Side X
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– Power on the LINE-TX port of the booster amplifier on Side X

b. Set the values of the parameters as follows:

– Power on the COM-TX port of the preamplifier on Side X = 8 dBm

– Power on the COM-RX port of the 40-WXC-C card on Side X = 8 dBm

– Power on the COM-TX port of the 40-WXC-C card on Side X = –18 dBm

– Power on the LINE-TX port of the booster amplifier on Side X = –8 dBm

c. Click Apply.

Step 38 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS. 

Step 39 In card view, display the 40-DMX-C card for Side C and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the VOA Attenuation Ref. 
value y.

b. Set the VOA Attenuation Calib. to –y.

c. Choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the Admin State drop-down list.

d. Click Apply.

Step 40 In card view, display the 40-MUX-C card for Side C and click the Provisioning > Optical Line > 
Parameters tabs. Choose OOS,MT (ANSI) or Locked,maintenance (ETSI) from the Admin State 
drop-down list and click Apply.

Step 41 In card view, display the booster amplifier card for Side C. Click the Inventory > Info tabs and record 
the LINE-RX -> COM TX insertion loss.

Step 42 Display the transponder card in card view and click the Provisioning > Line tabs. Choose IS (ANSI) or 
Unlocked (ETSI) from the Admin State drop-down list and click Apply.

Step 43 In card view, display the booster amplifier card for Side C and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

b. Verify the COM-TX Power value = (Optical power meter value) – (LINE RX -> COM TX insertion 
loss value in Step 41) (+\– 1 dB).

Step 44 In card view, display the preamplifier card for Side C and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the COM-RX Power value matches the COM-TX port Power value in Step 43a 
(+\– 1 dB).

c. Click the Provisioning > Opt. Ampli. Line > Parameters tabs and record the Total Output Power 
value of the COM-TX port. 

d. Verify that the COM-TX Total Output Power value is 8 dBm (+\– 1 dB).

Step 45 In card view, display the 40-WXC-C card for Side C and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the COM-RX power value matches the Total Output Power value of the COM-TX port 
value in Step 44c (+\– 1 dB).

c. Click the Inventory > Info tabs and record the CRX -> EXP insertion loss.
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d. Record the CRX -> DROP insertion loss.

e. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
EXP-TX port.

f. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
DROP-TX port.

g. Verify that the EXP-TX Power value in Step e = (COM-RX value in Step a) - (CRX -> EXP value 
in Step c) (+\– 1 dB).

h. Verify that the DROP-TX value in Step f = (COM-RX value in Step a) - (CRX -> DROP value in 
Step d) (+\– 1 dB).

Step 46 In card view, display the 40-DMX-C card for Side C and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Verify that the COM-RX port Power value in Step a matches the COM-TX port Power value in 
Step 45b (+\– 1 dB).

c. Click the Inventory > Info tabs and record the 1RX -> yTX insertion loss (where y is the channel 
number associated with yyyy.yy wavelength).

d. Click the Provisioning > Optical Chn > Parameters tabs and record the Power value of the 
CHAN-TX port associated with yyyy.yy wavelength.

e. Verify that the CHAN-TX Power value = (COM-RX Power value in Step a) - (1RX -> yTX insertion 
loss value in Step c) (+\– 1 dB).

Step 47 In card view, display the 40-MUX-C card for Side C and complete the following:

a. Click the Provisioning > Optical Chn > Parameters tabs and record the Power value of the 
CHAN-RX port associated with yyyy.yy wavelength.

b. Verify that the CHAN-RX value matches the CHAN-TX Power value in Step 46d (+\– 1.5 dB).

c. Click the Inventory > Info tabs and record the yRX -> 1TX insertion loss (where y is the channel 
number associated with yyyy.yy wavelength).

d. In the Provisioning > Optical Line > Parameters tabs, record the Power value of the COM-TX 
port.

e. Verify that the COM-TX Power value = (CHAN-RX Power value in Step a) – (yRX -> 1TX insertion 
loss value in Step c) (+\– 1 dB).

Step 48 In card view, display the 40-WXC-C card for Side C, and complete the following:

a. Click the Maintenance > OCHNC > Insert Value tabs, and set the available parameters as follows:

– Target Power (dBm) = –18.0

Note The target power is not set if the power value is higher than the channel power that is allocated 
and equalized.

– Input port = 9 (ADD-RX)

– VOA Attenuation (dB) = 13

– Wavelength = yyyy.yy (value set in Step 6)

b. Click Apply.
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c. Click the Maintenance > OCHNC tabs. In the Return Value COM-TX on selected Wavelength area, 
click Refresh and verify that the Actual Power (dBm) is –18 +\– 0.5 dB.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

e. Verify that the COM-TX Power value matches the Actual Power value in Step c (+\– 1 dB).

Step 49 In card view, display the booster amplifier card for Side C, and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-RX port.

b. Click the Provisioning > Opt. Ampli. Line > Parameters tabs and record the Power value of the 
LINE-TX port.

c. Verify that the LINE-TX value matches the Side C Tx Amplifier Ch Power recorded in 
Step 37a (+\– 1 dB).

d. Record the optical power meter value.

e. Verify that the optical power meter value matches the LINE-TX Power value in Step b (+\– 1 dB).

Step 50 In card view, display the 40-WXC-C card for Side C, and click the Maintenance > OCHNC tabs. In the 
Return Value COM-TX on selected Wavelength area, click Refresh and then Delete.

Step 51 Display Side A of the 40-WXC-C card in card view, and complete the following:

a. Click the Maintenance > OCHNC > Insert Value tabs, and set the available parameters as follows:

– Target Power (dBm) = –18.0

Note The target power is not set if the power value is higher than the channel power that is allocated 
and equalized.

– Input port = 3 (EXP-RX)

– VOA Attenuation (dB) = 13

– Wavelength = yyyy.yy (value set in Step 6)

b. Click Apply.

c. In the Return Value COM-TX on selected Wavelength area, click Refresh and verify that the 
Actual Power (dBm) is –18 +\– 0.5 dB.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

e. Verify that the value of the COM-TX port matches the Actual Power value in Step c (+\– 1 dB).

f. Click the Maintenance > OCHNC tabs. In the Return Value COM-TX on selected Wavelength area, 
click Refresh and then Delete.

Step 52 Repeat Step 51 for the 40-WXC-C card of Side B.

Step 53 Repeat Step 51 for the 40-WXC-C card of Side D.

Step 54 Display card view for the transponder card and choose OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI) from the Admin State drop-down list.

Step 55 Connect the transponder output port (with the 15-dB attenuator) to the Line RX port of the booster 
amplifier of Side D. 

Step 56 Complete the “DLP-G432 Set the Transponder Wavelength” task on page 15-125 to tune the transponder 
to the next odd wavelength after yyyy.yy nm.
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Step 57 Disconnect the patchcord between the client TX of lambda yyyy.yy from the client RX of lambda yyyy.yy 
on the Side C patch panel. Use this patchcord to connect the client TX of lambda yyyy.yy to the client 
RX of lambda yyyy.yy on the Side D patch panel. Note that yyyy.yy was recorded in Step 6.

Step 58 Repeat Steps 37 to 51 for Side D.

Step 59 Display Side A of the 40-WXC-C card in card view, and complete the following:

a. Click the Maintenance > OCHNC > Insert Value tabs, and set the available parameters as follows:

– Target Power (dBm) = –18.0

Note The target power is not set if the power value is higher than the channel power that is allocated 
and equalized.

– Input port = 4 (EXP-RX)

– VOA Attenuation (dB) = 13

– Wavelength = yyyy.yy (value set in Step 6)

b. Click Apply.

c. In the Return Value COM-TX on selected Wavelength area, click Refresh and verify that the 
Actual Power (dBm) is –18 +\– 0.5 dB.

d. Click the Provisioning > Optical Line > Parameters tabs and record the Power value of the 
COM-TX port.

e. Verify that the value of the COM-TX port matches the Actual Power value in Step c (+\– 1 dB).

f. Click the Maintenance > OCHNC tabs. In the Return Value COM-TX on selected Wavelength area, 
click Refresh and then Delete.

Step 60 Repeat Step 59 for the 40-WXC-C card of Side B.

Step 61 Repeat Step 59 for the 40-WXC-C card of Side C.

Step 62 Disconnect the optical power meter from the LINE-TX port of the booster amplifier of Side D.

Step 63 Disconnect the transponder output port (with the 15-dB attenuator) from the LINE-RX port of the 
booster amplifier of the Side x.

Step 64 In card view, display the 40-DMX-C card for Side C, and complete the following:

a. Click the Provisioning > Optical Line > Parameters tabs. 

b. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) from the Admin State 
drop-down list.

c. Set the VOA Attenuation Calib to 0 (zero).

d. Click Apply.

Step 65 In card view, display the 40-MUX-C card for Side C and click the Provisioning > Optical Line > 
Parameters tabs. Choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) from the Admin 
State drop-down list and click Apply.

Step 66 Repeat Steps 64 and 65 for Side D.

Step 67 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs and restore the values recorded in Step 37a for the following 
parameters for Sides C and D:

• Power on the COM-TX port of the preamplifier on Side X
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• Power on the COM-RX port of the 40-WXC-C card on Side X

• Power on the COM-TX port of the 40-WXC-C card on Side X

Step 68 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. Click Launch ANS.

Step 69 Restore the connections to the MMU cards of the four sides using the patchcords tested in this procedure:

a. Connect the patchcord from the COM-TX port of the 40-WXC-C card on Side A to the EXP-A-RX 
port of the MMU in the lowest slot of the upgraded ROADM node.

b. Connect the patchcord from the COM-RX port of the 40-WXC-C card on Side A to the EXP-A-TX 
port of the MMU in the lowest slot of the upgraded ROADM node.

c. Connect the patchcord from the COM-TX port of the 40-WXC-C card on Side B to the EXP-A-RX 
port of the MMU in the highest slot of the upgraded ROADM node.

d. Connect the patchcord from the COM-RX port of the 40-WXC-C card on Side B to the EXP-A-TX 
port of the MMU in the highest slot of the upgraded ROADM node.

Stop. You have completed this procedure.

NTP-G243 Perform the Two-Degree ROADM Node with 
40-SMR-1-C and OPT-AMP-17-C Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 On the 40-SMR-1-C card on Side A, do the following steps:

a. Remove the LC connectors between the ADD/DROP ports of the 40-SMR-1-C card and the MUX 
and DMX units.

Purpose This procedure tests a two-degree ROADM node with 40-SMR-1-C and 
OPT-AMP-17-C cards installed. 

Tools/Equipment One of the following:

• A tunable laser

• TXP_DME_10E_C 

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures “NTP-G143 Import the Cisco Transport Planner NE Update Configuration 
File” procedure on page 14-48

“NTP-G30 Install the DWDM Cards” procedure on page 14-64

“NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” 
procedure on page 14-75

“NTP-G37 Run Automatic Node Setup” procedure on page 14-126

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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b. Create a physical loopback by connecting a fiber optic jumper between the ADD and DROP ports.

Step 3 Retrieve the power set point of the DROP-TX port of the 40-SMR-1-C card on Side A. To view this set 
point, do the following:

a. Go to node view (single-shelf mode) or multishelf view (multishelf mode) and click the 
Provisioning > WDM-ANS > Provisioning tabs.

b. In the Selector window on the left, expand the 40-SMR-1-C card on Side A.

c. Expand the Port DROP-TX category.

d. Select Power.

e. Record the value of the Shelf i Slot i (40-SMR-1-C).Port DROP-TX.Power parameter in the right 
pane.

f. If the value of the Power set point is greater than -6dBm, continue with Step 4, else edit the Power 
set point to -6dBm and complete the “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. 

This will ensure there is enough power to perform the optical validation procedure.

Step 4 Display the OPT-AMP-17-C on Side A in card view, and complete the following steps:

a. Click the Maintenance > ALS tabs.

b. From the ALS Mode pull-down menu, select Disable. 

Step 5 Connect a tunable laser or a fully tunable TXP_DME_10E_C card to the LINE RX port of the 
OPT-AMP-17-C card on Side A. Connect a 10dB bulk attenuator to the fiber or regulate the output power 
of the tunable laser to -10dBm.

Step 6 Create an OCHNC DCN for channel 1 on Side A related to the ADD-DROP path using the “DLP-G105 
Provision Optical Channel Network Connections” task on page 17-44. The circuit must be bidirectional 
connecting the ADD-RX port of the 40-SMR-1-C card to the LINE-TX port of the OPT-AMP-17-C card 
and vice-versa (LINE-RX port of the OPT-AMP-17-C card to the DROP-TX port of the 40-SMR-1-C 
card)

Step 7 Set the tunable laser or the TXP_DME_10E_C card to the first wavelength of the 100-GHz ITU-T 
C-band grid (1530.33 nm) and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) 
state.

Step 8 Verify the power levels of channel 1 by performing the following steps:

a. Check the optical connection between the OPT-AMP-17-C and 40-SMR-1-C cards. The power 
difference between the COM-TX port of OPT-AMP-17-C and the LINE-RX port of 40-SMR-1-C 
must not exceed of +/- 1.5dB.

b. Check the following parameters of the RX-amplifier in the 40-SMR-1-C card:

– The Working mode on the EXP-TX port must be the same as the ANS set point value that is set 
to Gain.

– The total power on the EXP-TX port must be equal to Channel Power Ref. with a tolerance 
+/-1.5dB.

– The DCU insertion loss must be equal to the power difference between the DC-TX and DC-RX 
ports and the absolute value of the DCU insertion loss must be less than 11dB.

c. Check the parameters of the drop VOA in the 40-SMR-1-C card. The value of the VOA Attenuation 
parameter on the DROP-TX port must be equal to the value of the VOA Attenuation Ref. parameter 
with a tolerance of +/-1.0dB.

d. Check the following parameters of the add VOA in the 40-SMR-1-C card: 
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– In the card view, click the Provisioning > OCH > Parameters tabs.

– Select the first channel from the Wavelength drop-down list and click Retrieve. The optical path 
from the ADD-RX port to the LINE-TX port is highlighted.

– Verify if the value of the Power To parameter is the same as that of the VOA Power Ref. 
parameter with a tolerance +/-1.0dB.

e. Check the optical connection between the 40-SMR-1-C and OPT-AMP-17-C card. The power 
difference between the LINE-TX port of the 40-SMR-1-C card and the COM-RX port of the 
OPT-AMP-17-C card must not exceed +/- 1.5dB. 

f. Check the following parameters of the OPT-AMP-17-C card: 

– The Working mode on the LINE-TX port must be the same as the ANS set point value that is 
set to Gain.

– The value of the Gain parameter must be equal to the Gain set point +/-1.0dB. The gain set point 
for the OPT-AMP-17-C card is 17dB.

Step 9 Delete the OCHNC DCN circuit for channel 1 on Side A that is related to the ADD-DROP path created 
in Step 6 using the “DLP-G106 Delete Optical Channel Network Connections” task on page 17-49.

Step 10 Create an OCHNC DCN circuit for channel 1 on Side A related to the EXP path using the “DLP-G105 
Provision Optical Channel Network Connections” task on page 17-44. The circuit must be bidirectional 
and connects the LINE-RX port of the OPT-AMP-17-C card on Side A to the LINE-TX port of the 
OPT-AMP-17-C card on Side B.

Step 11 Verify the power levels of channel 1 by performing the following steps:

a. Check the optical connection between the OPT-AMP-17-C and 40-SMR-1-C card on Side A. The 
power difference between the COM-TX port of OPT-AMP-17-C and the LINE-RX port of 
40-SMR-1-C must not exceed +/- 1.5dB.

b. Check the following parameters of the RX-amplifier in the 40-SMR-1-C card: 

– The Working mode on the EXP-TX port must be the same as the ANS set point value that is set 
to Gain.

– The total power on the EXP-TX port must be equal to Channel Power Ref. with a tolerance 
+/-1.5dB. 

– The DCU insertion loss must be equal to the power difference between the DC-TX and DC-RX 
ports and the absolute value of the DCU insertion loss must be less than 11dB.

c. Check the optical connection between 40-SMR-1-C on Side A and 40-SMR-1-C on Side B. The 
power difference between the EXP-TX port and the EXP-RX port must not exceed +/- 1.5dB.

d. Check the parameters of the pass-through VOA in the 40-SMR-1-C card on Side B: 

– In the card view, click the Provisioning > OCH > Parameters tabs.

– Select the first channel from the Wavelength drop-down list and click Retrieve. The optical path 
from the EXP-RX port to the LINE-TX port is highlighted.

– Verify if the value of the Power To parameter is the same as the value of the VOA Power Ref. 
parameter with a tolerance +/-1.0dB.

e. Check the optical connection between the 40-SMR-1-C and OPT-AMP-17-C card on Side B. The 
power difference between the LINE-TX port of the 40-SMR-1-C card and the COM-RX port of the 
OPT-AMP-17-C card must not exceed +/- 1.5dB. 

f. Check the following parameters of the OPT-AMP-17-C card on Side B: 

– The Working mode on the LINE-TX port must be the same as the ANS set point value that is 
set to Gain.
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– The value of the Gain parameter must be equal to the Gain set point +/-1.0dB. The gain set point 
for the OPT-AMP-17-C card is 17dB.

Step 12 Turn off the laser or place the trunk port of the TXP card in OutofService (OOS) state and delete the 
OCHNC DCN circuit on Side A related to channel 1 created in Step 10 using the “DLP-G106 Delete 
Optical Channel Network Connections” task on page 17-49.

Step 13 Set the tunable laser or the TXP_DME_10E_C card to the second wavelength of the 100-GHz ITU-T 
C-band grid and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) state. Repeat 
Step 6 through Step 12 for the second wavelength.

Step 14 Repeat Step 13 for the remaining 38 wavelengths on Side A.

Step 15 Delete the OCHNC DCN circuit related to channel 40 using the “DLP-G106 Delete Optical Channel 
Network Connections” task on page 17-49 and turn off the laser or place the trunk port of the 
TXP_DME_10E_C card in OutofService (OOS) state.

Step 16 On the 40-SMR-1-C card on Side A, do the following steps:

a. Remove the physical loopback between the ADD and DROP ports on the 40-SMR-1-C card created 
in Step 2.

b. Reconnect the DROP-TX port to the RX port on the DMX side of the 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD patch panel.

Step 17 On the 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD unit on Side A, do the 
following steps:

a. Create a physical loopback between the MUX and DMX ports on the 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD unit.

b. Connect the TX port on the MUX side of the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD unit to a power meter. If the power meter is not available, reconnect the TX port 
of the 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD unit to the ADD-RX port 
of the 40-SMR-1-C card on Side A.

Step 18 Create an OCHNC DCN for channel 1 on Side A related to the ADD-DROP path as done in Step 6.

Step 19 Set the tunable laser or the TXP_DME_10E_C card to the first wavelength of the 100-GHz ITU-T 
C-band grid (1530.33 nm) and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) 
state.

Step 20 To verify the insertion loss on the optical path of the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD unit, do the following steps:

a. Retrieve the power value on the DROP-TX port of the 40-SMR-1-C card and record it as Pin.

b. Measure the optical power on the power meter or the ADD-RX port and record it as Pout.

c. Verify that the power difference between the power values obtained in step 21 a.and step 21 b. does 
not exceed the insertion loss value specified for the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD unit. (Pin - Pout must be less than 13dB with a tolerance of 1dB).

Step 21 Turn off the laser or place the trunk port of the TXP card in OutofService (OOS) state and delete the 
OCHNC DCN circuit on Side A related to channel 1 using the “DLP-G106 Delete Optical Channel 
Network Connections” task on page 17-49.

Step 22 Set the tunable laser or the TXP_DME_10E_C card to the next wavelength of the 100-GHz ITU-T 
C-band grid (1530.33 nm) and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) 
state and repeat Step 18 through Step 21 for the new wavelength.

Step 23 Restore the initial configuration after checking all the 40 available wavelengths:

a. Remove the power meter and reconnect the 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD unit to the ADD-RX port of the 40-SMR-1-C card.
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b. Remove the physical loopbacks between the MUX and DMX ports on the 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD unit on Side A.

c. Reset the ALS parameter on the 40-SMR-1-C card. Complete the following:

– In card view, display the 40-SMR-1-C card on Side A and click the Maintenance > ALS tabs.

– From the ALS Mode pull-down menu, select Auto Restart.

d. Import the CTP XML file again using the “NTP-G143 Import the Cisco Transport Planner NE 
Update Configuration File” procedure on page 14-48 to overwrite any manual settings.

e. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 and verify that 
there are no errors.

Step 24 Repeat all the steps from Step 2 through Step 23 related to Side B.

Stop. You have completed this procedure.

NTP-G244 Perform the Four Degree ROADM Node with 
40-SMR-2-C Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to perform the acceptance test. 
If you are already logged in, continue with Step 2.

Step 2 On the 40-SMR-2-C card on Side A, do the following steps:

a. Remove the LC connectors between the ADD/DROP ports of the 40-SMR-2-C card and the MUX 
and DMX units.

b. Create a physical loopback by connecting a fiber optic jumper between the ADD and DROP ports.

Purpose This procedure tests a four-degree ROADM node with 40-SMR-2-C cards 
installed. 

Tools/Equipment One of the following:

• A tunable laser

• TXP_DME_10E_C 

An optical power meter or optical spectrum analyzer

Two bulk attenuators (10 dB) with LC connectors

Prerequisite Procedures “NTP-G143 Import the Cisco Transport Planner NE Update Configuration 
File” task on page 14-48

“NTP-G30 Install the DWDM Cards” procedure on page 14-64

“NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” 
procedure on page 14-75

“NTP-G37 Run Automatic Node Setup” procedure on page 14-126

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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Step 3 Retrieve the power set point of the DROP-TX port of the 40-SMR-2-C card on Side A. To view this set 
point, do the following:

a. Go to the multishelf view (multishelf mode) and click the Provisioning > WDM-ANS > 
Provisioning tabs.

b. In the Selector window on the left, expand the shelf.

c. Expand the 40-SMR-2-C card on Side A.

d. Expand the Port DROP-TX category.

e. Select Power.

f. Record the value of the Shelf i Slot i (40-SMR-2-C).Port DROP-TX.Power parameter in the right 
pane.

g. If the value of the Power set point is greater than -6dBm, continue with Step 4, else edit the Power 
set point to -6dBm and complete the “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. 

This will ensure there is enough power to perform the optical validation procedure.

Step 4 Display the 40-SMR-2-C card for Side A in card view and complete the following steps:

a. Click the Maintenance > ALS tabs.

b. From the ALS Mode pull-down menu, select Disable for port 8 (LINE-TX). 

c. Click Apply.

Step 5 Connect a tunable laser or a fully tunable TXP_DME_10E_C to the LINE RX port of the 40-SMR-2-C 
card on Side A. Connect a bulk attenuator to the fiber or regulate the output power of the tunable laser 
to -10dBm.

Step 6 Create an OCHNC DCN on Side A related to the ADD-DROP path of channel 1 using the “DLP-G105 
Provision Optical Channel Network Connections” task on page 17-44. The circuit must be bidirectional 
connecting the ADD-RX port to the LINE-TX port of the 40-SMR-2-C card and vice-versa (LINE-RX 
port to the DROP-TX port of the 40-SMR-2-C card)

Step 7 Set the tunable laser or the TXP_DME_10E_C card to the first wavelength of the 100-GHz ITU-T 
C-band grid (1530.33 nm) and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) 
state.

Step 8 Verify the power levels of channel 1 by performing the following steps:

a. Check the parameters of the RX-amplifier in the 40-SMR2-C card: 

– In the 40-SMR2-C card view, click the Provisioning > Opt.Ampli.Line > Parameters tabs.

– Verify that the working mode on the EXP-TX port is set to Gain.

– Record the values of the Total Output Power and Channel Power Ref. parameters. 

– Verify that the value of the Total Output Power is within +/-1.0 dB of the Channel Power Ref. 
value.

– Record the value of the DCU insertion loss parameter and verify that the value is less than 
11 dB.

b. Check the parameters of the drop VOA in the 40-SMR-2-C card:

– Go to the multishelf view (multishelf mode) and click the Provisioning > WDM-ANS > Port 
Status tabs.

– In the Selector window on the left, expand shelf i, where i is the shelf you are working on.

– Expand Slot i (40-SMR2-C), where i is the slot where the 40-SMR2-C card is located.
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– Expand the Port DROP-TX category.

– Click the VOA Target Attenuation parameter.

– Record the VOA target attenuation displayed in the Value field.

– In the 40-SMR2-C card view, click the Provisioning > Optical Line > Parameters tabs.

– Record the VOA Attenuation Ref. value on Port 6 (DROP-TX).

– Verify that the value of the VOA Target Attenuation parameter recorded above is equal to the 
value of the VOA Attenuation Ref. parameter on the DROP-TX port with a tolerance +/-1.0 dB.

c. Check the parameters of the add VOA in the 40-SMR-2-C card: 

– In the 40-SMR-2-C card view, click the Provisioning > OCH > Parameters tabs.

– Select the required channel from the Wavelength drop-down list and click Retrieve. The optical 
path from the ADD-RX port to the LINE-TX port is displayed in the table.

– Record the values of the Power To and VOA Power Ref. parameters for the ADD-RX to 
LINE-TX row.

– Verify that the value of the VOA Power Ref. parameter is equal to the value of the Power To 
parameter with a tolerance +/-1.0dB.

– In the 40-SMR-2-C card view, click the Provisioning > Opt.Ampli.Line > Parameters tabs.

– Record the working mode of Port 8 (LINE-TX).

– Verify that the working mode on the LINE-TX port is set to Gain.

– Go to the multishelf view (multishelf mode) and click the Provisioning > WDM-ANS > Port 
Status tabs.

– In the Selector window on the left, expand shelf i, where i is the shelf you are working on.

– Expand Slot i (40-SMR2-C), where i is the slot where the 40-SMR2-C card is located.

– Expand the Port LINE-TX category.

– Click the Gain parameter.

– Record the gain displayed in the Value field.

– Verify that the gain is equal to 17 dB.

Step 9 Delete the OCHNC DCN circuit for channel 1 on Side A related to the ADD-DROP path that was created 
in Step 6 using the “DLP-G106 Delete Optical Channel Network Connections” task on page 17-49.

Step 10 Create an OCHNC DCN circuit for channel 1 on Side A related to the EXP-TX path towards Side B 
using the “DLP-G105 Provision Optical Channel Network Connections” task on page 17-44. The circuit 
must be bidirectional and connects the LINE-RX port of the 40-SMR-2-C card on Side A to the 
LINE-TX port of the 40-SMR-2-C card on Side B.

Step 11 Verify the power levels of channel 1 by performing the following steps:

a. Check the parameters of the RX-amplifier in the 40-SMR-2-C card: 

– In the 40-SMR2-C card view on Side A, click the Provisioning > Opt.Ampli.Line > 
Parameters tabs.

– Verify that the working mode on the EXP-TX port is set to Gain.

– Record the values of the Total Output Power and Channel Power Ref. parameters. 

– Verify that the value of the Total Output Power is within +/-1.0 dB of the Channel Power Ref. 
value.
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b. Check the optical connection between Side A and Side B through the 15454-PP-4-SMR patch panel. 
Depending on the source side, the EXP-i-RX port of the destination side varies. Verify the 
connectivity among the different sides using the 15454-PP-4-SMR patch panel block diagram in the 
“Node Reference” chapter of the Cisco ONS 15454 DWDM Reference Manual. For example, on 
Side A, EXP-TX is connected to Side B on EXP-1-RX, Side C on EXP-2-RX, and Side D on 
EXP-3-RX. The power difference between the EXP-TX port and the EXP-i-RX port must be less 
than 7 dB.

– In the 40-SMR2-C card view on Side B, click the Provisioning > Optical Line > Parameters 
tabs.

– Record the express RX power on Port 10 (EXP-RX 1-2).

– Compare the express RX power to the total output power recorded in Step 11a.

– Verify that the absolute value of the total output power minus the express RX power is less than 
7 dB.

c. Check the parameters of the pass-through VOA and TX-amplifier in the 40-SMR-2-C card on 
Side B: 

– In the card view, click the Provisioning > OCH > Parameters tabs.

– Select the first channel from the Wavelength drop-down list and click Retrieve. 

– View the optical path from the EXP-i-RX port to the LINE-TX port that is displayed in the table.

– Verify that the value of the Power To parameter is the same as the value of the Channel Power 
Ref. parameter with a tolerance +/-1.0dB.

– Click the Provisioning > Opt.Ampli.Line > Parameters tabs.

– Verify that the working mode on Port 8 (LINE-TX) is set to Gain.

– Ensure that the value of the gain parameter on Port 8 (LINE-TX) must be equal to 17 dB.

– The Working mode on the LINE-TX port must be the same as the ANS set point value that is 
set to Gain.

– The value of the Gain parameter on the LINE-TX port must be equal to the Gain set point 
+/-1.0dB. The gain set point for the 40-SMR-2-C card is 17dB.

Step 12 Delete the OCHNC DCN circuit towards Side B related to channel 1 created in Step 10 using the 
“DLP-G106 Delete Optical Channel Network Connections” task on page 17-49.

Step 13 Create the OCHNC DCN circuit for channel 1 on Side A related to EXP-TX path towards Side C using 
the “DLP-G105 Provision Optical Channel Network Connections” task on page 17-44. Repeat Step 11 
and Step 12 for the circuit that is created.

Step 14 Repeat Step 13 towards Side D, turn off the laser or place the trunk port of the TXP_DME_10E_C card 
in OutofService (OOS) state.

Step 15 Set the tunable laser or the TXP_DME_10E_C card to the second wavelength of the 100-GHz ITU-T 
C-band grid and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) state. Repeat 
Step 6 through Step 14 for the second wavelength.

Step 16 Repeat Step 15 for the remaining 38 wavelengths on Side A.

Step 17 Delete the OCHNC DCN circuit related to channel 40 using the “DLP-G106 Delete Optical Channel 
Network Connections” task on page 17-49 and turn off the laser or place the trunk port of the 
TXP_DME_10E_C card in OutofService (OOS) state.

Step 18 On the 40-SMR-2-C card on Side A, do the following steps:

a. Remove the physical loopback between the ADD and DROP ports on the 40-SMR-2-C card created 
in Step 2.
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b. Reconnect the DROP-TX port on the 40-SMR2-C card to the COM-RX port on the DMX side of the 
15216-MD-40-ODD patch panel.

c. Reconnect the ADD-RX port on the 40-SMR2-C card to the COM-TX port on the MUX side of the 
15216-MD-40-ODD patch panel.

Step 19 On the15216-MD-40-ODD unit on Side A, do the following steps:

a. Create a physical loopback between the MUX and DMX ports of the 15216-MD-40-ODD unit that 
are related to the same wavelength. Perform this step for all the 40 wavelengths on the 
15216-MD-40-ODD patch panel on the side you are working on.

Step 20 Create an OCHNC DCN for channel 1 on Side A related to the ADD-DROP path as done in Step 6.

Step 21 Set the tunable laser or the TXP_DME_10E_C card to the first wavelength of the 100-GHz ITU-T 
C-band grid (1530.33 nm) and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) 
state.

Step 22 To verify the insertion loss on the optical path of the 15216-MD-40-ODD unit on Side A, do the 
following steps:

a. In the 40-SMR2-C card view, click the Provisioning > Optical Line > Parameters tabs.

b. Retrieve the power value on Port 6 (DROP-TX) of the 40-SMR-2-C card and record it as Pin.

c. Retrieve the power value on Port 5 (ADD-RX) port and record it as Pout.

d. Verify that the power difference between the power values obtained in step 22 b. and step 22 c. do 
not exceed the insertion loss value specified for the 15216-MD-40-ODD unit. (Pin - Pout must be 
less than 13dB with a tolerance of 1dB).

Step 23 Turn off the laser or place the trunk port of the TXP_DME_10E_C card in OutofService (OOS) state and 
delete the OCHNC DCN circuit on Side A related to channel 1 using the “DLP-G106 Delete Optical 
Channel Network Connections” task on page 17-49.

Step 24 Set the tunable laser or the TXP_DME_10E_C card to the next wavelength of the 100-GHz ITU-T 
C-band grid (1530.33 nm) and place the trunk port of the TXP_DME_10E_C card in the In-Service (IS) 
state and repeat Step 20 through Step 23 for the new wavelength.

Step 25 Restore the initial configuration after checking all the 40 available wavelengths:

a. Remove the power meter and reconnect the 15216-MD-40-ODD unit to the ADD-RX port of the 
40-SMR-2-C card.

b. Remove the physical loopbacks between the MUX and DMX ports on the 15216-MD-40-ODD unit 
on Side A.

c. Reset the ALS parameter on the 40-SMR-2-C card. Complete the following:

– In card view, display the 40-SMR-2-C and click the Maintenance > ALS tabs.

– From the ALS Mode pull-down menu, select Auto Restart.

d. Import the CTP XML file again using the “NTP-G143 Import the Cisco Transport Planner NE 
Update Configuration File” task on page 14-48 to overwrite any manual settings.

e. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126 and verify no 
errors are present.

Step 26 Repeat all the steps from Step 2 through Step 25 related to Side B.

Step 27 Repeat all the steps from Step 2 through Step 25 related to Side C.

Step 28 Repeat all the steps from Step 2 through Step 25 related to Side D.
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Stop. You have completed this procedure.
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Turn Up a Network

This chapter explains how to turn up and test a Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) network. For DWDM topology reference information and span loss tables, see 
Chapter 13, “Network Reference.”

There are two main DWDM network types: metro core, where the channel power is equalized and 
dispersion compensation is applied, and metro access, where the channels are not equalized and 
dispersion compensation is not applied. The DWDM network topologies supported are hubbed rings, 
multihubbed rings, meshed rings, linear configurations, and single-span links. The DWDM node types 
supported are hub, terminal, optical add/drop multiplexing (OADM), reconfigurable optical add/drop 
multiplexing (ROADM), anti-amplified spontaneous emissions (anti-ASE), and line amplifier. For 
DWDM and hybrid node turn-up procedures, see Chapter 14, “Turn Up a Node.”

Note The procedures and tasks described in this chapter for the Cisco ONS 15454 platform is applicable to 
the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card and “RAMAN-COP” refers 
to the 15454-M-RAMAN-COP card.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G51 Verify DWDM Node Turn Up, page 16-2—Complete this procedure before beginning 
network turn-up.

2. NTP-G52 Verify Node-to-Node Connections, page 16-3—Complete this procedure next.

3. NTP-G201 Configure the Raman Pump on an MSTP Link, page 16-4—Complete this procedure to 
set the Raman total power and Raman ratio.

4. NTP-G53 Set Up Timing—Complete this procedure next.

5. NTP-G54 Provision and Verify a DWDM Network, page 16-28—Complete this procedure next.

6. NTP-G56 Verify the OSNR, page 16-33—Complete as needed.
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7. NTP-G142 Perform a Protection Switch Test, page 16-34—Complete as needed.

8. NTP-G164 Configure Link Management Protocol, page 16-36—Complete as needed.

9. NTP-G233 Configure Link Management Protocol on the Cisco CRS-1 or Cisco ASR 9000 Router 
and the Cisco ONS 15454 DWDM Node, page 16-43—Complete as needed.

10. NTP-G303 Configure Virtual links on the Cisco 7600 and Cisco ONS 15454 DWDM Node, 
page 16-65—Complete as needed.

11. NTP-G57 Create a Logical Network Map, page 16-68—Complete as needed.

12. NTP-G325 View the Power Levels of Cisco ONS 15454 MSTP Nodes, page 16-68—Complete as 
needed.

13. NTP-G326 Provision SRLG on the Cisco ONS 15454 MSTP Network, page 16-69—Complete as 
needed.

NTP-G51 Verify DWDM Node Turn Up

Step 1 Log in to an ONS 15454 node on the network that you will test. See the DLP-G46 Log into CTC task 
for instructions. If you are already logged in, continue with Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not turned on. See the DLP-G128 Disable Alarm Filtering task as 
necessary.

b. Verify that no equipment alarms appear (EQPT in the Cond column) indicating equipment failure or 
other hardware problems. If equipment failure alarms appear, investigate and resolve them before 
continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 3 Verify that the software version shown in the node view (single-shelf mode) or multishelf view 
(multishelf mode) status area matches the version required by your network. (The status area is located 
to the left of the shelf graphic.) If the software is not the correct version, perform one of the following 
procedures:

• Perform a software upgrade using a Cisco ONS 15454 software CD or Cisco ONS 15454 SDH 
software CD. Refer to the release-specific software upgrade document.

• Replace TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards with cards containing the correct 
release.

Step 4 Click the Provisioning > General tabs. Verify that all general node information settings are correct 
according to documentation provided by the network administrator. If not, see the NTP-G80 Change 
Node Management Information procedure.

Purpose This procedure verifies that each ONS 15454 is ready for DWDM network 
turn-up before adding nodes to a network. This procedure applies to all 
ROADM, OADM, and line-amplifier nodes.

Tools/Equipment Network plan provided by your network administrator

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click the Provisioning > Network tabs. Ensure that the IP settings and other Cisco Transport Controller 
(CTC) network access information is correct according to documentation provided by the network 
administrator. If not, see the NTP-G81 Change CTC Network Access procedure.

Step 6 Click the Provisioning > Protection tabs. Verify that all required protection groups have been created 
according to documentation provided by the network administrator. If not, see the “NTP-G33 Create a 
Y-Cable Protection Group” procedure on page 11-182 or the NTP-G83 Modify or Delete Card Protection 
Settings procedure.

Step 7 Click the Provisioning > Security tabs. Verify that all users have been created and that their security 
levels are correct according to documentation provided by the network administrator. If not, see the 
NTP-G88 Modify Users and Change Security procedure.

Step 8 If Simple Network Management Protocol (SNMP) is provisioned on the node, click the Provisioning > 
SNMP tabs. Verify that all SNMP settings are correct according to documentation provided by the 
network administrator. If not, see the NTP-G89 Change SNMP Settings procedure.

Step 9 Repeat this procedure at each node in the network.

Stop. You have completed this procedure.

NTP-G52 Verify Node-to-Node Connections

Note In this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Step 1 Check to see if the fibers coming from the adjacent nodes are connected to the OPT-BST, OPT-BST-E, 
OPT-AMP-17-C (operating in the booster amplifier mode), or OSC-CSM card LINE RX and TX ports. 
If yes, continue with Step 2. If adjacent node fibers are not connected to the LINE RX and TX ports, do 
not continue. Install the cabling to the adjacent nodes using the “NTP-G34 Install Fiber-Optic Cables on 
DWDM Cards and DCUs” procedure on page 14-75.

Step 2 Verify the following network fiber connections:

• The node’s Side A ports (LINE TX and RX) are connected to the Side B ports (LINE RX and TX) 
of the adjacent node.

• The node’s Side B ports (LINE RX and TX) are connected to the Side A ports (LINE TX and RX) 
of the adjacent node.

Step 3 Complete the DLP-G46 Log into CTC task at the network node that you want to verify.

Purpose This procedure verifies optical service channel (OSC) terminations 
between nodes and checks span attenuation. This procedure applies to all 
ROADM, OADM, and line-amplifier locations.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 16-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
16-3
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_41C9F20545A941B799A08E3EE386C598
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_7B5CFE9E8BD44FF2B3F09DA2C47FA766
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_7B5CFE9E8BD44FF2B3F09DA2C47FA766
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_5ECD79D07576409D8C1A3DC858EED334
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_05D88C20DA2047F2BBBDCE538E30E7D7
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 16      Turn Up a Network
  Before You Begin
Step 4 Click the Provisioning > Comm Channels > OSC tabs. Verify that OSC terminations appear under the 
OSC Terminations area for the Side B and Side A OSC-CSM or OSCM cards and that the port state is 
In-Service and Normal (IS-NR [ANSI]/Unlocked-enabled [ETSI]). If so, continue with Step 5. If OSC 
terminations are not created, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124.

Step 5 Complete the NTP-G76 Verify Optical Span Loss Using CTC procedure for all OSC-CSM cards. If the 
measured span loss is within the minimum and maximum expected span loss values, continue with 
Step 6. If not, clean the fiber connected to the OPT-BST, OPT-BST-E, OPT-AMP-17-C (operating in the 
booster amplifier mode), or OSC-CSM cards on both ends of the span, then repeat the NTP-G76 Verify 
Optical Span Loss Using CTC procedure. If the span loss is within the minimum and maximum expected 
span loss values, continue with Step 6. If not, contact your next level of support. 

Step 6 Repeat Steps 2 through 5 at each network node.

Stop. You have completed this procedure.

NTP-G201 Configure the Raman Pump on an MSTP Link

Step 1 The Raman pump can be configured in the following ways:

• DLP-G468 Configure the Raman Pump Using the Installation Wizard, page 16-5—This procedure 
is the preferred and recommended installation process.

• DLP-G690 Configure the Raman Pump Using Manual Day-0 Installation, page 16-19—Use this 
procedure to configure and tune RAMAN-CTP and RAMAN-COP cards, using manual day-0 
installation.

• DLP-G474 Configure the Raman Pump by Importing the CTP XML File, page 16-25—Use this 
procedure when the span is longer than 42 dB (expand on span). This procedure is not recommended 
for spans of 42 dB or less.

• DLP-G489 Configure the Raman Pump by Setting the ANS Parameters Manually, page 16-25—Use 
this procedure if the Raman installation wizard fails and expert intervention is required.

Stop. You have completed this procedure.

Purpose This procedure configures the Raman pump on an Multiservice Transport 
Platform (MSTP) link. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G468 Configure the Raman Pump Using the Installation Wizard

Note The installation wizard performs optical measurements and data exchange between the nodes. Make sure 
that the data communications network (DCN) is stable.

Note Running the installation wizard without setting the automatic node setup (ANS) parameters causes the 
wizard to fail. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 14-126.

Note Running the installation wizard can impact traffic. Make sure that nobody is working on the nodes before 
continuing with this procedure.

Caution To perform optical measurements, the installation wizard automatically turns on hardware resources 
installed on the nodes. Alarms can occur during the installation process. Following the recommendations 
is critical to the success of installation.

Note Make sure that a Muxponder, a WSS, or a tunable transponder is present before you run the Raman 
installation wizard.

Note When the span is longer than 42 dB, do not use the Raman installation wizard.

Purpose This procedure configures the Raman Pump on an MSTP link using the 
installation wizard.

Tools/Equipment None

Prerequisite Procedures •  DLP-G46 Log into CTC

• NTP-G30 Install the DWDM Cards, page 14-64

• NTP-G51 Verify DWDM Node Turn Up, page 16-2

• NTP-G37 Run Automatic Node Setup, page 14-126.

• Create an optical service channel (OSC) termination link by 
completing the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124 or create an optical transport section (OTS) provisionable 
patchcord terminations on line ports by completing “NTP-G184 
Create a Provisionable Patchcord” procedure on page 17-77, as 
required.

Required/As Needed Required

Onsite/Remote Onsite and remote

Security Level Provisioning or higher
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Note A bulk attenuator is not required between the transponder and the OPT-RAMP-C or OPT-RAMP-CE 
card if the Raman installation wizard is started from a Raman only node (line amplifier node equipped 
with OPT-RAMP-C or OPT-RAMP-CE card without post-amplifier). 

Step 1 From the CTC View menu, choose Go to Network View.

Step 2 Figure 16-1 shows a sample network view of nodes (terminal or ROADM) connected in the network. 

Figure 16-1 Network View of Nodes (Terminal or ROADM)

The Raman pump on the OPT-RAMP-C or OPT-RAMP-CE card can be configured on a single span or 
multiple spans.

Step 3 To start the Raman installation wizard, complete one of the following steps:

• To configure Raman amplification on a single span, go to Network view, right-click on a span and 
choose Raman Installation Day0 from the shortcut menu. (Figure 16-2). Go to Step 5.

• To configure Raman amplification on multispans, go to Network view, right-click on a specific node, 
and choose Raman Installation Day0 Multi-span from the shortcut menu (Figure 16-3).
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Figure 16-2 Installing the Raman Pump on a Single Span

Figure 16-3 Installing the Raman Pump on Multiple Spans
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The Routing page is displayed (Figure 16-4).

Figure 16-4 Selecting Spans for Raman Amplification

The Included Span list box lists all spans that are selected in the network.

Step 4 Select a span from the network to add a span.

If you are setting up multispans, make sure that the span selection is made in a sequence; otherwise, an 
error message is displayed. 

Step 5 When you have selected the span or spans, click Next.

The Setting Parameters page is displayed (see Figure 16-5). 
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Figure 16-5 Setting Raman Calibration Parameter

Note The Hints area displays the status of internal operations.

Note If multiple spans are selected, the applicable nodes are displayed on the left side of the page.

Step 6 Select one or more check boxes as applicable:

• Autorun wizard—The Installation wizard tunes the selected span automatically, requiring no user 
intervention. However, if the wizard displays errors, the wizard requests for user 
acknowledgements.

• Even Band—This option is used for optical networks that support only even band channels. If the 
network supports odd and even channels, the Raman Installation wizard tunes the transponder to the 
first tunable odd band channel.

• Auto Skip Tune Path—The Raman Installation wizard skips spans that have been previously tuned 
by the wizard. 

• Bidirectional Path—This configures the OPT-RAMP-C or OPT-RAMP-CE cards in both directions 
(source to destination and destination to source)

• MUX/DMUX Present—This option is used if the optical network has transponders connected to 
the A/D stage (MUX or WSS).

Several scenarios are discussed in the following section. Select as applicable:

• Check box Bidirectional Path is unchecked and check box MUX/DMUX Present is checked. See 
Figure 16-6 and Step 7a.

• Check box Bidirectional Path is unchecked and check box MUX/DMUX Present is unchecked. See 
Figure 16-7 and Step 7b.
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• Check box Bidirectional Path is checked and check box MUX/DMUX Present is checked. See 
Figure 16-8 and Step 7c.

• Check box Bidirectional Path is checked and check box MUX/DMUX Present is unchecked. See 
Figure 16-9 and Step 7d.

Note Before you check the MUX/DMUX Present check box, ensure that the following prerequisites are 
completed: 

• At least one source node is a terminal node or a ROADM node.

• Two transponders/muxponders supporting wavelength of 1530.33 nm and 1560.61 nm, used as 
probe signals, are available on the source node for odd channels or wavelengths of 1530.72 nm and 
1561.01 nm for even channels.

• Trunk ports are connected to the correct ADD ports. 

Note The Raman Wizard does not verify if the selected TXP connections are properly connected. The 
calibration process is terminated if a LOS-P alarm is detected on the MUX input port when the trunk 
port is turned on.

Note If you do not use the MUX/DMUX Present check box, ensure that the following prerequisites are 
completed:

• Connect a UT2-based trunk port (from a transponder/muxponder card) to the COM-RX port of the 
booster amplifier connected to the OPT-RAMP-C or OPT-RAMP-CE card on the source node.

A full-spectrum, tunable interface allows the system to tune the signal on two required wavelengths 
without any human intervention.

• A 10-dB bulk attenuator must be connected between the TXP trunk port and the COM-RX port of 
the booster amplifier.

Caution Make sure that the bulk attenuator is removed as soon as installation finishes and the correct fiber is 
reconnected to the COM-RX port of the booster amplifier.

Step 7 Perform any one of the following steps, based on your selection in Step 6.

a. Select the two transponders on the source node from the Slot drop-down list. The installation wizard 
tunes the transponders to the required wavelengths. (Figure 16-6).
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Figure 16-6 Bidirectional Path Is Unchecked and MUX/DMUX Present Is Checked

b. Select one transponder on the source node from the Slot drop-down list. The installation wizard 
verifies if the transponder can tune on the first tunable wavelength. Make sure that the card used is 
a tunable C-band transponder and set the transponder to the “first tunable wavelength”. Otherwise, 
the wizard fails and the installation must be repeated using a correctly configured tunable 
transponder (Figure 16-7).

Note The wizard uses a pre-installed UT-2 based transponder.
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Figure 16-7 Bidirectional Path Is Unchecked and MUX/DMUX Present Is Unchecked

c. Select the two transponders on the source and destination nodes from the Slot drop-down list. The 
installation wizard verifies if the transponders are tuned to the expected wavelengths or on the first 
tunable wavelength. Otherwise, the wizard fails and the installation must be repeated (Figure 16-8).
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Figure 16-8 Bidirectional Path Is Checked and MUX/DMUX Present Is Checked

d. Select a transponder on the source and destination nodes from the Slot drop-down list. The 
installation wizard verifies if the transponder can be tuned on the first tunable wavelength. Make 
sure that the transponder is a tunable C-band transponder. Otherwise, the wizard fails and the 
installation must be repeated (Figure 16-9).
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Figure 16-9 Bidirectional Path Is Checked and MUX/DMUX Present Is Unchecked

Step 8 Click Next. The Calibrate Raman Page is displayed (Figure 16-10).
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Figure 16-10 Calibrating Raman Amplification

The installation wizard changes the trunk port to the In-Service (IS) state and turns on all the amplifiers. 
All the OTS and optical channel (OCH) ports in the span are changed to IS state.

Step 9 As soon as the Raman calibrations are complete, the Next button is enabled. Click Next.
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Figure 16-11 Calibrating Raman Amplification

Step 10 The power received on the destination node when wavelength on the source is turned on is shown. If you 
installed Raman amplification on multiple spans, click Next to view results of other spans.

Step 11 If the installation wizard fails, click the Repeat button. The Raman installation wizard recalibrates the 
values on the destination node.

Note If you have repeated the calibration several times and the wizard fails, press Cancel to abort the 
installation process. Log in to the Cisco Technical Support Website at 
http://www.cisco.com/cisco/web/support/index.html for more information or call Cisco Technical 
Support at (800) 553-2447.

Step 12 Click Next. The Accept Results page is displayed (Figure 16-12).
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Figure 16-12 Raman Amplification Results

The calculated Raman power and Raman gain are displayed. (Figure 16-12.)

Step 13 The wizard compares the calculated Raman gain value with the expected results. Your action depends 
on the Raman gain values:

• Expected gain (Gt) – 0.5 dB <= (gain) <= (expected gain) + 0.5 dB—If the Raman gain is within 
this range, it means that the setup procedure was successful. Go to Step 14.

• (Expected gain) - 3.0 dB <= (gain) <= (expected gain) – 0.5 dB—If the Raman gain is within this 
range, it means that the values are slightly outside the range. The wizard recommends that you verify 
the span length and cabling, and repeat the installation wizard procedure. If the Raman gain values 
are still not within the expected value range even after repeating the installation process, you can 
choose to forcibly apply these values by clicking Force Calibration. 

Note After you have forced the new calibration, the new value of the Raman gain is applied to the 
OPT-RAMP-C or OPT-RAMP-CE card as the set point; However, the new value does not update 
the value of the ANS set point for Raman gain. After the installation is complete, reanalyze the 
network in Cisco Transport Planner using this new value for the Raman gain set point and verify 
that it results in a good network design. After the CTP analysis is successful, import the updated 
CTP XML file again into CTC by completing the “NTP-G143 Import the Cisco Transport 
Planner NE Update Configuration File” procedure on page 14-48. Launch, run, and apply the 
ANS parameters by completing “NTP-G37 Run Automatic Node Setup” procedure on 
page 14-126. This resolves the discrepancy between the values of the ANS parameters and the 
card parameters. 
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However, we recommend that you log in to the Cisco Technical Support Website at 
http://www.cisco.com/cisco/web/support/index.html for more information if the Raman gain values are 
still not within the expected value range or call Cisco Technical Support at (800) 553-2447.

• (gain) < (expected gain) – 3.0 dB or if (gain) < (expected gain) + 0.5 dB—If the Raman gain is within 
this range and the values calculated are far from the targeted results, the installation fails and the 
wizard recommends repeating the installation. If the results do not improve, it means that the 
installation process has failed. The Force Calibration option is not available. Click Cancel to abort 
the installation and log in to the Cisco Technical Support Website at 
http://www.cisco.com/cisco/web/support/index.html for more information or call Cisco Technical 
Support at (800) 553-2447.

Note The reason that the calculated values are not within the range may be due to installation issues 
(for example, the actual fiber type is different than the one used by Cisco Transport Planner to 
design the link) or procedural issues.

Step 14 Click Exports Data to export the Raman setup tuning data in text format (Figure 16-13).

Step 15 Click Finish.

Note When an error occurs during calibration of multiple spans, the calibration process stops and the Force 
Calibration button becomes visible.

Note If an error occurs during calibration of multiple spans when using the AutoRun wizard, the calibration 
stops and the Force Calibration button becomes visible. Click Force Calibration to force the results.
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Figure 16-13 Exporting Raman Tuning Data

Step 16 Return to your originating procedure (NTP).

DLP-G690 Configure the Raman Pump Using Manual Day-0 Installation

Purpose This task tunes the RAMAN-CTP and RAMAN-COP cards manually 
during day-0 installation.

Tools/Equipment • An optical spectrum analyzer (OSA) must be available at both the local 
and remote nodes.

• A 15 dB bulk attenuator

Prerequisite Procedures •  DLP-G46 Log into CTC

• Create an optical service channel (OSC) termination link by 
completing the “NTP-G38 Provision OSC Terminations” procedure on 
page 14-124 or create optical transport section (OTS) provisionable 
patchcord terminations on line ports by completing “NTP-G184 
Create a Provisionable Patchcord” procedure on page 17-77, as 
required. The ONS-SC-OSC-18.0= SFP is supported.

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note Perform the tuning procedure on one fiber at a time. Tune the RAMAN-COP module on the remote node 
followed by RAMAN-CTP of the local node.

Note The RAMAN-COP card needs RAMAN-CTP card to operate.

Note If a 40-SMR1-C or 40-SMR2-C card is connected to the COM port of the RAMAN-CTP card, the 
ADD-RX port of the 40-SMR1-C or 40-SMR2-C card must be set to the OOS,MT (ANSI) or locked, 
maintenance (ETSI) state to enable the probe signals. Change the administrative state of the ADD-RX 
port to IS,AINS (ANSI) or unlocked,automaticInService (ETSI) after the tuning procedure is complete. 
See the “DLP-G532 Change Optical Line Settings for 40-SMR1-C and 40-SMR2-C Cards” task on 
page 21-95.

Note If an OPT-EDFA-17, OPT-EDFA-24, OPT-AMP-C, or OPT-BST-E amplifier is used as a line amplifier 
during the tuning procedure, the COM-RX port of the amplifier must be set to the OOS,MT (ANSI) or 
locked, maintenance (ETSI) state. Change the administrative state of the COM-RX port to IS,AINS 
(ANSI) or unlocked,automaticInService (ETSI) after the tuning procedure is complete.

Step 1 To tune the RAMAN-COP card on the remote node, complete Steps 3 through 14. 

Step 2 To tune the RAMAN-CTP card on the local node, complete Steps 14 through 22.

Step 3 On the local node, perform the following steps:

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the 
RAMAN-CTP card.

b. Click the Maintenance > ALS tabs. 

c. Choose On from the OSRI drop-down list for the RAMAN-TX port.

d. Click Apply and then click Yes. This forces both the Raman pumps of the RAMAN-CTP card to 
shut down.

Note The DFB signal is not affected by the Raman noise because the Raman pumps of the 
RAMAN-CTP card are shut down. The Optical Signal to Noise Ratio (OSNR) value remains 
above the failure threshold during the RAMAN-COP card tuning procedure, when the Raman 
ratio is forced to 100%.

e. Connect the OSA to the COM-TX port of the RAMAN-CTP card using physical patch cords. 

f. Set the OSA Resolution Bandwidth (RBW) to 0.2 nm and the OSA Video Bandwidth (RBV) to 
100 Hz.

Step 4 On the remote node, perform the following steps:

a. Connect a tunable C-band transponder or muxponder to the COM-RX port of the line amplifier that 
is connected to the COM-RX port of the RAMAN-CTP card.

b. Connect a 15 dB bulk attenuator between the TXP trunk port and the COM-RX port of the line 
amplifier so that the input power of the line amplifier does not exceed -7 dBm.
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c. In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP or MXP 
card.

d. Click the Provisioning > Line > Wavelength Trunk Settings tabs.

e. Select the wavelength as 1530.33 nm for odd band or 1530.73 nm for even band from the wavelength 
field.

f. Click Apply to save the changes.

g. Click the Provisioning > Line > SONET tabs.

h. Choose the IS option from the Admin State drop-down field and click Apply.

i. Click the Maintenance > ALS tabs, and set the ALS mode to Disable. This enables the line 
amplifier or the 40-SMR1-C or 40-SMR2-C card to detect a valid input power on the COM-RX or 
ADD-RX port respectively. The line amplifier starts up in control power mode and reaches the per 
channel power set point. A valid signal flows from the node into the fiber.

Step 5 On the remote node, perform the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf view), double-click the RAMAN-COP 
card.

b. Click Maintenance > Manual Setup tabs.

c. Select the High Power First Lambda option. 

d. Click the Pump On button. The High Power First Lambda field becomes editable. 

Note The Raman pumps at 1428 nm on the RAMAN-COP card are automatically set to a high power 
level of 450 mW.

Step 6 On the local node, record the peak optical power level at 1530.33 nm manually. The OSA detects a single 
channel at 1530.33 nm.

Step 7 On the remote node, perform the following

a. Enter the peak optical power value recorded in Step 6 in the High Power First Lambda field.

b. Select the Low Power First Lambda option.

c. Click the Pump On button. The Low Power First Lambda field becomes editable.

Note The Raman pumps at 1428 nm on the RAMAN-COP card are automatically set to a low power 
level of 200 mW.

Step 8 On the local node, record the peak optical power level at 1530.33 nm manually. The OSA detects a single 
channel at 1530.33 nm. The peak optical power level has reduced significantly.

Step 9 On the remote node, enter the peak optical power value recorded in Step 8 in the Low Power First 
Lambda field.

Step 10 Switch off the transponder or muxponder card on the remote node and select the last lambda values using 
the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP or MXP 
card.

b. Click the Provisioning > Line > SONET tabs. 

c. Choose the OOS,DSBLD option from the Admin State drop-down field and click Apply.
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d. Click the Provisioning > Line > Wavelength Trunk Settings tabs.

e. Select 1560.61 nm for odd band or 1561.1 nm for even band wavelength from the wavelength field 
and then click Apply.

f. Click Provisioning > Line > SONET tabs.

g. Choose the IS option from the Admin State drop-down field and click Apply.

Step 11 Repeat Steps 5 through 10 to edit the High Power Last Lambda and Low Power Last Lambda settings.

Step 12 On the remote node, click Tune to calculate the power, ratio, and actual gain on the RAMAN-COP card. 
The results are displayed in the result panel in the Manual Setup > Maintenance tab.

• Power—Displays the optimum total pump power value provisioned on the RAMAN-COP card to 
reach the target Raman installation gain.

• Ratio—Displays the optimum pumps ratio value provisioned on the card to reach the target Raman 
gain.

Note The newly calculated set points for the power and ratio can be viewed in the Maintenance > 
Installation Report tab in the RAMAN-COP card view after the successful execution of Raman 
tuning procedure. The newly provisioned values overwrite the values for the power and ratio 
ANS parameters and the Origin field displays the value, “AUTOMATIC” in the Provisioning > 
WDM-ANS > Provisioning tab.

• Actual Gain—Displays the current Raman gain calculated using the power and ratio values. If the 
calculated gain is less than the Raman installation gain setpoint, a warning message is displayed, 
prompting the user to accept the reduced calculated gain.

Step 13 Click the Force button to force the new gain setpoint. 

Step 14 On the local node, perform the following:

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the 
RAMAN-CTP card.

b. Click the Maintenance > ALS tabs. 

c. Choose Off from the OSRI drop-down list for the RAMAN-TX port. 

d. Click Apply and then click Yes.

Step 15 On the local node, perform the following steps:

a. Connect the OSA to the COM-TX port of the RAMAN-CTP card using physical patchcords. 

b. Set the OSA Resolution Bandwidth (RBW) to 0.2 nm and the OSA Video Bandwidth (RBV) to 
100 Hz.

Step 16 On the remote node, perform the following steps:

a. Connect a tunable C-band transponder or muxponder to the COM-RX port of the line amplifier that 
is connected to the COM-RX port of the RAMAN-CTP card.

b. Connect a 15 dB bulk attenuator between the TXP trunk port and the COM-RX port of the line 
amplifier so that the input power of the line amplifier does not exceed -7 dBm.

c. In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP or MXP 
card.

d. Click the Provisioning > Line > Wavelength Trunk Settings tabs.

e. Select the wavelength as 1530.33 nm for odd bands or 1530.73 nm for even bands from the 
wavelength field.
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f. Click Apply to save the changes.

g. Click the Provisioning > Line > SONET tabs.

h. Choose the IS option from the Admin State drop-down field and click Apply.

i. Click the Maintenance > ALS tabs and set the ALS mode to Disable. This enables the line amplifier 
to detect a valid input power on the COM-RX port. The line amplifier starts up in control power 
mode and reaches the per channel power setpoint. A valid signal flows from the node into the fiber.

Step 17 On the local node, perform the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf view), double-click the RAMAN-CTP 
card.

b. Click the Maintenance > Manual Start tabs.

c. Select the High Power First Lambda option. Raman pump P1 is activated. 

d. Click the Pump On button. The High Power First Lambda field becomes editable. 

Note The Raman pumps at 1428 nm on the RAMAN-CTP card are automatically set to a high power 
level of 450 mW.

e. Record the peak optical power level at 1530.33 nm manually. The OSA detects a single channel at 
1530.33 nm.

f. Enter the peak optical power value recorded in Step 17e in the High Power First Lambda field.

g. Select the Low Power First Lambda option.

h. Click the Pump On button. The Low Power First Lambda field becomes editable.

Note The Raman pumps at 1428 nm on the RAMAN-CTP card are automatically set to a high power 
level of 200 mW.

i. Record the peak optical power level at 1530.33 nm manually. The OSA detects a single channel at 
1530.33 nm. The peak optical power level has reduced significantly.

j. Enter the peak optical power value recorded in Step 17i in the Low Power First Lambda field.

Step 18 Switch off the transponder or muxponder card on the remote node and select the last lambda values using 
the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf view), double-click the TXP or MXP 
card.

b. Click the Provisioning > Line > SONET tabs. 

c. Choose the OOS,DSBLD option from the Admin State drop-down field and click Apply.

d. Click the Provisioning > Line > Wavelength Trunk Settings tabs.

e. Select the wavelength as 1560.61 nm for odd bands and 1561.1 nm for even bands from the 
wavelength field and click Apply.

f. Click the Provisioning > Line > SONET tabs.

g. Choose the IS option from the Admin State drop-down field and click Apply.

Step 19 Repeat Steps 17 and 18 to edit the High Power Last Lambda and Low Power Last Lambda settings. The 
Raman pump P2 is activated and the Raman ratio is 0%.
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Step 20 On the local node, click the Tune button to calculate the power, ratio, and actual gain on the 
RAMAN-CTP card. The results are displayed in the result panel in the Manual Setup > Maintenance tab.

• Power—Displays the calculated optimum total pump power value provisioned on the RAMAN-CTP 
card to reach the target Raman installation gain.

• Ratio—Displays the optimum pumps ratio value provisioned on the RAMAN-CTP card to reach the 
target Raman gain.

Note The newly calculated setpoints for the power and ratio can be viewed in the Maintenance > 
Installation Report tab in the RAMAN-CTP card view after the successful execution of Raman 
tuning procedure. The newly provisioned values overwrite the values for the power and ratio 
ANS parameters and the Origin field displays the value, “AUTOMATIC” in the Provisioning > 
WDM-ANS > Provisioning tab.

• Actual Gain—Displays the current Raman gain calculated using the power and ratio values. 
The calculated gain (G) is compared with the expected Raman gain setpoint (GSTP). Your actions 
depends on the value of the calculated gain:

– GSTP – 0.5 dB <= G <= GSTP + 0.5 dB—If the calculated gain is within this range, it means that 
the tuning procedure was successful.

– GSTP – 2 dB < G < GSTP—A warning message is displayed, prompting you to accept the reduced 
calculated gain. Go to Step 21.

– G < GSTP – 2 dB—A failure message is displayed. Go to Step 22.

Step 21 Click the Force button to force the new gain setpoint. 

Note After you have forced the new calibration, the new value of the Raman gain is applied to the 
RAMAN-CTP card as the set point. The newly provisioned gain setpoint can be viewed in the 
Maintenance > Installation Report tab in the RAMAN-CTP card view. However, the newly 
provisioned gain setpoint does not automatically change the values of the Value and Origin fields 
of the ANS gain setpoint in the Provisioning > WDM-ANS > Provisioning tab. After the 
installation is complete, reanalyze the network in Cisco Transport Planner using the new value 
for the Raman gain set point and verify that it results in a good network design. After the CTP 
analysis is successful, import the updated CTP XML file again into CTC by completing the 
“NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” procedure on 
page 14-48. Launch, run, and apply the ANS parameters by completing “NTP-G37 Run 
Automatic Node Setup” procedure on page 14-126. This resolves the discrepancy between the 
values of the ANS parameters and the card parameters.

Step 22 Repeat the Steps 14 through 21 again after cleaning the fibers and checking the node connections.

Note The status field in the Maintenance > Installation Report tab displays the value, “Raman tuned by 
WIZARD” after the tuning procedure is complete.

Step 23 Repeat Steps 1 and 2 to complete the tuning procedure in the opposite fiber.

Step 24 Return to your originating procedure (NTP).
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DLP-G474 Configure the Raman Pump by Importing the CTP XML File

Step 1 Install the ANS parameters calculated using Cisco Transport Planner, by completing the “NTP-G143 
Import the Cisco Transport Planner NE Update Configuration File” procedure on page 14-48.

Step 2 Launch, run, and apply ANS parameters by completing “NTP-G37 Run Automatic Node Setup” 
procedure on page 14-126.

Step 3 Verify if the Raman pump was configured successfully. Perform the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C 
or OPT-RAMP-CE amplifier to display the card view.

b. Click the Maintenance > Installation tabs.

c. Verify the value of the Raman Ratio and Raman Total Power parameters are consistent with the ANS 
set points.

d. Verify if the status of the Raman configuration displays the value as “Tuned by ANS”. If not, go to 
Step 1 to repeat the procedure again.

Step 4 Return to your originating procedure (NTP).

DLP-G489 Configure the Raman Pump by Setting the ANS Parameters Manually

Note This procedure can be performed only on a per span basis and not on multiple spans. To configure 
multiple spans, repeat this procedure on each span that you want to configure.

Step 1 Provision the ANS parameters manually, by completing the “DLP-G541 Add an ANS Parameter” task 
on page 14-61. The ANS parameters are:

• (Slot i.OPT-RAMP-CE).Port RAMAN-TX.Amplifier Gain

Purpose This procedure configures the Raman pump by importing the Cisco 
Transport Planner XML file.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure configures the Raman pump by setting the ANS parameters 
manually.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed, when the wizard fails and expert intervention is required.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• (Slot i.OPT-RAMP-CE).Port RAMAN-TX.Raman Ratio

• (Slot i.OPT-RAMP-CE).Port RAMAN-TX.Raman Total Power

ANS parameters are displayed in the Provisioning > WDM-ANS > Provisioning tab. For more 
information, see Chapter 12, “Node Reference.”

Step 2 Launch, run, and apply ANS parameters by completing “NTP-G37 Run Automatic Node Setup” 
procedure on page 14-126.

Step 3 Verify if the Raman pump was configured successfully. Perform the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C 
or OPT-RAMP-CE amplifier to display the card view.

b. Click the Maintenance > Installation tabs.

c. Verify the values of the Raman Ratio and Total Pump Power parameters are consistent with the ANS 
set points.

d. Verify the status of the Raman configuration displays the value, “Tuned by ANS”. If not, go to Step 1 
to repeat the procedure again.

Step 4 Return to your originating procedure (NTP).

DLP-490 Restore Raman Link After a Fiber Cut Occurs

Note This procedure does not calculate the Raman pump ratio. The Raman pump ratio is not expected to 
change after the fiber cut is repaired.

Caution This procedure affects traffic. Ensure that nobody is working on the nodes before you begin.

Step 1 Complete the “NTP-G54 Provision and Verify a DWDM Network” procedure on page 16-28.

Ensure that the network traffic is restored.

Step 2 Verify if the restore procedure was successful. Perform the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C 
or OPT-RAMP-CE amplifier to display the card view.

b. Click the Maintenance > Installation tabs.

c. Verify the value of the Fiber Cut Recovery column. The possible values are:

• Executed— The restore procedure was completed successfully.

Purpose This procedure tunes Raman set points after a fiber cut has been repaired. 
The Raman total power value is calculated again, and the original Raman 
gain is restored.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed. 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Pending—The restore procedure is incomplete.

• Failed —The system failed to execute the procedure.

d. If the status is Pending or Failed in Step 2c., perform the following steps:

• Click the Maintenance > APC & Restore tabs.

• Click Restore from Fiber Cut. This recalculates the Raman gain on the span and verifies if this 
value is consistent with the ANS set point for Raman gain.

Step 3 Return to your originating procedure (NTP).

DLP-G350 Use the Cisco Transport Planner Traffic Matrix Report

Step 1 Display a printed copy of the Cisco Transport Planner Traffic Matrix report for your network. The report 
can be exported in Microsoft Excel (.xls) or HTML format.

Step 2 View the following information:

• Service Demand—Lists the general service demand from site to site.

• Service Circuit—Lists the service circuit.

• OCH-CC Src—Lists the optical channel client connection (OCHCC) source site and the shelf 
direction, either Side B or Side A. 

• OCH-CC Src Position—Lists the OCHCC source rack, shelf, and slot.

• OCH-CC Src Unit—Lists the OCHCC source TXP, MXP, or ITU-T line card.

• OCH-CC Src Port—Lists the OCHCC source port.

• A/D Src Position—Lists the optical channel add/drop card source rack, shelf, and slot.

• A/D Src Unit—Lists the optical channel add/drop card source TXP, MXP, or ITU-T line card.

• A/D Src Port—Lists the optical channel add/drop card source port.

• OCH-CC Dst—Lists the OCHCC destination site and shelf direction, either Side B or Side A. 

• OCH-CC Dst Position—Lists the OCHCC destination rack, shelf, and slot.

• OCH-CC Dst Unit—Lists the OCHCC destination TXP, MXP, or ITU-T line card.

• OCH-CC Dst Port—Lists the OCHCC destination port.

• A/D Dst Position—Lists the optical channel add/drop card destination rack, shelf, and slot

• A/D Dst Unit—Lists the optical channel add/drop card destination TXP, MXP, or ITU-T line card.

• A/D Dst Port—Lists the optical channel add/drop card destination port.

Purpose This task describes how to use the Cisco Transport Planner traffic matrix 
report to provision and verify a DWDM network.

Tools/Equipment None

Prerequisite Procedures NTP-G139 Verify Cisco Transport Planner Reports and Files, page 14-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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– Dest Unit is the product ID of the optical path source card.

– Dest Port is the port label reported on the front panel of the optical path destination card.

• Cl Service Type—Identifies the service type of the optical channel.

• Protection—Identifies the type of protection used for the optical channel:

– Optical paths for unprotected-Side B and unprotected-Side A optical channels are routed along 
one direction only in the network.

– Optical paths for Y-cable, fiber-switched, and client 1+1 optical channels are routed along two 
independent directions in the network.

• Op Bypass Site Name—Identifies where the optical channel is dropped and reinserted when it is not 
terminated on a TXP or MXP card (optical bypass).

Note If the word None appears in the Op Bypass Site Name column, no optical bypass is defined 
for the optical channel.

• Wavelength—Identifies the wavelength used for the optical channel. Table 17-6 on page 17-20 lists 
the thirty-two available wavelengths.

• DWDM Interface Type—Identifies the DWDM interface type that is used for the optical channel:

– Transponder indicates that a transponder (TXP), muxponder (MXP), or DWDM pluggable port 
module is used for the optical channel.

– Line Card indicates that an ITU line card is used for the optical channel.

• DWDM Card Type—Identifies the type of TXP or line card that is used for the optical channel. For 
information about card types supported by Cisco Transport Planner, see Cisco Transport Planner 
DWDM Operations Guide.

Step 3 Return to your originating procedure (NTP).

NTP-G54 Provision and Verify a DWDM Network

Purpose This procedure describes how to turn-up an optical service in MSTP 
networks. It also provides a guidance to perform an entry-level optical 
performances verification of an optical circuit 
(OCH-NC/OCH-CC/OCHTrail) created on the MSTP networks.

Tools/Equipment Test set or protocol analyzer

Cisco Transport Planner Traffic Matrix

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards.

Provisioning procedures of these cards are provided in Chapter 11, 
“Provision Transponder and Muxponder Cards”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note In this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Step 1 Complete the DLP-G46 Log into CTC task to log in to an ONS 15454 node on the network.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the DLP-G128 Disable Alarm Filtering task, as 
necessary.

b. Verify that no equipment (EQPT) alarms appear. If equipment failure alarms appear, investigate and 
resolve them before continuing. Refer to Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Step 3 Using the Cisco Transport Planner Traffic Matrix (see Table 14-1 on page 14-4) for your site, identify 
the first channel (ITU wavelength) to be provisioned. Use the TXP, MXP, or line card that corresponds 
to the selected wavelength.

Step 4 For the ITU wavelength identified in Step 3, create an optical channel client connection (OCHCC) 
circuit or optical channel network connection (OCHNC) circuit, or optical channel trail circuit using one 
of the following tasks: 

• DLP-G346 Provision Optical Channel Client Connections, page 17-18.

• DLP-G105 Provision Optical Channel Network Connections, page 17-44.

• DLP-G395 Create an Optical Channel Trail, page 17-34.

.After creating the OCHCC or OCHNC circuit, return to this procedure and continue with Step 5.

Note Every time a channel is created in the DWDM network, the amplifiers automatically calculate 
the optical output power needed to maintain a constant power level on each channel when 
working in Gain Control. If the amplifier is working in power control, APC tool is used for 
amplifiers power level calculation and setting. Automatic power control (APC) runs when you 
create new circuits. APC also runs periodically (every 60 minutes) to check and monitor power 
levels in all the significant sections of the network. If the span length changes, APC modifies 
amplifier gains and modifies express variable optical attenuation (VOA). For more information 
about APC, see the Chapter 13, “Network Reference.”

Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab. Verify that 
the OCHCC or OCHNC created in Step 4 has a DISCOVERED status and an IS state. If so, continue 
with Step 6. If not, complete “NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits” task on 
page 17-68.

Step 6 Click the circuit and click Edit.

Step 7 In the Edit Circuit dialog box, click the State tab.

Step 8 In the Cross-Connections table, verify that the circuit path is correct and record all the nodes that appear 
in the Node column. The first node is the circuit source, and the last node is the circuit destination. If the 
circuit path is incorrect, delete the circuit and go back to Step 4 to create a new circuit.

Step 9 Perform the entry-level performance verification of the optical power levels matching with expected 
setpoints for the OCH-circuit identified in Step 8.

Optical verification is done for cards in the OCH-circuit. The verification must be done node by node, 
following the logical signal flow from source to destination node.
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Verify the power levels on the following:

a. Fixed or reconfigurable add/drop cards.

b. Amplifiers, including the raman cards.

Note You need to verify the power setpoint for OPT-PSM cards in the path protection configuration.

Step 10 Display the circuit source node in node view (single-shelf mode), or shelf view (multishelf mode). 
Following the signal flow from the TXP, MXP, or line card Trunk ports, if an fixed or reconfigurable 
add/drop card is installed, complete the following steps. If not, continue with Step 11.

Note Use of Node Functional View to identify at a glance, the logical signal flow in complex nodes.

a. In node view (single-node mode) or multishelf view (multishelf mode) click the Provisioning > 
WDM-ANS > Provisioning tabs.

b. In the Selector area, select the first fixed or reconfigurable add/drop card to be checked. Identify the 
power parameter and record the corresponding port and active value from the parameter list.

c. Check the power setpoint on the ports displayed in the Port field in CTC. The add/drop cards must 
meet this output power setpoint per channel.

d. Display the selected fixed or reconfigurable add/drop module in card view:

e. Click the Provisioning tabs.

f. Locate the port selected in step b in the CTC menu.

Note The CTC displays the name according to the card installed.

g. Identify the row associated to the Port. Check the value reported in Power or Power To column in 
CTC.

– If the card value matches the VOA Power Ref. cell or the recorded Power value, with +/- 1 dB 
of tolerance, continue with Step 11. 

Note VOA Power Ref at card level must be equal to the Power Active Value recorded in step b. If not, 
go back to Node view and click the ANS button. Then repeat this procedure.

– If the value is out of tolerance range from the VOA Power Ref, contact your next level of 
support.

Step 11 Display the circuit source node in node view (single-shelf mode), or shelf view (multishelf mode). 
Following the signal flow, if an amplifier card is installed, complete the following steps.

Note Use of Node Functional View to identify the logical signal flow in complex nodes at a glance.

If not, continue with Step 12.

a. In node view (single-node mode) or multishelf view (multishelf mode) click the Provisioning > 
WDM-ANS > Provisioning tabs.
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b. In the Selector area, click the amplifier card to be checked. Identify the power parameter and record 
the corresponding port and active value from the parameter list.

c. Check the power setpoint on the ports displayed in the Port field in CTC. The add/drop cards must 
meet this output power setpoint per channel.

d. Display the selected amplifier in card view.

e. Click the Provisioning > Opt.Ampli.Line > Parameters tabs. Identify the row associated to the 
Port selected in step b. Check the signal output power value.

– If the value is equal to or greater (due to ASE accumulation) than the value shown in the 
Channel Power Ref cell, continue with Step 12. 

Note Channel Power Reference at card level must be equal to the Power Active Value noted in step b. 
If not, go back to Node view and click the ANS button. Then repeat this procedure.

– If the value is lower than the value shown in the Channel Power Reference cell, contact your 
next level of support.

Step 12 Go to the Edit Circuit dialog box and move to the next intermediate node in node view (single-shelf 
mode), or shelf view (multishelf mode). Following the signal flow, repeat Step 10 and Step 11 in order 
to check fixed or reconfigurable add/drop cards and amplifiers cards.
When all the intermediate nodes have been checked, move to Step 13 to verify the destination node.

Step 13 Display the Destination node in node view (single-shelf mode), or shelf view (multishelf mode). 
Following the signal flow, if an amplifier card is installed, complete the power levels check according 
with Step 11.

Complete the power level verification on the fixed or reconfigurable add/drop card that is dropping the 
signal using the following steps:

a. In node view (single-node mode) or multishelf view (multishelf mode) click the Provisioning > 
WDM-ANS > Provisioning tabs.

b. In the Selector area, click the last fixed or reconfigurable drop card to be checked. Identify the drop 
power parameter among the optical parameters and record the correspondent Port and Active Value.

c. Check the power setpoint on the ports displayed in the Port field in CTC. The cards must meet this 
Drop Power setpoint per channel.

d. Display the selected fixed or reconfigurable add/drop module in card view.

e. Click the Provisioning tabs. 

f. Locate the port selected in step b in the CTC menu.

Note The CTC displays the name according to the card installed.

g. Identify the row associated to the Port. Check the value reported in Power or Power To column in 
CTC.

– If the card value matches the VOA Power Ref. cell (when present) or the recorded Power Drop 
value, with +/- 2 dB of tolerance, continue with Step 14. 

Note VOA Power Ref at card level must be equal to the Power Drop Active Value recorded in step b. 
If not, go back to Node view and click the ANS button. Then repeat this procedure.
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– If the value is out of tolerance range from the VOA Power Ref, contact your next level of 
support.

Step 14 Check the received power range on TXP, MXP, or line cards:

a. Navigate to the node where the first TXP, MXP, or line card is installed.

b. Display the TXP, MXP, or line card in card view.

c. Complete the DLP-G136 Clear Selected PM Counts.

d. Click the Performance > Optics PM tabs. 

e. Record the values shown in the RX Optical Pwr field. 

f. Click the Provisioning > Optics Thresholds tabs. 

g. Verify that the value in Step e falls between the values shown for the RX Power High and 
RX Power Low. If so, continue with Step 15. If not, complete one of the following. 

– Power lower than range—Clean the trunk fiber at the patch panel and on the TXP or MXP card. 
Repeat Steps e through g. If the power is still too low, contact your next level of support.

– Power higher than range—Add attenuation to the fiber and repeat Steps e through g. If the power 
still does not fall within the range, contact your next level of support.

Step 15 Perform a short-term bit error rate (BER) test:

a. Complete the DLP-G136 Clear Selected PM Counts for the TXP, MXP, or line card.

b. Display the TXP, MXP, or line card in card view.

c. Click the Performance > Payload PM tabs, or, if OTN is provisioned, the Performance > OTN PM 
tabs. 

d. Perform a short-term BER test using a test signal from a test set or protocol analyzer.

e. Monitor the payload performance monitoring (PM) for at least 10 minutes for errors.

Note To see an accurate PM count, the BER test results must be consistent with the transmitted 
bit rate for at least 10 minutes.

Note For information about using a test set or protocol analyzer, see the test set or protocol 
analyzer user guide.

Step 16 Create a new OCHNC or OCHCC circuit for the next ITU wavelength listed in the Cisco Transport 
Planner Traffic Matrix and perform one of the following tasks: 

• If the new circuit optical path is not including nodes different from those the first circuits belongs 
to, perform only steps from Step 13 to Step 15.

• If the new circuit optical path includes new nodes, do the proper optical checks:

– Step 10 and Step 11 if the new node is the Source node

– Step 12 if the new nodes are intermediate nodes

– Step 13 if the new node is the destination node

Stop. You have completed this procedure.
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NTP-G56 Verify the OSNR

Step 1 Complete the DLP-G46 Log into CTC task at an ONS 15454 on the network.

Step 2 Using an optical spectrum analyzer, check the received OSNR for each transmitted channel on both ends 
of the span. Identify the last OSC-CSM, OPT-PRE, or OPT-BST MON port that the channel passes 
through before it is dropped. 

Note The OPT-PRE reference also applies to the OPT-AMP-17-C card operating in OPT-PRE mode 
and the OPT-BST reference also applies to the OPT-AMP-17-C card operating in OPT-LINE 
mode.

Step 3 If OPT-PRE cards are installed with an OPT-BST, OPT-BST-E, or OSC-CSM card, use the OPT-PRE 
MON port.

Note For OSNR values for each card class, see Chapter 4, “Optical Amplifier Cards.”

Step 4 If the OSNR is too low, check the following, depending on your node configuration:

Note The purpose of this step is not to improve the signal-to-noise ratio (SNR), but to match the 
per-channel power level within the RX port power range.

• Check the fiber connections between the OPT-BST, OPT-BST-E, or OSC-CSM card and the 
OPT-PRE amplifier. If needed, clean the connectors. See the NTP-G115 Clean Fiber Connectors 
procedure.

• On the near-end OPT-BST amplifier, check the equalization of the added channels at the monitor 
output.

• On the OPT-PRE amplifier, check the output power on both COM TX and DC TX ports.

• On the far-end OPT-PRE amplifier, check the amplifier gain tilt at the monitor output.

If the OSNR is still too low, contact your next level of support.

Step 5 Repeat Steps 2 and 4 for all traffic in the network.

Stop. You have completed this procedure.

Purpose This procedure verifies the optical signal-to-noise ratio (OSNR). The 
OSNR is the ratio between the signal power level and the noise power level.

Tools/Equipment Optical spectrum analyzer

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-G142 Perform a Protection Switch Test

Step 1 Complete the DLP-G46 Log into CTC task at an ONS 15454 on the network.

Step 2 Identify the Y-cable circuit to be tested by viewing the Traffic Matrix for your site. Locate the TXP, 
MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP cards in the ONS 15454 node that will 
be used for the protection group.

Step 3 Verify that the Y-cable protection group is provisioned:

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
Protection tabs.

b. In the Protect and Working areas, confirm that the correct TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, or OTU2_XP cards are in the Y-cable protection group by viewing the slot number and 
card type.

c. If the required protection group is not provisioned, stop and perform the “NTP-G33 Create a 
Y-Cable Protection Group” procedure on page 11-182. Otherwise, continue with Step 4.

Step 4 Repeat Step 3 for each Y-cable protection group at the node. When all protection groups are verified, 
continue with the next step.

Step 5 Physically connect the transmitter of the client or test set to either Port 10 or Port 12 of the Y-cable 
module protecting the test circuit. (See Table 14-7 on page 14-107 and Table 14-8 on page 14-107.)

Step 6 If you connected the transmitter to Port 10, connect the client or test set receiver to Port 5 on the Y-cable 
module. If not, connect the client or test set receiver to Port 11 on the Y-cable module.

Step 7 At the far-end site for the test circuit, physically loop the Y-cable module as follows:

a. If this is the first client on the Y-cable module, loop Port 10 to Port 5 on the far-end Y-cable module. 

b. If this is the second client on the Y-cable module, loop Ports 11 and 12 on the far-end Y-cable 
module.

Step 8 At the near-end site for the test circuit, place the client device or test set into service and begin 
transmitting the required payload.

Purpose This procedure tests the optical path, client TXP, MXP, GE_XP and 
GE_XPE (when provisioned in 10GE or 20GE MXP mode), 10GE_XP and 
10GE_XPE (when provisioned in 10GE TXP mode), and OTU2_XP (when 
provisioned in TXP mode) cards and the Y-cable protection groups in your 
network for proper operation. The test signals can be generated by either 
the actual client device or a test set (whichever is available). We 
recommend that you repeat this test at each node in the network where 
protection group traffic is dropped.

Tools/Equipment A list of protection groups. This information is provided in the 
Cisco Transport Planner Traffic Matrix.

A test set or actual client device that provides the required payload for the 
circuits that are provisioned.

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite; personnel are required to be on site at each end of the circuit under 
test.

Security Level Provisioning or higher
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Step 9 In CTC, display the near-end site in node view (single-node mode) or multishelf view (multishelf mode).

Step 10 Click the Maintenance > Protection tabs.

Step 11 In the Protection Groups area, highlight the protection group to be tested.

Step 12 In the Selected Group area, identify the active slot and the standby slot.

Step 13 Verify that the LED s on the physical cards in the shelf match the following:

a. For the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record the 
slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is green.

b. For the standby TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record 
the slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is not illuminated or amber, depending on the TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP card.

Step 14 In the Selected Group area, highlight the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, 
or OTU2_XP slot.

Step 15 From the Switch Commands area below the Selected Group area, click Manual, then click YES.

Step 16 From the Selected Group area, record the following information and verify that the active and standby 
TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP slot numbers are the opposite of 
Step 13.

a. For the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record the 
slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is green.

b. For the standby TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record 
the slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is not illuminated or amber, depending on the TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP card.

Step 17 Verify that the LEDs on the physical cards in the shelf match the following:

a. For the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP slot LEDs:

– DWDM port is green.

– Client port is green.

b. For the standby TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP slot LEDs:

– DWDM port is green.

– Client port is not illuminated.

Step 18 Confirm that the client or test set at the local site is operating normally without alarms. If the test set is 
reporting active alarms, contact your next level of support. 

Note It is normal to see a traffic hit on the test set during a protection switch.
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Step 19 From the Switch Commands area below the Selected Group area, click Clear, then click YES to return 
the protection group to the original state.

Step 20 Repeat Steps 5 through 19 for each protection group at your site.

Stop. You have completed this procedure.

NTP-G164 Configure Link Management Protocol 

Note This procedure is normally required only when the Cisco ONS 15454 must run traffic to and from a 
Calient PXC, a Cisco CRS-1 router, or a Cisco ASR 9000 router.

Note Cisco ONS Software Release 9.4 supports Cisco CRS-1 routers using Cisco IOS XR Software Release 
3.9.0 and Cisco ASR 9000 routers using Cisco IOS XR Software Release 4.1.0. If you have an earlier 
version of the Cisco IOS XR software, you cannot configure LMP on the Cisco CRS-1 or Cisco ASR 
9000 router, and the router will be visible as an unknown node in the CTC network view.

Step 1 Complete the DLP-G46 Log into CTC task to log in to the ONS 15454 on the network.

Step 2 To enable LMP, complete the “DLP-G372 Enable LMP” task on page 16-37.

Step 3 To set up one or more control channels, complete the “DLP-G373 Create, Edit, and Delete LMP Control 
Channels” task on page 16-37.

Step 4 To set up one or more traffic engineering (TE) links, complete the “DLP-G374 Create, Edit, and Delete 
LMP TE Links” task on page 16-40.

Step 5 To set up one or more data links, complete the “DLP-G378 Create, Edit, and Delete LMP Data Links” 
task on page 16-41.

Stop. You have completed this procedure.

Purpose This procedure configures Link Management Protocol (LMP). LMP 
manages the channels and links that are required between nodes for 
routing, signaling, and link management.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 16-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G372 Enable LMP

Step 1 In node view, click the Provisioning > Comm Channels > LMP > General tabs.

Step 2 In the Configuration area, click the Enable LMP check box to enable the LMP function.

Step 3 In the Local Node Id text entry box, enter the local node ID in the form of an IP address.

Note Do not set the LMP Local Node ID to another IP address in use on the network. This introduces 
a duplicate IP address in the network for traffic going to the IP address that is used as the LMP 
Local Node ID. We recommended to you set the LMP Local Node ID to the node's IP address, 
because this does not introduce a duplicate IP address in the network.

Step 4 If you are going to use LMP to manage a control channel between a Calient PXC node and a 
Cisco ONS 15454 DWDM node or between a Cisco CRS-1 or Cisco ASR 9000 router and 
Cisco ONS 15454 DWDM node, ensure that the LMP-WDM check box is unchecked.

Step 5 If you are going to use LMP to manage a control channel between the ONS 15454 nodes, check the 
LMP-WDM check box and use the Role field to choose one of the following roles:

• PEER, to use LMP to manage links between two nodes where the other node is configured as OLS. 

• OLS, to use LMP to manage links between two nodes where the other node is configured as PEER. 

The role selection is available only when LMP-WDM is enabled on the local node. Both the local and 
remote nodes must be configured with LMP-WDM enabled.

Step 6 Click Apply.

Step 7 In the Status area, verify that the Operational State is Up. This indicates that LMP is enabled and the link 
is active.

Step 8 Return to your originating procedure (NTP).

DLP-G373 Create, Edit, and Delete LMP Control Channels

Purpose This task enables the LMP function on the ONS 15454 node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates, edits, or deletes one or more LMP control channels 
between pairs of Cisco ONS 15454 nodes, between a Calient PXC and a 
Cisco ONS 15454, or between a Cisco CRS-1 or Cisco ASR 9000 router 
and a Cisco ONS 15454 node.

Tools/Equipment None

Prerequisite Procedures DLP-G372 Enable LMP, page 16-37
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Step 1 In node view, click the Provisioning > Comm Channels > LMP > Control Channels tabs.

Step 2 To create a control channel, click Create. The Create LMP Control Channel dialog box appears.

Note The values of the Admin State, Requested Hello Interval, Min Hello Interval, Max Hello 
Interval, Requested Hello Dead Interval, Min Hello Dead Interval, and Max Hello Dead Interval 
fields correspond to the values specified for these fields in the NODE > lmp section of the node 
view Provisioning > Defaults tabs. If you change the NODE > lmp values, those values are 
reflected as defaults in the Create LMP Control Channel dialog box. You can change the default 
values using the dialog box. However, the NODE > lmp values are always used as the initial 
defaults.

Step 3 In the Create LMP Control Channel dialog box, complete the following:

• Admin State—Select unlocked (if you are using an ETSI shelf) or IS (if you are using an ANSI 
shelf) to establish the control channel; otherwise, select locked, disabled (ETSI) or OOS-DSBLD 
(ANSI) to set the control channel to out of service.

• Local Port—Select Routed if the control channel is to be sent over the control plane or management 
network; otherwise, if the control channel is to be sent over the same fiber as the traffic (either in 
the payload or in the overhead), select one of the available traffic ports.

• Local Port Id—(Display only) Displays the local port identifier assigned by the node.

• Remote Node Type—Select 15454 or non-CRS1 if you are creating a control channel between two 
Cisco ONS 15454 nodes or between a Calient PXC and a Cisco ONS 15454 node; select CRS-1 if 
you are creating a control channel between a Cisco CRS-1 router and a Cisco ONS 15454 node; 
otherwise, select ASR9K if you are creating a control channel between a Cisco ASR 9000 router 
and a Cisco ONS 15454 node.

• Remote Node Address—In dotted-decimal format, enter the number that identifies the IP address of 
the remote node (either a Calient PXC peer node, a Cisco CRS-1 router, Cisco ASR 9000 router, or 
a Cisco ONS 15454 node) where the control channel will be established.

• Remote Node ID—Initially, CTC autopopulates this value to the remote node IP address that you 
just assigned. However, you can change the identifier to any nonzero 32-bit integer in dotted decimal 
format (for example, 10.92.29.10).

• Requested Hello Interval—Enter the Requested Hello Interval in milliseconds (ms). Before sending 
Hello messages, the Hello Interval and Hello Dead Interval parameters must be established by the 
local and remote nodes. These parameters are exchanged in the Config message. The Hello Interval 
indicates how frequently LMP Hello messages will be sent; the interval must be in the 300 ms to 
5000 ms range. The Min Hello Interval must be less than or equal to the Requested Hello Interval, 
and the Requested Hello Interval must be less than or equal to the Max Hello Interval.

• Min Hello Interval—Enter the minimum Hello Interval in milliseconds. When the two nodes 
negotiate for the Hello Interval, the value that you enter here will be the minimum Hello Interval 
acceptable for the local node. The Min Hello Interval must be in the 300 ms to 5000 ms range. The 
Min Hello Interval must be less than or equal to the Requested Hello Interval and the Requested 
Hello Interval must be less than or equal to the Max Hello Interval.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Max Hello Interval—Enter the maximum Hello Interval in milliseconds. When the two nodes 
negotiate for the Hello Interval, the value that you enter here will be the maximum Hello Interval 
acceptable for the local node. The Max Hello Interval must be in the 300 ms to 5000 ms range. The 
Min Hello Interval must be less than or equal to the Requested Hello Interval and the Requested 
Hello Interval must be less than or equal to the Max Hello Interval.

• Requested Hello Dead Interval—Enter the Requested Hello Dead Interval in milliseconds. The 
Requested Hello Dead Interval indicates how long a device should wait to receive a Hello message 
before declaring a control channel dead. The Requested Hello Dead interval must be in the 2000 ms 
to 20000 ms range. The Min Hello Dead Interval must be less than or equal to the Requested Hello 
Dead Interval and the Requested Hello Dead Interval must be less than or equal to the Max Hello 
Dead Interval.

Note The Requested Hello Dead Interval must be at least three times greater than the Requested 
Hello Interval.

• Min Hello Dead Interval—Enter the minimum Hello Dead Interval in milliseconds. The minimum 
Hello Dead Interval must be in the 2000 ms to 20000 ms range. The minimum Hello Dead Interval 
must be less than or equal to the Requested Hello Dead Interval and the Requested Hello Dead 
Interval must be less than or equal to the Max Hello Dead Interval. When the two nodes negotiate 
for the Hello Dead Interval, the value that you enter here will be the minimum Hello Dead Interval 
acceptable for the local node. 

Note The value of the Min Hello Dead Interval must be greater than the Min Hello Interval.

• Max Hello Dead Interval—Enter the maximum Hello Dead Interval in milliseconds. This interval 
must be in the 2000 ms to 20000 ms range. The Min Hello Dead Interval must be less than or equal 
to the Requested Hello Dead Interval and the Requested Hello Dead Interval must be less than or 
equal to the Max Hello Dead Interval. When the two nodes negotiate for the Hello Dead Interval, 
the value that you enter here will be the maximum Hello Dead Interval acceptable for the local node. 

Note The Max Hello Dead Interval must be greater than the Max Hello Interval.

Step 4 Click OK to accept the parameters that you have entered, or click Cancel to return to the Control 
Channels tab without creating a control channel.

Step 5 If you have chosen the Remote Node Type as CRS-1 or ASR9K in Step 3 and if you have chosen that 
automatic LMP configuration in the “DLP-G508 Configure the Cisco CRS-1, Cisco ASR 9000 Series, 
or Cisco 7600 Series Router Parameters” task on page 16-46, a confirmation dialog box is displayed to 
indicate that this operation will also change the configuration of the Cisco CRS-1 or Cisco ASR 9000 
router. Click Yes.

Step 6 If you created a control channel, verify that the parameters for the new Control Channel appear properly 
in the Control Channels tab.

Note The Actual Hello Interval and Actual Hello Dead Interval parameters reflect the values of these 
parameters as a result of the negotiated agreement of the local and remote nodes. They may be 
different than the requested values.
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Step 7 After the LMP control channel has been created, observe the status of the channel in the Operational 
State column of the Control Channels tab, and take the appropriate action as shown in the following list:

• Up—The control channel contacted the far-end node and successfully negotiated a control channel.

• Down—LMP is enabled and the link is inactive. Ensure that the Admin State of the control channel 
is unlocked (ETSI) or IS (ANSI) and not disabled (ETSI) or OOS-DSBLD (ANSI). If the state still 
does not transition to Up, the far-end control channel might have disjointed Hello negotiation times 
that prevent a control channel from transitioning to the Up state. For example, the local ONS 15454 
Min Hello Interval and Max Hello Interval might be 900 to 1000, while the remote Min Hello 
Interval and Max Hello Interval is 1100 to 1200.

• Config Send—The connection could not be made to the remote node. Check to make sure that the 
remote node address and remote node ID addresses are correct.

• Config Received—The local node sent a configuration request to the remote node and received a 
response of either ConfigNack or ConfigAck.

• Unknown

Step 8 To delete a control channel, click the channel row to highlight it and click Delete. A confirmation dialog 
box appears that allows you to click OK or Cancel.

Step 9 To edit a control channel, click the channel row to highlight it and click Edit. A dialog box appears that 
allows you to change the control channel parameters. You can then click OK or Cancel. If you are 
editing a control channel that involves a Cisco CRS-1 or Cisco ASR 9000 router, a confirmation dialog 
box is displayed. Click Yes.

Step 10 Return to your originating procedure (NTP).

DLP-G374 Create, Edit, and Delete LMP TE Links

Step 1 In node view, click the Provisioning > Comm Channels > LMP > TE Links tabs.

Step 2 To create a TE link, click Create. The Create LMP TE Link dialog box appears.

Step 3 In the Create LMP TE Link dialog box, complete the following:

• Admin State—Select unlocked (for ETSI shelves) or IS (for ANSI shelves) to put the TE link in 
service; otherwise, select locked, disabled (ETSI) or OOS-DSBLD (ANSI) to set the TE link to out 
of service.

• Remote Node Id—Select a remote node (either a Calient PXC peer node, a Cisco CRS-1 router, a 
Cisco ASR 9000 router, or a Cisco ONS 15454 node) for the other end of the TE link.

Purpose This task creates, edits, or deletes TE links and their association to 
neighboring LMP nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G372 Enable LMP, page 16-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
16-40
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 16      Turn Up a Network
DLP-  G378 Create, Edit, and Delete LMP Data Links
• Remote TE Link Id—Enter an unsigned 32-bit value (such as 0x00000001) to identify the remote 
node identifier for the other end of the TE link. This option is not available if you have chosen the 
automatic LMP configuration in “DLP-G508 Configure the Cisco CRS-1, Cisco ASR 9000 Series, 
or Cisco 7600 Series Router Parameters” task on page 16-46.

• MUX Capability—Select the MUX capability. This option is not available if you are creating a TE 
link that involves a Cisco CRS-1 or Cisco ASR 9000 router.

Step 4 Click OK to accept the parameters that you have entered and create the TE link, or click Cancel to return 
to the Control Channels tab without creating a TE link.

Step 5 If you created a TE link, verify that the parameters for the new TE link now appear properly in the TE 
Links tab.

Step 6 After the TE link has been created, observe the status of the TE link in the Operational State column of 
the TE Links pane, and take the appropriate action as shown in the following list:

• Up—The TE link is active.

• Down—Ensure that the Admin State of the TE link is unlocked (ETSI) or IS (ANSI) and not 
disabled (ETSI) or OOS-DSBLD (ANSI). The TE link does not transition to the Up state until a data 
link has been provisioned.

• Init—Verify that the Remote Node ID and Remote TE Link ID values are correct for the remote 
node. Verify that the remote node is using the Cisco ONS 15454 or the Cisco CRS-1 or Cisco ASR 
9000 router IP address for its remote node IP and that the remote node is using the local TE link 
index for its remote TE link index.

Step 7 To delete a TE link, click the link row to highlight it and click Delete. A confirmation dialog box appears 
that allows you to click OK or Cancel.

Step 8 To edit a TE link, click the link row to highlight it and click Edit. A dialog box appears that allows you 
to change the TE link parameters. You can then click OK or Cancel.

Step 9 Return to your originating procedure (NTP).

DLP-G378 Create, Edit, and Delete LMP Data Links

Note A port cannot be deleted if it is being used by a data link. A card cannot be deleted if any of its ports are 
being used by data links. Changing the state of the port impacts the state of a data link using the port.

Step 1 In node view, click the Provisioning > Comm Channels > LMP > Data Links tabs.

Purpose This task creates, edits, or deletes one or more data links, which define the 
node’s transport parameters. CTC supports up to 256 LMP data links.

Tools/Equipment None

Prerequisite Procedures NTP-G54 Provision and Verify a DWDM Network, page 16-28

DLP-G372 Enable LMP, page 16-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 To create a data link, click Create. The Create LMP Data Link dialog box appears.

Step 3 In the Create LMP Data Link dialog box, complete the following:

• Local Port—Select one of the available local ports for the data link.

• Local Port Id—(Display only) Displays the local port identifier.

• Data Link Type—Select Port or Component. A data link is considered to be either a port or a 
component link on each node where it terminates, depending on the multiplexing capability of the 
endpoint on that link; component links are multiplex capable, whereas ports are not multiplex 
capable.

• Local TE Link Id—Select an identifier for one of the local TE links that has already been created.

• Remote CRS Port Id—Select one of the available remote Cisco CRS-1 or Cisco ASR 9000 ports for 
the data link. This option is not available if you are creating a data link between two 
Cisco ONS 15454 nodes.

• Remote Port Id—Enter an unsigned 32-bit value (such as 0x00000001) to identify the remote node 
identifier for the other end of the data link. This option is not available if you have chosen the 
automatic LMP configuration in the “DLP-G508 Configure the Cisco CRS-1, Cisco ASR 9000 
Series, or Cisco 7600 Series Router Parameters” task on page 16-46.

Step 4 Click OK to accept the parameters you have entered and create the data link, or click Cancel to return 
to the Data Links tab without creating a data link.

Step 5 If you are creating a data link that involves a Cisco CRS-1 or Cisco ASR 9000 router and if you have 
chosen the automatic LMP configuration in the “DLP-G508 Configure the Cisco CRS-1, Cisco ASR 
9000 Series, or Cisco 7600 Series Router Parameters” task on page 16-46, a confirmation dialog box is 
displayed to indicate that this operation will also change the configuration of the Cisco CRS-1 or Cisco 
ASR 9000 router. Click Yes.

Step 6 If you created a data link, verify that the parameters for the new data link now appear properly in the 
Data Links tab.

Step 7 After the data link has been created, observe its status in the Operational State column of the Data Links 
tab, and take the appropriate action as shown in the following list:

• Up–Alloc or Up–Free—If the data link state does not transition to Up–Alloc or Up–Free, verify that 
the port is in service. Verification must be done using the CTC card view > Provisioning tab for the 
cards. (The difference between Up–Alloc and Up–Free is that an Up–Alloc data link is allocated for 
data traffic. An Up–Free data link is not allocated for traffic. The far end is either not ready to receive 
traffic through this port, or the path is being used as a backup in case some other allocated data link 
goes down).

• Down—The data link will be in the Down state if the port is not unlocked or not in-service. Verify 
that the remote port ID for the far-end data link is correct. On the far end, verify that the data link 
is using the local port ID as its remote port ID.

Step 8 To delete a data link, click the data link row to highlight it and click Delete. A confirmation dialog box 
appears that allows you to click OK or Cancel.

Step 9 To edit a data link, click the data link row to highlight it and click Edit. A dialog box appears that allows 
you to change the data link parameters. You can then click OK or Cancel. If you are editing a data link 
that involves a Cisco CRS-1 or Cisco ASR 9000 router, a confirmation dialog box is displayed. Click 
Yes.

Step 10 Return to your originating procedure (NTP).
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NTP-G233 Configure Link Management Protocol on the Cisco 
CRS-1 or Cisco ASR 9000 Router and the Cisco ONS 15454 
DWDM Node

Note This procedure is normally required only when the Cisco ONS 15454 DWDM node must run traffic to 
and from a Cisco CRS-1 or Cisco ASR 9000 router.

Step 1 Complete the DLP-G46 Log into CTC task to log in to a DWDM node on the network.

Step 2 Complete the “DLP-G508 Configure the Cisco CRS-1, Cisco ASR 9000 Series, or Cisco 7600 Series 
Router Parameters” task on page 16-46 to configure the Cisco CRS-1 or Cisco ASR 9000 router 
parameters. 

Step 3 Complete the “DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 9000 Series 
Router and Verify Configuration” task on page 16-47 to establish a Telnet session with the Cisco CRS-1 
or Cisco ASR 9000 router.

Step 4 Complete the “DLP-G510 Create a Task Group, User Group, and User Account on the Cisco CRS-1 or 
Cisco ASR 9000 Series Router” task on page 16-48 to create task groups, user groups, and user accounts 
on the Cisco CRS-1 or Cisco ASR 9000 router.

Step 5 If you have chosen the automatic LMP configuration in Step 2, complete the “NTP-G234 Automatically 
Configure Link Management Protocol on the Cisco CRS-1 or Cisco ASR 9000 Router and the Cisco 
ONS 15454 DWDM Node” procedure on page 16-44. 

If you have chosen the manual LMP configuration in Step 2, complete the “NTP-G207 Manually 
Configure Link Management Protocol on the Cisco CRS-1 or Cisco ASR 9000 Router and the Cisco 
ONS 15454 DWDM Node” procedure on page 16-44.

Stop. You have completed this procedure.

Purpose This procedure configures LMP on the Cisco ONS 15454 DWDM node and 
on the corresponding Cisco CRS-1 or Cisco ASR 9000 physical layer 
interface module (PLIM) port.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 16-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G234 Automatically Configure Link Management Protocol 
on the Cisco CRS-1 or Cisco ASR 9000 Router and the Cisco ONS 
15454 DWDM Node

Step 1 Complete the DLP-G372 Enable LMP, page 16-37 to enable the LMP function on the DWDM node.

Step 2 Complete the DLP-G373 Create, Edit, and Delete LMP Control Channels, page 16-37 to create the LMP 
control channel between the Cisco CRS-1 or Cisco ASR 9000 router and the DWDM node.

Step 3 Complete the DLP-G374 Create, Edit, and Delete LMP TE Links, page 16-40 to create TE links between 
the Cisco CRS-1 or Cisco ASR 9000 router and the DWDM node.

Step 4 Complete the DLP-G378 Create, Edit, and Delete LMP Data Links, page 16-41 to create a data link, 
which define the node’s transport parameters.

Stop. You have completed this procedure.

NTP-G207 Manually Configure Link Management Protocol on 
the Cisco CRS-1 or Cisco ASR 9000 Router and the Cisco ONS 
15454 DWDM Node

Purpose This procedure automatically configures LMP on the Cisco ONS 15454 
DWDM node and on the corresponding Cisco CRS-1 or Cisco ASR 9000 
PLIM port.

Tools/Equipment None

Prerequisite Procedures NTP-G233 Configure Link Management Protocol on the Cisco CRS-1 or 
Cisco ASR 9000 Router and the Cisco ONS 15454 DWDM Node, 
page 16-43

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure manually configures LMP on the Cisco ONS 15454 
DWDM node and on the corresponding Cisco CRS-1 or Cisco ASR 9000 
PLIM port.

Tools/Equipment None

Prerequisite Procedures NTP-G233 Configure Link Management Protocol on the Cisco CRS-1 or 
Cisco ASR 9000 Router and the Cisco ONS 15454 DWDM Node, 
page 16-43

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note For more information about the Cisco IOS XR commands used in the DLPs, see the Cisco IOS XR 
Command Reference publication at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Step 1 Complete the DLP-G372 Enable LMP, page 16-37 to enable the LMP function on the DWDM node.

Step 2 Complete the DLP-G373 Create, Edit, and Delete LMP Control Channels, page 16-37 to create the LMP 
control channel between the Cisco CRS-1 or Cisco ASR 9000 router and the DWDM node.

Step 3 Complete the DLP-G374 Create, Edit, and Delete LMP TE Links, page 16-40 to create TE links between 
the Cisco CRS-1 or Cisco ASR 9000 router and the DWDM node.

Step 4 In node view, click the Provisioning > Comm Channels > LMP > TE Links tab and write down the 
value of the Local TE Link field so that it can be used later.

Step 5 Complete the DLP-G378 Create, Edit, and Delete LMP Data Links, page 16-41 to create a data link, 
which define the node’s transport parameters.

Step 6 In node view, click the Provisioning > Comm Channels > LMP > Data Links tab and write down the 
value of the Local Port Id field so that it can be used later.

Step 7 Complete the DLP-G482 Configure a Static Route, page 16-50 to configure a static route.

Step 8 Complete the DLP-G483 Configure Local and Remote TE Links, page 16-52 to configure the local and 
remote TE links.

Step 9 Complete the DLP-G484 Enable the LMP Message Exchange, page 16-53 to enable LMP message 
exchange with the LMP neighbor.

Step 10 In node view, click the Provisioning > Comm Channels > LMP > Data Links tab and from the Local 
Port field, write down the card and the port involved in the LMP link. Double-click the card involved in 
the LMP link. In card view, click the Provisioning > Optical Chn > Parameters tabs and write down 
the value of the Actual Wavelength field for the port involved in the LMP link.

Step 11 Complete the DLP-G511 Configure the Wavelength on the Cisco CRS-1 or Cisco ASR 9000 Router, 
page 16-55 to configure the wavelength on the PLIM port of the Cisco CRS-1 or Cisco ASR 9000 router.

Step 12 If you need RADIUS AAA services, complete the DLP-G494 Configure the RADIUS Server, 
page 16-57 to configure a RADIUS server.

Step 13 Complete the DLP-G485 Enable Index Persistency on an SNMP Interface, page 16-58 to enable index 
persistency on an SNMP interface.

Step 14 Complete the DLP-G486 Configure the LMP Router ID, page 16-59 to configure LMP router ID.

Step 15 Complete the DLP-G487 Configure the 10 Gigabit Ethernet (GE) or POS Interface, page 16-60 to 
configure an interface and specify the IPv4 address for the interface.

Note Only users with proper task privileges, or a system administrator, can perform DLP-G482, 
DLP-G483, DLP-G484, DLP-G494, DLP-G485, and DLP-G486. The task privileges required to 
perform these DLPs are similar to the privileges required for automatic LMP configuration. 

Step 16 Complete the DLP-G488 Display Summary of Link Management Information, page 16-61 to display the 
interface resource or a summary of link management information.

Step 17 Complete the DLP-G374 Create, Edit, and Delete LMP TE Links, page 16-40 to edit the TE link created 
in Step 3. Change the Remote TE Link ID value to the value (Local TE Link ID) noted in Step 1 of the 
DLP-G488 Display Summary of Link Management Information, page 16-61.
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Step 18 Complete the DLP-G378 Create, Edit, and Delete LMP Data Links, page 16-41 to edit the data link 
created in Step 5. Change the Remote Port Id value to the value (Local Data Link ID) noted in Step 1 of 
the DLP-G488 Display Summary of Link Management Information, page 16-61.

Stop. You have completed this procedure.

DLP-G508 Configure the Cisco CRS-1, Cisco ASR 9000 Series, or 
Cisco 7600 Series Router Parameters

Step 1 From the Edit menu, choose Preferences. The Preferences dialog box is displayed.

Step 2 In the Preferences dialog box, click the Router tab.

Step 3 (Cisco CRS-1 and Cisco ASR 9000 series routers only) Leave the Skip automatic LMP configuration on 
routers check box unchecked if you want CTC to automatically configure an interface on the Cisco 
CRS-1 or Cisco ASR 9000 series router for the data link. Check this check box if you want to manually 
configure an interface on the Cisco CRS-1 or Cisco ASR 9000 series router.

Step 4 In the Router login area, enter the following:

• Username—Specify the name of the user on the Cisco CRS-1, Cisco ASR 9000, or Cisco 7600 
router. 

• Password—Specify the user password.

• Confirm Password—Specify the password again to confirm it.

Note If you leave the Username and Password fields blank, the CTC login information (username and 
password) will be used for the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router. 

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

Purpose This task configures the Cisco CRS-1, Cisco ASR 9000 series, or 
Cisco 7600 series router.

Tools/Equipment None

Prerequisite Procedures • NTP-G54 Provision and Verify a DWDM Network, page 16-28.

• (Cisco CRS-1 and Cisco ASR 9000 series routers only) DLP-G372 
Enable LMP, page 16-37.

• DLP-G46 Log into CTC.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 9000 
Series Router and Verify Configuration

Purpose This task establishes a Telnet session with the Cisco CRS-1 or Cisco ASR 
9000 router and verifies the node configuration, SSH, and/or XML module 
configuration.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 telnet {ip-address | host-name}

Example:
router# telnet 10.58.41.169

Establishes a Telnet session with the Cisco CRS-1 or Cisco ASR 9000 
router. When the session is established, you can log in with the 
root-system username and password. After you log in, the router 
displays the CLI prompt for the Cisco IOS XR software.

Step 2 show install active summary

Example:
router# show install active summary

Displays a summary of the active packages in a system or secure 
domain router. Ensure that the output of the show install active 
summary command includes the following lines:

hfr-mpls-3.9.x
hfr-k9sec-3.9.x
hfr-mgbl-3.9.x

Step 3 show running-config

Example:
router# show running-config

Displays the contents of the currently running configuration and 
verifies that Extensible Markup Language (XML) agent service and 
Secure Shell (SSH) client are installed on the Cisco CRS-1 or Cisco 
ASR 9000 router. Ensure that the output of the show running-config 
command includes the following lines:

ssh server v2
ssh server session-limit sessions
ssh server rate-limit maxsessions_per_minute
vty-pool default first-vty last-vty line-template default
xml agent tty

If the output does not contain the above lines, check the SSH and/or 
XML module configuration. Refer to Cisco IOS XR System Security 
Command Reference and Cisco IOS XR System Management 
Command Reference for details about SSH and XML configuration.

Step 4 Return to your originating procedure (NTP). —
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DLP-G510 Create a Task Group, User Group, and User Account on the Cisco 
CRS-1 or Cisco ASR 9000 Series Router

Note Only users who have permission to create new task groups and configure required task privileges, or a 
system administrator, can perform this task.

Purpose This task creates task groups, user groups, and user accounts on the Cisco 
CRS-1 or Cisco ASR 9000 series router.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 taskgroup taskgroup-name

Example:
router# taskgroup ipodwdmop

Creates a new task group and enters task group configuration 
submode. 

If you have chosen the automatic LMP configuration in the 
DLP-G508 Configure the Cisco CRS-1, Cisco ASR 9000 Series, or 
Cisco 7600 Series Router Parameters, page 16-46, perform Step 3. If 
you have chosen the manual LMP configuration in the DLP-G508 
Configure the Cisco CRS-1, Cisco ASR 9000 Series, or 
Cisco 7600 Series Router Parameters, page 16-46, perform Step 4.
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Step 3 task {read | write | execute | debug} 
taskid-name

Example:
router(config-tg)# task read cef

Specifies a task ID to be associated with the task group named in 
Step 2. Task IDs grant permission to perform certain tasks. 

Ensure that you specify the following task IDs to set up required 
privileges for the automatic LMP configuration:

task read cef
task read dwdm
task read ouni
task read snmp
task read static
task read sysmgr
task read logging
task read mpls-te
task read network
task read interface
task read basic-services
task write dwdm
task write ipv4
task write ouni
task write snmp
task write static
task write mpls-te
task write network
task write interface

Step 4 task {read | write | execute | debug} 
taskid-name

Example:
router(config-tg)# task read cef

Specifies a task ID to be associated with the task group named in 
Step 2. Task IDs grant permission to perform certain tasks. 

Ensure that you specify the following task IDs to set up required 
privileges for the manual LMP configuration:

task read cef
task read dwdm
task read ouni
task read snmp
task read static
task read sysmgr
task read logging
task read mpls-te
task read network
task read interface
task read basic-services
task write interface

Step 5 end

Example:
router(config-tg)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to commit 
the changes. Enter yes to save the configuration changes to the 
running configuration file and return to the EXEC mode.

Step 6 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 7 usergroup usergroup-name

Example:
router# usergroup ipodwdmop

Creates a new user group and enters user group configuration 
submode.

Command or Action Purpose
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DLP-G482 Configure a Static Route

Step 8 taskgroup taskgroup-name

Example:
router(config-ug)# taskgroup ipodwdmop

Associates the user group named in Step 7 with the task group named 
in this step. The user group takes on the configuration attributes (task 
ID list and permissions) already defined for the entered task group. 

Step 9 end

Example:
router(config-ug)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to commit 
the changes. Enter yes to save the configuration changes to the 
running configuration file and return to the EXEC mode.

Step 10 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 11 username user-name

Example:
router# username user123

Creates a name for a new user (or identifies a current user) and enters 
username configuration submode. The user-name argument can be 
only one word. Spaces and quotation marks are not allowed. 

Note The user that you specify for this command must be the user 
you have specified in the DLP-G508 Configure the Cisco 
CRS-1, Cisco ASR 9000 Series, or Cisco 7600 Series Router 
Parameters, page 16-46.

Step 12 password {0 | 7} password 

Example:
router(config-un)# password 0 passwd

Specifies a password for the user named in Step 11. Entering 0 
following the password command specifies that an unencrypted 
(clear-text) password follows. Entering 7 following the password 
command specifies that an encrypted password follows. 

Step 13 group group-name

Example:
router(config-un)# group ipodwdmop

Assigns the user named in Step 11 to a user group that has already 
been defined through the usergroup command in Step 7.

• The user takes on all attributes of the user group, as defined by 
that user group's association to various task groups.

• Each user must be assigned to at least one user group. A user may 
belong to multiple user groups. 

Step 14 end

Example:
router(config-ug)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to commit 
the changes. Enter yes to save the configuration changes to the 
running configuration file and return to the EXEC mode.

Step 15 Return to your originating procedure (NTP). —

Purpose This task explains how to configure a static route.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Command or Action Purpose
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Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 or Cisco ASR 9000 router is 10.58.41.169. To remove the static route configuration, 
use the no form of the Cisco IOS XR command. For more information about the Cisco IOS XR 
commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 router static

Example:
router(config)# router static

Enters static router configuration mode.

Step 3 address-family ipv4 unicast

Example:
router(config-static)# address-family ipv4 
unicast

Enters address family configuration mode while configuring static 
routes.

Step 4 destination-prefix prefix-mask {ip-address 
| interface-type interface-instance}

Example:
router(config-static-afi)# 10.58.41.22/32 
MgmtEth 0/RP0/CPU0/0

Establishes static routes in address family configuration mode. 
Specify the following options for this command:

• destination-prefix—IP route prefix for the destination (that is, 
DWDM node involved in the LMP link).

• prefix-mask—Prefix mask for the destination. The network 
mask can be specified as either a four-part, dotted-decimal 
address or can be indicated as a slash (/) and number.

• ip-address—(Optional) IP address of the next hop that can be 
used to reach that network. The IP address is required, not 
optional, if the interface type and number are not specified. 
You can specify an IP address and an interface type and 
interface number. 

• interface-type—(Optional) Interface type.

• interface-instance—(Optional) Either a physical interface 
instance or a virtual interface instance.

Note The interface that you specify for this command must be 
the management interface that connects the CRS-1 or ASR 
9000 router to the DWDM node.
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DLP-G483 Configure Local and Remote TE Links

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 or Cisco ASR 9000 router is 10.58.41.169. To remove the local and remote TE link 
configuration, use the no form of the Cisco IOS XR command. For more information about the 
Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Step 5 end

Example:
router(config-static-afi)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the local and remote TE links.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 mpls traffic-eng interface interface-type 
interface-instance

Example:
router(config)# mpls traffic-eng interface 
TenGigE 0/1/0/1

Enables Multiprotocol Label Switching-Traffic Engineering 
(MPLS-TE) on an interface and enters MPLS-TE interface 
submode.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 3 lmp data-link adjacency

Example:
router(config-mpls-te-if)# lmp data-link 
adjacency

Enters the LMP neighbor adjacency configuration mode.
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DLP-G484 Enable the LMP Message Exchange

Note Only users with proper task privileges, or a system administrator, can perform this task.

Step 4 neighbor neighbor-name

Example:
router(config-mpls-ouni-if-adj)# neighbor 
10.58.41.22

Associates an interface with a given LMP neighbor.

Step 5 remote te-link-id unnum identifier

Example:
router(config-mpls-te-if-adj)# remote 
te-link-id unnum 1

Configures the LMP neighbor remote TE link ID.

Note Specify the value (converted to decimal format) noted in 
Step 4 of NTP-G207 Manually Configure Link 
Management Protocol on the Cisco CRS-1 or Cisco ASR 
9000 Router and the Cisco ONS 15454 DWDM Node, 
page 16-44 for the te-link-id unnum identifier keywords 
and argument.

Step 6 remote interface-id unnum identifier

Example:
router(config-mpls-te-if-adj)# remote 
interface-id unnum 57410

Configures the LMP neighbor remote interface identifier.

Note Specify the value (converted to decimal format) noted in 
Step 6 of NTP-G207 Manually Configure Link 
Management Protocol on the Cisco CRS-1 or Cisco ASR 
9000 Router and the Cisco ONS 15454 DWDM Node, 
page 16-44 for the interface-id unnum identifier 
keywords and argument.

Step 7 remote switching-capability fsc

Example:
router(config-mpls-te-if-adj)# remote 
switching-capability fsc

Configures the LMP neighbor remote TE interface switching 
capability.

Step 8 end

Example:
router(config-mpls-te-if-adj)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 9 Return to your originating procedure (NTP). —

Purpose This task explains how to enable the LMP message exchange with the LMP 
neighbor.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose
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Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 or Cisco ASR 9000 router is 10.58.41.169. To remove the LMP message exchange 
configuration, use the no form of the Cisco IOS XR command. For more information about the 
Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 mpls traffic-eng signalling advertise 
explicit-null

Example:
router(config)# mpls traffic-eng 
signalling advertise explicit-null

Specifies that tunnels terminating on a router use explicit-null 
labels.

Step 3 mpls traffic-eng lmp neighbor 
neighbor-name

Example:
router(config)# mpls traffic-eng lmp 
neighbor 10.58.41.22

Configures or updates a new or existing LMP neighbor. 

Step 4 ipcc routed

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
ipcc routed

Configures a routed Internet Protocol Control Channel (IPCC) for 
the LMP neighbor.

Step 5 remote node-id ip-address

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
remote node-id 10.58.41.22

Configures the remote node ID for the LMP neighbor (DWDM 
node).

Step 6 end

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 7 Return to your originating procedure (NTP). —
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DLP-G511 Configure the Wavelength on the Cisco CRS-1 or Cisco ASR 9000 
Router

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note To remove the wavelength setting, use the no form of the Cisco IOS XR command. For more information 
about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Purpose This task explains how to configure the wavelength on the PLIM port of 
the Cisco CRS-1 or Cisco ASR 9000 router.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Command or Action Purpose

Step 1 show controllers dwdm interface-instance 
wavelength-map

Example:
router# show controllers dwdm 0/1/0/0 
wavelength-map

Displays the wavelength information of an interface.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

The output of the show command will include the following lines:

Wavelength band: C-band
MSA ITU channel range supported: 3~84

03       196.00          1529.553
----------------------------------------
04       195.95          1529.944
----------------------------------------
05       195.90          1530.334
----------------------------------------
06       195.85          1530.725
----------------------------------------

From the output of the show command, write down the channel 
number of the wavelength that matches that of the wavelength 
noted in Step 10 of NTP-G207 Manually Configure Link 
Management Protocol on the Cisco CRS-1 or Cisco ASR 9000 
Router and the Cisco ONS 15454 DWDM Node, page 16-44.

Step 2 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 3 controller dwdm interface-instance

Example:
router(config)# controller dwdm 0/1/0/0

Configures the DWDM controller.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 4 wavelength channel-number

Example:
router(config)# wavelength 04

Configures a specific wavelength to the DWDM controller. 

Note The channel number that you specify for this command 
must be the value noted down in Step 1.

Step 5 end

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 Return to your originating procedure (NTP). —
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DLP-G494 Configure the RADIUS Server

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the RADIUS server is 10.58.39.57. To remove the 
RADIUS server configuration, use the no form of the Cisco IOS XR command. For more information 
about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference document.

Purpose This task explains how to configure the RADIUS server.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

For details on configuring a node for RADIUS authentication, see the 
DLP-G281 Configure the Node for RADIUS Authentication task. See the 
User Guide for Cisco Secure ACS for Windows Server for more 
information about configuring the RADIUS server.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 radius-server host ip-address [auth-port 
port-number] [acct-port port-number] [key 
string] 

Example:
router(config)# radius-server host 
10.58.39.57 auth-port 1812 acct-port 1813 
key 7 12485043475F

Specifies the RADIUS server host.

Step 3 aaa group server radius group-name

Example:
router(config)# aaa group server radius 
radgroup1

Groups different RADIUS server hosts into distinct lists and 
enters server group configuration mode.

Step 4 server ip-address [auth-port port-number] 
[acct-port port-number]

Example:
router(config-sg-radius)# server 
10.58.39.57 auth-port 1812 acct-port 1813

Associates a particular RADIUS server with a defined server 
group.
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DLP-G485 Enable Index Persistency on an SNMP Interface

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note To remove the index persistency configuration, use the no form of the Cisco IOS XR command. For 
more information about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference 
document.

Step 5 end

Example:
router(config-sg-radius)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 7 aaa authentication login {{console | 
default} {group group_name | local | 
none}} 

Example:
router(config)# aaa authentication login 
default group radgroup1 local

Configures the authentication method used for login to the Virtual 
Firewall (VFW) application CLI. 

Step 8 end

Example:
router(config-if)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 9 Return to your originating procedure (NTP). —

Purpose This task explains how to enable index persistency on a Simple Network 
Management Protocol (SNMP) interface.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose
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DLP-G486 Configure the LMP Router ID

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 or Cisco ASR 9000 router is 10.58.41.169. To remove the LMP router ID 
configuration, use the no form of the Cisco IOS XR command. For more information about the 
Cisco IOS XR commands, see the Cisco IOS XR Command Reference document.

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 snmp-server interface interface-type 
interface-instance

Example:
router(config)# snmp-server interface 
TenGigE 0/1/0/1

Enables an interface to send SNMP trap notifications and enters 
SNMP interface configuration mode.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 3 index persistence

Example:
router(config-snmp-if)# index persistence

Enables index persistency on an SNMP interface. This command 
must be performed to ensure that the LMP IDs are persistent even 
after a system reload.

Step 4 end

Example:
router(config-snmp-if)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 5 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the LMP router ID.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G487 Configure the 10 Gigabit Ethernet (GE) or POS Interface

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note To remove the POS interface configuration, use the no form of the Cisco IOS XR command. For more 
information about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference document.

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 mpls traffic-eng lmp router-id ip-address

Example:
router(config)# mpls traffic-eng lmp 
router-id 10.58.41.169

Configures the LMP router ID.

Step 3 end

Example:
router(config)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 4 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the 10 GE or POS interface.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G488 Display Summary of Link Management Information

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 interface interface-type 
interface-instance

Example:
router(config)# interface TenGigE 0/1/0/1

Enters interface configuration mode.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 3 ipv4 point-to-point

Example:
router(config-if)# ipv4 point-to-point

Configures a 10 GE interface to act as a point-to-point interface.

Note For a POS interface, skip this step and continue with 
Step 4.

Step 4 ipv4 unnumbered interface-type 
interface-instance

Example:
router(config-if)# ipv4 unnumbered MgmtEth 
0/RP0/CPU0/0

Specifies the MPLS-TE tunnel IPv4 address for the interface.

Note The interface that you specify for this command must be 
the management interface that connects the CRS-1 or ASR 
9000 router to the DWDM node.

Step 5 end

Example:
router(config-if)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 Return to your originating procedure (NTP). —

Purpose This task displays the interface resource or a summary of link management 
information.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 or Cisco ASR 
9000 Series Router and Verify Configuration, page 16-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Command or Action Purpose

Step 1 show mpls traffic-eng lmp interface 
[interface-type interface-instance]

Example:
router(config-if)# show mpls traffic-eng 
lmp interface TenGigE 0/1/0/1

Displays the interface resource or a summary of link management 
information. From the output of the show command, write down 
the value of the Local TE Link ID and the Local Data Link ID 
parameters.

Step 2 Return to your originating procedure (NTP). —
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NTP-G337 Configure Provisioning Parameters for an Interface 
on the Cisco CRS-1 Router

Step 1 From the View menu, choose Go to Network View to view the circuits for an entire network.

Step 2 Double-click the Cisco CRS-1 router node in the circuit.

Step 3 Choose an interface on the Cisco CRS-1 router.

Step 4 Choose Provisioning > General to provision the administrative state, wavelength, and loopback settings 
for an interface on the Cisco CRS-1 router according to the following table.

Purpose This procedure configures the provisioning parameters such as 
administrative state, wavelength, loopback, proactive protection, and OTN 
for an interface on the Cisco CRS-1 router.

Tools/Equipment None

Prerequisite Procedures  DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Item Description

Admin State Choose an administrative state from the drop-down list and click Apply to 
configure the transport administration state on a router interface.

Admin states include:

• IS—Places the interface in In Service (IS) state, to support all the normal 
operations. This is the default.

• OOS,DSBLD—Places the interface in Out of Service Disabled 
(OOS,DSBLD) state. The laser is turned off and all traffic flow is stopped. 

• OOS,MT—Places the interface in Out of Service Maintenance (OOS,MT) 
state to perform configuration, while the laser and G.709 framer remain up.

Wavelength Allows you to set the wavelength on a router interface to a specific ITU channel.

Loopback Configures the loopback facility on a router interface.

• None—Clears the current loopback setting.

• Internal—Specifies that all the packets be looped back to the router.

• Line—Specifies that the incoming network packets be looped back to the 
DWDM network.
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Step 5 Choose Provisioning > Proactive Protection to provision the Proactive Protection settings for an 
interface on the Cisco CRS-1 router according to the following table.

Step 6 Choose Provisioning > OTN to provision the OTN settings for an interface on the Cisco CRS-1 router 
according to the following table.

Item Description

Trigger threshold Configures the trigger threshold of Forward Error Correction-Fast Re-Route 
(FEC-FRR). The available options are: 

• 1E-3 through 1E-9

• 2E-3 through 2E-9

• 3E-3 through 3E-9

• 4E-3 through 4E-9

• 5E-3 through 5E-9

• 6E-3 through 6E-9

• 7E-3 through 7E-9

• 8E-3 through 8E-9

• 9E-3 through 9E-9

Trigger window (ms) Configures the trigger window in which Fast Re-Route might be triggered. The 
range is from 10 to 10000 milliseconds.

Revert Threshold Configures the revert threshold to trigger reverting from the FEC-FRR route 
back to the original route.

The available options are:

• 1E-4 through 1E-10

• 2E-4 through 2E-10

• 3E-4 through 3E-10

• 4E-4 through 4E-10

• 5E-4 through 5E-10

• 6E-4 through 6E-10

• 7E-4 through 7E-10

• 8E-4 through 8E-10

• 9E-4 through 9E-10

Revert window (ms) Configures the revert window in which reverting from the FEC-FRR route back 
to the original route is triggered. The range is from 2000 to 100000 
milliseconds.

Item Description

ITU-T G.709 OTN Enables or disables the ITU-T G.709 monitoring on the OTN.
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Stop. You have completed this procedure.

NTP-G303 Configure Virtual links on the Cisco 7600 and 
Cisco ONS 15454 DWDM Node

Note This procedure is normally required only when the Cisco ONS 15454 DWDM node must run traffic to 
and from a Cisco 7600 router.

Step 1 Complete the “DLP-G711 Configure SSH Server on Cisco 7600 Series Nodes” task on page 16-66.

Step 2 To enable IPoDWDM using the Cisco 7600 series router, add the attribute “ctc.isC7600Supported=1” 
in the /users/<username>/.ctcrc file. This should be done prior to launching CTC. By default, 
IPoDWDM using the Cisco 7600 series router is disabled.

Step 3 If you need RADIUS AAA services, configure a RADIUS server. For more information, see 
“Configuring RADIUS”. 

Step 4 Complete the DLP-G46 Log into CTC task to log in to a DWDM node on the network.

Step 5 Configure the Cisco 7600 series router parameters in CTC. See “DLP-G508 Configure the Cisco CRS-1, 
Cisco ASR 9000 Series, or Cisco 7600 Series Router Parameters” task on page 16-46”. 

Step 6 Add a Cisco 7600 series node to the DWDM network in CTC. See DLP-G49 Add a Node to the Current 
Session or Login Group.

FEC Configures the FEC mode. The available options are:

• Disable

• Standard

• Enhanced

• Enhanced1.4

• Enhanced1.7

• LongHaul

• HighGain

SF BER Configures the signal failure (SF) bit error rate (BER). The available options are 
1E-1 through 1E-9.

SD BER Configures the signal degrade (SD) BER. The available options are 1E-1 
through 1E-9.

Purpose This procedure configures virtual links on the Cisco 7600 and the 
Cisco ONS 15454 DWDM node.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 16-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Repeat Step 1 through Step 5 to bring up the second Cisco 7600 series node in the network.

Step 8 Create Provisionable Patchcords between the Cisco 7600 series and DWDM nodes. See “NTP-G184 
Create a Provisionable Patchcord” task on page 17-77.”

Step 9 Create an Optical Channel (OCH) trail between the two Cisco 7600 series nodes. See “DLP-G395 Create 
an Optical Channel Trail” task on page 17-34”. After creating the OCH trails, traffic can be transmitted 
between the Cisco 7600 nodes.

Stop. You have completed this procedure.

DLP-G711 Configure SSH Server on Cisco 7600 Series Nodes

Note The user ID and password configured on the ONS 15454 and Cisco 7600 nodes must be the same.

Purpose This procedure configures the Secure Shell (SSH) server and performs 
node authentication for Cisco 7600 series nodes. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

• Enter your password if prompted.

Step 2 shell processing full 

Example:
router(config)# shell processing full

Enables shell processing.

Step 3 hostname host-name

Example:
router(config)# hostname test124

Configures the host name on the Cisco 7600 series router. 

Step 4 aaa new-model 

Example:
router(config)# aaa new-model

Enables authentication, authorization, and accounting (AAA). 
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Step 5 username username password password

Example:
router(config)# username cisco password 
cisco123

Enables the local username and password on the Cisco 7600 series 
router to be used in the absence of other AAA statements. 

Step 6 username username privilege 
privilege-level

Example:
router(config)# username cisco 
privilege 1

Assigns user name and privilege levels to the CTC user.

Step 7 ip domain-name domain-name

Example:
router(config)# ip domain-name 
rtp.cisco.com

Configures the DNS domain of the Cisco 7600 series router.

Step 8 crypto key generate rsa

Example:
router(config)# crypto key generate rsa

Generates the SSH key that is used with the SSH server.

Step 9 ip ssh version 2

Example:
router(config)# ip ssh version 2

Specifies that version 2 of SSH is configured on the Cisco 7600 series 
router.

Step 10 ip ssh time-out seconds

Example:
router(config)# ip ssh time-out 60

Indicates the time interval that the Cisco 7600 series router waits for 
the SSH client to respond. This setting applies to the SSH negotiation 
phase. When the EXEC session starts, the standard timeouts 
configured for the vty apply. The value can range from 1 to 120 
seconds. 

Step 11 ip ssh authentication-retries integer

Example:
router(config)#ip ssh 
authentication-retries 2

Indicates the number of attempts after which the interface is reset. 
The number of retries can range from 0 to 5.

Step 12 line vty 0 4

Example:
router(config)#line vty 0 4

Indicates that five terminal sessions are possible. 

Step 13 transport input ssh

Example:
router(config-line)# transport input 
ssh

Disables telnet mode and enables the SSH mode to login to the 
Cisco 7600 series router.

Command or Action Purpose
16-67
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 16      Turn Up a Network
DLP-  G711 Configure SSH Server on Cisco 7600 Series Nodes
NTP-G57 Create a Logical Network Map

Step 1 Complete the DLP-G46 Log into CTC task at a node on the network where you want to create the 
network map. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Change the position of the nodes in the network view according to your site plan:

a. Click a node to select it, then drag and drop the node icon to a new location. 

b. Repeat Step a for each node that you need to position.

Step 4 On the network view map, right-click and choose Save Node Position from the shortcut menu.

Step 5 Click Yes in the Save Node Position dialog box.

CTC opens a progress bar and saves the new node positions.

Note Retrieve, Provisioning, and Maintenance users can move nodes on the network map, but only 
Superusers can save new network map configurations. To restore the view to a previously saved 
version of the network map, right-click the network view map and choose Reset Node Position.

Stop. You have completed this procedure.

NTP-G325 View the Power Levels of Cisco ONS 15454 MSTP 
Nodes

Purpose This procedure allows a Superuser to create a consistent network view for 
all nodes on the network, meaning that all users see the same network view 
on their login nodes.

Tools None

Prerequisite Procedures This procedure assumes that network turn-up is complete.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This procedure displays the power levels of the ports of the ONS 15454 
MSTP nodes that traverse through an OCH or OCHNC trail using the 
Photonic Path Trace (PPT). The results are displayed in a histogram.

Tools None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the DLP-G46 Log into CTC task to log in to an ONS 15454 MSTP node on the network.

Step 2 In the network view, node view (single-node mode), multishelf view (multishelf mode), or card view 
click the Circuits tab.

Note An OCHNC or OCH trail circuit must exist on the optical path on which PPT is launched.

Step 3 Select the OCH trail and click Edit. The Edit Circuit window appears.

Step 4 In the Edit Circuit window, click the Photonic Path Trace tab.

Step 5 Click Start to start the PPT. The PPT creates a histogram that displays the power levels of the nodes 
versus the threshold levels.

Note The circuit must be in the DISCOVERED state to start the PPT.

Step 6 Click Export to export the data in the form of HTML.

Stop. You have completed this procedure.

NTP-G326 Provision SRLG on the Cisco ONS 15454 MSTP 
Network

Step 1 Complete the DLP-G46 Log into CTC task to log in to an ONS 15454 MSTP node on the network.

Step 2 To assign, modify, delete, or reset the SRLG attributes for the nodes or links, perform the following 
steps:

a. Click the Manage SRLGs option in the Tools > Manage IPoDWDM menu. The SRLG Management 
wizard appears.

b. Choose one of the following options from the Select Type drop-down list:

– Manage Node SRLG—To add or update the node SRLGs.

– Manage Link SRLG—To add or update the link SRLGs.

c. Click Next.

Purpose This procedure provisions Shared Risk Link Groups (SRLGs) for MSTP 
nodes and spans of the currently managed network using the SRLG 
management wizard. The SRLG information can be synchronized on Cisco 
CRS-1 or Cisco ASR 9000 routers and viewed as reports.

Tools None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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d. In the Manage SRLG page, complete the following fields:

– If you chose the Manage Node SRLG option in Step b., select the node from the Node 
drop-down list. If you the chose Manage Link SRLG option in Step b., select the span from 
the Link drop-down list.

– In the Unique SRLG field, an SRLG number is displayed. You can edit the value. If the SRLG 
value already exists, a message is displayed.

To reset the SRLG value, click Set Default. A confirmation box is displayed. Click Yes.

Note The unique SRLG range is from 0 to 4294967294.

– To add an additional SRLG, type a numeric value in the Additional SRLG field and click Add.

If the SRLG value already exists, a message is displayed.

Note A maximum of 20 SRLGs can be added to the SRLG list.

– To delete an additional SRLG, choose the value from the SRLG list and click Delete. To reset 
the value, click Set Default. A confirmation box is displayed. Click Yes.

e. Click Finish to exit the wizard.

Step 3 To view the SRLG values of the nodes and links, perform the following steps:

• To view the SRLG values for the OTS, OSC, or PPC links, go to the Network view and right-click 
the link, or place the mouse pointer over the link to see the SRLG value as a tooltip.

• To view the node SRLG values, click the Provisioning > General tab in the node view (single-shelf 
mode) or shelf view (multishelf view).

Step 4 To synchronize the SRLG information on the Cisco CRS-1 or Cisco ASR 9000 router, go to Network 
view, right-click the router and choose Synchronise IPoDWDM from the shortcut menu.

Step 5 Complete the “DLP-G540 View SRLG Reports” section on page 16-70 to view SRLG reports.

Stop. You have completed this procedure.

DLP-G540 View SRLG Reports

Step 1 Complete the DLP-G46 Log into CTC task to log in to an ONS 15454 MSTP node on the network.

Purpose This task explains how to view SRLG reports.

Tools None

Prerequisite Procedures NTP-G326 Provision SRLG on the Cisco ONS 15454 MSTP Network, 
page 16-69

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 To view the SRLG reports, perform the following steps:

• To view the consolidated SRLG report, click the Consolidated SRLG Report option in the Tools 
> Manage IPoDWDM > SRLG Report menu. The report displays the following information:

– Resource Name—Displays the node name or link name.

– Resource Type—Displays the resource type (node or link).

– Unique SRLG—Displays the unique SRLG value.

– Additional SRLG—Displays additional SRLG values.

• To view the detailed SRLG report, click the Detailed SRLG Report option in the Tools > Manage 
IPoDWDM > SRLG Report menu. The report displays the following information:

– Resource Name—Displays the node name or link name.

– Resource Type—Displays the resource type (node or link).

– SRLG Id—Displays the SRLG value.

– SRLG Type—Displays the SRLG type (unique or additional).

Step 3 Return to your originating procedure (NTP).
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C H A P T E R 17

Create Optical Channel Circuits and 
Provisionable Patchcords

This chapter explains the Cisco ONS 15454 dense wavelength division multiplexing (DWDM) optical 
channel (OCH) circuit types and virtual patchcords that can be provisioned on the ONS 15454. Circuit 
types include the OCH client connection (OCHCC), the OCH trail, and the OCH network connection 
(OCHNC). Virtual patchcords include internal patchcords and provisionable (external) patchcords 
(PPCs). This chapter also describes 17.3 End-to-End SVLAN Circuit that can be created between 
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards.

This chapter explains how to create Cisco ONS 15454 dense wavelength division multiplexing (DWDM) 
optical channel client connections (OCHCCs), optical channel network connections (OCHNCs), optical 
trail circuits, and STS circuits. The chapter also tells you how to create provisionable patchcords, 
upgrade OCHNCs to OCHCCs, manage SVLANs for GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards, and manage overhead circuits.

Note Unless otherwise specified, “ONS 15454" refers to both ANSI and ETSI shelf assemblies. 

Note In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to 
the 15454-M-RAMAN-COP card.

Note In this chapter, the “NFV view” refers to the “DWDM Network Functional View (NFV)”. The “GMPLS 
view” refers to the “DWDM Network Functional View (GMPLS)”.

Note In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the 
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card. 

17.1 Optical Channel Circuits
The ONS 15454 DWDM optical circuits provide end-to-end connectivity using three OCH circuit types: 

• Optical Channel Network Connections (OCHNC)

• Optical Channel Client Connections (OCHCC)
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• Optical Channel Trails (OCH Trails)

A graphical representation of OCH circuits is shown in Figure 17-1.

Figure 17-1 Optical Channel Circuits

17.1.1 OCHNC Circuits
OCHNC circuits establish connectivity between two optical nodes on a specified C-band wavelength. 
The connection is made through the ports present on the wavelength selective switches, multiplexers, 
demultiplexer, and add/drop cards. In an OCHNC circuit, the wavelength from a source OCH port 
ingresses to a DWDM system and then egresses from the DWDM system to the destination OCH port. 
The source and destination OCH port details are listed in Table 17-1.

R-OADM
Transponder
Muxponder

Transponder
MuxponderR-OADMR OADM

To clientTo client

R OADM

DWDM
Network

OCH NC

OCH Trail

OCH CCOCH CC 33
33

33

Table 17-1 OCHNC Ports

Card Source Ports Destination Ports

32WSS

32WSS-L

40-WSS-C

40-WSS-CE

ADD-RX —

32MUX-O

40-MUX-C

CHAN-RX —

32DMX-O

32DMX

32DMX-L

40-DMX-C

40-DMX-CE

— CHAN-TX

4MD

AD-1C-xx.x

AD-4C-xx.x

CHAN-RX CHAN-TX

40-SMR1-C

40-SMR2-C

ADD-RX DROP-TX
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17.1.2   OCHCC Circuits
Note When the 40-SMR1-C or 40-SMR2-C card operates along with the 15216-MD-40-ODD, 
15216-EF-40-ODD, or 15216-MD-48-ODD (ONS 15216 40 or 48-channel mux/demux) patch panel, the 
OCH ports on the patch panel are the endpoints of the OCHNC circuit. 

When the 40-SMR1-C or 40-SMR2-C card operates along with the 40-MUX-C and 40-DMX-C cards, 
the endpoints of the OCHNC circuit are on the MUX/DMX cards.

17.1.2 OCHCC Circuits
OCHCC circuits extend the OCHNC to create an optical connection from the source client port to the 
destination client port of the TXP/MXP cards. An OCHCC circuit represents the actual end-to-end client 
service passing through the DWDM system.

Each OCHCC circuit is associated to a pair of client or trunk ports on the transponder (TXP), muxponder 
(MXP), GE_XP (in layer-1 DWDM mode), 10GE_XP (in layer-1 DWDM mode), or ITU-T line card.

The OCHCCs can manage splitter protection as a single protected circuit. However, for the Y-Cable 
protection, two OCHCC circuits and two protection groups are required.

17.1.3 OCH Trail Circuits
OCH trail circuits transport the OCHCCs. The OCH trail circuit creates an optical connection from the 
source trunk port to the destination trunk port of the Transponder (TXP), Muxponder (MXP), GE_XP, 
10GE_XP, or ITU-T line card. The OCH trail represents the common connection between the two cards, 
over which all the client OCHCC circuits, SVLAN circuits or STS circuits are carried.

Once an OCHCC is created, a corresponding OCH Trail is automatically created. If the OCHCC is 
created between two TXP, MXP, GE_XP, or 10GE_XP cards, two circuits are created in the CTC. These 
are:

One OCHCC (at client port endpoints)

One OCH trail (at trunk port endpoints)

If the OCHCC is created between two TXPP or two MXPP cards, three circuits are created in the CTC. 
These are:

• One OCHCC (at client port endpoints)

15216-MD-40-ODD

15216-MD-40-EVEN

CHAN-RX CHAN-TX

15216-EF-40-ODD

15216-EF-40-EVEN

CHAN-RX CHAN-TX

15216-MD-48-ODD

15216-MD-48-EVEN

CHAN-RX CHAN-TX

15216-FLD-4 CHAN-RX CHAN-TX

Table 17-1 OCHNC Ports (continued)

Card Source Ports Destination Ports
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17.1.3   OCH Trail Circuits
• Two OCH Trails (at trunk port endpoints)
One for the working and other for the protect trunk.

Note On a TXP, MXP, and GE_XP card (in layer 1 DWDM mode), additional OCHCC circuits are created 
over the same OCH trail.

Note On a TXP, MXP, GE_XP (in layer 1 DWDM mode), and 10GE_XP (in layer 1 DWDM mode) card, the 
OCH trail cannot be created independently, and is created along with the first OCHCC creation on the 
card. However, on a GE_XP card (in layer-2 DWDM mode), 10GE_XP card (in layer-2 DWDM mode), 
and ADM_10G card, an OCH trail can be created between the trunk ports for the upper layer circuits 
(SVLAN in GE_XP/10GE_XP and STS in ADM_10G). No OCHCC is supported in these cases. 

If the OCHCC is created between two ITU-T line cards, only one trunk port belongs to the OCHCC at 
each end of the circuit. Table 17-2 lists the ports that can be OCHCC and OCH trail endpoints.

Figure 17-2 shows the relationships and optical flow between the OCHCC, OCH trail, and OCHNC 
circuits.

Table 17-2 OCHCC and OCH Trail Ports

Card OCHCC OCH Trail

TXPs

MXPs 

GE_XP

10GE_XP

ADM-10G

Any client port Any trunk port

ITU-T line cards:

• OC48/STM64 EH

• OC192 SR/STM64

• MRC-12

• MRC-2.5-12

• MRC-2.5G-4

Any trunk port Any trunk port
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Figure 17-2 Optical Channel Management

17.1.4 Administrative and Service States
OCHCCs, OCH trails, and OCHNCs occupy three different optical layers. Each OCH circuit has its own 
administrative and service states. The OCHCCs impose additional restrictions on changes that can be 
made to client card port administrative state. 

The OCHCC service state is the sum of the OCHCC service state and the OCH trail service state. When 
creating an OCHCC circuit, you can specify an initial state for both the OCHCC and the OCH trail 
layers, including the source and destination port states. The ANSI/ETSI administrative states for the 
OCHCC circuits and connections are:

• IS/Unlocked

• IS,AINS/Unlocked,AutomaticInService

• OOS,DSBLD/Locked,disabled

OCHCC service states and source and destination port states can be changed independently. You can 
manually modify client card port states in all traffic conditions. Setting an OCHCC circuit to 
OOS,DSBLD/Locked,disabled state has no effect on OCHCC client card ports. 

An OCH trail is created automatically when you create an OCHCC. OCH trails can be created 
independently between OCH-10G cards and GE_XP and 10GE_XP when they are provisioned in 
Layer 2 Over DWDM mode. The OCH trail ANSI/ETSI administrative states include: 

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

You can modify OCH trail circuit states from the Edit Circuit window. Placing an OCH trail 
OOS,DSBLD/Locked,disabled causes the following state changes:

OCHCC

Optical Shelf
STS/VT

Back
Panel

OCN Line Card TXP/MXP

ITU-T  Line Card 

OCN
Port

Back
Panel

Trunk
Port

Trunk
Port

Client
Port

15
94

73

LINE TX 

LINE RX 

OCH
RX 

OCH
TX 

OCHNC

OCH Trail

Optical Shelf

LINE TX 

LINE RX 

OCH
RX 

OCH
TX 
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17.1.4   Administrative and Service States
• The state of the OCH trail ports changes to OOS,DSBLD/Locked,disabled.

• The OCHNC state changes to OOS,DSBLD/Locked,disabled.

Changing the OCH trail state to IS,AINS/Unlocked,automaticInService causes the following state 
changes: 

• The state of the OCH trail trunk ports changes to IS/Unlocked.

• The OCHNC state changes to IS,AINS/Unlocked,automaticInService.

The OCH trail service state is the sum of the OCHCC trunk port state and the OCHNC (if applicable) 
state. Changing the client card trunk ports to OOS,DSBLD/Locked,disabled when the OCH trail state 
IS/Unlocked will cause the OCH trail state to change to OOS,DSBLD/Locked,disabled and its status to 
change to Partial.

The OCHNC circuit states are not linked to the OCHCC circuit states. The administrative states for the 
OCHNC circuit layer are: 

• IS,AINS/Unlocked,AutomaticInService

• OOS,DSBLD/Locked,disabled

When you create an OCHNC, you can set the target OCHNC circuit state to IS/Unlocked or 
OOS,DSBLD/Locked,disabled. You can create an OCHNC even if OCHNC source and destination ports 
are OOS,MT/Locked,maintenance. The OCHNC circuit state will remain 
OOS-AU,AINS/Unlocked-disabled,automaticInService until the port maintenance state is removed. 
During maintenance or laser shutdown, the following behavior occurs: 

• If OCHNCs or their end ports move into an AINS/AutomaticInService state because of user 
maintenance activity on an OCHCC circuit (for example, you change an optical transport section 
(OTS) port to OOS,DSBLD/Locked,disabled), Cisco Transport Controller (CTC) suppresses the 
loss of service (LOS) alarms on the TXP, MXP, GE_XP, 10GE_XP, or ITU-T line card trunk ports 
and raises a Trail Signal Fail condition. Line card trunk port alarms are not changed, however.

• If TXP client or trunk port are set to OOS,DSBLD/Locked,disabled state (for example, a laser is 
turned off) and the OCH trunk and OCH filter ports are located in the same node, the OCH filter 
LOS alarm is demoted by a Trail Signal Fail condition. 

OCHCCs are associated with the client card end ports. Therefore, the following port parameters cannot 
be changed when they carry an OCHCC: 

• Wavelength

• Service (or payload type) 

• Splitter protection 

• ITU-T G.709

• Forward error correction (FEC)

• Mapping 

Certain OCHCC parameters, such as service type, service size, and OCHNC wavelength can only be 
modified by deleting and recreating the OCHCC. If the OCHCC has MXP end ports, you can modify 
services and parameters on client ports that are not allocated to the OCHCC. Some client port 
parameters, such as Ethernet frame size and distance extension, are not part of an OCHCC so they can 
be modified if not restricted by the port state. For addition information about administrative and service 
states, see the Administrative and Service States document. 
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17.1.5 Creating and Deleting OCHCCs
To create an OCHCC, you must know the client port states and their parameters. If the client port state 
is IS/Unlocked, OCHCC creation will fail if the OTN line parameters (ITU-T G.709, FEC, signal fail bit 
error rate (SF BER), and signal degrade bit error rate (SD BER) on the OCHCC differ from what is 
provisioned on the trunk port. The port state must be changed to OOS-DSLB/Locked,disabled in order 
to complete the OCHCC.

If you delete an OCHCC, you can specify the administrative state to apply to the client card ports. For 
example, you can have the ports placed in OOS,DSBLD/Locked,disabled state after an OCHCC is 
deleted. If you delete an OCHCC that originates and terminates on MXP cards, the MXP trunk port states 
can only be changed if the trunk ports do not carry other OCHCCs.

17.1.6 OCHCCs and Service and Communications Channels
Although optical service channels (OSCs), generic communications channels (GCCs), and data 
communications channels (DCCs) are not managed by OCHCCs, the following restrictions must be 
considered when creating or deleting OCHCCs on ports with service or communication channels:

• Creating an OCHCC when the port has a service or a communications channel is present—OCHCC 
creation will fail if the OCHCC parameters are incompatible with the GCC/DCC/GCC. For 
example, you cannot disable ITU-T G.709 on the OCHCC if a GCC carried by the port requires the 
parameter to be enabled. 

• Creating a service or communications channel on ports with OCHCCs—OCHCC creation will fail 
if the GCC/DCC/GCC parameters are incompatible with the OCHCC. 

• Deleting an OCHCC on ports with service or communications channels—If an OSC/GCC/DCC is 
present on a TXP, MXP, GE_XP, 20GE_XP, or ITU-T line card client or trunk port, you cannot set 
these ports to the OOS,DSBLD/Locked,disabled state after the OCHCC circuit is deleted. 

17.1.7 Related Procedures
• NTP-G151 Create, Delete, and Manage Optical Channel Client Connections, page 17-15

• NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-34

• NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, page 17-41

• NTP-G58 Locate and View Optical Channel Circuits, page 17-71

17.2 Virtual Patchcords
The TXP, MXP, TXPP, MXPP, GE_XP, 10GE_XP, and ADM-10G client ports and DWDM filter ports 
can be located in different nodes or in the same single-shelf or multishelf node. ITU-T line card trunk 
ports and the corresponding DWDM filter ports are usually located in different nodes.

OCHCC provisioning requires a virtual patchcord between the client card trunk ports and the DWDM 
filter ports. Depending on the physical layout, this can be an internal patchcord or a provisionable 
(external) patchcord (PPC). Both patchcord types are bidirectional. However, each direction is managed 
as a separate patchcord.
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17.2   Virtual Patchcords
Internal patchcords provide virtual links between the two sides of a DWDM shelf, either in single-shelf 
or multishelf mode. They are viewed and managed in the Provisioning > WDM-ANS > 
Internal Patchcords tab.

When the NE update file is imported in CTC, the Provisioning > WDM-ANS > Internal Patchcord tab is 
populated with the internal patchcords. When you create an internal patchcord manually, the Internal 
Patchcord Creation wizard prompts you to choose one of the following internal patchcord types: 

• Trunk to Trunk (L2)—Creates an internal patchcord between two trunk ports (in NNI mode) of a 
GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE card provisioned in the L2-over-DWDM mode.

• OCH-Trunk to OCH-Filter—Creates an internal patchcord between the trunk port of a TXP, MXP, 
GE_XP, 10GE_XP, or ITU-T line card, and an OCH filter card (wavelength selective switch, 
multiplexer, or demultiplexer). 

• OCH-Filter to OCH-Filter—Creates an internal patchcord between a MUX input port and a DMX 
output port.

• OTS to OTS—Creates an internal patchcord between two OTS ports.

• Optical Path—Creates an internal patchcord between two optical cards, or between an optical card 
and a passive card.

Note If a Side-to-Side PPC is created between nodes, it will no longer function if the node Security Mode 
mode is enabled (see the “DLP-G264 Enable Node Security Mode” procedure on page 14-25). When the 
Secure mode is enabled, it is no longer possible for the DCN extension feature to use the LAN interface 
to extend the internal network (due to the network isolation in this configuration mode). The result is 
that the topology discovery on the Side-to-Side PPC no longer operates.

Table 17-3 shows the internal patchcord Trunk (L2), OCH trunk, OCH filter, and OTS/OCH ports.

Table 17-3 Internal Patchcord Ports

Card Trunk (L2) Port OCH Trunk Ports OCH Filter Ports OTS/OCH Ports

GE_XP

10GE_XP

GE_XPE

10GE_XPE

Trunk port in NNI 
mode

Any trunk port — —

TXPs

MXPs 

ADM-10G

ITU-T line cards

— Any trunk port — —

OPT-BST

OPT-BST-E

OPT-BST-L

— — — COM-TX

COM-RX

OSC-TX

OSC-RX
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17.2   Virtual Patchcords
OPT-AMP-17-C

OPT-AMP-L

— — — COM-TX

COM-RX

OSC-TX1

OSC-RX1

DC-TX1

DC-RX1

OPT-PRE — — — COM-TX

COM-RX

DC-TX

DC-RX

OSCM

OSC-CSM

— — — COM-TX

COM-RX

OSC-TX

OSC-RX

32MUX

32MUX-O 

40-MUX-C

— — Any CHAN RX port COM-TX

32DMX

32DMX-L

32DMX-O

40-DMX-C

40-DMX-CE

— — Any CHAN TX port COM-RX

32WSS

32WSS-L

40-WSS-C

40-WSS-CE

— — Any ADD port COM-TX

COM-RX

EXP-TX

EXP-RX

DROP-TX

40-WXC-C — — — ADD-RX

DROP-TX

COM TX

COM RX

Table 17-3 Internal Patchcord Ports (continued)

Card Trunk (L2) Port OCH Trunk Ports OCH Filter Ports OTS/OCH Ports
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17.2   Virtual Patchcords
PPCs are created and managed from the network view Provisioning > Provisionable Patchcord (PPC) tab 
(Figure 17-3), or from the node view (single-shelf mode) or multiself view (multishelf mode) 
Provisioning > Comm Channel > PPC tab.

Figure 17-3 Network View Provisionable Patchcords Tab

80-WXC-C — — — EAD i, i=1 to 8

AD

COM

COM-RX

DROP-TX

EXP-TX

MMU — — — EXP A TX

EXP A RX

1. When provisioned in OPT-PRE mode.

Table 17-3 Internal Patchcord Ports (continued)

Card Trunk (L2) Port OCH Trunk Ports OCH Filter Ports OTS/OCH Ports
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PPCs are required when the TXP, MXP, GE_XP, 10GE_XP, ADM-10G, or ITU-T line card is installed 
in a different node than the OCH filter ports. They can also be used to create OTS-to-OTS links between 
shelves that do not have OSC connectivity. PPCs are routable and can be used to discover network 
topologies using Open Shortest Path First (OSPF). GCCs and DCCs are not required for PPC creation. 
When you create a PPC, the PPC Creation wizard asks you to choose one of the following PPC types: 

• Client/Trunk to Client/Trunk (L2)—Creates a PPC between two client or trunk ports (in NNI mode) 
on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards provisioned in the L2-over-DWDM mode.

• Client/Trunk to Client/Trunk—Creates a PPC between two client or trunk ports on TXP, MXP, 
GE_XP, 10GE_XP, ADM_10G, or ITU-T line cards.

• Side to Side (OTS)—Creates a PPC between two OTS ports that belong to a Side. This option 
establishes data communications network (DCN) connectivity between nodes that do not have 
OSCM or OSC-CSM cards installed and therefore do not have OSC connectivity. CTC selects the 
OTS ports after you choose the origination and termination sides.

• OCH Trunk to OCH Filter—Creates a PPC between a OCH trunk port on a TXP, MXP, GE_XP, 
10GE_XP, ADM-10G, or ITU-T line card and an OCH filter port on a multiplexer, demultiplexer, 
or wavelength selective switch card.

Table 17-4 shows the PPC Client/Trunk (L2), Client/Trunk, OTS, and OCH Filter ports.

Table 17-4 Provisionable Patchcord Ports

Card
Client/Trunk (L2) 
Port Client/Trunk Port OTS Port OCH Filter Port

GE_XP

10GE_XP

GE_XPE

10GE_XPE

Client or trunk 
port in NNI mode

Any trunk port — —

TXPs

MXPs 

ADM-10G

ITU-T line cards

— Any trunk port — —

OPT-BST

OPT-BST-E

OPT-BST-L

— — COM RX1

LINE RX

LINE TX

—

OPT-AMP-17-C

OPT-AMP-L

— — COM RX2

COM TX3

LINE RX3

LINE TX3

—

OPT-PRE — — COM RX4

COM TX4

—

OSC-CSM — — COM RX1

LINE RX

LINE TX

—
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17.2.1   PPC Provisioning Rules
For related procedure, see NTP-G184 Create a Provisionable Patchcord, page 17-78

17.2.1 PPC Provisioning Rules
For Client/Trunk to Client/Trunk (L2) PPCs, the following provisioning rules and conditions apply:

• The card must be provisioned in the L2-over-DWDM mode.

• The client or trunk ports must be in the NNI mode.

32MUX

32MUX-O 

40-MUX-C

— — — Any CHAN RX 
port

32DMX

32DMX-L

32DMX-O

40-DMX-C

40-DMX-CE

— — — Any CHAN TX 
port

32WSS

32WSS-L

40-WSS-C

40-WSS-CE

— — — Any ADD port

40-WXC-C — — COM RX

COM TX

—

80-WXC-C — — EAD i, i=1 to 8

AD

COM

COM-RX

DROP-TX

EXP-TX

—

40-SMR1-C

40-SMR2-C

— — LINE RX

LINE TX

—

MMU — — EXP A RX

EXP A TX

—

1. Line nodes only.

2. When card mode is OPT-PRE.

3. When card mode is OPT-LINE.

4. Line nodes with two OPT-PRE cards and no BST cards installed.

Table 17-4 Provisionable Patchcord Ports (continued)

Card
Client/Trunk (L2) 
Port Client/Trunk Port OTS Port OCH Filter Port
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17.3   End-to-End SVLAN Circuit
• PPCs can be created only between NNI ports of the same size (1GE-1GE or 10GE-10GE).

• A wavelength check is not performed during L2 trunk-to-trunk patchcord provisioning. The source 
and destination wavelengths of a L2 trunk-to-trunk PPC can be different.

For Client/Trunk to Client/Trunk PPCs, the following provisioning rules and conditions apply:

• Patchcords can be created on preprovisioned or physically installed cards.

• Trunk-to-trunk connections require the same wavelength if the port is equipped. A wavelength check 
is automatically performed during patchcord provisioning.

• For connections involving one or more preprovisioned ports, no compatibility check is performed.

For OCH Trunk to OCH Filter PPCs, the following provisioning rules and conditions apply:

• GCC and DCC links are not required to create a PPC.

• PPCs can be created for preprovisioned or physically installed cards.

• OCH trunk and OCH filter ports must be on the same wavelength. CTC checks the ports for 
wavelength compatibility automatically during PPC provisioning. 

• For OC-48/STM-16 and OC-192/STM-64 ITU-T line cards, the wavelength compatibility check is 
performed only when the cards are installed. The check is not performed for preprovisioned cards. 

• For all other preprovisioned cards, a wavelength compatibility check is not performed if card is set 
to first tunable wavelength. The wavelength is automatically provisioned on the port, according to 
the add/drop port that you chose when you created the PPC.

For related procedures, see NTP-G200 Create, Delete, and Manage STS or VC Circuits for the 
ADM-10G Card, page 17-55

17.3 End-to-End SVLAN Circuit
An end-to-end SVLAN circuit can be created between GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE 
cards through a wizard in CTC. SVLAN circuits created this way are only a snapshot of the SVLAN 
settings (NNI and QinQ) of each card in the network. If an end-to-end SVLAN circuit is created via CTC 
and the SVLAN settings of the cards are changed manually, CTC does not update the SVLAN circuit 
created with the new settings. To update the SVLAN circuit in CTC, the circuit must be refreshed.

However, any changes made to subtended OCH trail circuits are reflected in the SVLAN circuit in CTC. 
If an OCH trail becomes incomplete and the current SVLAN circuit snapshot has some SVLAN circuits 
that are using it, they remain incomplete. If the snapshot contains incomplete SVLAN circuits and an 
OCH trail circuit becomes available, the incomplete SVLAN circuit snapshot in CTC appears to be 
complete.

When the destination port of the SVLAN circuit facing the router is configured as a NNI client port, the 
outgoing ethernet packets do not drop the SVLAN tag when they exit the MSTP network allowing the 
router to determine the origin of the ethernet packet.

SVLAN circuits are stateless circuits; an administrative or service state need not be set.

Note During SVLAN provisioning, if a SVLAN circuit span using UNI ports in transparent mode is over 
subscribed, a warning message is displayed. However, the circuit is created. This is supported on channel 
groups on GE_XP, 10GE_XP, GE_XPE, or 10GE_XPE cards. 

For related procedure, see:
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• NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card SVLAN Databases, 
page 17-84

• NTP-G203 Create End-to-End SVLAN Circuits, page 17-96

17.3.1 End-to-End SVLAN Provisioning Rules
The following provisioning rules and conditions apply to end-to-end SVLAN circuits:

• GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards must be provisioned in L2-over-DWDM mode.

• SVLAN database must be loaded with the SVLAN.

• SVLAN circuits are routed through OCH trail circuits or PPC; Client/Trunk to Client/Trunk (L2). 
Therefore, before creating an SVLAN circuit, make sure that the subtended OCH trail circuits 
between GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards or PPC links are created.

• For protected SVLAN circuits, create a ring (through OCH trail circuits), define a master node, and 
enable the protection role.

For information on how to create end-to-end SVLAN circuit, see the “NTP-G203 Create End-to-End 
SVLAN Circuits” section on page 17-96 procedure.

17.3.2 Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary.

Note The procedures and tasks described in this section for the Cisco ONS 15454 platform is applicable to the 
Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.

This section lists the procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G151 Create, Delete, and Manage Optical Channel Client Connections, 
page 17-15—Complete as needed.

2. NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-34—Complete as needed.

3. NTP-G59 Create, Delete, and Manage Optical Channel Network Connections, 
page 17-41—Complete as needed.

4. NTP-G334 Configure GMPLS Optical Restoration—Complete as needed.

5. NTP-G200 Create, Delete, and Manage STS or VC Circuits for the ADM-10G Card, 
page 17-55—Complete as needed.

6. NTP-G150 Upgrade Optical Channel Network Connections to Optical Channel Client Connections, 
page 17-65—Complete as needed.

7. NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits, page 17-69—Complete as needed to 
verify all conditions are valid before placing OCHNC or OCH trail circuits in service.

8. NTP-G58 Locate and View Optical Channel Circuits, page 17-71—Complete as needed to find, 
view, and filter OCHCC, OCHNC, and OCH trail circuits.

9. NTP-G184 Create a Provisionable Patchcord, page 17-78—Complete as needed.

10. NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card SVLAN Databases, 
page 17-84—Complete as needed.
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11. NTP-G60 Create and Delete Overhead Circuits, page 17-87—Complete as needed to create 
IP-encapsulated tunnels, firewall tunnels, and proxy tunnels; to create generic communications 
channel (GCC) terminations; to provision orderwire; or to create user data channel (UDC) circuits.

12. NTP-G62 Create a J0 Section Trace, page 17-95—Complete as needed to monitor interruptions or 
changes to traffic between two nodes.

13. NTP-G203 Create End-to-End SVLAN Circuits, page 17-96—Complete as needed to create end to 
end VLAN circuits.

14. NTP-G229 Provision DCN Extension for a Network Using GCC/DCC, page 17-99—Complete as 
needed to provision DCN extension for a network using GCC/DCC.

NTP-G151 Create, Delete, and Manage Optical Channel Client 
Connections

Note This procedure is not applicable to the ADM-10G card or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards that are provisioned in L2-over-DWDM mode.

Step 1 As needed, identify the OCHCC to be provisioned using the “DLP-G350 Use the Cisco Transport 
Planner Traffic Matrix Report” task on page 16-27.

Step 2 Complete the DLP-G46 Log into CTC at a node on the network where you want to manage OCHCCs. If 
you are already logged in, continue with Step 3.

Step 3 If you want to assign a name to the OCHCC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with Step 4.

Tip Naming the client ports help in identifying them correctly later.

Purpose This procedure creates, deletes, and manages OCHCC circuits. The 
OCHCC circuits can be created using the Circuit Creation wizard or the 
GMPLS view. OCHCCs create an end-to-end optical management path 
between TXP, MXP, GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE (when 
provisioned as TXPs or MXPs), OTU2_XP, 100G-LC-C, 10x10G-LC, 
CFP-LC, AR_MXP, AR_XP, or AR_XPE client ports, or between ITU-T 
trunk ports. ITU-T line cards include: OC48 ELR/STM64 EH, OC192 
SR1/STM64 IO, MRC-12, MRC-2.5-12, and MRC-2.5G-4. The OCHCC 
circuit is transported by an OCH trail circuit that is associated to one or 
more OCHNC circuits (for example, an OCHCC circuit passing through a 
regen node). 

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 If the client TXP, MXP, or ITU-T line cards are installed in a multishelf node, continue with Step 5. If 
not, complete the following substeps:

a. Use the information obtained from the Cisco Transport Planner traffic matrix report in Step 1 to 
complete the “DLP-G344 Verify Provisionable and Internal Patchcords” task on page 17-68. If 
provisionable patchcords (PPCs) exist between the nodes containing the TXP/MXP/ITU-T line 
cards and the DWDM nodes at each end of the OCHCC, continue with Step 5. If not, continue with 
Step b.

b. Complete the “NTP-G184 Create a Provisionable Patchcord” task on page 17-78 to create the PPCs 
between the OCHCC source and destination nodes. 

Note For the AR_XPE card, you can specify the ODU0 and ODU1 trunk side bandwidth when a 1GE or 1GFC 
payload is configured on the card.

Step 5 If the client TXP/MXP/ITU-T line cards are installed in a multishelf node, use the information obtained 
from the Cisco Transport Planner traffic matrix report in Step 1 to create internal patchcords between 
the 32DMX, 32DMX-O, or 32DMX-L ports and the TXP/MXP trunk ports using the “NTP-G242 Create 
an Internal Patchcord Manually” task on page 14-112. Create the internal patchcords on both the source 
and destination nodes of each OCHCC path. If the TXP/MXP/ITU-T line cards are not installed in a 
multishelf node, continue with Step 6.

Step 6 Complete the “DLP-G345 Verify OCHCC Client Ports” task on page 17-17 to verify the port rate and 
service state.

Step 7 To provision the OCHCC circuit, use either of the following procedures as needed:

• “DLP-G346 Provision Optical Channel Client Connections” task on page 17-18

• “DLP-G705 Provision GMPLS Optical Channel Client Connections” task on page 17-25

Step 8 Complete the “DLP-G706 Perform Optical Validation of GMPLS Circuits” task on page 17-32, as 
needed.

Step 9 Complete the “DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit” task on page 17-33, as 
needed.

Step 10 Complete the “DLP-G424 Edit an OCHCC Circuit Name” task on page 17-28, as needed.

Step 11 Complete the “DLP-G394 Change an OCHCC Administrative State” task on page 17-29, as needed.

Step 12 Complete the “DLP-G347 Delete Optical Channel Client Connections” task on page 17-26, as needed.

Stop. You have completed this procedure.

DLP-G104 Assign a Name to a Port

Purpose This task assigns a name to a port on any ONS 15454 card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the card that has the port that you want to provision. This can be any port on 
a traffic-carrying card. The card view opens.

Step 2 Click the Provisioning tab.

Step 3 Double-click the Port Name table cell for the port number where you are assigning a name. The cell 
activates and a blinking cursor indicates where you should enter the port name.

Step 4 Enter the port name. 

The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G345 Verify OCHCC Client Ports

Step 1 In node view, double-click the TXP, MXP, OTU2_XP, AR_MXP, AR_XP, AR_XPE, or ITU-T line card 
where you want to verify the client ports. The card view opens. 

Step 2 Click the Provisioning > Maintenance tabs.

Step 3 Click the Provisioning > Pluggable Port Modules tabs.

Step 4 Verify that a pluggable port module has been created and that the port rate under the Pluggable Port area 
is provisioned. If so, continue with Step 5. If not, complete the DLP-G726 Preprovisioning a Multirate 
PPM and the “DLP-G278 Provision the Optical Line Rate” task on page 11-175.

Step 5 Repeat Steps 1 through 4 for each TXP, MXP, OTU2_XP, AR_MXP, AR_XP, AR_XPE, or ITU-T line 
card containing OCHCC ports that you want to verify.

Step 6 Return to your originating procedure (NTP).

Purpose This task verifies the rate and service state of the OCHCC client ports.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G346 Provision Optical Channel Client Connections

Note OCHCCs can be created on preprovisioned client cards or physically installed client cards.

Note Creating an OCHCC circuit automatically creates an OCH trail circuit between the OCHCC source and 
destination client card trunk ports. The OCH trail circuit is created for the first OCHCC between two 
MXP cards. The OCH trail circuit is used by succeeding OCHCCs created between the MXP cards. 
When the OCH trail is created, it is assigned a system-generated name in the format 
circuit-type_NE-name::unique sequence number. To edit the OCH trail circuit name, complete the 
“DLP-G424 Edit an OCHCC Circuit Name” task on page 17-28.

Note If trunk ports are connected by a peer-to-peer provisionable patchcord (PPC), an OCH trail is not created.

Note The OCH Wlen (wavelength) parameter on the Circuits page can be used to determine the OCHCC and 
OCH trail associations.

Note If you want the OCHCC circuit to provision the client card trunk port’s ITU-T G.709, FEC, SD and SF 
threshold settings and Mapping parameters, you must place the client card trunk ports out of service. If 
any of the trunk ports, including OTU2-XP regen ports, are in-service state, a warning message “Trunk 
settings are not applied on any of the trunk ports” is displayed with details of the trunk ports that are in 
in-service state.

Note In a node using OTU2_XP cards configured in the regen mode, a single OCHCC circuit can be created 
that passes through the OTU2_XP card. Internal patch cords must be created from the OTU2_XP regen 
ports to the respective add/drop cards. OCHCC circuit creation through OTU2_XP cards in regen mode 
is not supported if different wavelengths are used on the two OTU2_XP regen ports.

Purpose This task creates an OCHCC between two TXP, MXP, GE_XP and 
GE_XPE (when configured in TXP or MXP mode), 10GE_XP and 
10GE_XPE (when configured in TXP or MXP mode), OTU2_XP, 
AR_MXP, AR_XP, or AR_XPE client ports, or two ITU-T-compliant line 
card trunk ports. 

Tools/Equipment Cisco Transport Planner Traffic Matrix Report

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G345 Verify OCHCC Client Ports, page 17-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The OCHCC circuit creation is not supported between different payloads in the 40G-MXP-C, 
40E-MXP-C, and 40ME-MXP-C cards.

Note The 40G-MXP-C card configured in the unidirectional regen mode does not support OCHCC circuit 
creation. Two bidirectional OCHNC circuits can be created, one on either side of the regenerator group 
for managing the circuit.

Note In AR_MXP, AR_XP, and AR_XPE cards, you cannot create the circuits using FICON payload option 
in Circuit Creation wizard. Create circuits using FC payload to bring up FICON traffic.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHCC from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCHCC circuit attributes:

• Name—Assign a name to the OCHCC. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor 
circuits. If you leave the field blank, Cisco Transport Controller (CTC) assigns a default name to the 
circuit. When a circuit includes a network element with release prior to 9.60, the circuit name is 
limited to 48 characters.

• Type—(Display only) OCHCC.

• Size—Defines the circuit payload type and rate. Two fields are provided. The first specifies the 
payload type. Choose a payload type, then choose the rate in the next field. Table 17-5 provides the 
OCHCC payload types and rates.

Note The payload type and rate must match the PPM provisioning on the client cards at the source 
and destination nodes. 

Table 17-5 OCHCC Client Rates

Payload Type Rates

SONET/SDH OC-192 (ANSI)/STM-64 (ETSI)—9.92 Gbps

OC-48 (ANSI)/STM-12 (ETSI)—2.48 Gbps

OC-12 (ANSI)/STM-4 (ETSI)—622 Mbps

OC-3 (ANSI)/STM-1 (ETSI)—155 Mbps

Ethernet 10GE—One Gigabit Ethernet 11.25 Gbps

1GE—One Gigabit Ethernet 1.125 Gbps
17-19
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 17      Create Optical Channel Circuits and Provisionable Patchcords
DLP-  G346 Provision Optical Channel Client Connections
• OCHNC Wavelength—Provides three fields to define the wavelength that the OCHCC will use to 
travel across the OCH network. Choose a wavelength from the first field. In the second field, you 
can change the wavelength band by choosing either C Band or L Band. In the third field, you can 
indicate whether odd or even C-band or L-band wavelengths appear. See Table 17-6 and Table 17-7 
for C-band and L-band wavelengths.

Note The OCHNC wavelength must match the trunk wavelength provisioned on the source and 
destination TXP or MXP cards. If the wavelengths do not match, the card will not appear as 
a source or destination.

FC/FICON 10GFC—Fibre Channel 10 Gbps 

4GFC—Fibre Channel 4 Gbps 

2GFC—Fibre Channel 2.125 Gbps

1GFC—Fibre Channel 1.06 Gbps

4GFICON—FICON 4 Gbps 

2GFICON—FICON 2.125 Gbps 

1GFICON—FICON 1.06 Gbps 

Data Storage ESCON—Enterprise System Connection 200 Mbps (IBM signal)

ISC Peer—Inter System Coupling Link 3 (ISC3)

ISC3 Peer 1G—InterSystem Coupling Link 3 (ISC3) 1 Gbps

ISC3 Peer 2G—InterSystem Coupling Link 3 (ISC3) 2 Gbps

ISC COMPAT—InterSystem Coupling Link 1 (ISC1)

ISC1—Inter system connect Link 1 (ISC1)

Video HDTV—High Definition Television

SDI/DI—Serial Digital Interface and Digital Video signal type 1

DV6000—Proprietary signal from video vendor

DVB-ASI—Proprietary signal from video vendor

Other Pass Through—Creates a pass-through OCHCC

Table 17-5 OCHCC Client Rates (continued)

Payload Type Rates

Table 17-6 OCH C-Band Channels

Channel No. Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.1 195.8 1531.12

3 31.9 195.7 1531.90

4 33.4 195.5 1532.68

5 32.6 195.6 1533.471

6 34.2 195.4 1534.25
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7 35.0 195.3 1535.04

8 35.8 195.2 1535.82

9 36.1 195.1 1536.61

10 37.4 195 1537.401

11 38.1 194.9 1538.19

12 38.9 194.8 1538.98

13 39.7 194.7 1539.77

14 40.5 194.6 1540.56

15 41.3 194.5 1541.351

16 42.1 194.4 1542.14

17 42.9 194.3 1542.94

18 43.7 194.2 1543.73

19 44.5 194.1 1544.53

20 44.3 194 1545.321

21 46.1 193.9 1546.12

22 46.9 193.8 1546.92

23 47.7 193.7 1547.72

24 48.5 193.6 1548.51

25 49.3 193.5 1549.321

26 50.1 193.4 1550.12

27 50.9 193.3 1550.92

28 51.7 193.2 1551.72

29 52.5 193.1 1552.52

30 53.3 193 1553.331

31 54.1 192.9 1554.13

32 54.9 192.8 1544.94

33 55.7 192.7 1555.75

34 56.5 192.6 1556.55

35 57.3 192.5 1557.361

36 58.1 192.4 1558.17

37 58.9 192.3 1558.98

38 59.7 192.2 1559.79

39 60.6 192.1 1560.61

40 61.3 192 1561.421

1. Requires 40-channel MUX or WSS cards, and 40-channel DMX cards.

Table 17-6 OCH C-Band Channels (continued)

Channel No. Channel ID Frequency (GHz) Wavelength (nm)
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Table 17-7 OCH L-Band Channels

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

1 190.85 1570.83 41 188.85 1587.46

2 190.8 1571.24 42 188.8 1587.88

3 190.75 1571.65 43 188.75 1588.30

4 190.7 1572.06 44 188.7 1588.73

5 190.65 1572.48 45 188.65 1589.15

6 190.6 1572.89 46 188.6 1589.57

7 190.55 1573.30 47 188.55 1589.99

8 190.5 1573.71 48 188.5 1590.41

9 190.45 1574.13 49 188.45 1590.83

10 190.4 1574.54 50 188.4 1591.26

11 190.35 1574.95 51 188.35 1591.68

12 190.3 1575.37 52 188.3 1592.10

13 190.25 1575.78 53 188.25 1592.52

14 190.2 1576.20 54 188.2 1592.95

15 190.15 1576.61 55 188.15 1593.37

16 190.1 1577.03 56 188.1 1593.79

17 190.05 1577.44 57 188.05 1594.22

18 190 1577.86 58 188 1594.64

19 189.95 1578.27 59 187.95 1595.06

20 189.9 1578.69 60 187.9 1595.49

21 189.85 1579.10 61 187.85 1595.91

22 189.8 1579.52 62 187.8 1596.34

23 189.75 1579.93 63 187.75 1596.76

24 189.7 1580.35 64 187.7 1597.19

25 189.65 1580.77 65 187.65 1597.62

26 189.6 1581.18 66 187.6 1598.04

27 189.55 1581.60 67 187.55 1598.47

28 189.5 1582.02 68 187.5 1598.89

29 189.45 1582.44 69 187.45 1599.32

30 189.4 1582.85 70 187.4 1599.75

31 189.35 1583.27 71 187.35 1600.17

32 189.3 1583.69 72 187.3 1600.60

33 189.25 1584.11 73 187.25 1601.03

34 189.2 1584.53 74 187.2 1601.46

35 189.15 1584.95 75 187.15 1601.88
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• Bidirectional—(Display only) OCHCCs are bidirectional. This field cannot be changed.

• Protection—Check to create a splitter-protected OCHCC (only MXPP/TXPP cards will be 
selectable as circuit endpoints) or a protected OCHCC when TXP is connected to a PSM card.

Step 6 In the State area of the Circuit Attributes page, provision the OCHCC state attributes:

• State—Provisions the OCHCC circuit state. The state can be IS (ANSI)/Unlocked (ETSI) or 
OOS,DSBLD (ANSI)/Locked,Disabled (ETSI). 

• Apply to OCHCC ports—If checked, applies the state chosen in the Apply to OCHCC ports 
drop-down list to the OCHCC client ports. For TXP, MXP, TXPP, or MXPP cards, the administrative 
state will apply to the client and all trunk ports. For ITU-T-compliant line cards, the administrative 
state will apply to the trunk port only. The states that you can apply include: 
IS (ANSI)/Unlocked (ETSI), OOS,DSBLD (ANSI)/Locked,Disabled (ETSI), and 
IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI).

Step 7 Click Next. 

Step 8 In the Source area, choose the source node from the Node drop-down list, then choose the source shelf 
(multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, and, 
if needed, the source port from the Port drop-down list. 

If no nodes appear in the Node drop-down list, complete the following steps: 

a. Click Back and review your circuit attribute settings. Verify that they are set to the client attributes 
provisioned on the client cards. If necessary, click Cancel and complete the “DLP-G345 Verify 
OCHCC Client Ports” task on page 17-17 to verify the client settings.

b. If the source and/or destination nodes are not configured for multishelf, complete the “DLP-G344 
Verify Provisionable and Internal Patchcords” task on page 17-68 to verify that the patchcords were 
created accurately.

If these steps do not solve the problem, refer to your next level of support.

Step 9 Click Next. 

Step 10 In the Destination area, choose the destination node from the Node drop-down list, then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from the Port drop-down list. 

If no nodes appear in the Node drop-down list, complete the following steps: 

a. Click Back and review your circuit attribute settings. Verify that they are set to the client attributes 
provisioned on the client cards. If necessary, click Cancel and complete the “DLP-G345 Verify 
OCHCC Client Ports” task on page 17-17 to verify the client settings.

36 189.1 1585.36 76 187.1 1602.31

37 189.05 1585.78 77 187.05 1602.74

38 189 1586.20 78 187 1603.17

39 188.95 1586.62 79 186.95 1603.60

40 188.9 1587.04 80 186.9 1604.03

Table 17-7 OCH L-Band Channels (continued)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)

Channel 
Number

Frequency 
(THz)

Wavelength 
(nm)
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b. If the source and/or destination nodes are not configured for multishelf, complete the “DLP-G344 
Verify Provisionable and Internal Patchcords” task on page 17-68 to verify that the patchcords were 
created accurately.

If these steps do not solve the problem, refer to your next level of support.

Step 11 Click Next. If the OCHCC is between ITU-T cards, continue with Step 12. If not, skip to Step 14.

Step 12 Complete the “DLP-G437 Set OCH Circuit Attributes” task on page 17-29.

Step 13 Click Next. 

Step 14 Complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31. Skip this step and 
continue with Step 16 if no constraints are needed. If the trunk ports are already connected by an existing 
OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in 
read-only mode; all buttons are disabled. Continue with Step 16.

Step 15 If the circuit is being created for AR_MXP, AR_XP, or AR_XPE card with MXP_MR (low or high rate) 
or MXPP_MR (low or high rate) operating mode, select the ODU1 and the respective timeslot within the 
selected ODU1. Table 17-8 describes the bandwidth utilization for the selected payload.

Note For the all other cards/card modes, you cannot select the ODU1 and timeslot parameters.

Step 16 Click Finish. The OCHCC and its OCH trail appear in the Circuits page. After the circuit status has been 
verified, the DISCOVERED status appears in the Status column.

If the OCHCC status does not change to DISCOVERED within 2 to 3 minutes, contact your next level 
of support.

Step 17 Return to your originating procedure (NTP).

Table 17-8 Bandwidth Utilization for the Selected Payload

Payload
Number of ODU1s 
required

Number of ODU0s 
required

Number of 
Timeslot 
required/ODU1

OC3

FE

1 — 1

OC12 1 — 4

OC48 1 — 16

FC2

ISC3-2G

1 — 14

ESCON 1 — 2

GE

FC1

ISC3-1G

1 1

1

—

NA

NA

FC4G 2 — NA
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DLP-G705 Provision GMPLS Optical Channel Client Connections

Note You cannot directly create the GMPLS OCHCC circuit on the 100G-LC-C, 10x10G-LC, and CFP-LC 
cards when configured in MXP-10x10G (10x10G Muxponder) card mode or with AR-XP cards. There 
are two ways to create the GMPLS OCHCC circuit: 

• Create the GMPLS OCH trail and then create the OCHCC circuit. 

• Create the OCHCC circuit and then upgrade the circuit to GMPLS OCHCC circuit.

Note You cannot create GMPLS OCHCC circuit on the AR_XP, AR_MXP, and AR_XPE cards directly from 
the NFV view.

Step 1 From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV view 
opens.

Step 2 From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 3 In the Circuit Parameters pane, provision the OCHCC circuit attributes:

a. Name—Assign a name to the circuit. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). When a circuit includes a network element with release prior to 9.60, the circuit name is 
limited to 48 characters.

b. Type—Choose OCHCC.

c. Protected—Check to route the circuit on a protected path. Select the protection type from the 
drop-down list. The available options are:

– PSM—When a PSM card is connected to a TXP card.

– Y-CABLE—The circuit is protected by a transponder or muxponder card in a Y-cable protection 
group.

– Splitter—When a MXPP/TXPP card is used. The circuit source and destination are on 
MXPP_MR_2.5G and TXPP_MR_2.5G cards. These cards provides splitter (line-level) 
protection.

d. IS—Check to place the trunk ports of the TXP /MXP card in service.

Purpose This task creates an OCHCC circuit between two TXP, MXP, GE_XP and 
GE_XPE (when configured in TXP or MXP mode), 10GE_XP and 
10GE_XPE (when configured in TXP or MXP mode), or OTU2_XP client 
ports, or two ITU-T-compliant line card trunk ports. 

Tools/Equipment Cisco Transport Planner Traffic Matrix Report

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G345 Verify OCHCC Client Ports, page 17-17

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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e. OCHNC Wavelength—Provides three fields to define the wavelength for the OCHCC circuit. 
Choose a wavelength from the first field. The wavelength band in the second field is set to C Band. 
In the third field, indicate whether odd or even C-band wavelengths appear. Table 17-6 lists the 
C-band wavelengths.

f. Protected OCHNC Wavelength—Define the wavelength of the protected OCHCC circuit. This field 
is visible only when the Protected check box is checked in Step c. The options available are similar 
to that of OCHNC Wavelength. 

g. Validation—Set the validation mode. For more information about the validation modes, see the 
“12.10.1.3 Validation Modes” section on page 12-110.

h. Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit 
is created if the actual optical validation result is greater than or equal to the value set in this field. 
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance 
Thresholds” section on page 12-110.

i. Protection Acceptance Threshold—Sets the optical validation threshold value for the protected 
GMPLS circuit.

Step 4 Configure the source and destination ports at the circuit endpoints in the map. For more information 
about configuring the source and destination ports, see the “12.10.3.3 Source and Destination Port 
Configuration” section on page 12-119.

Note The OCHCC circuit endpoints must be selected on the TXP/MXP cards. If other ports are 
selected, a warning dialog box is displayed prompting you to change the circuit type.

Step 5 Define the working or protect port parameters. For more information, see the “12.10.3.3.1 Working and 
Protect Port Parameters” section on page 12-120. Click Apply in the Working Port Parameters pane and 
Protected Port Parameters pane, to apply the settings.

Step 6 Click Apply in the Circuit Parameters pane.

Step 7 Click Yes in the Create Circuits confirmation dialog box.
The OCHCC and its OCH trail appear in the Circuits tab in the Network Data pane. After the circuit 
status has been verified, the DISCOVERED status appears in the Status column. The circuit might take 
a few minutes to come up, depending on the size of the network.

Step 8 Return to your originating procedure (NTP).

DLP-G347 Delete Optical Channel Client Connections

Purpose This task deletes DWDM OCHCC circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note If you are deleting more than half of all the active OCHCCs, it is recommended that you delete them two 
at a time to allow for proper power compensation. You do not need to delete the active OCHCCs two at 
a time if you are deleting all them.

Step 1 Complete the “NTP-G103 Back Up the Database” task on page 24-2 to preserve existing settings and, if 
you want to recreate the circuits, record the circuit information.

Step 2 Consult your network operations center (NOC) or other appropriate personnel to verify that the OCHCC 
can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCHCC deletion. 

Step 4 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 5 Under the Type column, choose one or more OCHCCs that you want to delete, then click Delete.

Step 6 In the Delete Circuits confirmation dialog box, complete the following: 

• Change drop port admin state—Check this box if you want to change the circuit source and 
destination port administrative state. After checking the box, choose one of the following 
administrative states: 

– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.

– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in 
service.

– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and 
disables them.

– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for 
maintenance.

• Notify when completed—Checked this box if you want the CTC Alerts confirmation dialog box to 
notify you when the OCHCC is deleted. During this time, you cannot perform other CTC functions. 
If you are deleting many OCHCCs, waiting for confirmation might take a few minutes. Circuits are 
deleted whether or not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, 
see the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC 
Alerts dialog box is not set to open automatically, the red triangle inside the CTC Alerts 
toolbar icon indicates that a notification exists. 

Step 7 (For AR_MXP, AR_XP, and AR_XPE cards) An OCHCC circuit cannot be deleted when the associated 
client port on the card is in IS (ANSI) or Unlocked (ETSI) state. To delete an OCHCC circuit, move the 
associated client port to OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state and then delete the 
OCHCC circuit.

Step 8 Complete either of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.
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Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following substeps. If 
you do not want to save it, continue with Step 10.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a TXT file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” task on page 24-2 if you require a backup of your 
changes.

Step 12 Return to your originating procedure (NTP).

DLP-G424 Edit an OCHCC Circuit Name

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 To rename the OCHCC circuit, do either of the following.

• Network view—Select the OCHCC circuit in the Circuits tab and click Edit. 

• NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3 In the Edit Circuit dialog box, click the General tab.

Step 4 In the Name field, enter the new OCHCC circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes the name of an OCHCC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G394 Change an OCHCC Administrative State

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 To change the administrative state of the OCHCC circuit, do either of the following.

• Network view—Select the OCHCC circuit in the Circuits tab and click Edit. 

• NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3 In the Edit Circuit dialog box, click the State tab.

Step 4 Click the cell in the Admin State column for the card you want to change, and choose an administrative 
state from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)

• OOS (ANSI) or Locked (ETSI)

Step 5 Click Apply.

Step 6 If you are changing the OCHCC state to OOS/Locked, click OK in the confirmation dialog box. (No 
confirmation dialog box appears when placing OCHCCs in service.)

Note For information about the OCH circuit state transitions, see the Administrative and Service States 
document.

Step 7 Return to your originating procedure (NTP). 

DLP-G437 Set OCH Circuit Attributes

Purpose This task changes the administrative state of an OCHCC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G346 Provision Optical Channel Client Connections, page 17-18

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task provisions OCH trunk attributes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

The OCH Circuit Attributes page must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In the OCH Circuit Attributes Preferences page, change the trunk settings as necessary. The settings 
provisioned here can only be provisioned on the ports when the ports are out of service. If the ports are 
in service, these parameters must be the same as the source and destination card ports. If not, the trunk 
settings are not editable and are retained as they are on both the trunk ports. An information pop up 
window is shown after the circuit creation indicating that the trunk settings are not applied on any of the 
trunk ports. You can view the current trunk settings (display only) in the Current Values area. 

• To change any of the trunk settings, complete the following in the Provisioning Values area:

– ITU-T G.709 OTN—Choose Enable or Disable to set or disable the IEEE G.709 monitoring on 
the optical transport network. If the OCHCC source or destination is an TXP_MR_10EX_C, 
40E-TXP-C, 40ME-TXP-C, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, 
MXP_2.5G_10EX_C, MXP_MR_10DMEX_C, 40G-MXP-C, 40E-MXP-C, or 40ME-MXP-C 
card, the ITU-T G.709 OTN parameter must always be checked. If ITU-T G.709 OTN is 
checked, the MXP_MR_2.5G and MXPP_MR_2.5G cards will not appear as OCHCC source 
and destination options.

– FEC—Choose the type of FEC: Disabled, Standard, or Enhanced. The options that appear 
depend on the card type. If the OCHCC source or destination is an TXP_MR_10EX_C, 
MXP_2.5G_10EX_C, MXP_MR_10DMEX_C, 40G-MXP-C, 40E-MXP-C, 40ME-MXP-C, 
40E-TXP-C, or 40ME-TXP-C card, the ITU-T G.709 OTN parameter must always be checked.

– SD BER—Choose the signal degrade bit error rate. The range of SD BER values supported for 
Cisco 7600 router is from 5 to 9.

– (Cisco 7600 series routers only) OPU—Choose the ITU-T G.709 OPU standard. OPU-1E and 
OPU-2E standards are supported on the Cisco 7600 series routers.

– SF BER—Choose the signal fail bit error rate.

– Mapping—Sets the mapping for the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, 
TXP_MR_10EX_C, MXP_MR_10DME_C, MXP_MR_DME_L, and MXP_MR_10DMEX_C 
cards: Not Used, ODU Multiplex (client SONET/SDH payload), Asynchronous, or 
Synchronous. The choices available depend on the card. If you set mapping to Synchronous, 
the client signal is mapped into the OTU2 signal without justification of the payload because 
the client signal timing (the timing source) is the same as the trunk output timing. If you set 
mapping to Asynchronous, the trunk timing is disconnected from the client timing (because the 
network element [NE] is the timing source), so justification is needed to map the client signal 
(OC192/STM64) to OTU2 trunk output.

Note When you create a 4xOC-48 OCHCC circuit, you need to select the G.709 and Synchronous 
options. A 4xOC-48 OCHCC circuit is supported by G.709 and synchronous mode. This is 
necessary to provision a 4xOC-48 OCHCC circuit.

Note If the OCHCC source or destination is an MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, or MXP_2.5G_10EX_C card, the Mapping parameter must always be set to 
Synch.

Set the proactive protection attributes. Proactive Protection Regen is supported on OTU2XP ports alone 
in Standard Regen and Enhanced FEC mode

Note Proactive protection regen is supported only on CRS-based OCH trails.
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• Proactive Protection—Choose Enable or Disable.

• Trigger Threshold—Choose the minimum BER threshold to trigger proactive protection by sending 
forward defect indication (FDI).

• Trigger Window—The trigger window value must be in multiples of 10 ms for trigger thresholds 
between 1E-3 and 6E-6 or 100 ms for trigger threshold between 5E-6 to 1E-7. Enter the duration to 
monitor the BER before triggering the proactive protection. The trigger window must be less than 
or equal to 10000 ms. 

• Revert Threshold—Choose a BER value, to indicate the threshold at which the FDI is cleared to 
allow traffic.

• Revert Window—Enter the duration to monitor the BER for which it should be less than the revert 
threshold value before removing the FDI sent to the router.
The revert window must be less than or equal to 10000ms. The revert window value must be at least 
2000ms and in multiples of 10ms for a Revert Threshold of 1E-4 to 6E-7, or 100ms for a Revert 
Threshold of 5E-7 to 5E-8.

• Set the protection in the Protection area, as needed. The fields in the protection area are disabled if 
the OCHCC is not protected and for OCH Trails. Set the following attributes:

– Revertive—If checked, traffic reverts to the working card after failure conditions remain 
corrected for the amount of time entered in the Reversion Time field. 

– Reversion Time—Sets the reversion time when Revertive is checked. The range is 0.5 to 12.0 
minutes. The default is 5.0 minutes. Reversion time is the amount of time that will elapse before 
the traffic reverts to the working card after conditions causing the switch are cleared. 

Step 2 Return to your originating procedure (NTP).

DLP-G438 Set OCH Routing Preferences

Step 1 In the OCH Circuit Routing Preferences page, view the circuit route. The new OCH appears with blue 
span arrows. Moving your cursor over the arrow displays span information including source, destination, 
and span loss. Complete the following steps to manually provision the routing constraints.

a. In the circuit map area, click a node that you want to include or exclude from the circuit route.

b. Click Include or Exclude. The node name will appear under the Included nodes or Excluded nodes 
list. Include and Exclude cannot be applied to source or destination nodes.

c. Repeat Steps a and b until the circuit routing constraints are complete. To remove a node from the 
Included nodes or Excluded nodes list, click the node in the list and click Remove. To move a node 
up or down in the routing sequence, click the node in the list and click Up or Down.

Purpose This task provisions OCH routing preferences.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

The OCH Circuit Routing Preferences page must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
17-31
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 17      Create Optical Channel Circuits and Provisionable Patchcords
DLP-  G706 Perform Optical Validation of GMPLS Circuits
Note Use the Reset button as needed to clear the constraints and set the default routing.

d. To force the circuit route through specific links, click Advanced. Select the sides where the circuit 
must cross this node and click OK:

– No Side Constraints—Uncheck. 

– Side In—Choose the first side from the drop-down list.

– Side Out—Choose the second side from the drop-down list.

Note All forced links appear in yellow.

e. Click Apply. CTC verifies the circuit route. If the route is valid, a “Routing evaluation succeeded.” 
message appears. If this message appears, click OK. If the route is not valid, a Route Error dialog 
box appears with an error message. If an error message appears, evaluate the error, click Close to 
close the error dialog box and repeat Steps a through e until the circuit route is successfully 
validated.

f. If the OCHCC is protected, repeat Steps a through e for the protect trunk ports.

Step 2 Return to your originating procedure (NTP).

DLP-G706 Perform Optical Validation of GMPLS Circuits

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 Select the GMPLS circuit to be re-validated and click Opt Val. The optical validation is performed and 
its result is displayed in a pop-up window.

Step 3 Return to your originating procedure (NTP).

Purpose This task performs revalidation of a GMPLS circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit

Step 1 If the non-GMPLS circuit was provisioned in a release older than R9.40, ensure that fiber attributes are 
available in the Provisioning > WDM-ANS -> GMPLS/WSON -> Fiber Attributes tab. For more 
information about the Fiber Attributes tab, see the “12.10.3.5 Fiber Attributes and Alien Wavelength 
Provisioning” section on page 12-121.

If the Fiber Attributes tab is empty, import the latest Cisco Transport Planner NE Update configuration 
file as described in the “NTP-G143 Import the Cisco Transport Planner NE Update Configuration File” 
task on page 14-48.

Step 2 Define the Alien Wavelength parameters in the Provisioning > WDM-ANS -> GMPLS/WSON -> 
Alien Wavelength tab if one of the following conditions exist. If not, continue with Step 3.

• In the non-GMPLS circuit, the TXP or MXP or ITU-T line cards are connected to the add/drop 
DWDM ports with provisionable patchcords (PPCs).

• No internal patchcords exist between the TXP/MXP and the add/drop DWDM ports (for example, 
in the case of a CRS connected to the add/drop DWDM ports). 

For more information about the Alien Wavelength tab, see the “12.10.3.5 Fiber Attributes and Alien 
Wavelength Provisioning” section on page 12-121.

Step 3 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 4 Select the circuit to be upgraded and click WSON Upgrade. 

Note The WSON Upgrade option is available only when a non-GMPLS circuit is selected.

Step 5 Click Yes in the Upgrade Circuits confirmation dialog box. The WSON/GMPLS Circuit Promotion 
dialog box is displayed.

Step 6 From the Validation drop-down list, choose the validation mode. For more information about the 
validation modes, see the “12.10.1.3 Validation Modes” section on page 12-110.

Step 7 From the Promotion Validation degree drop-down list, choose the optical validation value. For more 
information about the acceptance threshold value, see the “12.10.1.2 Acceptance Thresholds” section 
on page 12-110.

Step 8 Return to your originating procedure (NTP).

Purpose This task upgrades a non-GMPLS circuit to a GMPLS circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G178 Create, Delete, and Manage Optical Channel Trails

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you want to manage OCHNCs. 
If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the OCHNC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with the next 
step.

Step 3 Complete either of the following procedures as needed, between ADM-10G cards or GE_XP, 10GE_XP, 
GE_XPE, and 10GE_XPE cards that are provisioned in L2-over-DWDM mode:

• “DLP-G395 Create an Optical Channel Trail” task on page 17-35

• “DLP-G708 Create a GMPLS Optical Channel Trail” task on page 17-37

Step 4 Complete the “DLP-G706 Perform Optical Validation of GMPLS Circuits” task on page 17-32, as 
needed.

Step 5 Complete the “DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit” task on page 17-33, as 
needed.

Step 6 Complete the “DLP-G710 Reroute Wavelength of GMPLS Circuits” task on page 17-54, as needed.

Step 7 Complete the “DLP-G425 Edit an OCH Trail Circuit Name” task on page 17-40, as needed.

Step 8 Complete the “DLP-G419 Change an OCH Trail Administrative State” task on page 17-40, as needed.

Step 9 Complete the “DLP-G418 Delete an Optical Channel Trail” task on page 17-38, as needed.

Stop. You have completed this procedure.

Purpose This procedure creates and deletes DWDM OCH trail circuits and changes 
their administrative states. The OCH trail circuits can be created using the 
Circuit Creation wizard or the GMPLS view.

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G395 Create an Optical Channel Trail

Note OCH trail circuits are created automatically when you provision OCHCC circuits between TXP and 
MXP cards.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create. The Circuit Creation wizard is displayed.

Step 3 In the Circuit Creation wizard, choose OCHTRAIL from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCH trail circuit attributes:

• Name—Assign a name to the OCH trail. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor 
circuits. If you leave the field blank, CTC assigns a default name to the circuit. When a circuit 
includes a network element with release prior to 9.60, the circuit name is limited to 48 characters.

• Type—(Display only) Displays the OCH trail type—OCHTRAIL.

• Size—(Display only) Equipped non specific is the default.

• OCHNC Wavelength—Choose a band (either C Band or L Band) in the lower drop-down list. Then, 
choose the OCHNC wavelength that you want to assign to the OCH trail circuit in the upper 
drop-down list. See Table 17-6 on page 17-20 and Table 17-7 on page 17-22 for C-band and L-band 
wavelengths.

• Bidirectional—This parameter does not apply to OCH trail circuits.

• State—Provision the OCH trail circuit state. The state can be IS,AINS 
(ANSI)/Unlocked automatic inservice (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

Purpose This task creates an OCH trail circuit between ADM-10G cards, CRS-1 
routers, or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards when 
provisioned in L2-over-DWDM mode.

For OCH trails connecting ADM-10G cards, the OCH trail provides the 
low-layer path to route STS or VC circuits over ADM-10G cards.

For OCH trails connecting GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards in L2-over-DWDM mode, the OCH trail provides the links 
associated to the SVLAN entities.

For OCH trails connecting CRS-1 or Cisco 7600 routers, the OCH trail 
provides end-to-end circuit connectivity between the CRS-1 or Cisco 7600 
routers passing through an MSTP network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to trunk ports—Check this box if you want to provision the administrative state of the OCH 
trail trunk ports. If checked, choose the state in the next field, either IS (ANSI)/Unlocked (ETSI) or 
OOS,DSBLD (ANSI)/Locked,Disabled (ETSI).

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list. For most cards, the port will be 
automatically chosen.

If you are creating an OCH trail circuit between CRS-1 or Cisco 7600 routers, choose the source CRS-1 
or Cisco 7600 router from the Node drop-down list. The Shelf, Slot, and Port fields are not available. 
CTC automatically selects the PLIM port depending on the OCHNC Wavelength value specified in 
Step 5.

The source In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 8 Click Next. 

Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list (only the 
source node will be available because the source and destination nodes are the same), then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from Port drop-down list.

If you are creating an OCH trail circuit between CRS-1 or Cisco 7600 routers, choose the destination 
CRS-1 or Cisco 7600 router from the Node drop-down list. The Shelf, Slot, and Port fields are not 
available. CTC automatically selects the PLIM port depending on the OCHNC Wavelength value 
specified in Step 5.

The destination In and Out shelf (multishelf only), slot, and port appear under the OTS Lines area to 
show the destination in and out shelf, slots, and ports.

Step 10 Click Next.

Step 11 Complete the “DLP-G437 Set OCH Circuit Attributes” task on page 17-29.

Step 12 Click Next.

Step 13 Complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31. Skip this step and 
continue with Step 14 if no constraints are needed. If the trunk ports are already connected by an existing 
OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in 
read-only mode; all buttons are disabled. Continue with Step 14.

Step 14 Click Finish. The Create Circuit wizard closes and the OCH trail circuit appears in the Circuits table 
with a DISCOVERED status in the Status column. (The circuit might take a few minutes to come up, 
depending on the size of the network.) 

Step 15 Return to your originating procedure (NTP).
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DLP-G708 Create a GMPLS Optical Channel Trail

Note OCH trail circuits are created automatically when you provision OCHCC circuits between TXP and 
MXP cards.

Step 1 From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV View 
opens.

Step 2 From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 3 In the Circuit Parameters pane, provision the OCH Trail circuit attributes:

a. Name—Assign a name to the circuit. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). When a circuit includes a network element with release prior to 9.60, the circuit name is 
limited to 48 characters.

b. Type—Choose OCHTrail.

c. Bidirectional—This parameter does not apply to OCH trail circuits.

d. Protected—This parameter does not apply to OCH trail circuits.

e. IS—Check to place the trunk ports of the TXP /MXP card in service.

f. OCHNC Wavelength—Provides three fields to define the wavelength for the OCHCC circuit. 
Choose a wavelength from the first field. In the second field, change the wavelength band by 
choosing C Band. In the third field, indicate whether odd or even C-band wavelengths appear. 
Table 17-6 lists the C-band wavelengths.

g. Validation—Set the validation mode. For more information about the validation modes, see the 
“12.10.1.3 Validation Modes” section on page 12-110.

h. Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit 
is created if the actual optical validation result is greater than or equal to the value set in this field. 
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance 
Thresholds” section on page 12-110.

Purpose This task creates a GMPLS OCH trail circuit between ADM-10G cards, 
CRS-1 routers, or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards 
when provisioned in L2-over-DWDM mode.

For OCH trails connecting ADM-10G cards, the OCH trail provides the 
low-layer path to route STS or VC circuits over ADM-10G cards.

For OCH trails connecting GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
cards in L2-over-DWDM mode, the OCH trail provides the links 
associated to the SVLAN entities.

For OCH trails connecting CRS-1 routers, the OCH trail provides 
end-to-end circuit connectivity between the CRS-1 routers passing through 
an MSTP network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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i. Ignore Path Alarms—Check this check box to ignore the alarms on the path and create the circuit. 
This parameter is used to verify whether the circuit can be created on the path.

Step 4 Configure the restoration parameters for the OCH trail circuit in the GMPLS/WSON Restoration 
Configuration pane. For more information about configuring the restoration parameters, see the 
12.10.3.6 GMPLS Restoration Configuration, page 12-122.

Step 5 Configure the source and destination ports at the circuit endpoints in the map. For more information 
about configuring the source and destination ports, see the “12.10.3.3 Source and Destination Port 
Configuration” section on page 12-119.

Step 6 Define the working or protect port parameters. For more information, see the “12.10.3.3.1 Working and 
Protect Port Parameters” section on page 12-120. Click Apply in the Working Port Parameters pane and 
Protected Port Parameters pane, to apply the settings.

Step 7 Click Apply in the Circuit Parameters pane.

Step 8 Click Yes in the Create Circuits confirmation dialog box.
The OCH trail appear in the Circuits tab in the Network Data pane. After the circuit status has been 
verified, the DISCOVERED status appears in the Status column. The circuit might take a few minutes 
to come up, depending on the size of the network.

Step 9 Return to your originating procedure (NTP).

DLP-G418 Delete an Optical Channel Trail

Note If you are deleting more than half of all the active OCH trails, it is recommended that you delete them 
two at a time to allow for proper power compensation. You do not need to delete the active OCH trails 
two at a time if you are deleting all of them. 

Step 1 Complete the “NTP-G103 Back Up the Database” task on page 24-2 to preserve existing settings and, if 
you want to recreate the circuits, record the circuit information.

Step 2 Consult your network operations center (NOC) or other appropriate personnel to verify that the OCH 
trail can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCH trail deletion. 

Step 4 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 5 Under the Type column, choose one or more OCH trails that you want to delete, then click Delete.

Step 6 In the Delete Circuits confirmation dialog box, complete the following: 

Purpose This task deletes DWDM OCH trail circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Change drop port admin state—Check this box if you want to change the administrative state for the 
circuit source and destination ports. After checking the box, choose one of the following 
administrative states: 

– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.

– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in 
service.

– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and 
disables them.

– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for 
maintenance.

• Notify when completed—Check this box if you want the CTC Alerts confirmation dialog box to 
notify you when the OCH trail is deleted. During this time, you cannot perform other CTC functions. 
If you are deleting many OCH trails, waiting for confirmation might take a few minutes. Circuits are 
deleted whether or not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC Alerts 
dialog box is not set to open automatically with a notification, the red triangle inside the CTC 
Alerts toolbar icon indicates that a notification exists. 

Step 7 Complete either of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 8. If you do not want to save the information, continue with Step 9.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 10.

Step 8 If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you 
do not want to save it, continue with Step 10.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a TXT file extension, and click OK.

Step 9 Click Close to close the CTC Alerts dialog box. 

Step 10 Complete the “NTP-G103 Back Up the Database” task on page 24-2 if you require a backup of your 
changes.

Step 11 Return to your originating procedure (NTP).
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DLP-G425 Edit an OCH Trail Circuit Name

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 To rename the OCH trail circuit, do either of the following.

• Network view—Select the OCHCC circuit in the Circuits tab and click Edit. 

• NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3 In the Edit Circuit dialog box, click the General tab.

Step 4 In the Name field, enter the new OCH trail circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G419 Change an OCH Trail Administrative State

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 To change the administrative state of the OCH trail circuit, do either of the following.

• Network view—Select the OCHCC circuit in the Circuits tab and click Edit. 

• NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3 In the Edit Circuit dialog box, click the State tab.

Step 4 Click the cell in the Admin State column for the card you want to change, and choose an administrative 
state from the drop-down list:

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

• OOS,DSBLD (ANSI) or Locked (ETSI)

Purpose This task changes the name of an OCH trail circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the administrative state of an OCH trail circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G395 Create an Optical Channel Trail, page 17-35

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click Apply.

Step 6 If you are changing the OCH trail state to OOS/Locked, click OK in the confirmation dialog box. (No 
confirmation dialog box appears when you place OCH trails in service.)
For information about the OCH circuit state transitions, see the Administrative and Service States 
document.

Step 7 Return to your originating procedure (NTP).

NTP-G59 Create, Delete, and Manage Optical Channel Network 
Connections

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you want to manage OCHNCs. 
If you are already logged in, continue with Step 2.

Step 2 To provision an OCHNC circuit, use either of the following procedures as needed:

• “DLP-G105 Provision Optical Channel Network Connections” task on page 17-45

• “DLP-G709 Provision GMPLS Optical Channel Network Connections” task on page 17-47

Step 3 Complete the “DLP-G493 Provision Protected Optical Channel Network Connections” task on 
page 17-49, as needed.

Step 4 Complete the “DLP-G706 Perform Optical Validation of GMPLS Circuits” task on page 17-32, as 
needed.

Step 5 Complete the “DLP-G707 Upgrade a Non-GMPLS Circuit to a GMPLS Circuit” task on page 17-33, as 
needed.

Step 6 Complete the “DLP-G710 Reroute Wavelength of GMPLS Circuits” task on page 17-54, as needed.

Step 7 Complete the “DLP-G426 Edit an OCHNC Circuit Name” task on page 17-51, as needed.

Step 8 Complete the “DLP-G420 Change an OCHNC Administrative State” task on page 17-53, as needed.

Step 9 Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 17-50, as needed.

Stop. You have completed this procedure.

Purpose This procedure creates and deletes DWDM OCHNC channels and changes 
their administrative states. The OCHNC circuits can be created using the 
Circuit Creation wizard or the GMPLS view.

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G334 Configure GMPLS Optical Restoration

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you want to configure GMPLS 
optical restoration. If you are already logged in, continue with Step 2.

Step 2 Complete the DLP-G709 Provision GMPLS Optical Channel Network Connections, page 17-47 as 
needed.

Step 3 Complete the DLP-G708 Create a GMPLS Optical Channel Trail, page 17-37 as needed.

Step 4 Complete the DLP-G732 Edit a GMPLS OCHNC or OCH Trail Circuit, page 17-52.

Step 5 Complete the DLP-G731 Clear WSON Alarms, page 17-42 as needed.

Step 6 Complete the DLP-G733 Configure GMPLS UNI, page 17-43 as needed.

Stop. You have completed this procedure.

DLP-G731 Clear WSON Alarms

Step 1 Clear the alarms at the node, network, or circuit levels.

Clear the alarms at the node level.

a. From the View menu, choose Go to Home View. 

b. Click the Maintenance > DWDM > WSON tabs to view the list of unverified alarms at the node 
level.

c. Choose each alarm and click Acknowledge to clear the unverified alarms at the node level.

Clear the alarms at the network level.

d. Click the DWDM Functional View icon in the toolbar. The DWDM Functional View (NFV) 
window opens.

Purpose This procedure configures optical restoration for GMPLS circuits.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task clears the unverified alarms that appear in the WSON tab at the 
node, network, and circuit levels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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e. In the Network Data pane, click the WSON tab to view the list of unverified alarms at the network 
level.

f. Choose each alarm and click Acknowledge to clear the unverified alarms at the network level.

Clear the alarms at the circuit level.

g. Click the DWDM Functional View icon in the toolbar. The DWDM Functional View (NFV) 
window opens.

h. From the Change Perspective drop-down list in the toolbar, choose NFV. The NFV window opens.

i. From the Circuits tab, choose a GMPLS circuit that you want to edit.

j. Click the WSON tab to view the list of unverified alarms at the circuit level.

k. Choose each alarm and click Acknowledge to clear the unverified alarms at the circuit level.

Step 2 Return to your originating procedure (NTP).

DLP-G733 Configure GMPLS UNI

Step 1 From the View menu, choose Go to Home View. 

Step 2 Click the Provisioning > WDM-ANS > GMPLS/WSON > UNI tabs. 

Step 3 Click Create. 

Step 4 In the UNI window, provision the following parameters:

• Rx Port Selection—Choose the card type from the Type drop-down list; choose a shelf from the 
Shelf drop-down list; choose a source slot from Slot drop-down list and choose a port from the Port 
drop-down list. 

• Tx Port Selection—Choose the card type from the Type drop-down list; choose a shelf from the 
Shelf drop-down list; choose a destination slot from Slot drop-down list and choose a port from the 
Port drop-down list.

• UNI State—Choose Enable or Disable from the UNI State drop-down list. 

The Enable state is used to configure the UNI interface for the circuits to pass through, between the 
router and DWDM node. In the Disable state, the interface is configured but not active and circuit 
activation is rejected. When the status is changed from Enable to Disable, all the active circuits on 
the interface are deleted.

• Description—Enter the description of the UNI interface. The description can be up to 256 
characters.

• Remote System IP—Enter the IP address of the router.

Purpose This procedure configures the GMPLS UNI on a DWDM node and the 
router.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Remote Interface IP—Enter the IP address of the client side of the UNI, that is, the UNI-C interface.

• MSTP Interface IP—Enter the IP address of the network side of the UNI, that is, the UNI-N 
interface.

• Remote Communication Channel—Enter the IP address of the communication channel remote 
end-point. If the IP address is not provided, the remote system IP address is used as the remote 
communication channel address. The remote communication channel address must be defined if the 
remote system IP address is not a routable address. If the remote communication channel address is 
not defined, the UNI client uses another address as source address for signaling messages.

• Remote Router Interface—From the Interface Location drop-down list, choose None, POS, 
TenGigE, or HundredGigE and enter the remote router interface.

• Validation—Set the validation mode. For more information about the validation modes, see the 
“12.10.1.3 Validation Modes” section on page 12-110.

• Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit 
is created if the actual optical validation result is greater than or equal to the value set in this field. 
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance 
Thresholds” section on page 12-110.

• Restoration—Check this check box to enable the restoration of the GMPLS circuits on the UNI 
interface.

• Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.

• Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit 
on the restored path waits before moving to the original path after the failure is fixed. The circuit 
reverts to the original path after the soak time expires. The soak time must be set only if both the 
Restoration and Revert check boxes are checked.

Step 5 Click OK to configure the UNI on a DWDM node.

Note When the UNI is configured on a DWDM node, CTC runs the necessary CLI commands to 
configure the UNI on the connected router.

Stop. You have completed this procedure.
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DLP-G105 Provision Optical Channel Network Connections

Note In a node using OTU2_XP cards configured in the regen mode, you must create two OCHNC circuits, 
one on either side of the card.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCHNC circuit attributes:

• Name—Assign a name to the OCHNC. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor 
circuits. If you leave the field blank, CTC assigns a default name to the circuit. When a circuit 
includes a network element with release prior to 9.60, the circuit name is limited to 48 characters.

• Type—(Display only) OCHNC.

• Size—(Display only) Equipped non specific is the default.

• OCHNC Wavelength—Choose a band (either C Band or L Band) and wavelength number type 
(Odd or Even) in the lower drop-down list. Then, choose the wavelength that you want to provision 
in the upper drop-down list. See Table 17-6 on page 17-20 for C-band and Table 17-7 on page 17-22 
for L-band wavelengths.

• Bidirectional—Check this box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC.

Purpose This task creates an OCHNC between two optical nodes upon a specified 
C-band or L-band wavelength through the ports residing on the 32WSS, 
32WSS-L, 40-WSS-C, 40-WSS-CE, 32DMX-O, 32DMX, 32DMX-L, 
40-DMX-C, 40-DMX-CE, 4MD-xx.x, AD-1C-xx.x, AD-4C-xx.x, 
40-SMR1-C, 40-SMR2-C, 80-WXC-C, 15216-FLD-4, 
15216-MD-40-EVEN, 15216-EF-40-EVEN, or 15216-MD-48-EVEN, and 
15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD 
wavelength selective switches, multiplexers, demultiplexers, and add/drop 
cards:

OCH trails, which carry OCHCC circuits, are associated to the OCHNCs.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC

• An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength

• Cisco Transport Planner Traffic Matrix Report

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• OCHNC DCN—Check this box to create an OCHNC DCN. The OCHNC DCN establishes 
preliminary connectivity between nodes that lack LAN or optical service channel (OSC) 
connections. After the OCHNC is created, you create a GCC termination to provide permanent 
communications channel between the nodes. See the “DLP-G76 Provision DCC/GCC 
Terminations” task on page 17-88.

• Protection—Check to create a protected OCHNC. For more details, see the “DLP-G493 Provision 
Protected Optical Channel Network Connections” task on page 17-49.

• State—Provisions the OCHNC circuit state. The state can be IS,AINS (ANSI)/Unlocked, 
automatic in-service (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI). 

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source or ADD/DROP port from the Port drop-down list.

The source In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 8 Click Next. 

Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list, then choose 
the destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the 
Slot drop-down list, and, if needed, the destination port from the Port drop-down list.

The destination In and Out shelf (multishelf nodes only), slot, and port appear under the OTS Lines area.

Step 10 Click Next. 

Step 11 Skip this step and continue with Step 12 if no constraints are needed. If the trunk ports are already 
connected by an existing OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing 
Preferences page appears in read-only mode; all buttons are disabled. Continue with Step 12. If not, 
complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31.

Step 12 Click Finish. The Circuit Creation wizard closes and the new OCHNC appears in the Circuits table with 
a DISCOVERED status in the Status column. (The circuit might take a few minutes to come up, 
depending on the size of the network.)

Step 13 Return to your originating procedure (NTP).
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DLP-G709 Provision GMPLS Optical Channel Network Connections

Step 1 From the View menu, choose Go to Parent View. The Network view opens.

Step 2 Open the source node in the Network view either by double-clicking the node or right-clicking the node 
and choosing the Open Node option.

Step 3 Select the Provisioning > WDM-ANS > GMPLS/WSON tabs. 

Step 4 Define the fiber attributes and alien wavelength parameters for the node in the Fiber Attributes and Alien 
Wavelength tabs, as needed. For more information about alien wavelength parameters, see the 
“12.10.3.5 Fiber Attributes and Alien Wavelength Provisioning” section on page 12-121.

Step 5 Repeat the Step 1 through Step 3 for the destination node.

Step 6 From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV view 
opens.

Step 7 From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 8 In the circuit parameters pane, provision the OCHNC circuit attributes:

a. Name—Assign a name to the circuit. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). When a circuit includes a network element with release prior to 9.60, the circuit name is 
limited to 48 characters.

b. Type—Choose OCHNC.

c. Protected—Check to route the circuit on a protected path. Select the protection type from the 
drop-down list. The available option is:

– PSM—When a PSM card is connected to a TXP card.

d. OCHNC Wavelength—Provides three fields to define the wavelength for the OCHCC circuit. 
Choose a wavelength from the first field. In the second field, change the wavelength band by 
choosing C Band. In the third field, indicate whether odd or even C-band wavelengths appear. 
Table 17-6 lists the C-band wavelengths.

Purpose This task provisions an OCHNC between two optical nodes upon a 
specified C-band wavelength through the ports residing on the 32WSS, 
40-WSS-C, 40-WSS-CE, 32DMX, 40-DMX-C, 40-DMX-CE, 
40-SMR1-C, 40-SMR2-C, 80-WXC-C, 100G-LC-C, 10x10G-LC, AR_XP, 
AR_XPE, 15216-MD-40-EVEN, 15216-EF-40-EVEN, or 
15216-MD-48-EVEN, and 15216-MD-40-ODD, 15216-EF-40-ODD, or 
15216-MD-48-ODD wavelength selective switches, multiplexers, 
demultiplexers, and add/drop cards:

Tools/Equipment Cisco Transport Planner Traffic Matrix Report

Prerequisite Procedures • DLP-G46 Log into CTC

• An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength

• DLP-G350 Use the Cisco Transport Planner Traffic Matrix Report

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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e. Protected OCHNC Wavelength—Define the wavelength of the protected OCHCC circuit. This field 
is visible only when the Protected check box is checked in Step c. The options available are similar 
to that of OCHNC Wavelength. 

f. Validation—Set the validation mode. For more information about the validation modes, see the 
“12.10.1.3 Validation Modes” section on page 12-110.

g. Acceptance threshold—Set the optical validation threshold value for the GMPLS circuit. The circuit 
is created if the actual optical validation result is greater than or equal to the value set in this field. 
For more information about the acceptance threshold value, see the “12.10.1.2 Acceptance 
Thresholds” section on page 12-110.

h. Protection Acceptance Threshold—Set the optical validation threshold value for the protected 
GMPLS circuit.

i. Ignore Path Alarms—Check this check box to ignore the alarms on the path and create the circuit. 
This parameter is used to verify whether the circuit can be created on the path.

Step 9 Configure the restoration parameters for the OCHNC circuit in the GMPLS/WSON Restoration 
Configuration pane. For more information about configuring the restoration parameters, see the 
12.10.3.6 GMPLS Restoration Configuration, page 12-122.

Step 10 Configure the source and destination ports in the map. For more information about configuring the 
source and destination ports, see the “12.10.3.3 Source and Destination Port Configuration” section on 
page 12-119.

Note The OCHNC circuit endpoints must be selected on channel ports, express add/drop ports, or 
add/drop ports. If other ports are selected, a warning dialog box is displayed prompting you to 
change the circuit type.

After the ports are selected, the Alien Wavelength Selection pane is displayed. This pane displays 
options for the RX and TX channels at the endpoints of the circuit. 

Step 11 For both RX and TX channels, choose the alien class and the forward error correction (FEC) mode from 
the corresponding drop-down lists. For more information about FEC, see “G.8 FEC” section on 
page G-18. Click Apply in the Alien Wavelength Selection pane.

Step 12 Click Apply in the Circuit Parameters pane.

Step 13 Click Yes in the Create Circuits confirmation dialog box.
The OCHNC circuit appears in the Circuits tab in the Network Data pane. After the circuit status has 
been verified, the DISCOVERED status appears in the Status column. The circuit might take a few 
minutes to come up, depending on the size of the network.

Step 14 Return to your originating procedure (NTP).
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DLP-G493 Provision Protected Optical Channel Network Connections

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 4 Click Next.

Step 5 In the Circuit area of the Circuit Attributes page, provision the OCHNC circuit attributes:

• Name—Assign a name to the OCHNC. The name is limited to 80 characters, which can be a 
combination of alphanumeric (a-z, A-Z, 0-9) and special characters (+, #,%, and so on, including 
spaces). Circuit names should be 44 characters or less if you want the ability to create monitor 
circuits. If you leave the field blank, CTC assigns a default name to the circuit. When a circuit 
includes a network element with release prior to 9.60, the circuit name is limited to 48 characters.

• Type—(Display only) OCHNC.

• Size—(Display only) Equipped non specific is the default.

• OCHNC Wavelength—Choose a band (either C Band or L Band) and wavelength number type 
(Odd or Even) in the lower drop-down list. Then, choose the wavelength that you want to provision 
in the upper drop-down list. See Table 17-6 on page 17-20 and Table 17-7 on page 17-22 for C-band 
and L-band wavelengths.

• Bidirectional—Check this box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC. This field is not available if you check the Protection option.

• OCHNC DCN—Check this box to create an OCHNC DCN. The OCHNC DCN establishes 
preliminary connectivity between nodes that lack LAN or optical service channel (OSC) 
connections. After the OCHNC is created, you create a GCC termination to provide permanent 
communications channel between the nodes. See the “DLP-G76 Provision DCC/GCC 
Terminations” task on page 17-88.

• Protection—Check to create a protected OCHNC (only endpoint nodes equipped with PSM cards 
will be selectable as circuit endpoints).

• State—Provisions the OCHNC circuit state. The state can be IS,AINS (ANSI)/Unlocked, 
automatic in-service (ETSI) or OOS,DSBLD (ANSI)/Locked,Disabled (ETSI). 

Step 6 Click Next. 

Purpose This task creates a protected OCHNC circuit when a PSM card is 
provisioned at the endpoint nodes of a DWDM network. OCH trails, which 
carry OCHCC circuits, are associated to the OCHNCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength

Cisco Transport Planner Traffic Matrix Report

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 In the Circuit Source area, choose the source node from the Node drop-down list. Only endpoint nodes 
equipped with PSM cards are available for selection in the Node drop-down list. The slot, port, and the 
source In and Out OTS lines are automatically chosen by CTC. 

Step 8 Click Next. 

Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list. Only endpoint 
nodes equipped with PSM cards are available for selection in the Node drop-down list. The slot, port, 
and the source In and Out OTS lines are automatically chosen by CTC.

Step 10 Click Next. CTC completes the circuit creation by routing two distinct paths (a working path and a 
protected path) from the source node to the destination node. The working path is the one exiting the 
In/Out working source OTS lines and entering the In/Out working destination OTS lines. The protected 
path is the one exiting the In/Out protected source OTS lines and entering the In/Out protected 
destination OTS lines.

Step 11 Complete the “DLP-G438 Set OCH Routing Preferences” task on page 17-31. Skip this step and 
continue with Step 12 if no constraints are needed. If the trunk ports are already connected by an existing 
OCH Trail (MXP case) or by a direct PPC link, the OCH Circuit Routing Preferences page appears in 
read-only mode; all buttons are disabled. Continue with Step 12.

Step 12 Click Finish. The Circuit Creation wizard closes and the new OCHNC appears in the Circuits table with 
a DISCOVERED status in the Status column. (The circuit might take a few minutes to appear, depending 
on the size of the network.)

Step 13 Return to your originating procedure (NTP).

DLP-G106 Delete Optical Channel Network Connections

Note If you are deleting more than half of all the active OCHNCs, it is recommended that you delete them two 
at a time to allow for proper power compensation. You do not need to delete the active OCHNCs two at 
a time if you are deleting all the them.

Step 1 To preserve existing settings you must back up the database of every node on the path of the circuit. 
Complete the “NTP-G103 Back Up the Database” task on page 24-2 to back up the databases for all 
nodes on the circuit path. Record the circuit information if you plan to recreate the circuit.

Step 2 Consult your NOC or other appropriate personnel to verify that the OCHNC can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCHNC deletion. 

Step 4 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 5 In the Circuits table, under the Type column, choose one or more OCHNCs that you want to delete. (To 
choose more than one OCHNC, press the Shift or Control keys as you click the circuits.)

Purpose This task deletes DWDM OCHNC circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Click Delete.

Step 7 In the Delete Circuits confirmation dialog box, check Notify when completed, as needed. 

If checked, the CTC Alerts confirmation dialog box will alert you when the OCHNC is deleted. During 
this time, you cannot perform other CTC functions. If you are deleting many OCHNCs, waiting for 
confirmation might take a few minutes. Circuits are deleted whether or not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC Alerts 
dialog box is not set to open automatically with a notification, the red triangle inside the CTC 
Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete either of the following:

• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 9. If you do not want to save the information, continue with Step 10.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 11.

Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following steps. 

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a.txt file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” task on page 24-2 for every node on the path of the 
circuit if you require a backup of your changes.

Step 12 Return to your originating procedure (NTP).

DLP-G426 Edit an OCHNC Circuit Name

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 To rename the OCHCC circuit, do either of the following.

• Network view—Select the OCHCC circuit in the Circuits tab and click Edit. 

• NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3 In the Edit Circuit dialog box, click the General tab.

Purpose This task changes the name of an OCHNC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G105 Provision Optical Channel Network Connections, page 17-45

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 In the Name field, enter the new OCHNC circuit name.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G732 Edit a GMPLS OCHNC or OCH Trail Circuit

Note For OCHNC UNI circuits, only Restoration and Restoration and Revert options are supported. The 
Manual Revert and Upgrade Restored options are not applicable.

Step 1 From the View menu, choose Go to Network View and click the DWDM Functional View icon in the 
toolbar. The DWDM Functional View (NFV) window opens.

Step 2 From the Change Perspective drop-down list in the toolbar, choose NFV. The NFV window opens.

Step 3 From the Circuits tab, choose a OCH Trail or OCHNC GMPLS circuit that you want to edit.

Step 4 Click the Restoration tab to edit the following restoration and revertive parameters:

a. Check the Restoration check box to switch the circuit from the original path to an alternate path 
because of failure in the original path.

b. Check the Revert check box to revert the circuit from the restored path to the original path after the 
failure is fixed.

c. Click the Auto Revert radio button to automatically revert the circuit from the restored path to the 
original path after the failure is fixed, alarms listed in the WSON tab are acknowledged, and the soak 
time expires.

d. Click the Manual Revert radio button to manually revert the circuit from the restored path to the 
original path after the failure is fixed, alarms listed in the WSON tab are acknowledged, and the soak 
time expires.

e. Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on the restored 
path waits before moving to the original path after the failure is fixed.

Step 5 Click Manual Revert to revert the circuit to the original path from the restored path after the soak time 
expires.

Purpose This task edits the parameters of a GMPLS OCHNC or OCH Trail circuit.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G709 Provision GMPLS Optical Channel Network Connections, 
page 17-47

DLP-G708 Create a GMPLS Optical Channel Trail, page 17-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The circuit can be manually reverted only when the restoration status of the circuit is 
REST-REVERTIBLE.

Note In a PSM protected trail circuit, click the Manual Revert button twice to revert the working and 
protected trail circuit respectively.

Step 6 Click Upgrade Restored to discard the original path and make the restored path as the working path.

Step 7 Click Apply to save the changes.

Step 8 Click the WSON tab to acknowledge the unverified alarms.

a. Right-click the alarm and choose Select Affected Circuits to view the circuits affected by this 
alarm.

b. Choose each alarm and click Acknowledge to clear the unverified alarms.

Step 9 Click Revert Test to forcefully revert the circuit from the restored path to the original path.

Note When the circuit is forcefully reverted, the circuit cannot be restored and reverted. If the failure 
is not fixed in the original path, the circuit becomes unusable and traffic is affected. The revert 
test is possible only when all the alarms on the original path are acknowledged.

Note In a PSM protected trail circuit, if a working or protect trail circuit is restored, the Revert Test 
button reverts the restored trail to the original path. If both the working and protected trail 
circuits are restored, the Revert Test button reverts either the working or protected trail circuit. 
The user must click the Revert Test button again to revert the other trail circuit. 

Step 10 Return to your originating procedure (NTP).

DLP-G420 Change an OCHNC Administrative State

Step 1 Go to the network view, NFV view, or GMPLS view, and click the Circuits tab.

Step 2 To change the administrative state of the OCHCC circuit, do either of the following.

• Network view—Select the OCHCC circuit in the Circuits tab and click Edit. 

Purpose This task changes the administrative state of an OCHNC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45

DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• NFV view or GMPLS view—Double-click the circuit in the Circuits tab.

Step 3 In the Edit Circuit dialog box, click the State tab.

Step 4 Choose an administrative state from the drop-down list:

• IS,AINS (ANSI) or Unlocked,AutomaticInService (ETSI)

• OOS (ANSI) or Locked (ETSI)

Step 5 Click Apply.

Step 6 If you are changing the OCHNC state to OOS,DSBLD (ANSI) or Locked,Disabled (ETSI), click OK in 
the confirmation dialog box. (No confirmation dialog box appears when you place OCH trails in 
service.)
For information about the OCH circuit state transitions, see the Administrative and Service States 
document.

Step 7 Return to your originating procedure (NTP).

DLP-G710 Reroute Wavelength of GMPLS Circuits

Note GMPLS OCHCC circuits cannot be rerouted. Only the OCH Trail associated with the OCHCC circuit 
can be rerouted.

Step 1 From the View menu, choose Go to Network View and click the FV icon in the toolbar. The NFV view 
opens.

Step 2 From the Change Perspective drop-down list in the toolbar, choose GMPLS. The GMPLS view opens.

Step 3 Click the Wavelength re-routing button.

Step 4 In the confirmation dialog box, click Yes to enter the wavelength re-routing view. The Wavelength 
re-routing pane is displayed.

Step 5 In the Circuits tab, select the GMPLS circuit to be rerouted.

Step 6 From the Constraint Config drop-down list, select the required constraint type. For more information 
about the various constraint types, see the Table 12-18.

Step 7 In the map, select the node or link to which the constraint is to be applied.

Step 8 Repeat Step 5 and Step 6 to apply more constraints, as needed.

Purpose This task reroutes an existing GMPLS circuit through an alternate path 
based on the specified path constraints.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note While applying constraint to include a node or link on the alternate path, the selection of the 
nodes or links must be done sequentially, starting form the source to the destination of the 
circuit. 

Step 9 Click Apply. The circuit is rerouted if a feasible path is found that complies with the specified 
constraints. After a successful reroute, a confirmation message is displayed. Otherwise, a failure 
notification is displayed.

Step 10 Repeat the reroute process in case the reroute fails in Step 9. Click Clear in the Wavelength 
re-routing pane to clear the previous selections. Repeat the Step 6 through Step 9.

Step 11 Click the Wavelength re-routing button on the toolbar to close the Wavelength re-routing pane. In the 
confirmation dialog box, click Yes.

Step 12 Return to your originating procedure (NTP).

NTP-G200 Create, Delete, and Manage STS or VC Circuits for the 
ADM-10G Card

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you want to manage the STS or 
VC circuits. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the STS or VC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with the next 
step.

Step 3 If you are creating STS or VC circuits on ADM-10G cards across two nodes, you must complete the 
“DLP-G395 Create an Optical Channel Trail” task on page 17-35. If not, continue with the next step.

Step 4 Complete the “DLP-G463 Create an Automatically Routed STS or VC Circuit” task on page 17-56, as 
needed.

Step 5 Complete the “DLP-G464 Create a Manually Routed STS or VC Circuit” task on page 17-59, as needed.

Step 6 Complete the “DLP-G467 Edit an STS or VC Circuit Name” task on page 17-64, as needed.

Step 7 Complete the “DLP-G466 Delete an STS or VC Circuit” task on page 17-63, as needed.

Stop. You have completed this procedure.

Purpose This procedure creates and deletes STS and VC circuits for the ADM-10G 
card.

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G463 Create an Automatically Routed STS or VC Circuit

Note This procedure requires the use of automatic routing. Automatic routing is not available if both the 
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE 
default are set to FALSE. For a full description of these defaults see the Network Element Defaults.

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS or VC from the Circuit Type list.

• Number of Circuits—Enter the number of STS or VC circuits that you want to create. The default 
is 1. If you are creating multiple circuits with the same slot and sequential port numbers, you can 
use Auto-ranged to create the circuits automatically. 

• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
Circuits field. Auto-ranging creates identical (same source and destination) sequential circuits 
automatically. Uncheck the box if you do not want CTC to create sequential circuits automatically.

Step 4 Click Next.

Step 5 Define the circuit attributes:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters, 
(including spaces). Circuit names should be 43 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size. 

– Available SONET circuits are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-18c, STS-24c, 
STS-36c, STS-48c, and STS-192c.

– Available SDH circuits areVC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c, 
VC4-16c, and VC4-64c.

Note For creating a circuit using a Gigabit Ethernet port, choose the circuit size as STS-24c for a 
SONET circuit or VC4-8c for a SDH circuit.

Note An equivalent SDH circuit size for STS-1 SONET circuit does not exist.

• Bidirectional—Leave checked for this circuit (default).

Purpose This procedure creates an automatically routed STS or VC circuit for the 
ADM-10G card. CTC chooses the circuit route based on the parameters 
you specify and on the software version.

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits.

• Diagnostic—Leave unchecked.

• State—Choose the administrative state to apply to all of the cross-connects in a circuit:

– IS (ANSI)/Unlocked (ETSI)—Puts the circuit cross-connects in the IS-NR (ANSI) or 
unlocked-enabled (ETSI) service state.

– OOS,DSBLD (ANSI)/Locked,Disabled (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,DSBLD (ANSI) or locked-enabled,disabled (ETSI) service state. Traffic is not passed 
on the circuit.

– IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI)—Puts the circuit cross-connects in the 
OOS-AU,AINS (ANSI) or unlocked-disabled,automaticInService (ETSI) service state and 
suppresses alarms and conditions. When the connections receive a valid signal, the service state 
automatically changes to IS-NR (ANSI) or unlocked-enabled (ETSI).

– OOS,MT (ANSI)/Locked,maintenance (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,MT (ANSI) or locked-enabled,maintenance (ETSI) service state. The maintenance 
state does not interrupt traffic flow; it suppresses alarms and conditions and allows loopbacks 
to be performed on the circuit. Use OOS,MT (ANSI) or locked,maintenance (ETSI) for circuit 
testing or to suppress circuit alarms temporarily.

• Apply to drop ports—Check this check box if you want to apply the administrative state chosen in 
the State field to the circuit source and destination ports. CTC applies the administrative state to the 
ports only if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is 
larger than the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog 
box displays the ports where the administrative state could not be applied. If the check box is 
unchecked, CTC does not apply the administrative state to the source and destination ports.

Note If ports managed into the IS (ANSI) or Unlocked (ETSI) administrative state are not 
receiving signals, loss of signal alarms are generated and the port service state transitions to 
OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI).

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, 1+1, or optimized 1+1 protection. If you check this box, CTC 
displays only protected cards and ports as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-G465 Provision Path 
Protection Selectors” task on page 17-62. Otherwise, continue with Step 7.

Step 7 Click Next. 

Step 8 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list. For most cards, the port will be 
automatically chosen.

Step 9 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection configuration, click Use Secondary Source and repeat Step 8 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 10.

Step 10 Click Next. 
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Step 11 In the Circuit Destination area, choose the destination node from the Node drop-down list (only the 
source node will be available because the source and destination nodes are the same), then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from Port drop-down list.

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Check this check box if you want to specify nodes and spans to 
include or exclude in the CTC-generated circuit route. 

Including nodes and spans for a circuit ensures that those nodes and spans are in the working path 
of the circuit (but not the protect path). Excluding nodes and spans ensures that the nodes and spans 
are not in the working or protect path of the circuit.

• Review Route Before Creation—Check this check box if you want to review and edit the circuit 
route before the circuit is created. 

Step 14 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 15. CTC creates a fully protected circuit route based on the path diversity option you choose. 
Fully protected paths might or might not have path protection path segments (with primary and 
alternate paths), and the path diversity options apply only to path protection path segments, if any 
exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 16.

Step 15 If you selected Fully Protected Path in Step 14 and the circuit will be routed on a path protection 
configuration, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 16 If you checked Using Required Nodes/Spans in Step 13, complete the following substeps. Otherwise, 
continue with Step 17.

a. In the Circuit Constraints for Automatic Routing area, click a node or span on the circuit map.

b. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit is routed. Click spans twice to change the circuit direction. 

c. Repeat Step b for each node or span you wish to include or exclude.

d. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Nodes Links lists and click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 17 Click Next.

Step 18 If you selected Review Route Before Creation in Step 13, complete the following substeps. If not, 
continue with Step 19. 

a. Click Next.
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b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“DLP-G464 Create a Manually Routed STS or VC Circuit” procedure on page 17-59.

Step 19 Click Finish. One of the following results occurs if you entered more than one circuit in the Number of 
Circuits field on the Circuit Creation dialog box. 

• If you chose Auto-ranged, CTC automatically creates the number of circuits entered in the Number 
of Circuits field. If auto-ranging cannot complete all the circuits, for example, because sequential 
ports are unavailable at the source or destination, a dialog box appears. Set the new source or 
destination for the remaining circuits, then click Finish to continue auto-ranging. After completing 
the circuits, the Circuits window appears.

• If you did not choose Auto-ranged, the Circuit Creation dialog box appears so you can create the 
remaining circuits. Repeat Steps 3 through 18 for each additional circuit. After completing the 
circuits, the Circuits window appears.

Step 20 In the Circuits window, verify that the new circuits appear in the circuits list.

Stop. You have completed this procedure.

DLP-G464 Create a Manually Routed STS or VC Circuit

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, complete the following fields: 

• Circuit Type—Choose STS or VC from the Circuit Type list.

• Number of Circuits—Enter the number of STS or VC circuits that you want to create. The default 
is 1. 

• Auto-ranged—(Automatically routed circuits only) If you entered more than 1 in the Number of 
Circuits field on the Circuit Creation dialog box, uncheck this box. (The box is unavailable if only 
one circuit is entered in the Number of Circuits field.)

Step 4 Click Next.

Step 5 Define the circuit attributes:

Purpose This procedure creates an STS or VC circuit and allows you to provision 
the circuit route for the ADM-10G card. 

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 43 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Choose the circuit size.

– Available SONET are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-18c, STS-24c, 
STS-36c, STS-48c, and STS-192c.

– Available SDH circuits are VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, VC4-8c, VC4-12c, 
VC4-16c, and VC4-64c.

Note For creating a circuit using a Gigabit Ethernet port, choose the circuit size as STS-24c for a 
SONET circuit or VC4-8c for a SDH circuit.

• Bidirectional—Leave checked for this circuit (default).

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits.

• State—Choose the administrative state to apply to all of the cross-connects in a circuit:

– IS (ANSI)/Unlocked (ETSI)—Puts the circuit cross-connects in the IS-NR (ANSI) or 
unlocked-enabled (ETSI) service state.

– OOS,DSBLD (ANSI)/Locked,Disabled (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,DSBLD (ANSI) or locked-enabled,disabled (ETSI) service state. Traffic is not passed 
on the circuit.

– IS,AINS (ANSI)/Unlocked,AutomaticInService (ETSI)—Puts the circuit cross-connects in the 
OOS-AU,AINS (ANSI) or unlocked-disabled,automaticInService (ETSI) service state and 
suppresses alarms and conditions. When the connections receive a valid signal, the service state 
automatically changes to IS-NR (ANSI) or unlocked-enabled (ETSI).

– OOS,MT (ANSI)/Locked,maintenance (ETSI)—Puts the circuit cross-connects in the 
OOS-MA,MT (ANSI) or locked-enabled,maintenance (ETSI) service state. The maintenance 
state does not interrupt traffic flow; it suppresses alarms and conditions and allows loopbacks 
to be performed on the circuit. Use OOS,MT (ANSI) or locked,maintenance (ETSI) for circuit 
testing or to suppress circuit alarms temporarily.

• Apply to drop ports—Check this check box if you want to apply the administrative state chosen in 
the State field to the circuit source and destination ports. CTC applies the administrative state to the 
ports only if the circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is 
larger than the circuit, the circuit must be the first circuit to use the port. If not, a Warning dialog 
box displays the ports where the administrative state could not be applied. If the check box is 
unchecked, CTC does not apply the administrative state to the source and destination ports.

Note If ports managed into the IS (ANSI) or Unlocked (ETSI) administrative state are not 
receiving signals, loss of signal alarms are generated and the port service state transitions to 
OOS-AU,FLT (ANSI) or Unlocked-disabled,failed (ETSI).

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, 1+1, or optimized 1+1 protection. If you check this box, CTC 
shows only protected cards and ports as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-G465 Provision Path 
Protection Selectors” task on page 17-62. Otherwise, continue with Step 7.
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Step 7 Click Next. 

Step 8 In the Circuit Source area, choose the source node from the Node drop-down list, then choose the source 
shelf (multishelf nodes only) from the Shelf drop-down list, the source slot from the Slot drop-down list, 
and, if needed, the source port from the Port drop-down list. For most cards, the port will be 
automatically chosen.

Step 9 If you need to create a secondary source, for example, a path protection bridge/selector circuit entry 
point in a multivendor path protection configuration, click Use Secondary Source and repeat Step 8 to 
define the secondary source. If you do not need to create a secondary source, continue with Step 10.

Step 10 Click Next. 

Step 11 In the Circuit Destination area, choose the destination node from the Node drop-down list (only the 
source node will be available because the source and destination nodes are the same), then choose the 
destination shelf (multishelf nodes only) from the Shelf drop-down list, the destination slot from the Slot 
drop-down list, and, if needed, the destination port from Port drop-down list.

Step 12 Click Next.

Step 13 In the Circuit Routing Preferences area, uncheck Route Automatically. 

Step 14 To set the circuit path protection, complete one of the following:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 15. Fully protected paths might or might not have path protection path segments (with primary 
and alternate paths), and the path diversity options apply only to path protection path segments, if 
any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 17.

Step 15 If you selected Fully Protected Path in Step 14 and the circuit will be routed on a path protection 
configuration, choose a Node-Diverse Path option: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection portion of the complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection portions of the complete circuit path are needed. The paths might be node-diverse, but 
CTC does not check for node diversity.

Step 16 Click Next.

Step 17 In the Route Review/Edit area, node icons appear for you to route the circuit manually. Click the source 
node icon if it is not already selected.

Step 18 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns yellow. In the Selected Span area, the From and To fields provide span information. The 
source STS or VC appears.

Step 19 If you want to change the source STS or VC, adjust the Source STS or VC field; otherwise, continue 
with Step 20. 

Step 20 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue.

Step 21 If the Fully Protect Path check box is checked in the Circuit Routing Preferences panel, you must add 
two spans for all path protection or unprotected portions of the circuit route from the source to the 
destination.

Step 22 Repeat Steps 18 through 21 until the circuit is provisioned from the source to the destination node 
through all intermediary nodes.
17-61
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 17      Create Optical Channel Circuits and Provisionable Patchcords
DLP-  G465 Provision Path Protection Selectors
Step 23 Click Finish. CTC compares your manually provisioned circuit route with the specified path diversity 
option you chose in Step 15. If the path does not meet the specified path diversity requirement, CTC 
displays an error message and allows you to change the circuit path. 

Step 24 If you entered more than 1 in the Number of Circuits field on the Circuit Creation dialog box, the Circuit 
Creation dialog box appears so you can create the remaining circuits. Repeat Steps 3 through 23 for each 
additional circuit.

Step 25 When all the circuits are created, the main Circuits window appears. Verify that the circuits you created 
are correct.

Stop. You have completed this procedure.

DLP-G465 Provision Path Protection Selectors

Note Provisioning path signal degrade (SD-P) or path signal fail (SF-P) thresholds in the Circuit Attributes 
page of the Circuit Creation wizard sets the values only for path protection-protected spans. The circuit 
source and destination use the node default values of 10E-4 for SD-P and 10E-6 for SF-P for unprotected 
circuits and for the source and drop of path protection circuits.

Step 1 In the path protection area of the Circuit Attributes page of the Circuit Creation wizard, set the path 
protection selectors:

• Provision working go and return on primary path—Check this box to route the working path on one 
fiber pair and the protect path on a separate fiber pair. This feature only applies to bidirectional path 
protection circuits. 

• Revertive—Check this box if you want traffic to revert to the working path when the conditions that 
diverted it to the protect path are repaired. If you do not choose Revertive, traffic remains on the 
protect path after the switch.

• Reversion time—If Revertive is checked, click the Reversion time field and choose a reversion time 
from the drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the 
amount of time that will elapse before the traffic reverts to the working path. Traffic can revert when 
conditions causing the switch are cleared.

• SF threshold—Set the path protection path-level signal failure bit error rate (BER) thresholds. 

• SD threshold—Set the path protection path-level signal degrade BER thresholds.

• Switch on PDI-P—Check this box if you want traffic to switch when an STS or VC payload defect 
indicator is received.

Purpose This task provisions path protection selectors during circuit creation or 
during a topology upgrade conversion. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

The Circuit Attributes page of the Circuit Creation wizard must be open.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Return to your originating procedure (NTP).

DLP-G466 Delete an STS or VC Circuit

Step 1 Complete the “NTP-G103 Back Up the Database” task on page 24-2 to preserve existing settings and, if 
you will recreate the circuits, record the circuit information.

Step 2 Verify that traffic is no longer carried on the circuit and that the circuit can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the circuit deletion. 

Step 4 From the View menu, choose Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 Choose one or more STS or VC circuits from the Type column that you want to delete, then click Delete.

Step 7 In the Delete Circuits confirmation dialog box, complete the following: 

• Change drop port admin state—Check this box if you want to change the administrative state for the 
circuit source and destination ports. After checking the box, choose one of the following 
administrative states: 

– IS (ANSI) or Unlocked (ETSI)—Puts the ports in service.

– IS,AINS (ANSI) or UnlockedAutomaticInService (ETSI)—Puts the ports in automatic in 
service.

– OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Removes the ports from service and 
disables them.

– OOS,MT (ANSI) or Locked,maintenance (ETSI)—Removes the ports from service for 
maintenance.

• Notify when completed—If checked, the CTC Alerts confirmation dialog box indicates when the 
circuit is deleted. During this time, you cannot perform other CTC functions. If you are deleting 
many circuits, waiting for confirmation might take a few minutes. Circuits are deleted whether or 
not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup. If the CTC Alerts 
dialog box is not set to open automatically with a notification, the red triangle inside the CTC 
Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete one of the following:

Purpose This task deletes STS or VC circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• If you checked Notify when completed, the CTC Alerts dialog box appears. If you want to save the 
information, continue with Step 8. If you do not want to save the information, continue with Step 9.

• If you did not check Notify when completed, the Circuits page appears. Continue with Step 10.

Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you 
do not want to save it, continue with Step 10.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

c. Type the file name using a TXT file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” task on page 24-2 if you require a backup of your 
changes.

Step 12 Return to your originating procedure (NTP).

DLP-G467 Edit an STS or VC Circuit Name

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Click the STS or VC circuit whose name you want to edit, then click Edit. The Edit Circuit dialog box 
appears with the General tab displayed.

Step 4 In the Name field, enter the new STS or VC circuit name. 

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes the name of an STS or VC circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G150 Upgrade Optical Channel Network Connections to 
Optical Channel Client Connections

Note During this procedure, the OCHNC is replaced with two circuit types, the OCHCC, which establishes a 
connection between the client card client ports, and the OCH trail, which establishes a connection 
between the client card trunk ports. The OCH trail is given the same name as the OCHNC. The OCHCC 
is given a system-generated name in the format: circuit-type_NE-name::unique sequence number. To 
edit the OCHCC circuit name, complete the “DLP-G424 Edit an OCHCC Circuit Name” task on 
page 17-28. To edit the OCH trail circuit name, complete the “DLP-G424 Edit an OCHCC Circuit 
Name” task on page 17-28.

Note Multiple OCHCCs might use the same OCH trail. The OCH Wlen (wavelength) parameter on the 
Circuits page can be used to determine the OCHCC and OCH trail associations.

Step 1 As needed, identify the OCHCC to be provisioned using the “DLP-G350 Use the Cisco Transport 
Planner Traffic Matrix Report” task on page 16-27.

Step 2 Complete the DLP-G46 Log into CTC at a node on the network where you want to upgrade the OCHNCs. 
If you are already logged in, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab and find the OCH you want to upgrade.

Step 5 Record the following information:

• OCHNC Wlen (OCHNC wavelength)

• Source node/shelf (if applicable)/slot/port/side (include both Side A and Side B nodes, if present)

• Destination node/shelf (if applicable)/slot/port/side (include both Side A and Side B nodes, if 
present)

Step 6 Use the information recorded in Step 5 to complete one of the following 

• DLP-G344 Verify Provisionable and Internal Patchcords, page 17-68—Complete this task if 
provisionable patchcords (PPCs) and internal patchcords exist on the network but you are not sure 
whether one was created for the OCHNC that you want to upgrade.

Purpose This procedure upgrades OCHNCs created in earlier software releases to 
OCHCCs. It also upgrades an OCHNC circuit to an OCH trail circuit 
(without the OCHCC circuit) in case the PPCs or internal patchcords 
connect to an ADM_10G or GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
(only in L2-over-DWDM mode) cards.

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• NTP-G184 Create a Provisionable Patchcord, page 17-78—Complete this procedure if you know 
that PPCs were not created between the OCHNC node and the client node. If you recently upgraded 
from a previous release, you must create PPCs between the source client and OCHNC node and 
between the destination client and OCHNC node.

Step 7 In network view, click the OCHNC that you want to upgrade. 

Step 8 From the Tools menu, choose Circuits > Upgrade OCHNC. If the Upgrade OCHNC Initialization 
“Completed” status appears (Figure 17-4), continue with Step 9. If the “Failed” status appears 
(Figure 17-5), complete the following substeps:

a. Click each failure reason to view the failure details. A common cause of initialization failures is the 
absence or incorrect completion of PPCs or internal patchcords between the client nodes and the 
optical channel (OCH) nodes. 

b. Repeat Steps 3 through 8, verifying that the OCHNC ports and provisionable patchcord (PPC) path 
match on both sides. If the upgrade “Failed” status appears again, click Save to save the results to a 
local or network computer. (The file can be opened with any text editor.) Then, contact your next 
level of support.

Figure 17-4 Upgrade OCHNC Initialization—Completed
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Click to display details
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Figure 17-5 Upgrade OCHNC Initialization—Failed

Step 9 Click each result to review the details. If you want to save the results, click Save and save the results to 
a file on a local or network computer. Click Continue.

Step 10 Review the information in the Upgrade OCHNC dialog box, then click OK.

Step 11 Click Yes in the confirmation dialog box, then click OK on the Completed Upgrade OCHNC wizard 
page.

Tip To see all of the information in the Source and Destination table cells, increase the column 
widths by clicking and dragging the column heading borders to the right or left.

Step 12 View the OCHCC and its OCH trail in the Circuits page. For information and procedures for viewing 
and editing OCHCC and OCH trails, see the “NTP-G58 Locate and View Optical Channel Circuits” 
procedure on page 17-71.

Stop. You have completed this procedure.
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DLP-G344 Verify Provisionable and Internal Patchcords

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Provisionable Patchcords (PPC) tabs.

Step 3 Use one of the following methods to verify that PPCs exist from the client TXP, MXP, ADM-10G, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, 
AR_XP, AR_XPE, or ITU-T line card node, slot, and port to the DWDM OCH node, slot, port, and 
wavelength:

• Review the Patchcord Terminations table. PPCs should exist from the client TXP, MXP, ADM-10G, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, 
AR_MXP, AR_XP, or AR_XPE, or ITU-T line card node to the OCH node, slot, and port recorded 
in the referring procedure. 

• Review the network graphic. PPCs are represented by a small hand holding a lambda symbol. 
Clicking the PPC line on the graphic displays the PPC source and destination nodes, slots, and ports 
in the CTC information area. This information should match the node, slot, and port recorded in the 
referring procedure.

Step 4 Display the OCHCC source node in node view. 

Step 5 Click the Provisioning > WDM-ANS > Internal Patchcords tab. 

Step 6 Verify that internal patchcords exist from the source TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, or AR_XPE OCH trunk 
port to the OCH filter port. If so, continue with Step 7. If not, complete the “NTP-G242 Create an 
Internal Patchcord Manually” task on page 14-112.

Step 7 Display the OCHCC destination node in node view. 

Step 8 Click the Provisioning > WDM-ANS > Internal Patchcords tab. 

Step 9 Verify that internal patchcords exist from the destination TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, OTU2_XP, 100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE trunk port to 
the OCH filter port. If so, you are completed with this task. If not, complete the “NTP-G242 Create an 
Internal Patchcord Manually” task on page 14-112.

Step 10 Return to your originating procedure (NTP).

Purpose This task verifies the PPCs that are required between client TXP, MXP, 
ADM-10G, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, OTU2_XP, 
100G-LC-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE, or 
ITU-T line cards and OCH DWDM nodes for OCHCCs. This task is not 
required for OCHNCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits

Note This procedure cannot be used for OCHCC circuits.

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you want to diagnose and fix the 
OCHNC or OCH trail circuit. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab.

Step 4 Click the OCHNC or OCH trail that you want to diagnose.

Step 5 Click Edit.

Step 6 In the Edit Circuit dialog box, click the Diagnostic and Fix tab.

Step 7 Click Start. The diagnostic checks all OCHNC or OCH trail node connections and displays the results 
in an expandable tree view under the OCH diagnostic heading.

Step 8 Double-click OCH diagnostic to display the diagnostic messages.

• No problems are found—A “node: No issues found” message appears, where node is the node name 
or IP address of an ONS 15454 containing the OCHNC or OCH trail source, destination, or 
pass-through connection. If this message appears for all nodes, continue with Step 9.

• Problems are found—double-click on the nodes with problems and the error messages appear with 
a hyperlink labeled Fix or Check. If error messages appear, complete the fixes using the tasks and 
procedures listed in Table 17-9.

Note Only one error per node is displayed. If multiple errors exist, you must fix the first error, 
then rerun the diagnostic to display the next error(s).

Purpose This procedure checks nodes that are traversed by an OCHNC or OCH trail 
circuit to verify that all conditions required for bringing the circuit in 
service are in place. If not, the procedure identifies the invalid condition 
and provides links to the location in CTC where it can be fixed.

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45, 
or DLP-G395 Create an Optical Channel Trail, page 17-35

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 If you want to save the diagnostic results to a text file, complete the following steps. If not, continue with 
Step 10. 

a. Click Save. 

b. In the Save Diagnostic and Fix to File dialog box, enter the local directory and file name, or click 
Browse to navigate to a directory where you want to save the file. 

c. Click OK. 

Step 10 Repeat Steps 7 through 9 until “No issues found” appears for all nodes traversed by the OCHNC or 
OCH trail circuit.

Stop. You have completed this procedure.

Table 17-9 Diagnostic and Fix Errors

Error Message Description/Fix

Invalid connection state 
for “circuit name”: 
administrative state

The circuit state is not valid. Click Fix to display the State tab of the 
Edit Circuit dialog box where you can change the circuit state using the 
“DLP-G419 Change an OCH Trail Administrative State” task on 
page 17-40 or the “DLP-G420 Change an OCHNC Administrative State” 
task on page 17-53.

Invalid admin state: 
administrative state

The state of a port traversed by the circuit is not valid, for example, the port 
is in service. Click Fix to display the card view Provisioning tab, where 
you can change the port administrative state using the appropriate task for 
changing the optical line settings in Chapter 21, “Change DWDM Card 
Settings.”

ANS couldn’t regulate the 
port

ANS could not be regulated for the port. Click Fix to display the node view 
Provisioning > WDM-ANS > Port Status tab where you can launch ANS 
using the “NTP-G37 Run Automatic Node Setup” task on page 14-126.

APC couldn’t regulate the 
port

APC could not be regulated for the port. Click Fix to display the network 
view Maintenance > APC tab. Double-click the domain to expand the 
view. Right-click the node/side and choose the end you want to view. APC 
information is displayed on the right side. Read any message that might 
explain the failure, or restart APC by completing the DLP-G158 Enable 
Automatic Power Control.

APC regulation is running Indicates that APC regulation is running and must be allowed to finish. 
Click Check to display the node view Maintenance > DWDM > APC tab 
where you can monitor the APC regulation.

APC is not enabled for 
this side.

APC is not enabled on an ONS 15454 side. Click Fix to display the 
network view Maintenance > APC tab where you can enable APC using 
the DLP-G158 Enable Automatic Power Control.
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NTP-G58 Locate and View Optical Channel Circuits

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you want to view the circuits. If 
you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 As needed, complete the “DLP-G100 Search for Optical Channel Circuits” task on page 17-71.

Step 3 As needed, complete the “DLP-G101 View Optical Channel Circuit Information” task on page 17-72.

Step 4 As needed, complete the “DLP-G102 Filter the Display of Optical Channel Circuits” task on page 17-75.

Step 5 As needed, complete the “DLP-G103 View Optical Channel Circuits on a Span” task on page 17-77.

Step 6 As needed, complete the DLP-G114 Export CTC Data.

Stop. You have completed this procedure.

DLP-G100 Search for Optical Channel Circuits

Step 1 Navigate to the appropriate CTC view:

• To search the entire network, from the View menu choose Go to Network View.

• To search for circuits that originate, terminate, or pass through a specific node, from the View menu 
choose Go to Other Node, then choose the node you want to search and click OK.

Purpose This procedure allows you to locate and view OCHNC, OCHCC and OCH 
trail circuits. You can also export circuit data into a text file.

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision Optical Channel Network Connections, page 17-45

DLP-G346 Provision Optical Channel Client Connections, page 17-18

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task searches for OCHNC, OCHCC, OCH trail, and ONS 15454 
circuits at the network, node, or card level. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• To search for circuits that originate, terminate, or pass through a specific card, double-click the card 
on the shelf graphic in node view (single-shelf mode) or shelf view (multishelf mode) to open the 
card in card view. 

Step 2 Click the Circuits tab.

Step 3 If you are in node or card view, choose the scope for the search, Node or Network (All), in the Scope 
drop-down list located at the bottom right side of the screen. Choose Node to see all of the circuits on 
that node, or choose Network (All) to see all circuits in the network.

Step 4 Click Search if you need to search through the list of circuits.

Step 5 In the Circuit Name Search dialog box, complete the following:

• Find What—Enter the text of the circuit name you want to find. This field is not case-sensitive.

• Match whole word only—Check this check box to instruct CTC to select circuits only if the entire 
word matches the text in the Find What field. 

• Match case—Check this check box to instruct CTC to select circuits only when the capitalization 
matches the capitalization entered in the Find What field.

• Direction—Choose the direction for the search. Searches are conducted up or down from the 
currently selected circuit.

Step 6 Click Find Next. If a match is found the circuit will be highlighted in the Circuits page. To continue the 
search, click Find Next again to find the next circuit.

Step 7 Repeat Steps 5 and 6 until you are finished, then click Cancel.

Step 8 Return to your originating procedure (NTP).

DLP-G101 View Optical Channel Circuit Information

Step 1 Navigate to the appropriate CTC view:

• To view circuits for an entire network, from the View menu choose Go to Network View.

• To view circuits that originate, terminate, or pass through a specific node, from the View menu 
choose Go to Other Node, then choose the node you want to search and click OK.

• To view circuits that originate, terminate, or pass through a specific card, in node view (single-shelf 
mode) or shelf view (multishelf mode), double-click the card containing the circuits you want to 
view.

Purpose This task provides information about OCHNC, OCHCC, OCH trail, and 
ONS 15454 circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note In node or card view, you can change the scope of the circuits that appear by choosing Card 
(in card view), Node, or Network from the Scope drop-down list in the bottom right corner 
of the Circuits page.

Step 2 Click the Circuits tab. The Circuits tab shows the following information:

Note The following order is the default column sequence, the order might be different on your screen, 
depending on your individual CTC setup. 

• Circuit Name—Name of the circuit. The circuit name can be manually assigned or automatically 
generated.

• Type—OCHNC, OCHCC, or OCH-Trail. 

Note The following circuit types are not applicable to DWDM nodes: STS, VT, VTT (VT tunnel), 
VAP (VT aggregation point), STS-v (STS VCAT circuit), VT-v (VT VCAT circuit), HOP 
(high-order circuit), LOP (low-order circuit), VCT (VC low-order tunnel), and VCA 
(low-order VCAT circuit).

• Size—Circuit size. OCHNC, OCHCC, and OCH-Trail sizes are Equipped not specific, Multi-rate, 
2.5 Gbps No FEC, 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC.

Note The following circuit types under the circuit size column are not applicable to DWDM 
nodes: STS, VT, VCAT, VC12, VC11, VC3, and VC4. 

• OCHNC Wlen—The wavelength provisioned for the OCHNC, OCHCC, or OCH trail. See 
Table 17-6 on page 17-20 for a list of channels and wavelengths.

• Dir—The circuit direction, either two-way or one-way.

• Protection—The type of circuit protection. See Table 17-10 on page 17-74 for a list of protection 
types.

• Status—The circuit status. See Table 17-11 on page 17-74 for a list of circuit statuses.

• Source—The circuit source in the format: node/slot/port “port name”. The port name will appear 
in quotes only if a name was assigned to it. (To assign names to ports, see the “DLP-G104 Assign a 
Name to a Port” task on page 17-16.)

• Destination—The circuit destination in the format: node/slot/port “port name”. The port name will 
appear in quotes only if a name was assigned to it. (To assign names to ports, see the “DLP-G104 
Assign a Name to a Port” task on page 17-16.)

• # of VLANS—The number of VLANs used by an Ethernet circuit. VLANs are not applicable to 
DWDM nodes.

• # of Spans—The number of internode links that constitute the circuit. Right-clicking the column 
title shows a shortcut menu from which you can choose Span Details to show or hide circuit span 
detail. 
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• State—The circuit service state, which is an aggregate of the service states of its cross-connects. For 
ANSI shelves, the service state is IS, OOS, or OOS-PARTIAL. For ETSI shelves, the service state 
is Unlocked, Locked, or Locked-partial. For more information about ANSI and ETSI service states, 
see the Administrative and Service States document. 

– IS/Unlocked—All cross-connects are in service and operational.

– OOS/Locked—For ANSI, all cross-connects are OOS-MA,MT and/or OOS-MA,DSBLD. For 
ETSI, all cross-connects are Locked-enabled,maintenance and/or Locked-enabled,disabled.

– OOS-PARTIAL/Locked-partial—At least one cross-connect is IS-NR (ANSI) or 
Unlocked-enabled (ETSI) and others are out-of-service.

Note Right-clicking a column title (Circuit name, Type, etc.) opens a shortcut menu that allows 
you to show or hide circuit details.

• Acpt Threshold—The optical validation acceptance threshold value set for the GMPLS circuit. For 
more information on the threshold values, see the “12.10.1.2 Acceptance Thresholds” section on 
page 12-110.

• Opt Val—The optical validation result for the GMPLS circuit. For more information on the optical 
validation values, see the “12.10.1.3 Validation Modes” section on page 12-110.

Table 17-10 Circuit Protection Types

Protection Type Description

Y-cable (OCHNC and OCH-Trail circuit types only) The circuit is protected by a 
transponder or muxponder card Y-cable protection group.

Splitter The circuit is protected by the protect transponder splitter protection.

Unprot A circuit with a source and destination on different nodes is not protected. 

N/A A circuit with connections on the same node is not protected. 

Unknown A circuit has a source and destination on different nodes and communication 
is down between the nodes. This protection type appears if not all circuit 
components are known.

Table 17-11 Cisco ONS 15454 Circuit Status

Status Definition/Activity

CREATING CTC is creating a circuit.

DISCOVERED CTC created a circuit. All components are in place and a complete path exists 
from the circuit source to the circuit destination.

DELETING CTC is deleting a circuit.
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Step 3 Return to your originating procedure (NTP).

DLP-G102 Filter the Display of Optical Channel Circuits

PARTIAL A CTC-created circuit is missing a cross-connect or network span, a complete 
path from source to destination(s) does not exist, or an alarm interface panel 
(AIP) change occurred on one of the circuit nodes and the circuit is in need 
of repair. (AIPs store the node MAC address.)

In CTC, circuits are represented using cross-connects and network spans. If a 
network span is missing from a circuit, the circuit status is PARTIAL. 
However, a PARTIAL status does not necessarily mean that a circuit traffic 
failure has occurred, because traffic might flow on a protect path. 

Network spans are in one of two states: up or down. On CTC circuit and 
network maps, up spans are shown as green lines, and down spans are shown 
as gray lines. If a failure occurs on a network span during a CTC session, the 
span remains on the network map but its color changes to gray to indicate the 
span is down. If you restart your CTC session while the failure is active, the 
new CTC session cannot discover the span and its span line will not appear 
on the network map. 

Subsequently, circuits routed on a network span that goes down will appear 
as DISCOVERED during the current CTC session, but they will appear as 
PARTIAL to users who log in after the span failure. 

This status does not appear for OCHNC circuit types.

DISCOVERED_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is complete. A 
complete path from source to destination(s) exists. 

This status does not appear for OCHNC circuit types.

PARTIAL_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is missing a 
cross-connect, and a complete path from source to destination(s) does not 
exist. 

This status does not appear for OCHNC circuit types.

Purpose This task filters the display of OCHNCs, OCHCCs, OCH trails and 
SONET or SDH circuits in the Circuits page. You can filter the circuits in 
network, node, or card view based on circuit or OCHNC name, size, type, 
direction, and other attributes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Table 17-11 Cisco ONS 15454 Circuit Status (continued)

Status Definition/Activity
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Step 1 Navigate to the appropriate CTC view:

• To filter network circuits, from the View menu choose Go to Network View.

• To filter circuits that originate, terminate, or pass through a specific node, from the View menu 
choose Go to Other Node, then choose the node you want to search and click OK.

• To filter circuits that originate, terminate, or pass through a specific card, double-click the card on 
the shelf graphic in node view (single-shelf mode) or shelf view (multishelf mode) to open the card 
in card view. 

Step 2 Click the Circuits tab.

Step 3 Set the attributes for filtering the circuit display:

a. Click the Filter button.

b. In the General tab of the Circuit Filter dialog box, set the following filter attributes, as necessary:

• Name—Enter a complete or partial circuit name to filter circuits based on the circuit name.

• Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way 
circuits), or 2-way (display only two-way circuits).

• OCHNC Wlen—(DWDM OCHNCs only) Choose an OCHNC wavelength to filter the circuits. 
For example, choosing 1530.33 will display channels provisioned on the 1530.33-nm 
wavelength.

• Status—Choose one: Any (status not used to filter circuits) or Discovered (display only 
discovered circuits). Other statuses do not apply to OCHNCs. 

• State—Choose one: OOS (ANSI) or Locked (ETSI) to display only out-of-service circuits, 
IS (ANSI) or Unlocked (ETSI) to display only in-service circuits (OCHNCs have IS/Unlocked 
states only), or OOS-PARTIAL (ANSI) or Locked-partial (ETSI) to display only circuits with 
cross-connects in mixed service states.

• Protection—Enter the circuit protection type to filter circuits based on their protection.

• Shelf—(multishelf nodes only) Enter the shelf name to filter circuits based on that shelf.

• Slot—Enter a slot number to filter circuits based on the source or destination slot.

• Port—Enter a port number to filter circuits based on the source or destination port. 

• Type—Choose one: Any (type not used to filter circuits), OCHNC (displays only OCHNCs), 
OCHCC (displays only OCHCCs), or OCH-Trail (displays only OCH trail circuits). 

Note The following circuit types are not applicable to DWDM nodes: STS, VT, VT Tunnel, 
STS-V, VT-V, and VT Aggregation Point, VC_HO_PATH_CIRCUIT, 
VC_LO_PATH_CIRCUIT, VC_LO_PATH_TUNNEL, VC_LO_PATH_AGGREGATION, 
VC_HO_PATH_VCAT_CIRCUIT, and VC_LO_PATH_VCAT_CIRCUIT.

• Size—Click the appropriate check boxes to filter circuits based on size. The following sizes are 
available, depending on the circuit type: Multi-rate, Equipment non specific, 2.5 Gbps FEC, 
2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC. 

Note VT1.5, STS-1, STS3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, and STS-192c are not 
applicable to ANSI DWDM nodes. VC12, VC3, VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, 
VC4-8c, VC4-9c, VC4-16c, and VC4-64 are not applicable to ETSI DWDM nodes.
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The check boxes shown depend on the Type field selection. If you chose Any, all sizes are 
available. If you chose OCHNC as the circuit type, only Multi-rate, Equipment non specific, 
2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC appear. If you choose 
OCHCC, only OCHCC is available. If you choose OCH Trail, only Equipment non specific is 
available.

Step 4 To set the filter for the ring, node, link, and source and drop types, click the Advanced tab and complete 
the following substeps. If you do not want to make advanced filter selections, continue with Step 5.

a. If you made selections on the General tab, click Yes in the confirmation box to apply the settings.

b. In the Advanced tab of the Circuit Filter dialog box, set the following filter attributes as necessary:

• Ring—Choose the ring from the drop-down list. 

• Node—Click the check boxes by each node in the network to filter circuits based on node.

• Link—Choose a link in the network.

• Source/Drop—Choose one of the following to filter circuits based on whether they have single 
or multiple sources and drops: One Source and One Drop Only or Multiple Sources or 
Multiple Drops.

Step 5 Click OK. Circuits matching the attributes in the Filter Circuits dialog box appear in the Circuits page.

Step 6 To turn filtering off, click the Filter icon in the lower right corner of the Circuits page. Click the icon 
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 7 Return to your originating procedure (NTP).

DLP-G103 View Optical Channel Circuits on a Span

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), from the View menu choose 
Go to Network View. If you are already in network view, continue with Step 2.

Step 2 Right-click the green line between the nodes containing the circuits that you want to view and choose 
Circuits to view OCHNCs, OCHCCs, or unprotected circuits on the span.

Step 3 In the Circuits on Span dialog box, view information about the circuits that traverse the span. The 
information that appears depends on the circuit type. For OCHNCs, the following information appears:

• Type—The type of circuit: OCHNC, OCHCC, or OCH-Trail.

• Size—The circuit size.

• OCHNC Wavelength—The wavelength provisioned for the OCHNC.

• DIR—2-way or 1-way.

Purpose This task allows you to view OCHNCs, OCHCCs, and OCH trails on an 
ONS 15454 span. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• Circuit—The OCHNC circuit name.

• OCHNC Dir—The direction provisioned for the OCHNC, either Side B to Side A or Side A to 
Side B.

Step 4 Return to your originating procedure (NTP).

NTP-G184 Create a Provisionable Patchcord

Note If a Side-to-Side PPC is created between nodes, it will no longer function if the node Security Mode 
mode is enabled (see “DLP-G264 Enable Node Security Mode” task on page 14-25). If the Secure mode 
is enabled, the DCN extension feature is unable to use the LAN interface to extend the internal network 
(due to the network isolation in this configuration mode). The result is that the topology discovery on 
the Side-to-Side PPC no longer operates.

Note This task requires data communications channel (DCC) or generic communications channel (GCC) 
connectivity between the OCH node and the subtended TXP, MXP, or ITU-T line card client shelves.

Note An optical port requires two patchcords when the remote end is Y-cable protected, or is an add/drop 
multiplexer, or multiplexer/demultiplexer port.

Note This procedure automatically turns on any OPT-RAMP-C or OPT-RAMP-CE cards installed.

Step 1 Complete the following tasks, as needed, to verify the cabling between the TXP/MXP/line cards in the 
client node and the OCH cards in the DWDM node:

Purpose This procedure creates a provisionable patchcord (PPC), also called a 
virtual link. Four types of PPCs can be created:

• Client/Trunk to Client/Trunk (L2)

• Client/Trunk to Client/Trunk

• Side to Side (OTS)

• OCH-Trunk to OCH-Filter

PPCs create a virtual connection between the OCH and the client nodes. 
(PPCs are not required for OCHNCs.) 

Tools/Equipment OC-N, TXP, MXP, OADM, ROADM, multiplexer (MUX), and 
demultiplexer (DMX) cards

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• DLP-G349 Use the Cisco Transport Planner Internal Connections Report, page 14-78

• DLP-G350 Use the Cisco Transport Planner Traffic Matrix Report, page 16-27

Step 2 In the node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Comm Channels > PPC tabs. Alternatively, in network view, click the Provisioning > Provisionable 
Patchcord (PPC) tabs. 

PPCs can be created in either node or network view. However, if you create the PPC in node view, the 
PPC origination ports will be restricted to the cards installed on the node. Therefore, choose node view 
only if you know that the PPC origination port resides on a card installed in the node.

Note You can create OTS-to-OTS PPC only in the network view.

Step 3 Click Create. The PPC Attributes page of the PPC Creation wizard appears.

Step 4 Choose one of the following PPC link types. Table 17-2 provides a list of ports that serve as PPC 
endpoints for each option. However, if Cisco 7600 node is used as the client node, then choose only the 
OCH-Trunk to OCH-Filter link type.

• Client/Trunk to Client/Trunk (L2)—Creates a PPC between two NNI client or trunk ports on 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE cards provisioned in L2-over-DWDM mode.

• Client/Trunk to Client/Trunk—Creates a PPC between two optical channel trunk ports on TXP, 
MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, or ITU-T line cards.

• Side to Side (OTS)—Creates a PPC between two OTS (optical transport section) ports that belong 
to a Side. This option establishes DCN connectivity between nodes that do not have OSCM or 
OSC-CSM cards installed or TNC OSC provisioned and therefore do not have OSC connectivity. 
CTC selects the OTS ports after you choose the origination and termination sides.

• OCH-Trunk to OCH-Filter—Creates a PPC between an optical channel trunk port on a TXP, MXP, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, ADM-10G, OTU2_XP, or ITU-T line card, or 
Cisco 7600 series node and an optical channel filter port on a MUX, DMX, or WSS card; or 
ADD/DROP port of a 15216-FLD-4, or 15216-MD-40-EVEN, 15216-EF-40-EVEN, 
15216-MD-48-EVEN, 15216-MD-40-ODD, 15216-EF-40-ODD, or 15216-MD-48-ODD passive 
module.

Table 17-12 Provisionable Patchcord Ports

Card Client/Trunk (L2) Port Client/Trunk Port OTS Port OCH Filter Port

GE_XP

10GE_XP

GE_XPE

10GE_XPE

Client or trunk port in 
NNI mode

Any trunk port — —

TXP 

MXP

ADM-10G

OTU2_XP

ITU-T 

— Any trunk port — —
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OPT-BST

OPT-BST-E

OPT-BST-L

— — LINE RX

LINE TX

—

OPT-AMP-17-C

OPT-AMP-C

OPT-AMP-L

— — COM RX1

COM TX1

LINE RX2

LINE TX2

—

OPT-PRE — — COM RX3

COM TX3

—

OPT-RAMP-C

OPT-RAMP-CE

15454-M-RAMAN-CTP

15454-M-RAMAN-COP

— — LINE RX

LINE TX

—

40-SMR1-C

40-SMR2-C

— — LINE RX

LINE TX

—

32MUX

32MUX-O 

40-MUX-C

— — — Any CHAN 
RX port

32DMX

32DMX-L

32DMX-O

40-DMX-C

40-DMX-CE

— — — Any CHAN 
TX port

32WSS

32WSS-L

40-WSS-C

40-WSS-CE

— — — Any ADD port

40-WXC-C — — COM RX

COM TX

—

80-WXC-C — — EAD(i), i=1 to 
8

COM 

AD

COM RX

DROP TX

EXP TX 

—

Table 17-12 Provisionable Patchcord Ports (continued)

Card Client/Trunk (L2) Port Client/Trunk Port OTS Port OCH Filter Port
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Step 5 If you chose Client/Trunk to Client/Trunk or OCH-Trunk to OCH-Filter in Step 4, complete the 
following fields. If you chose Client/Trunk to Client/Trunk (L2) or Side to Side (OTS) (in Step 4, 
continue with Step 6. 

• OCHNC Wavelength—(OCH Trunk to OCH Filter only) From the drop-down lists, choose the 
wavelength band (C or L), wavelength number type (Odd or Even), and then the wavelength.

MMU — — EXP A RX

EXP A TX

—

40-SMR2-C — — — ADD-RX

DROP-RX

EXP-TX

EXPi-RX

40-SMR1-C — — — ADD-RX

DROP-RX

EXP-TX

EXP-RX

LINE-RX

LINE-TX

TDC-CC

TDC-FC

— — — DC-RX

DC-TX

XT-40G

XM-40G

XM-40G-CE

XT-40G-CE

— Any trunk port — —

15216-MD-40-ODD

15216-MD-40-EVEN

— — — Any CHAN 
RX/TX port

15216-EF-40-ODD

15216-EF-40-EVEN

— — — Any CHAN 
RX/TX port

15216-MD-48-ODD

15216-MD-48-EVEN

— — — Any CHAN 
RX/TX port

15216-FLD-4 — — — Any CHAN 
RX/TX port

1. When Card Mode is OPT-PRET.

2. When Card Mode is OPT-LINE.

3. Line nodes with two OPT-PRE cards and no BST cards installed.

Table 17-12 Provisionable Patchcord Ports (continued)

Card Client/Trunk (L2) Port Client/Trunk Port OTS Port OCH Filter Port
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Note Same wavelengths must be set at both the ends of a virtual link (Cisco 7600 node and the DWDM 
node). This wavelength must be set on the Cisco 7600 series router port on which the PPC or 
virtual link is configured.

• Protected—Check this box if you want only protected cards and ports to appear as options in the 
OCHNC origination and termination pages.

Step 6 Click Next.

Step 7 In the PPC Origination page, complete the fields shown in Table 17-13. The table columns indicate 
whether the field is provisionable based on the option chosen in Step 4.

Table 17-13 PPC Origination Fields

Field Description
Client/Trunk to 
Client/Trunk(L2)

Client/Trunk to 
Client/Trunk

OCH-Trunk to 
OCH-Filter

Side to 
Side (OTS)

Node Choose the node 
where the PPC will 
originate.

Yes Yes Yes Yes

(IPoDWDM using 
Cisco 7600) Choose 
the DWDM node as 
the PPC termination 
node.

No No Yes No

Side Choose the side 
where the PPC will 
originate.

No No No Yes

Shelf (Multishelf only) 
Choose the shelf 
where the PPC will 
originate.

Yes Yes Yes Yes

Slot Choose the slot 
where the PPC will 
originate.

Yes Yes Yes Yes

Port Choose the port 
where the PPC will 
originate.

Yes Yes Yes No

Tx Port (Display only) The 
OTS TX port where 
the PPC will 
originate.

No No No Yes

Rx Port Choose the RX port 
where the PPC will 
originate.

No No No Yes

Protection (Display only) 
Displays the 
protection option 
chosen in Step 5, if 
applicable.

No Yes Yes No
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Step 8 Click Next. If you chose Client/Trunk to Client/Trunk or OCH Trunk to OCH Filter with the Protected 
option in Step 4, continue with Step 9. If not, continue with Step 11.

Step 9 In the PPC Protect Termination page, provision the ID fields. If you chose OCH Trunk to OCH Trunk in 
Step 4, one ID field is available. If you chose OCH Trunk to OCH Filter in Step 4, two ID fields are 
available, Rx ID and Tx ID.

Step 10 Click Next.

Step 11 In the PPC Termination page, complete the fields shown in Table 17-14. The OCH Trunk to OCH Trunk, 
OCH Trunk to OCH Filter, and Side to Side (OTS) columns indicate whether the field is provisionable.

ID Displays the ID 
automatically 
assigned to the PPC. 

Yes Yes No No

Tx ID Displays the transmit 
ID automatically 
assigned to the PPC. 

No No Yes Yes

Rx ID Displays the receive 
ID automatically 
assigned to the PPC. 

No No Yes Yes

Table 17-14 PPC Termination Fields

Field Description
Client/Trunk to 
Client/Trunk (L2)

Client/Trunk 
to 
Client/Trunk

OCH Trunk to 
OCH Filter

Side to 
Side 
(OTS)

Node Choose the node where the 
PPC will terminate.

Yes Yes Yes Yes

(IPoDWDM using 
Cisco 7600) Choose the 
DWDM node as the PPC 
termination node.

No No Yes No

Side Choose the side where the 
PPC will terminate.

No No No Yes

Shelf (Multishelf only) Choose 
the shelf where the PPC 
will terminate.

Yes Yes Yes Yes

Slot Choose the slot where the 
PPC will terminate.

Yes Yes Yes Yes

Port Choose the port where the 
PPC will terminate.

Yes Yes No No

Tx Port Choose the TX port where 
the PPC will terminate.

No No Yes Yes

Rx Port Choose the RX port where 
the PPC will terminate.

No No Yes Yes

Table 17-13 PPC Origination Fields (continued)

Field Description
Client/Trunk to 
Client/Trunk(L2)

Client/Trunk to 
Client/Trunk

OCH-Trunk to 
OCH-Filter

Side to 
Side (OTS)
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Step 12 Click Next. If you chose Client/Trunk to Client/Trunk or OCH Trunk to OCH Filter with the Protected 
option in Step 4, continue with Step 13. If not, continue with Step 14.

Step 13 In the PPC Protect Termination page, provision the ID fields. If you chose Client/Trunk to Client/Trunk 
in Step 4, one ID field is available. If you chose OCH Trunk to OCH Filter in Step 4, two ID fields are 
available, Rx ID and Tx ID.

Step 14 In the PPCs ID page, review the PPC information. If the PPC information is correct, click Finish. If you 
need to make corrections, click Back and return to the wizard page where you want to change the 
information.

Stop. You have completed this procedure.

NTP-G181 Manage GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
Card SVLAN Databases

Protection (Display only) Displays 
the protection option 
chosen in Step 5, if 
applicable.

No Yes No No

ID Displays the ID 
automatically assigned to 
the PPC.

Yes Yes No No

Rx ID Displays the receive ID 
automatically assigned to 
the PPC.

No No Yes Yes

Tx ID Displays the transmit ID 
automatically assigned to 
the PPC.

No No Yes Yes

Table 17-14 PPC Termination Fields (continued)

Field Description
Client/Trunk to 
Client/Trunk (L2)

Client/Trunk 
to 
Client/Trunk

OCH Trunk to 
OCH Filter

Side to 
Side 
(OTS)

Purpose This procedure creates a service provider VLAN (SVLAN) database for 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards provisioned in 
L2-over-DWDM mode. The procedure stores newly created SVLANs in 
the card (each card has its own SVLAN DB). It also loads and merges 
SVLAN databases into the VLAN DB tab where they can be edited.

Tools/Equipment OC-N, TXP, MXP, OADM, ROADM, multiplexer (MUX), and 
demultiplexer (DMX) cards

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the DLP-G46 Log into CTC at the node on the network where you will manage the GE_XP, 
10GE_XP, GE_XPE, and 10GE_XPE SVLAN databases. 

Step 2 As needed, complete the following tasks: 

• DLP-G421 Create and Store an SVLAN Database, page 17-85

• DLP-G382 Add and Remove SVLANS to/from GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE NNI 
Ports, page 11-418

• DLP-G422 Load or Merge an SVLAN Database, page 17-86

Stop. You have completed this procedure.

DLP-G421 Create and Store an SVLAN Database

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > SVLAN > SVLAN DB tabs.

Step 3 In the box next to the Add row(s) button, enter the number of SVLANs you want to create.

Step 4 Click Add row(s).

Step 5 For each SVLAN row, enter the following:

• SVLAN ID—Enter the SVLAN ID. The range is 1 to 4093 with the following restrictions:

– 0 indicates an untagged frame.

– The database can contain a maximum of 4092 unprotected SVLANS. However, it can contain a 
maximum of 1024 protected SVLANs.

• SVLAN Name—Enter the SVLAN name. It can be up to 32 alphanumeric characters.

• Protection—If this is a protected SVLAN, check the Protection check box. A maximum of 1024 
SVLANs can be protected.

• MAC Learning—Enables or disables MAC learning for the port. MAC learning is used by Layer 2 
switches to learn the MAC addresses of network nodes so they know where to send traffic. Layer 2 
switches including the GE_XP and 10GE_XP cards in L2-over-DWDM mode maintain a MAC 
learning table that associates the MAC addresses and VLANs with a given port.

Note MAC address table aging is 300 seconds. It cannot be changed. To set this option, the card mode 
must be L2-over-DWDM.

Purpose This task creates an SVLAN for a network of GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE cards provisioned in L2-over-DWDM mode. It then stores 
the SVLAN database on the card and not on the node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• IGMP—Enables or disables the Internet Group Management Protocol (IGMP). By default, IGMP is 
disabled.

• IGMP Fast Leave—Enables or disables the IGMP fast leave. By default, IGMP fast leave is disabled.

• IGMP Suppression—Enables or disables the IGMP report suppression. By default, IGMP 
Suppression is disabled.

Step 6 Click Store.

Step 7 In the Store SVLAN DB dialog box, choose one of the following:

• To Node(s)—Stores the SVLAN database in one or more network nodes. Choose the network nodes 
where you want to store the SVLAN database. 

• Shelf—Appears only when the node is provisioned as a multishelf. Choose the shelf where you want 
to store the SVLAN database.

• Slot—Choose the slot containing the card where the SVLAN database is stored. To choose more 
than one slot, press the Shift key, or click Select All.

• To File—Stores the SVLAN database in a file. Enter a file name, then click Browse to navigate to 
a local or network drive where you want to store the file.

Step 8 Click OK.

Step 9 Return to your originating procedure (NTP).

DLP-G422 Load or Merge an SVLAN Database

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > SVLAN > SVLAN DB tabs.

Step 3 Click one of the following:

• Load—Loads an SVLAN database from the card or local file and replaces any SVLANs that are in 
the network view VLAN DB table.

• Merge—Loads a SVLAN database from the card or local file, but does not replace any SVLANs 
that are in the network view VLAN DB table. The loaded database is merged with any SVLANs that 
might be in the table.

Step 4 In the Load SVLAN DB dialog box, choose one of the following:

• From Node—Loads the SVLAN database from the card. Choose the card where you want to load 
the SVLAN database.

Purpose This task loads or merges an SVLAN database stored on the card or local 
file into the VLAN DB tab on the CTC network view.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Shelf—Appears only when the node is provisioned as a multishelf. Choose the shelf where you want 
to load the SVLAN database.

• Slot—Choose the slot containing the card where you want to load the SVLAN database from.

• From File—Loads the SVLAN database from a file. Enter the file path in the blank field, or click 
Browse to navigate to a local or network directory containing the database file. 

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

NTP-G60 Create and Delete Overhead Circuits

Note The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes 
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication 
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1 Complete the DLP-G46 Log into CTC at the node where you will create the overhead circuit. If you are 
already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 17-88.

Step 3 As needed, complete the “DLP-G97 Provision a Proxy Tunnel” task on page 17-90.

Step 4 As needed, complete the “DLP-G98 Provision a Firewall Tunnel” task on page 17-91.

Step 5 As needed, complete the “DLP-G109 Provision Orderwire” task on page 17-92.

Step 6 As needed, complete the “DLP-G110 Create a User Data Channel Circuit” task on page 17-94.

Step 7 As needed, complete the “DLP-G112 Delete Overhead Circuits” task on page 17-95.

Stop. You have completed this procedure.

Purpose This procedure creates overhead circuits on an ONS 15454 network. 
Overhead circuits include ITU-T GCCs, the AIC-I card orderwire, and the 
AIC-I card UDC.

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G76 Provision DCC/GCC Terminations

Note For the OTU2_XP card, you can provision the GCC on any ITU-T G.709-enabled port in Transponder 
card configuration and on any port in Standard Regen or Enhanced FEC card configuration. The 
OTU2_XP card supports a maximum of three GCC terminations (on port 3, port 4, and either port 1 or 
2) at a time.

Note The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes 
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication 
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1 If you are provisioning DCC termination on the TXP and MXP card, set the termination mode of the card 
as appropriate. See the “G.37 Termination Modes” section on page G-36 for details.

Step 2 If you are provisioning DCC termination, ensure that the OTN is disabled on OTN interfaces (usually 
trunk ports). If OTN is enabled, provision GCC instead of DCC termination. For more information about 
managing OTN setting on the card, see the “11.25 Procedures for Transponder and Muxponder Cards” 
section on page 11-163.

Step 3 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Comm Channels > GCC tabs.

Step 4 Select the DCC or GCC tabs as necessary. Available tabs are:

• GCC (both ANSI and ETSI)

Note For AR_MXP, AR_XP, and AR_XPE cards, GCC goes down after changing the trunk state to 
IS,AINS (ANSI) or Unlocked,automaticInService (ETSI). The GCC comes up when the trunk 
state changes to IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) after the specified 
soak time.

• DCC

– SDCC and LDCC (for ANSI)

– RS-DCC and MS-DCC (for ETSI)

Step 5 Click the Create button. The Create Terminations dialog box appears.

Purpose This task creates the DWDM DCC/GCC terminations required for network 
setup when using the TXP, MXP, and XP cards. Perform this task before 
you create OCHCC or OCHNC circuits for these cards. In this task, you 
can also set up the node so that it has direct IP access to a far-end non-ONS 
node over the DCC/GCC network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Select the ports where you want to create the DCC/GCC termination. To select more than one port, press 
the Shift key or the Ctrl key.

Step 7 Under Port Admin State area, select one of the following:

• Leave unchanged—Does not change the DCC/GCC termination port administrative state.

• Set to IS or Set to Unlocked —Puts the DCC/GCC termination port in service.

• Set OOS,DSLBD to IS,AINS (for ANSI) or Set Locked,disabled to 
Unlocked,automaticInService (for ETSI)—Changes a port that is currently out of service or locked 
to automatic in service.

• Set OOS,DSLBD to OOS,MT (for ANSI) or Set Locked,disabled to Locked,maintenance (for 
ETSI)—Changes a port that is currently out of service or locked to out of service for maintenance.

Step 8 For GCC termination, the GCC Rate is set as 192 kbps by default. For AR_MXP, AR_XP, and AR_XPE 
cards provisioned on 15454 ONS M6 and 15454 ONS M2 shelves, the GCC rate can be set to 400 kbps 
and 1200 kbps for OTU1 and OTU2 ports respectively. For 10x10G-LC cards, the GCC rate can be set 
to 400 kbps for OTU2 ports. For 100G-LC-C cards, the GCC rate can be set to 400 kbps and 1200 kbps 
for OTU4 and trunk ports. For CFP-LC cards, the GCC rate can be set to 400 kbps and 1200 kbps on the 
OTU3 virtual port of the peer 100G-LC-C card.

Note Ensure that the same GCC rate is configured at both ends of a GCC channel.

Step 9 Verify that the Disable OSPF on Link is unchecked. If this check box is checked, node discovery through 
the link termination will not happen.

Step 10 If the DCC/GCC termination includes a non-ONS node, check the Far End is Foreign check box. This 
automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be specified 
by the far end. To change the default to a specific IP address, see the DLP-G184 Change a GCC 
Termination.

Step 11 In the Layer 3 area, perform one of the following options:

• Check the IP box only if the DCC/GCC is between the ONS 15454 and another ONS node and only 
ONS nodes reside on the network. The DCC/GCC will use Point-to-Point Protocol (PPP).

• Check both the IP box and the OSI box if the DCC/GCC is between the ONS 15454 and another 
ONS node, and third-party NEs that use the OSI protocol stack are on the same network. The 
DCC/GCC will use PPP.

Step 12 If you checked OSI, complete the following substeps. If you checked IP only, continue with Step 13.

a. Click Next.

b. Provision the following fields:

– Router—Choose the OSI router.

– ESH—Sets the End System Hello (ESH) propagation frequency. End system (ES) NEs transmit 
ESHs to inform other ESs and intermediate systems (ISs) about the Network Service Access 
Points (NSAPs) that the ES NEs serve. The default is 10 seconds. The range is 10 to 1000 
seconds.

– ISH—Sets the Intermediate System Hello (ISH) protocol data unit (PDU) propagation 
frequency. IS NEs send ISHs to other ESs and ISs to inform them about the IS NEs that the IS 
NEs serve. The default is 10 seconds. The range is 10 to 1000 seconds.

– IIH—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation 
frequency. The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default 
is 3 seconds. The range is 1 to 600 seconds.
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– IS-IS Cost—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the 
cost to calculate the shortest routing path. The default metric cost for LAN subnets is 60. The 
cost normally should not be changed.

Step 13 Click Finish. The following alarms appear until all the network DCC/GCC terminations are created and 
the ports are in service:

• GCC-EOC for GCC termination

• EOC for SDCC termination

• EOC-L for LDCC termination

Step 14 Return to your originating procedure (NTP).

DLP-G97 Provision a Proxy Tunnel

Note If the proxy server is disabled, you cannot set up a proxy tunnel. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > Proxy tabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following fields:

• Source Address—Type the IP address of the source node (32-bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32-bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

Purpose This task sets up a proxy tunnel to communicate with a non-ONS far-end 
node. Proxy tunnels are only necessary when the proxy server is enabled 
and a foreign GCC termination exists, or if static routes exist so that the 
GCC network is used to access remote networks or devices. You can 
provision a maximum of 12 proxy server tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G76 Provision DCC/GCC Terminations, page 17-88 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G98 Provision a Firewall Tunnel

Note If the proxy server is configured as proxy-only or is disabled, you cannot set up a firewall tunnel. 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > Firewall tabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following fields:

• Source Address—Type the IP address of the source node (32-bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32-bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

DLP-G108 Change the Service State for a Port

Purpose This task provisions destinations that will not be blocked by the firewall. 
Firewall tunnels are only necessary when the proxy server is enabled and a 
foreign GCC termination exists, or if static routes cause the GCC network 
to access remote networks or devices. You can provision a maximum of 12 
firewall tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G76 Provision DCC/GCC Terminations, page 17-88 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task puts a port in service or removes a port from service. After 
creating an IP-encapsulated tunnel, put the ports that are hosting the 
IP-encapsulated tunnel in service.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note For more information about service states, see the Administrative and Service States document.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode) on the shelf graphic, double-click the 
card with the ports you want to put in or out of service. The card view appears.

Step 2 Click the Provisioning > Line tabs.

Step 3 In the Admin State column for the target port, choose one of the following from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)—Puts the port in the IS-NR (ANSI) or Unlocked-enabled (ETSI) 
service state. 

• OOS,DSBLD (ANSI) or Locked,disabled (ETSI)—Puts the port in the OOS-MA,DSBLD (ANSI) 
or Locked-enabled,disabled (ETSI) service state. 

For ANSI nodes, traffic is not passed on the port until the service state is changed to IS-NR; 
OOS-MA,MT; or Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS). For 
ETSI nodes, traffic is not passed on the port until the service state is changed to Unlocked-enabled; 
Locked-enabled,maintenance; or Unlocked-disabled,automaticInService.

• OOS,MT (ANSI) or Locked,maintenance (ETSI)—Puts the port in the 
OOS-MA,MT/Locked-enabled,maintenance service state. This state does not interrupt traffic flow, 
but alarm reporting is suppressed and loopbacks are allowed. Raised fault conditions, whether or not 
their alarms are reported, can be retrieved from the CTC Conditions tab or by using the TL1 
RTRV-COND command. Use the OOS-MA,MT/Locked-enabled,maintenance administrative state 
for testing or to suppress alarms temporarily. Change to the IS-NR/Unlocked-enabled or 
OOS-AU,AINS/Unlocked-disabled,automaticInService administrative states when testing is 
complete.

• IS,AINS (ANSI) or Unlocked,automaticInService (ETSI)—Puts the port in the 
OOS-AU,AINS/Unlocked-enabled,automaticInService service state. In this state, alarm reporting is 
suppressed, but traffic is carried and loopbacks are allowed. After the soak period passes, the port 
changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether their alarms are reported or 
not, can be retrieved from the CTC Conditions tab or by using the TL1 RTRV-COND command.

Step 4 If you set the Admin State field to IS-AINS or Unlocked,automaticInService, set the soak period time in 
the AINS Soak field. This is the amount of time that the port will stay in the OOS-AU,AINS or 
Unlocked-enabled,automaticInService state after a signal is continuously received. When the soak 
period elapses, the port changes to the IS-NR or Unlocked-enabled state.

Step 5 Click Apply. The new port service state appears in the Service State column.

Step 6 As needed, repeat this task for each port.

Step 7 Return to your originating procedure (NTP).

DLP-G109 Provision Orderwire

Purpose This task provisions orderwire on the AIC-I card. 

Tools/Equipment An AIC-I card must be installed in Slot 9.

An OSCM, OSC-CSM, MXP_2.5_10E, MXP_2.5_10G, 
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed. 
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Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create. 

Step 4 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire 
path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use 
either local or express orderwire channels. If regenerators exist, use the express orderwire channel. 
You can provision up to four ONS 15454 OC-N/STM-N ports for each orderwire path.

• PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law 
(North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both 
types of orderwire.

Caution When provisioning orderwire for ONS 15454 nodes residing in a ring, do not provision a complete 
orderwire loop. For example, a four-node ring typically has Side B and Side A ports provisioned at all 
four nodes. However, to prevent orderwire loops, provision two orderwire ports (Side B and Side A) at 
all but one of the ring nodes.

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following information:

• Node—Choose the source node.

• Shelf—(Multishelf mode only) Choose the source shelf.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following information:

• Node—Choose the destination node.

• Shelf—(Multishelf mode only) Choose the destination shelf.

• Slot—Choose the destination slot.

• Port—If applicable, choose the destination port.

Step 9 Click Finish.

Step 10 Return to your originating procedure (NTP).

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G110 Create a User Data Channel Circuit

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create.

Step 4 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down list. 
(User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following information:

• Node—Choose the source node.

• Shelf—(Multishelf mode only) Choose the source shelf.

• Slot—Choose the source slot.

• Port—If applicable, choose the source port.

Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following information:

• Node—Choose the destination node.

• Shelf—(Multishelf mode only) Choose the destination shelf.

• Slot—Choose the destination slot.

• Port—If applicable, choose the destination port.

Step 9 Click Finish.

Step 10 Return to your originating procedure (NTP). 

Purpose This task creates a UDC circuit on the ONS 15454. A UDC circuit allows 
you to create a dedicated data channel between nodes. 

Tools/Equipment An OSCM, OSC-CSM, MXPP_MR_2.5G, or MXP_MR_2.5G card must 
be installed. 

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G112 Delete Overhead Circuits

Caution Deleting overhead circuits is service affecting if the circuits are in service (IS). To put circuits out of 
service (OOS), see the “DLP-G108 Change the Service State for a Port” task on page 17-91.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click the overhead circuit that you want to delete: local or express orderwire, user data, IP-encapsulated 
tunnel, or DCC tunnel.

Step 4 Click Delete.

Step 5 In the confirmation dialog box, click Yes to continue.

Step 6 Return to your originating procedure (NTP).

NTP-G62 Create a J0 Section Trace 

Step 1 Complete the DLP-G46 Log into CTC at a node on the network where you will create the section trace. 
If you are already logged in, continue with Step 2.

Purpose This task deletes overhead circuits. Overhead circuits include 
IP-encapsulated tunnels, AIC-I card orderwire, and UDCs.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to traffic between nodes. 

Tools/Equipment One TXP or MXP card must be installed.

Prerequisite Procedures NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

DLP-G223 Change the 4x2.5G Muxponder Line Settings, page 11-285

 (if necessary)

DLP-G224 Change the 4x2.5G Muxponder Section Trace Settings, 
page 11-287

Required/As Needed As needed (optional if path trace is set)

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card.

Step 3 Click the Provisioning > Line > Section Trace tabs.

Step 4 From the Port drop-down list, choose the port for the section trace.

Step 5 From the Received Trace Mode drop-down list, enable the section trace expected string by choosing 
Manual.

Step 6 In the Transmit Section Trace String Size area, click 1 byte or 16 byte. The 1 byte option allows you to 
enter one character and the 16 byte option allows a 15 character string.

Step 7 In the New Transmit String field, enter the string that you want to transmit. Enter a string that makes the 
destination port easy to identify, such as the node IP address, node name, or another string. If the 
New Transmit String field is left blank, the J0 transmits a string of null characters.

Step 8 If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive 
from the source port in the New Expected String field. 

Step 9 If the card's Termination mode is set to Line, click the Disable AIS and RDI if TIM-P is detected check 
box if you want to suppress the alarm indication signal (AIS) and remote defect indication (RDI) when 
the STS Section Trace Identifier Mismatch Path (TIM-P) alarm appears. If the card's Termination mode 
is set to Section, the Disable AIS and RDI if TIM-P is detected check box will be grayed out and you 
will not be able to select it. Continue on to Step 10. Refer to the Cisco ONS 15454 DWDM 
Troubleshooting Guide for descriptions of alarms and conditions.

Step 10 Click Apply.

Step 11 After you set up the section trace, the received string appears in the Received field. The following 
options are available:

• Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII 
Mode. Click ASCII Mode to return the section trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds.

Stop. You have completed this procedure.

NTP-G203 Create End-to-End SVLAN Circuits

Purpose This procedure manually creates an end-to-end SVLAN circuit for the 
GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards provisioned in 
L2-over-DWDM mode.

Tools/Equipment None
17-96
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 17      Create Optical Channel Circuits and Provisionable Patchcords
DLP-  G112 Delete Overhead Circuits
Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits > SVLAN tabs. 

Step 3 Click Create.

Step 4 Define the circuit attributes:

• Name—Assign a name to the source SVLAN circuit. The name can be alphanumeric and up to 48 
characters (including spaces). If you leave the field blank, CTC assigns a default name to the source 
cross-connect.

• Type—(Display only) SVLAN.

• SVLAN ID—Displays the SVLAN identifier. Enter a SVLAN ID between 1 and 4093. 

Note Do not duplicate SVLAN IDs.

• Protection—Before enabling SVLAN protection be sure to define the master node in the OCH Ring 
that contains the circuit. Protection must be enabled in order to have a SVLAN protected circuit 
provisioned. 
Check/uncheck to enable/disable SVLAN protection. A maximum of 1024 SVLANs can be 
protected. 

Step 5 Click Next.

Step 6 Provision the circuit source (UNI or NNI client interfaces):

a. From the Node drop-down list, choose the circuit source node. 

b. From the Slot drop-down list, choose the slot where the card exists.

c. From the Port drop-down list, choose the port where the circuit must originate (UNI or NNI client 
ports).

Step 7 Click QinQ Settings. Provision the IEEE 802.1QinQ VLAN tags on the GE_XP, 10GE_XP, GE_XPE, 
or 10GE_XPE cards. See the “DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
QinQ Settings” task on page 11-421.

Step 8 Click Next.

Step 9 Provision the circuit destination (UNI or NNI client interfaces):

a. From the Node drop-down list, choose the circuit destination node.

b. From the Slot drop-down list, choose the slot where the card exists.

c. From the Port drop-down list, choose the port where the circuit must terminate (UNI or NNI client 
ports). 

Prerequisite Procedures DLP-G46 Log into CTC

DLP-G379 Change the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE Card 
Mode, page 11-170

DLP-G421 Create and Store an SVLAN Database, page 17-85

NTP-G178 Create, Delete, and Manage Optical Channel Trails, page 17-34

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 10 Click QinQ Settings. Provision the IEEE 802.1QinQ VLAN tags on the GE_XP, 10GE_XP, GE_XPE, 
and 10GE_XPE cards. See DLP-G384 Provision the GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE 
QinQ Settings, page 11-421.

Step 11 Click Next.

Step 12 The SVLAN Circuit Routing Preview pane provides the following information:

• SVLAN Circuit Path—Nodes and spans. Click a node to select it. Blue arrows show the new SVLAN 
route. Move your cursor over the arrow to view span information including source, destination, and 
span loss information.

• Selected Node—Node that is currently chosen in the graphic. All actions that are invoked will apply 
to this node.

• Included Nodes—Nodes that are included in the circuit path.

• Excluded Nodes—Nodes that are excluded from the circuit path. 

• Include—Includes the node displayed in the Selected Node field in the circuit path. Click Apply to 
update the circuit with the new constraints. This option is not applicable for protected SVLAN 
circuits.

• Exclude—Excludes the node displayed in the Selected Node field from the circuit path. Click Apply 
to update the circuit with the new constraints. This option is not applicable for protected SVLAN 
circuits.

Step 13 Click Finish to complete the circuit creation.

Step 14 To edit the SVLAN circuit, see instructions described in the “DLP-G472 Edit the End-to-End SVLAN 
Circuit” section on page 17-98.

Stop. You have completed this procedure.

DLP-G472 Edit the End-to-End SVLAN Circuit

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits > SVLAN tabs.

Step 3 Select the SVLAN circuit that you want to edit and click Edit.

The Edit Circuit pane appears. 

• Use the General tab to view circuit information (circuit type, size, protection type, and routing 
preference), and to modify the circuit name.

• Use the End Points tab to view and define new circuit drops for the SVLAN circuit. 

Purpose This task edits an end-to-end SVLAN circuit. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
17-98
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 17      Create Optical Channel Circuits and Provisionable Patchcords
DLP-  G472 Edit the End-to-End SVLAN Circuit
Step 4 Return to your originating procedure (NTP). 

NTP-G229 Provision DCN Extension for a Network Using 
GCC/DCC

Step 1 Complete the DLP-G46 Log into CTC at a node on the network (for example, Node A) where you want 
to provision the DCN extension. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 17-45, to 
create an OCHNC DCN circuit for the wavelength of the transponder (TXP) to be used for the GCC 
channel.

Step 3 Complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 17-88, to create a GCC 
service channel on the transponder in Node A.

Step 4 Complete the DLP-G46 Log into CTC at another node on the network (for example, Node B) where you 
want to provision the DCN extension. 

Step 5 Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 17-45, to 
create an OCHNC DCN circuit for the wavelength of the transponder to be used for the GCC channel.

Step 6 Complete the “DLP-G76 Provision DCC/GCC Terminations” task on page 17-88, to create a GCC 
service channel on the transponder in Node B.

Step 7 Turn up the circuit by forcing an ALS manual restart on the line-facing amplifier:

a. Double-click the line-facing amplifier card

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Manual Restart.

d. Click Apply. Click Yes in the confirmation dialog box.

Step 8 When the circuit is up, CTC discovers the GCC topology and shows the two nodes (Node A and B) 
connected by the GCC link.

Step 9 Complete the “NTP-G184 Create a Provisionable Patchcord” task on page 17-78, to create an 
OTS-to-OTS PPC between the two nodes.

Step 10 Complete the “DLP-G472 Merge two OCHNC DCN Circuits” task on page 17-100, to merge the two 
OCHNC DCN circuits into a single OCHNC circuit.

Stop. You have completed this procedure.

Purpose This procedure provisions a DCN extension for a network using GCC/DCC 
as the communication channel

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G472 Merge two OCHNC DCN Circuits

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Circuits tab.

Step 3 Select one of the OCHNC DCN circuits that you want to merge and click Edit. The Edit Circuit pane 
appears.

Step 4 Click Merge tab.

Step 5 Select the other OCHNC DCN circuit that you want to merge and click Merge. 

Step 6 Return to your originating procedure (NTP). 

NTP-G245 Create an Automatically Routed VCAT Circuit

Note This procedure requires the use of automatic routing. Automatic routing is not available if both the 
Automatic Circuit Routing NE default and the Network Circuit Automatic Routing Overridable NE 
default are set to FALSE. To view the NE default values, go to Shelf View and click the 
Provisioning->NE Defaults tab. For a full description of these defaults, see the Network Element 
Defaults section.

Step 1 Complete the DLP-G46 Log into CTC at the node where you would create the VCAT circuit. If you are 
already logged in, continue with Step 2.

Step 2 You must provision Ethernet or POS ports first before creating a VCAT circuit. Complete the following 
as necessary:

• To provision Ethernet ports for ADM-10G circuits, complete the “DLP-G551 Provision ADM-10G 
Ethernet Ports” task on page 17-107.

Purpose This task merges two OCHNC DCN circuits into a single OCHNC circuit

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates an automatically routed VCAT circuit.

Tools/Equipment ADM-10G card.

Prerequisite Procedures ADM-10G card must be installed at the nodes used in the VCAT circuit. 
Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• To provision a VCAT circuit that traverses through a third-party network, complete the “DLP-G553 
Create a Server Trail” procedure on page 17-108.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, choose STS-V or VC_HO_PATH_VCAT_CIRCUIT from the 
Circuit Type drop-down list. Click Next.

Step 6 Define the circuit attributes as follows:

• Name—Type the circuit name. The name can be alphanumeric and up to 48 characters (including 
spaces). Circuit names should be 43 characters or less if you want the ability to create monitor 
circuits. If you leave the field blank, CTC assigns a default name to the circuit. Monitor circuits are 
secondary circuits that monitor traffic on primary bidirectional circuits.

• Type—Displays the circuit type you chose in Step 5.

• Bidirectional—Checked by default and creates a bidirectional circuit.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. 

• Apply to drop ports—Check this check box to apply the IS administrative state to the circuit source 
and destination ports. The IS state is applied to the ports only if the circuit bandwidth is the same as 
the port bandwidth, or if the port bandwidth is larger than the circuit, the circuit must be the first 
circuit to use the port. If not, a Warning dialog box shows the ports where the administrative state 
could not be applied. If the check box is unchecked, CTC does not change the service state of the 
source and destination ports.

Note If the ports in the IS-state do not receive signals, then the loss of signal alarms are generated. 
This transitions the ports from the IS state to OOS-AU,FLT state.

• Symmetric—Checked by default. A bi-directional symmetrical VCAT circuit consists of only one 
VCAT member group. All member circuits are bi-directional circuits.

• Open VCAT—Check this check box to create open-ended VCAT circuits.

• Member size—Choose the member size. Choose the size of each member circuit in the VCG. 
STS1/STS3c for ANSI and VC4 for ETSI. For information about the member size that ADM-10G 
card supports, see Chapter 11, “Provision Transponder and Muxponder Cards”.

• Num. of members—Choose the number of members. The number of members defines how much 
bandwidth is required at the trunk. Thus depending on bandwidth requirements of the ethernet traffic 
on the GE ports, choose appropriate number of members. For information about the number of 
members that ADM-10G card supports, see Chapter 11, “Provision Transponder and Muxponder 
Cards”.

Note In ADM-10G cards, the Gigabit Ethernet port does not support flow control. When less than 
seven VC-4s are configured for the port, with the client traffic expected to be below the line rate, 
a burst in traffic beyond the supposed bandwidth leads to packet loss. It is, therefore, 
recommended to use an external flow control mechanism with less than seven VC-4s configured. 
Connecting a GE-XP or GE-XPE card between the client traffic and the ADM-10G Gigabit 
Ethernet interface enables such flow control.

• Mode—Select “None”. The ADM-10G card supports only pure VCAT and does not support 
SW-LCAS or HW-LCAS.
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Note A failure on one member causes the entire VCAT circuit to fail. For ADM-10G card, you can add or 
delete members after creating a VCAT circuit with no protection. But while adding or deleting the 
members, the entire VCAT circuit does not carry traffic.

Step 7 Click Next. 

Step 8 Complete the “DLP-G555 Provision a VCAT Circuit Source and Destination” task on page 17-111 for 
the VCAT circuit you are creating. If you are creating an open-ended VCAT circuit, complete the 
“DLP-G556 Provision an Open VCAT Circuit Source and Destination” task on page 17-111.

Step 9 In the VCAT Circuit Routing Preferences area, choose Route Automatically. The following options are 
available (choose either, both, or none based on your preferences).

• Using Required Nodes/Spans—Check this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

Including nodes and spans for a circuit ensures that those nodes and spans are in the working path 
of the circuit (but not the protect path). Excluding nodes and spans ensures that the nodes and spans 
are not in the working or protect path of the circuit.

• Review Route Before Creation—Check this check box to review and edit the circuit route before the 
circuit is created (you can see all the spans the circuit is traversing before the circuit creation is 
completed).

Step 10 If the VCAT circuit has a source or destination on a ADM-10G card, choose one of the following routing 
types. 

• Common Routing—Routes the members on the same fiber. 

• Split Routing—Allows the individual members to be routed on different fibers or each member to 
have different routing constraints. Split routing is required when creating circuits over a path 
protection configuration. 

If the VCAT circuit does not have a source or destination on a ADM-10G card, common routing is 
automatically selected and you cannot change it.

Step 11 If you want to set preferences for individual members, complete the following in the Member 
Preferences area. Repeat for each member. To set identical preferences for all members, skip this step 
and continue with Step 12:

• Number—Choose a number (between 1 and 256) from the drop-down list to identify the member.

• Name—Type a unique name to identify the member. The name can be alphanumeric and up to 
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to the 
circuit.

• Protection—Choose the member protection type:

– Fully Protected—Routes the circuit on a protected path. 

– Unprotected—Creates an unprotected circuit.

– PCA—Routes the circuit on a BLSR protection channel. 

– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.

• Node-Diverse Path—(Split routing only) Available for each member when Fully Protected is 
chosen.

Step 12 To set preferences for all members, complete the following in the Set Preferences for All Members area:

• Protection—Choose the member protection type:

– Fully Protected—Routes the circuit on a protected path. 
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– Unprotected—Creates an unprotected circuit.

– PCA—Routes the member on a BLSR protection channel. 

– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.

• Node-Diverse Path—(Split routing only) Available when Fully Protected is chosen.

Step 13 Click Next. If you chose Fully Protected or PCA, click OK to continue. If not, continue with the next 
step.

Step 14 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue 
with Step 15:

a. In the Circuit Constraints area, choose the member that you want to route from the Route member 
number drop-down list.

b. Click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit, or click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit is routed. Click spans twice to change the circuit direction. 

d. Repeat Steps b and c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node in the Required 
Nodes/Lines or Excluded Nodes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

f. Repeat Steps a through e for each member.

Step 15 If you selected Review Route Before Creation in Step 9, complete the following substeps. If not continue 
with Step 16:

a. In the Route Review/Edit area, choose the member that you want to route from the Route Member 
Number drop-down list.

b. Click a node or span on the circuit map.

c. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows indicate the circuit route. Green arrows indicate spans that you can add. Click a span 
arrowhead, then click Include to include the span or Remove to remove the span.

d. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-G246 Create a Manually Routed VCAT Circuit” procedure on page 17-104 to assign the 
circuit route yourself.

e. Repeat Steps a through d for each member.

Step 16 Click Finish. The Circuits window appears.

Note Depending on the complexity of the network and number of members, the VCAT circuit creation 
process can take several minutes. 

Step 17 In the Circuits window, verify that the circuit you created appears in the circuits list.

Stop. You have completed this procedure.
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NTP-G246 Create a Manually Routed VCAT Circuit

Step 1 Complete the DLP-G46 Log into CTC at the node where you would create the circuit. If you are already 
logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 17-16. If not, continue with Step 3.

Step 3 You must provision Ethernet or POS ports first before creating a VCAT circuit. Complete the following 
as necessary:

• To provision Ethernet ports for ADM-10G circuits, complete the “DLP-G551 Provision ADM-10G 
Ethernet Ports” task on page 17-107.

• To provision a VCAT circuit that traverses through a third-party network, complete the “DLP-G553 
Create a Server Trail” procedure on page 17-108.

Step 4 From the View menu, choose Go to Network View. 

Step 5 In the Circuit Creation dialog box, choose STS-V or VC_HO_PATH_VCAT_CIRCUIT from the 
Circuit Type drop-down list. Click Next.

Step 6 Define the circuit attributes as follows:

• Name—Type the circuit name. The name can be alphanumeric and up to 48 characters (including 
spaces). Circuit names should be 43 characters or less if you want the ability to create monitor 
circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Displays the circuit type you chose in Step 5.

• Bidirectional—Checked by default and creates a bidirectional circuit.

• Create cross-connects only (TL1-like)—Check this check box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. 

• Apply to drop ports—Check this check box to apply the IS administrative state to the circuit source 
and destination ports. The IS state is applied to the ports only if the circuit bandwidth is the same as 
the port bandwidth, or if the port bandwidth is larger than the circuit, the circuit must be the first 
circuit to use the port. If not, a Warning dialog box shows the ports where the administrative state 
could not be applied. If the check box is unchecked, CTC does not change the service state of the 
source and destination ports.

• Symmetric—Checked is the default. A bi-directional symmetrical VCAT circuit consists of only one 
VCAT member group. All member circuits are bi-directional circuits.

• Open VCAT—Check this check box to create open-ended VCAT circuits.

• Member size—Choose the member size. Choose the size of each member circuit in the VCG. 
STS1/STS3c for ANSI and VC4 for ETSI. For information about the member size that ADM-10G 
card supports, see Chapter 11, “Provision Transponder and Muxponder Cards”.

Purpose This procedure creates a manually routed VCAT circuit.

Tools/Equipment ADM-10G card.

Prerequisite Procedures ADM-10G card must be installed at the nodes used in the VCAT circuit. 
Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Num. of members—Choose the number of members. The number of members defines how much 
bandwidth is required at the trunk. Thus depending on bandwidth requirements of the ethernet traffic 
on the GE ports, choose appropriate number of members. For information about the number of 
members that ADM-10G card supports, see Chapter 11, “Provision Transponder and Muxponder 
Cards”.

Note In ADM-10G cards, the Gigabit Ethernet port does not support flow control. When less than 
seven VC-4s are configured for the port, with the client traffic expected to be below the line rate, 
a burst in traffic beyond the supposed bandwidth leads to packet loss. It is, therefore, 
recommended to use an external flow control mechanism with less than seven VC-4s configured. 
Connecting a GE-XP or GE-XPE card between the client traffic and the ADM-10G Gigabit 
Ethernet interface enables such flow control.

• Mode—ADM-10G card supports only pure VCAT and does not support SW-LCAS or HW-LCAS.

Note A failure on one member causes the entire VCAT circuit to fail. For ADM-10G card, you can add or 
delete members after creating a VCAT circuit with no protection. But while adding or deleting the 
members, the entire VCAT circuit does not carry traffic.

Step 7 Click Next. 

Step 8 Complete the “DLP-G555 Provision a VCAT Circuit Source and Destination” task on page 17-111 for 
the VCAT circuit you are creating. If you are creating an open-ended VCAT circuit, complete the 
“DLP-G556 Provision an Open VCAT Circuit Source and Destination” task on page 17-111.

Step 9 In the Circuit Routing Preferences area, uncheck Route Automatically. 

Step 10 If the VCAT circuit has a source or destination on a ADM-10G card, choose one of the following routing 
types. 

• Common Routing—Routes the members on the same fiber.

• Split Routing—Allows the individual members to be routed on different fibers or each member to 
have different routing constraints. Split routing is required when creating circuits over a path 
protection configuration. 

If the VCAT circuit does not have a source or destination on a ADM-10G card, common routing is 
automatically selected and you cannot change it.

Step 11 If you want to set preferences for individual members, complete the following in the Member 
Preferences area. Repeat for each member. To set identical preferences for all members, skip this step 
and continue with Step 12.

• Number—Choose a number (between 1 and 256) from the drop-down list to identify the member. 

• Name—Type a unique name to identify the member. The name can be alphanumeric and up to 
48 characters (including spaces). If you leave the field blank, CTC assigns a default name to the 
circuit.

• Protection—Choose the member protection type:

– Fully Protected—Routes the circuit on a protected path. 

– Unprotected—Creates an unprotected circuit.

– PCA—Routes the member on a BLSR protection channel. 

– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.
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• Node-Diverse Path—(Split routing only) Available for each member when Fully Protected is 
chosen.

Step 12 To set preferences for all members, complete the following in the Set Preferences for All Members area:

• Protection—Choose the member protection type:

– Fully Protected—Routes the circuit on a protected path. 

– Unprotected—Creates an unprotected circuit.

– PCA—Routes the member on a BLSR protection channel. 

– DRI—(Split routing only) Routes the member on a dual-ring interconnect circuit.

• Node-Diverse Path—(Split routing only) Available when Fully Protected is chosen.

Step 13 Click Next. If you chose Fully Protected or PCA, click OK. If not, continue with the next step.

Step 14 In the Route Review and Edit area, node icons appear so you can route the circuit manually.

Step 15 Complete the “DLP-G557 Provision a VCAT Circuit Route” task on page 17-112.

Step 16 Click Finish. If the path does not meet the specified path diversity requirement, CTC displays an error 
message and allows you to change the circuit path. 

Note Depending on the complexity of the network and number of members, the VCAT circuit creation 
process can take several minutes. 

Step 17 When all the circuits are created, the main Circuits window appears. Verify that the circuit you created 
appears in the window.

Stop. You have completed this procedure.

NTP-G247 Enable or disable Path Performance Monitoring on 
Intermediate Nodes

Note For PM parameter definitions, see the 11.15.15 Performance Monitoring Parameter Definitions, 
page 11-94 section.

Step 1 In node view, double-click the ADM-10G card to display the card view.

Step 2 Click the Provisioning > Line > SONET STS tabs

Purpose This task enables or disables path performance monitoring on STS 
circuits of intermediate nodes carrying high volume traffic.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 In the Provisioning->Line->SONET STS pane, check the Enable IPPM check box to enable path 
performance monitoring on the STS circuit. Uncheck (default option) the Enable IPPM to disable path 
performance monitoring on the STS circuit.

Step 4 Click Apply.

Step 5 Click the Performance tab to view PM parameters.

Step 6 Return to your originating procedure (NTP).

DLP-G551 Provision ADM-10G Ethernet Ports

Step 1 Complete DLP-G411 Provision an ADM-10G PPM and Port, page 11-171 to provision the PPM.

Step 2 In node view (single-shelf view) or shelf view (multishelf view), double-click the ADM-10G card to 
display the card view.

Step 3 Click the Provisioning > Line > Ethernet tabs.

Step 4 For each ADM-10G port, provision the following parameters:

• Port Name—Enter a logical name that defines the port. 

• Admin State—Select the service state from the drop-down list. See the “DLP-G108 Change the 
Service State for a Port” task on page 17-91 for more information.

• MTU—The maximum size of the Ethernet frames accepted by the port. For jumbo size Ethernet 
frames, choose jumbo (the valid range is 64-9216) or select 1548 (default). 

• Framing Type—Choose GPF-F POS framing (the default) or HDLC POS framing. The framing 
type needs to match the framing type of the POS device at the end of the circuit.

• CRC Encap—With GFP-F framing, you can configure a 32-bit cyclic redundancy check (CRC) or 
none (no CRC) (the default). HDLC framing provides a set 16-bit or 32-bit CRC. The encap and 
CRC should be set to match the encap and CRC of the POS device on the end of the circuit.

Step 5 Click Apply.

Step 6 Refresh the statistics to get the current RMON counts:

a. Click the Performance > Statistics tabs.

b. Click Refresh.

Step 7 Return to your originating procedure (NTP).

Purpose This task provisions ADM-10G Ethernet ports to carry traffic. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G553 Create a Server Trail

Note You cannot create server trails on ports with DCC links. 

Step 1 Complete the DLP-G46 Log into CTC at the node where you would create the circuit. If you are already 
logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Provisioning > Server Trails tabs.

Step 4 Click Create.

Step 5 In the Server Trail Creation dialog box, complete the following fields:

• Type—Choose STS or VC.

• Size—Depending on the type selected, choose the server trail size. For STSs, choose STS-1, 
STS-3c, STS-6c, STS-9c, STS-12c, or STS-24c; for VCs, choose VC-4, VC-4-2c, VC-4-3c, 
VC-4-4c, or VC4-8c 

• Protection Type—Choose one of the following protection types: Preemptible, Unprotected, or 
Fully Protected. The server trail protection sets the protection type for any circuit that traverses it.

– Preemptible— PCA circuits will use server trails with the Preemptible attribute.

– Unprotected—In Unprotected Server Trail, CTC assumes that the circuits going out from that 
specific port will not be protected by provider network and will look for a secondary path from 
source to destination if you are creating a protected circuit.

– Fully Protected—In Fully Protected Server Trail, CTC assumes that the circuits going out from 
that specific port will be protected by provider network and will not look for a secondary path 
from source to destination.

• Number of Trails—Enter the number of server trails. Number of trails determine the number of 
circuits that can be created on server trail. You can create a maximum of 3744 server trails on a node. 
You can create multiple server trails from the same port. This is determined by how many circuits 
of a particular server trail size can be supported on the port.

• SRLG—Enter a value for the Shared Resource Link Group (SRLG). SRLG is used by Cisco 
Transport Manager (CTM) to specify link diversity. The SRLG field has no restrictions. If you create 
multiple server trails from one port, you can assign the same SRLG value to all the links to indicate 
that they originate from the same port.

Step 6 Click Next.

Step 7 In the Source area, complete the following:

• From the Node drop-down list, choose the node where the server trail originates.

Purpose This procedure creates a server trail, which provides a connection between 
ONS nodes through a third-party network. You can create server trails 
between any two optical ports.

Tools/Equipment None

Prerequisite Procedures Chapter 14, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• From the Slot drop-down list, choose the slot containing the card where the server trail originates. 
(If a card’s capacity is fully utilized, the card does not appear in the list.)

• Depending on the origination card, choose the source port and/or STS or VC from the Port and STS 
or VC lists. The Port list is only available if the card contains multiple ports. STSs and VCs do not 
appear if they are already in use by other circuits.

Step 8 Click Next.

Step 9 In the Destination area, complete the following:

• From the Node drop-down list, choose the destination node.

• From the Slot drop-down list, choose the slot containing the card where the server trail will 
terminate (destination card). (If a card’s capacity is fully utilized, the card does not appear in the 
list.)

• Depending on the card selected, choose the destination port and/or STS or VC from the Port and 
STS or VC drop-down lists. The Port drop-down list is available only if the card has multiple ports. 
The STSs that appear depend on the card, circuit size, and protection scheme. 

Step 10 Click Finish.

Note When Server Trails are created on an IPv4 or IPv6 node and the IP address of the node changes, complete 
the “DLP-G554 Repair Server Trails” task on page 17-109 to repair the Server Trails.

Stop. You have completed this procedure.

DLP-G554 Repair Server Trails

Note The Server Trail Repair wizard can only fix the IP address changes and cannot fix Server Trail 
terminations when you migrate from IPv4 to IPv6 addresses.

Note The Server Trail Repair wizard cannot repair the server trails when IP address of nodes on both ends of 
the Server Trail are changed.

Purpose This procedure repairs server trail terminations in cases where the IP 
address changes for a node connected by a Server Trail link.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
17-109
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 17      Create Optical Channel Circuits and Provisionable Patchcords
DLP-  G554 Repair Server Trails
Note When server trails are created on an IPv4 or IPv6 node and the IP address of the node changes, make 
sure that the Server Trail Repair wizard is launched on the IP address of the node that changed. For 
example, if the IP address of server trails created on an IPv4 node changes, run the Server Trail Repair 
wizard on the IPv4 node and not on the IPv6 node.

Step 1 Complete the DLP-G46 Log into CTC at the node where you would repair server trails. If you are already 
logged in, continue with Step 2.

Note The Server Trail Repair wizard works only when nodes at both ends of the server trail are added 
in the CTC. If CTC is launched after the IP address is changed or if the node on any of the sides 
is not discovered automatically, then the node has to be added manually into the CTC.

Step 2 From the View menu, choose Go to Network View.

Step 3 Choose the Tools > Links > Repair Server Trails option from the tool bar.
The Server Trail Repair wizard appears.

Step 4 Specify the changed IP address.
The Server Trail Repair window provides the following options:

• Try to discover IP address changes—The wizard searches and displays the list of changed IP 
addresses.

Note The wizard can discover multiple IP address changes. However, the wizard can repair only 
one IP address change at a time. To repair multiple IP address changes, run the Server Trail 
Repair wizard multiple times.

• Apply the following IP change—Allows you to specify the changed IP address.

Select the node with the changed IP address and specify old IP address as Original IP Address. The 
wizard automatically displays the current IP address.

Step 5 Click Next.
If you selected the “Try to discover IP address changes” option in Step 4, then the wizard displays all 
the IP address changes that will be fixed. Click Next.

If you selected the “Apply the following IP change” option in Step 4, continue with Step 6.

Step 6 The Server Trail Terminations to Repair window appears. Click Finish to repair the server trails.

Stop. You have completed this procedure.
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DLP-G555 Provision a VCAT Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source.

Step 1 From the Node drop-down list (in the Source/Destination selection pane), choose the node where the 
circuit originates.

Step 2 From the Slot drop-down list, choose the slot containing the ADM-10G card where the circuit originates. 
(If a card’s capacity (bandwidth) is fully utilized, it does not appear in the list.)

Step 3 Depending on the circuit origination card, choose the source port.

Step 4 Click Next.

Step 5 From the Node drop-down list, choose the destination node.

Step 6 From the Slot drop-down list, choose the slot containing the ADM10-G card where the circuit will 
terminate (destination card). (If a card’s capacity (bandwidth) is fully utilized, the card does not appear 
in the list.)

Step 7 Choose the destination port.

Step 8 Click Next.

Step 9 Return to your originating procedure (NTP).

DLP-G556 Provision an Open VCAT Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source.

Purpose This task provisions a virtual concatenated (VCAT) circuit source and 
destination.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task provisions an open virtual concatenated (VCAT) circuit source 
and destination.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 From the Node drop-down list (in the Source/Destination selection pane), choose the node where the 
circuit originates.

Step 2 From the Slot drop-down list, choose the slot containing the ADM-10G card where the circuit originates. 
(If a card’s capacity (bandwidth) is fully utilized, it does not appear in the list.)

Step 3 Depending on the circuit origination card, choose the source port.

Step 4 Click Next.

Step 5 Click the Auto-ranged Destinations check box to select the endpoints (CCAT/VCAT) automatically. 
Only the first endpoint needs to be selected; all the other endpoints are automatically created.

If you have not chosen auto-ranged destinations from the card selected in Step 2, then choose the source 
port and/or STS. If applicable, choose VC from the Port and STS drop down-lists. The Port drop-down 
list is available only if the card has multiple ports. STSs and VCs do not appear if they are already in use 
by other circuits.

Step 6 From the Select Destinations For drop-down list, choose the member number.

Step 7 From the Node drop-down list, choose the destination node.

Step 8 From the Slot drop-down list, choose the slot containing the card where the circuit will terminate 
(destination card). (If a card’s capacity (bandwidth) is fully utilized, the card does not appear in the list.) 
Non-data cards may be used for open VCAT circuits. The cards that do not have ethernet ports are 
non-data cards.

Step 9 Click Add Destinations.

Step 10 Click Next.

Step 11 Verify that the open VCAT circuit source and destination appears.

Step 12 Return to your originating procedure (NTP).

DLP-G557 Provision a VCAT Circuit Route

Step 1 In the Circuit Creation wizard in the Route Review and Edit area, choose the member number from the 
Route Member Number drop-down list.

Step 2 Click the source node icon if it is not already selected.

Step 3 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns yellow. In the Selected Span area, the From and To fields provide span information. The 
source STS or VC appears. 

Step 4 Click Add Span. The span is added to the Included Spans list and the span arrow turns blue. 

Purpose This task provisions the circuit route for manually routed VCAT circuits.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Repeat Steps 3 and 4 until the circuit is provisioned from the source to the destination node through all 
intermediary nodes. 

Step 6 Repeat Steps 1 through 5 for each member.

Step 7 Verify that a VCAT circuit route is provisioned.

Step 8 Return to your originating procedure (NTP).
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Monitor Performance

The information in this chapter is in a new location. See Monitor Performance for the performance 
monitoring (PM) parameters and concepts that are defined for dense wavelength division multiplexing 
(DWDM) cards in Cisco ONS 15454. PM parameters are used by service providers to gather, store, set 
thresholds, and report performance data for early detection of problems. This chapter also explains how 
to enable and view PM statistics.
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Manage the Node

The information in this chapter is in a new location. See Manage the Node for information related to 
modifying node provisioning for the Cisco ONS 15454 and performing common management tasks such 
as monitoring the dense wavelength division multiplexing (DWDM) automatic power control (APC) and 
span loss values.
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Alarm and TCA Monitoring and Management

The information in this chapter is in a new location. See Alarm and TCA Monitoring and Management 
for Cisco Transport Controller (CTC) alarm and threshold crossing alert (TCA) monitoring and 
management.
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Change DWDM Card Settings

This chapter explains how to change line, performance monitoring (PM), and threshold settings on 
Cisco ONS 15454 DWDM cards. To install cards, see the “NTP-G30 Install the DWDM Cards” 
procedure on page 14-64.

Note The procedures and tasks described in this chapter for the Cisco ONS 15454 platform is applicable to 
the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise.

Note Unless otherwise specified, the term “ONS 15454” refers to both ANSI and ETSI shelf assemblies and 
card parameters apply to cards installed in both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary. 

Caution Changing card settings can be service affecting. You should make all changes during a scheduled 
maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G90 Modify OSCM and OSC-CSM Card Line Settings and PM Thresholds, 
page 21-2—Complete as needed.

2. NTP-G91 Modify OPT-PRE and OPT-BST Card Line Settings and PM Thresholds, 
page 21-13—Complete as needed.

3. NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card Line 
Settings and PM Thresholds, page 21-27—Complete as needed.

4. NTP-G202 Modify PSM Card Line Settings and PM Thresholds, page 21-47—Complete as needed.

5. NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
40-DMX-CE, and 4MD-xx.x Line Card Settings and PM Thresholds, page 21-54—Complete as 
needed.
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6. NTP-G93 Modify the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Line Settings and PM 
Thresholds, page 21-65—Complete as needed.

7. NTP-G174 Modify the 40-WXC-C or 80-WXC-C Line Settings and PM Thresholds, 
page 21-79—Complete as needed.

8. NTP-G241 Modify the 40-SMR1-C and 40-SMR2-C Line Settings and PM Thresholds, 
page 21-96—Complete as needed.

9. NTP-G149 Modify the MMU Line Settings and PM Thresholds, page 21-116—Complete as needed.

10. NTP-G101 Modify Alarm Interface Controller–International Settings, page 21-119—As needed, 
complete this procedure to change settings for external alarms, controls, and orderwire for the AIC-I 
card.

11. NTP-G102 Change Card Service State, page 21-122—Complete as needed.

12. NTP-G240 Modify TDC-CC and TDC-FC Line Settings and PM Thresholds, page 21-76

13. NTP-G280 Modify Threshold Settings for the TNC and TNCE Cards, page 21-123

NTP-G90 Modify OSCM and OSC-CSM Card Line Settings and 
PM Thresholds

Step 1 Complete the DLP-G46 Log into CTC procedure at the node where you want to change the OSCM or 
OSC-CSM card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G199 Change the OSCM and OSC-CSM OC-3/STM-1 Line Settings, page 21-3

• DLP-G200 Change the OSCM and OSC-CSM OC-3/STM-1 Line SONET/SDH Thresholds, 
page 21-5

• DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards, page 21-7

• DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings, page 21-8

• DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings, page 21-12

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure. 

Purpose This procedure changes the optical service channel (OSC) and PM 
parameters and thresholds for the OSCM and OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G199 Change the OSCM and OSC-CSM OC-3/STM-1 Line Settings

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OSCM or OSC-CSM 
card where you want to change the OC-3/STM-1 line settings.

Step 2 Click the Provisioning > OC3 Line > OC3 Line (ANSI) or Provisioning > STM-1 > STM-1 Line 
(ETSI) tabs. 

Step 3 Modify any of the settings described in Table 21-1.

Purpose This task changes the OC-3/STM-1 line settings for the OSC signal 
transmitted by OSCM and OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-1 OSCM and OSC-CSM Card OC-3/STM-1 Line Settings

Parameter Description Options

Port (Display only) Displays the port number. 1

Port Name Provides the ability to assign the specified port 
a name.

User-defined. Name can be up to 32 alphanumeric/special 
characters. Blank by default. 

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State (Display only) Displays the port administrative 
state. For more information about 
administrative states, see the Administrative 
and Service States document.

• IS (ANSI) or Unlocked (ETSI)—Puts the port in 
service. The port service state changes to IS-NR (ANSI) 
or Unlocked-enabled (ETSI).

• IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI)—Puts the port in 
automatic in-service. The port service state changes to 
OOS-AU,AINS (ANSI) or 
Unlocked-disabled,automaticInService (ETSI).
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Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition 
of the port. Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information about 
service states, see the Administrative and 
Service States document.

• IS-NR (In-Service and Normal [ANSI]) or 
Unlocked-enabled (ETSI)—The port is fully 
operational and is performing as provisioned.

• OOS-AU,AINS (Out-Of-Service and Autonomous, 
Automatic In-Service [ANSI]) or 
Unlocked-disabled,automaticInService (ETSI)—The 
port is out of service, but traffic is carried. Alarm 
reporting is suppressed. The ONS node monitors the 
ports for an error-free signal. After an error-free signal 
is detected, the port stays in the 
OOS-AU,AINS/Unlocked-disabled,automaticInService 
state for the duration of the soak period. After the soak 
period ends, the port service state changes to 
IS-NR/Unlocked-enabled. 

• OOS-MA,DSBLD (Out-of-Service and Management, 
Disabled [ANSI]) or Locked-enabled,disabled 
(ETSI)—The port is out of service and unable to carry 
traffic. 

• OOS-MA,MT (Out-of-Service and Management, 
Maintenance [ANSI]) or Locked-enabled,maintenance 
(ETSI)—The port is out of service for maintenance. 
Alarm reporting is suppressed, but traffic is carried and 
loopbacks are allowed.

SF BER Sets the signal fail bit error rate. From the drop-down list, choose one of the following:

• 1E-3

• 1E-4 

• 1E-5

SD BER Sets the signal degrade bit error rate. From the drop-down list, choose one of the following:

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Provides 
Synch

(Display only) If checked, the card is 
provisioned as a network element (NE) timing 
reference.

• Checked 

• Unchecked

SyncMsgIn Enables synchronization status messages 
(SSM) on the S1 byte, which allow the node to 
choose the best timing source.

• Checked

• Unchecked

Send Do Not 
Use

When checked, sends a Do Not Use for 
Synchronization (DUS) message on the S1 
byte.

• Checked

• Unchecked

Table 21-1 OSCM and OSC-CSM Card OC-3/STM-1 Line Settings (continued)

Parameter Description Options
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Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

DLP-G200 Change the OSCM and OSC-CSM OC-3/STM-1 Line SONET/SDH 
Thresholds 

Step 1 In node view (single-shelf mode) or shelf view (multishelf view), double-click the OSCM or OSC-CSM 
card where you want to change the SONET/SDH threshold settings.

Step 2 Click the Provisioning > OC3 Line > SONET Thresholds (ANSI) or Provisioning > OC3 Line > 
SDH Thresholds (ETSI) tabs. 

Step 3 Thresholds can be set for Near End or Far End directions for either the 15-minute or 1-day intervals. You 
can set thresholds for either the Line or Section types. Path thresholds do not apply. Modify any of the 
settings described in Table 21-2 (ANSI) or Table 21-3 (ETSI).

PJSTSMon # (Display only) Sets the STS that will be used 
for pointer justification. 

This parameter is set to Off. It cannot be changed.

AINS Soak (Display only) The automatic in-service soak 
period. It is always 00.00.

—

Type Defines the port as SONET or SDH. The 
Enable Sync Msg field and the Send Do Not 
Use field must be disabled before the port can 
be set to SDH.

From the drop-down list, choose one of the following:

• SONET 

• SDH

Purpose This task changes the OC-3/STM-1 line SONET/SDH thresholds settings 
for the OSC signal transmitted by the OSCM and OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-2 OSCM and OSC-CSM Cards OC3 Line SONET Threshold Settings

Parameter Description Options

Port (Display only) Displays 
the port number.

1

CV Coding violations Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

Table 21-1 OSCM and OSC-CSM Card OC-3/STM-1 Line Settings (continued)

Parameter Description Options
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Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

ES Errored seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

SES Severely errored seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

SEFS Severely errored framing 
seconds (Section only)

Numeric. Can be set for Far End, for 15-minute or one-day 
intervals for Section only. Select the bullet and click Refresh. 

FC Failure count (Line only) Numeric. Can be set for 15-minute or one-day intervals for 
Line (Near and Far End). Select the bullet and click Refresh 

UAS Unavailable seconds 
(Line only)

Numeric. Can be set for 15-minute or one-day intervals for 
Line (Near and Far End). Select the bullet and click Refresh. 

Table 21-3 OSCM and OSC-CSM Cards OC3 Line SDH Threshold Settings

Parameter Description Options

Port (Display only) Displays 
the port number.

1

EB Errored block Numeric. Can be set for 15-minute or one-day intervals for MS 
(Multiplex Section) or RS (Regeneration Section) (Near and 
Far End). Select the bullet and click Refresh. 

ES Errored seconds Numeric. Can be set for 15-minute or one-day intervals for MS 
or RS (Near and Far End). Select the bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for 15-minute or one-day intervals for MS 
or RS (Near and Far End). Select the bullet and click Refresh. 

BBE Background block error Numeric. Can be set for 15-minute or one-day intervals for MS 
or RS (Near and Far End). Select the bullet and click Refresh. 

OFS Out of frame seconds Numeric. Can be set for 15-minute or one-day intervals for RS, 
Near End. Select the bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for 15-minute or one-day intervals for MS 
or RS (Near and Far End). Select the bullet and click Refresh. 

Table 21-2 OSCM and OSC-CSM Cards OC3 Line SONET Threshold Settings (continued)

Parameter Description Options
21-6
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 21      Change DWDM Card Settings
DLP-  G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards
DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OSCM or OSC-CSM 
card where you want to change the optical line parameters.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-4. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical line parameters for OSCM and OSC-CSM 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-4 OSCM and OSC-CSM Card Optical Line Parameter Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, 
and direction (TX or RX).

OSCM

• 2 (OSC-RX)

• 3 (OSC-TX)

OSC-CSM

• 2 (COM-RX)

• 3 (COM-TX)

• 4 (LINE-RX)

• 5 (LINE-TX)

• 6 (OSC-RX)

• 7 (OSC-TX)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more information 
about administrative states, see document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance
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DLP-  G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of the 
port. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Shows the current power level per 
port.

—

VOA Mode (Display only) Shows the functional mode of the 
variable optical attenuator (VOA), when present. 

• Constant Attenuation

• Constant Power

VOA Power 
Ref

(Display only) Shows the optical power setpoint that 
must be reached when a VOA is present and VOA 
Mode is set to Constant Power. This parameter can 
only be modified by ANS.

—

VOA Power 
Calib

Modifies the optical power value of the VOA when 
VOA Mode is set to Constant Power.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

VOA 
Attenuation 
Ref

(Display only) Shows the VOA attenuation value 
when VOA Mode is set to Constant Attenuation. 
This parameter can only be modified by ANS. 

—

VOA 
Attenuation 
Calib

Modifies the attenuation value of the VOA when the 
VOA Mode is set to Constant Attenuation.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

Active 
Channels 

(Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the number 
of provisioned channels.

—

OSC Power (Display only) Shows the OSC power level per port. —

Purpose This task changes the optical line threshold settings for OSCM and 
OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-4 OSCM and OSC-CSM Card Optical Line Parameter Settings (continued)

Parameter Description Options
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DLP-  G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings
Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OSCM or OSC-CSM 
card where you want to change the optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold that you want to change, either Warning or Alarm.

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 4 Click Refresh.

Step 5 Modify any of the warning or alarm threshold settings. Table 21-5 shows the thresholds for warnings. 
Table 21-6 shows the thresholds for alarms.

Table 21-5  OSCM and OSC-CSM Cards Optical Line Warning Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

OSCM

• 2 (OSC-RX)

• 3 (OSC-TX)

OSC-CSM

• 2 (COM-RX)

• 3 (COM-TX)

• 4 (LINE-RX)

• 5 (LINE-TX)

• 6 (OSC-RX)

• 7 (OSC-TX)

opwrMin 
(dBm)

(OSCM only)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax 
(dBm)

(OSCM only)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.
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DLP-  G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings
Table 21-6  OSCM and OSC-CSM Cards Optical Line Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

OSCM

• 2 (OSC-RX)

• 3 (OSC-TX)

OSC-CSM

• 2 (COM-RX)

• 3 (COM-TX)

• 4 (LINE-RX)

• 5 (LINE-TX)

• 6 (OSC-RX)

• 7 (OSC-TX)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. If the VOA Mode is 
Constant Attenuation, you can manually 
change the threshold. The value must be 
within the optical power range that is 
specified for the card. For more 
information, see the Hardware 
Specifications document.

If VOA Mode is Constant Power, you 
cannot change the threshold manually 
because it is based on the Power setpoint 
(VOA Power Ref + VOA Power Calib). 
To change the threshold, you must change 
the VOA Power Calib value. This adjusts 
the Power setpoint. The threshold is 
automatically set to a value that is 5 dB 
lower than the Power setpoint.

You can set the threshold manually at the 
COM-RX and LINE-RX ports.

Numeric (dB). Double-click the table 
cell, enter a value, then press Enter.

Pwr OSC 
Degrade Low 
(dBm)

Shows the power degrade low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

In this case, the threshold is automatically 
linked to the Power setpoint (VOA Power 
Ref + VOA Power Calib) that is 
provisioned. Changing the setpoint will 
result in changing the threshold (always 
2 dB lower). 

Numeric.
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DLP-  G202 Change the OSCM and OSC-CSM Optical Line Threshold Settings
Step 6 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 7 Return to your originating procedure (NTP).

Pwr OSC 
Degrade High 
(dBm)

Shows the power degrade high threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port that is 
associated to a VOA (OSC-VOA). In 
Constant Power mode, the port is always 
active and the threshold is automatically 
linked to the Power setpoint (VOA Power 
Ref + VOA Power Calib). To change the 
threshold, change the Power setpoint. The 
threshold will always be 2 dB higher than 
the Power setpoint. 

Numeric.

Pwr OSC 
Failure (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. If the VOA Mode is Constant 
Attenuation, you can manually change 
the threshold. The value must be within 
the optical power range that is specified 
for the card. For more information, see 
the Hardware Specifications document.

If VOA Mode is Constant Power, you 
cannot change the threshold manually 
because it is based on the Power setpoint 
(VOA Power Ref + VOA Power Calib). 
To change the threshold, you must change 
the VOA Power Calib value. This adjusts 
the Power setpoint. The threshold is 
automatically set to a value that is 5 dB 
lower than the Power setpoint.

Numeric.

VOA Degrade 
High (dBm)

Does not apply to OSCM and OSC-CSM 
cards.

—

VOA Degrade 
Low (dBm)

Does not apply to OSCM and OSC-CSM 
cards.

—

Table 21-6  OSCM and OSC-CSM Cards Optical Line Alarm Thresholds Settings (continued)

Parameter Description Options
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DLP-  G203 Change the OSCM and OSC-CSM ALS Maintenance Settings
DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings

Note The ALS function should only be disabled temporarily for installation or maintenance reasons. Activate 
ALS immediately after maintenance or installation.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OSC-CSM or OSCM 
card where you want to change the ALS maintenance settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 21-7. The provisionable parameters are listed in the 
Options column in the table.

Purpose This task changes the automatic laser shutdown (ALS) maintenance 
settings for the OSC-CSM and OSCM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-7 OSC-CSM and OSCM ALS Maintenance Settings

Parameter Description Options

OSRI Optical safety remote interlock. When set 
to On, the OSC TX output power is shut 
down.

From the drop-down list, choose one 
of the following:

• On

• Off

ALS Mode Automatic laser shutdown mode. For 
OSCM cards, ALS provides the ability to 
shut down the OSC TX laser when the 
OSC RX detects a loss of signal (LOS).

For OSC-CSM cards, ALS provides the 
same functions as the OSCM card and 
also enables an optical safety mechanism 
at the DWDM network layer. For more 
details, see G.2 Automatic Laser 
Shutdown, page G-7

From the drop-down list, choose one 
of the following:

• Disable—Deactivates ALS.

• Auto Restart—(Default) ALS is 
active. The power is 
automatically shut down when 
needed and automatically tries to 
restart using a probe pulse until 
the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test
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DLP-  G203 Change the OSCM and OSC-CSM ALS Maintenance Settings
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

NTP-G91 Modify OPT-PRE and OPT-BST Card Line Settings and 
PM Thresholds 

Step 1 Complete the DLP-G46 Log into CTC at the node where you want to change the OPT-PRE, OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers, page 21-14

• DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers, 
page 21-15

• DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers, 
page 21-19

• DLP-G207 Change Optical Amplifier Threshold Settings for OPT-PRE and OPT-BST Amplifiers, 
page 21-21

• DLP-G322 Change the OPT-BST ALS Maintenance Settings, page 21-25

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
an amplifier restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays whether or not 
the laser is currently shut down, either 
YES or NO.

—

Request Laser 
Restart

If checked, allows you to restart the laser. Checked or unchecked

Purpose This procedure changes the line and threshold settings for an OPT-PRE, 
OPT-BST, OPT-BST-E, or OPT-BST-L amplifier card. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-7 OSC-CSM and OSCM ALS Maintenance Settings (continued)

Parameter Description Options
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DLP-  G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers
Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure. 

DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-PRE, OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier where you want to change the optical line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-8. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical line settings for an OPT-PRE, OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-8 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Amplifier Optical Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, and 
direction (TX or RX).

OPT-BST, OPT-BST-E, and OPT-BST-L

• 1 (COM-RX)

• 2 (COM-TX)

• 3 (OSC-RX)

• 4 (OSC-TX)

• 5 (LINE-RX)

OPT-PRE

• 1 (COM-RX)

• 3 (DC-RX)

• 4 (DC-TX)

Port Name Provides the ability to assign the specified port a name. User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click 
the Port Name table cell, enter the name, and press 
Enter.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.
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DLP-  G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST 
Amplifiers

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-PRE, OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier where you want to change the optical line threshold settings.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more information 
about administrative states, see the Administrative and 
Service States document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled (OPT-PRE 
only)

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously generated 
state that gives the overall condition of the port. 
Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Shows the current power level per port. —

Active 
Channels

(Display only) Indicates how many channels the port is 
carrying. Generally reflects the number of provisioned 
channels.

—

OSC Power (Display only) Shows the OSC power level per port.

Does not apply to OPT-PRE.

—

Purpose This task changes the optical line threshold settings for an OPT-PRE, 
OPT-BST, OPT-BST-E, or OPT-BST-L amplifier card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-8 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Amplifier Optical Line Settings (continued)

Parameter Description Options
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DLP-  G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers
Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-9.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

Table 21-9  OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Optical Line Warning Threshold 

Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

OPT-BST, OPT-BST-E, and OPT-BST-L

• 1 (COM-RX)

• 2 (COM-TX)

• 3 (OSC-RX)

• 4 (OSC-TX)

• 5 (LINE-RX)

OPT-PRE

• 1 (COM-RX)

• 3 (DC-RX)

4 (DC-TX)

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the name, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
name, and press Enter.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the name, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
name, and press Enter.
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DLP-  G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers
c. Modify any of the alarm thresholds shown under the Options column in Table 21-10.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-10  OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Optical Line Alarm Thresholds 

Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX).

OPT-BST, OPT-BST-E, and OPT-BST-L

• 1 (COM-RX)

• 2 (COM-TX)

• 3 (OSC-RX)

• 4 (OSC-TX)

• 5 (LINE-RX)

OPT-PRE

• 1 (COM-RX)

• 3 (DC-RX)

• 4 (DC-TX)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. For more information, see the 
Hardware Specifications document.

For OPT-BST, OPT-BST-E, OPT-BST-L 
cards, this parameter applies to the 
COM-RX and LINE-RX ports.

Numeric. Double-click the table cell, 
enter a value and press Enter.

Power Degrade 
High (dBm)

Does not apply to OPT-BST, OPT-BST-E, 
OPT-BST-L, and OPT-PRE line 
parameters.

—

Power Degrade 
Low (dBm)

Does not apply to OPT-BST, OPT-BST-E, 
OPT-BST-L, and OPT-PRE line 
parameters.

—
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DLP-  G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers
Step 5 Return to your originating procedure (NTP).

Pwr OSC 
Degrade Low 
(dBm)

Shows the power degrade low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) always active in 
Constant Power mode.

In this case, the threshold is automatically 
linked to the Power setpoint (VOA Power 
Ref + VOA Power Calib) that is 
provisioned. Changing the setpoint will 
result in changing the threshold (always 
2 dB lower).

Does not apply to OPT-PRE.

Numeric.

Pwr OSC 
Degrade High 
(dBm)

Shows the power degrade high threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port that is 
associated to a VOA (OSC-VOA). In 
Constant Power mode, the port is always 
active and the threshold is automatically 
linked to the Power setpoint (VOA Power 
Ref + VOA Power Calib). To change the 
threshold, change the Power setpoint. The 
threshold will always be 2 dB higher than 
the Power setpoint. 

Does not apply to OPT-PRE.

Numeric.

Pwr OSC 
Failure (dBm)

Shows the optical power low threshold 
for the OSC channel of the port.

You can set the threshold manually at the 
LINE-RX port.

—

Gain Degrade 
Low (dB)

Does not apply to OPT-BST, OPT-BST-E, 
OPT-BST-L, and OPT-PRE line 
parameters.

—

Gain Degrade 
High (dB)

Does not apply to OPT-BST, OPT-BST-E, 
OPT-BST-L, and OPT-PRE line 
parameters.

—

Table 21-10  OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Optical Line Alarm Thresholds 

Settings (continued)

Parameter Description Options
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DLP-  G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers
DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST 
Amplifiers

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-PRE, OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier where you want to change the optical amplifier line settings.

Step 2 Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-11. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical amplifier line settings for an OPT-PRE, 
OPT-BST, OPT-BST-E, or OPT-BST-L amplifier card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-11 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Optical Amplifier Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port 
type, and direction (TX or RX).

OPT-PRE

• 2 (COM-TX)

OPT-BST, OPT-BST-E, OPT-BST-L

• 6 (LINE-TX)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Total Output 
Power

(Display only) Shows the current power level per 
port. 

—
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DLP-  G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

Channel Power 
Ref.

(Display only) Shows the optical per-channel 
signal power setpoint that must be reached at the 
amplifier output when gain control is active.

—

Offset Adjusts the Total Output Power unless network 
conditions prevent the adjustment, for example, 
the port is in IS state.

Numeric. Double-click the table cell, enter a value, then 
press Enter.

Active 
Channels

(Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the 
number of provisioned channels.

OSC Power Shows the OSC power level per port.

Does not apply to OPT-PRE.

Signal Output 
Power

(Display only) Shows the current output power 
leaving the amplifier, including the amplified 
spontaneous emissions (ASE) contribution.

—

Output Power 
Set-Point

(Display only) Shows the output power setpoint. —

Working Mode (Display only) Shows the working mode, either 
GAIN or POWER.

—

Gain (Display only) The current gain of the amplifiers. —

Gain Set Point The value of the gain that the amplifier must 
achieve. APC can modify this value based on the 
number of optical channel network connection 
(OCHNC) circuits that are managed by the 
amplifier or to compensate for fiber aging 
insertion loss. For more information, see 
Chapter 13, “Network Reference.”

Display only or numeric depending on mode setting. 
When the system is configured as metro core, this field is 
display only. When the system is configured as metro 
access, this field can be changed by the user.

Tilt Reference (Display only) Shows the default value for the 
amplifier tilt. This field can only be modified by 
ANS.

—

Tilt Calibration Allows you to manually change the amplifier tilt. Numeric. Double-click the parameter, enter a value, and 
press Enter.

DCU Insertion 
Loss 

(Display only; OPT-PRE cards only) Shows the 
dispersion compensation unit (DCU) insertion 
loss.

—

Table 21-11 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Optical Amplifier Line Settings (continued)

Parameter Description Options
21-20
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 21      Change DWDM Card Settings
DLP-  G207 Change Optical Amplifier Threshold Settings for OPT-PRE and OPT-BST Amplifiers
DLP-G207 Change Optical Amplifier Threshold Settings for OPT-PRE and 
OPT-BST Amplifiers

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-PRE, OPT-BST, 
OPT-BST-E, or OPT-BST-L amplifier where you want to change the optical amplifier threshold settings.

Step 2 Click the Provisioning > Opt Apli Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-12.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Purpose This task changes the optical amplifier threshold settings for an OPT-PRE, 
OPT-BST, OPT-BST-E, or OPT-BST-L amplifier card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-12  OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Amplifier Line Warning Threshold 

Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

OPT-PRE

• 2 (COM-TX)

OPT-BST, OPT-BST-E, OPT-BST-L

• 6 (LINE-TX)

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.
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DLP-  G207 Change Optical Amplifier Threshold Settings for OPT-PRE and OPT-BST Amplifiers
Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Choose the alarm interval that you want to provision, either 15 minutes or 1 Day.

b. Under Types, choose Alarm.

c. Click Refresh.

d. Modify any of the alarm thresholds shown under the Options column in Table 21-13.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level.

Does not apply to OPT-PRE.

Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level.

Does not apply to OPT-PRE.

Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.

Table 21-12  OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Amplifier Line Warning Threshold 

Settings

Parameter Description Options

Table 21-13 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Amplifier Line Alarm Thresholds 

Setting

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

OPT-PRE

• 2 (COM-TX)

OPT-BST, OPT-BST-E, OPT-BST-L

• 6 (LINE-TX)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. For more information, see the 
Hardware Specifications document.

Numeric. Double-click the parameter, 
enter a value, and press Enter.
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DLP-  G207 Change Optical Amplifier Threshold Settings for OPT-PRE and OPT-BST Amplifiers
Power Degrade 
High (dBm)

(Display only) Shows the current value of 
the optical power degrade high threshold. 
This threshold applies only when the 
amplifier is active and in constant power 
mode.

Power Degrade High refers to the port’s 
Signal Output Power value and is 
automatically calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Power Degrade High threshold is 
linked to the Output Power Setpoint on 
the Parameters tab. Changing the setpoint 
changes the Power Degrade High 
threshold. The threshold value is always 2 
dB higher than the Output Power Setpoint 
value.

APC can modify this value based on the 
number of OCHNC circuits that the 
amplifier is managing. For more 
information, see Chapter 13, “Network 
Reference.”

—

Power Degrade 
Low (dBm)

(Display only) Shows the current value of 
the optical power degrade high threshold 
configured in the card. This threshold 
applies only when the amplifier is active 
and in constant power mode.

Power Degrade Low refers to the port’s 
Signal Output Power value and is 
automatically calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Power Degrade Low threshold is 
automatically linked to the Output Power 
Setpoint on the Parameters tab. Changing 
the setpoint changes the Power Degrade 
Low threshold. The threshold value is 
always 2 dB lower than the Output Power 
Setpoint.

APC can modify this value based on the 
number of OCHNC circuits that the 
amplifier is managing. 

—

Table 21-13 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Amplifier Line Alarm Thresholds 

Setting (continued)

Parameter Description Options
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DLP-  G207 Change Optical Amplifier Threshold Settings for OPT-PRE and OPT-BST Amplifiers
Step 5 Return to your originating procedure (NTP).

Gain Degrade 
High (dBm)

(Display only) Shows the current value of 
the gain degrade high threshold 
configured in the card. This threshold 
applies only when the amplifier is active 
and in constant gain mode.

Gain Degrade High refers to the port’s 
Gain value and is automatically 
calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Gain Degrade High threshold is 
linked to the Gain setpoint. Changing the 
setpoint changes the Gain Degrade High 
threshold. The threshold value is always 
2 dB higher than the Gain Setpoint value.

APC can modify this value based on the 
number of OCHNC circuits that the 
amplifier is managing and to compensate 
for insertion loss due to fiber aging.

—

Gain Degrade 
Low (dBm)

(Display only) Shows the current value of 
the gain degrade low threshold 
configured in the card. This threshold 
applies only when the amplifier is active 
and in constant gain mode.

Gain Degrade Low refers to the port’s 
Gain value and is automatically 
calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Gain Degrade Low threshold is 
automatically linked to the Gain Setpoint 
that is provisioned. Changing the setpoint 
changes the Gain Degrade Low threshold. 
The threshold value is always 2 dB lower 
than the Gain Setpoint value.

APC can also modify this value based on 
the number of OCHNC circuits that the 
amplifier is managing. 

—

Table 21-13 OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L Card Amplifier Line Alarm Thresholds 

Setting (continued)

Parameter Description Options
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DLP-  G322 Change the OPT-BST ALS Maintenance Settings
DLP-G322 Change the OPT-BST ALS Maintenance Settings

Note The ALS function should only be disabled temporarily for installation or maintenance reasons. Activate 
ALS immediately after maintenance or installation.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-BST, 
OPT-BST-E, or OPT-BST-L where you want to change the ALS maintenance settings.

Step 2 Click the Maintenance > ALS Mode tabs. 

Step 3 Modify any of the settings described in Table 21-14. The provisionable parameters are listed in the 
Options column in the table.

Purpose This task changes the ALS maintenance settings for the OPT-BST, 
OPT-BST-E, and OPT-BST-L cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
21-25
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 21      Change DWDM Card Settings
DLP-  G322 Change the OPT-BST ALS Maintenance Settings
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

Table 21-14 OPT-BST ALS Maintenance Settings

Parameter Description Options

OSRI Optical safety remote interlock. When set 
to On, the OPT-BST TX output power is 
shut down.

From the drop-down list, choose one 
of the following:

• On 

• Off

ALS Mode Automatic laser shutdown. For OPT-BST 
cards, ALS provides the ability to shut 
down the OPT-BST TX laser when the 
OPT-BST RX detects an LOS.

ALS also enables an optical safety 
mechanism at the DWDM network layer. 
For more information, see Appendix G, 
“Automatic Laser Shutdown.”

From the drop-down list, choose one 
of the following:

• Disable—Deactivates ALS. If 
the OPT-BST faces a span 
without an OSC connection, 
choose this option.

• Auto Restart—(Default) ALS is 
active. The power is 
automatically shut down when 
needed and automatically tries to 
restart using a probe pulse until 
the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
an amplifier restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays whether or not 
the laser is currently shut down, either 
YES or NO.

—

Request Laser 
Restart

If checked, allows you to restart the laser. Checked or unchecked
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DLP-  G322 Change the OPT-BST ALS Maintenance Settings
NTP-G160 Modify OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, 
OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card 
Line Settings and PM Thresholds

Step 1 Complete the DLP-G46 Log into CTC at the node where you want to change the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, or OPT-EDFA-24 amplifier card settings. If you are already 
logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Set the card working mode:

Caution Do not change the OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, or OPT-EDFA-24 
working mode if it is in service and circuits are provisioned.

a. Display the OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, or OPT-EDFA-24 card 
view.

b. Click the Provisioning > Card tabs.

c. In the Card Working Mode field, choose one of the following:

• OPT-PRE—Sets the card working mode to optical preamplifier.

• OPT-LINE—Sets the card working mode to optical booster amplifier.

d. Click Apply.

Step 4 Perform any of the following tasks as needed:

• DLP-G323 Change Optical Line Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, 
OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, 
OPT-EDFA-17, and OPT-EDFA-24 Amplifiers, page 21-28

• DLP-G324 Change Optical Line Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, 
OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, 
OPT-EDFA-17, and OPT-EDFA-24 Amplifiers, page 21-30

Purpose This procedure changes the line and threshold settings for the 
OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-AMP-C, 
OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24amplifier 
cards.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G323 Change Optical Line Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
• DLP-G325 Change Optical Amplifier Line Settings for OPT-AMP-L, OPT-AMP-17-C, 
OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, and OPT-EDFA-24 Amplifiers, 
page 21-34

• DLP-G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, 
OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, and OPT-EDFA-24 Amplifiers, 
page 21-36

• DLP-G327 Change the ALS Maintenance Settings of OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, 
OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, 
OPT-EDFA-17, and OPT-EDFA-24 Cards, page 21-44

Step 5 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure. 

DLP-G323 Change Optical Line Settings for OPT-AMP-L, OPT-AMP-17-C, 
OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Amplifiers

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, or OPT-EDFA-24 amplifier where you want to change the 
optical line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-15. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical line settings for the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and 
OPT-EDFA-24 amplifier cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G323 Change Optical Line Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE,
Table 21-15 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 

15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Amplifier Optical Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, and 
direction (TX or RX).

• 1 (COM-RX)

• 2 (COM-TX)

• 3 (OSC-RX)

• 4 (OSC-TX)

• 5 (LINE-RX)

• 6 (LINE-TX), OPT-RAMP-C and 
OPT-RAMP-CE only

• 7 (DC-RX), OPT-AMP-L, OPT-AMP-C, 
OPT-RAMP-C, and OPT-RAMP-CE only.
7 (DFB-RX) for 15454-M-RAMAN-CTP only.

• 8 (DC-TX), OPT-AMP-L and OPT-AMP-C 
only. 
8 (DFB-TX) for 15454-M-RAMAN-CTP only.

• 9 (RAMAN-RX), OPT-RAMP-C and 
OPT-RAMP-CE only. 
9(ASE-RX) for 15454-M-RAMAN-CTP only.

Port Name Provides the ability to assign the specified port a name. User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more information 
about administrative states, see the Administrative and 
Service States document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled 
(OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, and 
15454-M-RAMAN-COP only)

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously generated 
state that gives the overall condition of the port. 
Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Shows the current power level per port. —
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DLP-  G324 Change Optical Line Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G324 Change Optical Line Threshold Settings for OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and 
OPT-EDFA-24 Amplifiers

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, or OPT-EDFA-24 amplifier where you want to change the 
optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

Active Channel (Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the number of 
provisioned channels.

—

OSC Power Shows the OSC power level per port.

Does not apply to OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, and 
15454-M-RAMAN-COP.

—

Purpose This task changes the optical line threshold settings for OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and 
OPT-EDFA-24 amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-15 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 

15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Amplifier Optical Line Settings (continued)

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G324 Change Optical Line Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C,
c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-16.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-16  OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 

15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card 

Optical Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX):

• 1 (COM-RX)

• 2 (COM-TX)

• 3 (OSC-RX)

• 4 (OSC-TX)
4 
(LINE-RX)—15454-M-RAMAN-C
TP card only

• 5 (LINE-RX)
5 
(LINE-TX)—15454-M-RAMAN-C
TP card only

• 6 (LINE-TX), OPT-RAMP-C and 
OPT-RAMP-CE only

• 7 (DC-RX), OPT-AMP-L, 
OPT-AMP-C, OPT-RAMP-C, and 
OPT-RAMP-CE only
7 
(DFB-RX)—15454-M-RAMAN-CT
P card only

• 8 (DC-TX), OPT-AMP-L and 
OPT-AMP-C only
7 
(DFB-RX)—15454-M-RAMAN-CT
P card only

• 9 (RAMAN-RX), OPT-RAMP-C and 
OPT-RAMP-CE only
9(ASE-RX)—15454-M-RAMAN-C
TP card only

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the name, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
name, and press Enter.
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Chapter 21      Change DWDM Card Settings
DLP-  G324 Change Optical Line Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-17.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level.

Does not apply to OPT-RAMP-C, 
OPT-RAMP-CE, 
15454-M-RAMAN-CTP, and 
15454-M-RAMAN-COP.

Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the name, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level.

Does not apply to OPT-RAMP-C, 
OPT-RAMP-CE, 
15454-M-RAMAN-CTP, and 
15454-M-RAMAN-COP.

Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
name, and press Enter.

Table 21-16  OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 

15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card 

Optical Line Warning Threshold Settings

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G324 Change Optical Line Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C,
Table 21-17  OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 

15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 Card 

Optical Line Alarm Thresholds Setting

Parameter Description Options

Port (Display only) Displays the port number. • 1 (COM-RX)

• 2 (COM-TX)

• 3 (OSC-RX)

• 4 (OSC-TX)
4 
(LINE-RX)—15454-M-RAMAN-C
TP card only

• 5 (LINE-RX)
5 
(LINE-TX)—15454-M-RAMAN-C
TP card only

• 6 (LINE-TX), OPT-RAMP-C and 
OPT-RAMP-CE only

• 7 (DC-RX), OPT-AMP-L, 
OPT-AMP-C, OPT-RAMP-C, and 
OPT-RAMP-CE only
7 
(DFB-RX)—15454-M-RAMAN-CT
P card only

• 8 (DC-TX), OPT-AMP-L and 
OPT-AMP-C only
8 
(DFB-TX)—15454-M-RAMAN-CT
P card only

• 9 (RAMAN-RX), OPT-RAMP-C and 
OPT-RAMP-CE only
9(ASE-RX)—15454-M-RAMAN-C
TP card only

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. For more information, see the 
Hardware Specifications document.

You can manually set the threshold at the 
COM-RX and LINE-RX ports.

Numeric. 

Pwr OSC 
Failure (dBm)

Shows the optical power failure low 
threshold for the OSC channel of the port.

You can manually set the threshold at the 
LINE-RX port.

Numeric.
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Chapter 21      Change DWDM Card Settings
DLP-  G325 Change Optical Amplifier Line Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 5 Return to your originating procedure (NTP).

DLP-G325 Change Optical Amplifier Line Settings for OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, and 
OPT-EDFA-24 Amplifiers

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, or OPT-EDFA-24 
amplifier where you want to change the optical amplifier line settings.

Step 2 Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-18. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option. 

Purpose This task changes the optical amplifier line settings for OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
OPT-EDFA-17, and OPT-EDFA-24 amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-18 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, and OPT-EDFA-24 Optical Amplifier Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port 
type, and direction.

6 (LINE-TX)

8 (DC-TX), OPT-RAMP-C and OPT-RAMP-CE only

Port Name Assigns a name to the specified port. User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance
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Chapter 21      Change DWDM Card Settings
DLP-  G325 Change Optical Amplifier Line Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C,
Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Total Output 
Power

(Display only) Shows the current power level per 
port. 

—

Channel Power 
Ref.

(Display only) Shows the optical per-channel 
signal power setpoint that must be reached at the 
amplifier output when gain control is active.

—

Offset Adjusts the Total Output Power unless network 
conditions prevent the adjustment, for example, 
the port is in IS state.

Numeric. Double-click to change.

Signal Output 
Power

(Display only) Shows the current output power 
leaving the amplifier, including the ASE 
contribution.

—

Output Power 
Set-Point

(Display only) Shows the output power setpoint. 
Does not apply to OPT-AMP-L, OPT-AMP-C, or 
OPT-AMP-17-C.

—

Working Mode (Display only) Shows the working mode, either 
Output Power or Control Gain for the 
OPT-AMP-L or OPT-AMP-C; Control Power for 
the OPT-AMP-17-C; or Control Gain for the 
OPT-RAMP-C or OPT-RAMP-CE. 

—

Gain (Display only) The current gain of the amplifiers. —

Gain Set Point The value of the gain that the amplifier must 
achieve. APC can modify this value based on the 
number of OCHNC circuits that are managed by 
the amplifier or to compensate for fiber aging 
insertion loss. For more information, see 
Chapter 13, “Network Reference.” 

Display only or numeric depending on mode setting. 
When the system is configured as metro core, this 
field is display only.

Tilt (OPT-AMP-L 
and OPT-AMP-C)

(Display only) Shows the default value for the 
amplifier tilt. This field cannot be modified.

—

Tilt Reference 
(OPT-AMP-L, 
OPT-AMP-C, 
OPT-EDFA-17 
and 
OPT-EDFA-24)

(Display only) Shows the default value for the 
amplifier tilt. This field can only be modified by 
ANS.

—

Table 21-18 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, and OPT-EDFA-24 Optical Amplifier Line Settings 

Parameter Description Options
21-35
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_administrative_service_states.html


 

Chapter 21      Change DWDM Card Settings
DLP-  G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, and 
OPT-EDFA-24 Amplifiers

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Tilt Calibration 
(OPT-AMP-L, 
OPT-AMP-C, 
OPT-EDFA-17 
and 
OPT-EDFA-24)

Allows you to manually change the amplifier tilt. Numeric. Double-click the parameter, enter a value, 
and press Enter.

DCU Insertion 
Loss 
(OPT-AMP-L and 
OPT-AMP-C)

(Display only) When provisioned as an OPT-PRE 
only) Shows the DCU insertion loss.

—

Active Channels (Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the 
number of provisioned channels.

—

VOA Attenuation 
Ref

(Display only) Indicates the value for the VOA 
attenuation setpoint. This field can only be 
modified by ANS.

—

VOA Attenuation 
Calib

Allows you to manually change the VOA 
setpoint.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

Purpose This task changes the optical channel threshold settings for the 
OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
OPT-RAMP-CE, OPT-EDFA-17, and OPT-EDFA-24 amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-18 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, and OPT-EDFA-24 Optical Amplifier Line Settings 

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C,
Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, or OPT-EDFA-24 
amplifier where you want to change the optical amplifier threshold settings.

Step 2 Click the Provisioning > Opt Ampli Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-19.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-20.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-19 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, 

and OPT-EDFA-24 Card Amplifier Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction.

6 (LINE-TX)

8 (DC-TX), OPT-RAMP-C and 
OPT-RAMP-CE only

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level.

Does not apply to OPT-RAMP-C and 
OPT-RAMP-CE.

Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the name, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level.

Does not apply to OPT-RAMP-C and 
OPT-RAMP-CE.

Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
name, and press Enter.
21-37
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02
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DLP-  G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Table 21-20 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, 

and OPT-EDFA-24 Card Amplifier Line Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction.

6 (LINE-TX)

8 (DC-TX), OPT-RAMP-C and 
OPT-RAMP-CE only

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. For more information, see the 
Hardware Specifications document.

Numeric. Double-click to change.

Power Degrade 
High (dBm)

(Display only) Shows the current value of 
the optical power degrade high threshold. 
This threshold applies only when the 
amplifier is active and in constant power 
mode.

Power Degrade High refers to the port’s 
Signal Output Power value and is 
automatically calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Power Degrade High threshold is 
linked to the Output Power Setpoint on 
the Parameters tab. Changing the setpoint 
changes the Power Degrade High 
threshold. The threshold value is always 
2 dB higher than the Output Power 
Setpoint value.

APC can modify this value based on the 
number of OCHNC circuits that the 
amplifier is managing. For more 
information, see Chapter 13, “Network 
Reference.”

—
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Chapter 21      Change DWDM Card Settings
DLP-  G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C,
Power Degrade 
Low (dBm)

(Display only) Shows the current value of 
the optical power degrade high threshold 
configured in the card. This threshold 
applies only when the amplifier is active 
and in constant power mode.

Power Degrade Low refers to the port’s 
Signal Output Power value and is 
automatically calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Power Degrade Low threshold is 
automatically linked to the Output Power 
Setpoint on the Parameters tab. Changing 
the setpoint changes the Power Degrade 
Low threshold. The threshold value is 
always 2 dB lower than the Output Power 
Setpoint.

APC can modify this value based on the 
number of OCHNC circuits that the 
amplifier is managing. 

—

Table 21-20 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, 

and OPT-EDFA-24 Card Amplifier Line Alarm Thresholds Settings (continued)

Parameter Description Options
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DLP-  G326 Change Optical Amplifier Threshold Settings for OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 5 Return to your originating procedure (NTP).

Gain Degrade 
High (dBm)

(Display only) Shows the current value of 
the gain degrade high threshold 
configured in the card. This threshold 
applies only when the amplifier is active 
and in constant gain mode.

Gain Degrade High refers to the port’s 
Gain value and is automatically 
calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Gain Degrade High threshold is 
linked to the Gain setpoint. Changing the 
setpoint changes the Gain Degrade High 
threshold. The threshold value is always 
2 dB higher than the Gain Setpoint value.

APC can modify this value based on the 
number of OCHNC circuits that the 
amplifier is managing and to compensate 
for insertion loss due to fiber aging.

—

Gain Degrade 
Low (dBm)

(Display only) Shows the current value of 
the gain degrade low threshold 
configured in the card. This threshold 
applies only when the amplifier is active 
and in constant gain mode.

Gain Degrade Low refers to the port’s 
Gain value and is automatically 
calculated by the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/T
SCE when the amplifier is turned up.

The Gain Degrade Low threshold is 
automatically linked to the Gain Setpoint 
that is provisioned. Changing the setpoint 
changes the Gain Degrade Low threshold. 
The threshold value is always 2 dB lower 
than the Gain Setpoint value.

APC can also modify this value based on 
the number of OCHNC circuits that the 
amplifier is managing. 

—

Table 21-20 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, 

and OPT-EDFA-24 Card Amplifier Line Alarm Thresholds Settings (continued)

Parameter Description Options
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DLP-  G538 Change Optical Raman Line Settings for OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, and
DLP-G538 Change Optical Raman Line Settings for OPT-RAMP-C, 
OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP Amplifiers

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C, 
OPT-RAMP-CE, 15454-M-RAMAN-CTP, or 15454-M-RAMAN-COP amplifier where you want to 
change the optical Raman line settings.

Step 2 Click the Provisioning > Opt. Raman. Line > Parameters tab. 

Step 3 Modify any of the settings described in Table 21-21. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option. 

Purpose This task changes the optical Raman line settings for OPT-RAMP-C, 
OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP 
amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-21 OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP Optical Raman Line 

Settings

Parameter Description Options

Port (Display only) Displays the port number, port 
type, and direction.

3 (RAMAN-RX) for 15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP cards only

6 (RAMAN-TX) for 15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP cards only

10 RAMAN-TX

Port Name Assigns a name to the specified port. User-defined. Name can be up to 32 alphanumeric/ 
special characters. This field is blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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DLP-  G539 Change Optical Raman Line Threshold Settings for OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G539 Change Optical Raman Line Threshold Settings for OPT-RAMP-C, 
OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP Amplifiers

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C, 
OPT-RAMP-CE, 15454-M-RAMAN-CTP, or 15454-M-RAMAN-COP amplifier where you want to 
change the optical Raman threshold settings.

Step 2 Click the Provisioning > Opt. Raman. Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

Power (Display only) Indicates the current Raman 
power.

—

Active Channels (Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the 
number of provisioned channels. This field can be 
modified by ANS or the Raman wizard.

—

Ratio (Display only) Indicates the ratio of the Raman 
power setpoint distributed between the two 
Raman pumps. 

—

Power Setpoint (Display only) Indicates the Raman power 
setpoint as the sum of Pump1 and Pump 2 set 
points. This field is modified by ANS or the 
Raman wizard.

—

Purpose This task changes the optical channel threshold settings for the 
OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 
15454-M-RAMAN-COP amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-21 OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP Optical Raman Line 

Settings (continued)

Parameter Description Options
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DLP-  G539 Change Optical Raman Line Threshold Settings for OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP,
b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-22.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-20.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-22 OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP Card 

Raman Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction.

3 (RAMAN-RX) for 
15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP cards only

6 (RAMAN-TX) for 
15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP cards only

10 RAMAN-TX

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.
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DLP-  G327 Change the ALS Maintenance Settings of OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 5 Return to your originating procedure (NTP).

DLP-G327 Change the ALS Maintenance Settings of OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and 
OPT-EDFA-24 Cards 

Note To perform this task, the OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-EDFA-17, or 
OPT-EDFA-24 card must be in OPT-LINE mode. 

Table 21-23 OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, and 15454-M-RAMAN-COP Card 

Raman Line Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction.

3 (RAMAN-RX) for 
15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP cards only

6 (RAMAN-TX) for 
15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP cards only

10 RAMAN-TX

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. For more information, see the 
Hardware Specifications document.

Numeric. Double-click to change.

Purpose This task changes the ALS maintenance settings for the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and 
OPT-EDFA-24 amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G327 Change the ALS Maintenance Settings of OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C,
Note The ALS function should only be disabled temporarily for installation or maintenance reasons. Activate 
ALS immediately after maintenance or installation.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-AMP-L, 
OPT-AMP-17C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 15454-M-RAMAN-CTP, 
15454-M-RAMAN-COP, OPT-EDFA-17, or OPT-EDFA-24 card where you want to change the ALS 
maintenance settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 21-24. The provisionable parameters are listed in the 
Options column in the table.

Table 21-24 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 

15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 ALS 

Maintenance Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction.

10 (RAMAN-RX), OPT-RAMP-C 
and OPT-RAMP-CE only

8 (DC-TX), OPT-RAMP-C and 
OPT-RAMP-CE only

6 (RAMAN-TX), 
15454-M-RAMAN-CTP and 
15454-M-RAMAN-COP only

8 (DFB-TX), 
15454-M-RAMAN-CTP only

OSRI Optical safety remote interlock. When set 
to On, the OPT-AMP-L, 
OPT-AMP-17-C, OPT-AMP-C, 
OPT-RAMP-C, OPT-RAMP-CE, 
15454-M-RAMAN-CTP, or 
15454-M-RAMAN-COP TX output 
power is shut down.

From the drop-down list, choose one 
of the following:

• On 

• Off
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DLP-  G327 Change the ALS Maintenance Settings of OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, 
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

ALS Mode Sets the Automatic laser shutdown mode. 
For OPT-AMP-L, OPT-AMP-17-C, 
OPT-AMP-C, OPT-RAMP-C, 
OPT-RAMP-CE, 
15454-M-RAMAN-CTP, and 
15454-M-RAMAN-COP cards, ALS 
provides the ability to shut down the TX 
laser when the card RX detects an LOS.

ALS also enables an optical safety 
mechanism at the DWDM network layer. 
For more information, see Chapter 13, 
“Network Reference.”

From the drop-down list, choose one 
of the following:

• Disable—Deactivates ALS. If 
the OPT-AMP-L, 
OPT-AMP-17-C, or 
OPT-AMP-C, faces a span 
without an OSC connection, 
choose this option.

• Auto Restart—(Default) 
Activates ALS. The power is 
automatically shut down when 
needed and automatically tries to 
restart using a probe pulse until 
the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
an amplifier restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays the current status 
of the laser. 

—

Request Laser 
Restart

If checked, allows you to restart the laser 
for maintenance. 

Checked or unchecked

OSC Based Startup If checked, allows the Raman pump to be 
turned on even though OSC is the only 
detected power and there is no Raman 
signal.

Checked or unchecked.

Table 21-24 OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-RAMP-CE, 

15454-M-RAMAN-CTP, 15454-M-RAMAN-COP, OPT-EDFA-17, and OPT-EDFA-24 ALS 

Maintenance Settings (continued)

Parameter Description Options
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DLP-  G514 Change the PSM Card Mode
NTP-G202 Modify PSM Card Line Settings and PM Thresholds 

Step 1 Complete the DLP-G46 Log into CTC at the node where you want to change the card settings. If you are 
already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G514 Change the PSM Card Mode, page 21-47

• DLP-G476 Change Optical Line Settings for the PSM Card, page 21-48

• DLP-G477 Change Optical Line Threshold Settings for the PSM Card, page 21-49

• DLP-G478 Change the PSM ALS Maintenance Settings, page 21-52

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure. 

DLP-G514 Change the PSM Card Mode

Note You cannot change the PSM card mode if any of the PSM ports is in use in the normal configuration, 
that is, at least one patchcord is provisioned on the PSM ports.

Step 1 In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the PSM card where 
you want to change the card mode.

Step 2 Click the Provisioning > Card tab. 

Step 3 From the Mode drop-down list, choose one of the following:

• Normal—Sets the PSM card in normal configuration. In this configuration, the PSM card supports 
channel protection, line protection, and multiplex section protection configurations.

Purpose This procedure changes the line and threshold settings for the PSM card.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the PSM card mode.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G476 Change Optical Line Settings for the PSM Card
• Standalone—Sets the PSM card in standalone configuration. In this configuration, the PSM card can 
be equipped in any slot and supports all node configurations. When you select this option, CTC will:

– Not support creation of patchcords

– Set all VOA set points to 0dB attenuation

– Move the administrative state of all ports to IS (ANSI) or Unlocked (ETSI)

Note In the standalone configuration, you cannot change the administrative state of the PSM ports. 
However, you can enable optical safety in standalone configuration.

Step 4 Return to your originating procedure (NTP).

DLP-G476 Change Optical Line Settings for the PSM Card

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the PSM card where you 
want to change the optical line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-25 on page 21-48. The provisionable parameters are 
listed in the Options column.

Purpose This task changes the optical line settings for the PSM card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-25 PSM Card Optical Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, and 
direction (TX or RX).

• 1 (W-RX)

• 2 (W-TX)

• 3 (P-RX)

• 4 (P-TX)

• 5 (COM-RX)

• 6 (COM-TX)

Port Name Provides the ability to assign the specified port a name. User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.
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DLP-  G477 Change Optical Line Threshold Settings for the PSM Card
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G477 Change Optical Line Threshold Settings for the PSM Card

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more information 
about administrative states, see the Administrative and 
Service States document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously generated 
state that gives the overall condition of the port. 
Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Shows the current power level per port. —

VOA Mode (Display only) Shows the functional mode of the VOA, 
when present. 

Note For W-RX and P-RX ports, the VOA Mode is 
always set to Constant Attenuation.

• Constant Attenuation

• Constant Power

VOA 
Attenuation 
Ref

(Display only) Shows the VOA attenuation value when 
VOA Mode is set to Constant Attenuation. This 
parameter can only be modified by ANS. 

—

VOA 
Attenuation 
Calib

Modifies the attenuation value of the VOA when the 
VOA Mode is set to Constant Attenuation.

Numeric. Double-click the parameter, enter a 
value, and press Enter.

Active 
Channels

(Display only) Indicates how many channels the PSM 
card is carrying. Generally reflects the number of 
provisioned channels.

—

Purpose This task changes the optical line threshold settings for the PSM card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-25 PSM Card Optical Line Settings (continued)

Parameter Description Options
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DLP-  G477 Change Optical Line Threshold Settings for the PSM Card
Caution It is recommended that you use the optical line threshold values imported from the Cisco Transport 
Planner XML configuration file. If you want to modify the threshold values, consult your network 
operations center (NOC) or other appropriate personnel who can understand and set the correct threshold 
values.

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the PSM card where you 
want to change the optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-26.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-27.

Table 21-26 PSM Card Optical Line Warning Threshold Settings 

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX)

• 1 (W-RX)

• 2 (W-TX)

• 3 (P-RX)

• 4 (P-TX)

• 5 (COM-RX)

• 6 (COM-TX)

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
value, and press Enter.
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DLP-  G477 Change Optical Line Threshold Settings for the PSM Card
d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-27 PSM Card Optical Line Alarm Thresholds Setting

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX)

• 1 (W-RX)

• 2 (W-TX)

• 3 (P-RX)

• 4 (P-TX)

• 5 (COM-RX)

• 6 (COM-TX)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. You can manually 
change the threshold. The value must be 
within the optical power range that is 
specified for the card. For more 
information, see the Hardware 
Specifications document.

Numeric. Double-click the table cell, 
enter a value, then press Enter.

VOA Degrade 
High (dB)

(Display only) Shows the VOA degrade 
high threshold. This VOA value applies to 
the corresponding port and is 
automatically calculated when ANS is 
run.

This threshold applies to a port associated 
to a VOA that is always active in Constant 
Attenuation mode.

The threshold is automatically linked to 
the VOA setpoint that is provisioned 
(VOA Attenuation Ref + VOA 
Attenuation Calib). Changing the setpoint 
will result in changing the threshold 
(always 2 dB higher). 

Numeric.

VOA Degrade 
Low (dB)

(Display only) Shows the VOA degrade 
low threshold. This VOA value applies to 
the corresponding port and is 
automatically calculated when ANS is 
run.

This threshold applies to a port associated 
to a VOA that is always active in Constant 
Attenuation mode.

The threshold is automatically linked to 
the VOA setpoint that is provisioned 
(VOA Attenuation Ref + VOA 
Attenuation Calib). Changing the setpoint 
will result in changing the threshold 
(always 2 dB lower).

Numeric.
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DLP-  G478 Change the PSM ALS Maintenance Settings
Step 5 Return to your originating procedure (NTP).

DLP-G478 Change the PSM ALS Maintenance Settings

Note The ALS function is applicable for a PSM card in line (or path) protection configuration only. It is not 
applicable for all other PSM protection configurations.

Note The ALS function should only be disabled temporarily for installation or maintenance reasons. Activate 
ALS immediately after maintenance or installation.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the PSM card where you 
want to change the ALS maintenance settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 21-28. The provisionable parameters are listed in the 
Options column in the table.

Purpose This task changes the ALS maintenance settings for the PSM card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-  G478 Change the PSM ALS Maintenance Settings
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).

Table 21-28 PSM ALS Maintenance Settings

Parameter Description Options

OSRI Optical safety remote interlock. When set 
to On, only the PSM TX output power of 
the protect path is shut down.

From the drop-down list, choose one 
of the following:

• On 

• Off

ALS Mode Automatic laser shutdown. ALS provides 
the ability to shut down the PSM TX VOA 
when the PSM RX detects an LOS.

ALS also enables an optical safety 
mechanism at the DWDM network layer. 
For more information, see Chapter G, 
“Automatic Laser Shutdown.”

From the drop-down list, choose one 
of the following:

• Disable—Deactivates ALS.

• Auto Restart—(Default) ALS is 
active. The power is 
automatically shut down when 
needed and automatically tries to 
restart using a probe pulse until 
the cause of the failure is 
repaired.

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

(Display only) Displays the duration of 
the optical power pulse that begins when 
the VOA restarts. 

—

Recovery Pulse 
Interval

(Display only) Displays the interval 
between optical power pulses. 

—

Currently 
Shutdown

(Display only) Displays whether or not 
the VOA is currently shut down.

• YES

• NO

• APR—This is a temporary 
option that is displayed when the 
Currently Shutdown status is 
changing from YES to NO.

Request Laser 
Restart

If checked, allows you to restart the VOA. Checked or unchecked
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DLP-  G478 Change the PSM ALS Maintenance Settings
NTP-G175 Modify 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, and 4MD-xx.x Line Card 
Settings and PM Thresholds

Note Complete the DLP-G141 View Optical Power Statistics for 32MUX-O, 32WSS, 32WSS-L, 32DMX-O, 
32DMX, 32DMX-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-MUX-C, 40-DMX-C, and 
40-DMX-CE Cards to view the optical power statistics.

Step 1 Complete the DLP-G46 Log into CTC at the node where you want to change the card settings. If you are 
already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2 as needed.

Step 3 Perform any of the following tasks as needed:

• DLP-G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards, page 21-55

• DLP-G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards, page 21-57

• DLP-G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 
40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards, page 21-59

• DLP-G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards, page 21-62

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure. 

Purpose This procedure changes the line and PM parameter threshold settings for 
the multiplexer and demultiplexer cards. The cards included in this 
category are the 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 
40-DMX-C, 40-DMX-CE, and 4MD-xx.x cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
21-54
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 21      Change DWDM Card Settings
DLP-  G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C,
DLP-G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the multiplexer or 
demultiplexer card where you want to change the optical line settings.

Step 2 Perform one of the following:

• For 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, and 40-DMX-CE cards, 
click the Provisioning > Optical Line > Parameters tabs.

• For 4MD-xx.x cards, click the Provisioning > Optical Band > Parameters tabs.

Step 3 Modify any of the settings described in Table 21-29. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option. 

Purpose This task changes the optical line settings for a 32MUX-O, 32DMX-O, 
32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x 
card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-29 Multiplexer and Demultiplexer Card Optical Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, 
and direction (TX or RX).

32DMX, 32DMX-O, 32DMX-L

• 33 (COM-RX)

32MUX-O

• 33 (COM-TX)

40-DMX-C, 40-DMX-CE

• 41 (COM-RX)

40-MUX-C

• 41 (COM-TX)

4MD-xx.x

9 (COM-RX) and 10 (COM-TX)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click the 
table cell, enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.
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Chapter 21      Change DWDM Card Settings
DLP-  G414 Change Optical Line Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, 
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Shows the current power level per 
port.

—

AINS Soak (Display only) The automatic in-service soak 
period. It is always 00.00.

—

VOA Mode (Display only; 32DMX and 32DMX-L cards only) 
Shows the functional mode of the VOA, when 
present. 

• Constant Attenuation

• Constant Power

VOA Power 
Ref

(Display only; 32DMX and 32DMX-L cards only) 
Shows the optical power setpoint that must be 
reached when a VOA is present and VOA Mode is 
set to Constant Power. This parameter can only be 
modified by ANS.

—

VOA Power 
Calib

(32DMX and 32DMX-L cards only) Modifies the 
optical power value of the VOA when VOA Mode 
is set to Constant Power.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

VOA 
ATTenuation 
Ref

(Display only; 32DMX and 32DMX-L cards only) 
Shows the VOA attenuation value when VOA Mode 
is set to Constant Attenuation. This parameter can 
only be modified by ANS. 

—

VOA 
Attenuation 
Calib

(32DMX and 32DMX-L cards only) Modifies the 
attenuation value of the VOA when the VOA Mode 
is set to Constant Attenuation.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

Active 
Channels

(Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the number 
of provisioned channels.

—

Table 21-29 Multiplexer and Demultiplexer Card Optical Line Settings (continued)

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C,
DLP-G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 
32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the multiplexer or 
demultiplexer card where you want to change the optical line threshold settings.

Step 2 Perform one of the following:

• For 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, or 40-MUX-C cards, 
click the Provisioning > Optical Line > Optics Thresholds tabs.

• For 4MD-xx.x cards, click the Provisioning > Optical Band > Optics Thresholds tabs.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-30.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Purpose This task changes the optical line threshold settings for a 32MUX-O, 
32DMX-O, 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 40-MUX-C, 
or 4MD-xx.x card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-30  Multiplexer and Demultiplexer Card Optical Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number 
and description.

• 33 (COM-RX) for 32DMX, 
32DMX-O, 32DMX-L

• 33 (COM-TX) for 32MUX-O

• 41 (COM-RX) for 
40-DMX-C/40-DMX-CE

• 41 (COM-TX) for 40-MUX-C

• 9 (COM-RX) and 10 (COM-TX) for 
4MD-xx.x
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Chapter 21      Change DWDM Card Settings
DLP-  G415 Change Optical Line Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-31.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.

Table 21-30  Multiplexer and Demultiplexer Card Optical Line Warning Threshold Settings

 (continued)

Parameter Description Options

Table 21-31  Multiplexer and Demultiplexer Optical Line Alarm Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

32DMX, 32DMX-O, 32DMX-L

• 33 (COM-RX)

32MUX-O

• 33 (COM-TX)

40-DMX-C, 40-DMX-CE

• 41 (COM-RX)

40-MUX-C

• 41 (COM-TX)

4MD-xx.x

• 9 (COM-RX) and 10 (COM-TX)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for the 
card. For more information, see the 
Hardware Specifications document.

Numeric. Double-click the parameter, 
enter a value, and press Enter. 
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DLP-  G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C,
Step 5 Return to your originating procedure (NTP).

DLP-G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 
32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the multiplexer or 
demultiplexer card where you want to change the optical channel settings.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-32. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Power Degrade 
High (dBm)

Not applicable to 32MUX-O, 32DMX-O, 
32DMX, 32DMX-L, 40-DMX-C, 
40-DMX-CE, 40-MUX-C, and 4MD-xx.x 
cards.

—

Power Degrade 
Low (dBm)

Not applicable to 32MUX-O, 32DMX-O, 
32DMX, 32DMX-L, 40-DMX-C, 
40-DMX-CE, 40-MUX-C, and 4MD-xx.x 
cards.

—

Purpose This task changes the optical channel settings for a 32MUX-O, 32DMX-O, 
32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 40-MUX-C, or 4MD-xx.x 
card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-31  Multiplexer and Demultiplexer Optical Line Alarm Threshold Settings (continued)

Parameter Description Options
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DLP-  G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 
Table 21-32 Multiplexer and Demultiplexer Card Optical Channel Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, 
and direction (TX or RX).

32MUX-O, 32DMX-O, 32DMX, 32DMX-L

• 1 through 32 (CHAN-RX or CHAN-TX)

40-MUX-C, 40-DMX-C, 40-DMX-CE

• 1 through 40 (CHAN-RX or CHAN-TX)

4MD-xx.x

• 1 through 8 (CHAN-RX or CHAN-TX)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Shows the current power level per 
port.

—

Actual 
Wavelength

(Display only) Shows the wavelength specified by 
the manufacturing data. This field cannot be set 
manually.

—

Expected 
Wavelength

Shows the preprovisioned wavelength. Numeric. This field cannot be changed.

AINS Soak (Display only) The automatic in-service soak 
period. It is always 00.00.

—

VOA Mode Not applicable to the 32MUX-O, 32DMX-0, 
4MD-xx.x cards. Shows the current functional 
mode of the VOA.

• Constant Power 

• Constant Attenuation
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DLP-  G416 Change Optical Channel Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C,
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

VOA Power 
Ref.

Not applicable to the 32MUX-O, 32DMX-0, 
4MD-xx.x cards. Shows the power setpoint that 
must be reached on the path when a VOA is present 
and the VOA Mode is Constant Power. 

Demultiplexers show the reference value of the 
desired optical power going to the client. 
Multiplexers show the reference value of the 
desired per-channel optical power. This parameter 
can only be modified by ANS.

—

VOA Power 
Calib.

Not applicable to the 32MUX-O, 32DMX-0, 
4MD-xx.x cards. The user can modify the optical 
output power to the VOA if necessary. The VOA 
power calibration offsets the VOA power reference.

For demultplexers, you can modify the optical 
output power to the client if necessary. For 
multiplexers, you can modify the output power per 
channel.

This feature is normally used when the Network 
Type is configured as Access in the Provisioning > 
WDM-ANS tab.

Numeric. Double-click the parameter, enter a value 
and press Enter.

VOA 
Attenuation 
Ref.

Not applicable to the 32MUX-O, 32DMX-0, 
4MD-xx.x cards. Shows the attenuation value of the 
VOA when the VOA is set in attenuation mode. 
This parameter can only be modified by ANS and 
APC.

—

VOA 
Attenuation 
Calib.

Not applicable to the 32MUX-O, 32DMX-0, and 
4MD-xx.x cards. Allows the user to modify the 
attenuation value of the VOA if necessary when the 
VOA mode is set for constant attenuation.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

Table 21-32 Multiplexer and Demultiplexer Card Optical Channel Settings (continued)

Parameter Description Options
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DLP-  G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 
DLP-G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 
32DMX, 32DMX-L, 40-MUX-C, 40-DMX-C, 40-DMX-CE, or 4MD-xx.x Cards

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the multiplexer or 
demultiplexer card where you want to change the optical channel threshold settings.

Step 2 Click the Provisioning > Optical Chn > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-33.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Purpose This task changes the optical channel threshold settings for a 32MUX-O, 
32DMX-O, 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 40-MUX-C, 
or 4MD-xx.x card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 21      Change DWDM Card Settings
DLP-  G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C,
Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-34.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-33 Multiplexer and Demultiplexer Card Optical Channel Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX).

32MUX-O, 32DMX-O, 32DMX, 
32DMX-L

• 1 through 32 (CHAN-RX or 
CHAN-TX)

40-MUX-C, 40-DMX-C, 
40-DMX-CE

• 1 through 40 (CHAN-RX or 
CHAN-TX)

4MD-xx.x

• 1 through 8 (CHAN-RX or 
CHAN-TX)

opwrMin (dBm) Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the 
parameter, enter a value, and press 
Enter.

opwrMax (dBm) Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
30 dBm. Double-click the parameter, 
enter a value, and press Enter.
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DLP-  G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C, 
Table 21-34  Multiplexer and Demultiplexer Card Optical Channel Alarm Threshold 

Settings

Parameter Description Options

Port (Display only) Displays the port number, port 
type, and direction (TX or RX).

32MUX-O, 32DMX-O, 32DMX, 
32DMX-L

• 1 through 32 (CHAN-RX or 
CHAN-TX)

40-MUX-C, 40-DMX-C, 
40-DMX-CE

• 1 through 40 (CHAN-RX or 
CHAN-TX)

4MD-xx.x

• 1 through 8 (CHAN-RX or 
CHAN-TX)

Power Failure 
Low (dBm)

Shows the power failure low threshold. This 
power value applies to the corresponding port 
and is automatically calculated when ANS is 
run.

This threshold applies to a port associated to a 
VOA (OSC-VOA) that is always active in 
Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the threshold 
(always 5 dB lower). 

The 32DMX and 40-DMX-C/40-DMX/CE are 
exceptions. 32DMX and 
40-DMX-C/40-DMX-CE Power Failure Low 
thresholds apply to ports that are not 
associated to a VOA. The threshold is 
calculated automatically when you run ANS. 
You can manually change the threshold. The 
value must be within the optical power range 
that is specified for the card. For more 
information, see the Hardware Specifications 
document.

Numeric. Double-click the 
parameter, enter a value, and press 
Enter. 
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DLP-  G417 Change Optical Channel Threshold Settings for 32MUX-O, 32DMX-O, 32DMX, 32DMX-L, 40-MUX-C,
Step 5 Return to your originating procedure (NTP).

NTP-G93 Modify the 32WSS, 32WSS-L, 40-WSS-C, or 
40-WSS-CE Line Settings and PM Thresholds 

Power Degrade 
High (dBm)

(32MUX-O, 32DMX-0, and 4MD-xx.x cards 
only) Shows the power degrade high 
threshold. This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated to a 
VOA (OSC-VOA) that is always active in 
Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint will result in changing the 
threshold (always 3 dB higher). 

—

Power Degrade 
Low (dBm)

(32MUX-O, 32DMX-0, and 4MD-xx.x cards 
only) Shows the power degrade low threshold. 
This power value applies to the corresponding 
port and is automatically calculated when 
ANS is run.

This threshold applies to a port associated to a 
VOA (OSC-VOA) that is always active in 
Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint will result in changing the 
threshold (always 2 dB lower). 

—

Purpose This procedure changes the 32WSS, 32WSS-L, 40-WSS-C, or 
40-WSS-CE card thresholds and settings.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-34  Multiplexer and Demultiplexer Card Optical Channel Alarm Threshold 

Settings (continued)

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G212 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Parameters
Step 1 Complete the DLP-G46 Log into CTC procedure at the node where you want to change the 32WSS, 
32WSS-L, 40-WSS-C, or 40-WSS-CE card settings. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G212 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel 
Parameters, page 21-66

• DLP-G213 Change the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel 
Thresholds, page 21-69

Note To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see 
Alarm and TCA Monitoring and Management

• DLP-G214 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Line Parameters, 
page 21-73

• DLP-G215 Change the 32WSS, 32-WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Line 
Thresholds, page 21-74

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

DLP-G212 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical 
Channel Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 32WSS, 32WSS-L, 
40-WSS-C, or 40-WSS-CE card where you want to change the optical channel parameter settings.

Step 2 Click the Provisioning > Optical Chn: Optical Connectorn > Parameters tabs, where n = one of the 
four available groups of eight optical channels.

Step 3 Modify any of the settings described in Table 21-35. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical channel parameter settings for the 32WSS, 
32WSS-L, 40-WSS-C, or 40-WSS-CE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 21      Change DWDM Card Settings
DLP-  G212 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Parameters
Table 21-35 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Optical Channel Parameter Settings

Parameter Description Options

Port (Display only) Shows the port number. 
Each optical channel (wavelength) has 
two logical ports. However, only one is 
active at a time depending on the 
operating mode provisioned for the 
port on the card view Maintenance tab: 
either CHAN-RX or 
PASS-THROUGH.

For the 32WSS or 32WSS-L, ports 1 
through 32 (CHAN-RX) are assigned 
to optical channels configured as add 
channels. 

For the 40-WSS-C or 40-WSS-CE, 
CHAN-RX ports are 1 through 40.

32WSS or 32WSS-L ports 33 through 
64 (PASS-THROUGH) are assigned to 
optical channels configured as 
pass-through channels.

40-WSS-C or 40-WSS-CE ports 41 
through 80 are PASS-THROUGH 
channels.

—

Port Name Allows a logical name to be assigned 
for each of the port.

User-defined. Name can be up to 
32 alphanumeric/special characters. Blank by 
default. Double-click, enter the name, and 
press Enter.

See the “DLP-G104 Assign a Name to a Port” 
task on page 17-16.

Admin 
State

Sets the port administrative state unless 
network conditions prevent the change. 
For more information about 
administrative states, see the 
Administrative and Service States 
document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service 
State

(Display only) Identifies the 
autonomously generated state that 
gives the overall condition of the port. 
Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information 
about service states, see the 
Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,automati
cInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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Chapter 21      Change DWDM Card Settings
DLP-  G212 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Parameters
Power (Display only) Power value read by the 
photodiode located after the VOA 
associated to the port, and calibrated to 
the COM_TX port. For more 
information, see the Hardware 
Specifications document.

Numeric value (dB)

Actual 
Wavelength

(Display only) Displays the actual 
wavelength utilized by the channel.

—

Expected 
Wavelength

(Display only) Displays the expected 
wavelength assigned for the channel.

—

AINS Soak (Display only) The automatic 
in-service soak period. It is always 
00.00.

—

VOA Mode (Display only) Displays the active 
VOA working mode.

• Constant Power

• Constant Attenuation

VOA Power 
Reference

(Display only) Shows the value of the 
optical power setpoint that must be 
reached on the path where a VOA is 
present, when VOA Mode is set to 
Constant Power. This value is the 
desired per-channel optical power. This 
parameter can only be modified by 
ANS.

Numeric value (dB)

VOA Power 
Calibration

Allows you to modify the VOA power 
value when VOA Mode is Constant 
Power.

Double-click the parameter, enter a value, and 
press Enter.

• Numeric value (dB)

• –37 dB to –2 dB

VOA 
Attenuation 
Reference

(Display only) Shows the attenuation 
value of the VOA when the VOA Mode 
is Constant Attenuation. This 
parameter can only be modified by 
ANS.

Numeric value (dB)

VOA 
Attenuation 
Calibration

Allows you to modify the VOA 
attenuation value when VOA Mode is 
Constant Attenuation.

Double-click the parameter, enter a value, and 
press Enter.

• Numeric value (dB)

• –30 dB to +30 dB

Table 21-35 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Optical Channel Parameter Settings 

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G213 Change the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Thresholds
Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G213 Change the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical 
Channel Thresholds

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 32WSS, 32WSS-L, 
40-WSS-C, or 40-WSS-CE card where you want to change the optical channel threshold settings.

Step 2 Click the Provisioning > Optical Chn: Optical Connectorn > Optics Thresholds tabs, where n = one 
of the four available groups of eight optical channels.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-36.

Power ADD (Display only) Displays a measurement 
of the optical power coming in on the 
ADD RX port, reported in the 
CHAN-RX port column. This is the 
power transmitted by the TX laser of 
the TXP or MXP card that is connected 
to the 32WSS, 32WSS-L, 40-WSS-C, 
or 40-WSS-CE.

Numeric value (dB)

Path Value (Display only) Displays the path value 
for the CHAN-RX port column 
parameter.

Standby

Purpose This task changes the optical channel threshold settings for the 32WSS, 
32WSS-L, 40-WSS-C, or 40-WSS-CE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-35 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Optical Channel Parameter Settings 

Parameter Description Options
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Chapter 21      Change DWDM Card Settings
DLP-  G213 Change the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Thresholds
e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-37.

Table 21-36 32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Channel Warning Threshold 

Settings

Parameter Description Options

Port (Display only) Shows the port number, 
port type, and direction (RX or TX). Each 
optical channel (wavelength) has two 
logical ports. However, only one is active 
at a time depending on the operating 
mode provisioned for the port on the card 
view Maintenance tab: either CHAN-RX 
or PASS-THROUGH.

—

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.
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Chapter 21      Change DWDM Card Settings
DLP-  G213 Change the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Thresholds
Table 21-37  32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Channel Alarm Threshold 

Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX). For 
each optical channel (wavelength), two 
logical ports are associated. Only one port 
can be active at a time, depending on the 
port’s operating mode. The operating 
mode, provisioned on the card view 
Maintenance tab, is either CHAN RX or 
PASS-THROUGH.

32WSS and 32WSS-L ports 1 through 32 
(CHAN-RX) are associated to optical 
channels configured as add/drop channels.

40-WSS-C or 40-WSS-CE ports 1 through 
40 are the CHAN-RX channels.

32WSS or 32WSS-L ports 33 through 64 
(PASS-THROUGH) are associated to 
optical channels configured as 
pass-through channels.

For the 40-WSS-C or 40-WSS-CE, ports 
41 through 80 are the PASS-THROUGH 
channels.

—

Power Failure 
Low (dBm)

(Display only) Shows the power failure low 
threshold. This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 5 dB lower). 

The threshold is calculated automatically 
when you run ANS. For more information, 
see the Hardware Specifications document.

—
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Chapter 21      Change DWDM Card Settings
DLP-  G213 Change the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Channel Thresholds
d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

Power Degrade 
High (dBm)

(Display only) Shows the power degrade 
high threshold. This power value applies to 
the corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 3 dB higher). 

—

Power Degrade 
Low (dBm)

(Display only) Shows the power degrade 
low threshold. This power value applies to 
the corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 2 dB lower). 

Numeric

Power ADD 
Failure Low 
(dBm)

Shows the power add failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to the actual 
measurement of the optical power on the 
ADD RX port. It is reported as CHAN RX, 
that is, the power transmitted by the 
Trunk-TX laser of the TXP/MXP card 
connected to the 32WSS, 32WSS-L, 
40-WSS-C, or 40-WSS-CE card.

Numeric. CTC does not allow it to be 
changed.

Table 21-37  32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Channel Alarm Threshold 

Settings (continued)

Parameter Description Options
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DLP-  G214 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Line Parameters
DLP-G214 Change 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical 
Line Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 32WSS, 32WSS-L, 
40-WSS-C, or 40-WSS-CE card where you want to change the optical line parameter settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Modify any of the settings described in Table 21-38. The provisionable parameters are listed in the 
Options column. The SONET (ANSI) option is followed by the SDH (ETSI) option.

Purpose This task changes the optical line parameter settings for the 32WSS, 
32WSS-L, 40-WSS-C or 40-WSS-CE cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-38 32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Line Parameter Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX),

32WSS or 32WSS-L:

• 65 (EXP-TX)

• 66 (EXP-RX)

• 67 (COM-TX)

• 68 (COM-RX)

• 69 (DROP-TX)

40-WSS-C or 40-WSS-CE:

• 81 (EXP-TX)

• 82 (EXP-RX)

• 83 (COM-TX)

• 84 (COM-RX)

• 85 (DROP-TX)

Port Name Allows you to assign a logical name for 
each of the ports shown.

User-defined. Name can be up to 
32 alphanumeric/ special characters. Blank by 
default. Double-click, enter the name, and 
press Enter.

See the “DLP-G104 Assign a Name to a Port” 
task on page 17-16.
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DLP-  G215 Change the 32WSS, 32-WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Line Thresholds
Step 4 Return to your originating procedure (NTP).

DLP-G215 Change the 32WSS, 32-WSS-L, 40-WSS-C, or 40-WSS-CE Card 
Optical Line Thresholds

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Admin 
State

Sets the port administrative state unless 
network conditions prevent the change. 
For more information about 
administrative states, see the 
Administrative and Service States 
document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service 
State

(Display only) Identifies the 
autonomously generated state that gives 
the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, 
Secondary State. For more information 
about service states, see the 
Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Power value read by the 
photodiode associated with the port.

Numeric value (dB)

AINS Soak (Display only) The automatic in-service 
soak period. It is always 00.00.

—

Actual 
Channels

Number of active channels carried by the 
port (the difference between provisioned 
and failed) 

—

Purpose This task changes the 32WSS, 32WSS-L, 40-WSS-C, or 40-WSS-CE card 
optical line threshold settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-38 32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Line Parameter Settings 

Parameter Description Options
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DLP-  G215 Change the 32WSS, 32-WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Line Thresholds
Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 32WSS, 32WSS-L, 
40-WSS-C, or 40-WSS-CE card where you want to change the optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs for one of the groups of optical 
channels that are available.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-39.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-40.

Table 21-39 32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Line Warning Threshold 

Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX),

32WSS or 32WSS-L:

• 65 (EXP-TX)

• 66 (EXP-RX)

• 67 (COM-TX)

• 68 (COM-RX)

• 69 (DROP-TX)

40-WSS-C or 40-WSS-CE:

• 81 (EXP-TX)

• 82 (EXP-RX)

• 83 (COM-TX)

• 84 (COM-RX)

• 85 (DROP-TX)

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm.
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DLP-  G215 Change the 32WSS, 32-WSS-L, 40-WSS-C, or 40-WSS-CE Card Optical Line Thresholds
d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

NTP-G240 Modify TDC-CC and TDC-FC Line Settings and PM 
Thresholds

Table 21-40  32WSS, 32WSS-L, 40-WSS-C, and 40-WSS-CE Optical Line Alarm Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX),

32WSS or 32WSS-L:

• 65 (EXP-TX)

• 66 (EXP-RX)

• 67 (COM-TX)

• 68 (COM-RX)

• 69 (DROP-TX)

40-WSS-C or 40-WSS-CE:

• 81 (EXP-TX)

• 82 (EXP-RX)

• 83 (COM-TX)

• 84 (COM-RX)

• 85 (DROP-TX)

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

You can manually change the threshold. 
The value must be within the optical 
power range that is specified for the card. 
For more information, see the Hardware 
Specifications document.

Numeric. Double-click the parameter, 
enter a value, and press Enter.

Purpose This procedure changes the TDC-CC or TDC-FC card line settings and PM 
thresholds.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Chapter 21      Change DWDM Card Settings
DLP-  G545 Modify the Chromatic Dispersion Value for the TDC-CC and TDC-FC Cards
Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the TDC-CC or 
TDC-FC card settings. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G545 Modify the Chromatic Dispersion Value for the TDC-CC and TDC-FC Cards, 
page 21-77.

• DLP-G528 Change Optical Line Threshold Settings for TDC-CC or TDC-FC Card, page 21-78.

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

DLP-G545 Modify the Chromatic Dispersion Value for the TDC-CC and TDC-FC 
Cards

Step 1 In the node view (single-shelf mode) or shelf view (multishelf view), double-click the TDC-CC or 
TDC-FC card. 

Step 2 Click Provisioning > Card tab and then select the CD value from the Compensating Value drop-down 
list.

Step 3 Click Apply. A warning message appears stating that the change in compensation value could 
affect traffic.

Step 4 Click Yes. The compensation value is set.

Step 5 Return to your originating procedure (NTP).

Purpose This procedure modifies the chromatic dispersion (CD) value for the 
TDC-CC and TDC-FC cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G528 Change Optical Line Threshold Settings for TDC-CC or TDC-FC Card

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TDC-CC or TDC-FC 
card where you want to change the optical channel threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs.

Step 3 If you want to change the warning thresholds, complete the following steps. If not continue with Step 4.

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-41.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5.

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-42.

Purpose This task changes the optical line threshold settings for the TDC-CC or 
TDC-FC card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-41 TDC-CC and TDC-FC Cards Optical Line Warning Threshold Settings 

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (DC-RX or 
DC-TX).

• 1 (DC-RX)

• 2 (DC-TX)

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter a value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter a value, 
and press Enter.
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DLP-  G528 Change Optical Line Threshold Settings for TDC-CC or TDC-FC Card
d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

NTP-G174 Modify the 40-WXC-C or 80-WXC-C Line Settings and 
PM Thresholds 

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the 40-WXC-C or 
80-WXC-C card settings. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2. For 40-WXC-C cards, 
continue with Step 4. For 80-WXC-C cards, continue with Step 3.

Step 3 Verify the card mode for 80-WXC-C cards. Complete the following steps:

a. Display the 80-WXC-C card in card view.

b. Click the Provisioning > Card tabs.

c. Verify that the card mode is set to the mode designated by your site plan:

– BIDIRECTIONAL

– MULTIPLEXER

– DE-MULTIPLEXER

Table 21-42 TDC-CC and TDC-FC Cards Optical Line Alarm Thresholds Setting

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (DC-RX or 
DC-TX).

• 1 (DC-RX)

• 2 (DC-TX)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. You can manually 
change the threshold. The value must be 
within the optical power range that is 
specified for the card. For more 
information, see the Hardware 
Specifications document.

Numeric. Double-click the table cell, 
enter a value, and press Enter.

Purpose This procedure changes the 40-WXC-C or 80-WXC-C card thresholds and 
settings.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
21-79
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 21      Change DWDM Card Settings
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Step 4 If the card mode is set correctly, continue with Step 4. If not, complete the “DLP-G603 Change the 
80-WXC-C Card Mode” task on page 21-80.

Step 5 Perform any of the following tasks as needed:

• DLP-G406 Change 40-WXC-C or 80-WXC-C Card Optical Channel Parameters, page 21-81

• DLP-G407 Change the 40-WXC-C or 80-WXC-C Optical Channel Thresholds, page 21-84

Note To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see 
Alarm and TCA Monitoring and Management

• DLP-G408 Change 40-WXC-C or 80-WXC-C Optical Line Parameters, page 21-87

• DLP-G409 Change the 40-WXC-C or 80-WXC-C Optical Line Thresholds, page 21-89

• DLP-G413 Change 40-WXC-C or 80-WXC-C Card WXC Line Parameters, page 21-91

• DLP-G771 Changing the WXC Line Thresholds for the 80-WXC-C Card, page 21-93

Step 6 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

DLP-G603 Change the 80-WXC-C Card Mode

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 80-WXC-C card 
where you want to change the card mode.

Step 2 Click the Provisioning > WXC Line > Parameters tabs.

Step 3 Verify that any provisioned client or trunk ports have an OOS-MA,DSBLD (ANSI) or 
Locked-enabled,disabled (ETSI) service state in the Service State column. If so, continue with Step 4. 
If not, complete the following substeps.

a. For the first port that is in service, in the Admin State column, choose OOS,DSBLD (ANSI) or 
Locked,disabled (ETSI).

b. Repeat Step a. for each port that is in service.

c. Click Apply.

Purpose This task changes the card mode of the 80-WXC-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click the Provisioning > Card tabs. Choose one of the card modes shown in Table 21-43.

Step 5 Click Apply, then click Yes in the confirmation dialog box.

Step 6 Return to your originating procedure (NTP)

DLP-G406 Change 40-WXC-C or 80-WXC-C Card Optical Channel Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-WXC-C or 
80-WXC-C card where you want to change the optical channel parameter settings.

Step 2 Click the Provisioning > OCH > Parameters tabs. For 40-WXC-C cards, continue with Step 4. For 
80-WXC-C cards, continue with Step 3.

Step 3 Choose a wavelength from the Wavelength drop-down list and click Retrieve to retrieve the OCH 
parameters.

Table 21-43 80-WXC-C Card Modes

Mode Description

Bidirectional Provisions the 80-WXC-C card in the 
bidirectional mode. Traffic received from any of 
the nine input ports(EAD i, i=1 to 8, AD ports) 
are multiplexed and sent to the common output 
port (COM ports). The pre-amplifer output signal 
from the preamplifier is split in a 40%-to-60% 
ratio, 40% is sent on the drop path (DROP-TX 
port) and 60% is sent pass-through path (EXP-TX 
port). 

Multiplexer Provisions the 80-WXC-C card in the multiplexer 
mode. Traffic received from any of the nine input 
ports (EAD i, i=1 to 8, AD ports) are multiplexed 
and sent to the common output port (COM port).

Demultiplexer Provisions the 80-WXC-C card in the 
demultiplexer mode. Traffic received from 
common input port (COM port) is demultiplexed 
and sent to the nine output ports (EAD i, i=1 to 8, 
AD ports).

Purpose This task changes the optical channel parameter settings for the 
40-WXC-C or 80-WXC-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Modify any of the settings described in Table 21-44. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Table 21-44  40-WXC-C and 80-WXC-C Optical Channel Parameter Settings

Parameter Description Options

Circuit Name (Display only) Shows the circuit 
name. This is provisioned in the 
Circuits tab.

—

Admin State Sets the port administrative state 
unless network conditions prevent 
the change. For more information 
about administrative states, see the 
Administrative and Service States 
document.

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance 
( 40-WXC-C only)

Service State (Display only) Identifies the 
autonomously generated state that 
gives the overall condition of the 
port. Service states appear in the 
format: Primary State-Primary State 
Qualifier, Secondary State. For more 
information about service states, see 
the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,automat
icInService ( 40-WXC-C only)

• OOS-MA,DSBLD/Locked-enabled,disable
d ( 40-WXC-C only)

• OOS-MA,MT/Locked-enabled,maintenanc
e ( 40-WXC-C only)

From (Display only) The port where the 
circuit originated.

—

Power 
(40-WXC-C 
only)

(Display only) Power value read by 
the photodiode located after the VOA 
associated to the port, and calibrated 
to the COM_TX port. For more 
information, see the Hardware 
Specifications document.

Numeric value (dB)

Power From 
(80-WXC-C 
only)

Power on the port where the circuit 
originated. 

—

To 
(80-WXC-C 
only)

(Display only) The port where the 
circuit terminated.

—

Power To 
(80-WXC-C 
only)

Power on the port where the circuit 
terminated. 

—

Force Channel 
(80-WXC-C 
only)

Starts the channel by moving the 
VOA from Open to Closed loop. You 
can force a channel only when the 
Force Channel Status is in the 
Unlocked state. 

• OFF

• ON
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Step 5 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 6 Return to your originating procedure (NTP).

Force Channel 
Status 
(80-WXC-C 
only)

(Display only) Displays the channel 
status.

• Unlocked—Can force channel startup

• Locked—Cannot force channel startup as 
the device is under control of other 
functions like optical safety

• Forced—Channel startup has already 
been forced

Actual 
Wavelength 
(40-WXC-C 
only)

(Display only) Displays the actual 
wavelength utilized by the channel.

—

VOA Mode (Display only) Displays the active 
VOA working mode.

• Constant Power

• Constant Attenuation

VOA Power 
Ref.

(Display only) Shows the value of the 
optical power setpoint that must be 
reached on the path where a VOA is 
present, when VOA Mode is set to 
Constant Power. This value is the 
desired per-channel optical power. 
This parameter can only be modified 
by ANS.

Numeric value (dB)

VOA Power 
Calib.

Allows you to modify the VOA 
power value when VOA Mode is 
Constant Power.

Double-click the parameter, enter a value, and 
press Enter.

• Numeric value (dB)

• –37 dB to –2 dB

VOA 
Attenuation 
Ref. 
(40-WXC-C 
only)

(Display only) Shows the attenuation 
value of the VOA when the VOA 
Mode is Constant Attenuation. This 
parameter can only be modified by 
ANS.

Numeric value (dB)

VOA 
Attenuation 
Calib. 
(40-WXC-C 
only)

Allows you to modify the VOA 
attenuation value when VOA Mode is 
Constant Attenuation.

Double-click the parameter, enter a value, and 
press Enter.

• Numeric value (dB)

• –30 dB to +30 dB

Table 21-44  40-WXC-C and 80-WXC-C Optical Channel Parameter Settings (continued)

Parameter Description Options
21-83
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 21      Change DWDM Card Settings
DLP-  G407 Change the 40-WXC-C or 80-WXC-C Optical Channel Thresholds
DLP-G407 Change the 40-WXC-C or 80-WXC-C Optical Channel Thresholds

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-WXC-C or 
80-WXC-C card where you want to change the optical channel threshold settings.

Step 2 Click the Provisioning > OCH > OCH Thresholds tabs, where n = one of the four available groups of 
eight optical channels.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day. For 40-WXC-C 
card, continue with Step 3c. For 80-WXC-C card, continue with Step 3d.

c. Click Refresh. Continue with Step 3g.

d. Choose a wavelength from the Wavelength drop-down list.

e. In the Port drop-down list, choose an OCH port where you want to change the optical channel 
threshold settings.

f. Click Retrieve. 

g. Modify any of the warning thresholds shown under the Options column in Table 21-45.

Purpose This task changes the optical channel threshold settings for the 40-WXC-C 
or 80-WXC-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-45 40-WXC-C and 80-WXC-C Optical Channel Warning Threshold Settings

Parameter Description Options

Circuit Name (Display only) Shows the circuit name. 
This is provisioned in the Circuits tab.

—

Port Name (Display only) Shows the port name. —

Actual 
Wavelength

(Display only) Displays the actual 
wavelength utilized by the channel.

—

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.
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h. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm. For 40-WXC-C card, continue with Step 4b. For 80-WXC-C card, 
continue with Step 4c.

b. Click Refresh. Continue with Step 4f.

c. Choose a wavelength from the Wavelength drop-down list.

d. In the Port drop-down list, choose an OCH port where you want to change the optical channel 
threshold settings:

For the 80-WXC-C card, the following ports are available to view:

– 1 (EAD)

– 2 (EAD)

– 3 (EAD)

– 4 (EAD)

– 5 (EAD)

– 6 (EAD)

– 7 (EAD)

– 8 (EAD)

– 9 (AD)

– 10 (COM)

– (DROP-TX) (in BIDI mode)

e. Click Retrieve.

f. Modify any of the alarm thresholds shown under the Options column in Table 21-46.

Table 21-46  40-WXC-C and 80-WXC-C Optical Channel Alarm Threshold Settings

Parameter Description Options

Circuit Name (Display only) Shows the circuit name. 
This is provisioned in the Circuits tab.

—

Port Name (Display only) Shows the port name. —

Actual 
Wavelength

(Display only) Displays the actual 
wavelength utilized by the channel.

—
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g. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

Power Failure 
Low (dBm)

(Display only) Shows the power failure low 
threshold. This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 5 dB lower). 

The threshold is calculated automatically 
when you run ANS. For more information, 
see the Hardware Specifications document.

—

Power Degrade 
High (dBm)

(Display only) Shows the power degrade 
high threshold. This power value applies to 
the corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 3 dB higher). 

—

Power Degrade 
Low (dBm)

(Display only) Shows the power degrade 
low threshold. This power value applies to 
the corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 2 dB lower). 

Numeric

Table 21-46  40-WXC-C and 80-WXC-C Optical Channel Alarm Threshold Settings (continued)

Parameter Description Options
21-86
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_hardware_specifications.html


 

Chapter 21      Change DWDM Card Settings
DLP-  G408 Change 40-WXC-C or 80-WXC-C Optical Line Parameters
DLP-G408 Change 40-WXC-C or 80-WXC-C Optical Line Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-WXC-C or 
80-WXC-C card where you want to change the optical line parameter settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Modify any of the settings described in Table 21-47. The provisionable parameters are listed in the 
Options column. The SONET (ANSI) option is followed by the SDH (ETSI) option.

Purpose This task changes the optical line parameter settings for 40-WXC-C or 
80-WXC-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-47 40-WXC-C or 80-WXC-C Optical Line Parameter Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX),

40-WXC-C card options:

• 10 (DROP-TX)

• 11 (EXP-TX)

• 12 (COM-RX)

• 13 (COM-TX)

80-WXC-C card options:

• 11 (DROP-TX) 

• 12 (EXP-TX) 

• 13 (COM-RX)

Port Name Allows you to assign a logical name for 
each of the ports shown.

User-defined. Name can be up to 
32 alphanumeric/ special characters. Blank by 
default. Double-click, enter the name, and 
press Enter.

See the “DLP-G104 Assign a Name to a Port” 
task on page 17-16.

Admin 
State

Sets the port administrative state unless 
network conditions prevent the change. 
For more information about 
administrative states, see the 
Administrative and Service States 
document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance
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Step 4 Return to your originating procedure (NTP).

Service 
State

(Display only) Identifies the 
autonomously generated state that gives 
the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary 
State. For more information about 
service states, see the Administrative and 
Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power 
(40-WXC-
C only)

(Display only) Power value read by the 
photodiode associated with the port.

Numeric value (dB)

Active 
Channels 
(40-WXC-
C only)

Number of active channels carried by the 
port (the difference between provisioned 
and failed)

—

VOA Mode 
(80-WXC-
C in BIDI 
mode only)

(Display only) Displays the active VOA 
working mode.

• Constant Power

• Constant Attenuation

VOA 
Attenuatio
n Ref. 
(80-WXC-
C in BIDI 
mode only)

(Display only) Shows the attenuation 
value of the VOA when the VOA Mode 
is Constant Attenuation. This parameter 
can only be modified by ANS.

Numeric value (dB)

VOA 
Attenuatio
n Calib. 
(80-WXC-
C in BIDI 
mode only)

Allows you to modify the VOA 
attenuation value when VOA Mode is 
Constant Attenuation.

Double-click the parameter, enter a value, and 
press Enter.

• Numeric value (dB)

• –30 dB to +30 dB

Table 21-47 40-WXC-C or 80-WXC-C Optical Line Parameter Settings (continued)

Parameter Description Options
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DLP-G409 Change the 40-WXC-C or 80-WXC-C Optical Line Thresholds

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-WXC-C or 
80-WXC-C card where you want to change the optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs for one of the groups of optical 
channels that are available.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-48.

Purpose This task changes the 40-WXC-C or 80-WXC-C card optical line threshold 
settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-48 40-WXC-C or 80-WXC-C Optical Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX),

40-WXC-C card options:

• 10 (DROP-TX)

• 11 (EXP-TX)

• 12 (COM-RX)

• 13 (COM-TX)

80-WXC-C card options:

• 11 (DROP-TX)

• 12 (EXP-TX)

• 13 (COM-RX

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm.
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e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-49.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

Table 21-49  40-WXC-C or 80-WXC-C Optical Line Alarm Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX),

40-WXC-C card options:

• 10 (DROP-TX)

• 11 (EXP-TX)

• 12 (COM-RX)

• 13 (COM-TX) 

80-WXC-C card options:

• 11 (DROP-TX) 

• 12 (EXP-TX)

• 13 (COM-RX) 

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

You can manually change the threshold. 
The value must be within the optical 
power range that is specified for the card. 
For more information, see the Hardware 
Specifications document.

Numeric. Double-click the parameter, 
enter a value, and press Enter.
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DLP-G413 Change 40-WXC-C or 80-WXC-C Card WXC Line Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-WXC-C or 
80-WXC-C card where you want to change the optical line parameter settings.

Step 2 Click the Provisioning > WXC Line > Parameters tabs.

Step 3 Modify any of the settings described in Table 21-50. The provisionable parameters are listed in the 
Options column. The SONET (ANSI) option is followed by the SDH (ETSI) option.

Purpose This task changes the WXC line parameter settings for 40-WXC-C or 
80-WXC-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 21-50 40-WXC-C or 80-WXC-C WXC Line Parameter Settings

Parameter Description Options

Port (Display only) Displays the port 
number, port type, and direction (RX or 
TX),

40-WXC-C card options:

• 1 (EXP-RX) 

• 2 (EXP-RX) 

• 3 (EXP-RX) 

• 4 (EXP-RX) 

• 5 (EXP-RX)

• 6 (EXP-RX) 

• 7 (EXP-RX) 

• 8 (EXP-RX) 

• 9 (ADD-RX)

80-WXC-C card options:

• 1 (EAD)

• 2 (EAD)

• 3 (EAD)

• 4 (EAD) 

• 5 (EAD) 

• 6 (EAD)

• 7 (EAD)

• 8 (EAD)

• 9 (AD)

• 10 (COM)

Port Name Allows you to assign a logical name for 
each of the ports shown.

User-defined. Name can be up to 
32 alphanumeric/ special characters. Blank by 
default. Double-click, enter the name, and 
press Enter.

See the “DLP-G104 Assign a Name to a Port” 
task on page 17-16.

Admin State Sets the port administrative state unless 
network conditions prevent the change. 
For more information about 
administrative states, see the 
Administrative and Service States 
document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance
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Step 4 Return to your originating procedure (NTP).

DLP-G771 Changing the WXC Line Thresholds for the 80-WXC-C Card

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 80-WXC-C card 
where you want to change the WXC line thresholds.

Step 2 Click the Provisioning > WXC Line > WXC Line Thresholds tabs for one of the groups of optical 
channels that are available.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4.

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

Service State (Display only) Identifies the 
autonomously generated state that gives 
the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, 
Secondary State. For more information 
about service states, see the 
Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Active 
Channels

(Display only) Indicates how many 
channels the port is carrying. Generally 
reflects the number of provisioned 
channels.

—

Power 
(80-WXC-C 
only)

(Display only) Shows the current power 
level per port.

—

Purpose This task changes the WXC line thresholds for the 80-WXC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-50 40-WXC-C or 80-WXC-C WXC Line Parameter Settings (continued)

Parameter Description Options
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d. Modify any of the warning thresholds shown under the Options column in the following table.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5.

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in this table.

Table 21-51 80-WXC-C WXC Line Warning Thresholds

Parameter Description Options

Port (Display only) Displays the port 
number, port type, and direction (RX 
or TX),

80-WXC-C card options:

• 1 (EAD)

• 2 (EAD)

• 3 (EAD)

• 4 (EAD) 

• 5 (EAD) 

• 6 (EAD)

• 7 (EAD)

• 8 (EAD)

• 9 (AD)

• 10 (COM)

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is –50 dBm.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm.
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d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

DLP-G429 Multiplex a Single Wavelength on 40-WXC-C Card

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-WXC-C card 
where you want to multiplex a wavelength. 

Step 2 Click the Maintenance > OCHNC tabs.

Table 21-52 80-WXC-C WXC Line Alarm Thresholds

Parameter Description Options

Port (Display only) Displays the port 
number, port type, and direction (RX 
or TX),

80-WXC-C card options:

• 1 (EAD)

• 2 (EAD)

• 3 (EAD)

• 4 (EAD) 

• 5 (EAD) 

• 6 (EAD)

• 7 (EAD)

• 8 (EAD)

• 9 (AD)

• 10 (COM)

Power Failure 
Low (dBm)

Shows the power failure low 
threshold. This power value applies to 
the corresponding port and is 
automatically calculated when ANS 
is run. You can manually change the 
threshold. The value must be within 
the optical power range that is 
specified for the card. 

Numeric. Double-click the parameter, enter a 
value, and press Enter.

Purpose This task multiplexes a single wavelength onto the COM-TX port of a 
40-WXC-C card. Perform this task for testing and troubleshooting a 
40-WXC-C card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Enter the following values:

Target Power (dBm)—Enter the target power. The default is –14.0 dBm.

• Input Port—Choose the EXP-RX or ADD-RX port where you want to multiplex the wavelength 
from.

• VOA Attenuation (dB)—Enter the VOA attenuation. The default values are: 

– 20 dB for four-way mesh and an EXP-RX input port

– 16 dB for 8-way mesh and an EXP-RX input port

– 22 dB for an ADD-RX input port

• Wavelength—Choose the wavelength that you want to multiplex. The supported wavelengths are the 
40 channels of the C-band from 1530.33 nm to 1561.32 nm. A “Maintenance” wavelength is also 
provided that corresponds to a “Lambda zero” wavelength of 1529.55 nm.

Note You cannot multiplex a wavelength that is already allocated on the COM-TX port.

Step 4 Click Apply. This creates a cross-connection (add or pass-through) for the specified wavelength. This 
cross-connection remains active until you click Clear.

Step 5 If you want to multiplex additional channels, click Clear to delete the existing cross-connection, and 
repeat Steps 3 and 4. If not, continue with Step 6.

Step 6 To view the actual power on the COM-TX port, click Refresh. Wait 10-15 seconds for the actual power 
to appear.

Step 7 Return to your originating procedure (NTP).

NTP-G241 Modify the 40-SMR1-C and 40-SMR2-C Line Settings 
and PM Thresholds 

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the 40-SMR1-C or 
40-SMR2-C card settings. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G532 Change Optical Line Settings for 40-SMR1-C and 40-SMR2-C Cards, page 21-97

Purpose This procedure changes the 40-SMR1-C and 40-SMR2-C card thresholds 
and settings.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• DLP-G533 Change Optical Line Threshold Settings for 40-SMR1-C and 40-SMR2-C Cards, 
page 21-99

• DLP-G534 Change Optical Amplifier Line Settings for 40-SMR1-C and 40-SMR2-C Cards, 
page 21-103

• DLP-G535 Change Optical Amplifier Threshold Settings for 40-SMR1-C and 40-SMR2-C Cards, 
page 21-105

• DLP-G536 Change 40-SMR1-C and 40-SMR2-C Card Optical Channel Parameters, page 21-110

• DLP-G537 Change the 40-SMR1-C and 40-SMR2-C Optical Channel Thresholds, page 21-112

Note To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see 
Alarm and TCA Monitoring and Management

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

DLP-G532 Change Optical Line Settings for 40-SMR1-C and 40-SMR2-C Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-SMR1-C or 
40-SMR2-C card where you want to change the optical line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-53. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical line settings for the 40-SMR1-C and 
40-SMR2-C cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 21-53 40-SMR1-C and 40-SMR2-C Optical Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, 
and direction (TX or RX).

40-SMR1-C card options:

• 1 (EXP-RX)

• 3 (DC-RX)

• 4 (DC-TX)

• 5 (OSC-RX)

• 6 (OSC-TX

• 7 (ADD-RX)

• 8 (DROP-TX)

• 9 (LINE-RX)

• 10 (LINE-TX)

40-SMR2-C card options:

• 1 (DC-RX)

• 2 (DC-TX)

• 3 (OSC-RX)

• 4 (OSC-TX

• 5 (ADD-RX)

• 6 (DROP-TX)

• 7 (LINE-RX)

• 10 (EXP-RX 1-2)

• 11 (EXP-RX 1-3)

• 12 (EXP-RX 1-4)

Port Name Provides the ability to assign the specified port, a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task 
on page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more information 
about administrative states, see the Administrative 
and Service States document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Note You cannot set the 
OOS,DSBLD/Locked,disabled 
administrative state for LINE and OSC ports, 
and hence the 
OOS-MA,DSBLD/Locked-enabled,disabled 
service state is not applicable for these ports.
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Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G533 Change Optical Line Threshold Settings for 40-SMR1-C and 
40-SMR2-C Cards

Service State (Display only) Identifies the autonomously generated 
state that gives the overall condition of the port. 
Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Note You cannot set the 
OOS,DSBLD/Locked,disabled 
administrative state for LINE and OSC ports, 
and hence the 
OOS-MA,DSBLD/Locked-enabled,disabled 
service state is not applicable for these ports.

Power (Display only) Shows the current power level per port. —

VOA Mode (Display only) Shows the functional mode of the 
variable optical attenuator (VOA), when present. 

• Constant Attenuation

• Constant Power

VOA 
Attenuation 
Ref

(Display only) Shows the VOA attenuation value 
when VOA Mode is set to Constant Attenuation. This 
parameter can only be modified by ANS. 

—

VOA 
Attenuation 
Calib

Modifies the attenuation value of the VOA when the 
VOA Mode is set to Constant Attenuation.

Numeric. Double-click the parameter, enter a value, 
and press Enter.

Active 
Channels 

(Display only) Indicates how many channels the 
amplifier is carrying. Generally reflects the number of 
provisioned channels.

—

OSC Power (Display only) Shows the OSC power level per port. —

Purpose This task changes the optical line threshold settings for the 40-SMR1-C 
and 40-SMR2-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-53 40-SMR1-C and 40-SMR2-C Optical Line Settings (continued)

Parameter Description Options
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Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-SMR1-C or 
40-SMR2-C card where you want to change the optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-54.

e. Click Apply. If the change affects service, a warning message appears. Click Yes to complete the 
change.
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Table 21-54 40-SMR1-C and 40-SMR2-C Card Optical Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (TX or RX):

40-SMR1-C card options:

• 1 (EXP-RX)

• 3 (DC-RX)

• 4 (DC-TX)

• 5 (OSC-RX)

• 6 (OSC-TX

• 7 (ADD-RX)

• 8 (DROP-TX)

• 9 (LINE-RX)

• 10 (LINE-TX)

40-SMR2-C card options:

• 1 (DC-RX)

• 2 (DC-TX)

• 3 (OSC-RX)

• 4 (OSC-TX

• 5 (ADD-RX)

• 6 (DROP-TX)

• 7 (LINE-RX)

• 10 (EXP-RX 1-2)

• 11 (EXP-RX 1-3)

• 12 (EXP-RX 1-4)

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
value, and press Enter.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the table cell, 
enter the value, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the table cell, enter the 
value, and press Enter.
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Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

c. Modify any of the alarm thresholds shown under the Options column in Table 21-55.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Table 21-55 40-SMR1-C and 40-SMR2-C Card Optical Line Alarm Thresholds Setting

Parameter Description Options

Port (Display only) Displays the port number. 40-SMR1-C card options:

• 1 (EXP-RX)

• 3 (DC-RX)

• 4 (DC-TX)

• 5 (OSC-RX)

• 6 (OSC-TX

• 7 (ADD-RX)

• 8 (DROP-TX)

• 9 (LINE-RX)

• 10 (LINE-TX)

40-SMR2-C card options:

• 1 (DC-RX)

• 2 (DC-TX)

• 3 (OSC-RX)

• 4 (OSC-TX

• 5 (ADD-RX)

• 6 (DROP-TX)

• 7 (LINE-RX)

• 10 (EXP-RX 1-2)

• 11 (EXP-RX 1-3)

• 12 (EXP-RX 1-4)

Power Failure 
Low (dBm)

Shows the optical power failure low 
threshold for the port. The threshold is 
calculated automatically when you run 
ANS. You can manually change the 
threshold. The value must be within the 
optical power range that is specified for 
the card. For more information, see the 
Hardware Specifications document.

Numeric. 

Power Degrade 
High (dBm)

Does not apply to 40-SMR1-C and 
40-SMR2-C line parameters.

—
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Step 5 Return to your originating procedure (NTP).

DLP-G534 Change Optical Amplifier Line Settings for 40-SMR1-C and 
40-SMR2-C Cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-SMR1-C or 
40-SMR2-C card where you want to change the optical amplifier line settings.

Step 2 Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 21-56. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option. 

Power Degrade 
Low (dBm)

Does not apply to 40-SMR1-C and 
40-SMR2-C line parameters.

—

Pwr OSC 
Degrade High 
(dBm)

Does not apply to 40-SMR1-C and 
40-SMR2-C line parameters.

—

Pwr OSC 
Degrade Low 
(dBm)

Does not apply to 40-SMR1-C and 
40-SMR2-C line parameters.

—

Pwr OSC 
Failure (dBm)

Shows the optical power failure threshold 
for the OSC. The threshold is calculated 
automatically when you run ANS. You 
can manually change the threshold. The 
value must be within the optical power 
range that is specified for the card. If 
there is a failure, an LOS-O alarm is 
raised. For more information, see the 
Hardware Specifications document.

Numeric. 

Purpose This task changes the optical amplifier line settings for 40-SMR1-C and 
40-SMR2-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-55 40-SMR1-C and 40-SMR2-C Card Optical Line Alarm Thresholds Setting (continued)

Parameter Description Options
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Table 21-56 40-SMR1-C and 40-SMR2-C Card Line Settings

Parameter Description Options

Port (Display only) Displays the port number, port 
type, and direction.

40-SMR1-C card options:

• 2 (EXP-TX)

40-SMR1-C card options:

• 8 (LINE-TX)

• 9 (EXP-TX 1-1)

Port Name Provides the ability to assign the specified port, a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more 
information about administrative states, see the 
Administrative and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Note You cannot set the 
OOS,DSBLD/Locked,disabled 
administrative state for LINE-TX and 
EXP-TX ports, and hence the 
OOS-MA,DSBLD/Locked-enabled,disabled 
service state is not applicable for these ports.

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of 
the port. Service states appear in the format: 
Primary State-Primary State Qualifier, Secondary 
State. For more information about service states, 
see the Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Note You cannot set the 
OOS,DSBLD/Locked,disabled 
administrative state for LINE-TX and 
EXP-TX ports, and hence the 
OOS-MA,DSBLD/Locked-enabled,disabled 
service state is not applicable for these ports.

Total Output 
Power

(Display only) Shows the current power level per 
port. 

—

Offset Adjusts the total output power unless network 
conditions prevent the adjustment, for example, if 
the port is in IS state.

Numeric. Double-click to change.

Active Channels (Display only) Indicates how many channels the 
card is carrying. Generally reflects the number of 
provisioned channels.

—

OSC Power (Display only) Shows the OSC power level per 
port.

—
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Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 5 Return to your originating procedure (NTP).

DLP-G535 Change Optical Amplifier Threshold Settings for 40-SMR1-C and 
40-SMR2-C Cards

Channel Power 
Ref.

(Display only) Shows the optical per channel 
signal power setpoint that must be reached at the 
amplifier output when gain control is active.

—

Signal Output 
Power

(Display only) Shows the current output power 
leaving the amplifier, including the ASE 
contribution.

—

Output Power 
Set-Point

(Display only) Shows the output power setpoint. —

Working Mode (Display only) Shows the working mode, either 
Output Power or Control Gain. 

—

DCU Insertion 
Loss

(Display only) Shows the DCU insertion loss. —

Gain (Display only) The current gain of the amplifiers. —

Gain Set Point (Display only) The value of the gain that the 
amplifier must achieve. APC can modify this 
value based on the number of OCHNC circuits 
that the amplifier manages, or to compensate for 
fiber aging insertion loss. For more information, 
see Chapter 13, “Network Reference.”

—

Tilt Reference (Display only) Shows the default value for the 
amplifier tilt. Only ANS can modify this field.

—

Tilt Calibration Allows you to manually change the amplifier tilt. Numeric. Double-click the parameter, enter a value, 
and press Enter.

Purpose This task changes the optical channel threshold settings for the 
40-SMR1-C and 40-SMR2-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-56 40-SMR1-C and 40-SMR2-C Card Line Settings (continued)

Parameter Description Options
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Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-SMR1-C or 
40-SMR2-C card where you want to change the optical amplifier threshold settings.

Step 2 Click the Provisioning > Opt Ampli Line > Optics Thresholds tabs. 

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-57.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

Table 21-57 40-SMR1-C and 40-SMR2-C Card Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction.

40-SMR1-C card options:

• 2 (EXP-TX)

40-SMR1-C card options:

• 8 (LINE-TX)

• 9 (EXP-TX 1-1)

opwrMin 
(dBm)

Sets the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax 
(dBm)

Sets the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.

opwrMin OSC 
(dBm)

Sets the OSC low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm. Double-click the parameter, 
enter a value, and press Enter.

opwrMax OSC 
(dBm)

Sets the OSC high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm. 
Double-click the parameter, enter a value, 
and press Enter.
21-106
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 21      Change DWDM Card Settings
DLP-  G535 Change Optical Amplifier Threshold Settings for 40-SMR1-C and 40-SMR2-C Cards
c. Modify any of the alarm thresholds shown under the Options column in Table 21-58.

d. Click Apply. If the change affects service, a warning message appears. Click Yes to complete the 
change.

Table 21-58 40-SMR1-C and 40-SMR2-C Card Line Alarm Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number, port 
type, and direction.

40-SMR1-C card options:

• 2 (EXP-TX)

40-SMR1-C card options:

• 8 (LINE-TX)

• 9 (EXP-TX 1-1)

Gain Degrade 
Low (dBm)

(Display only) Shows the current value of the gain 
degrade low threshold configured in the card. This 
threshold applies only when the amplifier is active 
and in constant gain mode.

Gain Degrade Low refers to the Gain value of the 
port, which the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
automatically calculates when the amplifier is 
turned up.

The Gain Degrade Low threshold is automatically 
linked to the Gain Setpoint that is provisioned. 
Changing the setpoint changes the Gain Degrade 
Low threshold. The threshold value is always 2 dB 
lower than the Gain Setpoint value.

APC can also modify this value based on the 
number of OCHNC circuits that the amplifier is 
managing. 

—

Gain Degrade 
High (dBm)

(Display only) Shows the current value of the gain 
degrade high threshold configured in the card. 
This threshold applies only when the amplifier is 
active and in constant gain mode.

Gain Degrade High refers to the Gain value of the 
port, which the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
automatically calculates when the amplifier is 
turned up.

The Gain Degrade High threshold is linked to the 
Gain setpoint. Changing the setpoint changes the 
Gain Degrade High threshold. The threshold value 
is always 2 dB higher than the Gain Setpoint 
value.

APC can modify this value based on the number of 
OCHNC circuits that the amplifier is managing 
and to compensate for insertion loss due to fiber 
aging.

—
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Power Failure 
Low (dBm)

Shows the optical power failure low threshold for 
the port. The threshold is calculated automatically 
when you run ANS. You can manually change the 
threshold. The value must be within the optical 
power range that is specified for the card. For 
more information, see the Hardware 
Specifications document.

Numeric. Double-click to 
change.

Table 21-58 40-SMR1-C and 40-SMR2-C Card Line Alarm Thresholds Settings (continued)

Parameter Description Options
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Step 5 Return to your originating procedure (NTP).

Power Degrade 
High (dBm)

(Display only) Shows the current value of the 
optical power degrade high threshold. This 
threshold applies only when the amplifier is active 
and in constant power mode.

Power Degrade High refers to the Signal Output 
Power value of the port, which the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
automatically calculates when the amplifier is 
turned up.

The Power Degrade High threshold is linked to the 
Output Power Setpoint on the Parameters tab. 
Changing the setpoint changes the Power Degrade 
High threshold. The threshold value is always 
2 dB higher than the output power setpoint value.

APC can modify this value based on the number of 
OCHNC circuits that the amplifier is managing. 
For more information, see Chapter 13, “Network 
Reference.”

Note In Control Power working mode, this 
parameter is applicable only on the 
EXP-TX port for the 40-SMR2-C card.

—

Power Degrade 
Low (dBm)

(Display only) Shows the current value of the 
optical power degrade low threshold configured in 
the card. This threshold applies only when the 
amplifier is active and in constant power mode.

Power Degrade Low refers to the Signal Output 
Power value of the port, which the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
automatically calculates when the amplifier is 
turned up.

The Power Degrade Low threshold is 
automatically linked to the Output Power Setpoint 
on the Parameters tab. Changing the setpoint 
changes the Power Degrade Low threshold. The 
threshold value is always 2 dB lower than the 
output power setpoint.

APC can modify this value based on the number of 
OCHNC circuits that the amplifier is managing. 

Note In Control Power working mode, this 
parameter is applicable only on the 
EXP-TX port for the 40-SMR2-C card.

—

Table 21-58 40-SMR1-C and 40-SMR2-C Card Line Alarm Thresholds Settings (continued)

Parameter Description Options
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DLP-G536 Change 40-SMR1-C and 40-SMR2-C Card Optical Channel Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-SMR1-C or 
40-SMR2-C card where you want to change the optical channel parameter settings.

Step 2 Click the Provisioning > OCH > Parameters tab.

Step 3 From the Wavelength drop-down list, choose a wavelength and click Retrieve to retrieve the OCH 
parameters.

Step 4 Modify any of the settings described in Table 21-59. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This task changes the optical channel parameter settings for the 
40-SMR1-C and 40-SMR2-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 21-59 40-SMR1-C or 40-SMR2-C Card Optical Channel Parameter Settings

Parameter Description Options

Admin State Sets the port administrative state 
unless network conditions prevent the 
change. For more information about 
administrative states, see the 
Administrative and Service States 
document.

From the drop-down list, choose one of the 
following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Note You cannot set the 
OOS,MT/Locked,maintenance 
administrative state, and hence the 
OOS-MA,MT/Locked-enabled, 
maintenance service state is not 
applicable.

Service State (Display only) Identifies the 
autonomously generated state that 
gives the overall condition of the port. 
Service states appear in the format: 
Primary State-Primary State Qualifier, 
Secondary State. For more information 
about service states, see the 
Administrative and Service States 
document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled, 
automaticInService

• OOS-MA,DSBLD/Locked-enabled, 
disabled

• OOS-MA,MT/Locked-enabled, 
maintenance

Note You cannot set the 
OOS,MT/Locked,maintenance 
administrative state, and hence the 
OOS-MA,MT/Locked-enabled, 
maintenance service state is not 
applicable.

Power (Display only) Power value read by the 
photodiode located after the VOA 
associated to the port, and calibrated to 
the port. For more information, see the 
Hardware Specifications document.

Numeric value (dB).

Circuit Name (Display only) Shows the circuit name. 
This is provisioned in the Circuits tab.

—

From (Display only) The port where the 
circuit originated.

—

To (Display only) The port where the 
circuit terminated.

—

Power From Power on the From port where the 
circuit originated.

—

Power To Power on the To port where the circuit 
terminated.

—
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Step 5 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change. 

Step 6 Return to your originating procedure (NTP).

DLP-G537 Change the 40-SMR1-C and 40-SMR2-C Optical Channel Thresholds

Force Channel Allows you to move the VOA from 
Open to Closed loop to start the 
channel. 

You can force a channel only when the 
Force Channel Status is in the 
Unlocked state.

From the drop-down list, choose one of the 
following:

• OFF

• ON

VOA Power 
Ref.

(Display only) Shows the value of the 
optical power setpoint that must be 
reached on the path where a VOA is 
present, when VOA Mode is set to 
Constant Power. This value is the 
desired per channel optical power. 
Only ANS can modify this field.

Numeric value (dB).

VOA Power 
Calib.

Allows you to modify the VOA power 
value when VOA Mode is Constant 
Power.

Double-click the parameter, enter a value, 
and press Enter.

• Numeric value (dB)

• –25 dB to +12 dB

Force Channel 
Status

(Display only) Displays the channel 
status. The different statuses are:

• Unlocked—Can force channel 
startup

• Locked—Cannot force channel 
startup as the device is under 
control of other functions like 
optical safety

• Forced—Channel startup has 
already been forced

—

Purpose This task changes the optical channel threshold settings for the 
40-SMR1-C and 40-SMR2-C cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-59 40-SMR1-C or 40-SMR2-C Card Optical Channel Parameter Settings (continued)

Parameter Description Options
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Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the 40-SMR1-C or 
40-SMR2-C card where you want to change the optical channel threshold settings.

Step 2 Click the Provisioning > OCH > OCH Thresholds tab.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with c.. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Choose a wavelength from the Wavelength drop-down list.

d. In the Port drop-down list, choose an OCH port where you want to change the optical channel 
threshold settings: 

For the 40-SMR1-C card, the following ports are available to view:

– 1 (EXP-RX)

– 2 (EXP-TX)

– 7 (ADD-RX)

– 8 (DROP-TX)

– 10 (LINE-TX)

For the 40-SMR2-C card, the following ports are available to view:

– 5 (ADD-RX)

– 6 (DROP-TX)

– 8 (LINE-TX)

– 9 (EXP-TX 1-1)

– 10 (EXP-RX 1-2)

– 11 (EXP-RX 1-3)

– 12 (EXP-RX 1-4)

e. Click Retrieve. Modify any of the warning thresholds shown under the Options column in 
Table 21-60.

Table 21-60 40-SMR1-C or 40-SMR2-C Card Optical Channel Warning Threshold Settings

Parameter Description Options

Circuit Name (Display only) Shows the circuit name. 
This is provisioned in the Circuits tab.

—

Port Name (Display only) Shows the port name. —

Actual 
Wavelength

(Display only) Displays the actual 
wavelength that the channel utilizes.

—
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f. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Choose a wavelength from the Wavelength drop-down list.

c. In the Port drop-down list, choose an OCH port where you want to change the optical channel 
threshold settings.

d. Click Retrieve. Modify any of the alarm thresholds shown under the Options column in 
Table 21-61.

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

Table 21-60 40-SMR1-C or 40-SMR2-C Card Optical Channel Warning Threshold Settings 

Parameter Description Options

Table 21-61 40-SMR1-C or 40-SMR2-C Card Optical Channel Alarm Threshold Settings

Parameter Description Options

Circuit Name (Display only) Shows the circuit name. 
This is provisioned in the Circuits tab.

—

Port Name (Display only) Shows the port name. —

Actual 
Wavelength

(Display only) Displays the actual 
wavelength utilized by the channel.

—

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 5 dB lower). For more 
information, see the Hardware 
Specifications document.

—
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e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

Power Degrade 
High (dBm)

(Display only) Shows the power degrade 
high threshold. This power value applies to 
the corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 3 dB higher). 

Note This threshold applies only to 
certain ports depending on the 
working mode you have set.

—

Power Degrade 
Low (dBm)

(Display only) Shows the power degrade 
low threshold. This power value applies to 
the corresponding port and is automatically 
calculated when ANS is run.

This threshold applies to a port associated 
to a VOA (OSC-VOA) that is always active 
in Constant Power mode.

The threshold is automatically linked to the 
Power Setpoint (VOA Power Ref + VOA 
Power Calib) that is provisioned. Changing 
the setpoint results in changing the 
threshold (always 2 dB lower). 

Note This threshold applies only to 
certain ports depending on the 
working mode you have set.

Numeric

Table 21-61 40-SMR1-C or 40-SMR2-C Card Optical Channel Alarm Threshold Settings (continued)

Parameter Description Options
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NTP-G149 Modify the MMU Line Settings and PM Thresholds

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the MMU card settings. 
If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

Note To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see 
Alarm and TCA Monitoring and Management

• DLP-G342 Change MMU Optical Line Parameters, page 21-116

• DLP-G343 Change the MMU Optical Line Thresholds, page 21-118

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

DLP-G342 Change MMU Optical Line Parameters

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the MMU card where 
you want to change the optical line parameter settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Modify any of the settings described in Table 21-62. The provisionable parameters are listed in the 
Options column in the table. In the Options column, the SONET (ANSI) option is followed by the SDH 
(ETSI) option.

Purpose This procedure changes the MMU card thresholds and settings.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the optical line parameter settings for the MMU card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Return to your originating procedure (NTP).

Table 21-62 MMU Optical Line Parameter Settings

Parameter Description Options

Port (Display only) Displays the port number, port type, 
and direction (RX or TX):

• 1 (EXP-RX)

• 2 (EXP-TX)

• 3 (COM-RX)

• 4 (COM-TX)

• 5 (EXP A-RX)

• 6 (EXP A-TX)

—

Port Name Allows you to assign a logical name for each of the 
ports shown.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default. Double-click, 
enter the name, and press Enter.

See the “DLP-G104 Assign a Name to a Port” task on 
page 17-16.

Admin State Sets the port administrative state unless network 
conditions prevent the change. For more information 
about administrative states, see the Administrative 
and Service States document.

From the drop-down list, choose one of the following:

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State (Display only) Identifies the autonomously 
generated state that gives the overall condition of the 
port. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For 
more information about service states, see the 
Administrative and Service States document.

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Power (Display only) Power value read by the photodiode 
associated with the port.

Numeric value (dB)

AINS Soak (Display only) The automatic in-service soak period. 
It is always 00.00.

—

Actual 
Channels

Number of active channels carried by the port (the 
difference between provisioned and failed) 

—
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DLP-G343 Change the MMU Optical Line Thresholds

Caution Warning thresholds are monitored by CTC as part of performance monitoring. They must be 
user-provisioned.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the MMU card where 
you want to change the optical line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs.

Step 3 If you want to change the warning thresholds, complete the following steps. If not, continue with Step 4. 

a. Under Types, choose Warning.

b. Choose the warning interval that you want to provision, either 15 minutes or 1 Day.

c. Click Refresh.

d. Modify any of the warning thresholds shown under the Options column in Table 21-63.

e. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 4 If you want to change the alarm thresholds, complete the following steps. If not, continue with Step 5. 

a. Under Types, choose Alarm.

b. Click Refresh.

Purpose This task changes the MMU card optical line threshold settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-63 MMU Optical Line Warning Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX):

• 1 (EXP-RX)

• 2 (EXP-TX)

• 3 (COM-RX)

• 4 (COM-TX)

• 5 (EXP A-RX)

• 6 (EXP A-TX)

opwrMin 
(dBm)

Set the low power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 
–50 dBm.

opwrMax 
(dBm)

Set the high power warning level. Numeric. Can be set for 15-minute or 
one-day intervals. The default is 30 dBm.
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c. Modify any of the alarm thresholds shown under the Options column in Table 21-64.

d. Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the 
change.

Step 5 Return to your originating procedure (NTP).

NTP-G101 Modify Alarm Interface Controller–International 
Settings

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the AIC-I card settings. 
If you are already logged in, proceed to Step 2.

Table 21-64  MMU Optical Line Alarm Threshold Settings

Parameter Description Options

Port (Display only) Displays the port number, 
port type, and direction (RX or TX).

• 1 (EXP-RX)

• 2 (EXP-TX)

• 3 (COM-RX)

• 4 (COM-TX)

• 5 (EXP A-RX)

• 6 (EXP A-TX)

Power Failure 
Low (dBm)

Shows the power failure low threshold. 
This power value applies to the 
corresponding port and is automatically 
calculated when ANS is run.

You can manually change the threshold. 
The value must be within the optical 
power range that is specified for the card. 
For more information, see the Hardware 
Specifications document.

Numeric. Double-click the parameters, 
enter a value, and press Enter.

Purpose This procedure provisions the AIC-I card to receive input from or send 
output to external devices wired to the backplane (called external alarms 
and controls or environmental alarms), or changes orderwire settings. 

Tools/Equipment None

Prerequisite Procedures  NTP-G72 Provision External Alarms and Controls on the Alarm Interface 
Controller-International Card 

DLP-G109 Provision Orderwire, page 17-92

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G245 Change External Alarms Using the AIC-I Card, page 21-120

• DLP-G246 Change External Controls Using the AIC-I Card, page 21-121

• DLP-G247 Change AIC-I Card Orderwire Settings, page 21-121

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 24-2.

Stop. You have completed this procedure.

DLP-G245 Change External Alarms Using the AIC-I Card

Note The procedure is the same if you are using the alarm expansion panel (AEP). In this case, the number of 
contacts that are shown on the screen is changed accordingly. 

Step 1 Confirm that external-device relays are wired to the ENVIR ALARMS IN pins. See the “DLP-G20 
Install Alarm Wires on the MIC-A/P (ETSI Only)” or the “DLP-G23 Install Alarm Wires on the 
Backplane (ANSI Only)” in the Cisco ONS 15454 Hardware Installation Guide for more information.

Step 2 Double-click the AIC-I card to display it in card view.

Step 3 Click the Provisioning > External Alarms tabs.

Step 4 Modify any of the following fields for each external device wired to the ONS 15454 backplane. For 
definitions of these fields, see NTP-G72 Provision External Alarms and Controls on the Alarm Interface 
Controller-International Card.

• Enabled

• Alarm Type

• Severity

• Virtual Wire

• Raised When 

• Description

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes external alarm settings on the AIC-I card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G246 Change External Controls Using the AIC-I Card

Note The task is the same if you are using the AEP. In this case, the number of contacts that are shown on the 
screen is changed accordingly. 

Step 1 Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-G20 
Install Alarm Wires on the MIC-A/P (ETSI Only)” or the “DLP-G23 Install Alarm Wires on the 
Backplane (ANSI Only)” in the Cisco ONS 15454 Hardware Installation Guide.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the AIC-I card to display 
it in card view.

Step 3 Click the Provisioning > External Controls tabs.

Step 4 Modify any of the following fields for each external control wired to the ONS 15454 backplane. For 
definitions of these fields, see the NTP-G72 Provision External Alarms and Controls on the Alarm 
Interface Controller-International Card.

• Enabled

• Trigger Type

• Control Type

• Description

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G247 Change AIC-I Card Orderwire Settings

Purpose This task changes external control settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes orderwire settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has Side B and Side A ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (Side B and Side A) at all but one 
of the ring nodes.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the AIC-I card to display 
it in card view.

Step 2 Click the Provisioning > Local Orderwire tabs or the Provisioning > Express Orderwire tabs, 
depending on the orderwire path that you want to change. Provisioning steps are the same for both types 
of orderwire.

Step 3 If needed, adjust the transmit (Tx) and receive (Rx) dBm values by moving the slider to the right or left 
for the headset type (four-wire or two-wire) that you will use. In general, you should not need to adjust 
the dBm values.

Step 4 If you want to turn on the audible alert (buzzer) for the orderwire, check the Buzzer On check box.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

NTP-G102 Change Card Service State

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to change the card service state.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Inventory tab.

Step 3 Click the cell in the Admin State column for the card you want to change, and choose an administrative 
state from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)

• OOS,MT (ANSI) or Locked-enabled (ETSI)

Step 4 Click Apply.

Purpose This procedure changes a card service state. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64 or
NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 If an error message appears indicating that the card state cannot be changed from its current state, click 
OK.

For information about the card state transitions, see the Administrative and Service States document.

Stop. You have completed this procedure.

NTP-G280 Modify Threshold Settings for the TNC and TNCE 
Cards

Step 1 Complete the DLP-G46 Log into CTC task at the node where you want to modify the threshold settings.

Step 2 Perform any of the following tasks as needed:

• “DLP-G609 Modify Optical Threshold Settings for the TNC and TNCE Cards” task on page 21-123

• “DLP-G610 Modify Line Threshold Settings for the TNC and TNCE cards” task on page 21-125

Stop. You have completed this procedure.

DLP-G609 Modify Optical Threshold Settings for the TNC and TNCE Cards

Purpose This procedure changes the optical and line threshold settings for the TNC 
and TNCE cards on the Cisco ONS 15454 M2 and the Cisco ONS 15454 
M6 shelves.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

“DLP-G605 Provision PPM and Port for the TNC and TNCE cards” in the 
Cisco ONS 15454 Hardware Installation Guide.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the optical threshold settings for the TNC and TNCE 
cards on the ONS 15454 M2 and the ONS 15454 M6 shelves.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

“DLP-G605 Provision PPM and Port for the TNC and TNCE Cards” in the 
Cisco ONS 15454 Hardware Installation Guide.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TNC and TNCE 
cards where you want to change the optical threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Under Types, choose the type of threshold that you want to change, either TCA or Alarm.

Step 4 Click Refresh.

Step 5 Modify any of the threshold settings as needed by double-clicking the threshold value, deleting it, 
entering a new value, and hitting Enter. Table 21-65 shows the thresholds for warnings and alarms.

Note You can modify the optics thresholds either for 15 minutes or 1 day. To do so, choose the appropriate 
radio button and click Refresh. 15 minutes and 1 day interval are not applicable for alarm thresholds.

Step 6 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 7 Return to your originating procedure (NTP).

Table 21-65 TNC and TNCE cards Optical Warning and Alarms Thresholds Settings

Parameter Description Options

Port (Display only) Displays the port number 
and port type.

• port number (OC3)

• port number (FE)

• port number (ONE-GE)

Laser Bias 
High (%)

Sets the maximum laser bias. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

RX Power 
High (dBm)

Sets the maximum optical power 
received.

Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

RX Power Low 
(dBm)

Sets the minimum optical power received. Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

TX Power 
High (dBm)

Sets the maximum optical power 
transmitted.

Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.

TX Power Low 
(dBm)

Sets the minimum optical power 
transmitted.

Numeric. Can be set for 15-minute or 
one-day intervals. Double-click the 
parameter, enter a value, and press Enter.
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DLP-G610 Modify Line Threshold Settings for the TNC and TNCE cards

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TNC and TNCE 
cards where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line tabs.

Step 3 Modify any of the threshold settings as described in the following tables. These settings are found in 
Ports, OC3 Line, and SONET Thresholds subtabs.

Purpose This task changes the line threshold settings for the TNC and TNCE cards 
on the ONS 15454 M2 and the ONS 15454 M6 shelves.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

“DLP-G605 Provision PPM and Port for the TNC and TNCE cards” in the 
Cisco ONS 15454 Hardware Installation Guide.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 21-66 TNC and TNCE cards Line Threshold Settings  (Ports tab)

Parameter Description Options

Port (Display only) Displays the port number 
and port type.

• port number (OC3)

• port number (FE)

• port number (ONE-GE)

Port Name Provides the ability to assign the 
specified port a name.

User-defined. Name can be up to 32 
alphanumeric/special characters. Blank 
by default.

See the “DLP-G104 Assign a Name to a 
Port” task on page 17-16.

Admin State (Display only) Displays the port 
administrative state. For more 
information about administrative states, 
see the Administrative and Service States 
document. 

• IS (ANSI) or Unlocked (ETSI)—Puts 
the port in service. The port service 
state changes to IS-NR (ANSI) or 
Unlocked-enabled (ETSI).

• IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI
)—Puts the port in automatic 
in-service. The port service state 
changes to OOS-AU,AINS (ANSI) or 
Unlocked-disabled,automaticInServi
ce (ETSI).
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Service State (Display only) Identifies the 
autonomously generated state that 
displays the overall condition of the port. 
Service states appear in these formats: 
Primary State-Primary State Qualifier, 
Secondary State. For more information 
about service states, see the 
Administrative and Service States 
document. 

• IS-NR (In-Service and Normal 
[ANSI]) or Unlocked-enabled 
(ETSI)—The port is fully operational 
and is performing as provisioned.

• OOS-AU,AINS (Out-Of-Service and 
Autonomous, Automatic In-Service 
[ANSI]) or 
Unlocked-disabled,automaticInServi
ce (ETSI)—The port is out of 
service, but traffic is carried. Alarm 
reporting is suppressed. The ONS 
node monitors the ports for an 
error-free signal. After an error-free 
signal is detected, the port stays in 
the 
OOS-AU,AINS/Unlocked-disabled,a
utomaticInService state for the 
duration of the soak period. After the 
soak period ends, the port service 
state changes to 
IS-NR/Unlocked-enabled.

Reach Indicates the distance from one node to 
another node

From the drop-down list, choose one of 
the following:

• Auto Provision

• LX

• SX

• CX

• T

• DX

• HX

• ZX

• VX

• CWDM

• DWDM

• LR 2 (SONET)

• L2 (SDH)

• ULH (SDH and SONET)

Table 21-66 TNC and TNCE cards Line Threshold Settings (continued) (Ports tab)

Parameter Description Options
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Table 21-67 TNC and TNCE cards Line Threshold Settings (OC3 Line tab)

Table 21-68 TNC and TNCE cards Line Threshold Settings (SONET)

Table 21-1

Parameter Description Options

SF BER Sets the signal fail bit error rate. From the drop-down list, choose one of 
the following:

• 1E-3

• 1E-4

• 1E-5

SD BER Sets the signal degrade bit error rate. From the drop-down list, choose one of 
the following:

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

ProvidesSync (Display only) If checked, the card is 
provisioned as a network element (NE) 
timing reference.

• Checked

• Unchecked

SyncMsgIn Enables synchronization status messages 
(SSM) on the S1 byte, which allow the 
node to choose the best timing source.

• Checked

• Unchecked

SendDoNotUse When checked, sends a “Do Not Use for 
Synchronization (DUS)” message on the 
S1 byte.

• Checked

• Unchecked

PJSTSMon# (Display only) Sets the STS that will be 
used for pointer justification.

This parameter is set to 0. It cannot be 
changed. 

AINS Soak (Display only) The automatic in-service 
soak period. It is always 00.00.

—

Type Defines the port as SONET or SDH. The 
ProvidesSync Msg field and the Send Do 
Not Use field must be disabled before the 
port can be set to SDH. 

From the drop-down list, choose one of 
the following:

• SONET

• SDH

Table 21-2

Parameter Description Options

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals for Line or Section 
(Near and Far End).

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals for Line or Section 
(Near and Far End).
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Table 21-69 TNC and TNCE cards Line Threshold Settings (SDH)

Note Far end is not applicable for optics thresholds and Regenerator Section STM1 thresholds (or section 
thresholds in OC3).

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals for Line or Section 
(Near and Far End).

SEFS Severely errored framing seconds 
(Section only)

Numeric. Can be set for 15-minute or 
one-day intervals for Section (Near and 
Far End).

FC Failure count (Line only) Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End).

UAS Unavailable seconds (Line only) Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End).

Table 21-2

Parameter Description Options

Table 21-3

Parameter Description Options

RS-OFS Out of frame seconds Numeric. Can be set for 15-minute or 
one-day intervals for Section (Near and 
Far End).

EB Errored block Numeric. Can be set for 15-minute or 
one-day intervals for MS (Multiplex 
Section) or RS (Regeneration Section) 
(Near and Far End). Select the bullet and 
click Refresh. 

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals for MS or RS (Near and 
Far End). Select the bullet and click 
Refresh. 

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals for MS or RS (Near and 
Far End). Select the bullet and click 
Refresh. 

BBE Background block error Numeric. Can be set for 15-minute or 
one-day intervals for MS or RS (Near and 
Far End). Select the bullet and click 
Refresh. 

OFS Out of frame seconds Numeric. Can be set for 15-minute or 
one-day intervals for RS, Near End. 
Select the bullet and click Refresh. 
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Step 4 Click Apply. If the change affects traffic, a warning message appears. Click Yes to complete the change.

Step 5 Return to your originating procedure (NTP).
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C H A P T E R 22

Manage Network Connectivity 

This chapter provides an overview of ONS 15454 data communications network (DCN) connectivity. 
Cisco Optical Networking System (ONS) network communication is based on IP, including 
communication between Cisco Transport Controller (CTC) computers and ONS 15454 nodes, and 
communication among networked ONS 15454 nodes. The chapter shows common Cisco ONS 15454 IP 
network configurations and includes detailed data communications network (DCN) case studies that are 
based on actual ONS 15454 installations. The chapter provides information about the ONS 15454 IP 
routing table, external firewalls, and open gateway network element (GNE) networks. 

Although ONS 15454 DCN communication is based on IP, ONS 15454 nodes can be networked to 
equipment that is based on the Open System Interconnection (OSI) protocol suites. This chapter also 
describes the ONS 15454 OSI implementation and provides scenarios that show how the ONS 15454 can 
be networked within a mixed IP and OSI environment.

This chapter does not provide a comprehensive explanation of IP networking concepts and procedures, 
nor does it provide IP addressing examples to meet all networked scenarios. For ONS 15454 networking 
setup instructions, refer to the “Turn Up a Node” chapter.

Note Unless otherwise specified, in this chapter “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 22.1 IP Networking Overview, page 22-2

• 22.2 IP Addressing Scenarios, page 22-2

• 22.3 DCN Case Studies, page 22-23

• 22.4 DCN Extension, page 22-37

• 22.5 Routing Table, page 22-39

• 22.6 External Firewalls, page 22-41

• 22.7 Open GNE, page 22-42

• 22.8 TCP/IP and OSI Networking, page 22-45

• 22.9 Link Management Protocol, page 22-49

• 22.10 IPv6 Network Compatibility, page 22-54

• 22.11 IPv6 Native Support, page 22-54

• 22.12 Integration with Cisco CRS-1, Cisco ASR 9000 Series, or Cisco 7600 Series Routers, 
page 22-57

• 22.13 Photonic Path Trace, page 22-64
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• 22.14 Shared Risk Link Group, page 22-65

• 22.15 Proactive Protection Regen, page 22-65

Note To connect ONS 15454s to an IP network, you must work with a LAN administrator or other individual 
at your site who has IP networking training and experience. 

22.1 IP Networking Overview
ONS 15454s can be connected in many different ways within an IP environment:

• They can be connected to LANs through direct connections or a router.

• IP subnetting can create ONS 15454 node groups that allow you to provision nodes in a network that 
are not connected with a data communications channel (DCC). 

• Different IP functions and protocols can be used to achieve specific network goals. For example, 
Proxy Address Resolution Protocol (ARP) enables one LAN-connected ONS 15454 to serve as a 
gateway for ONS 15454s that are not connected to the LAN. 

• Static routes can be created to enable connections among multiple CTC sessions with ONS 15454s 
that reside on the same subnet with multiple CTC sessions. 

• ONS 15454s can be connected to Open Shortest Path First (OSPF) networks so ONS 15454 network 
information is automatically communicated across multiple LANs and WANs.

• The ONS 15454 proxy server can control the visibility and accessibility between CTC computers 
and ONS 15454 element nodes.

22.2 IP Addressing Scenarios
ONS 15454 IP addressing generally has nine common scenarios or configurations. Use the scenarios as 
building blocks for more complex network configurations. Table 22-1 provides a general list of items to 
check when setting up ONS 15454s in IP networks.

Table 22-1 General ONS 15454 IP Troubleshooting Checklist

Item What to Check

Link integrity Verify that link integrity exists between:

• CTC computer and network hub/switch

• ONS 15454s (backplane [ANSI] or MIC-C/T/P [ETSI] wire-wrap pins or 
RJ-45 port) and network hub/switch

• Router ports and hub/switch ports

ONS 15454 
hub/switch ports

If connectivity problems occur, set the hub or switch port that is connected to 
the ONS 15454 to 10 Mbps half-duplex.

Ping Ping the node to test connections between computers and ONS 15454s.
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22.2.1 Scenario 1: CTC and ONS 15454s on Same Subnet
Scenario 1 shows a basic ONS 15454 LAN configuration (Figure 22-1). The ONS 15454s and CTC 
computer reside on the same subnet. All ONS 15454s connect to LAN A, and all ONS 15454s have DCC 
connections.

Figure 22-1 Scenario 1: CTC and ONS 15454s on Same Subnet (ANSI and ETSI)

22.2.2 Scenario 2: CTC and ONS 15454s Connected to a Router
In Scenario 2, the CTC computer resides on a subnet (192.168.1.0) and attaches to LAN A (Figure 22-2). 
The ONS 15454s reside on a different subnet (192.168.2.0) and attach to LAN B. A router connects LAN 
A to LAN B. The IP address of router interface A is set to LAN A (192.168.1.1), and the IP address of 
router interface B is set to LAN B (192.168.2.1). The routers each have a subnet mask of 255.255.255.0.

IP addresses/subnet 
masks

Verify that ONS 15454 IP addresses and subnet masks are set up correctly.

Optical connectivity Verify that ONS 15454 optical trunk ports are in service and that a DCC is 
enabled on each trunk port.

Table 22-1 General ONS 15454 IP Troubleshooting Checklist (continued)

Item What to Check

CTC Workstation
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22.2.3   Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway
On the CTC computer, the default gateway is set to router interface A. If the LAN uses Dynamic Host 
Configuration Protocol (DHCP), the default gateway and IP address are assigned automatically. In the 
Figure 22-2 example, a DHCP server is not available.

Figure 22-2 Scenario 2: CTC and ONS 15454s Connected to Router (ANSI and ETSI)

22.2.3 Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway
ARP matches higher-level IP addresses to the physical addresses of the destination host. It uses a lookup 
table (called ARP cache) to perform the translation. When the address is not found in the ARP cache, a 
broadcast is sent out on the network with a special format called the ARP request. If one of the machines 
on the network recognizes its own IP address in the request, it sends an ARP reply back to the requesting 
host. The reply contains the physical hardware address of the receiving host. The requesting host stores 
this address in its ARP cache so that all subsequent datagrams (packets) to this destination IP address 
can be translated to a physical address.

Proxy ARP enables one LAN-connected ONS 15454 to respond to the ARP request for ONS 15454s not 
connected to the LAN. (ONS 15454 proxy ARP requires no user configuration.) For this to occur, the 
DCC-connected ONS 15454s must reside on the same subnet as the LAN-connected (gateway) 

Node #2
IP Address 192.168.2.20
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface “A” to LAN “A” 192.168.1.1
IP Address of interface “B” to LAN “B”  192.168.2.1
Subnet Mask 255.255.255.0
Default Router = N/A
Host Routes =  N/A

Node #1
IP Address 192.168.2.10

Subnet Mask 255.255.255.0
Default Router = 192.168.2.1

Static Routes = N/A

Node #3
IP Address 192.168.2.30
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
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ONS 15454. When a LAN device sends an ARP request to an ONS 15454 that is not connected to the 
LAN, the gateway ONS 15454 (the one connected to the LAN) returns its MAC address to the LAN 
device. The LAN device then sends the datagram for the remote ONS 15454 to the MAC address of the 
proxy ONS 15454. The proxy ONS 15454 uses its routing table to forward the datagram to the non-LAN 
ONS 15454.

Scenario 3 is similar to Scenario 1, but only one ONS 15454 (Node 1) connects to the LAN 
(Figure 22-3). Two ONS 15454s (Node 2 and Node 3) connect to ONS 15454 Node 1 through the section 
DCC. Because all three ONS 15454s are on the same subnet, proxy ARP enables ONS 15454 Node 1 to 
serve as a gateway for ONS 15345 Node 2 and Node 3.

Note This scenario assumes all CTC connections are to Node 1. If you connect a laptop to either ONS 15454 
Node 2 or Node 3, network partitioning occurs; neither the laptop or the CTC computer can see all nodes. 
If you want laptops to connect directly to end network elements (ENEs), you must create static routes 
(see the “22.2.5 Scenario 5: Using Static Routes to Connect to LANs” section on page 22-8) or enable 
the ONS 15454 proxy server (see “22.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server” 
section on page 22-12). 

Be aware that:

• GNE and ENE 15454 proxy ARP is disabled.

• There is exactly one proxy ARP server on any given Ethernet segment; however, there might be more 
than one server in an ANSI or ETSI topology.

• The proxy ARP server does not perform the proxy ARP function for any node or host that is on the 
same Ethernet segment.

• It is important in Figure 22-3 that the CTC workstation be located within the same subnet and on 
the same Ethernet segment as the proxy ARP server.
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Figure 22-3 Scenario 3: Using Proxy ARP (ANSI and ETSI)

You can also use proxy ARP to communicate with hosts attached to the craft Ethernet ports of 
DCC-connected nodes (Figure 22-4). The node with an attached host must have a static route to the host. 
Static routes are propagated to all DCC peers using OSPF. The existing proxy ARP node is the gateway 
for additional hosts. Each node examines its routing table for routes to hosts that are not connected to 
the DCC network but are within the subnet. The existing proxy server replies to ARP requests for these 
additional hosts with the node MAC address. The existence of the host route in the routing table ensures 
that the IP packets addressed to the additional hosts are routed properly. Other than establishing a static 
route between a node and an additional host, no provisioning is necessary. The following restrictions 
apply:

• Only one node acts as the proxy ARP server for any given additional host. 

• A node cannot be the proxy ARP server for a host connected to its Ethernet port. 

In Figure 22-4, Node 1 announces to Node 2 and 3 that it can reach the CTC host. Similarly, Node 3 
announces that it can reach the ONS 152xx. The ONS 152xx is shown as an example; any network 
element can be set up as an additional host. 

C Workstation
Address 192.168.1.100

t M k t CTC W k t ti 255 255 255 0
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Figure 22-4 Scenario 3: Using Proxy ARP with Static Routing (ANSI and ETSI)

22.2.4 Scenario 4: Default Gateway on CTC Computer
Scenario 4 is similar to Scenario 3, but Nodes 2 and 3 reside on different subnets, 192.168.2.0 and 
192.168.3.0, respectively (Figure 22-5). Node 1 and the CTC computer are on subnet 192.168.1.0. Proxy 
ARP is not used because the network includes different subnets. For the CTC computer to communicate 
with Nodes 2 and 3, Node 1 is entered as the default gateway on the CTC computer.

CTC Workstation
IP Address 192.168.1.100
Subnet Mark at CTC Workstation 255.255.255.0
Default Gateway = N/A

Node #2
IP Address 192.168.1.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

Node #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = Destination 192.168.1.100
  Mask 255.255.255.0
  Next Hop 192.168.1.10

Node #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = Destination 192.168.1.31
  Mask 255.255.255.255
  Next Hop 192.168.1.30

ONS 152xx
IP Address 192.168.1.31
Subnet Mask 255.255.255.0

LAN A

Ring

12
42

47
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22.2.5   Scenario 5: Using Static Routes to Connect to LANs
Figure 22-5 Scenario 4: Default Gateway on a CTC Computer (ANSI and ETSI)

22.2.5 Scenario 5: Using Static Routes to Connect to LANs
Static routes are used for two purposes: 

• To connect ONS 15454s to CTC sessions on one subnet connected by a router to ONS 15454s 
residing on another subnet. (These static routes are not needed if OSPF is enabled. Scenario 6 shows 
an OSPF example.)

• To enable multiple CTC sessions among ONS 15454s residing on the same subnet.

In Figure 22-6, one CTC residing on subnet 192.168.1.0 connects to a router through interface A (the 
router is not set up with OSPF). ONS 15454s residing on different subnets are connected through Node 1 
to the router through interface B. Because Nodes 2 and 3 are on different subnets, proxy ARP does not 
enable Node 1 as a gateway. To connect to CTC computers on LAN A, a static route is created on 
Node 1. 

CTC Workstation
IP Address 192.168.1.100
S b t M k t CTC W k t ti 255 255 255 0
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22.2.5   Scenario 5: Using Static Routes to Connect to LANs
Figure 22-6 Scenario 5: Static Route With One CTC Computer Used as a Destination (ANSI and ETSI)

The destination and subnet mask entries control access to the ONS 15454s:

• If a single CTC computer is connected to a router, enter the complete CTC “host route” IP address 
as the destination with a subnet mask of 255.255.255.255. 

• If CTC computers on a subnet are connected to a router, enter the destination subnet (in this example, 
192.168.1.0) and a subnet mask of 255.255.255.0.

• If all CTC computers are connected to a router, enter a destination of 0.0.0.0 and a subnet mask of 
0.0.0.0. Figure 22-7 shows an example.

The IP address of router interface B is entered as the next hop, and the cost (number of hops from source 
to destination) is 2.

rkstation
68.1.100
55.255.0
2.168.1.1
es = N/A

Router
IP Address  of interface ”A” to  LAN “A”  192.168.1.1
IP Address of interface  “B” to LAN  “B”   192.168.2.1
Subnet Mask 255.255.255.0

Node #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0

LAN B

LAN A

Int "A"

Int "B"
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22.2.6   Scenario 6: Using OSPF
Figure 22-7 Scenario 5: Static Route With Multiple LAN Destinations (ANSI and ETSI)

22.2.6 Scenario 6: Using OSPF
Open Shortest Path First (OSPF) is a link state Internet routing protocol. Link state protocols use a “hello 
protocol” to monitor their links with adjacent routers and to test the status of their links to their 
neighbors. Link state protocols advertise their directly connected networks and their active links. Each 
link state router captures the link state “advertisements” and puts them together to create a topology of 
the entire network or area. From this database, the router calculates a routing table by constructing a 
shortest path tree. Routes are recalculated when topology changes occur.

ONS 15454s use the OSPF protocol in internal ONS 15454 networks for node discovery, circuit routing, 
and node management. You can enable OSPF on the ONS 15454s so that the ONS 15454 topology is 
sent to OSPF routers on a LAN. Advertising the ONS 15454 network topology to LAN routers 

tion
100
55.0
.1.1
N/A

Router #1
IP Address  of interface ”A” to  LAN “A”  192.168.1.1
IP Address of interface  “B” to LAN  “B”   192.168.2.1
Subnet Mask 255.255.255.0

Node #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1

LAN B

N A

Int "A"
Int "B"

Static Routes
    Destination 0.0.0.0
    Mask 0.0.0.0
    Next Hop 192.168.2.1

outer #3

Router #2
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eliminates the need to manually enter static routes for ONS 15454 subnetworks. Figure 22-8 shows a 
network enabled for OSPF. Figure 22-9 shows the same network without OSPF. Static routes must be 
manually added to the router for CTC computers on LAN A to communicate with Nodes 2 and 3 because 
these nodes reside on different subnets.

OSPF divides networks into smaller regions, called areas. An area is a collection of networked end 
systems, routers, and transmission facilities organized by traffic patterns. Each OSPF area has a unique 
ID number, known as the area ID. Every OSPF network has one backbone area called “area 0.” All other 
OSPF areas must connect to area 0.

When you enable an ONS 15454 OSPF topology for advertising to an OSPF network, you must assign 
an OSPF area ID in decimal format to the ONS 15454 network. An area ID is a “dotted quad” value that 
appears similar to an IP address. Coordinate the area ID number assignment with your LAN 
administrator. All DCC-connected ONS 15454s should be assigned the same OSPF area ID. 

Note It is recommended that the number of ONS 15454s in an OSPF area be limited, because this allows faster 
loading into a CTC an is less likely to incur any problems.

Figure 22-8 Scenario 6: OSPF Enabled (ANSI and ETSI)

rkstation
68.1.100
55.255.0

168 1 1

Router
IP Address  of interface “A” to LAN A 192.168.1.1
IP Address of interface “B” to LAN B  192.168.2.1
Subnet Mask 255.255.255.0

LAN A

Int "A"

Int "B"
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22.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 22-9 Scenario 6: OSPF Not Enabled (ANSI and ETSI)

22.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server
The ONS 15454 proxy server is a set of functions that allows you to network ONS 15454s in 
environments where visibility and accessibility between ONS 15454s and CTC computers must be 
restricted. For example, you can set up a network so that field technicians and network operations center 
(NOC) personnel can both access the same ONS 15454s while preventing the field technicians from 
accessing the NOC LAN. To do this, one ONS 15454 is provisioned as a GNE and the other ONS 15454s 
are provisioned as end ENEs. The GNE ONS 15454 tunnels connections between CTC computers and 
ENE ONS 15454s, providing management capability while preventing access for non-ONS 15454 
management purposes.

Node #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1

rkstation
68.1.100
55.255.0
.168.1.1
es = N/A

Router
IP Address  of interface “A” to LAN A 192.168.1.1
IP Address of interface “B” to LAN B  192.168.2.1
Subnet Mask 255.255.255.0
Static Routes = Destination 192.168.3.20 Next Hop  192.168.2.10
                         Destination 192.168.4.30 Next Hop  192.168.2.10

LAN B

LAN A

Int "A"

Int "B"
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22.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
The ONS 15454 gateway setting performs the following tasks:

• Isolates DCC IP traffic from Ethernet (craft port) traffic and accepts packets based on filtering rules. 
The filtering rules (see Table 22-3 on page 22-17 and Table 22-4 on page 22-17) depend on whether 
the packet arrives at the ONS 15454 DCC or TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Ethernet 
interface.

• Processes Simple Network Time Protocol (SNTP) and Network Time Protocol (NTP) requests. 
ONS 15454 ENEs can derive time-of-day from an SNTP/NTP LAN server through the GNE 
ONS 15454.

• Processes Simple Network Management Protocol version 1 (SNMPv1) traps. The GNE ONS 15454 
receives SNMPv1 traps from the ENE ONS 15454s and forwards or relays the traps to SNMPv1 trap 
destinations or ONS 15454 SNMP relay nodes.

The ONS 15454 proxy server is provisioned using the Enable proxy server on port check box on the 
Provisioning > Network > General tab. If checked, the ONS 15454 serves as a proxy for connections 
between CTC clients and ONS 15454s that are DCC-connected to the proxy ONS 15454. The CTC client 
establishes connections to DCC-connected nodes through the proxy node. The CTC client can connect 
to nodes that it cannot directly reach from the host on which it runs. If not selected, the node does not 
proxy for any CTC clients, although any established proxy connections continue until the CTC client 
exits. In addition, you can set the proxy server as an ENE or a GNE:

• External Network Element (ENE)—If set as an ENE, the ONS 15454 neither installs nor advertises 
default or static routes that go through its Ethernet port. However, an ENE does install and advertise 
routes that go through the DCC. CTC computers can communicate with the ONS 15454 using the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE craft port, but they cannot communicate directly with 
any other DCC-connected ONS 15454. 

In addition, firewall is enabled, which means that the node prevents IP traffic from being routed 
between the DCC and the LAN port. The ONS 15454 can communicate with machines connected to 
the LAN port or connected through the DCC. However, the DCC-connected machines cannot 
communicate with the LAN-connected machines, and the LAN-connected machines cannot 
communicate with the DCC-connected machines. A CTC client using the LAN to connect to the 
firewall-enabled node can use the proxy capability to manage the DCC-connected nodes that would 
otherwise be unreachable. A CTC client connected to a DCC-connected node can only manage other 
DCC-connected nodes and the firewall itself. 

• Gateway Network Element (GNE)—If set as a GNE, the CTC computer is visible to other 
DCC-connected nodes and firewall is enabled.

• SOCKS Proxy-only—If Proxy-only is selected, firewall is not enabled. CTC can communicate with 
any other DCC-connected ONS 15454s. 

Note If you launch CTC against a node through a Network Address Translation (NAT) or Port Address 
Translation (PAT) router and that node does not have proxy enabled, your CTC session starts and initially 
appears to be fine. However CTC never receives alarm updates and disconnects and reconnects every two 
minutes. If the proxy is accidentally disabled, it is still possible to enable the proxy during a reconnect 
cycle and recover your ability to manage the node, even through a NAT/PAT firewall.

Note ENEs that belong to different private subnetworks do not need to have unique IP addresses. Two ENEs 
that are connected to different GNEs can have the same IP address. However, ENEs that connect to the 
same GNE must always have unique IP addresses.
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22.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 22-10 shows an ONS 15454 proxy server implementation. A GNE ONS 15454 is connected to a 
central office LAN and to ENE ONS 15454s. The central office LAN is connected to a NOC LAN, which 
has CTC computers. The NOC CTC computer and craft technicians must both be able to access the 
ONS 15454 ENEs. However, the craft technicians must be prevented from accessing or seeing the NOC 
or central office LANs.

In the example, the ONS 15454 GNE is assigned an IP address within the central office LAN and is 
physically connected to the LAN through its LAN port. ONS 15454 ENEs are assigned IP addresses that 
are outside the central office LAN and given private network IP addresses. If the ONS 15454 ENEs are 
collocated, the craft LAN ports could be connected to a hub. However, the hub should have no other 
network connections. 

Figure 22-10 Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on the Same Subnet (ANSI 

and ETSI)

Table 22-2 shows recommended settings for ONS 15454 GNEs and ENEs in the configuration shown in 
Figure 22-10.

Remote CTC
10.10.20.10

10.10.20.0/24

10 10 10 0/24

Interface 0/0
10.10.20.1

Router A

Interface 0/1
10.10.10.1

Table 22-2 ONS 15454 Gateway and End NE Settings

Setting ONS 15454 Gateway NE ONS 15454 End NE

OSPF Off Off
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22.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 22-11 shows the same proxy server implementation with ONS 15454 ENEs on different subnets. 
The ONS 15454 GNEs and ENEs are provisioned with the settings shown in Table 22-2.

Figure 22-11 Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on Different Subnets (ANSI 

and ETSI)

SNTP server (if used) SNTP server IP address Set to ONS 15454 GNE IP address

SNMP (if used) SNMPv1 trap destinations Set SNMPv1 trap destinations to 
ONS 15454 GNE

Table 22-2 ONS 15454 Gateway and End NE Settings (continued)

Setting ONS 15454 Gateway NE ONS 15454 End NE

emote CTC
0.10.20.10

10.10.20.0/24

Interface 0/0
10.10.20.1

Router A

Interface 0/1
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22.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 22-12 shows the same proxy server implementation with ONS 15454 ENEs in multiple rings.

Figure 22-12 Scenario 7: ONS 15454 Proxy Server With ENEs on Multiple Rings (ANSI and ETSI)

Table 22-3 shows the rules the ONS 15454 follows to filter packets for the firewall when nodes are 
configured as ENEs and GNEs. If the packet is addressed to the ONS 15454, additional rules (shown in 
Table 22-4) are applied. Rejected packets are silently discarded.

12
42

55

Remote CTC
10.10.20.10

10.10.20.0/24

10.10.10.0/24

Interface 0/0
10.10.20.1

Router A

Interface 0/1
10.10.10.1

Gateway NE
10.10.10.100/24

End NE
192.168.10.250/24

End NE
192.168.10.150/24

End NE
192.168.10.200/24

Ethernet

Optical Fiber

Gateway NE
10.10.10.200/24

End NE
192.168.80.250/24

End NE
192.168.60.150/24

End NE
192.168.70.200/24
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22.2.8   Scenario 8: Dual GNEs on a Subnet
If you implement the proxy server, note that all DCC-connected ONS 15454s on the same Ethernet 
segment must have the same gateway setting. Mixed values produce unpredictable results, and might 
leave some nodes unreachable through the shared Ethernet segment. 

If nodes become unreachable, correct the setting by performing one of the following:

• Disconnect the craft computer from the unreachable ONS 15454. Connect to the ONS 15454 
through another network ONS 15454 that has a DCC connection to the unreachable ONS 15454.

• Disconnect all DCCs to the node by disabling them on neighboring nodes. Connect a CTC computer 
directly to the ONS 15454 and change its provisioning.

22.2.8 Scenario 8: Dual GNEs on a Subnet
The ONS 15454 provides GNE load balancing, which allows CTC to reach ENEs over multiple GNEs 
without the ENEs being advertised over OSPF. This feature allows a network to quickly recover from 
the loss of GNE, even if the GNE is on a different subnet. If a GNE fails, all connections through that 
GNE fail. CTC disconnects from the failed GNE and from all ENEs for which the GNE was a proxy, and 
then reconnects through the remaining GNEs. GNE load balancing reduces the dependency on the launch 
GNE and DCC bandwidth, both of which enhance CTC performance. 

Note Dual GNEs do not need special provisioning

Figure 22-13 shows a network with dual GNEs on the same subnet.

Table 22-3 Proxy Server Firewall Filtering Rules

Packets Arriving At: Are Accepted if the Destination IP Address is:

TCC2/TCC2P/TCC3
/TNC/TNCE/TSC/T
SCE Ethernet 
interface

• The ONS 15454 itself

• The ONS 15454’s subnet broadcast address

• Within the 224.0.0.0/8 network (reserved network used for standard 
multicast messages)

• Subnet mask = 255.255.255.255

DCC interface • The ONS 15454 itself

• Any destination connected through another DCC interface

• Within the 224.0.0.0/8 network

Table 22-4 Proxy Server Firewall Filtering Rules

Packets Arriving At: Are Rejected If:

TCC2/TCC2P/TCC3
/TNC/TNCE/TSC/T
SCE Ethernet 
interface

• User Datagram Protocol (UDP) packets addressed to 
the SNMP trap relay port

DCC interface • Transmission Control Protocol (TCP) packets 
addressed to the proxy server port (1080)
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Figure 22-13 Scenario 8: Dual GNEs on the Same Subnet (ANSI and ETSI)
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22.2.9   Scenario 9: IP Addressing with Secure Mode Enabled
Figure 22-14 shows a network with dual GNEs on different subnets.

Figure 22-14 Scenario 8: Dual GNEs on Different Subnets (ANSI and ETSI)

22.2.9 Scenario 9: IP Addressing with Secure Mode Enabled
The TCC2, TCC2P, TCC3, TNC, TNCE, TSC, and TSCE cards default to repeater mode. In this mode, 
the front and back Ethernet (LAN) ports share a single MAC address and IP address. TCC2P, TCC3, 
TNC, TNCE, TSC, and TSCE cards allow you to place a node in secure mode, which prevents a 
front-access craft port user from accessing the LAN through the backplane port. Secure mode can be 
locked, which prevents the mode from being altered. To place a node in secure mode refer to the “DLP 
-G264 Enable Node Security Mode” task in the “Turn Up a Node” chapter. To lock secure node, refer to 
the “DLP-G265 Lock Node Security” task in the Manage the Node document. 

Remote CTC
10.10.20.10

10.10.20.0/24

Interface 0/0
10.10.20.1

Router A

0/1
0.1

Interface 0/2
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22.2.9   Scenario 9: IP Addressing with Secure Mode Enabled
22.2.9.1 Secure Mode Behavior

Changing a TCC2P, TCC3, TNC, TNCE, TSC, or TSCE node from repeater mode to secure mode allows 
you to provision two IP addresses for the ONS 15454 and causes the node to assign the ports different 
MAC addresses. In secure mode, one IP address is provisioned for the ONS 15454 backplane LAN port, 
and the other IP address is provisioned for the card Ethernet port. Both addresses reside on different 
subnets, providing an additional layer of separation between the craft access port and the ONS 15454 
LAN. If secure mode is enabled, the IP addresses provisioned for the backplane LAN port and card 
Ethernet port must follow general IP addressing guidelines and must reside on different subnets from 
each other. 

In secure mode, the IP address assigned to the backplane LAN port becomes a private address, which 
connects the node to an operations support system (OSS) through a central office LAN or private 
enterprise network. A Superuser can configure the node to hide or reveal the backplane's LAN IP address 
in CTC, the routing table, or TL1 autonomous message reports.

In repeater mode, a node can be a GNE or ENE. Placing the node into secure mode automatically turns 
on SOCKS proxy and defaults the node to GNE status. However, the node can be changed back to an 
ENE. In repeater mode, an ENE’s SOCKS proxy can be disabled—effectively isolating the node beyond 
the LAN firewall—but it cannot be disabled in secure mode. To change a node’s GNE or ENE status and 
disable the SOCKS proxy, refer to the “DLP-G56 Provision IP Settings” task in the “Turn Up a Node” 
chapter.

Caution Enabling secure mode causes the TCC2P, TCC3, TNC, TNCE, TSC, and TSCE cards to reboot; the card 
reboot affects traffic.

Caution The TCC2 card fails to boot when it is added as a standby card to a node containing an active TCC2P 
card configured in the secure mode.

Note If both front and backplane access ports are disabled in an ENE and the node is isolated from DCC 
communication (due to user provisioning or network faults), the front and backplane ports are 
automatically reenabled. 

Figure 22-15 shows an example of secure mode ONS 15454 nodes with front-access Ethernet port 
addresses that reside on the same subnet. 
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Figure 22-15 Scenario 9: ONS 15454 GNE and ENEs on the Same Subnet with Secure Mode 

Enabled

Figure 22-16 shows an example of ONS 15454 nodes connected to a router with secure mode enabled. 
In each example, the node’s port address (node address) resides on a different subnet from the node 
backplane addresses.
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Figure 22-16 Scenario 9: ONS 15454 GNE and ENEs on Different Subnets with Secure Mode 

Enabled

22.2.9.2 Secure Node Locked and Unlocked Behavior

Secure mode can be locked or unlocked on a node operating in secure mode. The default status is 
unlocked, and only a Superuser can issue a lock. When secure mode is locked, the node’s configuration 
(including Ethernet port status) and lock status cannot be changed by any network user. To have a secure 
node’s lock removed, contact Cisco Technical Support to arrange a Return Material Authorization 
(RMA) for the shelf assembly. See the “Obtaining Documentation and Submitting a Service Request” 
section on page lvii as needed. Enabling a lock makes a permanent change to the shelf’s EEPROM.

A node’s configuration lock is maintained if the active TCC2P, TCC3, TNC, TNCE, TSC, or TSCE 
card’s database is reloaded. For example, if you attempt to load an unlocked node database onto a locked 
node’s standby TCC2P, TCC3, TNC, TNCE, TSC, or TSCE card for transfer to the active TCC2P, TCC3, 
TNC, TNCE, TSC, or TSCE card (an action that is not recommended), the unlocked node’s status (via 
the uploaded database) will not override the node’s lock status. If you attempt to load a locked database 
onto the standby TCC2P, TCC3, TNC, TNCE, TSC, or TSCE card of an unlocked secure node, the active 
TCC2P, TCC3, TNC, TNCE, TSC, or TSCE card will upload the database. If the uploaded defaults 
indicate a locked status, this will cause the node to become locked. If a software load has been 
customized before a lock is enabled, all lockable provisioning features are permanently set to the 
customized NE defaults provided in the load and cannot be changed by any user.
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22.3 DCN Case Studies
The ONS 15454 network is managed over the IP DCN and the optical service channels (OSCs), DCCs, 
and generic communications channels (GCCs). ONS 15454s perform many of the same functions as 
Layer 3 routers because they manage traffic between the DCN network management system (NMS) and 
the dense wavelength division multiplexing (DWDM) optical networks. 

This section provides case studies that show different ways an ONS 15454 network can be implemented 
within the DCN. The case studies are based on actual field installations. They include the network 
problem, the network topology created to solve it, IP addressing examples, and strengths and weaknesses 
of the solution. Routing principles followed throughout the case studies include:

• If the ONS 15454 is connected to a DCN router, the default gateway points to the router.

• If the default gateway must advertise to the OSC/DCC/GCC network, a static route is added for the 
default gateway.

• If the network element (NE) is not connected to a DCN router, the default gateway is set to 0.0.0.0.

22.3.1 SOCKS Proxy Settings
SOCKS proxy (described in the “22.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server” section 
on page 22-12) enables the ONS 15454 to serve as a proxy for connections between CTC clients and 
ONS 15454 nodes connected by OSCs, GCCs, or DCCs. Although SOCKS proxy can make DCN 
implementations easier, it should not be used when any of the following conditions exist: 

• Network management is based on SNMP and SNMP traps. The ONS 15454 can proxy SNMP traps, 
but if a redundant DCN connection is required, trap duplication on the network management 
platform will occur.

• Telnet and debug session are required. These are not possible over SOCKS proxy.

• Direct IP connectivity to every node is required.

If these conditions are not present and no requirement to have direct IP connectivity to every node exists 
(that is, management is performed using CTC and/or Cisco Transport Manager [CTM]), Cisco 
recommends that you use the SOCKS proxy only option for all nodes that connect to a DCN router.

22.3.2 OSPF
Activating OSPF (described in the “22.2.6 Scenario 6: Using OSPF” section on page 22-10) on the 
ONS 15454 LAN interface is another option that can be used to create resilient DCN connections. 
However, this option can only be enabled if every element in the network, from the NEs to the NOC, 
runs OSPF. This is not always possible, for example, the DCN connections might be on a public network 
out of the control of the organization using the ONS 15454 network. If you are considering enabling 
OSPF on the LAN, the following limitations must be considered:

• If OSPF is enabled on the LAN, the internal OSC/DCC/GCC OSPF area cannot be 0.0.0.0.

• The ONS 15454 can act as an OSPF area border gateway and support OSPF virtual links. However, 
virtual links cannot pass over the OSC/DCC/GCC network.

If all elements in the DCN network are not running OSPF, enabling OSPF on the LAN is very difficult 
without creating isolated areas and/or segmentation of OSPF area 0. However, if the DCN network is a 
full OSPF network, enabling OSPF on the LAN might be employed for resilient DCN networks.
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22.3.3 Management of Non-LAN Connected Multishelf Node
When using dense wavelength division multiplexing (DWDM) multishelf management feature to 
subtend shelves from a node controller shelf, the Node Controller must be specially provisioned in case 
it does not have direct LAN reachability. 

Non-LAN connected Multishelf nodes are not manageable from CTC unless SOCKS Proxy is enabled 
on the node. In a GNE/ENE firewall configuration, non-LAN connected network elements must be set 
up as end network elements (ENEs) if Firewall is required. If firewall is not required on the non-LAN 
connected Multishelf node, then the node must be set up as SOCKS Proxy 

LAN-connected network elements (LNEs) can be set up as gateway network elements (GNEs) or as 
SOCKS proxies, depending upon network security requirements. If the GNE/ENE firewall feature is 
required, the LNE must be set up as a GNE. If the design does not require the firewall feature but does 
require all-IP networking, the LNE must be set up as a SOCKS proxy. For procedures to provision a node 
or shelf as a GNE, ENE or SOCKS proxy, refer to the “Turn Up a Node” chapter.

22.3.4 DCN Case Study 1: Ring Topology with Two Subnets and Two DCN 
Connections

DCN Case Study 1 (Figure 22-17) shows an ONS 15454 ring (DWDM or SONET/SDH). The ring is 
divided into two subnets and has two DCN connections for resiliency.

Figure 22-17 DCN Case Study 1: ONS 15454 Ring with Two Subnets and Two DCN Connections
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During normal operation, this configuration balances the management traffic load over the two available 
DCN connections. If one of the two DCN connections fails, the second DCN connection maintains 
accessibility so NE management can continue. However, if complete IP connectivity is required, for 
example, for SNMP when SOCKS proxy cannot be used, connection resilience is difficult to achieve 
because:

• The ONS 15454 does not support route overloading. Configuring different routers with different 
costs for the same network destination is not possible.

• The ONS 15454 always tries to route traffic on the LAN interface when its link is up, and the link 
on the NE connected to DCN router is always up.

• If the DCN connection fails, the route is longer available.

One solution is to create a generic routing encapsulation (GRE) tunnel to logically connect the remote 
Router 1 and remote Router 2 using the OSC/DCC/GCC network (Figure 22-18). With the GRE tunnel, 
both remote routers have an alternate path to reach the NOC network in case of DCN failure. However, 
the alternate path might become overloaded on the routing tables, resulting in higher costs.

Figure 22-18 DCN Case Study 1: ONS 15454 Ring with Two Subnets, Two DCN Connections, and 

GRE Tunnel

22.3.4.1 DCN Case Study 1 IP Configuration

The following sections show sample IP configuration at the routers and ONS 15454 nodes in DCN Case 
Study 1. 

22.3.4.1.1 NOC Router Configuration

Interface configuration:

interface Ethernet0/0
 ip address 10.58.46.121 255.255.255.192
 no ip directed-broadcast
!
interface Ethernet1/0
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 ip address 192.168.20.1 255.255.255.0
 no ip directed-broadcast
!
interface Ethernet2/0
 ip address 192.168.10.1 255.255.255.0
 no ip directed-broadcast
!

Static routes with alternate paths at different costs:

ip classless
ip route 192.168.100.0 255.255.255.0 192.168.10.2
ip route 192.168.100.0 255.255.255.0 192.168.20.2 10
ip route 192.168.200.0 255.255.255.0 192.168.20.2
ip route 192.168.200.0 255.255.255.0 192.168.10.2 10

22.3.4.1.2 Router 1 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.10.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.1 255.255.255.0
no ip directed-broadcast
!

GRE tunnel interface configuration:

interface Tunnel0
ip address 192.168.30.1 255.255.255.0
tunnel source Ethernet1/0
tunnel destination 192.168.200.1

Static routes with alternate paths at different costs:

ip classless
ip route 0.0.0.0 0.0.0.0 192.168.10.1
ip route 10.0.0.0 255.0.0.0 192.168.10.1
ip route 10.0.0.0 255.0.0.0 Tunnel0 10
ip route 192.168.200.0 255.255.255.0 Tunnel0 10
ip route 192.168.200.1 255.255.255.255 192.168.100.80

Note the host route to the peer Router 2 (192.168.200.1) points to the ONS 15454 network (through 
192.168.100.80). This is required to set up the GRE tunnel. In this configuration, only the external route 
to 10.0.0.0 (that includes the NOC network) is overloaded with the alternate path. However, overloading 
might occur on this last-resort route.

22.3.4.1.3 Router 2 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.20.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.200.1 255.255.255.0
no ip directed-broadcast
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GRE tunnel interface configuration:

interface Tunnel0
ip address 192.168.30.2 255.255.255.0
tunnel source Ethernet1/0
tunnel destination 192.168.100.1

Static routes with alternate paths at different costs:

ip classless
ip route 0.0.0.0 0.0.0.0 192.168.20.1
ip route 10.0.0.0 255.0.0.0 192.168.20.1
ip route 10.0.0.0 255.0.0.0 Tunnel0 10
ip route 192.168.100.0 255.255.255.0 Tunnel0 10
ip route 192.168.100.1 255.255.255.255 192.168.200.77

The host routing path to the Router 1 (192.168.100.1) points to the ONS 15454 network (by 
192.168.200.77). This is required to set up the GRE tunnel. In this configuration, only the external route 
to 10.0.0.0 (that includes the NOC network) is overloaded with the alternate path. However, overloading 
the last-resort route might occur. Table 22-5 shows network settings on the four ONS 15454 nodes. The 
static routes are created so the DCN-connected nodes advertise their capability to act as last-resort 
routers.

22.3.4.2 DCN Case Study 1 Limitations

DCN Case Study 1 shows how a GRE tunnel can be created between two routers to create DCN 
connection resiliency. While the resiliency is a benefit, when a DCN failure forces traffic to the GRE 
tunnel, the path calculated by the ONS 15454 OSPF algorithm running in the OSC/DCC/GCC network 
is no longer the shortest one. Subsequently, the round-trip delay time (RTT) might increase significantly 
because the DCN protection in this configuration is transparent to the ONS 15454 network. The ONS 
15454 continues to use the same routing table. In addition, if a DCN failure occurs, the routing path that 
uses the GRE tunnel adds additional latency because of the number and length of OSC/DCC/GCC spans 
that the tunnel has to travel over the ONS 15454 network.

This latency makes this DCN Case Study 1 solution difficult to scale to large networks. If this solution 
is used and the network grows significantly, a larger number of DCN-connected NEs are required. For 
example, the common rule in ONS 15454 DCN design is that all nodes should be within five section data 
communications channel (LDCC)/regeneration section DCC (RS-DCC/OSC or eight line DCC (LDCC) 
/multiplex section DCC (MS-DCC) spans from the network attached node. If Case Study 1 design is 
implemented, the maximum span numbers should be cut in half. However, if the DCN Case Study 1 
design is used in networks that have full IP routing, have connectivity to every NE, and require only 
CTC/CTM management, the SOCKS proxy feature can be used to provide the same DCN connectivity 
resilience.

Table 22-5 DCN Case Study 1 Node IP Addresses

Node IP Address/Mask Default Gateway
Static Routes:
Destination/Mask – Next Hop

Node 1 192.168.100.80/24 192.168.100.1 0.0.0.0/0 – 192.168.100.1

Node 2 192.168.100.79/24 0.0.0.0 —

Node 3 192.168.100.78/24 0.0.0.0 —

Node 4 192.168.100.77/24 192.168.100.1 0.0.0.0/0 – 192.168.200.1
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22.3.5 DCN Case Study 2: Linear Topology with DCN Connections on Both Ends
DCN Case Study 2, shown in Figure 22-19, shows a four-node linear topology with DCN connectivity 
at both ends.

Figure 22-19 DCN Case Study 2: ONS 15454 Linear Topology with DCN Connections at Both Ends

To maintain DCN resilience, static routes are used and a GRE tunnel is created between Router 1 and 
Router 2 over the DCC/OSC/GCC optical link. In this example, all ONS 15454s are part of the same 
subnet. Therefore, the Router 1 and Router 2 static route tables have more entries because alternate paths 
must be configured for every host.

22.3.5.1 DCN Case Study 2 IP Configurations

The following sections provide sample IP configurations at routers and ONS 15454 nodes in 
DCN Case Study 2. 

22.3.5.1.1 NOC Router IP Configuration

Interface configuration:

interface Ethernet0/0
 ip address 10.58.46.121 255.255.255.192
 no ip directed-broadcast
!
interface Ethernet1/0
 ip address 192.168.20.1 255.255.255.0
 no ip directed-broadcast
!
interface Ethernet2/0
 ip address 192.168.10.1 255.255.255.0
 no ip directed-broadcast
!
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Static routes with alternate paths at different costs:

ip classless
ip route 192.168.100.0 255.255.255.0 192.168.10.2
ip route 192.168.100.0 255.255.255.0 192.168.20.2 100
ip route 192.168.100.77 255.255.255.255 192.168.20.2
ip route 192.168.100.77 255.255.255.255 192.168.10.2 10
ip route 192.168.100.78 255.255.255.255 192.168.20.2
ip route 192.168.100.78 255.255.255.255 192.168.10.2 10
ip route 192.168.100.79 255.255.255.255 192.168.10.2
ip route 192.168.100.79 255.255.255.255 192.168.20.2 10
ip route 192.168.100.80 255.255.255.255 192.168.10.2
ip route 192.168.100.80 255.255.255.255 192.168.20.2 10

22.3.5.1.2 Router 1 IP Configuration

Site 1 router interface:

interface Ethernet0/0
ip address 192.168.10.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.1 255.255.255.0
no ip directed-broadcast

GRE tunnel interface configuration:

interface Tunnel0
ip address 192.168.30.1 255.255.255.0
tunnel source Ethernet1/0
tunnel destination 192.168.100.2

Static routes with alternate paths at different costs:

ip classless
ip route 0.0.0.0 0.0.0.0 192.168.10.1
ip route 10.0.0.0 255.0.0.0 192.168.10.1
ip route 10.0.0.0 255.0.0.0 Tunnel0 10
ip route 192.168.100.2 255.255.255.255 192.168.100.80

Note that the host routing path to the peer DCN router (Site 2, 192.168.100.2) points to the ONS 15454 
network (by 192.168.100.80) that is required to set up the GRE tunnel. In this configuration, only the 
external route to 10.0.0.0 (that include the NOC network) is overloaded with the alternate path, but 
overloading of the last-resort route might also occur.

22.3.5.1.3 Router 2 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.20.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.2 255.255.255.0
no ip directed-broadcast

GRE tunnel interface configuration:

interface Tunnel0
ip address 192.168.30.2 255.255.255.0
tunnel source Ethernet1/0
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tunnel destination 192.168.100.1

Static routes with alternate paths at different costs:

ip classless
ip route 0.0.0.0 0.0.0.0 192.168.20.1
ip route 10.0.0.0 255.0.0.0 192.168.20.1
ip route 10.0.0.0 255.0.0.0 Tunnel0 10
ip route 192.168.100.1 255.255.255.255 192.168.100.77

Note that the host route to the Router 1 (192.168.100.1) points to the ONS 15454 network (by 
192.168.200.77). This is required to set up the GRE tunnel. In this configuration, only the external route 
to 10.0.0.0 (that includes the NOC network) is overloaded with the alternate path. However, overloading 
the last-resort route might also occur. 

Table 22-6 shows network settings on the four ONS 15454 nodes. The static routes are created so the 
DCN-connected nodes advertise their capability to act as last-resort routers.

22.3.5.2 DCN Case Study 2 Limitations

The linear configuration in DCN Case Study 2 does not effectively protect the management network 
communication for every fiber failure because the DCN router is not notified of the failures. Therefore, 
it continues to send packets on the low-cost path. This problem does not occur in ring topologies where 
the fiber failure is internally protected from the optical ring network. However, the OSPF dynamic 
routing protocol can be used over the DCN network to provide a solution to this problem. An OSPF 
configuration is shown in DCN Case Study 3.

22.3.6 DCN Case Study 3: Linear Topology with DCN Connections on Both Ends 
Using OSPF Routing

DCN Case Study 3 is the same linear topology as DCN Case Study 2 except OSPF routing is used on the 
DCN network. This requires the OSPF active on LAN option, located on the node view (single-shelf 
mode) or multishelf view (multishelf mode) Provisioning > Network > OSPF tab, to be enabled at the 
end ONS 15454 nodes. In addition, OSPF must be running between Router 1, Router 2, and the NOC 
router.

Because the DCN connection usually passes over a public network where OSPF is not always an option, 
the connection between Router 1, Router 2, and the NOC router is configured as a GRE tunnel so OSPF 
can run on the tunnel itself.

Figure 22-20 shows the linear configuration with the separate OSPF areas, the tunnel connections, and 
the required OSPF virtual link. (The physical connections where the tunnels are passed are not shown in 
the figure because they are not directly part of the actual routing path.)

Table 22-6 DCN Case Study 2 Node IP Addresses

Node IP Address/Mask Default Gateway
Static Routes:
Destination/Mask – Next Hop

Node 1 192.168.100.80/24 192.168.100.1 0.0.0.0/0 – 192.168.100.1

Node 2 192.168.100.79/24 0.0.0.0 —

Node 3 192.168.100.78/24 0.0.0.0 —

Node 4 192.168.100.77/24 192.168.100.1 0.0.0.0/0 – 192.168.200.1
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Figure 22-20 DCN Case Study 3: ONS 15454 Linear Topology with DCN Connections at Both Ends 

Using OSPF

22.3.6.1 DCN Case Study 3 IP Configurations

The following sections provide sample IP configurations at routers and ONS 15454 nodes for 
DCN Case Study 3. 

22.3.6.1.1 NOC Router IP Configuration

Interface configuration:

interface Ethernet0/0
 ip address 10.58.46.121 255.255.255.192
 no ip directed-broadcast
!
interface Ethernet1/0
 ip address 192.168.20.1 255.255.255.0
 no ip directed-broadcast
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!
interface Ethernet2/0
 ip address 192.168.10.1 255.255.255.0
 no ip directed-broadcast
!
interface Loopback0
 ip address 1.1.1.1 255.255.255.0
 no ip directed-broadcast
!

GRE tunnel interface configuration:

interface Tunnel110
 ip address 192.168.110.1 255.255.255.0
 tunnel source Ethernet2/0
 tunnel destination 192.168.10.2
!
interface Tunnel210
 ip address 192.168.210.1 255.255.255.0
 tunnel source Ethernet1/0
 tunnel destination 192.168.20.2
!

OSPF routing configuration:

router ospf 1
 network 1.1.1.0 0.0.0.255 area 0
 network 10.0.0.0 0.255.255.255 area 0
 network 192.168.110.0 0.0.0.255 area 100
 network 192.168.210.0 0.0.0.255 area 200
 area 100 virtual-link 192.168.100.80
 area 200 virtual-link 192.168.100.77
!

Note that the OSPF virtual link to the end ONS 15454s is created to connect the DCC/OSC/GCC OSPF 
area 1 to the backbone area 0. No static routes are defined on the NOC router.

22.3.6.1.2 Router 1 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.10.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.1 255.255.255.0
no ip directed-broadcast

GRE tunnel interface configuration:

interface Tunnel110
 ip address 192.168.110.2 255.255.255.0
 tunnel source Ethernet0/0
 tunnel destination 192.168.10.1
!

OSPF and static routing configuration:

router ospf 1
 log-adjacency-changes
 network 192.168.100.0 0.0.0.255 area 100
 network 192.168.110.0 0.0.0.255 area 100
!
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ip classless
ip route 0.0.0.0 0.0.0.0 192.168.10.1

22.3.6.1.3 Router 2 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.20.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.2 255.255.255.0
no ip directed-broadcast

GRE tunnel interface configuration:

interface Tunnel210
 ip address 192.168.210.2 255.255.255.0
 tunnel source Ethernet0/0
 tunnel destination 192.168.20.1
!

OSPF and static routing configuration:

router ospf 1
 network 192.168.100.0 0.0.0.255 area 200
 network 192.168.210.0 0.0.0.255 area 200
!
ip classless
ip route 0.0.0.0 0.0.0.0 192.168.20.1

Table 22-7 shows network settings on the four ONS 15454 nodes. The static routes are created so the 
DCN-connected nodes can advertise their capability to act as last-resort routers.

Table 22-7 DCN Case Study 3 Node IP Addresses

Node IP Address/Mask Default Gateway OSPF Configuration

Node 1 192.168.100.80/24 192.168.100.1 DCC/OSC/GCC area: 0.0.0.1

LAN area: 0.0.0.100

OSPF Area Range Table:

• 192.168.100.79/32 - Area 0.0.0.1

• 192.168.100.78/32 - Area 0.0.0.1

• 192.168.100.77/32 - Area 0.0.0.1

Virtual Link Table: 1.1.1.1

Node 2 192.168.100.79/24 0.0.0.0 DCC/OSC/GCC area: 0.0.0.1

OSPF disabled on LAN
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The OSPF virtual link requires its neighbor to be indicated with its router ID, not the physical or tunnel 
interface connected to the network. Using a loopback interface on the NOC router makes the router ID 
selection independent from real interface IP address.

22.3.6.2 DCN Case Study 3 Limitations

DCN Case Study 3 shows that OSPF can provide better DCN resilience and more efficient routing 
choices, which results in better performance. OSPF also provides better network scalability. Some 
limitations of using OSPF include: 

• OSPF introduces additional complexity, for example, provisioning the OSPF virtual links and 
advertisement on the ONS 15454s and routers requires thought and planning. 

• OSPF must be enabled on the DCN connection between the NOC and the site routers. This can also 
be done through GRE tunnels, as shown in this case study. 

• Planning and thought must be given to the separation of the OSPF areas. Creation of virtual links to 
overcome the limitations described in the “22.3.2 OSPF” section on page 22-23 and to avoid 
isolated areas and segmentation in the backbone area requires planning as well.

22.3.7 DCN Case Study 4: Two Linear Cascaded Topologies With Two DCN 
Connections

DCN Case Study 4, shown in Figure 22-21, extends the simple linear topology shown in DCN Case 
Study 3. However in this example, two linear DCN connections go to the same site router and all the 
ONS 15454s are in the same subnet. A GRE tunnel logically connects the remote Router 1 and Router 2 
over the OSC/DCC/GCC network, which is similar to the DCN Case Study 1 configuration 
(Figure 22-18). The GRE tunnel provides the remote routers with an alternate path to reach the NOC 
network in case a DCN failure occurs. However, the alternate paths might overload the router routing 
tables and carry a higher cost because all alternate paths are host-based due to the fact the ONS 15454s 
reside in the same subnet.

Node 3 192.168.100.78/24 0.0.0.0 DCC/OSC/GCC area: 0.0.0.1

OSPF disabled on LAN

Node 4 192.168.100.77/24 192.168.100.1 DCC/OSC/GCC area: 0.0.0.1

LAN area: 0.0.0.200

OSPF Area Range Table:

• 192.168.100.80/32 - Area 0.0.0.1

• 192.168.100.79/32 - Area 0.0.0.1

• 192.168.100.78/32 - Area 0.0.0.1

Virtual Link Table: 1.1.1.1

Table 22-7 DCN Case Study 3 Node IP Addresses (continued)

Node IP Address/Mask Default Gateway OSPF Configuration
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Figure 22-21 DCN Case Study 4: Two Linear Cascaded Topologies with Two DCN Connections

22.3.7.1 DCN Case Study 4 IP Configurations

The following sections provide sample IP configurations at the routers and ONS 15454 nodes for 
DCN Case Study 4. 

22.3.7.1.1 NOC Router IP Configuration

Interface configuration:

interface Ethernet0/0
 ip address 10.58.46.121 255.255.255.192
 no ip directed-broadcast
!
interface Ethernet1/0
 ip address 192.168.20.1 255.255.255.0
 no ip directed-broadcast
!
interface Ethernet2/0
 ip address 192.168.10.1 255.255.255.0
 no ip directed-broadcast
!

Static routes with alternate paths at different costs:

ip classless
ip route 192.168.100.0 255.255.255.0 192.168.10.2
ip route 192.168.100.0 255.255.255.0 192.168.20.2 100
ip route 192.168.100.77 255.255.255.255 192.168.20.2 10
ip route 192.168.100.77 255.255.255.255 192.168.10.2 20
ip route 192.168.100.78 255.255.255.255 192.168.20.2
ip route 192.168.100.78 255.255.255.255 192.168.10.2 10
ip route 192.168.100.79 255.255.255.255 192.168.20.2
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ip route 192.168.100.79 255.255.255.255 192.168.10.2 10
ip route 192.168.100.80 255.255.255.255 192.168.10.2
ip route 192.168.100.80 255.255.255.255 192.168.20.2 10
ip route 192.168.200.0 255.255.255.0 192.168.20.2
ip route 192.168.200.0 255.255.255.0 192.168.10.2 100

22.3.7.1.2 Router 1 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.10.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.1 255.255.255.0
no ip directed-broadcast

GRE tunnel interface configuration:

interface Tunnel0
ip address 192.168.30.1 255.255.255.0
tunnel source Ethernet1/0
tunnel destination 192.168.100.2

Static routes with alternate paths at different costs:

ip classless
ip route 0.0.0.0 0.0.0.0 192.168.10.1
ip route 10.0.0.0 255.0.0.0 192.168.10.1
ip route 10.0.0.0 255.0.0.0 Tunnel0 10
ip route 192.168.100.2 255.255.255.255 192.168.100.80
ip route 192.168.100.77 255.255.255.255 Tunnel0 20
ip route 192.168.100.78 255.255.255.255 Tunnel0 10
ip route 192.168.100.79 255.255.255.255 Tunnel0 10

Note that the host routing path to the peer DCN router (Router 2, 192.168.100.2) points to the 
ONS 15454 network (by 192.168.100.80). This is required to set up the GRE tunnel. In this 
configuration, only the external route to 10.0.0.0 (that includes the NOC network) is overloaded with the 
alternate path. However, overloading of the last-resort route could also occur.

22.3.7.1.3 Router 2 IP Configuration

Interface configuration:

interface Ethernet0/0
ip address 192.168.20.2 255.255.255.0
no ip directed-broadcast
!
interface Ethernet1/0
ip address 192.168.100.2 255.255.255.0
no ip directed-broadcast

GRE tunnel interface configuration:

interface Tunnel0
ip address 192.168.30.2 255.255.255.0
tunnel source Ethernet1/0
tunnel destination 192.168.100.1

Static routes with alternate paths at different costs:

ip classless
ip route 0.0.0.0 0.0.0.0 192.168.20.1
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ip route 10.0.0.0 255.0.0.0 192.168.20.1
ip route 10.0.0.0 255.0.0.0 Tunnel0 10
ip route 192.168.100.1 255.255.255.255 192.168.100.79
ip route 192.168.100.80 255.255.255.255 Tunnel0 10

Note that the host routing path to the peer DCN router (Router, IP 192.168.100.1) points to the 
ONS 15454 network (by 192.168.200.79). This is required to set up the GRE tunnel. In this 
configuration, only the external route to 10.0.0.0 (that include the NOC network) is overloaded with the 
alternate path. However, overloading the last-resort route is also possible.

Table 22-8 shows network settings on the four ONS 15454 nodes. The static routes are created so the 
DCN-connected nodes can advertise their capability to act as last-resort routers.

22.3.7.2 DCN Case Study 4 Limitations

Many limitations described in the “22.3.4.2 DCN Case Study 1 Limitations” section on page 22-27 also 
apply to this case study. However, the problems are less acute because of the DCN connection in the 
middle of the optical network. For DWDM networks, increased latency might became a problem if the 
linear topology has many spans with intermediate line amplifier or optical add/drop multiplexing 
(OADM) nodes, which is sometimes done to cover long-distance connections. In this case, when one 
DCN fails, management packets for nodes near the middle of the span travel 1.5 times the complete 
point-to-point connection. The normal routing figure is 0.5. The full connection length of a GRE tunnel 
is used as an alternate routing path.

22.4 DCN Extension
ONS 15454 DWDM networks require a communication channel to exchange data among the different 
nodes within the network. Until Software Release 7.0, the only usable channel was the optical service 
channel (OSC) provided by the OSCM and OSC-CSM cards. In a long DWDM metro network, usage of 
OSC channel adds limitations in terms of cost and performance because the OSC channel maximum loss 
is 37 dB. 

The primary aim of the DCN extension feature is to remove the OSC constraint and leverage on already 
available external DCN or traffic matrix that allows nodes to be reached without using an OSC channel.

You can connect two nodes in a DWDM network without using an OSC channel in the following two 
methods:

• Using external DCN

• Using GCC/DCC

Table 22-8 DCN Case Study 4 Node IP Addresses

Node IP Address/Mask Default Gateway
Static Routes:
Destination/Mask – Next Hop

Node 1 192.168.100.80/24 192.168.100.1 0.0.0.0/0 – 192.168.100.1

192.168.100.1/32 – 192.168.100.80

Node 2 192.168.100.79/24 192.168.100.2 192.168.100.2/32 – 192.168.100.79

Node 3 192.168.100.78/24 192.168.100.2 0.0.0.0/0 – 192.168.100.2

Node 4 192.168.100.77/24 0.0.0.0 —
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The following sections describe the different communication methods and the factors to be considered 
while provisioning the connectivity.

22.4.1 Network Using OSC
Figure 22-22 shows a point-to-point network that uses OSC as the communication channel.

Figure 22-22 Network Using OSC

In a network using OSC channel, it is possible to supervise all the nodes from the network operations 
center (NOC) and all nodes can communicate with each other using the OSC channel. Network topology 
discovery is automatic when you use an OSC channel.

22.4.2 Network Using External DCN
Figure 22-23 shows a point-to-point network that uses external DCN as the communication channel.

Figure 22-23 Network Using External DCN

In a network using external DCN, it is possible to supervise all the nodes from the network operations 
center (NOC) and all nodes can communicate with each other using external DCN. The NOC is 
connected to each node through the external DCN. Since nodes do not have OSC connectivity, you must 
create an OTS-to-OTS PPC between the nodes. The OTS-to-OTS PPC creates a DCN connection 
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between the nodes. Refer to the “Create Optical Channel Circuits and Provisionable Patchcords” chapter 
for instructions on how to provision an OTS-to-OTS PPC. 

22.4.3 Network Using GCC/DCC
Figure 22-24 shows a point-to-point network that uses GCC/DCC as the communication channel.

Figure 22-24 Network Using GCC/DCC

In a network using GCC/DCC, one ONS 15454 node (for example, Node A) is provisioned as a gateway 
network element (GNE). The NOC is connected only to the GNE. It is possible to supervise all the nodes 
from the network operations center (NOC) and all nodes can communicate with each other using 
GCC/DCC.

However in such a network, because of the absence of the embedded OSC channel, discovery of the 
network topology is not automatic. You must manually provision the adjacency of nodes in order to 
configure the correct topology. Refer to the “Create Optical Channel Circuits and Provisionable 
Patchcords” chapter for instructions on how to provision DCN extension for a network using GCC/DCC.

22.5 Routing Table
ONS 15454 routing information is displayed on the Maintenance > Routing Table tab. The routing table 
provides the following information:

• Destination—Displays the IP address of the destination network or host.

• Mask—Displays the subnet mask used to reach the destination host or network.

• Gateway—Displays the IP address of the gateway used to reach the destination network or host.

• Usage—Shows the number of times the listed route has been used.

• Interface—Shows the ONS 15454 interface used to access the destination. Values are:

– motfcc0—The ONS 15454 Ethernet interface, that is, the RJ-45 jack on the 
TCC2/TCC2P/TCC3 and, for ANSI shelves, the LAN 1 pins on the backplane or, for ETSI 
shelves, the LAN connection on the MIC-C/T/P.

– pdcc0—An SDCC or RS-DCC interface, that is, an OC-N/STM-N trunk card identified as the 
SDCC or RS-DCC termination.

– lo0—A loopback interface.
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Table 22-9 shows sample routing entries for an ONS 15454.

Entry 1 shows the following:

• Destination (0.0.0.0) is the default route entry. All undefined destination network or host entries on 
this routing table are mapped to the default route entry.

• Mask (0.0.0.0) is always 0 for the default route.

• Gateway (172.20.214.1) is the default gateway address. All outbound traffic that cannot be found in 
this routing table or is not on the node’s local subnet is sent to this gateway.

• Interface (motfcc0) indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 2 shows the following:

• Destination (172.20.214.0) is the destination network IP address.

• Mask (255.255.255.0) is a 24-bit mask, meaning all addresses within the 172.20.214.0 subnet can 
be a destination.

• Gateway (172.20.214.92) is the gateway address. All outbound traffic belonging to this network is 
sent to this gateway. 

• Interface (motfcc0) indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 3 shows the following:

• Destination (172.20.214.92) is the destination host IP address.

• Mask (255.255.255.255) is a 32 bit mask, meaning only the 172.20.214.92 address is a destination.

• Gateway (127.0.0.1) is a loopback address. The host directs network traffic to itself using this 
address.

• Interface (lo0) indicates that the local loopback interface is used to reach the gateway. 

Entry 4 shows the following:

• Destination (172.20.214.93) is the destination host IP address.

• Mask (255.255.255.255) is a 32 bit mask, meaning only the 172.20.214.93 address is a destination.

• Gateway (0.0.0.0) means the destination host is directly attached to the node.

• Interface (pdcc0) indicates that a DCC interface is used to reach the destination host.

Entry 5 shows a DCC-connected node that is accessible through a node that is not directly connected:

• Destination (172.20.214.94) is the destination host IP address.

• Mask (255.255.255.255) is a 32-bit mask, meaning only the 172.20.214.94 address is a destination.

• Gateway (172.20.214.93) indicates that the destination host is accessed through a node with IP 
address 172.20.214.93.

Table 22-9 Sample Routing Table Entries

Entry Destination Mask Gateway Usage Interface

1 0.0.0.0 0.0.0.0 172.20.214.1 265103 motfcc0

2 172.20.214.0 255.255.255.0 172.20.214.92 0 motfcc0

3 172.20.214.92 255.255.255.255 127.0.0.1 54 lo0

4 172.20.214.93 255.255.255.255 0.0.0.0 16853 pdcc0

5 172.20.214.94 255.255.255.255 172.20.214.93 16853 pdcc0
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• Interface (pdcc0) indicates that a DCC interface is used to reach the gateway.

22.6 External Firewalls
This section provides information on firewall ports required for various type of connections that are 
established with the NE (controller card). Also, there are examples of Access Control List (ACL) for 
external firewall configuration that makes a connection feasible with the controller card.

22.6.1 Firewall Ports
Table 22-10 lists the ports that must be enabled to establish a communication channel with the 
NE (controller card).

Table 22-10 Firewall Ports for Various Sessions

Session 
Type Session Description Mode Port Number Firewall ACL

CORBA CORBA listener port on the NE Standard 57790 (default); user configurable to the 
standard port 683 or any other port.1

1. To configure the port, see the “DLP-G61 Provision the IIOP Listener Port on the ONS 15454” task on page 14-34.

Inbound

Secure 57791 (default); user configurable to the 
standard port 684 or any other port.

Standard Internet Inter-ORB Protocol 
(IIOP) listener port on machine running 
CTC

Standard Dynamic (default); user configurable to 
the standard port 683 or any other port.2

2. To configure the port, see the “DLP-G62 Provision the IIOP Listener Port on the CTC Computer” task on page 14-35.

Outbound

Secure Dynamic (default); user configurable to 
the standard port 684 or any other port.

SOCKS CTC configured with SOCKS or GNE — 1080 Inbound

HTTP HTTP port on the NE — 80 Inbound

HTTPS HTTPS port on the NE — 4333

3. If this port is blocked, NE could take long time to initialize.

Inbound

TL1 TL1 port on NE Standard 3082, 3083, 2362 Inbound

Secure 4083

SNMP SNMP listener port on NE Standard 161 Inbound

Secure

SNMP trap listener port on the machine 
receiving the traps

Standard 162 (default); user configurable to any 
port between 1024 to 65535

Outbound

Secure
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22.6.2 ACL Examples
The following access control list (ACL) example shows a firewall configuration when the proxy server 
gateway setting is not enabled. In the example, the CTC workstation's address is 192.168.10.10. and the 
ONS 15454 address is 10.10.10.100. The firewall is attached to the GNE; hence, inbound is from the 
CTC to the GNE and outbound is from the GNE to CTC. The CTC Common Object Request Broker 
Architecture (CORBA) standard port is 683 and the TCC CORBA default port on TCC is 57790.

access-list 100 remark *** Inbound ACL, CTC -> NE *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq www 
access-list 100 remark *** allows initial contact with ONS 15454 using http (port 80) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq 57790 
access-list 100 remark *** allows CTC communication with ONS 15454 GNE (port 57790) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 established 
access-list 100 remark *** allows ACKs back from CTC to ONS 15454 GNE *** 

access-list 101 remark *** Outbound ACL, NE -> CTC *** 
access-list 101 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 eq 683 
access-list 101 remark *** allows alarms etc., from the 15454 (random port) to the CTC 
workstation (port 683) *** 
access-list 100 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 established 
access-list 101 remark *** allows ACKs from the 15454 GNE to CTC *** 

The following ACL example shows a firewall configuration when the proxy server gateway setting is 
enabled. As with the first example, the CTC workstation address is 192.168.10.10 and the ONS 15454 
address is 10.10.10.100. The firewall is attached to the GNE; hence, inbound is from the CTC to the GNE 
and outbound is from the GNE to CTC. The CTC Common Object Request Broker Architecture 
(CORBA) standard port is 683 and the TCC CORBA default port on TCC is 57790.

access-list 100 remark *** Inbound ACL, CTC -> NE *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq www 
access-list 100 remark *** allows initial contact with the 15454 using http (port 80) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq 1080
access-list 100 remark *** allows CTC communication with the 15454 GNE (port 1080) *** 
access-list 100 remark 

access-list 101 remark *** Outbound ACL, NE -> CTC *** 
access-list 101 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 established 
access-list 101 remark *** allows ACKs from the 15454 GNE to CTC *** 

22.7 Open GNE
The ONS 15454 can communicate with non-ONS nodes that do not support Point-to-Point Protocol 
(PPP) vendor extensions or OSPF type 10 opaque link-state advertisements (LSA), both of which are 
necessary for automatic node and link discovery. An open GNE configuration allows a GCC-based 
network to function as an IP network for non-ONS nodes. 

To configure an open GNE network, you can provision GCC terminations to include a far-end, non-ONS 
node using either the default IP address of 0.0.0.0 or a specified IP address. You provision a far-end, 
non-ONS node by checking the Far End is Foreign check box during GCC creation. The default 0.0.0.0 
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IP address allows the far-end, non-ONS node to identify itself with any IP address; if you set an IP 
address other than 0.0.0.0, a link is established only if the far-end node identifies itself with that IP 
address, providing an extra level of security. 

By default, the proxy server only allows connections to discovered ONS peers and the firewall blocks 
all IP traffic between the GCC network and LAN. You can, however, provision proxy tunnels to allow 
up to 12 additional destinations for SOCKS version 5 connections to non-ONS nodes. You can also 
provision firewall tunnels to allow up to 12 additional destinations for direct IP connectivity between the 
GCC network and LAN. Proxy and firewall tunnels include both a source and destination subnet. The 
connection must originate within the source subnet and terminate within the destination subnet before 
either the SOCKS connection or IP packet flow is allowed. A proxy connection is allowed if the CTC 
client is in a source subnet and the requested destination is in the destination subnet. Firewall tunnels 
allow IP traffic to route between the node Ethernet and pdcc interfaces. An inbound Ethernet packet is 
allowed through the firewall if its source address matches a tunnel source and its destination matches a 
tunnel destination. An inbound pdcc packet is allowed through the firewall if its source address matches 
a tunnel destination and its destination address matches a tunnel source. Tunnels only affect TCP and 
UDP packets.

The availability of proxy and/or firewall tunnels depends on the network access settings of the node:

• If the node is configured with the proxy server enabled in GNE or ENE mode, you must set up a 
proxy tunnel and/or a firewall tunnel. 

• If the node is configured with the proxy server enabled in proxy-only mode, you can set up proxy 
tunnels. Firewall tunnels are not allowed.

• If the node is configured with the proxy server disabled, neither proxy tunnels nor firewall tunnels 
are allowed. 

Figure 22-25 shows an example of a foreign node connected to the GCC network. Proxy and firewall 
tunnels are useful in this example because the GNE would otherwise block IP access between the PC 
and the foreign node.
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Figure 22-25 Proxy and Firewall Tunnels for Foreign Terminations

Figure 22-26 shows a remote node connected to an ENE Ethernet port. Proxy and firewall tunnels are 
useful in this example because the GNE would otherwise block IP access between the PC and foreign 
node. This configuration also requires a firewall tunnel on the ENE.
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Figure 22-26 Foreign Node Connection to an ENE Ethernet Port

22.8 TCP/IP and OSI Networking
ONS 15454 DCN communication is based on the TCP/IP protocol suite. However, ONS 15454s can also 
be networked with equipment that uses the OSI protocol suite. While TCP/IP and OSI protocols are not 
directly compatible, they do have the same objectives and occupy similar layers of the OSI reference 
model. For detailed information about OSI protocols, processes, and scenarios, refer to the 
“Management Network Connectivity” chapter in the ONS 15454 Reference Manual. OSI/MultiService 
Transport Platform (MSTP) scenarios are provided in the following sections.

In OSI/MSTP Scenario 1 (Figure 22-27), an SDCC or RS-DCC carries an OC-N/STM-N signal from an 
OSI-based third-party NE to a transponder (TXP) or muxponder (MXP) card on an ONS NE. It is carried 
by GCC to a TXP/MXP card on another MSTP NE and then by SDCC or RS-DCC to a second third-party 
NE. This scenario requires TXPs/MXPs whose client interfaces can be provisioned in section or line 
termination mode. These include:

• TXP_MR_2.5 and TXPP_MR_2.5 (when equipped with OC-N/STM-N SFPs)

• TXP_MR_10G and TXP_MR_10E (when the client is configured as OC-192/STM-64)

• MXP_2.5_10G and MXP_2.5_10E
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OSI has to be carried or tunneled to the other TXP/MXP card through an OSC termination, GCC 
termination, or both. The third-party NMS has OSI connectivity to its NEs with the MSTP ONS NE 
serving as the GNE for third-party vendor, OSI-based SONET equipment.

Figure 22-27 OSI/MSTP Scenario 1

OSI/MSTP Scenario 2 (Figure 22-28) is similar to Scenario 1, except the MSTP NEs do not have 
connectivity to an OSI NMS.
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Figure 22-28 OSI/MSTP Scenario 2

OSI/MSTP Scenario 3 (Figure 22-29) shows the following:

• OSI is carried over an SDCC or RS-DCC termination.

• OSI has to be carried or tunneled to the other peer TXP/MXP through an OSC termination, GCC 
termination, or both.

• An OSS has IP connectivity to all the NEs.

• The MSTP NE is a GNE for the third-party OSI-based SONET NEs. The MSTP NEs perform all 
mediation functions.
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Figure 22-29 OSI/MSTP Scenario 3

OSI/MSTP Scenario 4 (Figure 22-30) shows the following:

• OSI is carried over an SDCC or RS-DCC termination.

• OSI has to be carried or tunneled to the other peer TXP/MXP through an OSC termination, GCC 
termination, or both

• An OSS has IP connectivity to all the NEs through third-party NE network.

• The MSTP NE is a GNE for the third-party OSI-based SONET NEs. The MSTP NEs perform all 
mediation functions.

• The third-party vendor NE is a GNE for the Cisco MSTP network.
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Figure 22-30 OSI/IP Scenario 4

22.9 Link Management Protocol 
This section describes Link Management Protocol1 (LMP) management and configuration. To 
troubleshoot specific alarms, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide. To configure 
LMP, refer to the “Turn Up a Network” chapter.

Note CTM support is not required for LMP.

LMP is used to establish traffic engineering (TE) links between Cisco ONS 15454 nodes or between 
Cisco ONS 15454 nodes and selected non-Cisco nodes that use vendor-specific hardware.

22.9.1 Overview
LMP manages TE links between nodes through the use of control channels. TE links are designed to 
define the most efficient paths possible for traffic to flow over a network and through the Internet. Traffic 
engineering encompasses traffic management, capacity management, traffic measurement and modeling, 
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1. The LMP protocol is specified by the IETF in an Internet-Draft, draft-ietf-ccamp-lmp-10.txt, which was 
published as a Proposed Standard, RFC 4204, (http://www.ietf.org/rfc/rfc4204.txt), on 2005-10-28.
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network modeling, and performance analysis. Traffic engineering methods include call routing, 
connection routing, quality of service (QoS) resource management, routing table management, and 
capacity management. 

LMP manages TE links between peer nodes, such as two optical cross-connect (OXC) nodes. Peer nodes 
have equivalent signaling and routing. LMP also manages TE links between a node such as an OXC and 
an adjacent optical line system (OLS) node. An example of an OLS node is an ONS 15454 DWDM node.

Networks with routers, switches, OXC nodes, DWDM OLS nodes, and add/drop multiplexers (ADM) 
use a common control plane such as Generalized Multiprotocol Label Switching (GMPLS) to provision 
resources and provide network survivability using protection and restoration techniques. LMP is part of 
the GMPLS protocol suite. 

A single TE link can be formed from several individual links. Management of TE links can be 
accomplished with in-band messaging, as well as with out-of-band methods. The following material 
describes the LMP between a pair of nodes that manages TE links. LMP accomplishes the following:

• Maintains control channel connectivity

• Verifies the physical connectivity of the data links

• Correlates the link property information

• Suppresses downstream alarms

• Localizes link failures for protection/restoration purposes in multiple types of networks

DWDM networks often use Multiprotocol Label Switching (MPLS) and GMPLS as common-control 
planes to control how packets are routed through the network.

LMP manages the control channel that must exist between nodes for routing, signaling, and link 
management. For a control channel to exist, each node must have an IP interface that is reachable from 
the other node. Together, the IP interfaces form a control channel. The interface for the control messages 
does not have to be the same interface as the one for the data. 

22.9.1.1 MPLS

MPLS provides a mechanism for engineering network traffic patterns that is independent of routing 
tables and routing protocols. MPLS assigns short labels to network packets that describe how to forward 
the packets through the network. The traditional Layer 3 forwarding mechanism requires each hop to 
analyze the packet header and determine the next hop based on routing table lookup. With MPLS, the 
analysis of the packet header is performed just once, when a packet enters the MPLS cloud. The packet 
is then assigned to a stream known as a Label Switch Path (LSP), which is identified with a label. The 
short, fixed-length label is an index into a forwarding table, which is more efficient than the traditional 
routing table lookup at each hop. Using MPLS, both the control protocol (used to manage the LSPs) and 
user data can be carried over the same bearer interfaces. 

22.9.1.2 GMPLS

GMPLS is based on MPLS, with protocol extensions to support additional technologies, including time 
division multiplexing (TDM) slots (such as SONET and SDH), wavelength division multiplexing 
(WDM) wavelengths at Layer 1, and fiber. For MPLS, the control traffic (signaling and routing) can run 
over bearer interfaces. This is not the case with GMPLS, where a separate control channel is used. The 
GMPLS control channel is managed with LMP. With GMPLS, the control channels between two 
adjacent nodes do not need to use the same physical medium as the data links between those nodes.
22-50
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 22      Manage Network Connectivity
22.9.2   Configuring LMP
22.9.2 Configuring LMP
Configuring LMP consists of the following four topics:

• Control channel management

• TE link management

• Link connectivity verification

• Fault management

22.9.2.1 Control Channel Management

Control channel management establishes and maintains control channels between adjacent nodes. 
Control channels use a Config message exchange and a fast keep-alive mechanism between the nodes. 
The latter is required if lower-level mechanisms are not available to detect control-channel failures. A 
maximum of four LMP control channels can be supported.

The nodes initially exchange configuration messages (Config, ConfigAck, and ConfigNack), which are 
used to exchange identifiers and negotiate parameters for the keep-alive protocol. The nodes then 
perform a continuous rapid exchange of Hello messages, which are used to monitor the health on the 
channel. 

Note The identifiers are Local Node Id, Remote Node Id, Local Control Channel Id, and Remote 
Control Channel Id. The parameters are the HelloInterval and the HelloDeadInterval. 

LMP out-of-fiber and LMP out-of-band control channels are supported and terminated on the shelf. An 
out-of-fiber control channel includes using the control plane network (Ethernet) for the control channel 
because Ethernet is separate from the fiber used for the data plane. An out-of-band control channel 
includes using overhead bytes, such as the SDCC and LDCC bytes, for the control channel because 
overhead bytes are separate from the payload. In-band means that the control messages are in the same 
channel as the data messages; therefore, out-of-band refers to overhead bytes in the same fiber, separate 
circuits dedicated to control messages in the same fiber (SONET/SDH circuits), or separate wavelengths 
in the same fiber (DWDM). 

Note Overhead bytes are SDCC or LDCC for SONET networks, RS-DCC or MS-DCC for SDH 
networks, and GCC or OSC for DWDM networks.

Out-of-band implies in-fiber, but not in-band. In-fiber means that the control messages are in the same 
fiber as the data messages, and includes both in-band and out-of-band. Out-of-fiber means that the 
control messages take a path separate from the data plane. This includes separate fiber and Ethernet.

The control channel management for a peer node to OLS link is the same as that for a link between two 
peer nodes.

Note The software supports gracefully taking a control channel down for administration purposes (refer to 
Section 3.2.3 of the IETF LMP document). However, there is no provision for a graceful restart (refer to 
Section 8 of RFC 4204). 

• Graceful means that the nodes participating in the control channel agree that the link should go 
down. To gracefully take down a control channel, the node sets the ControlChannelDown flag in its 
messages to the other node until either the HelloDeadInterval expires or the other node sends a 
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message back with the ControlChannelDown flag set. In either case, the node then stops sending 
messages for this control channel. Before a control channel is taken down, there should be a backup 
control channel in place that can be used to manage the data links. 

• Non-graceful means that one of the nodes just stops sending messages. The other side would declare 
a failure after the HelloDeadInterval, but would continue to send Hello messages to see if the control 
channel will come back up.

22.9.2.2 TE Link Management

LMP ensures that links are grouped into TE links and that the properties of those links are the same at 
both endpoints. This is called TE link management, or link property correlation.

Link property correlation is used to synchronize the TE link properties and verify the TE link 
configuration. The link property correlation function of LMP aggregates one or more data links into a 
TE link and synchronizes the properties of the TE link with the neighbor node. The procedure starts by 
sending a LinkSummary message to the neighbor. The LinkSummary message includes the local and 
remote Link Identifier, a list of all data links that make up the TE link, and various link properties. It is 
mandatory that a LinkSummaryAck or LinkSummaryNack message be sent in response to the receipt of 
a LinkSummary message, indicating agreement or disagreement with the link properties. 

Note A maximum of 256 LMP TE links is supported.

22.9.2.3 Link Connectivity Verification

Link connectivity verification is not supported in this release, but might be supported in the future.

22.9.2.4 Fault Management

Fault management is particularly useful when the control channels are physically diverse from the data 
links. It is used for rapid notification regarding the status of one or more TE-link data channels. The use 
of fault management is negotiated as part of the TE link’s LinkSummary exchange. Data links and TE 
link failures can be rapidly isolated and fault management supports both unidirectional and bidirectional 
LSPs. Transparent devices are useful because traditional methods for monitoring the health of allocated 
data links might no longer be appropriate. Instead, fault detection is delegated to the physical layer (for 
example, loss of light or optical monitoring of the data) instead of Layer 2 or Layer 3. Fault management 
uses the ChannelStatus, ChannelStatusAck, ChannelStatusRequest, and ChannelStatusResponse 
messages. 

Note The LMP Channel Activation/Deactivation Indication procedures are not supported; they are described 
in the IETF LMP document, Sections 6.4 and 6.5.
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22.9.3 LMP WDM
LMP manages traffic engineering links between peer nodes (nodes that are peers in signaling and/or 
routing). The purpose of the LMP WDM extensions2 is to allow LMP to be used between an OXC node 
and an adjacent DWDM OLS node. Figure 22-31 illustrates the relationship between LMP and 
LMP-WDM. OXC 1 and OXC 2 are peer nodes whose control channel is managed with LMP. 
LMP-WDM manages the control channel between an OXC node and an OLS node.

Figure 22-31 LMP and LMP-WDM Relationship

When the two OLS nodes can communicate their configuration and the current state of their optical link 
to the two peer nodes (OXC 1 and OXC 2) through LMP-WDM, network usability is improved through 
the reduction of manual configuration and enhanced fault detection and recovery.

22.9.4 LMP Network Implementation
Figure 22-32 shows a network-level LMP implementation. It is an IP-plus-optical network, with 
end-to-end routing based on MPLS and GMPLS. The primary network components are: 

• Routers 

– Cisco Carrier Router System (CSR)

– Cisco Gigabit Switch Router (GSR)

– Cisco ASR 9000 Series Routers

• An OXC node

• Ultra long-haul (ULH) DWDM equipment

LMP and other features allow the Cisco ONS 15454 DWDM node to fulfill the ULH DWDM role. 
Figure 22-32 illustrates the relationship between the network components.

2. LMP-WDM extensions that allow management of links between a peer node and an adjacent OLS node are 
described in the following IETF document: Internet-Draft, draft-ietf-ccamp-lmp-wdm-03.txt, published as a 
Proposed Standard, RFC 4209 (http://www.ietf.org/rfc/rfc4209.txt), 2005-11-1
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Figure 22-32 LMP System Implementation 

22.10 IPv6 Network Compatibility
IPv6 simplifies IP configuration and administration and has a larger address space than IPv4 to support 
the future growth of the Internet and Internet related technologies. It uses 128-bit addresses as against 
the 32-bit used in IPv4 addresses. Also, IPv6 gives more flexibility in designing newer addressing 
architectures. 

Cisco ONS 15454 DWDM can function in an IPv6 network when an Internet router that supports 
Network Address Translation-Protocol Translation (NAT-PT) is positioned between the GNE, such as an 
ONS 15454 DWDM, and the client workstation. NAT-PT is a migration tool that helps users transition 
from IPv4 networks to IPv6 networks. NAT-PT is defined in RFC-2766. IPv4 and IPv6 nodes 
communicate with each other using NAT-PT by allowing both IPv6 and IPv4 stacks to interface between 
the IPv6 DCN and the IPv4 DCC networks.

Note IPv6 is supported on Cisco ONS 15454 DWDM Software R8.0 and later with an external NAT-PT router.

22.11 IPv6 Native Support
Cisco ONS 15454 DWDM Software R9.0 and later supports native IPv6. ONS 15454 DWDM can be 
managed over IPv6 DCN networks by enabling the IPv6 feature. After you enable IPv6 in addition to 
IPv4, you can use CTC, TL1, and SNMP over an IPv6 DCN to manage ONS 15454 DWDM. Each NE 
can be assigned an IPv6 address in addition to the IPv4 address. You can access the NE by entering the 
IPv4 address, an IPv6 address or the DNS name of the device. The IPv6 address is assigned only on the 
LAN interface of the NE. DCC/GCC interfaces use the IPv4 address.
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22.11   IPv6 Native Support
By default, when IPv6 is enabled, the node processes both IPv4 and IPv6 packets on the LAN interface. 
If you want to process only IPv6 packets, you need to disable IPv4 on the node. Before you disable IPv4, 
ensure that IPv6 is enabled and the node is not in multishelf mode. 

Figure 22-33 shows how an IPv6 DCN interacts with and IPv4 DCC.

Figure 22-33 IPv6-IPv4 Interaction

You can manage MSTP multishelf nodes over IPv6 DCN. RADIUS, FTP, SNTP, and other network 
applications support IPv6 DCN. To enable IPv6 addresses, you need to make the necessary configuration 
changes from the CTC or TL1 management interface. After you enable IPv6, you can start a CTC or TL1 
session using the provisioned IPv6 address. The ports used for all IPv6 connections to the node are the 
same as the ports used for IPv4.

An NE can either be in IPv6 mode or IPv4 mode. In IPv4 mode, the LAN interface does not have an IPv6 
address assigned to it. An NE, whether it is IPv4 or IPv6, has an IPv4 address and subnet mask. 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards do not reboot automatically when you provision an 
IPv6 address, but a change in IPv4 address initiates a TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card 
reset. Table 22-11 describes the differences between an IPv4 node and an IPv6 node.
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ENE C
IPv6 Address:

3ffe:b00:ffff:1::4
IPv4 Address:

10.10.10.20

ENE B
IPv6 Address:

3ffe:b00:ffff:1::3
IPv4 Address:

10.10.10.10

GNE A
IPv6 Address:
3ffe:b00:ffff:1::5
IPv4 Address:
10.10.20.40

ENE D
IPv6 Address:
3ffe:b00:ffff:1::6
IPv4 Address:
10.10.20.30

NMS
IPv6 Address:

3ffe:b00:ffff:1::2

Table 22-11 Differences Between an IPv6 Node and an IPv4 Node

IPv6 Node IPv4 Node

Has both IPv6 address and IPv4 address assigned 
to its craft Ethernet interface.

Does not have an IPv6 address assigned to its craft 
Ethernet interface.

The default router has an IPv6 address for IPv6 
connectivity, and an IPv4 address for IPv4 
connectivity.

The default router has an IPv4 address.

Cannot enable OSPF on LAN. Cannot change 
IPv4 NE to IPv6 NE if OSPF is enabled on the 
LAN.

Can enable OSPF on the LAN.

Cannot enable RIP on the LAN. Cannot change 
IPv4 NE to IPv6 NE if RIP is enabled on the LAN.

Can enable static routes/RIP on the LAN.
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22.11.1   IPv6 Enabled Mode
22.11.1 IPv6 Enabled Mode
The default IP address configured on the node is IPv4. You can use either CTC or the TL1 management 
interface to enable IPv6. For more information about enabling IPv6 from the CTC interface, see the 
“Turn Up a Node” chapter. For more information about enabling IPv6 using TL1 commands, see the 
Cisco ONS SONET TL1 Command Guide or the Cisco ONS SDH TL1 Command Guide.

22.11.2 IPv6 Disabled Mode
You can disable IPv6 either from the CTC or from the TL1 management interface. For more information 
about disabling IPv6 from the CTC interface, see the “Turn Up a Node” chapter. For more information 
about disabling IPv6 using TL1 commands, see the Cisco ONS SONET TL1 Command Guide or the 
Cisco ONS SDH TL1 Command Guide.

22.11.3 IPv6 in Non-secure Mode
In non-secure mode, IPv6 is supported on the front and the rear Ethernet interfaces. You can start a CTC 
or TL1 session using the IPv6 address provisioned on the on the front and rear ports of the NE. 

22.11.4 IPv6 in Secure Mode
In secure mode, IPv6 is only supported on the rear Ethernet interface. The front port only supports IPv4 
even if it is disabled on the rear Ethernet interface. For more information about provisioning IPv6 
addresses in secure mode, see the “Turn Up a Node” chapter. For more information on secure mode 
behavior, see section 22.2.9 Scenario 9: IP Addressing with Secure Mode Enabled, page 22-19.

22.11.5 IPv6 Limitations
IPv6 has the following configuration restrictions:

• You can provision an NE as IPv6 enabled only if the node is a SOCKS-enabled or firewall-enabled 
GNE/ENE. 

• IPSec is not supported.

• OSPF/RIP cannot be enabled on the LAN interface if the NE is provisioned as an IPv6 node.

• Static route/firewall/proxy tunnel provisioning is applicable only to IPv4 addresses even if the IPv6 
is enabled.

Not supported on static routes, proxy tunnels, and 
firewall tunnels.

Supported on static routes, proxy tunnels, and 
firewall tunnels.

Routing decisions are based on the default IPv6 
router provisioned.

Table 22-11 Differences Between an IPv6 Node and an IPv4 Node

IPv6 Node IPv4 Node
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22.12   Integration with Cisco CRS-1, Cisco ASR 9000 Series, or Cisco 7600 Series Routers
• In secure mode, IPv6 is supported only on the rear Ethernet interface. IPv6 is not supported on the 
front port. 

• ONS platforms use NAT-PT internally for providing IPv6 native support. NAT-PT uses the IPv4 
address range 128.0.0.0 to 128.0.1.254 for packet translation. Do not use this address range when 
you enable IPv6 feature.

22.12 Integration with Cisco CRS-1, Cisco ASR 9000 Series, or 
Cisco 7600 Series Routers

This section describes the integration of a Cisco ONS 15454 DWDM node with a Cisco CRS-1, a 
Cisco ASR 9000 series, or a Cisco 7600 series router. To provision end-to-end circuit connectivity 
between a DWDM node and a Cisco CRS-1, Cisco ASR 9000 series router, or a Cisco 7600 series router, 
see the Chapter 16, “Turn Up a Network.”

This feature provides end-to-end circuit provisioning from one Cisco CRS-1, Cisco ASR 9000 series, or 
a Cisco 7600 series router to another Cisco CRS-1, Cisco ASR 9000 series, or a Cisco 7600 series router 
passing through an MSTP network (without using GMPLS). In other words, you can use CTC to create 
an OCH trail circuit that includes the Cisco CRS-1, Cisco ASR 9000 series, or a Cisco 7600 series nodes 
involved in the MSTP network. With this feature, circuit provisioning is extended to the physical layer 
interface module (PLIM) trunk ports of the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series 
router.

Note Cisco ONS Software Release 9.4 supports Cisco CRS-1 routers using 
Cisco IOS XR Software Release 3.9, and Cisco ASR 9000 series routers using 
Cisco IOS XR Software Release 4.1.0, and Cisco 7600 routers using Cisco IOS Software Release 10.0. 
If you have an earlier version of the Cisco IOS XR software, you cannot configure LMP on the Cisco 
CRS-1 or Cisco ASR 9000 series router and the router is displayed as an unknown node in the CTC 
network view. Similarly, if you have an earlier version of the Cisco IOS software, you cannot configure 
virtual links on the Cisco 7600 series router and the router is displayed as an unknown node in the CTC 
network view.

Note Cisco 7600 series router does not support LMP provisioning. Therefore, virtual links or the 
provisionable patchcords are created to establish connectivity between Cisco 7600 series routers and 
DWDM nodes.

Note Interoperability among the Cisco CRS-1 routers, Cisco ASR 9000 series, and Cisco 7600 series routers 
is not supported.

For more information about the Cisco CRS-1 router, see the documentation set available at 
http://www.cisco.com/en/US/products/ps5763/tsd_products_support_series_home.html.

For more information about the Cisco ASR 9000 series router, see the documentation set available at

http://www.cisco.com/en/US/products/ps9853/tsd_products_support_series_home.html

For more information about the Cisco 7600 series router, see the documentation set available at

http://www.cisco.com/en/US/products/hw/routers/ps368/tsd_products_support_series_home.html
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22.12.1 Card Compatibility
The following Cisco CRS-1 DWDM PLIMs support this feature:

• 4-10GE-ITU/C

• 1OC768-ITU/C

• 1OC768-DSPK

The following Cisco ASR 9000 series DWDM PLIMS support this feature:

• A9K-8T-L

The following Cisco 7600 series router cards support this feature:

• 76-ES+XT-2TG3CXL

• 76-ES+XT-4TG3CXL

• 76-ES+T-2TG

• 76-ES+T-4TG

• 76-ES+XC-20G3C

• 76-ES+XC-20G3CXL

• 76-ES+XC-40G3C

• 76-ES+XC-40G3CXL 

The following ONS 15454 DWDM cards support this feature:

• 32MUX-O

• 32DMX-O

• 32WSS

• 32DMX

• 40-DMX-C

• 40-DMX-CE

• 40-MUX-C

• 40-WSS-C

• 40-WSS-CE

• 100G-LC-C
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22.12.2   Node Management
22.12.2 Node Management
Figure 22-34 depicts a typical network that includes DWDM nodes and Cisco CRS-1 routers.

Figure 22-34 Cisco ONS 15454 DWDM Node and Cisco CRS-1 Router Network

Figure 22-35 depicts a typical network that includes DWDM nodes and Cisco 7600 series routers.

Figure 22-35 Cisco ONS 15454 DWDM Node and Cisco 7600 Series Router Network
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22.12.2   Node Management
22.12.2.1 Physical Connections

The ONS 15454 DWDM node can be connected to CTC in multiple ways. 

The Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router must be connected to CTC 
through TCP/IP, using an Ethernet interface. 

There must be two physical connections between the Cisco ONS 15454 DWDM node and the 
Cisco CRS-1, Cisco ASR 900 series, or Cisco 7600 series router for:

• (Cisco CRS-1 or Cisco ASR 900 series routers only) LMP Provisioning—This is implemented 
through the 10-Mbps Ethernet interface provided by the TCC2P card (on the Cisco ONS 15454 
DWDM side) and the RP card (on the Cisco CRS-1 or Cisco ASR 9000 series router side).

• (Cisco 7600 series routers only) Virtual Link or Patch Cord Provisioning—This is implemented 
through the 10-Mbps Ethernet interface provided by the TCC2P card (on the Cisco ONS 15454 
DWDM side) and the Supervisor card (on the Cisco 7600 series router side).

• 10-Gbps and 40-Gbps Traffic Provisioning—This is implemented through the fiber connection 
provided from the OCH ports of the multiplexer, demultiplexer, or WSS cards (on the 
Cisco ONS 15454 side) and from the trunk ports (on the Cisco CRS-1, Cisco ASR 9000 series, or 
Cisco 7600 series router side). You must use LC connectors on both the Cisco ONS 15454 DWDM 
side and the Cisco CRS-1 router side.

22.12.2.2 CTC Display

The CTC network view displays Cisco CRS-1 or Cisco ASR 9000 series routers that have LMP control 
channels to the DWDM node that you logged in to, and to the DWDM nodes with DCC connections to 
the login node (Figure 22-36). When a data link is established, the network view also displays the link 
between the Cisco CRS-1 or Cisco ASR 9000 series router and the DWDM node.

For a Cisco 7600 series router, you must manually add the node in CTC to make the router visible in the 
network view. 
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22.12.3   Circuit Management
Figure 22-36 Cisco CRS-1 Router in CTC Network View

The color of the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router in the network view 
depends on the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router alarm status. The color 
of the link between the DWDM node and the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series 
router depends on the link status. For more information on node and link colors, see the sections “CTC 
Node Colors” and “DCC Links”.

22.12.3 Circuit Management
This section describes LMP provisioning, virtual link provisioning, and optical channel (OCH) trail 
circuit provisioning on the DWDM node and the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 
series router. 

22.12.3.1 LMP Provisioning

To provision end-to-end circuit connectivity from one Cisco CRS-1 or Cisco ASR 9000 series router to 
another Cisco CRS-1 or Cisco ASR 9000 series router passing through a DWDM network, you must 
configure LMP on the OCH ports of the first and last DWDM nodes (those adjacent to the Cisco CRS-1 
or Cisco ASR 9000 series router) and on the PLIM trunk ports of the Cisco CRS-1 or Cisco ASR 9000 
series router. Configuring LMP involves creating control channels, TE links, and data links. CTC 
primarily uses data links to discover circuit routes. For each 10-Gbps or 40-Gbps fiber between the 
Cisco CRS-1 or Cisco ASR 9000 series router and the DWDM node, you must create a TE link and a 
data link. You must have a dedicated TE link for each data link because the Cisco CRS-1 or 
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Cisco ASR 9000 series router does not support link bundling (aggregation of one or more data links into 
a single TE link). When the port association is correct (checked using the LinkSummary message), the 
operational state of the data link transitions to Up–Free. 

During creation of data links between the OCH ports of the DWDM node and the PLIM trunk ports of 
the Cisco CRS-1 or Cisco ASR 9000 series router, CTC performs lambda tuning, that is, CTC 
automatically tunes the PLIM trunk port wavelength to match the supported wavelength on the OCH 
ports of the DWDM node. For more information on LMP, see the “22.9 Link Management Protocol” 
section on page 22-49.

You can configure LMP on the DWDM node and the Cisco CRS-1 or Cisco ASR 9000 series router 
through CTC. For details on configuring LMP, see the “Turn Up a Network” chapter.

Note LMP provisioning is not supported on Cisco 7600 series routers.

22.12.3.2 Virtual Link Provisioning

To provision end-to-end circuit connectivity from one Cisco 7600 series router to another Cisco 7600 
series router passing through a DWDM network, you must configure virtual links or provisional patch 
cords (PPC) on the OCH ports of the first and last DWDM nodes (those adjacent to the Cisco 7600 series 
router) and on the trunk ports of the Cisco 7600 series router. 

For more information on virtual link (virtual or provisionable patchcord) provisioning, see the 
“17.2 Virtual Patchcords” section on page 17-7.

You can configure virtual links on the DWDM node and the Cisco 7600 series router through CTC. For 
details on configuring provisionable patchcords, see the “Create Optical Channel Circuits and 
Provisionable Patchcords” chapter.

22.12.3.3 OCH Trail Circuit Provisioning

After you have provisioned LMP on the DWDM nodes and the Cisco CRS-1 or Cisco ASR 9000 series 
routers, or provisional patchcords on the DWDM nodes and the Cisco 7600 series routers, you can create 
an OCH trail circuit from one Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router to 
another Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router passing through an MSTP 
network. The endpoints (source and destination) of the OCH trail circuit must be Cisco CRS-1, 
Cisco ASR 9000 series, or Cisco 7600 series routers. CTC does not allow mixed nodes (Cisco CRS-1, 
Cisco ASR 9000 series, or Cisco 7600 series router to DWDM node) for OCH trail circuits. 

As part of OCH trail circuit creation, you must also define the following optical transport network (OTN) 
line parameters must be defined on both endpoints of the circuit:

• ITU-T G.709 

Note ITU-T G.709 OPU-1E and OPU-2E standards are supported on Cisco 7600 series routers.

• Forward error correction (FEC)

• Signal fail bit error rate (SF BER)

• Signal degrade bit error rate (SD BER). The range of SD BER values supported for Cisco 7600 
series router is from 5 to 9.
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22.12.4   Cisco CRS-1, Cisco ASR 9000 Series, or Cisco 7600 Series Router Management from CTC
After you define the source and destination nodes for the OCH trail circuit, CTC evaluates the circuit for 
a valid route between the two endpoints. If a valid route exists, CTC creates the required connections on 
all the impacted nodes.

22.12.4 Cisco CRS-1, Cisco ASR 9000 Series, or Cisco 7600 Series Router 
Management from CTC

After you have provisioned LMP on the Cisco CRS-1 or Cisco ASR 9000 series router and the DWDM 
node, the Cisco CRS-1 or Cisco ASR 9000 series router gets displayed in the CTC network view. In case 
of Cisco 7600 series routers, you must be manually add the node using the Add Node option in the CTC 
network view and then provision virtual links (provisionable patchcords) on the Cisco 7600 series router 
and the DWDM node.

You can view active alarms, performance monitoring (PM) parameters, and the software version of the 
Cisco CRS-1 or Cisco ASR 9000 series router from CTC. To view PM parameters and active alarms for 
a specific PLIM port, right-click the Cisco CRS-1, or Cisco ASR 9000 series router in CTC network 
view and choose Show Router Port Status > rack/slot/module/port (Figure 22-37). 

Performance monitoring (PM) parameters for Cisco 7600 series router cannot be viewed in CTC. To 
view active alarms for Cisco 7600 series, right-click the Cisco 7600 series router in CTC network view 
and choose Show Router Port Status > rack/slot/module/port.

Figure 22-37 Cisco CRS-1 Router PM Parameters

To view all the active alarms for Cisco CRS-1 or Cisco ASR 9000 series router, right-click the Cisco 
CRS-1 or Cisco ASR 9000 series router in CTC network view and choose Show Active Alarms.
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22.13   Photonic Path Trace
Note The Loss of Signal (LOS) alarm is not reported as critical for the Cisco CRS-1, Cisco ASR 9000 series, 
or Cisco 7600 router, whereas, it is reported as critical for the ONS 15454 node. To avoid this 
inconsistency, you can use Cisco Craft Works Interface (CWI) to manually change the severity of the 
LOS alarm of the Cisco CRS-1, Cisco ASR 9000 series, or Cisco 7600 series router.

To view the software version, click the Maintenance > Software tabs in the CTC network view. The 
working software version for each node is listed in the Working Version column. 

22.13 Photonic Path Trace
Photonic Path Trace (PPT) is a protocol that validates an optical path in an ONS 15454 MSTP network. 

PPT performs evidence-based path validation and identifies nodes in case of provisioning failure. PPT 
uses the power levels on each port to validate the path. For every node in the optical path, PPT reports 
the power levels against the threshold values in the form of a histogram. The histogram is displayed in 
the Photonic Path Trace tab of the Edit Circuit window in CTC. For each node, a set of power values 
collected from all the traversed ports is displayed in the histogram (Figure 22-38).

Figure 22-38 Photonic Path Trace

Note An OCHNC or OCH trail circuit must exist on the optical path on which PPT is started.
22-64
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 22      Manage Network Connectivity
22.14   Shared Risk Link Group
For information on how to start PPT on an optical path, see the “Turn Up a Network” chapter.

22.14 Shared Risk Link Group
SRLG is a unique 32 bit number that can be assigned to a link or DWDM node. This number can be used 
as an identifier of a link or a group of resources that may fail. A set of links constitute a SRLG if they 
share a resource (for example, a common fiber) whose failure causes the other links of the group to fail 
too. Therefore, the links in the group have a shared risk. A link can belong to multiple SRLGs. SRLG 
information is an unordered list of SRLGs that the link belongs to that is used by the router layer for 
making routing decisions. For example, if a router traverses through a diverse path, the path computation 
ensures that routing does not go through links sharing the same SRLG.

There are two types of SRLGs, unique and additional. Every link or DWDM node must be assigned a 
unique SRLG attribute. Additional SRLGs for DWDM nodes or links are optional and can be defined in 
CTC. The additional SRLGs for a link compute the additional risks associated with the link. A list of 
additional SRLGs for a link can be defined in the Additional Span SRLG information attribute in CTC. 
This list can contain up to 20 SRLGs.

When the SRLG value of a DWDM node or link is changed, the SRLG attributes are updated for all the 
relevant router ports. When a new router-based OCH trail is created, the SRLG information of the 
DWDM nodes and links that are part of the newly created circuit is automatically communicated to the 
source and destination router. SRLG information can also be synchronized when the SRLG values on 
the router ports differ from the SRLG values on the DWDM nodes. The SRLG information can be viewed 
as consolidated or detailed reports in CTC. For more information about provisioning SRLGs on DWDM 
nodes and links, refer to the “Turn Up a Network” chapter.

Note SRLG is not supported on Cisco 7600 nodes.

22.15 Proactive Protection Regen
When an optical signal degrades in a DWDM network, the downstream router is unaware of it. When the 
FEC limit is reached, there is traffic interruption with significant packet loss and an LOF alarm is raised. 
The LOF alarm triggers a Fast Reroute (FRR) mechanism in the router layer that switches traffic to a 
backup path.

The Proactive Protection Regen feature achieves a hitless switchover before the traffic is interrupted by 
triggering an FRR to backup paths before the LOF alarm is raised.

When the BER of the optical signal between the upstream router and the ONS node exceeds the trigger 
threshold value for the duration set as the trigger window, a PPR-FDI alarm is generated by the ONS 
node. The PPR-FDI alarm is sent to the downstream router which in turn triggers the switchover to the 
backup path. The downstream router then sends the PPR-BDI alarm to the upstream router to switch to 
the backup path.

The Proactive Protection Regen feature can be enabled on the OTU2_XP card ports when the card is used 
as a regenerator in Standard Regen or Enhanced FEC mode. This feature can also be configured during 
creation of OCH trail circuits between two Cisco CRS-1 routers. 

For more information about configuring the Proactive Protection Regen feature on OTU2_XP cards and 
OCH trails in CTC, refer to the “Provision Transponder and Muxponder Cards” chapter.
22-65
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Chapter 22      Manage Network Connectivity
22.15   Proactive Protection Regen
Note Proactive protection regen is not supported on Cisco 7600 series nodes.

The Proactive Protection Regen feature can also be enabled on the following cards:

• AR_MXP (high-rate RGN_10G card mode)

• AR_XP (high-rate RGN_10G card mode)

• AR_XPE (high-rate RGN_10G card mode)

• 100G-LC-C (TXP-100G and RGN-100G modes)

Note The 100G-LC-C card is configured in the TXP-100G mode when it is connected to the ASR 
9000 series router that supports 100GE payloads on its CFP pluggable. The 100G-LC-C card 
is configured in the RGN-100G mode when it connected to the Cisco CRS- 3 router using 
the 100G DWDM PLIM that supports OTU4 interfaces.

For more information about configuring the Proactive Protection Regen feature on AR_MXP, AR_XP, 
AR_XPE, and 100G-LC-C cards in CTC, refer to the “Provision Transponder and Muxponder Cards” 
chapter.
22-66
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Cisco ON
78-20702-02
C H A P T E R 23

Upgrade, Add, and Remove Cards and Nodes

The information in this chapter is in a new location. See Upgrade, Add, and Remove Cards and Nodes 
for procedures to add and remove dense wavelength division multiplexing (DWDM) cards and nodes.
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Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15454, including database backup and 
restoration, removing and replacing cards, viewing the ONS 15454 audit trail, and hardware 
maintenance procedures such as cleaning fibers, changing the fan tray filter, and other maintenance 
procedures.

Note The procedures and tasks described in this chapter for the Cisco ONS 15454 platform is applicable to 
the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, unless noted otherwise. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the 
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card. 

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary for general 
troubleshooting information and alarm or error descriptions. 

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-G103 Back Up the Database, page 24-2—Complete as needed.

2. NTP-G104 Restore the Database, page 24-3—Complete as needed.

3. NTP-G105 Restore the Node to Factory Configuration, page 24-4—Complete as needed to clear the 
database and upload a blank database and the latest software.

4. NTP-G273 Change the System Mode, page 24-9—Complete as needed to change the 
Cisco ONS 15454 M2 or ONS 15454 M6 node software from ANSI to ETSI or vice-versa.

5. NTP-G133 View and Manage OSI Information, page 24-10—Complete as needed.

6. NTP-G106 Reset Cards Using CTC, page 24-13—Complete as needed to reset the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and the dense wavelength division multiplexing 
(DWDM) cards.

7. NTP-G108 Viewing the Audit Trail Records, page 24-16—Complete as needed.
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8. NTP-G109 Off-Load the Audit Trail Record, page 24-17—Complete as needed.

9. NTP-G110 Off-Load the Diagnostics File, page 24-18—Complete as needed. 

10. NTP-G135 Edit Network Element Defaults, page 24-19—Complete as needed to edit the 
factory-configured (default) network element (NE) settings for the Cisco ONS 15454.

11. NTP-G136 Import Network Element Defaults, page 24-20—Complete as needed to import the 
factory-configured (default) NE settings for the Cisco ONS 15454.

12. NTP-G137 Export Network Element Defaults, page 24-21—Complete as needed to export the 
factory-configured (default) NE settings for the Cisco ONS 15454.

13. NTP-G166 View the Facilities, page 24-22—Complete as needed to view all facilities for the Cisco 
ONS 15454.

14. NTP-G119 Power Down the Node, page 24-22—Complete as needed to power down the node.

NTP-G103 Back Up the Database

Step 1 Complete the DLP-G46 Log into CTC task at the node you want to back up. If you are already logged 
in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Database tabs.

Step 3 Click Backup.

Step 4 Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name 
with the DB file extension; for example, database.db.

Step 5 Click Save.

Step 6 Click OK in the confirmation dialog box.

Stop. You have completed this procedure.

Purpose This procedure stores a backup version of the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE (software) database on 
the workstation running Cisco Transport Controller (CTC) or on a 
network server.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required. Cisco recommends performing a database backup at 
approximately weekly intervals and prior to and after configuration 
changes.

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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NTP-G104 Restore the Database

Note You must back up and restore the database for each node on a circuit path in order to maintain a complete 
circuit.

Note The following parameters are restored only when the  Complete Database (System and Provisioning) 
checkbox is checked:  node name, IP address, subnet mask and gateway, and IIOP port. If you change 
the node name and then restore a backed up database on this node, the circuits automatically  map to the 
newly renamed node. It is recommended to keep a record of the old and new node names.

Caution If you are restoring the database on multiple nodes, wait approximately one minute after the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card reboot has completed on each node before 
proceeding to the next node.

Caution TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards can be used in single IP address (repeater) and dual IP 
address (secure) mode. The secure mode has advanced features that affect database restore. A database 
from a secure node cannot be loaded on an unsecure repeater node. A repeater mode database can be 
loaded onto a secure node but the database will follow the node characteristics (that is, it will become 
secure). A secure database cannot be loaded onto a TCC2; only TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
cards support secure mode. For more information about the dual IP secure mode, see the “NTP-G26 Set 
Up CTC Network Access” procedure on page 14-17. Also refer chapter, “Chapter 22, “Manage Network 
Connectivity.”

Step 1 Complete the DLP-G46 Log into CTC task at the node where you are restoring the database. If you are 
already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab. Verify that 
no optical channel network connection (OCHNC) circuits have a PARTIAL_OOS state. If so, investigate 
and resolve the partial state before continuing.

Step 3 Complete the DLP-G157 Disable Automatic Power Control task 

Step 4 In multishelf view (multishelf mode) or in node view (single-shelf mode), click the Maintenance > 
Database tabs.

Step 5 Click Restore.

Step 6 Locate the database file stored on the workstation hard drive or on network storage. 

Purpose This procedure restores the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card software database, 
either partially or completely.

Tools/Equipment None

Prerequisite Procedures NTP-G103 Back Up the Database, page 24-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note To clear all existing provisioning, locate and upload the database found on the latest ONS 15454 
software CD.

Step 7 Click the database file to highlight it. 

Step 8 Click Open. The DB Restore dialog box appears. 

Caution Opening a restore file from another node or from an earlier backup might affect traffic on the login node.

Step 9 If you need a complete database restore, check the Complete database (System and Provisioning) 
checkbox. Continue with Step 11.

Note Complete database restore may be used only on a node that is removed from the network, and does not 
carry live provisioning traffic. This operation needs to be done by a live operator onsite, and must not 
use a remote connection.

Step 10 If you need to restore only the provisioning database (partial restore), do not check the Complete 
database (System and Provisioning) checkbox.

Step 11 Click Ok.

The Restore Database dialog box monitors the file transfer.

Step 12 Wait for the file to complete the transfer to the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

Step 13 Click OK when the “Lost connection to node, changing to Network View” dialog box appears. Wait for 
the node to reconnect.

Step 14 Complete the DLP-G158 Enable Automatic Power Control task.

Stop. You have completed this procedure.

Note During the database restore process, GMPLS circuits provisioned after the database was backed up may 
go into the partial state. When this occurs, delete and recreate the GMPLS circuits to revert to the 
discovered state.

NTP-G105 Restore the Node to Factory Configuration

Purpose This procedure reinitializes the Cisco ONS 15454, ONS 15454 M2,and 
ONS 15454 M6 using the CTC reinitialization tool. Reinitialization 
uploads a new software package to the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, clears the node 
database, and restores the factory default parameters.

Tools/Equipment ONS 15454 System Software CD, Version 9.2

JRE 1.6 is recommended to log into the node after reinitialization is 
complete. The reinitialization tool can run on JRE 1.3.1_02, JRE 1.4.2, 
or JRE 1.6. 
24-4
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_manage_the_node.html#task_6E2106B44DE5492BA96792EC09B492DD


 

Chapter 24      Maintain the Node
  Before You Begin
Caution Cisco strongly recommends that you keep different node databases in separate folders. This is because 
the reinitialization tool chooses the first product-specific software package in the specified directory if 
you use the Search Path field instead of the Package and Database fields. You might accidentally copy 
an incorrect database if multiple databases are kept in the specified directory.

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution Cisco recommends that you save the node database to safe location if you will not be restoring the node 
using the database provided on the software CD.

Note The following parameters are not backed up and restored when you delete the database and restore the 
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node 
name and then restore a backed up database with a different node name, the circuits map to the new 
renamed node. Cisco recommends keeping a record of the old and new node names.

Note A node will remain locked in secure mode even if it is restored with the factory database. A node locked 
in secure mode can only be unlocked by Cisco Technical Support.

Step 1 If you need to install or replace one or more TCC2/TCC2P/TCC3 cards, see the “DLP-G33 Install the 
TCC2, TCC2P, or TCC3 Card” task on page 3-36. If you need to install one or more 
TNC/TNCE/TSC/TSCE cards, see the “DLP-G604 Install the TNC, TNCE, TSC, or TSCE Card” task 
on page 3-43.

Step 2 If you are using Microsoft Windows, complete the “DLP-G248 Use the Reinitialization Tool to Clear the 
Database and Upload Software (Windows)” task on page 24-6.

Step 3 If you are using UNIX, complete the “DLP-G249 Use the Reinitialization Tool to Clear the Database 
and Upload Software (UNIX)” task on page 24-8.

Stop. You have completed this procedure.

Prerequisite Procedures NTP-G103 Back Up the Database, page 24-2

NTP-G17 Set Up Computer for CTC

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload 
Software (Windows)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Note The ONS 14545 Software CD is if the Reinit.jar file, the CISCO 15454 package file, and the NE 
default file are not stored on your computer.

Note A node will remain locked in secure mode after the node’s database is deleted, even if it is 
restored with the factory database. A node locked in secure mode can only be unlocked by Cisco 
Technical Support.

Step 1 Insert the ONS 15454 System Software CD, Version 9.2, into the computer CD-ROM drive. If the CTC 
Installation Wizard appears, click Cancel.

Step 2 From the Windows Start menu, choose Run. In the Run dialog box, click Browse and navigate to the 
CISCO15454 or CISCO15454SDH folder on the software CD.

Step 3 In the Browse dialog box Files of Type field, choose All Files. 

Step 4 Choose the RE-INIT.jar file and click Open. The NE Re-Initialization window appears.

Step 5 Complete the following fields: 

Purpose This task reinitializes the Cisco ONS 15454, ONS 15454 M2, and ONS 
15454 M6 using the CTC reinitialization tool on a Windows computer. 
Reinitialization uploads a new software package to the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, clears the node 
database, and restores the factory default parameters.

Tools/Equipment ONS 15454 System Software CD, Version 9.2

JRE 1.6 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02, JRE 1.4.2, or JRE 1.6. 

Prerequisite Procedures NTP-G103 Back Up the Database, page 24-2

NTP-G17 Set Up Computer for CTC

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454

Required/As Needed As needed to clear the existing database from the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and restore the 
node default settings.

Onsite/Remote Onsite

Security Level Superuser only
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• GNE IP—If the node you are reinitializing is accessed through another node configured as a gateway 
network element (GNE), enter the GNE IP address. If you have a direct connection to the node, leave 
this field blank.

• Node IP—Enter the node name or IP address of the node that you are reinitializing.

• User ID—Enter the user ID needed to access the node. 

• Password—Enter the password for the user ID.

• Upload Package—Check this box to send the software package file to the node. If unchecked, the 
software stored on the node is not modified.

• Force Upload—Check this box to send the software package file to the node even if the node is 
running the same software version. If unchecked, reinitialization will not send the software package 
if the node is already running the same version.

• Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the 
installed version) or revert to the uploaded software (if the software is earlier than the installed 
version) as soon as the software file is uploaded. If unchecked, the software is not activated or 
reverted after the upload, allowing you to initiate the functions later from the node view 
Maintenance > Software tab.

• Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC 
database restore operation.) If unchecked, the node database is not modified. 

• Confirm—Check this box if you want a warning message displayed before any operation is 
performed. If unchecked, reinitialization does not display a warning message. 

• Search Path—Enter the path to the CISCO15454 folder on the CD drive.

Step 6 Click Go. 

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse 
the upload process after you click Yes.

Step 7 Review the information in the Confirm NE Re-Initialization dialog box, then click Yes to start the 
reinitialization. 

The reinitialization begins. After the software is downloaded and activated, and the database is uploaded 
to the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, “Complete” appears in the status bar, and the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards reboot. Wait a few minutes for the reboot to 
complete.

Step 8 After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task.

Step 9 Complete the NTP-G24 Set Up Name, Date, Time, and Contact Information, page 14-13 and the 
NTP-G26 Set Up CTC Network Access, page 14-17.

Step 10 Return to your originating procedure (NTP).
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DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload 
Software (UNIX)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Note A node will remain locked in secure mode after the node’s database is deleted, even if it is restored with 
the factory database. A node locked in secure mode can only be unlocked by Cisco Technical Support.

Step 1 Insert the system software CD containing the reinitialization tool, software, and defaults database into 
the computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2 To find the recovery tool file, go to the CISCO15454 directory on the CD (usually 
/cdrom/cdrom0/CISCO15454 or /cdrom/cdrom0/CISCO15454SDH).

Step 3 If you are using a file explorer, double-click the RE-INIT.jar file. If you are working with a command 
line, run java -jar RE-INIT.jar. The NE Re-Initialization window appears.

Step 4 Complete the following fields: 

• GNE IP—If the node you are reinitializing is accessed through another node configured as a GNE, 
enter the GNE IP address. If you have a direct connection to the node, leave this field blank.

• Node IP—Enter the node name or IP address of the node that you are reinitializing.

• User ID—Enter the user ID needed to access the node. 

• Password—Enter the password for the user ID.

Purpose This task reinitializes the Cisco ONS 15454, ONS 15454 M2, and ONS 
15454 M6 using the CTC reinitialization tool on a UNIX computer. 
Reinitialization uploads a new software package to the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, clears the node 
database, and restores the factory default parameters.

Tools/Equipment ONS 15454 SONET System Software CD, Version 9.2

JRE 1.6 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02, JRE 1.4.2, or JRE 1.6.

Prerequisite Procedures NTP-G103 Back Up the Database, page 24-2

NTP-G17 Set Up Computer for CTC

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454

Required/As Needed As needed to clear the existing database from the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and restore the 
node default settings.

Onsite/Remote Onsite

Security Level Superuser only
24-8
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_ABD391FBD14D4CC7998587257BA07049
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_49F9D46937AC42F6947CB8A44ADF7463
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_DF2FA096F9714B16A45A3F3486A7DD7D
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_DF2FA096F9714B16A45A3F3486A7DD7D


 

Chapter 24      Maintain the Node
DLP-  G249 Use the Reinitialization Tool to Clear the Database and Upload Software (UNIX)
• Upload Package—Check this box to send the software package file to the node. If unchecked, the 
software stored on the node is not modified.

• Force Upload—Check this box to send the software package file to the node even if the node is 
running the same software version. If unchecked, reinitialization will not send the software package 
if the node is already running the same version. 

• Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the 
installed version) or revert to the uploaded software (if the software is earlier than the installed 
version) as soon as the software file is uploaded. If unchecked, the software is not activated or 
reverted after the upload, allowing you to initiate the functions later from the node view 
Maintenance > Software tab.

• Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC 
database restore operation.) If unchecked, the node database is not modified. 

• Confirm—Check this box if you want a warning message displayed before any operation is 
performed. If unchecked, reinitialization does not display a warning message. 

• Search Path—Enter the path to the CISCO15454 or CISCO15454SDH folder on the CD drive.

Step 5 Click Go. 

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse 
the upload process after you click Yes.

Step 6 Review the information in the Confirm NE Re-Initialization dialog box, then click Yes to start the 
reinitialization. 

The reinitialization begins. After the software is downloaded and activated and the database is uploaded 
to the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, “Complete” appears in the status bar and the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards will reboot. Wait a few minutes for the reboot to 
complete.

Step 7 After the reboot is complete, log into the node using the DLP-G46 Log into CTC task.

Step 8 Complete the NTP-G24 Set Up Name, Date, Time, and Contact Information, page 14-13 and the 
NTP-G26 Set Up CTC Network Access, page 14-17.

Step 9 Return to your originating procedure (NTP).

NTP-G273 Change the System Mode

Purpose This procedure changes the Cisco ONS 15454 M2 and ONS 15454 M6 
system mode from ANSI (SONET) to ETSI (SDH) or vice-versa.

This procedure applies to the ONS 15454 M2 chassis and ONS 15454 M6 
chassis in simplex mode and standalone mode.

Tools/Equipment PC or UNIX workstation.

Prerequisite Procedures • DLP-U546 Download the ONS 15454 Software

• DLP-U546 Download the ONS 15454 SDH Software

Required/As Needed As needed
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Step 1 (ONS 15454 M6 only) Ensure that the ONS 15454 M6 chassis is in simplex and standalone mode 
contains only one controller card (active TNC, TNCE, TSC, or TSCE card).

Step 2 Complete the “DLP-G46 Log into CTC” task. If you are already logged in, continue with Step 3.

Step 3 In the node view, click the Provisioning > General > General tabs. The System Mode field displays the 
system mode as ANSI or ETSI.

Step 4 Click Change System Mode to toggle the system mode between ANSI and ETSI. Changing the system 
mode erases all the provisioned data and the system will revert to the factory default settings.

Step 5 Click Yes. The node reboots after the system mode change is completed. This takes about 5 minutes.

Step 6 Exit CTC. Click File > Exit menu option to exit CTC.

Step 7 Verify that the system mode has changed:

a. Complete the “DLP-G46 Log into CTC” task on the ONS 15454 M2 or 15454 M6 chassis where you 
changed the system mode.

b. In the node view, click the Provisioning > General > General tabs. The System Mode field 
indicates if the system mode has changed.

Step 8 (ONS 15454 M6 only) Insert the standby controller card (TNC, TNCE, TSC, or TSCE card). This 
synchronizes the software from the active controller card to the standby controller card.

Stop. You have completed this procedure.

NTP-G133 View and Manage OSI Information

Note Additional information about the ONS 15454 implementation of OSI is provided in “Chapter 22, 
“Manage Network Connectivity.”

Step 1 Complete the “DLP-G46 Log into CTC” task. If you are already logged in, continue with Step 2.

Onsite/Remote Onsite

Security Level Provisioning or higher

Purpose This procedure allows you to view and manage Open Systems 
Interconnection (OSI) including the End System to Intermediate System 
(ES-IS) and Intermediate System to Intermediate System (IS-IS) routing 
information tables, the Target Identifier Address Resolution Protocol 
(TARP) data cache, and the manual area table.

Tools/Equipment None

Prerequisite Procedures NTP-G103 Back Up the Database, page 24-2

NTP-G17 Set Up Computer for CTC

NTP-G132 Provision OSI, page 14-36

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Perform any of the following tasks as needed:

• DLP-G298 View IS-IS Routing Information Base, page 24-11

• DLP-G299 View ES-IS Routing Information Base, page 24-12

• DLP-G300 Manage the TARP Data Cache, page 24-12

Stop. You have completed this procedure.

DLP-G298 View IS-IS Routing Information Base

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > OSI > 
IS-IS RIB tabs.

Step 2 View the following RIB information for Router 1:

• Subnet Type—Indicates the OSI subnetwork point of attachment type used to access the destination 
address. Subnet types include SDCC, LDCC, GCC, OSC, and LAN.

• Location—Indicates the OSI subnetwork point of attachment. For data communications channel 
(DCC) subnets, the slot and port are displayed. LAN subnets are shown as LAN. 

• Destination Address—The destination Network Service Access Point (NSAP) of the IS.

• MAC Address—For destination NEs that are accessed by LAN subnets, the NE’s MAC address.

Step 3 If additional routers are enabled, you can view their RIBs by choosing the router number in the Router 
field and clicking Refresh.

Step 4 Return to your originating procedure (NTP).

Purpose This task allows you to view the IS-IS protocol routing information base 
(RIB). IS-IS is an OSI routing protocol that floods the network with 
information about NEs on the network. Each NE uses the information to 
build a complete and consistent picture of a network topology. The IS-IS 
RIB shows the network view from the perspective of the IS node.

Tools/Equipment None

Prerequisite procedures “DLP-G46 Log into CTC” 

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G299 View ES-IS Routing Information Base

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > OSI > 
ES-IS RIB tabs.

Step 2 View the following RIB information for Router 1:

• Subnet Type—Indicates the OSI subnetwork point of attachment type used to access the destination 
address. Subnet types include SDCC, LDCC, GCC, OSC, and LAN.

• Location—Indicates the subnet interface. For DCC subnets, the slot and port are displayed. LAN 
subnets are shown as LAN. 

• Destination Address—The destination IS NSAP.

• MAC Address—For destination NEs that are accessed by LAN subnets, the NE’s MAC address.

Step 3 If additional routers are enabled, you can view their RIBs by choosing the router number in the Router 
field and clicking Refresh.

Step 4 Return to your originating procedure (NTP).

DLP-G300 Manage the TARP Data Cache

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > OSI > 
TDC tabs.

Step 2 View the following TDC information:

Purpose This task allows you to view the ES-IS protocol RIB. ES-IS is an OSI 
protocol that defines how end systems (hosts) and intermediate systems 
(routers) learn about each other. For ESs, the ES-IS RIB shows the network 
view from the perspective of the ES node. For ISs, the ES-IS RIB shows the 
network view from the perspective of the IS node.

Tools/Equipment None

Prerequisite procedures “DLP-G46 Log into CTC” 

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task allows you to view and manage the TARP data cache (TDC). The 
TDC facilitates TARP processing by storing a list of TID to NSAP 
mappings.

Tools/Equipment None

Prerequisite procedures “DLP-G46 Log into CTC” task

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• TID—The target identifier of the originating NE. For ONS 15454s, the TID is the name entered in 
the Node Name/TID field on the Provisioning > General tab.

• NSAP/NET—The NSAP or Network Element Title (NET) of the originating NE. 

• Type—Indicates how the TDC entry was created:

– Dynamic—The entry was created through the TARP propagation process.

– Static—The entry was manually created and is a static entry.

Step 3 If you want to query the network for an NSAP that matches a TID, complete the following steps. 
Otherwise, continue with Step 4.

Note The TID to NSAP function is not available if the TDC is not enabled on the Provisioning > OSI > 
TARP subtab.

a. Click the TID to NSAP button. 

b. In the TID to NSAP dialog box, enter the TID you want to map to an NSAP. 

c. Click OK, then click OK in the information message box.

d. On the TDC tab, click Refresh.

If TARP finds the TID in its TDC, it returns the matching NSAP. If not, TARP sends protocol data 
units (PDUs) across the network. Replies will return to the TDC later, and a check TDC later 
message is displayed. 

Step 4 If you want to delete all the dynamically generated TDC entries, click the Flush Dynamic Entries 
button. If not, continue with Step 5.

Step 5 Return to your originating procedure (NTP).

NTP-G106 Reset Cards Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you are performing the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE reset. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G250 Reset the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card” 
task on page 24-14.

Step 3 As needed, complete the “DLP-G251 Reset DWDM Cards Using CTC” task on page 24-15.

Purpose This procedure resets the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE 
and DWDM cards using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2, TCC2P, or TCC3 Card, page 3-36

DLP-G604 Install the TNC, TNCE, TSC, or TSCE Card, page 3-43

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
24-13
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_9F67D8A770B74291A7DF74138895B4C4


 

Chapter 24      Maintain the Node
DLP-  G250 Reset the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card
Stop. You have completed this procedure. 

DLP-G250 Reset the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note Before you reset the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card, you should wait at least 60 
seconds after the last provisioning change you made to avoid losing any changes to the database.

Note The ONS 15454 M2 chassis do not have a redundant controller card.

Note (On ONS 15454 shelf) When a software reset is performed on an active TCC2/TCC2P/TCC3, the AIC-I 
card goes through an initialization process and also resets. The AIC-I card reset is normal and happens 
each time an active TCC2/TCC2P/TCC3 card goes through a software-initiated reset.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. 

a. Verify that the alarm filter is not on. See the DLP-G128 Disable Alarm Filtering task as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Step 2 In node view, right-click the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card to reveal a shortcut 
menu.

Step 3 For TCC2/TCC2P/TCC3 cards, click Reset Card to initiate a soft reset. 

For TNC/TNCE/TSC/TSCE cards, click Soft-Reset Card to initiate a soft reset.

Purpose This task resets the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card 
and switches the node to the redundant 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2, TCC2P, or TCC3 Card, page 3-36

DLP-G604 Install the TNC, TNCE, TSC, or TSCE Card, page 3-43

“DLP-G46 Log into CTC” 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note To initiate a hard reset on the TNC/TNCE/TSC/TSCE card, right-click the card and click Hard-Reset 
Card when the card is in OOS-MT state. See Equipment Inventory for more information.

Step 4 Click Yes when the confirmation dialog box appears.

Step 5 Click Close when the “Lost connection to node, changing to Network View” dialog box appears.

Step 6 Return to node view (single-shelf mode) or multishelf view (multishelf mode) and confirm that the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card LED is amber (standby).

Step 7 Return to your originating procedure (NTP).

DLP-G251 Reset DWDM Cards Using CTC

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note ONS 15454 cards normally do not need to be reset. However, you might occasionally need to reset a card 
for testing or as an initial trouble-clearing step. For additional information, refer to the Cisco ONS 15454 
DWDM Troubleshooting Guide.

Note A software reset of the TXP and MXP card leads to removal of PM data from the PM counters. As a 
result, the PM counters do not display any PM data.

Step 1 If you will switch an active TXP or MXP card that is in a Y-cable protection group, complete the 
DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch task. If not, continue with Step 2.

Purpose This task resets the OSCM, OSC-CSM, 32MUX-O, 40-MUX-C, 
32DMX-O, 32DMX, 40-DMX-C, 40-DMX-CE, 32WSS, 40-WSS-C, 
40-WSS-CE, 40-SMR1-C, 40-SMR2-C, TDC-CC, TDC-FC, OPT-BST, 
OPT-PRE, OPT-AMP-17-C, 40-WXC-C, 80-WXC-C, AD-xC.xx.x, 
AD-xB.xx.x, transponder (TXP), muxponder (MXP), and ADM-10G 
cards using CTC.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 14-64

NTP-G179 Install the TXP, MXP, AR_MXP, AR_XP, AR_XPE, 
100G-LC-C, 10x10G-LC, CFP-LC, ADM-10G, and OTU2_XP Cards, 
page 14-69

“DLP-G46 Log into CTC” task

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 2 Right-click the card that you want to reset to reveal a shortcut menu.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

The card LED on the ONS 15454 shelf graphic will go through the following sequence: Fail (white 
LED), Ldg (white LED), and Act (green LED). The reset should complete within 1 to 2 minutes.

Step 5 If you performed a Y-cable protection group switch in Step 1, complete the DLP-G180 Clear a Manual 
or Force Y-Cable or Splitter Protection Switch task. If not, continue with Step 6.

Step 6 Return to your originating procedure (NTP).

NTP-G108 Viewing the Audit Trail Records

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view the audit trail log. If 
you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > Audit 
tabs.

Step 3 Click Retrieve.

A window containing the most recent audit trail records appears.

A definition of each column in the audit trail log is listed in Table 24-1.

Left-click the column headings to display the list in ascending-to-descending or 
descending-to-ascending order. 

Purpose This procedure explains how to view audit trail records. Audit trail records 
are useful for maintaining security, recovering lost transactions, and 
enforcing accountability. Accountability refers to tracing user activities; 
that is, associating a process or action with a specific user.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 24-1 Audit Trail Column Definitions

Column Definition

Date Date when the action occurred in the format MM/dd/yy HH:mm:ss

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (that is, whether or not the action was executed)

Operation Action that was taken
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Right-click the column heading to display the following options:

• Reset Sorting—Resets the column to the default setting.

• Hide Column—Hides the column from view.

• Sort Column—Sorts the table by the column’s values.

• Sort Column (incremental)—Sorts the table incrementally by multiple columns.

• Reset Columns Order/Visibility—Displays all hidden columns.

• Row Count—Provides a numerical count of log entries.

Shift-click the column heading for an incremental sort of the list.

Stop. You have completed this procedure.

NTP-G109 Off-Load the Audit Trail Record

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to off-load the audit trail log. 
If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click, click the Maintenance > 
Audit tabs.

Step 3 Click Retrieve.

Step 4 Click Archive.

Step 5 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7 Click Save. Click OK.

The 640 entries are saved in this file. The next entries continue with the next number in the sequence, 
rather than starting over.

Purpose This procedure describes how to off-load up to 640 audit trail log entries 
in a local or network drive file to maintain a record of actions performed 
for the node. If the audit trail log is not off-loaded, the oldest entries are 
overwritten after the log reaches capacity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Archiving does not delete entries from the CTC audit trail log. However, entries can be 
self-deleted by the system after the log maximum is reached. If you archived the entries, you 
cannot reimport the log file back into CTC and will have to view the log in a different 
application.

Stop. You have completed this procedure.

NTP-G110 Off-Load the Diagnostics File

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to off-load the diagnostics file. 
If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Diagnostic tabs.

Step 3 Click Node Diagnostic Logs. The Node Diagnostics dialog box is displayed.

Step 4 Click OK to continue.

Step 5 In the Select a Filename for the Node Diagnostics Zip Archive dialog box, navigate to the directory 
(local or network) where you want to save the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is a compressed file (.zip) that can be 
unzipped and read by Cisco Technical Support.

Step 7 Click Save.

The status window shows a progress bar indicating the percentage of the file being saved.

Step 8 Click OK.

Stop. You have completed this procedure.

Purpose This procedure describes how to off-load a diagnostic file. The diagnostic 
file contains a set of debug commands that were run on a node and their 
results. This file is useful to the Cisco Technical Assistance Center (TAC) 
when troubleshooting problems with the node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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NTP-G135 Edit Network Element Defaults

Note For a list of NE defaults, see the “Network Element Defaults document.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to edit NE defaults. 

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults tabs. Wait for the Defaults selector frame to load the defaults. This could take several minutes.

Step 3 Under Defaults Selector, choose either a card (if editing card-level defaults) or NODE (if editing 
node-level defaults). Clicking on the node name (at the top of the Defaults Selector column) lists all 
available NE defaults (both node- and card-level) under Default Name. 

Step 4 Locate a default that you want to change under Default Name. 

Step 5 Click in the Default Value column for the default property that you are changing and either choose a 
value from the drop-down list (when available), or type in the desired new value.

Note If you click Reset before you click Apply, all values will return to their original settings. 

Step 6 Click Apply (click in the Default Name column to activate the Apply button if it is unavailable). You 
can modify multiple default values before applying the changes. 

A pencil icon will appear next to any default value that will be changed as a result of editing the defaults 
file. 

Step 7 If you are modifying node-level defaults, a dialog box appears telling you that defaults were successfully 
applied to the node. Click Yes.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, see 
Chapter 21, “Change DWDM Card Settings.” To change settings for transponder or muxponder 
cards see Chapter 11, “Provision Transponder and Muxponder Cards.”

Purpose This procedure edits the factory-configured NE defaults using the NE 
Defaults editor. The new defaults can be applied to the node where they are 
edited, or exported to a file to be imported for use on other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G136 Import Network Element Defaults

Note For a list of NE defaults, refer to the “Network Element Defaults” document.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to import NE defaults. 

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults tabs. 

Step 3 Click Import.

Step 4 If the correct file name and location of the desired file do not appear in the Import Defaults from File 
dialog box, click Browse and browse to the file that you are importing.

Step 5 When the correct file name and location appear in the dialog box, click OK. If you are importing the 
factory defaults, the correct file name is 15454-defaults.txt for ANSI shelves and 15454SDH-defaults.txt 
for ETSI shelves. 

A pencil icon will appear next to any default value that will be changed as a result of importing the new 
defaults file. 

Step 6 Click Apply.

Step 7 If the imported file fails to pass all edits, the problem field shows the first encountered problem default 
value that must be fixed. Change the problem default value and click Apply. Repeat until the imported 
file passes all edits successfully.

Step 8 If you are modifying node-level defaults, a dialog box appears telling you that defaults were successfully 
applied to the node. Click Yes.

Step 9 If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Purpose This procedure imports the NE defaults using the NE Defaults editor. The 
defaults can either be imported from the CTC software CD (factory 
defaults) or from a customized file exported and saved from a node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, 
seeChapter 21, “Change DWDM Card Settings.” To change settings for transponder or 
muxponder cards, see Chapter 11, “Provision Transponder and Muxponder Cards.”

Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G137 Export Network Element Defaults

Note The defaults currently displayed are exported whether or not they have been applied to the current node.

Note The NE defaults can also be exported from the File > Export menu. These exported defaults are for 
reference only and cannot be imported.

Note For a list of NE defaults, refer to the “Network Element Defaults” document.

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to export NE defaults. 

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults editor tabs. 

Step 3 Click Export.

Step 4 If the location where you want to export the file does not appear in the Export Defaults to File dialog 
box, click Browse and browse to the location. 

Step 5 Change the file name to something that is easy to remember (the file name has no extension). 

Purpose This procedure exports the NE defaults using the NE Defaults editor. The 
exported defaults can be imported to other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Step 6 Click OK.

Stop. You have completed this procedure.

NTP-G166 View the Facilities

Step 1 Complete the “DLP-G46 Log into CTC” task at the node where you want to view DWDM facilities.

Step 2 In node view (single-shelf mode), shelf view (multishelf mode), or multishelf view (multishelf mode), 
click the Maintenance > DWDM> All Facilities tabs. 

• Marked—Displays a check mark if you have designated the facility for logical grouping. To mark a 
facility to group it with others, go to Step 3.

• Location—Displays the slot number, slot type, port number, and port type of the facility.

• Admin State—Displays the administrative state of the facility.

• Service State—Displays the service state of the facility.

• Power—Displays the power level of the facility.

Step 3 To mark certain facilities to group during column sorting, click the desired row and click Mark. A check 
mark appears in the Marked column. Click the Marked column header to group all of the checked 
facilities in ascending order. Click the Marked header again to sort in descending order.

Step 4 To sort the facilities by the Location, Admin State, Service State, or Power columns in ascending order, 
click on the desired column header. Click the column header again to sort in descending order.

Stop. You have completed this procedure.

NTP-G119 Power Down the Node

Purpose This procedure displays DWDM facility information for all facilities in a 
node (single-shelf mode), shelf view (multishelf mode), or multishelf node 
(multishelf mode).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance and higher

Purpose This procedure stops all node activity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Caution The following procedure is designed to minimize traffic outages when powering down nodes, but traffic 
will be lost if you delete and recreate circuits that passed through a working node.

Note Always use the supplied ESD wristband when working with the Cisco ONS 15454. Plug the wristband 
into the ESD jack located on the fan-tray assembly or on the lower right outside edge of the shelf on the 
NEBS 3 shelf assembly. To access the ESD plug on the NEBS 3 shelf assembly, open the front door of 
the Cisco ONS 15454. The front door is grounded to prevent electrical shock. For detailed instructions 
on how to wear the ESD wristband, see the Electrostatic Discharge and Grounding Guide for Cisco CPT 
and Cisco ONS Platforms.

Note The CTC views referenced in this procedure depend on the mode. For more information about CTC 
views, see CTC Operation, Information, and Shortcuts.

Step 1 Identify the node that you want to power down. If no cards are installed, go to Step 20. If cards are 
installed, log into the node. See the “DLP-G46 Log into CTC” task for instructions.

Step 2 Choose Go to Network View from the View menu. 

Step 3 Verify that the node is not connected to a network.

a. If the node is part of a Software R4.7 or later dense wavelength division multiplexing (DWDM) 
configuration, see the NTP-G130 Remove a DWDM Node and continue with Step 4.

b. If the node is not connected to a working network and the current configurations are no longer 
required, proceed to Step 4.

Note Before the power-down of a DWDM node, the fiber spans connected around it must be 
disconnected from the network. This is to prevent the accidental disconnection of 
wavelengths that pass through the shelf. A good indication that the shelf has been 
disconnected from the network is optical service channel (OSC) alarms, or no OSC channels 
provisioned.

Note Current configurations will be saved if Steps 4 to 20 are skipped.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab and verify 
that no circuits appear, then proceed to Step 5. If circuits appear, delete all the circuits that originate or 
terminate in the node. Complete the “DLP-G106 Delete Optical Channel Network Connections” section 
on page 17-50, the “DLP-G347 Delete Optical Channel Client Connections” section on page 17-26, or 
the “DLP-G112 Delete Overhead Circuits” section on page 17-95 as needed.

Note When deleting circuits from a node, make sure that the node is not connected to any network.
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Step 5 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Protection 
tabs and delete all protection groups:

a. Click the protection group that needs to be deleted and click Delete.

b. Click Yes.

Repeat until no protection groups appear.

Step 6 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Comm 
Channels tabs and delete all communications channel terminations:

a. Click the section data communications channel (SDCC), line data communications channel 
(LDCC), generic communications channel (GCC), link management protocol (LMP), provisionable 
(external) patchcords (PPC), or OSC termination that needs to be deleted and click Delete.

b. Click Yes.

Repeat until no SDCC, LDCC, GCC, or OSC terminations are present.

Step 7 Before deleting any installed DWDM cards, the optical sides and the optical patchcords must be deleted. 
In node view (single-shelf mode) or multishelf view (multishelf mode), click Provisioning > 
WDM-ANS > Optical Side tabs.

a. Select all the connections and click Delete.

b. Click Yes.

Repeat until no optical sides and the optical patchcords are present.

Step 8 In node view (single-shelf mode) or multishelf view (multishelf mode), click Provisioning > 
WDM-ANS > Internal Patchcords tabs.

a. Select all the connections and click Delete.

b. Click Yes.

Repeat until no internal patchcords are present.

Step 9 In node view (single-shelf mode) or multishelf view (multishelf mode), click Provisioning > 
WDM-ANS > Provisioning tabs and delete all the ANS parameters.

a. Select all the ANS parameters and click Remove. The Network Type parameter cannot be deleted.

b. Click Yes.

Step 10 In node view (single-shelf mode) or multishelf view (multishelf mode), click Provisioning > 
WDM-ANS > Passive Cards tabs, and delete all the passive cards.

a. Click the passive card you want to delete.

b. Click Delete, then click Yes.

Step 11 Repeat Step a and Step b for each installed passive card.

Step 12 For each installed channel-bearing card (AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x, where xx.x refers 
to the specific wavelengths), make sure all lines and bands are not in IS-NR (ANSI) or 
Unlocked-Enabled (ETSI) service state:

a. In card view, click the Provisioning > Optical Line > Parameters tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI), or 
Unlocked,automaticInservice (ETSI) is selected.

c. Click the Provisioning > Optical Chn > Parameters tabs.

d. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI), or 
Unlocked,automaticInservice (ETSI) is selected.
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Step 13 For each installed DWDM band-bearing card (AD-1B-xx.x and AD-4B-xx.x, where xx.x refers to the 
specific wavelengths), make sure all lines and bands are not in the IS-NR (ANSI) or Unlocked-Enabled 
(ETSI) service state:

a. In card view, click the Provisioning > Optical Line > Parameters tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI), or 
Unlocked,automaticInservice (ETSI) is selected.

c. Click the Provisioning > Optical Band > Parameters tabs.

d. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI), or 
Unlocked,automaticInservice (ETSI) is selected.

Step 14 For each installed transponder (TXP), muxponder (MXP), multiplexer, demultiplexer, amplifier, 
OSC-CSM, OSCM, wavelength switch, or single module ROADM card (32MUX-O, 32DMX-0, 
32DMX, 32WSS, 4MD-xx.x, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 80-WXC-C, 40-DMX-C, 
40-DMX-CE, 40-MUX-C, TDC-CC, TDC-FC, 40-SMR1-C, 40-SMR2-C, OPT-BST, OPT-PRE, 
TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, 40E-TXP-C, 40ME-TXP-C, 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, 40G-MXP-C, 40E-MXP-C, 
40ME-MXP-C, 100G-LC-C, 10x10G-LC, CFP-LC, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or 
ADM-10G), make sure all lines are not in the IS-NR (ANSI) or Unlocked-enabled (ETSI) service state:

a. In card view, click the appropriate tab depending on the card:

• For MXP_2.5G, MXP_2.5G_10G, TXP_MR_10G, TXP_MR_10E, click the Provisioning > 
Line > SONET tabs if the card was provisioned for a SONET payload, or the Provisioning > 
Line > SDH tabs if the card was provisioned for an SDH payload. 

• For TXP_MR_2.5G, TXPP_MR_2.5G, and MXPP_MR_2.5G cards, click the Provisioning > 
Line > SONET tabs.

• For MXP_2.5G_10E cards, click the Provisioning > Line > Trunk tabs.

• For MXP_MR_2.5G cards, click the Provisioning > Line > Client tabs.

• For ADM-10G, OTU2_XP, 40E-TXP-C, 40ME-TXP-C, 40G-MXP-C, 40E-MXP-C, 
40ME-MXP-C, 100G-LC-C, 10x10G-LC, and CFP-LC cards, click the Provisioning > Line > 
Ports tabs.

• For 32MUX-O, 32DMX-0, 32DMX, 32WSS, 40MUX, 40DMUX-C, TDC-CC, TDC-FC, 
OPT-BST, OPT-PRE cards, click the Provisioning > Optical Line > Parameters tabs.

• For 32DMX, 32DMX-O, 40-DMX-C, 40-MUX-C, 40-DMX-CE, 4MD cards, click the 
Provisioning > Optical Chn > Parameters tabs.

• For 40-WSS-C/40-WSS-CE cards, click the Provisioning > Optical Chn: 
Optical Connector x > Parameters tabs.

• For 40-WXC-C cards, click the Provisioning > WXC Line > Parameters tabs.

• For 40-DMX-C, 40-MUX-C, and 40-DMX-CE cards, click the Provisioning > Optical Line > 
Parameters tabs.

• For 4MD-xx.x cards, click the Provisioning > Optical Band > Parameters tabs.

• For GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards, click the Provisioning > Ether Ports 
> Ports tabs.

• For OPT-BST and OPT-PRE cards, click the Provisioning > Optical Ampli Line > Parameters 
tabs.

• For the 40-SMR1-C and 40-SMR2-C cards, click the Provisioning > Optical Line > 
Parameters tabs and Provisioning > Opt. Ampli. Line > Parameters tabs. 
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• For OSC-CSM and OSCM cards, click the Provisioning > Optical Line > Parameters tabs.

• For ADM_10G cards, click the Provisioning > Line > Ports tabs.

b. In the Admin State column for each line, make sure that the default state IS, AINS (ANSI) or 
Unlocked,automaticInservice (ETSI) is selected.

c. Repeat Steps a and b for each installed DWDM card.

Note Ports are put in service when circuits are provisioned, and put out of service when circuits are deleted. 
When circuits are deleted the Admin State displays as IS, AINS (ANSI) or Unlocked,automaticInservice 
(ETSI) and the Service State displays OOS-AU,AINS (ANSI) or Unlocked-disabled,automaticInService 
(ETSI).

Step 15 Remove all fiber connections to the cards.

Step 16 In node view (single-shelf mode) or shelf view (multishelf mode), right-click an installed card and click 
Delete.

Step 17 Click Yes.

Step 18 After you have deleted the card, open the card ejectors and remove it from the node. 

Step 19 Repeat Step 15 through Step 18 for each installed card.

Note You cannot delete a TCC2/TCC2P/TCC3 card in Cisco Transport Controller (CTC). Physically 
remove it after all the other cards have been deleted and removed.

Note (On 15454 M2 and 15454 M6) You cannot delete an active TNC/TNCE/TSC/TSCE card in Cisco 
Transport Controller (CTC). Physically remove it after all the other cards have been deleted and 
removed.

Step 20 Shut off the power from the power supply that feeds the node.

Step 21 Disconnect the node from its external fuse source.

Step 22 Store all of the cards that you removed and update inventory records according to local site practice.

Stop. You have completed this procedure.
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Security Reference

The information in this chapter is in a new location. See Security Reference for information related to 
Cisco ONS 15454 user IDs and security levels, user privileges and policies, audit trail, and RADIUS 
security.
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Timing Reference

The information in this chapter is in a new location. See Timing Reference for information about 
Cisco ONS 15454 users and node timing parameters, network timing, and Synchronization Status 
Messaging (SSM).
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SNMP

The information in this chapter is in a new location. See SNMP for information related to Simple 
Network Management Protocol (SNMP) implemented in the Cisco ONS 15454.
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CTC Enhancements, Operations, and Shortcuts

The information in this chapter is in a new location. See CTC Enhancements, Operations, and Shortcuts 
for information on Cisco Transport Controller (CTC) views, menus options, tool options, shortcuts, table 
display options, and shelf inventory data presented in CTC.
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Hardware Specifications

The information in this chapter is in a new location. See Hardware Specifications for information related 
to hardware and software specifications for the ONS 15454 ANSI and ETSI cards.
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Administrative and Service States

The information in this chapter is in a new location. See Administrative and Service States for an 
understanding of administrative and service states for Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) cards, optical payload ports, out-of-band optical service channel (OSC) ports, 
optical channel network connections (OCHNCs), and transponder/muxponder cards and ports.
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Configure GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Cards Using PCLI

The information in this chapter is in a new location. See Configure GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE Cards Using PCLI for information on how to provision GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards using Pseudo Command Line Interface (PCLI).
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Pseudo Command Line Interface Reference

The information in this chapter is in a new location. See Pseudo Command Line Interface Reference for 
information related to Pseudo-IOS command line interface (PCLI) for GE_XP, 10GE_XP, GE_XPE, and 
10GE_XPE cards.
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Fiber and Connector Losses in Raman Link 
Configuration

The information in this chapter is in a new location. See Fiber and Connector Losses in Raman Link 
Configuration for important guidelines to be followed when configuring a Raman link regardless of 
whether you are configuring the Raman link using the Raman installation wizard or the CiscoTransport 
Planner (CTP) XML file.
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Card Features

This chapter describes features common to the Cisco ONS 15454 suite of cards.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Note The cards described in this chapter are supported on the Cisco ONS 15454, Cisco ONS 15454 M6, Cisco 
ONS 15454 M2 platforms, unless noted otherwise.

Note In this chapter, “RAMAN-CTP” refers to the 15454-M-RAMAN-CTP card. “RAMAN-COP” refers to 
the 15454-M-RAMAN-COP card.

Note In this chapter, “100G-LC-C card” refers to the 15454-M-100G-LC-C card. “10x10G-LC” refers to the 
15454-M-10x10G-LC card. “CFP-LC” refers to the 15454-M-CFP-LC card. 

Chapter topics include:

• G.1 Safety Labels, page G-1

• G.34 Card Protection, page G-30

• G.35 Far-End Laser Control, page G-35

• G.36 Jitter Considerations, page G-36

• G.37 Termination Modes, page G-36

G.1 Safety Labels
This section explains the significance of the safety labels attached to some cards. The faceplates of the 
cards are clearly labeled with warnings about the laser radiation levels. You must understand all warning 
labels before working on these cards.
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G.1.1 Class 1 Laser Product Cards
The TCC2, TCC2P, TCC3, TNC, TNCE, TSC, TSCE, OSCM, OSC-CSM, 32MUX-O, 32DMX-O, 
4MD-xx.x, MXP_2.5G_10G, MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, ADM-10G, 
GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and OTU2_XP cards are Class 1 laser products. 

The labels that appear on these cards are described in the following sections.

G.1.1.1 Class 1 Laser Product Label

The Class 1 Laser Product label is shown in Figure G-1.

Figure G-1 Class 1 Laser Product Label

Class 1 lasers are products whose irradiance does not exceed the Maximum Permissible Exposure (MPE) 
value. Therefore, for Class 1 laser products the output power is below the level at which it is believed 
eye damage will occur. Exposure to the beam of a Class 1 laser will not result in eye injury and can 
therefore be considered safe. However, some Class 1 laser products might contain laser systems of a 
higher Class but there are adequate engineering control measures to ensure that access to the beam is not 
reasonably likely. Anyone who dismantles a Class 1 laser product that contains a higher Class laser 
system is potentially at risk of exposure to a hazardous laser beam

G.1.1.2 Hazard Level 1 Label

The Hazard Level 1 label is shown in Figure G-2. This label is displayed on the faceplate of the cards.

Figure G-2 Hazard Level Label

The Hazard Level label warns users against exposure to laser radiation of Class 1 limits calculated in 
accordance with IEC60825-1 Ed.1.2.

G.1.1.3 Laser Source Connector Label

The Laser Source Connector label is shown in Figure G-3.

CLASS 1 LASER PRODUCT
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Figure G-3 Laser Source Connector Label

This label indicates that a laser source is present at the optical connector where the label has been placed.

G.1.1.4 FDA Statement Labels

The FDA Statement labels are shown in Figure G-4 and Figure G-5. These labels show compliance to 
FDA standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.

Figure G-4 FDA Statement Label

Figure G-5 FDA Statement Label

G.1.1.5 Shock Hazard Label

The Shock Hazard label is shown in Figure G-6.
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Figure G-6 Shock Hazard Label

This label alerts personnel to electrical hazard within the card. The potential of shock hazard exists when 
removing adjacent cards during maintenance, and touching exposed electrical circuitry on the card itself.

G.1.2 Class 1M Laser Product Cards
The OPT-PRE, OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, 
OPT-RAMP-C, OPT-RAMP-CE, OPT-EDFA-17, OPT-EDFA-24, RAMAN-CTP, RAMAN-COP, 
TDC-CC, TDC-FC, PSM, AD-1C-xx.x, AD-2C-xx.x, AD-4c-xx.x, AD-1B-xx.x, AD-4B-xx.x, 32WSS, 
32WSS-L, 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 40-MUX-C, 40-WSS-C, 40-WSS-CE, 
40-WXC-C, 80-WXC-C, 40-SMR1-C, 40-SMR2-C, MMU, TXP_MR_10G, TXP_MR_10E, 
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, 
MXPP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, 40E-TXP-C, 40ME-TXP-C, 
40G-MXP-C, 40E-MXP-C, 40ME-MXP-C, AR_MXP, AR_XP, and AR_XPE, 100G-LC-C, 
100G-ME-C, 10x10G-LC, and CFP-LC are Class 1M laser products.

The labels that appear on these cards are described in the following subsections.

G.1.2.1 Class 1M Laser Product Statement

The Class 1M Laser Product statement is shown in Figure G-7.

Figure G-7 Class 1M Laser Product Statement

Class 1M lasers are products that produce either a highly divergent beam or a large diameter beam. 
Therefore, only a small part of the whole laser beam can enter the eye. However, these laser products 
can be harmful to the eye if the beam is viewed using magnifying optical instruments.

G.1.2.2 Hazard Level 1M Label

The Hazard Level 1M label is shown in Figure G-8. This label is displayed on the faceplate of the cards.
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G.1.2   Class 1M Laser Product Cards
Figure G-8 Hazard Level Label

The Hazard Level label warns users against exposure to laser radiation of Class 1 limits calculated in 
accordance with IEC60825-1 Ed.1.2.

G.1.2.3 Laser Source Connector Label

The Laser Source Connector label is shown in Figure G-9.

Figure G-9 Laser Source Connector Label

This label indicates that a laser source is present at the optical connector where the label has been placed.

G.1.2.4 FDA Statement Labels

The FDA Statement labels are shown in Figure G-10 and Figure G-11. These labels show compliance to 
FDA standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.

Figure G-10 FDA Statement Label

HAZARD
LEVEL   1M

14
59

90

96
63

5

96
63

4

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR

DEVIATIONS PURSUANT TO
LASER NOTICE NO.50,
DATED JULY 26, 2001
G-5
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02



 

Appendix G      Card Features
G.1.2   Class 1M Laser Product Cards
Figure G-11 FDA Statement Label

G.1.2.5 Shock Hazard Label

The Shock Hazard label is shown in Figure G-12.

Figure G-12 Shock Hazard Label

This label alerts personnel to electrical hazard within the card. The potential of shock hazard exists when 
removing adjacent cards during maintenance, and touching exposed electrical circuitry on the card itself.

G.1.2.6 Burn Hazard Label

The burn hazard label is shown in Figure G-13.

Figure G-13 Burn Hazard Label

This label is displayed on the RAMAN-CTP and RAMAN-COP cards. The label alerts personnel against 
skin exposure to radiation that may cause burns. The potential of the burn hazard exists during handling 
of fibers.
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G.2   Automatic Laser Shutdown
G.2 Automatic Laser Shutdown
The Automatic Laser Shutdown (ALS) procedure is supported on both client and trunk interfaces. On 
the client interface, ALS is compliant with ITU-T G.664 (6/99). On the data application and trunk 
interface, the switch on and off pulse duration is greater than 60 seconds and is user-configurable.

For information on ALS provisioning, refer the following procedures, as necessary:

• NTP-G162 Change the ALS Maintenance Settings, page 11-471 

• DLP-G203 Change the OSCM and OSC-CSM ALS Maintenance Settings, page 21-12

• DLP-G322 Change the OPT-BST ALS Maintenance Settings, page 21-25

G.3 Card-Level Indicators
Multiple colored LEDs indicate the status of the card.

Table G-1 lists the three card-level LEDs on the following cards:

• TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE

• TXP_MR_10G and TXP_MR_10E

• TXP_MR_10E_C and TXP_MR_10E_L

• TXP_MR_2.5G and TXPP_MR_2.5G

• 40E-TXP-C and 40ME-TXP-C

• MXP_2.5G_10G and MXP_2.5G_10E

• MXP_2.5G_10E_C and MXP_2.5G_10E_L

• MXP_MR_2.5G and MXPP_MR_2.5G

• MXP_MR_10DME_C and MXP_MR_10DME_L

• 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C

• GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE

• ADM-10G

• OTU2_XP

• TXP_MR_10EX_C

• MXP_2.5G_10EX_C

• MXP_MR_10DMEX_C

• PSM

• TDC-CC and TDC-FC

• AR_MXP, AR_XP, and AR_XPE

• 100G-LC-C, 100G-ME-C, 10x10G-LC, and CFP-LC
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G.3   Card-Level Indicators
Table G-2 lists the card-level LEDs on the AIC-I card.

Table G-3 lists the card-level LEDs on the MS-ISC-100T card.

Table G-1 Card-Level Indicators 

Card-Level LED Description

FAIL LED (Red) Red indicates that the card’s processor is not ready. This LED is on during reset. 
The FAIL LED flashes during the boot process. Replace the card if the red FAIL 
LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

Green indicates that the card is operational (one or both ports active) and ready 
to carry traffic. 

Amber indicates that the card is operational and in standby (protect) mode.

SF LED (Amber) Amber indicates a signal failure or condition such as loss of signal (LOS), loss 
of frame (LOF), or high bit error rates (BERs) on one or more of the card’s 
ports. The amber SF LED is also illuminated if the transmit and receive fibers 
are incorrectly connected. If the fibers are properly connected and the link is 
working, the LED turns off.

Table G-2 Card-Level Indicators on the AIC-I Card

Card-Level LEDs Description

Red FAIL LED Indicates that the card’s processor is not ready. The FAIL LED is on during 
reset and flashes during the boot process. Replace the card if the red FAIL 
LED persists.

Green ACT LED Indicates the AIC-I card is provisioned for operation.

Green/Red PWR A LED The PWR A LED is green when a supply voltage within a specified range 
has been sensed on supply input A. It is red when the input voltage on supply 
input A is out of range. 

Green/Red PWR B LED The PWR B LED is green when a supply voltage within a specified range has 
been sensed on supply input B. It is red when the input voltage on supply 
input B is out of range.

Yellow INPUT LED The INPUT LED is yellow when there is an alarm condition on at least one 
of the alarm inputs. 

Yellow OUTPUT LED The OUTPUT LED is yellow when there is an alarm condition on at least one 
of the alarm outputs. 

Green RING LED The RING LED on the local orderwire (LOW) side is flashing green when a 
call is received on the LOW.

Green RING LED The RING LED on the express orderwire (EOW) side is flashing green when 
a call is received on the EOW.
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Table G-4 lists the card-level LEDs on the following cards:

• 32MUX-O and 32DMX-O

• 4MD-xx.x

• OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L

• OPT-AMP-L, OPT-AMP-17-C, and OPT-AMP-C

• OPT-RAMP-C and OPT-RAMP-CE

• AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x and AD-4B-xx.x

• 32WSS and 32WSS-L

• 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, and 40-MUX-C

• 40-WSS-C, 40-WSS-CE, 40-WXC-C, and 80-WXC-C

• 40-SMR1-C and 40-SMR2-C

• MMU

• OPT-EDFA-17 and OPT-EDFA-24

Table G-5 lists the card-level LEDs on the following cards:

• OSCM

• OSC-CSM

Table G-3 Card-Level Indicators on the MS-ISC-100T Card

Card-Level LEDs Description

FAIL LED (Red) The red FAIL LED indicates that the card processor is not ready or that a 
catastrophic software failure occurred on the card. As part of the boot 
sequence, the FAIL LED is turned on until the software deems the card 
operational.

ACT LED (Green) The green ACT LED provides the operational status of the card. If the ACT 
LED is green, it indicates that the card is active and the software is 
operational.

Table G-4 Card-Level Indicators

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the card is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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G.4 Port-Level Indicators
For the following cards, the status of the card ports is indicated on the LCD screen of the ONS 15454 
fan-tray assembly that displays the number and severity of alarms for a given port or slot. 

• OPT-PRE, OPT-BST, OPT-BST-E, and OPT-BST-L

• OPT-AMP-L, OPT-AMP-17-C, and OPT-AMP-C

• OPT-RAMP-C and OPT-RAMP-CE

• RAMAN-CTP and RAMAN-COP

• OSCM and OSC-CSM

• 32MUX-O and 32DMX-O

• 4MD-xx.x

• AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, and AD-4B-xx.x

• 32WSS and 32WSS-L

• 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, and 40-MUX-C

• 40-WSS-C, 40-WSS-CE, 40-WXC-C, and 80-WXC-C

• 40-SMR1-C and 40-SMR2-C

• MMU

• OPT-EDFA-17 and OPT-EDFA-24

In some cards, multiple colored LEDs indicate the status of the port.

Port-Level LEDs for AR_MXP, AR_XP, and AR_XPE cards depend on the configured card mode.

Table G-6 lists the port-level LEDs on the following cards: 

• TXP_MR_10E, TXP_MR_10E_C, and TXP_MR_10E_L

• TXP_MR_2.5G and TXP_MR_10EX_C

• 40E-TXP-C and 40ME-TXP-C

• MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C

Table G-5 Card-Level Indicators on the OSCM and OSC-CSM Cards

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OSCM or OSC-CSM is carrying 
traffic or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as loss of 
signal (LOS), loss of frame alignment (LOF), line alarm indication signal 
(AIS-L), or high BER on one or more of the card’s ports. The amber signal 
fail (SF) LED also illuminates when the transmit and receive fibers are 
incorrectly connected. When the fibers are properly connected, the light 
turns off.
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G.4   Port-Level Indicators
Table G-7 lists the port-level LEDs on the following cards: 

• TXP_MR_10G

• MXP_2.5G_10G

Table G-8 lists the port-level LEDs on the TXPP_MR_2.5G card:

Table G-9 lists the port-level LEDs on the following cards:

• GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE

• MXP_MR_10DME_C, MXP_MR_10DME_L, and MXP_MR_10DMEX_C

Table G-6 Port-Level Indicators 

Port-Level LED Description

Green Client LED1

1. The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards have four client ports, and so 
have four client LEDs.

The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Table G-7 Port-Level Indicators on the TXP_MR_10G and MXP_2.5G_10G cards

Port-Level LED Description

Green Client LED

(four LEDs for 
MXP_2.5G_10G1)

1. The MXP_2.5G_10G card has four client ports, and so has four client LEDs.

The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green Wavelength 1 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the card is 
configured for Wavelength 1. 

Green Wavelength 2 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the card is 
configured for Wavelength 2.

Table G-8 Port-Level Indicators on the TXPP_MR_2.5G card

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM A LED The green DWDM A LED indicates that the DWDM A port is in service and 
that it is receiving a recognized signal.

Green DWDM B LED The green DWDM B LED indicates that the DWDM B port is in service and 
that it is receiving a recognized signal.
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• 40G-MXP-C, 40E-MXP-C, and 40ME-MXP-C

Table G-10 lists the port-level LEDs on the following cards:

• MXP_MR_2.5G

• MXPP_MR_2.5G

Table G-11 lists the port-level LEDs on the following cards for both client and trunk ports:

• ADM-10G

• OTU2_XP

Table G-9 Port-Level Indicators 

Port-Level LED Description

Port LEDs
(eight LEDs, four for 
each group, one for 
each SFP/XFP)

Green/Red/Amber/Off

Green—The client port is either in service and receiving a recognized signal 
(that is, no signal fail), or Out of Service and Maintenance (OOS,MT or 
locked, maintenance) in which case the signal fail and alarms will be ignored.

Red—The client port is in service but is receiving a signal fail (LOS).

Amber—The port is provisioned and in a standby state.

Off—The SFP is either not provisioned, out of service, not properly inserted, 
or the SFP hardware has failed.

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Table G-10 Port-Level Indicators on the MXP_MR_2.5G and MXPP_MR_2.5G cards

Port-Level LED Description

Client LEDs 
(eight LEDs)

Green indicates that the port is carrying traffic (active) on the interface. 
Amber indicates that the port is carrying protect traffic (MXPP_MR_2.5G). 
Red indicates that the port has detected a loss of signal.

DWDM LED
(MXP_MR_2.5G)

Green (Active)

Red (LOS)

Green indicates that the card is carrying traffic (active) on the interface. 

A red LED indicates that the interface has detected an LOS or LOC.

DWDMA and DWDMB 
LEDs
(MXPP_MR_2.5G)

Green (Active)

Amber (Protect Traffic)

Red (LOS)

Green indicates that the card is carrying traffic (active) on the interface. 

When the LED is amber, it indicates that the interface is carrying protect 
traffic in a splitter protection card (MXPP_MR_2.5G). 

A red LED indicates that the interface has detected an LOS or LOC.
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Note Client or trunk ports can each be in active or standby mode as defined in the related section for each 
specific protection type. For example, fiber-switched protection has active or standby trunk ports; 1+1 
APS protection has active or standby client ports, and client 1+1 protection does not utilize active or 
standby ports.

Table G-11 Port-Level Indicators on the ADM-10G and OTU2_XP cards

Port-Level Status Tri-color LED Description

The port-level LED is 
active and unprotected.

• If a port is in OOS/locked state for any reason, the LED is turned off.

• If a port is in IS/unlocked state and the PPM is preprovisioned or is 
physically equipped with no alarms, the LED is green. 

• If a port is in IS state and the PPM is physically equipped but does have 
alarms, the LED is red.

The port-level LED is in 
standby.

• If a port is in OOS/locked state for any reason, the LED is turned off.

• If a port is in the IS/unlocked state and the PPM is preprovisioned or is 
physically equipped with no alarms, the LED is amber. 

• If a port is in IS state and physically equipped but does have alarms, the 
LED is red.
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Table G-12 lists the port-level LEDs on the following cards:

• 100G-LC-C

• 100G-ME-C

• 10x10G-LC

• CFP-LC

Table G-13 lists the power-level LEDs on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

Table G-12 Port-Level Indicators the 100G-LC-C, 100G-ME-C, 10x10G-LC, and CFP-LC Cards

Port-Level LED Description

Port LEDs
(ten LEDs, one for 
each SFP+)

Green/Red/Amber/Off

Green—The client port is either in service and receiving a recognized signal 
(that is, no signal fail), or Out of Service and Maintenance (OOS,MT or 
locked, maintenance) in which case the signal fail and alarms will be ignored.

Red—The client port is in service but is receiving a signal fail (LOS).

Amber—The port is provisioned and in a standby state.

Off—The SFP is either not provisioned, out of service, not properly inserted, 
or the SFP hardware has failed.

DWDM LED

Green (Active) 

Amber (Protect 
Traffic) 

Red (LOS)

Green indicates that the card is carrying traffic (active) on the interface. 

When the LED is amber, it indicates that the interface is carrying protect 
traffic in a splitter protection card 

A red LED indicates that the interface has detected an LOS or LOF. 

Table G-13 Power-Level Indicators on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards

Power-Level LEDs Definition

Green/Amber/Red 
PWR A LED

The PWR A LED is green when the voltage on supply input A is between the 
low battery voltage (LWBATVG) and high battery voltage (HIBATVG) 
thresholds. The LED is amber when the voltage on supply input A is between 
the high battery voltage and extremely high battery voltage (EHIBATVG) 
thresholds or between the low battery voltage and extremely low battery 
voltage (ELWBATVG) thresholds. The LED is red when the voltage on 
supply input A is above extremely high battery voltage or below extremely 
low battery voltage thresholds. 

Green/Amber/Red 
PWR B LED 

The PWR B LED is green when the voltage on supply input B is between the 
low battery voltage and high battery voltage thresholds. The LED is amber 
when the voltage on supply input B is between the high battery voltage and 
extremely high battery voltage thresholds or between the low battery voltage 
and extremely low battery voltage thresholds. The LED is red when the 
voltage on supply input B is above extremely high battery voltage or below 
extremely low battery voltage thresholds. 
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Note For ONS 15454 ETSI shelf, the power-level LEDs are either green or red. The LED is green when the 
voltage on supply inputs is between the extremely low battery voltage and extremely high battery voltage 
thresholds. The LED is red when the voltage on supply inputs is above extremely high battery voltage 
or below extremely low battery voltage thresholds. 

Table G-14 lists the network-level LEDs on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

Table G-15 lists the ethernet port-level LEDs on the TNC/TNCE/TSC/TSCE card.

Table G-16 lists the SFP LED indicators.

Table G-14 Network-Level Indicators on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards

System-Level LEDs Definition

Red CRIT LED Indicates critical alarms in the network at the local terminal.

Red MAJ LED Indicates major alarms in the network at the local terminal.

Yellow MIN LED Indicates minor alarms in the network at the local terminal.

Red REM LED Provides first-level alarm isolation. The remote (REM) LED turns red when 
an alarm is present in one or more of the remote terminals.

Green SYNC LED Indicates that node timing is synchronized to an external reference.

Green ACO LED After pressing the alarm cutoff (ACO) button, the ACO LED turns green. 
The ACO button opens the audible alarm closure on the backplane. ACO is 
stopped if a new alarm occurs. After the originating alarm is cleared, the 
ACO LED and audible alarm control are reset.

Table G-15 Ethernet Port-Level Indicators on the TNC/TNCE/TSC/TSCE cards

Port-Level LEDs Definition

Green LINK LED Indicates the connectivity status.

Amber ACT LED Indicates data reception.

Table G-16  TNC and TNCE SFP Indicators

Port Type Link LED Activity LED

OC3 • RED - No link

• GREEN - Link

—

FE • RED - No link

• GREEN - Link

Blinks on packet flow

GE • RED - No link

• GREEN - Link

Blinks on packet flow
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G.5 Client Interface
The client interface in TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C 
cards is implemented with a separately orderable XFP module. The module is a tri-rate transceiver, 
providing a single port that can be configured in the field to support an OC-192 SR-1 (Telcordia 
GR-253-CORE) or STM-64 I-64.1 (ITU-T G.691) optical interface, as well as 10GE LAN PHY 
(10GBASE-LR), 10GE WAN PHY (10GBASE-LW), 10G FC signals or 
IB_5G signals (TXP_MR_10EX_C only).

The client side XFP pluggable module supports LC connectors and is equipped with a 1310-nm laser.

The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards provide 
four intermediate- or short-range OC-48/STM-16 ports per card on the client side. Both SR-1 or IR-1 
optics can be supported and the ports use SFP connectors. The client interfaces use four wavelengths in 
the 1310-nm, ITU 100-MHz-spaced, channel grid. 

The client interface in AR_MXP, AR_XP, and AR_XPE cards are implemented with a separately 
orderable XFP/SFP module. The module can be single-rate or tri-rate transceiver, providing a single port 
that can be configured in the field to support available payloads. For the list of supported payloads, see 
11.20 AR_MXP, AR_XP, and AR_XPE Cards section.

G.6 DWDM Interface
The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards serve as 
an OTN multiplexer, transparently mapping four OC-48 channels asynchronously to ODU1 into one 
10-Gbps trunk. The tunable wavelengths for the DWDM trunk is as follows:

• MXP_2.5G_10E—Tunable for transmission over four wavelengths in the 1550-nm, ITU 100-GHz 
spaced channel grid.

• MXP_2.5G_10E_C and MXP_2.5G_10EX_C—Tunable for transmission over the entire C-band 
and the channels are spaced at 50-GHz on the ITU grid.

• MXP_2.5G_10E_L—Tunable for transmission over the entire L-band and the channels are spaced 
at 50-GHz on the ITU grid.

• AR_MXP, AR_XP, and AR_XPE—The wavelengths for the DWDM trunk is based on the 
pluggable.

• 100G-LC-C, 100G-ME-C, 10X10G-LC, and CFP-LC—Tunable on 96 wavelength channels spaced 
at 50-GHz on the ITU grid over the entire C band.

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the card in a loopback on the 
trunk port. Do not use direct fiber loopbacks as it can cause irreparable damage to the card.

Note On the MXP_2.5G_10EX_C card, you cannot disable ITU-T G.709 on the trunk side. If ITU-T G.709 is 
enabled, then FEC cannot be disabled.
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G.7 DWDM Trunk Interface
On the trunk side, the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and TXP_MR_10EX_C 
cards provide a 10-Gbps STM-64/OC-192 interface. There are four tunable channels available in the 
1550-nm band or eight tunable channels available in the 1580-nm band on the 50-GHz ITU grid for the 
DWDM interface. The card provides 3R (retime, reshape, and regenerate) transponder functionality for 
this 10-Gbps trunk interface. Therefore, the card is suited for use in long-range amplified systems. The 
DWDM interface is complaint with ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE 
standards.

The DWDM trunk port operates at a rate that is dependent on the input signal and the presence or absence 
of the ITU-T G.709 Digital Wrapper/FEC. The possible trunk rates are:

• OC192 (9.95328 Gbps)

• OTU2 (10.70923 Gbps)

• 10GE (10.3125 Gbps) or 10GE into OTU2 (ITU G.sup43 11.0957 Gbps)

• 10G FC (10.51875 Gbps) or 10G FC into OTU2 (nonstandard 11.31764 Gbps)

• (TXP_MR_10EX_C only) Proprietary rate at the trunk when the client is provisioned as IB_5G.

The maximum system reach in filterless applications without the use of optical amplification or 
regenerators is nominally rated at 23 dB over C-SMF fiber. This rating is not a product specification, but 
is given for informational purposes. It is subject to change.

On the trunk side, the AR_MXP, AR_XP, and AR_XPE cards provide a 10-Gbps OTU2 or 2.5-Gbps 
OTU1 or 4-Gbps FC interfaces. The trunk wavelength can be tuned to any C-band wavelength, based on 
the pluggable inserted. The card provides 3R (retime, reshape, and regenerate) transponder functionality 
for this 10-Gbps trunk interface. Therefore, the card is suited for use in the long-range amplified 
systems. The DWDM interface is complaint with ITU-T G.707, ITU-T G.709, and Telcordia 
GR-253-CORE standards. The DWDM trunk port operates at a rate that is dependent on the input signal 
and the presence or absence of the ITU-T G.709 Digital Wrapper/FEC. 

The maximum system reach in filterless applications without the use of optical amplification or 
regenerators is nominally rated at 23 dB over C-SMF fiber. This rating is not a product specification, but 
is given for informational purposes. It is subject to change.
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G.8 FEC
Forward error correction (FEC) is a feature used for controlling errors during data transmission. This 
feature works by adding data redundancy to the transmitted message using an algorithm. This  
redundancy allows the receiver to detect and correct a limited number of errors occurring anywhere in 
the message, instead of having to ask the transmitter to resend the message.

For the TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, TXP_MR_10EX_C, or MXP_2.5G_10EX_C card, you can configure the forward 
error correction in three modes: NO FEC, FEC, and E-FEC modes. 

The E-FEC mode has a higher level of error detection and correction than the FEC mode. As a result, 
using the E-FEC mode allows higher sensitivity (that is, a lower optical signal-to-noise ratio [OSNR]) 
with a lower bit error rate than what the FEC mode allows. The E-FEC mode also enables longer distance 
trunk-side transmission than what the FEC enables.

The output bit rate is always 10.7092 Gbps as defined in the ITU-T G.709 standard, but the error coding 
performance can be provisioned in this way:

• NO FEC—No forward error correction

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm

• E-FEC—Standard ITU-T G.975.1 I.7, two orthogonally concatenated BCH super FEC code. This 
FEC scheme contains three parameterizations of a single scheme of two orthogonally interleaved 
BCH. The constructed code is decoded iteratively to achieve the expected performance.

For the AR_MXP, AR_XP, and AR_XPE cards you can configure forward error correction on 10 Gbps 
trunk XFP ports in four modes: NO FEC, FEC, I.4 E-FEC, and I.7 E-FEC. The 2.5Gbps SFP OTN ports 
have only two modes of operation: NO FEC and FEC. The output bit rate varies depending on the 
provisioned payload and the configured FEC. The details of the error-coding performance that can be 
provisioned are:

• NO FEC—No forward error correction

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm

• I.4 E-FEC—Standard G.975.1 I.4 two interleaved codes (RS and BCH) super FEC codes

• I.7 E-FEC— Standard G.975.1 I.7 two orthogonally concatenated block (BCH) super FEC codes; 
this FEC scheme contains three parameterizations of a single scheme of two BCH codes, with the 
constructed code decoded iteratively to achieve expected performance.

Note G.709 OTN is enabled by default for all trunk ports, except for a 4GFC transponder.

You can configure the forward error correction for the 100G-LC-C and 100G-ME-C cards in three 
modes: FEC, I.7 FEC, and HG-FEC. The 10x10G-LC cards supports only two modes: FEC and I.7 FEC. 
The FEC cannot be disabled. The output bit rate is always 10.7092 Gbps as defined in ITU-T G.709, but 
the error coding performance can be provisioned in this way:

• FEC—Standard ITU-T G.975 Reed-Solomon algorithm with 7% overhead.

• I.7 FEC—Standard G.975.1 I.7 two orthogonally concatenated block (BCH) super FEC codes; this 
FEC scheme contains three parameterizations of a single scheme of two BCH codes, with the 
constructed code decoded iteratively to achieve expected performance.
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• HG-FEC—High Gain FEC with 7% or 20% overhead provides better performance than the standard 
G.975.1. The HG-FEC is suitable for all applications where 100 G wavelengths are passing through 
a high number of ROADM nodes, with limited pass-band performance. High Gain FEC with 20% 
overhead is not supported on 100G-ME-C card.

Note G.709 OTN is enabled by default for OTU payloads.

The maximum bit error correction value in R9.6.0.3 is lesser than the maximum bit error correction value 
in earlier releases. During an upgrade to R9.6.0.3, the value of the Bit Errors Corrected does not change. 
In CTC, the maximum bit error correction value can be manually reconfigured in the card view > 
Provisioning > OTN > FEC Threshold tab using the values provided in Table G-17.

G.9 Client-to-Trunk Mapping
The TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_10EX_C, AR_MXP, AR_XP, and 
AR_XPE cards can perform ODU2-to-OCh mapping, which allows operators to provision data payloads 
in a standard way across 10-Gbps optical links. Additionally, the AR_MXP, AR_XP, and AR_XPE cards 
can perform ODU1-to-OCh mapping across 2.5 Gbps optical links.

Digital wrappers that define client side interfaces are called Optical Data Channel Unit 2 (ODU2) 
entities in ITU-T G.709. Digital wrappers that define trunk side interfaces are called Optical Channels 
(OCh) in ITU-T G.709. ODU2 digital wrappers can include Generalized Multiprotocol Label Switching 
(G-MPLS) signaling extensions to ITU-T G.709 (such as Least Significant Part [LSP] and Generalized 
Payload Identifier [G-PID] values) to define client interfaces and payload protocols.

G.10 Timing Synchronization
The TCC2/TCC2P/TCC3 card performs all system-timing functions for each ONS 15454. The 
TNC/TNCE/TSC/TSCE card performs all the system-timing functions for the 15454-M2 and 15454-M6 
shelves.

Table G-17 FEC Threshold Bit Error Correction Values

Data Rate
Bit Error 
Correction

Frames per 
Second

Bit Error 
Correction per 
Second

Maximum Bit Error Correction per 15 
Seconds

Releases earlier than R9.6.0.3

Any data rate 122368 82026 10037357568 9033621811200

R9.6.0.3

OTU1 4096 20421 83644416 75279974400

OTU2 4096 82026 335978496 302380646400

OTU3 4096 329492 1349599232 1214639308800

OTU4 4096 856164 3506847744 3156162969600
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G.10   Timing Synchronization
The TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card monitors the recovered clocks from each traffic 
card and two BITS ports for frequency accuracy. The TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card 
selects a recovered clock, a BITS, or an internal Stratum 3 reference as the system-timing reference. You 
can provision any of the clock inputs as primary or secondary timing sources. A slow-reference tracking 
loop allows the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card to synchronize with the recovered 
clock, which provides holdover if the reference is lost. The TCC2P/TCC3/TNC/TNCE/TSC/TSCE card 
supports 64/8K composite clock and 6.312 MHz timing output.

Note The TNC/TNCE/TSC/TSCE card supports the BITS-1 and BITS-2 external timing interfaces on the 
ONS 15454 M6 shelf. The card supports the BITS-1 interface on the ONS 15454 M2 shelf.

The TNC/TNCE/TSC/TSCE card supports SNTP operation that allows the nodes to synchronize the 
system clock automatically with a reference SNTP server following system reboots, card resets, and 
software upgrades.

For more information on the timing function, see Timing Reference document.

The MXP_2.5G_10G card is synchronized to the TCC2/TCC2P/TCC3 clock during normal conditions 
and transmits the ITU-T G.709 frame using this clock. The TCC2/TCC2P/TCC3 card can operate from 
an external building integrated timing supply (BITS) clock, an internal Stratum 3 clock, or from clock 
recovered from one of the four valid client clocks. If clocks from both TCC2/TCC2P/TCC3 cards are 
not available, the MXP_2.5G_10G card switches automatically (with errors, not hitless) to an internal 
19.44 MHz clock that does not meet SONET clock requirements. This will result in a clock alarm. 

The MXP_2.5G_10E and MXP_2.5G_10EX_C cards are synchronized to the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE clock and the MXP_2.5G_10E_C and MXP_2.5G_10E_L 
cards are synchronized to the TCC2/TCC2P/TCC3 clock during normal conditions and transmits the 
ITU-T G.709 frame using this clock. No holdover function is implemented. If neither 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE clock is available, the cards switch automatically (hitless) 
to the first of the four valid client clocks with no time restriction as to how long it can run on this clock. 
The cards continue to monitor the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card. If a 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card is restored to working order, the cards revert to the 
normal working mode of running from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE clock. If no 
valid TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE clock is available and all of the client channels 
become invalid, the cards wait (no valid frames processed) until the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card supplies a valid clock. In addition, the cards can 
select the recovered clock from one active and valid client channel and supply that clock to the 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

The AR_MXP, AR_XP, and AR_XPE cards are able to transparently transport synchronization and 
timing information for payload enveloped within ODU-1 and ODU-2. The AR_MXP and AR_XP cards 
are synchronized to the TCC2/TCC2P/TCC3/TNC/TSC clock during normal conditions and transmit the 
ITU-T G.709 frame using this clock. The AR_XPE card is synchronized to the 
TCC3/TNC//TNCE/TSC/TSCE clock during normal conditions and transmit the ITU-T G.709 frame 
using this clock. The AR_MXP, AR_XP, and AR_XPE cards select its synchronization source between 
an optical line, an external synchronization input, and the internal source. The optical line can be either 
OCN, OTN or Ethernet based. The AR_MXP and AR_XP cards transmit the SyncE information from an 
incoming SyncEthernet (ITU-T G.8262 and G.8264 ESMC) signal to the node controller (TNC). 

The 100G-LC-C, 100G-ME-C, 10x10G-LC, and CFP-LC cards are synchronized to TNC/TSC clock 
during normal conditions and transmits the ITU-T G.709 frame using this clock.

Note Only one port per card can be selected as a timing reference. The OTN ports configured as clients shall 
not be provisionable as timing source.
G-20
Cisco ONS 15454 DWDM Configuration Guide, Release 9.6.x

78-20702-02

http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_timing_ref.html


 

Appendix G      Card Features
G.11   Multiplexing Function
G.11 Multiplexing Function
The muxponder is an integral part of the reconfigurable optical add/drop multiplexer (ROADM) 
network. The key function of the MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, 
MXP_2.5G_10EX_C, AR_MXP, AR_XP, and AR_XPE cards is to multiplex 4 OC-48/STM16 signals 
onto one ITU-T G.709 OTU2 optical signal (DWDM transmission). The multiplexing mechanism allows 
the signal to be terminated at a far-end node by another similar card.

Termination mode transparency on the muxponder is configured using OTUx and ODUx OH bytes. The 
ITU-T G.709 specification defines OH byte formats that are used to configure, set, and monitor frame 
alignment, FEC mode, section monitoring, tandem connection monitoring, and termination mode 
transparency.

The card performs ODU to OTU multiplexing as defined in ITU-T G.709. The ODU is the framing 
structure and byte definition (ITU-T G.709 digital wrapper) used to define the data payload coming into 
one of the SONET/SDH client interfaces on the card. The term ODU1 refers to an ODU that operates at 
2.5-Gbps line rate. On the card, four client interfaces can be defined using ODU1 framing structure and 
format by asserting an ITU-T G.709 digital wrapper. 

The output of the muxponder is a single 10-Gbps DWDM trunk interface defined using OTU2. It is 
within the OTU2 framing structure that FEC or E-FEC information is appended to enable error checking 
and correction.

G.12 SONET/SDH Overhead Byte Processing
The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10EX_C, AR_MXP, 
AR_XP, AR_XPE, 100G-LC-C, 100G-ME-C, 10x10G-LC, and CFP-LC cards pass the incoming 
SONET/SDH data stream and its overhead bytes for the client signal transparently. The card can be 
provisioned to terminate regenerator section overhead. This is used to eliminate forwarding of unneeded 
layer overhead. It can help reduce the number of alarms and help isolate faults in the network.

G.13 Client Interface Monitoring
The following parameters are monitored on the MXP_2.5G_10E, MXP_2.5G_10E_C, 
MXP_2.5G_10E_L, MXP_2.5G_10EX_C, AR_MXP, AR_XP, AR_XPE, 100G-LC-C, 100G-ME-C, 
10x10G-LC, and CFP-LC cards:

• Laser bias current is measured as a PM parameter

• LOS is detected and signaled

• Transmit (TX) and receive (RX) power are monitored

The following parameters are monitored in real time mode (one second):

• Optical power transmitted (client)

• Optical power received (client)

In case of loss of communication (LOC) at the DWDM receiver or far-end LOS, the client interface 
behavior is configurable. AIS can be invoked or the client signal can be squelched.
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G.14 Jitter
For SONET and SDH signals, the MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, 
MXP_2.5G_10EX_C, AR_MXP, AR_XP, AR_XPE cards comply with Telcordia GR-253-CORE, 
ITU-T G.825, and ITU-T G.873 for jitter generation, jitter tolerance, and jitter transfer. For more 
information, see the “G.36 Jitter Considerations” section on page G-36.

G.15 Lamp Test
The MXP_2.5G_10E, MXP_2.5G_10E_C and MXP_2.5G_10E_L, MXP_2.5G_10EX_C, AR_MXP, 
AR_XP, AR_XPE, TDC-CC, TDC-FC, TNC, TNCE, TSC, TSCE, RAMAN-CTP, and RAMAN-COP 
cards support lamp test function activated from the ONS 15454 front panel or through CTC to ensure 
that all LEDs are functional.

The Lamp Test is run during the initial node turn-up, periodic maintenance routine, identification of 
specific cards, or LED testing.

NTP-G335 Perform Lamp Test

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance> 
Diagnostic tab.

Step 2 Click the Lamp Test button. The Lamp Test dialog box appears.

Step 3 Perform lamp test at the shelf level.

• Select the All option.

• Click Lamp Test.

Step 4 Perform lamp test at the card level.

• Select the Lamp Test For Slot option 

• Choose the required Slot ID or card from the drop-down list. 

• Click Slot Lamp Test. 

Note Cards in pre-provisioned or improper removal state are not listed in the drop-down list.

Stop. You have completed this procedure.

Purpose This procedure performs lamp test at the shelf and card levels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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G.16 Onboard Traffic Generation
The MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, and MXP_2.5G_10EX_C cards provide 
internal traffic generation for testing purposes according to pseudo-random bit sequence (PRBS), 
SONET/SDH, or ITU-T G.709.

G.17 Performance Monitoring
GFP-T performance monitoring (GFP-T PM) in MXP_MR_2.5G, MXPP_MR_2.5G, AR_MXP, AR_XP, 
AR_XPE, 100G-LC-C, 100G-ME-C, and 10x10G-LC cards are available via remote monitoring 
(RMON), and trunk PM is managed according to Telcordia GR-253-CORE and ITU G.783/826. Client 
PM is achieved through RMON for FC and GE.

G.18 Distance Extension
In MXP_MR_2.5G and MXPP_MR_2.5G cards, buffer-to-buffer credit management scheme provides 
FC flow control. When this feature is enabled, a port indicates the number of frames that can be sent to 
it (its buffer credit), before the sender is required to stop transmitting and wait for the receipt of a “ready” 
indication The MXP_MR_2.5G and MXPP_MR_2.5 cards support FC credit-based flow control with a 
buffer-to-buffer credit extension of up to 1600 km (994.2 miles) for 1G FC and up to 800 km (497.1 
miles) for 2G FC. The feature can be enabled or disabled, as necessary.

G.19 Slot Compatibility
You can install MXP_MR_2.5G, MXPP_MR_2.5G, AR_MXP, AR_XP, and AR_XPE cards in Slots 1 
to 6 and 12 to 17. The TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card is the only other card required 
to be used with these muxponder cards. Cross-connect cards do not affect the operation of the 
muxponder cards.

G.20 Interoperability with Cisco MDS Switches
You can provision a string (port name) for each fiber channel/FICON interface on the MXP_MR_2.5G 
and MXPP_MR_2.5G cards, which allows the MDS Fabric Manager to create a link association between 
that SAN port and a SAN port on a Cisco MDS 9000 switch.

G.21 Client and Trunk Ports
The MXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser 
(depending on the SFP) for the client ports. The card contains eight 12.5 degree downward tilt SFP 
modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are 
labeled TX and RX on the faceplate. In a MXP_MR_2.5G card, the trunk port is a dual-LC connector 
with a 45 degree downward angle. In a MXPP_MR_2.5G card, there are two trunk port connectors (one 
for working and one for protect), each a dual-LC connector with a 45-degree downward angle.
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G.22 Communication and Control for Controller Cards
The following section describes the communication and control for the controller cards:

G.22.1 TCC2 Card
The TCC2 card terminates up to 32 DCCs. The TCC2 hardware is prepared for up to 84 DCCs, which 
will be available in a future software release. The node database, IP address, and system software are 
stored in TCC2 nonvolatile memory, which allows quick recovery in the event of a power or card failure.

G.22.2 TCC2P/TCC3 Card
The TCC2P/TCC3 card supports multichannel, high-level data link control (HDLC) processing for the 
DCC. Up to 84 DCCs can be routed over the TCC2P/TCC3 card and up to 84 section DCCs can be 
terminated at the TCC2P/TCC3 card (subject to the available optical digital communication channels). 
The TCC2P selects and processes 84 DCCs to facilitate remote system management interfaces. 

The TCC2P/TCC3 card also originates and terminates a cell bus carried over the module. The cell bus 
supports links between any two cards in the node, which is essential for peer-to-peer communication. 
Peer-to-peer communication accelerates protection switching for redundant cards.

G.22.3 TNC and TNCE Cards
The TNC and TNCE cards act as node controller and shelf controller. The control tasks include system 
initialization, provisioning, alarm reporting, maintenance, diagnostics, IP address detection, and 
resolution. The control tasks also include SONET and SDH data communications channel (DCC) 
termination, 84 section SDCC and multiplex section MSDCC terminations, 28 SDCC tunnels or 
SDCC-to-line LDCC terminations, and system fault detection for the 15454-M2 and 15454-M6 shelves.

The system initialization tasks include assigning the network parameters to the system and loading the 
system with the provisioning data stored in the database. The line cards in the system do not boot without 
the TNC or TNCE card.

The TNC and TNCE cards support and provide the following:

• OSC communication to implement the Optical DCN, User Data Channels and Voice over IP 
interface.

• Supervisory data channel (SDC) for communication between the nodes.

• Two point-to-point Ethernet channels at 10 Mbps to carry Voice over IP traffic.

• Two point-to-point Ethernet channels at 10/100 Mbps to carry UDC traffic.

• Passive inventory of external devices on the 15454-M2 and 15454-M6 shelves.

• Supports OSC, UDC, and VoIP traffic. Two UDC/VoIP ports are present on the external connection 
unit that can be configured to carry UDC/VoIP traffic.

Note The TNC and TNCE cards support UDC and VoIP configuration only when OSC is configured on the 
ports. To delete the OSC channel on a port, delete the UDC and VoIP configuration on that port. For more 
information, refer the Cisco ONS 15454 Hardware Installation Guide.
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On the 15454-M2 and 15454-M6 shelves, the TNC and TNCE cards must adhere to the following rules 
for SDCC/LDCC allocation:

• SDCC + SDCC Tunnels <= 68

• LDCC <= 28

• IP Tunnels <= 10

• SDCC + SDCC tunnels + (LDCC * 3) <= 84

G.22.4 TSC and TSCE Cards
The TSC and TSCE cards act as a shelf controller. The control tasks include system initialization, 
provisioning, alarm reporting, maintenance, diagnostics, IP address detection, and resolution. The 
control tasks also include SONET and SDH data communications channel (DCC) termination, 84 section 
SDCC and multiplex section MSDCC terminations, 28 SDCC tunnels or SDCC-to-line LDCC 
terminations, and system fault detection for the ONS 15454 M2 and ONS 15454 M6 shelves.

The system initialization tasks include assigning the network parameters to the system and loading the 
system with the provisioning data stored in the database. The line cards in the system do not boot without 
the TSC and TSCE cards.

The TSC and TSCE cards support and provides the following: 

• Passive inventory of external devices on the 15454-M2 and 15454-M6 shelves.

• 100 Mbps UDC on the 15454-M6 shelf. 

On the 15454-M2 and 15454-M6 shelves, the TSC and TSCE cards must adhere to the following rules 
for SDCC/LDCC allocation.

• SDCC + SDCC Tunnels <= 68

• LDCC <= 28

• IP Tunnels <= 10

• SDCC + SDCC tunnels + (LDCC * 3) <= 84

G.23 Interface Ports
The TCC2 card has two built-in interface ports for accessing the system: an RJ-45 10BaseT LAN 
interface and an EIA/TIA-232 ASCII interface for local craft access. It also has a 10BaseT LAN port for 
user interfaces via the backplane. 

The TCC2P/TCC3 card has two built-in Ethernet interface ports for accessing the system: one built-in 
RJ-45 port on the front faceplate for on-site craft access and a second port on the backplane. The rear 
Ethernet interface is for permanent LAN access and all remote access via TCP/IP as well as for 
Operations Support System (OSS) access. The front and rear Ethernet interfaces can be provisioned with 
different IP addresses using CTC.

Two EIA/TIA-232 serial ports, one on the faceplate and a second on the backplane, allow for craft 
interface in TL1 mode.

Note To use the serial port craft interface wire-wrap pins on the backplane, the DTR signal line on the 
backplane port wire-wrap pin must be connected and active.
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G.24   External Alarms and Controls
The TNC/TNCE/TSC/TSCE card has three built-in interface ports:

• RJ-45 LAN port

• RJ-45 console port

• RS-232 port (serial port)

The RJ-45 LAN port and RS-232 port are located on the faceplate of the TNC/TNCE/TSC/TSCE card. 
The RJ-45 console port is behind the faceplate of the TNC/TNCE/TSC/TSCE card.

The front access RJ-45 LAN port provides 10/100 BASE-T Ethernet connectivity to the system. The 
RJ-45 LAN port has LEDs to provide link and activity status. The RJ-45 LAN port provides local and 
remote access to the Cisco Transport Controller through a common Web interface.

The RJ-45 console port is used to launch a debug session on the TNC/TNCE/TSC/TSCE card.

The RS-232 port is used to connect to the Transaction Language 1 (TL1) management interface. In TL1 
mode, the RS-232 port runs at 9.6 Kbps without any flow control.

The front access LAN port and RJ-45 EMS LAN port can be provisioned with different IP addresses by 
configuring the TNC and TNCE cards in secure mode using CTC. On 15454 M2, the EMS port is on the 
power module. On 15454 M6, the EMS port is on the ECU.

The two SFP ports (SFP1 and SFP2) are used for primary OSC and secondary OSC connections. SFP1 
supports OC-3/STM-1, FE, or GE payloads; SFP2 supports FE or GE payloads.

The two SFP ports on the TNC/TNCE/TSC/TSCE card are in IS,AINS administrative state during 
payload creation. In this state, only the following alarms are raised:

• AS-MT alarm on PPM

• AS-CMD alarm on PPM and facility

• Prov-Mismatch alarm on PPM

The TX power is -40 and RX power is -50 for Ultra long-haul SFPs. The TX power is -40 and RX power 
is -40 for other SFPs. When the OSC is created, the two SFP ports move to IS state. In this state, all the 
supported alarms are raised.

Note VLAN tagged traffic is not supported on UDC or VoIP ports that are present on the external connection 
unit.

G.24 External Alarms and Controls
The TNC/TNCE/TSC/TSCE card provides customer-defined (environmental) alarms and external 
controls on the ONS 15454 M6 shelf. The card provides input/output alarm contact closures. The 
TNC/TNCE/TSC/TSCE card operates in two modes:

• External alarms mode - This is the default mode and up to 14 alarm input ports can be configured. 
External alarms (input contacts) are typically used for external sensors such as open doors, 
temperature sensors, flood sensors, and other environmental conditions.

• External control mode - Up to 10 alarm input ports and four alarm output ports can be configured. 
External controls (output contacts) are typically used to drive visual or audible devices such as bells 
and lights, but they can control other devices such as generators, heaters, and fans.
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G.25   Digital Image Signing (DIS)
To configure the external alarms and external controls, go to Provisioning -> Alarm Extenders tab in the 
CTC node view. To view the external alarms and external controls, go to Maintenance -> Alarm 
Extenders tab in the CTC node view. For information on how to configure and view the external alarms 
and external controls, refer the Alarm and TCA Monitoring and Management document.

Note The LCD module must be present in the ONS 15454 M6 shelf assembly to provision alarms from the 
ECU, fan-tray assembly, or power modules.

For information on pinouts of external alarms and external controls, see the “ONS 15454 ANSI Alarm, 
Timing, LAN, and Craft Pin Connections” section in the Cisco ONS 15454 Hardware Installation Guide.

G.25 Digital Image Signing (DIS)
The TNC/TNCE/TSC/TSCE card provides services that authenticate the origin of the software running 
on the Cisco ONS 15454 M2 and Cisco ONS 15454 M6 platforms, see the “3.8 Digital Image Signing” 
section on page 3-20.

G.26 Database Storage
The node database, IP address, and system software are stored in TCC2P/TCC3 card nonvolatile 
memory, which allows quick recovery in the event of a power or card failure.

The TNC/TNCE/TSC/TSCE card provides 4 GB of non-volatile database storage (IDE Compact Flash 
Module) for communication, provisioning, and system control. This allows full database recovery during 
power failure.

The TNC/TNCE/TSC/TSCE card supports writing and reading to and from an external non-volatile 
memory device. The card also communicates with the non-volatile memory device through a USB 2.0 
standard interface.

The USB-WRITE-FAIL alarm may be raised on the TNC and TNCE cards when synchronization occurs 
between Compact Flash and USB Flash. If this alarm does not clear even after 20 minutes duration, it is 
recommended to contact TAC.

For information on USB-WRITE-FAIL alarm, see the Cisco ONS 15454 DWDM Troubleshooting Guide.

Note The configuration details are stored in the database of the TNC/TNCE/TSC/TSCE card. The database 
restore from a TNC/TNCE/TSC/TSCE card to a TSC/TSC/TSCE card or vice versa is not supported.

G.27 Redundant Controller Card Installation
Cisco does not support operation of the ONS 15454 with only one TCC2/TCC2P/TCC3 card. For full 
functionality and to safeguard your system, always operate with two TCC2/TCC2P/TCC3 cards. 

Install TCC3 cards in Slots 7 and 11 for redundancy. If the active TCC3 card fails, traffic switches to the 
protect TCC3 card. All TCC3 card protection switches conform to protection switching standards when 
the bit error rate (BER) counts are not in excess of 1 * 10 exp – 3 and completion time is less than 50 ms.
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G.28   Optical Service Channel
On the ONS 15454 M6 shelf, the TNC/TNCE/TSC/TSCE card operates in either simplex or duplex 
(redundant) control mode. In redundant control mode, high availability is achieved.

When a second TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card is inserted into a node, it 
synchronizes its software, its backup software, and its database with the active 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE. If the software version of the new 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE does not match the version on the active 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE, the newly inserted 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE copies from the active 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE, taking about 15 to 20 minutes to complete. If the backup 
software version on the new TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE does not match the version 
on the active TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE, the newly inserted 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE copies the backup software from the active 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE again, taking about 15 to 20 minutes. Copying the 
database from the active TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE takes about 3 minutes. 
Depending on the software version and backup version the new 
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE started with, the entire process can take between 3 and 40 
minutes. 

G.28 Optical Service Channel
The TNC and TNCE cards support two optical service channels (OSC) through two small-form factor 
pluggable (SFP) ports. The two SFP ports are named SFP1 and SFP2. The supported SFPs on TNC and 
TNCE ports are ONS-SC-OSC-ULH, ONS-SE-155-1510, and ONS-SC-Z3-1510.

Note When you replace SFPs on the TNC and TNCE cards, provisioning for the current SFP has to be deleted 
before the new SFP is plugged in.

SFP1 supports the following payloads: 

• OC-3/STM-1

• Fast Ethernet (FE) 

• Gigabit Ethernet (GE)

SFP2 supports the following payloads:

• Fast Ethernet (FE) 

• Gigabit Ethernet (GE)

G.29 MultiShelf Management
The TNC/TNCE/TSC/TSCE card supports multishelf management of up to 50 shelves including the 
node controller. The card supports up to 49 subtending shelves. The subtending shelves can be the 
ONS 15454 M6 or ONS 15454 shelves. This allows network administrators to isolate faults and 
provision new services across the DWDM network.

In the ONS 15454 M6 shelf, there are six FE RJ45 ports on the ECU and each TNC/TNCE/TSC/TSCE 
card supports three FE RJ45 connections to connect subtending shelves.
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G.30 Protection Schemes
The TNC/TNCE/TSC/TSCE card supports active and redundant architecture. The ONS 15454 M6 shelf 
supports 1:1 equipment protection with one TNC/TNCE/TSC/TSCE card acting as active and the other 
TNC/TNCE/TSC/TSCE card as redundant.

The 15454-M2 shelf supports simplex control mode. In this mode, the active TNC/TNCE/TSC/TSCE 
card operates without a redundant TNC/TNCE/TSC/TSCE card.

The 15454-M6 shelf supports both simplex and redundant control mode. In redundant control mode, the 
active TNC/TNCE/TSC/TSCE card operates with a redundant TNC/TNCE/TSC/TSCE card as the 
backup. If the active TNC/TNCE/TSC/TSCE card is removed, system traffic switches to the redundant 
TNC/TNCE/TSC/TSCE card. If the redundant TNC/TNCE/TSC/TSCE card is not present or not in the 
standby state, removing the active TNC/TNCE/TSC/TSCE card results in loss of system traffic and 
management connectivity.

In redundant control mode, a TNC/TNCE/TSC/TSCE card can protect another TNC/TNCE/TSC/TSCE 
card. However, a TNC/TNCE/TSC/TSCE card cannot protect a TNC/TNCE/TSC/TSCE card or vice 
versa.

G.31 Cards Supported by TNC/TNCE/TSC/TSCE
The TNC/TNCE/TSC/TSCE card supports 15454 MSTP line cards except the following cards:

• OSCM 

• ISC

• AIC

• AIC-I

The TNC/TNCE/TSC/TSCE card is not interoperable with TCC2 /TCC2P/TCC3 cards. The 
TNC/TNCE/TSC/TSCE and TCC cards cannot be inserted in the same shelf.

The line cards such as Transponder and Muxponder cards can be inserted in the 15454-M2 and 
15454-M6 shelves along with the TNC/TNCE/TSC/TSCE card.

G.32 Automatic Power Control
A transient gain range of 20 to 23 dB is available to APC in order to permit other amplifiers to reach 
their expected set points. However, operation in this range is not continuous. At startup, the 
OPT-AMP-17-C card caps the gain at a maximum of 20 dB.

Note When the OPT-AMP-17-C operates as a booster amplifier, APC does not control its gain.

G.33 Alarms and Thresholds
Table G-18 lists the alarms and its related thresholds for the OSC-CSM card.
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G.34 Card Protection

G.34.1 Y-Cable and Splitter Protection
Y-cable and splitter protection are two main forms of card protection that are available for TXP, MXP, 
AR_MXP, AR_XP, AR_XPE, and Xponder (GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and OTU2_XP) 
cards when they are provisioned in TXP or MXP mode. Y-cable protection is provided at the client port 
level. Splitter protection is provided at the trunk port level. 

Note GE_XP, 10GE_XP, GE_XPE, and 10GE_XPE cards use VLAN protection when they are provisioned in 
L2-over-DWDM mode. For more information, see the “G.34.3 Layer 2 Over DWDM Protection” 
section on page G-35. The ADM-10G card uses path protection and 1+1 protection. For more 
information, see the “11.15.10 Protection” section on page 11-90.

G.34.1.1 Y-Cable Protection

Y-cable protection is available for the following ONS 15454 TXP, MXP, and Xponder cards:

• TXP_MR_10G

• TXP_MR_10E

• TXP_MR_2.5G

• 40E-TXP-C

• 40ME-TXP-C

• MXP_2.5G_10G

• MXP_2.5G_10E

• MXP_2.5G_10E_C

• MXP_2.5G_10E_L

Table G-18 Alarms and Thresholds

Port Alarms Thresholds

LINE RX LOS None

LOS-P LOS-P Fail Low

LOS-O LOS-O Fail Low

LINE TX None None

OSC TX OPWR-DEG-HIGH OPWR-DEG-HIGH Th

OPWR-DEG-LOW OPWR-DEG-LOW Th

OPWR-FAIL-LOW OPWR-FAIL-LOW Th

OSC RX None None

COM TX None None

COM RX LOS-P LOS-P Fail Low
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• MXP_MR_2.5G

• MXP_MR_10DME_C

• MXP_MR_10DME_L

• 40G-MXP-C

• 40E-MXP-C

• 40ME-MXP-C

• GE_XP and GE_XPE (when in 10GE or 20GE MXP card mode)

• 10GE_XP and 10GE_XPE (when in 10GE TXP card mode)

• OTU2_XP (when in Transponder card configuration)

• AR_MXP

• AR_XP

• AR_XPE

• 10x10G-LC (when in TXP-10G mode)—The client ports of the 10x10G-LC cards are provisioned 
with 10G Ethernet LAN Phy and 8GFC payloads.

Note A hardware reset or a hardware failure of the active 10x10G-LC card configured in the 
TXP-10G mode in a Y-cable configuration causes a protection switchover that may result in 
a traffic hit of more than 50 msec.

• 10x10G-LC (when in MXP-10G mode)—The client ports of the 10x10G-LC cards are provisioned 
with 10GE, 8G FC, and OC192/STM-64 payloads.

Note A hardware reset or a hardware failure of the active 10x10G-LC card configured in the 
MXP-10G mode in a Y-cable configuration causes a protection switchover that may result 
in a traffic hit of more than 50 msec.

• CFP-LC (when in CFP-TXP mode)—The client ports of the CFP-LC cards are provisioned with 
100GE payloads. This configuration uses only the CFP LR4 pluggable.

• CFP-LC (when in CFP-MXP mode)—The client ports of the CFP-LC cards are provisioned with 
40GE payloads. This configuration uses only the CFP LR4 pluggable.

To set up Y-cable protection, create a Y-cable protection group for two TXP, MXP, or Xponder cards 
using Cisco Transport Controller (CTC). Next, connect the client ports of the two cards physically with 
a Y-cable. The single client signal is sent into the RX Y-cable and is split between the two TXP, MXP, 
or Xponder cards. The two TX signals from the client side of the TXP, MXP, or Xponder cards are 
combined in the TX Y-cable into a single client signal. Only the active card signal passes through as the 
single TX client signal. CTC automatically turns off the laser on the protect card to avoid signal 
interference where the Y-cable joins.

On the GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, and OTU2_XP cards, the Y-cable protection 
mechanism is provisionable and can be set ON or OFF (OFF is the default mode). 

When a signal fault is detected, the protection mechanism software automatically switches between 
paths. Y-cable protection also supports revertive and nonrevertive mode.
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G.34.1   Y-Cable and Splitter Protection
When an MXP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, AR_MXP, AR_XP, or 
AR_XPE card that is provisioned with Y-cable protection is used on a storage ISL link (ESCON, FC1G, 
FC2G, FC4G, FICON1G, FICON2G, FICON4G, or ISC-3 1/2G), a protection switchover resets the 
standby port to active. This reset reinitialises the end-to-end link to avoid any link degradation caused 
due to loss of buffer credits during switchover and results in an end-to-end traffic hit of 15 to 20 seconds.

When using the MXP_MR_10DME_C or MXP_MR_10DME_L card, enable the fast switch feature and 
use it with a Cisco MDS storage switch to avoid this 15 to 20 second traffic hit. When enabling fast 
switch on the MXP_MR_10DME_C or MXP_MR_10DME_L card, ensure that the attached MDS 
switches have the buffer-to-buffer credit recovery feature enabled.

You can also use the TXP_MR_2.5G card to avoid this 15 to 20 second traffic hit. When a Y-cable 
protection switchover occurs, the storage ISL link does not reinitialize and results in an end-to-end 
traffic hit of less than 50 ms.

AR_MXP, AR_XP, and AR_XPE cards support Y-cable protection on the client ports, which are part of 
an unprotected card mode. The Y-cable protection is not supported for video and auto payloads. 

When using the AR_MXP, AR_XP, or AR_XPE card on storage ISL link, use it with a Cisco MDS 
storage switch to avoid this 15 to 20 second traffic hit.

When the active AR_MXP, AR_XP, AR_XPE card is removed from a Cisco 15454 M2 or 
Cisco 15454 M6 shelf, there is a traffic hit of 60 to 100 ms.

Note Y-cable connectors will not work with electrical SFPs because Y-cables are made up of optical 
connectors and it is not possible to physically connect them to an electrical SFP. Y-cable protection is 
not supported on IB_5G.

Note There is a traffic hit of up to a of couple hundred milliseconds on the MXP_MR_2.5G and 
MXP_MR_10DME cards in Y-cable configuration when a fiber cut or SFP failure occurs on one of the 
client ports.

Note If you create a GCC on either card of the protect group, the trunk port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

Figure G-14 on page G-33 shows the Y-cable signal flow.

Note Loss of Signal–Payload (LOS-P) alarms, also called Incoming Payload Signal Absent alarms, can occur 
on a split signal if the ports are not in a Y-cable protection group.

Note Removing an SFP from the client ports of a card in a Y-cable protection group card causes an 
IMPROPRMVL (PPM) alarm. The working and protected port raises the IMPROPRMVL alarm. The 
severity on the client ports is changed according to the protection switch state.

Note On the OTU2_XP card, when the 10G Ethernet LAN Phy to WAN Phy conversion feature is enabled, 
Y-cable protection is not supported on the LAN to WAN interface (ports 1 and 3).
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Note When using fixed DWDM or tunable XFPs for Y-cable protection, the protection switch time may exceed 
50 ms.

Figure G-14 Y-Cable Protection

G.34.1.2 Splitter Protection

Splitter protection, shown in Figure G-15, is provided with TXPP cards, MXPP cards, and OTU2_XP 
cards (on trunk ports that are not part of a regenerator group). You can create and delete splitter 
protection groups in OTU2_XP card. 

To implement splitter protection, a client injects a single signal into the client RX port. An optical splitter 
internal to the card then splits the signal into two separate signals and routes them to the two trunk TX 
ports. The two signals are transmitted over diverse optical paths. The far-end MXPP or TXPP card uses 
an optical switch to choose one of the two trunk RX port signals and injects it into the TX client port. 
When using splitter protection with two MXPP or TXPP cards, there are two different optical signals 
that flow over diverse paths in each direction. In case of failure, the far-end switch must choose the 
appropriate signal using its built-in optical switch. The triggers for a protection switch are LOS, LOF, 
SF, or SD.

In the splitter protected 10G Ethernet LAN Phy to WAN Phy mode, AIS-P and LOP-P acts as trigger 
(when G.709 is enabled) for the Protection Switch, in addition to the existing switching criteria.

In the OTU2_XP card, the STS parameters such as, SF /SD thresholds, Path PM thresholds, and Path 
Trace is set for the working path (Port 3). The same parameters are also applicable for the protected path 
(Port 4).
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Figure G-15 Splitter Protection

G.34.2 1+1 Protection
The 1+1 protection is available for the GE_XP, GE_XPE, 10GE_XP, and 10GE_XPE cards:

The 1+1 protection is provided in the Layer 2 (L2) card mode to protect against client port and card 
failure. 1+1 protection is supported in both single shelf and multishelf setup. This means that the 
working card can be in one shelf and the protect card can be in another shelf of a multishelf setup. 
Communication between the two cards is across 10 Gigabit Ethernet interconnection interface using 
Ethernet packets. The Inter link (ILK) trunk or internal pathcord must be provisioned on both the cards. 
This link is used to transmit protection switching messages and data.

Note With 1+1 protection mechanisms, the switch time of a copper SFP is 1 second.

With 1+1 protection, ports on the protect card can be assigned to protect the corresponding ports on the 
working card. A working card must be paired with a protect card of the same type and number of ports. 
The protection takes place on the port level, and any number of ports on the protect card can be assigned 
to protect the corresponding ports on the working card. 

To make the 1+1 protection scheme fully redundant, enable L2 protection for the entire VLAN ring. This 
enables Fast Automatic Protection Switch (FAPS). The VLAN configured on the 1+1 port must be 
configured as protected SVLAN. 

1+1 protection can be either revertive or nonrevertive. With nonrevertive 1+1 protection, when a failure 
occurs and the signal switches from the working card to the protect card, the signal remains on the 
protect card until it is manually changed. Revertive 1+1 protection automatically switches the signal 
back to the working card when the working card comes back online. 1+1 protection uses trunk ports to 
send control traffic between working and protect cards. This trunk port connection is known as ILK trunk 
ports and can be provisioned via CTC. 

The standby port can be configured to turn ON or OFF but the traffic coming to and from the standby 
port will be down. If the laser is ON at the standby port, the other end port (where traffic originates) will 
not be down in a parallel connection. Traffic is blocked on the standby port. 

1+1 protection is bidirectional and nonrevertive by default; revertive switching can be provisioned using 
CTC.
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G.34.3 Layer 2 Over DWDM Protection
The Layer 2 Over DWDM protection is available for the following cards:

• GE_XP and GE_XPE

• 10GE_XP and 10GE_XPE

When the card is in L2-over-DWDM card mode, protection is handled by the hardware at the Layer 1 
and Layer 2 levels. Fault detection and failure propagation is communicated through the ITU-T G.709 
frame overhead bytes. For protected VLANs, traffic is flooded around the 10 Gigabit Ethernet DWDM 
ring. To set up the Layer 2 protection, you identify a node and the card port that is to serve as the master 
node and port for the VLAN ring on the card view Provisioning > Protection tab. If a failure occurs, the 
node and port are responsible for opening and closing VLAN loops.

Note The Forced option in the Protection drop-down list converts all the SVLANs to protected SVLANs 
irrespective of the SVLAN protection configuration in the SVLAN database. This is applicable to a 
point-to-point linear topology. The SVLAN protection must be forced to move all SVLANs, including 
protected and unprotected SVLANs, to the protect path irrespective of provisioned SVLAN attributes.

A FAPS switchover happens in the following failure scenarios:

• DWDM line failures caused by a fiber cut

• Unidirectional failure in the DWDM network caused by a fiber cut

• Fiber pull on the master card trunk port followed by a hard reset on the master card

• Hard reset on the master card

• Hard reset on the slave card

• An OTN failure is detected (LOS, OTUK-LOF, OTUK-LOM, OTUK-LOM, OTUK-SF, or 
OTUK-BDI on the DWDM receiver port in the case of ITU-T G.709 mode)

• Trunk ports are moved to OOS,DSBLD (Locked,disabled) state

• Improper removal of XFPs

A FAPS switchover does not happen in the following scenarios:

• Slave card trunk port in OOS,DSBLD (Locked,disabled) state followed by a hard reset of the slave 
card

• OTN alarms raised on the slave card trunk port followed by a hard reset of the slave card

G.35 Far-End Laser Control
The 15454 DWDM cards provide a transparent mode that accurately conveys the client input signal to 
the far-end client output signal. The client signal is normally carried as payload over the DWDM signals. 
Certain client signals, however, cannot be conveyed as payload. In particular, client LOS or LOF cannot 
be carried. Far-end laser control (FELC) is the ability to convey an LOS or LOF from the near-end client 
input to the far-end client output.

If an LOS is detected on the near-end client input, the near-end trunk sets the appropriate bytes in the 
OTN overhead of the DWDM line. These bytes are received by the far-end trunk, and cause the far-end 
client laser to be turned off. When the laser is turned off, it is said to be squelched. If the near-end LOS 
clears, the near-end trunk clears the appropriate bytes in the OTN overhead, the far-end detects the 
changed bytes, and the far-end client squelch is removed.
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FELC also covers the situation in which the trunk port detects that it has an invalid signal; the client is 
squelched so as not to propagate the invalid signal.

Payload types with the 2R mode preclude the use of OTN overhead bytes. In 2R mode, an LOS on the 
client port causes the trunk laser to turn off. The far end detects the LOS on its trunk receiver and 
squelches the client.

FELC is not provisionable. It is always enabled when the DWDM card is in transparent termination 
mode. However, FELC signaling to the far-end is only possible when ITU-T G.709 is enabled on both 
ends of the trunk span.

G.36 Jitter Considerations
Jitter introduced by the SFPs used in the transponders and muxponders must be considered when 
cascading several cards. With TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, 
TXP_MR_10E, 100G-LC-C, 100G-ME-C, 10x10G-LC, CFP-LC, AR_MXP, AR_XP, AR_XPE cards 
several transponders can be cascaded before the cumulative jitter violates the jitter specification. The 
recommended limit is 20 cards. With TXP_MR_10G cards, you can also cascade several cards, although 
the recommended limit is 12 cards. With MXP_2.5G_10G and MXP_2.5G_10E cards, any number of 
cards can be cascaded as long as the maximum reach between any two is not exceeded. This is because 
any time the signal is demultiplexed, the jitter is eliminated as a limiting factor.

The maximum reach between one transponder and the other must be halved if a Y cable is used. For more 
information on Y-cable operation, see the “G.34.1.1 Y-Cable Protection” section on page G-30.

G.37 Termination Modes
Transponder and muxponder cards have various SONET and SDH termination modes that can be 
configured using CTC (see the “11.25 Procedures for Transponder and Muxponder Cards” section on 
page 11-163). The termination modes are summarized in Table G-19.

Table G-19 Termination Modes

Cards Termination Mode Description

All TXP, MXP, and 
OTU2_XP cards, 
with the exception 
of the 
MXP_2.5G_10G 
card (see next 
section of this table)

Transparent Termination All the bytes of the payload pass transparently through the cards.

Section Termination In line termination mode, the section and line overhead bytes for 
SONET and the overhead bytes for the SDH multiplex and 
regenerator sections are terminated. None of the overhead bytes are 
passed through. They are all regenerated, including the SONET 
SDCC and line DCC (LDCC) bytes and the SDH RS-DCC and 
multiplexer section DCC (MS-DCC) bytes.
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For TXP and MXP cards, adhere to the following conditions while DCC termination provisioning:

• For SDCC/RS-DCC provisioning, the card should be in the Section/RS-DCC or Line/MS-DCC 
termination mode.

• For LDCC/MS-DCC provisioning, the card should be in the Line/MS-DCC termination mode.

For more information on enabling termination modes, see the “11.25 Procedures for Transponder and 
Muxponder Cards” section on page 11-163.

MXP_2.5G_10G1 Transparent Termination All client bytes pass transparently except the following: B1 is rebuilt, 
S1 is rewritten, A1 to A2 are regenerated, and H1 to H3 are 
regenerated.

Section Termination The SONET TOH section bytes and the SDH regenerator section 
overhead bytes are terminated. None of these section overhead bytes 
are passed through. They are all regenerated, including the SONET 
TOH section DCC bytes and the SDH RS-DCC bytes. In the section 
termination mode, the SONET TOH line and SDH multiplex section 
overhead bytes are passed transparently.

Line Termination In the line termination mode, the section and line overhead bytes for 
SONET and the overhead bytes for the SDH multiplex and 
regenerators sections are terminated. None of the overhead bytes are 
passed through. They are all regenerated, including the SONET 
SDCC and LDCC bytes and the SDH RS-DCC and MS-DCC bytes.

1. Clients operating at the OC48/STM16 rate are multiplexed into an OC192/STM64 frame before going to OTN or DWDM.

Table G-19 Termination Modes (continued)

Cards Termination Mode Description
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A
 P P E N D I X H

Network Element Defaults

The information in this chapter is in a new location. See Network Element Defaults for information 
related to factory-configured (default) network element (NE) settings for the Cisco ONS 15454, 
Cisco ONS 15454 M2, and Cisco ONS 15454 M6 platforms.
H-1
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